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1  General description
The R&S SmartONE Mobile Network Testing Software is the unified Rohde & Schwarz
solution for PC-based drive- and walk-testing. It covers all use cases around optimiza-
tion, network benchmarking and engineering and scales from a single laptop to large
multi-CPU installations with tens of test mobiles.

R&S SmartONE comprises the following two user interfaces (UIs), designed for the
tasks at hand.
● Web-based UI based on the SmartBenchmarker application software

This UI is available for efficient data collection and remote control support from
SmartMonitor. We refer to this UI as the "Standard" mode of R&S SmartONE both
in the R&S SmartONE launcher and in this document.

● Expert UI provided by the R&S ROMES4 application software
This UI is provided for complex measurement tasks and detailed data investigation
during the measurement. We refer to this UI as the "Expert" mode of R&S Smar-
tONE both in the R&S SmartONE launcher and in this document.

To use SmartBenchmarker, the licensing system requires the WIBU software license
bound to the PC. Both R&S ROMES4 and SmartBenchmarker application software use
the WIBU license only. Apart from the WIBU, soft-license, available is the license
stored on a WIBU license dongle.

Contact your Rohde & Schwarz representative to migrate to this licensing system at no
cost. Migration is possible from May 2020 onwards.

● System requirements.............................................................................................. 17
● MS Windows power options....................................................................................18
● MS Windows shutdown...........................................................................................20
● MS Windows sleep and hibernate...........................................................................20
● Introduction to R&S ROMES4.................................................................................20
● Start R&S ROMES4................................................................................................21
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1.1  System requirements

R&S ROMES4 runs under the MS Windows 10 operating system (OS), 64-bit version.

Administration rights are needed to do measurements on MS Windows <version>.

The following PC performances ensure the full R&S ROMES4 functionality:
● Current generation Intel® Core™ i7 CPU

System requirements
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● 16 GByte RAM
● 512 Gbyte SSD
● USB 3.0 and LAN ports which must be Gigabit Ethernet capable with 9k Jumbo

frame support

Since Windows 10 version 1607, Microsoft allows overriding the MAX_PATH limitation
so that path names longer than 260 characters are allowed. However, Windows 10 still
uses by default the mentioned limit. Therefore, R&S ROMES4 does not support path
names longer than 260 characters.

R&S ROMES4 does support the English standard character set only. Do not use any
special characters of other languages.

1.2  MS Windows power options

The following sections describe the modification of power setting that prevents Micro-
soft Windows version 10 to switch off a USB port used by a R&S ROMES4 device dur-
ing measurement. Otherwise, the USB port switch off can happen under the certain cir-
cumstances causing severe problems.

To optimize the OS for measurements with the R&S ROMES4, it is highly recommen-
ded to modify the power option setting.

1. In "Start" > "Settings" > "System" select "Power & sleep" > "Additional power set-
tings".

Figure 1-1: MS Windows 10 - power settings

MS Windows power options



General descriptionDrive Test Software

19Operating Manual 1171.6415.12 ─ 66

The "Power Options" window appears.

2. Select "Power saver" instead of "Balanced (recommended)".

Figure 1-2: MS Windows 10 - Change plan settings

3. Click "High performance" > "Change plan settings".

The "Edit Plan Settings" window lets you set the power plan changes.

Figure 1-3: MS Windows 10 - Edit Plan Settings

4. Select "Change advanced power settings" in the "Edit Plan Settings" window.

MS Windows power options
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The "Power Options" window is displayed.

5. Select "USB settings" > "USB selective suspend setting".

6. Change the setting from "Enabled" to "Disabled".

7. Press "OK".

The modification prevents MS Windows 10 to switch off a USB port used by a R&S
ROMES4 device during measurement.

1.3  MS Windows shutdown

The R&S ROMES4 correctly processes shut down events, but does not offer the option
to save changed workspaces. The measurement stops and the R&S ROMES4 closes
before the OS continues shutting down.

1.4  MS Windows sleep and hibernate

The OS does not allow the application to block the sleep or hibernate process. Thus,
there is no possibility to cancel these processes. If the R&S ROMES4 is measuring, it
tries to stop the measurement. As an application has only two seconds to respond to
the operating system, it can occur that the measurement cannot be stopped com-
pletely. Due to this fact, it is highly recommended to save all data and stop the mea-
surement before pressing the "Sleep" or "Hibernate" button of MS Windows.

Consider that not each measurement equipment supports the "Standby" mode and
reacts adequate on it.

1.5  Introduction to R&S ROMES4

Due to its modular concept, the R&S ROMES4 is a perfect solution for every coverage
measurement task. Rohde & Schwarz offers various options which can be combined
with the R&S ROMES4. The product offers the digital mobile phone networks and digi-
tal audio broadcasting measurement options and analog signal strength measurement
in almost every relevant frequency range. The latter can be used as a stand-alone sol-
ution or in combination with the R&S ROMES4.

Depending on the used devices, the complete system is either installed in a portable
case or in a van.

The following picture gives an overview of the basic steps taken in a measurement
tour.

Introduction to R&S ROMES4
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Figure 1-4: Overview of a measurement tour

The "Replay" mode is an additional feature for pre-evaluation purposes. Replay means
that you can load and analyze the stored measurement data after the measurement
tour, using different views that R&S ROMES4 provides for display and evaluation. You
can pause the replay at points of special interest to analyze the data replayed so far,
print the view contents or copy screenshots to the clipboard using the "Copy to Clip-
board" item in the context menu of the view, or [ALT+PrtSc] (for capturing the active
window) or [PrtSc] (for the whole screen).

1.6  Start R&S ROMES4

To perform a R&S ROMES4 measurement, you need a PC administrator rights and the
WIBU license. The measurement replay needs the normal user rights and you do not
need the license. When you install R&S ROMES4, the application detects or not the
presence of the license. If the license is detected, the software installation continues.
When the installation ends, R&S ROMES4 runs in measurement mode. This mode is
indicated on your PC desktop with the icon.

Start R&S ROMES4
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Figure 1-5: Desktop icons to start R&S ROMES4

Double-click the icon to start up R&S ROMES4.

If the license is not detected you have the possibility to work in "Replay Only" mode,
see Chapter 1.10.1, "R&S ROMES4 measurement and replay mode", on page 30.

1.6.1  R&S ROMES4 measurement mode

You need the admin rights to run R&S ROMES4 in measurement mode.

For the details of the measurement mode, see Chapter 1.9, "Measurement with R&S
ROMES4", on page 29.

User account control
At R&S ROMES4 start-up on a PC with the MS Windows 10, the operating software
performs the steps to control user account.
The operating system asks if you want R&S ROMES4 to change the system settings.
Click "Yes" to allow R&S ROMES4 makes the necessary changes, for example,
changes for DQA settings.
If the current user account has no admin rights, a dialog to enter the admin password
pops-up, so that R&S ROMES4 could run with admin rights.
Continue with Chapter 1.6.2, "Windows security alert", on page 23.

Suppressing R&S ROMES4 alert
It is possible to suppress the R&S ROMES4 alert pops-up for a duration of the current
measurement. To suppress the alert, click the "Ignore" button. No more alert pop-ups
are shown for the current measurement.

Figure 1-6: Suppressing R&S ROMES4 alert

Start R&S ROMES4
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1.6.2  Windows security alert

On the first startup of R&S ROMES4, a Windows security alert occurs to set the secur-
ity level of the network access. R&S ROMES4 needs a public networks access which
means that the firewall is set to the most stringent settings.

1. In the "Windows Security" dialog, select "On" in the "Public network" > "Windows
Defender Firewall" option.

2. Close the dialog.

The firewall setting for R&S ROMES4 is saved and its GUI opens, see Chapter 1.7,
"Startup wizard", on page 24.

Change user account control to start R&S ROMES4 without user control alert
To avoid the alert message, change the user account control to a less secure level.
User account control change is only recommended for stand-alone machines.
Select "Control Panel" > "System and Security" > "Change User Account Control Set-
tings". Drag the level bar to the lowest setting, as shown in the following figure.

Figure 1-7: User Account Control Settings

Start R&S ROMES4
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1.7  Startup wizard

In the "StartUp Wizard" dialog you can choose how to start R&S ROMES4.

The dialog appears while running R&S ROMES4 if the option "Show Startup Wizard" is
checked in "Tools" > "Preferences" > "Start Up".

You can select between the following:
● Predefined workspace
● Predefined project
● Start with an empty view area

Figure 1-8: Startup & Wizard window

A measurement file can be also selected. If the measurement file is selected, it opens
immediately after booting.

The dialog can be suppressed by checking "Don’t Ask Again". It can be enabled again
in the "Preferences" dialog.

User
To load R&S ROMES4 user, select the R&S ROMES4 user.
For each user, a copy of the R&S ROMES4 registry (only CurrentUser part) is cre-
ated. Each R&S ROMES4 user has its own MS Windows registry entry. At the same
time, the own registry entry is the only difference between the users.

Startup wizard
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At the startup of R&S ROMES4, the branch of the selected user is copied to the R&S
ROMES4 branch. With different users, it is possible to personalize R&S ROMES4.
For example, personalize R&S ROMES4 with different vehicle IDs, user IDs or default
directory.

Figure 1-9: Select a user profile from the drop-down menu.

Click the button on the right of the "User" combo-box to open the "ROMES User" win-
dow. You can add a new user or remove a selected one via "Add" or "Remove",
respectively.

Figure 1-10: Creation of new user

Mode
● "Load Project"

This option requires an R&S ROMES4 project file. The project file loads only the
specified modules and creates only the specified views.
The measurement can be started automatically, by checking the "Auto start of
Measurement" option. In this case no "Measurement File" can be opened, and the
"User Level" cannot be changed.

● "Load Workspace"
A predefined workspace is loaded after R&S ROMES4 booting.

● "Start with empty View Areas"
R&S ROMES4 starts without any preadjustment.

Startup wizard
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Measurement file
"Load Measurement File"
The user can select a measurement file, which will be open automatically after R&S
ROMES4 booting.

Close
Click "Close" to abort the start of R&S ROMES4.

1.8  R&S ROMES4 crash report

In the unlikely event of a R&S ROMES4 crash, R&S ROMES4 offers a possibility to
send the crash dump to Rohde & Schwarz.

The crash reports are dumped by MS Windows. Due to that reason, the R&S ROMES4
crash reports do not show the crash location.

To provide the crash location information, the crash dumps generated by MS Windows
are added to a *.zip file. If sent or e-mailed to R&S, the file can help developers to
catch the crashes when they appear on a customer's site.

When a crash occurs, a dialog box informs that R&S ROMES4 does not work anymore
(this dialog can differ if no debugger is installed).

Figure 1-11: R&S ROMES4 crashed

Click "Close the program" to obtain the R&S ROMES4 crash dialog and create the
crash report.

The report dialog has a form that lets you easily enter more information about the
crash and provide the developers with additional information.

R&S ROMES4 crash report
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Figure 1-12: Create report when R&S ROMES4 crashes

The user name and e-mail written in the "Contact Information" are stored between sub-
sequent dialogs and can be used for consultation. The field "Information about the
Crash" offers the form to provide more information about the crash.

Press the "Create Report" button. The *.zip file that contains all the necessary info
for Rohde & Schwarz is created.

All crash data is written into one single zipped file. When the *.zip file is generated,
the corresponding files in the MyRomes\LogFiles folder are deleted automatically.

R&S ROMES4 supports the RusWorkerDllLoader and RusWorkerDllLoaderPhysical-
Layer output files (RuSWorkerDllLoader.exe and RuSWorkerDllLoader0.exe)
and the crash dumps in case the R&S ROMES4 SW or one of those files crashes.

R&S ROMES4 crash report
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At R&S ROMES4 start after such a crash, the dialog for existing crash report appears.
It shows the same form of crash dialog, pre-filling the fields if information was provided
in the dialog. You can change the information in this report.

Figure 1-13: Existing R&S ROMES4 crash reports

The crash report shown in the "Existing ROMES Crash Reports" can be sent, stored,
uploaded or deleted. You can send the file containing the information and description of
the crash to Rohde & Schwarz via e-mail or by automatically uploading via FTP. There
is also the option to skip the dialog,

● Click "Delete" to delete the file.
● Click "Upload" to upload the crash report file via FTP.
● Click "E-Mail" to send the file via e-mail.
● Click "Store" to store the ZIP file which contains one or more crash dumps on the

disk. The option lets you send it later to Rohde & Schwarz, for example, if the Inter-
net connection is not available when the crash occurs.

● Click "Continue" to skip the execution of any action. In this case, the unchanged
dialog appears in the next R&S ROMES4 start.

1.8.1  Renaming the zipped crash dump file for e-mailing

Rename the zipped crash dump file to *.txt for sending it via e-mail in following two
scenarios.

● Sending existing crash dump during startup

R&S ROMES4 crash report
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● Sending crash dump file just after R&S ROMES4 crashes

1.8.1.1  Sending existing crash dump during startup

During startup, if crash dump file is detected in LogFile folder, the ".txt" extension is
appended to the ZIP file name.

1.8.1.2  Sending crash dump file just after R&S ROMES4 crashes

If crash occurs when R&S ROMES4 is running, the “.txt” extension is appended to the
ZIP file that contains a crash dump and report.

1.8.1.3  Restrictions

● Size restriction
MS Outlook can restrict the size of the attachment. The actual allowed maximum
attachment size depends on the Outlook configuration.

● Privilege restriction
MS Outlook can block the access if R&S ROMES4 and MS Outlook are launched
with different privileges. If for example R&S ROMES4 starts as an administrator
and MS Outlook starts as a regular user, an error occurs. Therefore, start both with
the same privilege level to avoid the error.
If MS Outlook is not running, R&S ROMES4 launches the sending e-mail dialog
with proper privilege. If sending still fails, it is likely the size problem.

● Possible error messages
– MS Outlook is in use and cannot be accessed
– System busy with "Switch" or "Retry" options
– Silent failure, no email dialog pops up

1.9  Measurement with R&S ROMES4

R&S ROMES4 supports that the current measurement and the evaluation of results
are configured and carried out independently from each other.

● Device settings in the "Hardware" menu bar determine how the device performs
measurement.

● Display configuration settings determine how the results are analyzed and viewed

Data can be viewed during the measurement without being stored (measurement
mode). Data can be viewed and stored at the same time (recording mode). Data recor-
ded in the past can be loaded from a measurement file and analyzed (replay mode).

You need administration rights to run R&S ROMES4 in measurement mode.

Measurement with R&S ROMES4
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The contents of a result file, i.e. measurement file, depends on a kind of devices and
their settings, not on a view configuration. In particular, the parameter selections and
settings in "Tools" > "Configuration Active View" do not have any influence on the
*.rscmd or *.sqc file. The RSCMD and SQC are the formats of measurement files
which R&S ROMES4 supports.

Measurement information about user name, test vehicle and vehicle ID which is saved
with the *.rscmd or *.sqc file is editable in "Tools" > "Preferences".

Figure 1-14: Principle of a measurement

1.10  Basic concepts of R&S ROMES4

The following section introduces the R&S ROMES4 basic operating concept, presents
the measurement data and the available file formats. It also defines frequently encoun-
tered terms of the R&S ROMES4 user interface.

1.10.1  R&S ROMES4 measurement and replay mode

The R&S ROMES4 measurement mode unlocks the selected technologies so that
measurements within these technologies are possible. This mode requires the WIBU
license. The license can be delivered as soft-license or as stored on dongle.

Without the license, or if the license is deactivated, R&S ROMES4 can work in "Replay
Only" mode. If the WIBU license is not detected, the dialog pops-up to let you decide if
to start the replay mode.

Basic concepts of R&S ROMES4
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Click "Yes" if you want R&S ROMES4 to start in replay mode. If you select "No", the
R&S ROMES4 does not start.

In "Replay Only" mode measurements are not possible, as R&S ROMES4 does not
support devices in this mode. However, all views, technologies and export functions
are available.

For how to activate and deactivate WIBU soft-license, see the "R&S ROMES4 - WIBU
License Management" document.

For details on current licenses, unlocked technologies on the own dongle and how to
activate additional licenses, see Chapter 3.10.4, "Licenses", on page 419.

1.10.2  Workspace and measurement files

The R&S ROMES4 opening "Welcome" window shows the workspace files and the
measurement files used in the previous sessions. The data in these two file types is
complementary. Measurement files contain the measured data, while the workspace
files (*.rsxks) control their visualization.

On the top-left side of the opening workspace, info about available but also missing
devices is displayed.

Figure 1-15: Workspace and measurement files

Basic concepts of R&S ROMES4
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1.10.2.1  Workspaces

When you run your workspace file, the workspace displays the loaded device and
screen settings for a R&S ROMES4 session. The display includes the type, size and
position of the all open views and the parameters associated with each opened view (if
applicable). If location map is defined, it is also displayed for the "ROMESMAP Route
Track View" in the "Workspace".

The signal configurations defined in the "Preferences" entry, see Chapter 3.8.1.2,
"Available signals configuration", on page 228, are stored in the MS Windows registry
by default. They can be alternatively included in workspace.

During the session, exactly one or no workspace is active. If the R&S ROMES4 runs
without any loaded workspace, the default R&S ROMES4 settings are used for the cur-
rent session.

User-defined workspaces can be stored to a workspace file <filename>.rsxks and
recalled in later sessions. So, the matching control windows can be easily set for each
kind of measurement and each operator can save and reuse favorite constellations.

The default directory for saving workspaces is defined in "Tools" > "Preferences" >
"General".

Workspace-related menu commands:
● Chapter 3.2.1, "New workspace", on page 104

Create a workspace.
● Chapter 3.2.2, "Open workspace", on page 105

Loads an existing workspace file.
● Chapter 3.2.3, "Reload workspace", on page 109

Reloads the current workspace. All unsaved changes are lost.
● Chapter 3.2.4, "Save workspace", on page 109

Saves the current workspace with its current name.
● Chapter 3.2.5, "Save workspace as", on page 109

Saves the current workspace with a new name.

Default workspace

R&S ROMES4 loads a default workspace if no other workspace or measurement file is
loaded. Locate the workspace in the configuration folder (supported are folders Current
Users and Application Folder) and name it ~default.rsxks.

The huge amount of information saved on the workspace is beneficial for users who
transfer workspaces between PCs and use similar setups on different PCs. If you want
to load an old workspace, that workspace is initially scanned for all referenced devices.

The list of devices saved on the workspace is checked against the list of available devi-
ces. The available devices are those ones that are connected to the PC (also named
the host PC) R&S ROMES4 is running on. If a device saved on the workspace (or
some of them) is not available on the PC, a new dialog is displayed offering the follow-
ing solutions:

- Ignore the problem: R&S ROMES4 tries to load the device which still fails. These
devices are marked with an orange bar.
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- Remove the device from the workspace. This device is not available and therefore
not loaded.

- If one or more devices are available as a replacement, they are offered as well.

- Replaced device or devices which can be loaded without problems are displayed with
a green bar.

Figure 1-16: Qualcomm device replaced by H8266

Use the "Auto Resolve" button for quick replacement of the devices stored on the
workspace with the currently available ones connected to the PC.

1.10.2.2  Recent measurements

R&S ROMES4 supports measurement file formats RSCMD and SQC.

A *.rscmd file contains the complete measurement data acquired on a tour.

A *.sqc file is only a container (zip) which contains several files acquired. The SQC
format is suitable for data processing.

The Fully integrated devices and the On PC testing (Classic mode) devices can store
data files in SQC format.

The On PC testing devices are those ones for which the QualiPoc.apk file cannot be
installed directly on a device. Such are, for example, IoT and 5G routers/MTP or mod-
ules where QualiPoc application is not installed.

An independent Trace Decoder supports a data file conversion from RSCMD to SQC
format in background if On PC testing (Classic mode) devices are used. The conver-
sion is supported for the following devices/jobs:

- Scanners (already available since R&S ROMES4 v-19.2)

- Qualcomm chipset-based On PC testing (Classic mode) devices

Basic concepts of R&S ROMES4



General descriptionDrive Test Software

34Operating Manual 1171.6415.12 ─ 66

- Samsung Exynos chipset-based On PC testing (Classic mode) devices

- DQA jobs executing by On PC testing (Classic mode) devices, precisely, for FTP Up-
and Download, HTTP Up- and Download, Ping and NB-IoT FTP jobs.

R&S ROMES4 interpolates the GPS data even if there is no data reception for longer
than 2 seconds if the SQC format is selected as a measurement file format. The Inter-
polated data is written into the RSCMD and MF file formats, which are then included in
the SQC file format. This approach ensures that the SmartAnalytics plots the same
location information for the R&S ROMES4 created scanner MF files, SmartBench-
marker or QualiPoc scanner MF files.
Select the SQC creation to have interpolated GPS information contained in RSCMD
format.

On PC testing mobile devices do not support voice test files.

The *.sqc file created by R&S ROMES4 can contain the files listed in the following
table.
Table 1-1: Measurement files contained in an SQC file

File Mandatory Remark

SQZ of QualiPoc no SQZ file of a QualiPoc measurement is copied from the
phone when the R&S ROMES4 measurement has been stop-
ped

RSCMD yes MF -> RSCMD converter can create the RSCMD file out of
the MF/SQZ format files

SQZ of Scanner/GPS no SQZ file of scanner / GPS measurements*

File Handler yes System frames of RSCMD file

File Info yes To know whether the file was written by SmartBenchmarker or
R&S ROMES4, R&S ROMES4 adds a RomesFileInfo.txt
file to the container.

FileID: ROMES File ID

Content: Measurement File Info Text

With this approach of handling measurement files, it is not necessary to export a
*.rscmd file for its analysis in NQDI or SmartAnalytics and additional converter is not
needed.

SQZ files (i.e. measurement files MF) ready for NQDI and SmartAnalytics post-pro-
cessing are produced during the R&S ROMES4 measurement using SQ Trace
Decoder. The prerequisite is the activated "Write SQZ Files for Mobiles and QoS in
Classic Mode" option in "Preferences" > "File Handling". The option supports the fol-
lowing devices/jobs:

- Scanners (already available since R&S ROMES4 v-19.2

- Qualcomm chipset based On PC testing (Classic mode) devices
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- Samsung Exynos chipset based On PC testing (Classic mode) devices

- DQA jobs executing by On PC testing (Classic mode) devices, precisely, for FTP Up-
and Download, HTTP Up- and Download, Ping and NB-IoT FTP jobs.

For replay in R&S ROMES4, the *.rscmd file within the container is extracted and
opened.

During a R&S ROMES4 session, no measurement file needs to be opened because
many actions (such as view configurations and export) are independent of the mea-
surement data. A measurement file must be opened if data is recorded or replayed.

The corresponding commands consider whether a *.rscmd measurement file is
already opened or not.
● If opened, the action is performed using the current measurement file ("Replay"), or

the current measurement file is proposed as a default file for the action ("Record-
ing").

● If not opened yet, a "File Open" dialog is opened first. In this dialog, a measure-
ment file can be selected.

The following are measurement file-related commands:
● Chapter 3.2.8, "Open measurement file", on page 112

Open a measurement file.
● Chapter 3.2, "File menu", on page 103

Search for a measurement file in selected directory.
● Chapter 3.2.9, "Close measurement file", on page 115

Close the current measurement file.
● Chapter 3.2.13, "Export measurement files", on page 130

Export the rscmd file contents.
● Chapter 3.6.2, "Start recording", on page 214

Start a measurement and write the results to a measurement file.

QualiPoc OneTraceDecoder/Converter

The QualiPoc.apk contains the feature OneTD to write the mobile trace data of dif-
ferent RATs during the QualiPoc measurement to RSCMD Phylis frames. The
CGSM_MOBILEFrame, CUMTS_MOBILEFrame, CLTE_MOBILEFrame and
CNR5G_MOBILEFrame are written and the frames are stored in the special MT record
mtPhylisFrame in the MF database.

The QualiPoc.apk is installed by R&S ROMES4 via the QPUpdateTool.exe file.

The QualiPoc converter transports these frames to the RSCMD files.

The converter GUI allows conversion of multiple SQZ/MF measurement files and their
transport to the RSCMD files.

Activate the "RSCMD Logging" option in the QualiPoc device using the "Settings" >
"Advanced Analysis" > "Advanced Logging Settings" command.

If "RSCMD Logging" is not activated during a QualiPoc handheld measurement, you
are warned with the following dialog.
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Figure 1-17: Warning to activate RSCMD logging

The converted RSCMD file shows OneTD in the measurement file info for input
MF/SQZ files containing mtPhylisFrame records (instead of ROMES2GO).

Figure 1-18: Measurement info - OneTD

A log file of conversion is not deleted if the file name contains non-ASCII characters
like ä, ö or ü. Therefore, do not use the special characters in the log file name.

1.10.2.3  R&S ROMES4 project

A project file (*.rsproj) stores all information about the necessary modules and
views for a certain measurement or evaluation task. Improved are the performances of
R&S ROMES4 and the clarity of its GUI. By loading a project, only necessary modules
and views are used within the R&S ROMES4.

Message view is created in any case.

● To load a project, defined it while starting the R&S ROMES4. Thus, the option to
load a defined project is the StartUp Wizard, see Chapter 1.7, "Startup wizard",
on page 24.

● R&S ROMES4 project can be loaded also by defining the switch ‘p’ at the com-
mand line:
Romes.exe –p C.\whereever\bestproject.rsproj

A project is always protected by a password. However, an empty password is allowed.
The project can be loaded without password, but it is required to overwrite it.
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Project-related menu commands:
● Chapter 3.2.6, "Create project", on page 110

Create a project.

1.10.3  Data selection

The data of a measurement file is presented in hierarchical tree in the view area of a
selected view. The configuration menus are used to select data for viewing and export-
ing. The trees give a graphical presentation of the correlation between the data that
originates from different devices and technologies.

Figure 1-19: Data tree and data selection

The previous figure shows the default data tree available in the view configuration
menus as long as no measurement (<filename>.rscmd) file is opened.

If a measurement file is opened, the data tree is adapted to the file contents. Not occu-
pied branches because the corresponding technologies or device are not available, are
truncated. The truncate ensures that any signal shown in the data tree is available in
the current measurement data.

The data tree shown in "Tools" > "Preferences" does not show the device hierarchy
level, because devices are selected elsewhere.

1.10.4  Signal analyzer

Signal Analyzer allows user to create and maintain composite signals. These signals
are custom R&S ROMES4 signals that can compare results from existing R&S
ROMES4 signals using arithmetic operations.

Composite signals can be added to views, saved with workspace, exported or impor-
ted.
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Signal Analyzer is a top-level signal node in signal tree hierarchy. For signal tree, see
Chapter 3.3.7, "Signal tree view", on page 158. The direct signal tree nodes are named
branches. The nodes located below each branch (if present) in "Signal Analyzer" are
composite signals.

Figure 1-20: Signal tree - signal analyzer branch

1.10.4.1  Purpose of composite signals

A composite signal is an arithmetic function of one or more regular signals. The signal
has the CS (S1, …, Sn) format, where CS is the composite signal function, S1 and Sn
are numeric signals.

For example, following expression/function defines a composite signal function CS
derived from RSRP1 and substrate signal RSRP2.

CS (RSRP1, RSRP2) = RSRP1 – RSRP2

RSRP1, RSRP2 can come from different devices.

The usage of composite signal is to compare and evaluate regular signals and make
easy testing different kind of devices.

1.10.4.2  Composite signals pre-Installed with R&S ROMES4

There are two composite signals that are pre-installed with R&S ROMES4.

● "5G NR-LTE RSRP Gain Top N[1]"
Shows the gain (in dB) between the SS-RSRP of the best member of the first 5G
Top N pool and RSRP of the best member of the first LTE Top N pool.

● "5G NR-LTE SINR Gain Top N[1]"
Shows the gain in (dB) between SS-SINR of the best member of the first 5G Top N
pool and the SINR of the best member of the first LTE Top N pool.
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A positive gain value indicates strong 5G signal. The negative value indicates that LTE
signal is better. If Top N pools other than the first one are needed, the signal can be
cloned and the signals change to use other Top N pools via the "Signal Analyzer Con-
figuration" window. These statements are valid for both listed signals.

The signals are shown in the "Signal Tree" under "Signal Analyzer" > "LTE 5G Deltas",
see the previous figure.

The expression used is "B-A", where "A" is the variable standing for LTE-Scanner Top
N Pool 1/Member 1RSRP (SINR respectively), and "B" is 5G-Scanner Top N Pool 1/
Member 1 SS-RSRP.

1.10.4.3  Composite signals in basic views

The configured signal analyzer composite signals can be configured in the R&S
ROMES4 "Basic Views" for use in measurement and replay.

The following basic views support configuration of the signal analyzer composite sig-
nals:

● "Alphanumeric View"
● "2D Chart View"
● "Grid View"
● "Generic Grid View"

The composite signals are configured for use in a basic view in the same way the other
R&S ROMES4 signals are configured for use. Use a view configuration page to config-
ure composite signal. Instead, drag the signal from the "Signal Tree" and drop it in the
view.

Once configured in a basic view, the composite signals behave the same as standard
R&S ROMES4 signals except for the "Alphanumeric View".

For composite signals configured as multi device, the result is displayed in a single
"Data Analyzer" column.

The following figure shows a resulting user composite signal configured for use in
"Alphanumeric View". A composite signal that subtracts an RSRP value from 5G UE
and RSRP value from 5G scanner is configured as the resulting user composite signal.

Figure 1-21: User composite signal in Alphanumeric View

For composite signals configured per device, the signal results are displayed in a col-
umn for each device that the composite signals are valid for.

In the following figure shows the use of the default 5G gain composite signals in the
"Alphanumeric View". The composite signal uses a signal from both LTE scanner and
5G scanner. The value is displayed both in the LTE scanner and the 5G scanner col-
umn.
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Figure 1-22: Default 5G gain composite signal

1.10.4.4  Configuration of signal analyzer

To configure the Signal Analyzer, click the "Technologies" > "TEC for Kernel" command
of the R&S ROMES4 main menu.

Figure 1-23: TEC for Kernel

The following window pops-up.

Figure 1-24: Signal analyzer configuration window
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The opened window corresponds to the "Signal Analyzer Configuration" option. The
signals listed under the "Pre Installed" section are installed with R&S ROMES4 and
cannot be modified or deleted.

Any signals created by the user are listed under the "User Defined" section.

If there are no user-defined signals, the "User Defined" section does not appear. A grid
in the middle of the page is populated with available composite signals.

The "Signal Analyzer Configuration" window can be opened also via the "Tools" >
"Configuration Signal Analyzer" menu command.

Figure 1-25: Opening the configuration window via Tools menu

Signal Analyzer - configuration of grid columns

The grid has four columns:
● "Selection"

Selected is if checked or unselected if cleared. Click the button to apply the corre-
sponding action to the selected composite signals.

● "Branch"
Composite signal branch, read only. Can be changed in composite signal configu-
ration dialog.

● "Name"
Name of a composite signal. It is unique in the given branch, read only. The name
can be changed in composite signal configuration dialog.

● "User Description"
This field is editable. Use this field to describe the composite signal. Combination
of branch and name uniquely identifies a composite signal.
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Signal Analyzer - configuration of grid groups

There are two groups of composite signals:
● Pre-Installed composite signals

Pre-installed and can be cloned and viewed, but cannot be removed, changed or
exported.

● User-defined composite signals
User defined, all button actions are allowed.

Buttons to check or clear all selections

At the bottom of each group, the selection column contains two icon buttons  used
to check or clear all selections.

Click the  button to check all selections.

Click the  button to clear all selections.

Buttons of signal analyzer configuration

There are several buttons below the "Signal Analyzer Configuration" grid:
● "Add"

Creates a new composite signal by filling the composite signal configuration dialog.
● "Remove"

Removes the selected composite signals.
● "Change"

Changes the selected composite signal in the composite signal configuration dia-
log.

● "Clone":
Clones the selected composite signals with new names.

● "View"
Displays the composite signal details in the "Composite Signal Configuration" dia-
log.

● "Import"
Imports composite signals from a disk file.

● "Export"
Exports the selected composite signals to a disk file.

Preinstalled signals cannot be exported.

Two sheet level buttons at the bottom are:
● "OK"

Saves all changes made in the "User Description" dialog or in the composite signal
configuration dialog to disk.
Note: All changes in "Analyzer Signal Configuration" or "Composite Signal Config-
uration" dialog are in memory and persist to disk only if the "OK" button is clicked.

● "Cancel"
Discards all changes.
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Signal analyzer - selection of the configuration buttons

The buttons are functional or grayed dependent on the composite signal selection.

● "Add" button is always active.
● "Remove" button is active only if at least one user-defined composite signal is

selected. The remove action is applied only to the user-defined signals.
● "Change" button is active if only one user-defined composite signal is selected.
● "Clone" button is active if there is any composite signal is selected.
● "View" button is active if there is only one composite signal is selected.
● "Import" button is always active.
● "Export" button is active if at least one user-defined composite signal is selected.

Add a composite signal

Click the "Add" button to launch composite signal configuration dialog for user to fill the
signal details.

If the signal is successfully added, the new signal is shown in the CSC grid. Refer to
"Composite Signal Configuration" section for details.

Remove composite signals

Click the "Remove" button to remove all the selected user-defined composite signals.

The action does not remove pre-installed composite signals no matter they are
selected or not.

Change a selected composite signal

Click the "Change" button launches the composite signal configuration dialog used to
make changes.

Refer to "Composite Signal Configuration" section for details.

Clone selected composite signals

Click the "Clone" button to clone all selected composite signals with new names.

A new name gets suffix "_xxx" where the xxx is a number from 001 to 999 depending
on the available next suffix number. If the number reaches the limit, the following dialog
displays.

Figure 1-26: Clone warning message
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View a selected composite signal

Click the "View" button to launch the composite signal configuration dialog, so that you
can view the details.

All the fields in the composite signal configuration dialog are read only. However, the
"Information" button is active.

Refer to "Composite Signal Configuration" section for details.

Export selected composite signals to disk

Clicking the "Export" button to launch the "Export Composite Signals" dialog. Browse a
folder and select or enter a file name to export the selected composite signals.

Figure 1-27: Exporting a file containing composite signals

If the name already exists, you are prompted whether replace it.
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Import composite signals from disk

Clicking the "Import" button to launch the "Import Composite Signals" dialog. Browse a
folder and select a composite signal file (XML file). Click "OK" to import it.

Figure 1-28: Importing a file containing composite signals

If the file is successfully imported, you receive a message indicating the number of
successfully imported signals.

If any of the signals that are attempted to be imported currently exist, the import of
those signals fails. You receive the error message in that case alerting you to the prob-
lem.

Figure 1-29: Import of some signals failed
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Table 1-2: Other error messages for failed import

Error message Cause

"No composite signals found to import" Import file contains no signals to import or is not for-
matted correctly.

"Import Failed: Composite signals already exist" All signals in the import file already exist as compo-
site signals in R&S ROMES4.

1.10.4.5  Composite signal configuration

The "Composite Signal Configuration" dialog launches if the "Add", "Change" or "View"
button in the "TEC for Kernel" > "Signal Analysis Configuration" window is clicked.

The following two screenshots of the "Composite Signal Configuration" dialog show the
empty one for adding signals and the populated one for changing.

Figure 1-30: Empty Composite Signal Configuration dialog

A source signal tree is located in the "Signal" pane. A components grid is located in the
"Composite Signal Components" pane.

The source signal tree contains regular signals and the leaf signals can be dragged to
the "Composite Signal Components" grid.
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The items in the "Composite Signal Components" grid are used as operands in compo-
site signal expression. You can configure a signal name, branch, device type, range
minimum/maximum, unit and color scale in this dialog.

Figure 1-31: Populated Composite Signal Configuration dialog

Custom functions to calculate electromagnetic field strength

Signal Analyzer contains the several built-in functions for calculating the strength of
electromagnetic field. The signal analysis is a workaround for recalculating the
received power to various units, having in mind also the antenna gain.

The possible functions and their corresponding syntax are shown in the following table.
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Table 1-3: Built in functions for calculating electromagnetic field strength

Function Description Syntax

dBmTOdBuVm Convert value from dBm to dBuV/m dBmTOdBuVm (X, Y, Z)

X - is the value in dBm to convert

Y - is the frequency

Z - is the antenna gain

dBuVmTOdBWm Convert value from dBuV/m to dBW (m2/
MHz)

dBuVmTOdBWm (X, Y)

X - is the value in dBuV/m to convert

Y - is the bandwidth

dBmTOdBWm Convert value from dBm to dBuV/m dBmTOdBWm (X, Y, Z, A)

X - is the value in dBm to convert

Y - is the frequency

Z - is the antenna gain

A - is the bandwidth

The following figure emphasis the dialog's functions in the "Composite Signal Expres-
sion" pane.

Figure 1-32: Convert dBm to dBWm function

Value map for signal analyzer

The Signal Analyzer supports the SignalAnalyzerMaps.xml file which defines
mappings for R&S ROMES4 signals to a new value.
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Locate the file in the My Documents\My ROMES\Configuration folder. With the R&S
ROMES4 installation, an example file is copied to the application’s configuration folder.
It is copied to the user’s configuration folder after the first startup if the synchronization
feature is active. Otherwise, check the folder C:\ProgramData\Rohde&Schwarz\My
ROMES\Configuration for the example file.

When the example file has been renamed to SignalAnalyzerMaps.xml and R&S
ROMES4 is restarted, the two new entries "AF1" and "AF2" are offered as functions for
Composite Signal Expression.

Figure 1-33: Added functions AF1 and AF2

The setup of a signal mapping is straight forward. The main tag of the file is Maps,
which has to be present always. The next tag is Map, which specified one Mapping
Table.

The Map has the following attributes:

- Attribute: Remark

- Name: The name of the function, which has to be used in the Signal Analyzer to get
the mapping. For example, if name=”MyMap”, then the corresponding call is MyMap(A)

- HelpTitle: An optional help title can be specified, which is used as a tool tip header in
the "Signal Analyzer" dialog for this Map.

- HelpDesc: An optional help description can be specified, which is used as a tool tip
text in the "Signal Analyzer" dialog for this Map.

Each Map contains at least two-point tags. Point tags have the attribute "In" and "Out".

The values of the In attributes must be increasing. The Map maps the input value to
the corresponding output value. If the input value is not equal to any Point’s In attrib-
ute, the value is calculated by a linear interpolation between the neighbor Points.

Example:

<Maps>
    <Map Name="AF1" HelpTitle="Antenna Factor 1" HelpDesc="this is a map">
                <Point In="1" Out="10"></Point>
                <Point In="10" Out="100"></Point>        
                <Point In="100" Out="1000"></Point>        
    </Map>
    <Map Name="AF2" HelpTitle="Antenna Factor 2" HelpDesc="this is another map">
                <Point In="1" Out="100"></Point>
                <Point In="10" Out="1000"></Point>        
                <Point In="100" Out="10000"></Point>        
    </Map>
</Maps>
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Some example calls:

AF1(1) => 10

AF1(5) => 50

AF2(30) => 3000

Ensure that the unit of the input signal has the expected value. For example, if the unit
for a frequency is set to Hz, the Point in attributes has also to be in Hz. If MHz is used,
a *.xml file has to contain MHz.

Enter composite signal name

A composite signal name is the required entry in the "Name of Signal" field.

If the entered name already exists in the selected branch, the signal is not created, the
"Composite Signal Configuration" dialog stays unchanged and the following error dis-
plays.

Figure 1-34: Warning message - name already exists

If the field is empty and you click "OK", the following error message displays.

Figure 1-35: Warning message - name invalid

Enter or select composite signal branch

A composite signal branch is the required entry in the "Branch" field. The filed is popu-
lated with the existing branches.

It also allows you to enter a new one. If you enter a new branch name, the signal is
created under the new branch node. If it is for changing or viewing, the branch from the
composite signal is automatically selected.

If you click "OK" with this field empty, the following message displays.
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Figure 1-36: Warning message - branch invalid

Select single or multiple device type

The selection of single or multiple device type is the requested entry in the "Multiple
Device" field.

The filed is populated with two choices:
● "Yes", which indicates that the signal involves multiple devices.
● "No", which indicates that the signal involves single device.

There are three signal device type categories:
● Independent Signal

The signal is independent and has no interference with any other types, such as
GPS and Error Message.

● Mobile Signal
The signal involves mobile type of devices, such as any UE. A mobile device does
not work as scan type of signal.

● Scan Signal
The signal involves scan type of device. A scanner does not work as UE type of
signal.

If you want to create a composite signal that involves both Mobile and Scan type of
devices, select "Yes" in the "Multiple Device" field. Otherwise, select "No".

If "Yes" is selected, the "Device" column is present in the composite signal component
grid. If "No" is selected, the column is not present.
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Figure 1-37: Different layout of grid dependent on selection

Source signal tree

A source signal tree is located in the "Signal" pane of the "Composite Signal Configura-
tion" dialog.

The figure shows UE type of source signals.

Figure 1-38: UE type of source signals

PRACH is not a leaf signal, but a branch and therefore cannot be dragged to the grid.
PRACH Tx Power is a leaf signal and can be added/dragged to the grid.

Filter source signals

The "Filter" field is located above the source signal tree. It allows you to enter string to
filter the signals you want to be shown only. The figure shows the filtered result with
filter string equal to "Scan".
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Figure 1-39: Selected branches that correspond to filter criterion

Composite signal components grid

The figure shows an empty and one populated composite signal components (CSC
grid) grid.

Figure 1-40: Empty and one populated CSC grid

The grid contains components for creating the signal expression.

The CSC grid has the following columns:
● "Var"

Variable name in CSC grid that represents this row item and is used in expression,
for example, A.

● "Type"
● The type of signal category, for example, LTE MOBILE or LTE SCAN.
● "Device"

It is a drop-down column available only if the "Multiple Device" selection is "Yes".
The list contains entries labeled "Device 1" to "Device n", where n is the set maxi-
mum number of devices for each technology in the "Tools" > "Preference" >
"Advanced Settings" page, see Figure 3-165. You can choose a device from the
list.

● "Unit"
It is the unit that is used in the expression calculation. Before calculation, the signal
value is always converted to frame unit and then to the chosen unit.

● "Data"
Allows for the entry of test data that can be used to test the configured expression.
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Preserved the top signal component rows
The grid preserves four top signal component rows. They cannot be deleted. For a new
signal, "Var" field is populated with A, B, C and D. The "Delete" operation only applies
to four non-top signal rows.

Add new row to CSC grid
The "Add" button is always enabled.
Click the button to a new to the grid. The "Var" field is automatically populated with the
next available name, alphabetically from A to Z.
It is case insensitive. So A = a. Totally 26 variables can be used. If the number of vari-
ables exceeds 26, R&S ROMES4 generates the error message "Too many rows in
grid".
A source signal can be added to and only to an empty row.

Delete row from CSC grid
The "Delete" button is enabled only if there are non-top4 rows.
If there are highlighted non-top4 rows in the grid, clicking the button deletes them. If
there is no highlighted row in the grid, clicking "Delete" deletes the last non-top4 row if
any.

Erase content of highlighted CSC grid row
Click the "Erase" button to erase content of the highlighted signal row, so that a source
signal can be added to this row.
Note: Source signal cannot be added to a row that is occupied.

Add source signal to CSC grid

To display leaf signals, expand the source signal tree.

Drag a desired signal from the source signal tree to the empty grid row. In this way cre-
ated is a composite signal component.

Device selection is necessary for multiple device type.

Clear test data

Click  to clear all currently entered test data from the "Test" column.

Generate random test data

Click  to generate random test data for all currently configured component signals.
The data generated is a random value between the signals low expected range value
and high expected range value.

Figure 1-41: Generated random test data
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Once the data is generated and if the expression is valid, the result of plugging the
data into the expression is displayed in expression result field.

Figure 1-42: Expression result field

If there is a current data in "Data" field, a prompt is shown asking if to clear the cur-
rently existing data.

Click "Yes" to clear the currently existing data and replace it with the new random data.

Click "No" to leave the current data in place and only generate the new data if there is
no test data entered.

Composite signal expression

Composite Signal Expression is the arithmetic expression used to produce a result for
the composite signal.

The expression consists of Variables and Operators.

Variables are linked to R&S ROMES4 signals in the "Composite Signal Components"
grid. There are two types of variables that can be used in the expression.

● Single variables
● Vector variables

Operators are divided to those ones valid for single variable and for vector variables.
Operators are shown in Table 1-4 and Table 1-6.

Single variables

Single variables occur when a single R&S ROMES4 signal is linked a variable name.

As an example considers the case where a comparison of 5G SS_RSRP and LTE
RSRP is desired. 5G SS_RSRP is assigned to the variable name of "A" and LTE
RSRP is assigned to the variable name of "B". An expression of A-B would subtract the
5G SS-RSPR from the LTE-RSRP to produce the result for the signal.
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Figure 1-43: Example of single variable

Expressions containing single variables are only calculated if all signals associated
with the variables in the expression are valid. In the above example if 5G SS-RSRP or
LTE RSPR is invalid, then the composite signal is invalid.

Vector variables

Vector variables are assumed if a single variable is associated with multiple R&S
ROMES4 signals.

Vector variables are used if arithmetic operations are to be done on a list of signals
were not all signals in the list are valid at the same time.

As an example, consider the case of attempting to calculate the total bandwidth for a
5G mobile. To calculate the total bandwidth, add the primary cell and 4 secondary cell
bandwidth signals to a composite signal. If each signal where to be given a different
variable name and an expression of "A+B+C+D+E" used to calculate the bandwidth,
then primary and all secondary cells must all be valid before a total bandwidth can be
calculated.
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Figure 1-44: Calculation of available bandwidth with single variables

The result in the example is most likely not the desired one as the total bandwidth can/
should be calculated with just the valid cells. By using a vector variable, the calculation
includes only the valid cells. The example can be changed to a vector variable by
assigning the primary and secondary cells with the same variable name.

Click the variable name in the "Var" column and use the drop-down menu to select the
variable name.

Figure 1-45: Example with vector variable

The resulting vector can then be passed to a valid arithmetic function to produce a
result using only valid values. For our bandwidth example, the expression is "sum(A)".
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Figure 1-46: Example solution with vector variable

If only primary cell and secondary cell 1 and 2 are valid, then only those cells are used
in the calculation of the bandwidth. If at any point in the measurement secondary cell 3
becomes valid, it is automatically included in the calculation. If primary and all secon-
dary cells have invalid results, the bandwidth also has an invalid result.

Mixing single and vector variables

Vector and single variables can be used in the same expression.

For example, assume a vector variable "A" is configured and a single variable "B" is
also configured. The expression of "sum(A) – B" can then be used to add up the
results of all valid items defined in vector variable "A" and subtract the value of "B" from
the result. For the calculation to be done, the single variable "B" must have a valid
result and at least one member of the vector variable "A" must have a valid result.

If a vector variable is used with an operation that does not support vector variables, the
expression still passes the validity check done by R&S ROMES4. In this case, only the
first valid member of the vector is used in the calculation.
For example, if a vector variable "A" is defined and single variable "B" is defined and
an expression "A+B" is used, then the first valid member of "A" would be added to the
value of "B".

Operators
Table 1-4: Operators valid for single variables

Basic operators +, -, *, /, %, ^

Equalities & Inequalities =, ==, <>, !=, <, <=, >, >=

Logic operators and, mand, mor, nand, nor, not, or, shl, shr, xnor, xor, true, false
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Basic operators +, -, *, /, %, ^

Functions abs, avg, ceil, clamp, equal, erf, erfc, exp, expm1, floor, frac, log, log10,
log1p, log2, logn, max, min, mul, ncdf, nequal, root, round, roundn, sgn,
sqrt, sum, swap, trunc

Trigonometry acos, acosh, asin, asinh, atan, atanh, atan2, cos, cosh, cot, csc, sec, sin,
inc, sinh, tan, tanh, hypot, rad2deg, deg2grad, deg2rad, grad2deg

Example: 
Table 1-5: Expressions using single variables

A+B Added variable A and B

A-B Subtract variable A from B

A/B Divide variable A by B

Sum(A,B,C,D) Sum of A, B, C and D

Avg(A,B,C,D) Average of A, B, C and D

Table 1-6: Operators valid for vector variables

Functions avg, max, min, mul, dot, dotk, sum, sumk, count, all_true, all_false,
any_true, any_false

Example: 
Table 1-7: Expressions using vector variables

Sum(A) Sum of all members in the vector variable "A"

Avg((A) Average of all members in the vector variable "A"

Min(A) Minimum value of all members in the vector variable "A"

This list of valid operations can also be accessed from within "Composite Signal Con-
figuration" window by hovering mouse over the expression edit box or clicking the 
button next to the "Clear" button.

Figure 1-47: Available operators
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1.10.4.6  Composite signal expression fields

The "Composite Signal Configuration" pane of the "Composite Signal Expression" dia-
log is shown in the following figure.

Figure 1-48: Expression entry fields

Composite signal expression validity indicator

The expression edit box shows different background color to indicate whether the
expression is valid.

● If the entered expression is complete and valid, the box shows green background.
● If the entered expression is invalid, the box shows red background.
● If the expression box is empty, the box background shows no color indicator.

Function list

The expression functions field is on the right-hand side of the "Composite Signal
Expression" pane, see the previous figure. The function list is a list of the available
functions that can be used in the expression. Hovering the mouse over a specific entry
pops-up a help entry for that function containing the definition of the function and an
example of the syntax.

Figure 1-49: Selected function and syntax example

Double-click a function name to insert the function name in the expression edit field at
the current location of the cursor.

Clear composite signal expression

Click  to clear the content of the expression edit filed.
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Calculate test data button

If the currently entered expression is valid, the  icon appears. Click this button to
update test data result if test data has been entered into the test data column.

If the current expression is invalid, the  icon appears. Click the button to bring up a
message with details on the error causing the expression to be invalid.

Test result field

The test result field shows the current result of the expression when using the data
configured in the "Test" column. The color of the result field corresponds to where the
result falls on the configured color scale for the composite signal. If test data is not con-
figured or the expression is not valid, then "N/A" appears in the field.

Figure 1-50: Result of composite signal expression

If the result falls outside of the currently configured minimum or maximum range, the
results are nevertheless shown. The message indicates if the value is out of range high
or out of range low.

Figure 1-51: Case the result is out of range
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Set low/high range buttons

The  set the current value of the composite signal to the minimum and maximum
range value, respectively.

Expression help button

Click  to clear the content of the expression edit filed. The action pops-up the window
which helps a composite signal setting.

Figure 1-52: Enter signal name

Show/hide function list box

Click  to show and hide the function list box, respectively. The action shows the
"Composite Signa Expression" pane as following.

Figure 1-53: Pane layout offering opening the function list
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Figure 1-54: Pane layout offering hiding the function list

1.10.4.7  Composite signal properties

The "Composite Signal Properties" pane of the "Composite Signal Configuration" dia-
log is shown in the following figure.

Figure 1-55: Composite Signal Properties pane

Select composite signal color scale type and make change

The pane is where you choose or change the color scale type of a composite signal.

The "Color Scale" button launches a color scale dialog for customizing color scale.
Click the button to get the dialog where you can change the color and the range of a
signal.

The "Select Color Type" edit box is populated with default color scales.

Figure 1-56: List of default color scales

While the list is opened
● Use the up/down key to preview color scale without selecting it,
● Use mouse to select a color scale from the list. The selected one is populated in

the preview bar on the left, or
● Cancel the selection process without changing it by selecting the "Select Color

Scale Type" line or pressing the [ESC] key.
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If the value text is too long, it shows blank. Resizing the dialog gives more space to
show the hidden text.

If composite signal range min or max is changed, the color scale preview bar is
refreshed.

Range minimum

Enter the composite signal range minimum in "Range Min.".

This value must be less than composite signal range maximum. If you change the
value, the corresponding color scale changes accordingly.

Range maximum

Enter the composite signal range maximum in "Range Max.".

This value must be greater than composite signal range minimum. If you change the
value, the corresponding color scale changes accordingly.

Composite signal unit

The "Unit" is a drop-down list populated with the predefined units and a unit from the
current composite signal. Click the arrow of the list to see all default units.

If the composite signal unit does not exist, you can insert the unit to the unit list.

Select a desired unit from the list or enter a new unit. If a new unit is entered, it is
added to the unit list. Select "no unit" if blank is desired.

Composite signal precision

The "Precision" entry shows the number of displayed decimal points when the result of
the composite signal is displayed in a generic view.

1.10.5  Supported file formats

In the following sections listed are the file formats which R&S ROMES4 uses in addi-
tion to those measurement and workspace file formats described in Chapter 1.10.2,
"Workspace and measurement files", on page 31.

The formats which are not listed are not shown in the Topic-Structure in Acrobat
Reader.

1.10.5.1  Export formats

Data stored in a measurement (*.rscmd) file can be exported to files with special data
formats and be used in other applications. Several ASCII and other export formats
(*.txt, *.asc, *.mif, *.pcap, *.csv) are available, depending on the system con-
figuration. Moreover, it is possible to export the layer 3 messages stored in a measure-
ment file during replay.
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A detailed description of file export and export formats can be found in Chapter 7,
"Data processing", on page 2098.

1.10.5.2  View result of export format (*.csv)

Several views support the export of the displayed data to a *.csv (comma-separated
values) file that can be opened and processed by MS Excel. The contents of the Excel
lists and the delimiters (commas, semicolons etc.) are view-dependent. To adjust MS
Excel to the current delimiters of the *.csv file, use the MS Excel "Data" > "Text to
Columns" wizard.

1.10.5.3  Image files

In the "ROMESMAP Route Track View" arbitrary bitmap files (*.jpg, *.bmp, *.pcx,
*.png, *.tif, *.gif) can be loaded and superimposed to a background world map.
The bitmaps can be positioned onto the world map with a set of coordinates which are
stored in a *.tab file, a short text file assigned to the bitmap. A detailed description of
a bitmap positioning can be found in Chapter 4.3.3.6, "Maps menu", on page 606.

1.10.5.4  Wave files

R&S ROMES4 allows wave (*.wav) files to use for the following purposes:

● Announcement of an event by an acoustic signal.
For this purpose the wave files have to be selected in the "Available Events" menu,
see Chapter 3.8.1.3, "Available events configuration", on page 238.

● Announcement of an error or warning regarding the overall state of a loaded device
by acoustic signals.
The error or warning sound is played whenever the overall state of the loaded
device is red or yellow, respectively. The sound is played only during measurement
or recording. See "Audio alarms for device states" on page 256.

● Speech Quality measurements (SQA).
The wave file is used as reference file and test file. Furthermore, the R&S
ROMES4 allows sound files from measurement files (*.rscmd) in wave format
*.wav to export.

● Fully integrated device use mode
LU.ini file supports the wave format of recording settings - the file includes WAV
file storing.

1.10.5.5  SC color files

In some of the scanner views, a color scale can be loaded from an SC color file
(*.scc).

The user-defined color scales can be stored to *.scc files to be reused in a later ses-
sion.
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1.10.5.6  ASCII export configuration file

If exporting measurement data to an ASCII file, the export configurations can be stored
to a *.rma file and reused later.

1.10.5.7  BTS list and network database files

Base station data provided by a network operator can be imported from the BTS list
(*.txt) or ASCII table description (*.atd) file with definite file formats, see Chap-
ter 7, "Data processing", on page 2098. Information on the base stations can be viewed
in several views, for example, in the alphanumeric view or ROMESMAP Route Track
view, see Chapter 4.2.3, "Alphanumeric view", on page 466 and Chapter 4.3.3,
"ROMESMAP route track view", on page 562, respectively.

Click "Tools" > "Transmitter Database". The "Base stations" dialog opens where you
can select the base station lists.

The information on base stations is imported to a network database file for internal use.
It is possible to edit the data within a network database and export data to a new BTS
list (*.txt).

Table 1-8: Supported file formats

Technology File extension

5G NR nrdb

LTE ltedb

UMTS umtsdb

GSM gsmdb

CDMA cndb

TETRA tdb

WiMAX wmdb

Basic concepts of R&S ROMES4



Getting startedDrive Test Software

67Operating Manual 1171.6415.12 ─ 66

2  Getting started
The following chapter presents a sample session with R&S ROMES4. The aim of the
chapter is to provide a quick overview of the most important functions and configura-
tions.

The tests include:
● Chapter 2.1, "Preparations", on page 67 (i.e. startup of the system, configuration

of the used hardware, loading a database containing system and network data)
● Evaluating the measurement results

The steps to perform are explained via the required menus and the screenshots of the
obtained results are shown. We also point out alternative settings and related mea-
surements which could not be reported in detail.

Chapter 2.2, "Measurement examples", on page 72 contains short operating sequen-
ces from various R&S ROMES4 applications.

2.1  Preparations

● Starting R&S ROMES4........................................................................................... 67
● Loading devices...................................................................................................... 68

2.1.1  Starting R&S ROMES4

The R&S ROMES4 is an application that runs under the MS Windows 10.

Figure 2-1: R&S ROMES4 start icon

Double-click the icon on your desktop to start up R&S ROMES4.

The R&S ROMES4 opening page shows that the R&S ROMES4 SW is a part of the
R&S SmartOne. While starting up, shown is the SW version, the date of SW issue, the
percentage of loaded devices and the currently running processes.
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Figure 2-2: R&S ROMES4 splash screen

The background processes related to scanning the connected hardware are visualized
during the startup of R&S ROMES4.

The background processes related to scanning while opening some measurement file
are also visualized, see Chapter 3.2.8, "Open measurement file", on page 112.

2.1.2  Loading devices

The devices as mobile phones, positioning systems or scanners have to be recognized
and supported by R&S ROMES4 before the measurement starts.

In general, the used test mobiles are connected via COM port 1 and the GPS receivers
with NMEA interface connected via COM port 2 of the controller.

To load a device, perform the following steps:

1. Select the "Hardware" > "Connect/Disconnect" entry of the R&S ROMES4 toolbar
menu.
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Figure 2-3: Hardware menu

The "Hardware Configuration" window opens.
The window shows a list of all devices which are supported by R&S ROMES4. The
list varies according to chosen options of the coverage measurement system.

2. For a mobile device setting, select one in the "Available Devices" > "Mobile Devi-
ces" branch.

Figure 2-4: Devices supported by R&S ROMES4

3. Select the manufacturer of your mobile device.

4. Click the  button to initiate the loading.
The "Assign Serial Port" window shows the COM ports assigned to the mobile
device. Set the Port 1.
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Figure 2-5: Assign the port to device

5. If the COM port 1 is not set, select it from the combobox.

6. Click "OK".
A progress bar appears to show the initialization of the mobile device.
After initialization, the loaded device is shown in the "Hardware Configuration" >
"Loaded Devices" pane.

7. Click "Available Devices" > "Navigation" to get the list of the navigation devices that
R&S ROMES4 supports.

8. Select "NMEA GPS" from the list.
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Figure 2-6: NMEA GPS device

9. Click the  button.

10. To load the device, proceed as described in step 5.

11. Assign the NMEA GPS device to COM port 2.

12. Click "OK."

The device is loaded.
The "Loaded Devices" pane displays the correctly loaded devices together with the
other previously loaded ones.

Figure 2-7: Loaded devices

13. Click "Continue" to confirm your choice. The action also closes the "Hardware Con-
figuration" window.
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2.2  Measurement examples

The following sections are intended for a quick introduction to typical measurement
tasks, listing the steps necessary to set up devices, obtain, display and interpret the
basic results. The examples are taken from different R&S ROMES4 options and tech-
nologies.

● Test mobiles............................................................................................................ 72
● UMTS scanner........................................................................................................ 80

2.2.1  Test mobiles

After connecting the mobile to the host PC and selecting the network providers, per-
form the steps like previously mentioned to load it. Qualcomm chipset-based test
mobile devices are loaded in a same way. The R&S ROMES4QP, R&S ROMES4QC or
ROMES4SAM option is required for Fully integrated devices (QualiPoc) and On PC
testing (Classic mode) devices.

The following example shows starting measurements with the Samsung chipset-based
test mobile SM-G950F. To run tests related to quality of service with the mobile device,
select the analyzer in the "Quality of Service" branch.

1. Click "Hardware" > "Connect/Disconnect".

The "Hardware Configuration"windows pops-up.

2. Select "Mobile Devices" > "Samsung Chipset (Phone)" and double-click.

Measurement examples



Getting startedDrive Test Software

73Operating Manual 1171.6415.12 ─ 66

Figure 2-8: Selection of Samsung device

The "Assign Serial Port" window pops-up and displays the found COM port as it is
autodetected.

3. Click "OK".

R&S ROMES4 shows all connected test devices. In our example only one is avail-
able.
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Figure 2-9: List of connected devices

4. Select the mobile device.

5. Click "OK".

It is loaded and displayed in the "Hardware Configuration" > "Loaded Devices"
pane.

6. Click "Continue" to confirm your choice and close the window.

The Samsung device is also assigned to the "Hardware" menu as an entry.

7. Double-click the "Data Quality Analyzer" or "Speech Quality Analyzer" in the "Qual-
ity of Service" branch.

The analyzer is loaded and shown in the "Hardware Configuration" > "Loaded
Devices" pane.

8. Click "Continue" to confirm your choice and close the window.

The analyzer is assigned to the "Hardware" menu as the QoS or SQA menu item.

9. Click the item.

The "QoS"/SQA window pops-up where you can select a job for execution and test.
See Figure 2-11.

Now you can use the mobile device for measurements.
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Figure 2-10: Loaded Samsung device and QoS analyzer

You can select a mobile device mode of operation as On PC testing (default), Fully
integrated device (QualiPoc, also abbreviated as QP) and iPhone.

1. Default setting does not assume a voice call. Configure the voice call with a Fully
integrated device (QP).
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Figure 2-11: Selecting voice call

2. Select the "Auto Dialing" tab of the SM-G950F window.

Figure 2-12: Service configuration

3. In the "Actions" pane, select "Dialing"

4. Enter a phone number to dial. It is a number where the call is accepted automati-
cally, i.e. your mobile mailbox. It is useful to run periodical calls to get the maximum
amount of measurement data, "Mode" > "Multi Cal".

5. Close the menu with "OK".
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6. Now start recording.

Figure 2-13: Menu to start recording

The recording starts in idle mode. You can see provider, connected cell, channel
numbers and several measurement results in the "3GPP Overview View".

The call is established.

In the following figures displayed are some available mobile views.

The following two figures show the "3GPP Overview View" for the different states of a
mobile device and measured parameters.
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Figure 2-14: Power and quality results - UMTS

Figure 2-15: Power and quality results GSM

The "Layer 3 View" shows all Layer 3 messages and also the messages from the NQA
state machine (in red color, if any).

Measurement examples



Getting startedDrive Test Software

79Operating Manual 1171.6415.12 ─ 66

Figure 2-16: Layer 3 messages view

In the Layer 3 view you can see the whole call from start to end. If it could be estab-
lished and held active until the end of the configured call duration, it is regarded as a
"Good Call". Double-click a message opens the window displaying the detailed mes-
sage content.

In the "Cell Set View" you can see which cells are in the neighbor set.

Figure 2-17: Cell set view - neighbor cells

The "ETSI QoS View" shows listed calls performed during the measurement.
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Figure 2-18: ETSI QoS view

To finish the recording, select "Measurement" > "Stop".

2.2.2  UMTS scanner

The R&S TSME WCDMA device is used for the UMTS network analysis and control.

At a UMTS scan, the test device measures and identifies all UMTS downlink (NodeB)
signals in the air. The main purpose of this measurement is to test the receiving condi-
tions of a mobile in an UMTS network and to analyze possible interferences.

Like any other R&S ROMES4 measurement, the UMTS measurements require con-
nected scanner device and its parameters set before you can start the measurement
and evaluate the results.

Connecting the R&S TSME to R&S ROMES4 as UMTS PNS

1. Click the "Hardware" > "Connect/Disconnect" in the menu bar to open the "Hard-
ware Configuration" dialog.

2. Expand the "Network Scanner TSME" item by clicking the "+" node in the "Availa-
ble Devices" list.

3. Double-click "TSME WCDMA" for the WCDMA scanner or click the  button to
initiate the scanner loading.

The selected scanner is loaded and displayed in the "Loaded Devices" pane.

4. Click "Continue" to confirm your choice. The action also closes the "Hardware Con-
figuration" window.

The loaded device is added to the "Hardware" menu entries.
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Configuring the UMTS PNS

After having added the scanner, perform the following:

1. Go to "Hardware" > "R&S UMTS PN" to open the configuration menu. In the exam-
ple, the four German operators are configured. For outside of Germany, modify the
names, frequency, UARFCN and UMTS band accordingly.

Figure 2-19: UMTS PN scanner page

2. Activate all channels with the check box in the first column.

3. By default, only SIB type 3 is configured which provides the Cell Id (CI). To get the
Location Area Code (LAC), activate SIB type 1 for all channels, and SIB type 11 to
get the neighbor cells list.

Measurement examples



Getting startedDrive Test Software

82Operating Manual 1171.6415.12 ─ 66

Figure 2-20: List of activated SIBs

TopN pool settings

Let us have a look at the Top N pool settings.

Select "TEC for UMTS PNS" > "Top N Settings".

By default, one pool with the eight strongest cells of all measured channels is config-
ured.
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Figure 2-21: Scanner Top N Settings

It is useful to identify the strongest cells of all providers. There are settings to get the
strongest cells of a single provider.

To get this information, proceed as following:

1. Select the manual pool configuration in the "Top N Settings".

2. Click "Add" to add a second pool. For the Top N pools setting, see "Top N pools"
on page 326.

The default "Top N Pool Settings" page opens where you can manually set the sec-
ond pool.
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Figure 2-22: Scanner Top N Settings - Adding additional pool

3. Let us pick T-Mobile in this example up. Select the "Sort" > "Yes" option to get a
sorted list.

4. Click "OK" to save the settings.
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Figure 2-23: Set of two Top N pools

Now there is one pool with all providers and one with T-Mobile only.

5. Click "OK" to save the settings.

The observation interval is modified automatically if necessary. Confirm with "OK".

Figure 2-24: Info on changed observation interval

If the views are not configured automatically when loading the scanner, let us configure
some views to display the data during measurement.

1. Select "View" > "Scanner Views" > "UMTS".
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2. Select, for example, BCH view, CPICH view and Top N view of the UMTS scanner
available views.

Figure 2-25: View selection

3. Use the "Tile_vertical" or the "Tile_horizontal" button to arrange the views automati-
cally on the screen.
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Figure 2-26: Selecting a UMTS scanner view

4. Start the recording with "Measurement" > "Start"

The views getting filled. In the "UMTS Scanner Top N View" you can see the stron-
gest cells. As we have configured SIB type 1 and 3, we can see also information
on CI and LAC.

Figure 2-27: Obtained measurement results

Measurement examples



Getting startedDrive Test Software

88Operating Manual 1171.6415.12 ─ 66

5. Switch between the pools by selecting from the "Top N" pull-down list.

The following figure shows the measurement results of just two configured cells, so
there are just two members in the pool.

Figure 2-28: Measured cells

Hover the mouse over the column names to get explanations on the parameters in
each column.

In the "CPICH View" you can see the average signal power of the received signals
separately for each provider. In the left table the signals are distinguished by scram-
bling code (SC). Each entry is a separate NodeB. In the right table, the signals are dis-
tinguished by their slot timing which is different in case there are several signal paths
because of reflections. In the example, NodeB with SC = 367 is received in three
paths.
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Figure 2-29: CPICH View

Successfully decoded MIB and SIBs messages are shown in the "BCH View".
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Figure 2-30: BCH View

Based on this information, it is possible to analyze if the neighbor lists are matching
with the measured coverage. The matching is detected, if the scanner finds all cells
included in the neighbor lists and the additional cells, not in the list but are potential
neighbors.

To display data in other than UMTS scanner specific views like, for example, "2D Chart
View" the parameters are also available in the general parameter tree. The parameters
of the Top N pool members are available by default.

Now go to "View" > "Basic Views" > "2D Chart View" and open the configuration menu.
You can select parameters from the Top N pools or for a specific scrambling code of a
provider.
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Figure 2-31: 2D chart view configuration page

Example: 
Ec/Io of pool 1/rank 1 (red line) and its SC (green line), and NodeB with Scrambling
Code 379 of 2132.6 MHz (blue line). At the position of the blue marker, the NodeB SC
379 is rank 1 of the pool, so the values are identical and the blue graph covers the red
one. For different SC of rank 1, the Ec/Io values are different too as they come from
different NodeBs. The blue and the red graph does not overlap.

Figure 2-32: Measurement Ec/Io results

Stop the measurement with "Measurement" > "Stop".
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3  User interface
This chapter describes the R&S ROMES4 interface elements and their use. Starting
the application opens the main window with all its working components. Which compo-
nents are active depends on the loaded workspace.

● Menus and commands............................................................................................92
● File menu.............................................................................................................. 103
● View menu............................................................................................................ 134
● Hardware menu.....................................................................................................190
● Technologies menu............................................................................................... 211
● Measurement menu.............................................................................................. 212
● Replay menu.........................................................................................................217
● Tools menu............................................................................................................223
● Window menu....................................................................................................... 414
● Help menu.............................................................................................................416

3.1  Menus and commands

The R&S ROMES4 main window consists of the elements described in this chapter. An
example of the main window layout is shown in the following figure.
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Figure 3-1: R&S ROMES4 main window - example

1 = Title bar
2 = Menu bar
3 = Toolbar and Measurement bar
4 = Docking window bar
5 = Work area with active views, subdivided into several view areas
6 = Status bar

The configuration of active elements, example given, the bars on the left-hand side of
the window and the views is described in Chapter 3.3, "View menu", on page 134.

3.1.1  Menu bar

The R&S ROMES4 menu bar with various menu titles is located below the title bar
along the top of the screen.

Selecting a command from one of these menus performs an action, displays a sub-
menu or a dialog. The menus, including dialogs that call for an explanation, are descri-
bed in this chapter.

Nine menus in the menu bar are used to access the functions and windows, which
configure and control measurements and evaluation of the measurement results.

The following menus are available:
● Chapter 3.2, "File menu", on page 103
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Opens and saves workspace and measurement files, exports and prints data and
closes the application.

● Chapter 3.3, "View menu", on page 134
Customizes the main application window and offers the view windows used to visu-
alize and evaluate measured data.

● Chapter 3.4, "Hardware menu", on page 190
Offers to load devices necessary for a wanted measurement.

● Chapter 3.5, "Technologies menu", on page 211
Displays information on the installed technology modules. For several technolo-
gies, the menu contains particular configuration panels.

● Chapter 3.6, "Measurement menu", on page 212
Starts and stops a measurement and displays the list of event settings.

● Chapter 3.7, "Replay menu", on page 217
Starts and stops the replay of a measurement file and allows setting device filters.

● Chapter 3.8, "Tools menu", on page 223
Customizes displays and defines directories for the different type of files used by
the measurement system. Furthermore, it customizes the internal database for
analysis of different RAT's data, e.g. Carrier to Interference (C/I).

● Chapter 3.9, "Window menu", on page 414
Arranges and handles the different view windows.

● Chapter 3.10, "Help menu", on page 416
Provides online help and general information on the coverage measurement sys-
tem.

3.1.2  View area

There are two tabs for the work area selection in the status bar of the R&S ROMES4
GUI.
● "Welcome"

Starting the R&S ROMES4 program with default settings shows the "Welcome"
area.

● "View Area"
Starting the R&S ROMES4 program with your views and settings stored to a file.
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Figure 3-2: Open UE view area

Saving and loading view areas
You can save your view area with all views and their settings to a file and reuse it in a
later session. You can also save one or more view areas that are loaded automatically
when R&S ROMES4 starts, see Chapter 3.3.6, "View areas", on page 158.

For the R&S ROMES4 tools provided to configure different working elements of the
main window and the views, see Chapter 3.9, "Window menu", on page 414.

Welcome
The "Welcome" view area allows quick access to the most important software configu-
rations and easier measurements setup. The screen offers the lists of recently used
workspaces and measurement files on the left-hand side and the currently connected
(available) devices on the right-hand side.
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Figure 3-3: R&S ROMES4 welcome view area

All three lists have buttons of the same size. The size of buttons is not adaptable which
implies that it does not change with the change of the screen size.
The "Available Devices" list starts with the "Missing Devices" button which provides
information and hints about trouble shooting devices detection problems.
Double-click the button opens the "Missing Devices" troubleshooting dialog. The dialog
gives the user hint about possible causes for connection problems and short links to
the trouble shooting tools.
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Figure 3-4: Missing devices dialog

Other icons under the "Available Devices" let you load device associated to the icon.
To select a device for measurements supported by R&S ROMES4 from the list, click
the "Add Device Manually" icon. The "Hardware Configuration" dialog pops-up.
Selecting this option also activates the Place Holder feature. The feature lets you con-
figure the R&S ROMES4 measurement workspace, scanners, mobile and GPS devi-
ces without attaching actual devices to PC on which R&S ROMES4 is running. For the
feature description, see Chapter 6.1.13, "Place holder", on page 1503.
If you click the "Add Devices to Workspace" icon, displayed is the "Load multiple Devi-
ces" dialog which improves the measurement setup with several devices. For how to,
see Chapter 3.4.3, "Simple hardware loading via workspace", on page 208.
Instead of loading device with its default values, you can choose to load it by starting
an associated wizard or the template settings.
There are two rows in the "Choose the initial Setup for your Device" dialog related to
two groups of the configuration (loading) possibilities.
● The upper row shows the available basic configurations, which are:

– Open configuration after having loaded the measurement
– Apply R&S ROMES4 wizard to the measurement

● The lower row shows custom pre-configured measurements, which are:
– Templates for the measurement
– Wizard profiles, which can be applied for the measurement
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Figure 3-5: Selection of the initial setup

Note: The list of available devices and use cases is only displayed if the software is
not in "Replay Only" mode.
After a measurement is loaded successfully, R&S ROMES4 offers several options to
start the measurement in the "Choose your next step" page.
● Start measurement now
● Return to the "Welcome" page
● Stay on the current sheet
● Add indoor navigation
● Add GPS navigation
During the measurement execution, the "Welcome" area displays the most important
items of the current measurement process, like the state of the current measurement
and the state of loaded devices.
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Figure 3-6: State of current measurement

Second View Area
The second view area appears, if selected, empty (only the view area name present in
the center). You can fill it with one or several views, see Chapter 3.3, "View menu",
on page 134. One of the views is always active and displayed with a highlighted title
bar. This approach gives the possibility to customize the view and work with it.
The view area can be divided into different superimposed view areas to gain more
space and arrange the views in different groups. Each view area has a name and is
accessible by clicking the associated tab in the status bar below the view area. For
faster changing the view area, click the drop-down arrow to open an overview of all
available open view areas. Click the target view area to change the view.

A right-click on one of the tabs opens a context menu with self-explanatory entries.

For the complete list of views, see Chapter 3.3, "View menu", on page 134.
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Move a view to another view area ← Second View Area
Suppose that a view area contains a view of a view type that can be opened several
times.
To move the view from the current area to a target area, use one of the following meth-
ods:
● Right-click the view and click "Move to – <Target View Area>" in the context menu
● Open the target view area and select the view type (e.g. "Alphanumeric View: 1") in

the "View" menu
A dialog window opens.

Click "Move View" to move the current version of the view to the other view area.

Create new view of the same type ← Second View Area
Suppose that a view area contains a view of the view type that can be opened several
times.
To create view of the same type (for example, "Alphanumeric View:2") in another view
area, use one of the offered options:
● Right-mouse button click the existing view to open the context menu, click "New

View" and then move the new view to the target view area.
● Open the target view area and select the view type (e.g. "Alphanumeric View: 1") in

the "View" menu
A dialog window opens.
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Click "Create new View" to create view of the same type at the other view area.

3.1.3  Coupled focus

Many views provide graphical tools to highlight special areas and read a particular
result. Examples are:
● Marker line and the info field in the "2D Chart View"
● Circular focus in the "ROMESMAP Route Track" view

The following figure illustrates them.

Figure 3-7: Examples for coupled focuses

The focus can be coupled in several views, which makes it easier to analyze different
aspects of a coverage measurement at a particular position using a set of appropriate
views. The coupled focus synchronizes the views in the current view area and synchro-
nizes, if necessary, also the views which become later visible. All views in other areas
are left unsynchronized.
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The Figure 3-7 figure shows as example a local maximum of the RxLevFull reported by
the test mobile in the "2D Chart View". The "ROMESMAP Route Track" view shows the
corresponding geographical position.

The following tools control the coupled focus:
● The mouse cursor or the arrow keys move the focus within the view. To obtain dif-

ferent step widths, combine the [arrow keys] with the [<SHIFT>] and the [<CTRL>]
keys.

● During the Replay Pause, the coupled focus is always enabled and cannot be dis-
abled. The color of the coupled focus cursor changes to green. When the Replay
Pause is released, the replay continues from the point in time where the last cou-
pled focus was set to.

If no coupled focus is available for a view, the message <<not synchronized>> is dis-
played in the title bar.

3.1.4  Docking bars

The user can group, move and dock the R&S ROMES4 bars.

By default the bars are docked to the vertical left edge of the R&S ROMES4 main win-
dow, see Figure 3-1.

Enable or disable a R&S ROMES4 bar

1. Click the menu "View" > "Toolbars".
A list with all available toolbars appears.

Figure 3-8: Available toolbars
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2. Select the bar you want to be displayed in the R&S ROMES4.

The related window of the selected bar is docked on the left-hand side of the R&S
ROMES4 window.

Move R&S ROMES4 bar

1. To float the displayed toolbar window, click the header of the window.

2. Move the window away from the docking position.
During dragging the window, some icons appear in the R&S ROMES4 window.

3. Drop the window at one of those icons.
The window docks to the appropriate edge.

Make the R&S ROMES4 bar permanently visible or hide automatically.

Docked windows can be permanently visible or they can be hidden automatically.

► Use the pin  in the header of window to change this property.

The following sections describe some docking windows. For all, refer to Chapter 3.3.4,
"Toolbars", on page 138.

3.2  File menu

The "File" menu opens and saves workspace and measurement files, exports and
prints data and closes the applications.
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Figure 3-9: File menu

The "Mergers/Converters" menu item has own submenus, see Chapter 3.2.12, "Merg-
ers/converters", on page 119.

3.2.1  New workspace

The "File" > "New Workspace" menu item opens the R&S ROMES4 default workspace,
see Chapter 1.10.2, "Workspace and measurement files", on page 31.

The workspace opened when R&S ROMES4 starts depends on the setting in the
"General" tab of the "Preferences" menu. R&S ROMES4 uses either the last work-
space used in the previous session or the default workspace. When opening the last
used workspace, different view windows open tiled across the main window. The main
application window size of the previous session is preserved.

User-defined workspaces can be stored to a workspace file <filename>.rsxks and
recalled in later sessions. The matching control windows can be easily set for each
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kind of measurement. The operator's favorite constellations can be saved and reused
later.

3.2.2  Open workspace

The function loads an existing workspace from a *.rsxks or a *.rscmd file.

The "Open Workspace" command calls up the "Open" dialog.

Figure 3-10: Load workspace file

Select the workspace file from the list to load the existing workspace.

Several loading options are offered after opening the workspace file, shown in the
lower part of the "Open" dialog figure. Not all loading options are by default active but
they can be selected if you need them.

The workspace of a measurement file can be loaded as well, see Figure 3-16.
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Usage of older workspace files
The *.rms and *.rsxwks workspace files of measurement software versions 3.0 to
3NG Rev.1 SP2 cannot be used in newer R&S ROMES4 versions as their format is dif-
ferent. If an old workspace (*.rms and *.rsxwks) is loaded into R&S ROMES4, the
system responds with an error message.

Cancel Filename Resolver
During loading a workspace, R&S ROMES4 tries to find all files which are associated
with the workspace. Depending on the number of files, looking for them can take up to
several minutes, especially if a file cannot be found on the computer. It is possible to
cancel this process and to continue loading the workspace. The cancelation only can-
cels the automatic reassignment of the files. The workspace is loaded with all files,
which are at the path the workspace has stored.

File list
The file list shows all files within the current directory with the extension (*.rsxks or
*.rscmd) selected in the dropdown box on the lower left side.

Click one of the files in the list to enter it in the "File name" window.

File name
A file selected from the file list is entered in this field. Alternatively, enter the file name
manually.

Open button
"Open" opens and loads a workspace. Alternatively, double-click a workspace file in
the list of workspace files.
During the workspace loading process, R&S ROMES4 checks for the availability of the
associated files. R&S ROMES4 searches for all files not found at the specified location
within the R&S ROMES4 directory. The resulting dialog displays the list of those files.
You can use the proposed files or browse manually for the files new search location.

Cancel button
"Cancel" discards the file selection.

Files of type
Only files of the type selected in this field are shown in the file list.
The following file types can be selected:
● Workspace files (*.rsxks)

Standard workspace file type containing the workspace but no measurement data.
● Measurement files (*.rscmd)

Measurement file created with an R&S ROMES4 version (e.g. 3NG) contains the
workspace created at the time when the file was recorded ("Start Recording").
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All workspaces and templates created with the R&S ROMES4 3NG Rev.1 SP1 or
higher contain the name of the device, with which the setup was created. If a template
was created with other device than the currently connected one to the R&S ROMES4 a
warning pops-up. Some devices (for example, the Qualcomm chipset-based devices)
also check for the device connection. If device is not connected, a warning is displayed
during the loading of the workspace.

Load hardware
A workspace can be loaded with or without the hardware required for the measure-
ment. Loading without hardware is faster and sufficient and suitable for replay ses-
sions.

R&S TSME loading from workspace
If you try to load a workspace with the R&S TSME scanner and it cannot be found on
the indicated IP address, R&S ROMES4 offers the following options:
● Continue loading the workspace without the device.
● Enter manually a new IP address of the device that you want to be used.
● Use the device automatically detected by the R&S ROMES4.
At the failure of the R&S TSME loading process, appears the usual dialog which allows
you to retry or to specify new links. Specify a new IP address for the mentioned device
and for each device separately.

Force Assign New Links
An additional option of the load workspace file dialog allows new physical device links
of each device to be specified during the loading process. The option is helpful, if the
workspace has been transferred from another computer with other physical link of a
device.

Load Signal Settings, if available
Once checked, the available signal settings for the workspace are loaded.

Load Event Settings, if available
Once checked, the available event settings for the workspace are loaded.

Load Databases of Workspace
Once checked, the databases for the workspace are loaded. Otherwise, the loading of
the workspace does not affect the current configuration of the databases.
Note: Loading a most recent workspace, loads always the previously used workspace
file.
As only one workspace configuration can be active at one time, the current workspace
is closed before a new one is opened. Before closing the workspace, R&S ROMES4
displays the following message:
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● "Yes" saves changes and closes the current configuration.
● "No" closes the current configuration without saving.
● "Cancel" returns to the current configuration.
If a workspace file cannot be located, assign a new file using the file resolver dialog.
R&S ROMES4 finds an appropriate file and enters the file automatically into the dialog
in this case.

Figure 3-11: Editing workspace automatically

If a new valid workspace file is not assigned, loading of the non-existing file is not tried.
R&S ROMES4 continues working by using the former loaded files. In this case an error
message appears in the "Output" view:
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Figure 3-12: Some error messages

3.2.3  Reload workspace

Reloads a workspace file.

3.2.4  Save workspace

Saves a workspace file with its current name.

3.2.5  Save workspace as

Saves a workspace file with a new name and directory. The "Save Workspace As"
command calls up the "Save As" dialog.
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Figure 3-13: Saving workspace

This dialog is analogous to the "Open" dialog, see the previous description.

Choose a file name with the extension *.rsxks and a directory of your choice to save
the current workspace for later use. If a file name is entered manually without exten-
sion, *.rsxks extension appends automatically.

3.2.6  Create project

The "Create Project" item is dimmed in the "File" menu as long as a device is not loa-
ded. Load the device, to activate the Create project function.

To create a R&S ROMES4 project, configure the R&S ROMES4 for your task. Load
devices you need and open all views, which are necessary. For such created project,
choose location on your PC disk to put the project file. R&S ROMES4 automatically
creates a project file (*.rsproj), which contains:

● All loaded devices
● All views that are opened on any "View Area"
● All technologies that are used by the loaded devices
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Figure 3-14: Saving the created project

If only a subset of views, technologies and devices are available in R&S ROMES4, a
setup can be created via the "File" > "Create Project" command. Such a project
reduces the number of modules that R&S ROMES4 loads during the startup. In that
way minimized is the overall startup time and the complexity of the menus/dialogs
which are filled with information concerning the modules.

3.2.7  Import / export workspace

R&S ROMES4 allows the creation of a *.zip file containing the Workspace and all
related files except geosets and maps due to potentially large size.

The exported workspace files always contain the complete R&S ROMES4 signal
description.

The import creates a directory which has the name of a ZIP file containing workspace
file you want to import. The workspace file *.rsxks is stored In this directory. All files
located in the R&S ROMES4 directory branch are stored at the same file location on
the target system. All other files are copied into subdirectories in the created work-
space directory.
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3.2.8  Open measurement file

Click  ("Open Measurement File") or [Ctrl+S] to call up the "Open" dialog. In the dia-
log browse for a measurement file you want to play.

The selected measurement file is replayed if the "Start Replay" command in Chap-
ter 3.6, "Measurement menu", on page 212 is executed. It is also used as a default file
for exporting.

Figure 3-15: Extended Open dialog

The upper part of the dialog is analogous to the one used to open a workspace file,
see Chapter 3.2.2, "Open workspace", on page 105. The left dropdown box offers to
open a measurement file having one of the following file formats, as supported by R&S
ROMES4:

● SQC format
● RSCMD format
● SQZ format
● MF format

If you select to open a SQC (SmartBenchmarker measurement) file or a QualiPoc SQZ
file, conversion or merge is internally performed in R&S ROMES4. The result is written
into a R&S ROMES4 compatible SQC file, which opens afterwards. The original file is
renamed to *.orig.

Several loading options are offered after opening the file, shown in the lower part of the
"Open" dialog figure. Not all loading options are by default active but they can be
selected if you need them. The "Open Measurement File Option" dialog contains the
same loading options. The dialog pops-up when the selected measurement file is
opening.
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Figure 3-16: Options when opening measurement file

Loading an indoor measurement file always loads the referenced indoor floorplans,
independently on the also loaded workspace.

Open as read-only
If "Open as read-only" is checked, the measurement file opened is protected so that
the file contents cannot be overwritten.

Load Workspace of Measurement File
A measurement file is loaded with or without the included workspace. Loading with the
included workspace allows R&S ROMES4 reconfiguration.
Before the workspace is loaded, R&S ROMES4 asks if the current settings have to be
saved. Click "Cancel" to avoid saving and to load the included workspace of the mea-
surement file immediately.
If an "Untitled" workspace is the current active workspace, the "Load Workspace of
Measurement File" function is checked by default.
Note: Loading a "Most Recent Workspace" always loads the databases.

Load Transmitter Databases of Workspace
A measurement file is loaded with or without the databases specified of the included
workspace.
By default the option is not checked. For further details, refer to "Load Databases of
Workspace" on page 107.

Load the Top N Configurations of the Workspace
If checked, R&S ROMES4 loads the Top N configurations of the workspace.
The loading overwrites the currently used Top N configuration. In case a backup of the
current configuration is required, do save it as a template from the concerning technol-
ogies menu.
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Load the Mapinfo Geoset (GST) of the Workspace
Note: This functionality with MapX/MapInfo is only available if the MapX is still instal-
led. The functionality is available if the program is running on your computer as being
installed in some previous version of R&S ROMES4.
Loading of MapInfo GST from the workspace with the custom overlay maps is possible
by checking the "Load the Mapinfo Geoset (GST) of the Workspace" option. This load-
ing is recommended instead of loading it from the indoor maps. The choice is stored in
the registry.
The "Load the Mapinfo LM (.lmxml) of the Workspace" check box is available on the
following dialogs:
● "Files" > "Open Measurement File" > "Open"
● "Files" > "<Recent measurement file>" > "Open"
● "Files" > "Open Workspace" > "Open"
● "Files" > "<Recent workspace file>" > "Open Workspace Options"
The main usage of this option is loading GST with special overlay maps.

Scan for File Set
If checked, R&S ROMES4 searches the selected folder for additional files which are
parts of a file set. All measurement files of the same set have the same file Id visible in
the file info window.

Figure 3-17: Scan for file set

Load Events of the Workspace
If checked, the events of the workspace are included in the measurement file.
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File Info
Information stored with the measurement data of the selected file is displayed in the
lower half of the "Open" dialog, see Chapter 3.2.10, "Measurement file info",
on page 115.

File scan
R&S ROMES4 automatically scans the data, sorts the time stamps and extracts geo-
graphical information during opening a measurement file. After the scan, the entire
measurement route can be displayed in Chapter 4.3.3, "ROMESMAP route track view",
on page 562.
To disable the file scan, press the [Ctrl] key while opening the file or disable the mea-
surement file scanning option in the "Preferences" > "General" window, see Chap-
ter 3.8.1.1, "General settings", on page 224.

3.2.9  Close measurement file

Closes the current measurement file.

3.2.10  Measurement file info

Displays the file information of the current measurement file.

The file information is identical with the information displayed when a measurement file
is opened, see Chapter 3.2.8, "Open measurement file", on page 112.

Included information is:
● Time zone, date and time of the started measurement. For R&S TSME, added is

the information on calibration date and the self-alignment date.
● User-defined comment
● User name, vehicle type and ID, the file length in blocks, and the duration of the

measurement.
● PC system Information, for example, operating system type (32 bit or 64 bit) and

CPU information (available and total physical memory)
● Path alias and current values of registry keys which are defined via "Tools" > "Pref-

erences" > "Advanced" > "Information Recorded to Measurement".
Therefore, the state of the operating system while the measurement was made is
stored.

● Used devices (for example, the R&S GSM NWS and R&S GPS devices) and the
most important devices' settings made before the measurement was started, see
the chapter "Hardware components".
Device settings such as the "Meas. Mode" of a mobile device, the frequency and
trigger settings are essential for the type of recorded data and the available views.
Relevant information, for example, is:

● Uplink Interference information in the BCH demodulator part (necessary is to check
"Uplink Interference Measurement", otherwise the line is omitted).

● Information about the band name and the used band classes for CDMA2000
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● Wideband and/or MIMO measurement information.
● TETRA 2 measurements shown as "Yes" or "No".

3.2.11  Welcome page

There are two displays of the R&S ROMES4 "Welcome" page.

The R&S ROMES4 opening page after starting up the application relates to the phase
which precedes measurements.

The second one is present during measurements.

3.2.11.1  Welcome page after R&S ROMES4 opening

After R&S ROMES4 startup, the "Welcome" page opens containing the following three
areas.

● "Recent Workspaces"
● "Recent Measurements"
● "Available Devices"

Figure 3-18: Welcome page after R&S ROMES4 opening

Recent workspaces

The "Recent Workspaces" area shows a list of recently opened workspaces.

The opened workspace files are marked with colored bars placed in front of them. The
meaning of the colors is:

● Bar is missing - the workspace that does not contain a device
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● Blue bar - the workspace contains device which does not support auto detection
(for example, TETRA handset)

● Red bar - at least one device is missing
● Yellow bar - scanner is available, but does not have the required amount of fron-

tends
● Green bar - all devices are available

Recent measurements

The "Recent Measurements" area shows a list of recently opened measurement files.
The files are not marked with the bars.

Available devices

All available devices, i.e., the devices connected to the PC which R&S ROMES4 is
running on, are shown in this area. The icon on the top of the list is related to the trou-
bleshooting function if a device detects a problem, see Figure 3-4.

Figure 3-19: Welcome page - available devices

The fully integrated QualiPoc devices are displayed grayed out in the "Available Devi-
ces" list if their "Ready to load" state is unavailable. If the devices are in the "Ready to
load" state, they are displayed as other devices.

The "Indoor Navigation" function offers the possibility to use a GPS in "GPS plus
Indoor" mode.
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Figure 3-20: Available GPS plus indoor and loaded QP device

The availability of the "GPS plus Indoor" mode is indicated with the presence of the
"GPS Navigation" icon in the "Welcome" page. If the GPS device is not connected, and
the associated icon is not present, the "Indoor Navigation" function loads the Indoor
device only.

Figure 3-21: Selection of indoor navigation mode

Choose the "Indoor Only" option for the Indoor device. The indoor option is necessary
if you use the unreferenced maps.

If both indoor and outdoor measurement are performed, recommended is to use the
combined mode, the "GPS plus Indoor" function.

3.2.11.2  Welcome page during measurements

The "Welcome" page shows the state and the measurement values of each connected
device during an active measurement.

Available devices in this case are shown in the status bar of the R&S ROMES4 main
window.

The tab on the left-hand side of the title bar of a particular view in the work area shows
the status of a measurement and device. One tab for each connected device is shown,
see Figure 3-1.

The tabs show the name of a device/scanner and the bar color above depends on the
state of the device.
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The colors indicate the following device states:

● Green - state OK
● Yellow - warning
● Red - error

The bar's color of a scanner is triggered by the worst state of the involved scanner.

If necessary, the displayed data for each device can be changed by adapting the fol-
lowing files in the widget folders of the MyROMES directory:
● UEWidgetView.xml for the UE "RF Summary" tab.
● ScannerSummaryWidgetView.xml for the "Scanners" tab

You can create the Widget folder. Copy the files from the application folder and then
adapt the files to your needs.

R&S ROMES4 always tries to load from the MyROMES directory first. The content
of ...\My ROMES\Configuration\WelcomePage.xml is ignored.

3.2.12  Mergers/converters

R&S ROMES4 supports merging of measurement files of different formats and conver-
sion of indoor measurement files generated by QualiPoc devices.

The "File" > "Mergers/Converters" menu command has the following items.

Figure 3-22: Supported merging function

3.2.12.1  Merge speech quality land unit files

This merging function merges the measurements of the land unit with the R&S
ROMES4 measurement files. Land unit files which can be merged must be of SQZ for-
mat. The MF format is not supported.

The measurement files of the land unit must be copied into a folder which R&S
ROMES4 has rights to read.

Select the "Merge Speech Quality Land Unit Files" entry of the "Mergers/Converters"
menu to get the merging dialog.
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Figure 3-23: Merge Speech Quality Land Unit Files dialog

The File Merger function can also be started from the console. The executable file
name is SQPolqaFileMerger.exe. The file is located in the same directory as the
Romes.exe file, see the following figure.
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Figure 3-24: Location of the SQPolqaFileMerger file

The merger must be started with the following command-line options:

-s "<ROMES Measurement File Name>"
-d "<Land Unit File Directory>"

Example: 
SQPolqaFilemerger.exe -s "c:
\MyRomes\measdata\polqa1.rscmd" -d "c:\LandUnitFiles"
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ROMES Measurement Files
In the "Merge Speech Quality Land Unit Files" > "ROMES Measurement Files" pane
select the R&S ROMES4 measurement files that you want to merge.
Click the "Add File(s)" button to get the "Open" dialog for selection of the R&S
ROMES4 measurement files to be merged.

Figure 3-25: Open dialog

The selected files populate the "ROMES Measurement Files" area of the "Merge
Speech Quality Land Unit Files" dialog.
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Figure 3-26: Files added for merging

Click the "Remove" button to remove a selected file from the list. Multiple selections
are possible.

Land Unit
Click the "Browse" button in the "Land Unit" pane to open the "Browse to Folder" direc-
tory selection dialog. Select the directory where the land unit files are stored. R&S
ROMES4 remembers the last selected directory.
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Figure 3-27: Directory selection dialog

Merge Status
Click the "Merge File(s)" button to start merging the files. Merging function recognizes
the corresponding land unit measurement files with the measurement ID stored in the
R&S ROMES4 measurement file header.
When all selected files have been merged, a summary is displayed in the "Merge Sta-
tus" list.
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Figure 3-28: Status of the merging

The merged files have the suffix _merged. If the target file name with the _merged
suffix already exists, a sequenced number is appended to the file.
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Figure 3-29: Selected merged file

Merging again an already merged file is not possible. The merged file gets an entry in
the file header.
The "Cancel" button cancels the files merging.
Click the "Close" button to close the "Merge Speech Quality Land Unit Files" dialog.

3.2.12.2  Merge measurement files with QualiPoc files

R&S ROMES4 supports merging and conversion of several measurement files gener-
ated by QualiPoc devices.

An existing *.rscmd measurement file can be merged with *.mf/*.sqz files gener-
ated by mobile devices operating in QualiPoc mode.

It is possible to merge several measurement files generated at different time by the
same device. The QualiPoc files in this case are distinguished by a different time in the
filename. If at merging of several subsequent measurement files of the same QualiPoc
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device a measurement file takes longer time and a max. file size or max. time is
reached, the R&S ROMES4 recording switches to subsequent files. The subsequent
files are named with the same filename appended by 001, 002, and so on.

R&S ROMES4 also supports conversion of QualiPoc indoor measurements. The con-
version is supported, if a SmartBenchmarker file (*.sqc/ *.sqz) has indoor measure-
ments.

► Click the "Merge Measurement Files with QualiPoc Files" entry in the "Mergers/
Converters" menu.

A window opens where the files to be merged can be selected.
It is possible to select multiple *.mf/*.rscmd files. In this case, for each *.rscmd
file is checked whether a *.mf/*.sqz file or multiple of the *.mf/*.sqz files can
be merged with the *.rscmd file. If N *.rscmd files are selected for merging with
M *.mf/*.sqz files, the result of merging is N *.rscmd files.

Figure 3-30: Files merging

You can open the created file directly after the successful merging using the "Open
Merged File and Close" button.

Only *.mf/*.sqz files with start- and end-time in between the start- and end-time of
the *.rscmd file can be merged.
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The QualiPoc NCM function merges optionally a *.rsmcd file into a *.sqz file from
the QualiPoc, which then contains the mobile data.
The merge procedure merges the *.rscmd file of the obtained *.sqz file with the
included *.mf file. In this case it is not necessary to specify a source folder for
the*.mf file in the merge dialog.
The merge procedure merges the *.rscmd file of the obtained *.sqz file.
After a successful merge, the merged *.rscmd file opens.

The following sections describe the parameters in the merging page.

GPS Selection when more then one GPS is available
If GPS is available in the R&S ROMES4 measurement file and in one or more Quali-
Poc measurement files. Select which GPS data that you want to be used in the merged
file.

Default is "Automatic Selection".
The decision criteria for the default selection are:
● If Indoor is used, the GPS data with Indoor to be used
● The GPS data with the most valid position data per minute to be used.

Add File(s)
Allows selection of the RSCMD files to merge them with QialiPoc files.

Remove
Removes the selected RSCMD file from the list.

Browse
Selects the directory where the QualiPoc files are stored.

Merge File(s)
Starts the merging process. The selected RSCMD files are merged with QualiPoc
measurement file, whose start- and end-time are in between the start- and end-time of
the RSCMD files.

Cancel
Cancels the merging process.

Open Merged File and Close
Opens the merged file directly. The button is available only if at least one file was suc-
cessfully merged. If more than one file was merged, the last successfully merged file is
opened.
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Merge Status
The list box shows the current progress of the merging process.

3.2.12.3  Merging/converting QualiPoc files of selected UEs

R&S ROMES4 offers you the possibility to select which UEs to be included when
merging or converting QualiPoc files. For this purpose, available is the UE selection
dialog.

Figure 3-31: Dialog for selecting UEs for merging/conversion

1. Select UEs which measurement files that you want to convert in the shown dialog.

2. Click the "Start Conversion" button.

The steps of the conversion are displayed in the "Status" pane.

At the end of the conversion, the new created measurement file is automatically
displayed.
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An UE measurement can be split into more than one file. In such a case, the start time
of each measurement file is added as a suffix in the UE selection dialog.

Figure 3-32: Measurement of selected UE split into two files

3.2.13  Export measurement files

Exports and saves measurement data for later evaluation, for example, with another
application.

For details and an example, refer to Chapter 7.2.2, "Export procedure", on page 2100.

3.2.14  Export measurement file info

Writes the file information of several measurement files to a single text file.

The file information is identical with the information displayed when a measurement file
is opened (see Chapter 3.2.10, "Measurement file info", on page 115).

It is exported in two steps.
● Step 1: The "Export Measurement File Info(s) command" opens a file "Open" dia-

log to select the measurement files.
● Step 2: After file selection, the "Open" button calls up a "Save As..." dialog to

select a file name (*.txt) and a directory for the file information.

The file information on the individual files in the *.txt file forms the separate consec-
utive sections. Each section starts with the name and path of the measurement file,
e.g.

************D:\RuS\Romes\MeasData\dvb-test4.rscmd**********

If an R&S ROMES4 measurement file is exported, the file extension is *.rscmd, older
measurement files keep the *.cmd extension.
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The text file can be regarded as a catalog providing an overview of a whole archive of
measurement files. If it is viewed with a suitable text editor using functionality such as
the text search function.

3.2.15  Print

[Ctrl + P]

Prints the contents of the active view.

The Print option is an alternative to taking screenshots via the clipboard (see chapter 7
"Data processing"). R&S ROMES4 uses the standard "Print" menu familiar from other
MS Windows applications. Printing to a file or a configurable printer with selectable
page numbers is possible. For details use the context-sensitive help.

To control the appearance of the hardcopy, a preview option is provided; see Chap-
ter 3.2.16, "Print preview", on page 131.

3.2.16  Print preview

Shows a preview of the hardcopy to be created.

The "Print Preview" command opens a window showing one page (our example shows
a section of such a page).

Figure 3-33: Print preview layout

The icon bar contains icons that control the preview and printout. The icons functions
are listed in the following table, the order is from left to right.
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Command Description

"Print" Print the previewed file with the current printer settings

"Next Page" Show next page (if applicable, otherwise grayed)

"Previous Page" Show previous page (if applicable, otherwise grayed)

"Toggle
One/Two Pages
display"

Show two pages (if applicable, otherwise grayed)

"Zoom In" Magnify current page by a factor of 2 (2 steps possible)

"Zoom Out" Reduce scale of current page by a factor of 2 (2 steps possible)

"Close" Close the window without printing

3.2.17  Print setup

Modifies the printer settings.

R&S ROMES4 uses the standard "Print Setup" menu familiar from other MS Windows
applications. For details use the context-sensitive help.

3.2.18  C:\...*.rsxks

Opens one of the workspace files saved before.

A maximum of four workspace files numbered 1 to 4 are listed in this field.

The "File" > "Open Workspace Option" dialog of the workspace files offers an addi-
tional option in comparison to the standard MS Windows file dialogs.

Figure 3-34: Dialog which opens a recent workspace

Load the Top N configurations of the Workspace
To avoid overwriting the current Top N configuration with the one inside the workspace,
the related box needs to be unchecked before loading, see the Figure 3-34.
The Workspace file load unchecking option is always possible before loading a file,
also if loading from a *.rscmd file.
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The option is available on four different dialogs where workspaces or *.rscmd files
are loaded. In the Figure 3-34 an example of the dialog which opens a recent work-
space is shown.
The unchecking option works as expected for GSM / LTE / TETRA / UMTS, sharing the
base software solution of Top N.
The CDMA and WiMAX technologies are different. If the Workspace file load option is
set not to load the Top N settings from the Workspace, the default setting is used.

3.2.19  C:\...*.rscmd (or *.cmd)

Opens one of the measurement files used before.

A maximum of four measurement files numbered 5 to 8 are listed in this field.

The RSCMD file header shows the scanner types which the R&S TSME supports.

The currently open measurement file is replayed when the "Start Replay" command in
the Chapter 3.6, "Measurement menu", on page 212 is executed. It is also used as a
default file for exporting, see Chapter 3.2.13, "Export measurement files", on page 130.

The "Open Measurement File" dialog offers the option to the standard Windows file
dialogs. A dialog allows you to configure the same options as available in the normal
file open dialogs.

Figure 3-35: Open measurement file options

3.2.20  Exit

Closes the application.

Before closing, R&S ROMES4 issues a warning if there are unsaved changes to the
currently active workspace.
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3.3  View menu

The "View" menu customizes the main application window and offers the view windows
used to visualize and evaluate measured data.

Figure 3-36: View menu

The selection of the view windows is determined during R&S ROMES4 installation.
The selection depends on the system configuration and the available options.

In the "View" > "Toolbar" select the tool bars that you want to be shown. The bars are
located in the horizontal line on the top or on the vertical left border of the R&S
ROMES4 opening page.

3.3.1  Lazy views

To improve the startup and replay performances, only a subset of views is created dur-
ing the R&S ROMES4 startup. The views that are not created are identified in the
"View" menu. They have an asterisk next to their names.
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Figure 3-37: Available views in Basic Views

Views that are not created upfront, so-called the "Lazy Loaded Views", do not retrieve
any measurement data until they are displayed. That means, it is a good practice to
open the views required in measurement mode before starting the measurement.
Some views that display more data than recently measured like chart views, cannot
display all information, but start displaying measurement data once they are visible.

During replay and file scanning, the views can be created at any time. Data is delivered
to those views to fill them correctly. Data filling can require a rescan of the file. If it is
necessary to display more views at a time, use the "View" > "Show / Hide Views" dia-
log to create a set of views in one row.

By using the XML profile files, it is possible to change the lazy loading strategy for each
view. For example, if you want the "3GPP Overview View" automatically created, but
not displayed, change in the RomesProfiles.xml file the line.

<RomesView Name="3GPP Overview View" MinProfile="1" Tec="GSM"/>
to

<RomesView Name="3GPP Overview View" MinProfile="1" Tec="GSM"
DelayLoad="false" />

3.3.2  Full screen

Maximizes the main application window to full screen size.

The toolbar, the measurement bar and the status bar are hidden in full screen mode.

3.3.3  UI theme

The view customization and multiple themes are not supported. Instead, in "View" > "UI
Theme" you can select light or dark mode for your dialogs.
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Figure 3-38: UI Theme entry

Example is given for the "ROMESMAP Route Track View".
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Figure 3-39: R&S UI theme for ROMESMAP

Not all dialogs currently support these two modes.

The "UI Theme" entry contains option to change the icon size. Changing the icon size
applies only for the main toolbar icons and takes place immediately. All other icons are
of fixed size.
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3.3.4  Toolbars

Available toolbars are displayed/hidden if selected/deselected respectively in the
"View" > "Toolbars" menu.

The same content is displayed if right-mouse click any point on the Menu bar.

Figure 3-40: Available toolbars

File Bar
Displays and hides the toolbar of the main application window.

Figure 3-41: Available toolbars in View

The toolbar forms the left part of the upper margin of the main window and offers con-
trols for the most common program tasks. Otherwise, offered are in the "File" and
"Help" menu and in the context menu of the main application window.
Table 3-1: Function of the buttons in the toolbar

Control Menu command Shortcut

1 Create new workspace Ctrl N

2 Open an existing workspace Ctrl O

3 Save the active workspace Ctrl S
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Control Menu command Shortcut

4 Open RSCMD File for Replay  

5 Close RSCDM File  

6 Toggle Coupled Focus Ctrl Y

7 Hold / Release all views (stops the measurement display for closer examina-
tion without stopping the measurement)

 

8 Add / Remove Hardware Modules Ctrl H

9 Configuration of active View F12

10 Show / Hide Signal Tree  

11 Auto Arrange View  

12 Preferences (opens "Preferences" page)  

13 Step One Data Set Forward (active in "Replay" mode only)  

14 Pause Replay (active in "Replay" mode only) Shift

15 Stop (active in "Replay" mode only)  

16 Restart Replay (active in Replay mode only) F8

17 Toggle Replay Speed / Full Speed (active in Replay mode only)  

18 Replay Speed (active in Replay mode only)  

19 Toggle Recording  

20 Stop (Measurement mode) F6

21 Configuration of Indoor Input F8

*: Scrollbars are only visible if "Window" > "Manage Window" is disabled.
The following two figures show the effect of resizing the virtual desktop. The tiles are
split and arranged within available desktop space.
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Figure 3-42: DQA views before the resize

Figure 3-43: DQA views after the resize

Auto Arrange
The Auto Arrange feature is hold per worksheet. Once activated, it arranges the views
without overlapping and keeps that arrangement during resize of R&S ROMES4.
To illustrate how to use the Auto Arrange feature:
1. Arrange the views roughly as you like.

View menu



User interfaceDrive Test Software

141Operating Manual 1171.6415.12 ─ 66

Figure 3-44: Freely arranged views - feature inactive

2. Activate the feature.

Figure 3-45: Arranged views - feature activated

While in Auto Arrange mode, sizing one side of a single view rearranges all visible
views so that the complete worksheet is covered.
The Auto Arrange mode is switched off if:
- Button is triggered again.
- One view is resized on two sides, so that automatic rearrangement is not clear.
- One view is minimized or moved.
- Standard function such as "Cascade" / "Tile horizontal" / "Tile vertical" / "Arrange" is
called.
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- It is not clear, how the views can be arranged.

Measurement Bar
Displays and hides the measurement bar of the main application window.
The measurement bar offers controls for the most common program tasks for the mea-
surement task. The complete list of measurement commands is available in the Chap-
ter 3.6, "Measurement menu", on page 212.

Figure 3-46: Measurement bar

Replay Bar
Displays and hides the replay bar of the main application window. The replay bar dis-
appears during measuring tasks. If the measurement task is stopped, the replay bar is
again visible.
The replay bar controls the common replay program tasks. The commands are also
available in Chapter 3.3.5, "Replay control", on page 156 dialog.

Figure 3-47: Replay bar

For the functions of the controls, see Table 3-1.

Status Bar
The status bar forms the lower margin of the main window.
It shows and hides the general status of the R&S ROMES4 application on the left-hand
side of the bar ("Ready" status).
This "Ready" status is replaced by other information when the mouse hovers over
menu or toolbar buttons of the main window.
The status bar contains additional information ("Status of Measurement/Replay") on
the right-hand side which changes dependent on whether a measurement or replaying
is on.
● In the left-hand part of the status bar you see "Ready" or a short description of the

function of a control element in the menu/toolbar.
– Select the menu item description by the pointer or the cursor key or, simply

click the item.
– Toolbar button description is selected by the pointer (arrow points to the button)

or click with the left mouse button.
● The middle part of the status bar contains the view area control tabs ("Welcome",

"View Area", etc.).
● The next field of the status bar indicates the free disc space available for storing

measurement data. During a measurement or during recording, the time elapsed
since the start of the measurement is also shown. In addition, the data rate which
is being written to the measurement file during recording is indicated.
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● The last right-hand field of the status bar gives the status of data processing. It
indicates the status of the current temporary working data set. Possible messages
in this part are:

Message Description

Ready Ready for measuring or data processing

Replay Data measured before and stored to a measurement file are being processed and loa-
ded

Replay Pause Replay process paused

Measurement file
open

Status of measurement/replay. When replaying, shows amount of left data or replayed
blocks.

Measuring Measurement running (without data recording)

Recording Measurement and data recording running

The view area control allows changing the order of the views simply by drag & drop.
Click the tab of the view that you want to move. Drag the mouse to the place where
you like to insert the view area while keeping the left button pressed.
Also, the names of the view areas can be edited in the tab control. Double-click the tab
and enter the new name.
The fields in the right-hand part of the status bar indicate which of the following keys
are latched:

Indicator Description

CAP The Caps Lock key is latched

NUM The Num Lock key is latched

SCRL The Scroll Lock key is latched

The status bar can be hidden to enlarge the main application window. A check mark on
the left-hand side of the menu item indicates that the status bar is displayed.

Link Bar
Displays and hides the link bar of the main application window.
The link bar shows additional software applications available for the R&S ROMES4.
Otherwise these tools are accessible via the "Tools" submenu of the R&S ROMES4
program menu.

Control Menu command

Start the tool R&S Device Manager

Output Bar
Displays and hides the "Output" docking window.
The "Output" window shows the status messages generated by the R&S ROMES4
application.
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Figure 3-48: Output window - replay messages

The window contains the "Save" button to save the output file to the RTF file format. If
pressed, a file dialog appears to save the content of the "Output" window.
Click "Save" to save the status messages as an RTF file. Click "Clear" to clear the cur-
rent content of the window.

Figure 3-49: Output window - ROMES messages

In the drop-down list of the "Output" window you can select the following messages for
display:
● ROMES messages
● Internal messages
● Messages of the currently opened measurement file, the section "Replay"

Signal Tree Bar
Displays and hides the docking window "Signal Tree" in R&S ROMES4.
The "Signal Tree" pane is placed in one of the docking windows.
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Figure 3-50: Signal Tree window

All signals within a tree's branch appear once for each technology.
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Figure 3-51: Signals under the one branch

This approach requires a device configuration dialog which allows that the device
appears in a view when a signal is dragged or configured for use in the view.

Figure 3-52: Configuration dialog for device

The list of devices shows all available devices for the selected signal of a technology.
You can select one or more devices for use in the target view. The dialog allows selec-
tion of a limited number of devices. The limitation depends on the requirements of the
particular view that is being configured.
If the view limits the number of devices for selection, a message appears next to the
"select all" and "remove all" icons. The message indicates the maximum number of
allowed device selections.
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Figure 3-53: Limitation symbols - select all/remove all

If the maximum allowed device selection is one, the check box list behaves like a radio
button selection. If you click a check box next to a device while another device is
checked, the last one mentioned device is unchecked and the newly selected one
checked.
If the maximum allowed device selection is greater than one, once the maximum num-
ber of devices is reached, a currently selected device must be deselected. In that way
allowed is the selection of a new device.
To select all devices, click the "select all" icon. To deselect all selected devices, click
the "remove all" icon.
Note: If the maximum number of allowed devices is less than the number of available
devices, the "select all" icon is disabled.
Checking the "Apply for all signals" box, applies the device selection to all currently
selected signals. If the check box is unchecked, the selected device is the default
device for the next selected signal.
The following views are affected by the described approach:
● 2D Chart View
● Device Grid View
● Grid View
● Statistic View
● Statistic Histogram View
● XY View

Shortcut Bar
Displays and hides the docking window "Shortcuts" in the R&S ROMES4. The window
shows several R&S ROMES4 functions that let you fast access to them.

View menu



User interfaceDrive Test Software

148Operating Manual 1171.6415.12 ─ 66

Figure 3-54: Shortcut bar docking window

Devices Bar
Displays the "Devices" window, which includes the devices connected to R&S
ROMES4 and their states
The state of a connected device is indicated with a colored circuit icon on the left side
of the device. Green icon indicates correct state of the loaded device. If the icon is yel-
low or red colored, the warning or error overall state of the device is detected, respec-
tively. If the Audio Alarms feature for a device status is activated, detection of these
states generates also an audio alert, see Chapter 3.8.1.5, "Notification center",
on page 254.
The window shows all available and recognized test devices.
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Figure 3-55: Devices window

Click with the right-mouse button the selected device to see device's details.
The functions of the buttons on top of the "Devices" window are described in the fol-
lowing table.
Table 3-2: Meaning of the buttons in the Devices window

But-
ton

Description

Configure device

Disconnect selected devices from R&S ROMES4

Force a rescan of the connected device.

Opens the Add/Hide Hardware dialog

Opens one of available Wizards
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But-
ton

Description

Automatically opens Views, which are recommended for loaded devices

Recognized devices are not connected automatically to R&S ROMES4

How to install devices, refer to Chapter 6.1.1, "Devices manager", on page 1448.

User Grid Bar
"User Grid Bar" displays and hides the user grid which can be configured by the user.

Figure 3-56: User grid docking window

The buttons available in the window are:
●  - deletes the currently selected configuration
● - saves current grid configuration to as profile with the given name
●  - opens the configuration dialog

The dialog allows the number of rows and columns to be specified in the grid.

Figure 3-57: User grid settings

Each cell can contain a fixed text, that is, the name of a signal or the value of a signal.
To enter a fixed text, double-click the cell and enter the text.
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To show the value of a signal, drag & drop the signal from the signal tree to the cell. If
you want that the name of the signal is displayed instead of the value, press the CTRL
key while dropping the signal to the cell.
The configuration can be stored with the name of the combo box. Users can select a
different configuration by choosing another entry of the combo box.
The grid configuration is not stored to the workspace file. The grid configuration is
stored in the MyROMES\Configuration folder of the current user.

The "User Grid" is always on top of the normal R&S ROMES4 views.

Touch Helper Bar
Displays and hides the docking window "Touch Helper", providing a better usage of
touch screens.

Figure 3-58: Touch helper docking window

R&S ROMES4 offers the possibility to define buttons for certain commands, see Chap-
ter 3.8.1.11, "Touch helper", on page 277. The configured buttons are then placed in
the "Touch Helper" bar, which can be pinned to the screen if necessary.

TCM handling
For TCM handling, use the extra tool which is a part of Windows Tray.
To open the detailed TCM view, use the tray icons menu of a module.

Figure 3-59: TCM tray icon menu

Select the "Open TCM" option.
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The TCM dialog is shown on the left hand-side of the R&S ROMES4 "Welcome" page.

Figure 3-60: Devices names as QP unit names

The "ROMES TCM" dialog displays TCM devices' names as the QP unit names if
available.
The dialog contains the section related to RPC, as it has its own sensors for tempera-
ture control. Four check boxes "Aux 1" to "Aux 4" are created for switching on/off the
12 V ports of the RPC device.
For the TCM installation, see Chapter 6.4.1.1, "Prerequisites", on page 1513.

Background Processes
If the "Background Processes" context menu is checked, the window shows running
background processes, if any.
R&S ROMES4 uses concurrent processes to improve performance. These tasks and
their state are visualized in the "Background Processes" window. The window opens if
you click the same named bar.

Figure 3-61: Background process window

The progress dialog is available for scanning attached hardware, opening a new mea-
surement file or compressing the file.
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Figure 3-62: Progress dialog scans measurement file

The previous figure illustrates the progress dialog ability to display all concurrent
entries.

Time Line
The timeline control gives you a fast feedback on the loaded measurement file, the
data available in it and an easy possibility to navigate though the time range. It pro-
vides the tool for quick jump to a certain time in the measurement.
Click the "Time Line" command to open the "TimeLine" window.

Figure 3-63: TimeLine window

The timeline control is set visible automatically when a measurement file is loaded. It
displays all loaded devices (scanners and mobiles) and their respective events if not
filtered away. The control allows the time position to access, set and zoom into a time
range. While running a replay, the zoomed area follows the time ruler automatically.
As being implemented as a toolbar, the timeline is visible on all tabs.
The meaning of the buttons in the window is described in the following table. The but-
tons are grouped according to their function.
Table 3-3: Meaning of the buttons in the Time Line window

Buttons Description

Display data for scanners and mobiles. Events are shown for dis-
played devices only.

Filter button allows devices and events without any displayed data to
hide.
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Buttons Description

Jump in time - use 5 s to jump backwards or forward.

The current time is displayed as a time ruler in orange. The ruler can
be moved to a different time using the mouse: press mouse button
over the time ruler, move the ruler and release the ruler on the desired
time.

Jump to event - jump to the next or last displayed event.

Zoom in or out into the displayed areas. You can use CTRL+mouse
wheel to zoom in or out instead.

Close the "Time Line" window.

Double-click the desired time in the data area to set the time.
The lower axis displays the complete time range for the entire measurement and acts
simultaneous as a scrollbar. The white “button” on the axis shows the zoomed area.
Using the mouse, you can drag and drop the left or right end of this button to define the
zoomed area.
The zoomed area can be moved by moving the button on the lower axis or by Shift
+mouse wheel. The area is updated automatically during replay, so that the current
time is always visible.

Mobile display ← Time Line
The DQA jobs execution by mobiles is displayed with their respective start and stop
times. These ranges are displayed in green whenever the job was successful, or in red
if unsuccessful.

Figure 3-64: Successful DQA job execution with a mobile

If the job's result is undetermined, the outcome is displayed in blue.

Figure 3-65: Display of undetermined job results with details

To display details, move the mouse pointer over a job.
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TETRA mobile timeline display ← Mobile display ← Time Line
The Timeline control is able to visualize SQA measurement from TETRA or classic
mobile phones.

Figure 3-66: Timeline visualization of the SQA measurement from TETRA mobile

SQA messages from TETRA or classic mobiles can be structured in [Up] and [Down]
messages. The [Up] message is visualized with a bar above the mid of the device line,
the [Down] message is displayed below. Results are marked with a blue vertical bar.
Results referencing an error are displayed red.

Scanner display ← Time Line
The count of detected transmitters in a specific time range is displayed for scanners in
the "TimeLine" window.
This count is visualized in a blue scale: the darker, the more transmitters have been
detected.

Figure 3-67: Displayed detected scanners

Events display ← Time Line
The "TimeLine" window shows also events if available.

Figure 3-68: Displayed events

Every event is displayed with its icon (centered) at the respective time position. If the
zoom factor is too wide, the clustered display of events is applied to avoid their over-
lapping display.

Figure 3-69: Displayed events as clustered
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Each cluster has the same width in pixels. Below each cluster, the count of detected
events is displayed. On top of the cluster line, the time position of the events is dis-
played. If only one event fits into one cluster, its icon is drawn instead of the count.
Move over a cluster to display details of the events.

Figure 3-70: Events cluster details

Note: All types of events in this cluster are displayed without duplicates.
If you zoom in deep enough, all events are displayed without clustering.

Figure 3-71: Displayed events w/o clustering

3.3.5  Replay control

Opens or closes a dialog to control the replay of a measurement file.

Figure 3-72: Recording buttons in tool bar and Replay control dialog

The "Replay Control" dialog opens automatically each time a measurement file is
replayed, if up-front "Show Replay Control Dialog Automatically" is active in the "Pref-
erences" dialog, see Chapter 3.8.1.1, "General settings", on page 224.

Basic functionality
The "Replay Control" dialog contains the replay control buttons of the replay bar.
These buttons correspond to the following "Replay Menu" commands.
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Table 3-4: Reply control buttons

 Step One Data Set Forward  Stop Replay

 /  Pause / Continue Replay

These two buttons are unified and toggle between
each other.

 Restart Replay

Replay Jump

The control element to the right of the measurement bar icons defines by
which amount R&S ROMES4 can jump forward and back within the mea-
surement file.

Together with the "Pause after Jump" checkbox, it corresponds to the Chap-
ter 3.7.7, "Jump", on page 220.

The two buttons below the measurement bar icons initiate a replay jump by a
selectable amount of time.

The two buttons below initiate a replay jump to the previous or next event.
The pull-down lists select the relevant events; they give access to the list of
available events in the Preferences menu.

See Chapter 3.8.1.3, "Available events configuration", on page 238.

Note: The name of the event can be too long for the panel. The too long
event's name does not cause any system problems.

Shows the speed of measurement file replay.

The unit showing the amount by which R&S ROMES4 jumps can be changed to "s" for
seconds and to "m" for meter. The "m" is available only if a trigger device is attached
during the measurement.

Block Mode
 The "Show Block List" icon in the right half of the dialog displays the blocks in the

measurement file and initiates a replay jump to the next block; if the file contains sev-
eral blocks. The blocks are listed in the table above the icon; see Chapter 3.7.9,
"Replay jump to block", on page 222. A double-click the block initiates a jump to the
selected block.

Bookmark Mode
 The "Bookmark" icon in the right half of the dialog displays the bookmarks in the

measurement file and initiates a replay jump to the next bookmark; if the file contains
several bookmarks. The bookmarks are listed in the table above the icon. A double-
click the bookmark initiates a jump to the selected bookmark.
Bookmarks can be added or manipulated in the "replay pause" state. The following
buttons are related to bookmarks in measurement files:

 Add a bookmark  Remove the selected bookmark

 Edit selected bookmark  Save bookmark list to meas. file.
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3.3.6  View areas

Opens a submenu to rename, create, delete, load and save view areas.

There are entries in the context menu of the work area; see description in chapter
Chapter 3.1.2, "View area", on page 94. Also, it provides commands for reusing view
areas.

Save default View Area after change of screen resolution
To reuse a default View Area after a change of the screen resolution, load it ("Load
View Area") and save it again under a file name containing the new resolution.

Create new View Area
Calls up the "New Sheet" as a view area. The area can be renamed and deleted. It
also gives the possibility to create another "New Sheet".

Rename current View Area
Calls up the "View Area Name" window where you can rename the created area view
which by default is named New Sheet.

Delete current View Area
Deletes the currently used view area.

Load View Area
Calls up an "Open" dialog box to select and load a View Area file (*.va) saved before.
All views within the View Area are stored together with their size, position and configu-
ration settings.
The View Area file is in XML format.

Save View Area
Calls up a "Save As" dialog to save the current view area with its views in a View Area
file (*.va).

3.3.7  Signal tree view

The  icon calls up the "Signal Tree" drag&drop tree.

Instead, you can click the "Signal Tree" bar on the left side of the screen. The list of
signal groups opens. The opened list lets you select signals within a group you want to
be displayed in the current measurement file.
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Figure 3-73: Signal tree docking window

The tree displays the branches of the data that are available in the current measure-
ment file. The data tree structure is explained in Chapter 1.10.3, "Data selection",
on page 37.

The complete data tree is displayed in a view configuration menu, for example, in the
Chapter 4.3.3, "ROMESMAP route track view", on page 562, Chapter 4.2.3, "Alphanu-
meric view", on page 466, Chapter 4.2.1, "2D chart view", on page 448.

The signal tree view is a fast alternative for selecting a signal or a group of signals to
be viewed without opening the view configuration menu.
● Click a single signal to select for displaying.
● Click several signals with pressed SHIFT or CTRL key to select a group of signals.
● Click a technology, device, or data structure node to select all signals below the

node.
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After drag and drop into the view area, the selected signals appear in the "Selected
Parameter", "Selected Signals" lists and in the "Values" tab of the view's configuration
menu. They can be removed with the context menu or the view configuration menu.

The GPS distance signal is calculated during the measurement for a GPS device and
is available as a separate signal in the "Signal Tree" > "GPS" "Device" tree. The "Dis-
tance (GPS)" signal, calculated during the replay process and displayed in the "Posi-
tion" branch is made obsolete.

Figure 3-74: GPS Distance - obsolete parameter

3.3.7.1  Support of multi-RAT signals for UE

R&S ROMES4 supports the multi-RAT signals. The signals are included in the "Availa-
ble Signals" tree under the "UE Values" entry. These signals are part of the UEs and
named Generic UE KPIs. The support of multi-RAT signals helps the user to display
the corresponding value of the signal for different RATs.

The signals can be used as any other signals, that is, for displaying the values in the
alphanumeric view, map view and other views.
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Figure 3-75: Multi-RAT signals for UE

The signals can have different valid ranges and/or units, which is RAT-dependent.

The map view displays the legends of all RAT-dependent signals. The underlays of
such a signal is the color of the RAT. In this way it is easier to interpret the color of the
track. Those RAT-dependent signals are marked with an "*" sign.

Currently supported multi-RAT signals are shown in the following table.
Table 3-5: Multi-RAT signals

RAT signal GSM signal UMTS signal LTE signal

Channel power RxlevFull RSSI RSSI

Signal power RxlevFull RSCP RSRP

Signal quality RxQual Ec/No RSRQ

Interference Avg C/I SIR estimated SINR

Tx power Tx power Tx power Tx power PUSCH

Cell ID Cell identity Cell identity eNodeB ID/cellID

Serving Cell Serving cell name from
database

Serving cell name from
database

Serving cell name from
database

Channel ARFCN UARFCN EARFCN

Cell identifier BSIC Scrambling code PCI
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RAT signal GSM signal UMTS signal LTE signal

PhyTP DL Qualcomm: GSM QoS
Info RLC DL Rate

Samsung: GSM Server
Report DL Data
Throughput

Qualcomm: UMTS
HSDPA Decode Sum-
mary MAC Throughput

Samsung: UMTS Layer
1 DL Data Throughput

Qualcomm: LTE Total
PDSCH

Total PDSCH Through-
put Ack’d

Samsung: LTE Through-
put DL Data Throughput

PhyTP UL Qualcomm: GSM QoS
Info RLC UL Rate

Samsung: GSM Server
Report UL Data
Throughput

Qualcomm: UMTS
HSUPA Statistics Avg.
Total TP

Samsung: UMTS Layer
1 UL Samsung: LTE
Throughput UL Data
Throughput

Qualcomm: LTE PUSCH
PDSCH Throughput

Samsung: LTE Through-
put UL Data Throughput

The "UE Values" branch also contains links to GSM signals, which are valid for all
RATs. Selecting the value in the "GSM" or "UE Value" branch has the same effect.

For the signals description, see "R&S ROMES4 Description of Signals" manual.

3.3.7.2  Tooltips for R&S ROMES4 signals

The drag and drop tree offers a Tooltip, which shows the most important attributes of a
selected signal.

Figure 3-76: Tooltip for UMTS RSCP signal

The Tooltips offer detailed explanations of many signals in the tree, as illustrated in the
previous figure.
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The explanation of the described R&S ROMES4 signals can be compiled as a single
document. For the document, select the "Help" > "Create Signal Description Docu-
ment" command, see Chapter 3.10.3, "Create signal description document",
on page 418.

The result is an HTML file, which can be displayed in the Internet Explorer and printed
as a PDF document, if desired.

Open in Browser
Click the "Open in Browser" line in a Tooltip to edit the text in the default browser.
While the first and second section of the information is taken directly from the technolo-
gies, the third part is taken from a description file.

Figure 3-77: Layout of the HTML file

3.3.8  Generic views

The lower part of the "Signal Tree" shows a selection of views that are not designed for
a particular technology. In general, these generic, general-purpose views can be used
for arbitrary signals, irrespective of the selected measurement file.

The following templates are available in that part:
● ROMESMAP Route Track View
● Basic Views, which include the following views' templates:

– Alphanumeric View
– 2D Chart View
– Statistic View
– Grid View
– Device Grid View
For the views details, see Chapter 4.2, "Basic views", on page 445.
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To display one or several ROMES signals from the "Signal Tree" in the R&S ROMES4
generic view:

1. Select the signal or signals from the "Signal Tree" list.

2. Drag and drop them in a selected view type icon of the lower part of "Signal Tree".

The signals are included in the view, which opens.

3.3.9  Custom views

These views let you create your own views and administer the existing, available ones.

Figure 3-78: Custom Views

Create New
Click the "Create New" option to open the "Create Custom View" window. Select a
unique name for a new view, a template and a menu group, where the new view
appears In the dialog. Optionally, a subgroup can be specified.

After leaving the dialog, press "OK".
The view is created and the "My View" dialog is shown. Here you can configure the
custom view. This view now appears in the menu and is created each time R&S
ROMES4 starts as another view.
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Administration
Lets you administer the specified custom views.

● "Remove"
The button allows the value of the "to be removed" column to toggle. If the column
shows "Yes", the view is removed during R&S ROMES4 shutting down.

● "Update"
The button allows overwriting the configuration file of the view. Next time, the view
appears according to the overwritten configuration.

Both buttons impact the appearance of the selected items in the list.

Configuration Files
The list of the custom views is stored in the
<ROMES_DIR>\Configuration\UserDefinedViews.xml file.

The views configurations are stored is separate files per view. They have the following
path:
<ROMES_DIR>\Configuration\UDViews\<ViewName>.xml
Note: Do not change the files manually.

3.3.10  Show / hide views

The "Show / Hide Views" shows and arranges or hides the individual R&S ROMES4
view windows.

The view command opens a dialog with the same name.

Users can select/deselect all items in the subtree by clicking a parent item.

Parent Item also indicates one of the following states:
● All views are selected
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Figure 3-79: All views selected

● No any views selected

Figure 3-80: No view selected

● At least one view is selected.
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Figure 3-81: Opened views for LTE scanner

If the views are already opened, the associated items in the view are marked as
“selected”. The following figure shows the case of opened "ROMESMAP Route Track
View".

Figure 3-82: Opened ROMESMAP view and marked corresponding item
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A view hidden via the "Show / Hide Views" function is temporarily removed from the
main window and can be recalled anytime. The R&S ROMES4 workspace contains at
least one view of every type. All views can be hidden but only multiple views of the
same type (if available) can be destroyed, i.e. permanently removed.

● Main pane
List of all provided view windows. A view is shown/opened, if selected in the corre-
sponding check box.

● "OK"
Apply the current settings and close the "Show / Hide Views" dialog.

● "Cancel"
Discard the current settings and close the "Show / Hide Views" dialog.

● "Apply"
Apply (preview) the current settings without closing the "Show / Hide Views" dialog.

● "Tile vertical / horizontal"
The selected views are tiled, i.e. placed side by side so they do not overlap, see
Chapter 3.9, "Window menu", on page 414.

● "Cascade"
The selected views are superimposed, such that all title bars are visible.

● "Multiple Views"
If "Create new view" is selected, the R&S ROMES4 always creates new views on
the current view area and does not affect the views on the other view area sheets.
Otherwise, views from other sheets are moved to the current sheet.

3.3.11  Basic views

Offers a selection of views to show information from any technology, see Figure 3-37.

A star (*) displayed behind a view type indicates that the view is not yet loaded in R&S
ROMES4. The star appearance is motivated by performance reasons. When the
marked view is selected and opened for the first time in R&S ROMES4, the star (*) is
removed. That means the view type is now loaded and therefore faster available in
R&S ROMES4. If no star is shown, then it is possible that a sign ":1" is displayed
behind a view type.

A sign ":1" displayed behind a view type indicates that several views of the same type
with different configurations can be opened simultaneously. How to create several
views of the same type, see sections "Create new view of the same type" on page 100
and "New Window" on page 415.

Basic Views can be specified as default views for the corresponding technologies.

The following templates are available in that panel:
● 2D Char View
● ACD Status View
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● Alphanumeric View
● Bar Char View
● Device Grid View
● Event View
● General Status View
● Grid View
● Message View
● Resource Usage View
● Statistic Histogram
● Statistic View
● Time Gated Spectrum View
● X-Y Graph

For detailed information, refer to Chapter 4.2, "Basic views", on page 445.

● Chapter 4.2.1, "2D chart view", on page 448
Shows the current measurement data as a function of time. In practice, an unlimi-
ted number of 2D-charts can be defined simultaneously.

● Chapter 4.2.2, "ACD status view", on page 461
Shows the status of use cases related to automatic channel detection for different
technologies.

● Chapter 4.2.3, "Alphanumeric view", on page 466
Shows information about the selected parameters. Several alphanumeric views
corresponding to different connected mobile stations can be opened simultane-
ously.

● Chapter 4.2.4, "Bar chart view", on page 471
Shows measurement data in a flexible bar chart.

● Chapter 4.2.5, "Device grid view", on page 477
Shows any available signal during replay or measurement.

● Chapter 4.2.6, "Event view", on page 498
Shows all events that occurred during the measurement.

● Chapter 4.2.7, "General status view", on page 501
List of device messages of general interest.

● Chapter 4.2.8, "Grid view", on page 504
Shows any available signal during replay or measurement.

● Chapter 4.2.9, "Message view", on page 515
Detailed, chronological list of the system messages generated during the measure-
ment.

● Chapter 4.2.11, "Statistic histogram", on page 525
Collection of several diagrams to show a statistical evaluation of a signal.

● Chapter 4.2.12, "Statistic view", on page 532
Shows the most common statistical key indicators of any R&S ROMES4 signal.

● Chapter 4.2.14, "X-Y graph view", on page 543
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The X-Y graph (or scatter plot) can be used to set two signals in correlation to each
other. That is, the value of one signal is used as x value, the value of another sig-
nal as y value.

3.3.12  CW views

Offers the "Alphanumeric View" to monitor a continuous wave (CW) measurements
using a test receiver.

A star "*" displayed behind the view type indicates that the view is not yet loaded in
R&S ROMES4. The star appearance is motivated by performance reasons. When the
marked view is selected and opened for the first time in R&S ROMES4, the star is
removed. That means, the view type is now loaded and therefore faster available in
R&S ROMES4. If no star is shown, then it is possible that a sign ":1" is displayed
behind the view type.

In general, the sign displayed behind a view type indicates that several views of the
same type with different configurations can be opened simultaneously. How to create
several views of the same type see sections "Create new view of the same type"
on page 100 and "New Window" on page 415.

For more information, refer to Chapter 4.5, "CW views", on page 1058.

3.3.13  Mobile views

The views offer a selection of views to show, for example, GSM, UMTS, TETRA, LTE,
NB-IoT, 5G NR mobile data.

The "Mobile Views" display different views depending on the selected supported tech-
nologies:
● For UMTS, see Chapter 3.3.13.6, "UMTS", on page 176
● For TETRA, see Chapter 3.3.13.9, "TETRA", on page 178 (not default, has to be

enabled during the R&S ROMES4 installation)
● For LTE, see Chapter 3.3.13.7, "LTE", on page 177
● For NB-IoT, see Chapter 3.3.13.8, "NB-IoT", on page 177
● For 5G NR, see Chapter 3.3.13.1, "5G NR", on page 172
● For HSDPA/HSUPA, see Chapter 3.3.13.4, "HSDPA", on page 174/Chap-

ter 3.3.13.5, "HSUPA", on page 175
● For GSM/GPRS, see Chapter 3.3.13.3, "GSM", on page 173/Chapter 3.3.13.2,

"GPRS", on page 172

The lower part of the mobile views list contains the views that are common for several
technologies (most of them for 4G and 5G NR UEs).

For detailed information about one particular view of these views, refer to Chapter 4.4,
"Mobile views", on page 686.
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Figure 3-83: Default mobile views

A star (*) displayed behind a view type indicates that the view is not yet loaded in R&S
ROMES4. The star appearance is motivated by performance reasons. When the
marked view is selected and opened for the first time in R&S ROMES4, the star (*) is
removed. That means the view type is now loaded and therefore faster available in
R&S ROMES4. If no star is shown, then it is possible that a sign ":1" is displayed
behind a view type.

A sign ":1" displayed behind a view type indicates that several views of the same type
with different configurations can be opened simultaneously. How to create several
views of the same type, see sections "Create new view of the same type" on page 100
and "New Window" on page 415.
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3.3.13.1  5G NR

Offers a selection of views of a 5G NR mobile signals.

See Chapter 4.4.8, "5G NR views", on page 859.

3.3.13.2  GPRS

Offers a selection of views of a GPRS mobile signal.

GPRS views can be opened anytime, however, they are empty unless GPRS data are
available.

For detailed information, refer to Chapter 4.4.4, "GPRS views", on page 770.

● Chapter 4.4.4.2, "GSM GPRS state view", on page 771
List of parameters characterizing the operating state of mobile phones supporting
GPRS.

● Chapter 4.4.4.3, "GSM GPRS PDP info view", on page 772
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List of important Packet Data Protocol (PDP) parameters of mobile phones sup-
porting GPRS.

● Chapter 4.4.4.4, "GSM GPRS RLC/MAC view", on page 774
Overview of important Radio Link Protocol/Medium Access Control parameters of
mobile phones supporting GPRS.

● Chapter 4.4.4.5, "GSM GPRS TS/CS view", on page 780
Statistical evaluation of the number of timeslots (TS) that are active in the connec-
tion and the Coding Scheme (CS) that is used for the transmission of radio blocks.

● Chapter 4.4.4.6, "GSM GPRS RLC/MAC header view", on page 782
List of the exchanged RLC/MAC block header information.

● Chapter 4.4.4.7, "GSM GPRS/EGPRS view", on page 785
Control and physical parameters of a GPRS and EGPRS connection.

● Chapter 4.4.4.8, "GSM GPRS RLC MAC release indicators view", on page 788
Control and physical parameters of the connection release information, such as the
cause of the release, statistical parameters and the release indicator description, if
supplied.

3.3.13.3  GSM

Offers a selection of views of the GSM mobile signals.

GSM views can be opened anytime, however, they are empty unless GSM data are
available.

For detailed information, refer to Chapter 4.4.5, "GSM views", on page 790.

● Chapter 4.4.5.8, "GSM system information view", on page 808
List of the GSM parameters in the Layer 3 messages System Information Type 1 to
6 sent by the BTS.

● Chapter 4.4.5.3, "GSM frequency hopping view", on page 794
List of the frequency hopping parameters of GSM mobile phones.

● Chapter 4.4.5.2, "GSM dedicated 3G cell list view", on page 792
Overview of the measured dedicated 3G cell parameters.

● Chapter 4.4.5.4, "GSM idle 3G cell list view", on page 796
Overview of the measured idle 3G cell parameters.

● Chapter 4.4.5.6, "GSM RR 3G reselection measurements view", on page 803
An overview of the Radio Resource 3G reselection measurement results.

● Chapter 4.4.5.7, "GSM rejected 3G cells view", on page 805
Overview of the determined 3G cell parameters for rejected cells.

View menu



User interfaceDrive Test Software

174Operating Manual 1171.6415.12 ─ 66

● Chapter 4.4.5.5, "GSM RR 3G reselection measurements parameters view",
on page 799
An overview of the Radio Resource 3G reselection measurement parameters.

● Chapter 4.4.5.1, "GSM chart view", on page 790
Display of GSM layer 1 parameters in a 2D chart.

3.3.13.4  HSDPA

Offers a selection of views of the UMTS HSDPA mobile signals.

HSDPA views can be opened anytime, however, they are empty unless HSDPA data
are available.

For detailed information, refer to Chapter 4.4.2, "UMTS HSDPA views", on page 714.

● Chapter 4.4.2.2, "UMTS HSDPA UL HS-DPCCH view", on page 718
CQI values reported by the test mobile in the last 100 HSDPA subframes.

● Chapter 4.4.2.3, "UMTS HSDPA HS decode status view", on page 721
Status of the HS-SCCH demodulation and the decoded HS-SCCH information.

● Chapter 4.4.2.4, "UMTS HSDPA configuration view", on page 724
Configuration of the DL HSDPA channels received by the test mobile, the UL HS-
DPCCH, and information related to the finger configuration command, the DL HS-
SCCHs, and the active HARQ processes.

● Chapter 4.4.2.5, "UMTS HSDPA MAC configuration view", on page 727
Configuration of the MAC-hs that the test mobile receives from the network.

● Chapter 4.4.2.6, "UMTS HSDPA MAC status view", on page 729
Overview of the status of the reordering entity in the mobile receiver.

● Chapter 4.4.2.7, "UMTS HSDPA MAC header view", on page 732
Mobile-specific subframe number and the corresponding (HS-DSCH) MAC-hs
headers as defined in standard 2GPP TS 25.321.

● Chapter 4.4.2.8, "UMTS HSDPA performance view", on page 735
Transmission performance parameters, given in terms of the requested or ach-
ieved data throughput.

● Chapter 4.4.2.9, "UMTS HSDPA decode statistic view", on page 737
Statistical evaluation of the received DL HS-DSCH transport blocks, together with
the block error rate and the number of retransmissions needs successful decoding
of the blocks of each size.

● Chapter 4.4.2.10, "UMTS HSPA L2 statistic view", on page 740
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Shows information about the used PDU size.

3.3.13.5  HSUPA

Offers a selection of views of the UMTS HSUPA mobile signals.

HSUPA views can be opened anytime, however, they are empty unless HSUPA data
are available.

For detailed information, refer to Chapter 4.4.1, "UMTS HSUPA views", on page 688.

● Chapter 4.4.1.1, "UMTS HSUPA ACK/NACK view", on page 689
Shows the used transport block sizes per TTI. The y-axis shows the TBS and the
x-axis represents the TTIs.

● Chapter 4.4.1.2, "UMTS HSUPA cell status view", on page 690
Shows events per TTI for HICH, RGCH, and AGCH for the mobile, serving cell and
non-serving cells of the mobile.

● Chapter 4.4.1.3, "UMTS HSUPA DL channel configuration view", on page 693
DL parameters of the active HSUPA connections, which were transmitted in the
corresponding RRC messages. The power-offset table shows the basic information
about the inputs of the mobiles' transmit power calculation.

● Chapter 4.4.1.4, "UMTS HSUPA HARQ view", on page 697
Shows the characteristics of all HARQ processes of the test mobile, and a statisti-
cal evaluation of the received UL E-DCH transport blocks.

● Chapter 4.4.1.5, "UMTS HSUPA L1/MAC statistic view", on page 699
Shows a configurable selection of the statistics parameters provided by the mobile
itself.

● Chapter 4.4.1.6, "UMTS HSUPA performance view", on page 705
Four preconfigured 2D charts showing signals related to the transmission perfor-
mance in terms of the requested or achieved data throughput.

● Chapter 4.4.1.7, "UMTS HSUPA power graph view", on page 708
Shows the most important absolute and relative power values for the HSUPA ses-
sion.

● Chapter 4.4.1.8, "UMTS HSUPA UL channel configuration view", on page 710
UL parameters of the active HSUPA connections, which were transmitted in the
corresponding RRC messages. The power-offset table shows the basic information
about the inputs of the mobiles' transmit power calculation.
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3.3.13.6  UMTS

Offers a selection of views of the UMTS mobile signals.

UMTS views can be opened anytime; however, they are empty unless UMTS data are
available.

For detailed information, refer to Chapter 4.4.3, "UMTS views", on page 742.

● Chapter 4.4.3.1, "UMTS finger data view", on page 743
Layer 1 parameters characterizing the different downlink WCDMA signals received
by the mobile, captured with the different branches (fingers) of the test mobile
UMTS RAKE receiver.

● Chapter 4.4.3.2, "UMTS NAS status view", on page 746
Higher-layer (Non-Access Stratum, NAS) parameters of the serving cell and the
connection.

● Chapter 4.4.3.3, "UMTS TrCH view", on page 749
Channel coding parameters in the downlink and uplink Transport Channels
(TrCHs).

● Chapter 4.4.3.4, "UMTS physical channels view", on page 753
Physical channel parameters in the downlink and uplink WCDMA signals.

● Chapter 4.4.3.5, "UMTS SIB view", on page 758
Tree view of the exchanged System Information Blocks.

● Chapter 4.4.3.6, "UMTS RLC/MAC view", on page 760
Display of important Radio Link Control/Medium Access Control parameters of
UMTS mobile phones.

● Chapter 4.4.3.7, "UMTS measurement report view", on page 763
Intra-frequency measurement results that the test mobile sends to the network in a
Measurement Report RRC message.

● Chapter 4.4.3.9, "UMTS reselection view", on page 766
Display of parameters that are used for cell reselection of UMTS mobile phones.

● Chapter 4.4.3.8, "UMTS power control view", on page 765
Transmitter output power and closed loop power control parameters of a UMTS
mobile.

● Chapter 4.4.3.10, "UMTS Layer 1 graph view", on page 770
Display of UMTS or GSM layer 1 parameters in a 2D chart.

View menu



User interfaceDrive Test Software

177Operating Manual 1171.6415.12 ─ 66

3.3.13.7  LTE

Offers a selection of views of the LTE mobile signals.

For detailed information refer to:
● Chapter 4.4.6.1, "LTE CER view", on page 811

Shows the reported CER values for antennas.
● Chapter 4.4.6.3, "LTE chart view", on page 814

Shows the current measurement, for example, Tx and Rx Power or Error Rates as
a function of time in a predefined 2D chart.

● Chapter 4.4.6.2, "LTE CQI view", on page 812
Shows the reported CQI values of the downlink transmission.

● Chapter 4.4.6.5, "LTE HARQ statistic view", on page 819
Shows statistics about the used transport block sizes and the necessary retrans-
mission.

● Chapter 4.4.6.6, "LTE HARQ view", on page 822
Shows detailed information about the HARQ processes in downlink and uplink
direction.

● "LTE Performance View"
Offers a quick overview of the most important parameters concerning the LTE
downlink performances.

● Chapter 4.4.6.8, "LTE RACH view", on page 828
Shows information on the test-mobile's RACH procedures during the measure-
ment.

● Chapter 4.4.6.9, "LTE radio bearer view", on page 841
Shows the currently active bearers.

3.3.13.8  NB-IoT

Offers a selection of views of a NB-IoT mobile signals.
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● Chapter 4.4.7.1, "NB-IoT details view", on page 854
Provides an in-depth view of the NB-IoT procedures.

● Chapter 4.4.7.2, "NB-IoT NPRACH view", on page 857
Shows the NPRACH information.

3.3.13.9  TETRA

Offers a selection of views of the TETRA mobile signals.

For detailed information, refer to Chapter 4.4.9, "TETRA views", on page 890.

● Chapter 4.4.9.1, "TETRA graph view", on page 891
Shows on a 2D Chart the RSSI and the C1 of the current server and the RSSI and
the C2 of the best neighbor.

● Chapter 4.4.9, "TETRA views", on page 890
Provides the summary of the test mobile state, the received power of the radio sig-
nal and the corresponding quality of the server cell and the best neighbor. Also pro-
vides information about active cell set and system parameters. If applicable, pro-
vides the results from a connected TETRA scanner which give a quick overview of
the current situation.

3.3.14  Navigation views

Offers a selection of views to display data in a map.

The Geographic Positioning System (GPS) is used to visualize data with valid geo-
graphical information (longitude/latitude parameters) in a map or to retrieve geographic
information assigned to the data points.
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For detailed information, refer to Chapter 4.3, "Navigation views", on page 548.

● Chapter 4.3.1, "GPS info view", on page 548
List of the geographical coordinates and other information about a particular test
point.

● Chapter 4.3.3, "ROMESMAP route track view", on page 562
Map view shows measured data, the R&S ROMES4 signals, the R&S ROMES4
events and technology-specific features, for example, displaying BTS symbols and
best server symbols. Furthermore, the view shows data recorded with the Indoor
navigation device.

3.3.15  QoS views

Offers a selection of views to evaluate the Quality of Service of a data connection mea-
sured with the available Quality Testers (xQA).

The QoS views are divided into several groups. One group of views is for data DQA
(data quality analysis) and another for SQA (speech data quality analysis), if activated.
See for example Chapter 3.3.13.6, "UMTS", on page 176.
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For detailed information, refer to Chapter 4.6, "QoS views", on page 1059.

● Chapter 4.6.3, "QoS KPI export result view", on page 1093
Shows the result of the exported *.csv file from the KPI export definition.

● Chapter 4.6.4, "QoS KPI generator view", on page 1095
Shows all KPIs of a session under the session tree node.

3.3.15.1  DQA

Offers a selection of views of QoS DQA data.

DQA views can be opened anytime, however, they are empty unless DQA data are
available.

A star (*) displayed behind a view type indicates that the view is not yet loaded in R&S
ROMES4. The star appearance is motivated by performance reasons. When the
marked view is selected and opened for the first time in R&S ROMES4, the star (*) is
removed. That means the view type is now loaded and therefore faster available in
R&S ROMES4. If no star is shown, then it is possible that a sign ":1" is displayed
behind a view type.
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A sign ":1" displayed behind a view type indicates that several views of the same type
with different configurations can be opened simultaneously. How to create several
views of the same type, see sections "Create new view of the same type" on page 100
and "New Window" on page 415.

For detailed information, refer to Chapter 4.6.2, "QoS DQA views", on page 1071.

3.3.15.2  SQA

Offers a selection of views of QoS SQA data.

SQA views can be opened anytime, however, they are empty unless SQA data are
available.

For detailed information related to SQA message view, refer to Chapter 4.6.1, "QoS
SQA view", on page 1060. The view displays the result of the speech quality analysis
which requires option R&S ROMES4SQA, Voice Quality PESQ.

3.3.16  RF power scanner views

Offers a selection of views of RF Power Scan data.

The R&S TSME RF Power Scanners allow elementary spectrum measurement and
analysis and show the signals for each selected sweep. For detailed information, refer
to Chapter 4.8.9, "RF power scanner views", on page 1319.
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3.3.17  Scanner views

Offers a selection of views to show technology scan data.

The R&S ROMES4 GUI has been aligned for the scanners. All scanner configuration
pages, except GSM and TETRA which have a different underlying channel model,
have been adapted.

A star (*) displayed behind a view type indicates that the view is not yet loaded in R&S
ROMES4. The star appearance is motivated by performance reasons. When the
marked view is selected and opened for the first time in R&S ROMES4, the star (*) is
removed. That means the view type is now loaded and therefore faster available in
R&S ROMES4. If no star is shown, then it is possible that a sign ":1" is displayed
behind a view type.

A sign ":1" displayed behind a view type indicates that several views of the same type
with different configurations can be opened simultaneously. How to create several
views of the same type, see sections "Create new view of the same type" on page 100
and "New Window" on page 415.

● 5G NR scanner view............................................................................................. 182
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3.3.17.1  5G NR scanner view

Offers a selection of views to show 5G New Radio scanner data.
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For detailed information, refer to Chapter 4.8.2, "5G NR scanner views", on page 1126.

● Chapter 4.8.2, "5G NR scanner views", on page 1126
Shows the n best beams over all. The view can be filtered by PCI and frequency.

● Chapter 4.8.2.4, "5G NR scanner SSS-PBCH CIR view", on page 1143
Shows the CIR of the different beams.

● Chapter 4.8.2, "5G NR scanner views", on page 1126
Shows the standard Top N view as used by all scanner technologies.

● Chapter 4.8.2.6, "5G NR SSB history view", on page 1149
Shows the SSB history of selected Top N pool.

● Chapter 4.8.2, "5G NR scanner views", on page 1126
Shows the SSB performances of selected Top N pool.

● Chapter 4.8.2.7, "5G NR SSB performance view", on page 1150
Shows the SSB performances, available only during the measurement.

3.3.17.2  CDMA2000/1xEV-DO scanner views

Offers a selection of views to show CDMA2000 or 1x EV-Do Pseudo Noise Scanner
data.

For detailed information, refer to Chapter 4.8.4, "CDMA2000/1xEV-DO scanner views",
on page 1160.

● Chapter 4.8.4.1, "CDMA2000/1xEV-DO scanner F-PICH view", on page 1160
Average signal power of the received Forward Pilot Channels (F-PICHs) and analy-
sis of the properties of all DL signals received in the CDMA2000 PN or 1x Ev-DO
scan.

● Chapter 4.8.4.3, "CDMA2000/1xEV-DO scanner F-SYNC view", on page 1172
Information that the R&S TSMU decoded from the Forward Synchronization Chan-
nel (F-SYNC).

● "CDMA2000/1xEV-DO scanner system time line estimation view"
Shows the parameters used for the GPS signal-based CDMA system time line.

● Chapter 4.8.4.5, "CDMA2000/1xEV-DO scanner Top N view", on page 1175
List of the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools.
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● Chapter 4.8.4.2, "CDMA2000/1xEV-DO scanner BCH view", on page 1168
CDMA/1xEV-DO System Information (SI) messages decoded from the BCH
demodulator (Layer 3 messages).

3.3.17.3  GSM scanner views

Offers a view to visualize GSM network scan data.

For detailed information, refer to Chapter 4.8.5, "GSM scanner views", on page 1179.

● Chapter 4.8.5.2, "GSM scanner BCH view", on page 1181
System Information (SI) decoded from the GSM BCH with their full contents.

● Chapter 4.8.5.3, "GSM scanner Top N view", on page 1187
Shows the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools.

● Chapter 4.8.5.4, "GSM scanner transmitter view", on page 1196
Shows the GSM data measured and demodulated by R&S radio network analyzers
during the GSM network scan.

3.3.17.4  LTE scanner views

Offers a selection of views to show LTE Scanner data.

View menu



User interfaceDrive Test Software

185Operating Manual 1171.6415.12 ─ 66

For detailed information, refer to Chapter 4.8.6, "LTE scanner views", on page 1204 and
among other views to the following ones.

● Chapter 4.8.6.2, "LTE scanner BCH view", on page 1212
Shows the System Information Blocks (SIBs) and Master Information Block (MIB)
decoded from the LTE BCH channel.

● Chapter 4.8.6.4, "LTE scanner CIR view", on page 1227
Shows the channel impulse response of the LTE signals.

● Chapter 4.8.6.3, "LTE scanner cell ID tracer view", on page 1222
Shows the evolution in time of the time delay and power of all received LTE peaks
with a particular Cell ID or a particular rank in a top N pool.

● Shows the downlink allocation analysis results
● Chapter 4.8.6.6, "LTE scanner MIMO view", on page 1234

The view shows the measured condition numbers of one cell.
● Chapter 4.8.6.7, "LTE scanner power view", on page 1238

Shows the channels quality by viewing the general Signal-to-Interference-plus-
Noise Ratio (SINR) and specific SINR of S-SCH and SINR of P-SCH.

● Chapter 4.8.6.10, "LTE scanner subband view", on page 1244
The view shows the measured subband SINR values of one cell.

● Chapter 4.8.6.14, "LTE scanner Top N view", on page 1258
Shows the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools defined in the technology configuration.
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3.3.17.5  LTE-M scanner views

Offers a selection of views to show LTE-M scanner data.

● Chapter 4.8.7.2, "LTE-M scanner BCH view", on page 1281
Shows the System Information Blocks (SIBs) and Master Information Block (MIB)
decoded from the LTE BCH channel.

● Chapter 4.8.7.3, "LTE-M scanner Top N view", on page 1288
Shows the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools defined in the technology configuration.

3.3.17.6  NB-IoT scanner views

Offers a selection of views to show NB-IoT scanner data.

For detailed information, refer to Chapter 4.8.8, "NB-IoT scanner views", on page 1297.

● Chapter 4.8.8, "NB-IoT scanner views", on page 1297
Shows a list of detected BTSs and their MIB and SIBs decoded from the NB-IoT
BCH.

● Chapter 4.8.8, "NB-IoT scanner views", on page 1297
Shows the CIR and CIR peaks of the reference signal measurements.

● Chapter 4.8.8, "NB-IoT scanner views", on page 1297
Shows the properties of the NB-IoT scanner signals received from the eNodeB.

3.3.17.7  TETRA scanner views

Offers a selection of views to show TETRA Scanner data.
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For detailed information views, refer to Chapter 4.8.10, "TETRA scanner views",
on page 1339.

● Chapter 4.8.10.3, "TETRA scanner CIR view", on page 1346
Shows the channel impulse response of the TETRA signals.

● Chapter 4.8.10.1, "TETRA scanner BCH view", on page 1340
Shows information received by the broadcast channels of the TETRA signal. It is
summary of all found TETRA transmitters.

● Chapter 4.8.10.2, "TETRA scanner carrier spectrum view", on page 1342
Shows the scanned spectrum of a single carrier.

● Chapter 4.8.10.4, "TETRA scanner constellation diagram view", on page 1348
Shows the current state of the constellation diagram of either a fixed carrier or a
specified member of a Top N Pool.

● Chapter 4.8.10.6, "TETRA scanner spectrum view", on page 1356
Shows the total inband power of each carrier index.

● Chapter 4.8.10.7, "TETRA scanner Top N view", on page 1363
Shows the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools defined in the technology configuration.

3.3.17.8  UMTS scanner views

Offers a selection of views to show UMTS Pseudo Noise Scanner data.
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For detailed information views, refer to Chapter 4.8.11, "UMTS scanner views",
on page 1370.

● Chapter 4.8.11.2, "UMTS scanner BCH view", on page 1377
Shows System Information Blocks (SIBs) and Master Information Block (MIB)
decoded from the UMTS BCH with their full contents.

● Chapter 4.8.11.3, "UMTS scanner CPICH view", on page 1383
Shows the average signal power of the received P-CPICHs and a comprehensive
analysis of the properties of all DL signals received in the UMTS PN scan.

● Chapter 4.8.11.4, "UMTS scanner P-SCH view", on page 1391
Shows the properties of the Primary Synchronization Channel in the DL UMTS sig-
nal.

● Chapter 4.8.11.6, "UMTS scanner SC tracer view", on page 1397
Shows the evolution of the delay time of a single CPICH relative to the frame boun-
dary. Several PNS SC Tracer Views with different configurations can be opened
simultaneously.

● Chapter 4.8.11.7, "UMTS scanner Top N view", on page 1404
Shows the properties of the signals from the NodeB that are elements of the Top N
pools. The pools are defined in the device configuration menu.

3.3.17.9  WiMAX scanner views

Offers a selection of views to show WiMAX Scanner data.
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For detailed information views, refer to Chapter 4.8.12, "WiMAX scanner views",
on page 1412.

● Chapter 4.8.12.1, "WiMAX scanner BCH view", on page 1413
Shows the demodulated and decoded content of received channels of the WiMAX
signal.

● Chapter 4.8.12.3, "WiMAX scanner Top N view", on page 1420
Shows the properties of the signals from the base transceiver stations that are ele-
ments of the Top N Pools defined in the technology configuration.

● Chapter 4.8.12.2, "WiMAX scanner CIR view", on page 1416
Shows the channel impulse response of the WiMAX signals.

3.3.18  WLAN views

Offers different views to analyze the WLAN information obtained in the network scans
performed by a WLAN adapter in regular intervals.
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For detailed information, refer to Chapter 4.7, "WLAN views", on page 1103.

● Chapter 4.7, "WLAN views", on page 1103
Shows the information on co-existing channels and overlapping channels.

● Chapter 4.7.2, "WLAN scan view", on page 1108
Shows the basic information acquired in a WLAN network scan (WLAN BSSID list
information).

● Chapter 4.7.3, "WLAN signal view", on page 1112
Shows RSSI of all received signals in a 3-dimensional bar graph.

● Chapter 4.7.4, "WLAN survey view", on page 1114
Shows the statistical evaluation of the results in the other WLAN views.

3.4  Hardware menu

The "Hardware" main menu is used to load hardware devices necessary for a mea-
surement.

3.4.1  Loading hardware

For automatic detection of hardware device, use the Chapter 6.1.1, "Devices man-
ager", on page 1448 function. Otherwise, use the "Hardware" > "Connect/Disconnect"
command. Both ways load the hardware devices necessary for a measurement.
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Load the hardware devices (i.e., network scanners and different types of mobile
phones) before a measurement is started.

They can be provided in two different ways:
● Implicitly, by loading a workspace file
● Explicitly, via the "Hardware" command

The installation process is menu-guided. For further information, refer to Chapter 6,
"Hardware Components", on page 1447.

The installation process is menu-guided. For further information, refer to chapter "Hard-
ware Components".

It is not necessary to load device for evaluating data in the replay mode.
The "Hardware" menu commands are disabled as long as a measurement file is
opened.

3.4.2  Wizards

Wizards simplify the setup of a measurement task. Available wizards are listed in the
"Hardware" > "Wizards" menu.

Select a wizard from the menu and follow the instructions on the screen.

The settings of wizards can be stored as profiles. These profiles are used for loading
devices via the R&S ROMES4 "Device Manager".

Figure 3-84: Hardware menu – Wizards
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3.4.2.1  Automatic channel detection wizard

The Automatic Channel Detection (ACD in further text) function is aimed to make the
channel detection faster. Scanners have to be available for technologies that support
ACD function to do channels detection. The screenshot Figure 3-86 shows the radio
access technologies (also here named TECs) which ACD wizard supports.

The algorithm takes care about the reliability of the fast channel detection, especially of
fast cdma/EVDO channels detection. For the GSM, UMTS and cdma2000/1xEVDO
scanners, the measurement rates are set automatically. Each individual channel of
mentioned technologies gets approximately the same number of measurements per
second in settings of the measurement rate.

For scanner measurement rate signals, see Chapter 3.8.1.2, "Available signals config-
uration", on page 228.

The LTE, NB-IoT and 5G NR finders of ACD provide fast and efficient channel detec-
tion. The finders and their scanners support frontend distribution for the automatic
channel detection. The function distributes the selected band onto the all available
frontends automatically. If you want to specify a specific frequency range for a fron-
tend, this frequency range can be defined in the transducer table as XML file. Note that
each R&S TSME must be connected to its own network card when detecting channels
automatically.

If the channel list of a scanner which does ACD function contains the specific channels
to scan, the ACD considers this information. The ACD treats these channels as already
detected.

The ACD performance depends mainly on the number of different technologies and the
size of the observed frequency range. It is highly recommended to shrink both parame-
ters as much as possible to achieve the maximum benefit of this feature.

The function needs a license. If the license is not found when running the wizard, an
error message is displayed.

ACD wizard start procedure

The ACD wizard sets up a measurement, which detects and locates all available chan-
nels in a specified frequency band for 5G NR, LTE, NB-IoT, UMTS, GSM, and
cdma2000/1xEVDO. In GSM, if necessary to search for channels in the several bands
(for example, GSM900/1800 and GSM450), several instances of the GSM network
scanner have to be configured.

The wizard supports configured scanners demodulation messages. Selection of
demodulation messages per TEC to be available in ACD wizard is covered in the fol-
lowing procedure, see the step 9. The selection for each TEC is stored to disk and is
available next time the technology scanner is loaded. The all previously mentioned
technologies support demodulation messages.

TETRA also supports demodulation messages, but automatic channel detection is not
supported by ACD wizard. The ACD function is only configurable in the TETRA config-
uration page.
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1. Start the ACD wizard selecting the "Automatic Channel Detection" command in
"Hardware" > "Wizards".

The wizard starts with the existing configuration. It checks if there are devices
which can interfere with the setup.

2. If such devices are found, the ACD wizard pops-up a dialog to inform you about the
necessity to unload those devices. The dialog offers you to abort the ACD wizard.
Otherwise, click "Yes" to continue with the wizard.

Figure 3-85: ACD wizard warning during setup

The ACD opening "Welcome to the Automatic Channel Detection Wizard!" page is
displayed.

3. Specify the RATs for ACD among the available ones. The available technologies
for ACD scanning are those ones for which a license is available in a configured
device.
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Figure 3-86: Opening ACD wizard page

4. Select the positioning type to be added to ACD in the lower part of the wizard's
opening page.
You can select between a GPS devices and Position Estimator. The latest one
requires a license. If the license is unavailable, the position estimation is dimmed in
the page. The Position Estimator estimates the geographic position of the detected
transmitters letting the wizard to set sensitivity and ACD to "Fair". These properties
favor the scanning speed of the found channels and improve the results of the
position estimation.

5. Click the "Next" button.

Continue with the step 6 or 7 dependent on which positioning type you selected.

6. If you selected the position estimation as a positioning type, the warning dialog
pops-up.
The dialog informs you that the optimization of a scanner configuration for this use
case can imply significant changes. You can abort the optimization process, if
desired.

Hardware menu



User interfaceDrive Test Software

195Operating Manual 1171.6415.12 ─ 66

Otherwise, click "Yes" to continue the process.

The next wizard's page opens.

7. Select how do you want to specify the target frequency range for ACD in that page.
Select the first option if you know the 3GPP or 3GPP2 bands that you want to use.
The wizard selects the 3GPP and 3GPP2 target bands accordingly. Click "Next"
and go to step 10.

Figure 3-87: Second ACD wizard page

8. If you select the second offered option for the target frequency range, you have to
specify bands. To do that, click "Next".
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The additional ACD wizard's page opens where you can select bands per technol-
ogy.

9. Select the bands for scanning within the given range per technology. Select also
the configured scanner demodulation messages to be available in the ACD wizard.
The "MIB/SIB Preselection" offers two choices for MIB/SIB demodulation mes-
sages. "Minimum Set of MIB/SIBs" is the default choice. The "All MIB/SIBs" choice
enables all the demodulation messages.

Figure 3-88: Select band and MIB/SIB for scanning

The ACD wizard supports scanning of up to 20 bands of any supported technology
in one measurement. The geographic preselection usage shrinks the number of
bands for the user's position.
Click "Next".

10. The final ACD wizard page pops-up.

11. Verify in this page if the selected RATs and bands are the right ones.
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Figure 3-89: ACD wizard final page

12. If you check the "Save as Use Case" box, the wizard saves the settings under a
given use case name

13. Click "Finish".

The ACD wizard loads the necessary devices and creates the default worksheets
for the selected technologies. An additional ACD worksheet is created, which
includes the ACD view and an alphanumeric view with the most important signals
for GPS and Position Estimator.

Hardware menu



User interfaceDrive Test Software

198Operating Manual 1171.6415.12 ─ 66

Figure 3-90: Automatic channel detection worksheet

ACD wizard uses layer 3 messages

The Use Layer 3 Messages feature is active within the ACD wizard by default.

If the ACD is configured to use Layer 3 messages, the 5G NR scanner activates SIB4
demodulation.

The ACD wizard supports the usage of Layer 3 message of LTE. Previously you have
to activate manually it in LTE scanner configuration page. Check the "Use Layer 3
Messages" box in the "Scanner Configuration" > "Automatic Channel Detection" dialog
to activate the ACD and SIBs demodulation. See Figure 6-288.

If configured, the SIB5 demodulation starts automatically. SIB5 uses the content of 5G
NR SIB4 to get quick access to other 5G NR channels. SIB5 is used as additional
source for LTE channels detection.

ACD uses band slicing

It is possible to define specific frequency ranges for 5G NR ACD bands. These bands
slices can be selected afterwards in the ACD wizard or the manual ACD configuration
of the 5G NR scanner configuration.

To do so, create an XML file ACDBandSlices.xml in the folder My Romes\Configura-
tion folder.

The content of the file has to be the following:

<BandSlices>
    <BandSlice RAT="5GNR" Band="78" MinInHz="3300000000" MaxInHz="3400000000"/>
    <BandSlice RAT="5GNR" Band="78" MinInHz="3700000000" MaxInHz="3800000000"/>
    <BandSlice RAT="5GNR" Band="257" MinInHz="26500000000" MaxInHz="28000000000"/>
</BandSlices>

The entries in the file have the following meanings:
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- RAT: always 5G NR,

- Band: 5G NR Band Number

- Min/MaxInHz: Minimum and maximum of the frequency range

The range has to be within the specified band. Ranges which do not fulfill this condition
are ignored.

The R&S ROMES4 measurement file info shows the applied ranges during the mea-
surement.

Figure 3-91: Applied ranges in measurement file info

The ACD Band Slicing feature helps to reduce the scanner load-doing ACD, especially
for wide frequency bands.

3.4.2.2  Capacity test wizard

The R&S ROMES4 DQA Capacity Test job wizard is available for smartphones with
Android OS (QualiPoc devices).

1. Click "Hardware" > "Wizard" > "Capacity Test".

The wizard page opens for the selection of the mobile device if you want to load a
new device.
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Figure 3-92: Wizard opening page applicable for DQA jobs

Note: Instead, you can select the option "Loaded Devices" and in that case the
"Available Devices" list is empty.

2. Select mobile device from the "Available Devices" list.

3. Click "Next".

The page pops-up where you have to define the "URL", i.e. file to load, "Transfer
Time" which is the duration of the test and the number of parallel downloads of the
specified file, "Run Count".
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Figure 3-93: Running wizard for selected device

If you select the second option, you are requested to select device. Select the
device from the "Hardware" > "<Device name>" menu.

4. Click "Next".

The capacity test for the selected smartphone is configured.
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Figure 3-94: Configured job

5. Click "Finish".

The wizard page closes.

The mixture of the upload and download capacity test is supported in the DQA job con-
figuration page, see Chapter 6.5.2, "DQA jobs with Android OS-based smartphones",
on page 1961.

3.4.2.3  cdma/EVDO scanner wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new one ("New Device").
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Figure 3-95: ROMES Wizard page for cdma/EVDO

3. For a previously not loaded device, select "New Device".

4. Select the channels for scanning. The wizard supports selection of up to 12 chan-
nels.

For each selected channel, define the following parameters:
● Channel Name
● Channel Number
● Bandwidth [MHz]
● BCH Demodulation

In the "Demodulation" column you can select System Information Blocks for
demodulation.

● Usage

5. Verify the data that you entered.

6. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.
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3.4.2.4  FTP down- and up-load wizards

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").
For a previously not loaded device, select "New Device".

3. For a previously not loaded device, select "New Device".

4. Specify the ftp server by IP address or name.

5. For "FTP download/upload" wizard only:
● Specify the file to download.
● Enter password and name if necessary.

If you press the "Anonymous" button, the wizard generates password and
name automatically.

● Specify the directory on the server and the local file to upload.

6. For "FTP Download" wizard only:
● Specify the file to download.
● Enter password and name if necessary.

If you press the "Anonymous" button, the wizard generates password and
name automatically.

7. For "FTP Upload" wizard only:
● Specify the file to upload.
● Enter password and name if necessary.

If you press the "Anonymous" button, the wizard generates password and
name automatically.

● Specify the directory on the server and the local file to upload.

8. Verify the data that you entered.

9. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.2.5  GSM NWS wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Devices").

3. For a previously not loaded device, select "New Device".

4. Select the channels for scanning.
For loaded BTS database, you can configure the scanner automatically depending
on the content of the database.
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5. For manual scan, specify a band.

6. For manual scan, put the channels in after specifying the band.

7. Select additional measurements, which the scanner can do. For example, specify
System Information Block messages for demodulation and whether to save spec-
trum into the measurement file.

8. Verify the data that you entered.

9. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.2.6  HTTP download / HTTP download (QP) wizard

For both HTTP Download wizards, the following steps are valid steps:

1. Select device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").

3. For the previously not loaded device, select "New Device".

4. Choose the country, provider and the network for the data connection.

5. Specify the URL of the HTTP transfer file.

6. Set the user name and password for the HTTP download and press "Next".
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Figure 3-96: HTTP download wizard

7. Verify the data that you entered in the opened window.

8. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

The same procedure applies to set up the HTTP Download (QP) measurements via
the associated wizard.

3.4.2.7  LTE scanner wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").

3. For a previously not loaded device, select "New Device".

4. Select the channels for scanning. The LTE scanner wizard supports scanning of up
to 63 channels.

For each selected channel, define the following parameters:
● Channel Name
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● Band
● EARFCN
● BCH Demodulation
● LTE Measurement
Note: A band specification and EARFCN are basis for the frequency calculation.
All other LTE parameters set up according to default values.

5. Verify the data that you entered.

6. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.2.8  TETRA scanner wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").

3. For a previously not loaded device, select "New Device".

4. Select Base Frequency Index.

5. Select Frequency Offset [kHz].

6. Select First Carrier Index.

7. Select Last Carrier Index.

8. Verify the data that you entered.

9. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.2.9  UMTS PNS wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").
For a previously not loaded device, select always "New Device".

3. Select the channels for scanning. The UMTS PNS wizard supports scanning of up
to 32 channels.

For each selected channel, define the following parameters:
● Channel Name
● UMTS band/UARFCN or frequency
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Note: If you want to measure on a frequency which is not the standard 3GPP
UARFCN, select "No UMTS Band".
A band specification and UARFCN are the basis for the frequency calculation.
All other UMTS parameters set up according to default values.

4. In the "Demodulator" column you can select System Information Blocks for demod-
ulation.

5. Verify the data that you entered.

6. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.2.10  WiMAX scanner wizard

1. Select the device that you want to use.

2. Decide if to apply the settings to an already loaded device ("Loaded Devices") or to
a new device ("New Device").

3. For a previously not loaded device, select always "New Device".

4. Select the channels for scanning. The WiMAX scanner wizard supports scanning
of up to 12 channels.

For each selected channel, define the following parameters:
● Channel Name
● Frequency [MHz]
● Bandwidth [MHz]
● BCH Demodulation

In the "Demodulation" column you can select System Information Blocks for
demodulation.

5. Verify the data that you entered.

6. Press "Finish".

The wizard loads and configures the all necessary devices automatically. Now start
the measurement.

3.4.3  Simple hardware loading via workspace

A measurement setup with several devices, loading and configuring them separately
could be time consuming. To improve this activity, the "Load multiple Devices" dialog
can be used. The dialog lists all available devices and lets you load wanted devices
simultaneously. For each device and ACD a template, wizard or configuration can be
selected.
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Figure 3-97: Simplified HW loading test device in on PC testing (classic) mode

To speed up the loading process, choose between loading all devices in a specific use
mode or loading each device in a separate mode. For example, load some devices in
On PC testing (Classic mode) and the other ones in Fully integrated device mode. This
loading improves the devices setup time.

If a device is not loaded, its icon is displayed grayed out in the "Available Devices"
pane of the dialog.
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Figure 3-98: Simplified HW loading test device in fully integrated device mode

Select as many devices for loading as you want to. Press "Continue Loading Devices"
to load them as fast as possible. After the all specified devices have been loaded, pos-
sible wizards or configurations are displayed.

Figure 3-99: All loaded devices
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3.5  Technologies menu

The "Technologies" menu displays all mobile technologies for which R&S ROMES4
supports the specific settings on the installed technology modules. The menu contains
particular configuration pages for several technologies.

Figure 3-100: Technologies menu

The "Technologies" menu contains the following entries, which allow preferred settings:
● "TEC for 5G NR Scanner"

Opens the 5G NR scanner settings page, see chapter Chapter 3.8.2, "Overview of
settings (configuration of software modules)", on page 279

● "TEC for BTS Position Estimator"
Opens the "Position Estimator" settings page, see chapter Chapter 3.8.2.5, "TEC
for BTS positon estimator", on page 294

● "TEC for CDMA2000/ 1x EV-DO Scanner"
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Opens the CDMA PNS settings page, see chapter Chapter 3.8.2.7, "TEC for
CDMA2000 1x Ev-DO PNS", on page 300

● "TEC for GSM Scanner"
Opens the GSM NWS settings page, see chapter Chapter 3.8.2.8, "TEC for GSM
NWS", on page 305

● "TEC for LTE Scanner"
Opens the LTE scanner settings page, see chapter Chapter 3.8.2.12, "TEC for LTE
scanner", on page 341

● "TEC for LTM-M Scanner"
Opens the LTE-M scanner settings page, see chapter Chapter 3.8.2.14, "TEC for
LTE-M scanner", on page 362

● "TEC for NB-IoT Scanner"
Opens the NB-IoT scanner settings page, see chapter Chapter 3.8.2.13, "TEC for
NB-IoT scanner", on page 356

● "TEC for QoS Tester"
Opens the "QoS Settings" page, see chapter Chapter 3.8.2.15, "TEC for QoS
tester", on page 367

● "TEC for RF Power Scanner TSME"
Opens the "RF Power Scanner Signals TSME" settings page, see chapter Chap-
ter 3.8.2.16, "TEC for RF power scanner TSME", on page 369

● "TEC for TETRA"
Opens the "TETRA Parameters" settings page, see chapter Chapter 3.8.2.17,
"TEC for TETRA", on page 373

● "TEC for TETRA Scanner"
Opens the TETRA scanner settings page, see chapter Chapter 3.8.2.18, "TEC for
TETRA scanner", on page 374

● "TEC for UMTS Scanner"
Opens the UMTS PNS settings page, see chapter Chapter 3.8.2, "Overview of set-
tings (configuration of software modules)", on page 279

● "TEC for WiMAX Scanner"
Opens the "WiMAX Scanner TopN" settings page, see chapter Chapter 3.8.2.11,
"TEC for WiMAX scanner", on page 337

Other entries in the menu show only the information on installed module and related
file.

3.6  Measurement menu

The "Measurement" lets users start and stop a measurement and display the list of
event settings.
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Figure 3-101: Measurement menu

3.6.1  Start

 Starts the measurement without writing the data to a file.

A measurement can also be started with the "Start measurement" button on the mea-
surement bar.

The "Start Measurement" command is disabled unless at least one device has been
loaded using the "Hardware" > "Connect/Disconnect" command.
If there are errors with device, the summary error message shows the list of devices
which have problems at the start of measurement.

Before the measurement starts, a temporary measurement file (*.rscmd or *.sqc)
must be defined. To this end, the "Open" window pops-up and offers a list of already
existing measurement files.

1. Select one of the existing files to overwrite previous measurement data.

2. Define a new measurement file if you do not want to overwrite any existing data.
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3. Click the "Open" button to open the selected/defined file for writing and return to
the measurement, which starts immediately.

With a temporary measurement file, it is possible to switch over to recording without
delay while a measurement is running. Otherwise, nothing is recorded and the tempo-
rary file is deleted after the end of the measurement.

3.6.2  Start recording

Click the  button in the toolbar to start the measurement (if not yet running) and write
the data to a measurement file. The replay of the results is later possible based on writ-
ten data in the file.

If the measurement recording is running, the  button gets the function to toggle
recording.

Data recording can also be started by clicking the "Measurement" > "Start Rec." com-
mand of the menu bar. A measurement file (not temporary this time) must be defined
as explained in the previous section.

The "Start Rec." command is disabled unless at least one device is loaded using the
"Hardware > Connect/Disconnect" command.

"Start Recording" creates a block in the measurement file. See Chapter 3.7.9, "Replay
jump to block", on page 222.

Data recording rate

The data recording rate depends on the number and kind of used devices and on the
measurement settings.

Example: 
● Low rate case - 2 GSM test mobiles doing autodial and network quality analysis

with GPS generate data recording rate of about 3 MB per hour.
● Medium rate case - UMTS PN scanner with SIB decoding with GPS generates data

recording rate of about 50 MB per hour
● High rate case - UMTS PN scanner with SIB decoding with GPS and CW test

receiver with raw data generates data recording rate of about 50 MB per hour. The
CW test receiver generates data recording rate of about 25 MB per hour.

Measurement file

The "Start Recording" command overwrites the current measurement file which has
been selected and opened by the "File > Open Measurement File" command, see
chapter Chapter 3.2, "File menu", on page 103). If no measurement file has been
selected yet, the "Open Measurement File" command is executed first which calls the
"Open" window up.
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3.6.3  Stop recording

If the measurement recording is running, you can stop the data recording without stop-
ping the measurement using the same  button.

Data recording can also be stopped with the "Stop Rec." command of the "Measure-
ment" menu.

Stop recording terminates the current block in the measurement file, see Chap-
ter 3.7.9, "Replay jump to block", on page 222.

3.6.4  Stop

Click

Click the  button to stop the measurement and the measurement data recording. The
same button is used to stop the measurement file replay.

An ongoing measurement or replay can also be stopped with the "Stop" command in
the "Measurement" or "Reply" menu bar, respectively.

If "Ask for Comment after the Measurement" is enabled in the "Preferences" dialog,
see chapter Chapter 3.8.1.1, "General settings", on page 224, a user-defined comment
can be stored within the header of measurement file.

3.6.5  Blocks

Opens a submenu to define blocks within a measurement file.

The "Blocks" entry is enabled only while a measurement is running. The menu com-
mands "Start Block" and "Close Block" define the start and end of a block, respectively.
"Discard Current Block" is enabled after "Start Block".

Blocks represent a useful navigation tool within the replayed measurement file; see
Chapter 3.7.9, "Replay jump to block", on page 222.

3.6.6  Events

Click the "Measurement" > "Events" command to open a submenu with a list of up to
10 user-defined events.

A user-defined event can only be triggered if a recording is started. The events are
stored within the measurement file currently recorded. The default names "Event_1" to
"Event_10" can be changed via the "Tools" > "Preferences" command, see Chap-
ter 3.8.1.3, "Available events configuration", on page 238.

To handle event easier, use shortcuts which trigger the individual user events. The
default shortcuts for user-defined events from 1 to 10 are the [Ctrl+F1] to [Ctrl+F10]
keys.
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3.6.7  Set comment marker

Click the "Set Comment Marker" command to trigger including a comment marker
event in the measurement file.

The purpose of the comment marker event is to include a written comment into the
measurement file that is related to the particular time or position when the "Set Com-
ment Marker" was triggered. After "Set Comment Marker" is activated, a comment
entry dialog is shown.

Figure 3-102: Dialog to enter a comment

At the end of the comment, click "OK" to continue the measurement. The "Set Com-
ment Marker" is enabled after "Start Recording". For configuration information, refer to
"Comment event" on page 243.

Note that the measurement recording cannot be stopped unless the comment marker
is closed or disabled.

To trigger a comment marker easier, a shortcut can be used (default is [Ctrl+F12]).

3.6.8  Set voice marker

Click the "Set Voice Marker" command to trigger or stop a voice marker event to be
included in the measurement file.

The purpose of the voice marker event is to include a spoken comment into the mea-
surement file that is related to a particular time or position. After "Set Voice Marker" is
activated, the "Recording (0%)" message in the status bar indicates that R&S
ROMES4 is ready for recording the comment spoken into a connected microphone.

Figure 3-103: Recording status

At the end of the comment, click "Set Voice Marker" again to continue the measure-
ment. "Set Voice Marker" is enabled after "Start Recording". For configuration, refer to
"Voice marker event" on page 244.

Note that the measurement recording cannot be stopped unless the Voice Marker is
closed or disabled.
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To trigger a voice marker easier, a shortcut can be used (default [Ctrl+F11]).

3.7  Replay menu

The "Replay" menu starts and stops the replay of a measurement file.

Figure 3-104: Replay menu

3.7.1  Start

To load a measurement file, click the  icon besides "File" > "Open Measurement
File".

During the replay, the Welcome sheet shows an overview of the currently available
sheets and the views that are opened on them. Click the text to be brought to the cor-
responding item.
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Figure 3-105: Welcome page during a file replay

Hardware devices
To replay a file, it is not necessary to load a device. You only have to configure the
desired views.

Measurement file
The "Replay" command replays the current measurement (*.rscmd or *.cmd) file,
that is, the file opened via "File" > "Open Measurement File", see chapter Chapter 3.2,
"File menu", on page 103. If no measurement file is selected yet, the "Open Measure-
ment File" command is executed first. It means, the "Open" entry is called up.
Note: A replayed measurement file must not have the "Read Only" file attribute. To
replay files from a CD-ROM or DVD-ROM, copy the files to a hard disk or another
appropriate medium. Change also the file attributes.

Monitoring the replay process
Two different tools are indicated while the measurement file is replayed:
● In the measurement bar, next to the icons controlling the replay mode, the "Replay

Speed" is indicated on a marker bar with an meter symbol, see Figure 3-106.
By default the measurement file is loaded at "Min" speed. The replay speed can be
enhanced by dragging and dropping the arrow symbol on the marker bar to the right.
Minimum and maximum speed depends on your system resources.
● On the right-hand side of the status bar, a bar graph indicates the progress of the

replay, i.e. the percentage of data already loaded. It shows the current state of the
replay (block no. or paused) and the elapsed time.
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3.7.2  Pause / continue replay

 /  Pauses (interrupts) and continues the replay process, respectively.

The "Pause Replay" button is unified with the "Continue Replay" button. While a mea-
surement is replayed, the button changes to pause. While pausing, the button offers to
continue replaying.

No replay active
All icons are grayed except the "Continue Replay" icon. "No replay active" is the status
after starting the measurement system or after a replay was completed or stopped.

Replay running or paused
A measurement file is being replayed. You can now pause, jump to another position in
the file, pause, or stop the replay. A paused replay can be continued by clicking the
"Pause" icon again or stopped.

3.7.3  Step one data set forward

 A pause after the next data frame (i.e. the next time when data were recorded) can
be initiated this button on the measurement bar. The function is available while a mea-
surement file is being replayed. If applied repeatedly, it can be used to step through the
measurement file and monitor the individual data frames recorded.

3.7.4  Restart replay

 Stops and restarts the current replay process.

A restart can also be initiated with this button on the measurement bar. This function is
available while a measurement file is being replayed.

3.7.5  Status of the replay process / full speed

 Shows the speed changes of the current replay.

Click the button to toggle replay speed from manually set speed to maximum. If the
current speed is just at the maximum, another click changes it back to the value before
the maximal replay speed was selected. The current replay speed is always shown at
the speed bar.

Figure 3-106: Adjusting the reply speed

3.7.6  Device filter

Opens the "Replay Device Filter" dialog for the test devices in the replayed file.
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The "Replay Device Filter" shows the test devices of the currently replayed measure-
ment file. If no measurement file is opened, it shows the devices included in the last
replayed file. Measurement data from unchecked devices is excluded from the replay.
The dialog is updated each time a new measurement file is loaded.

Figure 3-107: Devices filtering for replay

3.7.7  Jump

Jumps forward and backward in the measurement file.

Click the "Jump" command. The "Replay Jump" window opens.

Figure 3-108: Replay jump
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The current position within the measurement file, the current measurement time, and
the current driven distance is indicated in the three fields to the right of the "Relative/
Time/Distance" radio buttons. The position of the arrows on the marker bar corre-
sponds to the relative time needed to replay the file up to that position in time, relative
to the total measurement time. The current distance is relative to the total distance.

After selecting one of the three parameters "Relative/Time/Distance", the current posi-
tion in the measurement file can be changed by overwriting the value in the field, by
incrementing/decrementing the indicated value with the up/down buttons on the right
side, or by dragging the arrow across the marker bar.

Distance is only available if a trigger device is attached during the measurement.

Measurement files are recorded such that a later measurement time corresponds to a
later file position of the measurement data. The "Replay Jump" function can therefore
be used to select a particular stage of the measurement tour.

If "Change to Replay Pause State after Jump" is checked, the replay is paused after
the jump. Otherwise, it is continued.

In many views it is possible to initiate a replay jump to a particular timestamp in the
measurement file; see Replay jump to timestamp in Chapter 4.1, "Common properties
of R&S ROMES4 views", on page 428.

3.7.8  Replay jump to next event

Jumps forward to the next event in the measurement file.

Click the "Jumping... Event found" command to open the "End of Files" window.

Figure 3-109: End of file
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The events to be searched for must be defined in the "Preferences" > "Available
Events" tab. See chapter Chapter 3.8.1.3, "Available events configuration",
on page 238 before the replay is started.

The event found is indicated in the "Event" panel, together with its time stamp in the
measurement file and the name of the measuring device.

● "Jump to"
List of events, according to the current
Chapter 3.8.1.3, "Available events configuration", on page 238

● "Start Replay"
Defines the start time of the replay to be initiated after a particular event is found.

● "Replay"
Closes the "Event" found window and resumes the replay session, refreshing the
contents of all views. The replay is paused or restarted at the "Start Replay" time,
depending on whether "Change to Replay Pause" is activated or not. At the end of
the file, the "Replay" button is replaced by "Close", the title bar of the window indi-
cates "End of File".

● "Prev. / Next"
Jumps to the previous or to the next event in the measurement file. This button is
disabled if no event is found.

● "Events"
Opens the "Available Events" tab in the "Preferences" menu to change the current
event selection. This button is disabled if no event is found.

3.7.9  Replay jump to block

Jumps to a block in the measurement file.

Recording is interrupted and the "Jump to Block" dialog is opened.

Replay "Jump to Block" is only enabled if a measurement file recorded with R&S
ROMES4 V3.22 or higher containing several blocks is replayed. The blocks must be
defined during the measurement using the Blocks submenu; see below. A new block is
defined each time that recording is started (Start Recording). Stop Recording closes
the current block. A name can be assigned to each block if this feature is enabled in
the Preferences dialog; see Chapter 3.8.1.1, "General settings", on page 224.
The blocks in a measurement file can be exported separately; see Chapter 7.2,
"Exporting data", on page 2099.

The "Jump to Blocks" dialog displays a complete list of the blocks in the replayed mea-
surement file. Each block is characterized by the timestamp for the start (SOB) and
end of the block (EOB).

● "Jump"
Jumps to the selected block and closes the dialog. The replay is resumed or pau-
ses at the start of the selected block, depending on whether the "Change to Replay
Pause State after Jump" box is checked. Jump is disabled if no block is selected in
the list.
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● "Cancel"
Closes the dialog without any further action.

3.8  Tools menu

The "Tools" menu configures the display and defines directories for the different types
of files used by the measurement system.

Figure 3-110: Tools menu entries

3.8.1  System configuration (preferences)

For the system configuration, select "Tools" > "Preferences" of the R&S ROMES4 main
application page.

The "Preference" page contains several entries to configure different system parame-
ters.

● Configuration of the general system and measurement parameters, see Chap-
ter 3.8.1.1, "General settings", on page 224

● Selection of signals to measure out of available signals, see Chapter 3.8.1.2,
"Available signals configuration", on page 228

● Selection and definition of events to monitor, see Chapter 3.8.1.3, "Available
events configuration", on page 238

● Configuration of the measurements, like update rate of the list views, see Chap-
ter 3.8.1.4, "Performance", on page 253

● Configuration of notification center. The center notifies a remote system whenever
the R&S ROMES4 event occurs, see Chapter 3.8.1.5, "Notification center",
on page 254
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● Configuration of formats for date, position, distance and for the scrambling code,
see Chapter 3.8.1.6, "Formats settings", on page 256

● Configuration of Autostart/Restart, see Chapter 3.8.1.7, "Auto-/Restart settings",
on page 260

● Configuration of a measurement file format for upload and export, see Chap-
ter 3.8.1.8, "File handling", on page 265

● The Automatic Channel Detection (UMTS, LTE, NB-IoT, 5GNR) stores all detected
channels in a 1x1 km raster after the measurement, see Chapter 3.8.1.9, "Auto-
matic channel detection", on page 270.

● Configuration the maximum number of supported devices per technology, see
Chapter 3.8.1.10, "Advanced settings", on page 271

● Configuration of the commands to be displayed as bars in "Touch Helper", see
Chapter 3.8.1.11, "Touch helper", on page 277

● Configuration of the custom colors to the color scheme in "User colors", see Chap-
ter 3.8.1.12, "User colors", on page 278

Click "OK" to store the configurations to the current workspace.

Some of the "Preference" functions are not available during a measurement or replay.

3.8.1.1  General settings

Selecting "Tool" > "Preferences" opens the page for general system configuration. The
figure shows default configuration.

Figure 3-111: Preferences – General

After performing configuration, click "OK" to load only the selected devices. Otherwise,
click "Cancel" to return to the default properties and load all devices.
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At installing a new version, the directory is synchronized again until the user switches
off the process. The related registry key is not taken from the former R&S ROMES4
version.

Default Directories
"Default Directories" displays the current default directories for measurement files
(*.rscmd or *.cmd), workspace files (*.rsxks), and exported data files, see Chap-
ter 7.2, "Exporting data", on page 2099. The directories can be changed in the "Browse
for Folder" dialog. To open the dialog, click the "..." buttons.
Adjust the path to the My ROMES directory. Using a new directory request, restart
R&S ROMES4.
After the path has changed, an exclamation mark indicates that the application of the
new path is still pending.

At the next startup of the R&S ROMES4, the following dialog appears.

Choose one of the possible actions:
● "Decline changes"

Do not use the new path - R&S ROMES4 continues using the original path.
● "Set new path and COPY..."

Use the new path - R&S ROMES4 tries to copy all files from the original directory
to new one. Those files are logged to a log file. It can occur that not all files can be
copied due to restricted access rights. Some files can be locked by R&S ROMES4
or another application. Copy those files manually.

● "Set new path but do not copy any files"
Use the new path, but do not move or copy the files.

● "Let me think about it. (Old path will be used, ...)"
The new path remains pending - the dialog appears again at the next startup.
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Measurement info
"Measurement Info" lets you specify the user name, vehicle used for the measurement
tour and the vehicle's ID. The entries are stored in the measurement file and displayed
by opening the measurement file, see the "Open Measurement File" command in
Chapter 3.2, "File menu", on page 103.
● "Generate filenames automatically"

If checked, R&S ROMES4 automatically assigns a file name
(User_Vehicle_VehicleID_Date_Time.rscmd) to any measurement file cre-
ated by executing the "Start Measurement" or "Start Recording" commands.
Otherwise, these commands first open a dialog for selecting the directory and
defining the name of the measurement file.

● "QP / Classic Mode 2 Campaign Name"
The measurement campaign name ROMES Probe can be defined in the "Preferen-
ces" > "General" configuration page, apart from being always displayed in SmartA-
nalytics and NQDI.

Miscellaneous
The "Miscellaneous" pane contains several entries to control the recording of measure-
ment files.
The function to update directory structure at startup is by default ON. Also, the auto-
matically generated view areas function and the option to generate the overview views
only is by default ON. Other miscellaneous functions are configurable.

Ask for Comment after the measurement ← Miscellaneous
If checked, a user-defined comment can be entered before the measurement file is
closed on executing the "Stop Measurement" command.

Ask before Stopping Measurement ← Miscellaneous
If checked, the system asks if to stop the measurement.

Lock Screen if faster than ... ← Miscellaneous
If a speed of moving vehicle exceeds the specified value during the measurement,
R&S ROMES4 switches to "Welcome" view area at the active "Lock Screen if faster
than" option.
The software shows only a minimum set of parameters required for different reasons in
this case.
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Figure 3-112: Locked screen due to exceeded speed

Note: If the Telecom version of the RCS shell-box is detected by R&S ROMES4, the
speed lock is set to 5 km/h automatically, see Support of RCS Telekom.

Clean LogFiles Directory automatically ← Miscellaneous
By default the directory is cleaned at each startup of the R&S ROMES4. All files older
than 14 days are deleted.

Max. Age ← Miscellaneous
The maximum age of a log file is adjustable. Set for how many days your log file is
kept.

Ask for Device Filter ← Miscellaneous
If checked, R&S ROMES4 opens the "Device Filter" selection dialog while opening the
measurement file.
The Chapter 3.7.6, "Device filter", on page 219 shows the test devices of the currently
active measurement file. If no measurement file is opened, it shows the devices of the
last replayed file.
Measurement data from unchecked devices is excluded from the replay. The dialog is
updated every time a new measurement file is loaded.
The first file scan has to be a complete scan. In that case, the user-defined device filter
setting only becomes active after the first complete measurement file scan has been
performed.
After that, the device filter is displayed according to the settings shown in "Device Set-
tings".
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Figure 3-113: Preferences – Device Filter

Note: If a measurement file is scanned for the first time, "Device Filter" is not shown.

Disable Measurement Only Mode ← Miscellaneous
If checked, the Measurement Only mode is disabled. As this mode does not record any
data, it can be helpful to disable it, to avoid it is switched on accidentally.

Show StartUp Wizard ← Miscellaneous
The wizard allows choosing the way of the R&S ROMES4 start. You can select to start
the application with the predefined workspace or project file or to start an empty R&S
ROMES4. In addition, a measurement file can be selected. In this case, it is opened
immediately after R&S ROMES4 booting.
R&S ROMES4 loads automatically only those modules that are supported by the avail-
able licenses and resolved dependencies during startup.

Afterwards ← Miscellaneous
The option lets you choose if R&S ROMES4 switches back to the last viewed "View
Area" or remains on the "Welcome" view area after the speed lock has been released.
For details, see "Miscellaneous" on page 226.

Reset "Dont Ask Again" Dialog ← Miscellaneous
The “Don’t ask again” dialog for R&S ROMES4 reset using this button, refer to "Miscel-
laneous" on page 226.

3.8.1.2  Available signals configuration

The "Preferences" > "Available Signals" dialog displays all the signals available for
viewing and lets configure the range and the color scale for them.
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Figure 3-114: Available signals configuration - 5G NR PRACH Tx power

Signal Tree
The available signals are structured as a tree.
To modify the view, double-click an entry in the columns, for example, the unit, format
or the range of a signal that you want to visualize.
Exp. Min and Exp. Max define, for example, the total y-axis scale of several views (e.g.
the "2D Chart View"). Manual scaling of the y-axis is particularly useful if the actual
value range of a signal (or its range of interest) is considerably smaller than its "natu-
ral" scale. For example, if only small GSM signal levels are measured so that the entire
RxLev scale between 0 and 63 is not needed.
Each signal definition contains a full set of parameters, for example:
● Name, ID and html detail description
● Color scale
● Unit description
● Formatting description
● Ranges
● Physical access description
The configured R&S ROMES4 signals, which are multiplied in a large extent, can
occupy a significant portion of available 2GB memory space, although these multiple
instances of a signal slightly differ. To avoid the high memory usage of the signals, the
signals internal composition is based on pointers to the main common variables of their
multiple instances.
As a result of the pointers-based signal internal composition, all instances of a multi-
plied signal share the setup of:
● Color scale
● Unit description
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● Ranges
The achievements are:
● Signal with full variables content
● Lightweight signal instance, which uses only pointers to the variables of the previ-

ously mentioned signal

Restore Default Settings
The two buttons in the "Restore Default Settings" panel reset the unit, format, and the
expected minimum and maximum to default.
● "All Signals"

Default settings for all signals
● "Selected Signal"

Default settings for selected signal only

Color Scale Configuration
For the selected signal, you can choose a way of the signal visualization in the Route
Tracking or Indoor view, with the support of the "Color Scale for <variable>" dialog. The
dialog opens for the selected signal if you click the "Color Scale Configuration" > "Color
Scale" button.
If no meaningful scale is assigned to the selected signal, the button is disabled
(grayed, and "Not Available" is indicated instead of a color scale.
Since all changes of signal settings made in "Preferences" are unique for each signal,
the changes you make in the "Color Scale for <variable>" dialog are saved at the dia-
log closing with "OK".
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Figure 3-115: Color scale configuration for selected signal

The "Color Scale for <variable>" dialog displays by default-assigned colors to five sub-
ranges of the selected signal range in the "Signals Tree".
The dialog is made of the following sections.

Template ← Color Scale Configuration
Contains a combo-box which offers you all current known color templates. Select other
color set. The selected signal is adapted automatically.
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Figure 3-116: Colorset selection within Template

Once you have selected a color set, it is mapped equidistant to your selection of sig-
nal's range. You can now move the borders in the "Preview" by moving them with your
mouse. The color set is also configurable in "Settings".
● "New"

If you need a template different to the ones already in the combo box, click "New".
For the options available in this button, see "Color Scale Template Editor"
on page 233.

● "Save"
Saves the current color scale as a *.csl template file. At the next R&S ROMES4
startup, this defined color setting is loaded and used.

● "Load"
Opens the "Open" dialog letting you to load a color configuration from a color scale
file defined previously as a template (the "Open" > "File Name" offers the CSL for-
mat).
The color scale files are ASCII text files. They contain the defined colors and the
corresponding ranges.

Figure 3-117: Three colors in the color scale file
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Color Scale Template Editor ← Template ← Color Scale Configuration
As mentioned in the previous text, if you need a template different from the ones avail-
able in the "Template" combo box, click "New". The buttons in "Template" section can
be used for color setting in the following way:
1. The first section is already selected. Click the axis or preview to select a different
section.

2. Change the color of the selected section by changing the color in the "Color" combo-
box.

3. Continue by selecting another section and color.

4. Now, select another section and set its color or try the "Auto fill" button. The button
sets the remaining (empty) sections automatically.
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Using this function, you can create smooth color sets with a variable count of pre-set
nodes (Green G5 and Teal T5 in the example).
Changing the count using the spin-box of the "Count" deletes sections from the end or
adds new sections at the end. Up to 16 colors are allowed.
Use "Insert before" or "Delete" buttons to add a section in a specific location or delete
the selected section, respectively. Save the new template to the Configuration/Color-
scales folder.
All templates stored there are offered in the Template's combo-box of the "Color Scale
for <variable>" dialog.

Preview ← Color Scale Configuration
Shows the current color configuration.
The combo-box on the right in this section shows a list of colors to change the formerly
fixed color settings for the “other” values of the signals. This color is used if the value of
the signal is not within the range of the color scale.

Setting ← Color Scale Configuration
The section offers two ways to set up and display signals coloring.
● Signal coloring of to up to five subranges ("From", "To", each) and the subranges

associated with these colors. The lower limits ("From") in the table can be changed
(double-click a table field under the "From" column and overwrite the entry) but
must remain in ascending order.

● Signal auto-coloring option possible if the "Auto Color: Generated color sequence
with repetition" is checked. The color scale contains 16 colors as default.
In this option, the color of a selected signal is not based on the value, but on the
occurrence of the value. The first occurred value gets the first color, the second
occurred value gets the second color of scale and so on.
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Figure 3-118: Auto-coloring dialog

All the colors generated in this way are unique and the colors of adjacent values
are more different than others. You can edit the colors. Then the color scale is
applied to the whole range of a signal as a repetitive pattern. Almost any change in
a value is shown with a different color.
This function automates the definition of a signal color scale with many colors. A
typical application is, for example, for the TETRA LA signal. It has a large range
and has a different color for each value in a measurement, so that a change in LA
is immediately visible.
The following signals are set to default auto-color if the "Auto Color:..." check-box is
checked:
- 5G NR RAT: NR-ARFCN, PCI
- LTE RAT: EARFCN, PCI
- UMTS RAT: UARFCN, SC
- GSM RAT: BCCH
The "Apply" button generates the new scale after changing the color repetition.

● You can change a color field in the "Settings" > "Color" column within the "ROMES
Color Picker" dialog. The dialog pops-up when right-mouse click the field. This
changing possibility applies to both color setting ways.
A color field in the "Settings" >"Color" column in both setting ways you can change
in the pop-up "ROMES Color Picker" dialog which appears when right-mouse click
the field.
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Figure 3-119: Current color in the color picker

Color Scale for Scanner Measurement Rate Signals ← Color Scale Configuration
For the GSM, UMTS, LTE and cdma/EVDO scanner measurement rate signals an
additional color scale configuration is available.
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Figure 3-120: LTE scanner measurement rate signals

For the scanner measurement rate signals, the standard 5-color scale with 200 Hz
intervals is tailored into 20 colors scale and non-linear intervals. Such a tailoring favors
the lower numbers, as illustrated in the following figure.

Figure 3-121: Color scale for scanner measurement rate signals

Miscellaneous
In this panel you can filter the list of available signals.
Note: By default, the simultaneous configuration of all the signals related to a signal
selected for editing is active. For example, selecting the GSM RxLev signal of a serv-
ing cell, enables measuring and editing up to 6 neighbor cells' RxLev.
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● Filter
A text filter lets you filter the signals by a given text string.
Only signals that include written text are shown. If the parent tree items state was
expanded and the filter does not match any signals, the tree item is collapsed. Oth-
erwise, the tree item remains in the former state.
In the following figure is an example of filtering FTP signal. Only the signals that
include the FTP text are shown.

Figure 3-122: Filtering QoS Testing - FTP signals

3.8.1.3  Available events configuration

The "Available Events" dialog in the "Preferences" > "Basic" is used to select the signal
events for recording during the measurement.

The test system automatically generates the signal events according to the properties
of a measured signal and the settings made in the "Available Events" dialog. The
examples of the signal events are sudden changes of a numeric signal value or recor-
ded actions. For example, a drop of the measured signal power or a channel change
triggers the numeric signal value change. The start of a call or a handover triggers the
recorded action change.

Each signal event definition contains a full set of parameters, for example:
● Name, ID
● Threshold properties definitions multiplied by max device

As the result of the pointers-based signal internal composition, all instances of an
event signal share the threshold settings per device.
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Figure 3-123: Preferences – Available Events

It is possible to configure the R&S ROMES4 events apart from the technologies
events, see "ROMES events" on page 242.

If an event is activated, the event symbol is displayed in general purpose and other
view types, for example, in the "2D Chart View" or in the "ROMESMAP Route Track
View".

An event view displays a chronological record of the all events that occurred during the
measurement.

Under certain circumstances, it can happen that some events are present during
recording but not during replay. The presence of the events during recording but not
replaying can happen if timings in recording and replay slightly differ. The typical case
is when event states exist only for a short time, like below 1 second.

Events

The "Events" tree shows all events available by the R&S ROMES4. The available
events are structured per technology and per device which recorded them, UE or scan-
ner or the R&S ROMES4 counters. The events are associated with symbols. Selecting
an event opens a specific configuration section in the right half of the dialog.

It is necessary to select events you are interested in. Double-click the selected event to
activate it for recording. An activated event is marked by a checkmark and indented.

The "Events" pane contains the "Unselect All" button. To unselect all previously
selected events, press the button. The button is useful if many events must be unse-
lected or to assure that nothing is chosen.
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The selected event in the following figure supports the option to be pointed in time
when device's RAT mode or network changes.

Figure 3-124: Point event in time

The events are directly connected to the corresponding signals in the "Signal Tree". To
get all changes of RAT's mode (UMTS, LTE, 5G, and so on) or networks, check the
"On All Changes" option.

Events of template signals

There are no Top N events available for GSM, UMTS, LTE, NB-IoT and 5G NR scan-
ners. A Top N event is available in the "Events" list if a responding signal is used in the
2D View or the ROMESMAP Route Track View.

Figure 3-125: Top N events are not configurable

The previous note is not true if a scanner Top N event stands for a Top N signal config-
ured as the template signal.

A template signal is not an actual signal, which belongs to one specific value, but a
generic template which can be specific by specifying the templates parameters.

Scanner Top N signals are the most common templates for example. The Top N RSRP
value node in the "Signal Tree" stands for the RSRP value of any TopN pool and pool
member. When the template is added to one of the views, the user is prompted to
enter parameters Top N pool and Top N member to create the specific signal.

These specific signals and their events for the specified Top N pool and Top N member
are available and can be found on the "Available Events" page.
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<Event>
Depending on the selected event, various settings are offered on the right side of the
"Available Events" dialog.
● "Device"

Select events to be generated for only one or for all used devices
● "Enabled"

Event recording is enabled for the selected device, if the event recording is
enabled in the event tree. Double-click the event to label its symbol by a check-
mark.

● "Beep/Sound"
If checked, a configurable sound announces that an event was triggered

● "On All Changes"
If checked, an event is selected whenever the value of the selected parameter
changes
This function is useful to indicate the change of channels or modes, for example. It
is not used for measurement parameters that continuously vary in time, like RxLev.

● "Apply for all devices"
If the button is clicked (and the label appears in a dashed frame), the event set-
tings are valid for all devices used, not just for the device indicated in the "Device"
field.

Finally, the user events "Event_1" to "Event_10" can be renamed for later identification
in the "Event" panel.

Positive Slope/Negative Slope
An event can be triggered when a signal parameter passes a given threshold in
upward or downward direction ("Positive Slope"/"Negative Slope"). This feature is pro-
vided for numeric parameters that cover a range of (continuous or discrete) values,
e.g. RxLev, FER etc.
● "Activate"

If the box is checked, the positive or negative slope event is triggered, respectively.
● "Threshold"

Entry of the positive/negative threshold. The units of the signal are selected auto-
matically.

● "Sound"
A sound to announce that the event is activated by loading a *.wav file which can
be selected via the browse (…) button. The selected *.wav file is indicated in the
"Sound" window. At the same time, the gray square icon on the right side changes
to an icon showing a megaphone. R&S ROMES4 provides a selection of *.wav
files in the "Sounds" subdirectory of its program directory.

Slope Toggle Mode
A toggle mode for crossing threshold events is supported.
If checked, the "Slope Togle Mode (Hysteresis)" prevents getting two consecutives
“positive” or “negative” events. After having triggered a positive event, first a negative
event has to be triggered, before the next positive events can be triggered (hysteresis).
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Figure 3-126: Toggle mode for selected PoP event

Missing the toggle mode activation, the event is triggered whenever the given thresh-
old is passed in the right direction.

Events will be shown in…
The list of all opened views capable of displaying events. The events appear in all
selected views.

ROMES events
At the bottom of the events tree in the "Events" pane, there is the "ROMES Events"
branch.
The "ROMES Events" include:
● "User Events"
● "Marker Events"

The "Marker Events" include the following options:
– "Comment"
– "Voice Marker"

● "Network Survey"
The "Network Survey" includes the options:
– "Threshold Passed Up"
– "Threshold Passed Down"
– "Unknown Transmitter"
– "Too less Satellites"
– "Enough Satellites again"
For more, see Chapter 3.8.7, "Network survey", on page 410.
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The user and comment events must be triggered manually during a measurement.
They are intended to include information into the measurement file that is not automati-
cally recorded. Information such as "traffic jam" or "tunnel in/out" can help during the
assessment of the measurement data.

User Events ← ROMES events
User events are located within the "Romes Events" > "User Events" branch of the
event tree. The events' names can be changed for later identification. Use names such
as "Enter_tunnel", "Leave_tunnel" instead of the default event names "Event_1" to
"Event_10".

Figure 3-127: User events

The event names are shown in the "User Events" list opened by the "Events" com-
mand in the "Measurement" menu.

Marker events ← ROMES events
The marker events comprise the comment events and the voice marker events.

Comment event ← Marker events ← ROMES events
To configure a comment event, go to the "ROMES Events" > "Marker Events" branch
of the event tree.
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Figure 3-128: Comment event

The purpose of the comment event is to include a written information into the measure-
ment file related to a particular time or position. When recording measurement data
("Measurement" > "Start Recording"), you can trigger events using the Chapter 3.6.7,
"Set comment marker", on page 216 command in the "Measurement" menu.
The comment event can be used during recording independently from the activation in
the event configuration menu. However, for displaying a comment event during replay
the activation is mandatory.

Voice marker event ← Marker events ← ROMES events
The voice marker event is also configured in the "ROMES Events" > "Marker Events"
branch of the event tree.
The purpose of the voice marker event is to include a spoken comment into the mea-
surement file that is related to a particular time or position. If recording measurement
data ("Measurement" > "Start Recording"), you can trigger voice marker events using
the Chapter 3.6.8, "Set voice marker", on page 216 command in the "Measurement"
menu.

Network survey ← ROMES events
The R&S ROMES4 notification function offers several possibilities to notify a remote
system whenever some R&S ROMES4 event occurs.
The network survey events are active by default if the "Tools" > "Network Survey" >
"Activate Network Survey" option is checked, see Figure 3-288.
It is possible to activate/deactivate the events manually. For manual actions, check the
"Notification (Measurement only)" check box in the "Network Survey Event" pane.
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Figure 3-129: Dialog to activate network survey events

The events are displayed in the "Basic Views" > "Event View". If necessary, the events
can be published via the Notification Center function.
You can choose a way of notification and set the corresponding parameters in the
"Notification Center" dialog, see Chapter 3.8.1.5, "Notification center", on page 254.

LTE UE and 5G NR UE events

In the following sections some R&S ROMES4 supported events are pointed out. We
are here focusing on EN-DC events and the 5G NR events.

LTE UE events
The events are configured in the Preferences > "Available Events" > "LTE UE Events"
tree.
Some LTE mobile events are described in the following sections.

Redirection and carrier aggregation events ← LTE UE events
These events are configured in the common "RRC Events" branch of the "LTE UE
Events" tree.
Redirection event
The redirection event generates a report whenever an LTE RCC message with a “redi-
rectedCarrierInfo” was received. The target network is displayed in the event info. Also
the event info of the already existing “mobilityControlInfo” event shows the "targetPhy-
sCellId".
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Figure 3-130: Redirection event

LTE-Advanced carrier aggregation events
There are events to inform the user about the point in time when a secondary compo-
nent carrier (SCC) has been added or released.

Figure 3-131: LTE-Advanced carrier aggregation events
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Figure 3-132: Adding carrier aggregation events

RLC radio bearer events ← LTE UE events
LTE RLC radio bearer events generate report wherever a radio bearer is established,
modified or removed.
The events are logged in the "Event View". The "Info" column displays the correspond-
ing unique radio bearer configuration IDs. Also, the events can be visualized in the "2D
Chart View" and "Map View" regarding the point in time, respectively the location, they
occurred.

Figure 3-133: LTE RLC radio bearer events

Note: Replaying old measurement files provides wrong information, which can result in
too many events. Use the event obtained only with the measurement files recorded
with the current R&S ROMES4 version.
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Figure 3-134: LTE RLC radio bearer events configuration

LTE NQA events ← LTE UE events
The NQA events for LTE generate reports concerning a call status and its quality.

Figure 3-135: NQA events for LTE UE call

4G/5G RRC events ← LTE UE events
The events are available in the "LTE UE Events" tree.
The 5G EN-DC RRC events available in R&S ROMES4 since version 19.3 are further
extended.
R&S ROMES4 enhances and extends the RRC event feature with reworked and
refined definitions and structure of the events. There are events for 5G NR IRAT Mobi-
lity and 5G NR CA/DC cell configurations.
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Figure 3-136: LTE UE 4G/5G events

For the description of all 4G/5G RRC events, see Table 12-12.

LTE/5G NR UE RRC measurement events
The "RRC Measurement Events" of both LTE and 5G NR UE can detect the SON-rela-
ted event A3. Additional R&S ROMES4 events for SON are available.
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Figure 3-137: RRC measurement events of LTE and 5G NR UE

The SON events are accounted for the calculation of Mobility KPIs, but can be
observed in the "Layer 3 View".

Figure 3-138: SON events in Layer 3 View

5G NR UE Events
The following figure shows the event groups which are supported.
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Figure 3-139: 5G NR UE supported events

The RRC events make it easy to follow the 5G and LTE message flow based on RRC
messages.
The RRC messages are transferred via the LTE network in the Non-Standalone (NSA)
operation of 5G NR. Therefore, most of the events are found under the LTE events
branch. Only two 5G events for RACH procedure are under the 5G NR UE events.
The Layer 2 DL events provide information on a 5G radio bearer establishment proce-
dure, that is, the bearer addition and release.
The events can be displayed in the "Basic Views" and "Events" if they are enabled.
The "Layer 3 View" display of the events depends on the events activation.
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Figure 3-140: Layer 3 view - emphasis on DC RB messages

5G RRC Events
This group of events supports the overview of events in 5G SA networks.

Figure 3-141: List of the 5G RRC events

For the description of the all 5G RRC events, see Table 12-13.
Loading of an 5G event defined as a *.xml file is done in the following way:
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1. R&S ROMES4 tries to load the file 5GEventConfig.user.xml from the current
users MyROMES\Configuration folder.
2. If this file does not exist, the standard file 5GEventConfig.xml is loaded from
\ProgramData\Rohde&Schwarz\My ROMES\Configuration.

3.8.1.4  Performance

To improve the performance of R&S ROMES4, the update rate of the list views (for
example, the "Top N Views", the "TETRA Scanner Spectrum View", the "RF Power
Scanner Views") is adjustable. The default configurations are shown in the following
figure.

Figure 3-142: Preferences – Performance

Measurement
Data tree shows all the signals available for viewing. Double-click the entries in the cor-
responding columns, for example, display format or a value range (expected minimum
and maximum) to modify the value in a view.
● "Show all measurement results"

The list of views updates for each changed measurement result.
● "Use update rate"

Lists are only updated if measurement results have been changed and the values
are older than the update rate. Set as default 2 updates/sec.

● "Limit of displayed Top N members:"
If selected, limits the count of displayed Top N members in the GSM, UMTS, LTE
and TETRA Top N view. In this way the user can optimize the CPU load during
measurements and recording.
The red line at the bottom of the "Top N List" in the "Top N Overview View" indi-
cates that the Top N pool has more members than displayed, see Figure 4-921.
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Replay
Two buttons in "Restore Default Settings" reset the unit, format, and the expected mini-
mum and maximum to default.
● "Show all measurement results"

The list of views updates each time measurement results change.
● "Use update rate"

Lists are only updated if measurement results have been changed and the values
are older than the update rate.

● "Update rate is coupled to replay speed"
For maximum replay speed, the update rate can be set.
For minimum replay speed, there are two possibilities:
– "Show all measurement results" (default)

The list of views updates each time the measurement results change, if the
replay speed ranges from 0 % up to 10 %. For replay speed above 10 %, a
dynamic update rate is used.
UPDATE_RATE = MAX_UPDATE_RATE * 100 / REPLAY_SPEED_IN_PER-
CENTS

– "Use update rate"
A dynamic update rate is used for all replay speeds.
UPDATE_RATE = MIN_UPDATE_RATE + (MAX_UPDATE_RATE –
MIN_UPDATE_RATE) / 100 * REPLAY_SPEED_IN_PERCENTS

3.8.1.5  Notification center

A channel for notification of a configured network survey event, out of offered ones,
can be selected in the "Notification Center" dialog. The events are by default activated
in the "Tools" >"Network Survey" dialog.

The events can be manually activated/deactivated in the "Preferences" >"Available
Events" > "Network Survey" dialog by checking/unchecking the "Notification (Measure-
ment only)" check-box.
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Figure 3-143: Preferences - Notification Center

The available channels for notification are:
● "SMS"
● "Executable"
● "Write a Logfile per Event"

SMS
R&S ROMES4 can send an SMS by a R&S ROMES4 event occurring. The SMS is
sent using the "ADB" interface of the selected Android smartphone. Ensure that the
ADB is enabled on the phone and connected properly to the computer.
Note: Deactivate the "Screenlock" of the phone.
Successfully tested UE - Samsung Galaxy S5.

Executable
An event also can trigger the execution of an executable or batch file.
Optionally, the event text can be passed to the executable as a parameter, for example
any.exe “Event1”.

This option is useful if you have special needs for the event notification.
For example, use the SNMP Trap Generator (the TrapGen tool) for sending the SNMP
Trap Messages to the SNMP Manager.
The following command entered under "Executable" gives an example how to trigger
the TrapGen tool to send the SNMP Trap Messages:
e:\trapgen293\trapgen.exe -d 192.168.2.1 -v 0.0.0.0.0.0.0000.0.0.0.0 STRING

The command consists of the following parts:
● e:\trapgen293\trapgen.exe which is a path to executable
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● -d 192.168.2.1 which is destination IP address
● -v 0.0.0.0.0.0.0000.0.0.0.0 STRING which is variable parameter, that is,

object ID and a type of variable
The complete variable parameter is necessary to forward the event text as a
parameter if the corresponding check box is checked in "Notification Center" >
"Executable".

Write a logfile per event
An event can be written in a log file. For log file per event, browse the output path.
The log files of the events have the following JSON format:
{"Event":"<EventName>",

"Info":{

"Time":"",

"Type":"",

"Power":"",

"Technology":"",

"Name":"",

"MCC":"",

"MNC":"",

"LAC-TAC":"48020",

"CI":"85943/1",

"Frequency":"806.000000",

<RAT dependent element>

}

}

Audio alarms for device states
The option allows an error/warning sound to play if the error/warning overall state of a
loaded device is detected. Select the wave file that you want to be played in the men-
tioned situations by browsing in the "Warning" and "Error" fields.
The error or warning sound is played whenever the overall state of the loaded device is
red or yellow, respectively.
The sound is played only during measurement or recording.

3.8.1.6  Formats settings

In "Formats" you can set specific formats for exporting.
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Figure 3-144: Preferences – Formats

Exports
● "Decimal delimiter"

This character separates the values of two signals in the export file.

TopN pool signals
Different R&S ROMES4 signal configurations (for example, color scale, limits) can
apply to different Top N pools or providers. However, the signals within the same pool
have the same settings.

UMTS settings
● "Scrambling code format"

"SC Format" opens a drop-down list to select whether the Primary Scrambling
Code in the signals and in the views (e. g. the PNS CPICH) is displayed in decimal,
octal, Hex small or Hex large format.

● "SC Range 0...8176"
According to standard 3GPP TS 35.213, the primary scrambling codes are num-
bered n = 16*i (i = 0 to 512). 15*512 and numbers n = 16*i + k (i = 0 to 512, k = 1 to
15) are reserved for the optional secondary scrambling codes. This convention is
used if SC Range 0 … 8176 is checked. In the alternative convention, the Primary
Scrambling Codes numbers are divided by 16 and cover the range 0 to 511.

5G NR settings
"Cell Identity Split" lets you specify the usage of 36 bits available for 5G NR cell iden-
tity.
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R&S ROMES4 offers the possibility to format the CI value - the format is a string which
specifies how many bits out of 36 CI bits are taken for each group. Groups are separa-
ted by "/". The default splitting is 28/8, but can be anything else, for example, 21/15 or
20/16.
The format is used in "5G NR BCH View" and for the following signals:
- "5G NR UE" > "Serving Cell" > "Cell Identity"
- "5G NR Scan" > "Top N Templates" > "Top N NCI User"
- "5G NR Scan" > "gNodeB Templates"> "NCI User"
The L3 details of 5G scanner/5G UE and 4G scanner/4G UE give additional cell iden-
tity split interpretation. For detailed interpretation, see "5G NR RRC messages"
on page 977/"LTE RRC messages" on page 979 respectively.

Timestamp format
The "Timestamp Format" panel defines the format of the timestamp signal to be inclu-
ded in the measurement file. A timestamp of 36.123 s is displayed as follows:

xxx ms 36123

HH:MM:SS 00:00:36

HH:MM:SS, xxx 00:00:36,123

Note: If "File Scanning" is activated and a measurement file is already opened, all
changes on the timestamp format are active not earlier than the file is reloaded.
Change the timestamp active by closing and reopening the file.

Position format
"Position Format" defines whether the position coordinates used in the views are dis-
played in decimal, degree/minute/second or in UTM format.
The UTM format is shown in the views or info where the position coordinates are dis-
played, like:
● "ROMESMAP Route Track View", see Figure 4-186.
● BTS position in the "BTS Info" and in the "BTS Short Info", see "Show BTS Info"

on page 578.
● "GPS Info View"

Figure 3-145: GPS Info view - UTM position format
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UTM format supported views and dialogs ← Position format
The position of a device can be edited in the UTM format in the following views or dia-
logs:
● "Alphanumeric View"

Figure 3-146: Device[1] alphanumeric view - UTM format

● "BCH view"

Figure 3-147: BCH view, case UMTS scanner - UTM format

● "Base station"

Figure 3-148: Base stations info - UTM format

The dialog is shown when selecting the "Tools" > "Transmitter Database" com-
mand.

● "Modify Transmitter"

Figure 3-149: Modify transmitter data - UTM format

● "Measurement file info: Driven area"
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Figure 3-150: Measurement file info - UTM format

When exporting, a driven area info is shown as:
ASCII Export
[DATA]
13:49:55;?;1;191;-82.35;?;6.15;?;?;?;-103.12; -11.09;5335009;32 N
695587;515.97;0.01
13:49:55;?;1;191;-82.35;?;6.15;?;?;?;-103.12; -11.09;5335009;32 N
695590;515.97;0.02
How to export, see Chapter 7.2, "Exporting data", on page 2099.

Unit "°" is shown for UTM in "Basic Views" and exports.

Distance Format
The "Distance Format" panel defines whether the R&S ROMES4 views use the R&S
ROMES4 trigger distance scale or a user-defined distance scale.

3.8.1.7  Auto-/Restart settings

The tab specifies the autostart and restart settings of R&S ROMES4.

Figure 3-151: Preferences – Auto-/Restart
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Autostart
The function "Use Autostart Mode" activates/deactivates measurements automatically.
If a workspace file is specified, it is used for the measurement.
By elapsing of a measurement cycle, the measurement stops and restarts automati-
cally.
R&S ROMES4 can wait n seconds before starting the first measurement.
If the user stops the measurement initiated by the Autostart feature, the R&S ROMES4
Watchdog stops automatically. There is no pop-up dialog.
At the R&S ROMES4 restart, the autostart function gets active again.

24/7 system stability ← Autostart
A Watchdog timer can observe the R&S ROMES4 operation to ensure the system sta-
bility 24 hours, 7 days. The Watchdog starts automatically if R&S ROMES4 starts up in
autostart mode.
The Watchdog observes the startup process and whether the measurement has been
started automatically.
If any failure occurs, the Watchdog shuts down R&S ROMES4 and restarts it. After
three restarts within a measurement time less than five minutes, the Watchdog stops
the observation and sends a notification to a Notification Center.
R&S ROMES4 itself checks its system health every 60 seconds. It checks if the suffi-
cient memory is available and if all devices are in good shape. If a problem is detected,
R&S ROMES4 shuts down. The Watchdog detects the missing R&S ROMES4 process
and restarts the application.

Restart
The restart function can be used only if the autostart mode is inactive. The function
forces creation of a new measurement file and the measurement restart if the specified
condition is fulfilled.
Optionally, a countdown dialog can be displayed before the restart of the measurement
takes place. Activate the "Show Countdown" option.
Note: R&S ROMES4 does not support measurement files greater than 1.8 GB.
It is possible to create a set of measurement files without restarting the measurement.
Each single file of such a file set is a fully valid and can be replayed, exported or evalu-
ated with R&S ROMES4NPA.
R&S ROMES4 allows opening the complete file set or a part of it for replaying. To gen-
erate a new file during the measurement, select the "Measurement" > "Split" menu
item.
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Figure 3-152: Splitting measurement file

By default, R&S ROMES4 generates a file set when the configured maximal file size or
measurement time has been exceeded. The measurement restart, when creating a
measurement file due to file size or time limits, can be selected via "Restart Measure-
ment when creating new Measurement File".
The format of the file name of the subsequent files of a file set is:
<Filename>.<part>.rscmd
If the user enters, for example, the file myROMESMeasurement.rscmd, the following
files are created:
● myROMESMeasurement.rscmd
● myROMESMeasurement.1.rscmd
● myROMESMeasurement.2.rscmd
● myROMESMeasurement.3.rscmd and so on.
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Figure 3-153: Result of splitting

The "Open" dialog for R&S ROMES4 "Replay" operation mode offers an option to scan
for files sets, see "Scan for File Set" on page 114.
If you want, you can select to open the complete set of files or just parts after identify-
ing a file set. By default, the complete file set is selected.

Figure 3-154: Select file to load

Tools menu



User interfaceDrive Test Software

264Operating Manual 1171.6415.12 ─ 66

If checked, "Close ROMES after <n> cycles" closes R&S ROMES4 automatically after
n cycles of measurement. One cycle is one measurement of <x> MB or <y> minutes as
specified in the "Restart" pane.
If "Use Autostart Mode" is checked, the R&S ROMES4 Watchdog restarts R&S
ROMES4 automatically after it has been closed.
For long-term measurements as monitoring use cases, we recommend restarting every
eight hours. To do so, use the option "Restart measurement when creating new Mea-
surement File", "Create New Measurement File, if the current one is longer than", for
example, "120 minutes" and "Close ROMES after", for example, "4 cycles",
The choice between choosing a longer or shorter restart period depends on use case.
Note: Keep in mind that R&S ROMES4 could run into memory problems, if the amount
of data is too high.

SQZ File Creation
At R&S ROMES4 crash, the measurement fragments of the last measurements left on
the hard disc.
The "SQZ File Creation" function, if activated, creates an SQZ file from these measure-
ment fragments at next start of R&S ROMES4. To create the file, a periodic writing of
SQZ files for QualiPoc, Classic Mode of operation, scanner and GPS measurements is
introduced.
To activate the feature, check the "Enable Cyclic SQZ File Creation" box.
If the feature is activated, the QualiPoc and Classic Mode SQZ files are created and
copied to the measurement folder after 10 cycles of the session loop. The scanner and
GPS SQZ files are created and copied to the measurement folder after 10 minutes.
If R&S ROMES4 crashes, R&S ROMES4 asks you if you want to create an SQC from
the last measurement during after the next restart.

Figure 3-155: Option to create SQC file from crash

If you select "Yes", the action is followed by the information on created file.
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Figure 3-156: Information on created *.sqc file

Note: This feature is only available if the SQC file format is activated.

3.8.1.8  File handling

The "File Handling" dialog lets you select the output format of exported measurement
data files and a way to export them.

The dialog supports upload of measurement files to an FTP server. You can select out
of three supported protocols for uploading to the server. R&S ROMES4 supports the
server public key authentication if the SFTP protocol is selected.

The function to write SQZ files for mobiles and the QoS in classic mode is enabled by
default. The SQZ files (MF-measurement files) ready for post-processing in NQDI and
SmartAnalytics are produced during the R&S ROMES4 measurement using the SQ
Trace Decoder.

Output format
R&S ROMES4 supports the RSCMD and SQC measurement file formats.
The SQC format is a default output format. This option compresses the measurement
RSCMD file and the all related QualiPoc SQZ files to a SQC file (ZIP format). The cre-
ated file has a name of the RSCMD file and the extension "sqc".
For more details, see Table 1-1.

FTP upload
R&S ROMES4 supports the following FTP uploads:
● Upload of the R&S ROMES4 measurement files
● Upload of results of the automatically exported files
The "FTP Upload" options upload the measurement files and/or the results of the auto-
matically exported files. The upload is accomplished if "Upload ROMES Measurement
File" and/or "Upload result of automatically exported file" is checked, respectively.
If both options are checked, both uploads are executed. If both options are deselected,
the entire FTP upload section is deactivated.
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Figure 3-157: Preferences – File Handling

The "FTP Upload" > "Protocol" entry allows for file upload selection among the FTP,
FTPS and SFTP protocols.
At any given time, only one of the three protocols can be enabled. Use the "Test" but-
ton to set the common configuration entries, "Server", "User" and "Password" for files
upload.
R&S ROMES4 supports uploading to subfolders of all FTP protocols.
Enter subfolders in the "FTP Upload" > "Server" edit box. The previous screenshot is
using SFTP as an example.
- Multiple levels of subfolders can be entered.
- Subfolders are auto-created if they do not exist in FTP server.
- Same logic applies to all FTP protocols.
The "FTPS/SFTP Security Settings" pane is dimmed if the FTP or FTPS protocol is
selected as the upload protocol. The pane is active if you select the SFTP protocol.
The entries in the pane are used to make the SFTP server public key authentication.
For the details, see the SFTP protocol section.
FTP upload starts at the point in time R&S ROMES4 switches to a new measurement
file.
Switching to a new file happens if the maximum file size is reached, the maximum
duration of the file is exceeded or the user splits the measurement manually.
If there is seamless file change, the measurement file is not closed by R&S ROMES4.
The features which rely on the accessibility of all measurement files of the current set
file prevent the file to close. Due to the measurement file directory inaccessibility to
FTP loader and the file zipping, R&S ROMES4 creates a copy of the measurement file
(_<filename>.rscmd) and uploads that one.
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Note: If there is seamless file change, it is not possible to delete the measurement file
after upload.
To see the messages of the FTP loader, check the R&S ROMES4 "Output".
If the FTP upload fails, the FTP loader retries the upload every five minutes, unless it
succeeds.
If closing R&S ROMES4 while an upload is still pending, a warning message is issued.
To avoid shortage of disk space, delete the file locally if the system is meant to run
24/7.
● "Password"

The field hides the entered password. The ciphered password is saved in registry.

Figure 3-158: Stored ciphered password

FTP protocol ← FTP upload
If "FTP" is checked for files upload, the "FTPS" and "SFTP" selection components are
inactive.

Figure 3-159: Selection of FTP protocol

Enter the server, user name and password and click "Test" to test the setting and
upload the file to FTP server.

Figure 3-160: Warning to select FTP file
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After the file selection and loading, the messages pops-up indicating the successful
FTP upload.

FTPS protocol ← FTP upload
If "FTPs" is checked for files upload, the "SFTP" selection component is inactive.

Figure 3-161: Selection of FTPS protocol

Click "Test" to test the FTPS settings and enforce file upload.

SFTP protocol ← FTP upload
R&S ROMES4 supports SFTP server public key authentication. For the authentication,
you can use SFTP private key file. A host key fingerprint and user password can be
used. Their usage is optional if the private key file is specified and accepted.
If "SFTP" is checked, the SFTP protocol is available and the FTP and FTPS protocols
are inactive.

Figure 3-162: Selection of SFTP protocol

The SFTP host key fingerprint is displayed in the "SFTP Host Key Fingerprint" when
the SFTP private key file is selected. The SFTP host key fingerprint authenticates the
server.
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The "SFTP Host Key Fingerprint" box can contain a string that is saved in previous
successful upload. Use the  button to clear the content of the box.
The SFTP private key file authentication is added to the SFTP server authentication
option while SFTP upload.

Figure 3-163: SFTP protocol settings

To use private key file for authentication, user’s public key file has to be added to SFTP
server public key container.
The  button lets you browse and select a private key file from the Windows' "Open"
page. The selected file is displayed in the "SFTP Private Key File" box.
The private key file authenticates user.
The  button lets you clear the content in the "SFTP Host Key Fingerprint" and "SFTP
Private Key File" box.
The "Passphrase" box is used to enter a passphrase.
Click "Test" to test the SFTP settings and enforce the selected private key file upload.
User must provide either password or private key file for authentication.
If a private key file is specified and accepted, the server's host key fingerprint is auto-
matically accepted and displayed in the "SFTP Host Key Fingerprint" box. User provi-
ded host key fingerprint and user password are ignored.
If a private key file requires passphrase, enter passphrase accordingly.
If private key file is not specified, or specified private key file is not accepted, password
is used to authenticate the user.

Automatic export
It is possible to export a measurement file automatically. The option needs activation.
The automatic export is triggered after the measurement is stopped or split.
To export the measurement file automatically:
1. Select "Automatically export the Measurement File".
The option is activated.
2. Select the file's export format in "Export Module", for example, ASCII.
3. Browse the configuration file that you want to apply in "Export Configuration" and
confirm the selection with "OK". For creation of such a file, see Chapter 7.2.2, "Export
procedure", on page 2100.
A copy of the measurement auto_export_<measurementfile>.rscmd is created
and the R&S ROMES4 command-line export feature is called to do actual export.
The result of the export is stored in the "Export Result" default folder.
Note: Ensure that the disk has enough space available for the copy of the measure-
ment file and the export result.
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Copy to Folder
Check the "Target Folder" box to activate the option to copy the measurement file auto-
matically to a different folder. This folder can be any folder of the MS Windows operat-
ing system. For example, you can upload the file automatically to the cloud, so that the
measurement file is coped to the cloud folder.

3.8.1.9  Automatic channel detection

The Automatic Channel Detection (ACD) function stores all detected channels (UMTS,
LTE, NB-IoT, 5GNR) in a 1x1 km raster after the measurement. This information can
be used to speed up the channel setup for the next measurements.

To enable, disable or configure this feature (enabled by default) open the "Preferences"
> "Auto Channel Detection" page. The page offers settings, which apply to all technolo-
gies of the ACD.

Figure 3-164: Preferences – Automatic Channel Detection

The left part of the page offers the settings, which can be found at the scanners ACD
settings page also. The right side of the page offers settings for the Reuse feature.

Reuse Detected Channels...
The feature can be switched on and off with the "Reuse Detected Channels of Last
measurements..." check box. The filters can be set based on two criteria.
The option "Use Channels which have been detected in last" > "n Minutes" helps to
speed up the measurement, especially in bad GPS coverage or indoor environment. If
this check box is checked, the new measurements automatically add all channels to
the scanners, which have been detected by the ACD within the last n minutes. The
location is not considered.
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To use the location, enable the "Use Channels with a last detection around the current
position" option. During the drive test, R&S ROMES4 builds up a 1x1 km raster. If any
channel has been measured in such a raster before, it is added automatically to the
technology scanner. It is possible to filter out the raster results by using the additional
time filter. If this filtering option is selected, only channels, which have been actively
measured within the last m days are considered.
It is also possible to clear the channel cache if "Clear Channel Cache" is clicked. The
raster information is built up again with the next measurement. The cache contains the
data for 90 days. Spectra which have not been measured for 90 days are removed.

3.8.1.10  Advanced settings

The "Advanced Settings" option gives the possibility for advanced configuration of
devices and export of all the system settings.

Figure 3-165: Preferences - Advanced Settings

Device Configuration
The following functions related to devices configuration are included in this pane.
Note: The QualiPoc closes when R&S ROMES4 is shutting down by default.
However, QualiPoc does not close if the "Auto Power Off" option in the "QualiPoc Set-
tings" > "Identify Moblie" is checked. For QualiPoc settings, see Figure 6-29.

Synchronize PC time with GPS time on request ← Device Configuration
If checked, the PC time is aligned to an existing time information from a GNSS system,
for example, from GPS. The function checks if a GNSS device is available and the time
information is reliable.
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As it is important that no change of the clock and no timestamps jumps happen within
a measurement, this time setting is implemented only before or after a measurement.
An automatically generated file name consisting date and time is aligned to the time
data in the file.
After loading a GNSS (GPS) device, the time information is monitored.
If the time information from the GNSS device is not available, the system shows its
unavailability in the status bar as .
If a reliable time information from a GNSS device is available and the difference to
GNSS time is below 5 sec, the system shows  in the status bar. If the differ-
ence is more than 5 sec, the system shows .
The mentioned synchronization status indications apply to devices in R&S TSME/
TSME6 which have a build in GNSS chip. It applies also to devices using uBlox proto-
col and NMEA protocol like TSMX-PPS2 and other GPS devices.
Note: The indication of synchronization status does not apply to MAVLink and R&S
HE300.
At the beginning of a measurement or when it stops, the option gives the possibility to
adjust the PC time. If the sync state is , R&S ROMES4 informs about the
time difference and asks for a PC time adjustment. The displayed dialog gives the pos-
sibility to set the PC time.

Figure 3-166: Dialog to set PC time by GPS

Note: R&S ROMES4 needs ADMIN rights for a set time. Without ADMIN rights, set
time does not work.
The GNSS system needs minutes to get reliable time information from a GNSS device
if it is powered on or has bad receiving conditions. Thus, it is necessary to set the
GNSS antenna to good receiving conditions.
If only GPS is used, it needs up to 12 minutes to achieve the leap seconds which
adjust the UTC time by several seconds. Only if the leap seconds info is received, the
time can be considered as reliable. Without reliable time information, the PC time set is
not attempted.
Note: The reported time is in UTC. This UTC time differs to the real-world time by time
zones and daylight savings.
Set the Windows time zone (for example, UTC+01:00 Amsterdam, Berlin, ... ) correct.
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Offer GPS for QualiPoc/iPhone Devices ← Device Configuration
QualiPoc with GPS or GPS of iPhone is available if this option is activated.

Do not check for actual traces during... ← Device Configuration
R&S ROMES4 tests by default if the given COM port delivers actual trace data during
connecting to a Qualcomm UE. Check this option to suppress this test.
"Do not check for actual traces during the connection attempt to a Qualcomm UE"
unchecked is useful for use cases in which UE does not deliver any trace in connecting
state.

Scan for Qualcomm IP Connected Devices ← Device Configuration
The function "Scan for Qualcomm IP Connected Devices from <IP address> to <IP
address>" improves the handling of the diagnostic port per IP connection.
If necessary, R&S ROMES4 can scan for IP diagnostic ports by activating this function.
Set the start and end IP address for scanning and specify the diagnostic port in the
"Port" field.
Note: Only the last byte of the addresses can differ.
R&S ROMES4 scans specified IP addresses and report Qualcomm devices connected
to these addresses.
Note: A device has to support Ping and the Qualcomm diagnostic interface on the
specified port.

QualiPoc Screen Brightness Setting ← Device Configuration
To reduce the device power consumption, the screen of QualiPoc device is dark since
QualiPoc version 23.0. The "QualiPoc Screen Brightness Setting" let you switch
between the following screen brightness:
● "Force normal brightness"
● "Force minimum brightness"
● "Leave brightness as it is" (default)

Ignore the following COM Ports ← Device Configuration
Lets you specify COM ports to be ignored during the hardware scan. Specify the ports
by the full name and separate them using a semi-column, e.g. COM1;COM2;COM3;.
The option is useful if the scanning hangs or device scan takes long. Especially Blue-
tooth COM port can lead to long device scanning duration, for example.

ADB Screen View ← Device Configuration
The "ADB Screen View" option offers to enter a path of an executable file, for example
scrcpy.exe which mirrors the Android device's screen.

R&S ROMES4 supports applications which can mirror the Android device's screen, for
example the AndroidScreenCopy application. The application is called with the stan-
dard ADB parameter -s adbID.

Independently on used application, the application has to accept this parameter to
identify the mobile device (for example, "-s AddroidID"). The application can be called
from "Devices" tab.
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Figure 3-167: Calling the mirroring application

Note: R&S ROMES4 calls the application as specified and is not responsible for the
correct behavior of it.

Links
The "Links" entry in the "Tools" menu shows a list of links to access software programs.
The list is modified via the "Add" and "Remove" buttons.
● "Add"

Opens a file browser window. Here you can select a new software program to be
added to the "Links" list.

● "Remove"
Deletes the selected link from the "Links" list.

System configuration transfer
The R&S ROMES4 system configurations can be exported as the
SystemStatusV473.xml file from one computer and import to another R&S
ROMES4 installation on a different computer. The system configuration transfer
requires administration rights.
All files located in the MyROMES directory are identified by the tag, for example, MyR-
OMES_FileKey.
If a new R&S ROMES4 version is installing, the prerequisite is to open and close the
file before the configuration settings are exported.
The "Export System Configuration" option requests to give an archive file name first.
Then, it saves the current R&S ROMES4 configuration in a zipped archive.
Import a ZIP file by using command-line switches. Two different switches are available:
Romes.exe –sys [file]
Or
Romes.exe –sys_overwrite [file], where

-sys asks before overwriting any file on the target computer.

-sys_overwrite overwrites all files on the target computer without asking.

[file] the name of the ZIP file (optional). If it is not defined, a file selection dialog
appears.
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The SystemStatus.XML file can contain two different XML tags, which both have the
attribute Name:
● RegKey:

The only attribute is "Name", which specifies the subbranch of the R&S ROMES4
(HKEY_LOCAL_MACHINE\SOFTWARE\Rohde & Schwarz\%ROMES_DIR%)
branch in the registry.
RegKey Example 1:
<RegKey Name="General\UMTS_PNS_SETTINGS\*"/>
The command copies all keys of the branch
HKEY_LOCAL_MACHINE\SOFTWARE\Rohde & Schwarz\
%ROMES_DIR%\General\UMTS_PNS_SETTINGS and its subbranches. (“*” is the
wildcard for all below the specified branch)
RegKey Example 2:
<RegKey Name="General\ReplayOnlyVersion"/>
Copies only one key HKEY_LOCAL_MACHINE\SOFTWARE\Rohde & Schwarz\
%ROMES_DIR%\General\ReplayOnlyVersion

● FileKey:
Analogous to the RegKey tag, the FileKey tag specifies files to be transferred.
FileKey Example 1:
<FileKey Name="DriverTemplates\*"/>
Copies all files in the %ROMES_DIR%\DriverTemplates and its subdirectories
FileKey Example 2:
<FileKey Name="Driver\QualcommMobiles.xml"/>
Copies only the file %ROMES_DIR%\Driver\QualcommMobiles.xml

TCM Settings
R&S ROMES4 supports TCM temperature range setting via an own application,
TCMTray.exe. The application is installed automatically with the R&S ROMES4
setup.
The TCM Tray application, at the ROMES Directory/Tools/TCM, can be started auto-
matically or manually by R&S ROMES4.
If started automatically, TCM Tray exists with R&S ROMES4. Its lifetime is bound to
R&S ROMES4.
To allow R&S ROMES4 to start TCM Tray automatically, select the option "Start TCM
Tray at ROMES Startup". After setting this option, TCM Tray is started immediately and
with every start of R&S ROMES4.
For manual TCM Tray start, use the following command-line parameters:
-r: correlated registry path to R&S ROMES4
-c: color scheme (light or dark)

Example: 
TCMTray.exe -r "SOFTWARE\Rohde & Schwarz\Romes22.3" -c light

If you do not enter the right parameters, the following error is displayed.
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Figure 3-168: Response to a wrong parameter

Set the temperature values for issuing a warning message. Allowed range for the lower
temperature value is 23 °C to 25 °C and for the higher 25 °C to 27 °C.
R&S ROMES4 uses the configured temperature values to decide if warnings need to
be issued in the "ROMES TCM" dialog when the TCM temperature is not in the given
range.
Once TCM Tray is running, its icon and status is displayed in the tray box in the follow-
ing way.
Table 3-6: Running TCM tray status

Icon of the TCM tray status Meaning

TCM started and connected. All found devices are in
a normal state (not too hot or cold).

TCM started but not connected. Check your
RPC/TCM device.

TCM connected - one device has a problem as get-
ting too hot.

TCM connected - one device has a problem as get-
ting too cold.

Note: If TCM Tray is started manually, its lifetime is not bound to R&S ROMES4 which
lets you monitor your mobiles without R&S ROMES4.
Note: TCM Tray can be started only once. It does not start, if another TCM Tray
instance is already running. The "TCMTray" information window pops-up the informa-
tion about an already running instance.
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Open the detailed TCM view/dialog using the tray icons menu, see "TCM handling"
on page 151.

3.8.1.11  Touch helper

The "Touch Helper" tab lets you select from the list-box the commands you want to be
displayed as buttons of the "Touch Helper" bar in the "Welcome View" area. You can
also select the color of a button corresponding to the selected command.

Figure 3-169: Touch Helper dialog

"Add" and "Remove" add and remove a button to the bar, respectively. A separator
adds additional space between two buttons and allows buttons to be grouped. The
color of the separator is not used.

Also, the width and height of the buttons can be adapted to the needs of the user.

Press "OK" to confirm the selection.

The settings of the Touch Helper bar are stored in
the ..\My ROMES\Configuration\ folder of the current user.
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3.8.1.12  User colors

The "Preferences" > "User Colors" dialog lets customers define and use their preferred
colors.

New colors can be defined in the "Define Color" pane on the left side of the dialog.

The right side pane shows all currently available colors. The "System Defined Colors
(read only)" shows colors predefined in the Rohde & Schwarz and the "User Defined
Colors" already defined additional user colors.

Up to 100 colors can be defined, removed or changed.

Figure 3-170: User colors dialog

The user colors are stored in .../MyRomes/Configuration/UserColors.xml and therefore
can be shared with other users.

Once defined, user colors can be used just as the predefined colors and selected in
the various color pickers available in R&S ROMES4.
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Figure 3-171: User color pickers

Once a color is picked for a special usage in R&S ROMES4, it is stored with its RGB
value. If you change the color or you delete it, the color is still available for the special
usage.

3.8.2  Overview of settings (configuration of software modules)

● Technologies......................................................................................................... 280
● Technology scanner settings, info, templates....................................................... 285
● Configuration of workspace scanner Top N setting...............................................288
● TEC for 5G NR scanner........................................................................................290
● TEC for BTS positon estimator............................................................................. 294
● TEC for C-V2X scanner........................................................................................ 295
● TEC for CDMA2000 1x Ev-DO PNS..................................................................... 300
● TEC for GSM NWS............................................................................................... 305
● TEC for UMTS scanner.........................................................................................321
● TEC for CW devices..............................................................................................336
● TEC for WiMAX scanner.......................................................................................337
● TEC for LTE scanner.............................................................................................341
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● TEC for NB-IoT scanner........................................................................................356
● TEC for LTE-M scanner........................................................................................ 362
● TEC for QoS tester................................................................................................367
● TEC for RF power scanner TSME........................................................................ 369
● TEC for TETRA.....................................................................................................373
● TEC for TETRA scanner....................................................................................... 374

3.8.2.1  Technologies

The "Technologies" tab in the R&S ROMES4 GUI is used to set the SW modules. Click
the tab to get the list of available modules.

Figure 3-172: List of available SW modules
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The R&S ROMES4 technology scanning capability is characterized with the generic
implementation of some processing, handling and displaying the features that can be
set via "TEC for <variable>" pages.

Figure 3-173: TEC for LTE Scanner page as an example

Most of the R&S ROMES4 "TEC for <variable> Scanner" pages have the common
"Information" and "Templates" page layout.

The TEC configuration pages can be resized (enlarged). The panes within them follow
the size.

Generic implementation of the Top N processing and display features
GSM, UMTS, LTE, NB-IoT, LTE-M, 5G NR and TETRA scanner technologies share the
generic implementation of the Top N processing and the Top N display functions. The
benefit for the user is a common Top N user interface and improved performances.
Note: There are no Top N events available for GSM, UMTS, LTE, NB-IoT and 5G NR
scanners, see Figure 3-125. A Top N event is available in the "Events" list if a respond-
ing signal is used in 2D or ROMESMAP Route Track view.

Top N pool configuration
The Top N pools filtering provides the filtered scanners' result of channels and/or pro-
viders.
There are two ways of filtering GSM, UMTS, LTE, NB-IoT, and 5G NR channels and/or
providers used for Top N pool ranking.
● Automatic pool configuration (not supported by TETRA scanner)
● Manual pool configuration
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If a use case requires an evaluation of the scans sorted out by channel and/or provider,
the user needs the appropriate-filtered pools. Manual filtering is applicable for many
use cases because usually a user scans always the same channels/providers and
therefore the configuration is done only once.
However, the R&S ROMES4 feature Automatic Channel Detection (ACD) gives the
possibility to find and scan unknown networks and automatically create Top N pools.
To open the automatic pool configuration page of a technology, see, for example,
"Automatic Pool Configuration" on page 347. If this option is selected for a technology,
the Top N selector control gets the additional entry "Show all TopN Pools" which shows
all Top N pools present in the Top N list of the "<Technology> Top N Scanner View".
The decision values responsible for calculation and ranking the Top N pools are availa-
ble as signals in "Preferences" > "Available Signals".
Note: If a measurement file is opened or a measurement is active, the Top N pool con-
figuration is disabled.

Automatic channel detection monitoring
ACD monitoring as a R&S ROMES4 supported use case lets you fine-tune the setup
for a long-term monitoring.
The aim of the ACD monitoring use case is interested to detect high power transmitters
which transmit that power.
To optimize the performance of the system, we recommend the following settings:
1. Open a blind scan page of any involved scanner. The figure shows the LTE scanner
ACD page.

Figure 3-174: ACD page of LTE scanner

2. Unselect the "Use Layer 3 Messages" check-box. Otherwise R&S ROMES4 reads
out all neighbor lists of detected transmitters and adds the detected neighbor cells'
channels automatically to the system.
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This automatic approach has a sense during a drive test but is not what is needed dur-
ing a monitoring use case. The monitoring use case aims to measure only actual “on
air” transmitters.
3. Unselect "Create Template". The template can be used to set up a new measure-
ment with the found channels which is not requested for the monitoring use case.
4. Select the appropriate "Sensitivity" dependent on the requirements of the monitoring
use case. This option is available for UMTS, LTE, NB-IoT and 5G NR scanners.
The following table shows the default settings for the sensitivities per supported tech-
nologies. The values in the table show how strong a transmitter has to be at least in
terms of power and quality to be added to the R&S ROMES4 technology scanner.
Table 3-7: ACD default sensitivities per supported technologies

Technology Measured param-
eter

Low Medium High

UMTS Power (dBm) -100 -160 -160

Quality (dB) 3 0 -5

LTE Power (dBm) -100 -160 -160

Quality (dB) 3 0 -5

NB-IoT Power (dBm) -120 -160 -160

Quality (dB) 0 -5 -15

5G NR Power (dBm) -120 -160 -160

Quality (dB) 3 0 -5

Note: -160 (dBm) stands for “power value ignored”, only the quality value is of interest.
If these values do not suit use case, they can be changed in the registry.
1. Open "Start" > "Windows System" > "Run" > "regedit".
2. Navigate to the branch ACD. The path is shown in the line below the menu bar (in
the screenshot shown is the 5G NR case).
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Figure 3-175: ACD branch in regedit

3. Below the ACD branch one branch per technology allows you to adapt the values
(<x>P for Power, <y>Q for Quality).
The actual-used values are written into the measurement file’s info which is the lower
part of the Window's "Open" page of a measurement file you want to open.

Implementation of the dynamic PDU handling
Many broadcast messages are not static but their content varies in time. Demodulation
and display of the broadcast messages dynamic changes is supported by the R&S
ROMES4 implementation of the PDUs dynamic handling applicable to all RATs.
The implementation is generic and is based on configuration of PDUs. For example,
implemented is to the measurements with a repetition interval of SIBs and SIs to
record their changes over a time.
In case a dynamically configured SIB is static and does not change its content during
the measurement, only the last transmission timestamp is shown in the "TimeStamp"
column.
For the dynamic PDU configuration, see for example Dynamic PDU Settings.
The "Measurement Info" of the measurement files shows the repetition interval for
dynamic PDUs. It is displayed directly after the PDU name, as shown in the following
figure.
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Figure 3-176: Dynamic PDU repetition interval as a measurement info

3.8.2.2  Technology scanner settings, info, templates

Each the "TEC for <variable> Scanner" configuration page is a proprietary sheet that
contains multiple buttons on the left side of the page.

Three types of buttons are common for each technology scanner setting.
● Settings
● "Info"
● "Templates"

The figure Figure 3-173 shows them for LTE TEC.

Settings

The Settings function stands for different settings related to Top N pool and Top N sig-
nals settings. The pages vary dependent on technology.

Workspace scanner Top N settings

Scanner Top N settings in workspace are maintained on switching between manual
and automatic Top N setting modes or loading, stopping, closing measurement files.

The main purpose of this feature is to keep the Top N settings in workspace when load-
ing a measurement file and then stop and close it.

The Top N settings in workspace are not supported by TEC for CDMS2000 / 1xEV-DO
Scanner and TEC for WIMAX Scanner, as these technologies do not have automatic
and manual mode. For the configuration of the scanner Top N settings workspace, see
Chapter 3.8.2.3, "Configuration of workspace scanner Top N setting", on page 288.

Info

The following figure shows the "Info" page of the "TEC for LTE Scanner".
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Figure 3-177: Info page

The page contains the scanner information and the "Custom Name" box.

If the custom name is entered, it is shown as the page title. The custom name is saved
to template file if you save current settings to a template. It takes effect immediately.

Templates

You can save the current settings of the all settings pages of a "TEC for <variable>
Scanner" to a template file or reload an existing template file into system.

To save the current setting to a new template file, click the "Save" button in "Templates"
> "Save Current Settings as Template".

The figure shows the "Template" page of the "TEC for LTE Scanner".
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Figure 3-178: Templates page - example

1. Click the "Save" button to save the current settings to a new template file with a file
name given in "Name of Template" or

2. Highlight an existing template file in "Available Templates" list.

3. Click "Save" to save the current settings to that file.

4. Load the saved template file into system by highlighting it in "Available Templates".

5. Click the "Load" button. Instead, double click it.

6. Before loading a template, the following dialog asks you to confirm the action.

7. Click "Yes" to continue loading, otherwise, nothing happens.

All by the R&S ROMES4 supported "TEC for <variable> Scanner" configurations sup-
port this save/restore template procedure.

Many configuration changes require restarting R&S ROMES4.
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Restart R&S ROMES4 after loading a new template. In that way the changes take
effect.

3.8.2.3  Configuration of workspace scanner Top N setting

Workspace scanner Top N setting states

The workspace scanner Top N settings have the following states:

● Default Top N - the Top N settings when R&S ROMES4 starts
● Workspace Top N - the Top N settings with a named workspace
● Updated Top N- the Top N settings with updates on top of Default or Workspace

Top N
● Measurement Top N - the Top N settings embedded in a measurement file.

In this state the Top N setting modification is disabled until the measurement file is
stopped and closed.

Top N setting state transition

The Top N state before opening a measurement file is the base Top N. This base Top
N can be any one of the defaults Top N, workspace Top N, updated Top N or measure-
ment Top N.

The Top N state can change on following actions:

1. Load a measurement file.

2. Load new or a named workspace that closes current workspace

3. Change Top N settings.

4. Close the measurement file.

The following table shows Top N settings state transitions.
Table 3-8: Top N state transition

Source of Top N state Action Destination Top N state

Any Top N state Load measurement Measurement Top N

Any Top N state Load a new workspace Default Top N

Any Top N state Open a named workspace Workspace Top N

Default Top N Change Top N settings Default Top N

Workspace Top N

Updated Top N

Change Top N settings Updated Top N

Measurement Top N on top of
Default Top N

Close measurement file Default Top N
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Source of Top N state Action Destination Top N state

Measurement Top N on top of
Updated Top N

Close measurement file Updated Top N

Measurement Top N on top of
Workspace Top N

Close measurement file Workspace Top N

Typical workflow scenarios

Update Top N settings on default Top N state

If current state is default Top N, after applying any changes, current state is still default
Top N.

A template load also changes the default Top N.

The preferred Top N settings can be saved as templates.

Update Top N settings on workspace Top N state

Current Top N state changes to Updated Top N.

Updated Top N state stays for more Top N setting changes.

The updated Top N is discarded when opening a new or a named workspace.

Load measurement file on default Top N state

The measurement embedded Top N can be loaded depending on user’s choice.

On closing, the default Top N is restored no matter whether the measurement Top N is
loaded or not.

Load named workspace Top N

If a named workspace is loaded, its Top N settings are saved as workspace Top N.

Update Top N settings on workspace Top N state

The updated Top N is saved on top of workspace Top N.

The updated Top N is used to restore the Top N settings on closing measurement file.

The updated Top N is discarded when opening a new or a named workspace.

Load measurement file on updated Top N

The measurement file can be opened on updated Top N.

The measurement embedded Top N can be loaded depending on user’s choice.

On measurement closing, the updated Top N is restored.

The updated Top N is discarded when opening a new or a named workspace.

Load measurement file on workspace Top N

The measurement file can be opened on workspace Top N.
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The measurement embedded Top N can be loaded depending on user’s choice.

On closing, the workspace Top N is restored.

Load template

Loading a template changes default Top N, but not workspace Top N.

The Top N setting changes are discarded when opening a new or a named workspace.

Save workspace

"Save workspace" updates the workspace file including the workspace Top N. The new
Top N setting becomes the new workspace Top N.

Any updates before saving workspace file become the new workspace Top N.

Save workspace as

"Save workspace as" creates a workspace file.

The new workspace Top N is saved; the original file update is discarded.

Any updates before saving workspace file become the new workspace Top N.

3.8.2.4  TEC for 5G NR scanner

R&S ROMES4 supports the configuration of the 5G NR scanner. In 5G NR a transmit-
ter is identified by PCI like in 4G RAN and, in addition, by Beam Index.

Select the "Technologies" > "TEC for 5G NR Scanner" entry to open the "TEC for 5G
NR Scanner" page.
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Figure 3-179: 5G NR Top N pool settings

The page contains the following tabs:
● "Top N Settings", the opening page
● "Settings"
● "Info"
● "Templates"

The 5G NR technology provides signals for the Top N pools and template signals
which are used to get the measurement parameters of a specific gNodeB. For the sig-
nal description, see the "Description of the R&S ROMES4 Signals" document.

5G NR scanner Top N settings

The upper pane of the page lets you select the optional Top N signals for display in the
"Tree View" if they are also selected in the "5G NR Scanner Top N View".

The lower pane lets you specify if to configure the Top N pools automatically or man-
ually.

A number of parameters per each beam and per cell are considered when setting the
scanner. The next section is dedicated to these parameters.
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The following Top N values per cell (PCI) and per beam are configurable:
● RSRP
● RSRQ
● SINR

The values per cell include all beams of the cell which fulfill the specified thresholds.
Click the "Settings" tab to open the page where you can specify the thresholds. The
linear average value over all beams is fed into the Top N algorithm.

Measurements of optional Top N signals
The 5G NR scanner can measure the Reference Signal power, quality and SINR of
synchronization signals (primary PS and secondary SS), demodulation signal (DM),
PBCH, SSB and SS-PBCH signals. The scanner can measure and report the signal
path loss (SLP) of these signals and the received power (x-RePower, where x stands
for any of the mentioned signals).
The power (x-RSRP) is defined as the linear average over the power contributions of
the resource that carry respectively PS, SS, DM-RS, PBCH, SSB, SS-PBCH signals.
The signal to noise and interference (x-SINR) is defined as the linear average over the
power contributions of all present signals divided by the linear average of interference
and noise over the same signals. The signals which can be detected are PS, SS, DM-
RS, PBCH, SSB and SS-PBCH.
The quality (x-RSRQ) is defined as the received quality of all resource elements of the
one of the mentioned signal types.
The optional signals are also those signals that are broadcast in MIB, k-SSB, the gNo-
deB name, distance to the device and so on. k-SSB is the frequency domain offset
between SSB and the overall RB grid.
For the all optional signals and their description, see the "Description of R&S ROMES4
Signals" document.
To have the signals available for measurement, activate them in the "Optional Top N
Signals" > "Signals" pane, see Figure 3-179.
The signals are visible in the Top N view if you configure them in the "5G NR Scanner
TopN View" configuration page, see "5G NR scanner TopN view configuration"
on page 1148. They can be exported and visualized in a map view.
RSRQ is not specified for PS, DM-RS and PBCH. Therefore, the signals remain empty.
RSRQ is defined for SS only.
Note: The scanner history, performance and chart views cannot visualize the previ-
ously listed signals.

5G NR settings

The "Settings" page lets you specify the following:

● "SS-PBCH-RE Power [dBm]"
The configured value of the SS-PBCH RE power is used for calculating the path
loss.

● "Thresholds for Cell Ranking"
A configured threshold value to be used for the cell Top N pool ranking. The availa-
ble thresholds for cell ranking are:
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– "thresholdRSRP [dBm]"
– "thresholdRSRQ [dBm"]
– "thresholdSINR [dBm]"

● "Store High Speed Data for Smart Analytics"
Select the option to store the 5G High-Speed Scanner data into the *.sqc file, if
necessary. By default the option is off.

Figure 3-180: 5G NR settings page

R&S ROMES4 supports all 3GPP TS 38.101 specified band versions, that is, the Ver.
15.20.0, 15.30.0, 15.40.0 (default) and 15.50.0.

The 3GPP TS 38.101 version 15.10.0 was introduced temporary and as being obsolete
is removed from R&S ROMES4.

Replay old measurement files
The old measurement files replay is still supported.

Info tab

The "Info" page is divided into two parts.
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The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.5  TEC for BTS positon estimator

Selecting the "Technologies" > "TEC for BTS Positon Estimator" entry opens the con-
figuration page of the BTS position estimator technology.

Figure 3-181: Position Estimator configuration
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By applying a knowledge base file the estimator adds, respectively overwrites, the esti-
mated positions to all transmitters which have been decoded in the measurement file.

For more, refer to Position Estimation Knowledge Base File.

3.8.2.6  TEC for C-V2X scanner

R&S ROMES4 supports the configuration of the Cellular V2X, that is the LTE version of
V2X, scanner.

Select the "Technologies" > "TEC for C-V2X Scanner" entry to open the "TEC for C-
V2X Scanner" page.

Figure 3-182: C-V2X Top N pool settings

The page contains the following tabs:
● "Top N Settings", the opening page
● "Info"
● "Templates"

The C-V2X technology provides signals for the Top N pools and template signals which
are used to get the measurement parameters of a specific gNodeB. For the signal
description, see the "Description of the R&S ROMES4 Signals" document.
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Top N settings

This configuration page is the standard page for the Top N pool signal settings made of
two panes.

● "Top N Pool Signal Settings" without function
● "Top N Pool"

Top N pool signal settings

The upper pane of the page has no function as there is a single Top N node under the
"Top N Templates" node.

Figure 3-183: C-V2X Top N signals

Top N pools

This lower pane lets you specify whether to configure the Top N pools automatically or
manually.

Automatic Pool Configuration
Automatic is the default Top N pool configuration option. It orders the scanner to use
automatic Top N pool property configuration.
Click the "Properties" button next to the "Automatic Pool Configuration" button to
launch the "Top N Pool Settings" page.
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Figure 3-184: C-V2X scanner automatic pool configuration

Specify the following entries in the "General" pane:
● "Name"

Defines the name of Top N Pools.
The specified name is displayed in "C-V2X Scanner Top N View" background and
Top N drop-down "List".

Figure 3-185: Top N pool names in background

● "Count N"
Specifies the number of top ranked items to display.

● "Sort"
Specifies whether to sort the items in the Top N list or not.

● "Observation"
– "Interval"
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Specifies the interval to refresh the values.
– "Dynamic: Adjust to ..."

The Top N calculation adjusts dynamically the Top N calculation interval to the
max. scan cycle time last minute when the above given interval is shorter.

● "Value"
Drop-down list to specify the decision value for Top N ranking. The possible values
for ranking are:
– Avg BR-SINR
– Avg BR-RSRP

● "Calculation"
Specifies how to calculate the selected decision value for Top N ranking. The pos-
sible options for calculation are:
– Min
– Max
– Avg
– Last

The lower part of this pane specifies the criterion for the automatic pool configuration.
Select the criterion among the following options:
● "Create a TopN Pool for each EARFCN"
● "Create a TopN Pool for each provider"
● "Create a TopN Pool for each provider and EARFCN combination"

Manual Pool Configuration
Click the "Manual Pool Configuration" radio button in the "Top N Settings" pane of the
page, to activate the bottom section of the page.

Figure 3-186: Bottom buttons active in manual pool configuration

The active buttons let you do the following:
● "Add"

Adds a new entry to the list.
● "Remove"

Removes the selected item from the list.
● "Properties"

Launches the "Top N Pool Settings" page to specify the highlighted items.

Tools menu



User interfaceDrive Test Software

299Operating Manual 1171.6415.12 ─ 66

Figure 3-187: Top N pool settings for manual configuration

The "General" pane is the same as the one for automatic pool configuration. For the
entries in this pane, see "Top N pools" on page 363.
The lower part of the "Properties" > "Top N Pool Settings" page has the following
entries:
● "Apply Filter"

If checked, the filter string specified in the edit box below is applied. Otherwise, no
filter is applied.

● Filter String Box
The filter string contains a semi-colon delimited EARFCNs. If "Apply Filter" is
checked, only the EARFCNs of the string are shown in Top N list.
Example: 5514;8448;5110;

● "Apply Filter Provider"
Specifies the list of providers to be shown.

● Provider grid
Specifies the list of providers to be shown.

● "Add Provider"
The button is used to add provider.

● "Add MCC/MNC"
The button is used to add provider by MCC/MNC.

● "Remove"
Removes the selected provider.

● "OK"
The button is used to accept the changes.

● "Cancel"
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The button is used to discard the changes.

3.8.2.7  TEC for CDMA2000 1x Ev-DO PNS

Selecting "Technologies" > "TEC for CDMA2000 1x Ev-DO PNS" opens the configura-
tion page with the following tabs:
● "Top N Settings"
● "Top N Settings in Registry"
● "Signal Settings"
● "Info"
● "Templates"

The "Info" and "Templates" tabs are RAT technology independent.

Figure 3-188: TEC for CDMA2000 1x EV-DO PNS

CDMA PNS Top N settings

The page is opened by selecting "TEC for CDMA2000 1x Ev-DO PNS", see the previ-
ous figure.

The upper pane "In current workspace configured CDMA PNS Top N pools" is used to
administrate the Top N pools of the current workspace.

The lower pane "Performance" is used to set the number of Top N recalculations per
second.

In current workspace configured CDMA PNS Top N pools
The pane shows the Top N pools list configured in the current workspace.
The Top N pool list can be amended using the "Add" button.
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The entries in the list can be deleted using the "Remove" button and the properties of a
list entry can be viewed or modified using the "Properties" button.

Add ← In current workspace configured CDMA PNS Top N pools
Adds user-defined Top N pools in the list of available signals, see Chapter 3.8.1.2,
"Available signals configuration", on page 228.

Figure 3-189: CDMA2000 1xEV-DO PNS - Add page

The "Add" dialog contains the following panes:
"General"
● "Name"

Name of the CDMA PNS Top N pool.
● "Count N"

Number of pool elements (range 1 to 16). The display of pool elements in the list of
available signals is limited to the "Max. Number of members per Top N pool".

● "Sort"
If checked, the initial Top N View list is sorted by the averaged measured signal
power during the observation in the Top N pool.

"Observation"
● "Interval"

Measurement interval in seconds (range 0 to 300).
The observation interval is limited, see Interval.

● "Mode"
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The parameter is used for ranking the Top N pools. The ranking of the pools within
one observation period can be set according to average/max ./min power values.

● "Hysteresis"
The parameter (in dB) is used for FDD cells if the quality measure for cell selection
and reselection is set to CPICH Ec/No.

"Channels/Selected Channels": A list of RF channels to be displayed in the Top N list
can be entered manually. In the channel list the absolute RF channel numbers are
placed in increasing order of ARFCN.
● "All scanned channels"

All scanned BCCH channels are displayed in the Top N Poll list.
● "Selected channels"

Fixed channel list allows the manual entry of the RF channel numbers to be dis-
played in the Top N list. The channels or channel ranges for the scan signals are
set separated by commas (e.g. 1-10,13,90-102).
Dynamic channel list defined by selected mobile: The displayed channels are
defined by the configured test mobile.

Remove ← In current workspace configured CDMA PNS Top N pools
Removes the selected CDMA PNS Top N pool from the "Top N Pool" list, see also
"Remove" on page 311.

Properties ← In current workspace configured CDMA PNS Top N pools
Allows the modification of the properties for the selected Top N pool.
The "Properties" page contains the same panels as the "Add" page.

CDMA PNS Top N settings in registry

The tab opens a page which contains two panes for administrating the scan signal set-
tings of the current workspace.
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Figure 3-190: CDMA PNS Top N settings in registry

General Top N pool signal settings in the registry
The changes in Top N pool definitions made on this panel will affect available Top N
signals only after R&S ROMES4 is restarted.
● "Number of Top N pools in the signal configuration tree"

Defines the maximum number of Top N pools in the list of "Available Signals", see
Chapter 3.8.1.2, "Available signals configuration", on page 228.

● "Max. Number of members per Top N pool"
Defines the maximum members per pool in the list of "Available Signals", see
Chapter 3.8.1.2, "Available signals configuration", on page 228.

● "Optional signals per Top N member"
If checked, the BTS name taken from the CDMA BTS database (if available) is
included in the settings.
Note: Optional signal settings are the R&S ROMES4-specific settings.
The selected optional signals are stored with the current R&S ROMES4 installation
and not at the current workspace. Therefore, if you open the current workspace
with another R&S ROMES4 on another computer, the selected optional signals are
not selected anymore.
Select the optional signals again for that other R&S ROMES4 installation.

CDMA PNS signal settings

The tab opens the page where you can create the signals for each possible PN offset.
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Figure 3-191: CDMA PNS signal settings

Power values
The changes made on this panel will affect available Top N signals only after R&S
ROMES4 is restarted.
● "Create Signals for each possible PN Offset"

Let you specify the maximum number of frequencies (max.12) for which the signals
of each possible PN offset can be created.

Note: When a measurement file is loaded, the frequency is displayed as an additional
information on the parameters in the basic views and in the signal tree.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.
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In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.8  TEC for GSM NWS

Selecting the "Technologies" > "TEC for GSM Scanner" entry opens the "TEC for GSM
NWS" configuration page with the following tabs:
● "Top N Settings"
● "Signal Settings"
● "UE Interference Trigger"
● "Top N Interference Trigger"
● "C/I Analysis Parameters"
● "C/I Analysis Export"
● "Matching ETS"
● "Info"
● "Templates"

The "Info" and "Templates" tabs are RAT technology independent.

Figure 3-192: GSM Scanner Top N Settings
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GSM NWS Top N settings

The "Top N Settings" page is divided into two panes:
● "Top N Pool Signal Settings" to set preferences for the Top N pool signals and acti-

vate some optional signals.
● "Top N Pools" to administrate the Top N pools of the current workspace and to filter

them for ranking.

Top N pool signal settings

The Top N pool definitions' changes made in this pane affect the available NWS Top N
signals only after R&S ROMES4 is restarted.

If the Top N values are used for basic views or exports (for example, for ASCII, KML),
signals have to be defined for the required number of Top N pools. The following
parameters are configurable:
● Number of Top N Pools in the signal configuration tree

Defines the number of signals for different Top N pools respective channels and/or
providers. This number is the maximum number of channels and/or providers that
are expected during the measurement campaign.
For GSM, UMTS, LTE, NB-IoT and TETRA technology, a maximum Top N pool
configurations is limited to 64. If a workspace is loaded from a measurement, there
is a mismatch between the count of Top N pools in the workspace and ones config-
ured in R&S ROMES4. In this case, a message is shown, which explains the prob-
lem and gives a hint for a solution.

Figure 3-193: Warning message for the mismatch

The check is done before actually loading the workspace. You can cancel loading
the workspace, which saves waiting time.
Note: As the GSM, UMTS, LTE, NB-IoT and TETRA technologies share common
base software, this warning message is issued for each of them when the mis-
match occurs.

● Max. number of members per Top N pool
Defines how many members to be post-process and displayed per Top N pool. Set
this value to n if you are interested in the n-th strongest cells per Top N pool
respective channel and/or provider. These values are valid only for post processing
and displaying, and have no effect to the actual measurement. The number of
members is limited to 64.
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● Optional Top N signals
Optional signal settings are R&S ROMES4 specific-settings.
The selected optional signals are stored with the current R&S ROMES4 installation
and not at the current workspace. Therefore, if the current workspace opens with
another R&S ROMES4 on another computer the optional selected signals are not
selected anymore and have to be selected for this other R&S ROMES4 installation
again.
– "BSIC"

Base transceiver station (BTS) identity code. In this view, the BSIC is always
octal (so that BSIC = ab where a is the NCC and b is the BCC), irrespective of
the format selected in "Preference" > "Available Signals", that is, octal/decimal/
hex.

– "MCC"
Mobile Country Code

– "MNC"
Mobile Network Code

– "LAC"
Location Area Code

– "CI"
Cell identity in binary format, 16 bits long string

– "BTS Name"
Name of the BTS, taken from the GSM BTS database (if available).

– "BTS Dist."
Distance to the BTS in km

– "NCC"
Network Colour Code

– "BCC"
Basestation Colour Code

– "C1"
C1 cell selection criterion

– "C2"
C2 cell reselection criterion

– "NR"
Neighbor relation to another members of the Top N pool. It is a percentage of
members which are listed in the BA list. It is available if at least the SI2 is
demodulated.

– "Provider"
Name of the network provider.

Top N pools

The pane lets you choose between the automatic and manual filtering of channels
and/or providers for obtaining Top N pools.

The buttons displayed in this pane depend on selected filtering type. The "Properties"
button is displayed in both cases as needed for configuration of the basic Top N pool
parameters.
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Automatic Pool Configuration
This option creates the pools automatically. Automatic pool creation depends on what
is measured, respectively what was measured when replaying or exporting a file.
Click "Properties" to configure the template for the auto Top N pools.

Figure 3-194: Properties page of automatic Top N pool

The properties in the "General" pane are basically the same as ones of a manually
configured Top N pool, see "Properties" on page 312. The only difference is that the
pool name cannot be set, it is set automatically.
There is only one possibility for Top N pool selection. The "Create a Top N Pool for
each provider" is by default only available.
Note: Automatic pool configuration removes the manually configured pools. To keep
them, save the configuration as a template.

Manual pool configuration
This option shows a list of the GSM NWS Top N pools configured in the current work-
space. The option lets you add more Top N pools or modify the parameters values of
the configured ones.
If this type of Top N pool configuration is selected, the following buttons are displayed:
● "Add"
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● "Remove"
● "Properties"

Add ← Manual pool configuration
Amends additional pools with default settings to the Top N pools list. To customize the
Top N pool, modify it directly in the "Add" dialog or open the Top N pool later on via the
"Properties" button.

Figure 3-195: Manual GSM Top N pool - Add/Properties

The page contains the following panes:
● "General"
● "Observation"
● "Apply Filter"/"Apply Provider Filter"
General
● "Name"

Name of the GSM NWS Top N pool. The name identifies the pool in the views and
in the data tree, so it is worth to select meaningful names.

● "Count N"
Number of pool members, ranging from 1 to 64. The number is limited to avoid a
crash which can occur when entering too high number of Top N members. The dis-

Tools menu



User interfaceDrive Test Software

310Operating Manual 1171.6415.12 ─ 66

play of Top N pool members in the list of "Available Signals" is limited with the set-
tings in the "Max. Number of members per Top N pool" as well.

● "Sort"
In an unsorted pool ("Sort: No"), the members remain at fixed positions unless they
are replaced by a new member having a stronger selected signal ("Value") which is
observed. Unsorted pools are suitable for monitoring a BTS or a fixed set of BTSs
for an extended period of time. They are particularly easy to monitor in graphical
diagrams where fixed positions always correspond to the same BTSs.
In a sorted pool ("Sort: Yes"), the members are sorted according to a stronger sig-
nal which is observed. The positions are redistributed after each update, according
to the observed signals' strengths. Sorted pools are suitable for monitoring or com-
paring signals with definite strength, e.g. the strongest and second-strongest signal
along a measurement tour, irrespective of the transmitting BTSs.

Observation
● "Interval"

Measurement interval given in seconds (range 0 to 300). The interval applies for
selected calculation mode, that is, average/max/min/last (minute). The observation
interval is automatically adapted by the system as long as the measurement period
is longer than the configured one. That value is shown in "Replay" of the Top N
List.
The observation interval is limited to the integer values from 100 ms to 60000 ms.
The warning message appears if the user inserts a value out of the range, see the
following figure.

Figure 3-196: Observation interval limits

The same limitation is valid for CDMA, UMTS, WiMAX, LTE, NB-IoT and TETRA
technologies.

● "Dynamic: Adjustment to Max Scan Cycle Time Last Minute when above given
Interval"
The Top N calculation can dynamically adjust the Top N calculation interval to the
max. scan cycle time last minute when above given interval is shorter.
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The option is switched on by default. The interval is automatically increased to the
max. scan cycle time of the last minute, if this interval is larger than the interval
given in milliseconds. If the interval is shorter, then the members of the Top N are a
randomly changing set, which is not useful.
Before applying any Top N calculation, the first scan-full cycle has to be completed.
NOTE: A valid Top N needs at least one measurement of each frequency.
The "Dynamic: Adjustment to Max Scan Cycle Time" replaces the previous adjust-
ment to the maximum scan cycle time of the total file.
The old GSM Top N settings can lead to a different Top N behavior if comparing the
files of R&S ROMES versions 4.77 and higher with the previous ones. Update Top
N to the “dynamic” option.

● "Hysteresis"
The hysteresis value (in dB) determines the hysteresis for the ranking of the pool
members. To switch it off, enter 0 dB and set the sort mode to "Last".

● "Value"
The parameter is used to select signal type which is used for ranking the Top N
pools. The parameter can be selected between the PSCH (synchronization chan-
nel burst power), C/I and the UE emulation Cue.

● "Calculation"
The parameter determines if the average/max/min/last value of the previously
selected parameter within one observation period is used for ranking.

Filters let you manually select criterion for Top N pool ranking.
● "Apply Filter"

Used for Top N pool filtering based on configured RF channels.
If checked, only the listed RF channels entered by users are considered when
ranking the Top N pool.

● "Channel list"
In the channel list the absolute RF channel numbers are placed in increasing order.
For performance reason (mostly memory usage), it is desirable to configure only a
few of frequencies (channels) for the channel-specific signals. As default, the first n
channels of each scanner are assigned to the channel signals.
Fixed channel list allows the manual entry of the RF channel numbers to be dis-
played in the Top N list. The channels or channel ranges for the scan signals are
set separated by commas (e.g. 1-10,90-102). Single RF channels are defined by
using the separator “;” (e.g. 13; 14).

● "Apply Provider Filter"
Used for Top N pool filtering based on configured provider.
If selected, filters for Top N pool ranking only the selected providers.

● "Provider/MCC/MNC"
Via the "Add Provider" or "Add MCC/MNC" users can add a provider from the "Net-
work Provider Database" to the list of providers or enter directly a combination of
MCC and MNC.

Remove ← Manual pool configuration
Deletes the selected entry from the "Top N Pools" list, after confirmation in the follow-
ing dialog.
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Figure 3-197: Remove Top N pool dialog

The last Top N pool configuration cannot be removed. This approach is applicable for
all ROMES technologies.
The following dialog is displayed in this case.

Figure 3-198: Top N pool cannot be removed

Properties ← Manual pool configuration
Shows the properties of an entry from the list and lets users modify the configured
parameters values.
The button opens the page which is common for GSM, WCDMA, LTE and TETRA Top
N pool properties setting, see Generic implementation of the Top N processing and dis-
play features.
The "Properties" dialog contains the same panes as the "Add" dialog, see "Add"
on page 309.

Scan cycles signals of GSM NWS events

The implemented scan cycle signals in GSM NWS are:
● Scan Cycle Time Total (Average/Min./Max.)
● Scan Cycle Distance Total (Average/Min./Max.)
● Scan Cycle Distance Last Minute (Average/Min./Max.)

Tools menu



User interfaceDrive Test Software

313Operating Manual 1171.6415.12 ─ 66

Figure 3-199: GSM NWS scan cycle signals

One "scan cycle" is defined as the all configured frequencies measured at least once.
One "scan cycle" is also valid if multiple scanners are combined.

The state of the cycle analysis is sampled every 5 seconds and stored in the scanner
data models for coupled focus analysis.

The “total” values are calculated from the complete measurement.

The “last minute” values are calculated with a sliding window of one-minute duration.

A warning has been implemented for long scanner cycle times (> 60 sec). It can be
shown in the file scan phase in replay mode.

Confirm this warning message by clicking the "OK" button during the NPA processing.
The NPA processing waits for this confirmation to proceed.

GSM, UMTS and LTE default scan-averaging time is 2000 ms. A problem with the Top
N updates can already occur earlier than when exceeding a 60 sec scan cycle. Never-
theless, the 60 sec scan cycle time is considered as a major measurement problem.
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Signal settings

This tab opens a page allowing you to administrate the scan signal settings of the cur-
rent workspace.

Figure 3-200: GSM NWS signal settings

General
● "Generate Signals for Channels and Stations"

If the "Generate Signals For Channels and Stations" box is checked, R&S
ROMES4 generates signals for the configured number of channels and stations,
set in other two parameters of the "General" pane.
If unchecked, what is a default setting for the parameter, R&S ROMES4 generates
signals for just one channel selected from the "Scanned Channel<ARFCN\BSCI>
Template" branch in the "Available Signals" tree, see GSM Scanner Templates.

● "Number of channels in the scan signal configuration tree"
Defines the maximum number of channels in the "Signal Tree", see Chap-
ter 3.8.1.2, "Available signals configuration", on page 228.

● "Number of stations per channel in the scan signal configuration tree"
Defines the maximum number of stations per channel. For example, scanned are
several stations on a given channel. 4 stations and 15 channels are shown by
default and the previous parameter.

Default setting for "Generated Signals For Channels and Stations" reduces the number
of scanner measured signals, which otherwise can be huge due to combination of con-
figured number of stations and channels. The deactivated parameter offers easy
accessibility to the measurement data of a specific scanned channel without need of
the former signals.
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Optional signals per channel
● "Total power inband"

Total in-band power (if available)

Optional signals (per measured station)
● "Power SCH"

Code power of the SCH (Synchronization Channel)
● "BTS Name"

Name of the BTS, taken from the GSM BTS database (if available)
● "BSIC"

Base transceiver station (BTS) identity code. In this view, the BSIC is always octal
(so that BSIC = ab where a is the NCC and b is the BCC), irrespective of the for-
mat selected in "Preferences" > "Available Signals" (octal/decimal/hex)

● "NCC and BCC"
Network Color Code and BTS Color Code

● "LAC and CI"
Location Area Code and Cell Identity

● "MCC and MNC"
Mobile Country Code and Mobile Network Code

● "C1 and C2"
Cell selection/re-selection criterion, respectively

Channel assignment
The function assigns a created list of channels to the scan signals. All GSM channels
can be assigned. Even the measurements with GSM1800 and GSM1900 can be evalu-
ated in parallel with scan signals.
The “p” prefix in front of the channel number stands for the option to scan GSM1900
(PCS) channels and distinguish them from the channel numbers of GSM 1800.
The “p” is so far only necessary in the channel list of the scan signal assignment. In
other places there is always a specific network indication given, like “GSM 850 + GSM
1900”.
After assignment, 16 signal parameters are available for each channel in the tree view.
If the channel assignment field is left blank, the parameters are assigned to the first
found channels at run-time. For example, assigned are 1, 2, 3 for GSM900, or 512,
513, 514 for GSM1800 or p512, p513 for GSM1900. The channel assignment fields or
channel ranges for the scan signals are separated by commas (for example,
1-10,13,90-95). If the channel assignment field is filled, the available signal parameters
are assigned to the entered channels. The signal parameters can be displayed, in the
"Alphanumeric View", for example.

Multiple scanners
Allows you to choose how to handle the measurement results of the GSM scanners.
To get the maximum output of the extended GSM C/I Analyzer, the measurement
results of multiple scanner devices are merged in R&S ROMES4 as provided from one
single virtual device. The merging of these measurement results is necessary for the
algorithms used by the GSM C/I Analyzer modules. For normal coverage measure-
ments, this mode offers the most out of the data provided by the scanners.
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The multiple GSM network scanners handling as one virtual device is the default set-
tings.
However, in some situations it is necessary to evaluate the results of different scanners
separately. The typical case is a necessity to compare the performances of antennas.
The comparison is possible by measuring the two antennas under the test with two
scanners.
If you need the GSM NWS measurement results handled separately, uncheck the
"Handle multiple Scanner GSM..." option. Changing the option requires R&S ROMES4
restart.
After the restart, all the C/I related configuration pages are not available anymore in
"TEC for GSM NWS".
The following views are also not available in this mode:
● "GSM Scanner Transmitter View"
● "GSM Scanner Interference Analyzer View"
● "GSM Scanner interference Event View"
Once you again activate multiple scanner options and restart R&S ROMES4, the "TEC
for GSM NWS" and the views behave as all the other scanner technologies. That is,
the multiple tabs for different devices at the TopN and BCH view are shown.
Note: Auto TopN pools are not supported with multiple scanners for any technology.

UE interference trigger

The configuration applies to the selected analysis which is displayed in the top row of
the "UE interference Trigger" page. The analysis type can be selected in the "Selected
analysis" text box.

Figure 3-201: Mobile Interference Trigger
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Mobile interference trigger configuration
● "Generate mobile interference events"

The triggering and detection events must be enabled. Adjacent channels are not
measured by default. Triggering and calculation of the COI event is also by default
OFF, see "Channel Selection" on page 1785.

● "Thresholds for Interference Detection and Event Generation"
Sets the conditions for interference event detection. The conditions can be set
independently for serving cells that operate at constant frequency (Frequency Hop-
ping Off column) or in frequency-hopping mode (Frequency Hopping On column).
An interference event is detected if both the measured RxLev and RxQual values
exceed a threshold for a sufficient number of samples within a certain period of
time.
– "RxLev"

Minimum received signal level required for an interference situation. The value
can be entered either as a RxLev value in steps from 0 to 63 (steps) or as an
absolute level in dBm.

– "RxQual"
Minimum received signal quality required for an interference situation. The
value can be entered either as RxQual value (range 0 to 7) or as a minimum
Frame Error Rate (FER) detected by the test mobile, expressed in %.
In case RxQualS < RxQualF (that is, when DTX in downlink is used), the sub
values are used.

– "Monitoring Interval in Seconds"
Period of time for the evaluation of the trigger conditions for RxLev and
RXQual. The monitoring interval is a moving time interval ranging up to the cur-
rent measurement time.

– "Detected Samples during Monitoring Interval in %"
Minimum percentage of measurement points within the monitoring interval ful-
filling the trigger conditions for both RxLev and RxQual. A minimum percentage
of 3% or larger is required.

Top N interference trigger

The "Top N Interference Trigger" tab opens a page which allows you to configure the
trigger conditions for interferer reporting, that is, the threshold values for interference
detection and event generation for the selected Top N members as a trigger sources.
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Figure 3-202: Top N interference trigger configuration

C/I analysis parameters

The "C/I Analysis Parameters" tab opens a page which allows you to configure the
interferer reporting of the selected analysis.

It contains a check box for switching the calculation and reporting of potential interfer-
ers on or off.

A C/I threshold level [dB] limits the reporting to interferers which have a worse (lower)
C/I.

A choice can be made to use the min. C/I or the average C/I for reporting and thresh-
old decision.

A leading and a trailing time span [s] can be configured before and after the event
duration to include more measurements into the analyzed time span.

Furthermore, the check box allows switching the use of SYSTYPE1 information on Tx
channels on or off. If the SYSTYPE1 information is not reliable, it is useful to switch it
off.
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Figure 3-203: C/I analysis parameters configuration

C/I analysis export

For the COI interferer export, it is possible to select which states of interferers can be
included. Default is "Confirmed" interferers.
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Figure 3-204: C/I analysis export configuration

Matching ETS

Figure 3-205: Matching ETS

● "Upgrade ETS measurements to SCH measurements"
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If this option is enabled, an Extended Training Sequence (ETS) is upgraded to an
SCH measurement if an SCH could not be measured.

The upgrade depends on a match in timing that uses the following parameters:
● "Time Offset (Microseconds)"

Defines the time offset in microseconds.

● "Time Drift (ppm)"
Defines the time drift in ppm.

● "Time Span for ETS (Minutes)"
Defines the time span for ETS in minutes.

● "Max. Time Error (Microseconds)"
Defines the maximum time errors in microseconds.

● "Set default Values"
The button resets the configured parameters to the default values. Before the
resetting, you are asked if you really want to reset to default value.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.9  TEC for UMTS scanner

Click the "Technologies" > "TEC for UMTS Scanner" entry to open the UMTS PNS con-
figuration page.

The following tabs are available:
● "Top N Settings", the opening page
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● "Signal Settings"
● "Pilot Pollution"
● "Info"
● "Templates"

The "Info" and "Templates" tabs are RAT technology independent.

Figure 3-206: TEC for UMTS PNS

UMTS PNS Top N processing done as postprocessing

The Top N configuration and calculation is a task of UMTS scanner postprocessing and
follows the processing scheme of the other technologies. Therefore, the measurement
files do not include Top N records.

One major benefit of doing the Top N and Pilot Pollution calculation in the postprocess-
ing is the possibility to change the calculation parameters according to needs.

Multiple UMTS PNS configurations

Multiple of R&S TSME can be configured for UMTS PNS measurements. The configu-
ration is done in the "Hardware Configuration" page, as the following figure displays.
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Figure 3-207: Multiple UMTS PNS configurations via hardware configuration page

This feature opens many possibilities for measurements configurations, for example,
higher measurement rates by using more scanners or dedicated scanning tasks apart
from general scanning tasks.

The following is applicable for the configured multiple devices, if not mentioned other-
wise:
● During an UMTS PN scan, the test devices measure and identify all UMTS down-

link (NodeB) signals in the air.
● The spectrum analysis consists of a frequency sweep over a specified range to

detect arbitrary UMTS downlink and uplink signals.

Do not configure the same frequency/UARFCN for two UMTS PN scanners.

UMTS PNS Top N settings

The configuration page, see the Figure 3-206, is divided into two panes:
● "Top N Pool Signal Settings" lets you select some optional signals
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● "Top N Pools" lets you administrate the Top N pools of the current workspace and
to filter them for ranking
The configuration is used to evaluate the Top N pools and to display them in the
"UMTS Scanner Top N View".

As the Top N pools also appear in the signal tree, they can be analyzed in general R&S
ROMES4 views, for example, in the "Alphanumeric View"or "ROMESMAP Route Track
View".

The UMTS scanner Top N configuration page is derived from a generic scanner Top N
configuration page.

The UMTS PNS Top N configuration is valid for all used UMTS PN scanners. All scan-
ners have the same Top N pools configuration.

Top N pool signal settings

The maximum number of Top N pools can be limited in the "Measurement"
on page 253.

In the "UMTS Scanner Top N View" the optional signals can be displayed apart from
the default ones if selected in "Top N Pool Signal Settings".

There is a single Top N node under the "Top N Templates" branch in the "Signal Tree"
showing all default and selected optional signals.

Optional Top N signals

Note: Optional signal settings are the R&S ROMES4-specific settings.

The selected optional signals are stored with the current R&S ROMES4 installation
and not at the current workspace. Therefore, if the current workspace opens with
another R&S ROMES4 on another computer, the optional selected signals are not
selected anymore and have to be selected for this other R&S ROMES4 installation
again.

The following optional signals can be selected:
● "P(PSCH)"

The signal power of the Primary Synchronization Channel of all recorded DL UMTS
signals.

● "P(SSCH)"
The signal power of the Secondary Synchronization Channel of all recorded DL
UMTS signals.

● "Ec/Io (PSCH)"
Ratio of the received energy per PN chip for Primary Synchronization Channel to
the total transmit power spectral density.

● "Ec/Io (SSCH)"
Ratio of the received energy per PN chip for Secondary Synchronization Channel
to the total transmit power spectral density.

● "Doppler"
Doppler frequency due to a relative movement of the test vehicle to the Node, that
is, a cell pilot signal deviation due to movement.

● "Code Group"
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Scrambling code group
● "Delay Spread"

RMS (Root Mean Square) delay spread in chip periods - standard deviation of the
time delay DeltaT at all CPICH measurement points weighted with the measured
power Ec (CPICH). A small delay spread indicates that the individual CPICH peaks
of the NodeB signal are relatively close or that the power of peaks with different
time delay is low.

● "Drift [ns/s]"
Mean time drift of P-CPICH concerning the internal clock which can be synchron-
ized with the PPS of GPS.

● "Std.Dev.Drift"
90% confidence interval width of the average time drift. A small value indicates that
the drift measurement is estimated to be relatively accurate.

● "Cue-Qual"
Cell reselection criterion value based on UE emulation by quality information in
system information blocks.

● "Cue-Lev"
Cell reselection criterion value based on UE emulation by level information in sys-
tem information blocks.

● "NR"
The Neighbor Relation is the percentage of cells in the current Top N pool, which
are the members of the specific intra-frequency neighbor cells list. The signal is
available only if at least SIB11 and SIB12 are demodulated.

● "Add. PLMNs"
Additional PLMNs shared on this NodeB.
R&S ROMES4 supports the 3GPP specified RAN Sharing feature. The feature
supports that a physical base station serves several network operators, i.e.
PLMNs.
Check "Add. PLMNs" to visualize the base stations for all PLMNs in the list. The
info about primary PLMN is a part of the standard MIB message, while the list of
additional PLMNs is contained in the "v690NonCriticalExtension" element.

Figure 3-208: RAN sharing info in v690ext MIB

Note: The shown MCC and MNC signals of the NodeB in the TopN List view are
always related to the primary PLMN. However, for TopN pools, filtering of NodeB
signals applies to all PLMNs that are in the list and the mentioned signals are
shown in the "Add. PLMNs" column.
If the TopN pool is created automatically for the PLMNs, a pool for each PLMN in
the list is also created automatically.

● "Frame Time of arrival offset to PPS"
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Time difference between PPS and the start of a UMTS frame received by the scan-
ner (only available if the Position Estimation option was available during the mea-
surement).

● "Frame Number of arrival offset to PPS"
Virtual frame number between PPS and the start of a UMTS frame received by the
scanner. It is virtual frame number of the RF frame in which the CIR has been mea-
sured.

To activate the signal configuration changes, R&S ROMES4 must be closed and
restarted.

Top N pools

The pane lets you choose between the automatic and manual filtering of channels
and/or providers for obtaining the Top N pools.

The buttons displayed in this pane depend on selected filtering type. The "Properties"
button is displayed in both cases as needed for configuration of the basic Top N pool
parameters.

Automatic pool configuration
This option creates the Top N pools automatically for the user. Depending on what is
measured, respective what was measured when replaying or exporting a file, the pools
are created automatically.
Click "Properties" to configure the template for the auto Top N pools.
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Figure 3-209: Automatic UMTS Top N pool filtering

The properties in "General" are basically the same as the properties of a manually con-
figured Top N pool, see "Manual pool configuration" on page 328. The only difference
is that the pool name cannot be set, it is set automatically.
The main difference in this case is that you have to select the criterion for the auto-
matic Top N pool configuration among the following:
● Channel-based selection

If selected, evaluates Top N pool for each frequency (UARFCN) which is scanned.
● Provider-based selection

If selected, evaluates Top N pool for each provider in the provider list. If provider
has several channels, the Top N pool is evaluated for all those channels.
Note: Transmitters are only added to the Top N pools evaluation from the point in
time when their PLMN code has been decoded.

● Provider and UARFCN combination-based selection.
If selected, evaluates Top N pool for all combinations of provider and channels.
The option helps to separate providers from each other if they share the channels,
for example, at a country borders. The previous note applies to this selection as
well.

Note: Automatic pool configuration removes the manually configured pools. To keep
them, you can save the configuration as a template.
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Manual pool configuration
The option shows a list of the UMTS Top N pools configured in the current workspace.
It lets you add more pools or modify the parameters values of the configured ones.
If this type of Top N pool configuration for filtering and ranking is selected, the following
buttons are displayed:
● "Add"
● "Remove"
● "Properties"

Add ← Manual pool configuration
Amends additional pools to the default settings to the Top N pools list. To customize
the Top N pool, modify it directly in the "Add" dialog or open the Top N pool later on via
the "Properties" button.

Figure 3-210: UMTS PNS Top N pool - Add/Properties

The page contains the following panes:
● "General"
● "Observation"

Defines the update interval and the criteria for Top N pools evaluation and ranking
● "Apply Filter/Apply Provider Filter"
● Defines the criteria for the Top N pools filtering
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The "General" pane contains the following entries:
● "Name"

Name of the UMTS Top N pool. The name identifies the pool in the views and in
the signal tree. Therefore select the meaningful names.

● "Count N"
Number of Top N members in a Top N pool. The number is limited to 64 to avoid a
crash which can occur when entering too high max count of top N members. The
actual number of elements can fall below N and vary if the system is not able to
detect and analyze enough signals.

● "Sort"
In an unsorted pool ("Sort: No"), the members remain at fixed positions unless they
are replaced by a new member having a stronger selected signal ("Value") which is
observed. Unsorted pools are suitable for monitoring a NodeB or a fixed set of
NodeB for an extended period. They are particularly easy to monitor in graphical
diagrams where fixed positions always correspond to the same NodeB.
In a sorted pool ("Sort: Yes"), the members are sorted according to a stronger sig-
nal which is observed. The positions are redistributed after each update, according
to the observed signals strengths. Sorted pools are suitable for monitoring or com-
paring signals with definite strength, e.g. the strongest and second-strongest signal
along a measurement tour, irrespective of the transmitting NodeBs.

The "Observation" pane contains the following entries:
● "Interval"

Lets you calculate the evaluation period as minimum/maximum/average/last or the
measurement value (Ec/Io, RSCP of CPICH or Cue) for all signals. The selected
calculation value is recalculated and the pool is updated every time the system
receives a new UMTS PN scan data. The Ec/Io, RSCP or Cue values received
within the evaluation interval before the current time is entered into the calculation.
Large evaluation intervals tend to stabilize the pool by delaying the exchange of
pool elements.
The observation interval is limited, see Interval.
The observation interval obeys the following rules:
– The interval is always a multiple of 0.016 s regardless of the measured rate if

only one frequency exists in the Top N pool.
If the current value differs, the following warning appears.

The correction is performed automatically.
– If there are multiple frequencies in the Top N pool, the minimum interval

depends on the number of frequencies in the measurement and the sampling
rate according to the formula:
2 * (number of frequencies in the measurement) / sampling rate + 0.5 s.
e.g.: 2 * (4 Freq.) / 0.1 + 0.5 = 80.5 s
Sampling rate = number of measurements per second
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● "Dynamic: Adjustment to Max Scan Cycle Time Last Minute when above given
Interval"
The Top N calculation adjusts dynamically the Top N calculation interval to the
max. scan cycle time last minute if the previously given interval is shorter.
The option is on by default. The interval is automatically increased to the max.
scan cycle time of the last minute, if it is larger than the interval given in millisec-
onds. If the interval is shorter, then the members of the Top N are a randomly
changing set which is not useful.
Before applying any Top N calculation, the first scan-full cycle has to be completed.
Note: A valid Top N needs at least one measurement of each frequency.

● "Hysteresis"
Minimum level difference between the signal value of a pool candidate and the low-
est signal value in the pool. A pool candidate becomes a pool element and repla-
ces a previous element if
Ec/Io or RSCP (candidate) ≥ Ec/Io or RSCP (previous) + Hysteresis
A large hysteresis stabilizes the pool, preventing elements from being replaced
because of small fluctuations in the measurement results.

● "Value"
Indicates selected signal for ranking the Top N pools. For that purpose the Ec/Io,
RSCP or UE emulation criterion (Cue) signal can be observed. The first two signals
make ranking according to quality and power, respectively. If you wish to rank the
detected cells based on the UE emulation criterion, choose the third option.
Often, only one network is under the investigation, so probably you would like to
set a provider filter to the Top N configuration. The configuration of the Top N pool
has to be done before a measurement file is going to be opened, respectively a
measurement is started.

● "Calculation"
Determines if the "Min/MaxAverage//Last" value of the previously selected parame-
ter is used for ranking within one observation period.
Ec/Io (CPICH) is the ratio of the received energy per PN chip for the P-CPICH to
the total transmit power spectral density, see Chapter 4.8.11.3, "UMTS scanner
CPICH view", on page 1383.

The filtering part of this page contains the following entries:
● "Apply Filter"

Used for Top N pool filtering based on configured UMTS channels.
If checked, only the listed UMTS channels (UARFCN) are considered when ranking
the Top N pool.

● "Channel List"
In the channel list the absolute UMTS channel numbers are placed in increasing
order. For performance reason (mostly memory usage), it is desirable to configure
only a small number of frequencies (channels) for the channel-specific signals.
Single UMTS channels are defined by using the separator “;”. The range of UMTS
channels is defined by using the “-“ separator.

● "Apply Provider Filter"
Used for Top N pool filtering based on configured provider.
If selected, filters for Top N pool ranking only the selected providers.

● "Provider/MCC/MNC"
Use "Add Provider" to selected and add a provider to the list from the "Network
Provider Database" page. Instead, you can use "Add MCC/MNC" to enter directly a
combination of MCC and MNC.
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"Top N Signals" and "Top N Pools" are dynamic concepts. The signal level from a spe-
cific NodeB varies in time and according to the measurement position. The elements of
a Top N pool are exchanged accordingly and even their number can change if the sys-
tem detects less than N signals.

Remove ← Manual pool configuration
Deletes the selected entry from the "Top N Pools" list; see "Remove" on page 311.

Properties ← Manual pool configuration
Shows the properties of an entry from the list and lets you modify the configured
parameters values; see "Properties" on page 312.

Scan cycles signals of UMTS scan

The following figure shows the implemented scan cycle signals in UMTS scan.

Figure 3-211: UMTS scan cycle signals

For details, see "Scan cycles signals of GSM NWS events" on page 312.

UMTS PNS signal settings

Click "Signal Settings" to get the page letting you to do the following:

● Selection of a data format of the scrambling code and configure channel frequen-
cies.

● Configuration of the CIR signals for each scrambling code and predefined number
of frequencies.

● Selection of UARFCN channels for assignment to the scan list.
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Figure 3-212: TEC for UMTS PNS - UMTS technology window

The number of signals configured for scanner receiver and the enabled options stay
unchanged. Therefore, the signal settings function does not affect the measurement.

Format
● "SC Format"

"SC Format" opens a drop-down list to select whether the Primary Scrambling
Code in the signals and in the views (for example, in the chapter Chapter 4.8.11.4,
"UMTS scanner P-SCH view", on page 1391) is displayed in decimal, octal, hex
small or hex large format.

● "SC Range"
According to standard 3GPP TS 35.213, the primary scrambling codes are num-
bered as n = 16*i (i = 0 to 512). The 15*512 numbers n = 16*i + k (i = 0 to 512, k =
1 to 15) are reserved for the optional secondary scrambling codes. This convention
is used if "SC Range 0 … 8176" is checked.
In the alternative convention, the Primary Scrambling Codes numbers are divided
by 16 and cover the range 0 to 511.
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CIR signals
The default setting for "Generated Signals for each possible Scrambling Code" is
unchecked. The unchecked option reduces the number of scanner measured signals,
which otherwise can be huge due to combination of configured number of SCs and
channels. The inactive option offers easy access to the measurement data of a specific
scanned channel.
If "Create Signals for each possible Scrambling Code" is checked, the R&S ROMES4
creates CIR signals for each of the 512 Primary Scrambling Codes allowed for the
downlink UMTS signal and for the number of frequencies selected in the "Max" drop-
down list. The number of created signals is 512*n, where n denotes the selected num-
ber of frequencies.
The CIR signals are filled with data when a measurement or replay session is started.
The CIR signals can be configured in "Preferences" > "Available Signals", see Chap-
ter 3.8.1.2, "Available signals configuration", on page 228 and analyzed in many
generic views, for example, in the "2D Chart View".

Figure 3-213: Configured CIR signals

In the replay session, however, a few displayed signals have several advantages:
● Signal tree is easier to handle as unwanted signals are omitted.
● Performance is improved as less system resources are needed.
It is possible to avoid the previously described setting for CIR signals as a combination
of each CS and selected number of frequencies. As the number of combinations in that
case can be huge, the number of measured signals becomes also huge. The obtained
huge number of signals makes it difficult to find and select the required measurement
data.
The "CIR SC<UARFCN\SCI > Template" branch of "Available Signals" enables easy
access to the measurement data of interest. For details, see UMTS Scanner Tem-
plates.
Omitting the CIR signals does not affect the functionality of the Chapter 4.8.11, "UMTS
scanner views", on page 1370.

Channel assignment
For performance reason (mostly memory usage), it is desirable to configure only a few
frequencies (channels) for the channel-specific signals.
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The channel assignment option offers to configure a list of channels (UARFCN) to be
used as CIR signals. The feature applies to multiple scanners of the UMTS technology.
With this option, it is possible to export the signals of the n-th measured channel with
only one set of channel signals. Simply, enter the UARFCN in the channel list of the
TEC configuration. The signal names show the assigned channel numbers in the
alphanumeric view, see Figure 4-45.

Pilot pollution

"Pilot Pollution" lets you define the thresholds for the calculation of the Hard Pilot Pollu-
tion (HPP) and Soft Pilot Pollution (SPP). HPP and SPP are weighted sums of the
Received Signal Code Power (RSCP) of all measured CPICHs relative to a reference
CPICH signal. Thus, it is a measure of the potential interference/pollution of the refer-
ence CPICH.

Figure 3-214: TEC for UMTS PNS - Pilot Pollution window

The HPP and SPP are indicated in the "UMTS Scanner Top N View", see Chap-
ter 3.3.17.8, "UMTS scanner views", on page 187. The same thresholds apply to all
reference pilot signals selected in the "Top N Property" dialog.

Pilot pollution signals also appear in the signal tree. Therefore, they can be analyzed in
general R&S ROMES4 views, for example, in the "Alphanumeric View" or "ROMES-
MAP Route Track View".
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Thresholds
They are graphical representation of the upper Thigh and the lower Tlow threshold for the
calculation of the pilot pollution. To calculate the pilot pollution for a given reference
signal CPICH(0), all other detected CPICHs are sorted according to their signal
strength and comparison with Thigh and Tlow.

HPP(0) is equal to the total number of received channels CPICH(n) (n=1,2,3, and so
on) exceeding the upper threshold Thigh(n).

SPP(0) is equal to HPP(0) plus the sum of all received channels CPICH(n) between
the lower threshold Tlow (n) and the upper threshold Thigh(n), each weighted by the
ratio.
(RSCP(n) – Tlow (n)) / (Thigh(n) – Tlow (n)).

Signals below Tlow (n) do not contribute to HPP and SPP. This definition shows that
HPP(0) ≤SPP(0), irrespective of the reference CPICH and that both quantities, are
minimized for the strongest CPICH in the Top N pool (if CPICH(j) > CPICH(k) , then
HPP(j) ≤ HPP(k) and SPP(j) ≤ SPP(k)).

Pilot pollution threshold settings
The thresholds Thigh(n) and Tlow (n) are both defined by two polygonal curves in the
range 1 ≤ n ≤ 32. The cursor shows an Ⓐ symbol when pausing over one of the circles
separating the straight sectors of the curves. It can then be used to drag the circle in
vertical direction. Double-clicking a point on a curve inserts a new point or removes the
current point. Thigh(n) and Tlow (n) can be modified with the following restrictions:

Thigh(n) must be larger than Tlow (n) for all n.

Both functions must be monotonically descending, i.e. for n > m applies:
Thigh(n) ≤ Thigh(m) and

Tlow(n) ≤ Tlow(m)

Load / Save pilot pollution scheme (PPS)
Once defined in the "Thresholds" diagram, a pilot pollution scheme can be named and
stored for later reuse.
● "Available PPS"

List of all defined pilot pollution schemes. A selected PPS appears in the "Thresh-
olds" diagram. "OK" applies the selected PPS.

● "Save Current PPS"
Opens an input box for the name of the current PPS. The saved PPS is added to
the list of available PPS.

● "Remove All PPS"
Clears the list of available PPS.
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Pilot pollution calculation per channel
The "Pilot Pollution calculation per channel" lets you select the number of reference
CPICHs for which a pilot pollution analysis is performed. The pilot pollution is always
calculated for the k signals with the strongest P-CPICH level in the Top N pool, where 0
≤ k ≤ N. A selected number k > N is replaced by N upon pressing "OK".

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.10  TEC for CW devices

Selecting the "TEC for CW Devices" > "CW Technology" menu opens the page con-
taining the "CW Technology" tab.

The "Number of Signals" pane lets you set the number of CW test receiver signals for
display in the data trees (for example, in the "Values" page of the 2D chart configura-
tion menu). It is possible to configure maximum 512 CW signals in the tree. The config-
ured number of the CW signals brings the setting into effect after R&S ROMES4
restart.

This number leaves the receiver configuration and the enabled options unchanged and
does not affect the measurement.

However, a smaller number of displayed signals has the following advantages in replay
mode:
● Data tree is easier to handle as unwanted signals are omitted.
● Performance is improved as less system resources are needed.
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Figure 3-215: Configuration of Software Modules – TEC for CW Devices

3.8.2.11  TEC for WiMAX scanner

Click the "Technologies" > "TEC for WiMAX Scanner" entry for the WiMAX scanner
configuration pages.

The following tabs are available:
● "Top N Settings", the opening page
● "Info"
● "Templates"

The last two tabs are technology independent.
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Figure 3-216: TEC for WiMAX Scanner – WiMAX TopN Settings

WiMAX Top N settings

"TEC for WIMAX Scanner" lets you configure WiMAX scanner Top N pools.

The "Top N Settings" page is divided into two panes.

● "General Top N pool signal settings" lets you set preferences for the general Top N
pool signals.

● "In current workspace configured WiMAX Scan Top N pools" lets you administrate
the Top N pools of the current workspace.

General Top N pool signal settings
The changes in Top N pool definitions made in this panel will affect available Top N sig-
nals only after the R&S ROMES4 is restarted.
● "Number of Top N pools in the signal configuration tree"

Defines the maximum number of Top N pools in the list of available signals, see
Chapter 3.8.1.2, "Available signals configuration", on page 228.

● "Max. Number of members per Top N pool"
Defines the maximum members per pool in the list of available signals.

● "Optional signals per Top N member"
Note: Optional signal settings are R&S ROMES4 specific settings
The selected optional signals are stored with the current R&S ROMES4 installation
and not at the current workspace.
Therefore, if the current workspace opens with another R&S ROMES4 on another
computer, the optional selected signals are not selected anymore and have to be
selected for another R&S ROMES4 installation again.
– "Center Frequency"

Center frequency of the used channel according to standard IEEE 802.16
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– "Bandwidth"
For WiMAX, different bandwidths are possible according to standard IEEE
802.16

– "FFT Size"
Fast Fourier Transformation Ratio

– "CP Ratio"
Cyclic Prefix Ratio

– "Frame"
Frame Rate

– "Name (of BTS)"
WiMAX base station name

– "Distance (to BTS in km)"
Distance to BTS

In current workspace configured WiMAX Scan Top N pools
This panel shows a list of the Top N pools configured in the current workspace.
The Top N pool list can be amended using the "Add" button.
An entry in the list can be deleted using the "Remove" button.
The properties on an entry can be viewed or modified using the "Properties" button.

Add ← In current workspace configured WiMAX Scan Top N pools
Adds the Top N pools you defined in the list of "Available Signals", see Chapter 3.8.1.2,
"Available signals configuration", on page 228.

Figure 3-217: Add - opening page

The "Add" page contains the following panes:
"General"
● "Name"
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Name of the WiMAX Scan Top N pool.
● "Count N"

Number of pool elements (range 1 to 16). The amount of the pool elements in the
list of available signals is limited to the "Max. Number of members per Top N pool".

● "Sort"
The Top N View list can be sorted by RSSI and CINR or not sorted.

"Observation"
● "Interval"

Interval in which the selected value (RSSI or CINR) is observed, given in seconds
(range 0 to 300).
The observation interval is limited, see Interval.

● "Mode"
The measured RSSI and CINR power value defines the sort order for the Top N
View. The sort mode can be set to average/max/min/last power values.

● "Hysteresis"
Measurement interval in seconds (range 0 to 300).

Remove ← In current workspace configured WiMAX Scan Top N pools
Removes the selected WiMAX Scan Top N pool from the "Top N Pools" list, see
"Remove" on page 311.

Properties ← In current workspace configured WiMAX Scan Top N pools
Allows the modification of the properties for the selected Top N pool.

Figure 3-218: Properties - opening page

The "Properties" dialog contains the same panes as the "Add" dialog.

Info tab

The "Info" page is divided into two parts.
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The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.12  TEC for LTE scanner

Select the "Technologies" > "TEC for LTE Scanner" menu to open the configuration
pages. The following tabs are available:
● "Top N Settings", opening page
● "Scanner Signals"
● "Pilot Pollution"
● "Info"
● "Templates"
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Figure 3-219: Scanner Top N Settings page

The "Info" and "Templates" tabs are technology independent.

Top N settings

The LTE Top N pool settings are done in the "TEC for LTE Scanner" page. The Top N
pool configuration is stored in the registry. The last workspace settings are the default
for the Top N pool configuration of new workspaces.

The "Scanner Top N Settings" page is divided into two panes:
● "Top N Pool Signal Settings" lets you activate some optional signals.
● "Top N Pools" lets you administrate the Top N pools of the current workspace and

filter them for ranking.

Top N pool signal settings

The pane contains the list of optional signals in "Optional Top N Signals". If you want
an optional signal to be displayed in the "Signal Tree" and "LTE Scanner Top N View",
select it in the list.

If selected, the optional signal gets a column in the "List" pane of the "LTE Scanner Top
N View". Otherwise, only the default signals are displayed in the view.

The selected optional signals are stored with the current R&S ROMES4 installation
and not at the current workspace. If you open the current workspace with another R&S
ROMES4 on another computer, the selected optional signals are not selected. Select
the optional signals for that R&S ROMES4 installation again.
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Optional Top N signals

● "eNodeB Name"
Given name of an LTE BTS

● "Carrier Frequency"
Selected carrier frequency

● "EARFCN"
E-UTRA Absolute Radio Frequency Channel Number
The signal stands for the primary EARFCN value of the given Top N pool (Primary
Band). It has to be differentiated from the Top N EARFCN (MFBI) signal which is by
default visible in the "LTE Scanner Top N View" and "Signal Tree".
Top N Signal EARFCN(MFBI) shows the frequency current value of the cell as
received in SIB 1 “multiBandInfoList” or “multiBandInfoList_v9e0” fields.

● "Power Ratio (P-Sync/S-Sync)"
Average/maximum/minimum/last power, depending on the Top N pool settings
measured on Primary Synchronization Signal/Secondary Synchronization Signal.

● "SINR of P-Sync"
Signal-to-Interference-plus-Noise Ratio of Primary Synchronization Signal

● "SINR of S-Sync"
Signal-to-Interference-plus-Noise Ratio of Secondary Synchronization Signal

● "Amp. SINR of P-Sync"
Amplitude-based Signal-to-Interference-plus-Noise Ratio of Primary Synchroniza-
tion Signal

● "Amp.SINR of S-Sync"
Amplitude-based Signal-to-Interference-plus-Noise Ratio of Secondary Synchroni-
zation Signal

● "Frame Struct. Type"
FDD (Frame Structure Type 1) or TDD (Frame Structure Type 2)

● "RS SINR"
SINR of Reference Signal

● "CIR out of CP"
Percentage of CIR values outside of the cyclic prefix

● "ECI(28) and ECI(20/8)"
EUTRAN Cell Identifier columns, showing the 28 bits long string, are added to the
"Top N List". The information is the same as the one in the ECGI column, but the
formatting of these parameters in the list is different.

● "MCC"
Mobile Country Code

● "MNC"
Mobile Network Code

● "TAC"
Tracking Area Code

● "Cyclic Prefix"
Type of Cyclic Prefix used - normal or extended.

● "Cyclic Prefix Length"
Length (in µs) of the Cyclic Prefix.
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● "Physical-Layer Cell Identity Group"
Cell Identity Group of the Physical Cell ID, range 0 to 167

● "Physical-Layer Cell Identity"
Cell Identity referring to the physical layer, range 0 to 2

● "HPP"
Hard Pilot Pollution of the eNodeB signal as defined via the "Pilot Pollution" config-
uration page, see "Pilot pollution" on page 353.

● "SPP"
Soft Pilot Pollution of the eNodeB signal as defined via the "Pilot Pollution" configu-
ration page, see Chapter 3.8.2.12, "TEC for LTE scanner", on page 341.

● "Internal CellID"
Unique cell identity.

● "eNodeB Distance"
Distance to eNodeB

● "4G Drift"
Time drift against the receiver time in ns.

● "Cue-Qual"
Cell reselection criterion value based on UE emulation by quality information in
system information blocks.

● "Cue-Lev"
Cell reselection criterion value based on UE emulation by level information in sys-
tem information blocks.

● "NR"
The Neighbor Relation is the percentage of cells in the current Top N pool, which
are the members of the specific intra-frequency neighbor cell list. NR is available
only if SIB4 is demodulated.

● "Frame Time of Arrival Offset To PPS"
Time difference between PPS and the start of a LTE frame received by the scanner
expressed in ms.

● "Subband RSRP / RSRQ"
RSRP and RSRQ values measured within the subbands. Activating these optional
signals creates the set of WB subband RSRP/RSRQ min/max signals with and
without noise capping (NC) in the available signals tree, as highlighted in the fol-
lowing figure. The signals are included in the basic views.
For the signals description, refer to "R&S ROMES4 Description of Signals" docu-
ment.

Tools menu



User interfaceDrive Test Software

345Operating Manual 1171.6415.12 ─ 66

Figure 3-220: WB subband RSRP/RSRQ available signals

R&S ROMES4 Alphanumeric view shows the WB subband RSRP/RSRQ min/max
signals.

● "CIR Delay Spread"
CIR delay spread is the time between the first and the last peak in the "CIR sync."
measurement.
The value is displayed in the available signals tree, the same branch as previously
mentioned. The signal is also shown in the basic views. Note that the signal is
present in the last column of the "LTE Scanner Top N View" or in the next-to-last
column if the "Create Signal for each NPCI" is activated, see "LTE signals settings"
on page 352.

● "Add. PLMNs"
Additional PLMNs shared with this eNodeB.
R&S ROMES4 supports the 3GPP specified "RAN Sharing" feature. The feature
requests that a physical base station serves several network operators, i.e.
PLMNs.
"Add. PLMNs" active fulfills the goal to visualize the eNodeBs for all PLMNs in the
list. The list of the PLMNs is a part of the SIB1. The first entry in the list is the pri-
mary PLMN for R&S ROMES4. Every entry of the list is taken as a valid PLMN,
while the "cellReserverdForOperatorUse" flag is considered.
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Figure 3-221: RAN sharing info in SIB1

Note: The shown MCC and MNC signals of the eNodeB in the "TopN List" are
always related to the primary PLMN. However, for Top N pools, filtering of the eNo-
deB signals considers all PLMNs that are in the list and the mentioned signals are
shown in the "Add. PLMNs" column.
If the Top N pool is created automatically for the PLMNs, a pool for each PLMN in
the list is also created automatically.

● "Frame Number of Arrival Offset To PPS"
Virtual Frame Number between PPS and the start of a LTE frame received by the
scanner.
It is internal virtual frame number for the RF frame, in which the CIR has been
measured.

● "Provider"
Name of the network provider.

● "MIB DL Bandwidth"
LTE downlink bandwidth decoded from MIB, expressed in MHz.

● "MIMO2x2 / MIMO4x4 / MIMO4x4"
MIMO characteristics of an eNodeB, contains average Rank and Condition Num-
ber, expressed in dB.

● "SIB2 eMBMS / DSS"
SIB2 broadcasts eMBMS subframe pattern (MBSFN) to be configured by UEs. For
details, see "Description of R&S ROMES4 Signals".

● "eNodeB Tx Ports"
Number of eNodeB Tx antenna ports decoded from MIB.

● "LTE-M"
Indicates that the cell supports LTE-M.

● "5G NR"
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Indicates that the cell supports interworking with 5G RAT.
● "Sch SIBs"

Indicates scheduled SIBs.

To activate a changed signal configuration, R&S ROMES4 must be closed and restar-
ted.

Top N pools

The pane lets you choose between the automatic and manual filtering of channels
and/or providers for obtaining the Top N pools. The buttons displayed in this pane
depend on selected filtering type. The "Properties" button is displayed in both cases as
needed for configuration of the basic Top N pool parameters.

It administrates the Top N pools of the current workspace.

This pane shows a list box with the Top N pools configured in the current workspace.
The selected list entry properties can be viewed or modified using the "Properties" but-
ton. The selected list entry can be deleted from the list of configured Top N pools using
the "Remove" button.

Automatic Pool Configuration
This option creates the Top N pools automatically for the user. Depending on what is
measured, respective what was measured when replaying or exporting a file, the pools
are created automatically.
Click "Properties" to configure the template for the auto Top N pools.
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Figure 3-222: Automatic LTE Top N pool configuration

The properties in the "General" pane are basically the same as those properties of the
manually configured Top N pools, see "Manual pool configuration" on page 328. The
only difference is that the pool's name cannot be set. It is set automatically.
Select the criterion for the automatic Top N pool configuration among the following cri-
teria:
● Channel-based selection

If selected, evaluates Top N pool for each frequency (EARFCN) which is scanned.
● Provider-based selection

If selected, evaluates Top N pool for each provider in the provider list. If provider
has several channels, the Top N pool is evaluated for all those channels.
Note: Transmitters are only added to the Top N pools evaluation from the point in
time when the PLMN code has been decoded.

● Provider and EARFCN combination-based selection.
If selected, evaluates Top N pool for all combinations of provider and channels.
This option helps to separate provider from each other if they share the channels,
e.g. at a country borders. The previous note applies to this selection.

Note: Automatic pool configuration removes the manually configured pools. In order to
keep them, save the configuration as a template.
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Manual Pool Configuration
This option shows a list of the LTE Top N pools configured in the current workspace.
You can add more pools or modify the parameters values of the configured ones.
If this type of Top N pool configuration for filtering and ranking is selected, the following
buttons are available:
● "Add"
● "Remove"
● "Properties"

Add ← Manual Pool Configuration
Lets you add additional pools with default settings to the list of Top N pools. To custom-
ize the Top N pool, modify it directly in the "Add" dialog or open the Top N pool later on
via the "Properties" button.
Note: If the maximum number of Top N pools is set to "1", the "Add" button is inactive.
You can edit the default manual Top N pool to make any necessary changes. To add
an additional Top N pool, change the maximum number of Top N pools to 2. Changing
the number of pools enables the "Add" manual pool configuration button.

Figure 3-223: LTE Scanner Top N pool - Add/Properties

The page contains the following panes:
● "General"
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● "Observation"
● "Apply Filter/ Apply Provider Filter"
"General" pane lets you define the following:
● "Name"

Name of the LTE Scan Top N pool.
● "Count N"

Number of Top N pool members, ranging from 1 to 64. The display of pool ele-
ments in the list of "Available Signals" is limited to the "Max. number of members
per Top N pool".
The number is limited to avoid a crash which can occur when entering too high
max count of top N members. The actual number of elements can fall below N and
vary if the system is not able to detect and analyze enough signals.

● "Sort"
In an unsorted pool ("Sort: No"), the members remain at fixed positions unless they
are replaced by a new member having a stronger selected signal ("Value") which is
observed. Unsorted pools are suitable for monitoring an eNodeB or a fixed set of
eNodeBs for an extended period of time. They are particularly easy to monitor in
graphical diagrams where fixed positions always correspond to the same eNo-
deBs.
In a sorted pool ("Sort: Yes"), the members are sorted according to a stronger sig-
nal which is observed. The positions are redistributed after each update, according
to the observed signals strengths. Sorted pools are suitable for monitoring or com-
paring signals with definite strength, e.g. the strongest and second-strongest signal
along a measurement tour, irrespective of the transmitting eNodeBs.

"Observation" lets you specify the update interval and the criteria for Top N pools eval-
uation and ranking.
● "Interval"

The moving evaluation interval for the min/max/average/last value of the selected
Power, SINR or Cue signal. The value is recalculated and the pool is updated
every time the system receives new LTE PN scan data. All values of the selected
signals received within the evaluation interval before the current time is entered
into the calculation. Large evaluation intervals tend to stabilize the pool by delaying
the exchange of pool elements.
The observation interval is limited, see Interval.

● "Dynamic: Adjustment to Max Scan Cycle Time Last Minute when above given
Interval"
The Top N calculation dynamically adjusts the Top N calculation interval to the
max. scan cycle time last minute when the above given interval is shorter.
The option is switched on by default. The interval is automatically increased to the
max. scan cycle time of the last minute, if this max. scan cycle time is larger than
the interval given in milliseconds. If the interval is shorter, then the members of the
Top N are a randomly changing set which is not useful.
Before applying any Top N calculation, the first scan full cycle has to be completed.
NOTE: A valid Top N needs at least one measurement of each frequency.

● "Hysteresis"
The set hysteresis value (in dB) determines the hysteresis for the ranking of the
pool members. To switch it off, enter 0 dB and set the sort mode to "Last".

● "Value"
Indicates a signal type selected for ranking the Top N pools.
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It is possible to select among the following signals:
– "Power"
– "SINR"
– "Cue, the UE emulation signal"
– "RSRP"
The first two signals make ranking according to power and quality, respectively. If
you wish to rank the detected cells based on the UE emulation criterion, choose
the third option. The ranking also supports reference signal (RS) received power
signal.

● "Calculation"
Determines if the min/max/average/last value of the previously selected parameter
is used for ranking within one observation period.

Filtering options let you define the criteria for the Top N pools filtering.
● "Apply Filter"

Used for Top N pool filtering based on configured LTE channels. If checked, only
the listed LTE channels (EARFCN) entered by users are considered when ranking
the Top N pool.

● "Only the listed LTE channels (EARFCN) will be...."
A list of RF channels to be displayed in the Top N ranking list can be entered man-
ually. In the channel list the absolute RF channel numbers are placed in in-creasing
order of EARFCN. A range is specified by using the “-“ separator. Single EARFCNs
are defined by using the separator “;”. For example, 2500-2510;2520 means that
the Top N Pool includes all members (up to 16) having EARFCNs from 2500 to
2510 and the EARFCN 2520.

● "Apply Provider Filter"
Used for Top N pool filtering based on configured provider. If selected, filters for
Top N pool ranking only the selected providers.
When the provider filtering is activated, BCH decoded signals for the selected pro-
viders with their MCC/MNC are displayed.

● "Add Provider/MCC/MNC"
Via "Add Provider" and "Add MCC/MNC" you can add select a provider from the
"Network Provider Database" or enter directly a combination of MCC and MNC.

The "Top N Signals" and "Top N Pools" are of dynamic concepts that means, the signal
level from a specific eNodeB varies in time and according to the measurement posi-
tion. The elements of a Top N pool are exchanged accordingly and even their number
can change, if the system detects less than N signals.

Remove ← Manual Pool Configuration
Deletes the selected entry from the "Top N Pools" list, see "Remove" on page 311.

Properties ← Manual Pool Configuration
Shows the properties of an entry from the list and lets users modify the configured
parameters values, see "Properties" on page 312.

Scan cycles signals of LTE scanner events

The following figure shows the implemented scan cycles signals in LTE scanner.
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Figure 3-224: Scan cycle signals of LTE scanner

For details see "Scan cycles signals of GSM NWS events" on page 312.

LTE signals settings

In the "Signals Settings" page you can set the properties of the LTE signals.

Figure 3-225: TEC for LTE Scanner – signals settings

The panes of the page provide the following setting options:
● "Miscelaneous"

The "LTE Doppler Drift Correction" option is used to correct the Doppler effect, unit
[ns/s]

● "eMBMS" lets you activate the eMBMS function by defining the following:
– "Max Area IDs"
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Maximum number of area IDs which can be assigned to the actual measured
areas automatically or manually by definition of channel and area pairs, default
12

– "Max. eNodesB per Area ID"
Maximum number of eNodeBs per area ID, default 5.

– "Assignment"
Select between automatically or manually assignment of eMBMS areas to the
measured eMBMS area signals.
If the manual assignment is selected the frequency / area ID pair have to have
the format, e.g. 6100,1;6300,1;6300,2. This setting means that there are three
assigned pairs: EARFCN 6200 and area ID 1; EARFCN 6200 and area ID 2;
EARFCN 6300 and area ID 2.

– "List of Frequency / Area ID pairs ..."
A list of selected frequency and area ID pairs to be assigned to the eMBMS
areas signals; a format as previously mentioned.

For eMBMS area ID and the eNodeBs signals which are measured and reported,
see Chapter 4.8.6.5, "LTE scanner eMBMS view", on page 1232.

● "Wideband and MIMO Signals"
– "Create Signal for a max. Antenna Combination of"

The type and number of signals to be measured and reported by the LTE Scan-
ner.
The selected signals are shown in the "Top N List" of the "LTE Scanner Top N
View" and in the "Signal Tree".

Figure 3-226: Wideband and MIMO signals

The changes take effect only after restart of R&S ROMES4.

Pilot pollution

Pilot pollution can be calculated for the measured LTE base stations on each channel.
The calculation is done on the RSRP signals.
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Figure 3-227: Pilot Pollution for LTE signals

The upper pane shows the “Pilot Pollution Scheme”, containing the default thresholds
of the pilot pollution algorithm. This scheme can be customized.

The lower part lets you configure a constraint for the calculation, that is, derive the pilot
pollution for the given count of stations on a channel only. The default is 1.

The results of the pilot pollution calculation are the Hard Pilot Pollution (HPP) and the
Soft Pilot Pollution (SPP) signal values. Both values are available in the signal tree and
can be analyzed in the generic R&S ROMES4 views, for example, in the "Alphanu-
meric View", if selected.
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Figure 3-228: HPP and SPP Top N signals selection

The HPP and SPP Top N signals are by default off and have to be configured in the
"Top N Settings" configuration page.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.
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3.8.2.13  TEC for NB-IoT scanner

Select the "Technologies" > "TEC for NB-IoT Scanner" menu to open the NB-IoT con-
figuration pages:
● "Top N Settings"
● "Pilot Pollution"

The page has two more tabs, the "Info" and the "Templates" tab which are technology
independent.

Top N settings

The page is divided into two panes:
● "Top N Pool Signal Settings" which lets you activate some optional signals.
● "Top N Pools" which lets you select between automatic or manual Top N pool con-

figuration.

Figure 3-229: NB-IoT Scanner Top N settings

Top N pool signal settings

There is a single Top N node under the "Top N Templates" node instead of separate
branch for each Top N pool and Top N member, see Chapter 4.8.8.1, "NB-IoT scanner
signals tempates", on page 1297.
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Figure 3-230: Single Top N node under the Top N templates

You can configure additional optional signals which are added then to the NB-IoT Top
N signals and template signals. Changes of a setting affect the Top N signal and the
template signal configuration.

The following optional signals are available in "Optional Top N Signals" > "Signals".
● "eNodeB Name"

LTE base station's name.
● "EARFCN"

E-UTRA Absolute Radio Frequency Channel Number.
● "ECI(20/8)", "EC(28)"

EUTRAN Cell Identifier columns; Cell Identifier: CellID*256 (or << 16) + eNodeB
ID.

● "MCC"
Mobile Country Code

● "MNC"
Mobile Network Code

● "TAC"
Tracking Area Code

● "eNodeB Dist."
Distance to the eNodeB.

● "Provider"
A name of network provider.

● "Add. PLMNs"
Additional PLMNs shared with this eNodeB
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Figure 3-231: List of all eNodeB signals

To activate a changed signal configuration, R&S ROMES4 must be closed and restar-
ted.

Top N pools

If you select automatic pool configuration, the "Properties" button becomes active.

Click the button to open the dialog which allows you to configure the parameters for the
automatic Top N pool.
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Figure 3-232: NB-IoT Scanner Top N pool settings

The ranking of the Top N pools can be based on selected signal in the "Observation" >
"Value" drop-down box. Supported values are:

● NSSS CINR
● NRSSI
● NSSS Power
● NRSRP

If the NRSRP is selected, the algorithm uses the maximum of NRSRP (Tx0) and
NRSRP (Tx1) to calculate the Top N ranking. If signal is not present (shown as "---"), it
does not join the ranking.

Figure 3-233: Ranking of Top N pools based on NRSRP
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The display shows the current value that cannot reflect the correct ranking.

You can select one of the following Top N pool configurations:
● "Create a TopN Pool for each EARFCN"

The selection is channel-based. Evaluated is Top N pool for each frequency
(EARFCN) which is scanned.

● "Create a TopN Pool for each provider"
The selection is provider-based. Evaluated is Top N Pool for each provider in the
provider list. If provider has several channels, the Top N pool is evaluated for all
those channels.

● "Create a TopN Pool for each provider and EARFCN combination"
The selection is provider and EARFCN combination based. Evaluated is Top N
pool for all combinations of provider and channels.

Pilot pollution

Pilot pollution can be calculated for the measured base stations on each channel. The
calculation is done on the RSRP signals.

The upper pane shows the Pilot Pollution Scheme, which gives the thresholds for the
pilot pollution algorithm. This scheme can be customized like in UMTS.
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Figure 3-234: NB-IoT scanner Pilot Pollution page

The configuration is the same as for the TEC for LTE Scanner.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.
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In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.14  TEC for LTE-M scanner

R&S ROMES4 supports the configuration of the LTE-M scanner in the "TEC for LTE-M
Scanner" page.

Select the "Technologies" > "TEC for LTE-M Scanner" entry to open the page.

The page contains the following tabs:
● "Top N Setting", the opening page
● "Info"
● "Templates"

Figure 3-235: LTE-M Top N pool settings

The last two tabs are technology independent.

The LTE-M technology provides signals for the Top N pools and template signals. For
the signal description, see "Description of the R&S ROMES4 Signals" document.
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Top N settings

This configuration page is the standard page for the Top N pool signal settings made of
two panes.

● "Top N Pool Signal Settings" without function
● "Top N Pool"

Top N pool signal settings

The upper pane of the page has no function as there is a single Top N node under the
"Top N Templates" node, see Chapter 4.8.7.1, "LTE-M scanner signals templates",
on page 1274.

Figure 3-236: Top N node under the Top N templates

Top N pools

Specify whether to configure the Top N pool automatically or manually in the lower
pane.

Automatic Pool Configuration
Automatic is the default Top N pool configuration option. It orders the scanner to use
automatic Top N pool property configuration.
Click the "Properties" button next to the "Automatic Pool Configuration" button to
launch the "Top N Pool Settings" page.
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Figure 3-237: LTE-M automatic pool configuration

Specify the following entries in the "General" pane:
● "Name"

Defines the name of Top N Pools.
The specified name is displayed in "LTE-M Scanner Top N View" background and
Top N drop-down "List".

Figure 3-238: Top N pool names in background
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Figure 3-239: Top N pool names in the List

● "Count N"
Specifies the number of top ranked items to display.

● "Sort"
Specifies whether to sort the items in the Top N list or not.

● "Observation"
– "Interval"

Specifies the interval to refresh the values.
– "Dynamic: Adjust to ..."

The Top N calculation adjusts dynamically the Top N calculation interval to the
max. scan cycle time last minute when the above given interval is shorter.

● "Value"
Drop-down list to specify the decision value for Top N ranking. The possible values
for ranking are:
– Avg BR-SINR
– Avg BR-RSRP
– Avg BR-RSRQ

● "Calculation"
Specifies how to calculate the selected decision value for Top N ranking. The pos-
sible options for calculation are:
– Min
– Max
– Avg
– Last

The lower part of this pane specifies the criterion for the automatic pool configuration.
Select the criterion among the following options:
● "Create a TopN Pool for each EARFCN"
● "Create a TopN Pool for each provider"
● "Create a TopN Pool for each provider and EARFCN combination"

Manual Pool Configuration
Click the "Manual Pool Configuration" radio button in the "Top N Settings" pane of the
page, to activate the bottom section of the page.
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Figure 3-240: Bottom buttons active in manual pool configuration

The active buttons let you do the following:
● "Add"

Adds a new entry to the list.
● "Remove"

Removes the selected item from the list.
● "Properties"

Launches the "Top N Pool Settings" page to specify the highlighted items.

Figure 3-241: Top N pool settings for manual configuration

The "General" pane is the same as the one for automatic pool configuration. For the
entries in this pane, see "Top N pools" on page 363.
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The lower part of the "Properties" > "Top N Pool Settings" page has the following
entries:
● "Apply Filter"

If checked, the filter string specified in the edit box below is applied. Otherwise, no
filter is applied.

● Filter String Box
The filter string contains a semi-colon delimited EARFCNs. If "Apply Filter" is
checked, only the EARFCNs in this string are shown in Top N list.
Example: 5230;8448;5110;

● "Apply Filter Provider"
Specifies the list of providers to be shown.

● Provider grid
Specifies the list of providers to be shown.

● "Add Provider"
The button is used to add provider.

● "Add MCC/MNC"
The button is used to add provider by MCC/MNC.

● "Remove"
Removes the selected provider.

● "OK"
The button is used to accept the changes.

● "Cancel"
The button is used to discard the changes.

Info tab

See "Info tab" on page 355. The name can be customized.

Templates tab

"Templates tab" on page 367.

Templates can be created (saved), deleted and exiting templates can be loaded.

3.8.2.15  TEC for QoS tester

Select "Technologies" > "TEC for QoS Tester" to open the QoS tester page.

The opening page "QoS Settings" lets you set the KPI definitions, that is, the KPI defi-
nition file and the KPI export definition file.

The R&S ROMES4 KPI generator is disabled by default as it increases the perfor-
mance for default measurements,

To activate the KPI generator, check the "KPI Generator Active" check-box in the open-
ing page.

The R&S ROMES4 KPI generator is based on the R&S ROMES4 kpi.xml file, which
can be adapted if the corresponding option is available. Even if disabled, all trigger
points are saved to the file, so that in a replay with the generator enabled all KPI are
available.
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The Qos KPIs are visible in the "QoS KPI Generator View" and relate to R&S ROMES4
generated KPIs only. KPIs generated by QualiPoc are not affected by this option.

To ease the switch between the different KPI definition and KPI export definition files,
the page offers two drop-down edit controls.

Figure 3-242: Selection of KPI and KPI export definition files

For calculating and exporting KPIs, the following two definition files in XML format are
necessary:
● kpi.xml
● kpiexport.xml
Default files with basic definitions are delivered with the R&S ROMES4 installation
located in the directory:

[RomesAppliciationData]\configuration.

These files can be copied to another location, for example MyRomes, otherwise they
are overwritten with a later R&S ROMES4 version. The used definition files during run-
time (replay and measurement) are defined in the "Technology Module" for QosTester
configuration.
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The definition of KPIs and the definition of KPI export is described in the document:
KPI Definition File.doc
An example is described in the document:
KPI Definition HOWTO define a KPI.doc
The KPI calculation is based on trigger points. All from R&S ROMES4 provided trigger
points are described in the document:
Trigger Point Definitions.doc

When changes are made in a definition file, an open measurement must be closed and
reloaded to see the resulting changes in the views.

To use an own KPI definition file or a KPI export definition file (edit or change definition
to specific customer requests), the KPI Generator option ID is necessary. If the KPI
Generator option ID is not available, these edit boxes are disabled. Without the KPI
Generator option ID, the KPIs can be generated during measurement and replayed
later, but only on the basic definition files. Changing and editing is not allowed, as each
editing of the basic definition files is detected and results in usable files.

3.8.2.16  TEC for RF power scanner TSME

R&S ROMES4 supports the configuration of the RF Power Scanner in the "TEC for RF
Power Scanner TSME" page.

Select "Technologies" > "TEC for RF Power Scanner TSME" entry to open the page.

The page contains the following tabs:
● "Signal Setting", the opening page
● "Info"
● "Templates"
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Figure 3-243: TEC for RF Power Scanner TSME – Signal Settings page

The last two tabs are technology independent.

Signal settings

The "Signal Settings" configuration page supports setting frequencies for four addi-
tional fixed markers. These fixed markers are applied at R&S ROMES4 ASCII export
only, see Chapter 7.2.5.8, "RF power scanner data export", on page 2149.

The fixed markers do not interact with the other markers of the RF Power Spectrum
View.

The channel signals configuration is not needed as the "All Channels" node is always
available. The node is located in the "Sweep Template" branch of the "Signals Tree" >
"RF Power Scan" tree, see Chapter 4.8.9.1, "RF power scanner sweep template",
on page 1320.

R&S ROMES4 restart is not needed for changes in this page.
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Figure 3-244: Extended signal tree of the RF Power Scanner

The all RF Power Scanner signals are structured in the following branches of "Sweep
Template":

● "Sweep Rate"
● "Current Peak Marker", "Free Marker" and "Fixed Marker"
● "All Channels" (for each result value)

It is possible to define events for all available signals.

Signal tree of RF power scan
 

Sweep rate ← Signal tree of RF power scan
● "Sweep Rate Total"

The sweep rate from the first to the last available measurement of a R&S TSME
configured as RF Power Scanner.

● "Sweep Rate Total Ex First 2 Minutes"
The sweep rate of the first measurement 2 minutes after the first measurement
started to the last measurement.

● "Sweep Rate Last Minute"
Sweep rate of the last minute. Within the first minute after the first measurement,
the interval is shorter.

● "Visualized Sweep Rate Total"
The update rate of the R&S ROMES4 views. The sweep rate is defined the same
as "Sweep Rate Total".
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● "Visualized Sweep Rate Total Ex First 2 Minutes"
The update rate of the R&S ROMES4 views. The sweep rate is defined the same
as "Sweep Rate Total Ex First 2 Minutes".

● "Visualized Sweep Rate Last Minute"
The update rate of the R&S ROMES4 views. The sweep rate is defined the same
as "Sweep Rate Last Minute".

The R&S TSME sweep rate is stored in the rscmd file. Therefore, it is in the replay
mode the same as during the measurement.
The sweep rate of the visualization is calculated while replaying. The visualized sweep
rate is rising with the replay speed.

Marker ← Signal tree of RF power scan
There are three types of markers:
● Current Peak Marker
● Free Marker
● Fixed Marker Frequency for ASCII export only
The "Current Peak Marker" signals are always filled. The "Free Marker" and "Fixed
Marker Frequency..." signals are filled only if the markers are set active in the view,
otherwise they are empty.
For all markers the following five signals are available:
● Frequency: Center frequency of the channel filter or the center frequency of the

result biased on the frequency resolution.
● Channel Index: Index of the channel filter result (only available, if channel filter is

active).
● Level: Power value biased on the frequency resolution respectively the channel fil-

ter settings and the frequency- and time-detector type.
● Min Level: value biased on the frequency resolution respectively the channel filter

settings and the frequency- and time-detector type (only available if an Auto Detec-
tor is set).

● Attenuation: Attenuation setting (only available if a fixed attenuation is set in the
scanner configuration).

● Preamplifier: Preamplifier setting (only available if the preamplifier is set in the
scanner configuration).

All Channels ← Signal tree of RF power scan
The branch contains the signals of available channels, for example, frequency and
channel index.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.
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Templates tab

The "Templates" page is divided into two parts.

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.2.17  TEC for TETRA

Select "Technologies" > "TEC for TETRA" to get the "TETRA Parameters" opening
page.

The purpose of activating the "Include carrier for..." option is filtering not only by MCC,
MNC and LA but also by carrier to avoid ambiguity if more than one cell of a provider
within one LA.

Figure 3-245: TEC for TETRA
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3.8.2.18  TEC for TETRA scanner

Select the "Technologies" > "TEC for TETRA Scanner" to get the configuration pages
with the following tabs:
● "Top N Settings", the opening page
● "Signal Settings"
● "Info"
● "Templates"

The "Info" and "Templates" tabs are technology independent.

Figure 3-246: TEC for TETRA Scanner – Top N Settings

The configuration pages let you configure the Top N pools, the maximum number of
members per pool and the signals which TETRA scanner collects.

TETRA scanner Top N settings

In "Top N Settings" you can set the number of Top N pools and the number of mem-
bers of a pool. For each member,, a set of signals is created. Some of those signals
are optional. Thus it is possible to select or unselect those signals in the "Optional Top
N Signal" list.
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The "Top N Settings" page is divided in an upper panel "Top N Pool Signal Settings" to
set preferences for the Top N pool signals and a lower panel "Top N Pools" to adminis-
trate the Top N pools of the current workspace.

Top N Pool Signal Settings
● "Number of Top N pools in the signal configuration tree"

Defines the maximum number of Top N pools in the list of "Available Signals", see
Chapter 3.8.1.2, "Available signals configuration", on page 228.

● "Max. Number of members per Top N pool"
Defines the maximum number of members per pool in the list of "Available Sig-
nals". This number is limited to 64.

● "Optional Top N Signals"
Note: The optional signal settings are R&S ROMES4 specific settings. The
selected signals are stored within the current R&S ROMES4 installation and not at
the current workspace. if the current workspace opens with another R&S ROMES4
on another computer the optional selected signals are not selected anymore and
have to be selected for this other R&S ROMES4 installation again.
– "Main Carrier"

Frequency of the MCCH extracted from SYSINFO PDU.
– "TETRA Power [dBm]"

Indicates the power of TETRA carrier. The default Top N pool has the TETRA
Power as the observation value.

– "C1"
Path loss parameter C1; the calculation is based on the values of the broadcast
channel and the configured maximum UE transmit power.

– "FRA"
The active state of Fast Reselection; the calculation is based on values of the
broadcast channel.

– "SRA"
The active state of Slow Reselection; the calculation is based on values of the
broadcast channel.

– "FRT"
Fast Reselection Threshold, range 0 [dB] to 15 [dB].

– "SRT"
Slow Reselection Threshold, range 0 [dB] to 15 [dB].

– "#C-SCCH in use"
Number of Common Secondary Control Channels in use.

– "BER Pre-Viterbi"
Ratio of estimated number of channel errors in block 1 and block 2 to the num-
ber of analyzed bits in block 1 and block 2 (comparison of received data and
re-encoded after error correction). It has to be generated in the default configu-
ration (together with main carrier and TETRA Power). BER Pre-Vit. is estab-
lished as default quality parameter. The user has the possibility to choose the
BER Pre-Vit. as the observation value for default Top N Pool definition and Top
N signals, see Figure 3-247.

– "BLER AACH"
Block Error Rate of the Access Assign Channel.

– "Freq-Error"
Frequency error in Hz.

– "Phase-Error"
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RMS (Root-mean-square) phase error on the information symbols. Value in
degree (°).

– "Delay Spread"
Delay spread of arriving paths, the value given in µs.

– "Timeslot"
Timeslot number extracted from SYNC PDU.

– "FN"
Frame number extracted from SYNC PDU.

– "MFN"
Multiframe number extracted from SYNC PDU.

– "MCCH BER Pre-Vit.[%]"
Bit Error Rate on the Main Control Chanel (MCCH).

– "MCCH BER AACH [%]"
Bit Error Rate on the Access Assignment Channel (AACH).

– "MCCH ER Payload CRC"
Error Rate of the payload CRC.

– "MCCH BLER AACH"
Block Error Rate on the Access Assignment Channel (AACH).

– "TETRA2 Active"
TETRA Enhanced Data Service (TEDS) active.

– "Modulation Type"
Used modulation in burst.

– "Code Rate"
Code Rate in burst.

– "Burst Mod ER"
Burst Modulation Error Ratio in dB.

– "Pilot Mod ER"
Pilot Modulation Error Ratio in dB.

– "Header Mod ER"
Header Modulation Error Ratio in dB.

– "Data MER"
Data Modulation Error Ratio in dB.
MER = Modulation Error Ratio (Mod ER in dB)

– "SICH Error Rate"
Number of errors in the received SICH bits / total number of SICH bits.

– "AACH Error Rate"
Number of errors in the received AACH bits / total number of AACH bits.

– "Data Error Rate"
Number of errors in the received data bits/total number of data bits.

– "BLER Pre-Bit"
Block Error Rate of the number of channel errors in block 1 and block 2 to the
number of analyzed bits in block 1 and block 2 (comparison of received data
and re-encoded data after error correction (Convolutional Code with Viterbi-
Detector)).

– "Colour Code"
Colour code extracted from the SYNC PDU.

– "Source Address (DMO)"
Source address in direct mode operation.

– "Destination Address (DMO)"
Destination address in direct mode operation.
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– "LTP1 (TETRA Power)"
If active, generates the LTP1 (TETRA Power) signal for each Top N pool; three
LEE parameters are assigned to it in the signal tree, see "LTP calculation"
on page 560.
For example, it looks like LTP95(TETRA Power)[1][#1] for Top N 1 in the signal
tree.
The signal is not active by default but it persists over all workspaces as being
stored in registry. The setting changes apply after R&S ROMES4 restart.

– "LTP2 (TETRA Power)"
See the previous description.

– "DMO Channel"
If activated, the DMO channel is available in the "TETRA Scanner Top N View"
and "TETRA Scanner Spectrum View". It is ready for use in the "Signal Tree".
R&S ROMES4 restart is needed after changing the setting of this parameter.
If the "“Create Signals for each possible Carrier”" option is activated in "Signals
Settings", the DMO channel is present as a carrier signal in the tree.

– "EVM (Peak)"
Error Vector Magnitude, the peak value

– "EVM (RMS)"
Error Vector Magnitude, the root mean square value

Top N Pools
The automatic Top N pool configuration is not supported by TETRA scanners. The
option "Automatic Pool Configuration" is due to that grayed, see Figure 3-246.
This pane shows a list-box with the Top N pools manually configured in the current
workspace. From here the Top N pool list can be amended, a list item deleted or the
item's properties viewed and modified.

Add ← Top N Pools
Amends additional pools with default settings to the Top N pools list of the "Available
Signals" page. To customize the Top N pool, modify it directly in "Add" or open the Top
N pool later on via "Properties".
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Figure 3-247: Add button - TETRA Top N pool settings

The "Add" dialog contains the following panels and entries:
"General"
● "Name"

Name of the TETRA Scan Top N pool. The name has to be unique.
● "Count N"

Sets the number of Top N pool members, ranging from 1 to 64. The number is limi-
ted to avoid a crash which can occur when entering too high max count of top N
members. The display of pool elements in the list of "Available Signals" is limited to
the "Max. number of members per Top N pool".

● "Sort"
Allows sorting the members of a Top N pool.
Every list member has an index which has nothing to do with any of the parame-
ters. The index can also be found in the Top N parameters: 1. element = index 1, 2.
element = index 2 and so on.
If sorting is active ("Yes"), index and rank are the same as you have sorted your list
by the rank. Therefore 1. element is rank 1, 2. element rank 2 and so on, see the
following figure.
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Figure 3-248: Top N list members sorted

If sorting is disabled, the ranking looks like shown in the following figure.
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Figure 3-249: Top N list members not sorted

You could click on the rank column and then from top down you would have rank 1, 2,
3, and so on. The action however does not change the data in the "Alphanumeric
View" and has nothing to do with the ranking itself.
"Observation"
● "Interval"

Observation interval of the selected value given in ms.
The observation interval is limited, see Interval.

● "Hysteresis"
Hysteresis value (in dB or % dependent on selected "Value" signal) determines the
hysteresis for the ranking of the pool members. To switch it off completely, enter
value 0 and set the sort mode to "Last".

● "Value"
The parameter is used for ranking the Top N pools. The members of a pool can be
sorted by Inband Power, SNR, TETRA Power, BER Pre-Vit and UE emulation crite-
rion C1, which emulates the selection behavior of a TETRA radio. The appropriate
UE Emulation Option for TETRA is necessary in this case.
The TETRA power based sorting is default, see Figure 3-247.
The result of the observation interval which is responsible for the ranking can be
observed for the selected parameter and for each pool member.
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Figure 3-250: Ranking based on TETRA power

Figure 3-251: An example of the TETRA power selection

● "Calculation"
Determines if the min/max/average//last value of the previously selected parameter
is used for ranking within one observation period.

"Filter": A list of RF channels to be displayed in the Top N list can be entered manually.
In the channel list the absolute RF channel numbers are placed in increasing order of
ARFCN.
● "Apply Filter"

If checked, the listed RF channels are not considered when calculating the ranking
of the Top N pool.
Otherwise, only the listed RF channels are taken into account when calculating the
ranking of the Top N pool.

● "Channel list"
Single RF channels are defined by using the separator “;”. For example,
3600-3700; 3750 means RF channels from 3600 to 3700 and RF channel 3750.

● "Apply Provider Filter"
Filter Top N Pool concerning the provider.

● "Provider/MCC/MNC"
Via "Add Provider" and "Add MCC/MNC" select a provider from the "Network Pro-
vider Database" or enter directly a combination of MCC and MNC.

● "Use only Main Carriers"
Option for using only main carriers for the Top N pool calculation. The option is per
Top N pool, which allows to create pools which contain traffic channel and which do
not.
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Remove ← Top N Pools
Deletes the selected entry from the "Top N Pools" list, see "Remove" on page 311.

Properties ← Top N Pools
Allows the modification of the properties for the selected Top N pool. The "Properties"
dialog contains the same panels as the "Add" dialog, all field descriptions are defined
there.

TETRA scanner signals settings

The following panes are part of this page allowing you to set TETRA signals.

● "ROMES Signals"
● "C1 Calculation"
● "Percentile for LTP (TETRA Power) calculation"
● "TETRA Transmitter Colour"

Figure 3-252: TEC for TETRA Scanner – Signals Settings

ROMES signals
● "Create Signals for each possible Carrier"
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If activated, a set of signals is created for each carrier. The signals are visible in the
"Available Signals" tree, under "TETRA Scanner" > "Device n" > "Carrier [#x, <vari-
able>]".

● "Number of Sweeps"
TETRA scanner supports multiple sweeps. This option allows the number of
sweeps to set, that is, to configure more than one sweep for the TETRA signals.
The configured sweeps are numbered from #1 to #n.
TETRA signals and views are marked with "#'<Sweeps>", see TETRA Channels.

C1 calculation
The function calculates the C1 criteria as the scanner results. The C1 criterion is calcu-
lated from the values of the broadcast channel and the configured maximum UE trans-
mit power.
● "Max. Tx Power dBm"

Defines the maximum transmit power of the UE. This value is needed for correct
calculation of the path loss parameter C1.

Percentile for LTP(TETRA Power) calculation
LTP(TETRA Power) is the probability of a certain TETRA Power over the Lee Time.
Within the Lee Time, all TETRA powers are put into a CDF. Taken the x percentile of
Location Time Probability of TETRA power is a n’th value of sorted TETRA power and
is named the LTPxx(TETRA Power). For example, LTP95(TETRA Power) stands for
95% percentile of LTP(TETRA Power).
Enter the wanted value for up to two LTP(TETRA Power) percentiles. These two
parameters are stored to registry, therefore they persist over all workspaces.

TETRA Transmitter Colour
The function allows you to choose LA or carrier as a color indicator of the TETRA
transmitter.
This color is used in the map for the underlays of radios and scanner signals and in the
TETRA TopN View and TETRA Spectrum View. Together with the new auto-color fea-
ture, it offers a convenient way to display easily the LA for the transmitters.

Info tab

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.

Templates tab

The "Templates" page is divided into two parts.

Tools menu



User interfaceDrive Test Software

384Operating Manual 1171.6415.12 ─ 66

The upper "Available Templates" part allows loading or deleting a user-defined tem-
plate for the technology.

In the lower "Save Current Settings as Template" part you can name a template and
describe the template's entry before saving the current settings which is defined in the
"TEC for <variable> Scanner".

The "Save" button opens the "Save As" page for the template file.

For how to use the template, see the general description in Chapter 3.8.2.2, "Technol-
ogy scanner settings, info, templates", on page 285.

3.8.3  Coupled focus

Enables or disables the coupled focus between several views (see Chapter 3.1.3,
"Coupled focus", on page 101).

3.8.4  Hold all views

Freezes the current measurement display of views for examination purposes without
stopping the measurement.

3.8.5  Transmitter database

Click the "Tools" > "Transmitter Database" command to open the "Base stations" win-
dow.

Figure 3-253: Opening Transmitter Database window
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You can manage the cell database files of all mobile technologies base stations (BTS)
in this window.

Click the arrow of the drop-down box in the "Technology" pane to select technology for
which you want to manage cell database file.

Figure 3-254: Base stations window

R&S ROMES4 supports common database, as one that R&S NESTOR uses, see
Chapter 7.3.3, "CSV format definition for BTS list", on page 2182. The common data-
base support helps in data management of huge databases and gives more flexibility
across the products.

R&S ROMES4 uses the Nestor Rohde.Schwarz.CellDatabase server to import GSM,
UMTS, LTE and 5G NR base station databases. The RohdeSchwarz.CelldDatabase
server is installed while installing R&S ROMES4 and started with R&S ROMES4 start.
This R&S ROMES4 additional process can be seen in "Task Manager".
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Figure 3-255: RohdeSchwarz.CellDatabase process

The old BTS DB files of the 3GPP defined technologies are not supported anymore
since the newly created DB files have different filename extensions and formats
(SQLite DB). For the database file extensions, see Table 3-9.

3.8.5.1  Technology

The designated transmitter database for the different technologies can be loaded
and/or selected in the "Technology" window.

Further actions for the selected transmitter database are possible, for example, a data-
base load/unload or export. The "Info Text" tab enables visualization of the BTS data in
the "ROMESMAP Route Track View".

Drop-down menu
Switches between the databases of the different technologies.
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Figure 3-256: Technology selection via drop-down menu

Load
Opens a dialog to browse and select an existing database file. R&S ROMES4 accepts
the file formats shown in the following table.
Table 3-9: Supported file formats for loading

Technology File extension

5G NR nrdb

LTE ltedb

(replacing the enbdb extension since R&S ROMES4 v.19.0)

UMTS umtsdb

(replacing the umtsdb extension since R&S ROMES4 v.19.0)

GSM gsmdb

(replacing the gsmdb extension since R&S ROMES4 v.19.0)

CDMA cndb

TETRA tdb

WiMAX wmdb

Unload
Removes the conjunction of the current selected transmitter database with R&S
ROMES4.
Select the technology database from the drop-down menu. Click the "Unload" button. If
the action was performed successfully, the database disappears from the "File" infor-
mation field.

Create
The tab is without a function.
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Export
Exports the stored data from the transmitter databases to a file. The export function
uses the TXT format-based files. The format of these files is specified so that other
systems can use them.

Export of BTS databases to *.csv format for QualiPoc ← Export
Loaded transmitter databases of GSM, UMTS, LTE and 5G NR can be exported as
*.csv files in QualiPoc format. Exporting into the QualiPoc format writes the file in
UTF-8 coding.
QualiPoc displays non-ASCII characters in BTS names as question marks.
The function is found in the "Save as type" drop-down box of the "Transmitter Data-
base" > "Export" > "Export Database" page.

Figure 3-257: Export dialog of QualiPoc

Export of GSM databases to *.csv ← Export
The GSM databases support export to two CSV export formats.
● QualiPoc BTS List for generating CSV file which includes only the predefined man-

datory columns.
● ROMES DB BTS List for generating CSV file which includes all columns supported

by database.
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Figure 3-258: Supported GSM DB export formats

Import
Imports a file from the BTS list file into the database.
The import function uses the text format-based files. The format of these files is speci-
fied so that other systems can use them. The R&S ROMES4 import function supports
the following file formats.
Table 3-10: File formats supported for import

Technology File extension

5G NR ATD, CSV

LTE ATD, BUF, CDC/CDN, CSV

UMTS ATD, BUF, CDC/CDN, CSV

GSM ATD, BUF, CDC/CDN, VIG, CSV

CDMA ATD

TETRA ATD

WiMAX ATD

 

Note:
The recommended import format is ATD.

The CSV format supported for import of GSM, UMTS, LT'E and 5G NR base stations brings to users no
visible changes in the "Base station" window.

Supported import formats are described in chapter "Data Processing", section Chap-
ter 7.3, "BTS list formats", on page 2163.
For details, see Chapter 3.8.5.2, "Import of BTS list file into the database",
on page 391.
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Info Text
The tab opens the "Specify Info Text" dialog.
Check the combo box "Full" and "Short" or "Short(N)" associated to the transmitter
parameters that you want to be displayed inside the "Bts Info" field and directly in the
"Navigation Views" > "ROMESMAP Route Track View".

Figure 3-259: Data text to be shown

● "Name"
Name of the column as used in the transmitter database, not editable.

● "Full"
If checked, the parameter value is displayed in "Bts Info". To open this field, press
SHIFT+ left mouse button when hovering over a transmitter symbol in "ROMES-
MAP Route Track View".

● "Short"
If checked, the parameter value is displayed as a "quick" information directly at the
transmitter symbol that is visible in the navigation view.
TIP: To avoid too much text in the view, use a value adjustment in "ROMESMAP
Route Track View" > "Route Tracking".
TIP: To adjust the resolution threshold, enter the preferred value in "Bts Symbol" >
"Bts Info Threshold" > "Short Info". The default value for showing info is 10 km per
1000 points screen resolution.

● "Short(N)"
If checked instead of "Short", a full information is displayed, that is, the meaning of
the displayed values.

● "Alias"
To use an alias name instead of the original one from the database, select the tar-
get line and click "Alias". A dialog for entering or modifying the alias name is dis-
played. Enter the preferred name and confirm with "OK".
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Figure 3-260: Short(N) BTS information

3.8.5.2  Import of BTS list file into the database

To import an existing BTS list file (*.atd, *.buf, *.txt, *.cdc) into the database:

1. Open the "Base stations" window.

2. Ensure that an empty or non-empty database file is available or create a file (see
the previous section).

3. Select a RAT from list in the "Technology" box.

4. Click the "Import" button.

The file selection dialog opens.

5. Select a BTS list file that you want to import into network database.

6. Click "Open" to import the BTS list file.

Note:
● If your BTS list file contains valid MCC and MNC information, proceed as indi-

cated.
● Otherwise, check the "MCC" and "MNC" boxes and enter your MCC and MNC

in "Open" > "Import to NDB". Then proceed as indicated, that means, click
"Open"

7. For GSM only
a) If your BTS list file contains valid MCC and MNC information, go to step 6.
b) Otherwise, check the "MCC" box.
c) Continue by checking the "MNC" box.
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d) Enter your MCC and MNC in the "Open" > "Import to NDB" field.

Figure 3-261: Selecting file for import

e) Click then the "Open" button to confirm the new entries.
f) Update the "MCC/MNC" list.

8. If the "Do you want to create a new database?" message box opens, click "No" to
add the data to a selected database. If you want to create a database instead, click
"Yes".

The "Create Database" dialog shows.

9. Give the file name.

10. Click "Save"

11. For GSM only
Define the GSM type in "Create Database" > "Network".
The "Network" pull-down list defines the GSM hyper-band for the BTS database
file. The band selection operates as a filter and prevents import of BTSs of other
bands into the database file. For example, for databases containing both GSM900
and GSM1800 base stations, GSM 900 +GSM E + GSM R + GSM 1800 has to be
selected.

Tools menu



User interfaceDrive Test Software

393Operating Manual 1171.6415.12 ─ 66

Figure 3-262: Create Database window for GSM

The file import is terminated.

The LTE neighbor cells import from CDC format input files into the GSM BTS database
is supported.

Import of BTS list of CSV files

The import of BTS list of CSV files related to 3GPP specified technologies is simplified
by the Transmitter List Formatter tool. Use the "Transmitter List Formatter" dialog of the
tool to assign the content of the CSV file to the mandatory columns of the R&S
ROMES4 database.

By importing the BTS list for a specific technology, the dialog switches to the corre-
sponding mode automatically and shows all mandatory columns for the selected tech-
nology. The dialog tries to assign the CSV file column automatically to the mandatory
database columns.

Verify the assignments, before you continue. Each combo box provides a Tooltip for
detailed information of the expected data.

Although MNC, MCC and NCC (for GSM) are mandatory, these columns have not to
be present in the source CSV file. It is possible to enter the corresponding values
directly into the input fields. Those values are used for all cells in the CSV file.
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It is also possible to use a CSV file, which contains cells of different technologies, if
one column of the CSV file identifies the technology. In this case, specify this column
as "System/RAT" and select the corresponding "System-Filter" for the technology to
import.

Figure 3-263: BTS list formatter dialog

After finishing an import, a message box is displayed if an error occurred.

Figure 3-264: Reported error during the BTS list importing

Also a log file is created. The log file's sample looks as following:

Line: 1        Cell: NodeB Name - CellID invalid

Line: 67133 Cell:                       - CellID invalid

Line: 67231 Cell:                       - CellID invalid

Line: 67780 Cell:                       - CellID invalid
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3.8.5.3  Query

Open the "Query" dialog to query BTS database.

It is possible to define geographic selection in the left part of the dialog.
● Geographic selection by circle

Specifies the geographical center point and its radius in kilometers.
● Geographic selection by rectangle

Specifies the W/E longitude and the N/S latitude.

Figure 3-265: Query dialog window

The right part of the dialog window shows all available database columns.
Specify in the list the values that the database columns have to contain. For exam-
ple, the "Query" list has the value BTS for the "Name". The result of the parametric
query is a table containing the data for those BTSs only whose name starts with
the 5262 string.

Figure 3-266: Result of parametric query

3.8.5.4  Expand BTS database - CSV import

To add custom defined values for CSV import, you have to add a "Tags" column to your
CSV header. For each BTS define one or more custom values, separated by "#".

Example: 

Figure 3-267: Tags added to CSV header
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After importing the CSV file, the "Transmitter Database" dialog lists for the selected
technology all tags.

Figure 3-268: Listed tags of three LTE cells

To query the BTS database for defined "Tags" value, edit your search the string into the
"Tags" section.

Figure 3-269: Query cell database by added tag

The following figure shows the cell's database query result.
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Figure 3-270: Result of the query with edited tag

From "Specify Info Text", select "Tags" entry to display tags value in "BTS Info" view.

Figure 3-271: Tag selection
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Figure 3-272: BTS info of LTE cell

3.8.5.5  GSM database station query

Case: 1

Open the "Transmitter Database" dialog to query GSM BTSs. The list of BTS stations
is displayed.
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Figure 3-273: List of GSM cells

Click the "Query" button to open the "Query" dialog. All tags defined for GSM BTSs are
available for query. For example, enter a query value for the "HeightAboveGround"
parameter.

Figure 3-274: BTS query by HeightAboveGround

The query result is shown in the "Transmitter Database" dialog for BTSs that have the
"HeightAboveGround" value as indicated in "Query".
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Figure 3-275: Result of the query of GSM BTS

Case: 2

Open the "Transmitter Database" dialog to query for "Tags" value of GSM BTSs. The
list of BTS stations is displayed.
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Figure 3-276: Configured tags of GSM cells

Edit the complete or part of custom defined "Tags"value.

Figure 3-277: Query for GSM cells with tag defect

The query result is shown in the following figure.
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Figure 3-278: GSM cell with tag station info, defect

3.8.5.6  Options

● Save Database to RSCMD
The current BTS database is included into the measurement file *.rscmd created
for the next measurement.

● Use Data of RSCMD
The next replay does not use the current BTS database but the BTS information
included in an existing measurement file (*.rscmd or *.cmd).

● Max. allowed distance of a transmitter from the current position
Assume that only BTSs within a definite radius around the measurement position
have any influence. Excluding distant base stations saves processing time. For
example, the maximum GSM cell radius of approx. 35 km is a good estimate for
the maximum distance.

● Reload database at startup
Reload database at startup. The database loaded when R&S ROMES4 shuts down
will be reloaded next time R&S ROMES4 starts.

3.8.5.7  Show the result of a selective query on the map

If selected, the red BTS marker functionality of the ROMESMAP Route Track View is
available for the queried BTS. Click the red BTS marker to get the info field, see the
Figure 3-260.
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3.8.6  Network provider database

The R&S ROMES4 "Tools" > "Network Provider Database" menu opens the "Edit, Add
or Remove Network Providers" window.

The window is divided into two panes. The left part of the window, the "Countries"
pane, shows the configured worldwide moble network operators saved in the data-
base. The right "Provider" pane displays the details of a selected previously configured
provider or of a new created provider. The information available in this pane is the pro-
vider's name, a country it belongs to, its MNC, the provider associated color and the
supported RATs. The associated color is used then system-wide.

The buttons on the bottom of the window change dependent on the selected items and
actions.

Apart from possibility to select and edit information on existing providers, you can add
new providers to a country or remove the selected provider. The  button added next
to the "Country" dropdown box lets you add or modify a provider's Mobility Country
Code. The button becomes functional when you click "Add Provider" or, for the
selected provider, the "Edit Provider" button.

Figure 3-279: Network provider database window

The  button is also functional when you click the "Add Provider" or the "Edit Pro-
vider" button. It lets you attach the preferred icon to a selected or added provider from
the set of icon *.ico files. If the button is clicked, the "Open" window pops-up. Browse
a folder where the icon files are stored.

The network provider database file is located in the user-specific directory

...“…\My Documents\My Romes\Configuration
The file is put at this location during the R&S ROMES4 startup. If not found, check the
"Update Directory Structure at Startup" box in the "Tools" > "Preferences" window.
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In rare cases, a message is issued if the opening database file for writing is not possi-
ble.

3.8.6.1  Define color scheme for views

To distinguish the network provider's different channels on the map, the option to set
the color of the channels of the supported technologies is applicable. It is necessary to
define bands the configured channels belong to in the network provider database.
There is the possibility not only to select different colors for bands of different technolo-
gies, but also to distinguish by color different channels within one band. You can define
the same band, different channels using different colors. Defining those entries is done
in the "Band" graph.

Figure 3-280: Network provider database window – Edit mode

After the colors of technologies, bands and channels are selected chose the button
"Apply Changes" to make the selections executable. At the end, click the "Close &
Save" button to make the change persistent.

Figure 3-281: GSM base stations
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With the installation of a new R&S ROMES4 version, a new network provider database
is also installed. If the currently used database differs from the originally installed one,
you are asked what you want to do. You can continue using the current database,
which can contain your adaptions or use the new database which is coming with the
installed version.

3.8.6.2  Add/Edit network provider

The steps to add a new network provider and to edit the existing one slightly differ.

Adding network provider

1. Select the R&S ROMES4 "Tools" > "Network Provider Database" menu.

The main window of the "Network Provider Database" opens. The left part of the
window is grayed out.

2. Click the "Add Provider" button if you want to add a new provider to the database.
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Figure 3-282: Create entry in the Network Provider Database

The left part of the window changes. It becomes functional and lets you specify
provider's details, that is, provider name, country, RATs to be recorded, the provid-
ers color, bands and the MCC.

3. The  button changes to . Click the button. The "Add Mobile Country Code" dia-
log pops-up where you can specify the new provider, country and the MCC.

Figure 3-283: Adding new provider

4. Click "OK"

The added provider is included in the list of the network providers in the "Countries"
pane.
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Figure 3-284: The added provider included in the database

5. Click the "Apply Changes" button for addition of the new provider to the database.

The "Close & Save" button becomes now functional.

6. Click the "Close & Save" button to finish the procedure and save the changes in
the database, providing the change persistency.

Editing network provider to modify MCC

1. Select the network provider in the "Countries" pane if the provider is present in the
database and you want to edit and modify data.

Figure 3-285: Edit an entry of the Network Provider Database
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2. Click the "Edit Provider" button for selected provider.

3. The  button changes to . Click the button to modify MCC.

4. The "Add Mobile Country Code" dialog pops-up.

Figure 3-286: Edited provider data

5. Specify the value in the "Country Code", for example 999.

Figure 3-287: Modified provider data

6. Click "OK".

The changed MCC is added for this provider in the list in the "Countries" pane.
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7. Repeat the steps 5. and 6. from the previous procedure.

The modified MCC is saved in the network provider database, providing the
change persistency.

Otherwise, applicable for both procedures, click the "Reject Changes" button to discard
the previous actions.

Add mobile country code

The "Continent", "Country" and "Provider Name" are auto-populated if they are availa-
ble in the "Countries" pane selection.

- If a provider is selected in the "Countries" pane, the continent, country and provider
are available.

- If a country is selected in the "Countries" pane, the continent and country are availa-
ble. Provider is populated with private provider.

- If a continent is selected in the "Countries" pane, the continent is available. Country
and provider are populated with private country and private provider, respectively.

- If none is selected in the "Countries" pane, continent, country and provider are popu-
lated with private continent, private country and private provider, respectively. This
case occurs when a provider is deleted and not accepted.

You can use the auto-populated values, or change the populated continent, country
and provider to anything but do not leave them blank.

When you enter a value in the "Country Code", the "OK" button is functional if:

1. None of the boxes are blank.

2. The entered country code does not match any existing code in the database.

3. The entered country name is not associated with exiting different continent.
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3.8.6.3  Remove network provider entry

1. Select the "Tools" > "Network Provider Database" entry.

2. The "Edit, Add or Remove Network Providers" window opens.

3. Select within the left window area one provider.

4. Click the "Remove Provider" button.

The provider is removed from the list in the "Countires" pane.

5. Click the "Apply Changes" button to accept the removal of the provider.

The "Close & Save" button becomes now functional.

6. Click the "Close & Save" button to remove the provider from the database, provid-
ing the change persistency.

3.8.7  Network survey

The Network Survey feature supports GSM, UMTS, LTE, NB-IoT and 5G NR technolo-
gies.

For all supported technologies, the network survey lets you monitor the state of a net-
work. The network state in this context means a set of demodulated transmitter signals
and their power values per technology.

Select "Tools" > "Network Survey" to get the configuration page. Check the "Activate
Network Survey" check box to activate the function.
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Figure 3-288: Network survey dialog

The "Reference File" option of the feature is not supported by NB-IoT and 5G NR.

The feature can work without a reference file. Therefore, no need to create such a file.
If a reference file is specified, only the "Offset to Reference [dB]" values are used.

It is possible to specify an "Exclude File" which allows transmitters to specify, which are
assumed to be OK and do not trigger any events. The format of such a file is CSV for-
mat.

RAT;MCC;MNC;LAC;CI;NR-ARFCN;PCI;Beam
The wildcard * is allowed and ignores the column. For example, if you want to exclude
all GSM transmitters with MCC 123 and MNC 45 specify the line:

GSM;123;45;*;*
If the received power of a measured cell is higher than the required "Min. Power [dBm]"
and higher than the cell's power in a reference file plus the specified "Offset to Refer-
ence [dB]", the network survey events are generated. The offset to reference is consid-
ered in a period longer than the period set in "Min. Violation Time".

GSM, UMTS, LTE and NB-IoT transmitters are searched by Cell Identity only.
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As for 5G NR networks, transmiters are searched by Cell Identity only if available. If
Cell Identity is not available, used is the PCI and the NR-ARFCN, see the Table 3-11.

The "Hysteresis [dB]:" value specified per technology is used to avoid ping-pong
events which occur when a transmitter detects whose power is around the given "Min.
Power [dBm]:" threshold. After the “high power” event has been activated, the transmit-
ter is disabled only if the power drops below "Min. Power [dBm]:" – "Hysteresis [dB]:"
value. Once it dropped below this value, a new “high power” value can be triggered.

For example, for GSM configured is a Min. power of -51 dBm and a hysteresis of 3 dB.
The first time a transmitter is detected with power higher than -51 dBm (for the "Min
Violation Time") a “high power” event is triggered. The corresponding “low power”
event is triggered when the transmitter’s power drops below -51 dBm - 3 dB = -54
dBm. Only in this case a new “high power” event can be triggered once the power
passes the -51 dBm threshold again.

Adapt ACD Sensitivity automatically
The 5G NR, LTE, NB-IoT and UMTS networks survey support automatic adaptation of
the associated ACD thresholds, relative to the configured minimal power values. Check
the "Adapt ACD Sensitivity automatically to" box and specify the threshold to make the
function active.
Note: GSM is not affected by this setting. GSM does not use the ACD.

Activate GPS Survey
If a GPS is connected, and the option is checked, the Network Survey function checks
if the minimum number of satellites are currently available. Whenever the threshold is
passed, an event is generated. The "Too Less Satellites" event or the "Enough Satel-
lites again" event can be triggered. To get these events, it is necessary to activate them
in the "Network Survey" branch of the "ROMES Events" in the "Available Events" >
"Events" pane, see Figure 3-129.
The GPS survey can be deactivated at the beginning of the measurement. The "Grace
Period at the start..." can be specified in the "Network Survey" dialog. Only after the
given amount of time the GPS data is surveyed and events are triggered.

Lab Environment
The "Lab Environment" function enables a set of features, which help when special
needs come up in a stationary lab environment. The set of features can increase in the
future, but for now this feature focuses on the handling of a transmitter database.
If "Lab Environment" is checked, the transmitter monitoring works without a GPS sig-
nal. The position of the transmitter is not considered.
Import of transmitter database without GPS position set is supported for ATD and CSV
formats only.
The ATD/TXT format of transmiter database can be imported without position defini-
tion. A default position is set then to all BTSs.
To support the CSV format, you have to add the "PosLongitude" and "PosLatitude" def-
inition to the header. No position values are required to import. A default position is set
then for all BTSs.
The selection of the transmitter from the database in "Lab Environment" mode differs
from the usual drive test mode.
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Note: The complete set of transmitters is loaded into the application. This loading can
consume some memory, but we do not consider it as a problem up to some hundreds
of transmitter entries.
Depending on the technology, the selection method of a transmitter is as the following:
Table 3-11: Lab environment table

Technology Method

GSM Cell Identity

UMTS Cell Identity

LTE Cell Identity

NB-IoT Cell Identity

Note: The same Transmitter Database as for LTE is used. The NB-IoT Cell Identities
have to differ from the LTE Cell Identities.

5G NR If the Cell Identity is available, the Cell Identity is used.

If the Cell Identity is not available, the PCI is used. Also the NR-ARFCN is used.

The method does the following:

1. Get a set A of 5G NR bands, which are possible for the NR-ARFCN of the detec-
ted cell,

2. Get a set B of 5G NR bands, which are possible for the NR-ARFCN of the cell in
the database,

3. Compare set A with set B; if at least one band is contained by both sets, the
transmitter is accepted.

4. If more than one transmitter is possible, the names of the possible transmitters
are concatenated.

Network survey event information
The "Event View" of the network survey events contains in the "Information" column
the text that follows the following pattern:
Tec, Power, Frequency, Channel, Cell Identity, physical ID, Mode, Name

Figure 3-289: GSM network survey - event threshold passed up

The "Mode:" tag of the events for 5G and NB-IoT are at the end of the event descrip-
tion.
For the "Event View" page, see Chapter 4.2.6, "Event view", on page 498.
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3.8.8  Reset USB ports

R&S ROMES4 supports the Cleware GmbH USB cutter. All detected USB cutters will
disable the USB link and enable the link again after five seconds, if the "Reset USB
Ports" command is selected.

3.8.9  Run QualiPoc update tool

If clicked, the "Run QualiPoc Update Tool" menu item opens the tool to run QualiPoc
update. The following warning message precedes running the tool as this action closes
the R&S ROMES4 application.

Figure 3-290: Warning if running QP update tool

The QualiPoc update tool can be started also independently on R&S ROMES4 from
the Windows "Start" > "R&S ROMES" menu, see Chapter 5.4, "QualiPoc update tool",
on page 1436.

3.9  Window menu

The "Window" menu offers commands for arranging and handling the view windows
and shows a list of all open views.

Window menu
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Figure 3-291: Window menu

Multiple Document Interface (MDI) window allows changing a child frame size and its
position in the view area according to application size change. Use the "Grow/Shrink
windows" switch to turn this option on or off. It is a button in the toolbar.

Figure 3-292: Button for changing a child frame size

With the R&S ROMES4 installation, the status of this function is stored in the registry
together with other options and used when the R&S ROMES4 is started again.
The function is disabled (grayed) when there are no open child windows in the client
area (for example, when the Welcome view is active).

New Window
Create a view of the same type as the active window.
The "New Window" command enables multiple view types. Those types are character-
ized by a current number behind the view title (e.g. "Measurement Report View: 1").
The "New Window" is also available in the context menu associated to multiple views.

Window menu
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Close All Windows
Closes all windows on all View Areas.

Close All Windows on <S>
Closes all windows on the View Area named <S>.

Manage Windows
Changes child frame size and a position in one or more view areas according to the
changes of application size.
If this item is active (checked) and there are opened views, for example, the "Message
View" and some more, their windows grow/shrink with the R&S ROMES4 main win-
dow. Also they slightly change their positions.

Normalize vitr. Desktop
Resizes the virtual desktop. The tiles are split and arranged equally within the available
desktop space.

Toggle Windows Size
Toggles the size of child frames if pressed Strg+Circumflex.

Cascade
Superimpose all opened view windows showing each one’s title bar. The active window
is placed in the foreground.

Tile horizontal/vertical
Places all open view windows side by side (or stacked vertically) so that they do not
overlap.

Arrange Icons
Arranges the minimized views to the bottom of the visible view area.

3.10  Help menu

The "Help" menu provides online help and general information on R&S ROMES4.

Help menu



User interfaceDrive Test Software

417Operating Manual 1171.6415.12 ─ 66

Figure 3-293: Help menu

3.10.1  Index

Opens the start page of the online help.

The opening page helps you to find all information needed for using the R&S ROMES4
via the navigation tools such as the table of contents, index of keywords and hyperlinks
quickly.

Figure 3-294: Online help
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3.10.2  Using help

The online help system itself is accessible by clicking "Help" > "Index" or the F1 key.

R&S ROMES4 is equipped with a context-sensitive help function. A help page is avail-
able for most windows and can be called anytime during operation.

The context-sensitive help page is a part of a comprehensive help system. To get the
help page of an open window, the left mouse button click in the window's area or title
bar and press then the F1 key.

It is possible to move from the context-sensitive page to any page of the help system.

The help function is provided with a navigation bar. Other help pages are called from
the context-sensitive page via the table of contents, index, arrows for scrolling and
page-internal links.

The help file (*.chm) is available on the installation folder and can be used as a stand-
alone help.

3.10.3  Create signal description document

R&S ROMES4 can compile a single document, which contains all signal descriptions,
see Chapter 3.3.7.2, "Tooltips for R&S ROMES4 signals", on page 162. The result is
an HTML file, which can be displayed in the Internet Explorer and printed as a PDF
document, if desired.
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3.10.4  Licenses

The "Help" > "Licenses" entry unifies licensing information on R&S TSMx scanner (see
Note, QualiPoc and expired licenses within one dialog.

If you click the "Help" > "Licenses" command, the "Licenses Overview" dialog is dis-
played. There are four tabs available in this dialog, each exposing the licensing infor-
mation.

The "Available Options" displays all software modules available in the current R&S
ROMES4 installation.

The licensing information, like installed or missing licenses and up to which R&S
ROMES4 version is an installed device licensed, is displayed in the middle part of the
dialog, named as "Detailed Information". For the selected device, this information is
displayed.
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Figure 3-295: Licenses dialog - Available Options

The lowest part displays the found sales options which can be ordered. The "Info" col-
umn provides link for the license details of the found options.

The "PESQ License" button lets you modify the PESQ license in the dialog of the same
name. The PESQ license is the only license which can be modified. The "OK" button
becomes active when you select a PESQ file.

Figure 3-296: Active PESQ file browse button

The "Save Log" button writes the list of modules shown in "Available Options" to a text
file. The name and directory of the file are shown in a pop-up dialog.
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Figure 3-297: Versions log file created

The "OK" and "Cancel" buttons let you confirm or cancel the selection, respectively,
and close the "Licenses Overview" dialog.

3.10.4.1  TSMx option table

The "Licenses Overview" > "TSMx Option Table" tab opens the dialog in which you can
see the complete options associated to a selected scanner and the status of provided
options' licenses. The scanner is selected in the "Device" drop-down list.

Figure 3-298: Complete table of R&S TSME6 scanner options
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The R&S TSMx scanner licenses can be time limited.

To inform you about the expiry of the licenses of the R&S TSMx scanner within next 30
days, R&S ROMES4 provides a warning.

The R&S TSMx scanner is the naming of all scanners of the R&S TSME family.

How many hours trigger the warning can be adapted by the following registry key:

In how many hours to trigger the warning about expiry of the R&S TSMx licenses is
adaptable by the following registry key:

Computer\HKEY_CURRENT_USER\SOFTWARE\Rohde & Schwarz\Romes<version>
\General

TSMxExpMinHoursForWarning DWORD (32-bit) value key

Every time R&S ROMES4 scans for scanner, it checks the licenses and shows the
warning. It is possible to suppress the warning for the current session.

Already deactivated licenses do not trigger the warning.

3.10.4.2  Expiring licenses

The "Licenses" > "Licenses Overview" > "Expiring Licenses" tab opens the dialog
which shows the expired licenses.

The dialog automatically pops-up at the startup and is automatically closed after 30
seconds if there is no user interaction (no screenshot, since no change).

The two options, "OK" and "Cancel" to proceed within this time are available. You can
continue the start of R&S ROMES4 or exit.

If you continue, some functionality cannot work as before, since the licensed features
that expired are disabled.

If R&S ROMES4 is started again after the license expiration is shown, the dialog does
not come up again unless there is new expiration information available.

To enable the expired licenses again, reload them.
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Figure 3-299: Expired licenses dialog

The dialog of expired licenses is always recallable via the "Expired Licenses" tab.

3.10.4.3  QualiPoc licenses

An information table similar to the one from the "QualiPoc Update Tool" is shown in this
license dialog.

The "QualiPoc" dialog is automatically updated when R&S ROMES4 detects changes
in the connection status with the mobile/QualiPoc.
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Figure 3-300: QualiPoc licenses dialog

The "Update Information" button rescans all mobiles and refreshes the information in
the table. If a change is not detected by R&S ROMES4, you can force a refresh of the
data with this button.

QualiPoc licenses reporting

The QualiPoc software of release 22.3 and higher, reports licenses related information
to a central cloud instance. This information is uploaded during each start-up of the
QualiPoc application. The following are advantages of the feature QualiPoc Licenses
Reporting:

- Better customer support on maintenance issues

- Minimizes the effort for license-related support issues for customer and R&S

- Getting better understanding of the devices and software versions used in the field

The reported information is:

- License used to operate this QualiPoc instance (serial number the license is bound
to, license options, maintenance period, time limited options)

- Version number of the used QualiPoc build

- Device-related information (model, firmware, region code/CSC)

The information which is not transferred is:

- Location information (longitude, latitude...)

- Information about product usage, configured jobs or measurement files

- Any other information which is stored on a device under test
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The feature is activated by default. Each customer can deactivate the related reporting
in the "Settings" menu of the QualiPoc application.

Click "Settings" > "Advanced Analysis" > "License Reporting" in QualiPoc menu.

3.10.5  TSMx installation

The command opens the "TSMx Installation" dialog showing all the R&S TSMx-related
software modules available in the current R&S ROMES4 installation.

Figure 3-301: TSMx Installation dialog

● "Save"
Writes the selected module shown in the "TSMx Installation" dialog to a text file.
The name and directory of the file are shown in a popup window.

● "Close"
Closes the "TSMx Installation" dialog.

3.10.6  About R&S ROMES4

Displays the R&S ROMES4 startup window indicating the name and version number of
your R&S ROMES4 copy.

In addition, the window provides a selection of useful URL links, that is, the support
contacts.
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Figure 3-302: "About ROMES ..." information

Click the contact data of your region to create an e-mail.

3.10.7  3rd party tools acknowledgments

The "Help" > "3rd Pary Tools Acknowledgements" entry summarizes two entries, the
"Open Source Acknowledgments" and the "License Agreements".
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3.10.7.1  Open source acknowledgments

If you click the "Open Source Acknowledgments" command, the "R&S ROMES4 Drive
Test Software <version> Open Source Acknowledgment" document is displayed.

3.10.7.2  License agreements

The ASIO redistribution license agreement is shown if you click the "License Agree-
ments" command. R&S ROMES4 Drive Test SW is using licensed ASIO product for
Speech Quality purposes.

ASIO is a trademark and software of Steinberg Media Technologies GmbH.
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4  Display and evaluation of results
This chapter describes how to display and analyze the data measured or stored in a
measurement file and replayed. Data selection and configuration of the view properties
is performed in the "Tools" > "Configure Active View" window.

A view configuration is also possible from the individual view's window - the right
mouse button click the window's area and select the "Configure" entry from the pop-up
window.

The view windows are called up in the "View" menu.

For an overview of all menus and menu commands refer to Chapter 3.3, "View menu",
on page 134.

● Common properties of R&S ROMES4 views........................................................428
● Basic views........................................................................................................... 445
● Navigation views................................................................................................... 548
● Mobile views..........................................................................................................686
● CW views............................................................................................................ 1058
● QoS views...........................................................................................................1059
● WLAN views........................................................................................................1103
● Scanner views..................................................................................................... 1117

4.1  Common properties of R&S ROMES4 views

The R&S ROMES4 views are optimized to visualize different data types obtained from
different sources. Therefore the views vary in appearance and functionality. However,
some properties are common to many or even all views.

Figure 4-1: General view properties - example

Common properties of R&S ROMES4 views
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The following entries are part of each view.

4.1.1  View title

The title bar contains the name of the view and three icons to minimize, maximize and
close the view. A sequence number (: 1) behind the view's name indicates that it is
allowed to open several views of the same type.

4.1.2  Device tabs

Many views include separate tabs to display the data originating from different test
devices (e.g. different test mobiles, receivers, etc.). A mouse click the tab correspond-
ing to a device, places its view into the foreground.

The device tabs in all open views are coupled. Selecting a device tab in anyone view,
activates the same tab in all other views. The "Control" key disables this coupling
mechanism.

4.1.3  Context menu

Most views provide a context menu to access typical configurations and perform
actions.

A right mouse click a point anywhere in the View Area opens the context menu. The
following context menu commands are often used:

● "Configure"
Opens the configuration menu associated with the view; see below.

● "Configure Signals"
Opens the "Available Signals" tab of the Chapter 3.8.1, "System configuration
(preferences)", on page 223 to configure the signals available for viewing.

● "Configure Events"
Opens the "Available Events" tab of the Chapter 3.8.1, "System configuration (pref-
erences)", on page 223. Here you can select the signal events to be recorded dur-
ing the measurement and configure the additional user and comment events.

● "Hold"
This function "freezes" the current measurement display for examination purposes
without stopping the measurement. A view on hold can be released, which updates
the view to reflect the actual measurement status.

● "Copy to Clipboard"
Copy a screenshot of the current view to the clipboard to paste it into another appli-
cation.

● "New View"
Opens an additional view of the same type. A practically unlimited number of views
can be opened at the same time. Views of the same type are distinguished by the
current number in the title bar indicating the order in which they have been created.
Example given, the 1 in the Figure 4-1 figure.
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● "Destroy View"
Deletes the active view with its contents. New View cannot restore a deleted view.
A workspace must contain at least one view of each type, so "Destroy View..." is
disabled for the last view of each type. R&S ROMES4 generates a warning:

● "Save as Default Configuration"
Saves a current configuration of the view to an ASCII file named Master.rsxks
in the Workspace subdirectory of R&S ROMES4 program directory. The file con-
tains everything defined in the configuration menu of the view, including the
selected signals.
The default view configuration is used whenever a new view of the same type is
created, irrespective of the current workspace. It is changed if a new default view
configuration is saved. The new configured file is reset by deleting the previous
one.

● "Move to"
Opens a secondary context menu which contains all currently available view areas.
This command is dimmed if the current workspace contains only one view area.

● "Remove Signals"
Opens a secondary context menu with all signals selected for display. Clicking a
signal removes it from the "Selected Param." list. "Remove Signal" is not shown if
the "Selected Param." list is empty.

4.1.4  Configuration menu

Some views are associated with a configuration entry that can be opened from the
context-sensitive menu. The configuration entries provide view-specific settings.

4.1.4.1  Info

The "Info" tab provides the information on the current view version. It is common for
each view and present in each view configuration menu.

Use the "Module Properties" > "Custom Name" box to assign a custom name to an
active view in the view's title bar.

Different connected devices can be associated with different custom names using this
option. For example, use it to separate mobiles in different networks or if simultane-
ously operated mobiles perform different tasks.
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Figure 4-2: Info tab

As the "Info" tabs are analog for all view types, we omit them in the following views
description.

4.1.5  Replay jump to timestamp

In many views (e.g. the "Layer 3 View", "2D Chart View", "Route Track View" etc.), it is
possible to initiate a replay jump to a particular message, event or characteristic posi-
tion spotted in the view (in general, to a particular timestamp in the message file). This
type of replay jump must be initiated during a replay pause. The replay is continued at
the selected timestamp.

To initiate a replay jump to a timestamp (e.g. in the "Layer 3 View"), proceed as follows:

1. Open the view, replay a measurement file ("Step One Data Set Forward" or )
Pause the replay ("Measurement – Replay Pause" or ).

2. Keep the [Ctrl] key on your keyboard pressed.

3. The cursor icon has the clock symbol.

4. Double-click a particular message.

The screen is refreshed. After clicking  again, the replay starts with the message
selected in the last step.
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4.1.6  Coupled focus

Many views provide graphical tools to highlight special areas and read a particular
result. The focus in several views can be coupled, which makes it easier to analyze dif-
ferent aspects of a coverage measurement at a particular position using a set of appro-
priate views. For details, see Chapter 3.8.3, "Coupled focus", on page 384.

4.1.7  Unifying the transmitter signals

Several views use colors to identify a certain transmitter. For example, the Top N views
print the color of a transmitter at the first column of the table or, the "ROMESMAP
Route Track Vew" uses the colors to underlie the tracks.

R&S ROMES4 uses the same color for the same values. The actual color is derived
from the value of a RAT-specific signal. The RAT-specific signals from UE and scan-
ners are linked together. If you change the color scale of one R&S ROMES4 signal, the
color scale of the others is changed automatically.

There is only one color scale used by the different R&S ROMES4 signals.

RAT UE Scanner

GSM BCC TopN Pool 1 BCC

UMTS Scrambling Code TopN Pool 1 Scrambling Code

LTE/5G NR PCI TopN Pool 1 PCI

cdma/EVDO PN offset TopN Pool 1 PN offset

TETRA Carrier or LA (dependent on set-
ting in the "TEC for TETRA Scan-
ner"

TopN Pool 1 Carrier or LA

WiMAX - TopN Pool 1 Preamble Index

4.1.8  Extended grid view

Some R&S ROMES4 views independently of type are called grid views as the layout of
the main window is a grid or contains several grids.

A grid contains column filter where text can be entered to filter grid lines. Grid lines are
removed if the lines do not contain the filter text. The following screenshot of the "View"
> "Basic Views" > "Event View" shows a grid with filter bars.
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Figure 4-3: Grid view - example

The extended grid view supports, apart from the mentioned "Event View", the "LTE/
5GNR RRM Mobility Analysis View" in the "View" > "Mobility View".

4.1.8.1  Extended grid filter marker

Grid in a view can be extended to include markers for highlighting grid cell text with col-
ors. The grid column filter in extended grid allows you to mark custom text.

The general marker syntax is

$C:TEXT$ where

- $ is the marker start and stop token. A valid marker must be included with two ‘$’s.

- C is the color specifier, can be any of following colors:

r: o: y: b: g:

red orange yellow blue green

- : is a separator for separating color specifier and marker text

- TEXT is the marker text to be marked or highlighted. The marker text is case insensi-
tive.
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Example: 
Filter $g:gps$
The meaning is: mark all “gps” parts of the column's texts green.
The following screenshot illustrates this example of the "Event View".

Figure 4-4: GPS events marked in green

4.1.8.2  Multiple extended grid markers

Multiple color markers per line and filter are allowed.

Example: 
Filter $g:gps$$r:device$

The meaning is: mark all “gps” parts of the column's texts green and all “device” parts
red.

The following screenshot illustrates this example.
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Figure 4-5: GPS and device events marked

4.1.8.3  Grid filter

The grid filter works the same way as preciously described. The actual columns filter
text is the text in the filter bar with all markers removed.

Example: 
Filter “gps $g:gps$$r:device$”
This means: the grid is filtered with “gps“ and colored by “$g:gps$$r:device$”.

Press return key to filter the grid.
● The grid is filtered.
● Color marker takes effect immediately when the second marker token “$” is

entered if the marker is valid.
● Filtering takes effect only after return key is pressed.
● Blanks or anything between two extended filter markers is a part of filter text. For

example, “gps $g:gps$ $r:device$” empties the grid, because the actual filter text is
“gps “

Common properties of R&S ROMES4 views



Display and evaluation of resultsDrive Test Software

436Operating Manual 1171.6415.12 ─ 66

Figure 4-6: Filtered grid

4.1.9  Drag and drop signals between views

In general, signals can be drag-dropped from some basic views and the "3GPP Over-
view View" to other views. The signals are dragged from so called source views and
dropped to so called target views. The "Copy Signals between Views" feature is appli-
cable to the following views.

The source views from which you can drag a signal are:
● "2D Chart View" (Legend Pane)
● "Alphanumeric View"
● "ROMESMAP Route Track View"
● "3GPP Overview View"

The target views in which you can drop the signal are:
● "2D Chart View" (Legend Pane)
● "Alphanumeric View"
● "ROMESMAP Route Track View"
● "X-Y Grap"
● "Statistic Histogram"
● "Grid View" (Configuration Mode)

The device filter dialog automatically pops-up that let you choose a device depending
on the device's availability in source view and the device's requirement in target view.
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4.1.9.1  Drag and drop signals from/to the basic views

The R&S ROMES4 signals are usually first selected from the "Signal Tree" and drop-
ped into a source view. Once signals are available in the source view, they can then be
drag-dropped to other target views.

If a view does not support character string signals, e.g. the "2D Chart View", string type
signals cannot be dropped into such a view.

In the following, illustrated is this signals drag-drop feature for all views previously lis-
ted.

Drag signals from 2D chart view

Selected signals in the "2D Chart View" are shown in the  row header which is pres-
ent in the "Chart 3" of the following screenshot. The 1st, 3rd and 5th signals are
selected there.

The signal sets (RSS0, RSS4) can also be selected in this view. When dragging a sig-
nal set, all signals in a signal set are copied.

Single signal is drag-dropped inside the "2D Chart View" between/inside groups. Multi-
ple selected signals can be drag-dropped to other target views.

Figure 4-7: Chart 3 shows the drag-dropped signals

Drag signals from alphanumeric view

The screenshot of the "Alphanumeric View" shows three selected signals (blue lines)
that can be dragged into any target view. Drag/drop a signal inside the view changes
its position in the view.

Common properties of R&S ROMES4 views



Display and evaluation of resultsDrive Test Software

438Operating Manual 1171.6415.12 ─ 66

Figure 4-8: Selected signals for drag-drop in Alphanumeric View

Drag signals from statistic view

Similarly, selected are three signals in the "Statistic view" that can be dragged to any
target view.

Figure 4-9: Selected signals for drag-drop in Statistic View

4.1.9.2  Drag and drop signals from ROMESMAP route track view

The signals in the "ROMESMAP Route Track View" are listed in the dropdown list of
the dialog on the top-left side of the view. The screenshot shows in that box RSSI
(PCell) signal. The associated device is stored in the dropdown list of the box next to
the previous one, shown as "<empty>" in the screenshot. The selected signal can be
dragged and dropped by pressing the "Value" area on the top.
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Figure 4-10: ROMESMAP Route Track View showing the selected signal

Hover mouse over the "Value" box to get the Tooltip of that box.

Figure 4-11: Tooltip of the Value box

A signal from other view can be dropped into the legend or the box on the top-left side
of the view.

4.1.9.3  Drag and drop signals from 3GPP overview view

The "3GPP Overview View" deals with only UE (i.e. mobile) signals. In the view, there
are "Label" and "Data cells" signals and both can be dragged and dropped.

General top sections and default RAT

The following screenshot shows the "3GPP Overview View" in general, without mea-
surement file or closed measurement file. The default RAT is LTE.
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Figure 4-12: Default 3GPP Overview View

The signals in two top sections of the view are draggable, but only the data cells. The
labels, as cell name, MCC, MNC, test, state, direction etc., are not draggable.

Dragging on a label signal, e.g. "Band", the default view is applied. A "Cell Type" filter
dialog pops-up for user to select cell type, PCell and SCells. If the signal does not sup-
port PCell, the "Cell Type" dialog is not displayed.

When replay or measurement starts, the associated RAT is populated in the view.
Draggable cells change accordingly.
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LTE and 5G NR label and data cells

If the measurement file contains measured both LTE and 5G NR cells, the LTE and 5G
RAT data cells populate accordingly the "3GPP Overview View" grid. The RAT can
change in time.

Figure 4-13: LTE cell data and 5G NR cells data populate 3GPP Overview View

1. If a label is associated with multiple signals, all them are copied during drag-drop,
such as QSPK/16AQM/64QAM/256QAM.

2. More SCell data cells can be available.

3. RAT for 5G cells is optional.

4. A signal can be associated with devices, the devices are shown in different tabs.

5. AvgPUSCH Layers is not draggable.

NB-IoT label and data cells

Dragging label and data cells are the same for NB-IoT in the "3GPP Overview View".
Data cell column is "NB-IoT Total". All NB-IoT signals are draggable in this view.

Common properties of R&S ROMES4 views
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Figure 4-14: NB-IoT cell data populate 3GPP Overview View

UMTS label and data cells

Dragging label and data cells are the same for UMTS in the "3GPP Overview View".
Data cell column is "Serving Cell". All UMTS signals are draggable in this view. Drag-
ging QSPK/16AQM/64QAM/256QAM drags all four signals.

Common properties of R&S ROMES4 views
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Figure 4-15: UMTS cell data populate 3GPP Overview View

GSM label and data cells

Dragging label and data cells are the same for GSM in the "3GPP Overview View".
Dragging label and data cells are the same. Data cell column is "Serving Cell".

Common properties of R&S ROMES4 views



Display and evaluation of resultsDrive Test Software

444Operating Manual 1171.6415.12 ─ 66

Figure 4-16: GSM cell data populate 3GPP Overview View

Not draggable GSM signals are:

- Hopping

- Top Rank

- CA-List

- P-TCHs

4.1.9.4  Drag the Top N signals from the <TEC> scanner TopN view

The Top N signals can also be dragged from the Top N list and dropped to other views.
If the list items are displayed, all the "List" columns, except for the "#" column, can be
dragged.

The signals in theTopN view are copied/dragged in the following way:

1. TopN pools and members are associated with the row.

2. TopN devices and/or TETRA sweeps are associated with the tabs.

3. If dragging on an empty area, but still under a TopN column in the TopN view, the
filter dialog displays pools and members.

4. Signal can be dragged even if no measurement file is loaded. The filter displays
pools and members.

Common properties of R&S ROMES4 views
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The Top N signals cannot be dragged in the following situations:

1. If dragging on a point that is outside of Top N columns, nothing happens. For exam-
ple, dragging on a point far right-hand side of the TopN view.

2. Signals copying is not supported in "Details" pane of the "5G NR Scanner Top N
View".

3. Signals copying is not supported in the "cdma2000/1xEV-DO Scanner Top N View"
and "WiMAX Scanner Top N View".

4.2  Basic views

The R&S ROMES4 basic views can be used to analyze data from various sources.
The views are available irrespective of a kind of measurement performed or a type of
measurement data replayed.

A basic view can be selected from the "View" > "Basic Views" menu of R&S ROMES4
menu bar, when the mouse pauses over the view you want to be displayed.

Figure 4-17: Basic Views menu

The configuration page "Values" of some basic views contains the options which help
the user to find the required signal faster and in a more convenient way.

Available functions in this page are:
● "Available Signals"

Shows the list of signals available to be selected for viewing.
● "Selected Signals"

Shows the list of signals selected for viewing.
● "Tree Filter" makes it possible to filter the trees in the "Available Signals" list just by

entering the tree's name or a part of its name as a filter.

The following views contain these options:
● Alphanumeric View

Basic views
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● 2D Chart View
● Statistics Histogram
● Statistics View
● ROMESMAP Route Track View

All views respect the general performance settings regarding the visual update rate
done in the "Tools" > "Preferences" > "Performance" menu. The view individual set-
tings are not supported.

Basic views as default views

It is possible to define several basic views including their different configuration set-
tings using the R&S ROMES4 Default Views feature.

Pre-configured basic views can be used as the default views for the corresponding
technologies.

R&S ROMES4 opens default views for each device after it has been connected suc-
cessfully to the application. Which views have to be loaded is specified in the file
DefaultViews460.xml which is located in the MyROMES\Configuration folder.

It is possible to define basic views, for example, the Alphanumeric View and load a
specific configuration. The xml CfgCustomName attribute lets you specify the specific
view of the config file.

Also, a Tec "Industry40" is defined. If the data quality tester (DQA) runs in Classic
Mode 2, it returns "Industry40" as supported Tec.

To create desired default view, perform the following:

1. Create a workspace.

2. Configure the basic views, as you would like to have them opened automatically.

3. Click the"Info" tab in the view configuration dialog.

4. Give each basic view a custom name in the "Custom Name" box. It is important,
that each view gets its unique custom name, as the names are used to find the cor-
rect configuration later.

Figure 4-18: Naming the default view
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5. Save the workspace to the MyROMES\Configuration folder. It is the folder in which
the DefaultViews460.xml is located.

6. Open the DefaultViews.xml in a text editor.

7. Add the desired default views.

The "Device Grid View" and "Grid View" are not supported.

Example: 
Adding the Interactivity Test View and two Alphanumeric Views for Industry 4.0
<!--============== Industry 4.0 ==========================-->
<DefaultView         Name="Interactivity Test Summary View"
                     OverviewSheet="I4.0"
                     Tec1="Industry40"/>
<DefaultView         Name="Alphanumeric View"
                     OverviewSheet="I4.0"
                     Tec1="Industry40"
                     CfgFile="I40.rsxks"
                     CfgCustomName="Interactivity Results"/>
<DefaultView         Name="Alphanumeric View"
                     OverviewSheet="I4.0"
                     Tec1="Industry40"
                     CfgFile="I40.rsxks"
                     CfgCustomName="="iPerf Results"/>

The Name attribute gets the basic view’s name.
The CfgCustomName attribute specifies the custom name as a set in the "info" tab of
the basic view’s configuration dialog.
The CfgFile attribute specified the name of the workspace which contains the config-
urations of the custom views. The workspace has to be located in the MyROMES\Con-
figuration folder.

● 2D chart view........................................................................................................ 448
● ACD status view....................................................................................................461
● Alphanumeric view................................................................................................466
● Bar chart view....................................................................................................... 471
● Device grid view....................................................................................................477
● Event view.............................................................................................................498
● General status view...............................................................................................501
● Grid view............................................................................................................... 504
● Message view....................................................................................................... 515
● Resource usage view............................................................................................517
● Statistic histogram.................................................................................................525
● Statistic view......................................................................................................... 532
● Time gated spectrum view.................................................................................... 540
● X-Y graph view......................................................................................................543
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4.2.1  2D chart view

The "2D Chart View" contains a Cartesian diagram showing one signal, the R&S
ROMES4 signal sets or both as a function of time or covered distance.

Figure 4-19: Basic 2D Chart View

The view supports visualization of the configured signals both in line and bar chart.
How to enable the bar charts, see Chapter 4.2.1.4, "Chart group menu", on page 455.

R&S ROMES4 allows several independent diagrams to open superimposing many
quantities in the same diagram simultaneously.

You can add signals you want to be displayed in the view in the following way:

- drag and drop signal from the "Signal Tree"

- click the  "Add Signal/Signal Set" button in the "Chart<variable>" legend title bar.
The action brings up by default a pop-up window containing the list of available signals.

Basic views
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Figure 4-20: List of available signals

It is possible to select one or more signals from the list by double click the desired sig-
nals. The selected signals are marked in the list with the check mark next to the sig-
nals' names. After selection of all desired signals, click "OK" to add the signals to the
"2D Chart View".

If a signal without available data is selected (for example, RxQual while the mobile is in
"Scan" mode), no trace is plotted.

Instead, you can select a signal set if you click the "Signal Set" button in the previously
mentioned pop-up window.
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Figure 4-21: Added signal sets for display

You can modify the signal sets by clicking the "RSS Admin" button. If you want to
return to add signals pop up, you need again to click the  icon after the mentioned
signal set modification.

The "Copy Signal" option lets you copy the selected signal or signal sets to the tem-
plate filter.

4.2.1.1  2D chart view as bar chart

Adding the signals to bar chart is the same as adding them to line chart of the view.
You can add them from "Signal Tree" or "Add Signal/Signal Set" button. The last men-
tion is the only way to add signal set.

Figure 4-22: ROMES signals displayed as bar chart
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Figure 4-23: ROMES signal sets displayed as bar chart

If multiple chart groups are configured, a signal can be configured in up to 2 different
chart groups. To duplicate a signal, drag and drop the signal from one group to another
while holding the “CTRL” key. The same applies while dragging entire groups.

If a signal is configured in more than one group and you want to delete it, the signal
must be deleted from each group separately by default. However, both signals can be
deleted at the same time by holding down the “CTRL” key when delete either of the
signals.

There is Incompatibility with the existing workspaces.
Redo each existing R&S ROMES4 workspace that contains configured old bar chart
view with an instance of the configured "2D Chart View" with bar charts. R&S ROMES4
does not convert automatically the old "2D Bar Chart View" entries in the workspace to
the new version of the view.

4.2.1.2  Chart group legend

Signals configured for a chart group are displayed in the chart group legend.

Figure 4-24: Chart field and the various group legends

Table 4-1: Entires in the Chart field

Column Meaning

1 Indicates the color of a signal in the chart and also the selected signal. The selected signal
is shown on the chart with a thicker plot line. The selected signal can be changed by click-
ing different signal. Only one signal at a time can be selected.

2 Indicates the current signal value and unit.
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Column Meaning

3 Indicates the signal name.

4 Shows or hides a signal on the chart. Check the box to get the signal on the chart.

5 Indicates the axis group number and the auto zoom to fit status. Signals with the same
axis group number share a Y-axis setting on the chart. Signals that share the axis are
determined automatically by R&S ROMES4 with the same relationship id or same unit
value.

Automatic zoom to fit X-axis status is A for automatic zoom to fit enabled or D for auto-
matic zoom to fit disabled.
Automatic zoom to fit is disabled under the following conditions:
● Automatic zoom to fit is disabled in the properties menu.
● Y-axes for the values are manually set by the user for the axis group that the signal is

a part of.

6 Indicates the minimum Y-axis value. The default minimum Y-axis value for an axis group is
calculated by taking the lowest Y-axis value of all signals in the group.

7 Indicates the maximum Y-axis value. The default maximum Y-axis value for an axis group
is calculated by taking the highest Y-axis value of all signals in the group.

8 Indicates the signal configuration used to show the signal on the chart. To change the
value, click the column and bring up the pop-up menu.

9 Contains two icon buttons.

 removes the signal from the chart group.

 resets Y-axis values to default calculated values for this signal and all signals in the sig-
nal group.

Figure 4-25: Changing signal value - clicking the column 8
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Related to column 8 in the "Chart" field, the following options to change are:

● "Graph Type" - the graph type used for data display, which can be selected
between:
– "Line" - standard 2D chart line graph
– "Vertical Line" - shows data points as a series of vertical lines instead a single

horizontal line

Figure 4-26: Layout of Vertical line graph

– "Scatter Circle"
– "Scatter Triangle"
– "Scatter Rectangle"
– "Scatter Rhombus"
– "Scatter Triangle Left"
– "Scatter Triangle Down"
– "Scatter Triangle Right"
– "Scatter Pentagon"
– "Scatter Hexagon"
– "Scatter Star"
– "Scatter Cross"

In general, scatter chart shows only data points using the defined shape
(screen shot shows Scatter Circle)
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Figure 4-27: Scatter chart example - scatter circle

● "Use Color" allows for a single color to represent the signal in the chart.
● "Use Signal Value Color", the color on the chart corresponds to the current value of

the signal.
● "Use Other Signal For Color", the color on the chat corresponds to the current

value of the selected signal.

4.2.1.3  Chart group title

A chart group title by default is the "Chart x" where x is the chart number. This value
can be changed in the "2D Chart View:x Properties" menu by changing the title in the
"Group Configuration" > "Chart x" > "Title" field for the chart. The screenshot shows
selection of Chart 1 for display and for title change.
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Figure 4-28: Properties field - chart 1

The option "Chart" in the "Group Configuration" > "Chart n" lets you switch from the
line chart number n to the bar chart if the box is checked.

The default background color can also be changed here by selecting a color in the
"Header Color" field.

4.2.1.4  Chart group menu

The  "Show / Hide Chart Group" button of this menu has the following options:

● "Hide Chart" - hides the chart group.
● "Remove Chart" - removes the chart group.
● "Show All" - shows all hidden chart groups.
● "Add Chart Group" - adds a new chart group at the end of the current chart groups.
● "Remove All Signals" - removes all configured signals from the chart group.
● "X Axes Zoom To Fit" - zoom X axis to show the entire replay or measurement.

Zoom applies to all chart groups if the "Couple X Axis" is checked in the properties
menu. If the "Couple X Axis" is unchecked, the option applies to the specific chart
group. (Applicable only during reply or measurement.)
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● "X Axis Reset" - resets X axis to default values. Reset applies to all chart groups if
the "Couple X Axis" is checked in the properties menu. If the "Couple X Axis" is
unchecked, the option applies to the specific chart group. (Applicable only during
reply or measurement.)

● "Y Axes Zoom To Fit" - zoom the Y axis of the specific chart group to current values
in the chart. (Applicable only during replay or measurement.)

● "Y Axis Reset" - reset the Y axis of the specific chart group to the default values.
(Applicable only during replay or measurement.)

The  "Add Signal/Signal Set" icon adds wanted signal or signal set in the view.

The  "Zoom To Fit X Axis" icon resets the X axis to default values if you press the
“CTRL” key while clicking the icon.

The  icon resets the Y axis of the specific chart group to default values. Press
“CTRL” key while clicking this button icon to zoom to fit the Y axis.

Adding chart group

Click the "Show / Hide Chart Group" > "Add Chart Group" to add a new chart group
(the view supports up to 8 chart groups), or click the  "Add Chart Group" in the "2D
Chart View: 1 Properties" menu.

Moving chart groups

Chart group order can be changed by clicking and holding a chart group title bar and
then dragging it to a new location in the view.

Moving signals

Signals can be moved to a new position within the same chart group or to a new chart
group. Click and hold on the signal's name and then drag to a new location.

Properties menu

The "2D Chart View: 1 Properties" pane holds the following entries, see the Fig-
ure 4-28.

"Global"
● "Update Rate In MS" – shows how often is the view redrawn during replay or mea-

surement.
● "Update Signal Rate in MS" – shows how often are signals updated in milliseconds.
● "Show Legend" – shows/hides the chart legend.
● "Show Events" – shows/hides the chart event windows. This window shows config-

ured R&S ROMES4 events for the measurement/replay.
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Figure 4-29: 2D chart view shows events

● "Event Line Color" – select a color to represent event markers in the chart.
● Available are the following "Zoom Options":

– "Mouse Wheel & Pan" - to zoom, use the mouse wheel. Click and hold on the
chart to pan the chart.

– "Magnify" – to zoom on the chart, click the left mouse button to zoom in and the
right mouse button to zoom out.

– "Select" – to zoom into selected area in the chart, use mouse, place the cursor
on the area and zoom into it.

● "Zoom Type" – what axis zooming applies to.
– "X Axis Only" – zooming applies to only the x axis.
– " Y Axis Only" – zooming applies to only the y axis.
– "Both" – zooming applies to both the x and y axis simultaneously.

● "Show Values on Mouse Over" – show or hide the values in the chart for the cur-
rent mouse position. (In the following screenshot these values are listed in the
upper left corner of the view.)
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Figure 4-30: Values shown in the chart

● "Cursor Color" – changes the color of the current position cursor.
● "Selected Signal Style" – the chart style of the selected signal for each chart group.

– "Thick" – selected signal represented by a single thick line. (Thick line only
applies if the selected signal is a line type. If the select signal is configured as a
vertical line or scatter type, that type is displayed as filled instead of a thick
line.)

Figure 4-31: Tick line signal style

– "Filled" – the selected signal is represented by filled area.
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Figure 4-32: Filled signal style

– "Tick and Fill" – the selected signal is represented by a thick line and filled
area.

● "Show Thick Line" – the option increases the thickness of the all lines in the chart
both the cursor and signal lines.

Figure 4-33: Display of the tick lines

● "Show Data Point Marker" – shows individual data point markers in the chart.
(Applicable only to signals configured as a line type.)
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Figure 4-34: Data point marker display

● "Font Size" – font size of the text in the chart legend.

"Y Axis Controls"
● "Stack Y Axis" – if uncheck, only the axis values and title of the selected signal’s

axis group is displayed. If check, the axis values and all axis groups are displayed.

Figure 4-35: Stack Y-axis selection

● "Auto Zoom To Fit" – if checked, the y axis is automatically zoomed to the minimum
and maximum values for the current replay / measurement.

● "Use Decimal Separator" – axis values are displayed using a decimal separator.
● "Couple Y Axis" – if checked, R&S ROMES4 automatically groups the signals with

the same signal relationship ID or unit value on the same axis. If unchecked, all
signals are shown on a separator axis.

"X Axis Controls"
● "X Axis Type" – X-axis is displayed in the time values or distance values.
● "X Axis Span in Seconds" – span of the X-axis in seconds.
● "Couple Axis" – all charts share the X-axis if checked. All charts have the separate

X-axes if unchecked.
● "Track Axis" – during measurement or replay the X-axis of the chart is automati-

cally scrolled to the current location of the measurement/replay. If unchecked, the
X-axis is not scrolled unless done by the user.
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"Group Configuration"
● "Chart X" – this section is repeated for each configured chart group.
● "Show" – shows/hides the chart group.
● "Title" – configures a custom title for a chart group. Emptying the field removes the

custom title for the chart group.
● "Header Color" – selects a custom color for the chart group header.

Figure 4-36: Stack Y-axis chart with selected header color

4.2.1.5  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.2  ACD status view

The "ACD Status View" displays the current status of the ACD use cases for various
technologies, namely, for 5G NR, LTE, NB-IoT, LTE-M, UMTS , GSM, cdma2000,
TETRA and WiMAX.

The detected bands which overlap in terms of frequency range are included in the
view. If spectra overlap, they share the horizontal space of the display.
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The following figure shows bands sharing between technologies in the "ACD Status
View". The LTE Band 3 is shared between 2G and 4G, and the LTE Band 1 is shared
between 3G and 4G. The thin bars in the figure display the ACD status view of NB-IoT.

Figure 4-37: LTE bandwidths at band 3 overlap

Each band which has been selected for the ACD is represented by one horizontal line.
If the GSM network scanner is active, its ACD status is represented by the lines for
each scanned GSM band. If a GSM band is fully covered by any other technology ACD
band, for example, by an LTE band, the GSM band is merged into that band.

The view can also display the UL channels of the detected frequencies if they are
within the frequency range of any sweep.

If the band scanning is based on ACD monitoring use cases, the RF Power Scan spec-
trum is displayed as light gray background picture for that band (not applicable for 5G
NR scanning). The update rate of the spectrum is about 10 seconds. For the ACD,
refer to Chapter 3.8.2.1, "Technologies", on page 280 and Chapter 6.4.15.2, "Configu-
ration LTE scanner", on page 1728.

The frequencies which still have to be tested by the ACD are represented by small
green and yellow squares above the spectrum. A green square means that a fre-
quency is currently under the test, a yellow square that the frequency still has to be
tested.

By detecting the carrier, the corresponding part of the spectrum (frequency bandwidth)
is covered by a rectangle. The color of the rectangle represents the RAT of the detec-
ted carrier.

A dotted rectangle means that the actual bandwidth of the carrier is not detected yet.
The dotted rectangle appears when MIB of LTE channels MIB is still not decoded or
GSM frequency ranges are not detected.
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A spectrum display in the "ACD Status View" explodes to the normal size if a mouse
hovers over it, showing its details.

Figure 4-38: ACD details

The rectangle contains the following details:
● Radio Access Technology name (for example LTE and 5G NR)
● Center frequency/frequency range in GSM
● Channel number/channel number range in GSM
● Logo of provider if found in the database
● Name of provider followed by the MCC and MNC values

Included MCC and MNC allow a quick check the expected numeric values of both
parameters.

The last power of the carrier that was reported by the scanner to the ACD is represen-
ted by the lower more opaque part of the rectangle. If a detected carrier has not been
measured for one minute, it starts to get transparent. After two minutes, the transpar-
ency does not increase anymore. An asterisk is appended to the RAT name as long as
it has not been measured again by the corresponding scanner.

The "ACD Status View" of the 5G NR technology displays the content of demodulated
SIB1, which is a provider's name, MCC and MNC and carrier frequency. To pop up the
Tooltip which holds the mentioned SIB1 content, hover with mouse over the detected
spectrum. In case that the Initial Bandwidth Part (IBWP) is not identical with the carrier,
the IBWP is shown explicitly, see the following figure. If the 5G Demodulator v47.97 or
higher is used during recording, the view provides the 5G NR mode of operation per
provider. Displayed is in this case the superset of all possible modes of gNodeBs
demodulated for the particular provider.

Figure 4-39: 5G NR SIB1 content
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If the detected 5G NR SSB contains a SIB1 with the corresponding information, the
specific carriers bandwidth is shown around the SSB block. The bandwidth is taken
from the first demodulated NodeB which contains the information.

Figure 4-40: ACD status view of 5G NR

ACD status view export

The ACD status view supports export of the view's content to a file of CSV format. All
identified downlink spectra are exported.

To trigger the view export, click the "Export data as CSV" context menu entry.

4.2.2.1  Deactivating automatic channel detection

The ACD algorithm automatically adds detected channels to active scanners. You can
deactivate this behavior by unchecking the "Auto Start Scan" option in the ACD config-
uration page of each scanner.

If you uncheck the option, all detected channels are displayed gray in the "ACD View".

Figure 4-41: ACD view - UMTS channel detection deactivated

To enable the scan of a detected channel, click it and confirm your intention.
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Figure 4-42: Inquiry to start scanning UMTS channel

Once the scanner is started to measure, the corresponding rectangle gets colored.

Figure 4-43: ACD view - UMTS channel scan active

4.2.2.2  Special ACD case - GSM

As GSM is not a part of the ACD, the GSM frequency blocks have to be retrieved out
of the result for the scan of several GSM channels. This algorithm accounts all GSM
channels which have been scanned within the last two minutes. GSM frequency blocks
are always represented by a dotted rectangle, because there is not fixed bandwidth of
this block.

By default, only GSM BCCHs are accounted for the GSM frequency blocks. TCHs are
not represented in the graph unless SI Type 1 is decoded by the scanner. In that case
the channels of the CA list are counted analogue to the counting of BCCHs.

The GSM frequency blocks are calculated every 10 seconds and are based on the
measurements of the last minute.

The update is not synchronous to the "Transmitter Scan View".
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4.2.3  Alphanumeric view

The "Alphanumeric View" displays current values of the signals selected in the corre-
sponding configuration menu. The values are continuously updated while the measure-
ment or replay session is going on.

Example: Several devices

Figure 4-44: Alphanumeric View

In the "Alphanumeric View" signals from different measurement devices (e.g. from dif-
ferent GSM or CDMA devices) are displayed in different columns. If only mobile phone
parameters are viewed, a device name for each column is unambiguous and therefore
indicated in the table heading.

Device parameters from other technologies, e.g. from test receivers or GPS receivers,
are always displayed in the first column.

If the first column contains parameters from several devices, the table headings read
"Device [1]", "Device [2]" etc. The device for each parameter value can still be
obtained: It is indicated in a yellow popup window when the pointer is placed on the
parameter value.

After clicking a parameter (or selecting a group of parameters using the shift or control
keys), it is possible to change the order or remove the parameters from the view.

Note that the "Serving Cell" name can only be displayed if a correct BTS list is provi-
ded. In this case, also the distance to the BTS is displayed (example: BTS1 (2.6 km)).

The channel assignment option for 3GPP RATs (see Figure 3-225), visualizes the tech-
nologies' assigned channels (e.g. EARFCN or UARFCN) for the measured signals.
The following figure illustrates for LTE the channel assignment.
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Figure 4-45: Measured signals and assigned channel number

LTE scanner's narrowband (NB) and wideband (WB) measurement rate signals have
each their own configurable measurement rates. Based on that fact, the NB and WB
measurement rate signals are displayed separately in the "Alphanumeric View".

Figure 4-46: Separated NB and WB measurement rates

4.2.3.1  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.3.2  Alphanumeric view configuration

The "Alphanumeric View" window lets you select the signals to be displayed, set the
colors for the signals and the view's layout. The information on the current view's ver-
sion is also available.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

4.2.3.3  Values tab

Selects the signals to be displayed in a generic (basic) and some mobile views. The
connected devices can be indicated in the "Selected Signals [Maximum Allowed <vari-
able>]" list for some signals. The "Values" tab is analogous to the "Values" tab of the
"Alphanumeric View".

For further description of the tab, see Chapter 4.2.3.3, "Values tab", on page 468.

Figure 4-47: Alphanumeric View - Values tab

To add a signal in the "Alphanumeric View":

1. Click in the "Alphanumeric View" area to get the context menu. Select the "Configu-
ration" command.

The "Alphanumeric View" > "Configuration" window opens.

2. Select in the "Available Signals" list a signal for display in the view. Click ">".

The selected signal is shown in the "Selected Signals [Maximum Allowed 200]" list.
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3. Click "OK".

The selected signal is now present in the "Alphanumeric View" in the "Parameter"
column.

To display the optional signals in the list, activate them in the TEC window.
For example, the HPP / SPP, MIMO and the WB signals of LTE cells (of each possible
physical cell ID) are present in the view's list only if they are activated in "TEC for LTE
Scanner" > "Top N Pool Settings" > "Optional Top N Signals".

Configuration of a scanner Top N signals

Figure 4-48: Adding the signals for all Top N pools

The view's available Top N signals of the "TEC for <variable> Scanner" can be config-
ured in the "Top N Templates" branches of a technology scanner. The function lets you
configure signals as Top N template signals.

1. Select a signal in the "Top N Templates" branch and click ">" or double click the
selected signal.

The "Please Specify the Filter for the Signal" window pops-up.

2. Specify the filtering criteria for the (new) selection. There is the option to apply the
filtering criteria to all signals.

3.Click "OK"

The selected Top N signals are displayed now in the "Selected Signals [Maximum
Allowed 200]" pane.
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Figure 4-49: Result of the signals selection

Tree Filter
Makes it possible to search for a tree in the "Available Signals" list by entering just the
tree's name or a part of its name as a filter.

4.2.3.4  Alphanumeric view configuration: Settings tab

Click the tab to set the layout of the "Alphanumeric View".

Figure 4-50: Alphanumeric View - Settings tab

Color Scheme
Within the "Color Scheme" pane, you can select colors for the text and the back-
ground. A colored text or background makes it easier to distinguish when a signal
value changes.
The signals color settings are made in "Tools" > "Preferences" > "Available Signals",
see "Color Scale Configuration" on page 230.
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Select Font
Click the "Select Font" button to open a window which allows the font attributes to be
set for this view. The font attributes are: font, font style and font size.

4.2.4  Bar chart view

The R&S ROMES4 "Bar Chart View" is a basic view intended to present measurement
data in a flexible bar chart.

Figure 4-51: Measurement shown in Bar Chart View

The "Bar Chart View" provides a bar chart. Each bar represents one ROMES Signal
Set (RSS).

● ROMES signal set.................................................................................................471
● Information in the bar chart view...........................................................................473
● Bar chart view configuration..................................................................................477

4.2.4.1  ROMES signal set

The RSS is a set of one to n ROMES signals. It represents a set of individual signals.
One signal defines the bar height whereas the same or any other signal defines the bar
color. The RSS can be configured freely by using all available ROMES signals and
easily assigned to the "Bar Chart View".
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Each RSS is saved as an XML file and stored within the folder

My ROMES\Configuration\SignalSets
At least one signal must be marked to define the bar height and one signal must be
marked to define the bar color. One or more can be marked to provide long and / or
short information.
● Bar Height

One and only one signal can be used to define the height of the bar. This signal
has to be a numerical signal. Signal sets without a signal specified for bar height
are not valid and cannot be used. Therefore they are ignored.

● Bar Color
One and only one signal can define the color of the bar. In case the signal set does
not specify a signal for bar color the first signal in the sequence is used for color-
ing.

● Short Information
All signals can be used for generating the short information. For the short informa-
tion the current value of the signal is used. Short information is shown vertically
inside the bar. The user is responsible to select the best signals to get the short
info shown properly. Invalid values or missing values are shown with “-“.

Figure 4-52: RSS short information

● Long Information
All signals can be used for generating the long information. Long information is
shown as a ToolTip on the top of the related bar. The long information contains for
each signal the signal name, the current value and the signal unit.

RSS administration

The RSS administration dialog can be used to maintain the RSS. With this dialog the
RSS can be created, deleted, renamed or modified.

The following figure shows all available signal sets in the "Available Signal Sets" list.
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Figure 4-53: RSS administration

The RSS "RSS_0" is selected and its signals are listed within the "Signal Set Options
for RSS_0" list. For each signal there are some options which can be set or unset.
Only numeric signals can be used for bar height.

The RSS administration dialog can open from the bar chart configuration dialog with
the button "RSS Admin", see Figure 4-56.

4.2.4.2  Information in the bar chart view

The "Bar Chart View" is a basic view and can be instantiated many times.
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Figure 4-54: Chart bar view for RSS_0

The figure shows a bar chart view with six RSS configured. The RSS "RSS_0" is
selected and the y-axis shows the related signal information according to "RSS_0".
Each bar shows also some short information.

The bar width is calculated automatically and depends on the number of RSS assigned
to the bar chart view and the visual width of the "Bar Chat View" dialog. There is no
limitation how many RSS a bar chart view can show (it mainly depends on the usabil-
ity).

The x-axis shows all configured RSS and can be used to select an RSS. The y-axis is
always synchronized with the signal defined for the height of the selected RSS.

Bar chart views work only with the RSS. Thus, it is not possible to drop a signal to any
bar chart view. To define which RSS shall be visible within a bar chart view the related
configuration dialog must be used. Signal sets are part of the R&S ROMES configura-
tion and not stored within individual workspace. Only the information which RSS are
defined for a bar chart views is stored into the workspace.

Bar

A bar within the chart can be specified freely by the user. The configuration of a bar
consists of the RSS and a signal independent configuration set. The bar has the follow-
ing properties which can be used for visualization:
● Bar Height
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The height of the bar reflects the value of one of the signals of the RSS. At least
one signal of the RSS must be configured for height. If not, the first signal is used.

● Bar Color
The color of the bar reflects the value of one of the signals of the RSS. The color is
given by the color scale, which can be configured in the "Preferences" > "Available
Signals" dialog. At least one signal of the RSS must be configured for color. If not,
the first signal is used.

● Afterglow
Optionally, the chart keeps visible the last maximum value. Default setting is "Off".

● X-Axis Label
All RSS assigned to the bar chart view are shown on the x-axis. The currently
selected RSS is marked and the selection can be changed.

● Y-Axis
The y-axis of the bar chart view changes according to the currently selected RSS
(bar).

● Y-Axis Label
The y-axis label is the name of the currently selected RSS.

● v
The short information is a text which is displayed in the graph. This text should be
quite short to avoid overlapping with other element of the chart. It is the user's
responsibility to select a convenient set of signals. The value of the text is given by
one to n signals from the RSS.

● Long Information
The long information is a text which is displayed in the graph only as a ToolTip
(mouse-over) for a certain bar. The value of the text is given by 1 to n signals from
the RSS.
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Figure 4-55: ToolTip as a bar's long information

● Bar Chart View Toolbar
The "Bar Chat View" toolbar offers the following functions:
– Open bar chart view configuration, the  button
– Reset y-axis, the  button
– Choose Y-axis selection, the  button
– Zoom In, the  button
– Zoom Out, the  button
– Show or hide limit lines (two red horizontal lines), the  icon in the toolbar
– Print, the  icon in the toolbar

● Coupled Focus
The "Bar Chart View" is a passive coupled focus view. This means it will be
synchronized, if the coupled focus was initiated by clicking into another view. But
this view will not be able to initiate a coupled focus, as it only displays a snapshot.

● Printable
The view can be printed as a screenshot.

● Multi View
The view can be created several times.
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4.2.4.3  Bar chart view configuration

In the "Signal Sets" dialog it is possible to select signal sets you want to be shown on
the bar chart view.

Figure 4-56: Bar Chart View - configuration page

With ">" and "<" add and remove the signals from the view, respectively.

With "Up" and "Down" in "Selected Signal Sets / Bars" change the RSS sequence
shown in the bar chart view.

If you change some configuration parameters in the "Signal Sets" dialog and click
"OK", the all affected bar chart views are updated.

To maintain the RSS, open the "RSS Administration" dialog. In case of one or more
RSS have been changed, the all opened bar chart views are informed and updated.

4.2.5  Device grid view

The "Device Grid View" allows viewing any available signal during replay or measure-
ment with R&S ROMES4. You can create your own view similar to the already availa-
ble 3GPP Overview View.

R&S ROMES4 generic grid view abilities are:

● Ability to merge multiple cell to form a single larger cell.
● Ability to display in a cell a line chart of the last 30 seconds of the cells value.

The advantage of the Device Grid View is the extended flexibility in the view layout.
The content of the cells of Device Grid View can be defined independently. Each cell
can contain text, R&S ROMES4 signal values, names or sources. Values can be
visualized by numbers bars and/or colors.
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Define the view before the measurement starts. The view is not supposed to be recon-
figured dynamically like, for example, the Alphanumeric View.

The "Device Grid View" offers a grid for each device, but does not create tab for each
one.

The view offers additionally the capability to switch between grids depending on the
value of a certain R&S ROMES4 signal. This allows the user to create views, which
show different signal, depending, for example, on the RAT or the phone mode.

4.2.5.1  Starting device grid view

To access the "Device Grid View", select "View" > "Basic View" > "Device Grid View" in
the R&S ROMES4 tool bar.

Figure 4-57: Accessing Device Grid View

You can access the view also by right-mouse click the view area and choosing "Basic
View" > "Device Grid View".

Device grid view default

Figure 4-58: Default Device Grid View
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The default "Device Grid View" pane contains two groups, "Group Blue" and "Group
White" and a default static cell text ("Start Configuration via Context Menu"). The view
is configurable via context menu.

Device grid view configuration

Configuration of the "Device Grid View" can be done by launching the configuration
mode via the context menu.

Figure 4-59: Launch configuration mode

Click "Configuration" to place the "Device Grid View" in configuration mode. Configura-
tion is only available if there is no measurement in progress or opened measurement
file.

Figure 4-60: Device Grid View - configuration

Decision signal

The Device Grid View may be configured so that a different grid can be configured for
different response values of a given signal. For example, setting the decision signal to
RAT type allows the grid configuration for UMTS, GSM, CDMA, LTE, TETRA, EDVO,
WIFI, 5G and NB-IoT.
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The decision signal has to be a part of the Data Source signal set. All signals which
offer an enumerator/alias are allowed as decision signals.

The decision signal is configured via "Data Sources" of the configuration dialog.

Figure 4-61: Data source dialog

To start a decision signal that the view will use to switch grids, one must be selected.

To select the signal, click . This pops-up the dialog shown in the following figure,
which allows you to do the selection.

Figure 4-62: Dialog to select decision signal

First, select the type that the tabs in the view are based on. This fills the decision
combo box with only the signals available for that type. The available values are
"Mobile Devices" and "DQA".

Then choose the signal from the drop-down "Decision" box to switch on. Click "OK" to
save the selection.

Changing the decision signal erases any other currently configured grids.

The view now fills in the available responses for the chosen decision signal. Each time
a selection is made from this drop-down box, the grid for that response will be gener-
ated and presented for configuration.
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Figure 4-63: Configured mode

If a given response was not previously selected, a default grid is shown. It is not
required to configure a grid for all possible response values of the decision signal. A
default grid that will be presented during measurement or replay, when the decision
signal value is a value for which a grid has not been configured, may be chosen by
clicking the favorite icon .

For example, in the previous selection of "Mode" (RAT Type) only the response value
of LTE, GSM, UMTS may be configured.

The LTE response could then be marked as the default grid by clicking . This results
in the LTE grid being displayed when the "Mode" signal value is any value other than
LTE, GSM or UMTS. The view then displays the LTE grid when the "Mode" value was
"LTE", the GSM grid when the "Mode" value was "GSM" and the UMTS gird when the
"Mode" value was UMTS.

To enable easier configuration of the decision based grids there is also the ability to
save and reload an individual grid as a template.

To load an existing template use the "Decision Value Grid Template" section of the con-
figuration dialog. Click the load template button  or select one of the pre-loaded tem-
plates from the drop down list.

Figure 4-64: Selecting Device Grid View template

Choose "Open" from the template menu to prompt for a location of the template file to
be opened. The chosen template is then placed in the template list. In that way it may
be referenced later.

Opening a template erases any items currently configured in the grid for the currently
selected decision signal.

To reload a template, select it from the drop list of available temples or click the tem-
plate, open button and press "Reload". Pressing "Reload" does not prompt for a tem-
plate to reload. Instead, that reloads the currently selected template in the drop down
list. If a template is not currently selected, a prompt for the location of the template to
load will be generated.

To change the location of the template directory (where the template list is filled from),
click  and then click the "Change Template Director" item. This will prompt for a
location of the template directory.

Once a template file has been modified by changing any cell within the grid, the tem-
plate's name in the template list becomes blue in color.
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Figure 4-65: Template's color

To save a template, click the file save  button.

To save the file with the same name as the currently loaded template, click the left side
of the button.

Clicking the arrow to the right, pops-up a menu with the options "Save" and "Save As".
Click "Save" to save the template with the same name as the currently selected file.
Click "Save As" to prompt for a new location and a file's name to be saved as the tem-
plate. After the file is successfully saved, the template's name in the template list
becomes black in color to indicate that the template has no outstanding changes.

Signals

Signals may be added to the grid by dragging available signals from the R&S ROMES4
signal tree.

Figure 4-66: Selection of signal

A signal displayed on the grid is one of the following:
● Signal Value - Shows the current value of the signal during the measurement or

replay.
● Signal Name - Shows the name of the signal.
● Signal Source - Shows the name of the signal source (device name).

Dragging the signal onto the grid without holding additional keys adds the signal to the
grid by value. Holding down the CTRL key adds the signal as a signal name. Holding
the CTRL +SHIFT key while dragging adds the signal as a signal source.

While in the configuration mode, the signal name will be proceeded by a label that indi-
cates the current signal configuration.

The labels are:
● SV{x] - Signal value where x is the device id of the signal
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● SN{x] - Signal name where x is the device id of the signal
● SS{x] - Signal source where x is the device id of the signal

Exiting the configuration mode removes a label from the cell.

● Empty - Pops-up the dialog which lets you clear the selected signal.

Figure 4-67: Device instance - empty signal

● Text - Pops-up the dialog which lets you change the cell content.

Figure 4-68: Device instance -text

Multiple signals

A cell may contain multiple R&S ROMES4 signals by first configuring a cell as line, col-
umn, or range chart.

Multiple signals may be added to the cell by dragging and dropping the desired signals
from the "Signals Tree".

The signals can also be added by changing a cell type from Empty to Signal Value and
adding the signals from the cell configuration screen. The screen may be accessed for
a cell that has been previously configured as a line, column or range type by double
clicking that cell.
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Figure 4-69: Signal configuration

To add the signals on the screen, drag and drop the desired signals from the "Available
Signals" onto "Selected Signal" tree.

Instead, click ">" to add the signals into the "Selected Signals" pane.

The maximum number of signals that are allowed to be added is determined by the
configured cell type. For the Signal Value, Signal Name and Signal Source standard
cell type only one signal is allowed to be added. For Line and Column chart types a
maximum of 4 signals is allowed. For the Range chart type a maximum of 8 signals is
allowed. You may see the maximum allowed signals for the selected chart type by
looking at the "Selected Signals [Maximum Allowed n]" text label.

Once the signals are added to the selected signals pane, the order of the signals my
be changed by selecting a signal and clicking the "Up" or "Down" button to move the
signal up or down in the signal order.

To remove one or several signals from the cell, select the signals in the selected sig-
nals pane and click the "<" button. To remove all currently selected signals from the
cell, click "<<".

If a cell contains multiple signals and the cell type is changed to a type that allows for
fewer signals, the signals over the maximum number of signals for the newly config-
ured cell type will be automatically removed.

Cell attributes - display and type

A type of configured signal may be also changed via the configuration dialog in the
"Cell Attributes" section, by changing the cell type to the desired value.
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Figure 4-70: Configured cell attribute

Signal Value may have the following attributes:
● Bar - Shows the signal value as bar graph.
● Color - Shows the signal with the configured color for the signal.

The color of the signal may be configured by right clicking the view and choosing
"Configure Signals". This must be done when no measurement file is currently
loading

● Trend - Shows a trending value (up or down) of the signal during the measurement
or replay.

● Title - May have this additional attribute. If not in configuration mode, the signal
name and signal source have a blue background.

● Legend - For a cell configured with the "Line", "Range" or "Column" chart option,
display the legend in the chart of the cell.

● Standard - Cell configured to display the value of a single signal with optionally a
"Bar", "Color" or "Trend" attribute

● Line - Tracks the signal values of a range of 30 seconds of the replay or measure-
ment, see Chapter 4.2.5.1, "Starting device grid view", on page 478.

● Column - Signals in the cell configured to be displayed in a column type chart, see
Chapter 4.2.5.1, "Starting device grid view", on page 478.

● Range - Signals in the cell configured to be displayed in a range type chart, see
Chapter 4.2.5.1, "Starting device grid view", on page 478.

All mentioned attributes may be modified for the selected cell(s) in "Display", the cell
attributes section display list.
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Figure 4-71: Display list

Only the attributes that apply to the currently selected cell type are active and allow to
be chosen.
Table 4-2: Relationship Cell type - Available attributes

Cell type Available attributes

Signal value Bar/Color/Trend/Legend/Standard/Line/column/Range

Signal name Title

Signal source Title

Text Title

Figure 4-72: An illustration of the relationship

The device id of the signal may also be modified from the dialog screen by use the
Device Instance entry field.

The device id specifies from which device the value shall be displayed. The id of the
first device of a certain type is 0, of the second 1 and so on. For example, if you have
connected two test UEs and you want to show the RSSI of both, you have to add the
RSSI signal to two cells and specify the device id of one cell to 0 and of the other to 1.

It is recommended to add the signal source cells to grid to be able to clearly identify the
source of each signal.

The view displays signal values for the signal on the device that corresponds to the
device id for the active measurement or replay.

Line charts

A cell configured with the line chart attribute displays the configured signals in a line
graph type of chart. This line chart will track the signal values of a range of 30 seconds
of the replay or measurement.
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Figure 4-73: Line chart

The displayed black line represents the current time of the replay or measurement. For
replay with a file scanning, the graph shows a range of ±15 seconds from the current
time of the replay. This range may be changed by changing the settings of trading sec-
onds in the "Globals" > "Trending (s)" filed on the configuration screen.

Figure 4-74: Globals

If "Globals" > "Grid Adaptive" is checked, the grid automatically adjusts the size of col-
umns and rows to fill all available space within the view.

For measurements and replays without file scanning, the graph by default shows a
range of -27 seconds to + 3 seconds. This range can be changed by changing the
trending seconds setting on the configuration screen. The low end of the range is –
90% of the configured value and the high end is 10% of the configured value.

Figure 4-75: Changed trading seconds

If all selected signals are of the same type, only one Y axis is configured for the chart.

Figure 4-76: One y-axes in line chart

If more than one type of signal is configured, each signal has its’ own axis label on the
chart.
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Figure 4-77: Four Y-axes for four signals in line chart

The display of the chart legend is optional and may be hidden by deselecting the "Leg-
end" attribute from the "Cell Attributes" > "Display/Type" list on the configuration
screen.

Figure 4-78: Deselected legend in line chart

Figure 4-79: Line chart w/o legend

Column chart

A cell configured with the "Column" attribute displays the current value of the config-
ured signals in a column type of chart.

Figure 4-80: Column chart

If all selected signals are of the same type, only one Y axis is configured for the chart.
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Figure 4-81: One y-axes in column chart

If more than one type of signal is configured, each signal has its’ own axis label on the
chart.

Figure 4-82: Four y-axes for four signals in column chart

The display of the chart's legend is optional and may hidden by deselecting the "Leg-
end" attribute.

Figure 4-83: Deselected legend in column chart

Figure 4-84: Column chart w/o legend

Range chart

A cell configured with the "Range" chart attribute displays the configured signals in a
range graph type of chart.

This type of chart tracks a signal's state changes. The bar shows encompassing the
time of signal changed to that state till the time the signal changed to a different state.
The range chart tracks the signal values of a range of 30 seconds of the replay or mea-
surement.
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Figure 4-85: Range chart

The displayed black line represents the current time of the replay or measurement.

For replay with file scanning, the graph shows a range of ±15 seconds from the current
time of the replay.

This range may be changed by changing the settings of trading seconds in the "Trend-
ing (s)" filed on the configuration screen.

For measurements and replays without file scanning, the graph by default shows a
range of -27 seconds to + 3 seconds. This range can be changed by changing the
trending seconds setting on the configuration screen. The low end of the range is –
90% of the configured value and the high end is 10% of the configured value.

Chart error conditions

To correctly draw the column, line, or range chart, the view requires a minimum amount
of space. A single cell is typically not sufficient to allow this. The minimum merge range
of cell is 5x2 to allow for a type chart to drawn.

If you attempt to change a cell that has a merge range of less than 5x2 to a line in the
column or range chart, the following error message is presented

Figure 4-86: Reported errored conditions

There are also occasions where a chart that is set to the minimum of 5x2 cell can still
not be shown. These occasions are based on other configuration factors such as the
length of the signal names and presence of a legend. In this condition, once the view is
taken out of configuration mode the cell will show a "Chart N/A" message in place of
the chart and the cell background will be changed to red.
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Figure 4-87: Chart not available

Text labels

A static text label may be placed on the grid by double-clicking the desired cell and
then entering the desired label. The same can be achieved if you select the desired
cell and click the edit cell text button .

Figure 4-88: Updating cell

The static text may have the following optional configuration value.

● Title – Shows the static text with a blue background if not in configuration mode.

Figure 4-89: Static label

The Title attribute may also be applied for the currently selected cell(s) via the "Cell
Attributes" section of the configuration dialog.

Figure 4-90: Text attribute - title
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While in configuration mode, a static cell text is appended with a Text [x] marker where
x is the optional title configuration. For example, the upper label has the notation
Text[T]: Static Label.

Group

The signals of the grid may be set for easier viewing and classification into groups in
the grid. Additional groups may be added by clicking one of the existing groups and
clicking the add group button  on the configuration dialog. In this way you add a new
group after the highlighted group.

Figure 4-91: Adding group

Holding the CTRL key while clicking the  button provides a new group label before
the selected group.

To edit the name of an existing group, click the desired group and press the  button.

To delete a group, select the desired group and click the remove group button . The
group is removed.

Figure 4-92: Selecting group for removing

Deleting a group deletes all rows and columns within that group.

Adding/removing or deleting rows and columns

Under "Edit" there are the control buttons allowing to add additional rows and columns
to the grid. For this, selecting an existing row or column on the grid and click the  or

 button, respectively, on the configuration dialog.

By default, the new row or column will be added after the selected row or column. To
add a row or column before the selected row or column hold the CTRL key down while
clicking the add row or column button.
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Multiple rows or columns may be added by selecting the desired number of rows or
columns and clicking add row or column. For example, if you wish to add 5 columns to
the grid, select five cells and click .

To remove a row or column click the row or column to be deleted and then click the
remove row  or remove column  button.

Additional controls in edit

Under "Edit" there are also the control buttons allowing the following tasks:

● Merging and de-merging of selected cells via available icons  and .
● Selection of a signal cell as a line chart
● Controls that determine the amount of time displayed in the line chart and if the y-

axis of the line chart is adaptive.

Merging cells together

The "Device Grid View" allows multiple cells to be merged together to form a single
larger cell.

To merge the cells together highlight the cells that are to be merged together

1. Highlight the cells that are to be merged together.

Figure 4-93: Cells selected for merging

2. Click the merge cell button.

The cells are merged together.

Figure 4-94: Merged cell

The merged cell is interactive as any other cell in the grid,

Signals can be drop into the cell.
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Figure 4-95: Dropped signal into the merged cell

You can type a static text in the merged cell.

Figure 4-96: Added text in the merged cell

Demerging of merged cells

Once a group of cells has been merged together the group may be demerged.

Selecting the merged cell you want to demerge and click the unmerge cell button .
Demerging the cell results in the content of the merged cell be placed in the upper left
most cell of the merged cell range.

Figure 4-97: Placement of demerged cells

Moving cells within the grid

Existing cells may be moved within the grid by dragging and dropping the cell to a new
location.

The cells may also be moved via copy and paste.

To copy a cell, select the desired cell(s) and the click the copy  button. The same is
performed if you press the CTRL + C keyboard combination.
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To paste the cell then into a new cell location, click the desired new cell(s) location and
press the paste  button. The same is performed if you press the CTRL + V keyboard
combination.

If the currently selected cell contains existing content, R&S ROMES4 prompts for con-
firmation to overwrite the existing content.

Figure 4-98: Warning message

The existing content may be moved to a new cell. To do that, cut the cell (this removes
the content from the existing cell) and then paste the content into a new cell.

To cut an existing cell, click the desired cell(s) and then click the cut  button or press
the CTRL + X keyboard combination.

Templates

Once a grid has been configured, it may be saved as a template for later reloading,
modifying or reusing purpose.

Loading an existing template may be done from the template section of the configura-
tion dialog. To load a template, click the load template  button or select one of the
preloaded templates from the drop down list.

Figure 4-99: Selection of preloaded template

Choosing "Open" from the template's open menu prompts for a location of the template
file to open. The chosen template is then placed in the template's list. In that way it
may be referenced later.

Opening a template erases any items currently configured in the Device Grid View.

To reload a template, select it from the drop list of available temples or click the tem-
plate, open button and press "Reload". Pressing "Reload" does not prompt for a tem-
plate to reload. Instead, that reloads the currently selected template in the drop down
list. If a template is not currently selected, a prompt for the location of the template to
load will be generated.

To change the location of the template directory (where the template list is filled from),
click  and then click the "Change Template Director" item. This will prompt for a
location of the template directory.
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Once a template file has been modified by changing any cell within the grid, the tem-
plate's name in the template list becomes blue in color.

Figure 4-100: Template's color

To save a template, click the file save  button.

To save the file with the same name as the currently loaded template, click the left side
of the button.

Clicking the arrow to the right, pops-up a menu with the options "Save" and "Save As".
Click "Save" to save the template with the same name as the currently selected file.
Click "Save As" to prompt for a new location and a file's name to be saved as the tem-
plate. After the file is successfully saved, the template's name in the template list
becomes black in color to indicate that the template has no outstanding changes.

Figure 4-101: No outstanding changes

Exiting configuration mode

To exit the configuration mode of the Grid View:
● Click check button to keep any configuration changes.
● Click "x" button to avoid any current configuration changes.

Figure 4-102: Two ways to exit

Clicking "OK" will not save the changes made to the current workspace until the cur-
rent workspace has been saved.

Device grid view measurement or replay

During measurement or replay the following items may be displayed by the Device
Grid View:
● Decision Signal Value Switching – If the Device Grid View has been configured

with a decision signal and the value of that signal changes during measurement or
replay the grid for that value will be loaded and presented. If no grid has been con-
figured for the current response value then the grid configured as the default grid
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will be shown until the decision signal again change to a value that has a grid con-
figured.

● Static text - Configured static text items are displayed as entered during configura-
tion. If the text item is configured with a "Title" attribute, the cell is displayed with
blue back ground.

The values in the static text cell remain the same throughout the measurement or
replay.

● Signal value – Items configured as signal value type display the current value for
the selected device id filter of the signal. If the signal does not have a value, "-" is
displayed. Any coupled focus changes made to the replay will be observed by the
Grid View and the displayed values updated to the correct time in the measure-
ment or replay.

Figure 4-103: Signal value - PCI value

– If the cell is configured with the "Bar" attribute, the cell displays the values as a
bar graph.

– If the cell is configured with the "Trend" attribute, the cell displays an up arrow
graphic  if the value is tending up, displays a down arrow  if
the value is tending down and a side ways arrow.  if the value is
tending steady.

– If the cell is configured with a "Color" attribute, the cell displays the configured
color for the signal.

● Signal source – Items configured as signal source display the device source of the
configured signal.

● Signal name – Items configured as signal name display the name of the configured
signal in the cell. If the cell has the "Title" attribute applied, the cell appears with a
blue background.

● Groups name – Group name remains static thoughout the replay or measurement.
Nevertheless, the group sections may be minimized by double clicking the group
label or by clicking the group minimize button.
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4.2.5.2  Custom views

The Device Grid View is added as a template option in the custom views configuration.

The Device Grid View is set as a custom view via "View" > "Custom View" > "Create
New" command.

Choose the "Device Grid View" in the "Select a Template" drop-down box of the "Cre-
ate Custom View" > "Properties" pane.

Figure 4-104: Device Grid View selected as template

One the view is created as the custom view, the configurations described in previous
sections can be configured.

4.2.6  Event view

The "Event View" displays a chronological record of all events that occurred during the
measurement. What represents an event is defined in the "Available Events" tab of the
"Preferences" menu, see Figure 3-123. It is possible to combine expression with the
pipe "|" to get all lines which fulfill at least one of the given conditions.

The "Event View" has a grid layout. The view offers filter possibilities. The grid cells
information text can be marked and highlighted with colors. For the extended grid view
handling, see Chapter 4.1.8, "Extended grid view", on page 432.

Basic views



Display and evaluation of resultsDrive Test Software

499Operating Manual 1171.6415.12 ─ 66

Figure 4-105: Events view

The notification center can write *.json log files for R&S ROMES4 events.

It is composed as follows (the json extension is not shown).

Year-Month-Day-Hour-Minute-Second-Milliseconds[Number]_EventName
For example, 2021-12-29-09-38-52-307[0]_Threshold Passed Up.json.

"Milliseconds" and "Number" are necessary to be able to write several *.json files for
the same event which occurs at the same point in time.

4.2.6.1  View table

The events are displayed in tabular form:

● "Symbol"
The symbol indicates detected event.

● "Time"
Time of the event, the scale is relative to the start time of the measurement.

● "Distance"
The traveled distance between the shown events.

● "Device"
Device (mobile phone type, fax terminal, test receiver etc.) that triggered the event.

● "Event"
Short notes concerning events.
The notes can be entered by pressing the CTRL+F12 keys during measurement,
for example to record a note about an observation. The note cannot be longer than
500 characters. As the result, the comment event text is shown as an entry in this
column.
During replay, the "Edit Comment Event Text" entry of the context-sensitive config-
uration menu allows the field of an event to open and edit.
Select the event in the "Event" column, click the right mouse button to get configu-
ration menu and choose the mentioned entry. Opens the editor. Press the "OK"
button to update the comment editor after editing the text.
The text is also patched into the measurement file for later processing, for example
for ASCII export.
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Figure 4-106: Text field of the comment editor

● Information
Additional event information, e.g. the entered event comment.

4.2.6.2  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.6.3  Event view configuration

You can select in the "Event View > Event View Configuration" dialog devices whose
configured events you want to be displayed.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Figure 4-107: Event View - device filter selection

Event view information

The "Info" tab lets user see the current view version.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.2.7  General status view

The "General Status View" displays text messages of general interest, for example, the
application events reported during the measurement.

The NQA messages are displayed in the view if, for example, the "NQA" > "NQA moni-
toring active" option of a device configuration is activated.
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Figure 4-108: General Status View

The view is divided into two parts. The upper part, "Event List", shows the list of events
with the associated data. The existing event line is marked with a simplified icon "X".
The lower "Driver Status List" part shows the amount of produced data per device. If a
device does not produce any data, the corresponding line is marked red. However, no
data generated is just an indication for a possible problem (e.g., the Indoor device does
not generate data, unless you reach a new waypoint).

During measurements, the amount of generated data per device is logged. Every 10
seconds the average amount of data is calculated and stored to the measurement file.
The amount of data is displayed for each device in the "General Status View" > "Driver
Status List".

The alerts about low data rate from devices which occur during a measurement are
visible in the "General Status View" during the measurement file replay. The visualiza-
tion is supported since R&S ROMES4.92.

The view shows events during recording and "Replay Only", but not during a measure-
ment. If the measurement runs without problems, no messages appear for an exten-
ded period.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.7.1  General status view configuration

The "General Status View" configuration activates the remote display and shows infor-
mation on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The remote display R&S TS95-RD makes it easier to monitor the process of data
recording. It is connected to the measurement system via a printer connector. During
the measurement tour, the LEDs of the remote display inform whether the measure-
ment yields valid data, a warning, or an error.

Figure 4-109: General Status View - configuration

Error Visualization
For each detected error, an error message can be displayed in a pop-up window that
remains on screen or is automatically closed after a definite time (option "Hide the
Popup" checked). The display time of the pop-up is set in the "after...seconds" field.

Error Sound
For each detected error, an error sound is played if the "Play File" box is checked.
A wave file (*.wav) can be selected by the "..." button if the "Continuously Playing"
option is checked. The sound is continuously repeated.
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4.2.8  Grid view

The "Grid View" allows viewing any available signal during replay or measurement with
R&S ROMES4. You can create your own view similar to the already available "3GPP
Overview View".

R&S ROMES4 generic grid view abilities are:

● Ability to merge multiple cell to form a single larger cell.
● Ability to display in a cell a line chart of the last 30 seconds of the cells value.

The advantage of the "Grid View" is the extended flexibility in the view layout. The cells
content of the "Grid View" can be defined independently. Each cell can contain text,
R&S ROMES4 signal values, names or sources. Values can be visualized by numbers
bars and/or colors.

Define the view before the measurement starts. The view is not supposed to be recon-
figured dynamically like, for example, the "Alphanumeric View".

The "Grid View" offers a tab for each device, but one grid for all devices.

To access the view, select "View" > "Basic View" > "Grid View" in the R&S ROMES4
tool bar.

You can access the view also by right-mouse click the view area and choosing "Basic
View" > "Grid View".

Figure 4-110: Default Grid View

The default "Grid View" contains two groups, "Group Blue" and "Group White", and a
default static cell text ("Start Configuration via Context Menu"). the view is configurable
via context menu.

4.2.8.1  Grid view configuration

Configuration of the Grid View can be done by launching configuration mode via the
context menu.
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Figure 4-111: Launching configuration mode

Select "Configuration" to place "Grid View" in configuration mode. Configuration is only
available if there is no measurement in progress or opened measurement file.

Figure 4-112: Configuration mode - details

Signals

Signals may be added to the grid by dragging available signals from the R&S ROMES4
signal tree.
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Figure 4-113: Selection of signals

A signal may be displayed on the grid in one of three ways:
● Signal Value - Shows the current value of the signal during the measurement or

replay.
● Signal Name - Shows the name of the signal.
● Signal Source - Show the name of the signal source (device name).

Dragging the signal onto the grid without holding additional keys adds the signal to the
grid by value.

Holding down the CTRL key adds the signal as a signal name and holding the CTRL
+SHIFT key while dragging adds the signal as a signal source.

While in the configuration mode, the signal name will be proceeded by a label that indi-
cates the current signal configuration.

The labels are:
● SV{x] - Signal value where x is the device id of the signal
● SN{x] - Signal name where x is the device id of the signal
● SS{x] - Signal source where x is the device id of the signal

Exiting the configuration mode removes a label from the cell.

● Empty - Pops-up the dialog which lets you clear the selected signal.

Figure 4-114: Device instance - empty signal

● Text - Pops-up the dialog which lets you change the cell content.
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Figure 4-115: Device instance -text

Multiple signals

For details, see "Multiple signals" on page 483.

Cell attributes - display and type

A type of configured signal may be also changed via the configuration dialog in the
"Cell Attributes" section, by changing the cell type to the desired value.

Figure 4-116: Configured cell attribute

Signal Values may also have the following additional attributes:
● Bar - Show the signal value as bar graph.
● Color - Show the signal with the configured color for the signal.

The color of the signal may be configured by right clicking the view and choosing
"Configure Signals". This must be done when no measurement file is currently
loading

● Trend - Shows a trending value (up or down) of the signal during the measurement
or replay or .

● Title - May have this additional attribute. If not in configuration mode, the signal
name and signal source have a blue background.
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● Legend - For a cell configured with the "Line" or "Column" chart option, display the
legend in the chart of the cell.

● Standard - Cell configured to display the value of a single signal with optionally a
"Bar", "Color" or "Trend" attribute.

● Line - Tracks the signal values of a range of 30 seconds of the replay or measure-
ment.

● Column - Signals in the cell configured to be displayed in a column type chart.
● Range - Signals in the cell configured to be displayed in a range type chart, see

Chapter 4.2.5.1, "Starting device grid view", on page 478.

All mentioned additional attributes may be modified for the selected cell(s) in the cell
attributes section display list.

Only the attributes that apply to the currently selected cell type are active and allow to
be chosen.
Table 4-3: Relationship Cell type - Available attributes

Cell type Available attributes

Signal value Bar/Color/Trend/Legend/Standard/Line/column/Range

Signal name Title

Signal source Title

Text Title

Figure 4-117: An illustration of the relationship

The device id of the signal may also be modified from the dialog screen by use the
Device Instance entry field.
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The device id specifies from which device the value shall be displayed. The id of the
first device of a certain type is 0, of the second device is 1 and so on. For example, if
you have connected two test UEs and you want to show the RSSI of both, you have to
add the RSSI signal to two cells and specify the device id of one cell to 0 and of the
other to 1.

It is recommended to add the signal source cells to grid to be able to clearly identify the
source of each signal.

The view displays signal values for the signal on the device that corresponds to the
device id for the active measurement or replay.

Line chart

Refer to Chapter 4.2.5.1, "Starting device grid view", on page 478.

Column chart

Refer to Chapter 4.2.5.1, "Starting device grid view", on page 478.

Range chart

Refer to Chapter 4.2.5.1, "Starting device grid view", on page 478.

Chart error

Refer to "Chart error conditions" on page 490.

Text labels

A static text label may be placed on the grid by double-clicking the desired cell and
then entering the desired label. The same can be achieved if you select the desired
cell and click the edit cell text button .

Figure 4-118: Updating cell

The static text may have the following optional configuration value.

● Title – Shows the static text with a blue background if not in configuration mode.

Figure 4-119: Static label
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The Title attribute may also be applied for the currently selected cell(s) via the "Cell
Attributes" section of the configuration dialog.

Figure 4-120: Text attribute - title

While in configuration mode, a static cell text is appended with a Text [x] marker where
x is the optional title configuration. For example, the upper label has the notation
Text[T]: Static Label.

Group

The signals of the grid may be set for easier viewing and classification into groups in
the grid. Additional groups may be added by clicking one of the existing groups and
clicking the add group button  on the configuration dialog. In this way you add a new
group after the highlighted group.

Figure 4-121: Adding group

Holding the CTRL key while clicking the  button provides a new group label before
the selected group.

To edit the name of an existing group, click the desired group and press the  button.

To delete a group, select the desired group and click the remove group button . The
group is removed.

Figure 4-122: Selecting group for removing
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Deleting a group deletes all rows and columns within that group.

Adding/removing or deleting rows and columns

Under "Edit" there are control buttons allowing to add additional rows and columns to
the grid. For this, selecting an existing row or column on the grid and click the  or 
button, respectively, on the configuration dialog.

By default, the new row or column will be added after the selected row or column. To
add a row or column before the selected row or column hold the CTRL key down while
clicking the add row or column button.

Multiple rows or columns may be added by selecting the desired number of rows or
columns and clicking add row or column. For example, if you wish to add 5 columns to
the grid, select five cells and click .

To remove a row or column click the row or column to be deleted and then click the
remove row  or remove column  button.

Additional controls in edit

Under "Edit" there are also the control buttons allowing the following tasks:

● Merging and de-merging of cells via available icons  and .
● Selection of a signal cell as a line chart
● Controls that determine the amount of time displayed in the line chart and if the y-

axis of the line chart is adaptive.

For the merging/demerging of the cells details, see Chapter 4.2.5.1, "Starting device
grid view", on page 478

Moving cells within the grid

Existing cells may be moved within the grid by dragging and dropping the cell to a new
location.

The cells may also be moved via copy and paste.

To copy a cell, select the desired cell(s) and the click the copy  button. The same is
performed if you press the CTRL + C keyboard combination.

To paste the cell then into a new cell location, click the desired new cell(s) location and
press the paste  button. The same is performed if you press the CTRL + V keyboard
combination.

If the currently selected cell contains existing content, R&S ROMES4 prompts for con-
firmation to overwrite the existing content.
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Figure 4-123: Warning message

The existing content may be moved to a new cell. To do that, cut the cell (this removes
the content from the existing cell) and then paste the content into a new cell.

To cut an existing cell, click the desired cell(s) and then click the cut  button or press
the CTRL + X keyboard combination.

Templates

Once a grid has been configured, it may be saved as a template for later reloading,
modifying or reusing purpose.

Loading an existing template may be done from the template section of the configura-
tion dialog. To load a template, click the load template  button or select one of the
preloaded templates from the drop down list.

Figure 4-124: Selection of preloaded template

Choosing "Open" from the template's open menu prompts for a location of the template
file to open. The chosen template is then placed in the template's list. In that way it
may be referenced later.

Opening a template erases any items currently configured in the "Grid View".

To reload a template, select it from the drop list of available temples or click the tem-
plate, open button and press "Reload". Pressing "Reload" does not prompt for a tem-
plate to reload. Instead, that reloads the currently selected template in the drop down
list. If a template is not currently selected, a prompt for the location of the template to
load will be generated.

To change the location of the template directory (where the template list is filled from),
click  and then click the "Change Template Director" item. This will prompt for a
location of the template directory.

Once a template file has been modified by changing any cell within the grid, the tem-
plate's name in the template list becomes blue in color.
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Figure 4-125: Template's color

To save a template, click the file save  button.

To save the file with the same name as the currently loaded template, click the left side
of the button.

Clicking the arrow to the right, pops-up a menu with the options "Save" and "Save As".
Click "Save" to save the template with the same name as the currently selected file.
Click "Save As" to prompt for a new location and a file's name to be saved as the tem-
plate. After the file is successfully saved, the template's name in the template list
becomes black in color to indicate that the template has no outstanding changes.

Figure 4-126: No outstanding changes

Exiting configuration mode

To exit the configuration mode of the Grid View:
● Click "OK" to keep any configuration changes.
● Click "Cancel" to avoid any current configuration changes.

Figure 4-127: Two ways to exit

Clicking "OK" will not save the changes made to the current workspace until the cur-
rent workspace has been saved.

4.2.8.2  Grid view during measurement and replay

During measurement or replay the following items may be displayed by the Grid View:
● Static text – Configured static text items are displayed as entered during configura-

tion. If the text item is configured with a "Title" attribute, the cell is displayed with
blue back ground.

The values in the static text cell remain the same thoughout the measurement or
replay.
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● Signal value – Items configured as signal value type display the current value for
the selected device id filter of the signal. If the signal does not have a value, "-" is
displayed. Any coupled focus changes made to the replay will be observed by the
Grid View and the displayed values updated to the correct time in the measure-
ment or replay.

Figure 4-128: Signal value - PCI value

– If the cell is configured with the "Bar" attribute, the cell displays the values as a
bar graph.

– If the cell is configured with the "Trend" attribute, the cell displays an up arrow
graphic  if the value is tending up, displays a down arrow  if
the value is tending down and a side ways arrow  if the value is
tending steady.

– If the cell is configured with a "Color" attribute, the cell displays the configured
color for the signal.

● Signal source – Items configured as signal source display the device source of the
configured signal.

● Signal name – Items configured as signal name display the name of the configured
signal in the cell. If the cell has the "Title" attribute applied, the cell appears with a
blue background.

● Groups name – Group name remains static thoughout the replay or measurement.
Nevertheless, the group sections may be minimized by double clicking the group
label or by clicking the group minimize button.

4.2.8.3  Custom views

The Grid View is added as a template option in the custom views configuration.

The Grid View is set as a custom view via "View" > "Custom View" > "Create New"
command.

Choose the "Grid View" in the "Select a Template" drop-down box of the "Create Cus-
tom View" > "Properties" pane.
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Figure 4-129: Grid View selected as template

One the view is created as the custom view, the configurations described in previous
sections can be configured.

Custom views are persistent on the current system. This means, the new custom view
will behave as any other view and will be available whenever R&S ROMES4 starts.

If the workspace contains a Custom View which is not available at the system, the cus-
tom view is created temporarily. In this case, it disappears once R&S ROMES4 is
restarted.

4.2.9  Message view

The "Message View" displays a detailed chronological record of certain system mes-
sages generated during measurement or file export.

The displayed time format for the messages is always HH:MM:SS, irrespective of the
time format settings elsewhere in R&S ROMES4.

Figure 4-130: Message View
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Not all messages displayed during recording are stored in the measurement file. For
this reason, some messages are not displayed when replaying the file later.

Message Description

C:\RuS\ROMES\D1026T17.58 cre-
ated

A new Transmitter Scan file with the given name was created.

BTS appended A BTS was appended successfully to the database. This message
occurs only when the BTS was appended via the BTS edit func-
tion.

BTS deleted Indicates that a BTS was deleted successfully from the database.

BTS time offset evaluation started Starts the update of the database.

Database updated This message shows the update of the database, which usually
occurs every two minutes.

Frequency correction = ... Hz The result of this frequency correction.

Frequency correction stopped The frequency correction is calculated with help of at least 4 sec-
tors. If fewer than 4 sectors are available, the frequency correction
could not be performed and this message appears.

Just ... MB memory left To be able to run the software, there must be at least 80 MByte of
free disk space available. If this message occurs, check your free
disk space and verify that the disk is not fragmented.

Sector skipped: (Reason) After reading a sector from the base station text file, the program
checks, whether all entries have consistent values. E.g., if there is
a sector in the GSM band with channel 1283, the sector is not
taken into the database.

Skip sector During reading a base station text file, a sector did not have all
mandatory entries. The corresponding sector is skipped and the
program continues with reading the next sector.

System nonlinear to network One or more BTSs have a drift beyond the allowed range. In this
case, a new Transmitter Scan file is created.

Transmitter Scan Overlap: m Sectors,
n Identified Sectors

When a new Transmitter Scan file is opened, m recently measured
BTS are also taken in the new file to avoid a loss of overlap. On
"n" of these sectors, the Cl could be identified.

TS File ... added to database Every Transmitter Scan file which is manually added to the data-
base is shown.

The Message View has no configuration menu.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.2.9.1  View contents

The messages are displayed in consecutive lines together with the time when they
were recorded. In general, all messages are self-explanatory.
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Clicking the icon in the lower left corner of the view deletes all messages in the view
and clears a space for new messages.

4.2.9.2  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "Message View" has no configuration menu.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.2.10  Resource usage view

The "Resource Usage View" shows the resource usages that are reported by Phylis
kernels. The purpose of the view and the associated signals is to show the resource
utilization for modules.

The resource usage information includes:

● Time since measurement starts
● Time modules spend on kernel and/or user mode
● IQ-related time and counts
● Usage information in recent seconds (1, 5, or 15 seconds)

The listed resource usage information, that is, the available usage times and counters
signals are counted from measurement statistics.

Resource usage signals as information on usage are available under the "Signal Tree"
> "System Info" > "Resource Usage Template" branch. Signals can be drag and drop
from there to a basic view, for example, Alphanumeric View or 2D Chart View as
shown in the screenshot.
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Figure 4-131: Resource usage signals in Alphanumeric view

To get info on a resource usage signal hover with mouse over the signal. A ToolTip
shows the signal description and unit or refer to "Description of R&S ROMES4 Signals"
document.

4.2.10.1  Resource usage monitor service

The following definitions apply when considering this basic view type:

1. Resource Usage Monitor Service is an internal service that sends queries to all
active kernel processes for the resource usage information about every 10 seconds.
The usage information is compiled and inserted into frames and distributed. It starts
when R&S ROMES4 starts (different from the "Resource Usage View" that is not
launched until user starts it).

- It does not start collecting data until measurement starts.

- It stops collecting data when measurement stops.

- Resource Usage Data Provider retrieves the usage information to be used by views
and template signals.

- Resource Usage View shows the collected information.

- Resource Usage Template Signals can be dragged and dropped into basic views for
display.

The System Info SW device is added automatically whenever user adds any scanner.
The screenshot shows that both LTE scanner and System Information are added to the
"Loaded Devices" list.

Basic views



Display and evaluation of resultsDrive Test Software

519Operating Manual 1171.6415.12 ─ 66

Figure 4-132: System Info automatically added with a scanner addition

4.2.10.2  Resource usage view launching

To launch the "Resource Usage View", select "View" > "Basic Views" > "Resource
Usage View".

You can launch the view also when selecting the "Basic Views" > "Resource Usage
View" from the menu which pops-up if right-mouse button click anywhere an empty
view area.

The view is a lazy view, meaning that it is not launched when R&S ROMES4 starts.

4.2.10.3  Details of resource usage view

Collected times and counters are module-based.

There are two types of resource usage values:
● Initial Resource Values - the first collected times and counters
● Current Resource Values - any later collected times and counters

The "Resource Usage View" shows the differences between the Current Response
Values and the Initial Response Values for all modules.

Multiple modules can be grouped.
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Figure 4-133: Resource usage view

Resource usage view layout

The "Resource Usage View" uses Resource Usage Provider to collect resource usage
times and counters. The collected times and counters are displayed in the view. If the
collected data is not available, the corresponding cell shows "-".
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Figure 4-134: Properties of Resource Usage View

Apart from "Time" and "Count" columns showing time and count values, the view con-
tains the following columns.

● "PPId" column
The first "PPId" column is a Phylis Process Id, followed by a "Primary Module ID" in
parentheses if available. "PPId" identifies and distinguishes different Phylis pro-
cesses. For grouped modules, the row has the Phylis Process Id, but not the Pri-
mary Module ID.
Resource usage data are collected from different Phylis processes. R&S ROMES4
itself is a local process. At least one external Phylis process exists to handle signal
scanning, demodulation and so on.

● "Module"
Represents module or group name.

● "Code"
Represents module code or group ID.
– Module code for modules is displayed and represents an internal module iden-

tifier.
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– Group contains a list of related modules. A module is not shared by more than
one group. If a module is shared, it does not join any group and is listed as an
individual module. The number after the group ID is the number of modules
defined in the group. The group ID definitions are shown in the following table.

● Rest of columns are resource usage times and counters already introduced in
Chapter 4.2.10, "Resource usage view", on page 517.

The "Resource Usage View" contains two parts, the grid and the property bar.

Resource usage view grid

The "Resource Usage View" grid's rows and columns have the following meaning:
● Each row is a module or group with the same module code or group id.
● Each column indicates a usage time or counter

– The first column is the module or group name
– The second column is the module code or group ID column

If a number is displayed in parentheses next to the module code, the number is
an instance number, indicating that more multiple instances are running.

The usage frames are created about every 15 seconds or slightly longer. The data
starts showing up in 10 to 20 or more seconds depending on the system load.

The view depends on the received frames to display grid data. The resource usage
runs in a normal thread and if system is busy running other high priority threads, the
frames delivery is delayed.

The template signals and data displayed in the "Resource Usage View" can not be well
synchronized because frame delivery time differs. The view's property bar settings can
be saved in workspace and they will be reloaded next time loading the workspace.

Resource usage view properties bar

The entries contained in the "Properties" pane which you can activate/deactivate for
display in the grid are shown in the following screenshot.
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Figure 4-135: Properties bar

The following entries in "Properties" are available:

● "Global" > "Monitor Mode"
– "Accumulated" shows the value from start of measuring.
– "Instantaneous" shows the value for the recent x seconds, where x can be 1, 5

or 15 seconds, so called instantaneous seconds.
● "Columns"

Figure 4-136: Columns properties

"Columns" properties are for customizing each column. A column in the view can
be selectively made visible if the "Show" check-box is checked or invisible other-
wise. An alert with a threshold and alert color can be set if the "Alert" check-box is
checked.

The previous screenshot shows the selected settings for the Time From Start signal,
but the meaning of the entries is common for all other monitored signals.

The Time From Start is the time duration from measurement start up to a current time.
As "Show" is checked, the "Time..." column is shown in the "Resource Usage View".
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As "Alert" is checked, alerting is activated and other two properties, the "Threshold"
and the "Color" are displayed.

- Threshold: enter the threshold value of double type

- Color: select a color from the color picker control

When value exceeds the threshold, the value's background color changes as shown in
the following screenshot.

Figure 4-137: Alerts raised for some resource usage signals per module

The property bar settings can be saved in workspace.

Resource usage signal filter

Resource usage signal filter is used to specify the criteria to filter the signals.
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Figure 4-138: Resource usage signal template

The first parameter in the filter is Phylis Process Id. Select one or more from drop-
down box. The first number is the index to the drop-down list, the second number in
parentheses is the Phylis Process Id (PPId). When a measurement file is not opened
or is closed, the PPId is not available, and therefore not displayed.

The second parameter is a module that reports its resources usage. The module is dis-
played with its name and code.

4.2.11  Statistic histogram

The "Statistic Histogram" shows statistical evaluation of a signal. The evaluation
results are shown in a graph mode and in a table.

The table can be displayed below the graph if necessary. The range of the Y-axis is
calculated automatically.

If an invalid signal is selected (for example, RxQual while the mobile is in scan mode),
the diagrams remain empty. R&S ROMES4 allows several statistic histograms to open
simultaneously.

The "Statistic Histogram" complements the Chapter 4.2.1, "2D chart view",
on page 448, which displays the actual values of different signals.
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Figure 4-139: Statistic Histogram

The default colors are adapted to the R&S color scheme.

4.2.11.1  Diagram / table

The diagram or table shows the distribution of the signal values. The available signals
appear in the "Parameter" pull-down list after they have been selected in the "Values"
configuration menu.

The "Show table" button lets you choose between a graphical mode only (the button is
gray) or a tabular mode (the button becomes blue).

Figure 4-140: Show table

The values are displayed in a table as well.

Figure 4-141: Show bar chart

The values are displayed as a bar chart in the graph mode.

Figure 4-142: Show plot chart

The values are displayed in a 2D-chart with a continuous (polygonal) curve.

The following table corresponds to the bars in the figure above:
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4.2.11.2  Legend and marker

Figure 4-143: Show / hide legend

Displays or hides the legend on the right side of the diagram

Figure 4-144: Show / hide marker

Displays or hides the marker line and an info field. The info field shows the x-axis vari-
able and the value of the relative and accumulated bars/curves (if activated) at the
marker line. The marker line can be shifted to the left and to the right by the corre-
sponding cursor keys. A double click places the marker to the desired position.

4.2.11.3  Accumulated bars

The following icons display or hide the bars or curves for the relative or accumulated
frequency of each value. Several types of bars/curves can be active at the same time:

Figure 4-145: Show/hide density graph P(X=x)

Displays the relative frequency of all values in percent (p(X)) in the Figure 4-139.
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Figure 4-146: Show/hide cumulative density graph P(X<=x)

Displays the accumulated frequency in ascending order, i.e. the sum of the frequencies
of all signal values below the current value (P(X<x) in the same figure.

Figure 4-147: Show/hide complementary cumulative density graph P(X>x)

Displays the accumulated frequency in descending order, i.e. the sum of the frequen-
cies of all signal values above and including the current value (P(X>=x) in the same
figure.

The first bar/first value of the curve always starts at 100%. The sum of the accumula-
ted frequencies equals to 100% for all signal values:

P(X<x) + P(X>=x) = 100% for all X

Figure 4-148: Enable comparison of multiple devices

Shows or hides the device name in the legend and the marker.

The colors of the bars or curves and the scale of the y-axis are set in the "Settings" tab
of the configuration menu.

4.2.11.4  Scaling

The x-axis is scaled by the expected value range of the analyzed signal. The expected
range is set automatically for each signal but can be changed in the "Available Signals"
tab of the "Tools" > "Preferences" menu (see Figure 3-114).

"Exp. Min." and "Exp. Max." define the first and last value on the x-axis.

The intermediate x-axis values depend on the nature of the analyzed signal.

Many signals are defined on a step scale with a fixed number of discrete values. For
example, RxLev of a GSM mobile is an integer number between 0 and 63.

For those signals, "Step" is displayed in the legend below the diagram. The x-axis is
labeled with all values between the minimum and the maximum expected value. Each
step represents a class for the statistical evaluation, i.e. it is represented by a single
bar or point on the view curve.

For continuous signals, classes are defined by dividing the expected value range by an
integer number ("Number of Classes") set in the "Settings" tab of the configuration
menu. The classes are thus intervals of equal width. The center values of each interval
label the x-axis.
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4.2.11.5  Legends

The Statistic Histogram displays on the top-right side already mentioned icons for rela-
tive or accumulated frequencies of the current signal.

The statistical parameters of the current signal are placed across the bottom of the his-
togram.
● "Min. / Max."

Minimum and maximum value ever measured or replayed
● "Average"

Arithmetic means value of all values ever measured
● "Current"

Current measured value
● "Invalid"

Number of invalid values in the signal

The invalid values are excluded from the diagram.

The sum of all individual frequencies p(X) always amounts to 100%.

4.2.11.6  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.11.7  Statistic histogram configuration

The "Statistic Histogram" configuration menu defines the signals to be viewed, config-
ures the diagram and shows information on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Statistic histogram configuration: value tab

Selects the signals to be displayed in a generic (basic) and some mobile views. The
connected devices can be indicated in the "Selected Signals [Maximum Allowed <vari-
able>]" list for some signals. The "Values" tab is analogous to the "Values" tab of the
"Alphanumeric View".

For further description of the tab, see Chapter 4.2.3.3, "Values tab", on page 468.

Figure 4-149: Statistic Histogram configuration - Values tab

Statistic histogram configuration: histogram view tab

The "Histogram View" tab lets you select which statistic classes to show in the view
based on signal coloring, select the way of statistic calculation and configure the y-axis
scale.

Figure 4-150: Statistic Histogram configuration - Histogram View tab
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Statistic Classes
The classes within the view are defined from signal coloring only. The approach is an
automatic statistic classes configuration according to the signal color scale. Benefit is
that each signal has its own classes configuration which fits to the individual range and
partition.
Use "Configure Signals" to open the signal configuration. All R&S ROMES available
signals are shown. Nearly all signals have a color scale configuration, which can be
altered in an adequate way. Changes are stored in registry and therefore persist over
all workspaces.
As a result, the statistic classes are set according to the color scale settings.
Note: If auto-coloring for a certain signal, the classes are not defined by signal-color-
ing. In that case, used is just one class with borders set to minimum/maximum range of
the signal.

Statistic Calculation
The height of the bars can be calculated in two alternative ways.
● If "Sample based calculation" is selected, the height of each bar is proportional to

the number of samples in the class.
If "Time based calculation" is selected, the height of each bar is proportional to the
amount of time that the signal values fall inside the class.

Graph
Selects the bar types/curves to be displayed, the display colors and the y-axis scale.
The three check boxes p(X), P(X<x) and P(X>=x) show (if checked) or hide the bar
graphs or curves for the relative frequency of the values per class and the accumulated
frequencies. They are equivalent to the corresponding icons in the view. The "Choose
Color" pull-down lists select the display color for each bar graph or curve:

OK
Apply all configured settings and close the configuration menu.

Cancel
Discard all configured settings and close the configuration menu.

Statistic histogram configuration: info tab

The "Info" tab is similar for all view types. For a short description, refer to Chapter 4.1,
"Common properties of R&S ROMES4 views", on page 428.
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4.2.12  Statistic view

The "Statistic View" displays the most common statistical key indicators of any R&S
ROMES4 signal. To get wanted signal statistic, select an available signal from the "Sig-
nal Tree" and drag&drop in the view. The approach is common for basic views, for
example, the same applies for "2D Chart View" or "Alphanumeric View".

The "Statistic View" provides the "Stat","Data", "Histogram" table in the statistic center
dialog (in the "Parameter" window). In addition, the "CDF" and "PDF" charts are sup-
ported for selected signal.

The "Histogram" is based on the "Statistic Histogram" view, and therefore offers chart
mode as well.

The change in statistic classes has no effect once a signal is evaluated. For the statis-
tic classes, see "Statistic view configuration: histogram view tab" on page 539.

R&S ROMES4 detects the important changes in the "Statistic View" configuration page
and starts rescan of the RSCMD file. The important changes are, for example, adding
or removing a signal or the change in number of classes or width.

4.2.12.1  Statistic view analyzer

For each configured signal shown in the statistic center dialog, a specialized analyzer
window can be opened (mentioned "Stat", "Data" "Histogram". It provides additional
views on the signal data. The chart/table shows the statistical key indicators of the sig-
nal values.

A double click a signal row in "Parameter" opens the analyzer panel. Alternatively, a
single mouse click on the row and a right click with the "Open Analyzer" item of the
context menu also opens the analyzer.

The following statistical indicators are calculated and shown in the "Parameter" for the
selected signal:
● Unit of the selected signal
● Number of samples (valid & invalid "Count")
● Number of invalid samples ("Invalids")
● Mean
● Standard deviation ("Dev.")
● Minimum and Maximum
● Percentiles (1%, 5%, 25%, 50%, 75%, 90%, 95%, 99%)

Stat panel

The upper part of the "Stat" panel shows a box plot and the lower part shows the asso-
ciated indicators in a table.

A box plot shows summarizing the distribution of the scores of a group of numerical
data in a graphical way.
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The blue box in the box plot shows the median score as a line and the first (25th per-
centile) and third quartile (75th percentile) of the score distribution as the lower and
upper parts of the box.

The median is the score at the 50% percentile: half of all numerical data get a score
higher than the median, and 50% get a score lower. It is the middle point in the distri-
bution of scores.

The 25th percentile is the point at which 25% of the numerical data score lower (and
75% score higher). The 75th percentile is the point at which 75% of the numerical data
score lower (and 25% score higher). Thus, the area in the "box" represents the middle
50% of the patients.

Data panel

The "Data" panel displays the time stamps of the selected signal, the value of the stat-
istical parameter and the label of the class the parameter value belongs to ("Histogram
Class").

The number of the most recent values displayed can be configured using the function
"Performance" on page 538.

Histogram panel

The "Histogram" panel shows the signal parameter values as bar chart and table.

The "Histogram" is based on the "Statistic Histogram". The diagram types, the legend,
and the accumulated bars are described in Chapter 4.2.11, "Statistic histogram",
on page 525.
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Figure 4-151: Statistic View - histogram panel

CDF panel

This panel displays the Cumulative Distribution Function (CDF) of the selected signal
data.
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Figure 4-152: Statistic View - CDF panel

PDF panel

This panel displays the Probability Distribution Function (PDF) of the selected signal
data.
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Figure 4-153: Statistic View - PDF panel

4.2.12.2  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The tables of the "Statistic View" can be exported as CSV file formats. Click the
"Export data as CSV" entry of the context menu to export the view. All data in the view
are exported.

4.2.12.3  Statistic view configuration

Statistic view configuration: values tab

The "Statistic View" configuration lets you select and control the signals for displaying
and get information on the current view version.
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To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-154: Statistic View configuration - Values

Selects the signals to be displayed in a generic (basic) and some mobile views. The
connected devices can be indicated in the "Selected Signals [Maximum Allowed <vari-
able>]" list for some signals. The "Values" tab is analogous to the "Values" tab of the
"Alphanumeric View".

For further description of the tab, see Chapter 4.2.3.3, "Values tab", on page 468.

Statistic view configuration: statistic view configuration tab

The "Calculation" > "Statistic View Configuration" tab lets you set the upper and lower
threshold for selected signal, the signal evaluation mode and the number of stored sig-
nal values for performance control purposes.
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Figure 4-155: Statistic View Configuration - setting thresholds

Thresholds and evaluation mode
If you check the check box of a signal, the associated thresholds of the selected signal
can be defined in the dialog which opens automatically.
The dialog also opens if you select an already configured signal and click the "Change
Thresholds" button. In this case you can change the configured thresholds.

Thresholds ← Thresholds and evaluation mode
The "Upper Limit" and "Lower Limits" must be within the valid range that is displayed
for the signal. The signal states and the state indicating colors can be defined using the
percentiles and the color selection list boxes below the limit entry fields.

Evaluation mode of signal ← Thresholds and evaluation mode
Selected evaluation mode defines the statistic calculation that is the height of the bars
in the view.
The Evaluation mode of the signal can be defined as following:
● "Sample based", where the number of samples is used in the measurement.

The height of each bar is proportional to the number of samples in the class.
● "Time based", where the amount of time determines the number of samples.

The height of each bar is proportional to the amount of time that the signal values
fall inside the class.

Performance
The number of "Lines per data" limits the stored results shown in "Analyzer Data", see
"Data panel" on page 533. The "Updates/s" field defines the refresh rate of the signal
display, where a value of "0" means that the signal data is displayed immediately
(i.e.when the data is available).

OK
Apply all configured settings and close the configuration menu.
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Cancel
Discard all configured settings and close the configuration menu.

Statistic view configuration: histogram view tab

"Histogram View" lets you configure signals for statistic, the way of calculation, which
bar types/curves to display, the display colors and the y-axis scale.

Figure 4-156: Statistic View configuration - Histogram View

Statistic Classes
The classes within the view are defined from signal coloring only. The approach is an
automatic statistic classes configuration according to the signal color scale. Benefit is
that each signal has its own classes configuration which fits to the individual range and
partition.
Use "Configure Signals" to open the signal configuration. All R&S ROMES available
signals are shown. Nearly all signals have a color scale configuration, which can be
altered in an adequate way. Changes are stored in registry and therefore persist over
all workspaces.
As a result, the statistic classes are set according to the color scale settings.
Note: If auto-coloring for a certain signal, the classes are not defined by signal-color-
ing. In that case, used is just one class with borders set to minimum/maximum range of
the signal.

Graph
Selects the bar types/curves to be displayed, the display colors and the y-axis scale.
The three check boxes p(X), P(X<x) and P(X>=x) show (if checked) or hide the bar
graphs or curves for the relative frequency of the values per class and the accumulated
frequencies. They are equivalent to the corresponding icons in the view. The "Choose
Color" pull-down lists select the display color for each bar graph or curve:
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OK
Apply all configured settings and close the configuration menu.

Cancel
Discard all configured settings and close the configuration menu.

Statistic view configuration: info tab

The "Info" tab is similar for all view types. For a short description, refer to Chapter 4.1,
"Common properties of R&S ROMES4 views", on page 428.

4.2.13  Time gated spectrum view

The "Basic Views" > "Time Gated Spectrum View" shows the results of the Time Gated
Spectrum scanner.

The Time Gated Spectrum scanner starts when the 5G NR scanner detects a gNodeB.

Figure 4-157: Time gated spectrum panoramic view

The view allows between the different display modes of the time gated spectrum scan-
ner to switch. After the Time Gated Spectrum scanner has started, the 5G NR scan-
ner’s data is not required anymore for the Time Gated Spectrum scanner.
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If you are not interested in the 5G NR scanner’s measurement data, you can reduce its
measurement by clicking the  button. This action reduces any gaps in the spectrum
to a minimum.

The panoramic view that is displayed in the previous screenshot gives an overview of
the spectrum of interest. When the frequency of interest has been found, the view can
be focused by clicking that frequency.

When clicking the  button, the view switches to the hunting view to investigate a
potential interferer.

Figure 4-158: Time gated spectrum hunting view

The screenshot of the hunting view shows in the upper part that the spectrum is
reduced to 9.6MHz. The focus is set to the signal on the right side displayed in the
panoramic view, thus the focus frequency has changed. In the lower half of the screen-
shot, the time gated view is shown with a period of 10ms. All settings can be changed
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by clicking them. You can set up the color scale when you click the upper or lower limit.
The same approach for setting applies to period and span.

Figure 4-159: Changed color scale in the hunting view

The measurement data of the Time Gated Spectrum scanner is NOT stored to the
measurement file as having hudge amount of data by default,

You can activate/deactivate storing the Time Gated Spectrum scanner’s measurement
data during the R&S ROMES4 measurement, by clicking the save  button. If the
measurement data is stored to the R&S ROMES4 measurement file, the replay shows
the same display mode as during the measurement. It is not possible to change the
display mode (panorama or hunting) during replay.

The following table lists the function of the buttons on view's upper left.

Button Name Function

Panoramic view The wide frequency range gives a good overview. Pro-
vides max. 5650 MHz span, spectrum histogram, no
time periodic histogram.

Switch to hunting view Less frequency range, parallel spectrum and time gate
view.

Reset hunting view Reset hunting view with frequency and time gate dis-
play.

Show only frequency
view / time gate view

The buttons are applicable only in hunting mode.

Waterfall on / off Toggle waterfall on and off.

Resize chart Resize chart after changing the window size
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Button Name Function

Change scanner speed •Reduce the scanner speed to allow the time gated
measurements more frontend time.

Store spectrum data to
the measurement file

Toggle recording of the spectrum and time gate views
to the measurement file

4.2.14  X-Y graph view

The X-Y graph (or scatter plot) can be used to set two selectable signals in correlation
to each other. That is, the value of one signal is used as x value, the value of another
signal as y value.

For example, the correlation between RxQual and RxLev can be of interest. This con-
figuration is shown in the figure below.

Note that the quantity of an x-y-pair is shown using the color and the radius of the cir-
cle. The larger the radius, the more samples have been found for that pair. Same
applies to the darkness of the color. The darker the color, the more pairs are detected.

To calculate these indicators, all pairs found are set in relation to each other, i.e. their
quantity is normalized.

Figure 4-160: X-Y Graph View
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Figure 4-161: X-Y chart buttons

To zoom in and out, use mouse wheel in "Scroll Mode" and the left mouse button to
pan.

To zoom in and out, use the left mouse button and ALT + right button, respectively, in
"Scroll Mode". Use the mouse wheel to pan the x-axis and CTRL + mouse wheel to
pan the y-axis.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.2.14.1  X-Y graph view configuration: values tab

The "X-Y Graph View" configuration selects and controls the signals to be displayed
and shows information on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Basic views



Display and evaluation of resultsDrive Test Software

545Operating Manual 1171.6415.12 ─ 66

Figure 4-162: X-Y Graph View: Configuration - Values

Selected Signals
The "Selected Signals" table on the "Values" panel shows the configured signals and
associated devices of the scatter plot axes.
● "X-Axis Signal"

List of all signals selected for display on the X-axis.
● "X-Axis Device"

Associated device of the signal selected for display on the X-axis.
● "Y-Axis Signal"

List of all signals selected for display on the Y-axis.
● "Y-Axis Device"

Associated device of the signal selected for display on the Y-axis.
● "Signal Handling"

This column shows the plot mode number and the selected timeslot.

Available Signals
● "Add"

This button opens a menu to add the signals available for the X and Y-axes.
● "Edit"

This button opens a menu to modify the signals available for the X and Y-axes.
● "Remove"

Removes the complete signal row from the table.
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Example: 
The example shows selection of the signals to be shown in "X-Y Graph View" and
parameters for kind of signal handling and slicing period.

Figure 4-163: Configured signals for display on x- and y-axes

Signal Handling
Since many signals cannot be matched directly because they are measured/reported
at different points in time, the scatter plot can be configured how to match an x-y pair.
The following signal handling modes are available:
● "Last Value [0]:"

X, Y values are matched without the need of any time-constraint; the time slice is
preset to 1s. Once an x-y pair is available, it is displayed by the graph.

● "Time Slots [1]:"
X, Y values are matched if both occur within a given time interval. If one signal has
a valid value, then a pair is built if the other signal reports a valid value within a
specified time range.
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● Equidistant Time Slices (last value)[2]:
The time axis is split in time-slots of the same size. If in each time-slot at least one
value for each X and Y signal is found, then this pair is used as input for the graph.
Only one pair per time-slot is built and the most-recent values for each signal are
used. The length of the time slot is defined by the time slice value entry field.

● Equidistant Time Slices value)[3]:
Similar to the mode [2] above, but all reported values in a time-slot for one signal
are averaged. The length of the time slot is defined by the time slice value entry
field.

4.2.14.2  X-Y graph view configuration: chart configuration tab

The "Chart Configuration" page lets you define the colors of the curves and the scaling
for x- and y-axes.

Figure 4-164: Colors configured for SS-RSRP signal pairs

Colors
The colors of up to 199 signal curves can be defined in "ROMES Color Picker" opened
if double-click a field of the "Colors" column in the "Color Scale for <variable" > "Set-
tings" section, see Figure 3-119.
The "Restore Default Values" button resets all colors to their default values.
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X-Axis/Y-Axis
The axis’ ranges are the expected minimum/maximum range as configured in the
"Tools" > "Preferences" menu. To select the active signal, use the radio buttons in the
legend.
"Show Title" shows or hides the x-axis/y.axis title (only visible if the view window is high
enough for the title display).

4.3  Navigation views

The "Navigation Views" lets you visualize measured quantities with valid geographic
coordinates and retrieve the geographic coordinates of an individual measured value.

The following navigation views are displayed if hover a mouse over the "View" > "Navi-
gation Views" menu:
● "GPS Info View"
● "Panorama View"
● "ROMESMAP Route Track View"

Figure 4-165: Navigation Views

● GPS info view........................................................................................................548
● Panorama view..................................................................................................... 551
● ROMESMAP route track view...............................................................................562

4.3.1  GPS info view

R&S ROMES4 supports the GPS, the BeiDou, the Galileo and the GLONASS satellite
system as the GNSS.
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Valid time and position data is displayed for all available navigation systems. The satel-
lite information (satellite ID and SNR) for up to 20 satellites is included in the "GPS info
View". The satellites are sorted according to their SNR.in the view.

Figure 4-166: GPS Info view

In good receiving situations there can be 40 satellites and more. To differentiate among
detected and used GNSS, a character is introduced denoting the used GNSS. The
characters which denote GNSS are:

- Bxx stands for BeiDou

- Exx stands for Galileo

- Gxx stands for GPS

Rxx stands for GLONASS

GLONASS and GPS cannot be active simultaneously in µBlox modules generation 7
and lower.

BeiDou, Galileo and GLONASS are available only with NMEA protocol version 4.1 or
higher (µBlox modules can be configured to use NMEA 4.1 in the µ-Center).

The "GPS Info View" shows the recorded satellite information, that is, the satellite ID
and SNR and the calculated direction and speed of the test vehicle. Compass heading
and speed are displayed in a compass and speedometer if the receiver provides these
quantities.

For the details about the satellites, hover the mouse over the bars. The ToolTip
appears with the information.

The bars are marked with their Ids and the The colors of the bars indicate the following
states of a satellite:
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● Blue - signal is OK
– Code Lock on Signal
– Code and Carrier locked
– Code and Carrier locked, receiving 50 bps data

● Yellow - signal is not usable
– Signal detected but unusable
– Channel is searching

● Red - Error on channel

If the R&S ROMES4 measurement setup is equipped with a µBlox satellite receiver,
the additional Car Sensor Info is shown in the "GPS Info View" as black/blue squares
(LEDs) below the bars.

The µBlox unit is supported, but it is not available from Rohde & Schwarz. The LED is
blue, if the car sensor is available.

The squares (LEDs) indicate the status of the associated elements. The LEDs remain
black until the first status has been arrived.

LEDs "GPS Position" and "GPS velocity" change to blue if valid longitude / latitude and
speed data is available. In case of configuration with ADR (configuration ADR car sen-
sors connected is enabled), the remaining LEDs may change to blue. Otherwise, these
LEDs are black.

The calibration statuses are shown for an ADR configuration. Usually, the status dis-
play starts with "In Progress", the next status is "Coarse Calibration". The best status is
"Fine Calibration". This status is not always permanent. During improvement, the sta-
tus may fall back to coarse.

The calibration status related to pulses is shown. It changes from 'In Progress' to
'Coarse Calibration' and to 'Fine Calibration' after a while of driving.

LED "Tacho pulse" changes to blue, when sensor data arrives.

LED "Gyro" remains black as long as the calibration of the Gyro has not started. It
changes to blue when the calibration begins.

LED "Driving Direction" changes immediately to blue, as sensor data is available. It
shows the result forwards or backwards.

Latitude / Longitude / Altitude

Shows the geographic coordinates of the current measurement point.

GPS Time / GPS Accuracy

Shows the Universal Time Coordinated (UTC) or Universal Transversal Mercator
(UTM) projection of the current measurement point and the position accuracy.

GPS Health

Shows the operating conditions of the satellite receiver. The condition messages are,
for example, "Doing position fix", "No usable satellite", "Only 1 satellite" and so on.
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GPS Selection

Shows the validity of the current results. The following status messages are possible:

● 2D GPS
Data with valid longitude and latitude coordinates

● 3D GPS
Data with valid longitude and latitude and altitude coordinates

● 2D DGPS
Data with valid longitude and latitude coordinates, only with DGPS (differential
GPS) receiver

● 3D DGPS
Data with valid longitude and latitude and altitude coordinates, only with DGPS (dif-
ferential GPS) receiver

● DR
Dead Reckoning, only if provided by GPS receiver

● GPS + DR
Both GPS and Dead Reckoning used for highest accuracy, only if DR is provided
by GPS receiver

Satellites

Shows how many satellites per GNSS technology are available in addition to the total
number of detected satellites. The detected satellites are marked with their IDs. The
bar graphs show the relative quality of the received GNSS signals.

4.3.2  Panorama view

The "Panorama View" visualizes the panorama measurement. The purpose of panor-
ama measurement is a polar measurement on a fixed place.

Panorama measurements with a normal antenna are performed in manual mode. The
user is asked to direct the antenna to a given direction.

The R&S HE300 directional antenna makes it possible to measure power signal
dependent on the direction. In fact, the power signal measurement results of an R&S
scanner or receiver are paired with the direction information from the R&S HE300 to
get the polar measurement.

For some R&S HE300 details, see Chapter 6.6.1.6, "R&S HE300 GPS compass",
on page 2080 and refer to "R&S HE300 User Manual".
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Figure 4-167: Panorama view, an example

4.3.2.1  Panorama view details

The polar chart is divided into segments. The results whose angles fall into one seg-
ment are assigned to the middle of a segment. A result in the polar chart is the aver-
aged result of the incoming measurement results from a signal for a certain segment. If
the unit is dBm or dB, a conversion dBm -> mW -> averaging -> dBm is performed.

The segments which are currently measuring are colored green. Blue is used to color
the already measured segments. The blue marker in the view is the automatic antenna
or current segment marker.

The tool bar on the top left-hand side of the view contains three buttons.
Table 4-4: Tool bar buttons

Button (Icon) Meaning and function

"Open Configuration" - if clicked, opens the configuration page.

"Zoom to fit on/off" - toggle between the expected range of the signal and zoom
to fit.

"Heading Marker on/off" - show/hide the marker of the chart.

The marker shows the actual angle of the compass of the directional antenna. Showing
the angle helps positioning the antenna in the wanted direction. The marker is visible
for all panorama modes, not only the automatic mode with electronic compass.
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There is the "Chart" on the top right-hand side of the view. It lets you add or remove
signals. It shows signals that are currently measuring and the measurement results.
Double-click a signal's name grays the line and hides that signal.

The "Panorama Measurement" list on the low right-hand side, shows the existing mea-
surements. The associated "Start" /"Next" and "Stop" buttons allow the panorama mea-
surement to start/contine or stop.

Whenever a panorama measurement is started/stopped, an event is thrown.

Enable "Start Panorama Measurement"/"Stop Panorama Measurement" for the notifi-
cation of these events in wanted views, like shown in the following figures.

Figure 4-168: Panorama view - configure events

In that way, whenever a panorama measurement is started or stopped, a message is
written in the Event View and General Status View.

Figure 4-169: Panorama measurements event view
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To meet the LEE criteria, the device must not exceed the Lee speed. If the driven
speed is more than the Lee speed, an overspeed info is written to the "General Status
View".
If the speed falls below the Lee speed, an overspeed end info is written.

Figure 4-170: Overspeed occurred for LTP(RSSI)

If there is a valid position given from an existing GPS, a"Start Panorama Measure-
ment" button  appears in the "ROMESMAP Route Track View".

Figure 4-171: Start Panorama Measurement

The button appears in the view only if the position is valid.

Direct the antenna in the given direction at the panorama measurement with normal
antenna, which supposes manual mode.

At ASCII export, it is important to know which measurement values belong to which
direction. For panorama measurements in manual mode, the event Panorama Mea-
surement: Next Manual Direction tells which direction angle is applied.
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Figure 4-172: Exporting data gives segment info

To get this information, check "Export Events" in the "ASCII export" > "Settings" page,
see Figure 7-9.

"Panorama Measurement: Next Manual Direction" events are not available at auto-
matic mode, where an electronic compass gives the compass direction.

4.3.2.2  Configuration of panorama view

1. Select the "Panorama View" item in the "View" > "Navigations View" pop-up menu.

The "Panorama View" window appears.

2. Click with the right-mouse button any point in the view's window.

The list of commands is displayed.

3. Select the "Configure" command.

The configuration page opens, showing the "Values" page.
The "Values" page lets you add or remove signals from the panorama view.
The "Chart Configuration" allows the colors of the signals to alter and restore their
default values.
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Figure 4-173: Panorama View - configuration

Other possible configurations on this window are:
● "Segment Size"

The segment size determines the width of a segment.
The polar chart is divided into segments. Results which angle falls into one seg-
ment are assigned to the middle of a segment. Small segments need more mea-
surements and are more difficult to meet.
If a measurement file is loaded, the combo-box is grayed to prevent from changing,

● "Toggle Measuring / Recording"
The option helps to prevent unwanted measurement data and large measurement
files. Enabling this feature means whenever a panorama measurement is started
the measurement mode changes to recording. Whenever a panorama measure-
ment is stopped the measurement mode changes to measuring.

● "Fixed Measurement Time per Sector [s]"
The option allows you to include an OMNI antenna measurement into the workflow.
Also, it is possible to stop automatically the section measurement after a prede-
fined number of seconds.

4.3.2.3  Panorama measurement

Panorama measurement is a section in a R&S ROMES4 measurement, where starting
and stopping markers cover the panorama measurement.

Ideally, the directional antenna R&S HE300 is turned slowly in a 360° circle to cover all
angles.

Within a R&S ROMES4 measurement, there can be several panorama measurements.
From the scanners point of view, those measurements are just a long measurement.
With a direction/location information and the panorama start/stop markers, it is possible
to extract panorama measurement.
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Panorama curve drown from end to start point
Doing the panorama measurement groups the measurement data in several segments
in a polar diagram.
The circle is closed if all segments contain measured data. Stopping a panorama mea-
surement after some segments are measured does not result in a closed curve.
The feature "Panorama curve drown from end to start point" corrects previously men-
tioned drawback.

Panorama measurement requires the option ROMES4PAN. Replaying the panorama
measurement is always possible, no option is needed.

Panorama measurements with R&S HE300 Var03

Having a R&S HE300 Var03 which gives direction information, the panorama measure-
ment is assumed to be in automatic mode. However, the user has to start the R&S
ROMES4 measurement.

Without starting R&S ROMES4 panorama measurement, the actual signals are filled
and an enabled marker shows the actual direction.

Figure 4-174: Panorama measurement with R&S HE300

Start the R&S ROMES4 panorama measurement by pressing the "Start" button. Each
segment that has measurement data is marked as a green pie. The marker helps to
direct the antenna to the next segment, turning the R&S HE300 in a 360° circle until
each segment becomes green.

If a single segment was not hit, direct to that direction to complete all segments.

Stop the panorama measurement by button "Stop".

A panorama measurement is automatically named to Pano_x, where x = 1,2,3… Click
the "Pano_" text to alter the name. The text is written to a *.rscmd file.
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Figure 4-175: Panorama measurement events

Figure 4-176: Status of panorama measurement

Either stop the R&S ROMES measurement now or proceed to the next wanted location
and do another panorama measurement.

Panorama measurements without R&S HE300 Var03

This section considers the usage of any directional antenna and magnetic compass
instead of the R&S HE300 device.

As in this case the R&S HE300 compass is not detected, the panorama measurement
is assumed to be in manual mode.

The manual mode means lack of direction information. The panorama measurement
indicates just a segment to which you have to point the direction antenna.

Nevertheless, R&S ROMES4 panorama measurement has to be started.
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Figure 4-177: Panorama measurement without R&S HE300

Without starting the measurement, the actual signals are filled. No marker is shown by
default.

Start the panorama measurement by clicking the "Start" button. The first segment is
marked as a violet pie. A violet pie denotes the segment where the antenna needs to
be directed.

In parallel, the order "Please direct antenna between 67° and 112°" is displayed and
the "Start" button changes to "Next". Turn the directional antenna in that segment. A
segment that had measurement data in the past is marked as a green pie, while the
actual one is violet.

As the antenna has to be turned manually to the wanted segment, measurement in the
polar chart is omitted for 3s. The "Next" button is grayed for that time.

Wait at least until a measurement value is shown in the polar chart. After some sec-
onds, press "Next". The next pie gets violet and a new order asks for turning the
antenna into that new segment. Proceed in this way until each segment becomes
green. There is no chance to go back to an already measured segment.

Stop the panorama measurement clicking the "Stop" button.

A panorama measurement is automatically named to Pano_x, where x = 1,2,3… Click
the "Pano_text" to alter the name. The text is written to the *.rscmd file. Either stop
the R&S ROMES4 measurement now or proceed to the next wanted location and do
another panorama measurement.

Location time probability of RSSI measurements

Location Time Probability of RSSI measurement (further in text LTP(RSSI)) is the prob-
ability of measuring a certain number of RSSIs over the specified time.
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LTP(RSSI) measurement is only implemented for RSSI from the TETRA scanner. No
other technology or other power is supported. For configuration, see "TETRA scanner
Top N settings" on page 374 and "TETRA scanner signals settings" on page 382.

RSSI of each TETRA carrier is put into an array and sorted for the power. Taken an n-
th value is the n-th percentile of LTP of RSSI. According to the LEE criteria, power val-
ues are sampled near the wavelength of the carrier to reach a certain confidence inter-
val.

The LEE criteria recommends 36 measurements in 40 wavelength. Following this crite-
ria, the measurement tries to reach a minimum of 36 RSSI measurements in 40 wave-
length.

LTP calculation

The LTP calculation considers, according to LEE requirements, the following LEE
parameters:
● Lee Speed

Maximum driving speed in [km/h] the device drives, whereby the Lee criteria (36
RSSI measurements in 40 wavelength) is fulfilled. It is calculated as the ratio
between Current Analysis Measurement Rate and carrier frequency. If the device
goes less the Lee speed, more RSSIs are taken into the LTP calculation

● Lee Distance
Distance in [m] of 40 wavelength; it is calculated as 40xspeed of light/carrier fre-
quency.

● Lee Time
Time in [s] needed for minimum 36 measurements within 40 wavelength. It is cal-
culated as 36/Current Analysis Measurement Rate.

Within the Lee Time, all RSSIs are put into a CDF.

Taken the x percentile of Location Time Probability of RSSI is an n-th value of sorted
RSSI. It is named the LTPxx(RSSI), for example, LTP95(RSSI) means the 95% per-
centile of LTP(RSSI).

At the calculation, each incoming RSSI from one carrier measured within the Lee Time
is put into an array which is sorted by RSSI. The RSSIs, which exceed the Lee Time
are removed. If there are enough RSSI measurements (>=36) in the array, a RSSI for
a certain percentile can be requested and displayed. Depending on the TETRA scan-
ner measurement settings, the Current Analysis Measurement Rate differs in a tremen-
dous way and affects the Lee Time and Lee Speed. See the following tables as an
example of LEE parameters dependency of Current Analysis Measurement Rate for
400MHz frequency.

Figure 4-178: Lee distance for different Analysis Measurement Rates
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Figure 4-179: Lee Time versus Lee Speed

4.3.2.4  Exporting panorama measurement data

Having a panorama measurement, it is possible to export the data. Panorama mea-
surement values have associated exported degrees.

Click with the right mouse button within the "Panorama View" area to open the context
menu. Select "Export data as CSV". The command exports all panorama measure-
ment data into a *.csv file. It is possible to specify name and directory.

Figure 4-180: Exported degrees for measured signal

This measurement data is the averaged data for a signal which falls into a certain seg-
ment. To see the raw data, use the ROMES ASCII Export.

4.3.2.5  Replaying panorama measurements

The measurements fill the "panorama measurement list" while loading a R&S
ROMES4 measurement containing the panorama measurements.

Double-click the line to fill the polar diagram.

Replaying the *.rscmd file, fills all the signals to polar chart.

The polar chart is filled with the final averaged results when reaching the start panor-
ama measurement. The line of the active panorama measurement is marked.

There is no more update. The contents of the polar chart is erased by reaching the
stop of a panorama measurement.

During replay, the "Start"/"Stop" buttons are invisible.

To alter the panorama measurement name, click the "Pano_text" and edit. The new
name is written to the *.rscmd file.
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Click the Start Panorama Measurement  icon in the "ROMESMAP Route Track View"
to fill the polar chart of the "Panorama View".

4.3.3  ROMESMAP route track view

The ROMESMAP Route Track View functionality supports 5G NR, NB-IoT, LTE, GSM,
UMTS, CDMA2000 and TETRA technologies.

The "ROMESMAP Route Track View" page visualizes a measurement tour and the
behavior of the measured signals. For this task, it uses a projection onto a background
map that can be loaded and positioned into the view. Events and specific technology
features can be visualized.

Figure 4-181: ROMESMAP Route Track View

① = Toolbar
② = Overview Map: Shows a world map and the placemark shows the location of the current map .
③ = Elevation Profile: Creates a route or measurement to view its elevation profile.
④ = Docking bar
➄ = Map view
⑥ = Navigation: Provides the map view with additional navigation possibilities like scroll, zoom and go

home.
➆ = Legend, see Legend.
➇ = Status bar: Contains the information on position of the cursor, the altitude over the map and the eleva-

tion or zoom level value, see Status bar.
➈ = Scale bar: Shows the current scale area

The view includes the possibility to show the neighbor cells of the selected cell, see
"Neighbor cell display" on page 580.
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The ROMESMAP Route Track View functionality provides a common map view inter-
face to a range of map servers, for example, SRTM, PCMAP or R&S Map server. The
maps and map servers can be ordered from R&S. For a complete list, ask the R&S
customer support or see the R&S ROMES4 data sheet.

The ROMESMAP Route Track View functionality integrates the redesigned R&S
ROMES4 "MapView" component. This component optimizes the work with tiled maps
(tiles) like OpenStreetMap.
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4.3.3.1  Examples of supported scanners

The "ROMESMAP Route Track View" offers the mentioned features for evaluating the
coverage of the 5G NR signals measured by a 5G scanner as it offers them for other
3GPP RATs. The evaluation is based on a beam-based Top N pool. Only the beam-
based Top N pools are listed in the combo-box.
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Figure 4-182: 5G NR beam-based TopN pools

If none of beam-based Top N pools are configured, a corresponding message is dis-
played.

Figure 4-183: No beam-based TopN pools case

All beams of the selected Top N pool are listed in a "5G NR TopN Scanner". You can
filter the list by NR-ARFCN, PCI, SSB-Index and by the geographic polygon-filter.

The displayed values on the map are synchronized automatically with the list. The
color of the circles depends on the beam, its size of the Top N decision value (RSRP,
SINR or RSRQ). Click the visible button to show the values. It is also possible to show/
hide specific beam or change its color.
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Figure 4-184: 5G NR scanner - ROMESMAP Route Track View

All layers related to NB-IoT scanner (best route underlay, server lines, server highlight-
ing) are also supported with "ROMESMAP Route Track View".
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Figure 4-185: NB-IoT scanner - ROMESMAP Route Track View

4.3.3.2  View area

The entire view area is horizontally split into three parts.

On the left side of the view area, there is a string of switches.

● Toolbar (top section), see the "Toolbar" on page 583
Contains combo boxes and a toolbar to modify functions for the map view.

● Middle section
The middle section is vertically split into three parts: docking bar and its dialogs if
selected, "Map View" and "TreeView".
– "Docking bar" on page 567 (left section)

The switches of the docking bar enable the fast access to the visibility of BTS
info, Bts color and technology-specific features.

– "Map View" on page 573 (middle section)
"Map View" shows signal legend, BTS symbols, signal route, signal route
underlay, lines to best server, event symbols and cursor symbol. It is organized
in layers. The signals along a measurement tour, event symbols, base stations,
and arbitrary bitmaps of the explored area can be projected onto background
map. Backgrounds maps are always shown together with a length scale.

– Tree view (right section)
The "TreeView" shows all the loaded layers of the "ROMESMAP Route Track
View". The overlays, layers, objects and the corresponding properties can be
shown, modified and saved via this view. The tree entries can be made visible
or invisible on the map view. To show/hide an overlay, a layer or an object sim-
ply add/remove the related check box marker of the entry. See also Chap-
ter 4.3.3.6, "Maps menu", on page 606.

● Status bar (bottom section)
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Shows the position of the cursor in selected format, the geographic coordinates of
the current measurement point and the current scale factor.

Figure 4-186: Status bar - current mouse position

A zoom level indicator showing a value after a zoom operation is on the right from
the position data. The zoom value is a relative value which must be interpreted in
the context of the currently loaded map.
The current OpenStreetMap zoom level is shown in the following figure.

Figure 4-187: Status bar - current OSM zoom level

If an elevation shading layer is active, then the elevation value is shown in this
place.

Docking bar
The docking bar assumes switches on the left border of the "ROMESMAP Route Track
View". The switches enable fast access to the dialogs which show BTS info, BTS color,
scanners and the parameters included in the "Tec Feature Switch", like BTS symbols,
server lines, best server, position estimator if you click them.
The access to the mentioned dialogs is also possible via the context menu of the
"ROMESMAP RouteTrack View".

Figure 4-188: Option to open a dialog of docking bar

BTS Info ← Docking bar
"Bts Info" dialog gives the details on BTS configuration parameters like name, BSCI
and ARFCN.

Navigation views



Display and evaluation of resultsDrive Test Software

568Operating Manual 1171.6415.12 ─ 66

Figure 4-189: BTS info pane

BTS Color ← Docking bar
"BTS Color" shows the color settings of different BTSs.

Figure 4-190: BTS color pane

To change the provider's color, click the "Tools" > "Network Provider Database" com-
mand.
Instead, use the "Edit Network Provider" > "Edit, Add or Remove Providers" option
which offers a shortcut for opening the network provider's dialog. If you select a pro-
vider in the "BTS Colors" list, the network provider dialog is scrolled to that provider.

Tec Feature Switch ← Docking bar
The access to the visibility of features like BTS symbols, server lines or position esti-
mation, is centralized in the "Tec Feature Switch" dialog.
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Figure 4-191: Tec feature switches

The upper part of the dialog shows the grid of switches for the visibility of the suppor-
ted mobile technologies. The lower part shows the switches for the indoor features and
the Position Estimator (PE) features.
Besides the already known mobile switches for layer visibility and underlay (etc.) visi-
bility, which were scattered across many different menus and configuration pages,
additional switches are inserted:
- Switches for the BTS symbol layers under "RAT Feature"
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- Switches for the neighbor lines under "RAT Feature"
- Switches for scanner layers under "RAT Feature"
- Indoor switches "Indoor Feature"
- Position Estimator switches "PE Feature"
- Switch for selectively display of BTS stations filtered by bands "BTS Feature", availa-
ble for GSM, UMTS, LTE and NR5G.
The dialog itself is a windows control bar and can be opened with the "Tec Feature
Switch" button on the left border of the view. Like the other control bars, it can be
docked and undocked or automatically opened/closed.
The configuration items are present in the menus and technology configuration pages.
The ALT+CTRL keyboard controls are also available.
Description of Tech Feature Switch behavior
For the "RAT Feature" per technology and the "Indoor Feature" switches the following
applies:
● If the "Main Switch" is not selected, all individual switches in a column of the tech-

nology and indoor features, respectively, are erased. If selected again, the previous
setting of individual switches re-establishes.

For the "RAT Feature" switches also applies:
● If a switch under the "All tec" per RAT feature group ("Bts symbols", "Scanner",

"Mobile") is not selected, all individual switches for that group are inactive (dim-
med).

● If a switch under the "All tec" per single visibility parameter is not selected (for
example, "Underlay", "Server lines"), the complete row of individual switches is
dimmed, see the following screenshot.

Figure 4-192: Switch "All tec" for underlay and server lines visibility not selected

Selecting the switch in the last two cases re-establishes the previous setting of individ-
ual switches.
For the "PE Feature" switches, the following applies:
● If the "Main Switch" per technology is not selected, all switches in all columns for a

technology are not activated (dimmed).
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Figure 4-193: Switch "All tec" by power visibility ticked

Figure 4-194: Switch "All tec" by power visibility not selected

● If the "All tec" per single visibility parameter is not selected, all individual switches
in a row are inactive (dimmed).

● If the "All tec" "Main Switch" is not selected, all individual switches are inactive.
● If the "All tec" "by Band" switch in the "BTS Feature" grid is not selected, the list

boxes of all technologies there are inactive. If selected, the list boxes offer availa-
ble bands based on corresponding database after loading BTS databases. For
more of the usage of the "BTS Feature", see the next section.

Figure 4-195: All tec switch of BTS feature activated - LTE bands displayed
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The "Main Switch" per technology and the "All tec" switch per visibility parameter are
used to indicate whether all technologies are switched on (selected and green), or at
least one of them is switched off (not selected and red).

Tec Feature Switch - BTS Feature ← Tec Feature Switch ← Docking bar
After loading BTS databases, the technology list boxes offer available bands based on
corresponding database.
Select one or more bands to display BTS stations selectively. The following screen-
shots show the BTS's layout in the "ROMESMAP Route Track View" for LTE and 5G
NR bands selection.

Figure 4-196: LTE stations display corresponding to selected band

Figure 4-197: 5G NR stations display corresponding to selected band
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Figure 4-198: LTE and 5G NR stations display corresponding to selected bands

Binning View ← Docking bar
The "Binning View" allows you to visualize bin layer and set the bin size in a map. You
can choose the bin size selecting a value between 5 m and 1000 m or set it automati-
cally ("Binning Size" > "Auto"). If set to "Auto", R&S ROMES4 adapts the bin size auto-
matically according to the currently selected zoom level.

To open the "Binning View", click the same named vertical bar on the left side of the
"ROMESMAP Route Track View". Alternatively, click the "Binning Configuration Bar" in
the context menu of the "ROMESMAP Route Track View".
The configuration dialog hides the bin layer if the "Show Binning Layer" check-box is
deselected. The currently selected bin size is reflected in the "TETRA Scanner Report
View" automatically.

Map View
The middle section of the view is the main display area for a measured route track.
The display area is composed of a stack of layers.
● The lowest layers are maps selected from the set of location maps provided by a

location map server.
For example, the lowest layer can be a European map with the countries in differ-
ent colors and the second layer is a detailed map of a city area.

● The next layers above the geographical maps show the locations of the BTS. The
main transmit direction of the BTS is shown by the middle axis of the triangles
which originate from a true geographical location.
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The following two figures show the typical symbol of a BTS with three cells and
antennas and the symbol of an omnidirectional cell.

Figure 4-199: Directed cell with three sectors

Figure 4-200: Omnidirectional cell

The size of the symbols is configurable. The color of the symbols has a default
value for each technology. The color can be customized and can be made depend-
ent on MCC/MNC.

● The layers above the BTS layers are the "Route Underlays" and "Lines to Best
Server" which are colored by the CellId.

● The default route track layer follows the previous one. A thin black line shows the
route in case no signal is configured or the current signal is invalid.

● The next layer is a set of layers for the configured signals, from which only one is
visible while others are hidden. The signal route covers the default route track as
long as it is valid.

● On the top of the signal layers, there are event layers, one for each device. Only
one of the event layers is shown depending on the device or the current signal.
The other events are hidden. The event layers show different symbols which sym-
bolize the events. The events info is available in the info-box located left or right
from the route if you place the cursor over a symbol and click left mouse button +
SHIFT key. The info-box of the event shows.

Navigation views



Display and evaluation of resultsDrive Test Software

575Operating Manual 1171.6415.12 ─ 66

Figure 4-201: Example of a Handover Command event display as icon

● On top of the event layers, there are the layers for the "Best Server" symbols.
For example, for LTE the current best server is symbolized by a green (default) flag
"Top1". The next best servers are colored blue (default) and show the Text "Top2"
etc.

● On top of the "Best Server" symbols is the layer for the "Bts Markers". The "Bts
Markers" show the location of selected BTS on a map and are activated from other
views (like the BCH view). A color of the marker is configured in the views which
use this function.

Figure 4-202: BTS Marker

The BTS marker function is set in the "Tools" > "Transmitter Database" > "Query"
dialog if a BTS is selected from loaded BTSs.
For more details about the "Query" dialog, see Chapter 3.8.5, "Transmitter data-
base", on page 384.
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Figure 4-203: BTS Query dialog

The selection results are shown in the following figure.

Figure 4-204: Results displayed in the Base stations window

The "Show the result of a selective query on map" check-box lets you switch the
marker function on and off.

Navigation views



Display and evaluation of resultsDrive Test Software

577Operating Manual 1171.6415.12 ─ 66

Figure 4-205: BTS red marker and the BTS info bar

The red marker points to the BTS of the query result. Multiple markers can be
shown for larger query results. If selection is not done in the query and all BTS are
in the result set, the result is not marked.
The markers can be deleted by the entry in the context menu "Remove All Bts
Query Markers" or by the next query.

● On top of all other layers, there are the cursor layers. The cursor is never hidden
by any other element.

Note: If the LTE cell identities (CI) match, a mismatch in the physical cell identities
(PCI) is ignored. The choice is in the lookup of the LTE cell name in the "LTE Overview
View", see Chapter 4.4.12, "3GPP overview view", on page 923.

Cursors in the map view ← Map View
The map component on the "ROMESMAP Route Track View" shows four different cur-
sors (arrow, closed hand, pointing hand, open hand) depending on its internal state.
The "Sync Views" state, representing the coupled focus, is indicated by green color of
the cursors, see Figure 4-213 and Chapter 3.1.3, "Coupled focus", on page 101.
The “Jump to Timestamp” state is indicated by additional clock symbol in the cursors.
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Table 4-5: Map View cursors

Cursor symbol Not Synchronized View Synchronized View Jump to Timestamp

Arrow

Closed hand

Pointing hand

Open hand

Map level out horizontally ← Map View
If the "Switch on / off rotating the map" function is activated ( ) so that the map rotat-
ing is enabled, you can level out the map horizontally.
1. Press the CTRL key.
2. Select two points of the desired horizontal line in the map by clicking with the
mouse’s left button on them.
3. The figure shows the map layout after clicking the red spots.

Figure 4-206: Map leveled out horizontally

Show BTS Info
An info field containing a detail information on BTS sectors can be opened by [SHIFT]
+ left mouse button click the sector symbol (triangle). This action opens the "Bts Info"
pane.
For example, for a GSM base station visualization stated in "Info Text" on page 390,
displayed are BTS color code (BCC), BCCH channel number, cell identity (CI), network
color code (NCC).
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Figure 4-207: Example for the BTS information

If multiple sectors overlap at a position, the info of the nearest BTS sector to this posi-
tion is issued. The current position is the black dot of the BTS symbol.
The radius of the hot zone can be configured in the "Bts Layer" dialog.
The "BTS Info" pane for Position Estimator displays the corresponding confidence
interval value next to the direction value.

Figure 4-208: BTS info on PE

The confidence interval is +/- 52° in the figure. Starting from BTS antenna direction of
300°, an underlaying red sector of 104° (+/- 52°) is drawn.
The BTS confidence interval is displayed as a red colored, transparent sector under
the antenna sector in the "ROMESMAP Route TRACK View".
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Figure 4-209: Red sectors show BTS confidence interval

Coloring server lines
Coloring server lines changes to auto-color for all scanner technologies.
Whenever a scanner decodes the typical identifier of a BTS, NodeB or eNodeB, server
lines are drawn from that BTS to the actual route in the route track view. A change of a
cell is an important information.
Scanner signals which are used for server lines are colored in different colors to detect
the change. Having R&S ROMES4 18.0 or higher installation or unchanged the default
coloring for the signals, the color scale changes to auto-color. Sixteen colors are used
to distinguish the characteristic cells. These colors are used in repetition.

Neighbor cell display
The "Neighbour Cell Display" shows the neighbor cells of the selected BTS. It uses the
existing neighbor data (2G, 3G and 4G neighbor cell) in the BTS data bases. This fea-
ture is coupled to the BTS selection of the “Bts Info” feature, which is activated by
“mouse over” at the location of a BTS symbol.
The neighbors of the BTS are displayed by drawing colored lines to them, as shown in
the following figure.

Figure 4-210: Colored lines between the selected cell and its neighbor cells

Multiple BTS supporting different technologies (GSM, UMTS, and so on) if selected by
the "mouse over", shows simultaneously the lines to neighbors of multiple technolo-
gies.
To sort the things between the many possible lineouts, the two methods are available:
● If the multiple BTS is selected by the "mouse over", the "Neighbour Cell Selection

Control" option allows a single BTS selection from the list.
The method reduces the displayed lines to the neighbors of a single BTS.
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● The lines are colored differently for 2G, 3G and 4G neighbors, as shown in the pre-
vious figure.

Example: GSM and UMTS sample
Sample display with a GSM and an UMTS selected BTS shows the sum of all 2G and
3G neighbor cells.

Figure 4-211: GSM and UMTS neighbor cells

The figure shows server lines in the UMTS part of the route with the Multi RAT feature
applied. The feature works also for mobiles which switch between GSM-UMTS-LTE or
other multi-RAT configurations.

Navigation views



Display and evaluation of resultsDrive Test Software

582Operating Manual 1171.6415.12 ─ 66

Example: GSM sample
A GSM sample is displayed with the 2G neighbor cells of the selected GSM BTS in the
"Neighbour cell display control" window.

Figure 4-212: GSM neighbor cells

The example shows only the GSM part of the route.

The "Neighbour cell display control" window can be toggled in two ways:
● Click the  button, see Show / Hide Neighbour Cell Control.
● Select the entry in the context menu of the view.
The display can be cleared also in two ways:
● Click the "Clear" button in the "Neighbour cell display control" window.
● Select the "Clear Neighbour Cell Display" entry in the context menu of the view.

Measurement curve
It is a polygonal curve connecting the individual measurement points projected onto the
background map. The curve's coloring indicates the signal values as written in the leg-
end. That is, the legend only shows the colors of signal values which actually have
been measured for the selected device, see "Legend" on page 589.
The plotted signal, the device type and number and the signal value of the current
measurement point are indicated above the diagram.
For how to create a polygon, see Chapter 4.3.3.4, "Scanner data on map view",
on page 594.
Note: "Display entire measurement route at once"
You can display the entire measurement route stored in a measurement file (*.rscmd
or *.cmd) immediately at opening the file. Activate the measurement file scanning
option in the "Preferences" > "General" menu.
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Coupled focus
The Coupled Focus functions are available with [ALT + left] mouse click in the map
area. The replay jump to the timestamp of the nearest route position is done by "CTRL
+ left" mouse click.
The following figure shows a coupled focus. A synchronized map view is indicated with
the green cursor, see "Cursors in the map view" on page 577.

Figure 4-213: Cursor symbol for synchronized view

Toolbar
The toolbar offers the selected signal, device list and map, shows the signal value at
the current measurement point and provides map tools.

Map settings ← Toolbar
Table 4-6: Toolbar - Pull down lists

1 Parameters list of all signals selected in the configuration menu. The selected signal is visualized in
the map view.

2 Devices
Pull down list of all devices measured or contained in the measurement file replayed. The measure-
ment curve in the diagram shows the signal for the current device.

The device selection is also for selecting the events, which are device-specific.

If no measurement file is open, then the device selection shows <empty>.

3 Signal value
Value of the current signal and device at the current measurement point.

Map tools (buttons) ← Toolbar
The buttons showed in the following table, offer the tools for carrying out the actions for
customizing the map view. Click a button to carry out the corresponding action.
Table 4-7: Toolbar - Buttons

Button Description

Zoom to driven area
During replay or measurement zooms the view to the driven area of the measure-
ment file.
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Serverlines off / on
Hides or shows the server line.

Serverlines Transparency
Changes quickly the server line transparency. For details see "LTE RTM Bts layer
configuration: scanner layers" on page 669.

Serverlines Repetition Distance
Changes quickly the server line repetition distance, see also Figure 4-316.

Event symbols off / on
Hides or shows the event symbols.

Show / Hide Layer Mover
Shows or hides the Layer Mover.

Apply the stored layer mover settings from the workspace
Reads the values from the workspace and shows the selected signal and the other
signals with offsets. For more details, see Apply the stored....

Multi RAT: Show features (server lines etc.) for all RAT of the selected mobile
server lines, BTS markers, short info texts etc. can be shown by selecting this icon,
see GSM and UMTS neighbor cells.

Show / Hide Neighbour Cell Control
Shows or hides the neighbor cells of the selected cell.

Show / Hide Map Overlay Transparency Control
Sets the transparency of loaded map layer overlay of the MapInfo location map
(*.lmxml) or top image (*.kml) type.

The transparency control is a floating dialog which remembers its position in the
registry. The transparency values are 1 to 255, where 255 is the opaque value. The
value 0 is a special: Auto. For the Source/Dest. operation, for example, the b/w
images have all white pixels fully transparent.

The setting is stored in the workspace and is applied to the overlay when loading
the workspace.

Adapt toolbar
Two "Adapt toolbar" buttons open the "Toolbar" dialogs in which the group of to
them associated toolbar buttons can be selected or deselected for appearance in
the bar, see "Adapt toolbar dialog" on page 587.

Indoor Layer Manager
Opens the "Indoor Floor Plans" dialog, see Chapter 4.3.3.7, "Indoor floorplan man-
ager", on page 633. If the associated arrow is clicked, the context menu to select
indoor waypoints presentation opens, see "Indoor measurement" on page 654.
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Rescan
Rescans the entire measurement file, see the following "Rescan and refresh" sec-
tion.

Screenshot Wizard
Helps to create screenshots per signal and/or floorplan automatically, see Chap-
ter 4.3.3.8, "Screenshot wizard", on page 657.

Add Routes from Measurement Files
Opens the dialog to add a further measurement route on the map.

The command opens the file chooser for *.rscmd files. Multiple files can be
selected as well. The selected *.rscmd files are scanned for their routes and a set
of black lines is displayed on the map showing the routes of the measurements.

Delete Routes
Deletes all currently displayed routes. The action cannot be undone. Therefore
before the action is performed a message box for confirmation is displayed.

Disable
Disables or enables the updating of the view.

Opens the configuration dialog
Calls up the configuration dialog, see ROMESMAP route track view configuration.

Switch Legend on / off
Shows or hides the legend.

Auto Move/Zoom the Map on / off
If activated, the view follows the geographical measurement position so that the
current location is always visible.

If Auto mode is off, opening another measurement file does not rescale the map.

Switch on / off rotating the Map
If on, rotates the map. The view is rotated by pressing the right mouse button and
moving the mouse.

If rotate map is active, the context menu is available only in the top dialog of the
view.

Clean up (clear) the current measurement route during measurement or
replay
During measurement and replay (without file scan) deletes the elements of the
route track up to the current position. This measurement can be useful, for exam-
ple, to get a clear view before driving the same route in the reverse direction.

Top Map Layer
Opens the menu of map's view.

The "Load Map" command shows the pull-down list of available maps.

Open Location Map
Opens a window to select a *.lmxml location map file for loading.

Save Location Map
Saves a *.lmxml location map file with a given name to a selected directory.
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Zoom in
Magnifies the entire map. When zoomed, a loaded bitmap appears with a shaded
pattern which is removed when the Set anchor tool is set.
The following two options are available:
● Put the "Zoom in" icon to the center of the area that you want to magnify. The

map is magnified by a factor of 2.The position of the icon becoming the center
of the magnified map window.

● Left-click a point on the map, keep the cursor button pressed and move to
another point to draw a rectangle. On releasing the cursor button. The border
of the rectangle becomes the border of the magnified map window

Zoom out
Scales down the entire map. When zoomed, a loaded bitmap appears with a sha-
ded pattern which is removed when the Set anchor tool is set. Proceed as follows:

Put the "Zoom out" icon to the center of the area that you want to make smaller.
The map is scaled down by a factor of 2. The position of the icon becoming the cen-
ter of the scaled down map window.

The max. "Zoom out" is defined by the "world window" which is set by the MapView
component and is normally the bounds of the map.

Home
Sets home location.

Cluster
Activates the cluster in "TreeView"

Disable selection
Default mouse pointer used for selections like selecting a specific timestamp during
coupled focus. The pointer coordinates are indicated in the legend.

Grayscaled mode
Grayed the map view.

Elevation shading
Shades the elevation points.

Import buildings
Starting with OSM zoom level 15, this button is activated, see "TreeView"
on page 614.

Toggle 2D/3D view
Allows from ROMESMAP 2D to 3D view to switch.

Settings
Calls up the map view settings dialog. General settings like units, map quality and
labels are changed here. If your internet connection is behind a proxy, you have to
configure the proxy settings first.

RS Maps Studio
Basemaps offered by the local running mapserver RSMapsStudio. OpenstreetMap
is supported by the server.

Dimmer
Changes the brightness of the map view.
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Measure
Starts the distance tool mode of the cursor: A special ruler cursor is shown. If the
mouse is pressed and then moved while holding down, a distance line is shown.
Also, the value of the distance and the direction is displayed in the box at the left
side of the map view. The mode is terminated by the mouse double-click.

Measure Circle
See the previous button's description. The line shows a circle's radius in this case.

Elevation Profile
Creates a route or measurement to view its elevation profile.

Zoom To Rect
Changes the cursor to a cross and allows the selection of a rectangle with the
mouse (left button pressed). The view is zoomed on release of the mouse button.

Adapt toolbar dialog ← Map tools (buttons) ← Toolbar
Click the "Adapt toolbar" button to open the "Toolbar" dialog.

Figure 4-214: Toolbar buttons available

The dialog lets you add or remove a button to/from the toolbar. The visibility state of
the buttons is stored in the registry.

Rescan and refresh ← Map tools (buttons) ← Toolbar
 
Navigation map full rescan""
Navigation map full scan/rescan scans the entire measurement file. The full scan/
rescan of navigation map takes place in following scenarios:
- First time when opening a measurement file.
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- Addition of new signals requires full rescan.
Click CTRL-SHIFT-"Rescan" to start a full rescan manually.
"Fast rescan"
Fast rescan uses file-based cached frames to improve performance, as being faster
than full rescan. It can be used to synchronize the map view.
Click "Rescan" button to start fast rescan.
"Refresh"
After navigation map configuration change, refresh occurs automatically. Refresh uses
file-based cached server lines to redraw updated server lines.
Refresh is faster than fast rescan.
"Transparency changes without refresh"
If the configuration changes involve only in server line transparency, the changes take
effect immediately without refresh.

Toggle 2D/3D view ← Map tools (buttons) ← Toolbar
The "Toggle 2D/3D view" button is only functional if the following options are available/
configured:
● Sales Option: ROMES43DM
● Option name: SYS_3D_Maps
● Option ID: 458
If the options are available, click the  toggle button to get the 3D ROMESMAP Route
Track view.

Figure 4-215: 3D ROMESMAP Route Track View - BTS layer

For details about 3D view, see "TreeView" on page 614.

Zoom via rectangle ← Map tools (buttons) ← Toolbar
The "Zoom To Rect" button offers much faster and more precise control of the shown
area, as illustrated in the following figure.
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Figure 4-216: Zoom via rectangle

Legend
The legend shows a signal value or value ranges symbolized by the different colors of
the measurement curve. Define by the color scale configuration in "Preferences" >
"Available Signals" > "Color Scale Configuration" which signal and which colors of
selected signal's values (ranges) to be shown in a map, see "Color Scale Configura-
tion" on page 230.
Any change in the signal value is shown based on the auto-color function after select-
ing the set of signal colors. The legend shows the color scale only for the signal values,
which actually have been measured for the selected device. The repetition has a range
of 2 to 100.

Figure 4-217: ROMESMAP route track auto-coloring

The geographic coordinates of the current measurement point are shown in the status
bar. For more details on this issue, see Chapter 4.3, "Navigation views", on page 548.

Navigation views



Display and evaluation of resultsDrive Test Software

590Operating Manual 1171.6415.12 ─ 66

4.3.3.3  Context menu

Figure 4-218: ROMESMAP Route Track View - context sensitive menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:
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- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The functions included in the context menu are described in the following sections.

Tools
Opens a submenu providing tools for customizing the current view. The map tools are
also accessible via the buttons on the toolbar menu, see "Toolbar" on page 583.

Save View As Image File
Saves the opened "ROMESMAP Route Track View" as an image file.

Remove All Bts Query Markers
Deletes all BTS markers from the map.

Show/Hide Layer Mover
Opens or closes the "Layer Mover" dialog. The dialog contains all the signals selected
in the "ROMESMAP route track view configuration: values tab" on page 595 configu-
ration dialog.

Figure 4-219: Layer Mover window

The dialog can display several signals along a route track with a relative offset so that
the signal values can be read simultaneously. Simply select a signal in the list and click
the arrow buttons for the signal position. Click the  to reset (superimpose) the signals.

Figure 4-220: Example of layer offset on the display

The layer mover function generates legends for each visible signal.
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Figure 4-221: Legends for moved signals

If a layer is moved, the appropriate legend for the moved signal is displayed.
Note: The legends are stacked vertically. It can happen that not all legends fit onto the
screen.

Apply the Stored Layer Mover Settings
"Apply the stored layer mover settings from the workspace" reads the values from the
workspace and shows the selected signal plus the other signals with offsets.
The function is a part of the feature "Save settings of the Layer Mover". The other part
is the function to store the name of the main signal plus the names and offsets of the
other signals in the workspace.
The setting is stored while saving the workspace.
Note: The storage is temporarily. It is possible to restore the offset after another move-
ment if the layers have been moved and stored via save workspace. But this only
works if the workspace is still open. If the workspace is closed, the setting is lost.

Show/Hide Neighbour Cell Control
Shows or hides the neighbor cells of the selected cell.

Clear Neighbour Cell Display
Removes the neighbor cell view.

Multi RAT: Show Features (server lines etc.) for all RATs
Shows server lines, BTS markers, short info texts and so on.

Bts Info Bar
Shows/hides the Bts information, see "Docking bar" on page 567.

Bts Color Bar
Shows/hides the Bts color legend, see "Docking bar" on page 567.

TEC Feature Switch Bar
Shows/hides the TEC Feature Switch dialog, see "Docking bar" on page 567.

GSM/UMTS/LTE Scanner Bar
Provides some means to visualize and analyze the results for a certain Top N. In this
way the user gets a good overview of a network under the investigation.

Navigation views



Display and evaluation of resultsDrive Test Software

593Operating Manual 1171.6415.12 ─ 66

The cell table shows all detected cells, which fulfill the selection done by using the con-
trols at the top of the dialog:
● "Top N pool"

Only results of this Top N pool are count. Only those cells are listed, which have
been ranked as specified by the rank control in this Top N pool.

● "Geographic Area"
It is possible to shrink the selection of cells to cells, which have been ranked as
specified by the rank control in the selected geographic area. The geographic
areas are polygons, which have to be defined.

● "Ranks"
Only the cells that are listed are the cells which have been ranked at least once
with one of the selected ranks.

The following figure shows this dialog.

Figure 4-222: 3GPP technology scanner bar

For how to create a polygon, filter the table and display the driven routes, see Chap-
ter 4.3.3.4, "Scanner data on map view", on page 594.

GSM/TETRA/LTE/CDMA/UMTS/Position Estimator
Opens a submenu for the Route Track Modules (RTM).
RTMs are the technology-specific extensions of the "ROMESMAP Route Track View",
which show online the estimated BTS positions during the measurement on the map,
see Chapter 4.3.3.16, "Position estimator layer configuration", on page 680.
For position estimation details, see Chapter 6.4.28, "BTS position estimation",
on page 1870.
The different technologies RTMs share many similarities but also have some extras
dependent on technology, mainly in the mobile devices section. These differences are:
● Serving cell and neighbors extras for GSM
● Active set, candidates and neighbors extras for CDMA. CDMA has two modes,

CDMA2000 and EVDO
● Active set and neighbor set extras for UMTS
The view elements, the menus and the configuration pages are similar for all technolo-
gies. Nevertheless, some specific extensions per technology exist. For details, see
Chapter 4.3.3.10, "GSM layer configuration", on page 663
Chapter 4.3.3.11, "TETRA layer configuration", on page 666
Chapter 4.3.3.12, "LTE layer configuration", on page 667
Chapter 4.3.3.13, "5G NR layer configuration", on page 675
Chapter 4.3.3.14, "CDMA2000 1xEV-DO layer configuration", on page 677
Chapter 4.3.3.15, "UMTS layer configuration", on page 679
Chapter 4.3.3.16, "Position estimator layer configuration", on page 680
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4.3.3.4  Scanner data on map view

The map view displays a colored driven route of received signal and the rank as speci-
fied. If more than one rank is chosen, the layers of the lower ranks are above the lay-
ers of the higher ranks. The color of the route represents the color of the cell in the
table (in the figure, it is the black route of the first cell). The size of the route represents
the scaling parameter value, which has been used for ranking.

In an UE emulation, this scaling parameter is the Cue criterion.

Figure 4-223: Scanner Top N pool map view

The columns of any scanner in the "ROMESMAP Route Track View" can be sorted by
multiple columns. Which column is selected can be seen from the arrows in the column
header. If all columns are not sorted (no arrows), the original order, which is the inser-
tion order of the entries, is restored.

The color can be changed per cell. Each cell can be switched on and off by checking
or unchecking the "Visible" combo-box.

To toggle the visibility of layers, use the  button.

The table of detected cells can be filtered also by using also a column.

To clear all table filters, click the "Clear" button.

To set all cells in the current list visible or invisible, click the "Clear All" or "None" button

If a geographic area filter is applied, listed are only the cells which have been ranked in
this area. The rank values are displayed only in this area.

The content of the current list can be extracted to a *.scv file by using the  button.

To open the dialog for zooming the scaling parameters, click the  icon. The "Mea-
surement Point Display Parameter" dialog pops-up where you can define the scaling
parameters values for a technology.

Creating a polygon:

1. Click the  button.
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The "Map View" changes to the "Enter Polygon" mode.

2. Define the polygon on the map.

3. Finish the polygon with a double-click for the last corner.

The polygon is stored in the My ROMES\mapdata\polygons\ directory.

Deleting a polygon:

► Click the  button.

The polygon is removed from the combo-box and deleted from the
My ROMES\mapdata\polygons\ directory.

The accidental dropping of a column is not possible, whereas permutation is still
enabled. If a column is dragged and then dropped outside a valid area, nothing
changes.

4.3.3.5  ROMESMAP route track view configuration

The "ROMESMAP Route Track View" configuration menu defines the signals to be
viewed and shows information on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

ROMESMAP route track view configuration: values tab

Selects the signals to be displayed in a generic (basic) and some mobile views. The
connected devices can be indicated in the "Selected Signals [Maximum Allowed <vari-
able>]" list for some signals. The "Values" tab is analogous to the "Values" tab of the
"Alphanumeric View".

For further description of the tab, see Chapter 4.2.3.3, "Values tab", on page 468.
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Figure 4-224: ROMESMAP Route Track View - Values

For the meaning of the "Tree Filter" option, see Chapter 4.2, "Basic views",
on page 445.

ROMESMAP route track view configuration: route tracking tab

The "Route Tracking" page provides the general options for the map view configura-
tion.

Figure 4-225: ROMESMAP Route Track View - Route Tracking

Value visualizing
● "Display events"
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If the box is checked, the events selected in "Tools" > "Preferences" > "Available
Events" are displayed along the measurement tour, see Figure 3-111.

● "Display High Speed Values"
The option is used to display data obtained from the 5G NR scanner high-speed
measurements.

● "Hide No Signal"
The option to switch off black line on the ROMESMAP route track during drive test,
which is by default shown. Check the "Hide No Signal" box to remove the line from
the map.

Figure 4-226: Show-hide the black route line

If the box is checked, the "No Signal" layer disappears after closing the "ROMES-
MAP Route Tracking View" dialog, as shown in the previous figure.

● "Signal values as circle"
The route track is displayed as a line after loading a measurement file.
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This function displays a route track as the measurement points instead of lines. If
"Signal values as circle" is checked, the route track is displayed as a single circle
for each measurement point after submitting the configuration (click "OK") and fin-
ishing the prompted rescan.

Figure 4-227: Route track display after applying the function

● "Ignore altitude"
If checked, a signal route is painted as grounded in the 3D map view, that is, the
altitude values are ignored.

● "Signal line width"
Sets the line thickness of the polygonal curve along the measurement tour on a
scale between 1 (thin line) and 7 (thick line). If the "Automatic" option is set, the line
width is adapted to the shape of the curve.

● "Signal line resolution [m]"
The signal line resolution defines the segment length of the route track (1 m to 100
m).
The route-tracking segment lengths are gauged to the speed of travel ranging
between the configurable minimum and maximum value. The route-tracking seg-
ment lengths are generated as the speed-dependent (dynamically reckoned) ones.
However, the non-dynamic value can be simulated by setting the signal line resolu-
tion max. and min. values to the same value, see the Figure 4-225.
The track is actually a polygon of segments and the resolution is a parameter
which influences the performance. A finer resolution has more segments and
higher data volume and lower performance.

● "Gap detection thresh. [m]"
The gap detection threshold defines the transmission interruption of the positioning
data to display a gap in the connection line (1 m to 1000 m).
The route-tracking segment lengths are gauged to the actual speed of travel rang-
ing between the configurable minimum and maximum value. The route-tracking
segment lengths are generated as the speed-dependent (dynamically reckoned)
ones. However, the non-dynamic value can be simulated by setting the gap detec-
tion threshold max. and min. values to the same value.

● "Speed [km/h]"
The speed of travel value is dynamic, ranging between the configurable minimum
and maximum value (0 km/h to 100 km/h).
At speeds greater than the configured maximum speed value, the signal line reso-
lution and the gap detection threshold values stay at their maximum.
At speeds less than the minimum value, the signal line resolution and the gap
detection threshold values stay at their minimum.
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● "Hotspot symbol size [pt]"
The size of the hotspot symbol in points (15 pt to 150 pt).

The values for the signal line resolution and the gap detection threshold remain at their
configured maximum and minimum at speeds which exceed/fall below the configured
max. and min. values, respectively.

Auto panning
The function recenters the map whenever the cursor is about to leave the visible map
during measurement or replay.
● "Enable auto panning"

If checked, the auto panning function is activated.
● "Threshold from center %"

The threshold is configurable between 0% and 100% of the distance between the
center and the edge of the visible map. The default value is 90%.
NOTE: A low threshold can cause frequent map moves and high CPU activity.

Routes of previous measurements
The routes of previous measurements are shown as thin lines to help keeping a track
of already driven routes.
Select between the two possible ways to show routes:
● "Show routes of previous measurements"

If checked, the previous measurement routes are shown. The function keeps in
memory the last “max. count” measurement routes and displays them as blue line.

● "All routes of the current day"
If checked, the data of the routes made on current day is recorded in files within
directory …\My Romes\DrivenRoutes. The data is also available after the R&S
ROMES4 restart.
This function is an alternative to the previously mentioned function "Show routes of
previous measurements".
For indoor measurements, the records storage is unchanged, which means that
daily routes are stored per map.
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Figure 4-228: Daily route

● "Last max. count of routes"
Defines max. count of shown routes. The function is not applicable if the "All routes
of the current day" function is active.

● "Previous routes color"
The color of the previous routes, applicable for both route types.

● "Width of routes (pt)"
Defines the line thickness of the previous routes, applicable for both route types.

Both the route types can be deleted with the "Delete Routes" toolbar button.

Cursor
● "Cursor Color"

You can configure cursor color to make the cursor more visible on some maps, for
example mostly red colored maps.

Legend
● "Display legend"

If checked, the legend is shown in the map display.
● "Legend position"

As default, the legend is positioned on the left bottom corner. To use another place,
select from the drop-down list.

Automatic Rescan After Parameter Change ?
The rescan of the view is immediately executed by default if you press "OK" after some
route tracking setting changes. The changes take effect and are visible only after
rescan.
If the "Ask before immediate rescan" flag is checked, R&S ROMES4 offers to choose
how to do rescan after parameters change. The "ROMES" > "Rescan Immediately?"
dialog is displayed offering to do rescan immediately (press "Yes") or to do a manual
rescan later (press "No").
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Server lines and server symbols display rule
Sometimes a BTS cannot be clearly identified from the measurement values. For
example, if the cell identity is not available but the lower-level Information, like SC,
BSIC and PCI reused nearby, is available, the BTS cannot be identified. If more than
one BTS with matching values is found in a radius, the situation is ambiguous.
One option to avoid this ambiguity is to select the nearest BTS by distance and mark
the result like it is done with the BTS names in many views ( "+" is added to show this
condition). This approach cannot be applied to server lines.
● "Do not use nearest server if the identification is ambiguous"

This option allows the server lines suppression in ambiguous situations.

Mode
The following modes are available:
● "Move"

The center of the map moves accordingly without changing the zoom factor.
● "Zoom out"

The zoom factor is reduced to zoom out from the map and to see the current posi-
tion on the route track. The center of the card is always the same.

Automatically switch map loading offline
The function lets you choose in which case the automatic switch to offline for map
loading to be performed during measurement, if at all. The given options are:
● "Offline always during measurement"
● "Offline only for DQA measurement"
● "No automatic Offline"

Mouse Wheel
The "Number of Ticks per Zoom Level" option lets you specify the number of ticks on
the mouse wheel necessary to change from one zoom level to the next one.

ROMESMAP route track view configuration: Bts symbols tab

The "Bts Symbols" dialog provides for base stations the display options on the map.
The position and transmission characteristics of base stations in the view area are indi-
cated with colored symbols in the route track view. A BTS with an omnidirectional
antenna is symbolized by a circle. A BTS with directed antennas is symbolized by a dot
with up to three triangles indicating the sectors with their maximum transmission direc-
tions.

The tab is analogous for all technologies.
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Figure 4-229: ROMESMAP Route Track View - Bts Symbols

Bts Symbols
The following parameters define the size of the base station symbols:
● "Variable size"

Distance between a user position and a BTS, ranging from 0 m to 180 m, defines
the size of the BTS symbol. It changes with the zoom.

● "Automatic: Use smaller symbol for indoor"
The default variable size of BTS symbols on the "ROMESMAP Route Track View"
is optimized for good visibility of drive test results. For indoor measurements how-
ever the symbols are much too large. This parameter, by default active, switches
automatically to smaller BTS symbols for indoor measurements made with the
indoor device.
– "Variable indoor size"

Applies the specified smaller BTS symbols size for the indoor display.
The following two figures illustrate the BTS symbol presentation in the
"ROMESMAP Route Track View" when this function is inactive and active.

Figure 4-230: BTS symbols presentation with the unchecked parameter
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Figure 4-231: BTS symbols presentation with the checked parameter

● "Fixed size"
All BTSs have the same size, ranging from 0 pixel to 49 pixels, irrespectively of its
distance to the current position. The size does not change with zoom.

● "Fixed size connector distance"
End point of lines to best server is not recalculated when fixed BTS size is used.
Server lines, BTS markers and short info texts are positioned at an invisible “con-
nector” near the end of the wings of the BTS symbols. For fixed size BTS symbols,
there is a problem as the “connector” position depends on the zoom level. For the
optimal solution, all “connector” positions have to be recalculated after a zoom and
all server lines and markers have to be repositioned or redrawn. The action is not
possible in short time. Implemented compromise uses the fixed “connector” posi-
tions, also for the fixed size BTS symbols. You can adjust this compromise for best
results by "Fixed size connector distance". The default is 90 m.

● "Minimum symbol size for automatic sizing of symbols"
Defines the minimum symbol size for automatic sizing in percentage.

● "Symbol transparency"
Transparency of a BTS symbol can be adjusted to make visible the contents of
other layers behind the BTS symbol.

Limiting the Display of BTS Symbols
Only the BTS symbols within a given radius (in meters) around the current position are
displayed. Displaying large number of BTS symbols reduces the system performance
in sense of memory and processing capacity. For the optimization reason, only the
BTSs which are of interest in the current measurement situation and near to a mea-
surement location has to be displayed.
● "BTS symbol display"

The threshold introduced is the vertical size of the map in [km]. If the vertical size is
below the threshold, all BTS symbols in the view are automatically displayed. If the
initial vertical size of the view is above the threshold, only BTS cell symbols as
place holders in areas where BTSs are located are displayed. One BTS symbol per
area of 1 square degree (°) is shown.
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Figure 4-232: Limited display - only BTS symbols displayed

The BTS cell symbols can be expanded into BTS symbols:
● Manually, by [Shift+click] a BTS cell symbol
● Automatically by zooming deep enough, so that the vertical view size goes below

the threshold
Once a BTS cell symbol is expanded into BTS symbols, it stays expanded until the
BTSs are deleted or redrawn because of configuration changes.
Zooming in on the BTS cell symbol does not mean to zoom in on a real BTS symbol,
but to the cell area which contains at least one BTS symbol.

BTS Info Threshold
● "Short Info"

Limits the radius to display the short information in the Bts Info bar.
Also avoids too much text in the "ROMESMAP Route Track View". Enter the pre-
ferred value in the box to adjust the threshold of resolution below which no short
info text is displayed.

● "Long Info"
Activates the long information display in the "Bts Info" bar only if the map is shown
in detail (deep zoom in), that means, if the set resolution threshold is exceeded,
see Bts red marker and the Bts info bar.
If being zoomed out, it is only annoying to have the "Bts Info" bar open while mov-
ing the mouse over the Bts symbols.
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BTS cell maker mode
The default "Colored icon" option of the "BTS cell maker mode" function marks the
serving cell and the neighbors as icons.
The "Colored cell" option-selected switches to colored cell symbols.

Figure 4-233: BTS cell marker mode - colored icon and colored cell

BTS Short Info Font
Sets a font type and the color of the font in the BTS short info texts displayed on the
"Map View".
Note: The "Map View" does not support all available fonts. In case the selected font is
not supported, the most similar supported font is chosen automatically.

ROMESMAP route track view configuration: RTM tab

The "Route Track Modules" tab lets you select the available modules (the technology-
specific extensions) and make global configuration. Therefore, the function loads route
tracks of the technologies and selects between mobile or scanner layer data per each
track. The visibility of the route tracks in the map can be adjusted using this tab.

Figure 4-234: ROMESMAP Route Track View configuration - RTM
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Up/Down
These buttons manage the order of the RTM layer. If more than one technology-spe-
cific layer is made visible, the order can be managed. By default, all technology layers
are visible, see the previous figure.

Configuration
Select a technology from the list and click the "Configuration" button.
The configuration dialog for the selected technology opens. For how to configure the
technologies, refer to:
Chapter 4.3.3.13, "5G NR layer configuration", on page 675
Chapter 4.3.3.10, "GSM layer configuration", on page 663
Chapter 4.3.3.11, "TETRA layer configuration", on page 666
Chapter 4.3.3.12, "LTE layer configuration", on page 667
Chapter 4.3.3.14, "CDMA2000 1xEV-DO layer configuration", on page 677
Chapter 4.3.3.15, "UMTS layer configuration", on page 679
Chapter 4.3.3.16, "Position estimator layer configuration", on page 680

4.3.3.6  Maps menu

The  button opens the context sensitive menu dealing with map files. The menu
offers loading and positioning raster images to the "ROMESMAP Route TrackView", for
example, the background maps.

The valid MapInfo map files have a standard bitmap format. The geographic position-
ing information assigned to a bitmap is stored in a TAB file, i.e. a text file with the same
name but with the extension *.tab.

Load Map.................................................................................................................... 607
└ OpenStreetMap (*.dgml)...............................................................................610

Import.......................................................................................................................... 612
Map Projection............................................................................................................ 614
TreeView..................................................................................................................... 614

└ Insert Buildings............................................................................................. 614
└ 3D View.........................................................................................................616

└ Visualization of 5G dron measurement...............................................617
└ 3D Building Layer............................................................................... 618
└ Add Compas Control.......................................................................... 619
└ Altitude Mode for 3D View.................................................................. 620
└ Add Legend to 3D View...................................................................... 622
└ Add Layer Mover................................................................................ 623
└ Drag and Drop in 3D View.................................................................. 624
└ 3D View Reply Mode.......................................................................... 624

Widgets....................................................................................................................... 627
Export map..................................................................................................................628
Download map tiles.....................................................................................................628

└ Selection Method.......................................................................................... 628
└ Elevation data............................................................................................... 629
└ Zoom.............................................................................................................630
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└ Number of tiles to download......................................................................... 630
└ Elevation shading data map..........................................................................630

Create new map theme...............................................................................................632
Print ... (Ctrl+P)........................................................................................................... 632
Print Preview............................................................................................................... 633
offline/online................................................................................................................ 633

Load Map
Click the "Load Map" menu to see the basemaps offered by the locally running server,
the RsMapsStudio.

Figure 4-235: Maps menu – OpenstreetMap

The SmartOne setup installs the RsMapsStudio.
If successfully installed, RsMapsStudio map server runs a windows service.

Figure 4-236: RsMapsStudio service runs

The RsMapsStudio setup supports the OpenstreetMap. Also, the server supports the
"RsOsmBasic", "RsOsmDark" and "RsOsmSimple" basemaps which do not offer high
zoom level details.
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Figure 4-237: RSOsmBasic map

Figure 4-238: RSOsmDark map

To install a map for the RsMapsStudio:
1. Download the detailed, high zoom level mapdata (offline maps) for RsMapsStudio
from GLORIS. Use the following link for download:
https://gloris.rohde-schwarz.com/irj/portal/interop?NavigationTarget=ROLES://
portal_content/rus/core-ext/Anonymous/LogonCustomSamlRedirector&iFrame-
Mode=true&forceLogonRedirectUrl=/irj/portal/mnt_product_page?uvs-visible-tabs-con-
fig=product&uvs-tab=rusext-gloris-tab-all&uvs-searchterm=*
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Figure 4-239: Location of the offline maps for RsMapsStudio

The maps are located under the "Maps" > "Planet" in the GLORIS.
2. Launch MapsStudio by clicking the  button.
3. This action launches the RsMapsStudio WebApp.

Figure 4-240: RsMapsStudio WebApp

4. Click the info button on the right top-corner. The "Maps Studio" > "ABOUT" window
pops-up.
5. Click the "Show User Manual" to get the detailed information how to install new
maps for MapsStudio.
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Figure 4-241: Available R&S Maps Studio user manual

Note: Instead of requesting the offline maps from the R&S second-level support, you
can download maps from R&S GLORIS.

OpenStreetMap (*.dgml) ← Load Map
The OpenStreetMap (OSM) server is embedded in the R&S Map server. Hence, the
OpenStreetMap is available from the R&S Map server of the ROMESMAP Route
Track. OpenStreetMaps are downloaded from the OpenStreetMap Community and
cached for use in R&S ROMES4.
During start-up, the R&S Map server checks whether it is on- or off-line. If on-line, all
map data which is needed but not found in the local cache, is downloaded immediately
and cached for further use. If off-line, only cached map data is used.
Note: Impact on measurement results. Do not start the "ROMESMAP Route Track
View" with an OpenStreetMap server while a DQA measurement is active. The map
server data presumably uses the DQA RAS connection which has an impact on the
measurement result.
Start the OpenStreetMap server by loading it.
1. To load the OpenStreetMaps in the "ROMESMAP Route Track View", click  >
"Load Map" > "OpenStreetMap".
In case the PC is behind a proxy, you have to set the proxy first. Click  to open the
proxy settings dialog.
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Figure 4-242: Proxy settings dialog

2. Enter the proxy data and select "save password".
3. Click "OK" to confirm the settings.
Map data is downloaded and copied to a cache storage on the local disk, as needed
for display for each map and zoom level. Otherwise, only the world map with the lowest
zoom level is available.
Maps are updated on request. Whenever a new area or a new zoom level for an area
has to be displayed, the map data is downloaded automatically. Downloading lasts as
long as there are no configured DQA job within the R&S ROMES4 measurement.
Whenever a measurement containing a DQA session is active, other downloads are
suppressed by the R&S ROMES4 automatically.
Configuration of the OpenStreetMap Server
Configuration of the OpenStreetMap server is only needed, if you want to have your
own server for OpenStreetMaps. The configuration data is stored in the file
openstreetmap.dgml, which is loaded during the server start-up.
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The link to the server is stored in the following lines:

These lines can be changed freely. Up to three links are accepted. The "path" in the
link points to the location, where the tiled maps are stored. For the OpenStreetMap
server, this path must contain "/". If the server of your company stores these files, for
example in "tiles", a valid link is:

During installation, this file is stored and updated in the application data section of all
users.

Import
The "Map View" supports import of raster/vector layers.
● "GeoData"

Supported formats are: Google KML/KMZ, Garmin GPX, MicroWorld Database II
(*.pnt), S57 marine vector data.

● "Image layer"
Supported formats are: Georeferenced images (GeoTiff). Other formats like JPEG,
PNG are supported if a Word file is available. Also there is a resolution.
Limitation depends on your graphic device. If import fails, use the R&S GeoRefWi-
zard to crunch your image into small tile maps.

● "ESRI layer"
Supported formats are: ESRI Shape *.shp, ESRI Grid *.adf, ArcInfo *.e00.

● "MapInfo layer"
Supported formats are: MapInfo Tab (*.tab raster/vector layer), MapInfo Mif
(*.mif) and MapInfo Mid (*.mid).

● "Add Image"
Use this option for not referenced images of indoor measurements. A *.kml file
with a default referencing is created.
Click "Add Image" to get a dialog where a projection, resolution and a fix point can
be defined for creating default TAB file for the image.
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Figure 4-243: Add Image

– "Add"
An image file must be selected. If pressed, the "Select one or more files" dialog
appears where you can choose a file for loading. Supported image formats are:
PNG, JPG, TIF and BMP.

– "Position"
Selects the Geo coordinate format. The selected position is shown in the "Posi-
tion (left/bottom)" line of the "Add Image" dialog.

Figure 4-244: Select the preferred coordinate format

– "Projection"
Lets you select a projection type or create your own in the "Projection settings"
dialog which is displayed when the Projection entry is clicked.
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Note: If the projection of the used map and the one used in R&S ROMES4 do
not match 100%, the displayed route can be slightly shifted during panning
and/or zooming.

– "Resolution"
Resolution in meters per pixel.

– "OK"
Selected image is loaded and a *.tab file is created with the parameters
described previously.

– "Cancel"
Cancels loading the selected image.

● "Add Indoor Floorplans"
The function adds/imports indoor floorplans into the ROMESMAP view by activat-
ing the Indoor Floorplan Manager.
The R&S ROMES4 handles indoor floorplans differently than "normal" map layers
in a way that it offers the Indoor Floorplan Manager functions to handle both geore-
ferenced and non-georeferenced maps. For details see Chapter 4.3.3.7, "Indoor
floorplan manager", on page 633

Map Projection
The "Map Projection" menu offers three map projections:
● "Globe": Spherical Mercator
● "Mercator"
● "Flat Map": Equirectangular
The WGS84 ellipsoid is used by all projections.

TreeView
Shows/hides the "TreeView" of the "ROMESMAP Route Track View". The "TreeView"
is by default closed.
To open it, click  and select the "View" > "TreeView" entry in the pop-up menu of the
"ROMESMAP Route Track View" tool bar. Move the vertical splitter to the right to
adjust the view size.
The "TreeView" offers to set the ROMESMAP and legend overlays and select layout of
the OpenStreetMap.

Insert Buildings ← TreeView
If  is activated, the raw OSM buildings height data is downloaded and stored
in ...\mapdata\buildings.
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Figure 4-245: Button to activate buildings layers

The function is activated starting with OSM zoom level 15.
Also, the buildings are rendered over the map.

Figure 4-246: Buildings presentation in ROMESMAP Route Track View

If you want to remove one or all building layers, use the "TreeView" > "BuildingsOver-
lay" > "Delete" context menu command.
To load existing *.osm file, click , that is, the "Insert buildings" function.

To use downloaded *.osm files on other systems, copy them into ...My ROMES\map-
data\buildings directory. If the directory does not exist, create it.
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3D View ← TreeView
The navigation through the 3D "ROMESMAP Route Track View" map can be:
● Pan map - press and hold the left mouse button, move mouse; the map moves in

all directions.
● Rotate map - press and hold the right mouse button, move mouse left-right.
● Tilt map - press and hold the right mouse button, move mouse up-down.
● Zoom map - use navigation control (the roller on the left side) or the mouse wheel

to zoom in/out the map.
BTS symbols are grouped to clusters, starting with the map zoom level less than 13.

Figure 4-247: Clusters of grouped BTS symbols

For seamless map zoom, the zoom step resolution can be changed.
Click the  button to open the RomesMapServer settings dialog. Select "Navigation"
and change the seamless zoom step. Check the "seamless zoom" box and choose the
number of seamless zoom steps in the "seamless zoom stepes" dropdown box. If the
value 12 is chosen, the choice means that you need 12 mouse wheel ticks to zoom a
full OSM zoom level. For example, 12 mouse wheel ticks to change from OSM level 10
to level 11.

Navigation views



Display and evaluation of resultsDrive Test Software

617Operating Manual 1171.6415.12 ─ 66

Figure 4-248: Set seamless zoom steps

Note: If the "ROMESMAP Route Track View" is used in 3D mode, changes in Win-
dow's "Display" > "Scale and layout" settings require R&S ROMES4 restart.
Otherwise, the legend disappears. Other unwanted issues can occur.

Visualization of 5G dron measurement ← 3D View ← TreeView
The "ROMESMAP Route Track View" can visualize a 5G drone measurement file and
5G BTS stations with height above ground values.
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Figure 4-249: Visualization of a 5G drone measurement

The mentioned visualization capability means that R&S ROMES4 supports the height
above ground (HAG) parameter.
If you hover mouse over a BTS or a signal route (dependent on availability of each), a
HAG value is displayed next to the "Position" (Longitude/Latitude) section.

Figure 4-250: HAG value displayed if mouse hovers over BTS or signal route

3D Building Layer ← 3D View ← TreeView
If the map zoom level is higher than 12, you can activate building layer for display.
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Figure 4-251: Activated building layer in 3D view

The buildings layer data is downloaded and rendered for a predefined area around the
current map center.
Use the "Layers" control (the right-bottom button ) to enable/disable buildings layer.
The button lets you select between the "Bulidings" and "BTS" layer.
Pan the map to a new center and activate buildings button again to download and ren-
der changed area.
Use the "Open Controls" button on the top-right of the view to control/change some
settings (for example, buildings color or opacity).
Note: Enabling the building layer in 3D view requires the Internet connection availabil-
ity.

Add Compas Control ← 3D View ← TreeView
The 3D ROMESMAP Route Track view offers adding the compass control. The com-
pass control, located right-top, visualizes current rotation.
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Figure 4-252: Compass usage in 3D view

Double click left mouse-button resets rotation and pitches compass to zero.

Figure 4-253: Reset rotation

Altitude Mode for 3D View ← 3D View ← TreeView
By default, signal route in 3D view is painted by respecting altitude values.
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Figure 4-254: Respective altitude values of signal routes

To ignore altitude values, click any point in the ROMESMAP Route Track area to open
the "Configure" dialog, select the "Route Tracking" tab and tick the "Ignore altitude"
check box.

Figure 4-255: Segment of the Route Tracking dialog

Ignoring altitude values means to paint a signal route as grounded, as shown in the fol-
lowing figure.
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Figure 4-256: 3D view shows grounded route

Note: After changing the configuration, switch to 3D view and select the "3DView
reload" command in the menu of map's view.

Add Legend to 3D View ← 3D View ← TreeView
"Legend" can be switched on/off via "Layers" control.
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Figure 4-257: Activation of legend in 3D view

Add Layer Mover ← 3D View ← TreeView
Click the  "Layer Mover" button to open the "Layer Moved" dialog. Select a signal in
the dialog and move to one of the available directions. The selected signal moves cor-
respondently in the view.
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Figure 4-258: Layer mover in 3D view

Drag and Drop in 3D View ← 3D View ← TreeView
Drag&Drop function is supported in 3D ROMESMAP Route Track View.

Figure 4-259: Drag&Drop support in 3D view

3D View Reply Mode ← 3D View ← TreeView
The replay mode of the 3D ROMESMAP Route Track view is shown in the following
figure.
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Figure 4-260: Replay mode of 3D view

Switching to other bitmaps is done by using the same menu as in 2D view. Click the
"Top Map Layer" icon and select the wanted map in "Load Map".
You can select various 3D view layouts if using the available tool buttons. The following
figure shows the grayscaled mode and the elevation shading layer activated by corre-
sponding buttons explicitly named in the figure.

Figure 4-261: 3D view - grayscaled mode and elevation shading layer

The signal values in the 3D ROMESMAP Route Track view can be shown as circles.
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Figure 4-262: Signal values shown as circles in 3D view

If a Position Estimator (PE) measurement file is loaded, the estimated BTS stations
along with confidence sector are displayed.
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Figure 4-263: Estimated BTS stations

If a 3D view rendering error occurs, use the "View" > "3D View reload" command of the
"Top Map Layer" button.

Widgets
The following widgets are available:
● "Compass"

Displays right/top on the map; In case the map is turned, use left click into the com-
pass rose to reset turning.

● "Elevation Profile"
Creates a route or measurement to view its elevation profile.

● "Scale Bar"
The scale bar shows the current scale. Right click on the scale bar to open context
menu, enable or disable "Ratio scale".

● "Navigation"
Provides the map view with additional navigation possibilities like scroll, zoom and
go home, as described in Figure 4-181.

● "Overview Map"
Shows a world map. The placemark shows the location of the current map area, as
described in Figure 4-181.

● "Download Progress"
Some base maps relay on on-line services like OpenStreetMap (OSM). If a reques-
ted map tile is not saved to cache, the MapView function tries to download that tile
from Internet. To see if currently download request is active, enable this option. A
small circle is displayed at the right/bottom on the map showing the download pro-
gress.

● "Routing"
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Provides the additional navigation information and route configuration, that is, the
Marble configuration to speak driving instruction.

● "TouchNav"
See the "Navigation" widget.

● "License"
Displays the available licenses.

Export map
"Export map" offers to export screenshot or the high-resolution map of the current view
to an image file. Supported formats are JPEG and PNG.

Download map tiles
Opens the "Download Region" dialog where you can specify:
● Way of region selection in the "Selection Method" pane,
● Part of the "ROMESMAP Route Track View" layout where to download the eleva-

tion data from the SRTM elevation data or map tiles in the "Elevation Data" pane,
● Download tile level range from start- to end-zoom level and view the number of

tiles to download for specified levels in the "Zoom" pane.

Figure 4-264: Download map tiles limit checked

Selection Method ← Download map tiles
● "Visible region"

If selected, the region for which elevation data is downloaded is specified via zoom
in/out or pan the map.
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● "Download Route"/"Offset from route"
Currently not supported.

● "Specify region"
If selected, the region for which elevation data has to be downloaded is specified
by entering the area coordinates.

Elevation data ← Download map tiles
The SRTM files contain elevation information. R&S ROMES4 needs SRTM elevation
data download to calculate the heights above ground.

Figure 4-265: Activated download of elevation data

There are two parameters which set the BTS height when importing a BTS station list
from the supported file formats (ATD, CSV, CDC, BUF). These parameters are:
- PosAltitude which defines the BTS height above sea level
- HightAboveGround which defines the BTS height above ground (HAG)
If the HightAboveGround parameter is not available in the BTS list, R&S ROMES4 cal-
culates the height above ground from the PosAltitude parameter in the BTS list and the
available SRTM elevation data.
To download SRTM elevation data files, proceed as following:
1. Set the current map view to an area for which you want to download SRTM files.
2. Mark the "Download SRTM" check-box in the opened "Downloads map tiles" >
"Download Region" dialog.
3. Enter your "Earthdata" credentials.
Note: SRTM elevation data download requires a NASA Earthdata login account. To
create an account, use the Earthdata account link. Set "Username" and "Password"
obtained by your account.
4. Click "OK" or "Apply" to start SRTM data download. Downloaded files are stored
locally as *.hgt files in ...\mapdata\srtm folder.
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If you select "OK", the dialog "Download Region" closes and download runs in back-
ground. To observe download progress, click "Apply".
If "Download SRTM" is unchecked, the map tiles are downloaded.
The map tiles are stored in mapdata folder. The exact folder path is according to "zoom
level{x-coordinate{y-coordinate" and depends on active basemap. For example, for the
OpenstreetMap (OSM) the path is ..\mapdata\earth\openstreetmap\z\x\y.png.
SRTM server only supports SRTM data from 60° south to 60° north. SRTM data north
of 60° are only available by request from R&S. If you set the download area north of
60°, a hint to request data from R&S is displayed.

Zoom ← Download map tiles
In the "Download Region" > "Zoom" > "Tile Level Range" combo-boxes select a down-
load range from start- to end-zoom level.
The current OSM zoom level can be viewed as the "OSM" value in the status bar of the
"ROMESMAP Route Track View".
Note: Count of SRTM elevation data size for download is a map zoom level dependent
and limited to 50.
Count of tiles for download is a map zoom level dependent and limited to 250.000.

Number of tiles to download ← Download map tiles
Shows the number of tiles to download and the map tiles download limit, see Fig-
ure 4-264.

Elevation shading data map ← Download map tiles
For the 3D map, the function is a height display on a map important.
If the elevation shading data function is active, map tiles are rendered and the map is
shaded corresponding to terrain height information.
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Figure 4-266: Example of elevation shading map

To enable this ROMESMAP Route Track feature, click the elevation shading button, .
The elevation information is contained in the TSM server which is on-line unavailable.
Therefore, the information cannot be downloaded from the server. To overcome this
obstacle and display the elevation shading data, create these tiles from the SRTM ele-
vation data files using R&S ROMES4 and the GeoRefWizard application.
Proceed as following to create elevation shading map tiles:
1. In Windows 10 search for the "R&S ROMES" > "Georeferencing Tool<version>" to
open the "GeoRefWizard" dialog,
2. Select the "Open image" button in the top-left corner of the dialog, navigate to SRTM
folder previously mentioned in the "Download map tiles" on page 628 and select one
SRTM file from the <SRTM ('.hgt)> file type list to load.
3. The new elevation map tile has to be stored in C:\Users\[username]\Documents\My
ROMES\mapdata\maps\earth\elevation-shading.
To set this map tile as output folder, select the  button next to "Referenced file" and
execute the choice.

Figure 4-267: Setting map tile
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4. Click "Create" to start elevation map tiles rendering.

Figure 4-268: Create tile

Note: By default, the GeoRefWizard creates elevation map tiles from all SRTM files
found in the selected folder, so it is not needed to open one *.hgt file after another.
However, creation of elevation map tiles from all SRTM files can be time consuming as
depends on SRTM files count. R&S recommends creating only tiles for a specified
area.
To create tiles for specified area only, set your current map view to that area and mark
the "current view" check box before start rendering.

Create new map theme
Opens the "MapView Map Theme Creation Wizard". With this wizard, it is possible to
install new maps from servers which support the WMS (Web Map Service) interface.
For example, browse the http://geoint.nrlssc.navy.mil/nrltileserver/wms to load the
LANDsat7 map or the http://www.nasa.network.com/wms for i-cubed Landsat.
How to: Chapter 4.3.3.9, "Map theme creation wizard", on page 658.
After R&S ROMES4 shutdown and restart, the additional map is available in the
"ROMESMAP Route Track View".

Print ... (Ctrl+P)
Prints the current map view and offers modifying the printer settings.
To control the appearance of the hardcopy, use the print preview option.
The "Print" option is an alternative to taking screenshots via the clipboard (see Chap-
ter 7.4, "Obtaining screenshots", on page 2188). R&S ROMES4 uses the standard
"Print" menu familiar from other MS Windows applications. Printing to a file or a config-
urable printer with selectable page numbers is possible. For details use the context-
sensitive help.
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To control the appearance of the hardcopy, use the "Print Preview" option.

Print Preview
Show a preview of the hardcopy to be created.

offline/online
The map view can either work in offline or online mode. For online mode, an internet
connection has to be available. If online mode is enabled, the map tries to download
detailed map tiles according to current zoom level. Depending on the mode set, menu
entry is switched to visualize current mode.
If your internet connection is behind a proxy, the map view automatically prompts you
to set your proxy authentication, see Figure 4-242.
Your settings are stored for further use, your password is stored encrypted.
If the DQA tester is loaded for a measurement, the map view is automatically switched
to offline to avoid the maps download measuring as additional load. After the end of
the measurement, the online state is automatically restored.

4.3.3.7  Indoor floorplan manager

Indoor Floorplan Manager manages to set of the user’s indoor floorplan maps. The
manager can handle both geo-referenced and non-georeferenced indoor floorplans.

To open the manager's dialog, click the  button in the toolbar of the view or use the
 button, "Import" > "Add Indoor Floorplans" command.

Figure 4-269: Indoor Floor Plan dialog
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The following table shows the formats the Indoor Floorplan Manager can read.
Table 4-8: File formats supported by the Indoor Floorplan Manager

Extension Type Remark

tab Georeferenced, Non-
Georeferenced

TAB file with image file

A TAB file has for unit either meter or degree. For
georeferenced maps, unit degree is used. For non-
georeferenced ones unit meter is used.

Georeferenced maps do not have to have the
north direction port to the top of the image. During
the import process, the image is rotated accord-
ingly and saved as <image>_ref.<ext> and
<tabfilename>_ref.tab.

When loading a TAB file, R&S ROMES4 checks
for the _ref tag in the file name. If the file name
contains this tag, it is assumed that the tab is
georeferenced. If it is not found, R&S ROMES4
looks for the according file in the same folder. If it
finds this TAB file, it loads the _ref tab file instead
of the originally defined file.

jpg, tif, bmp, png Non-Georeferenced A simple image which is imported as non-georefer-
enced map.

GeoPdf Georeferenced A GeoPdf can consist of one or more map layers,
those layers can be raster and vector types.

ibwc Georeferenced, Non-
Georeferenced

The IBWC files created from an iBWave project
are loaded into the Indoor Floorplan Manager. For
details on loading TAB files, refer to the "tab" row
of this table.

The names of the map layers are entered as in the
"Image" column.

dxf Non-Georeferenced R&S ROMES4 supports the AutoCAD format DXF.
This support allows user to import such AutoCAD
files into R&S ROMES4 and use them for indoor
measurements.

Indoor floor plan dialog

The "Indoor Floor Plan" dialog shows the list of added indoor floorplan maps.
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Figure 4-270: Added images in the indoor floor plan

● "Level"
Defines the level of a floor. The level can be a negative number. Default is 0.

● "Image"
Floorplan name of a layer.

● "TAB"
Associated TAB format file.

● "Geo-Ref"
The layer is geo-referenced or not; you can change this parameter.

● "Parent"
Container of a layer if applicable (for example, an IBWC file's name).

The following buttons are located at the bottom of the dialog:
● "Add"

Lets you add TAB, AutoCAD or image map file in the "Indoor Floor Plan" dialog's
list.

● "Remove"
Removes the currently selected map.

● "Remove All"
Removes all maps in the list.

● "Up/Down"
Shifts the selection of maps one layer up/down. The arrow in the "Level" field lets
you the maps ordering as well.

● "Reverse"
Reverses the order of the maps. The last map becomes the first and vice versa.
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● "Geo-Ref"
Creates geo-referencing floorplan map from the selected images in the list and
loads the map in the "Floorplanmap" area which is at the time related to active
"ROMESMAP Route Track View" map area.

Figure 4-271: Loaded map into the floorplanmap area

● Quality settings drop-box
The quality settings applied to raster maps first time the maps are imported as TAB
files and after the first import. You can choose between the auto-quality (default),
high, middle and low quality.
The better is the quality, the longer the processing time for the first import is. If the
auto-quality is selected, R&S ROMES4 adapts the quality depending on the size of
the raster image file.
Typical processing times for a 12 MB raster image on an i5 processor are shown in
the following figure.

● "Load"
Lets you load the ROMES Floor Plan Set or IBWC (ibWave) files into the "Indoor
Floor Plan" dialog.

● "Save"
Saves the current set of maps.

● "OK"
Press the button to confirm the configuration. R&S ROMES4 loads then all the
added layers to the "ROMESMAP Route Track View" and deletes all the removed
layers from the actual view. If only non-georeferenced maps were loaded, R&S
ROMES4 switches the geographic maps automatically off.

The indoor floorplan maps are associated with the workspace. Thus, they are also
associated with each measurement, as each measurement file contains the current
workspace. By changing the workspace, the "Indoor Floor Plan" resets and the all
indoor floorplans are removed from the "ROMESMAP Route Track View".
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The workspace of a measurement file has to be loaded if you want to replay an indoor
measurement and get the floorplans of that measurement file.

If more than one file has to be imported, the files are imported in parallel.

Handling of georeferenced floorplans

To create correct georeferenced floorplan:

1. Select a floorplan in the list of the "Indoor Floor Plan" dialog.

2. Click the "Geo-Ref" button.

The loaded floorplan image is displayed in the "Floorplanmap" pane of the dialog,
see Figure 4-271.

The toolbar with the functional buttons is associated to the pane.

Table 4-9: Floorplanmap toolbar buttons

1 2 3 4 5 6 7 8 9

ZoomOut ZoomIn Home Center
floorplan

Floorplan
select
mode

Floorplan
connec-

tion mode

Remove
connec-

tion

Create
geo-refer-

encing
floorplan

Proper-
ties

Using "ZoomOut"/"ZoomIn" or mouse wheel you can increase/decrease the displayed
floorplan image.

Floorplan select mode
The "Floorplan select mode" function (the button 5 in the Table 4-9) is by default active.
Use this mode to resize and move a floorplan. You have to set-up the floorplan position
for geo-referencing first.
How to move the floorplan map: Move mouse over the map, click and hold left mouse
button, move the mouse to pan the map. Zoom-in/-out the map to the area that your
floorplan building belongs to.

Center floorplan
Click the "Center floorplan" button (the button 4 in the Table 4-9) to center the floorplan
image in the visible floorplanmap area you adjusted in the previous action.
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Figure 4-272: Centered floorplan image in the map area

Zoom-out the map with button or mouse wheel to get an overview.
While moving the mouse over the floorplan, cursor is shown as a white cross with
arrows. If you move the mouse over a floorplan image edge, the cursor changes to
black cross.
To resize the floorplan, hold the left mouse button. Resizing is limited to default minimal
floorplan size.

Figure 4-273: Floorplan resized and centrally positioned
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Floorplan connection mode
This function (the button 6 in Table 4-9) lets you position the floorplan at the map and
floorplan building.
Click and hold left mouse button, move the mouse to move the floorplan to a position
near the map building. Resize the floorplan and/or zoom-in the map to get a view
where both buildings (the floorplan and the map building) are visible. If floorplan posi-
tion matches your needs, activate floorplan connection mode.

Figure 4-274: Floorplan positioned according to building position

In "Floorplan connection mode" cursor is shown as an arrow along with a plus sign.
1. Connect four floorplan reference points with corresponding map reference points.
2. Move the mouse over a floorplan reference point.
3. Set a marker with left mouse button click.
4. Move mouse over the corresponding map reference point and with left mouse button
click again.
5. The marker is set and the connection line is displayed.
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Figure 4-275: Connection lines bind floorplan with building in map

After the fourth connection line is set, mouse cursor changes. The "Create geo-refer-
enced floorplan" button (the button 8 in the table) is activated.
If you want to fine-tune the connection point position, move the mouse over a connec-
tion point marker. Then, click and hold left mouse button and move the mouse to
change the position. Use "Remove connection" toolbar button to remove the last con-
nection line.

Create geo-referenced floorplan
The "Create geo-referenced floorplan" function starts the geo-referencing. The new
geo-referenced floorplan is displayed in the "Floorplanmap" pane after referencing is
finished.

Figure 4-276: Created new geo-referenced floorplan

The "TAB" entry from the floorplan list is set to the new created floorplan TAB filename.
Also the "Geo-Ref" check box is marked.
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To verify geo-referencing, you can set the floorplan transparency. For the transparency,
move mouse over the floorplan, right click to open a context menu and select "Proper-
ties" to get the properties dialog. Instead click the "Properties" toolbar button.

Figure 4-277: Properties dialog

For transparency, enter the value between 0 and 255 (255 means opaque) in the
"Transparency" combo-box.
Click "OK" to close the dialog. The new geo-referenced floorplan is added to the base-
map, exactly positioned over the basemap building.
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Figure 4-278: Adjusted building position

By default, floorplans are displayed opaque, as the following screenshot shows.

Figure 4-279: Opaque display of floorplan

The right mouse button click on any point in the floorplan opens a context menu. The
context menu lets you select "Transparency" to set floorplan transparency within the
"ROMESMAP Route Track View" area.
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Figure 4-280: Transparency display of floorplan

Handling of GeoPdf map files for indoor floor plan

R&S ROMES4 supports GeoPdf format map files in indoor import.

To add a GeoPdf map to an indoor floor plan:

1. Click the "Add" button in the"Indoor Floor Plan" dialog.

The "Load Indoor Floor Plan" dialog opens.

2. Open the file type drop-down list in this dialog to select the "GeoPdf" file type.
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Figure 4-281: Selection of the map file type

The list of GeoPdf files is displayed.

3. Select the file from the list.
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4. Click "Open" to add the GeoPdf map file to the import list. Multi-selection is suppor-
ted.

The selection is added to the "Indoor Floor Plan" list.

Figure 4-282: Added GeoPdf map file
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5. Click "OK" to start import.

The import runs. As long as an import is running, displayed is the blue progress bar
in the StatusBar, placed left to position info.

Figure 4-283: GeoPdf map file is importing

Depending on count of layers and complexity of map, importing a GeoPdf could be
time consuming.

After import finishes, the GeoPdf map is displayed.

Figure 4-284: GeoPdf map imported and displayed

To handle a GeoPdf as an indoor floorplan, ROMESMAP import renders all layers into
one single GeoTiff. After finished import, the GeoTiff file is added to "ROMESMAP
RouteTrack View".
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Along to the GeoTiff, an additional corresponding MapInfo TAB file is created. Storing
an Indoor measurement file does not add the original GeoPdf file but the GeoTiff and
TAB files.

Handling of IBWC files for indoor floor plan

IBWC files are created from an iBwave project where the measurements are reimpor-
ted. Other floorplans are not added to this IBWC floorplan, as not needed. Therefore,
loading an IBWC file is done via the "Load" button in the "Indoor Floor Plan [IBWC]"
dialog.

IBWC files can be saved using the "Save" button. Saving the files is possible if an
IBWC file was loaded before.

If an IBWC file was imported (and edited), a link to this file is saved into the workspace
file as well.

The following two features are introduced to support loading R&S ROMES4 measure-
ments into Actix:

● The original (unchanged) IBWC input is stored in the SQC file root directory with
the suffix .origibwc if an indoor measurement based on an IBWC file is per-
formed in R&S ROMES4.

● The patched IBWC file intended for the usage in Actix is stored in the Asset direc-
tory.
The file patching includes the following:
– 1) Collection name is used as the input in the "Indoor Floor Plan" dialog,

instead of formerly used mapset name ROMES_Floorplan_[ibwc filename].
– 2) Building name is used as the input in the dialog, instead of one provided

automatically.
– 3) Layout names are entered as in the dialog (the "Image" column), instead of

ones provided automatically as, example given, Floorplan1, Floorplan2.
– 4) Level entered in the "Level" column can be input, instead of one provided

automatically and starting with 0. The values in the column are used for the lev-
els ordering.
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Figure 4-285: Loaded IBWC floor plan map

For the level editing, there are some helpers:

● "Lowest Level at"
Defines the level of the lowest floor. The level can be a negative number. Default is
0.

● "Reverse"
Used to reverse the values of the level column only.

● "Rename Collection and Building"
Used to change names of collections and buildings.

The buttons "Up" and "Down" visible in the "Indoor FloorPlan" dialog are removed in
this IBWC dialog since ordering is done via "Level".

These functions are only available, if an IBWC floor plan map has been loaded. Other-
wise, the dialog looks like Figure 4-270.

Support of AutoCAD format DXF

Indoor measurements with DXF files are always non-georeferenced, and cannot be
georeferenced later.

Only single DXF files are supported. The DXF master files, which include links to other
DXF files are supported.
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DWG file can be converted to a DXF file by using some tools, like, for example, the
Teigha®File Converter (free) tool. Ensure that the output file format is ASCII DXF.

Figure 4-286: Converting DXF file format to DWG

The DXF file can be loaded like other indoor maps using the Indoor Floorplan Man-
ager.

Figure 4-287: Loading DXF file with Indoor Floorplan Manager

Floorplan multi-selection

In case you have several floorplans with identical dimensions, where each floorplan
represents different building levels, it is possible to create the geo-referencing for all at
once.

1. Press Ctrl – Key and select all floorplans for which you want to create identical
geo-referencing.

2. Click the "Geo-Ref" button.

In the "Floorplanmap" displayed is now the first floorplan from your multi-selection.
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Figure 4-288: Selection of several floorplans

3. Resize and move that floorplan.

4. Click the "Floorplan connection mode" toolbar button.

5. Set the four connections.

6. Click "Create geo-referennced floorplan".

For all selected floorplans, the corresponding *.tab file is created. The floorplan
listbox shows TAB name entry for all selected floorplans and the corresponding
"Geo-Ref" check-boxes are marked.

Figure 4-289: Display of multi-selected floorplans

Click "OK" to add all floorplans on the basemap. All floorplans are now located on
same position with same dimension.
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Figure 4-290: Mapinfo map for multi-selected floorplans

The floorplan "Properties" dialog is now filled with the building data what is visible if
you click the "Properties" toolbar button.

Figure 4-291: Geo-referenced floorplan

To move the loaded floorplan to a known map position, edit the coordinate fields. For
coordinates refer to Figure 4-277.

To set the floorplan transparency, enter a value between 0 and 255. The floorplan
"Properties" dialog can be opened by floorplan context menu if you click right mouse
button.
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Figure 4-292: Option to get the properties dialog

Indoormap image at the home location

An unreferenced indoor floor plan image is loaded according to the current map center
and scale.

If the map scale is higher than 2000 m, the geographic image width and height are cal-
culated depending on image resolution - 1 pixel (width and height) equates 1 m.

The following screenshots show the indoormap floor plan images when the map scale
in the "ROMESMAP Route Track View" changes from 8000 m to 180 m.

An image of resolution 4844x4871 is imported in the "Indoor Floor Plans" at the map
scale set to 8000 m first.
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Figure 4-293: Map scale set to 8000 m

The first import result is the image of geographic width 4844 m and geographic height
4871 m.

Figure 4-294: Image with the map scale set to 8000 m

The second import of the same image (resolution 4844x4871) in the "Indoor Floor
Plans" is done with the map scale set to 180 m.
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Figure 4-295: Map scale set to 180 m

Figure 4-296: Image with the map scale set to 180 m

The second import result is the image of geographic width 360 m and geographic
height 364 m.

Indoor measurement

To zoom in a specific indoor layer, double click the appropriate layer in the indoor mea-
surement dialog.

If the waypoints (WP) are editing during a measurement, the corresponding R&S
ROMES4 signal lines are adapted on the fly in the "ROMESMAP Route Track View".

Navigation views



Display and evaluation of resultsDrive Test Software

655Operating Manual 1171.6415.12 ─ 66

Figure 4-297: Indoor waypoints

Hide waypoint layer

The indoor waypoint layers are displayed by default in the "ROMESMAP Route Track
View".

Click the  icon's arrow to open the pop-up menu where you can select the option to
hide the indoor waypoint layers.

In the displayed pop-up menu check the "Hide Waypoint Layer"context sensitive menu
to make the indoor waypoint layers invisible.
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Figure 4-298: Hidden indoor waypoints

Fixed size waypoint

The waypoint size does not change while zoom in/out if the "Fixed size Waypoint" con-
text sensitive menu is checked-in in previously mentioned pop-up menu.

If "Fixed size Waypoint" is unchecked, the waypoint size changes according to current
zoom level.

The following TETRA report example shows the indoor plan layout dependent on acti-
vation/deactivation of the mentioned context menu.

Figure 4-299: Waypoints size fixed or adaptive

Hide waypoint label

The indoor waypoint labels are displayed by default in the "ROMESMAP Route Track
View".
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To make the indoor waypoint labels invisible, select the "Hide Waypoint Label" entry of
the "Indoor Layer menu". The menu's entries are visible if you click the arrow of the 
icon.

Figure 4-300: Hiding waypoints label

4.3.3.8  Screenshot wizard

The Screenshot Wizard allows an automated screenshot export of a content added in
the "ROMESMAP Route Track View".

To open the wizard press  located in the "ROMESMAP Route Track View" icon bar.

The icon is available in the icon bar if at least one signal has been added to the
"ROMESMAP Route Track View".

The wizard allows the screenshots of the measurements to generate for each signal
and floorplan.

"Export Underlay Layer" option is checked by default. To create an export without
underlay layer, uncheck this box.

If you want to create screenshots only for the floorplans on which at least one waypoint
has been set, check the "Export only Layers which ..." option.

The resolution of the map on the currently visible screen is displayed. With "Target
Pixel Width", you can create a high resolution of the image on the screen. It defines the
width of the resulting exported image. The width can be used as a target width by
pressing the arrow button.

If this value is higher than the currently visible screen, the export tries to generate the
high-resolution screenshot using the following steps.

1. Internally, the view is extended to meet the requested number of pixels for the tar-
get width.

This extension leads to a greater geographic area that is covered by this internal
view, as the zoom level still is the same.

2. In a second step the zoom level is adapted.

In this way, the originally visible geographic area fits as good as possible into the
significant internal view.
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It is possible to suppress the color scale in the Legend during the export. Check the
"Legend does not show Color Ranges" box to activate this option. The Legend of the
screenshot displays also the floorname.

Further, specify the output folder and the output file name.

The output file name can be any combination of text and the following parameters:
● "%FILE%" File name of the measurement file
● "%FLOOR%" Name of the floorplan
● "%SIGNAL%" Name of the visible R&S ROMES4 signal
● "%DEVICE%" Name of the device which reported the R&S ROMES4 signal

Figure 4-301: Configuration of screenshots for export

Errors that can occur due to creation of a high-resolution image

● If not enough RAM is available to extend the view to the requested size, the export
tries to achieve half of the requested size.

● If the current zoom level is already at the maximum so that step 2. Cannot zoom in
anymore, the output is an image with the requested resolution, but the covered
geographic area is more than the visible one.

After finishing the export process, each occurred error is reported.

4.3.3.9  Map theme creation wizard

To create a map theme, select the "Create new map theme" command in the context
sensitive menu which is opened when clicking the  icon.
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The "MapView Map Theme Creation Wizard" window opens guiding you through the
steps needed for creating basemaps.

Figure 4-302: Welcome to the Map creation wizard window

Three different kinds of basemap creation are offered in this window.
● "Web Map Service (WMS)"
● "A single image showing the whole world"
● "Online map providing indexed tiles (e.g. Open Street Map)"

Creating WMS-based map theme

There are many free-to-use WMS servers available, offering different kind of maps.
MapView is able to connect to any WMS server following the WMS specification
described by the OGC, see http://www.opengeospatial.org/standards/wms.

The creation of a basemap connecting to a Landsat7 WSM server is explained here.

A list of free/commercial WMS servers can be found in
http://mapmatters.org/search/.

1. Open this site in Internet Explorer.

2. Enter “Landsat7” into the search field to get a list of WMS servers offering satellite
images collected by the Landsat7 program
(http://landsat.gsfc.nasa.gov/about/landsat7.html).

3. Select one of the listed servers.
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The “Overview” site opens, copy the WMS server Url listed on top of the overview
site.

4. From the map menu, open the "MapView Map Theme Creation Wizard".

Figure 4-303: Inserting a custom server URL

The "Web Map Service (WMS)" basemap option is selected by default. Click the
"Next" button and use CTRL-V to copy the WMS server Url into the Url field. Click
the "Next" button.

5. The "Available Maps" window opens.

The maps offered by this WMS server are displayed in a list.

6. Scroll down to select Landsat7 from the list.
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Figure 4-304: List of available maps

Click the "Next" button.

7. The "General Information" window displays the map title, map name and a preview
image downloaded from the server.

Figure 4-305: General Information window
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Click the "Next" button.

8. Now, activate the coordinate grid layer for the new basemap. Select the "Coordi-
nate Grid" check-box.

Figure 4-306: Coordinate grid setting

Click the "Next" button.

9. The "Summary" window displays all basemap information.
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Figure 4-307: WMS creation finished

You can click the "Preview Map" to see a preview of the new basemap.
Click "Finish" to finalize map theme creation.

The new basemap will be listed in the basemap pop-up menu "Load Map" after the
MapView restart.

4.3.3.10  GSM layer configuration

The submenu of the "GSM Layer" command in the "ROMESMAP Route Track View"
context menu provides display settings for base stations and GSM signals.

Figure 4-308: GSM layer submenu

● "Configuration"
Opens the technology layer dialog to set the display options. It contains the follow-
ing tabs:
– "BTS Symbols"
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The BTS size controls can be found within the "BTS Symbols" page, see
"ROMESMAP route track view configuration: Bts symbols tab" on page 601.

– "Scanner Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Scanner
Layers" tab, see "LTE RTM Bts layer configuration: scanner layers"
on page 669.

– "Mobile Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Mobile Lay-
ers" tab, see "LTE RTM Bts layer configuration: mobile layers" on page 672.

– "C/I Analysis Layers"
The tab is the part of the "ROMESMAP GSM RTM BTS Layer" page, see Fig-
ure 4-310.

– Info
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Info" tab,
see "LTE RTM Bts layer information: info" on page 674.

● "Show/Hide..."
You can select specified layer to be displayed or hidden in the map view.

● "Mobile: Select Mobile"
Specifies of which mobile the route underlay is displayed.
The function has two options as shown in the following figure:
– Automatic selection by selected signal
– Change to automatic selection when a signal of a mobile from the list was

selected

Figure 4-309: Selected mobile for display in map view

If no option is checked, one mobile is selected. The route underlay of that mobile is
displayed all the time, no matter which signal/mobile is selected at the top of the
Route Track view.
If "Automatic Selection by Selected Signal" is selected, it is not possible to select a
mobile with that function. The route underlay is in this case specified by the
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selected signal and the selected mobile on top of the Route Track view. It must be
a GSM signal and a mobile that stays on GSM to show the belonging route under-
lay for GSM of that mobile.
If "Change to Automatic Selection when a Signal of a Mobile..." is selected, the
route underlay of the selected mobile is displayed all the time up to that moment
when another signal of the mobiles from the list is selected. Then the function
switches back to automatic selection.

● "Scanner: Select TopN Pool"
Lets select a scanner Top N pool from the list which route underlay is displayed.

ROMESMAP GSM RTM Bts layer: C/I analysis layers

The "C/I Analysis Layers" tab shows configuration settings for display setting of C/I
analysis layers data and the order of the corresponding layers.

Figure 4-310: GSM RTM Bts Layer

● "General"
Shows the C/I measured data if the "Display C/I Data" check box is ticked.
For data display, the analysis layer uses the line width and the colors of serving cell
and interferers selected below. Used are lines to serving cell and interferers, serv-
ing cell and interferers highlightings.

● "Display C/I event route underlay"
Activate or deactivate the displaying of the C/I event route as underlay. If activated,
define the C/I event route underlay line width and color via "Underlay line width"
and "Route underlay color", respectively.

● "Display lines to serving cell and interferers"
Draw line of selected width for measured serving cell signal and interferers via
"Line width".

● Serving cell and interferers highlighting
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Define the color to mark the serving cell signal and interferers.

Use only sorted Top N pools for the "ROMESMAP Route Track View".

4.3.3.11  TETRA layer configuration

The TETRA technology-specific extension of the "ROMESMAP Route Track View"
shows following information:
● Transmitters of the currently loaded TETRA database
● Route underlay and lines to best server in the color of the carrier of the currently

best server of the selected Top N pool
● For scanner Top N pools: best server symbols (Top1)
● Highlight serving cell and the neighbor cell

The submenu of the "TETRA Layer" command in the "ROMESMAP Route Track View"
context menu provides display settings for base stations and TETRA signals. For the
menu entries, refer to the LTE Layer Configuration chapter.

Figure 4-311: TETRA layer submenu

● "Configuration"
Opens the technology layer dialog to set the display options. It contains following
tabs:
– "BTS Symbols"

The BTS size controls can be found within the "BTS Symbols" page, see
"ROMESMAP route track view configuration: Bts symbols tab" on page 601.

– "Scanner Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Scanner
Layers" tab, see "LTE RTM Bts layer configuration: scanner layers"
on page 669

– "Mobile Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Mobile Lay-
ers" tab, see "LTE RTM Bts layer configuration: mobile layers" on page 672.

– "Info"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Info" tab,
see "LTE RTM Bts layer information: info" on page 674.

● "Show/Hide..."
You can select specified layer to be displayed or hidden in the map view.
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● "Mobile: Select Mobile"
Specifies of which mobile the route underlay is displayed, for more see Mobile:
Select Mobile

● "Scanner: Select TopN Pool"
Lets select a scanner Top N pool from the list which route underlay is displayed.

Use only sorted Top N pools for the "ROMESMAP Route Track View".

Correct server lines for TETRA route track

The recognition of the TETRA base station is based on decoding LA and MCC signals
in the R&S ROMES4 version 18.0 and higher. This approach assures the correct
server lines.

The former approach to use MCCH for this purpose is abandoned. The TETRA net-
work can change MCCH dynamically so that after a while server lines partly miss.

4.3.3.12  LTE layer configuration

The LTE technology extension of the "ROMESMAP Route Track View" shows the fol-
lowing information:
● Symbols of LTE BTS
● Route underlay and lines to best server in the color of the cell ID
● For scanner Top N pools:

– Scanner data
– Best server symbols (Top1)
– Next best server symbols (Top2 to Top6)

● For the LTE mobiles:
– Mobile device data
– Labels for a serving cell (for example, the cell name and ID)
– Labels for the neighbor cells (for up to 12 cells, cell name and ID)

The submenu of the "LTE Layer" command in the "ROMESMAP Route Track View"
context menu displays settings for base stations, LTE and LTE NB-IoT signals.

Figure 4-312: LTE layer submenu
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A valid base station list must be imported and the BTS data base created before any
configurations can be made. These actions are done in "Tools" > "Transmitter Data-
base" > "Base station", see Chapter 3.8.5, "Transmitter database", on page 384.

● "Configuration"
Opens the "ROMESMAP LTE RTM Bts Layer" dialog to set the following display
options.
– "BTS Symbols"
– "LTE Scanner Layers"
– "NB-IoT Scanner Layers"
– "Mobile Layers"
– "Info"

● "Hide /Show ..."
You can select a layer to be displayed or hidden in the map view. This selection is
valid for the following layers:
– LTE mobile layers
– LTE scanner layers
– NB-IoT scanner layers

● "Scanner..."
You can select the scanner Top N pool from the list of route underlay which is dis-
played. The scanners whose Top N pools that can be selected are:
– LTE scanner
– NB-IoT scanner

Use the "NB-IoT Scanner: Select TopN Pool" entry to open the "Select NB-IoT
Scanner Top N Pool" dialog.

Use only sorted Top N pools for the "ROMESMAP Route Track View".

LTE RTM Bts layer configuration: BTS symbols

The "BTS Symbols" tab dialog provides information on BTS size control and BTS color
configuration.
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The tab is analogous for all technologies.

Figure 4-313: LTE RTM BTS Layer Configuration - BTS Symbols

The "BTS Symbol" page is technology independent:

● "The BTS size controls can be found ..."
For information about the BTS size control, see "ROMESMAP route track view
configuration: Bts symbols tab" on page 601.

● "BTS color configuration in the Network Provider Database"
Defines which color to use. The coloring depends on the network provider data-
base, see Chapter 3.8.6, "Network provider database", on page 403. The database
is searched for MCC and MNC and the returned color is used.
All base stations (BTS) from other networks get the default color.

LTE RTM Bts layer configuration: scanner layers

The "LTE Scanner Layers" dialog lets you set the parameters of LTE scanner data dis-
play and the order of the corresponding layers. The dialog layout and the meaning of
the dialog's parameters is common for all supported RATs.
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Figure 4-314: LTE RTM BTS Layer Configuration - Scanner Layers

● "LTE - General"
If "Display scanner data" is marked, the scanner data in the "LTE - Best server dis-
play" pane is displayed.

● "LTE - Best server display"
Defines the display option for the best server information.
– "Route underlay"

Activates/deactivates display of the best server route as underlay. If activated,
you can select the width of the underlay line.

– "Display lines to best server"
Draws lines between the measurement position and the active sector (best
server). Define the line repetition distance (in meters, default 200m), the line
width and the best server line transparency (in %, default 80%). Here you can
continuously change the values of the mentioned parameters.

– "Highlight (mark) ..."
Lets you select the color for the best server (1st Top N element) and the sec-
ond best server (2nd Top N element) if the check-boxes are marked.

The following screenshot shows the best server lines display in the ROMESMAP
dependent on the values set for the "Line repetition distance [m]" and "Best server line
transparency" parameters. The sample signal is Top N EARFCN.

The first parameter determines the distance between server lines. More lines are
drowned for smaller distance. A change is shown if you click the "OK" button in the dia-
log. The "Best server line transparency" allows the line transparency to change. The
total transparency is 100%, while invisible and 0% transparency is opaque.
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Figure 4-315: Three cases of the best server lines display - scanner layer

The "server lines Transparency" and "server lines Repetition Distance" buttons in the
"ROMERSMAP Rroute Track View" icon bar let you quick change the values of these
parameters. Possible values are displayed if clicked the left-mouse button.

Figure 4-316: Server line transparency and distance repetition buttons
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Display lines to best server during replay mode
To display lines to best server during replay of a measurement file, the BTS database
has to be loaded together with the measurement file before file scan was performed.
Loading the BTS database afterwards is possible. However, the loading has no effect
on drawing the lines to the best server for the currently open and scanned measure-
ment file. Thus, reopen the measurement file together with the BTS database to see
the lines to the best server during replay.

LTE RTM Bts layer configuration: NB-IoT scanner layers

For the description of the entries in this dialog, see the previous chapter.

Figure 4-317: RTM BTS Layer Configuration - NB-IoT Scanner Layers

LTE RTM Bts layer configuration: mobile layers

The "Mobile Layers" dialog lets you set the parameters of a mobile device data display
and the order of the corresponding layers.

If "General" > "Display mobile data" is marked, the mobile data selected in the "Best
server display" pane is displayed.

For the further explanation of the dialog parameters, see "LTE RTM Bts layer configu-
ration: scanner layers" on page 669.
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Figure 4-318: RTM BTS Layer Configuration - Mobile Layers

The following screenshot shows the best server lines display in the ROMESMAP
dependent on the values set for the "Line repetition distance [m]" and "Best server line
transparency" parameters for mobile data. The sample signal is RSRP.
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Figure 4-319: Three cases of the best server lines display - mobile layer

Display lines to best server during replay mode
See the Note in the "LTE RTM Bts layer configuration: scanner layers" on page 669.

LTE RTM Bts layer information: info

The "Info" page is divided into two parts.

The upper "Module Properties" part allows a user-defined name of the technology to
set. The "Custom Name" field has no function in a view context. It is only useful in the
devices context, where connected devices can be associated with different custom
names. The field is assigned to separate mobiles in different networks or when simulta-
neously operated mobiles perform different tasks.

The lower "File Version" part shows the file information on the dynamic link library
properties which are implemented in the selected technology.
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4.3.3.13  5G NR layer configuration

Figure 4-320: 5GNR layer submenu

The 5G NR technology extension of the "ROMESMAP Route Track View" shows the
following information:
● Symbols of 5GNR BTS
● Scanner layers
● Mobile layers
● Info, which is common for all RATs

5G NR RTM Bts layer configuration: scanner layers

The following configuration options for display of the scanner Top N pools data and the
order of the corresponding layers are available.
● Scanner data display
● Best server display configuration:

– Separate best server PCI and best server SSB route underlays
– Color server lines to best server PCI or to best server SSB index
– Symbols of best server and the next best server (Top1 and Top2)
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Figure 4-321: 5GNR layers configuration - scanner layers

The result of the configuration gives a "ROMESMAP Route Track View" like the follow-
ing one.

Figure 4-322: ROMESMAP route track view - 5G NR scanner
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5G NR RTM Bts layer configuration: mobile layers

The following configuration options for display of a 5G NR mobile device data and the
order of the corresponding layers are available:
● Mobile data display
● Best server display configuration:

– Separate best server PCI and best server SSB route underlays
– Color server lines to best server PCI or to best server SSB index
– Symbols of best server and the next best server (serving cell and neighbors)

Figure 4-323: 5GNR layers configuration - mobile layers

4.3.3.14  CDMA2000 1xEV-DO layer configuration

The CDMA technology-specific extension of the "ROMESMAP Route Track View"
shows following information:

● Symbols for CDMA BTS,
● Route underlay and lines to best server in the color of the PN offset
● For the scanner TopN pools:

– Best server symbols (Top1)
– Next best server symbols (Top2 to Top6)

● For the Mobiles CDMA2000 or EVDO
– Best server symbols (Active Set A1 to A6)
– Next best server symbols (Candidate Set C1 to C6 and Neighbour Set N1 to

N9)
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The submenu of the "CDMA Layer" command in the "ROMESMAP Route Track View"
context menu provides display settings for base stations and CDMA2000 & 1xEV-DO
signals.

Figure 4-324: CDMA2000 1xEV-DO layer submenu

● "Configuration"
Opens the technology layer dialog to set the display options. It contains following
tabs:
– "BTS Symbols"

The BTS size controls can be found within the "BTS Symbols" page, see
"ROMESMAP route track view configuration: Bts symbols tab" on page 601.

– "Scanner Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Scanner
Layers" tab, see "LTE RTM Bts layer configuration: scanner layers"
on page 669

– "Mobile Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Mobile Lay-
ers" tab, see "LTE RTM Bts layer configuration: mobile layers" on page 672.

– "Info"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Info" tab,
see "LTE RTM Bts layer information: info" on page 674.

● "Show/Hide..."
You can select specified layer to be displayed or hidden in the map view.

● "Mobile: Select Mobile"
Specifies of which mobile the route underlay is displayed, for more see Mobile:
Select Mobile

● "Scanner: Select TopN Pool"
Lets select a scanner Top N pool from the list which route underlay is displayed.

Use only sorted Top N pools for the "ROMESMAP Route Track View".
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4.3.3.15  UMTS layer configuration

The submenu of the "UMTS Layer" command in the "ROMESMAP Route Track View"
context menu provides display settings for base stations, UMTS signals and UMTS
scanner Top N data, see the following figure.

Figure 4-325: UMTS layer submenu

● "Configuration"
Opens the technology layer dialog to set the display options. It contains following
tabs:
– "BTS Symbols"

The BTS size controls can be found within the "BTS Symbols" page, see
"ROMESMAP route track view configuration: Bts symbols tab" on page 601.

– "Scanner Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Scanner
Layers" tab, see "LTE RTM Bts layer configuration: scanner layers"
on page 669

– "Mobile Layers"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Mobile Lay-
ers" tab, see "LTE RTM Bts layer configuration: mobile layers" on page 672.

– "Info"
The tab is analogous to the "ROMESMAP LTE RTM BTS Layer" > "Info" tab,
see "LTE RTM Bts layer information: info" on page 674.

● "Show/Hide..."
You can select specified layer to be displayed or hidden in the map view.

● "Mobile: Select Mobile"
Specifies of which mobile the route underlay is displayed, for more see Mobile:
Select Mobile

● "Scanner: Select TopN Pool"
Lets select a scanner Top N pool from the list which route underlay is displayed.

Use only sorted Top N pools for the "ROMESMAP Route Track View".
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4.3.3.16  Position estimator layer configuration

Click the "Position Estimator > Configuration" command in the "ROMESMAP Route
Track View" context menu to open the "BTS Symbol" page.

The "BTS Symbol" page is technology independent, see "LTE RTM Bts layer configura-
tion: BTS symbols" on page 668. It provides the information about the BTS size control
and the BTS color configuration.

If a measurement with estimated BTS positions and a matching BTS database are loa-
ded in R&S ROMES4, many BTSs can be displayed twice, as:
● BTS symbol at the known position from the BTS database
● BTS symbol with estimated position (with error ellipsis)

If the position of the BTS is known from the database, the display of estimated BTS is
suppressed by default. This suppression makes the display much clearer.

However, sometimes it can be useful to have both displays for comparison and evalua-
tion. This option can be configured if selecting "BTS Symbol" > "Show estimated bts
data even if the position is known from the bts database". The setting is stored in the
registry as a user preference and needs a reload of the measurement file to show
effects.

However, sometimes it can be useful to have both displays for comparison and evalua-
tion. This option can be configured if selecting "Show estimated bts data even if the
position is known from the bts database", see the following figure. The setting is stored
in the registry as a user preference.
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Figure 4-326: Display estimated BTS data...

The estimated BTS positions and their error ellipses are shown in the Position Estima-
tor layer of the map online during the measurement. Later in replay, after loading the
file, the final status at the end of the measurement is shown.

As the estimator cannot detect the direction of a BTS sector or if it is directed at all, all
transmitters are visualized as omnidirectional.

Base stations and error ellipses can be hidden or shown per technology and / or esti-
mation progress by configuring the "Tec Feature Switch", see Chapter 4.3.3.2, "View
area", on page 566. There are three different progress states, visualized by different
colors of the error ellipses, as shown in the following table:
Table 4-10: Position estimation progress states

Estimation Error ellipse color

by Power red

in Progress yellow

Finished green

By default, only yellow and green ellipses and the related BTS symbols are shown.

The threshold for the "Finished" state depends on the configuration of the minimum
position error (estimation cutoff) in the PE settings, see Chapter 6.4.28.2, "Scanner
settings for the BTS position estimator", on page 1872.

In the following, the examples for estimated BTS positions and their error ellipses are
given.
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Example: Estimated BTSs and their error ellipses "by power" only
In this case the PE feature in the "Tec Feature Switch" is configured as shown in the
following figure.

Figure 4-327: PE configuration for estimation "by power" only

This state represents the worst quality and therefore the largest ellipses, and all BTSs
are displayed along the driven tour.

Figure 4-328: Estimated BTSs and their error ellipses "by power" only
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Example: Estimated BTSs and their error ellipses "in progress" only
In this case the PE feature option in the "Tec Feature Switch" is configured as shown in
the following figure.

Figure 4-329: PE configuration for estimation "in progress" only

Figure 4-330: Estimated BTSs and their error ellipses "in progress" only
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Example: Estimated BTSs and their error ellipses "finished" only
In this case the PE feature option in the "Tec Feature Switch" is configured as shown in
the following figure.

Figure 4-331: PE configuration for estimation "finished" only

Figure 4-332: Estimated BTSs and their error ellipses "finished" only

4.3.3.17  User specified variable resolution for power, quality and UE

It is possible to specify the limits of the ellipses displayed in the map view according to
the size of power, quality and equipment number.

A measurement value which is between its maximum and minimum value results in a
circle or ellipse, the radius of which is an interpolation between the user-defined maxi-
mum and minimum. The max. and min. values of the UE-emulation parameters (power,
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quality and count users) are set in the "Measurement Point Display Parameters" modal
dialog.

Click the  button in the scanner area to get the configuration dialog. This, so called
"wrench" button, is found in the UE emulation menu bar for GSM, UMTS and LTE
scanner.

The "Measurement Point Display Parameters" dialog is common for the mentioned UE-
emulation technologies.

Figure 4-333: UE emulation modal dialog

Click "OK" to set the limits for the UE-emulation parameters and store in the registry.
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Figure 4-334: Wrench button and the map layout

4.4  Mobile views

"Mobile Views" can be used to view different technologies data. Some of the views
evaluate processes that are independent of the technology, others show information
that is exchanged between different technologies to ensure interoperability (e.g. the
Layer 3 messages).

The views can be selected from a submenu displayed on the right-hand side of the
"View" menu when the mouse pauses over the "Mobile Views" command.
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Figure 4-335: Mobile views

Graphics library used for mobile views

R&S ROMES4 makes use of the third party graphics library BCGDPro version 27.3 in
order to support some 3GPP mobile views, for example, the LTE MIMO view, the LTE
CA view, the LTE Modulation view, the LTE CA DL/UL Performance Views, the Mobile
Serving Cell view.

Based on the BCGCPro version 27.3 the redrawn performances of the views during
replay and scanning are improved. By opening multiple of these views simultaneously,
the performance updates make R&S ROMES4 to perform better.
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● UMTS HSUPA views.............................................................................................688
● UMTS HSDPA views.............................................................................................714
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● 3GPP handover analyzer view..............................................................................898
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● Layer 3 view..........................................................................................................958
● LTE/5GNR RRM mobility analysis view................................................................ 990
● QualiPoc messages view......................................................................................998
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● UE capabilities view............................................................................................ 1023
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● UE modulation view............................................................................................ 1052

4.4.1  UMTS HSUPA views

The "UMTS HSUPA Views" display High Speed Uplink Packet Access (HSUPA)-spe-
cific information acquired with UMTS test mobiles supporting HSUPA or data cards
supporting HSUPA.

In general, recording of the different message types shown in the "UMTS Views" has to
be explicitly activated in the device configuration menu:

1. Enable UMTS HSUPA in the "Configuration" tab.

2. Select the HSUPA node in the "Expert Mode" tab.

R&S ROMES4 supports HSUPA test mobiles based on Qualcomm 7200 chipset-based
mobile or newer one.

The HSUPA views can be selected from a submenu displayed on the right side of the
"View" menu hovering the mouse cursor over "HSUPA".
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Figure 4-336: UMTS HSUPA views

The UMTS UE's view related to HSUPA ACK/NACK respects the general performance
settings done in "Tools" >"Preferences" > "Performance" regarding the visual update
rate. The individual view settings are avoided, see Chapter 4.4.1, "UMTS HSUPA
views", on page 688.

● UMTS HSUPA ACK/NACK view........................................................................... 689
● UMTS HSUPA cell status view..............................................................................690
● UMTS HSUPA DL channel configuration view......................................................693
● UMTS HSUPA HARQ view................................................................................... 697
● UMTS HSUPA L1/MAC statistic view....................................................................699
● UMTS HSUPA performance view......................................................................... 705
● UMTS HSUPA power graph view..........................................................................708
● UMTS HSUPA UL channel configuration view......................................................710

4.4.1.1  UMTS HSUPA ACK/NACK view

The "UMTS HSUPA ACK/NACK View" shows the used transport block sizes per TTI.
The Y-axis shows the TBS and the X-axis represents the TTIs.

Figure 4-337: UMTS HSUPA ACK/NACK View

The chart of the view supports zooming using the mouse wheel, and panning using the
left mouse button.

Mobile views



Display and evaluation of resultsDrive Test Software

690Operating Manual 1171.6415.12 ─ 66

Diagram

The view shows a bar graph with fixed scale. Each bar corresponds to a TTI value
reported by the mobile.

● A green bar denotes an acknowledged TTI
● A red bar denotes an unacknowledged TTI
● A yellow bar denotes a subframe that is not acknowledged but also not unacknowl-

edged: no answer was received from the mobile

Use the Chapter 4.4.1.2, "UMTS HSUPA cell status view", on page 690 to analyze the
cause for an unacknowledged or DTX frame.

Statistical results

Below the graph, the view shows the most important values per update cycle (Sam-
ples) in the diagram and the number of ACK, NACK, and DTX subframes. See the pre-
vious figure, ACK + NACK + DTX = Samples).

The arithmetic mean value of the displayed TBS values, the maximum, and the mini-
mum TBS values are displayed below.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSUPA ACK/NACK View" has no context menu for configuration.

4.4.1.2  UMTS HSUPA cell status view

The Cell Status views show the events per TTI. Each column reflects one TTI. The
background color corresponds to the Happy Bit (green = happy, red = unhappy, all
other colors = DTX).

It is important, that the DialuUp connection is established during the R&S ROMES4
measurement session, as the mobile needs the information about the evolved cell set
once. In the case, the DialUp connection is already established when the R&S
ROMES4 measurement is started. The information about the Radio Link Set (RLS) is
provided when the RLS changes and the mobile send a new trace due to changes.
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Figure 4-338: UMTS HSUPA Cell Status View

The first two rows show the result of the combination of the received HICH and RGCH.

● Combined HICH and RGCH................................................................................. 691
● Serving cell HICH, RGCH and AGCH...................................................................692
● RLS cell #<no.> HICH and RGCH........................................................................ 692
● Service parameters...............................................................................................692
● Context menu........................................................................................................693

Combined HICH and RGCH

Each row of the subdiagram shows one TTI. The chart contains the following results:

● Combined HICH
The first row shows the result of the combination of the received Hybrid ARQ Indi-
cator Channel (HICH).
The color of a square in the TTI data row shows the type of TTI data:
– Green → ACK
– Red → NACK
– Yellow → DTX
The background color of the column represents the Happy Bit.
– Light green Happy → Bit true
– Pink → Happy Bit false
– White → Happy Bit not set
This parameter shows whether the mobile is "happy". The mobile is considered
happy if it can transmit the currently available data within a certain time frame sig-
naled by an RRC message.

● Combined RGCH
The second row shows the result of the combination of the received Relative Grant
Channel (RGCH), where the color of the square indicates:
– Green → Up
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– Red → Down
– Yellow → Hold
– Gray → no RGCH received

Serving cell HICH, RGCH and AGCH

The subdiagram shows the same values and colors described for the Combined HICH
and RGCH on a cell basis, in this case for the serving cell (SC).

The chart contains the following results:
● "SC HICH"

The background and square colors are identical to those colors described for Com-
bined HICH.

● "SC RGCH"
The background and square colors are identical to those colors described for Com-
bined RGCH above.

● "SC AGCH"
This additional row shows the Absolute Grant channel (AGCH) values which were
transmitted in a certain TTI.

RLS cell #<no.> HICH and RGCH

The subdiagram shows the same values and colors described for the Combined HICH
and RGCH on a cell basis, in this case for a non-serving cell (NSC), where #<nr.>
could be #1, #2, or #3.

The chart contains the following results:
● "NSC #<nr.> HICH"

The background and square colors are identical to those colors described for
"Combined HICH".

● NSC #<nr.> RGCH
The background and square colors are identical to those colors described for
"Combined RGCH".

Service parameters

The last subdiagram shows additional parameters for the given TTIs.

The chart contains the following results:
● "DTX"

Discontinuous transmission (green = true, red = false)
● "PLD Limit"

Reason for the limitation of the throughput as described for the "Payload Limit" of
the "UMTS HSUPA Performance View". (P = Power Rate, S = Serving Grant limit,
B = Buffer Occupancy, M = MUX restricted, H = HARQ restricted).

● "# Retransmissions"
The number of retransmissions.

● "# MAC-d"
The number of Medium Access Control entities handling dedicated transport chan-
nels

Mobile views



Display and evaluation of resultsDrive Test Software

693Operating Manual 1171.6415.12 ─ 66

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSUPA Cell Status View" has no context menu for configurations
assigned.

4.4.1.3  UMTS HSUPA DL channel configuration view

The "UMTS HSUPA DL Channel Configuration View" shows the most important DL
parameters of the active HSUPA connections, which were transmitted in the corre-
sponding RRC messages. The power-offset table shows the basic information about
what is the transmit power calculation of the mobile based on. For detailed information,
refer to TS25.331 and TS25.212.

It is important, that the DialUp connection is established during the R&S ROMES4
measurement session, as the mobile needs the information about the evolved cell set
once. In the case, the DialUp connection is already established, when the R&S
ROMES4 measurement is started. The information about the Radio Link Set (RLS) is
provided when the RLS changes and the mobile send a new trace due to these
changes.

Figure 4-339: UMTS HSUPA DL Channel Configuration View

The channel configuration data is displayed in different panels.
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EUL channel configuration

The following EUL (Enhanced Uplink) channel information is displayed in the view:
● "TTI (DL→HSDPA)"

Transmission Time Interval for the E-DCH. The standard 3GPP TS 25.321 allows a
TTI of, e.g, 2 ms.

● "Serving Cell Index"
Serving cell index in the range 0 to 7.

AGCH

The following information is related to the Absolute Grant Channel (AGCH). This chan-
nel carries the absolute grants for uplink DCH scheduling.
● "AGCH Present"

Indicates the presence of the Absolute Grant Channel
● "AGCH Action"

Enabled or disabled
● "AGCH OVSF"

Orthogonal Variable Spreading Factor of the Absolute Grant Channel
● "AGCH Offset to DPCH"

The offset (in chips) between AGCH and the Dedicated Physical Channel
● "AGCH Start FN"

Frame number of the AGCH start frame
● "AGCH End FN"

Frame number of the AGCH end frame
● "AGCH STTD"

Space/Time Transmit Diversity scheme used for the AGCH

ERNTI

The following information is related to the primary and secondary Enhanced Radio Net-
work Temporary Identity (P-ERNTI and S-ERNTI).
● "P-ERNTI Present"

Indicates the presence of the primary ERNTI
● "P-ERNTI"

Primary ERNTI number
● "S-ERNTI Present"

Indicates the presence of the secondary ERNTI
● "S-ERNTI"

Secondary ERNTI number
● "SG Selection"

Indicates the use of the primary or secondary serving grant
● "Initial SG"

Identifier of the initial service grant
● "# of Cells"

Number of cells
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Radio link set

The "Radio Link Set" panel contains a table with information related to RLS and the rel-
ative grant channel:
● "RLS Idx"

Radio Link Set (RLS) index
● "DPCH"

DPCH channel
● "TPC"

TPC Index
● "Finger"

Reference Finger
● "RGCH present"

Relative Grant Channel (RGCH) is present (yes/no)
● "RGCH action"

RGCH action is enabled or disabled
● "RGCH SFN"

RGCH Start Frame Number (SFN)
● "RGCH EFN"

RGCH End Frame Number (EFN)
● "RGCH DPCH Offset"

Relative Grant Channel DPCH Offset
● "RGCH Sign."

Relative Grant Channel Signature
● "HICH present"

Hybrid Indicator Channel (HICH) is present (yes/no)
● "HICH action"

Hybrid Indicator Channel action is enabled or disabled
● "HICH SFN"

HICH Start Frame Number (SFN)
● "HICH EFN"

HICH End Frame Number (EFN)
● "HICH OVSF"

Orthogonal Variable Spreading Factor of the Hybrid Indicator Channel
● "HICH DPCH Offset"

Hybrid Indicator Channel DPCH Offset
● "HICH Sign."

Hybrid Indicator Channel signature
● "HICH STTD"

Hybrid Indicator Channel Space/Time Transmit Diversity scheme
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSUPA DL channel configuration view configuration

The "UMTS HSUPA DL Channel Configuration View" configuration menu defines the
list elements for the "Radio Link Set (RLS)" table and shows information on the current
view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-340: UMTS HSUPA DL Channel Configuration View - configuration
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The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.4.1.4  UMTS HSUPA HARQ view

The "UMTS HSDPA HARQ View" shows the characteristics of all HARQ processes of
the test mobile. The view shows a statistical evaluation of the received UL E-DCH
transport blocks, together with the block error rate and the number of retransmissions
needed to decode successfully the blocks of each size. The transport block size
depends on the allocated power for the mobile. Depending on TTI Duration up to 8 par-
allel HARQ processes can be active per mobile.

Figure 4-341: UMTS HSUPA HARQ View

Table

The Header of the table defines which of the HARQ Processes are displayed.
● HARQ Filter

Each Flag represents one HARQ process. For a TTI of 2 ms, the maximum number
is 8 and for a TTI of 10 ms the maximum number of HARQ processes is 4. Setting
of this flag displays or hides the specific HARQ process. By default the filter is dis-
abled and only the sum of all HARQ processes is displayed

● Select All
Click this button to set the flags for all HARQ processes.

● Select None
Click this button removes the flags for HARQ processes.

Each row reflects an E-TFCI and displays the following values:
● HARQ ID

Identifier of the HARQ process is displayed
"Sum" indicates the values, which are listed below, depending on the
Transport Block Size
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● ETFCI
Transport Format Combination Identifier for E-DCH

● TBS
Transport block size in bits

● %
Percentage of usage of E-TFCI

● SG
Average Serving Grant

● LUPR
Average Last Used Power Ration

● SB+
Number of successfully decoded subblocks. A subblock is a mobile specific unit
comprising the HS-DSCH data of one subframe.

● SB-
Number of subblocks which could not be decoded successfully has to be retrans-
mitted. These blocks contribute to the SBLER but not necessarily to the BLER; see
below.

● SBLER [%]
Subblock error rate, SBLER = SB– / (SB+ SB–).

● BL+
Number of successfully decoded blocks

● BL–
Number of blocks which could not be decoded successfully until the maximum
number of retransmissions was reached. Number of successfully decoded blocks

● BLER [%]
Block error rate, BLER = BL– / (BL+ BL–). The BLER is usually smaller than the
SBLER because it counts only the blocks that could not be decoded until the end
of the HARQ process (until the maximum number of retransmissions was reached).

● # [%]
Number of blocks successfully decoded without retransmission.

● # n [%]
Number of blocks successfully decoded after one initial transmission and (n–1)
retransmissions.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSUPA HARQ view configuration

The UMTS HSUPA HARQ View is configured via the "HSDPA Decode Statistic View"
configuration tab. You can select the HSUPA HARQ signals to be displayed from the
offered list.

The configuration tabs used to select signals to be displayed in the UMTS HSDPA
Decode Statistic View and the UMTS HSPA L2 Statistic View have the same name.
However, the offered signals in the "List Column" of these configuration tabs differ.

Figure 4-342: UMTS HSUPA HARQ View - configuration

4.4.1.5  UMTS HSUPA L1/MAC statistic view

The "UMTS HSUPA L1/MAC Statistic View" shows a configurable selection of the sta-
tistics parameters provided by the mobile itself.
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Figure 4-343: UMTS HSUPA L1/MAC Statistic View

Diagram

Each parameter is shown in one row, and the alarm thresholds can be configured sep-
arately for each parameter. The following parameter properties are shown by default,
the list columns can be configured using the "List format" tab of the configuration dialog
as described in Chapter 4.4.1.5, "UMTS HSUPA L1/MAC statistic view", on page 699.

● Parameter
Name of the HSUPA L1/MAC statistic parameter.

● Value
Absolute value of the HSUPA L1/MAC statistic parameter.

● Value in percent
The percent Value visualized as a bar diagram. The minimum and maximum of the
value range are as defined in the definition of the signal. The color of the bar is
defined as:
– Green
– Red
– Orange
– Yellow

● Alarm Thr.
The value of the alarm threshold (or "Off").
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● Alarm Count
The count of processed values in alarm state "On".

The L1/MAC statistic parameters comprise the following values, which can be config-
ured using the "Parameters" tab of the configuration dialog as described in section
"Parameters configuration" on page 703:

● TTI
Transmission Time Interval for the E-DCH. The standard 3GPP TS 25.321 allows a
TTI of 2 ms, which is one HSUPA subframe comprising 3 slots. The valid range is 0
to 1, alarm threshold default is 0.5.

● Serv. RG Up Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Happy Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Avg. Number of E-DCH cells
The valid range is 0 to 254, alarm threshold default is 127.

● Serv. RG Down Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Serv. RG Hold Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● AGCH Success Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Mean rec.AGCH Commands
The valid range is 0 to 65534, alarm threshold default is 32767.

● Mean Serving Grant
The valid range is 0 to 37, alarm threshold default is 18.5.

● New Transmission Rate
The valid range is 0 to 100%, alarm threshold default is 50.

● Retransmission Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● DTX Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Residual BLER
The valid range is 0 to 100%, alarm threshold default is 50.

● First Attempt BLER
The valid range is 0% to 100%, alarm threshold default is 50.

● Power Limited Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● SG Limited Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Buffer Limited Rate
The valid range is 0% to 100%, alarm threshold default is 50.

● Mean scheduled transmitted bits
The valid range is 0 to 65534, alarm threshold default is 32767.

● Mean non-scheduled transmitted bits
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The valid range is 0 to 65534, alarm threshold default is 32767.
● Avg. Supported Bits

The valid range is 0 to 65534, alarm threshold default is 32767.
● Avg. DPCCH Power

The valid range is –130 dBm to +30 dBm, the alarm threshold default is –50.
● Max. Power allowed

The valid range is –130 dBm to +30 dBm, the alarm threshold default is –50.
● Avg. Beta d/c

The valid range is –30 to +30, the alarm threshold default is 0.
● Avg. Beta hs/c

The valid range is –30 to +30, the alarm threshold default is 0.
● Avg. Beta ec/c

The valid range is –30 to +30, the alarm threshold default is 0.
● Avg. Beta ed/c

The valid range is –30 to +30, the alarm threshold default is 0.
● Scheduled Buffer Empty Rate

The valid range is 0% to 100%, alarm threshold default is 50.
● Non-Scheduled Buffer Empty Rate

The valid range is 0% to 100%, alarm threshold default is 50.
● Mean scheduled buffer status

The valid range is 0 to 65534, alarm threshold default is 32767.5.
● Mean non-scheduled buffer status

The valid range is 0 to 65534, alarm threshold default is 32767.5.
● Avg. AGCH Qual.

The valid range is 0 to 65534, alarm threshold default is 32767.
● Avg. RGCH Qual.

The valid range is 0 to 65534, alarm threshold default is 32767.
● Avg. HICH Qual.

The valid range is 0 to 65534, alarm threshold default is 32767.
● MAC Resets

The valid range is 0 to 254, alarm threshold default is 127.
● Mean E-TFCI

"Transport Format Combination Indicator". The valid range is 0 to 254, alarm
threshold default is 127

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,
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- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSUPA L1/MAC statistic view configuration

Parameters configuration

The "Parameters" tab offers an editable list with the shown parameters. Therefore the
"Parameters" panel offers check boxes to select the elements displayed in the "UMTS
HSUPA L1/MAC Statistic View".

Also the alarm threshold settings can be configured.

Figure 4-344: UMTS HSUPA L1/MAC Statistic View - parameters

Edit alarm threshold
The setting of an alarm can be defined for each selected parameter in the "Edit alarm
threshold" panel when clicking the same named button.
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Figure 4-345: Setting alarm threshold

The valid and expected value ranges for each parameter of the mobile are shown on
the dialog.
● Alarm is switched on

This checkbox toggles the state of the alarm between "On" and "Off".
● Alarm threshold

Defines the actual threshold value above / below which an alarm event is triggered.
The valid value range of the threshold is shown above the entry field.

● OK
Stores the alarm threshold setting and the alarm state.

● Cancel
Aborts the current alarm threshold setting action and closes the dialog.

List format configuration

The "List format" tab of the "UMTS HSUPA L1/MAC Statistic View" configuration menu
selects the information to be displayed.
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Figure 4-346: UMTS HSUPA L1/MAC Statistic View - list format

List Column
The "List Column" offers check boxes to select the columns displayed in the "UMTS
HSUPA L1/MAC Statistic View".

4.4.1.6  UMTS HSUPA performance view

The "UMTS HSUPA Performance View" contains four preconfigured 2D charts. The
signals in these charts are related to the transmission performance, given in terms of
the requested and achieved data throughput.
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Figure 4-347: UMTS HSUPA Performance View

A double-click the  button ("Show / Hide Chart Group") opens or closes a chart in the
performance view. The functionality of the charts in the view is analogous to the Chap-
ter 4.2.1, "2D chart view", on page 448.

For the meaning of the configuration entries in the "UMTS HSUPA Performance View:
<variable> Properties", see Chapter 4.2.1, "2D chart view", on page 448.

Chart 1

The "Chart 1" shows the most important, general parameters regarding throughput.

The chart contains the following results:
● "Happy Rate"

This parameter shows whether the mobile is "happy". The mobile is considered
happy if it can transmit the currently available data within a certain time frame sig-
naled by an RRC message.

● "Comb. ACK Rate"
The rate of acknowledged TTIs. A TTI is counted as acknowledged when the cor-
responding combination of the different HICH of the radio link-set results in an
ACK.

● "NS (Non-scheduled) ACK Rate"
The rate of TTIs which were acknowledged by "other cell", which are not belonging
to the radio link set.

● "Comb. NACK Rate"
The combined NACK rate is calculated as "100% - Comb. ACK Rate".

● "DTX Rate"
Rate of TTIs in which no data was transmitted.

● "Comb. ACK'd Throughput"
Data throughputs based on the transport block sizes of the acknowledged TTIs.
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● "Scheduled Throughput"
Data throughputs based on the transport block sizes of sent TTIs.

Chart 2

The "Chart 2" shows information about the Hybrid ARQ Indicator Channel (HICH) of
the related cells in the radio link set.

The chart contains the following results:
● "Comb. HICH Success Rate"

Rate of the successful reception of HICH information of one of the cells, which
belong to the radio link set.

● "Srv. Cell HICH Success Rate"
Rate of the successful reception of HICH information of the serving cell.

● "Srv. Cell ACK Rate"
Rate of the successful reception of acknowledged TTIs of the serving cell.

● "1. Non-serv. Cell HICH Success Rate"
Rate of the successful reception of HICH information of the first non-serving cell.

● "1. Non-serv. Cell ACK Rate"
Rate of the successful reception of acknowledged TTIs of the first non-serving cell.

● "2. Non-serv. Cell HICH Success Rate"
Rate of the successful reception of HICH information of the second non-serving
cell.

● "2. Non-serv. Cell Rate"
Rate of the successful reception of acknowledged TTIs of the second non-serving
cell.

Chart 3

The "Chart 3" is related to retransmissions. It shows the minimum, average, and maxi-
mum number of retransmissions within the update rate.

The chart contains the following results:
● "Min. Retransmission Count"

Counter for the minimum number of retransmissions.
● "Max. Retransmission Count"

Counter for the maximum number of retransmissions.
● "Avg. Retransmission Count"

Calculated average number of retransmissions.

Chart 4

The "Chart 4" is related to payload limit (only available for Qualcomm chipset). This
chart shows information on the throughput limitation. Qualcomm specified the values 0,
1, 2, 3 and 4.

The chart contains the following results:
● "Ltd. by Power Rate"

The max. allowed transmit power limits the throughput.
● "Ltd. by SG Rate"
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The current serving grant limits the throughput.
● "Ltd. by Buffer Occ. Rate"

The data buffer in the mobile is empty. There is no more data to transmit.
● "Ltd. by MUX"

The current multiplexer limits the throughput.
● "Ltd. by HARQ"

The current HARQ process limits the throughput.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSUPA Performance View" configuration is done in the "UMTS HSUPA
Performance View: <variable> Properties" pane. Selecting the "Configure" command in
the context-sensitive menu of the view opens only the "Info" page.

4.4.1.7  UMTS HSUPA power graph view

This View displays the most important power values for the HSUPA session in a 2D
Chart. The upper chart displays the "Max. Allowed Tx Power" and the currently used
power for the DPCCH. The second graph displays all relative power, calculated by the
mobiles using the given Beta Factors. The third graph displays the SG and the last
graph the UE Power Headroom.
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Figure 4-348: UMTS HSUPA Power Graph View

A double-click the title bars of the subdiagrams opens or closes them in the power
graph view. The functionality of all sub-diagrams is analogous to the Chapter 4.2.1, "2D
chart view", on page 448.

Absolute power

The "Absolute Power" subdiagram shows the average of the "Maximum Allowed Trans-
mission Power" in Uplink and the power of the associated "Dedicated Physical Control
Channel" in absolute values.

Relative power

This subdiagram shows the Power of certain Physical Channels relative to the
DPCCH.

The chart contains the following results:
● Prel(DPDCH)

Rel. Power of the “Dedicated Physical Data Channel” (R.99 Channel).
● Prel(HS-DPCCH)

Rel. Power of the “High-Speed Dedicated Physical Control Channel” (HSDPA
Channel).

● Prel(E-DPCCH)
Rel. Power of the “Enhanced Dedicated Physical Control Channel” (HSUPA Chan-
nel).

● Prel(E-DPDCH)
Rel. Power of the “Enhanced Dedicated Physical Data Channel” (HSUPA Chan-
nel).

● Prel(remaining)
Remaining Power in UL.
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Serving grant

● Mean SG
Average Value of the Serving Grant.

Scheduling info

● UE Power Headroom
Indicates the Power Status of the UE, means how much the UE is able to power
up.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.1.8  UMTS HSUPA UL channel configuration view

The "UMTS HSUPA UL Channel Configuration View" shows the most important UL
parameters of the active HSUPA connections, which were transmitted in the corre-
sponding RRC messages. Configuration of MAC-e and MAC flows is included in the
view. The power-offset table shows the basic information about what is the transmit
power calculation of the mobile based on. For detailed information, refer to TS25.331
and TS25.212.

It is important, that the DialUp connection is established during the R&S ROMES4
measurement session, as the mobile needs the information about the evolved cell set
once. In the case, the DialUp connection is already established, when the R&S
ROMES4 measurement is started. The information about the Radio Link Set (RLS) is
provided when the RLS changes and the mobile send a new trace due to these
changes.

Mobile views



Display and evaluation of resultsDrive Test Software

711Operating Manual 1171.6415.12 ─ 66

Figure 4-349: UMTS HSUPA UL Channel Configuration View

The channel configuration data is displayed in different panels.

EUL UL channel configuration

The following EUL (Enhanced Uplink) UL channel information is displayed in the view:
● TTI

Transmission Time Interval for the E-DCH. The standard 3GPP TS 25.321 allows a
TTI of, e.g., 2 ms, which is one HSUPA subframe comprising 3 slots

● Puncturing Limit
Uplink puncturing limit limits the amount of puncturing that can be applied to mini-
mize the number of physical channels.

● IR CC
Incremental Redundancy (IR) or Chase Combining (CC) shows the HARQ combin-
ing scheme.

● E-DPCCH Offset (DPCCH)
E-DPCCH power offset in dB.

● R99 DPDCH present
Indicates the presence of Release 99 DPDCH.
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● SG Selection
Indicates a primary (or other) service grant.

● HSDPA UL present
Indicates the presence of an HSDPA uplink channel

● Initial SG
Identifier of the initial service grant

● DPCCH slot format
Shows the DPCCH slot format (0 to 3)

● I/Q Mapping
1 for I, 0 for Q

● Action type
Shows whether the action type is enabled

● 2 Step Threshold
Value of 2-index-step threshold to set the serving grant.

● Signaled max. SF
Max. spreading factor of the channel.

● UE max. SF
Max. spreading factor of the UE

● Max. Tx Power
Maximum transmission power in dBm

● Start FN
Frame number of the start frame

● End FN
Frame number of the AGCH end frame

MAC-e configuration

Following information is displayed in the MAC-e Configuration:
● E-TFCI Table

Transport Format Combination Indicator Table for E-DCH.
● Min. E-TFCI

Minimum E-TFCI
● Happy Delay

Time until the UE sends a Happy Bit.
● Sched. TX HARQ Alloc.

Scheduled TX HARQ Process Allocation
● SI Power Offset

Power of Scheduling Information
● SI Periodicity Grant

Scheduling Information periodicity if Grant is available
● SI Periodicity No Grant

Scheduling Information periodicity if No Grant is available

The table in the MAC-e configuration displays following Logical Channel information.
● ID

Mac Flow Id
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● Type
Grant Type (S: Scheduled, NS: Non-scheduled)

● Max.ReTx
Maximum number of retransmissions

● #LogCh
Number of Logical Channels

● PO
E-DCH MAC Power Offset

● NS_GV (Non-scheduled_GV)
Non scheduled Grant Value (Value range: 0 -19982)

● NS-TX-H-A (Non-scheduled-TX-H-A)
Non scheduled TX HARQ process allocation

● Logical Channels
Radio Bearer ID, LogCh ID, Priority, Type, RLC Mode, Incl. in SI, # of PDU Sizes

Power offset table

The "Power offset table" contains the measured TCFI power-offset data for the availa-
ble E-TCFIs.
● Configured

Indicates whether the related Reference E-TFCI is configured.
● Ref. TFCI

Reference E-TFCI number.
● Reference Power Offset

Ref. Power Offset (in dBm).

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSUPA UL channel configuration view configuration

The "UMTS HSUPA UL Channel Configuration View" configuration menu defines the
list elements of the Power Offset list and the MAC Flow list.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Figure 4-350: UMTS HSUPA UL Channel Configuration View - configuration

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.4.2  UMTS HSDPA views

The "UMTS HSDPA Views" display HSDPA-specific information acquired with an
UMTS test mobile supporting HSDPA. In general, recording of the different message
types shown in the "UMTS Views" must be explicitly activated in the mobile device con-
figuration menu.

1. Enable UMTS HSDPA in the "Configuration" tab.

2. Select the HSDPA node in the"Expert Mode" tab.

R&S ROMES4 supports HSDPA test mobiles based on Qualcomm 6275 chipset or
newer.

The HSDPA views can be selected from a submenu displayed on the right side of the
"View" menu when the mouse cursor hovers over "HSDPA".
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Figure 4-351: UMTS HSDPA views

Additional HSDPA views
In addition to the HSDPA views described in this section, the "Handover Analyzer
View" and the "UMTS Finger Data View" can display HSDPA data. HSDPA-related
information in these views is only available with HSDPA license.

The UMTS UE's view related to UMTS HSDPA UL HS-DPCCH respects the general
performance settings done in "Tools" > "Preferences" > "Performance" regarding the
visual update rate. The individual view settings are avoided.

4.4.2.1  HSDPA signals

In addition to the "HSDPA Views" described in this section, R&S ROMES4 provides an
extensive selection of HSDPA signals. These signals appear below the "UMTS" node
of the "Tools" > "Preferences" > "Available Signals" tree and can be analyzed in the
appropriate Chapter 4.2, "Basic views", on page 445 and exported to ASCII files. Many
signals are also displayed in the "HSDPA Views". For description, see the "R&S
ROMES Description of Signals" manual.
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Figure 4-352: HSDPA signals

HSDPA throughput statistics (QP only)

There are parameters displayed in QualiPoc which are available as signals in R&S
ROMES4. The following figure shows the signals of the HSDPA throughput statistics
inserted in the Alphanumeric View.
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Figure 4-353: HSDPA throughput statistics signals

Results for MIMO and non-MIMO signals

All signals below the HSDPA Decode Summary Branch refer to the sum of both trans-
port blocks (TB1 and TB2) in MIMO case. To get the value for each MIMO path sepa-
rately, use the HSDPA MIMO Decode Summary branch, which offers signals for the
separated paths.

Branch HSDPA (MIMO) Decode Summary

All signals below the "HSDPA Decode Summary"
branch refer to the sum of both transport blocks
(TB1 and TB2) in MIMO case. To get the value for
each MIMO path separately, use the "HSDPA MIMO
Decode Summary" branch, which offers signals for
the separated paths.
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HSDPA CQI statistics

Below the branch "HSDPA CQI Statistic" signals are
distinguished between MIMO and non-MIMO TTIs.

Also signals are available that reflect the statistic for
the non-MIMO case and the two transport blocks in
the MIMO case.
●

Figure 4-354: 

HSDPA CQI statistics values inserted to "Alphanu-
meric View"

HSDPA CQI statistics (obsolete)

The "HSDPA CQI Statistics (Obsolete)" set of signals made of only "CQI Min/Max/Avg"
signals is only valid if no MIMO TTI was present during the reporting time period. If at
least one MIMO TTI was found, those values are set to invalid, because the CQI value
range differs between MIMO and non-MIMO case. Thus a statistic over all does not
make a sense.

Note, that in the MIMO case, the "HSDPA Performance View" does not show any "Avg.
CQI" value in the upper chart due to the same reason.

4.4.2.2  UMTS HSDPA UL HS-DPCCH view

The "UMTS HSDPA UL HS-DPCCH View" shows the CQI (Channel Quality Indicator)
values reported by the test mobile in the last 100 HSDPA subframes. In the network,
the CQI is transmitted on the UL High Speed Dedicated Physical Control Channel (HS-
DPCCH), which is a fixed rate channel with a spreading factor of 256. The first slot of
each UL HS-DPCCH subframe contains the ACK/NACK messages; the following two
slots carry the CQI. The frame structure of the uplink HS-DPCCH is shown in the figure
below.
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Figure 4-355: HS-DPCCH frame structure

The CQI values are integer numbers between 0 and 30; see CQI-mapping tables in
standard 3GPP TS 25.214. Large CQI numbers denote a good channel quality and a
high potential DL data throughput.

Figure 4-356: UMTS HSDPA UL HS DPCCH View

The charts of the view support zooming using the mouse wheel, and panning using the
left mouse button.

MIMO refers to TTIs
In this section the wording “MIMO” refers to those TTIs for which two transport blocks
are preferred by the UE.

Diagram

The view's diagram is split into two charts.

The upper chart shows the current state of the transmission, ACK, NACK or DTX. The
lower chart is the main part of the view. It shows the CQI values which reflect the cur-
rent state of the transmission channel for the point of view of the UE.
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If there are two CQIs, the CQIs are drawn one above the other, so that the sum of both
can be recognized easily.

The default colors are in accordance with the R&S adoptive colors.

Each bar corresponds to a CQI value reported by the mobile device.

The colors of the bars in the upper part of the view show the current state of the trans-
mission. The transmission is related to the messages transmitted in the first (HARQ-
ACK) slot of the HS-DPCCH subframe that carried the CQI value.
● Yellow background means DTX

No transmission took place in this TTI. Denoted are subframes that were not
acknowledged or not unacknowledged. No answer was received from the mobile
device. This case is most likely because the mobile cannot correctly demodulate
the downlink HS-SCCH. Note that the mobile can use DTX independently in the
ACK/NACK and CQI slots.

● Green background visualizes an ACK
It denotes an acknowledged subframe; the mobile sends an ACK message after a
successful CRC check of a received HS-DSCH packet.

● Red background visualizes a NACK
For the transmission which took place in the corresponding TTI it denotes an unac-
knowledged subframe. The mobile sends a NACK message after a failed CRC
check.

The blue color of the frame of the CQI bar reflects the PCI (protocol capability indica-
tor) value of the TTI. A PCI bit is an information element (a field) that indicates which
protocol the device has or can use.

Analyze the cause for an unacknowledged or DTX frame
Use the Chapter 4.4.2.9, "UMTS HSDPA decode statistic view", on page 737 to ana-
lyze the cause for an unacknowledged or DTX frame.

Statistical results

The view shows the total number of CQI bars ("Samples") in the diagram below the
charts and the number of ACK, NACK and DTX subframes (ACK + NACK + DTX =
Samples).

The arithmetic mean value of the displayed CQI values, the maximum, and the mini-
mum CQI values are displayed.

The statistical report is separated into a non-MIMO and a MIMO part.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,
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- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSDPA UL HS-DPCCH View" has no context menu for configurations.

4.4.2.3  UMTS HSDPA HS decode status view

The "UMTS HSDPA HS Decode Status View" shows the status of the HS-SCCH
demodulation and the decoded HS-SCCH information. The view contains a table with
up to 100 of the newest samples (sets of results) provided by the test mobile.

The view is split in two parts with three sections each. In MIMO case, the parts of the
view are:
● Upper part reflects the state of the first MIMO path (first carrier).
● Lower part reflects the state of the second MIMO path (secondary carrier).

The HS-SCCH is a downlink physical channel used to carry downlink signaling infor-
mation related to HS-DSCH transmission. This information includes the channelization
code set, the modulation scheme, the transport block size and HARQ-related informa-
tion (see standard 3GPP TS 25.212).

Figure 4-357: UMTS HSDPA HS Decode Status View

Diagram

The view shows tables with fixed scale. Each column corresponds to an HS-SCCH
sample comprising the following information:
● "SCCH Demod"/"DC SCCH Demod"

Indicates whether the mobile attempted to demodulate the HS-SCCH.
If a dual cell is activated, "DC SCCH Demod" carries the information for the second
MIMO path.
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● "SCCH Valid"/"DC SCCH Valid"
Indicates whether the mobile was able to decode consistent signaling information
from the demodulated HS-SCCH
If a dual cell is activated, "DC SCCH Valid" carries the information for the second
MIMO path.

● "#HS-DSCH Codes"/"DC #HSDSCH Codes"
Number of HS-(P)DSCH channelization codes in the range between 1 and 15. The
HS-PDSCH is a fixed rate (SF = 16) physical channel with channelization code
numbers ranging from 1 to 15. The channelization code C16,0 is barred because
the channelization codes C256,0 and C256,1 are reserved for the P-CPICH and P-
CCPCH, respectively. The HS-PDSCH channelization codes are allocated contigu-
ously starting from the first code.
If a dual cell is activated, "DC #HSDSCH Codes" carry the information for the sec-
ond MIMO path.

● "HARQ Process"/"DC HARQ Process"
HARQ Process ID, number of the HARQ process that the transmission belongs to
(range 0 to 7). The HARQ process ID defines the background color of the column.
The ID always corresponds to the first transport block (TB 1). A maximum of 16
HARQ processes is supported.

The information contained in the transport blocks ("DSCH Status", "New TX" and
"Modulation") is shown for each MIMO path separately. In the non-MIMO case, only the
section of the first transport block (TB1) is filled.

If a dual cell is activated, "DC HARQ Process" carry the information for the second
MIMO path.

● "DSCH Status TB1/TB2"/"DC DSCH Status TB1/TB"2
Shoes the status of the CRC check for the transmitted and decoded HS-DSCH
packet. CRC pass (successful transmission) causes an ACK message in the UL
HS-DPCCH. CRC fail causes a NACK message. No CRC check (because no valid
HS-SCCH information could be obtained) causes DTX. See also Chapter 4.4.2.2,
"UMTS HSDPA UL HS-DPCCH view", on page 718.
If a dual cell is activated, "DC DSCH Status TB1/TB2" carry the information for the
second MIMO path.

● "New TX TB1/TB2"/"DC New TX TB1/TB2"
Transmission of a new HS-DSCH packet or retransmission of a packet transmitted
earlier.
If a dual cell is activated, "DC New TX TB1/TB2" carry the information for the sec-
ond MIMO path.

● "Modulation TB1/TB2"/"DC Modulation TB1/TB2"
Modulation scheme for (QPSK, 16QAM or 64QAM)
If a dual cell is activated, "DC Modulation TB1/TB2" carries the information for the
second MIMO path.

The meaning of the colors in the diagram is listed in the table below.

Note that a red square often causes red or white squares in the cells below the red
marked cell. For example, a failed SCCH demodulation means that the mobile cannot
start receiving the HS-DSCH and all the following cells are white.
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Table 4-11: Color codes in the UMTS HSDPA HS Decode Status View

Decoding
Stage

Green Blue Violet Red White

SCCH Demod Attempted -/- -/- Not attempted
(because the
SCCH did not
carry the
proper UE ID)

n/a

SCCH Valid Yes -/- -/- No n/a

DSCH Status CRC Pass -/- -/- CRC Fail n/a

New Trans-
mission

New Trans-
mission

-/- -/- Retransmis-
sion

n/a

Modulation 64QAM 16QAM QPSK -/- n/a

Details window

A double-click any of the table columns opens a details window for the corresponding
sample.

The window repeats the information in the table and contains the following additional
entries:
● "HARQ Process ID"

Value of the HARQ process identifier (0 to 7)
● "Redundancy Version"

Value Xrv in the range 0 to 7. Xrv jointly codes the redundancy version (RV) param-
eters r, s and the constellation version parameter b.

● "Transport Block Size"
Size of the HS-DSCH transport blocks in bit, calculated from the 6-bit transport
block size index; see 3GPP TS 25.321.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSDPA HS Decode Status View" configuration menu contains the "Info"
tab; seeChapter 4.1.4, "Configuration menu", on page 430.
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4.4.2.4  UMTS HSDPA configuration view

The "UMTS HSDPA Configuration View" shows the configuration of the DL HSDPA
channels received by the test mobile, the UL HS-DPCCH, and information related to
the finger configuration command, the DL HS-SCCHs, and the active HARQ pro-
cesses. This configuration data is generated whenever there is a L1 reconfiguration
related to HSDPA.

Most of the displayed information is mobile-specific and primarily intended for monitor-
ing the status of the test mobile.

Figure 4-358: UMTS HSDPA Configuration View

The configuration data is displayed in different panels:
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DL HS channel

The following information is related the DL High-Speed Channels (HS-DPCH and HS-
SCCH):
● "Last Action"

Status of the DL transmission. Enable, Disable, or Reslam
● "Ref. Finger"

Reference finger (values 0 to 11)
● "HS Cell Index"

High-speed cell index in the range 0 to 7
● "SC"

Common scrambling code for all DL HSDPA channels

Use the Chapter 4.4.3.1, "UMTS finger data view", on page 743 to view the preceding
parameters together with the time offset and Ec/Io of all signals captured by the differ-
ent fingers of the mobile receiver.

● "DPCH HW Channels"
Values 0 to 3.

● "DPCH SCCH Offset"
Corresponds to starting global subframe number, values 0 to 149 (256 chip peri-
ods).

● "Start Global subframe Number"
Mobile-specific subframe no. in the range 0 to 1279.

● "Final Global subframe Number"
Mobile-specific subframe no. in the range 0 to 1279, only relevant for Last Action:
Reslam.

● "DL DPCH ACTION CFN"
Mobile-specific parameter, 0 to 255.

● "DL DPCH TICK CMD SENT"
Mobile-specific parameter, 0 to 149.

UL HS-DPCCH channel

The following information is related the UL HS-DPCCH. This channel carries the ACK/
NACK and CQI messages that the mobile reports to the network; see Chapter 4.4.2.2,
"UMTS HSDPA UL HS-DPCCH view", on page 718.

● "Last Action"
Status of the UL transmission: Enable, Disable, or Reslam

● "CQI Adjustment"
Adjustment applied to SIR measurement before quantization; CQI Adjustment =
[12.04 + DSCH to CPICH offset (signaled to the mobile) + SNR to CQI offset (con-
stant for a software build, e.g. 4.0].

● "CQI Feedback Cycle"
Time (in multiples of HSDPA subframes with a length of 2 ms) after which the
mobile repeats the transmission of CQI symbols on the HS-DPCCH. Possible val-
ues are 0, 1, 2, 4, 5, 10, 20, 40 and 80
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● "CQI Rep. Factor"
Number of repeated CQI transmissions (1 to 4)

● "ACK/NACK Rep."
Factor Number of repeated ACK/NACK transmissions (1 to 4)

● "HS-DPCCH Offset"
Corresponds to starting global subframe number, values 0 to 149 (256 chip peri-
ods)

● "Start Global subframe Number"
Mobile-specific subframe no. in the range 0 to 1279

● "Final Global subframe Number"
Mobile-specific subframe no. in the range 0 to 1279, only relevant for "Last Action:
Reslam"

● "UL DPCH ACTION CFN"
Mobile-specific parameter, 0 to 255

● "UL DPCH TICK CMD SENT"
Mobile-specific parameter, 0 to 149

Finger configuration command

The following information is mobile-specific:
● "CMD SENT CFN"

Counter in the range 0 to 255
● "CMD SENT TICK"

Counter in the range 0 to 149

SCCH info

The "SCCH Info" field provides information about the channels in the HS-SCCH set
which is allocated to the mobile. An HS-SCCH set is a set of 1 to 4 HS-SCCHs. The
mobile continuously monitors all the HS-SCCHs in the allocated set.

The panel shows the number of enabled SCCHs together with their channelization
codes (OSVF). The SCCHs are fixed rate channels (SF = 128) with code numbers
ranging from 1 to 127.

The remaining information is mobile-specific.

HARQ info

The "HARQ Info" field provides information about the active HARQ processes together
with the internal address and the size of the physical buffer associated with each proc-
ess.

In addition, the following information is displayed:
● "HARQ ACK/NACK Rep."

Mobile-specific parameter
● "DRMB Storage Direction"

Mobile-specific parameter
● "H-RNTI"

Mobile views



Display and evaluation of resultsDrive Test Software

727Operating Manual 1171.6415.12 ─ 66

HS-DSCH RNTI, 16-bit identity, identifies the mobile for which data is transmitted in
the corresponding HS-DSCH TTI

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.2.5  UMTS HSDPA MAC configuration view

The "UMTS HSDPA MAC Configuration View" shows the configuration of the MAC-hs
that the test mobile receives from the network. The MAC-hs is the MAC entity that han-
dles the high-speed downlink shared channel (HS-DSCH), see standard 3GPP TS
25.321. The view is updated every time the MAC-hs is reconfigured.

Figure 4-359: UMTS MAC Configuration View
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Diagram

The view shows the following MAC-hs parameters with their values:
● "Action"

Indicates the last action that the MAC-hs entity was requested to perform by upper
layers: "Start", "Stop", or "Reconfigure".

● "Reset Indicator"
TRUE indicates that a reset of the MAC-hs entity has been requested.

● "CCTRCH_ID"
Unambiguous identifier for the Coded Composite Transport Channel (CCTrCH)
inside the radio link (range 0 to 7).

● "MAC_FLOW_ID"
Mobile-specific parameter, range 1 to 8

● "Queue"/"Queue ID"
The "Queue ID" provides identification of the reordering queue in the receiver, to
support independent buffer handling of data belonging to different reordering
queues (range 1 to 8)

● "Release Timer"
Value of the reordering release timer (T1). The release timer controls the stall
avoidance in the mobile’s reordering buffer; see 3GPP TS 25.321, section
11.6.2.3.2. Possible values are 10, 20, 30 … 100, 120, 140, 160, 200, 300 and 400

● "Window Size"
Size of the receiver window, given in terms of a TSN range

● "PDU Size"
Size of the Protocol Data Units (PDUs) that can be transferred to MAC within a
transmission time interval in the range 0 to 5000 (bits)

● "PDU Index"
MAC PDU Size Index in the range 0 to 7

● "Logical Channel"/"RLC ID"
Mobile-specific parameter, range 0 to 17

● "Type"
Channel type: BCCH, PCCH, CCCH, DCCH, CTCH, or DTCH

● "Mode"
Channel Mode: Transparent mode (TM), Unacknowledged mode (UM), or
Acknowledged mode (AM)

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS MAC Configuration View" has no context menu for configurations.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.4.2.6  UMTS HSDPA MAC status view

The "UMTS HSDPA MAC Status View" gives an overview of the status of the reorder-
ing entity in the mobile receiver. The different state variables are described in standard
3GPP TS 25.321. The mobile collects this information in up to 100 consecutive sam-
ples which are displayed in a table.
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Figure 4-360: UMTS HSDPA MAC Status View

Diagram

The view displays the following information elements:
● "#"
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Current number of the sample, assigned in the range 1 to 100
● "ID Queue ID (0 to 7)"

The Queue ID provides identification of the reordering queue in the receiver, to
support independent buffer handling of data belonging to different reordering
queues

● "Received TSN"
Transmission Sequence Number (TSN, 0 to 63) of the last received (HS-DSCH)
MAC-hs PDU

● "Next TSN"
Next expected TSN. The TSN following the R&S TSME of the last in-sequence
MAC PDU received

● "WUE"
WUE (Window Upper Edge) represents the TSN at the upper edge of the receiver
window. While timer T1 is active, the number is equal to the Received TSN. Other-
wise it is invalid.

● "T1 TSN"
TSN used in the reordering procedure. The TSN of the latest MAC-hs PDU that
cannot be delivered to the disassembly entity, when the timer T1 is started.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSDPA MAC status view configuration

The "UMTS HSDPA MAC Status View" configuration menu selects the information to
be displayed.
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Figure 4-361: UMTS HSDPA Status View - configuration

4.4.2.7  UMTS HSDPA MAC header view

The "UMTS HSDPA MAC Header View" shows the mobile-specific subframe number
and the corresponding (HS-DSCH) MAC-hs headers as defined in standard 2GPP TS
25.321, sections 9.1.4 and 9.2.2.

Figure 4-362: UMTS MAC-hs PDU

For an overview of the last 100 MAC-hs PDUs, use the Chapter 4.4.2.6, "UMTS
HSDPA MAC status view", on page 729.
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Figure 4-363: UMTS HSDPA MAC Header View

Diagram

The MAC-hs header contains the following information elements:
● "FN"

Internal subframe number, range 0 to 1279
● "VF"

Version flag, now set to zero
● "ID"

Queue ID (0 to 7; provides identification of the reordering queue in the receiver, to
support independent buffer handling of data belonging to different reordering
queues
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● "TSN Transmission"
Sequence Number (TSN, 0 to 63) on the HS-DSCH
The TSN field is used for reordering purposes to support in-sequence delivery to
higher layers.

● "SID(n)"
Size Index Identifier (0 to 7), identifies the size of a set of consecutive MAC-d
PDUs
The MAC-d PDU size for a given SID is configured by higher layers and is inde-
pendent for each Queue ID.

● "N(n)"
Number of MAC-D PDUs (0 to 63), the number of consecutive MAC-d PDUs with
equal size

The flag fields ("F") in the figure above indicate whether the MAC-hs header contains
additional "SID" and "N" fields. They are not relevant for the "MAC Header View"
because the number of columns in the table is selected in the configuration menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSDPA MAC header view configuration

The "UMTS HSDPA MAC Header View" configuration menu selects the information to
be displayed.
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Figure 4-364: UMTS HSDPA Header View - configuration

4.4.2.8  UMTS HSDPA performance view

The "UMTS HSDPA Performance View" contains four preconfigured 2D charts. The
signals in these charts are related to the transmission performance, given in terms of
the requested and achieved data throughput.

Figure 4-365: UMTS HSDPA Performance View
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A double-click the  button ("Show / Hide Chart Group") opens or closes a chart in the
performance view. The functionality of the charts in the view is analogous to the Chap-
ter 4.2.1, "2D chart view", on page 448.

For the meaning of the configuration entries in the "UMTS HSDPA Performance View:
<variable> Properties", see Chapter 4.2.1, "2D chart view", on page 448.

Chart 1

The "Chart 1" shows data throughput that the mobile requests according to the mea-
sured channel quality. The requested throughput is calculated from the CQI messages
that the mobile transmits on the UL HS-DPCCH, see Chapter 4.4.2.2, "UMTS HSDPA
UL HS-DPCCH view", on page 718. The results are averaged over the number of sub-
frames (100) shown in the "UMTS HSDPA HS-DPCCH View".

The chart contains the following results:
● "Req. Throughput"

Requested total throughput
● "Req. Avg. # Codes"

Number of HS-(P)DSCH channelization codes in the range between 1 and 15, see
Chapter 4.4.2.9, "UMTS HSDPA decode statistic view", on page 737

● "Req. QPSK Rate"
Percentage of the requested throughput that can be transferred on QPSK-modula-
ted data blocks

● "Req. 16QAM Rate"
Percentage of the requested throughput that can be transferred on 16QAM-modu-
lated data blocks

● "Req. Avg. CQI"
Average CQI value received from the mobile

Conflict of MIMO and non-MIMO signals
In MIMO case, the "HSDPA Performance View" does not show any "Req. Avg. CQI"
value. The reason is that the statistic is only valid, if no MIMO TTI was present during
the reporting time period. If at least one MIMO TTI was found, those values are set to
invalid. It is because the CQI value range differs between a MIMO and non-MIMO
case, thus a statistic over all does not make any sense.

Chart 2

The "Chart 2" shows the scheduled throughput. It is the data throughput that the net-
work uses according to the requests (CQI messages) from the mobile. The results are
analogous to the "Requested Throughput" results.

Chart 3

The "Chart 3" shows the MAC layer throughput. It is the actual DL data throughput
achieved. The MAC throughput depends on the scheduled throughput and the percent-
age of data blocks that the network has to retransmit ("HARQ Retransmission Rate").
The "MAC BLER" is the percentage of MAC blocks that the UE received with error. The

Mobile views



Display and evaluation of resultsDrive Test Software

737Operating Manual 1171.6415.12 ─ 66

larger the Block Error Rate, the higher the number of retransmissions and the smaller
the MAC throughput.

Chart 4

The "Chart 4" shows the RLC DL throughput. It is the data throughput of the RLC
blocks that the mobile receives from the network. The "RLC DL BLER" is the percent-
age of RLC blocks that the UE received with error.

To measure "RLC DL Throughput" signal, it is required that the UMTS message type
WCDMA RLC DL AM Statistics is selected in a test device menu. For details how
to configure the test device, refer to "Extra settings UMTS" on page 1573.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS HSDPA Performance View" configuration is done in the "UMTS HSDPA
Performance View: <variable> Properties" pane. Selecting the "Configure" command in
the context-sensitive menu of the view opens only the "Info" page.

4.4.2.9  UMTS HSDPA decode statistic view

The "UMTS HSDPA Decode Statistic View" shows a statistical evaluation of the
received DL HS-DSCH transport blocks. Also is shown the block error rate and the
number of retransmissions needed to decode successfully the blocks of each size. The
transport block size depends on the CQI values that the mobile reported to the net-
work; see standard 2GPP TS 25.214 and Chapter 4.4.2.2, "UMTS HSDPA UL HS-
DPCCH view", on page 718. The results are averaged over the number of subframes
(100) shown in the "UMTS HSDPA HS-DPCCH view".
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Figure 4-366: UMTS HSDPA Decode Statistic View

Diagram

The table contains the following columns:
● "#"

Number of the carrier and the MIMO path, e.g. 1 to 1 means primary carrier first
MIMO path (or SISO)

● "TBS"
Transport block size in bits, in ascending order
The results in each row are relating to blocks of the same size.

● "SB+"
Number of successfully decoded subblocks
A subblock is a mobile-specific unit comprising the HS-DSCH data of one sub-
frame.

● "SB++"
Number of duplicate subblocks
Duplicate subblocks are subblocks that the network retransmitted although they
were received correctly (usually because no ACK message was received from the
mobile).

● "SB–"
Number of subblocks which could not be decoded successfully and had to be
retransmitted
These blocks contribute to the SBLER but not necessarily to the BLER, see the fol-
lowing parameters.

● "SBLER"
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Subblock error rate, SBLER = SB–/(SB+SB–)
● "BL+"

Number of successfully decoded blocks
● "BL–"

Number of blocks which could not be decoded successfully until the maximum
number of retransmissions was reached

● "BLER"
Block error rate, BLER = BL–/(BL+BL–)
The BLER is usually smaller than the SBLER because it counts only the blocks
that could not be decoded until the end of the HARQ process (until the maximum
number of retransmissions was reached).

● "# 1 [%]"
Number of blocks successfully decoded without retransmission

● "# n [%]"
Number of blocks successfully decoded after one initial transmission and (n–1)
retransmissions

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSDPA decode statistic view configuration

The "UMTS HSDPA Decode Statistic View" configuration tab shows a list of signals
that you can select to be displayed. The tab has the same name as the one used for
the "UMTS HSUPA HARQ View" configuration, see UMTS HSUPA HARQ view config-
uration.
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Figure 4-367: UMTS HSDPA Decode Statistic View - configuration

4.4.2.10  UMTS HSPA L2 statistic view

The "UMTS HSPA L2 Statistic View" shows information on used PDU size. The first
column shows the size in octets, the second the absolute numbers of this size, the
third the total numbers of PDUs and the fourth is the percentage of this size usage in
the reporting period.

This information is only available if the "HSPA+ Flexible DL RLC AM PDU" size is acti-
vated.
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Figure 4-368: UMTS HSPA L2 Statistic View

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS HSPA L2 statistic view configuration

The "UMTS HSDPA L2 Statistic View" configuration tab shows a list of signals that you
can select to be displayed. The tab has the same name as the one used for the "UMTS
HSUPA HARQ View" configuration, see "UMTS HSUPA HARQ view configuration"
on page 699.
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Figure 4-369: UMTS HSPA L2 Statistic View - configuration

4.4.3  UMTS views

The "UMTS Views" display UMTS-specific information acquired with an UMTS test
mobile and using the UMTS device.

In general, recording of the different message types shown in the view must be explic-
itly activated in the "Configuration" and "Expert Mode" tabs of the device configuration
menu, refer to "UMTS devices configuration" on page 1571.

The UMTS views can be selected from "View" > "Mobile Views" if the mouse pauses
over "UMTS".

Figure 4-370: UMTS views
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4.4.3.1  UMTS finger data view

The "UMTS Finger Data View" shows the most important layer 1 parameters character-
izing the different downlink WCDMA signals received by the mobile, captured with the
different branches (fingers) of the test mobile UMTS RAKE receiver. The value of the
critical quantity Ec/Io for each signal is visualized in addition by horizontal bars. A
mobile with a Qualcomm chipset must be used to record the data.

The view displays the fingers of the primary and the secondary carrier of a dual cell.

The view is empty unless the test mobile is configured to record the "WCDMA Finger
Info"; see description of the "Extra settings" tab of the device configuration menu in
"Extra settings UMTS" on page 1573.

Figure 4-371: UMTS Finger Data View

The results for each mobile are arranged in a separate tab.

Results

Table of the most important layer 1 parameters of the captured downlink WCDMA sig-
nals. Each table row represents a signal. The maximum number of rows/signals can be
set in the configuration menu. The signals are sorted according to the signal-to-noise
ratio Ec/Io, the strongest signal appears on top of the list.

● SC
Primary scrambling code of the signal used to identify a cell
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The format is selected in the "TEC for UMTS Test Mobiles"; refer to section "Con-
figuration Menu in chapter 3.

● Offset
Time offset of the signal in 1/8-chip units relative to the system time (hardware-
dependent)
The difference between the offsets of different signals provides important informa-
tion. Two signals with equal SC, Status, Div., and OVSF but different offset and
Ec/Io originate from the same source but propagated along different paths.

● Status
Status of the receiver fingers; one or several of the following characters:
– A1/A2 (Antenna)

Shows the used antenna of the device (A1, A2) for this finger
– L (Lock Detection State)

Shows whether the finger RSSI is > high threshold regardless of whether the
given type of lock is enabled

– T (Time Tracking Lock)
Shows when time tracking lock is enabled, that the finger RSSI > upper lock
threshold

– D (Data Combining Lock)
Shows when the data combining lock is enabled, that the finger RSSI > upper
lock threshold

– P (Power Control Bit Lock)
Sows when the data combining lock is enabled, that the finger RSSI > power
control bit threshold

● Div.
Downlink transmit diversity scheme for the CPICH: STTD (Space Time Transmit
Diversity), TSTD (Time Switched Transmit Diversity), SSDT (Site Selection Diver-
sity Transmit Power Control), or No Diversity

● OVSF
Orthogonal Variable Spreading Factor, code number of the signal

● Ec/Io
Ratio of the received energy per PN chip for the signal to the total received power
spectral density at the mobile antenna connector. Ec/Io is obtained in an unbiased
measurement, i.e. the contribution of the noise floor to the powers is subtracted.

The "SC", "Offset" and "Ec/Io" values for each finger generate signals in the "UMTS –
<Device> – Finger Info" branch of the data tree.

HSDPA results

The HSDPA-related results are closely related to the "Last Action", "Ref. Finger", and
"HS Cell Index" parameters in the Chapter 4.4.2.4, "UMTS HSDPA configuration view",
on page 724. Note that signals from the same source (equal SC) have the same
"HSDPA" status and "HS Cell Index", but only a single signal can be the reference sig-
nal.

The results are comma delimited in the following order:
● A (or –)

Active (or not)
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● 1 .. n
Cell index in the range 0 to 7

● R
Reference finger

HSUPA results

Note that signals from the same source (equal SC) have the same HSUPA status and
"Cell Index", but only a single signal can be the reference signal.

The results are comma delimited in the following order:
● A (or –)

Active (or not)
● 1 .. 7

Radio link set in the range 0 to 7
● R

Reference finger
● SC

Serving Cell

Ec/Io bars

A colored bar overlaid to each table row shows the signal strength, expressed by its
Ec/Io. The scale of the Ec/Io bars is defined in the configuration menu, the colors
denote the SCs of the different signals; they can be customized in the "Colors" tabs of
the UMTS view configuration menus, for example, the one linked to the UMTS Cell Set
View. If the signal strength falls below the selected minimum, the bar is replaced by a
narrow line at the left edge of the diagram.

The SC color codes are also shown in the "ROMESMAP Route Track" menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS finger data view configuration

The "UMTS Finger Data View" configuration menu defines the maximum number of
table rows in the "UMTS Finger Data View" and the scale the Ec/Io bars and displays
information about the view version.
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To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-372: UMTS Finger Data View: Finger Data View - configuration

Graph
The "Graph" panel in the "Finger Data View Configuration" tab contains three input
fields:
● Min. Ec/Io [dB]

Value of Ec/Io at the left edge of the diagram. The length L of the bars increases
with the value of Ec/Io, it is given by the linear formula:

where Lmax denotes the diagram width.
● Max. Ec/Io [dB]

Value of Ec/Io at the right edge of the diagram; see above.
● Max. Count

Maximum number of signals displayed in the view (= maximum number of table
rows). The signals are sorted according to their Ec/Io, so a small number elimi-
nates weak signals that can be of minor interest.

4.4.3.2  UMTS NAS status view

The "UMTS NAS Status View" shows an overview of higher-layer (Non-Access Stra-
tum, NAS) parameters of the serving cell and the connection. A Qualcomm mobile
must be used to record the data.
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The view is empty unless the test mobile is configured to record the "UMTS NAS GMM
State", "UMTS NAS MM State", "UMTS NAS REG State", or "UMTS NAS MM Charac-
teristics" data, see description of the "Expert Mode" tab of the device configuration
menu.

Figure 4-373: UMTS NAS Status View

The results for each mobile are arranged in a separate tab. Each tab consists of sev-
eral panels.

Serving cell

Table of the most important higher layer (NAS) parameters of the serving cell.
● Name

Name of the serving cell NodeB, taken from the UMTS NodeB database (if availa-
ble)

● Cell ID
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Cell Identity of the serving cell
● URA ID

UTRAN Registration Area
● Res.

Cell reserved or not reserved
● Res. SoLSA

Cell reserved for Support of Localized Service Area
● Access

Indication of possible cell access restrictions: Access for "All Calls" or "Emergency
Calls Only"

● Barred
Indication whether the cell is barred (for all calls, including emergency calls) or not
barred

MM / GMM state

Overview of the current Mobility Management (MM) and GPRS Mobility Management
(GMM) states, substates and updates of the mobile. The GMM results are available for
test mobiles supporting GPRS functionality (which is true for most test mobiles). MM
and GMM are described in standard 3GPP TS 24.008.

MM characteristics

Table of additional MM parameters:
● Net Op. Mode

Network operation mode Class I, II or III, see standard 3GPP TS 123 060. The
operation mode is indicated as system information to the mobile.

● Service type
Circuit switched service ("CS"), packet switched service ("PS") or both ("CS and
PS") or "Limited Service"

● MCC
Mobile Country Code

● MNC
Mobile Network Code

● LAI
Location Area Identity

● RAI
Routing Area Identity

Other available
● PLMNs

MCC and MNC of other networks detected by the mobile

The "NAS" values generate signals in the "UMTS – <Device> – NAS State" branch of
the data tree.
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REG state

Table of registration information in the network
● State

Identifies the state of the UE:
– Not registered and the UE is not currently searching a new operator to register

to.
– Registered in home network.
– Not registered, but UE is searching a new operator to register to.
– Registration denied.
– Unknown
– Registered under roaming conditions.

● PLMN Selection Mode
Identifies how the UE selects the network:
– Automatic
– Manual
– Deregister from network.
– Manual/automatic; if manual selection fails, automatic mode is entered.

● UE Operation Mode
An UE in class-A mode of operation involved in a CS connection makes only RA
updates and no combined RA/LA updates to the SGSN.
An UE in class-B mode of operation involved in a CS connection does not make
any updates during the CS connection.
An UE in class-C mode of operation never makes combined RA/LA updates.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The configuration menu displays information about the view version only in the mobile/
technology common "Info" page.

4.4.3.3  UMTS TrCH view

The "UMTS TrCH View" shows an overview of the channel coding parameters in the
downlink and uplink Transport Channels (TrCHs). A Qualcomm mobile must be used to
record the data.
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The view is empty unless the test mobile is configured to record the WCDMA TrCH
Downlink or the "WCDMA TrCH Uplink" parameters; see description of the "Expert
Mode" tab of the device configuration menu.

Figure 4-374: UMTS TrCH View

The results for each mobile are arranged in a separate tab.

View area

The entire view area is horizontally split to accommodate two different tables for the
"TrCH Downlink" and the "TrCH Uplink".

A click the "TrCH Downlink" or "TrCH Uplink" title bars compresses and expands the
corresponding table. A compressed table leaves more space for the other table. A
compressed table is characterized by the symbol >>> (instead of <<<) in its title bar.
On pausing on one of the title bars, the cursor displays a compress symbol.

The contents of both tables can be selected in the configuration menu.

TrCH downlink

Table of the channel coding parameters of the downlink TrCHs received by the test
mobile.

Each table row represents a single transport channel that has been added during the
measurement (and possibly removed). A new table row is created each time that a
new transport channel is added. However, a table row for a removed transport channel
is deleted after the "Time Window for DL/UL" set in the configuration menu.
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Clicking an entry in the table heading sorts the cells according to the corresponding
parameter. A gray triangle in the heading pointing upward (downward) indicates that
the table is sorted in ascending (descending) order.

● CCTrCH ID
Composite Coded Transport Channel ID in the range 0 to 15, identifies unambigu-
ously a CCTrCH inside a Radio Link.

● TrCH ID
Transport channel number assigned to L1 by L2. Transport channels are multi-
plexed to the CCTrCH in the ascending order of these IDs.

● Type
Transport channel type, e.g. Paging Channel (PCH), Slow Broadcast Channel
(SBCH), Random Access Channel (RACH), Dedicated Channel (DCH), Downlink
Shared Channel (DSCH), Forward Access Channel (FACH)

● Code Rate
Coding rate and type of error protection/channel coding (Convolutional coding,
turbo coding)

● CRC Bits
Number of CRC bits per transport block.

● TTI Format
Length of the Transmission Time Interval in ms.

● RM
Rate matching attribute, assigned by higher layers and used when the number of
bits to be repeated or punctured is calculated.

● BLER
Estimation of the transport channel block error rate (BLER) based on evaluating
the CRC on each transport block.

A double-click a table row opens a popup window with detailed information about the
transport block format:

TrCH uplink

Table of the most important parameters of the uplink WCDMA TrCHs transmitted by
the test mobile. The parameters are a subset of the TrCH Downlink parameters. Uplink
transport channel types are Dedicated Channel (DCH), Random Access Channel
(RACH), and Common Packet Channel (CPCH).
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS TrCH view configuration

The "UMTS TrCH View" configuration menu selects the columns in the view tables,
defines the time window and displays information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "UMTS Transport Channel View" window lists the complete set of DL/UL transport
channel parameters that is displayed (default), see "TrCH uplink" on page 751 and
"TrCH downlink" on page 750). Clearing a parameter hides the column in the table.

Restricting viewed results
Restricting the viewed results makes it easier to read the tables if only a subset of
available parameters are needed. To restrict the number of measured parameters and
enhance the system performance, use the settings in the device configuration menu.
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Figure 4-375: UMTS TrCH View - configuration

Time Window for DL/UL
Time after which a table row for a removed TrCH channel is cleared in the UMTS TrCH
view DL and UL tables. Cleared table rows leave room for new entries.

4.4.3.4  UMTS physical channels view

The "UMTS Physical Channels View" shows an overview of the physical channel
parameters in the downlink and uplink WCDMA signals. A Qualcomm mobile must be
used to record the data.

The view is empty unless the test mobile is configured to record the "WCDMA Com-
mon Physical Channels Downlink", "WCDMA Dedicated Physical Channels Downlink",
"WCDMA Physical Channels Uplink", or "WCDMA PRACH" parameters; see descrip-
tion of the Expert Mode tab of the device configuration menu.
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Figure 4-376: UMTS Physical Channels View

The results for each mobile are arranged in a separate tab.

View area

The entire view area is horizontally split to accommodate four different tables for the
"Common Physical Channels" (downlink), "Dedicated Physical Channels" (downlink),
"Uplink Physical Channels", or "PRACH".

A click one of the title bars compresses and expands the corresponding table. A com-
pressed table leaves more space for the other tables. A compressed table is character-
ized by the symbol >>> (instead of <<<) in its title bar. On pausing on one of the title
bars, the cursor displays a compress symbol.

The contents of both tables can be selected in the configuration menu.

Common physical channels

Parameters of the downlink common physical channels.

Each table row represents a single physical channel that has been added during the
measurement (and possibly removed). A new table row is created each time that a
new physical channel is added. On the other hand, a table row for a removed physical
channel is deleted after the "Time Window for DL/UL" set in the configuration menu.

Clicking an entry in the table heading sorts the cells according to the corresponding
parameter. A gray triangle in the heading pointing upward (downward) indicates that
the table is sorted in ascending (descending) order.

● #
Color scheme to distinguish channels with different scrambling codes and
sequence number

● State
Physical channel state: Added (allocated) or "Released"

● Type
Physical channel type: PICH, AICH, DPCH, PDSCH, SCCPCH0, SCCPCH1 (on
FACH), AICH, PCCPCH_S(serving), PCCPCH_N(eighbor),

● Slot Format
Slot format of the SCCPCH in the range 0 to 16
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● SC
Primary scrambling code of the signal in the format selected in the TEC for UMTS
Test Mobiles tab of the Configuration of Software Modules menu; refer to chapter
Chapter 3.8.2, "Overview of settings (configuration of software modules)",
on page 279. The primary SC is used to identify the cell.

● Diversity
Downlink transmit diversity scheme for the CPICH: STTD (Space Time Transmit
Diversity), TSTD (Time Switched Transmit Diversity), SSDT (Site Selection Diver-
sity Transmit Power Control), or "No Diversity"

● CCTrCH ID
Composite Coded Transport Channel ID in the range 0 to 15, identifies unambigu-
ously a CCTrCH inside a Radio Link.

● T Offset
Time offset of the channel relative to the frame boundary, in 156-chip units (corre-
sponding to 1/10 slot or 1/150 frame).

● Code
Channelization code number assigned to the channel

● T Add
Time when the physical channel was added

● T Released
Time when the channel was removed/released

Dedicated physical channels

Parameters of the downlink dedicated physical channels (DPCHs). In addition of the
parameters for the Common Physical Channels, the table contains the following
entries:
● #RL

Sequence number for the radio links that the test mobile establishes to the network
● 2nd SC

Secondary Scrambling code number. “---” or “0” is displayed if a primary scrambling
code is used.

Uplink physical channels

Parameters of the uplink physical channels (DPCCH/DPDCH). The table contains the
following entries:
● Tx Power Max

Maximum transmit power of the test mobile (+33 dBm, +27 dBm, +24 dBm or +21
dBm for power class 1, 2, 3, or 4 mobiles)

● Power Offset
DPCCH power offset in dB. The DPCCH power offset is a reference value for the
initial DPCCH power:
PDPCCH = Power Offset – CPICH_RSCP

● PCP Length
Length of the Power Control Preamble in slots

● PC
Power control algorithm (PCA1 or PCA2)
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● TPC
Transmit Power Control step size in dB

● TFCI
Presence of the optional Transport Format Combination Indicator

● FBI
Number of Feedback Information bits (0 to 2)

● Punc. Limit
Uplink puncturing limit limits the amount of puncturing that can be applied to mini-
mize the number of physical channels.

● TX Power Init.
Initial TX power of the test mobile

● Slot Format
UL DPCCH slot format

● SC Type
Scrambling code type (Long or Short)

● SC
UL scrambling code number

● SF Min.
Minimum allowed spreading factor

PRACH

Parameters of the uplink Physical Random Access Channel (PRACH), relevant for the
physical random access procedure of the test mobile (3GPP TS 25.214). Some of the
parameters are analogous to the Uplink Physical Channel parameters.

Besides the table contains the following entries:
● Mask 1

PRACH preamble signature in the range 0 to 15
● Mask 2

PRACH subchannel in the range 0 to 11; see 3GPP TS 25.216.
● SC Index

PRACH scrambling code index
● TrCH ID

Transport channel number assigned to L1 by L2. Transport channels are multi-
plexed to the CCTrCH in the ascending order of these IDs

● PWF
PRACH preamble power step size, transmit power difference between two consec-
utive PRACH preambles

● Max. Retrans.
Maximum number of preambles to be transmitted before a single preamble cycle is
terminated.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS physical channels view configuration

The "UMTS Physical Channels View" configuration menu selects the columns in the
view tables, defines the time window and displays information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "Physical Channel View" tab displays the complete parameter set to be displayed
in the view tables (see description in chapter "Dedicated physical channels"
on page 755). Clearing a parameter hides the column in the table.

Restricting viewed results
Restricting the viewed results makes it easier to read the tables if only a subset of
available parameters are needed. To restrict the number of measured parameters and
enhance the system performance, use the settings in the device configuration menu.
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Figure 4-377: UMTS Physical Channels View

Time Window for Downlink Lists
Time after which a table row for a removed physical channel is cleared in the "Com-
mon Physical Channel" and "Dedicated Physical Channel" tables. Cleared table rows
leave room for new entries.

4.4.3.5  UMTS SIB view

The "UMTS SIB View" shows a tree view of the exchanged System Information Blocks.
The block type ("Master Information Block", "Scheduling Block 1 and 2", "System Infor-
mation Block type 1 to 18") can be selected from a pull-down list. The SIB types and
their information elements are described in standard 3GPP TS 25.331.

The view is empty unless the test mobile is configured to record the "Layer 3 –
WCDMA RRC Signaling Messages"; see description of the "Expert Mode" tab of the
device configuration menu in chapter 6.
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Figure 4-378: UMTS SIB View

The results for each mobile are arranged in a separate tab.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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The configuration menu displays information about the view version in the mobile/tech-
nology common "Info" page.

4.4.3.6  UMTS RLC/MAC view

The "UMTS RLC/MAC View" displays important Radio Link Control/Medium Access
Control parameters of UMTS mobile phones. To record the RLC/MAC parameters, a
Qualcomm test mobile must be used and recording of all layer 2 RLC and MAC mes-
sages must be enabled in the device configuration menu.

Figure 4-379: UMTS RLC/MAC View

View

The RLC/MAC parameters for each mobile and for the uplink and downlink are
arranged in separate tabs. Each tab is divided into a RLC/MAC channel list in the
upper part plus a detailed message section in the lower part.

A click the "Uplink (Downlink) RLC/MAC Channels" title bar shows or hides the
RLC/MAC channel list. A hidden list leaves more space for the detailed message sec-
tion. A hidden list is characterized by the symbol >>> (instead of <<<) in the title bar.
On pausing on the title bar, the cursor displays a compress symbol.
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The contents of the RLC/MAC channel list can be selected in the configuration menu.

RLC/MAC channels

The channel lists monitor the RLC/MAC channels in uplink (mobile station towards
base station) and downlink (base station towards mobile station) direction, respectively.
The MAC and RLC protocols are specified in standards 3GPP TS 25.321 / TS 25.322
and related standards.

● ID
Logical channel identifier.

● Type
Logical channel type: "CCCH", "SHCCH", "DCCH" or "DTCH" in uplink direction,
"BCCH", "PCCH", "SHCCH", "CCCH", "DCCH", "DTCH", "CTCH" in downlink
direction. The logical channels depend on the "RLC" Mode.

● RLC Mode
Type of service that the RLC provides to higher layers: "AM Data" ("Acknowledged
Mode Data transfer"), "TM" ("Transparent Mode data transfer"), "UM" ("Unacknowl-
edged Mode data transfer").

● RB ID
Radio Bearer identity, required by RLC for ciphering.

● TrCH ID
Transport Channel identity of the TrCH on which the MAC operates.

● TrCH Type
Transport Channel type: "DCH", "DSCH", "FACH", "RACH", "PCH", "BCH", (in
"FDD": "CPCH", "USCH").

● Ciphering
Ciphering mode: Information whether ciphering is used in RLC.

● Ciph. ID
Ciphering key

● HFN RLC
Hyper Frame Number ("RLC AM HFN" or "RLC UM HFN")

● State
RLC state, protocol state for RLC modes AM Data and TM (AM/TM Data Transfer
Ready, Null State)

Detailed messages

The detailed message section is filled when a RLC/MAC channel is selected in the list.
The detailed messages depend on the RLC Mode and the signal direction (uplink/
downlink). An example is shown in figure 4-379 "UMTS RLC/MAC View" above.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS RLC/MAC view configuration

The "UMTS RLC/MAC View" configuration menu selects the columns in the view tables
and displays information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "RLC/MAC View" tab displays the complete parameter set to be displayed in the
RLC/MAC channel lists (see chapter "RLC/MAC channels" on page 761). Clearing a
parameter hides the column in the table.

Restricting viewed results
Restricting the viewed results makes it easier to read the tables if only a subset of
available parameters are needed. To restrict the number of measured parameters and
enhance the system performance, use the settings in the device configuration menu.
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Figure 4-380: UMTS RLC/MAC View - configuration

4.4.3.7  UMTS measurement report view

The "UMTS Measurement Report View" shows the intra-frequency measurement
results that the test mobile sends to the network in a "Measurement Report" RRC mes-
sage. The message contents are described in standard 3GPP TS 34.108.

The view is empty unless the test mobile is configured to record the "Layer 3 –
WCDMA RRC Signaling Messages"; see description of the "Expert Mode" tab of the
device configuration menu.

Figure 4-381: UMTS Measurement Report View

The results for each mobile are arranged in a separate tab.
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Intra frequency measurements

Parameters of the downlink common physical channels.

Each table row represents a physical channel of a definite channel type that has been
allocated without interruption. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A gray triangle in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

● #
Color scheme to distinguish channels with different scrambling codes and
sequence number

● SC
Primary scrambling code of the signal in the format selected in the "TEC for UMTS
Test Mobiles" tab of the "Configuration of Software Modules" menu; refer to chapter
Chapter 3.8.2, "Overview of settings (configuration of software modules)",
on page 279. The primary SC is used to identify the cell.

● Ec/Io [dB]
Ratio of the received energy per PN chip for the signal to the total received power
spectral density at the mobile antenna connector."Ec/Io" is obtained in an unbiased
measurement, i.e. the contribution of the noise floor to the powers is subtracted off.

● RSCP
CPICH Received Signal Code Power in dBm; the received power on one code,
measured on the Primary CPICH.

● PL
Downlink path loss: P-CPICH power reported by the NodeB minus RSCP.

● COUNT-C-SFN
Value of the "COUNT-C-SFN" high parameter transmitted in the cell synchroniza-
tion information; see standard 3GPP TS 25.331, section 10.3.7.6. The value is an
integer number of frames between 0 and 3840.

● OFF
Value of the "OFF" parameter transmitted in the cell synchronization information;
see standard 3GPP TS 25.331, section 10.3.7.6. The value is an integer number of
frames between 0 and 255.

● Tm
Value of the "Tm" parameter transmitted in the cell synchronization information;
see standard 3GPP TS 25.331, section 10.3.7.6. The value is an integer number of
frames between 0 and 38399.

● SFN-CFN
"System Frame Number (SFN) – Connection Frame Number (CFN)"
Observed time difference in chips, given by
"SFN-CFN = OFF*38400 + Tm"

See standard 3GPP TS 25.215, section 5.1.8.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The configuration menu displays information about the view version in the mobile/tech-
nology common "Info" page.

4.4.3.8  UMTS power control view

The "UMTS Power Control View" shows the transmitter output power of a UMTS
mobile and the parameter that the network uses for closed loop power control.

The results for each mobile are arranged in a separate tab. Each tab consists of two
panels.

Tx power

Series of bar graphs showing the transmitter output power parameters of the UMTS
mobile during its last random access procedure. The parameters are updated after
each random access procedure.

● Current Tx Power
Current Tx power of the mobile in dBm.

● Init. Tx Power
1st PRACH preamble power

● Message Tx Power
Tx power after the end of the preamble sequence, used for transmission of the
RACH message part.

● P0 Parameter
Optional downlink power control parameter. If P0 is not present, then downlink
power control is not used.

● Preamble Count
Number of PRACH preambles transmitted by the test mobile

Power control

Table of closed loop power control parameters. The parameters are updated while a
connection is maintained.

● Algorithm
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Power control algorithm used to control the uplink power. Algorithm 1 means that
the mobile power changes after each slot by the Step Size. Algorithm 2 means that
the mobile power only changes if the same Transmit Power Control (TPC) com-
mand is received in a group of 5 consecutive slots.

● Step Size
Power step that the mobile transmitter performs according to the received TPC pat-
tern and the power control algorithm.

● Close Loop Div.
Information whether the mobile uses closed loop mode transmit diversity.

● Compressed Mode
Information whether the mobile operates in compressed mode. In compressed
mode the mobile transmitter is switched off in periodic gaps so that the mobile can
monitor UMTS and GSM neighbor cells.

● UL/DL Power Control Commands
Total number of power-down (decrease) and power-up (increase) commands
among the last 1500 transmit power control (TPC) commands. If power control
algorithm 1 is active, the difference between both DL numbers indicates the net
power change of the mobile.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "UMTS Power Control View" has no configuration menu assigned.

View further signals

To view the further available signals, use the basic "Alphanumeric View" and select the
signals from the corresponding Figure 4-47.

For Qualcomm chip-set based mobiles, additional UMTS power control signals are
available in the signal tree below "RACH Parameters".
● # of Transmitted Preambles
● Last Power Setting

4.4.3.9  UMTS reselection view

The "UMTS Reselection View" shows parameters that are used for cell reselection of
UMTS mobile phones. The reselection process and the parameters are described in
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standard 3GPP TS 25.304. To record the parameters, "Cell Reselection" must be
enabled in the "Extra settings" tab of the UMTS mobile device configuration menu, see
chapter 6.

Figure 4-382: UMTS Reselection View

View

The view is divided into a UMTS cell list in the upper part and a GSM neighbor cell list
in the lower part.

A click the "UMTS (GSM) Reselection Channels" title bar shows or hides the corre-
sponding cell list. A hidden list leaves more space for the other list. A hidden list is
characterized by the symbol >>> (instead of <<<) in the title bar. On pausing on the
title bar, the cursor displays a compress symbol.

The contents of the cell lists can be selected in the configuration menu.

UMTS IRAT measurements

The UMTS cell list shows the IRAT measurement parameters of the UMTS cells, listed
in the order they are detected and reported by the mobile.

● Color Symbol
Color code for the Primary SC as defined in the "Colors" tab of the configuration
menu.
The SC color codes are also shown in the "ROMESMAP Route Track" view.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● UARFCN
UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL
signal. The carrier frequency is equal to "f = 0.2 MHz * UARFCN".

● SC
Primary scrambling code of the signal used to identify a cell.
The format is selected in the "TEC for UMTS Test Mobiles" tab; refer to section
"Configuration Menu" in chapter 3.

Mobile views



Display and evaluation of resultsDrive Test Software

768Operating Manual 1171.6415.12 ─ 66

● RSCP
CPICH Received Signal Code Power in dBm; the received power on one code,
measured on the Primary CPICH.

● Rank RSCP
Cell reselection criterion (cell ranking) Rs or Rn for serving cell or neighbor cell,
computed as per 3GPP TS 25.304. Range 0 to 200 or ‘---‘ if ranking is not done.

● Ec/Io
Ratio of the received energy per PN chip for the signal to the total received power
spectral density at the mobile antenna connector. Ec/Io is obtained in an unbiased
measurement, i.e. the contribution of the noise floor to the powers is subtracted off.

● Rank Ec/Io
Cell reselection criterion (cell ranking) Rs or Rn for serving cell or neighbor cell,
computed as per 3GPP TS 25.304. Range 0 to 200 or ‘---‘ if ranking is not done.

● NodeB
Name of the NodeB, taken from the UMTS NodeB database (if available).

GSM IRAT measurements

The GSM cell list shows the IRAT measurement parameters of the GSM neighbor
cells, listed in the order they are detected and reported by the mobile.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1

● ARFCN
Absolute Radio Frequency Channel Number of the received GSM neighbor cell
signal

● BCC
BTS Color Code

● NCC
Network Color Code

● RSSI
Received Signal Strength Indicator of the received GSM channel power in dBm

● Rank
Determines how much is the neighbor cell better, relative to the serving cell (range
0 to 200)

● State
The state of a GSM cell: verified (V) or not verified (NV)

● BTS Name
Name of the BTS, taken from the GSM BTS database (if available)
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

UMTS reselection view configuration

The "Reselection View" tab displays the complete parameter set to be displayed in the
reselection parameter lists (see description in chapter "UMTS IRAT measurements"
on page 767). Clearing a parameter hides the column in the table.

Restricting viewed results
Restricting the viewed results makes it easier to read the tables if only a subset of
available parameters are needed. To restrict the number of measured parameters and
enhance the system performance, use the settings in the device configuration menu.

Figure 4-383: UMTS Reselection View - configuration
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4.4.3.10  UMTS Layer 1 graph view

The "UMTS Layer 1 Graph View" contains a Cartesian diagram to display UMTS or
GSM layer 1 parameters as a function of time. It corresponds to the Figure 4-19) with a
special selection of signals in the configuration menu. The controls in the view, in the
context menu, and in the configuration menu are identical with the "2D Chart View".

Figure 4-384: UMTS Layer 1 Graph View

4.4.4  GPRS views

The "GPRS Views" display parameters of the operating state of GPRS-supporting
mobile phones, related parameters contained in the layer messages, Packet Data Pro-
tocol (PDP) parameters, Radio Link Control/Medium Access Control parameters, a
statistical evaluation of the number of timeslots (TS) that are active in the connection,
exchanged RLC/MAC block header information, control and physical parameters of a
GPRS/EGPRS connection, and the RLC or MAC Release indicators,

The GPRS views can be selected from a submenu displayed on the right side of the
View menu when the mouse pauses over "GPRS Views".

Figure 4-385: GPRS views
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4.4.4.1  Mobiles to provide GPRS parameters

The GPRS views described in this section require corresponding mobiles. The follow-
ing test mobiles are known which provide GPRS parameters:
● Siemens (S55, S55-R) mobiles

They have to be used in Data/Trace mode and the splitter box must be connected
to provide two COM ports, see Chapter 6.1.3.2, "Splitter box (mobiles supporting
GPRS)", on page 1456.

● Qualcomm test mobiles and Qualcomm-compatible test mobiles such as Samsung
They are connected via USB interface.

4.4.4.2  GSM GPRS state view

The "GSM GPRS State View" displays parameters characterizing the operating state of
mobile phones supporting GPRS. The parameters are shown for all mobiles that are
used in the current measurement or recorded in the replayed measurement file.

Figure 4-386: GSM GPRS State View

The operating state parameters are arranged with separate columns for each mobile in
the table. The width of the columns can be varied with a drag-and-drop mechanism in
the header of the table. Part of the information is also displayed in chapter Chap-
ter 4.4.4.4, "GSM GPRS RLC/MAC view", on page 774.

The "GSM GPRS State" view has no context menu for configurations assigned.
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The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

● GMM Service State
GPRS Mobility Management service state: Ready, Idle or Stand-by.

● SNDCP Header Compr.
Compression information from the Subnetwork Dependent Convergence Protocol:
Header compression "Used" or "Not used".

● SNDCP Data Compr.
Compression information from the Subnetwork Dependent Convergence Protocol.
Data compression Used or Not used.

● CS UL / CS DL
Channel coding scheme (CS1 to CS4) used in uplink (UL) and downlink (DL) direc-
tion.

● TBF UL / TBF DL
Status of the Temporary Block Flow (TBF) in uplink (UL) and downlink (DL) direc-
tion: open (during data transfer) or closed.

● TS Conf. UL / DL
Timeslot configuration in uplink (UL) and downlink (DL) direction.

4.4.4.3  GSM GPRS PDP info view

The "GSM GPRS PDP Info View" displays important Packet Data Protocol (PDP)
parameters of mobile phones supporting GPRS. The parameters are shown for all
mobiles that are used in the current measurement or recorded in the replayed mea-
surement file.

Figure 4-387: GSM GPRS PDP Info View

The PDP parameters are arranged in the separate tables for each mobile. The number
of columns per mobile depends on the mobile itself. The width of the columns can be
varied with a drag-and-drop mechanism in the header of the table.

The "GSM GPRS PDP Info" view has no context menu for configurations assigned.

Mobile views



Display and evaluation of resultsDrive Test Software

773Operating Manual 1171.6415.12 ─ 66

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

● SM State
One of the four values PDP Active, PDP Active Pending, PDP Inactive, PDP Inac-
tive Pending. If SM State = PDP Inactive or PDP Active Pending, then some of the
other parameters of the view are invalid.

The following five parameters indicate the Quality of Service (QoS) of the PDP:
● Reliability Class

The reliability class indicates the probability of loss, duplication, mis-sequencing or
corruption of Service Data Units (SDU). This translates into the transmission char-
acteristics that are required by an application. :
The reliability classes are as specified in GSM 04.08
– Acknowledged GTP, LLC, and RLC, Protected data
– Unacknowledged GTP, Acknowledged LLC and RLC, Protected data
– Unacknowledged GTP and LLC, Acknowledged RLC, Protected data
– Unacknowledged GTP, LLC and RLC, Protected data
– Unacknowledged GTP, LLC and RLC, Unprotected data

● Delay Class
Defines the maximum delay to be incurred by the transfer of data through the
GPRS network. Four delay classes 1 (smallest delay) to 4 (largest delay; maximum
delay not specified) are defined.

● Precedence Class
Indicates the relative priority of maintaining the service. The following three prece-
dence classes are defined:
– High Priority

Service commitments will be maintained ahead of all other priority levels.
– Normal Priority

Service commitments will be maintained ahead of low priority users.
– Low Priority

Service commitments will be maintained after the high and normal priority com-
mitment has been fulfilled.

● Peak Throughput
Maximum user data throughput (bit rate) requested by the user.

● Mean Throughput
Mean user data throughput (bit rate) requested by the user, including periods in
which no data is transmitted.

● Radio Priority
Radio priority of the requested TBF; one of the levels between Level 1 (highest pri-
ority) and Level 4 (lowest priority, corresponding to the highest throughput).

● NSAPI
Network layer Service Access Point Identifier; integer number that, together with
the Temporary Logical Link Identity (TLLI), is used for network layer routing.
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● IPv4
Internet Protocol address according to the IETF convention.

● SAPI
Network Service Access Point Identifier. An integer value in the range [0; 15], iden-
tifying a PDP context belonging to a specific MM Context ID.

● A/U
Acknowledge mode or Unacknowledge mode.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.4.4  GSM GPRS RLC/MAC view

The "GSM GPRS RLC/MAC View" displays important Radio Link Control/Medium
Access Control parameters of mobile phones supporting GPRS and EDGE. The
parameters are shown for all mobiles that are used in the current measurement or
recorded in the replayed measurement file.
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Figure 4-388: GSM GPRS RLC/MAC View – GPRS view
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Figure 4-389: GSM GPRS RLC/MAC View – EDGE view

For each mobile, the RLC/MAC parameters are arranged in six panels. The mobile
type and its power class are indicated above the Uplink panel.

The "GSM GPRS RLC/MAC" view has no context menu for configurations assigned.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

Uplink / downlink

The "Uplink and Downlink" panels monitor the Temporary Block Flow (TBF) in uplink
(mobile station towards base station) and downlink (base station towards mobile sta-
tion) direction, respectively. The TBF is a temporary physical connection between the
mobile and the base station that is maintained only for the duration of the data transfer.
● TBF

Status of the TBF: open (during data transfer) or closed.
● TFI
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Temporary Flow Identity. Together with the direction (uplink or downlink), the TFI
uniquely identifies a RLC data block.

● CS
GPRS channel coding scheme (CS1 to CS4) or EDGE modulation and coding
scheme (MCS1 to MCS9). A diagram makes it easy to notice changes of the cod-
ing scheme.
– The EDGE diagram consists of 9 bars, corresponding to the modulation and

coding schemes MCS1 to MCS9.

– The GPRS diagram consists of 4 bars, corresponding to the coding schemes
CS1 to CS4.

● TS
Timeslot used for the TBF. The LED symbols light while the TBF occupies one or
several of the timeslots 0 to 7.

RLC/MAC information

The RLC/MAC Information panel displays the following information:
● Ack Mode

RLC mode: Acknowledge mode or Unacknowledge mode.
● Type of Allocation

MAC mode; medium access method to be used during the TBF: Dynamic alloca-
tion, Fixed allocation or No allocation

● MS Output Power
Output power of the mobile station in dBm.

● Netw. Control Order
Current value of the NETWORK_CONTROL_ORDER parameter defined in GSM
05.08. This parameter controls the measurement reports provided by the mobile
and its cell re-selection. Possible values are:
– NC0

Normal MS control: MS performs autonomous cell re-selection
– NC1

Normal MS control with measurement reports
– NC2

Network control. MS sends measurement reports but does not perform autono-
mous cell re-selection

● RESET
The MS returns to the broadcast parameters. Only sent on PCCCH or PACCH

● PC_MEAS_CHAN
Channel where the measurements for power control are made: BCCH or PDCH.

● C_VALUE
Value of the C parameter calculated by the mobile station; relevant for the channel
quality report.

● SIGN_VAR
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Value of the signal variance parameter calculated by the mobile station; relevant for
the channel quality report.

● SPLIT_PG_CYCLE
Optional parameter specified in GSM 05.08 controlling the occurrence of paging
blocks on CCCH or PCCCH belonging to the mobile station in DRX (Discontinuous
Reception) mode.

● PRIORITY_ACCESS_THR
Control parameter indicating whether packet access is allowed and for which prior-
ity level it is allowed.

● CONTROL_ACK_TYPE
Default format of the PACKET CONTROL ACKNOWLEDGMENT message: either
4 Access Bursts or RLC/MAC Control Block.

● ACCESS_BURST_TYPE
Access burst format: 8 Bit Access Bursts or 11 Bit Access Bursts.

● RxQual
Received signal quality reported by the mobile.

GMM info

The GMM Info panel displays the following GPRS Mobility Management information:
● Attach State

GPRS operating mode of the mobile: – (not available), Attached, IMSI Attached,
Combined Attached, Not Attached

● Service State
GPRS operating mode of the mobile: – (idle/not available), Stand By or Ready.

● P-TMSI
Packet TMSI of the mobile, transferred to the network during a GPRS attaches.

● TLLI
Temporary Logical Link Identity, code number to identify the mobile at the
RLC/MAC layer.

● MNC
Mobile Network Code

● MCC
Mobile Country Code

● LAC
Location Area Code

● CI
Cell Identity

● Mode
Network mode of operation 1, 2, or 3.

● T3314
Ready timer used in the MS and in the network for each assigned P-TMSI to con-
trol the cell updating and paging process.

● RAC
Routing Area Code; fixed length code (of 1 octets) identifying a routing area within
a location
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SNDCP compression

The "SNDCP Compression" panel indicates whether or not the mobile uses compres-
sion of the Subnetwork Dependent Convergence Protocol (SNDCP) information (GSM
04.65). Protocol control information compression is an optional SNDCP feature that
helps to improve channel efficiency.

The TCP/IP Header and Data Compression are indicated in separate boxes. A red box
indicates that compression is enabled.

QoS information

The QoS Information panel indicates parameters describing the user data throughput
and reliability of the GPRS connection. The parameters characterize the quality of ser-
vice (QoS); see GSM 02.60.
● UL Retransmission Rate

Number of unacknowledged uplink (UL) frames that the mobile had to retransmit
for error recovery

● UL Data Rate
UL data rate in bytes/s

● UL Total Blocks
Total number of UL data blocks transferred

● DL Retransmission
Rate Number of unacknowledged downlink (DL) frames that the base station had
to retransmit for error recovery

● DL Data Rate
DL data rate in bytes/s

● DL Total Blocks
Total number of DL data blocks transferred

● Block Error Rate
Ratio of blocks received with error at the mobile to total number of received blocks
(GSM 11.10).

Interference levels

The Qualcomm based mobiles report the SNR values per ARFCN / timeslot pair (see
chapter Chapter 4.4.4.7, "GSM GPRS/EGPRS view", on page 785). The value, which
is displayed in the field is the average of the reported values for the corresponding
timeslot over all ARFCNs.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,
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- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.4.5  GSM GPRS TS/CS view

The "GSM GPRS TS/CS View" provides a statistical evaluation of the number of time-
slots ("TS") that are active in the connection and of the Coding Scheme ("CS") that is
used for the transmission of radio blocks. EDGE MCS statistics are also supported. All
parameters are shown for the uplink and downlink.

Figure 4-390: GSM GPRS TS/CS Views (for GPRS and EDGE)

UL TS / DL TS

Distribution in time of the number of timeslots used in the connection: Ratio of the time
during which each number of timeslots is active to the total connection time. The ratios
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are expressed as percentages and visualized with colored bars. The length of the bars
is proportional to the percentages; the sum of all percentages adds up to 100 %.

The maximum number of timeslots displayed can be selected in the configuration
menu.

UL CS / DL CS

Distribution in time of the coding scheme used in the connection: Ratio of the time dur-
ing which each coding scheme is used to the total connection time. The ratios are
expressed as percentages and visualized with colored bars. The length of the bars is
proportional to the percentages; the sum of all percentages adds up to 100 %.

The maximum CS number displayed can be selected in the configuration menu.

The display of the fields UL MCS / DL MCS can be selected in the configuration menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM GPRS TS/CS view configuration

The "GPRS QoS View" configuration dialog lets the user define the contents of the
view.
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Figure 4-391: GSM GPRS TS/CS View - configuration

Settings
Clearing the "Show Number of Time Slots…" or "Show Coding Scheme…" check box
entirely hides the corresponding diagram in the view.
In addition, it is possible to simplify the diagrams by restricting the maximum number of
time slots to less than 8 or the number of coding scheme to less than 4. This makes it
easier to read the diagram, especially if the maximum number of TS and maximum CS
is known.
The "Supported Coding Scheme" drop-down boxes offer the options for GPRS or
GPRS + EGPRS coding scheme statistic graphs. If GPRS + EGPRS is selected, the
"DL MCS" and "UL MCS" fields are shown in the view. Otherwise (GPRS is selected)
they are hidden.

4.4.4.6  GSM GPRS RLC/MAC header view

The "GSM GPRS RLC/MAC Header View" shows the exchanged RLC/MAC block
header information. The RLC/MAC header contents depend on the transmission direc-
tion (UL/DL); they are described in standard 3GPP TS 44.060.
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Figure 4-392: GSM GPRS RLC/MAC Header View

For each mobile, the RLC/MAC header information is arranged in a table. The width of
the columns can be varied with a drag-and-drop mechanism in the header of the table.

The "GSM GPRS RLC/MAC Header" view has no context menu for configurations
assigned.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

List of entries

Each RLC/MAC header forms a list with the entries described below. Some of the val-
ues are only available for a particular direction (uplink or downlink).
● @

Timestamp assigned to the header
● Message Type

Data block or message type transmitted in the RLC/MAC block
● TFI 5-bit

Temporary Flow Identity identifies the Temporary Block Flow (TBF) to which the
RLC data block belongs.

● BSN
Block Sequence Number, carries the sequence absolute Block Sequence Number
(BSN) modulo Sequence Number Space (SNS) (128 in GPRS and 2 048 in
EGPRS) of each RLC data block within the TBF.

● Ext.
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Extension bit indicates the presence of an optional octet in the RLC data block
header (0: Extension octet follows immediately; 1: No extension octet follows).

● RRBP
Relative Reserved Block Period specifies a single uplink block in which the mobile
station shall transmit either a PACKET CONTROL ACKNOWLEDGEMENT mes-
sage or a PACCH block to the network.

● USF
Uplink State Flag, sent in all downlink RLC/MAC blocks, indicates the owner or use
of the next uplink radio block on the same timeslot.

● PR
Power Reduction field, indicates the power level reduction of the current RLC
block.

● FBI
Final Block Indicator indicates whether the downlink RLC data block is the last RLC
data block of the downlink TBF.

● CV
4-bit Countdown Value, sent by the mobile station to allow the network to calculate
the number of RLC data blocks remaining for the current uplink TBF.

● SI
Stall Indicator bit, indicates whether the mobile's RLC transmit window can
advance (i.e. is not stalled, value 0) or can not advance (i.e. is stalled, value 1).

● R
Retry bit, indicates whether the mobile station transmitted the CHANNEL
REQUEST message, PACKET CHANNEL REQUEST message, or EGPRS
PACKET CHANNEL REQUEST message one time or more than one time during
its most recent channel access.

● TI
TLLI Indicator bit indicates the presence of an optional TLLI field within the RLC
data block.

Detailed information

An upper case D appears to the right of the cursor arrow when it is placed in the active
(gray) zone of the view. This symbol indicates that there is detailed information to be
retrieved for the current RLC/MAC header. A double-click opens the detailed informa-
tion window; see Chapter 4.4.4.4, "GSM GPRS RLC/MAC view", on page 774.

Detailed information window
The detailed information window is totally independent of the GSM, GPRS RLC/MAC
Header View, so you can move, resize and scroll it as you like. Click the printer symbol
in the lower right corner to generate a hard copy of the detailed in-formation. Alterna-
tively, you can write the detailed information into the table (e.g. if you wish to create a
hard copy), see the "Messages" tabs of the configuration menu.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.4.7  GSM GPRS/EGPRS view

The "GSM GPRS/EGPRS View" displays the control and physical parameters of a
GPRS and EGPRS connection.

If this view is used with an EDGE-enabled test mobile, it also displays EDGE-parame-
ters.

Figure 4-393: GSM GPRS/EGPRS View

For each mobile, the GPRS and EGPRS parameters are arranged in two panels and
two tables below.
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EGPRS parameters

The upper left panel shows the following EGPRS-related control parameters:
● EGPRS Supp.

EGPRS capability of the mobile phone ("Yes" or "No"). Most of the following param-
eters are only available if EGPRS is supported.

● LLC Uplink/Downlink Window Size
LLC window size, i.e. the maximum number of sequentially-numbered uplink/down-
link I frames that may be outstanding at any time. The window size is in the range
1 through 255 (see standard 3GPP TS 04.64).

● RLC Uplink/Downlink Window Size
RLC window size (no. of RLC data blocks) that the network selects for the uplink/
downlink, depending on the number of timeslots allocated (see standard 3GPP TS
44.060). For GPRS, a fixed window size of 64 is used.

● LQ Meas. Mode
Link Quality Measurement Mode (0 to 3), see standard GPP TS 04.60, sub clause
11.2.7.2.

● PacketCh Req.
EGPRS packet channel request supported in serving cell (Yes/No).

● MCS Uplink/Downlink
GPRS channel coding scheme (CS1 to CS4) or EGPRS modulation and coding
scheme (MCS1 to MCS9) used in the uplink and downlink.

● Reseg. Bit
Value of the resegment bit sent in the PACKET UPLINK ACH/NACK message, indi-
cating whether or not the transmitted RLC blocks shall be resegmented (see stan-
dard 3GPP TS 51.010).

● Pre-emptive Bit
Value of the pre-emptive transmission bit sent in the PACKET UPLINK ACH/NACK
message, indicating whether or not pre-emptive transmission shall be used.

The upper right panel shows a list of GPRS-related control parameters relevant for cell
reselection and described in standard 3GPP TS 04.60 and related standards.
● GPRS RXLEV ACCESS MIN

Minimum received signal level at the MS required for access to the system (value
range: 0 to 63).

● GPRS CELL RESEL HYST
Additional hysteresis applied in Ready state for cells in the same Routing Area
(value range: 0 dB, 2 dB,..., 14 dB).

● RA RESEL HYST
Additional hysteresis applied for cells in different Routing Areas (value range: 0 dB,
2 dB,..., 14 dB).

● RANDOM ACCESS RETRY
1-bit value, if set to 1, it indicates that the mobile station is allowed to try to access
another cell if available.

● T RESEL
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Delay time before a mobile is allowed to reselect a cell after an abnormal release
of the connection to this cell. T RESEL can be set to 8 discrete values between 5
seconds and 300 seconds.

GPRS/EGPRS measurements

Below the parameter panels of the "GSM GPRS/EGPRS View" presents an evaluation
of physical parameters of the GPRS/EGPRS connection that the mobile reports to the
network (see standard 3GPP TS 04.60 and related standards).
● Mean BEP

Mean value of the Bit Error Probability of the channel averaged over all timeslots in
the TBF. Two different values are calculated – one for GSMK (CS1-CS4, MCS1-
MCS4) and one for 8PSK (MDC5-MCS9). Range is 0 to 31; see 3GPP TS 04.60
and 3GPP TS 05.08.

● Var BEP
Variation coefficient for the Bit Error Probability averaged over all time slots of the
TBF. Two different values are calculated – one for GSMK (CS1-CS4, MCS1-MCS4)
and one for 8PSK (MDC5-MCS9). Range is 0 to 7; see 3GPP TS 05.08.

● Type
The table shows results from the serving cell ("SC") and up to six neighbor cells
(NC1, …, NC6), if available.

● ARFCN
Absolute Radio Frequency Channel Number used in the serving cell and the neigh-
bor cells.

● Prio
GPRS priority class, 3-bit value to indicate the HCS priority for the call.

● C32
Flag indicating an exception rule for GPRS_RESELECT_OFFSET according to
3GPP TS 05.08.

● RxLev
RxLev of the serving cell and the neighbor cells

GPRS/EGPRS traffic channels

The last part of the "GSM GPRS/EGPRS View" presents traffic channel related infor-
mation (for Qualcomm only):
● ARFCN

Absolute Radio Frequency Channel Number used in the serving cell and the neigh-
bor cells.

● TN
Time Slot Number

● Power
Received Power (in dBm)

● SNR
Signal-to-Noise ratio (in dB)

The mobile reports an "SNR" value and a "Power" value per ARFCN/timeslot pair.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.4.8  GSM GPRS RLC MAC release indicators view

The "GSM GPRS RLC MAC Release Indicators View" shows control and physical
parameters of the connection release information, such as the cause of the release,
statistical parameters and the release indicator description, if supplied.

Figure 4-394: GSM GPRS RLC MAC Release Indicators View

For each mobile, the RLC or MAC Release indicators are arranged in two lists. The
width of the columns can be varied with a drag-and-drop mechanism in the header of
the table.

Uplink / downlink table

Each RLC or MAC release indicator forms a table row with the entries described below.
● Cause

The cause of the RLC/MAC release
● Count

The number of measured release indicators of the current session
● %

Percentage of the related cause
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● Description
Release indicator description

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM GPRS RLC MAC release indicators view configuration

The configuration page let you select the contents of the view defines the contents of
the view.

Figure 4-395: GSM GPRS RLC MAC Release Indicators View - configuration

RLC/MAC Release Indicator Lists
In the "RLC Release Indicators Lists"/"MAC Release Indicators Lists" you can select
via the available check boxes the elements to be displayed in the uplink and downlink
RLC/MAC release indicator view tables.
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4.4.5  GSM views

The "GSM Views" display GSM-specific information included in the measurement data.
GSM data can be acquired using the supported GSM mobile devices. The devices are
attached to R&S ROMES4 by selecting the "Generic Mobiles GSM / WCDMA" option
in the "Available Devices" > "Mobile Devices" branch of the "Hardware" > "Hardware
Configuration" window.

Some of the views require a particular measurement mode or a GSM mobile support-
ing special features (for example, GPRS).

The GSM views can be selected from a submenu displayed on the right side of the
"View" menu when the mouse hovers over "GSM".

Figure 4-396: GSM views

The GSM mobile signals BCCH, CI, LAC, MCC, MNC, BSIC and C2 have been
assigned the same relation IDs like for the GSM NWS Top N signals. This helps the
operations with signals, for example, grouping in the GSM 2D chart view.

● GSM chart view.....................................................................................................790
● GSM dedicated 3G cell list view............................................................................792
● GSM frequency hopping view............................................................................... 794
● GSM idle 3G cell list view......................................................................................796
● GSM RR 3G reselection measurements parameters view................................... 799
● GSM RR 3G reselection measurements view.......................................................803
● GSM rejected 3G cells view..................................................................................805
● GSM system information view...............................................................................808

4.4.5.1  GSM chart view

The "GSM Chart View" displays "RxLev" and "RxQual" and "Frame Erasure Rate" of
the serving cell. Also is displayed "RxLev" of up to 6 neighbor cells, N1 to N6. The val-
ues are taken from the "Measurement Report". For detailed description of the parame-
ters, refer to Chapter 4.4.13.4, "GSM grid layout", on page 946.
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Figure 4-397: GSM Chart View

For the meaning of the panes and entires in the view, see Chapter 4.2.1, "2D chart
view", on page 448.

The view shows following GSM signal properties:
● "RxLev"

– "RxLev Full"
Received Signal Level assessed over the full range of TDMA frames within a
SACCH block.

– N1-N6 RxLev
Received Signal Level of the neighbour cells.

● "RxQual"
– "RxQual Full"

Received Quality assessed over the full range of TDMA frames within a
SACCH block.

● "FER"
– FER Full""

"Frame Erasure Rate" assessed over the full range of TDMA frames within a
SACCH block.

– "C1"
UE estimation parameter C1.

– "C2"
UE estimation parameter C2.
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Context menu

The "GSM Chart View" configuration is done in the "GSM Chart View: <variable> Prop-
erties" pane. Selecting the "Configure" command in the context sensitive menu of the
view opens only the "Info" page.

4.4.5.2  GSM dedicated 3G cell list view

The "GSM Dedicated 3G Cell List View" shows an overview of the measured 3G cell
parameters.

The view is empty unless the test mobile is configured to record the GSM 3G cell-rela-
ted messages.

Figure 4-398: GSM Dedicated 3G Cell List View

The results for each mobile are arranged in a separate tab.

Cell list

The cell list comprises the most important parameters of the serving cell and all other
cells that are currently used for the connection; its members are permanently moni-
tored and updated by the network.

Each table row represents a cell. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A gray triangle in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

● Color Symbol
Color code for the Primary SC as defined in the Colors tab of the configuration
menu.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● 3G NC Index
Index of the cell in the 3G neighbourhood Cell List.

● UARFCN
UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL
signal.
The carrier frequency is equal to f = 0.2 MHz * UARFCN
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● SC
Primary scrambling code of the signal in the format selected in the TEC for UMTS
Test Mobiles tab of the Configuration of Software Modules menu; refer to section
Configuration Menu in chapter 3. The primary SC is used to identify the cell.

● Diversity
Downlink transmit diversity scheme for the CPICH: STTD (Space Time Transmit
Diversity), TSTD (Time Switched Transmit Diversity), SSDT (Site Selection Diver-
sity Transmit Power Control), or No Diversity

● PN Pos. [Chips]
PN position in Chips, ranging from 0 to 38399.

● RSSI [dBm]
The received signal strength indicator of the cell on the forward traffic channel,
ranging from –109 to –21 dBm.

● Ec/Io [dB]
Ratio of the received energy per PN chip for the signal to the total received power
spectral density on the PCPICH. Ec/Io is obtained in an unbiased measurement, i.e.
the contribution of the noise floor to the powers is subtracted.

● RSCP
CPICH Received Signal Code Power in dBm; the received power on one code,
measured on the Primary CPICH.

● Expires [ms]
Time until this cell loses its known status.

● Q Search P
Quality threshold for reselection. L1 searches for 3G cells if the signal level is
below or above the threshold value.

● 3G Search Prio
Flag indicating if the idle frames in dedicated or packet transfer mode can be used
with priority for 3G measurements, when BSIC decoding is required.

● Node B
Name of the node B, taken from the UMTS Node B database (if available).

The "SC" value for each active set element generates signals in the "UMTS –
<Device> – Active Set" branch of the data tree.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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GSM dedicated 3G cell list view configuration

In the "GSM Dedicated 3G Cell List View" page you can select/deselect the parame-
ters to be viewed in the tables and see the information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The complete parameter set to be displayed in the cell list is by default selected in the
"3G cells in dedicated mode" field. If you deselect a parameter, the associated column
in the table is hidden.

Restricting the viewed results makes it easier to read the tables if only a subset of the
available parameters is needed. To restrict the number of parameters measured and
enhance the system performance, use the settings in the device configuration menu.

Figure 4-399: GSM dedicated 3G Cell List View - configuration

4.4.5.3  GSM frequency hopping view

The "GSM Frequency Hopping View" shows the channel information of a GSM (or
GPRS) connection that may or may not be operated in frequency hopping mode. The
parameters are shown for all mobiles that are used in the current measurement or
recorded in the replayed measurement file.

Mobile views



Display and evaluation of resultsDrive Test Software

795Operating Manual 1171.6415.12 ─ 66

Figure 4-400: GSM Frequency Hopping View

The hopping information provided by each mobile is displayed in a separate tab. Each
tab is divided into two panels showing the properties of the BTS and the channel
parameters of the RF connection, respectively.

BTS information

The upper panel indicates the channel number of the Broadcast Control Channel
BCCH) plus the base station name, if a BTS list is available.

Traffic channels

The panel below "BTS Info" shows the parameters of the RF connection.

Channel list

The channel list shows the sequence of GSM channel numbers ("ARFCN") and fre-
quencies used, together with the carrier-to-interference ratio ("C/I") and RxLev value
for each hopping frequency. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A blue arrow in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

Some of the parameters may not be provided by all test mobiles. The "C/I" is provided
by various test mobiles. The icons  and  denote what kind of service is used - CS
Circuit Switched (mobile) and Packet Switched (PS). In case of a PS connection addi-
tionally the timeslot is provided. If frequency hopping is off, the list shows only one traf-
fic channel. The list is empty if the mobile is in idle mode.

Mobile views



Display and evaluation of resultsDrive Test Software

796Operating Manual 1171.6415.12 ─ 66

Parameter list

The parameter list below the hopping channel list shows the properties of the dedica-
ted connection. It is not shown while the connection is "Idle". Some of the parameters
may not be provided by all test mobiles.
● TSC

Training sequence code of the RF channel.
● TS

Traffic channel timeslot number of the connection.
● MAIO

Mobile Allocation Index Offset in the range 0 to 63. The MAIO is only displayed if
frequency hopping is on.

● CH_Type
Channel type allocated for the connection: "TCH-F" (full-rate traffic channel), "TCH-
H" (half-rate traffic channel), "SDCCH/4" or "SDCCH/8".

● SubChNr
SDCCH sub-channel number as defined in section 7, tables 3 and 4 of standard
3GPP TS 05.02.

● HSN
Hopping Sequence Number in the range 0 to 63. The HSN is only displayed if fre-
quency hopping is on.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.5.4  GSM idle 3G cell list view

The "GSM Idle 3G Cell List View" shows an overview of the 3G cell parameters for
measured idle cells.

The view is empty unless the test mobile is configured to record the GSM 3G idle cell-
related messages.
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Figure 4-401: GSM Idle 3G Cell List View

The results for each mobile are arranged in a separate tab.

Cell list

The cell list comprises the most important parameters of the 3G cells that are currently
available for the connection; its members are permanently monitored and updated by
the network.

Each table row represents a cell. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A gray triangle in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

● Color Symbol
Color code for the Primary SC as defined in the "Colors" tab of the configuration
menu.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● UARFCN
UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL
signal.
The carrier frequency is equal to "f = 0.2 MHz * UARFCN"

● SC
Primary scrambling code of the signal in the format selected in the "TEC for UMTS
Test Mobiles" tab of the "Configuration of Software Modules" menu. The primary
SC is used to identify the cell.

● Diversity
Downlink transmit diversity scheme for the CPICH: "STTD" (Space Time Transmit
Diversity), "TSTD" (Time Switched Transmit Diversity), "SSDT" (Site Selection
Diversity Transmit Power Control), or "No" Diversity

● PN Pos. [Chips]
PN position in Chips, ranging from 0 to 38399.
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● Ec/Io [dB]
Ratio of the received energy per chip to the total received power density in the
band.

● RSCP [dBm]
Unbiased Integral Received Signal Code Power for all measured peaks in dBm.

● Thresholds valid
Indicates if GSM L1 should apply cell reselection criterion S to be reported to the
RR layer (see standard 3GPP TS 25.304).

● Ignore
Indicates if GSM L1 is not supposed to report this cell to the RR layer.

● SQual
Signal quality value used as a criterion for cell reselection.

● SRxLev
RxLevel value used as a criterion for cell reselection.

● Node B
Name of the closest node B with the corresponding SC and ARFCN.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM idle 3G cell list view configuration

In the "GSM Idle 3G Cell List View" page you can select/deselect the parameters to be
viewed in the tables and see the information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The complete parameter set to be displayed in the cell list is by default selected in the
"3G cells in idle mode" field. If you deselect a parameter, the associated column in the
table is hidden.
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Figure 4-402: GSM Idle 3G Cell List View - configuration

4.4.5.5  GSM RR 3G reselection measurements parameters view

The "GSM RR 3G Reselection Measurements Parameters View" shows the parame-
ters used for the Radio Resource 3G reselection measurements described in the previ-
ous sections.
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Figure 4-403: GSM RR 3G Reselection Measurements Parameters View

Parameters

The "GSM RR 3G Reselection Measurements Parameters View" displays the parame-
ters used for the Radio Resource 3G Reselection measurements, described in the fol-
lowing. Additional information on these parameters is available in standard 3GPP TS
51.010.

● Q Search P
Q Search P defines a threshold and also indicates whether these measurements
shall be performed when RLA_P of the serving cell is below or above the thresh-
old.

● Q Search I
For a multi-RAT MS, cells or frequencies with other radio access technologies may
be included in 3G Cell Reselection list (see 3GPP TS 04.18). The network controls
the measurements for reselection of idle cells by the parameter Qsearch_I broad-
cast on BCCH. Qsearch_I defines a threshold and also indicates whether these
measurements shall be performed when RLA_C of the serving cell is below or
above the threshold. The value of 7 indicates to always search for neighbouring 3G
cells, a value of 15 disables the search.
Search for 3G cells if signal level is below (0-7) or above (8-15) threshold
0 = - 98 dBm, 1 = - 94 dBm to 6 = - 74 dBm,
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7 = ∞ (always), 8 = - 78 dBm, 9 = - 74 dBm, and so on
14 = - 54 dBm, 15 = ∞ (never).
Default value = ∞ (never).

● Q Search C
As defined in 3GPP TS 45.008, the Q Search C parameter defines a threshold and
also indicates whether the mobile measures 3G cells when the average signal level
(RxLevel) of the BCCH carrier is below (0-7) or above the threshold (8-15). The
value of 7 indicates to always search for neighbouring 3G cells, a value of 15 disa-
bles the search.
Search for 3G cells if signal level below threshold (0-7):
- 98, - 94 to - 74 dBm, ∞ (always)
or above threshold (8-15):
- 78, - 74 to - 54 dBm, ∞ (never)

● Q Search C initial
Indicates the Q Search C value to be used in connected mode before the config-
ured Q Search C is received,
0 = use Q Search I, 1 = ∞ (always).
Default value = use Q Search I.

● 3G BA Ind.
The 3G_BA_IND message type parameter is needed to identify set of 3G Neighbor
Cell information used for reporting in dedicated mode. The value received is reflec-
ted in the Measurement Report and Enhanced Measurement Report messages as
described in standard 3GPP TS 04.18.

● 3G Search Prio
This parameter indicates if 3G cells may be searched when BSIC decoding is
required. With 3G Search Prio set to On, the MS attempts to demodulate the SCH
on the BCCH carrier of as many surrounding cells as possible, and to decode the
BSIC as often as possible, as a minimum at least once every 10 seconds. A multi-
RAT MS is allowed to extend this period to 13 seconds if the neighbor cell list con-
tains cells from other RATs. With 3G Search Prio set to Off, the BSIC is also deco-
ded, but only 2G neighbor cells are monitored.

● FDD Q Offset
"FDD Q min", "FDD Q Offset" and optionally "FDD RSCP min" and "FDD Qmin Off-
set" are broadcast on BCCH of the serving cell.
"FDD Q Offset" applies an offset to "FDD Q min" value:
0 = 0 dB, 1 = 2 dB, 2 = 4 dB, 3 = 6 dB,
4 = 8 dB, 5 = 10 dB, 6 = 12 dB, 7 = 14 dB.
Default value = 0 dB

● FDD GPRS Q Offset
Applies an offset to RLA_P for cell re-selection to access technology/mode: default
is –12 dB.

● FDD MultiRAT Report
The parameter "FDD MultiRAT Report" indicates a number of cells to be reported
in a measurement, e.g. "1" (one cell) report message and does not include the
number of places taken by RSSI reporting in the measurement report message. If
no measurements have been performed on a cell since last report, the cell shall
not be included in the report.
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The "FDD MultiRAT Report" parameter is broadcast on BCCH and PBCCH. An MS
attached to GPRS uses the parameter broadcast on PBCCH if it exists. In all other
cases, the MS uses the parameters broadcast on BCCH.

● FDD Q Min.
"FDD Q min" is defined as the minimum threshold for Ec/No for UTRAN FDD cell
reselection, its default value is 12 dB.

● FDD Report Offset
The "FDD Report Offset" parameter applies an offset to the reported value when
prioritizing the cells for reporting for GSM frequency band or access technology/
mode FDD.
Possible values are: 0 (0 dB), 1 (6 db), to 7 (42 dB). The default value is 0 dB.

● FDD Report Threshold
The "FDD Report Threshold" parameter applies priority reporting if the reported
value is above the thus defined threshold for GSM frequency band or access tech-
nology/mode FDD. The default value is "always"

● FDD Report Quantity
The parameter "FDD Report Quantity" is used to specify whether the MS reports
the results of the P-CPICH level measurement of the neighbouring 3G cells as
RSCP or as Ec/No, e.g. 0 = RSCP, 1 = Ec/No

● Index Start 3G
Each 3G neighbour Cell Description received is added to the 3G neighbor cell list,
starting with the index equal to the parameter "Index Start 3G". If this parameter is
not present then the value 0 is used.
For each 3G neighbour Cell Description, the cells are indexed in the following
order:
1) UTRAN FDD cell ARFCNs are indexed in the order of occurrence in the 3G
neighbor cell description. Then, for each FDD ARFCN, the cells are indexed in the
order of increasing values of the decoded FDD_CELL_INFORMATION parameters.
2) UTRAN TDD cell ARFCNs are indexed in the order of occurrence in the 3G
neighbor cell description. Then, for each TDD ARFCN, the cells are indexed in the
order of increasing values of the decoded TDD_CELL_INFORMATION parameters.
3) CDMA 2000 cells are indexed in the order of occurrence in the 3G neighbor cell
description.

● Report Type
The condition for sending the Packet Enhanced Measurement Report message
instead of the Packet Measurement Report message is based on the "Report Type"
parameter and if the MS has received BSIC information for all cells.

● MI 3G Wait
The "3G Neighbour Cell" list (either from SI2quater or from PSI3quater) is used for
reporting when the MS enters dedicated mode, until the MS has received a given
number of instances of Measurement Information (MI) messages that contain 3G
neighbor cell description. This number of instances is defined by the "MI 3G-Wait"
parameter.

● FDD Q Min. Offset
FDD Q Min. Offset is extracted from the Layer 3 message SI2quater. The parame-
ter applies an offset to the minimum threshold for Ec/No for UTRAN FDD cell rese-
lection.

● FDD RSCP Min.
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"FDD RSCP Min." is extracted from the Layer 3 message SI2quater. The parame-
ter defines the minimum value for Received Signal Code Power (RSCP) for FDD.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "GSM RR 3G Reselection Measurements Parameters View" has no specific con-
figuration menu.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.4.5.6  GSM RR 3G reselection measurements view

The "GSM RR 3G Reselection Measurements View" is an overview of the measured
Radio Resource 3G reselection parameters.

The view is empty unless the test mobile is configured to record the GSM RR-related
messages. See the description of a device's "Expert Mode" configuration menu.

Figure 4-404: GSM RR 3G Reselection Measurements View

The results for each mobile are arranged in a separate tab.

Cell list

The cell list comprises the most important parameters of the 3G cells that are involved
in Layer3 RR reselection measurements.
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Each table row represents a cell. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A gray triangle in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

● Color Symbol
Color code for the Primary SC as defined in the "Colors" tab of the configuration
menu.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● UARFCN
UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL
signal.
The carrier frequency is equal to "f = 0.2 MHz * UARFCN"

● SC
Primary scrambling code of the signal in the format selected in the "TEC for UMTS
Test Mobiles" tab of the configuration of software modules; refer to section Configu-
ration Menu in chapter 3. The primary SC is used to identify the cell.

● Diversity
Downlink transmit diversity scheme for the CPICH: "STTD" (Space Time Transmit
Diversity), "TSTD" (Time Switched Transmit Diversity), "SSDT" (Site Selection
Diversity Transmit Power Control), or "No" Diversity

● RSCP [dBm]
Unbiased Integral Received Signal Code Power for all measured peaks in dBm.

● 5s Timer State
State of the 5s Timer (Stopped/Running/Expired)

● NodeB
Name of the closest NodeB with the corresponding SC and ARFCN.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM RR 3G reselection measurements view configuration

In the "View Configuration" page you can select/deselect the parameters to be viewed
in the tables and see the information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.
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A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The complete set of the 3G cells parameters to be displayed in the list of 3G cells for a
GSM mobile in idle mode is by default selected in the "3G cells in idle mode" pane. If
you deselect a parameter, the associated column in the table is hidden.

Figure 4-405: GSM RR 3G Reselection Measurements View - configuration

4.4.5.7  GSM rejected 3G cells view

The "GSM Rejected 3G Cells View" shows an overview of the determined 3G cell
parameters for rejected cells.

The view is empty unless the test mobile is configured to record the GSM L3 RR 3G
rejected cell-related messages.

Figure 4-406: GSM Rejected 3G Cells View
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Cell list

The cell list comprises the most important parameters of the 3G cells that have a regis-
tration result of "rejected"; its members are permanently monitored and updated by the
network.

Each table row represents a cell. Clicking an entry in the table heading sorts the cells
according to the corresponding parameter. A gray triangle in the heading pointing
upward (downward) indicates that the table is sorted in ascending (descending) order.

● Color Symbol
Color code for the Primary SC as defined in the "Colors" tab of the configuration
menu.

● #
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● UARFCN
UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL
signal.
The carrier frequency is equal to "f = 0.2 MHz * UARFCN"

● SC
Primary scrambling code of the signal in the format selected in the "TEC for UMTS
Test Mobiles" tab of the "Configuration of Software Modules" menu. The primary
SC is used to identify the cell.

● Diversity
Downlink transmit diversity scheme for the CPICH: "STTD" (Space Time Transmit
Diversity), "TSTD" (Time Switched Transmit Diversity), "SSDT" (Site Selection
Diversity Transmit Power Control), or "No" Diversity

● Type
Reject type as defined by Radio Resource Control (RRC): Threshold (RRC deliv-
ered a threshold) or Timer (RRC delivered a timer value)

● Reason
Reason for the rejection. Possible reasons include:
NONE, INVALID_STATE, CELL_BARED, PLMN_MISMATCH, LOW_S_VALUE,
AQUISITION_FAIL, SIBS_FAILED_LOWER_LAYERs, INVALID_SIBS,
SIBS_TIMEOUT, SIBS_FAILED_OTHER, FORBIDDEN_LA, CELL_QUAL_FAIL-
URE, CELL_NOT_SUITABLE, CELL_NOT_EVALUATED, or
CELL_CHANGE_FAILURE

● Timer Value
Time (in seconds) when the same cell should be reconsidered.

● SQual min.
Minimum Cell Selection Quality value [dB], the parameter is used in the cell rese-
lection criterion S for FDD cells.

● RxLev min.
Threshold value [dBm] to be applied to Ec/No measurements

● NodeB
Name of the closest NodeB with the corresponding SC and ARFCN.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM rejected 3G cells view configuration

The "View Configuration" tab lets you select/deselect the parameters of the 3G cells in
idle mode to be displayed in the "GSM Rejected 3G Cells View". The view configura-
tion provides in addition the information about the view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The complete set of the 3G cells parameters to be displayed in the list of rejected 3G
cells for a GSM mobile in idle mode is by default selected in the "3G cells in idle mode"
field. If you deselect a parameter, the associated column in the table is hidden.

Figure 4-407: GSM Rejected 3G Cells View - configuration
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4.4.5.8  GSM system information view

The "GSM System Information View" displays a selection of GSM parameters con-
tained in the layer 3 messages System Information Type 1 to 6 sent by the BTS,
according to GSM recommendation 04.08. The values are shown for all mobiles used.

Figure 4-408: GSM System Information View

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM system information view configuration

The "GSM System Information View" configuration menu defines the parameters to be
viewed and shows information on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-409: GSM System Information View - configuration

The parameters of different System Information types (SI type 1 to 6) conveyed via the
Layer3 messages are shown in the view if selected in "Parameter". The parameters'
short explanation is given in the following table.
Table 4-12: GSM System Information Type 1 to 6 parameters

DTX use Discontinuous Transmission RxLev-AccMin Min. received signal level at a
MS for access to a cell

PWRC Power Control Indicator CellResHyst
[dB]

RxLev hysteresis required for
Cell Reselection

RL_TO Radio Link Timeout CellIdentity
[hex]

Cell Identity code

PLMN Public Land Mobile Network LAC [hex] Location Area Code

T3212 Timeout Value MCC Mobile Country Code

CCCH-Config Common Control Channel

Configuration

MNC Mobile Network Code
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MaxRetr Max. allowed RACH retrasmis-
sions

CA No. RF channel number in a particu-
lar cell (Numbering in a Cell
Allocation)

Reestabl Reestablishment Indicator BA No. BCCH Allocation Number

BsAgBlksRes No. of blocks on each CCCH
reserved for access grant mes-
sages

BA Ind. BCCH Allocation sequence
number indication

Tx Int Number of slot to spread
transm.

CA ARFCN Cell Allocation ARFCN

Emerg.Call Emergency call permission BA ARFCN BCCH Allocation ARFCN

BsPaMulFrms Transmisson of the same pag-
ing messages to MSs of the
same paging group

BA No. ext Extended BCCH Allocation
Number

CellBarAcc Cell Access Barred BA Ind. ext Extended BCCH Allocation
sequence number indication

MsTxPwrMaxCC
H

Max. allowed transmitted RF
power

BA ARFCN ext Extended BCCH Allocation
ARFCN

The extended BA parameters are relevant for the network operators who work with two
GSM bands (GSM900 and GSM1800) identified by two parameter sets.

4.4.6  LTE views

The "LTE Views" display the LTE-specific information acquired with an LTE test mobile
and the installed LTE device.

Activate explicitly recording of different messages which you wan04_0408_LTE Views,
38, en_USt to visualize in the LTE views. For activation, use the "Configuration" and
"Expert Mode" pages of the device's configuration menu, see Chapter 6.4.7, "LTE
mobile devices", on page 1633.

The LTE views can be seen and a view selected from the submenu displayed when the
mouse pauses over "View" > "Mobile Views" > "LTE".
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Figure 4-410: LTE views

Some of the views visualize the measurements and messages collected during the
eMBMS sessions.

With the addition of 5G NR support, the "LTE CA Downlink Performance View", "LTE
CA Uplink Performance View", "LTE Carrier Aggregation View", "LTE MIMO View" and
"LTE Modulation View" are replaced by "UE CA Downlink Performance View", "UE CA
Uplink Performance View", "UE Carrier Aggregation View", "UE MIMO View" and "UE
Modulation View", respectively.

● LTE CER view....................................................................................................... 811
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● LTE chart view.......................................................................................................814
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● LTE HARQ statistic view....................................................................................... 819
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● LTE radio bearer view........................................................................................... 841
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4.4.6.1  LTE CER view

The Channel Energy Response (CER) view shows the responses of both antennas.

The view is useful to check inter-symbol interferences.
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Figure 4-411: LTE CER View

4.4.6.2  LTE CQI view

The view gives a quick overview of the reported CQI values to the network. The upper
part shows some basic information about modes (e.g. P0→primary carrier, Reporting
Mode 1-0, and so on) and the channel (PUSCH or PUCCH) the CQI was reported on.
The Rank Indicator (RI) is visualized as a number only. Two last rows in the upper part
of the view display the wideband CQI value, coded in color from red (0) via yellow to
green (15).

The lower part shows the first CQI for the configured subbands (SB 0 to 8) as color
coded. If transmitted, a second CQI value is also color coded.

Mobile views



Display and evaluation of resultsDrive Test Software

813Operating Manual 1171.6415.12 ─ 66

Figure 4-412: LTE CQI View

Compact visualization
For compact visualization only TTIs are represented, in which a CQI value is reported
(in contrast to the Chapter 4.4.6.6, "LTE HARQ view", on page 822).

The next two sections display the subband CQIs. The display provides a quick over-
view over the CQI situation and if there is a specific problem for a certain subband.

Tooltips and details window can be used as usual.

The chart contains the following results:
● Channel
● Tx Mode
● Rpt. Mode
● Rpt Type
● RI
● WB CQI 0/WB CQI 1
● CQI 1/CQI 2
● SB 0 to SB 8

The LTE-Advanced Carrier Aggregation feature is supported in "LTE CQI View" in a
way that it shows the CQI processes for PCC and LCC or SCC. A desired view is dis-
played when selecting the "PCC" or "SCC" button.

To show both in parallel, the view has to be duplicated with the "New View" command
of the context menu, see Context menu.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The view's configuration page has only the "Info" tab. The page can be accessed by
selecting the "Configure" entry or via "Tools" > "Configuration Active View". See Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

If you select the "New View" command, the second LTE CQI view opens allowing mon-
itoring another carrier component for LTE carrier aggregation.

4.4.6.3  LTE chart view

The "LTE Chart View" displays the measured data of a server cell and the best neigh-
bor cells, the channel quality of the current server cell and Frame Error Rates (FER) in
a predefined 2D Chart. For definition and explanation of the signals, refer to 3GPP TS
36.214 and TS 36.213.

Figure 4-413: LTE Chart View

The "LTE Chart View" configuration is done in the "LTE Chart View: <variable> Proper-
ties" pane. Selecting the "Configure" command in the context sensitive menu of the
view opens only the "Info" page.
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For the meaning of the entries in the properties of the "LTE Chart View", see Chap-
ter 4.2.1, "2D chart view", on page 448.

In the following defined are the LTE parameters that are displayed in this view.

Server / best neighbor

● RSSI
Received Signal Strength Indication
The received power in a radio signal, i.e. all channels together.
3GPP TS 36.214 definition: E-UTRA Carrier Received Signal Strength Indication
(RSSI), comprises the linear average of the total received power (in [W]) observed
only in OFDM symbols containing reference symbols for antenna port 0, in the
measurement bandwidth, over N number of resource blocks by the UE from all
sources, including co-channel serving and non-serving cells, adjacent channel
interference, thermal noise etc.

● RSRP
Reference-Signal-Received-Power
Received Signal Strength on Reference Symbols
3GPP TS 36.214 definition: Reference Signal Received Power (RSRP) is the linear
average over the power contributions (in [W]) of the resource elements that carry
cell-specific reference signals within the considered measurement frequency band-
width.
For RSRP determination, the cell-specific reference signals R0 is used, according
to 3GPP TS 36.211. If the UE can reliably detect that R1 is available, it can use R1
in addition to determine RSRP.

● SINR
Signal-to-Interference-plus-Noise Ratio
Indicates the quality of the channel.

● Tx Power
Transmission power of the uplink reference signal in dBm.

● 1. NC RSSI
RSSI signal of the first neighbor cell.

● 1. NC RSRP
RSRP signal of the first neighbor cell.

Channel quality

● 1st CINR
Ratio of carrier/interference plus noise of the first antenna.
The received energy per chip divided by the power density in the band.

● 2nd CINR
Ratio of carrier/interference plus noise of the second antenna.

● 1st CQI Metric
The Channel Quality Indicator is an indication of the downlink mobile radio channel
quality as experienced by this UE. Essentially, the UE is proposing to the eNodeB
an optimum modulation scheme and coding rate to use for a given radio link qual-
ity. The resulting transport block error rate would not exceed 10% in this way. 16
combinations of modulation scheme and coding rate are specified as possible CQI
values. The UE can report different types of CQI.
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A so-called “wideband CQI” refers to the complete system bandwidth. Alternatively,
the UE can evaluate a “subband CQI” value per subband of a certain number of
resource blocks. The subband is configured by higher layers. The full set of sub-
bands covers the entire system bandwidth.
A CQI per code word needs to be reported for spatial multiplexing. The CQI for the
first antenna is shown in the table.

● 2nd CQI Metric
Channel Quality Indication for the second downlink radio channel.

● 1st DL MCS Level
Current used modulation coding scheme on the first downlink radio channel. The
information is provided by the eNodeB, see table below.

● 2nd DL MCS Level
Current used modulation coding scheme on the downlink for the second antenna if
used.

Table 4-13: Channel Quality Indicator for first antenna

CQI index modulation code rate x 1024 efficiency

0 out of range

1 QPSK 78 0.1523

2 QPSK 120 0.2344

3 QPSK 193 0.3770

4 QPSK 308 0.6016

5 QPSK 449 0.8770

6 QPSK 602 1.1758

7 16QAM 378 1.4766

8 16QAM 490 1.9141

9 16QAM 616 2.4063

10 64QAM 466 2.7305

11 64QAM 567 3.3223

12 64QAM 666 3.9023

13 64QAM 772 4.5234

14 64QAM 873 5.1152

15 64QAM 948 5.5547

Table 4-14: Currently defined modulation coding schemes

MCS Index
IMCS

Modulation Order
Q'm

TBS Index
ITBS

Redundancy Version
rvidx

0 2 0 0

1 2 1 0

2 2 2 0
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MCS Index
IMCS

Modulation Order
Q'm

TBS Index
ITBS

Redundancy Version
rvidx

3 2 3 0

4 2 4 0

5 2 5 0

6 2 6 0

7 2 7 0

8 2 8 0

9 2 9 0

10 2 10 0

11 4 10 0

12 4 11 0

13 4 12 0

14 4 13 0

15 4 14 0

16 4 15 0

17 4 16 0

18 4 17 0

19 4 18 0

20 4 19 0

21 6 19 0

22 6 20 0

23 6 21 0

24 6 22 0

25 6 23 0

26 6 24 0

27 6 25 0

28 6 26 0

29 reserved 1

30 2

31 3

FER

Frame erasure ratio detected by the UE.

● PDSCH FER
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Frame erasure ratio for the Physical Downlink Shared Channel (PDSCH)
● PUSCH FER

Frame erasure ratio for the Physical Uplink Shared Channel
● DL FER

General frame erasure ratio for the downlink
● UL FER

General frame erasure ratio for the uplink

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "Configue" command opens the chart's read only "Info" page.

4.4.6.4  LTE EPS bearer view

The view displays the current active EPS bearers of the UE and their most important
values.

Figure 4-414: LTE EPS Bearer View

Only EPS bearers, which have been configured during the measurement are shown.
The values of the view reflect directly the content of the logged Layer 3 messages.
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4.4.6.5  LTE HARQ statistic view

The view displays statistics of the used transport block sizes and the necessary
retransmission. The upper list shows the downlink statistics for one or two codewords.
The bottom list stands for uplink.

Figure 4-415: LTE HARQ Statistic View

The view supports also the LTE-Advanced Carrier Aggregation feature and displays
the data of secondary component carriers. The secondary component carriers (SCC)
data is shown in the first column. The SCC entries are marked with "Sn" for n-th SCC
and the PCC with "P".

Figure 4-416: LTE-Advanced HARQ Statistic View

All HARQ statistics are also done for eMBMS HARQ. Using the corresponding R&S
ROMES4 signals, the resulting values are visible. The "HARQ Statistic View" adds the
prefix "e" to TBSs used for MBMS/eMBMS.
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Figure 4-417: LTE HARQ Statistic View - eMBMS

In the LTE available signals tree you can see all the signals related to the eMBMS
HARQ statistics.

The eMBMS available signals are described in the "Description of R&S ROMES Sig-
nals" manual.

Figure 4-418: LTE HARQ Statistics View - available eMBMS signals

View area

The entire view area is horizontally split to accommodate two tables for the downlink
and the uplink.

A click on the title bars compresses and expands the tables. A compressed table
leaves more space for the other table A compressed table is characterized by the sym-
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bol >>> (instead of <<<) in its title bar. On pausing on one of the title bars, the cursor
displays a compress symbol.

Table

The following information is displayed for downlink and uplink:
● #

Code word
● TBS

Transport block size
● SB+

Number of successful decoded sub-blocks. Number of successfully decoded sub-
blocks. A sub-block is a mobile specific unit comprising the data of one subframe.

● SB++
Number of duplicated Sub Block Number of duplicate sub-blocks. Duplicate sub-
blocks are sub-blocks that the network retransmitted although they were received
correctly (usually because no ACK message was received from the mobile).

● SB-
Number of failed decoded sub blocks. Number of sub-blocks which could not be
decoded successfully has to be retransmitted. These blocks contribute to the
SBLER but not necessarily to the BLER

● SBLER [%]
Sub-block error rate. SBLER = SB– / (SB+ SB–).

● BL+
Number of successful decoded blocks.

● BL-
Number of failed decoded blocks.

● BLER [%]
Block error rate, BLER = BL– / (BL+ BL–). BLER is usually smaller than the SBLER
because it counts only the blocks that could not be decoded until the end of the
HARQ process (until the maximum number of retransmissions was reached).

● #1[%] to # >5[%]
Percentage of blocks for which n (n=1 to 5) transmissions were needed for suc-
cessful decoding.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

LTE HARQ statistic view configuration

The view configuration menu allows adapting the visualized columns in the "Downlink"
and "Uplink" table of the view. Select or deselect the IE listed in the "Downlink List Col-
umn"/"Uplink List Column" according to your needs.

Figure 4-419: LTE HARQ Statistic View - configuration

4.4.6.6  LTE HARQ view

The view displays detailed information about the HARQ processes in downlink and
uplink direction for FDD and TDD LTE.

The "LTE HARQ View" supports the LTE-Advanced Carrier Aggregation feature. The
view shows the HARQ processes for PCC or SCC<n>.
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Figure 4-420: LTE HARQ View - FDD mode

The "LTE HARQ View" supports also eMBMS. The HARQ processes are evaluated
separately for "normal" LTE and eMBMS.

The "LTE HARQ View" for eMBMS shows the eMBMS TTIs also, but the background
color is always gray.

Figure 4-421: LTE HARQ View - eMBMS

The Qualcomm chipset-based LTE test UEs can trace the PDSCH Resource Block
(RB) allocation and the PUSCH RB allocation, as shown in the following figure.
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Figure 4-422: RB allocation for PUSCH

Enable the PDSCH/PUSCH de-mapper log for tracing the RB allocations. Due to the
high update rate of this log, it is disabled by default, see "Extra settings LTE (Qual-
comm)" on page 1639.

Each line of the RB allocation field represents a resource block, starting with RB 0 at
the top. The field has always reserved 110 lines.

Visualizing the PCC and SCC processes

The view is identical for both component carriers.

A desired view is displayed when selecting the "PCC" or the "SCC<n>" button. The
buttons are also present in the "LTE CQI View" to visualize the CQI processes for PCC
or SCCs.

The upper part of the view, the "DL DCI" table, shows the DL layers. Hovering the
mouse over a column marks the column and the other columns which are related to
this TTI. A Tooltip displays the actual System Frame Number (SFN) and subframe
number of the TTI, the HARQ ID and the used MCS. The view shows one column for
each TTI, independently on if the TTI was used by the test device or not. This
approach allows you to get a quick impression about the allocated time resources. The
values are coded in colors.

The lower part, the "UL DCI" table, shows the UL DCI data transmission itself and the
HICH. The corresponding retransmissions are not in the same TTI (column), but
always shifted by 4 TTIs.
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Figure 4-423: Move mouse pointer over column to view details

If double-click a column, the Tooltip shows information of the complete column.

Figure 4-424: Double-click a column to view more details

Based on the HARQ, the R&S ROMES4 provides signals which can be used in the
basic views, example given, in the "Alphanumeric View" or "2D Chart View". All signals
are calculated on 1second basis.
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Figure 4-425: LTE HARQ View signals

LTE HARQ view data exporter

The executable ExportHARQ.exe file is the command line-tool for exporting the LTE
HARQ view data to an R&S ROMES4 measurement file in CSV format. You can export
to separate files all view entries with the valid data of each device.

Figure 4-426: Successful data export

If the export was successful, the exporter returns the data value to 0.

Syntax of export command line

The command line is

[C:\Program Files (x86)\Rohde-Schwarz\ROMES<version>]HARQ.exe 
-f <measurement file> [-d <destination dir>]
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The exporter saves the output files in the measurement file directory if no destination
directory is specified.

The output files are named like the input files with the appended device name.

In case there are blanks in paths and/or file names, it is mandatory to use quotation
marks.

For example, "C:\User\My ROMES\MeasData\Measurement File.rscmd"

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The view configuration menu has only the "Info" tab. Click the "Configure" entry of the
context menu to open the "Info" page.

If you select "New View", the "LTE HARQ View" allows monitoring the available compo-
nent carriers for LTE carrier aggregation.

4.4.6.7  LTE performance view

The "LTE Performance View" displays the throughput performances of the mobile dur-
ing the measurement.

In the properties pane you can select the charts displaying the performances you are
interested in:

● Requested throughput per MSC and wideband CQi
● Total scheduled throughput per MSC
● Total acknowledged throughput and DL PDCP and RLC throughput
● MIMO imbalance
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Figure 4-427: LTE Performance View

The "LTE Performance View" configuration is done in the "LTE Performance View:
<variable> Properties" pane. Selecting the "Configure" command in the context sensi-
tive menu of the view opens only the "Info" page.

For the meaning of the configuration entries in the properties of the "LTE Performance
View", see Chapter 4.2.1, "2D chart view", on page 448.

4.4.6.8  LTE RACH view

The "LTE RACH View" summarizes all the information on the test-mobile's RACH pro-
cedures during the measurement.

There is a tab showing the connected device on the top of the screen. Multiple tabs are
shown for multiple devices.

A switch bar control is located at the top of the tab view, see "Switch bar"
on page 830.

The "RACH Summary" pane contains details on one RACH procedure attempt and
success, see "RACH summary pane" on page 831.
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Figure 4-428: LTE RACH View

The view supports the R&S ROMES4 coupled focus, see Chapter 4.1.6, "Coupled
focus", on page 432.

General description

The RACH procedure can be triggered/started for one of the following reasons:
● Connection Request
● Radio Link Failure
● UL Data Arrival, see Figure 4-428
● DL Data Arrival
● Handover

These reasons to start RACH procedure are counted separately by R&S ROMES4 in
the "RACH Summary" table.

The RACH procedure is controlled by a set of parameters that is signaled in the SIB2-
NB Layer 3 message. They tell the UE, for example, what channel resources, timings
and transmit power to use. The RACH resource parameters also control the behavior
in case the signaling procedure fails. For example, controlled is how many attempts the
UE can use to finalize the RACH signaling before it must abort the procedure.

The result of a RACH attempt can be:
● Success
● Failure (with details at what stage it failed)

The result of one RACH procedure can be:
● Success
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● Abort
● Unknown

Figure 4-429: RACH procedure result

The reasons to trigger RACH procedure and the results of it are counted separately by
R&S ROMES4 in the "RACH Summary" table.

Switch bar

The bar contains two switches used for hiding/showing chart summary (the top pane)
and RACH procedure details (the bottom pane), respectively.

If a pane is visible, the corresponding switch shows "Hide …" and clicking the switch
hides the pane.

The following figure shows the procedure details' pane only. The first switch is changed
to grey color and shows "Show Chart Summary".

Figure 4-430: Hiding the view panes
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Similarly, if a pane is invisible, the corresponding switch is in grey color and shows
"Show …" and clicking the switch shows the pane. At least one pane is visible.

If resizing the view smaller, the switch cannot have enough space to show all the text.
Ellipse is displayed at the end of the text.

Scroll bars can appear on the grids depending on the view size.

RACH summary pane

The "LTE RACH View" is horizontally divided into two panes.
● The top pane provides the statistics summary of all RACH procedures, that is, the

number of started RACH procedures for any of the previously mentioned reasons.

Figure 4-431: Top pane - RACH Summary

The number of rows and columns of this table is fixed. The table always stays in
the middle horizontally.

● The bottom part of the view is vertically divided into two panes.
– The left bottom pane displays the list of RACH procedures and the messages

summary.
– The right bottom pane displays detailed information on the selected item in the

list, see Figure 4-429.
Double click an item of the procedure list to toggle expanded/collapsed status
of the node.
CTRL+double click an item of the procedure list to toggle expanded/collapsed
status of all nodes.

Panes with loaded measurement file

1. Initially loading of the RACH view populates the view with empty panes.
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Figure 4-432: Initial loading of the view

2. After loading a measurement, the chart summary pane and the procedure pane are
populated. The last entry of the procedure list ("Result") is selected and is visible.

Figure 4-433: Procedure result

The "Procedure" table contains the procedure nodes and the message nodes.
The detail pane is populated with the selected procedure or message node.
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The following figure shows the success and abort procedure on the left-hand side and
the attempt message on the right-hand side.

Figure 4-434: RACH attempt procedure and message

Root procedure nodes

The root nodes labeled with RACH are:

● Success final procedure without failed attempt (one attempt)

● Success final procedure with failed attempts (five attempts)

● Aborted procedure

Message nodes

The nodes under the procedure nodes are message nodes.

There are six types of message nodes.

Trigger

"Trigger" indicates the reason to start RACH procedure. The message node contains
the information given in the next table.
Table 4-15: Message node - Trigger

RACH
Reason

Connec-
tion

Matching
ID

Preamble Preamble
mask

MSG3
size

Group Pathloss CRNTI
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MSG1

MSG1 is the request sent to base station. The message node contains the information
given in the next table.
Table 4-16: Message node - MSG1

EARF
CN

EAR
FCN
offset

Cov-
erage
level

CP
lengt
h

PRA
CH
TX
powe
r

Sub
car-
rier
index

Sub
car-
rier
index
offset

Num-
ber of
repe-
titions

RA-
RNTI

Sched
uled
SFN-
SubFN

PRAC
H Tx
SFN-
SubF
N

Win-
dow
start
SFN-
SubF
N

Win-
dow
end
SFN-
SubFN

MSG2

MSG2 is the response from base station. The message node contains the information
given in the next table.
Table 4-17: Message node - MSG2

SFN-SubFN Timing
Advance

Timing
Advance inclu-
ded

RACH proce-
dure mode

RNTI type RNTI value

MSG3

MSG3 is the request sent to base station. The message node contains the information
given in the next table.
Table 4-18: Message node - MSG3

Subcar-
rier spac-
ing

I_SC I_Delay I_Rep I_MCS Number
of sub-
carriers

Subcar-
rier index

Sched-
uled
SFN-
SubFN

MSG3 Tx
SFN-
SubFN

MSG4

MSG4 is the response from base station. The message node contains the information
given in the next table.
Table 4-19: Message node - MSG4

Contention Result MSG4 RX SFN-SubFN UL ACK SFN-SubFN

Attempt

"Attempt" indicates a failed connection attempt. The message node contains the infor-
mation given in the next table.
Table 4-20: Message node - Attempt

Tx counter RACH result RACH procedure

The "RACH Result" field of the message detail shows why the attempted connection
failed.

The Figure 4-434 shows the Attempt message details in case the MSG2 failed.
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Result

"Result" indicates the final result of RACH procedure. The message node contains the
same information as the attempt node.

The possible results are:
● Success result without failed attempts, see Figure 4-433.
● Success result with failed attempts
● Aborted result, see the following figure.

Figure 4-435: RACH procedure result - Aborted

Focus coupled synchronization

The RACH view participates RACH synchronization in "Replay" > "Pause" mode.

RACH synchronization is a process where a data provider notifies all its data observers
to synchronize to a given timestamp. The process is called Focus Coupled Synchroni-
zation.

The following is valid for the process:

1. While Replay is in progress, there is no focus coupled view synchronization

2. While Replay reaches the end, there is no focus coupled view synchronization

3. Click the "Pause" button.

Replay is in Paused mode and focus coupled view synchronization is available.
The synchronization is timestamp-based.

4. Changing selection in one of focus coupled views, triggers synchronization to
RACH views

5. The synchronized RACH nodes are RACH procedure nodes, not message nodes.

During the RACH synchronization

1. Clicking an entry of, for example, Layer 3 view, causes RACH view to show the
corresponding procedure node whose timestamp is related to the selected Layer 3
view record.
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2. Clicking an entry of RACH view procedure list, notifies all its subscribers to syn-
chronize, including other RACH views.

Replaying or measuring in progress

If R&S ROMES4 is configured to work with a phone or UE during measuring, new
nodes for the phone connect procedures is added to RACH view procedure pane. The
pane automatically grows and scrolls to the bottom. The last message of the last pro-
cedure is selected as visible.

Count of failed MSG2, MSG4 and attempts

MSG2 failure

During connection procedure, after UE sends MSG1, a MSG2 is expected.

1. If MSG2 is not received correctly, an Attempt message is generated. The associ-
ated "MSG1" and the "RACH Result" field of the Attempt message show Fail-
ure@MSG2 in the details pane.

2. The total count of failed MSG2 is displayed in the cell of the "Failure@MSG2" row
and in the "#Total" column of the "RACH Summary" pane.

3. The #Total count is the sum of failed MSG2’s from all connection procedure nodes,
including the nodes whose final result is success.

Figure 4-436: Total number of MSG2 failures
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MSG4 failure

During connection procedure, after UE sends MSG3, a MSG4 is expected. MSG4 can
fail.

There are two types of MSG4 failure:
● MSG4 timeout
● MSG4 resolution not passed

If the MSG4 fails, the "Contention Result" field of MSG4 node's detailed pane shows
the message "failed".

Figure 4-437: Total number of MSG4 failures (timer)

In addition, an RACH Attempt message is generated following the failed MSG4.

The "RACH Result" field of the RACH Attempt message shows the failure reason in
the detailed pane. The shown message is "Failure@MSG4 due to CT timer expired" or
"Failure@MSG4 due to CT resolution is not passed".

Figure 4-438: Failure@MSG4 due to CT timer expired

Signals and events for LTE RACH procedures

RACH procedures signals

There are two types of RACH signals:
● RACH single signal
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The signal occurs between trigger and final result in one connection procedure.
The signal values are only valid inside the procedure time frame. A line chart for
those values shows the gap between procedures.

● RACH final signals
The signal is the result for each connection procedure. The values stay continu-
ously until new value comes in. In a line chart, it shows continuous line.

For the description of the signals related to RACH procedures, see the "Description of
R&S ROMES4 Signals" document, the "LTE" > "Device n" > "RACH Procedures" chap-
ter.

RACH procedures events

1. Add a RACH signal to "Alphanumeric View".

2. Right click the added RACH signal.

3. Choose the "Configure Events" menu item.

The "Configure Events" dialog shows the new RACH procedures events.

Figure 4-439: RACH procedure events configuration

RACH signals views

RACH signals in alphanumeric view

The figure shows all the RACH procedure signals in Alphanumeric View.
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Figure 4-440: RACH procedure signals in Alphanumeric View

RACH single signals in 2D chart view

The figure shows the RACH procedure single signals in 2D Chart View.
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Figure 4-441: RACH procedure single signals in 2D Chart View

RACH final signals in 2D chart view

The figure shows the final RACH procedure signals in 2D Chart View.
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Figure 4-442: RACH procedure final signals in 2D Chart View

4.4.6.9  LTE radio bearer view

"LTE Radio Bearer View" shows the currently active downlink and uplink bearers,
based on the RLC parameters configuration. The bearer type includes also the
eMBMS bearer if present.

Figure 4-443: LTE Radio Bearer View

The following table shows the available information elements (IE) in the view. The
Direction column indicates if an IE is present in DL, UL or in both directions.
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Table 4-21: Available information in LTE Radio Bearer View

IE Meaning Direction Remark

CFG CFG_IDX of the radio bearer Both Unique index of the radio bearers

RB-ID Radio Bearer ID Both Radio Bearer ID

LC-ID Logical Channel ID Both Logical Channel ID

Mode Radio Bearer Mode Both AM or UM

Type Radio Bearer Type Both Signaling Radio Bearer (SRB) or Data
Radio Bearer (DRB)

Tro T_reordering Downlink T_reodrering timer in milliseconds

Tsp T_status_prohibit Downlink T_status_prohibit timer in milliseconds,
AM only

SNF-Len Sequence Length Both Sequence length in bits: 5 bits SN or 10
bits SN, UM only

P-PDU Poll PDU Uplink poll_PDU constant, AM only

P-Byte Poll Byte Uplink poll_byte constant, AM only

TP-ReTx T_poll_retransmit Uplink T_poll_retransmit timer in milliseconds,
AM only

Max ReTx Maximum retransmission Uplink Maximum number of retransmissions,
AM only

EPS ID EPS bearer Id Both Identity of EPS bearer

EPS mode EPS mode Both EPS mode (default)

EPS CQI EPS channel quality identifier Both A value from 0 to 15 indicting the chan-
nel quality

Path PDCP path Downlink Visualizes which RAT is used by the
bearer

LTE radio bearer view configuration

The "HARQ Decode Statistic View Configuration" menu lets you adapt the visualized
columns in the "Downlink" and "Uplink" table. Select/deselect the RB parameters listed
in the "Downlink List Column" and "Uplink List Column" panels of the view according to
your actual needs.
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Figure 4-444: LTE RB View - configuration

4.4.6.10  LTE TTI view

The "LTE TTI View" lets you follow the data stream over the air for each used TTI and
therefore to perform a detailed analysis of a test device performances per TTI. The
view displays per TTI recorded values of component carriers and their states, fre-
quency, SFN, number of used RBs and layers, modulation and so on.

To open the view, select the "Mobile Views" > "LTE Views" > "LTE TTI View".
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Figure 4-445: LTE TTI view

The previous figure highlights the option to display the PDSCH or PUSCH component
carriers' states in the view. The state is reported as "Deconfigured", "Deactivated" or
"Activated". The "Serving Cell View" however does not display the states of DL/UL
component carriers.

The component carrier state signals are included in the "PDSCH Carrier" and "PUSCH
Carrier" nodes of "Signal Tree" > "LTE UE". The signals are visualized in the "3GPP
Overview View".

Figure 4-446: Extract from 3GPP Overview View
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The "LTE TTI View" is filled by the values obtained only by Qualcomm chipset based
devices.
Due to a huge amount of data, the required data logging is disabled by default. To get
filled view, enable the TTI logging on the Qualcomm device’s configuration page.

4.4.6.11  LTE UE signals

The following chapter is dedicated to the LTE UE signals supported by R&S ROMES4.
The all LTE UE signals are configurable via "Preferences" > "Available Signals" > "LTE
UE".

Figure 4-447: LTE UE available signals

The signals you want to display in a particular R&S ROMES4 supported LTE UE view
can be also selected via the view's context menu.The LTE UE signals are grouped in
nodes (branches) each one related to certain procedure, layer or function (e.g. support
of VoLTE, eMBMS).

The previous screenshot shows the nodes of the "Signal Tree" > "LTE UE" signals. The
UE cell signals are not distinguished in nodes whether they belong to PCell (Primary
Cell) or SCell (Secondary Cell). The dedicated PCell and SCell UE signal nodes are
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not supported in the R&S ROMES4 signal tree for LTE UE by default. For signal nodes
that indicate performances of PCC and SCCs introduced are LTE UE nodes template
signals. For example, the template signals are those signals contained in the "LTE UE
Carriers" node.

Figure 4-448: Template signals in LTE UE Carriers node

If a signal is only available in PCell carrier, "(P)" is suffixed in the signal name. If multi-
ple signals are selected and the selected signals contain both PCell and SCell carriers,
the filter dialog asks twice for both types of signals, once for each type.

For the following LTE UE nodes, related to carrieir aggregation, supported are template
signals:

● "LTE UE Carriers"
● "Channel Quality Carrier"
● "PDSCH Carrier"
● "PUSCH Carrier"
● "HARQ DL Statistic Carrier"
● "HARQ UL Statistic Carrier"

Some signals of the previously listed signal nodes have the suffix (P) or (S) to mark
clearly, that these signals are related to PCC or SCCs only, respectively.
Therefore, the mentioned nodes simplify the presentation of signals related to CA.

The list of supported LTE UE signals is long, as covered under the corresponding
subnodes (branches). In the "Selection of LTE UE signals" on page 850 mentioned
are only some of the supported signals. For the all LTE UE signals and their descrip-
tion, see "Description of R&S ROMES4 Signals" document.

Template signals filter dialog

When signal(s) are dragged into a view or for export, filter dialog pops up. LTE filter
dialogs show different number of carriers in pulldown list.
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Signals available for both PCell and SCell

If both PCell and SCell signals are available for the selected signal, following pulldown
list displays LTE filter dialog.

Figure 4-449: LTE filter dialog

There are 9 LTE UE mobile template signals, a PCell signal and SCell signals 1 to 8.

PCell only signals

If only PCell signal is available for the selected signal, the pulldown list is auto filled
with the only choice - PCells.

Figure 4-450: Filtering PCells only
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Optionally, check the "Apply for all signals" check box to apply the choice to all signals.

Multiple signals for PCell only and for both PCell and SCell

It is possible to select multiple signals, some of them are PCells only and some are for
both PCell and SCell. In this situation, the filter dialog asks twice for both types of sig-
nals, once for each type.

Prior filter

The "Prior Selection" template option is available in the filter dialog for both PCell and
SCell.

Figure 4-451: Prior selection both PCell and SCell

The LTE UE and 5G NR UE template signals are contained in the UE mobile views
that involve carrier signals, e.g., "UE CA DL Performance View"/"UE CA DL Perfor-
mance View", "Serving Cell View". The views are updated to show the signals cor-
rectly.

As the number of carrier increases, it can happen that there is no enough space to
show all carriers at top of the view. Because of that reason, the carriers are not presen-
ted at the top of the views. If only one carrier is selected at a time, the carriers are dis-
played for selection in a pulldown menu. If multiple carriers are chosen for display at
the same time, they have to be selected from the property bar on the left side of the
view.
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Figure 4-452: Single carrier selection from carrier selector
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Figure 4-453: Multiple carriers selection from property bar

Selection of LTE UE signals

The list of supported LTE UE signals is long, as covered under the corresponding sub-
nodes (branches). Here are mentioned only some of the supported signals. For the all
LTE UE signals and their description, see "Description of R&S ROMES4 Signals" docu-
ment.

Scanner Top N rank

The "LTE UE Carriers" branch of the "LTE UE" signal tree contains the "Scanner Top N
Rank" signal. The signal displays the current rank of the carrier in the corresponding
LTE TopN pool. Only LTE auto-EARFCN Top N pools are supported by this feature.

Figure 4-454: Alphanumeric view shows the scanner Top N rank

The screenshot shows that PCI 436 is detected by the scanner and ranked as the best
cell.

The "3GPP Overview View" shows the Top N rank of the carrier for LTE and 5G NR
within the MCG and SCG columns, respectively.
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Figure 4-455: 3GPP Overview view shows MCG and SCG values

EPS QoS

The signals which provide access to the content of the PDU session configuration are
available in the "EPS QoS" branch. The content is taken from the corresponding Layer
3 messages.

Figure 4-456: EPS QoS signals

The Session Activation has to take place while the measurement is active to get
access to the data.

IRAT neighbor cells signals

R&S ROMES4 supports for LTE mobiles measurements and reporting of IRAT neigh-
bor cells.

The IRAT neighbor cell signals are filled at the point in time when the UE starts report-
ing the measurement results to the network. The "measurementReports" messages
and the corresponding "measConfiguration" command itself can be observed in the
Layer 3 view.
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Figure 4-457: Time between measConfig and measurementReport

The IRAT neighbor cell details can be observed in the "Alphanumeric View".

Figure 4-458: Reported 3G neighbor cell details

Voice call signals

R&S ROMES4 supports for LTE mobiles measurements and reporting of voice calls.

A voice call interruption is observed in the "Alphanumeric View". The signal to display
the "Voice Interruption Time" between the RTP and the AMR stream, if configured, is
measured and displayed in the view.

Figure 4-459: Voice call interruption time in both directions

The voice interruption time is measured from the last received RTP packet to the point
in time when the first AMR packet has been received. The time is calculated separately
for the downlink and uplink stream. This calculated performance indicator is not neces-
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sarily the exact duration of the audio-interruption during the SRVCC, but is an indica-
tion of the performance.

The calculation of this duration is based on the UEs internal timestamps.

VoLTE RTP statistics signals

VoLTE statistics signals provided by the implemented RTP analyzer are available for
viewing. Supported VoLTE RTP statistics signals are displayed for configuration in the
"Preferences" page.

The values of the signals are updated in average every second.

Figure 4-460: VoLTE RTP statistics available signals

The VoLTE RTP statistic signals are defined for both directions.

VoLTE IMS signals

Voice over LTE over IMS monitoring and reporting is supported by the R&S ROMES4,
as far as concerning the security procedure.

Support of Cat M1

R&S ROMES4 supports the Cat M1 devices. They behave basically as normal LTE
devices from a R&S ROMES4 perspective. The LTE available signal tree includes
"Applied Coding Rate on the PUSCH" and "Last RACH MSG1 Type (LTE, NB-IoT or
LTE-CatM)" signals. These signals give additional information on Cat M1 devices.

Support of LAA

Qualcomm and Exynos chipsets-based devices provide signals which indicate the cur-
rent LTE CA state. One signal shows the number of aggregated carriers (LTE CA), the
other one indicates if unlicensed band 46 is a part of the carrier aggregation set (LTE
CA Type). The LTE CA signal type LAA is shown in several views if a LAA carrier is
configured, for example in the "UE CA Downlink Performance View".

The Qualcomm chipset based devices support signals in the "PDSCH LAA Total"
branch, analog to the "PDSCH Total" branch. These signals show the corresponding
values, aggregated over all currently active carriers in a configured LAA band.

ESM throughput signals

The ESM throughput values obtained from UE can be displayed as R&S ROMES4 sig-
nals. The signals are available in the "ESM Throughput" branch.
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These signals are the throughput values assigned by the network in EPS Mobility Man-
agement message, which is sent from a network to the UE during network connection.

Qualcomm only LTE MIMO-related signals

The R&S ROMES4 provides the signals of PCC and SCC<n>, n=1 to 8, obtained by
the Qualcomm chipset based mobiles. These signals help better to understand the
MIMO state. In addition to the Channel Quality RI, added is the distribution RI rate. The
rate is calculated based on all reported RI during one cycle.

The RI reflects the UE reports of the current RF conditions regarding the usage of
MIMO mode. It is the eNB that decides how many MIMO layers have to be used. The
min., max. and average number of user layers and its distribution can be visualized by
using the signals PCC/SCCn MIMO Layers Min., Max., Avg. and the corresponding
rate signals. The signals report the value for all TTI in one cycle.

4.4.7  NB-IoT views

Select the "View" > "Mobile Views" > "NB-IoT" to get currently available NB-Iot views.

Figure 4-461: NB-IoT mobile views

To get an in-depth view of what is going on during a NB-IoT session, detailed measure-
ment data is required.

On the other hand, the setup of the actual test requires some knowledge of AT com-
mands and the general behavior of such a module. To fulfill both requirements, R&S
ROMES4 offers solutions which help you getting data in more convenient way.

4.4.7.1  NB-IoT details view

The "NB-IoT Details View" offers an in-depth view of the NB-IoT procedures. It offers
all available data per TTI from the sources of NPRACH, NPDSCH, NPUSCH and DCI
information.

To get a better overview, all uplink related messages are colored blue, while all down-
link related messages are colored green. The view synchronizes to other views by
timestamps, so that the related TTIs for problems spots can be identified easily. The
cells of the table which indicate errors are marked red.

The left most columns are the same for all source. They describe the source, the tim-
ing (HSFN, SFN, SubSFN), NPRACH messages, RNTI type and the direction.

The content of the right columns depend on the source. Thus the actual name of the
parameter is part of the cell.
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Figure 4-462: NB-IoT Details view

Detailed measurement data

NB-IoT signals have their own branch in the "Available Signals" tree, refer to "Descrip-
tion of R&S ROMES4 Signals".

The branch is just a different view of the data in the measurement files. The measure-
ment data itself is still stored in the LTE mobile container.

Depending on the firmware of the NB-IoT module, R&S ROMES4 can provide more
detailed measurement data via the NB-IoT available signals branches related to:

● Layer 1
Layer 1 parameters which are essential for coverage measurement. These param-
eters are NRSRP, NRSSI, NRSRQ, NSINR, for example.

Figure 4-463: 3GPP Overview view of NB-IoT
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Additionally to the server parameters, the cell reselection list is populated via R&S
ROMES4 signals. This list contains all eNodeBs, which are currently seen by the
UE and their ranking regarding cell reselection.

● Layer 2
The NPUSCH signal branch provides signals, which indicate collisions on the
NPRACH. For all format 1 TTIs the number of collisions are counted and reported
as percentage related to the total number of format 1 TTIs .

● Service Status of UE
The actual service status of the UE is available as R&S ROMES4 signal (the
branch "NB-IoT" > "Device" > "Serving Cell"). This signal indicates, if the UE is in
service or, for example, in power save mode.

Figure 4-464: Alphanumeric view - reported collision

● Data Transport
NB-IoT supports two different ways for transporting the user data to its destination.
The data can be sent over the user plane, as normal LTE does, or sent piggy-
backed on control plane messages. Which of these possibilities is actually suppor-
ted, can be figured out by checking the 3GPP Overview View.

Figure 4-465: NB-IoT information within 3GPP overview view

● MIB Decoding
Before the UE tries to attach to the network it has to decode its Master Information
Block. R&S ROMES4 offers the possibility to track UE's attempts of MIB decoding.
Every time the UE attempts to decode the MIB, the according R&S ROMES4 sig-
nals are filled, and a line is added to the Layer 3 View. This helps to see what is
going actually before the UE decides to attach to the network.
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Figure 4-466: Alphanumeric view - NB-IoT operation mode

Figure 4-467: Layer 3 view - details

4.4.7.2  NB-IoT NPRACH view

The "NB-IoT NPRACH View" shows the NPRACH information. The views for LTE and
NB-IoT are the same, the only difference is the title.
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Figure 4-468: NB-IoT NPRACH view

For the view description, see Chapter 4.4.6.8, "LTE RACH view", on page 828.

Signals and events for NB-IoT NPRACH procedures

NB-IoT NPRACH procedures signals

There are two type of NB-IoT NPRACH signals:
● NB-IoT NPRACH single signal

The signal occurs between trigger and final result in one connection procedure.
The signal values are only valid inside the procedure time frame. A line chart for
those values show gap between procedures.

● NB-IoT NPRACH final signals
The signal is the result for each connection procedure. The values stay continu-
ously until new value comes in. In a line chart, it shows continuous line.

For the description of the signals related to NB-IoT NPRACH procedures, see the
"Description of R&S ROMES4 Signals" document, the "NB-IoT" > "Device n" >
"NPRACH Procedures" chapter.
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NB-IoT NPRACH procedures events

1. Add a NB-IoT NPRACH signal to "Alphanumeric View".

2. Right click the added NB-IoT NPRACH signal and choose the "Configure Events"
menu item.

The "Configure Events" dialog shows the new NB-IoT NPRACH procedures
events.

Figure 4-469: NB-IoT NPRACH procedures events configuration

4.4.8  5G NR views

The highlights are several views which support 5G NR UE signals testing with Qual-
comm MTP.

A set of dedicated views helps in analysis and optimization of LTE-5G NR Dual Con-
nectivity performance.

The following figure shows the available 5G NR UE views, accessible via "View" >
"Mobile Views".

Mobile views



Display and evaluation of resultsDrive Test Software

860Operating Manual 1171.6415.12 ─ 66

Figure 4-470: 5G NR UE views

The "Mobile Views" > "Serving Cell View" visualizes the NR/EN-DC cells history when
a SA/NSA measurement file is run.
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Figure 4-471: Serving cell view

The view shows the history of applied RAN in the first chart. The lower chart shows
used bands, configured carriers and cell IDs of the measured and reported cells.

Some 5G NR UE views are based on the concept implemented in the "2D Chart View".
These views are: "5G NR Performance View", "5G UE EN-DC DL Data Chart", "5G UE
EN-DC PDSC BLER Chart", "5G UE EN-DC PUSCH Tx Power Chart", "5G UE EN-DC
PDSCH Throughput Chart", "5G UE EN-DC PUSCH Throughput Chart", "5G UE EN
DC PUSCH ReTX Chart" and "5G UE EN-DC UL Data Chart".
For the meaning of the panes and entires in the previously listed views and charts, see
Chapter 4.2.1, "2D chart view", on page 448.

An introduction to some available 5G NR UE views which provide quick and easy crea-
tion of workspaces for 5G NR UE testing is presented in the following chapters.

Support of DSS capability of 5G NR UE

A 5G NR UE DSS capability is visualized with the signals available in the "Signal Tree"
> "5G NR UE" branch of R&S ROMES4. The signals are also visible in some Basic
Views, for example, in the "Alphanumeric View".

The names of relevant 5G and 4G R&S ROMES4 signals get an appendix, which rep-
resents the current role of a carrier. This appendix consists of the MCG or SCG and
the Carrier Index (PCell, SCell1,..., SCelln). Signals assigned to a DSS carrier get the
"-D" appendix.
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Figure 4-472: MCG appendix to 4G signals

To append the "-D" appendix to the carrier, the following conditions apply:

● 5G NR UE signals - 5G carrier has to have a valid DSS LTE frequency.
● 4G UE signals - 4G carrier has to have a valid EARFCN DL and band value. Any of

the current 5G carrier’s DSS LTE frequency matches the band and the 4G LTE car-
rier frequency calculated from EARFCN DL.

The smart events allow the DSS setup and release to follow in the "Layer 3 View", as
highlighted in the following figure.

Figure 4-473: Extract from Layer 3 View

4.4.8.1  5G NR BWP view

The "5G NR BWP View" shows in a simple way the assigned Bandwidth Parts to 5G
NR UE. Assigned are the initial ("iDBWP") and dedicated downlink bandwidths (up to 4
DBWP per UE can be defined). Since this assignment can be dynamic and user spe-
cific, a visual representation helps to understand the UE behavior in terms of assigned
frequency resources over time.

The "5G NR BWP View" shows the actual BWPs assigned to 5G NR UE and the DL
carriers allocation for SA and NSA networking.
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Figure 4-474: 5G NR BWP view

BWPs are shown only for measurements files recorded with R&S ROMES4 20.2 or
higher.

To launch the view, click "5G NR" > "5G NR BWP View" in the "View" > "Mobile Views"
menu. The opened view has no data.

Figure 4-475: Empty 5G NR BWP view
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The "5G NR BWP View" is designed as a tab view for different devices and therefore
supports the BWP view of multiple devices. If more devices included in a measure-
ment, more tabs are added in the title bar (each one for different UE connected to R&S
ROMES4).

Figure 4-476: Title bar and tabs of loaded devices

You can activate or deactivate cells for which BWPs you want to be displayed. For con-
nected UE, BWPs of up to 12 cells can be activated for display.

The selection of cells and signals to be displayed in the view and the view's layout con-
figuration is done in the "5G NR BWP View Properties" pane. The parameters of a cell
which can be activate or deactivate for display are iDBWP, SCS-SC1, SCS-SC2, SCS-
SC3, SSB (SSB index) and downlink dedicated BWPs.

The pane opens when mouse hovers over the "5G NR BWP View Properties" bar. If
the bar is invisible, as closed in previous action, click right-mouse button any point of
the view to get the context-sensitive menu and select the "Properties" option.

For each subcarrier (SC), x-axis represents a frequency in [MHz].

5G NR BWP view description

The title bar of the view contains the tabs for loaded mobile devices.

The view area is divided into sections which are assigned to activated 5G NR cells.
Activated can be primary (PSCell) and up to 11 secondary cells ("n.SCell", n=1..11).

Section

Each section is considered as a 5G NR cell and contains bandwidth data series
(IDBWPx, SCS-SCx) for that cell. It is possible to have up to five cell's bandwidth data
in the section area.

The figure shows primary 5G NR cell section that contains four bandwidth data distin-
guished by four colors.
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Figure 4-477: Section corresponding to PSCell

A section can contain up to nine cell's bandwidth data series (IDBWP, SCS-SC1, SCS-
SC2, SCS-SC3, SSB, DBWP1, DBWP2, DBWP3 and DBWP4). The previous figure
shows for that PSCell has measured data iDBWP, SSB and DBWP.

Data series rectangular

The cell data series are displayed as colored rectangles on the left-hand side in a sec-
tion. The similar cells' series types are grouped with the similar colors.

Figure 4-478: Selected section - details

The cell series rectangles can be overlapped. The rectangles of SCS-SCn and DBWPx
do not overlap. Each of them occupies a separate line.

Each section of the view has a separate x-axis. The x-axis shows the frequency range
in MHz. Each x-axis can contain different value range. The x-axis title and unit are dis-
played at the bottom of the view area and shared by all rows ("Frequency [MHz]").
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Section legend

Each section row contains a legend box that shows the color of bandwidth data.

A bandwidth data series can be shown or hidden by checking or clearing the corre-
sponding check box in the legend area. The following figure shows the legend for
PSCell.

Figure 4-479: Legend of a PSCell

The cell series can also be controlled by the "5G NR BWP View Properties" bar. For
the bar details, see Figure 4-481.

If a section row does not have enough height to show all the legend entries, arrows are
displayed at the sides where more entries are available. Click the arrow to show more
choices.

Figure 4-480: Arrow in the legend

Properties bar

The "5G NR BWP View Properties" bar is at the right-hand side of the "5G NR BWP
View".
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Figure 4-481: Properties bar of the view

The following entries are available in the bar:

● "Restore All Values"  button on top of the property view is used to restore the
default properties.

● "General" shows the general properties which include:
– "Show Legend" check box to show or hide the legend. By default, the box is

checked and the legend is displayed.
– "iDBWP Color" check box to select a color from the color drop-down palette

and change the corresponding iDBWP color.
– "SCS-SCn" check box to select a color from color drop-down palette and

change the corresponding SCS-SCn color, n=1, 2, 3.
– "SSB" check box to select a color from color drop-down palette to change the

corresponding SSB.
– "DBWPx Color" check box to select a color from color drop-down palette to

change the corresponding DBWPx color, x=1, 2, 3, 4.
● "PSCell" shows the primary 5G NR cell properties included in the following entries

which are checked by default:
– "Show" shows or hides the PSCell row.
– "IDBWP" > "Show" shows or hides the iDBWP series data rectangle.
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– "SCS-SCn" > "Show" shows or hides the SCS-SCn series data rectangle, n=1,
2, 3.

– "SBS" > "Show" shows or hides the SBS series data rectangle.
– "DBWPx" > "Show" shows or hides the DBWPx series data rectangle, x=1, 2,

3, 4.
● "n.SCell" shows a secondary 5G NR cell property, n= 1 to 11. The following entries

which are checked by default describe the cell properties:
– "Show" shows or hides the n.SCell row.
– "IDBWP" > "Show" shows or hides the iDBWP series data rectangle.
– "SCS-SCn" > "Show" shows or hides the SCS-SCn series data rectangle, n=1,

2, 3.
– "SBS" > "Show" shows or hides the SBS series data rectangle.
– "DBWPx" > "Show" shows or hides the DBWPx series data rectangle, x=1, 2,

3, 4.

Exporting data as CSV

1. With the right-hand mouse button click any point on the view area to get the con-
text-sensitive menu and choose the "Export Data as CSV" option.

2. Browse a folder.

3. Enter a name to save the generated CSV file.

The exported format is Cell,Series,F-Offset,F-BW,PointA(arfcn).

The meaning of the format is as following:
● Cell: cell name
● Series: series name
● F-Offset: frequency offset starting from PointA in MHz
● F-BW: frequency bandwidth in MHz
● PointA(arfcn): PointA in ARFCN format, is the point where the chart starts

The PointA appears only once for each cell and at the end of the first series of each
cell.

Exported CSV samples

An example of the data exported from a sample of one CSV file is listed here.

Cell,Series,F-Offset,F-BW,PointA(arfcn)

PSCell,iDBWP, 27702-27798,PointA(2074207)

PSCell,SCS-SC1, 27702-27798

PSCell,SSB, 27736-27764

1.SCell,iDBWP, 27802-27897,PointA(2075873)
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1.SCell,SCS-SC1, 27802-27897

1.SCell,SSB, 27836-27864

2.SCell,iDBWP, 27902-27997,PointA(2077539)

2.SCell,SCS-SC1, 27902-27997

2.SCell,SSB, 27936-27964

3.SCell,iDBWP, 28002-28097,PointA(2079205)

3.SCell,SCS-SC1, 28002-28097

3.SCell,SSB, 28035-28064

In this example, there are four cells and each cell has three series bandwidth data
(iDBWP, SCS-SC1 and SSB). The PointA is displayed at the end of the first line of the
cell series.

4.4.8.2  5G NR performance view

The "5G NR Performance view" shows in three charts the signal level (RSRP), signal
quality (RSRQ) and the signal to noise and interference ratio (SINR) of the SSB and
user signal. The group charts can be added and named in the view's properties pane if
you click the  button and select "Add Chart Group" in the menu.

Figure 4-482: 5G NR performance view

In the "5GNR Performance View: 1Properties" pane you can select signals to be
shown in a configured signal set group (RSS<variable>) via the "Add Signal/Signal
Set"  button. For more details related to the properties pane, see Chapter 4.2.1, "2D
chart view", on page 448.

The performance view provides the EN-DC cells quality history details.
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4.4.8.3  5G NR RACH view

R&S ROMES4 provides the "5G NR RACH View" for 5G NR. The view shows a sum-
mary of all collected RACH procedures and allows each procedure individually to
investigate.

Figure 4-483: 5G NR RACH view

To open the view, click "Mobile Views" > "5G NR Views" > "5G NR RACH View".

The upper table summarizes the complete set of recorded RACH procedures. The list
on left bottom shows all individual RACH procedures including their subprocedures. To
get even more details of such a subprocedure, click it to get the details on the right of
the details table.

Results of random access procedure

The workspace's second page of the "5G NR View" shown in the following figure gives
the details and results of 5G NR Random Access (RA) procedure.
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Figure 4-484: Displayed results of RA procedure steps

The following information on 5G NR random access procedure is included in this page:

● Identity, reason and contention type of triggered RACH
The information is contained in the "5G UE RACH Trigger" 5G NR mobile view.

● Attempt summary including counts, final result and beam identity
The information is contained in the "5G UE RACH Attempt" 5G NR mobile view.

● Physical transmission summary including Tx Power and path loss
The information is contained in the "5G UE PRACH Summary" 5G NR mobile view.

● Details of each RACH message; msg1, msg2, msg3 and msg4
The information is contained in the "5G UE MSG1", "5G UE MSG2", "5G UE
MSG3" and "5G UE MSG4" 5G NR mobile view.

4.4.8.4  5G NR TTI view

The "5G NR TTI View" lets you follow the data stream over the air interface for each
used TTI and perform a detailed analysis of performances of a test device per TTI. The
view displays per TTI the recorded values such as component carriers and their states,
5G NR frequency, numerology, SFN, slot number, used MCS and modulation type and
more. The view can also display the PDCP downlink logs per TTI. The PDCP logs
allow you to verify how much data has been transferred via LTE and 5G NR.

The 5G NR cell component carriers states in downlink and uplink are included in the
view's grid. A state is reported as "Deconfigured", "Deactivated" or "Activated". The
"Serving Cell View" however does not display the states of DL/UL component carriers.
The component carrier state signals are included in the "Signal Tree" >"5G NR UE"
branch, and visualized in the "3GPP Overview View", see Figure 4-446.

To open the view, select the "Mobile Views" > "5G NR Views" > "5G NR TTI View".
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Figure 4-485: 5G NR TTI view

The Tooltips of the column header give more information about the content of the col-
umn. The column filters offer a possibility to shrink the size of information to the one
which is under the investigation.

Activate the option "Store 5G NR TTI information". The size of the measurement file
increases when using this option.

Figure 4-486: Enabled needed option

Although the "5G NR TTI View" can be opened during the measurement, it is meant to
be used for in-depth analysis during the post-processing/analyses phase of a measure-
ment. The view can be time synchronized with other views to ease the access of criti-
cal point of times in the measurement file.

The view requires a Qualcomm chipset-based test UE.

Evaluated PMI displayed in the view

For the Qualcomm chipset-based mobile devices, R&S ROMES4 derives the reported
PMI values for Type I Single Panel codebook (i11, i12, i13 and i2) and implements
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them. The values are visible in the "5G NR TTI View" and are available as R&S
ROMES4 signals.

The "CRI" ("CSI Resource Indication") report lines of the "5G NR TTI View" show the I
values and the source of the values (carrier Id and report Id) and the current configura-
tion of the antenna panel of the source.

The columns PMI-I contain the actual information values. Depending on the configura-
tion, not always all I values are reported.

The first info column contains the current configuration given by the panel dimension in
N1, N2, O1 and O2 and the currently active code book mode (CBM).

The second info column contains the source of the values as there are carrier Id, report
Id and the report mode (a periodical: A or periodical: P). The Bits values inform about
the bit size which was necessary to report the I values to the gNodeB.

Figure 4-487: PMI information columns - on the right side of the view

The R&S ROMES4 capability to offer signal templates allows the used PMI information
values to visualize as signals. An ixy value can be compared only for a certain combi-
nation of cell group, carrier Id, report Id and rank indicator. Therefore you have to
select these properties to specify the signals content.

Two signals are provided for each I value.

- ixy: This signal is a numeric signal, which can be used on the map, the "2D Chart
view" or any other basic view. It reports the ixy value which occurred the most during
the R&S ROMES4 data-reporting period (approx. 500ms).

- i Distribution: This signal is a text signal and can be used only in the "Alphanumeric
View" or in the ASCII export. It prints all I values with its number of occurrences during
the reporting period.
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For the signals definition, see the "5G NR UE" > "CSI Templates" branch of the "Signal
Tree" or the same named chapter in the "Description of the R&S ROMES signals"
document.

When you add the signals to a view, a signal filter "Signal Templates - ixy" pops up. Fill
the corresponding filter values in the filter.

Example:

Figure 4-488: Added i11 signal

Figure 4-489: Alphanumeric View of the PMI-i11

Read the distribution signals as this example shows: 4(1);7(6): i11 had one time the
value 4 and 6 times the value 7. The i11 signal’s value is 7 as seven has the most
occurrences.
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The former PMI signals in the "5G NR UE" >"5G NR Carriers" signal branch have been
removed.

TTI occupancy signals

The TTI Occupancy signals let you better understand the TTIs number granted and
scheduled for transmission.

The information is available as a set of signals per carrier and is available only on
Qualcomm based chipsets mobiles. Those signals are available per carrier for down-
link (e.g. on PSCell, "PSCell PDSCH TTI Occupancy") and for uplink (e.g. on PSCell,
"PSCell PUSCH TTI Occupancy"). The value is calculated as several reported TBSs
per time in TTI/second.

4.4.8.5  CSI report channel state feedback

The "CSI report channel state feedback" view is a default-configured grid view. It is not
configurable by the user. It shows channel state indication (CSI - CQI, RI and PMI)
measurement reports in tabular form. The report includes the report of the primary cell
in NSA and SA operation mode, MCG cells and added SCG cells.

Figure 4-490: CSI report - channel state feedback

4.4.8.6  5G NR UE views

There are three widget templates installed in the R&S ROMES4 software which can be
used as a starting point for setting up a 5G NR UE grid view. One widget is a part of
the "Device Grid View" (5GUE.pwidget) and two are parts of the "Grid View"
(5G UE Cell Quality.gwidget and 5G UE History.gwidget).

1. Open the "Device Grid View" or "Grid View" page.
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2. Double-click any point in the view to get the context-sensitive menu.

3. Select "Configure" in the pop-up menu.

4. In the opened page, under the "Template", click the drop-down button for loading
the existing template file.

5. Select the mentioned files.

Figure 4-491: Loading the 5G UE widget template file

The 5G NR UE grid views open.

4.4.8.7  5G EN-DC capable UE

The R&S ROMES4 5G EN-DC capable mobile device views are partly dedicated.
Some are included in the general 5G NR views.
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Figure 4-492: Some 5G UE EN-DC views

The following views provide the information on UE Master Node (LTE) and Secondary
Node (5G NR) for EN-DC capable UEs.

● Actual serving cell parameters such as ARFCN, PCI, SSB index and the history of
serving cell changes are visualized in the "Serving Cell View".

● DL carrier allocation is included in the "5G NR BWP View".
● Actual cell quality measurement results including RSRP, RSRQ and SINR are

visualized in the "5G NR Performance View".
● The CSI measurements are visualized in the "CSI Report Channel State Feed-

back" table.
● UL and DL data channel performance including physical layer throughput, RB allo-

cation and modulation and coding schemes are visualized in the dedicated views.

DL dual connectivity data

The EN-DC DL data pages display the data transport performance of the downlink
physical layer.
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Figure 4-493: DL data chart of an EN-DC capable UE

The metrics related to EN-DC DL Transport Block transmission which can be assumed
as the performance of reception of MAC PDUs over the physical layer are shown in the
PDSCH BLER and Throughput pages. The later page gives the EN-DC throughput and
BLER comparison of LTE and 5G NR downlinks.
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Figure 4-494: PDSCH BLER and throughput chart of an EN-DC capable UE

The EN-DC cell quality measurement history of included RSRP, RSRQ and SINR are
included in the "5G NR Performance View".

The resource allocation including frequency domain allocation of resource blocks is
included in the "5G NR BWP View".

UL dual connectivity data

The UL EN-DC data page displays the data transport performance of the uplink direc-
tion of all 5G RAN layers.
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Figure 4-495: UL charts of an EN-DC capable UE

The metrics related to UL Transport Block transmission which can be assumed as the
performance of reception of MAC PDUs over the physical layer are included in the fol-
lowing charts:

The following metrics related to UL Transport Block transmission which can be
assumed as the performance of reception of MAC PDUs over the physical layer are
shown:

● EN-DC UL transmission power comparison of LTE and 5G NR control channels
(PUCCH) and shared data channels (PUSCH) is provided in the "5G UE EN-DC
PUSCH Tx Power Chart".

● UE received power on PUSCH is provided in the "5G UE EN-DC PUSCH ReTx
Chart".

● EN-DC throughput and retransmission comparison of LTE and 5G NR uplinks pro-
vided in the "5G UE EN-DC PDSCH Throughput Chart".

4.4.8.8  5G NR quality of service

The following page is an example of the workspace which provides the results of the
application to physical layer comparison.

Mobile views
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Figure 4-496: 5G UE QoS views

The workspace page related to 5G UE QoS displays the application layer measure-
ment results and the output. Also are compared the TCP/IP network interface data per-
formances with the DL and UL physical layer.

The following information is included:

● Application layer test results and statistics
● Application layer testing progress
● Downlink throughput side-by-side comparison of IP network interface with LTE and

5G NR downlink physical layer
● Uplink throughput side-by-side comparison of IP network interface with LTE and 5G

NR uplink physical layer

This information is given by the existing QoS DQA views and the "5G EN-DC DL Data
Chart" and "5G EN-DC UL Data Chart" 5G NR mobile views.

4.4.8.9  5G NR UE signals and templates

The following chapter is dedicated to the 5G NR UE signals supported by R&S
ROMES4. The signals are configurable via "Preferences" > "Available Signals" > "5G
NR UE"

Mobile views
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Figure 4-497: 5G NR UE supported signals

The signals you want to display in a particular R&S ROMES4 supported 5G NR UE
view can be also selected via the view's context menu. The 5G NR UE signals are
grouped in nodes (branches) each one related to certain procedure or layer.

The previous screenshot shows the nodes of the "Signal Tree" > "5G NR UE" signals.
The UE cell signals are not distinguished in nodes whether they belong to PCell (Pri-
mary Cell) or SCell (Secondary Cell). The dedicated PCell and SCell UE signals nodes
are not supported in R&S ROMES4 signal tree for 5G NR UE signals as default. For
signal nodes that indicate performances of PCC and SCCs introduced are 5G NR UE
nodes template signals. For example, the template signals are those signals contained
in the "5G NR UE Carriers" node.

Mobile views



Display and evaluation of resultsDrive Test Software

883Operating Manual 1171.6415.12 ─ 66

Figure 4-498: Template signals in 5G NR Carriers node

If a signal is only available in PCell carrier, "(P)" is suffixed in the signal name. If multi-
ple signals are selected and the selected signals contain both PCell and SCell carriers,
the filter dialog asks twice for both types of signals, once for each type.

For the following 5G NR UE nodes are supported template signals:

● "5G NR Carriers"
● "Channel Quality Carrier"
● "PDSCH Carrier"
● "PUSCH Carrier"
● "RRC IEs"
● "BSR Buffer Status"
● "5G NR TDD Configuration"

Template signals filter dialog

When signals are dragged into a view or for export, filter dialog pops up. 5G NR filter
dialogs show different number of carriers in pulldown list.

Signals available for both PCell and SCell

If both PCell and SCell signals are available for the selected signal, following pulldown
list displays 5G NR filter dialog.

There are 12 5G NR UE mobile template signals, a PCell signal and SCell signals 1 to
11.
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Figure 4-499: 5G NR filter dialog

PCell only signals

If only PCell signal is available for the selected signal, the pulldown list is auto filled
with the only choice - PCells.

Figure 4-500: Filtering PCells only

Optionally, check the "Apply for all signals" check box to apply the choice to all signals.
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Multiple signals for PCell only and for both PCell and SCell

It is possible to select multiple signals and some of them are PCells only and some are
for both PCell and SCell. In this situation, the filter dialog asks twice for both types of
signals, once for each type.

Prior filter

The "Prior Selection" template option is available in the filter dialog for both PCell and
SCell.

Figure 4-501: Prior selection both PCell and SCell

The LTE UE and 5G NR UE template signals are contained in the UE mobile views
that involve carrier signals, e.g., "UE CA DL Performance View"/"UE CA DL Perfor-
mance View", "Serving Cell View". The views are updated to show the signals cor-
rectly.

As the number of carrier increases, it can happen that there is no enough space to
show all carriers at top of the view. Because of that reason, the carriers are not presen-
ted at the top of the views. If only one carrier is selected at a time, the carriers are dis-
played for selection in a pulldown menu. If multiple carriers are chosen for display at
the same time, they have to be selected from the property bar on the left side of the
view.
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Figure 4-502: Single carrier selection from carrier selector
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Figure 4-503: Multiple carriers selection from property bar

5G NR UE signals

The list of supported 5G NR UE signals is long, as covered under the corresponding
subnodes. Here are mentioned only some of the supported signals. For the all 5G NR
UE signals and their description, see "Description of R&S ROMES4 Signals" docu-
ment.

The Qualcomm and Exynos chipset based mobile devices measure and report RSRP
per antenna ports. The signals are visible in the "5G NR UE" > "5G NR Carriers" node
of the "Signal Tree". However, their availability in the node depends on used firmware.

VoNR support

A 5G NR UE capability to support VoNR is indicated in the "UE Capabilities View", see
Figure 4-645. The important 5G NAS MM IEs shown in the following screenshot are
included in the "5G NR UE" > "NAS IEs" branch.

Figure 4-504: VoNR signals
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5G NR TDD

For the TDD configuration, 5G NR UE branch "5G NR TDD Configuration" displays the
TDD slot pattern for UL and DL allocation in a radio frame. To see the signals display-
ing the TDD configuration only, type filtering criterion "tdd".

Figure 4-505: Filtered 5G NR TDD configured signals

The configured TDD slot patterns of a cell are shown as strings of letters "D", "U", "F"
indicating downlink, uplink and flexible configured slot, respectively. The following
"Alphanumeric View" screenshot displays the configured pattern.

Figure 4-506: Example of the configured TTD slot pattern

The "TDD Pattern(full)" signal provides the slot number added to the slot letter and the
info on slot's symbols configuration. A symbol is marked as "d" for DL, "u" for UL and
"f" for flexible symbol. The Tooltip explains the information of TDD Pattern(full) when
mouse hovers over the signal.

Figure 4-507: Tooltip for TDD Pattern (Full) signal

NAS PDUI sessions signals support

The signals which provide access to the content of the PDU session configuration are
available in the "NAS PDU Sessions" branch of the "Signal Tree" > "5G NR UE". The
content is taken from the corresponding Layer 3 messages.
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Figure 4-508: Supported NAS signals

PDSCH/PUSCH carrier signals support

The "PDSCH Carrier" and "PUSCH Carrier" branches contain signals that indicate the
states of a primary component carrier and secondary component carriers. The consec-
utive "PDSCH Total" and "PUSCH Total" branches indicate the CC states in total.
Added are the corresponding signals that indicate a time elapsed for PDSCH and
PUSCH component carriers being in "Deactivated" and "Activated" state. For the sig-
nals, refer to the "Description of R&S ROMES4 signals" document.

Figure 4-509: Supported PCC and SCC state signals

The "5G NR Carriers" > "PCell" branch of the "5G NR UE" signal tree contains the
"Scanner Top N Rank" which displays the current rank of the carrier in the correspond-
ing 5G NR TopN pool. Only 5G NR auto NR-ARFCN TopN pools are supported by this
feature.

Figure 4-510: Alphanumeric view shows the scanner Top N rank

The screenshot shows, that PCI 337 has been detected by the scanner and ranked as
the best cell.

The "3GPP Overview View" shows the TopN rank of the carrier for LTE and 5G NR
within the MCG and SCG columns, respectively.
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Figure 4-511: 3GPP Overview view shows MCG and SCG values

4.4.8.10  Network - 5G NR UE negotiated throughput

EPS Mobility Management Message "ESM Throughput Information" is responsible for
informing the UE on assigned throughputs negotiated between 5G NR UE and net-
work. This information is an important message for understanding the difference
between promised/negotiated and achieved throughputs on the radio-link. The informa-
tion is included in R&S ROMES4 application in a form of several signals like "Delay
Class", "Reliability Class", "Maximum Bit Rate UL/DL" and "Guaranteed Bit Rate UL/
DL".

4.4.9  TETRA views

The "TETRA Views" display TETRA-specific information acquired with a TETRA test
mobile and installed TETRA device.

Recording of the different message types shown in the "TETRA Views" must be explic-
itly activated by the TETRA device configuration tabs "Configuration" and "Expert
Mode".

R&S ROMES4 available TETRA views are displayed in the context sensitive menu on
the "View" > "Mobile Views", when the mouse pauses over "TETRA".

Figure 4-512: TETRA views

Measurement files recorded with R&S ROMES4 4.50 SP1 or earlier
Due to an update of the supported TETRA data format, measurement files recorded
with R&S ROMES 4.50 SP1 or earlier are not fully supported anymore by R&S
ROMES4 4.50 SP2 or later. The files can still be replayed but the "Layer 3 View" and
"ETSI QoS View" remain empty.
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TETRA group calls
Group calls within separated groups are highly recommended as the test cases with
four mobiles in two cars. In addition, other users of the same group in the same net-
work should not interfere with the measurement.
Explanation: If this is ignored, the Call KPIs cannot be calculated according to ETSI or
other in R&S ROMES4 implemented standards and will be rendered invalid. R&S
ROMES4 will not inform the user about such configuration errors. As a consequence
the QoS view will most likely contain invalid setup-times and other wrong messages
related to KPI.
However, R&S ROMES4 NPA indicates detection of the invalid message sequences,
which is particularly important when analyzing many files. The R&S ROMES4 NPA
informs then the user which files contain the non-standard setup. In order to get valid
KPIs, these files have to be removed from the evaluated files list.

4.4.9.1  TETRA graph view

The "TETRA Graph View" displays the TETRA power and the CI of the current server
and the TETRA power and the C2 of the best neighbor.

Figure 4-513: TETRA Graph View

The "TETRA Graph View" configuration is done in the "TETRA Graph View: <variable>
Properties" pane.
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Figure 4-514: Properties of TETRA graph view

For the meaning of the configuration entries in the properties of the "TETRA Graph
View", see Chapter 4.2.1, "2D chart view", on page 448.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Selecting the "Configure" command in the context sensitive menu of the view opens
only the "Info" page.

TETRA power

Indicates the received TETRA power of the server expressed in dBm.

C1

Path loss C1 of the server expressed in dB. The calculation is based on the values of
the broadcast channel and the configured maximum MS transmit power.

Best NC TETRA power

Indicates the received TETRA power of the best neighbor cell expressed in dBm.

Best NC C2

Path loss parameter C2 expressed in dB.

C2(n) = 
TETRA Power(n) - RXLEV_ACCESS_MIN_MCELL(n) - Max ( 0, MS_TXPWR_MAX_MCELL(n) - PMS(n) )

● TETRA Power(n)

Mobile views



Display and evaluation of resultsDrive Test Software

893Operating Manual 1171.6415.12 ─ 66

Averaged TETRA signal level at MS or equivalent signal quality measurement on
the monitored carrier.

● RXLEV_ACCESS_MIN_MCELL(n)
Minimum permissible received level at MS on the monitored carrier.

● MS_TXPWR_MAX_MCELL(n)
Maximum MS transmit power allowed on the monitored carrier.

● PMS(n)
Maximum transmit power of the MS for the modulation mode on the monitored car-
rier.

4.4.9.2  TETRA overview view

The "TETRA Overview View" displays the most important parameters. In the upper
section shows the registration state of the MS. The next section shows the most impor-
tant parameters concerning the current serving cell. The parameters of best neighbor
cell can be seen below, followed by the "Call State Info" and the "Top N" list of the
TETRA scanner, if available.

Figure 4-515: TETRA Overview View

The "TETRA Overview View" configuration menu customizes the color of the carrier
and the contents of the table.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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State

● RAT
Current Radio Access Technology.

● Mobile State
Possible states of the radio are:
– Unknown

No network available
– Idle

Registered in standby mode (no active call)
– Access

Call is set up
– Dedicated

Call in TETRA network
– Unconnected

Radio is not connected
– Scan

Radio is in scan mode
– Registered home network

Radio is registered in home network

Network provider

● MCC
Mobile Country Code identifies a country the operator belongs to.

● MNC
Mobile Network Code identifies the operator.

Server

The "Server" panel displays several parameters describing the signal power and qual-
ity reported by the test mobile of the current serving cell.

● Name
Name of the serving cell.
There is a "+" behind the name when there are more than one cell of a provider
within the same LA and the filtering by carrier is not enabled, see TEC for TETRA.

● Frequency
Centre frequency of the TETRA channel.

● TETRA Power
Indicates the received wideband power in dBm.

● BER
Block Error Rate

● C1
Server path loss parameter C1 calculated using the values of the broadcast chan-
nel and the configured maximum UE transmit power.

● LA
Location Area a geographical area including one or more cells.
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Best neighbor

● Name
Name of the best neighbor cell.
There is a "+" behind the name when there are more than one cell of a provider
within the same LA and the filtering by carrier is not enabled, see TEC for TETRA.

● TETRA Power
Received wideband power in dBm.

● C1
Path loss parameter C1 calculated for a neighbor cell using broadcast channel
information and the configured maximum UE transmit power.

● LA
Location Area a geographical area including one or more cells.

CS call info

The "CS Call Info" panel displays the circuit switched call state.

Top N

The "Top N" panel displays TETRA scanner data recorded by the TETRA scanner
device. It shows the properties of the signals from the BTS that are elements of the
current Top N Pools. The data is also displayed in Chapter 4.8.10.7, "TETRA scanner
Top N view", on page 1363.

The drop down menu on top of the "Top N" panel contains all Top N pools defined in
the "Top N" tab of the TETRA technology configuration. Up to 3 differently named pools
can be configured in the default setup. Each pool has several configurable parameters.
The Top N list gives an overview of the received signals in the current Top N pool
together with their measured power parameters, frequency and timing information. In
the view configuration menu, it is possible to show or hide each individual table col-
umn.

On mouse rollover, each cell in the table header provides a short explanation of the
corresponding column.

The Top N list contains the following columns:
● #

Number of measured cells within the Top N pool
● Rank

Current rank within the Top N pool
● Carrier

TETRA Carrier Index (0 to 3999)
● Main Carrier

Frequency of the MCCH extracted from SYSINFO PDU
● LA

Location Area a geographical area including of one or more cells
● Inband Power

Inband power of the TETRA channel in dBm
● TETRA Power
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Received TETRA power in dBm
● SNR

Signal-to-Noise-and-interference-ratio in dB
● C1

Path loss parameter C1 calculated using the values of the broadcast channel and
the configured maximum MS transmit power

● FRA
State of the Fast Reselection
Calculation uses the values of the broadcast channel.

● SRA
State of the Slow Reselection
Calculation uses the values of the broadcast channel.

● BLER Pre-Vit.
Ratio of estimated number of channel errors in block 1 and block 2 to the number
of analyzed bits in block 1 and block 2 (comparison of received data and re-enco-
ded data after error correction (Convolutional Code with Viterbi-Detector))
expressed in %.

● BLER AACH
Block Error Rate of Access Assign Channel
Ratio of estimated number of channel errors in the broadcast block to number of
analyzed bits in the broadcast block (comparison of received data and re-encoded
data after error correction (Reed-Muller-Code)) expressed in %.

● Freq-Error
Frequency error in Hz

● Phase-Error
RMS (Root-mean-square) phase error on the information symbols expressed in
degree [°]

● Delay Spread
Delay spread of arriving paths expressed in µs

● Timeslot
Timeslot number extracted from SYNC PDU

● FN
Frame number extracted from SYNC PDU

● MFN
Multiframe number extracted from SYNC PDU

● Burst Mod ER
Modulation Error Ratio over all symbols in the burst in dB

● Pilot Mod ER
Modulation Error Ratio over the pilot and sync symbols in dB

● Header Mod ER
Modulation Error Ratio over the header symbols in dB

● Data MER
Modulation Error Ratio over the data symbols in dB
MER = Modulation Error Ratio (Mod ER in dB)
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

TETRA overview view configuration

Top N view configuration

The "Top N View" tab defines the contents of the "Top N" table.

Figure 4-516: TETRA Overview View - configuration

2D Chart Option
The option to display the signal quality is active if "Show signal quality" is checked. The
function is the possibility to switch "on" or "off" the second y-axis on the chart and qual-
ity signal bars.
If the option is selected, you will see the result of the switching only on the next frame.
The chart must redraw at least once for it.

Color settings

The color scale for the TETRA Power signal values obtained both from mobiles and
scanners is unified with the scale used in R&S ROMES4 NPA.
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Figure 4-517: Color scale setting - common for TETRA mobiles and scanners

4.4.10  3GPP handover analyzer view

The "3GPP Handover Analyzer View" shows a list of the GSM (2G → 2G), UMTS (3G
→ 3G), LTE (4G -> 4G) and inter-RAT (3G → 2G, 4G → 2G and 4G → 3G ) handover
procedures attempted by UMTS, GMS and LTE mobile devices and provides a statisti-
cal evaluation. The list and the statistics are displayed in two alternative views. It is
possible to open several "3GPP Handover Analyzer Views" simultaneously in order to
observe the list and the statistical views in parallel.

Figure 4-518: 3GPP Handover Analyzer View
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The Handover analyzer generates nodes for each UMTS event. It may happen that the
actual ActiveSetUpdate (renamed to UMTS Handover analyzis due to support of 3G ->
2G handover packet switched, see Chapter 4.4.10.1, "Handover list", on page 899) is
not placed in the same branch as the triggered event if meanwhile the mobile has
reported different event. In this case, the event can be found in one of the branches
above.

The handover analysis requires the Handover Analyzer plugin option R&S
ROMES4HOA. The view is empty unless the test mobile records the "Layer 3 Mes-
sages". For more, see the description of the "Handover" window in the mobile devices
configuration menus in the chapter "Handover analyzer" on page 1584. The handover
analysis must be activated in the "HOA" check box of the window.

The complete list of the recorded handovers is selected via "Show List" in the context
menu.

4.4.10.1  Handover list

The handover list consists of the following columns:
● Handover

Shows current handover number and handover type. The handover analyzer
reports GSM,UMTS LTE intra-/inter-RAT handovers. CS and PS denote the circuit
switched and packet switched domains, respectively.
The following Layer 3 messages which are relevant for the handover processes
related to 3G and 2G technologies are listed within a handover event:
– 3G → 3G Handovers (CS):

Measurement report with one of the events (1a, 1b, …, uplink) described below
ACTIVE SET UPDATE (downlink)
ACTIVE SET UPDATE COMPLETE (uplink)

– 3G → 2G Handovers (CS):
Measurement report with event 3a described below (uplink) or Cancel event
HANDOVER FROM UTRAN COMMAND (to GSM, downlink)
HANDOVER COMPLETE (uplink)

– 3G → 2G Handovers (PS):
Due to support of 3G → 2G handover (PS), the page UMTS ActiveSet Analysis
is renamed as UMTS Handover Analysis to show that more than some Active
Set Updates are detected.

– 2G → 2G Handovers (CS):
GSM HANDOVER COMMAND (downlink)
HANDOVER COMPLETE (uplink)

– 3G → 3G Handovers (PS):
CELL UPDATE (downlink)
CELL UPDATE CONFIRM (uplink)

– 3G → 3G Handovers (HSDPA):
TRANSPORT CHANNEL RECONFIGURATION REQUEST / ACCEPT

It is possible to expand or collapse the messages for a single handover (click the
+ / – symbols or double-click the line) or all handovers (use the context menu).
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Double-click for a detailed analysis of the Layer 3 messages. For a complete list of
Layer 3 messages use Chapter 4.4.15, "Layer 3 view", on page 958.

● Time
Handover start time, the time of the first Layer 3 message (see above) which initi-
ated the handover report.

● Event
Handover type or one of the measurement reporting events that the UMTS test
mobile received from the network. The events are used to notify a UMTS UE in
which instance it should transmit a measurement report.
3GPP TS 25.331 describes the following events:
– Event 1a

For intra-frequency measurements: a primary CPICH enters the reporting
range.

– Event 1b
A primary CPICH leaves the reporting range.

– Event 1c
A non-active primary CPICH becomes better than an active primary CPICH.

– Event 1e
Aa primary CPICH becomes better than an absolute threshold.

– Event 1f
A primary CPICH becomes worse than an absolute threshold.

– Event 2d
For inter-frequency measurements: The estimated quality of the currently used
frequency is below a certain threshold.

– Event 2f
The estimated quality of the currently used frequency is above a certain thresh-
old.

– Event 3a
For inter-RAT measurements: The estimated quality of the currently used
UTRAN frequency is below a certain threshold and the estimated quality of the
other system is above a certain threshold.

● Result
Status of the handover attempt.
Possible results are:
– Start
– Pending
– Complete for successful handovers
– Timeout for handover time exceeded the timeout specified in "HOA" tab of the

UMTS mobile device configuration menu (see "Handover analyzer"
on page 1584).

– Event Change for the measurement reporting event changed by the network
during the handover.

● Add
GSM: BCCH and BSIC of the source base station.
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UMTS: Name of an UTRAN cell added to the active set, taken from the Node B
database (if available). To monitor the complete active set and neighbor set, see
Chapter 4.4.18, "Serving cell view", on page 999.

● Remove
GSM: BCCH, BSIC, CI, and LAC of the target BTS and cell.
UMTS: Name of an UTRAN cell removed from the active set, taken from the Node
B database (if available).

4.4.10.2  Filter options

The buttons above the "Handover" list are used to select for display or hiding hand-
overs/reselections of different types and with specific results. A dimmed button means
that the handover events are not shown in the list, they are hidden.

● The buttons in the first row stand for the events outcomes.
● The buttons in the second row stand for mobility events in the 3G and 2G technolo-

gies.
● The buttons in the third row stand for the 4G mobility events.

Beside each line in the "Handover" list, the simple symbol indicates event and its state.

4.4.10.3  Further analysis

An upper case D appears to the right of the cursor arrow when it is placed on a layer 3
message. This symbol indicates that there is detailed information to be retrieved for the
current Layer 3 message. The detailed information window is opened by double-click-
ing the message.

It is also instructive to monitor the measurement route and the NodeBs / Base Stations
in the Chapter 4.3.3, "ROMESMAP route track view", on page 562 view. The cells in
the "Add" and "Remove" columns can be displayed with different colors using the
"Show NodeBs/BTSs" on map command in the context menu. The color code can be
configured in the "3GPP Handover Analyzer View" configuration menu.

3G –> 3G handover

The statistical evaluation of the recorded handovers is selected via "Show Statistics" in
the context menu. There are three versions of the statistics tab, corresponding to the
three handover types "3G → 3G", "3G → 2G" (inter-RAT), "2G → 2G" The versions are
selected in the drop-down list across the top of the view.

The 3G –> 3G Handover tab shows the following results.
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Event table

The table lists the total number of detected handovers with their measurement report-
ing event class and the handover result.
● Handovers with the same active event appear in the same row. The last row ("All")

shows the sum of all previous rows. "Event Change" handovers are classified
according to the event at the start of the handover.

● Handovers with the same result appear in the same column. The following catego-
ries are defined: MR (Measurement Report; the sum of the "ASU", "ASU-F", and
"ASU-X" columns), "ASU" (Active Set Update, handovers with an update of the
active cell set), "ASU-C" (Active Set Update Complete, ASU handovers that could
be completed without error), "ASU-F" (Active Set Update Failure, ASU handovers
that failed before the timeout), "ASU-X" (all other handovers, e.g. the "Timeout" or
"Event Change" handovers).

Overview of the GSM handovers and handovers between different Radio Access Tech-
nologies (inter-RAT handovers, 3G/UMTS → 2G (GSM) and 2G (GSM) → 3G/UMTS).
● SR

Success Rate, ratio of the successful handover attempts (Result: "OK") to the total
number of handover attempts for each handover type. A handover is classified suc-
cessful if it could be achieved before the "Handover Timeout" defined in the config-
uration menu elapsed.

● Attempts
Total number of handover attempts for each handover type.

The distribution of the duration of the handover procedures (i.e. the time between a HO
command and a HO response) is shown in two bar graphs:
● GSM Handover [s]

Time for GSM handovers.
● Inter-RAT Handover [s]

Time for inter-RAT handovers including
3G → 2G and 2G → 3G handovers.

The diagram scales and the number of classes (bars) are fixed.

Successful handover distribution

The upper bar graph shows the percentage of successful (completed) handover
attempts for each event class, i.e. the number of "ASU-C" handovers divided by the
number of "MR" handovers. In the example of the figure above, all "Event 1a" and
"Event 1b" handovers but none of the "Event 2f" handovers were successful.

The diagram scales and the number of classes (bars) are fixed.

General handover distribution

The lower bar graph shows the percentage of (completed and failed) handover
attempts for each event class. The red portion of each bar corresponds to the failed,
the green portion to the successful attempts. The added length of all bars is 100%.

The "3G → 2G Handover" and "2G → 2G Handover" tabs are similar to the previous
one.
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The following properties of the network standard simplify the tables and diagrams:
● An inter-RAT handover can only occur while the measurement reporting event 3a is

active, so the "3G → 2G Handover" view only shows the percentage of successful
and failed handovers within the event class 3a.

● No reporting events are defined for GSM (2G) networks, so the "2G →  2G Hand-
over" view only shows the percentage of successful and failed handovers.

IRAT HO testing using autodialing

The autodialing mechanism of the mobile devices was extended with a new feature in
order to test IRAT handovers automatically.

4.4.10.4  Support of 4G mobility, redirection and handover

For the LTE technology the R&S ROMES4 HO analyzer supports the following events:
● 4G Mobility
● Redirection

– 4G → 4G
– 4G → 3G
– 4G → 2G

● Handover
– 4G → 3G
– 4G → 2G
– 4G → 3G/2G during a voice call, named SRVCC

The analyzer results are reported automatically if the Handover Analyzer feature is
switched on in the mobile devices configuration (default setting when the necessary
option is available).

3GPP Release 8 Layer 3 messages are supported and given in the following chapters.

4G mobility

The 4G mobility info evaluats the rrcConnectionReconfiguration messages which
contain a mobilityControlInfo structure. The analyzers result reports the foregoing
measurementReport, the rrcConnectionReconfiguration and the rrcConnection-
ReconfigurationComplete.

The source and the target eNodeB are reported also, see the Figure 4-518.

4G → 2G redirection

The start trigger point of the 4G → 2G redirection is the rrcConnectionRelease with a
redirectedCarrierInfo structure. The analyzer checks if the Location Area Update in
2G can be executed successfully. The corresponding message flow can be seen in the
"Handover Analyzer View". The source eNodeB and the target ARFCNs are reported.

Mobile views



Display and evaluation of resultsDrive Test Software

904Operating Manual 1171.6415.12 ─ 66

4G → 3G redirection

The start trigger point of the 4G → 3G redirection is the rrcConnectionRelease with
the redirectedCarrierInfo structure. The analyzer checks if the rrcConnectionSetup-
Complete in the 3G network succeeded. This message is a trigger point for successful
4G → 3G redirection. The corresponding message flow can be seen in the "Handover
Analyzer View". The source eNodeB and the target UARFCN are reported.

4G → 4G redirection

The start trigger point of the 4G → 4G redirection is the rrcConnectionRelease with a
redirectedCarrierInfo structure. The analyzer checks if the rrcConnectionSetup at
the new EARFCN succeeded. The corresponding message flow can be seen in the
"Handover Analyzer View". The source eNodeB and the target EARFCN are reported.

4G → 3G handover

The Handover Analyzer plugin supports detection of 4G→ 3G handover events among
others, see Figure 4-519.

The corresponding trigger points are displayed in the "Handover Analyzer View":
● mobilityFromEUTRANCommand
● handoverToUTRANComplete
● LOCATION UPDATING REQUEST
● LOCATION UPDATING ACCEPT

Figure 4-519: 4G -> 3G Handover

The message flow, the source eNodeB and the target UARFCNs are also reported.

SRVCC (4G→ 3G /2G handover)

The Layer 3 view displays the corresponding messages which are involved into the
handover process, as shown in the following figure.
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Figure 4-520: Layer 3 messages view

The Handover Analyzer generates nodes for each HO event.
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Figure 4-521: SRVCC tracer

The SRVCC is displayed in the "ETSI QoS View".

The "ETSI QoS View" reports the presence of an IRAT handover in the "Mode" column,
see the following figure.
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Figure 4-522: Mode column shows IRAT HO type

Statistics

For both new analyzer results, the statistics are reported. To show the statistics display,
change the views display by opening the context menu and selecting the "Show Statis-
tics".

Figure 4-523: Show Statistics - the 4G → 4G mobility case

4G handover analyzer events

The 4G handover analyzer results provide the events can be used for visualizing the
analyzers results, for example, in the map or 2D chart. The events have to be activated
in the "Event Configuration" dialog. To access the dialog click "Tools > Preferences".

Mobile views



Display and evaluation of resultsDrive Test Software

908Operating Manual 1171.6415.12 ─ 66

Figure 4-524: List of 4G events

4.4.10.5  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional, view-specific commands:
● Show Node B…

Use the color code defined in the "3GPP Handover Analyzer View" configuration
menu (see below) to mark the cell for the selected handover in the "ROMESMAP
Route Track" view. This feature is only available if a handover process is selected
in the handover list. The colored cells are the ones listed in the "Add" and
"Remove" columns, respectively. The UMTS layer / GSM BTS layer in the "Route
Track" view must be visible to use this feature.

● Hide Node B
Reverse the previous action, display the selected cell symbol with standard colors.

● Hide all Node B
Display all cell symbols with standard colors.

● Show List/Statistics
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Toggle between the list of the recorded handovers and the statistical evaluation.
● Close all Details

Remove all open details windows from the view. This action is convenient for
removing several open windows pinned over the view; see Chapter 4.1, "Common
properties of R&S ROMES4 views", on page 428.

● Expand/Collapse All
Show or hide the layer 3 messages for each handover in the list.

● Export
● Export the handover analyzer data to a *.csv export file that can be opened and

processed by Excel. The file contains the information in the statistics view.
● Print/Preview Chart

Show a print preview or print the Show Statistic view.

4.4.10.6  3GPP handover analyzer view configuration

The "3GPP Handover Analyzer View" configuration menu defines the CMD file scan-
ning behavior and the color scheme for the NodeB / BTS symbols in the "ROMESMAP
Route Track View" .

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-525: 3GPP Handover Analyzer View - configuration

General
The "Scan File" check box enables/disables the automatic scanning of 2G/3G-related
handover data in the active measurement file.
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Route Track Colors ← General
● The colors distinguish the following UMTS Node Bs and GSM base stations:
● "UMTS Remove"

UTRAN source cell of the handover
● "UMTS Add"

UTRAN target cell of the handover
● "GSM Source"

GSM target cell of the handover
● "GSM Target"

GSM target cell of the handover

4.4.11  3GPP neighbour set view

The "3GPP Neighbour Set View" is joining and enhancing the existing GSM, UMTS
and LTE cell set views towards a single 3 technology view for all intra- and inter-RAT
measurements commanded by the network and performed by the mobile station.

For a 3GPP specific technology, signaling info from the cell broadcast and/or measure-
ment control messages are evaluated and displayed depending on the mobile state
and current measurement situation.

4.4.11.1  Measurement data

Information about the neighbour set will be retrieved from the mobile trace data and
from the Layer 3.

4.4.11.2  State/list

The "State" has an overview bar for displaying the current mobile state (idle, DCH,
FACH, PCH, Dedicated, GPRS Active, LTE traffic, compressed mode) and the follow-
ing technology specific information: HSDPA, HSUPA, Dual Cell, MIMO activation.

The "List" > "Set" table has the tree layout with the five fixed root items:
● Active
● Intra-Frequency Neighbor Cells
● Inter-Frequency Neighbor Cells (not available for GSM)
● Inter-RAT Neighbor Cells [Technology 1]
● Inter-RAT Neighbor Cells [Technology 2]

The technology of the Inter-RAT tree items is dependent on the current RAT and can
be GSM, UMTS or LTE. Each tree item has a sub-set of eight columns. The content of
each column depends on the current RAT.
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Table 4-22: Inter-RAT tree items

RAT Cell
State

Channel Color Cell
Identifier

Name Quality Level Source

GSM Cell State ARFCN Color BSIC BTS ... RxLevF
or RSSI

Source

UMTS Cell State UARFCN Color SC Node B Ec/No RSCP Source

LTE Cell State EARFCN Color PCI Enode B RSRQ RSRP Source

If RAT changes, the tree is reset.

RAT dependent 3GPP neighbour set view

RAT GSM

2G intra- and inter-frequency and 3G inter-RAT neighbors are extracted from SIT 2
(detected mode) and SIT 5 (detected mode) of the current cell. The cell info list of UE
trace will be modified by the reception of the SIT 2 and 5. The cells which are included
in both lists are marked "Trace/SIT2" or "Trace/MC" (SIT5).

Figure 4-526: RAT GSM

Cell State
● Active Set: Indication whether the cell is the serving cell or not (Yes/No).
● Intra-Frequency Neighbor Cells

– Monitored Set: The cell is reported in the Layer 3 message SIT2 or SIT5.
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Figure 4-527: System Information Type 2

– Detected Set: The cell is detected by the mobile trace and not reported in the
Layer 3 SIT2 or SIT5.

● Inter-Frequency Neighbor Cells: Not available for GSM
● Inter-RAT Neighbor Cells LTE: Currently not implemented
● Inter-RAT Neighbor Cells UMTS: Cell State is not available

ARFCN
● Absolute Radio Frequency Channel Number (ARFCN) of the received DL signal.

Color
● Active Set: No coloring
● Intra-Frequency Neighbor Cells

– Green: The cell is monitored and measured (RxLevF value available)
– No color for all other states

● Inter-Frequency Neighbor Cells: Not available for GSM
● Inter-RAT Neighbor Cells LTE: Not currently implemented for GSM
● Inter-RAT Neighbor Cells UMTS: No coloring

BSIC
● Base transceiver station (BTS) identity code; In this view, the BSIC is always octal

(BSIC = ab where a is the NCC and b is the BCC), irrespective of the format (octal/
decimal / hex) selected in the "Preferences > Available Signals" menu.

BTS
● The BTS Name; Only available when a transmitter database corresponding to the

measurement data is loaded.
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RxLevF
● Minimum received signal level required for an interference situation. The value can

be entered either as an RxLev value in steps from 0 to 63 (steps) or as an absolute
level in dBm depending on the signal settings. The values will only be displayed
when they are inside the expected range.
In the Inter RAT Neighbor Cells UMTS this column displays the RSCP value.

Source
● Trace: The data source is a mobile trace
● MC: The data source is the Layer 3 SIT3, SIT5ter or SIT2bis
● SIT2: The data source is the Layer 3 SIT2
● SIT2ter: The data source is the Layer 3 SIT2ter
● SIT2quater: The data source is the Layer 3 SIT2quater
● SIT2n: The data source is the Layer 3 SIT2n
● SIT2bis: The data source is the Layer 3 SIT2bis

Multiple data sources are possible.

When the signal settings of the RxLevF value have been changed during replay, the
measurement file must be reloaded to apply the changes in this view. This especially
holds for the ranges of the appropriate signals. If not set correctly, the signal color will
be black.

RAT UMTS

For idle mode, 3G intra- and inter-frequency and 2G and 4G inter -RAT neighbors are
extracted from SIB 11 and SIB19 of the current cell the UE camps on.

SIB 12 modifies the settings from SIB 11 of the selected cell (formerly camped cell) in
Cell FACH, Cell PCH and URA PCH.

If the UE changes from idle (PCH, FACH) to Cell DCH state, the SIB 11 (SIB12 if trans-
mitted) is modified by IntraFreqCellInfoSI List on reception of the RRC Measurement
Control. Cells which are included in the cell info list of the UE trace are marked as
"Trace/MC”, while all another are marked as MC.

If the UE changes from Cell DCH state to Idle (PCH, FACH), the Cell Info List of UE
trace is modified on reception of the SIB11 (12, if available) by its IntraFreqCellInfoSI
List. Cells which are included in both lists are marked as "Trace/SIB11" ("Trace/SIB12")
or “SIB11” (SIB12).
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Figure 4-528: RAT UMTS

Cell State
● Active Set: Indication whether the cell is the serving cell or not (Yes/No).
● Intra-Frequency Neighbor Cells

– Monitored Set: The cell is reported in the Layer 3 message DL DCCH, SIB11 or
SIB12.
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Figure 4-529: DL DCCH message

– Detected Set: The cell is detected by the mobile trace and not reported in the
Layer 3 message DL DCCH, SIB11 or SIB12.

● Inter-Frequency Neighbor Cells
– Monitored Set: The cell is reported in the Layer 3 message DL DCCH, SIB11 or

SIB12.

Figure 4-530: Inter-frequency measurement
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– Detected Set: The cell is detected by the mobile trace and not reported in the
Layer 3 message DL DCCH, SIB11 or SIB12.

● Inter-RAT Neighbor Cells GSM
– BSIC verification is required: The bsic_VerificationRequired flag is set in the

Layer3 DL DCCH message.

Figure 4-531: Verification required

– BSIC verification is not required: The bsic_VerificationRequired flag is not set in
the Layer3 DL DCCH message
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Figure 4-532: Verification not required

● Inter-RAT Neighbor Cells LTE: Cell state not available.

UARFCN
● UTRAN Absolute Radio Frequency Channel Number (ARFCN) of the received DL

signal. The carrier frequency is equal to "f = 0.2 MHz * UARFCN".

Color
● Active Set: No coloring
● Intra-Frequency Neighbor Cells:

– Green: The cell is monitored and measured (RSCP value available).
– Red: The cell is detected and the triggering condition for the detected set is not

included in the event criteria list of the Intra-Freq Reporting Criteria.
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Figure 4-533: Red color - triggering condition not included

– Yellow: The cell is detected and the triggering condition for the detected set is
included in the event criteria list of the Intra Freq Reporting Criteria.
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Figure 4-534: Red color - triggering condition included

– No coloring: The cell is detected and the event criteria list of the Intra Freq
Reporting Criteria is not available.

● Inter-Frequency Neighbor Cells: No coloring
● Inter-RAT Neighbor Cells GSM: Yellow if BSIC verification is required, otherwise no

coloring.

SC
● The scrambling code of a cell.

Node B
● The Node B name. Only available when a transmitter database corresponding to

the measurement data is loaded.

Ec/No
● Ratio of the received energy per PN chip for the signal to the total received power

spectral density at the mobile antenna connector. The color depends on the value
and is taken from the signal setting.
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The values are only be displayed when they are inside the expected range. In the
Inter RAT Neighbor Cells LTE this column displays the RSRQ value. In the Inter
RAT Neighbor Cells GSM this column has now values.
In the Inter RAT Neighbor Cells UMTS this column displays the RSCP value.

RSCP
● CPICH Received Signal Code Power value; The color depends on the value and is

taken from the signal setting.
The values are only be displayed when they are inside the expected range. In the
Inter RAT Neighbor Cells LTE this column displays the RSRP value. In the Inter
RAT Neighbor Cells GSM this column displays the RxLevF value.

Source
● Trace: The data source is a mobile trace
● MC: The data source is the Layer 3 measurement control (DL DCCH)
● SIB11: The data source is the Layer 3 SIB11
● SIB12: The data source is the Layer 3 SIB12
● SIB19: The data source is the Layer 3 SIB19

Multiple data sources are possible.

When the signal settings of the Ec/No or RSCP values have been changed during
replay, the measurement file must be reloaded to apply the changes in this view. This
especially holds for the ranges of the appropriate signals. If not set correctly, the signal
color will be black.

RAT LTE

4G intra- and inter-frequency and 2G and 3G inter-RAT neighbors are extracted from
SIB 4,5,6 and 7 of the current cell the UE camps on.

When the UE changes from idle to connected, the SIB 4,5,6,7 is modified on reception
of the RRCReconfiguration message (DL_DCCH) by the Cell Info List of the UE trace.
The cells which are included in both (intra- and inter-frequency) lists are marked as
Trace/SIB4, 5, 6, 7 or Trace/MC.

The"3GPP Neighbour Set View" for LTE RAT only shows the DL_DCCH message
details on the right side of the Cell Info List. The Layer 3 DL_DCCH message contains
the active set of objects, configurations and measurements of the serving LTE cell.
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Figure 4-535: RAT LTE

Cell State
● Active Set: Indication whether the cell is the serving cell or not (Yes/No).
● Intra-Frequency Neighbor Cells:

– Monitored Set: The cell is reported in the Layer 3 message DL DCCH or SIB4.
– Detected Set: The cell is detected by the mobile trace and not reported in the

Layer 3 message DL DCCH or SIB11.
In the current LTE networks the SIB4 comes very rarely.

● Inter-Frequency Neighbor Cells:
For the LTE serving cell the current active set of objects, measurements and con-
figurations of the Layer 3 message DL DCCH are displayed in a detail window at
the right side of the list.
– Monitored Set: The cell is reported in the Layer 3 message DL DCCH or SIB5,

see the previous figure.
– Detected Set: The cell is detected by the mobile trace and not reported in the

Layer 3 message DL DCCH and SIB5.
● Inter-RAT Neighbour Cells GSM: Cell state is not available.
● Inter-RAT Neighbour Cells UMTS: Cell State is not available.

EARFCN
● EUTRAN Absolute Radio Frequency Channel Number of the received DL signal.

Color
● Active Set: No coloring
● Intra-Frequency Neighbor Cells

– Green: The cell is monitored and measured (RSRP value available).
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– No color for all other states.
● Inter-Frequency Neighbor Cells: No coloring
● Inter-RAT Neighbor Cells GSM: No coloring
● Inter-RAT Neighbor Cells UMTS: No coloring

PCI
● The physical cell ID of the cell.

ENode B
● The ENode B name; only available when a transmitter database corresponding to

the measurement data is loaded.

RSRQ
● Reference Signal Received Quality; It is the ratio N×RSRP/(E-UTRA carrier RSSI),

where N is the number of RB's of the E-UTRA carrier RSSI measurement band-
width. The measurements in the numerator and denominator shall be made over
the same set of resource blocks. E-UTRA Carrier Received Signal Strength Indica-
tor (RSSI), comprises the linear average of the total received power (in [W])
observed only in OFDM symbols containing reference symbols for antenna port 0,
in the measurement bandwidth, over N number of resource blocks by the UE from
all sources, including co-channel serving and nonserving cells, adjacent channel
interference, thermal noise etc. (3GPP TS 36.214).
The values are only be displayed when they are inside the expected range. In the
Inter RAT Neighbor Cells UMTS this column displays the Ec/No value. In the Inter
RAT Neighbor Cells GSM this column has now values.

RSRP
● Reference-Signal-Received-Power Received Signal Strength on Reference Sym-

bols Definition TS 36.214; The signal is defined as the linear average over the
power contributions (in [W]) of the resource elements that carry cell-specific refer-
ence signals within the considered measurement frequency bandwidth.
For RSRP determination the cell-specific reference signals R0 according TS
36.211 shall be used. If the UE can reliably detect that R1 is available it may use
R1 in addition to R0 to determine RSRP. The values are only be displayed when
they are inside the expected range. In the Inter RAT Neighbor Cells UMTS this col-
umn displays the RSCP value. In the Inter RAT Neighbor Cells GSM this column
displays the RxLevF value.

Source
● Trace: The data source is a mobile trace
● MC: The data source is the Layer 3 measurement control (DL DCCH)
● SIB4: The data source is the Layer 3 SIB4
● SIB5: The data source is the Layer 3 SIB5
● SIB6: The data source is the Layer 3 SIB6
● SIB7: The data source is the Layer 3 SIB7

Multiple data sources are possible.

When the signal settings of the RSRQ or RSRP values have been changed during
replay, the measurement file must be reloaded to apply the changes in this view. This
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especially holds for the ranges of the appropriate signals. If not set correctly, the signal
color will be black.

4.4.11.3  Limitations

Certain chipsets may have restrictions concerning their trace output. Also various
access network vendors and parameter settings can influence the results on the view.

4.4.11.4  Supported devices

All 2G, 3G, 4G Qualcomm and Samsung chipsets based devices and the QualiPoc
converter files.

4.4.12  3GPP overview view

The R&S ROMES4 "3GPP Overview View" displays the most important parameter val-
ues of the 3GPP test mobile, like it's state, power/quality, system parameters and tests
results performed by the mobile.

The view's layout is adjusted to fit all supported technologies (GSM, UMTS, LTE, NB-
IoT, LTE EN-DC, 5G NR).

Figure 4-536: Default 3GPP Overview View page

The upper part of the view is common for the technologies. The common part includes
the "Serving Cell", "Technology" and "UE State" sections. They show the serving cell
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details like cell name, MCC, MNC and BTS ID, the RAT details and the UE states,
respectively.

This part of the view shows also the results of the performed data, voice and/or WLAN
tests in the "Data Test", "Voice Test" and "WLAN" sections.

The "Data Test" section has three ways of data test results display depending on set-
tings done in the "3GPP Overview View Properties" pane. The data test results can be
displayed as text, gauges and chart dependent on selection in "General Settings" >
"Data Display".

The option to show data test results as text allows you to focus on the actual values.

Figure 4-537: 3GPP Overview View - text display of data test results

In case of gauges display, the two gauges "QoS DLl Thp" and "QoS ULThp" on left
show the data throughput on the application layer for all RATs. The two gauges on the
right-hand side add additional information about the PDSCH/PUSCH throughput for
LTE and 5G NR.

Therefore, the PDSCH/PUSCH throughput is shown by these right-hand gauges sepa-
rately, as two parts (DL/UL) per LTE and 5G NR and also on the application layer
gauges, on left-hand side.

The usage of the supported MSC during the measurement is displayed by the colored
horizontal bar. The bar is made of colored blocks that represent the values in percent-
age of contribution of each used MSC in the total modulation. The selection of MCS
colors is done in the "3GPP Overview View Properties" pane, see Figure 4-536.
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Figure 4-538: 3GPP Overview View - gauges display of test results

The following screenshot shows capacity test result as a chart.

Figure 4-539: 3GPP Overview View - chart display of test results

The "Voice Test" section shows the last MOS value and the AMR values if a voice test
is available (all phones do report AMR values). The section is hidden by default and is
visible if a voice call is configured for a replay or measurement. The approach provides
better use of screen space as voice calls are not the most commonly test items.

However, the "Voice Test" section can be forced to display even if no voice call is con-
figured by checking the "Show Voice Call Section" check-box in the "3GPP Overview
View Properties" > "General Settings" pane.

The data and WLAN test sections are optional. Similarly, the associated check-boxes
in the "3GPP Overview View Properties" > "General Settings" pane are provided to
select them for display.

The lower part of the "3GPP Overview View" is a grid displaying the Physical Layer
parameters and measured values of the currently used RAT. The parameters shown
here differ and depend on the RAT the mobile is working on.
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The view offers to change the font size of the grid. To do so, either press CTRL and
move the mouse wheel on the selected grid or change the font size in the configuration
pane.

The "Total" column for LTE and 5G NR can be hidden. Bandwidths, carrier count and
Top N rank are displayed per LTE and 5G NR.

Select the layout of the upper part of the view, that is, if to show and how the test
results section, the coloring of displayed used MCSs and the QoS throughput scaling
in "General Settings".

If the "General Settings" > "Auto QOS Thp Scales" option is selected, the throughput
ranges of the gauges are adapted to the actual values. They can also be set to initial
value.

If the "Auto QOS Thp Scales" is not selected, the gauges use the range value defined
in "General Settings" > "QOS Thp Scale".

If the data of the gauge is outside the range of the selected scale, the gauge pointer
changes from R&S blue to red. Any shaded area in the gauge changes to a combina-
tion of red and the normal color of the shaded area.

The amount of SCells for LTE and 5G can be set in the "Number of S-Cells To Show"
option of the RAT dedicated parts of the "3GPP Overview View Properties" configura-
tion pane. The only column that is shown if this number is left as default "0" is the
"PCell" column. All SCells columns and the "Total" column are hidden in this case.

If the "Number of S-Cells To Show" is set to its max value, "PCell", "Total" and all
"SCell n" are shown (n= number of Scell), as displayed the previous screenshots.

The following default screenshot shows minimum of columns (PCell only) as "Number
of S-Cells To Show"=0.

If during the measurement more SCells are detected, the number of columns will be
increased automatically.

Fixing the LTE and 5G EN-DC columns prevents toggling between them two in 3GPP
overview view and the checked option "Always Display SC Group" makes that both
columns are displayed.

The "3GPP Overview View" shows one additional icon besides the provider's one if the
mobile is forced.

Display of visual elements sources

The "3GPP Overview View" has the ability to add the underlying data source of any
visual element on the view to a R&S ROMES4 generic view. This ability allows for
greater flexibility in data analysis of the 3GPP overview.

To add the underlying R&S ROMES4 signal to a generic view ("Alphanumeric View",
"2D Chart view", "Grid View" or Map) drag the desired visual element (text field, gauge,
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chart or grid element) to a generic view. The underlying signal is added than to the
view, the same as if it had been added from the "Signal Tree".

Optional Tooltips

The "3GPP Overview View" can optionally display ToolTips for all visual elements in
the view. The option is active if the "Show Tooltips" check-box in the properties menu is
checked. If checked, the ToolTip shows the underlying R&S ROMES4 signal that is
used as a data source for the visual element. You get a better understanding of the
data and it’s sources that are used in the view.

To view the Tooltip, hover the mouse over a visual element.

4.4.12.1  RAT specific areas in 3GPP overview view

5G NR PDSCH (Downlink)

● "Net PDSCH Thp [kbit/s]"
Resulting PDSCH throughput of all acknowledged TBs, not including non-acknowl-
edged TBs, ref. 3GPP TS 36.306.

● "PDSCH BLER [%]"
PDSCH Block Error Rate, the rate of non-acknowledged TBs.

● "PDSCH MCS"
Average Modulation and Coding Scheme on PDSCH in observation period.

● "PDSCH TBS [Bytes]"
Average Transport Block Size on PDSCH in observation period.

● "PDSCH RB"
Average number of PDSCH Resource Blocks for all TTIs in observation period.

● "PDSCH Layers"
Average PDSCH transmission layers in observation period.

● "QPSK/16QAM/64QAM/256QAM"
– QPSK: Rate of Transport Blocks using QPSK modulation on PDSCH in obser-

vation period.
– 16QAM: Rrate of Transport Blocks using 16QAM modulation on PDSCH in

observation period.
– 64QAM: Rate of Transport Blocks using 64QAM modulation on PDSCH in

observation period.
– 256QAM: Rate of Transport Blocks using 256QAM modulation on PDSCH in

Observation period.

5G NR PUSCH (Uplink)

● "Scheduled PUSCH Thp [kbit/s]"
Resulting PUSCH throughput of all transmitted TBs aslo including non-acknowl-
edged TBs, ref. 3GPP TS 36.306.

● "PUSCH ReTx Rate [%]"
PUSCH Retransmission Rate, the rate of retransmitted TBs. Number of non-tog-
gling NDI divided by the total number of observed TTIs
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● "Avg PUSCH MCS"
Average Modulation and Coding Scheme on PUSCH in observation period.

● "Avg PUSCH TBS"
Average Transport Block Size on PUSCH in observation period.

● "Avg PUSCH RB"
Average Number of PUSCH Resource Blocks in observation period.

● "Avg PUSCH Layers"
Average PUSCH transmission layers in observation period.

LTE state

● EMM "State"
– "Registered"
– "Idle"

● RRC "State"
– "Connected"
– "Idle"

● "Modem State"
Possible state is "Traffic".

● "MIMO"
MIMO transmission mode refers to the use of multiple antennas at transmitter and
receiver side. For LTE downlink, a 2x2 configuration for MIMO is assumed as base-
line configuration, i.e. two transmit antennas at the base station and two receive
antennas at the terminal side.
– "SISO": Single Input-Single Output
– "SIMO": Single Input-Multiple Output
– "MISO": Multiple Input-Single Output
– "MIMO": Multiple Input-Multiple Output

UMTS

● "Node B"
Name of the NodeB, taken from the UMTS NodeB database (if available)

● "Cell ID"
Serving cell Identity

● "Band"
Frequency band the cell is operating

● "UARFCN DL"
UTRAN ARFCN of the received DL signal; the carrier frequency is calculated as
f = 0.2 MHz * UARFCN.

● "UARFCN UL"
UTRAN ARFCN of the transmitted UL signal

● "SC"
Primary scrambling code of a cell in the format selected in "TEC for UMTS Test
Mobiles > Configuration of Software Modules"; the primary SC is used to identify
the cell.
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● "CPICH RSCP [dBm]"
CPICH Received Signal Code Power in dBm is the received power on one code,
measured on the Primary CPICH.

● "TrChannel BLER [%]"
Estimation of the transport channel block error rate (BLER) based on evaluating
the CRC on each transport block.

● "CPICH Ec/No [dB]"
Received energy per chip divided by the power density in the band. The CPICH
Ec/No is identical to CPICH RSCP divided by the RSSI UTRAN.

● "Transmit Power [dBm]"
Total mobile transmitted power on one carrier in dBm.

GSM

the Master Cell Group section contains the following parameters:

● "BTS Name"
Name of the Base Station; the parameter is displayed if a valid GSM BTS database
is available

● Band
Used GSM band, e.g, E-GSM, DCS, PCS

● "Timeslot"
Shows the number of current occupied timeslot

● "Hopping"
● "BCCH (ChanNr)"

Number of the broadcast control channel of the cell and mobile
● "BSCI"

Base station identity code
● "RxQual (F/S)"

Displays the received RXQual full (F) and sub (S) value. The bar is divided into two
parts:
– Upper part shows the full value
– Lower part shows the sub value. If DTX is off, the color of the lower bar is gray.

● "RxLev (F/S) [dBm]"
Displays the received RXLev full (F) and sub (S) value. The bar is divided into two
parts:
– Upper part shows the full value
– Lower part shows the sub value. If DTX is off, the color of the lower bar is gray.

● "Timing Advance (Step)"
The length of time the signal from the mobile takes to reach the Base Station. It is
count in steps. The Timing Advance (TA) value is normally between 0 and 63. Each
step representing an advance of one symbol period.

● "Transmit Power [dBm]"
Total mobile transmitted power on one carrier in dBm.

● "TCHs"
Shows the list of currently active traffic channels.

● "CA-List"

Mobile views



Display and evaluation of resultsDrive Test Software

930Operating Manual 1171.6415.12 ─ 66

Cell Allocation (CA) list. The parameter shows the defined ARFCN within a cell.
Note: CA list is only shown in idle mode.

● "Ext. BA-List"
Extended BCCH Allocation List is relevant for network operators who work with two
GSM bands (GSM900 and GSM1800) identified by two parameter sets.

● "BA-List"
BCCH Allocation List shows the supported frequencies on the neighboring cells;
the parameter is broadcast on the BCCH (Broadcast Control Channel). It gives
mobiles the frequencies of the BCCH carriers on neighboring cells.

● "P-TCHs"
Shows the list of active traffic channels for GPRS (the Qualcomm device only).

PS call info (GSM/UMTS)

"PS Call Info" displays the following parameters reflecting the current state of the test
UE regarding PS connections.
● "PS Call State"

Phone mode concerning PS connections based on Layer 3 messages reported by
the mobile; indicates if a PDP context is established or not

● "# of PDPs"
Number of established PDP contexts

4.4.12.2  RAT common areas in 3GPP overview view

In the following sections listed are parameters that are common for different technolo-
gies. Some per RAT specific parameters are noted as such.

Serving cell

The "Serving Cell" pane displays the following parameters describing the serving cell:
● "Cell Name"
● "MCC"

Mobile Country Code identifies the Country of the network.
● "MNC"

Mobile Network Code identifies the operator.
● "TAC"

Tracking Area Code
● "eNB ID / CiD"In genera, BTS identifier / servinfg cell identifier
● "LAC"

Location Area Code
At the end of this section there is the table containing the details on available LAC
and RAC signals.

5G NR only
● "SSB NR-ARFCN"

NR Absolute Radio Frequency Channel Number of the SSB for the NR cell. Ref
3GPP 38.331.

● "NR Cell"
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Name of serving cell.
● "Band"

Band of NR cell.
● "PCI"

Physical cell ID of the NR cell.
● "Serving SSB Index"

Serving NR cell beam SS/PBCH Block index.
● "Num SSB Beams"

Number of detected SSB beams of the serving NR cell.
● "Avg CQI WB"

Avg CQI WB CQI WB value.
● "Avg RI"

Average RI value.

LTE only
● "Node B"

Name of the eNodeB, taken from the LTE eNodeB database (if available)
● "Phys. Cell"

Physical Cell ID (0..503)
● "EARFCN DL"

Evolved ARFCN of the received DL signal
● "EARFCN UL"

Evolved ARFCN of the transmitted UL signal
● 1st DL MCS

Used modulation coding scheme in downlink
● "2nd DL MCS"

Used modulation coding scheme in downlink
● "UL MCS"

Used modulation coding scheme in uplink
● "RI"

Rank Indication is the number of useful transmission layers when spatial multiplex-
ing is used; in case of transmit diversity, the rank is equal to 1

● "TAC"
Tracking Area Code is a part of the IMEI used to uniquely identify the UE

● "CP"
Cyclic Prefix

● "BW"
Bandwidth
Note: E-UTRA operating band 25 for LTE FDD and 41, 42 and 43 for LTE TDD
specified by 3GPP TS 36.101 are supported.

● "1st CQI"
First channel quality indicator

● "2st CQI"
Second channel quality indicator

● "RB DL"
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Number of resource blocks used in downlink
● "RB UL"

Number of resource blocks used in uplink
Table 4-23: LAC/RAC signals

Signal Remark

LAC (3G) The 3G Location Area Code which is reported by
the trace messages of the Test UE.

LAC (3G, registered CS) The 3G Location Area Code of the Circuit Switched
Domain to which the UE is registered concerning
the layer 3 message flow.

LAC (3G, registered PS) The 3G Location Area Code of the Packet Switched
Domain to which the UE is registered concerning
the layer 3 message flow.

LAC (3G, last read on SIB) The last 3G Location Area Code which was read out
of a system information block.

RAC (3G) The 3G Routing Area Code which is reported by the
trace messages of the Test UE.

RAC (3G, registered) The 3G Routing Area Code to which the UE is regis-
tered concerning the layer 3 message flow (Routing
Area Updates).

RAC (3G, last read on SIB) The last 3G Routing Area Code which was read out
of a system information block.

LAC (2G) The 2G Location Area Code which is reported by
the trace messages of the Test UE.

LAC (2G, registered CS) The 2G Location Area Code of the Circuit Switched
Domain to which the UE is registered concerning
the layer 3 message flow.

LAC (2G, registered PS) The 2G Location Area Code of the Packet Switched
Domain to which the UE is registered concerning
the layer 3 message flow.

LAC (2G, last read on SIB) The last 2G Location Area Code which was read out
of a system information message.

RAC (2G) The 2G Routing Area Code which is reported by the
trace messages of the Test UE.

RAC (2G, registered) The 2G Routing Area Code to which the UE is regis-
tered concerning the layer 3 message flow.

RAC (2G, last read on SIB) The last 2G Routing Area Code which was read out
of a system information block.

Technology

● "RAT"
Radio access technology

● "Num CA"
Number of Component Carriers (Carrier Aggregation)

● "Total BW"
Total used bandwidth
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● "MIMO"
Type of the used MIMO

UE state

The UE state section relates to mobile state, NAS state related to mobility and RRC
states.

● "Unknown"
Network unavailable

● "Idle"
Registered in standby mode (no active call)

● "Access"
Call is set up

● "Dedicated"
Call in GSM network

● "Unconnected"
Mobile is not connected

● "Scan"
Mobile is in scan mode

● "CELL FACH"
UMTS mode

● "CELL DCH"
Call in UMTS network

● "CELL PCH"
UMTS mode

● "URA PCH"
UMTS mode

● "Traffic"
Data transfer in LTE network

Power / quality

The "Power/Quality" panel displays several parameters describing the signal power
and quality reported by the test mobile (see 3GPP TS 25.225 recommendation).

● "Tx Power"
Total mobile transmitted power on one carrier in dBm. the parameter is present in
the 3GPP Overview View for LTE, UMTS and GSM.

5G NR only
● "SS-RSRP"

Reference Signal Received Power value from layer 3 beam filtered measurement
based on SS/PBCH blocks in [dBm], ref 3GPP 38.331, 38.215 and 38.133.

● "SS-RSRQ"
Reference Signal Received Quality value from layer 3 beam filtered measurement
based on SS/PBCH blocks in [dB, ref 3GPP 38.331, 38.215 and 38.133.

● "SS-SINR"
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Signal to Interference and Noise Ratio value from layer 3 beam filtered measure-
ment based on SS/PBCH blocks in [dB], ref 3GPP 38.331, 38.215 and 38.133.

● "TX-Power"
Max. Transmit Power (PUCCH or PUSCH) of UE on the NR-ARFCN of this cell in
[dBm].

LTE only
● "RSSI"

Received wideband power in dBm
● "RSRP"

Reference Signal Received Power in dBm is the received signal strength on refer-
ence symbols.

● "SINR"
Received energy per chip divided by the power density in the band.

● "PDSCH BLER"
Estimation of the transport channel block error rate (BLER) based on evaluating
the CRC on each transport block.

● "Transmit Power"
As previously defined

UMTS only
● "RSSI UTRAN"
● Received wideband power in dBm.
● "CPICH RSCP"
● CPICH Received Signal Code Power in dBm is the received power on one code,

measured on the Primary CPICH.
● "CPICH Ec/Io"
● Received energy per chip divided by the power density in the band. The CPICH

Ec/No is identical to CPICH RSCP divided by the RSSI UTRAN.
● "TrChannel BLER"
● Estimation of the transport channel block error rate (BLER) based on evaluating

the CRC on each transport block.
● "Transmit Power"

As previously defined

GSM only
● R"xLev (F/S)"

Displays the received RXLev full (F) and sub (S) value. The bar is divided into two
parts:
– Upper part: Shows the full value
– Lower part: Shows the sub value. If DTX is off, the color of the lower bar is

gray.
● "RxQual (F/S)"

Displays the received RXQual full (F) and sub (S) value. The bar is divided into two
parts:
– Upper part: Shows the full value
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– Lower part: Shows the sub value. If DTX is off, the color of the lower bar is
gray.

● "Timing Advance"
The length of time the signal from the mobile takes to reach the Base Station. It is
count in steps. The Timing Advance (TA) value is normally between 0 and 63. Each
step representing an advance of one symbol period.

● "Transmit Power"
As previously defined

Data test

"Data Test" displays the information on currently running DQA jobs.
● "Test": Name of the current DQA job
● "State": Current state of the DQA job
● "Direction": Current link direction
● "Progress": The current progress of the DQA job
● "Qos DL ThpL": Current downlink throughput on the application layer (socket)
● "QoS UL Thp": Current uplink throughput on the application layer (socket)
● "LTE Thp": Current PDSCH/PUSCH throughput for LTE
● "5G-NR Thp": Current PDSCH/PUSCH throughput for LTE

The ranges of the throughput values can be set using the "Configure Signals" com-
mand of the view's configuration manu. The Click the line to open the "Available Sig-
nals" window. Select "QoS Tester" > "DQA Current State". To change the range, click
"Exp. Min." and "Exp. Max." of the "DQA Cur. DL Data Rate"/"DQA Cur. UL. Data
Rate".

Figure 4-540: Setting the throughput range for data calls
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Alternatively you can set the thresholds via "Tools" >"Available Signals" > "QoS Tester"
> "DQA Current State".

Voice test

The "Voice Test" section displays the following parameters describing the ongoing call:
● "WB"
● "CS Mode"

– "Voice"
– "Data call"

● Vocoder UL/DL, GSM only
– "AMR codec mode"
– "FR (Full Rate)"
– "HR (Half Rate)"
– "EFR (Enhanced Full Rate)"

● "Channel Type", GSM only
Channel type allocated for the connection:
– "TCH-F": Traffic Channel Full Rate
– "TCH-H": Traffic Channel Half Rate
– "SDCCH/4": Stand-alone Dedicated Control Channel/4
– SDCCH/8: Stand-alone Dedicated Control Channel/8

● "AMR DL/UL Rate", UMTS and LTE
Downlink/Uplink voice encoder is always NB/WB AMR. The current selected rate is
shown.

● "Bearer Type (DL)", UMTS only
Indicates the Spreading Factor (SF)

4.4.12.3  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:
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- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.12.4  3GPP overview view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

View settings

In te "LTE CA" pane you can choose for display the MCS modulation type or MSC
value if LTE carrier aggregation is active.

Figure 4-541: View Settings page
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4.4.13  Cell set view

The "Cell Set View" combines the elements of the cell set views of different 3GPP
specified RAT cells and the measurement report view to a single view. Such an view
switches between data values of these technologies based on the current RAT mode.

To access the view, select the "View" > "Mobile Views" > "Cell Set View" command.

The default view is shown in the following figure.

Figure 4-542: Default layout of the view

The Cell Set View supports 5G NR. If the current RAT is equal to 5G EN-DC, the view
shows LTE and 5G NR carrier cells and LTE and 5G NR neighbor cells.
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Figure 4-543: RAT mode 5G EN-DC

Table 4-24: LTE/5G cell details

Column Value

LTE PCell 5G PSCell

1 Intentionally left blank Intentionally left blank

2 Band Band

3 EARFCN NR-ARFCN

4 PCI PCI

5 RSSI Serving SSB Index

6 RSRP RSRP

7 RSRQ RSRQ

8 SINR SINR

9 TX-Power TX-Power

10 eNodeB and Cell ID Periodicity

11 Cell name Cell name

Table 4-25: LTE/5G carrier aggregation details

Column Value

LTE Carrier Aggregation 5G Carrier Aggregation

1 SCell number (1 to 4) SCell number (1 to 4)

2 Band Band

3 EARFCN NR-ARFCN
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Column Value

LTE Carrier Aggregation 5G Carrier Aggregation

4 PCI PCI

5 RSSI Serving SSB Index

6 RSRP RSRP

7 RSRQ RSRQ

8 SINR SINR

9 TX-Power TX-Power

10 - Periodicity

11 - Cell name

Table 4-26: LTE/5G neighbor cells details

Column Value

LTE Neighbor Cell 5G Neighbor Cell

1 Neighbor cell # Neighbor cell # (X, Y)

X = Neighbor Cell #

Y = Beam Index of Neighbor Cell

2 EARFCN NR-ARFCN

3 PCI PCI

4 RSSI SSB index

5 RSRP RSRP

6 RSRQ RSRQ

7 SINR SINR

8 Serving cell -

9 - Type

PSCell – SSB Index = 5G PSCell Serving
SSB Index

Beam - Candidate SSB index of the 5G
PSCell

NCell - Neighbor Cell

4.4.13.1  Layout of the cell set view

Current RAT mode

Shows the current RAT mode for the Replay/Measurement.

The background color can be modified by going to the signal configuration screen and
modifying the color ("Preferences" > "Available Signals"). The following figures show
the cases RAT mode undefined and RAT mode defined as UMTS.
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Figure 4-544: Undefined RAT Mode

Figure 4-545: Defined RAT mode as UMTS

Grid layout

The grid of the Cell Set View shows the values specific to a RAT mode, see RAT spe-
cific grid layout chapters.

The following is generic and applies across all RAT specific grids.

Column resizing

The size of any column on the grid may be resized by holding the mouse over the col-
umn boarder, left clicking and dragging the mouse to the left or right to increase or
decrease the size of the column, respectively.

Groups

Each grid layout has its values sorted into groups. Each individual group may be
shown or hidden by clicking the group show/hide icon.

Figure 4-546: Show/hide groups

Column sorting

Column sorting is done by a group. The result of the sorting is the ability to have each
group sorted by a different column. The current column sort order is indicated by the
column sorting icon.

Figure 4-547: Sorting icon

Clicking the column header of the current column, the sorting values cycle though
ascending (up arrow), descending (down arrow) and no sorting (no icon displayed).
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The column that the group is sorted on can be changed if you click a different column
header.

Cell contents

Cells that contain measurement values show the trend of the value by a data icon on
the left side of the cell. If the value is increasing, an up arrow is displayed . If
the value is decreasing a down arrow is displayed . If the value is unchanged, at
side ways arrow is displayed . If no arrow is displayed it is because the current
value is invalid or the previous value was invalid.

The cells also contain a displayed bar graph that shows where the current value is in
relation to the minimum and maximum for the represented signal.

Figure 4-548: Current value relative to min/max values

The background color of the cell can be modified by going to the signal configuration
menu and modifying the color of the signal in question.

4.4.13.2  LTE grid layout

The Cell Set View for the RAT mode LTE is shown in the following figure.

The "LTE PCell" section shows the current server cell (PCC). The "LTE Carrier Aggre-
gation" section shows the secondary cells SCC1 – SCC4. The "LTE Neighbor Cells"
section shows up to twelve measured neighbor cells.

Figure 4-549: RAT mode LTE - Cell Set View

Each table row represents a cell.

The following columns are filled in the LTE grid:
● LTE Band

Shows the LTE band for each cell.
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● EARFCN
Evolved Absolute Radio Frequency Channel Number

● PCI
Physical Cell ID (0 to 503)

● RSSI [dBm]
Received Signal Strength Indication - the total received power
Definition TS 36.214: E-UTRA Carrier Received Signal Strength Indicator (RSSI),
comprises the linear average of the total received power (in [W]) observed only in
OFDM symbols containing reference symbols for antenna port 0, in the measure-
ment bandwidth, over N number of resource blocks by the UE from all sources,
including co-channel serving and non-serving cells, adjacent channel interference,
thermal noise and so on.

● RSRP [dBm]
Reference Signal Received Power
Definition TS 36.214: Reference signal received power (RSRP), is defined as the
linear average over the power contributions (in [W]) of the resource elements that
carry cell-specific reference signals within the considered measurement frequency
bandwidth.
For RSRP determination the cell-specific reference signals R0 according TS
36.211 [3] shall be used. If the UE can reliably detect that R1 is available, it may
use R1 in addition to R0 to determine RSRP.

● RSRQ [dB]
Reference Signal Received Quality
Definition TS 36.214: It is the ratio N×RSRP/(E-UTRA carrier RSSI), where N is the
number of RB's of the E-UTRA carrier within the RSSI measurement bandwidth.
The measurements in the numerator and denominator shall be made over the
same set of resource blocks.

● SINR [dB]
Signal-to-Interference-plus-Noise Ratio - Measure of the quality of the radio chan-
nel.

● TX Power [dBm]
Transmitted power

● eNode ID and cellID
eNodeB (20 bit as number) and Cell identity (8 bit as number).

● Serving Cell
eNodeB name

4.4.13.3  UMTS grid layout

The UMTS grid layout is obtained in the "Cell Set View" if the current RAT mode is
UMTS. The view is shown in the following figure.
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Figure 4-550: RAT mode UMTS - Cell Set View

The UMTS cell set grid shows an overview of the Layer1 parameters of the serving cell
and the neighbor cells.

The results for each mobile are arranged in a separate tab. The HSPA+ dual cells are
also shown. Therefore, the view shows the second carrier in the "Active Set" section.

The following columns are filled in the UMTS Cell Set View grid:
● "Color Symbol"

Color code for the primary SC as defined in the "Colors" tab of the configuration
menu. The SC color codes are also shown in the "ROMESMAP Route Track" view.

● "SC#"
Sequence number for the cell, assigned in chronological order and always starting
with 1.

● "UARFCN"
UTRA Absolute Radio Frequency Channel Number

● "Ec/Io [dB]"
Ratio of energy per modulating bit to the noise spectral density

● "RSCP [dBm]"
Received Signal Code Power is the received power on one code, measured on the
primary CPICH.

● "SC"
Scrambling code of the signal used to identify a cell. The format is selected in the
"TEC for UMTS Test Mobiles"

● "Diversity"
Downlink transmit diversity scheme for the CPICH
Possible schemes are:
– STTD (Space Time Transmit Diversity)
– TSTD (Time Switched Transmit Diversity)
– SSDT (Site Selection Diversity Transmit Power Control)
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– No Diversity
● "Position"

Indicates the active cell position.
● "Offset"

Time offset of the signal in 1/8-chip units relative to the system time (hardware-
dependent).

● "Node B"
● Name of the NodeB, taken from the UMTS NodeB database (if available)
● "State"

Indication whether the neighbor cell is monitored, detected, undetected or not listed
● "CI"

Cell ID of the cell in active set.
R&S ROMES4 provides a signal for the active set cell ID. The following figure
shows the active set cell ID among other parameters in the "Alphanumeric View".

Figure 4-551: Active set parameters

● "TPC"
Cell's transmission power control value ranging from 0 to 5

● "Sec. SC"
Secondary Scrambling code number. “Not in use” is displayed if the cell uses only
primary scrambling code.

● "OVSF"
Orthogonal Variable Spreading Factor, code number of the signal

● "HSUPA"
If HSUPA is activated, the column shows which EUL set the NodeB belongs to:
– "SC"

"Serving Cell"
– "RLS"

Radio Link Set
– "Other"

Other cells
● "Serving"

Indication whether a cell is the serving cell (Yes/No)
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The "Active Set" table comprises the most important parameters of the downlink sig-
nals from the UTRAN serving cell and all other cells that are currently used for the con-
nection. The members are permanently monitored and updated by the network.

The "Neighbor Set" table comprises the most important parameters of the downlink
signals from all UTRAN cells that are in the neighbor set and not currently used for the
connection. The members of the neighbor set are permanently monitored and updated
by the network.

The SC and Ec/Io values for each active set element generate signals in the "UMTS" >
"Device n" > "Active Set" branch of the "Signal Tree".

A Qualcomm chipset based mobile must be used to record the neighbor cell data.

4.4.13.4  GSM grid layout

The "Serving Cell" section shows the current server cell. The "Neighbor Cells" section
shows up to 32 measured neighbor cells.

Figure 4-552: RAT mode GSM - cell set view

The following columns are filled:
● "SC#"

Serving cell number
● "ARFCN"

Absolute Radio Frequency Channel Number; GSM channel number of the mea-
sured SCH.

● "BSIC"
Base transceiver station identity code. BSIC is always octal (so that BSIC = ab,
where a is the NCC and b is the BCC), irrespective of the format (octal/decimal/
hex) selected in the "Preferences" > "Available Signals" tab.

● "Rx Level Full [dBm]"
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RxLev assessed over the full range of TDMA frames within a SACCH block. Mobile
reports the signal value for the serving cell and the neighbor cells.

● "Rx Level Sub [dBm]"
RxLev assessed over a subset of 12 TDMA frames. Mobile reports the signal value
for the serving cell and the neighbor cells.

● "Rx Qual Full"
Received signal quality assessed over the full range of TDMA frames within a
SACCH block. Mobile reports the signal value for the serving cell and the neighbor
cells.

● "Rx Qual Sub"
Received signal quality assessed over a subset of 12 TDMA frames. Mobile reports
the signal value for the serving cell and the neighbor cells.

● "C1"
Parameter relevant for cell selection

● "C2"
Reselect parameter, relevant for cell selection (GSM phase II)

● "C31"
C31 cell reselection criteria

● "C32"
Flag indicating an exception rule for GPRS_RESELECT_OFFSET according to
3GPP TS 05.08.

● "CI"
Cell Identity (16 bit)

● "TA"
Timing Advance

● "BTS Name"
Name of the base station. This parameter is displayed if a valid BTS list is availa-
ble. Detailed information can be obtained by double-clicking the BTS name.

DL /UL DTX mode
A large difference between the Rx Qual Full and Rx Qual Sub values indicates that the
downlink signal shows strong variations in time. One possible reason is that the BTS
uses discontinuous transmission (DTX).
In the DTX mode, the BTS transmitter is switched off during time periods where no
information needs to be transferred. The relevant received signal quality is given by Rx
Qual Sub. The averaged parameter Rx Qual Full is generally larger (in extreme cases,
Rx Qual Full can be equal to 7, while Rx Qual Sub is equal to 0!) and the Rx Qual Sub
reported value underestimates the signal quality.
The current DTX mode of a GSM mobile, that is, whether DTX is used, can be seen in
the "Alphanumeric View". The "GSM System Information View" and the "Layer 3 View"
show the DTX mode that the network commands the mobile station to use ("shall use
DTX", "shall not use DTX" or "may use DTX").
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4.4.13.5  Cell set view properties

Configuration of the Cell Set View is done through the use of a properties grid window
that is attached to view. By default the properties window is attached to the upper right
corner of the view.

Figure 4-553: Cell Set View Properties tab

Click the properties tab to open the properties window.

Figure 4-554: Cell Set View Properties window

You can access the same window via the "Properties" entry of the context menu which
pops-up if right click any point in the "Cell Set View".

The "Cell Set View Property" window can be pinned to the view so that it is always
available. For that, click the  icon in the window.

To restore the property values to their saved workspace values, click the "Restore All
Values" button within the dialog.

Figure 4-555: Restore button

To restore an individual property’s value, right mouse button click a property and
choose "Reset Value".
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LTE properties

The only configurable property for the LTE grid layout is the number of neighbor cells
to display.

The property defines the maximum number of neighbor cells to be displayed in the
grid.

UMTS properties

The configurable properties for the UMTS grid layout are:

● Only measured neighbors
The property limits the neighbor cell display to those neighbors which have valid
Ec/Io and RSCP values.

● Number of neighbor cells to display
The property defines the maximum number of neighbor cells to be displayed in the
grid.

GSM properties

The only configurable property for the GSM grid layout is the number of neighbor cells
to display.

The property defines the maximum number of neighbor cells to be displayed in the
grid.

4.4.14  ETSI QoS view

The "ETSI QoS View" shows the NQA calls classified as "Good", "Blocked", "Dropped"
or "No service" for LTE, LTE CSFB to 2G or 3G, VoLTE, UMTS, UMTS, GSM or
TETRA mobile originating or terminating calls.

If a B-Party hangs up during a call, the NQA recognizes that and counts the call as
dropped which is displayed in the "ETSI QoS View".

In addition to the information concerning the call classification, the "ETSI QoS View"
displays a set of QoS parameters defined in the ETSI/IREG specifications.

The IREG is an ETSI committee developing specifications for the QoS evaluation.

QoS is a general notion, defined as “the collective effect of a service performance
which determines the degree of satisfaction of a user”. A critical technical aspect rela-
ted to QoS is a network performance (NP), i.e. “the ability of a network portion to pro-
vide the functions related to communication between users”.
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The parameters to assess the QoS of various services are defined in ETSI TS
102.250-2 and related documents.

Requirements for displaying data in this view:
● Autodialing is enabled for the test mobile
● "Constant Call Pattern" ("ETSI Specification") is enabled
● The option "Use NQA" is enabled in the test mobile device "NQA Settings" menu

All device settings and call classes are explained in chapter Chapter 6, "Hardware
Components", on page 1447.

Figure 4-556: ETSI QoS View

The measurement results for each mobile are arranged in a separate tabs. The view
contains two panels, independently on selected tab. The "ETSI Parameters" pane pro-
vides a statistical evaluation of the whole measurement. The lower "Call List" pane is a
list with the results of each individual. The list can be replaced by the "Call Statistics"
for a selected call.

Information about BLER, Ec/Io or handover durations are not shown in this view.

While executing a TETRA test be aware of the note TETRA Group Calls. If it is
ignored, the obtained ETSI QoS measurement results will, for example, contain multi-
ple calls per call sequence as shown in the following figure.
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Figure 4-557: Disturbed TETRA call - ETSI QoS View

4.4.14.1  IREG IR.42 parameters

An overview of QoS service-independent and telephony-related parameters defined in
TS 102.250-2 (formerly: PRD IR.42) and statistical evaluation of the timing parameters
are defined this section.

The following values are displayed in percent:
● NA-CS

Network Accessibility-Circuit Switched, ratio of the number of successful GSM net-
work access attempts to the total number of network access attempts. The criterion
for successful network access is that the path loss criterion parameter C1 is larger
than 0 (see standard 3GPP TS 05.08).

● NA-PS
Network Accessibility-Packet Switched, ratio of the number of successful GPRS
network access attempts (with GPRS enabled for cell) to the total number of net-
work access attempts. The criterion for successful network access is that the path
loss criterion parameter C1 is larger than 0.

● SA-T
Service Accessibility-Telephony, ratio of the number of successful call attempts
(after successful network access) to the total number of call attempts.

● CCR-CS-T
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Call Completion Rate Circuit Switched Telephony, ratio of the number of intention-
ally terminated telephony calls to the number of successful telephony calls.

The larger the four values, the better the QoS. The values in the "ETSI Parameters"
pane turn to red if they fall below the limits defined in the configuration menu.

Support of VoLTE
The R&S ROMES4 Voice Call Analyzer supports VoLTE calls by generating the well-
known result classes of voice calls and calculates the System Response Time S-RT
and Call Setup Time C-ST.
The analyzer results are based on IMS messages, see Chapter 4.4.15, "Layer 3 view",
on page 958. The messages are currently available for test-UEs with a Qualcomm
chipset with the running Qualcomm IMS Stack (the Qualcomm chipset does not mean
necessarily that the implemented IMS stack is also provided by Qualcomm). The R&S
ROMES4 Qualcomm device checks for these UEs the possible problems during a
VoLTE call, see Possible Problems Check During VoLTE Call

The distribution of the following timing parameters is shown in two-bar graphs:
● System Response Time S-RT

Time between the start of a call attempt and indication of successful network
access.

● Call Setup Time C-ST
Time between the start of a call setup attempt (after successful network access)
and indication of call setup success.

Short times indicate a good QoS. The diagram scales and the number of classes are
defined in the configuration menu.

Calculation of these times is based on Layer 3 trigger points. Depending on RAT and
call direction (MOC / MTC), the calculation is made as shown in the following list.
● LTE - CSFB

– MOC
S-RT: T(LTErrcConnectionSetupComplete) - T(EmmExtendedServiceRequest)
C-ST: T(ALERTING) - T(EmmExtendedServiceRequest)

– MTC
S-RT: T(ALERTING) - T(EmmExtendedServiceRequest)
C-ST: T(CONNECT_ACK) - T(EmmExtendedServiceRequest)

● VoLTE
– S-RT = tINVITE-Trying – tINVITE-Request
– C-ST= tACK-Ok – tINVITE-Request

● UMTS
– MOC

S-RT: T(rrcConnectionSetupComplete) - T(rrcConnectionRequest)
C-ST: T(ALERTING) - T(rrcConnectionRequest)

– MTC
S-RT: T(ALERTING) - T(PAGING_RESPONSE)
C-ST: T(CONNECT_ACK) - T(PAGING_RESPONSE)
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● GSM
– MOC/MTC
– MOC

S-RT: T(rrAssigmentCommand) - T(cmServiceRequest)
C-ST: T(ALERTING) - T(cmServiceRequest)

– MTC
S-RT: T(ALERTING) - T(PAGING_RESPONSE)
C-ST: T(CONNECT_ACK) - T(PAGING_RESPONSE)

● GSM-R
– MOC/MTC

- Mobile terminated VBS/VGCS setup time
NOTE: Only the files recorded with the R&S ROMES4 version 17.00 or higher hold
this determined KPI.

● TETRA
– MOC

- S-RT: T(NQA: Start of Call) - T(NQA: Start of Dial)
- C-ST: T(NQA: Call active or D-CONNECT) - T(NQA: Start of Call or U-
SETUP)

– MTC
- S-RT: no calculation
- C-ST: no calculation

NOTE: TETRA mobile PEI device provides the timestamps based on AT com-
mands and AT responses. L3 commands / responses are not available.
NOTE: TETRA Sepura device provides the timestamps based on arrival of certain
internal data times.

4.4.14.2  Call list

The "Call List" shows all calls with their characteristics and QoS parameters. The table
contains the following rows:
●

Colored symbols to distinguish the Good, Dropped, Blocked/Cancelled calls and
No Service case.

● Start/End
Start and end time of the call.

● Result
Call class: Good, Dropped, Blocked and No Service call; see description of NQA
tab of the device configuration menu in chapter 6.

● MOS
Mean Opinion Score value according to PESQ SQA measurement.

● Tx
Maximum transmits power of the mobile during the call (not for GSM).
Note:
This parameter's values are not reported for TETRA.
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● S-RT, C-ST
System response time and call setup time, see previous chapter.

● CI(Start )/ CI(End)
Cell Identity (decimal) at start and end of call.

● MCC, MNC/NID
Mobile Country Code and Mobile Network Code/Network Identification Code.

● Mode
Call mode: for example GSM, UMTS, LTE, CDMA, TETRA call or CSFB (3G)/
CSFB (2G) (LTE network is not available to make or receive voice call so that the
device "falls back" to a more accessible 3G or 2G network to finish the call), LTE ->
UMTS handover, LTE -> GSM network assisted cell change (NACC).

● Type
Type of connection: Voice, Data or Group (TETRA only)

4.4.14.3  Call details

A double-click on a row in the "Call List" table opens the call details providing the
entries of the"Call List" table plus three bar graphs to assess the distribution of the fol-
lowing parameter values:
● RxQual/BLER

Indication of the Bit Error Rate (GSM) or Block Error Rate (UMTS).
● RxLev/Ec/Io

Indication of the downlink signal strength received by the mobile.
● Handover Duration

Indication of the time needed for successful handover attempts.

The handover statistics (number of "Handover Attempts" and "Successful Intracell/
Intercell HOs)" is indicated in addition.

With SQA measurements, there is also a KPI window available, which allows the
replay of speech quality files, if applicable:

Select a Speech Quality entry in the KPI window and click on the "Player" button to
replay the file on the standard sound card. This function is also available during mea-
surements with recording. The measurement must be set up with other soundcards to
avoid a distortion.

Clicking  closes the "Call Statistics" and displays the "Call List" table.
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Example: 
ETSI QoS view of speech quality measurement results made with Smartphone
The "ETSI QoS View" shows the average downlink MOS value of the call. The details
of the call allow the user to listen to the degraded speech samples, if they were stored
to the measurement file. To do so, just select one of the offered KPIs and press the
button "Player".
Note: As the System Response Time parameter is not supported by Smartphone
speech quality measurement, the corresponding parameter view is empty.

Figure 4-558: ETSI QoS view of Smartphone speech quality measurement results

4.4.14.4  Handling of incoming SMS

The MTC Analyzer is enhanced to handle incoming SMS during expected incoming
calls, see Tracking of SMS.

The incoming SMSs are displayed with a separate icon . The "SMS" result is shown
in the "Call List" and does not interfere with the call statistics. The call statistics are
detected by the Layer 3 message CP-DATA.
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Figure 4-559: Handling the incoming SMS during incoming call

The feature is not intended to be an SMS analyzer for counting incoming SMS. The
SMS entry is a result of the MTC analyses for incoming voice calls, which is more
robust against the unexpected incoming messages, see Chapter 6.5.1.4, "Configura-
tion menus for the DQA jobs", on page 1891.

4.4.14.5  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.4.14.6  ETSI QoS view configuration

The "GSM ETSI View Configuration" configuration menu defines limits for the QoS
parameters and configures the bar graphs.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Figure 4-560: ETSI QoS View - configuration

General
Select the "Export" option to export the results of the "Generated Calls" table to a
*.csv export file. This file can be then opened and processed by Excel, for example:
Start;End;Result;Quality;Tx;S-RT[s];C-ST[s];CI(Start);CI(End);MCC;MNC;Mode;Type
63813 ms;132000 ms;Good;OK;-6.0 dBm;0.44;6.55;-;-;262;1;UMTS;---   

System Response / Call Setup
The "System Response / Call Setup" panel defines the number of classes (that is, the
maximum number of bars) in the "System Response Time" and "Call Setup Time" dia-
grams, sets the scale of the y-axis and the colors of the bars.
With a number n of classes and a SR or CS time interval between "Min" and "Max"
seconds, the classes correspond to the following sub-intervals:

Class 1 [ 0 s, (Max – Min) / n ]

Class k [ (k – 1)*(Max – Min) / n, k*(Max – Min) / n ] , 2 ( k ( (n – 1)

Class n [ (n – 1)*(Max – Min) / n, ∞ s ]

Quality Acceptance
The four input fields in the "Quality Acceptance" panel contain lower limits for the QoS
Parameters displayed in the "IREG IR.42 Parameters" panel. A measurement result
turns red if it is below the limits.
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Call Details - Colors
The "Call Details" panel sets the colors of the bars in the "RxQual/BLER Distribution",
"RxLev/Ec/Io Distribution" and "Handover Duration" diagrams.

4.4.15  Layer 3 view

The "Layer 3 View" can display all Layer 3 messages recorded with mobile-related
technologies and IP tracers, AT commands and the NQA state machine's messages.

Figure 4-561: Layer 3 messages supporting RATs/layers

The Layer 3 messages are shown for all used mobiles. The tabs in the title bar of the
view show the types of used/connected mobiles. The Layer 3 messages are arranged
in a separate list for each mobile. Select the message types that you want to be dis-
played in the view for an individual mobile in the "Layer 3 View" configuration menu.
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Figure 4-562: Layer 3 View - messages of the selected mobile device

The "Layer 3 View" automatically displays the second-level content of rrcConnection-
Reconfiguration and SystemInformation message.

The uplink and downlink Layer 3 messages appear in separate columns, unless this
feature is switched off. It can be switched in the configuration menu, see the "Separate
Up/Downlink Columns" parameter in "Display" on page 968. The width of the individ-
ual lists can be varied with a drag&drop action in the header of the table.

The messages are not available in "Scan" mode. The mobile must be in "Normal",
"Camp" or "Test Transmitter" mode.

The text filter on top of the "Layer 3 View" filters the content of the view immediately.
Only the lines which contain the specified text are displayed after clicking the filter but-
ton.
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Figure 4-563: Filtered view

It can be necessary to refresh the view content after changing the filter. To refresh the
content, click the  button.

The QualiPoc IP traces are visible together with the other messages in the "Layer 3
View".

Decoding the QualiPoc IP traces’ details requires a Wireshark installation. R&S
ROMES4 uses the default Wireshark installation path by default. However, if the Wire-
shark default folder is not found, you have to run the tshark.exe manually the first
time a decoding is attempted.

The AT commands and responses for mobiles configured with the generic mobile devi-
ces are supported in the "Layer 3 View".

The message details of the WiMAX MAC Management Payload decoding available for
all MAC Management Messages (except UL-MAP and DL-MAP) are also supported.

Find dialog

The following keys are used directly in the "Layer 3 View":
● [Ctrl+F], which opens the "Find" dialog
● [F3], which continues a previous search, searching from top to bottom for the next

occurrence of the search string
● [Shift+F3], which continues a previous search, searching from bottom to top for the

next occurrence of the search string

Figure 4-564: Find dialog

Detailed information

An upper case D appears to the right of the cursor arrow when it is placed on a Layer 3
message. This symbol indicates that there is detailed information to be retrieved for the
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current Layer 3 message. The detailed information window is opened by double-click-
ing the selected message. The view automatically enables the detail filter and adds the
corresponding filter, see "Detail Filter" on page 971.

It is possible also to move elements from the details window directly into the "Layer 3
View" by drag and drop.

Figure 4-565: Details of the selected message in the Layer 3 View

Detailed messages are displayed during measurement/recording and replay session.
Switching between different Layer 3 messages is also possible during a pause and
even after stop.

Handling of the detailed information window

The detailed information window is independent of the Layer 3 view. You can move,
resize and scroll it as you like.

Each individual list of Layer 3 messages can be stopped and released at any time by
left mouse button clicking its title bar. A stopped list is indicated by a red "STOP" sym-
bol left of the mobile type.
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A search function was added to the details Layer 3 view page. While entering a text in
the search field, the first occurrence of the text is highlighted in the tree view. Use the

 and  buttons to move the selection to the next / previous hit.

Figure 4-566: Search function

Click  to generate a hardcopy of the detailed information or you can copy the content
to the clipboard (the previous button). Alternatively, you can write the detailed informa-
tion into the table (e.g. if you wish to create a hardcopy), see the "…Messages" tabs of
the configuration menu.

The  "Save to File" button offers the possibility to save the content of the Layer 3
detailed information directly to a text file.

4.4.15.1  IP tracer results

The IP tracer option enables capturing and decoding network traffic for the R&S
ROMES4 software. This function is provided via a link layer network access and a
comprehensive decoding engine, based on the Microsoft Network Monitor packet ana-
lyzer.

The protocol is shown in the "Type" column and the messages in the "Up" and "Down"
columns. Source and destination IP address are shown in additional columns.

Figure 4-567: IP tracer results

IP tracer results are only visible if the IP tracer is configured in the DQA Connect to
Network job, see "Connect to network" on page 1892.
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R&S ROMES4 supports IP tracing only with network adapters and not with modems.

IP tracer TCP checksum

The TCP checksum cannot be calculated for TCP data packets, when the payload has
been removed. In this case, the TCP checksum is marked as [n.a.] in the details win-
dow of the Layer 3 View.

Figure 4-568: TCP checksum
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4.4.15.2  MAC management messages

The MAC management messages can be analyzed in the "Layer 3 View". The view
displays the messages together with the IP traces if measured. The details of the MAC
messages are not available. The exceptions are the 5G NR MAC CE messages, which
can be visualized in the view if so configured, see Figure 4-573 and 5G NR MAC CE
and BWP Switch.
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Figure 4-569: MAC management messages

4.4.15.3  Layer 3 filter

The "Layer 3 Filter" allows filtering dependent on a message type. Open it via context
menu. After starting R&S ROMES4, the filter is empty. It is filling with the displayed
messages during the measurement or replay.
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Figure 4-570: Filtering Layer 3 supported messages

Messages or groups of messages can be deselected.

● Apply
Click "Apply" to update the view.

● Apply for all Tabs
If checked, the filter is assigned to all tabs.

● Reset Tree
Click "Reset tree" to blank the filter window again.
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4.4.15.4  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

In addition, the context menu provides the following menu commands:
● "Show/Hide Filter"

Opens the "Layer 3 Filter" dialog, see Chapter 4.4.15.3, "Layer 3 filter",
on page 965.

● "Add Bookmark"
Opens the "Edit Bookmark" dialog to define timestamp and a description for the
bookmark of the selected message.

Figure 4-571: Edit bookmark for a Layer 3 message

● "Export"/"Export Byte Stream"
Exports all visible information to a text file (*.txt). The file can be opened with a
text editor or opened and processed, for example, by Excel. Using "Export Byte
Stream", the corresponding Byte stream is visible beside the Layer 3 information.

● "Show Trigger Point ID"
Opens a window with the trigger point ID. This ID is also copied to the clipboard.

Figure 4-572: Trigger point of the selected Layer 3 message
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4.4.15.5  Layer 3 view configuration

"Layer 3 View" lets you select messages you want to be shown or exported. The view
also shows information on the current view version.

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "Configure" entry triggers the execution of a measurement from the list and dis-
plays the messages obtained during the measurement. The large scale of possibilities
to trigger and display Layer 3 messages is offered in this configuration page.

Apart from the configuration, there is the second option related to configuring Layer 3
views of signals, protocol-related signals of some 3GPP and non-3GGP technologies.

Display configuration

The "Display" page lets you select the display mode of the GSM/NAS, GPRS RLC/
MAC, UMTS /LTE / 5G NR RRC, etc. messages, control the text markers and details
filtering.

Figure 4-573: Layer 3 View - Display tab

Display
The controls "Display" let you select a type of information for display and the way of
displaying in"Layer 3 View".
● "Time Stamp"

If the box is checked, the time stamp associated with the message occupies the
first column of the "Layer 3 View" tables.

● "Logical Channel"
If the box is checked, the logical channel associated with the message occupies
the second column of the "Layer 3 View" tables.

● "Layer 2 Message"
If the box is checked, layer 2 messages associated with the layer 3 messages are
displayed in an additional column of the "Layer 3 View" tables. There are test devi-
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ces uncapable to record the layer 2 messages. However, those test devices, which
support layer 2 messages have to be configured accordingly. For the concerned
mobile device, see Chapter 6.4, "Test devices", on page 1511.

● "BCCH"
Check the "BCCH" box to get the additional column in the "Layer 3 View". Usually,
there are only messages from the serving cell. Some mobiles are able to receive
information from one or more neighbor cells in the same time. In this case, the
associated BCCH channel number is shown. Messages from the serving cell have
no entry in the "BCCH" column.

Figure 4-574: Additional column "BCCH"

The entry "BCCH" is used to distinguish between the messages from the own and
the neighbor cells, concerning the mobiles with previously mentioned capability.
If you uncheck the "BCCH" box, it is not possible to distinguish between messages
from the own and the neighbor cell. If you check the "Show only Serving Cell Mes-
sages" box, the view displays only the messages which belong to the serving cell.

● "Source/Destination IP"
If the IP Tracer is enabled and this box is checked, the source and destination IP
addresses are displayed in own columns.

● "Separate Up/Downlink Columns"
If the box is checked, uplink and downlink messages appear in separate columns
of the "Layer 3 View".
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Otherwise, all messages from one mobile are written in a single column, in a chro-
nological order. An (Up) or (Down) identifier after each message indicates the
transmission direction of the messages.
Knowing the transmission direction is useful for display of the AT commands and
the responses associated to a generic mobile device measurement setup, for
example.

Figure 4-575: Separate columns for up and downlink

● "Show only Serving Cell Messages"
If this option is checked, the layer 3 messages of the service cells only are
exchanged for the display. Otherwise, the "Layer 3 View" shows all the layer 3
message records.

● "Autoscrolling during..."
If the boxes are checked, the "Layer 3 View" tables are scrolled down automatically
when the bottom of the view window is reached. Otherwise, the scrollbar can be
used to move up and down in the table. Autoscrolling can be activated/deactivated
separately for replay and measurement sessions.

● "Scan File"
If the box is checked, the automatic scan for "Layer 3-related QoS" data in the
active measurement file is activated.

● "Automatic Refresh of View"
If the box is checked, the automatic view refreshment is activated whenever the
configuration concerning filters or mark changes. It is also possible to trigger
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refresh via the refresh button  or "Refresh View" in context menu. Whenever it is
necessary to initiate a refresh view process - the automatic refresh is disabled and
a detail item was dropped onto the view - the icon gets an exclamation mark.

● "5G NR MAC CE" and BWP Switch
If the box is checked, the 5G MAC CE (control element) messages are displayed in
the "Layer 3 View". Although the messages display is an option, the option is by
default switched on. The color of the message is customizable.
The setting applies to the BWP Switch message as well. This message is shown
whenever the assigned BWP by DCI has changed.
Note: Both features are limited to Qualcomm chipset-based UEs and measurement
files recorded with R&S ROMES4 23.2 or newer.

Color Scheme
Different message types can be displayed with different colors to be distinguished eas-
ier. Each of the pull-down combo boxes in "Coloring" lists a set of colors. Select a pre-
ferred color for the selected Layer 3 message here.

Text Marker
The controls in the "Text Markers" panel define markers that can be used to highlight
keywords or expressions in the list of displayed messages. "Add" opens the "Configure
Text Marker" dialog.

Figure 4-576: Dialog to configure text marker

The dialog can be opened from the context menu of the "Layer 3 View". A text marker
highlights the search text entered in the "Text" line with selected "Background Color".
The options "Match whole word" and "Match case" refine the text selection.
It is possible to define several text markers with different attributes,
Use "Remove"/"Change" buttons to delete/modify the search text in the "Text" field.

Detail Filter
Filters the detailed information displayed in the view. Filtering can be used to limit the
amount of information displayed and search for particular information types. To activate
the filter, proceed as follows:
1. Enable the details display for a particular message in one of the "Messages" tabs of
the configuration menu (example given, for the "SETUP" in the "GSM NAS Messages"
tab).
2. Click "OK".
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3. Replay the ("Replay" or ) measurement file and pause the replay ("Pause Replay"
or ) when the message details are displayed for the first time.
4. Click the "Display" tab in the view's configuration page.
5. Click "Detail Filter Configuration" tab on the configuration page. The "Detail Filter"
dialog opens.
6. In the box at the bottom of the "Detail Filter" dialog type the detailed information you
wish to be displayed in the "Filter Strings" field. For example, type "BCD Number".

Figure 4-577: Detail filter dialog

7. Click "Add". The typed information is added.
8. Click "OK" to close the "Detail Filter" dialog.
9. Check the "Enable Detail Filter" box.
10. Click "OK" to close the configuration page.
11. Continue the replay. The next SETUP message is displayed with the "BCD Num-
ber" information only.

Figure 4-578: More details
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It is possible to move elements from the "Detail Filter" directly into the "Layer 3 View"
by drag and drop. The view automatically enables the detail filter and adds the filter.
The filter is the selected item (in our example the BCD Number) in the details tree.
The "Details Filter" works per line. Only the line which contains the filter text is printed
to the view. However, there are several layer 3 items, which hold the actual value in a
lower hierarchy or the next line from the output’s point of view. To add the following line
to the filtered text, add a “+” to the filter text. The “+” is added automatically if the item
is dragged and dropped from the "Details" window while the [Alt] key is pressed.

Figure 4-579: Adding lower hierarchy line

The previous screenshot shows the line "mappedQoS_FlowsToAdd" is followed by a
"+" in the "Detail Filter". It is because the line in the "Details" window contains the QFI
result 1 which is in the lower line.
The context menu of the "Layer 3 View" offers the command to remove the selected
details.

The "Remove Detail Filter" entry of the menu only appears if the mouse cursor hovers
over a detail item you want to remove and the detail filter is activated in the configura-
tion.
If you select this option, R&S ROMES4 checks the currently active detail filters. If only
one filter is matching the selected detail item, it is removed automatically. If more filters
are matching the item, the "Details Filter" dialog opens. The matching detail item is
preselected and you have to remove manually the item using the "Remove" button.
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Trigger configuration

The "Trigger" tab controls the export of data during a replay session and defines the
trigger for selecting a range of messages to be displayed.

Figure 4-580: Layer 3 View - Trigger tab

Layer 3 Message Trigger

Instead of listing all messages of a given type recorded during the measurement, it is
possible to select a range of messages:
● "No trigger"

All messages recorded are displayed
● "Start at"

Display starts when the first "Trigger Start" message is detected and continues until
the end of the measurement

● "Start and stop"
Display starts when the first "Trigger Start" message is detected and stops at the
first Trigger Stop message

● "Trigger Start"
Pull down list to select the message type triggering the start of the display

● "Trigger Stop"
Pull down list to select the message type triggering the stop of the display

● "Pre Trigger"
Number of messages displayed before the "Trigger Start" message

● "Post Trigger"
Number of messages displayed after the "Trigger Stop" message
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4.4.15.6  Layer 3 view messages

GSM/NAS messages

The "GSM/NAS Messages" tab selects the GSM/Non Access Stratum (NAS) layer 3
messages to be displayed.

Figure 4-581: Layer 3 View - GSM/NAS messages

Message List
List of all Layer 3 message types defined in GSM/NAS. The second column of the
table indicates whether the detailed information concerning a message type is dis-
played in the Layer 3 View.
● "Select"

Displays the selected, highlighted message type (left-click) in the "Layer 3 View".
As an alternative, the box on the left of the message type can be checked (left-
click).

● "Unselect"
Hides the selected, highlighted message type (left-click) in the "Layer 3 View". As
an alternative, the box on the left of the message type can be cleared (left-click the
checked box).

● "All"
Display all layer 3 messages in the "Layer 3 View".

● "None"
Display no layer 3 messages in the "Layer 3 View".

● "Details"
Displays the detailed information concerning the selected message type in the
"Layer 3 View" from where it can be printed.

● "No Details"
Removes the detailed information from the "Layer 3 View" so that it cannot be prin-
ted. The detailed information can still be retrieved on screen by double-clicking an
individual message.
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Tip:
Details selected for display are included in an export file generated during a replay.
See "Display configuration" on page 968.
Details selected for display are also included in an export file generated during a
replay.

GPRS RLC/MAC messages

The "GPRS RLC/MAC Messages" tab selects the RLC/MAC control messages to be
displayed.

Figure 4-582: Layer 3 View - GPRS RLC/MAC messages

Message List
List of all RLC/MAC (Radio Link Protocol/Medium Access Control) control message
types defined for GPRS. The second column of the table indicates whether the detailed
information concerning a message type is displayed in the "Layer 3 View".
The buttons below the table are the same as in the "GSM/NAS Messages" tab.

5G NAS messages

The "5G NAS Messages" tab selects the 5G NR NAS control messages for display.
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Figure 4-583: Layer 3 View - 5G NAS messages

The page is similar to all other message pages in the "Layer 3 View" configuration.

5G NR RRC messages

The "5G NR RRC Messages" page is similar to all other message pages in the "Layer
3 View" configuration.

Figure 4-584: Layer 3 View - 5G NR RRC messages

The "rrcReconfiguration" message is followed by the first level of its content when 5G
NR SA operation mode is used.
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Figure 4-585: Available information in rrcReconfiguration message

The "systemInformation" message is followed by the contained SIBs in this mode.

Figure 4-586: Available SIBs in systeminformation message

The message presentation complies with the presentation of the contents of the same
Layer 3 message in LTE.

Layer 3 details of 5G scanner and 5G UE give an additional split interpretation to cell
identity (0x1cfde00ac0) '000111001111110111100000000010101100'B. In SIB1 a cell
identity is presented as [36Bit X/Y] (decimal) x/y. The default splitting is 28/8, but can
be anything else, for example, 21/15 or 20/16.

LTE NAS messages

The "LTE NAS Messages" tab selects the LTE NAS control messages for display.

Figure 4-587: Layer 3 View - LTE NAS messages
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The LTE NAS messages can be colored separately. Details of an LTE NAS message
are displayed in a separate window if double-click the message.

Figure 4-588: Layer 3 View - LTE NAS messages separately colored

Message List
List of all NAS control message types defined for LTE. The second column of the table
indicates whether the detailed information concerning a message type is displayed in
the "Layer 3 View".
The buttons below the table are the same as in the "GSM/NAS Messages" tab.

LTE RRC messages

The "LTE RRC Messages" tab selects the LTE RRC control messages to be displayed.
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Figure 4-589: Layer 3 View - LTE RRC messages

Layer 3 details of LTE scanner and 4G UE give an additional split interpretation to cell
identity (0x0142a920) '00010100001010101001000100000000'B. In SIB1 a cell iden-
tity is presented as [28Bit 20/8] (decimal) x/y. However, variable splitting is not suppor-
ted in LTE. It is fix to 20/8.

Message List
List of all RRC (Radio Resource Control) message types defined for LTE. The second
column of the list indicates whether the detailed information concerning a message
type is displayed in the "Layer 3 View".
The buttons below the list are the same as in the "GSM/NAS Messages" tab.

IMS messages

The "IMS Messages" tab selects the IMS control messages to be displayed.
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Figure 4-590: Layer 3 View - IMS messages

Details of an IMS message are displayed in a separate window if double-click the mes-
sage.

Details of an IMS message are displayed in a separate window if double-click the mes-
sage, see the following figure.
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Figure 4-591: IMS message detail view

Message List
List of all IMS message types used for IP-based communication, like VoLTE. The sec-
ond column of the list indicates whether the detailed information concerning a message
type is displayed in the "Layer 3" view.
The buttons below the list are the same as in the "GSM/NAS Messages" tab.

UMTS RRC messages

The "UMTS RRC Messages" tab selects the UMTS RRC control messages to be dis-
played.
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Figure 4-592: Layer 3 View - UMTS RRC messages

Message List
List of all RRC (Radio Resource Control) message types defined for UMTS. The sec-
ond column of the list indicates whether the detailed information concerning a message
type is displayed in the "Layer 3 View".
The buttons below the list are the same as in the "GSM/NAS Messages" tab.

TETRA messages

The "TETRA Messages" tab selects the TETRA messages to be displayed.

Figure 4-593: Layer 3 View - TETRA messages
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Message List
List of all defined TETRA control message types. The second column of the table indi-
cates whether the detailed information concerning a message type is displayed in the
"Layer 3 View".
The buttons below the table are the same as in the "GSM/NAS Messages" tab, see
"GSM/NAS messages" on page 975.

4.4.15.7  Layer 3 measurement reports

5G NR measurement reports

The "Layer 3 View" shows the 5G NR NAS messages beneath the 5G NR RRC mes-
sages. The messages are 5G Mobility Management and 5G Session Management
messages.

The 5G NR NAS messages are colored according to the coloring configuration. Dou-
ble-click a message to get the decoded Layer 3 details in a separate window.

Figure 4-594: 5G NR Layer 3 messages
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Figure 4-595: Details of selected message

The ciphered messages cannot be decoded. In this case, the ciphered data stream is
printed.

5G NR measurement report events

The R&S ROMES4 5G NR UE events are available for reporting if triggered by the cor-
responding 3GGP events.

An 3GGP 5G NR event setup is done in the event branch "5G NR UE Events" > "RRC
Measurement Events" within the "Available Events" dialog.

Figure 4-596: RRC measurement events

Activated the events before the start of the measurement, respectively before loading
the measurement file for replay.

R&S ROMES4 decodes the Layer 3 message flow in such a way, that the result of
3GPP events is shown directly in the Layer 3 View, apart from being shown in the
"Event View".
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Figure 4-597: Example - measured event A3

The corresponding RRC reconfiguration message is contained in the measurement
file.

LTE measurement reports

The LTE measurement report is referred to a specific measurement ID. To find out
what is the actual measurement object and the report configuration responsible for the
measurement report identified with an ID, R&S ROMES4 offers the Layer 3 View's
detailed window.

Figure 4-598: LTE Layer 3 detailed view

The "Layer 3 View" displays several eMBMS/Flute messages during the eMBMS ses-
sion and also makes them visible in the mentioned details view.
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Figure 4-599: LTE Layer 3 detailed view - eMBMS session

It is also possible to add the event detail information to the "Layer 3 View" by using the
Layer 3 detail filter. The filter can be configured by moving the corresponding detail ele-
ment from the detail window to the "Layer 3 View" or by specifying the elements in the
configurations dialog.

1. Click any point in the Layer 3 View to get the context-sensitive menu. Select the
"Configuration" entry.

The Layer 3 View "Display" window pops-up.

2. Click the "Detail Filter Configuration" button.

The "Detail Filter" window pops-up.

3. Select the event from the detail window.

4. Click "OK" to move it to the Layer 3 View.

The selected detail events are now inserted in the LTE Layer 3 View.
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Figure 4-600: Inserting event details into the Layer 3 View

The event for measurement report has different icons for different events. The Tooltip
includes the event-specific information which, as a kind of LTE event, has triggered the
measurement report.

Figure 4-601: Inserted events
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Figure 4-602: Diagram of inserted events

LTE measurement report events

The R&S ROMES4 LTE UE events are available for reporting if triggered by the corre-
sponding 3GGP events.

An 3GGP LTE event setup is done in the event branch "LTE UE Events" > "RRC Mea-
surement Events" within the "Available Events" dialog.

Figure 4-603: RRC measurement events

Activate the events before the start of the measurement, respectively before loading
the measurement file for replay.
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R&S ROMES4 decodes the Layer 3 message flow in such a way, that the 3GPP event
results are shown directly in the Layer 3 View, apart from being shown in the "Event
View".

Figure 4-604: Example - measured event A2

The corresponding RRC reconfiguration message is contained in the measurement
file.

4.4.16  LTE/5GNR RRM mobility analysis view

R&S ROMES4 offers an analyzer which allows you to get insights into the LTE/5GNR
mobility events quick and easy and helps to identify and improve LTE/5GNR mobility
issues.

The "LTE/5GNR RRM Mobility Analysis View" has a grid layout and the grid cells infor-
mation text can be marked and highlighted with colors. For the grid view handling, see
Chapter 4.1.8, "Extended grid view", on page 432.

The view supports coupled focus. Triggered by a mobility event procedure of this view,
the "Layer 3 View" synchronizes to the start timestamp of the event. It marks the time-
stamp column blue for the duration of the event in the view.
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Figure 4-605: LTE/5GNR RRM Mobility Analysis View - example

The configuration file 5GEventConfig.xml is not supported.

To navigate through the view perform the following:

- Select a cell in the grid.

- Use the arrow keys to move a line up or down.

- If you press the control key, the selection is the next/previous line with the same con-
tent in the column of the selected cell as the selected cell has.

- If you press the shift key, the selection is the next/previous line with a non empty cell
in the column of the selected cell.

4.4.16.1  Approach to RRM procedures performance analysis

The support of combination of two RATs (LTE and 5G NR) and several different bands
to achieve high capacity and wide area coverage requires state-of-the-art 5G-4G net-
work solution. These assets together with a mobile operator's goal to offer a customer
required quality experience, impose permanent RRM performance monitoring and opti-
mization.

RRM performance must be in focus at the operations department and constantly opti-
mized, and monitored for problems through the troubleshooting.

The R&S ROMES4 KPIs and Smart Event help that these tasks are done easier and
quicker.

A KPI set and the events related to RRC connection control and mobility procedures of
LTE, 5G EN-DC, NR are defined in accordance to some requirements. The require-
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ments are to define KPIs which are considered as the important indicators of the high
network performance quality.

The solution is relaying on setting the high network-wide goals for the KPI success
rates and to analyze the cases and the situations where they are not met.

The following chapter gives the closer look to some problematic situations that are sub-
jects of such analysis tasks.

4.4.16.2  RRM procedures problem analysis

Measurement reporting problem

In LTE and NR technologies there is no need to transmit the neighbor cell list to the
UEs via RRC signaling. The UEs are able to detect cells on the measured frequencies.
This detection capability is confirmed from the measurement in the life networks. The
RRC measurement configuration rarely contains any cell identity information to force or
prevent measurement on specific cells. However, such an option exists for LTE and NR
and is used in some networks.

In the UE measurement report is visible if it reports cells with their PCI. From RAN per-
spective, it is required that neighbor cell relations are uniquely identified in each
eNB/gNB cell. In that way only a source cell can address the correct target cell on the
control signaling interface between the nodes within the RAN. Therefore, the CGI is
needed in neighbor cell relation table of an eNB/gNB cell. The optimization principle is
that an eNB/gNB cannot have too many cells in the table but also not too few.

The ANR feature is the common solution to automate the neighbor cell list manage-
ment in LTE and NR. When the UE reports a neighbor cell PCI that is not defined as a
neighbor, the eNB/gNB updates the measurement configuration. In the updated config-
uration it requests the UE to measure specifically this PCI, decode the broadcasted cell
information from SIB1 and report back the CGI. The reported CGI is sufficient to add
the cell into the neighbor cells table.

UEs need a larger idle gap in the channel frame structure to have time to decode the
SIB1 compared to measurement gap for normal reference signal measurement. This
type of measurements has not to be configured too often. Otherwise, it turns into a
tradeoff between intensity of the ANR function to invoke RRC measurements with CGI
requests and the throughput in a serving cell.

There are many EN-DC networks that do not broadcast SIB1 on the NR cells and then
the UE cannot report the CGI to the ANR. Without support of ANR the EN-DC NR
neighbor cell table optimization needs more manual work, just like in the past with 2G
and 3G networks.

Missing neighbor problems are one of the most common root causes for dropped calls
and bad connection quality. If the UE sends measurement reports to the primary cell,
reporting a good neighbor cell and there is no response from the eNB/gNB, the UE
most probably drops its connection. The cause of dropped connection is bad signal
quality. The UE initiates then the RRC Reestablishment procedure.
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The previous case is a sign that the cell relation to this neighbor cell is not defined in
the primary cell. There are also other potential reasons, for example if the neighbor cell
has too high traffic load currently.

R&S ROMES4 can easily detect the situations where there is no response to the UE
measurement report. Searching for the KPI 'No MR Response' it quickly identifies if
such problem occurs. This KPI is supported both for LTE and NR.

The following screenshot shows such a case for LTE.

Figure 4-606: Problem - No MR response

KPI helps to find the problem. The decoded RRC MR events help to understand the
problem. The following screenshot shows that a neighbor cell with PCI 400, which is
reported by event A3, has much better cell quality than the serving one. Nevertheless,
there is no handover triggered by the eNB.

Figure 4-607: Measurement report of event A3

Connectivity problem

MR-DC operation has an advantage that the primary cells of master and secondary
cell groups do not have to be collocated, that is, to be installed on the same antenna
site.

However it is a challenge for the coverage. If the cell groups use different frequency
bands, the resulting coverage layers do not always overlap. If the layers do not over-
lap, there are areas where the connection to the secondary cell group is bad. In that
case there is no any advantage to utilize the cell groups in a DC connection.

In EN-DC networks various types of failures can happen at secondary node (SN) addi-
tion or SN change. The failures often indicate the problem areas for using DC.   To
find out if and where these problems occur, search for KPI results 'Failed'. Narrow
down then the selection to SN addition or SN change.

The following screenshot shows an example of the SN change connectivity problem.
The SN change from PCI 334 to 582 fails.

Figure 4-608: Problem - SN Change Inter-gNB
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If UE cannot perform the RRC SCG configuration, it sends an SCG failure information
message to inform the MCG PCell. There can be various failure causes and the UE
indicates failure in the RRC message.

Figure 4-609: Layer 3 view shows synchronization failure

The previous screenshot shows a SynchReconfigFailure and indicates that initial cell
synchronization failed, that is, detection and decoding of SS/PBCH block on PCI 582
failed.

Mobility problems

RRM solutions of different network equipment manufacturers show variety of used
measurement report events to trigger connection control and mobility actions. In gen-
eral, the following summary applies to any LTE and NR network:

● LTE and NR event A3, A4 and/or A5 report a better neighbor cell on serving cell
frequencies. These events trigger RAN to take a handover decision where the
PCell is changed to the reported neighbor.

● LTE event A6 reports better neighbor cell measured on serving SCell frequencies
(CA case). The event triggers RAN to take a decision to change SCell.

● LTE event B1-NR and/or B2-NR are used to report an NR cell- They trigger RAN to
take a decision to change operation mode to EN-DC and add the NR cell.

● NR event B1 and/or B2 are used to report an LTE cell. They trigger NR RAN to
take a decision to perform an IRAT handover to LTE.

The commonality of the LTE and NR MR events is the set of parameters for threshold,
hysteresis and offsets. These parameters define the cell quality conditions that the
actual cell reference signal measurements are compared against.

The MR events have also the parameters time-to-trigger, report interval and the report
amount. These parameters define when to trigger a report and how often to repeat it
when the conditions are fulfilled.
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Figure 4-610: LTE multi-cell measurement

A common optimization principle is to reduce the number of unnecessary handovers. A
high frequency of handovers increases the processing load in the network. The load on
the signaling interfaces is also increased that can have impact on quality and traffic
capacity of the mobile system. A typical case is the ping-pong handover where the UE
is repeatedly handed over between same cells.

The following screenshot shows an example for EN-DC. In this example, the LTE Cell
(MCG PCell) is switching between PCI 444 and 165 and the NR Cell (SCG PSCell) is
switching between PCI 43 and 400.

Figure 4-611: Problem - ping-pong handover in EN-DC

The figure Figure 4-605 showing the "LTE/5GNR RRM Mobility Analysis View" page
also shows the previously mentioned sequence. The MR event A3 triggers the LTE
handovers with SN change KPIs. A solution to this ping-pong problem is to optimize
the A3 parameters, for example, to configure specific offset between these LTE cells.

4.4.16.3  KPIs for LTE/5G NR RRC connection control and mobility procedures

The following table contains the R&S ROMES4 supported KPIs for LTE and 5G NR
RRC connection control and mobility procedures. The KPIs are based on the events
related to 5G NR IRAT mobility and 5G NR CA/DC cell configurations. The events are
shown in the "LTE UE and 5G NR UE events" on page 245.
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KPI name RAT Description

4G - Handover (LTE A3) LTE LTE PCell intra-frequency handover triggered
by LTE MR event A3

4G - IF Handover (LTE A3) LTE LTE PCell inter-frequency handover triggered
by LTE MR event A3

4G - MCG Handover (LTE A3) LTE CA LTE PCell intra-frequency handover with SCell
configuration (CA) triggered by LTE MR event
A3

4G - MCG IF Handover (LTE A3) LTE CA LTE PCell inter-frequency handover with SCell
configuration (CA) triggered by LTE MR event
A3

4G - IF Handover (LTE A4) LTE LTE PCell inter-frequency handover triggered
by LTE MR event A4

4G - MCG IF Handover (LTE A4) LTE CA LTE PCell inter-frequency handover with SCell
configuration (CA) triggered by LTE MR event
A4

4G - IF Handover (LTE A5) LTE CA LTE PCell inter-frequency handover triggered
by LTE MR event A5

4G - MCG IF Handover (LTE A5) LTE CA LTE PCell inter-frequency handover with SCell
configuration (CA) triggered by LTE MR event
A5

4G - MCG Add SCell(LTE A6) LTE CA LTE MCG addition of SCell triggered by LTE
MR event A6_r10

 

4G - eNB to MeNB Handover
(LTE B1-NR)

LTE/LTE CA LTE PCell reconfiguration with handover to 5G
ENDC triggered by LTE MR eventB1-NR-r15

4G - eNB to MeNB Change (LTE
B1-NR)

LTE/LTE CA LTE PCell reconfiguration to 5G ENDC trig-
gered by LTE MR eventB1-NR-r15

 

5G ENDC - MeNB to eNB Hand-
over (LTE A3)

LTE-5G ENDC MN LTE PCell reconfiguration with handover
from 5G ENDC to LTE triggered by LTE MR
event A3

5G ENDC - MeNB to eNB
Change

LTE-5G ENDC MN LTE PCell reconfiguration from 5G ENDC
to LTE

5G ENDC - MN Handover w. SN
Change (LTE A3)

LTE-5G ENDC MN LTE PCell handover with SN 5G NR
PSCell change triggered by LTE MR event A3

5G ENDC - MN Handover w. SN
Change (5GNR A3)

LTE-5G ENDC MN LTE PCell handover with SN 5G NR
PSCell change triggered by 5G NR MR event
A3

5G ENDC - MN Handover w/o SN
Change (5GNR A3)

LTE-5G ENDC MN LTE PCell handover without SN 5G NR
PSCell change triggered by 5G NR MR event
A3

 

4G - SN Addition NR PSCell (LTE
B1-NR)

LTE/LTE CA SN addition of 5G NR PSCell triggered by LTE
MR eventB1-NR-r15
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KPI name RAT Description

 

5G ENDC - SN Re-Addition NR
PSCell (LTE B1-NR)

LTE-5G ENDC SN (re-)addition of 5G NR PSCell triggered by
LTE MR eventB1-NR-r15 when already in 5G
ENDC

5G ENDC - SN Re-Addition NR
PSCell (LTE A3)

LTE-5G ENDC SN (re-)addition of 5G NR PSCell triggered by
LTE MR eventA3 when already in 5G ENDC

5G ENDC - SN Re-Addition NR
PSCell (5GNR A3)

LTE-5G ENDC SN (re-)addition of 5G NR PSCell triggered by
5GNR MR eventA3 when already in 5G ENDC

5G ENDC - SN Change Inter-gNB
(LTE A3)

LTE-5G ENDC SN Inter-gNB change of 5G NR PSCell trig-
gered by LTE MR event A3

5G ENDC - SN Change Inter-gNB
(5GNR A3)

LTE-5G ENDC SN Inter-gNB change of 5G NR PSCell trig-
gered by 5G NR MR event A3

5G ENDC - SN Change Intra-gNB
(5GNR A3)

LTE-5G ENDC SN Intra-gNB change of 5G NR PSCell trig-
gered by 5G NR MR event A3

5G ENDC - SN Change Intra-gNB
(5GNR A4)

LTE-5G ENDC SN Intra-gNB change of 5G NR PSCell trig-
gered by 5G NR MR event A4

 

4G - No MR Response (LTE A3) LTE No response from eNB to LTE measurement
reports triggered by event A3

4G - No MR Response (LTE A4) LTE No response from eNB to LTE measurement
reports triggered by event A4

4G - No MR Response (LTE A5) LTE No response from eNB to LTE measurement
reports triggered by event A5

4G - No MR Response (LTE A6) LTE No response from eNB to LTE measurement
reports triggered by event A6

 

4G - IRAT LTE-NR Redirection
(LTE B1-NR)

LTE → 5G NR IRAT LTE RRC release with redirection to 5G NR
carrier triggered by LTE MR eventB1-NR-r15

 

5G NR - Handover (5GNR A3) 5G NR 5G NR PCell intra-frequency handover trig-
gered by NR MR event A3

5G NR - IF Handover (5GNR A3) 5G NR 5G NR PCell inter-frequency handover trig-
gered by NR MR event A3

 

5G NR - IRAT NR-LTE Handover
(5GNR B2)

LTE → 5G NR IRAT 5G NR to LTE inter-system handover triggered
by NR MR event B2

5G NR - IRAT NR-LTE Redirec-
tion

LTE → 5G NR IRAT 5G NR RRC release with redirection to LTE
carrier

 

5G NR - No MR Response
(5GNR A1)

5G NR No response from gNB to NR measurement
reports triggered by event A1
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KPI name RAT Description

5G NR - No MR Response
(5GNR A2)

5G NR No response from gNB to NR measurement
reports triggered by event A2

5G NR - No MR Response
(5GNR A3)

5G NR No response from gNB to NR measurement
reports triggered by event A3

5G NR - No MR Response
(5GNR A4)

5G NR No response from gNB to NR measurement
reports triggered by event A4

5G NR - No MR Response
(5GNR A5)

5G NR No response from gNB to NR measurement
reports triggered by event A5

5G NR - No MR Response
(5GNR A6)

5G NR No response from gNB to NR measurement
reports triggered by event A6

4.4.17  QualiPoc messages view

A view displaying the log messages of the QualiPoc application is available.

Figure 4-612: QP messages view

This is helpful to analyze quickly problems if jobs do not run as expected.

4.4.17.1  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,
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- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

Click the "Configuration" entry of the menu to open the "Info" page.

4.4.18  Serving cell view

The "Serving Cell Vew" tracks the network, band, channel type and channel ID for all
available carriers.

The view contains the following possible sections:
● Network section - contains the information about current network type.
● Carier sections - whose number is dependent on number of component carriers

selected for display, if a measurement file contains more carriers. For LTE, up to 9
LTE UE mobile signals can be selected, PCell and SCell 1 to SCell 8.For 5G NR,
up to 12 5G NR UE mobile signals, PCell and SCell 1 to SCell 11.

On the right side of the view there is the the view's property bar, "Serving Cell View
Properties". The property component lets you select for display carriers and controls
the look and feel of the view.

The view is launched from the R&S ROMES4 "View" > "Mobile Views" > "Serving Cell
View". It can also be launched from the context popup menu. Right click the empty
view area to get the context menu.

The view supports LTE UE and 5G NR UE measurements. If the current measurement
or replay file contains LTE and 5G signals (the RAT mode is "5G EN-DC"), a carrier
section contains for both technologies the "Band" /"5G NR Band", "Channel"/"5G NR
Channel" and channel "ID"/"5G NR ID" fileds. The 5G NR carrier fields are shown even
when the no 5G carriers present if the "Display 5G Carrier" option is checked in the
"Serving Cell View Properties", see Figure 4-620. The option is by default unchecked.

The following figure shows the "Serving Cell View" page for the case EUTRA-NR Dual
Connectivity (EN-DC).
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Figure 4-613: Serving cell view - EN-DC

Carrier values

Each possible carrier has one of the following sections.

Figure 4-614: Single chart view

The values on the left represent the band, channel number and channel ID for the
given carrier at a specific point in time of the measurement file. The values in colored
lines on the right represent duplex mode and type ID of a band of the measurement or
replayed measurement file.

You can configure the size taken up by a section by clicking the size bar above or
below the section. Move and drag the mouse to increase or decrease the section size.

Signals tracked

The view tracks the following signals:
● Network

This is the network type (5G NR/ LTE/UMTS/GSM).
● Carrier 1

For the network type 5G NR includes:
– 5G NR Band - 5G NR band
– 5G NR Channel - PCC NARFCN DL
– 5G NR ID - PCI

● Carrier 2 to Carrier 12
For the network type 5G NR includes:
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– 5G NR Band - SCC2 to SCC12 5G NR band
– 5G NR Channel - SCC2 to SCC12 NARFCN DL
– 5G NR ID - SCC2 to SCC12 PCI

● Carrier 1
For the network type LTE includes:
– Band - LTE band
– Channel - PCC EARFCN DL
– ID - PCC PCI

● Carrier 2 to Carrier 9
For the network type LTE includes:
– Band - SCC1 - SCC8 LTE band
– Channel - SCC1 - SCC8 EARFCN DL
– ID - SCC1 -SCC8 PCI

● Carrier 10 to Carrier 9
For the network type LTE includes:
– Band - N/A
– Channel - N/A
– ID - SCC1 -N/A

● Carrier 1
For network type UMTS includes:
– Band - UMTS FDD band x or UMTS TDD band x
– Channel - UARFCN 0
– ID - Scrambler Code 0

● Carrier 2
For network type UMTS includes:
– Band - UMTS FDD band x or UMTS TDD band x
– Channel - UARFCN 1
– ID - Scrambler Code 1

● Carrier 3 to Carrier 12
For network type UMTS includes:
– Band - N/A
– Channel - N/A
– ID - N/A

● Carrier 1
For network type GSM includes:
– Band – Used network for the given RAT. GSM 900, GSM 1800, GSM 1900,

GSM 900/1800, GSM-R, GSM-E
– Channel - BCCH
– ID - BSIC

● Carrier 2 to Carrier 12
For network type GSM includes:
– Band - N/A
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– Channel - N/A
– ID - N/A

4.4.18.1  Replay and measurement display items

During replay and measurement, the following items are available.

Figure 4-615: Mouse hovering over data

Moving the mouse over the time graph shows the values represented by that point in
time.

Within the time chart, a solid vertical black line represents the current timestamp of the
measurement.

Figure 4-616: Current cursor position

While a replay of a measurement is paused, doubling clicking any point within the time
graph rewinds or advances the replay file to that point. All other synced views should
also be advanced to that point.

The user may scroll along the time axis by clicking and holding and moving the mouse
on the scroll bar on the bottom chart. In addition, the user may scroll the time axis by
clicking and holding then moving the mouse on any of the displayed charts.

If the user attempts to scroll the time axis to a point in the measurement where the cur-
rent cursor (solid black line) cannot be displayed during replay and measurement, the
view automatically scrolls the line graph back to a point where the current cursor can
be displayed. This behavior can be changed in configuration, see the configuration
chapter.

During the replay, the user may also zoom-in on the time axis by using the mouse
wheel or by using touch pinch. The user can also zoom gestures if on a touch screen
capable device.

4.4.18.2  Mobile serving cell view configuration

To configure the colors displayed on the serving cell view:

1. Stop and close the current replay or measurement file.

2. Click "Tool" > "Preference" > "Available Signals".
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Figure 4-617: Customize serving cell signal colors

3. Select the desired signal and modify the colors to the desired values, as shown in
the following figure.

Figure 4-618: Changing signal colors

The configuration for the view can be accessed by clicking the "Serving Cell View
Properties" tab. The tab is by default located in the upper right portion of the view.
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Figure 4-619: Serving cell view properties tab

Click the properties tab to open the properties window.

Figure 4-620: Serving Cell View Properties window

If the "Serving Cell View Property" tab is not visible, you can recover it via the "Proper-
ties" entry of the context menu. The menu pops-up if right click any point in the "Serv-
ing Cell View". The tab is invisible if you unpin it from the view.

The "Serving Cell View Property" tab can be pinned to the view so that it is always
available. For that, the push-pin icon of the window has to look like .

A properties of the view can be changed in the properties window. The window is dis-
played all the time the view is active.

Once the properties window is un-pinned, it can be undocked from the view and made
floating. For that, double click the title bar or single click the title bar and drag the panel
off of the view.
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Figure 4-621: Unpinned Serving Cell View Properties window

The window can be re-docked to the serving Cell View by dragging the panel to the
left, right, top or bottom of the view and dragging the panel to the display arrows. In this
way you can dock the panel to the desired location on the view.

Figure 4-622: Serving Cell View Properties window docking options

The configured properties are saved when the workspace or measurement file is
saved.
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Within the properties window three buttons are available:
● "Restore All Values"

 restores the property values to their saved workspace values when the view was
started for the first time. If a workspace/measurement file is loaded, the setting
reverts to the values from the file. Any individual setting can be reverted by right
mouse click the setting and choosing "Reset Value".

● "Reset Zoom"
 resets the axis for all the charts to the values defined in the configuration.

● "Global"
 shows/hides the contents of the "Serving Cell View Properties" window.

Properties available in the view - global

The following properties are available to be changed in the view.

Update Rate in MS
The number of milliseconds between the bar and the line graph display updates during
a measurement or replay. This is done to help with system performance. The lower the
number the more frequent the screen refresh during measurement or replay, thereby
slowing overall system performance. A value of zero refreshes the screen every time a
new data point is received.

Lock Axis
Setting this configuration property to false allows scrolling the X-axis of each line graph
shown independently. Setting this value to true has all line graph X-axis scroll together.

Track Axis
Setting this configuration to false allows scrolling the line graph outside of the current
cursor during replay and has no the view automatically scroll the line graph back to the
current cursor.

X Axis Span is S
The new of second that is displayed on the line graph X-axis.

Zoom Option
The setting changes the way how the zoom control works for the line graph.
● "None"

No zoom control for the charts will be enabled.
● "Mouse Wheel & Pan"

Zoom the chart by using the mouse wheel
● "Magnify"

Allow for zoom; the left mouse button click the line graph to zoom in, the right
mouse button to zoom out.

● "Selection"
Allow a specific location to be zoomed into by selecting an area with mouse.

Show Data Points
Allows changing the view so that when the mouse is moved over the line graph the
individual antenna power levels are not shown.
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Cursor Color
Allows changing the color of the cursor that indicates the current time in the measure-
ment or replay.

Show Graph
The "Show Graph" drop box contains three possible values to choose.
● "Both": show both bars and lines (default)
● "Bar Graph": show current values
● "Line Graph": show value over time

Network Show
Show or hide the network section.

Carrier 1 to 12 Show
Show or hide this carrier group.

4.4.19  UE activity log view

The "UE Activity Log View" combines the most important logs from of all layers
involved in UE tests. This view merges and condenses the information of the Layer 3
view, the RRC mobility view, the QP message view and the DQA message views. By
merging the information from these views, it provides an overview of what is going on.

Figure 4-623: UE activity log view

The level of provided information can be controlled by the filters available for each
layer. The filters are offered in the view’s property pane, the "UE Activity Log View:1
Properties". The "Colors" in the properties pane provides control of information from
different sources.
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Colors are synchronized with the Layer 3 view’s colors, if applicable. Using the F2 and
F3 keys, it is possible to jump to the previous or next red message in the list. Use the
"Hold" option of the context menu to avoid auto-scrolling during the measurement or
replay.

4.4.19.1  UE activity log filter file format

The available filters can be adapted if necessary. The filter files are located in the
folder <My Documents>\My ROMES\Configuration\UEActivityLog.

The names of the files are fixed and cannot be changed. The filter file format is the fol-
lowing:

<MessageLists>
<MessageList Name="Default" Protocol="5G RRC">
   <Message SourceID="0x0601"/>
   <Message SourceID="0x0302"/>
   <Message SourceID="0x0803"/>
</MessageList>
<MessageList Name="Little More" Protocol="5G RRC">
   <Message SourceID="0x0601"/>
   <Message SourceID="0x0302"/>
   <Message SourceID="0x0803"/>
   <Message SourceID="0x0406"/>
</MessageList>
<MessageList Name="Show All" Protocol="5G RRC">
 </MessageList>
 </MessageLists>
 

The filter file format also can be as following:

<!--
eTextMarkerCyan = 1,
eTextMarkerYellow = 2,
eTextMarkerRed = 3,
eTextMarkerGreen = 4,
eTextMarkerOrange = 7,
-->

<MessageLists>
<MessageList Name="Default" Protocol="DQA">
<Exclude Text="rtt="/>
<Colored Text="success" Color="4"/>
<Colored Text="sucess" Color="4"/> 
<Colored Text="test ok" Color="4"/>
<Colored Text="start" Color="1"/>
<Colored Text="rat changed" Color="7"/>
</MessageList>
<MessageListName="Show All" Protocol="DQA">
  <Colored Text="success" Color="4"/>
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  <Colored Text="sucess" Color="4"/> 
  <Colored Text="test ok" Color="4"/>
  <Colored Text="start" Color="1"/>
  <Colored Text="rat changed" Color="7"/>
</MessageList>
</MessageLists>

The MessageLists is the container for n filters, specified by MessageList.

The MessageList has the following attributes:

- Name

- Protocol, it cannot be changed.

The MessageList specifies:

- Message, if one or more messages are specified, only these messages are show
(applicable for Layer 3 layers only).

- Exclude, all items, which contain this text are not shown. Use lower case only.

- Colored, all items’ messages and result columns, which contain the text are colored
as specified. Use lower case only.

4.4.20  UE CA downlink performance view

There are UE CA downlink and uplink performance views. As being similar, explana-
tions given here for the "UE CA Downlink Performance View" are applicable for the
"UE CA Uplink Performance View" as well.

The differences between them two are:
● "UE CA Downlink Performance View" has sections and associated charts for

RB/TP and MCSn/CQIn, n=1, 2.
● "UE CA Uplink Performance View" does not support CQI signal and the sections/

charts are RB/TP and MCS.

Both views can be launched from the "View" > "Mobile Views" > "UE" menu. Instead,
you can launch the views from the context menu which pops-up when right-mouse but-
ton click on the empty view area.
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Figure 4-624: UE CA Downlink Performance View

The view is separated into three sections each having bar area and chart for a selected
carrier.

The "Carrier" drop-down box lets you select LTE carriers and/or 5G NR CA carriers for
display. You can choose up to 9 LTE carriers (PCell and SCell1 to SCell8) and up to 12
5G NR carriers (PSCell and SCell1 to SCell11).

Figure 4-625: Supported carriers
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The view also contains legends per section and the properties component placed on
the right-hand side of the view by default. The properties components are used to
select supported signal combinations of the selected carrier for display and to config-
ure the view's layout.

If you click the "UE CA Downlink Performance View Properties" bar, the properties
pane opens. Four default colors are used to display four different signals: RB, TP, MCS
and CQI. The corresponding color areas are also used for showing the Y-axis of a sec-
tion. A sector for the supported signals combination does not appear if not activated in
the properties pane.

The X-axis is displayed at the bottom of the view.

Two Y-axes are displayed at both sides of bar and chart areas. Y-axes on the left of the
graph are primary and Y-axes on the right the secondary ones.

Figure 4-626: Partly selected charts with properties pane

If you resize the screen to reduce the width at the certain point, the legend is hidden to
give more space to lines and bars.
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Figure 4-627: Hidden legend

By resizing the view to even smaller width, the lines are hidden to show only bars. Bby
increasing the width of the view, the line and legend are restored if they are so config-
ured.

4.4.20.1  Charts and legend

Charts
The view contains three signal sections:
● RB/TP
● MCS1/CQI1
● MCS2/CQI2

Figure 4-628: UE CA Download Performance View single chart

For each displayed section, the view displays a bar graph in the left pane and line
graph in the right pane. You can configure the size of the screen taken up by a graph
on the view. Click the size bar of a signal and drag the mouse to increase or decrease
the size.
A section has a title displayed vertically on the left of the chart. If the section does not
have enough space to show the entire title, ellipsis is displayed at the end.
You can hide bars, lines or legend in the properties bar using the "Show Graph" prop-
erty, see "Properties available in the view" on page 1020.
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Figure 4-629: UE CA Downlink Performance View chart selection

Signal Charts
RB/TP Chart
The RB/TP chart shows the Resource Block Average number (RB), Throughput (TP)
and Rank Indicator (RI).
RB and TP are displayed in bar and line graphs. RI is displayed as a graph back-
ground color.
RB and TP signals have two Y-axes. RB Y-axis is the primary one and is on the left of
the graph. TP Y-axis is the secondary one and is on the right of the graph.
Different RI values are displayed using different colors, see the following figure.

Figure 4-630: RB/TP selection

The following selections are available:
● Both bar and line background are filled with the color that represents a value.
● Possible values are displayed in legend, for example in the previous figure "RI 2"

means that the value is 2 for RI signal and "RI 1" means 1 for RI signal.
● In total two values are available in this measurement file.
● RI color legend does not have check box to show/hide the signal.
MCSn/CQIn Chart
The MCSn/CQIn chart shows the MCS and CQI and modulation signals.
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MCSn and CQIn are displayed in bar and line graphs and modulation is displayed as
line chart background color.
MCS and CQI signals have two Y-axes. The MCSn Y-axis is the primary one and is on
the left of the graph. The CQIn Y-axis is the secondary one and is on the right of the
graph.
Different modulation values are displayed using different colors.

Figure 4-631: MCS/CQI selection

The following selections are supported:
● Both bar and line background are filled with the color that represents modulation

value.
● Possible values are displayed in legend. If more values are available, an arrow is

present to let user view more values.
● The modulation signals in the legend do not have a check box to show/hide the

signal.

Legend
Legend is by default shown on the right side of the view. Following picture shows the
legend for signal RB/TP chart. Other signal legends are similar.

Figure 4-632: RB/TP legend

The legend can be entirely hidden to make more space for bars or lines by clearing the
"Show Legend" check box in the configuration pane.

Figure 4-633: Hide legend
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There is an up and down arrow to access the non-displayed items if the list of all
options in the legend cannot be displayed due to screen size constraints.

Figure 4-634: Legends scroll arrows

Click the arrow to scroll the list up and down accordingly.

4.4.20.2  Replay and measurement display items

During replay and measurement the following items are available. Moving the mouse
over the line graph shows the power levels for each value represented by the current
mouse location.

Figure 4-635: Mouse over display data

The bar shows the values for the current time within the measurement or replay.

Figure 4-636: Current values

Within the line graph, a solid vertical black line represents the current timestamp of the
measurement.

Figure 4-637: Current cursor position

During a replay of a measurement is paused double click at any point within the line
graph rewinds or advances the replay file to that point. All other synced views can also
be advanced to that point.

If the user scrolls on any one of the lines graphs X-axis, the X-axes of the other dis-
played line graphs scroll the same amount.

If you attempt to scroll the X-axis to a point in the measurement where the current cur-
sor (solid black line) cannot be displayed during replay and measurement, the view
automatically scrolls the line graph back to a point where the current cursor can be dis-
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played. This behavior can be changed in configuration, see the configuration section
for details.

The user can also scroll the Y-axis of line graph by clicking the scroll bar on the line
graph and moving the mouse up and down. The Y-axis can be adjusted for each signal
independently.

Zoom to Fit
The "Zoom to Fit" feature sets the Y-axis minimum and maximum automatically, so that
all lines and bars are displayed properly using the available chart space.

Figure 4-638: Auto zoom to fit

The following buttons are available in configuration bar:
● "Reset Zoom"

Click  to reset the Y-axis min and max to the default values in configuration.
● "Zoom To Fit"

Click  to recalculate the Y-axis min and max to show the lines/bars with all availa-
ble chart spaces.

Hovering mouse over the icons displays their functions.

Auto Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is checked, the Auto Zoom mode is active. This
zoom mode is useful during measurement or replay.
In Auto Zoom mode, when a new value that is outside of the current Y-axis scope
enters the display, the Y-axis range is reconfigured. The new value is shown in the
chart properly after the reconfiguration.
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Figure 4-639: Y-axis configuration disabled by Auto Zoom To Fit

Note: The Y-axis is not reconfigured if the maximum or minimum value goes out of cur-
rent display.
If you change the Y-axis or zoom-in to a line using mouse wheel in Auto Zoom mode,
the mode turns off.
Click "Auto Zoom To Fit" icon to resume the Auto Zoom mode. The min and max value
settings of Y-axis in configuration bar are disabled.

Manual Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is cleared, the Auto Zoom mode is deactivated,
see Figure 4-638.
The default configured Y-axis used min and max settings.
Click the "Zoom To Fit" icon to zoom to fit the charts.
In this mode, the min and max value settings of Y-axis in configuration bar are activa-
ted.

4.4.20.3  UE CA downlink performance view configuration

The configuration for the view can be accessed by clicking the "UE CA Downlink Per-
formance View Properties" tab, which is by default located on the upper right portion of
the view.
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Figure 4-640: UE CA Downlink Performance View Properties

If the tab is not visible, it can be recovered by right mouse-button click any point in the
"UE CA Downlink Performance View" and selecting "Properties".

Figure 4-641: Accessing the view via context menu

If the tab is selected, a configuration item can be changed. The tab automatically hides
itself if another item on the screen is selected.

The properties panel is displayed while the view is active.

The configuration properties can be pinned to the screen by clicking the pin icon in the
properties panel.

Once the properties panel is pinned, it can be undocked from the view and made float-
ing. To do undocking, double click the title bar of the properties panel or single click the
title bar and drag the panel off of the view.

The properties bar can be redocked to the view by dragging the panel to the left, right,
top or bottom of the view. Drag the panel to the display arrows to dock the panel to the
desired location on the view.
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Figure 4-642: View properties docking

The configured properties are saved when the workspace or measurement file is
saved.

Three buttons are available within the properties panel.

Figure 4-643: Available buttons in properties panel

Apart from the buttons "Reset Zoom" and "Zoom To Fit", there is the "Restore All Val-
ues" button. Click  to restore all properties to the values existed when the view was
first started. If a workspace/measurement file is loaded, the setting reverts to the val-
ues from the file. Any individual setting can be reverted by right mouse click the setting
and choosing "Reset Value".

Properties available in the view - global

The following properties are available for selection in the view.

Current Selected Tab
This setting sets the default selected tab when R&S ROMES4 starts.

Update Rate in MS
The number of milliseconds between the bar and the line graph display updates during
a measurement or replay. This update is done to help with system performance. The
lower the number the more frequent the screen refresh during measurement or replay,
therefore slowing overall system performance. A value of zero refreshes the screen
every time a new data point is received.

Lock Axis
Unchecked, this configuration property allows scrolling the X-axis of each line graph
independently. X-axes of all line graphs are scrolled together if the property is checked.

Track Axis
Unchecked, this configuration allows scrolling the line graph outside of the current cur-
sor during replay. If checked, always returns to X-axis of the line graph back to the cur-
rent cursor.
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Properties available in the view

X Axis Span in S
Time in second to display on the line graph X-axis.

Show Graph
The "Show Graph" drop box contains three possible values to choose.
● "Both" - show both bars and lines (default)
● "Bar Graph" - show bars only
● "Line Graph" - show lines only

Show Chart Legend
If unchecked, this configuration property hides the legend. It is checked by default to
show a chart legend.

Auto Zoom To Fit
Check "Auto Zoom To Fit" to activate the automatic zoom mode to fit Y axis when mea-
suring or replaying. Unchecked, the mode is deactivated.

Show Thick Line
Check the check box to show thick chart line and vertical cursor bar.

Properties available in the view - y axis

RB Minimum Value
Minimum power level value to display on the Y-axis of the RB signal.

RB Maximum Value
Maximum power level value to display on the Y-axis of the RSSI signal.

TP Minimum Value
Minimum power level value to display on the Y-axis of the TP signal.

TP Maximum Value
Maximum power level value to display on the Y-axis of the TP signal.

MSC Minimum Value
Minimum power level value to display on the Y-axis of the MCSx signals.

MCS Maximum Value
Maximum power level value to display on the Y-axis of the MCSx signals.

CQI Minimum Value
Minimum power level value to display on the Y-axis of the CQIx signals.

CQI Maximum Value
Maximum power level value to display on the Y-axis of the CQIx signals.
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Zoom Options
The setting changes the way how the zoom control works for the line graph.
● "None"

No zoom control for the charts is enabled.
● "Mouse Wheel & Pan"

Zoom the chart by using the mouse wheel
● "Magnify"

Allow for zoom; the left mouse button click the line graph to zoom in, the right
mouse button to zoom out.

● "Selection"
Allow a specific location to be zoomed into by selecting an area with mouse.

Show Data Points
Allows changing the view so that when the mouse is moved over the line graph the
individual antenna power levels are not shown.

Cursor Color
Allows changing the color of the cursor that indicates the current time in the measure-
ment or replay.

RB Color
Allows changing the color that represents this item in the bar and graph charts.

TP Color
Allows changing the color that represents this item in the bar and graph charts.

MCS Color
Allows changing the color that represents this item in the bar and graph charts.

CQI Color
Allows changing the color that represents this item in the bar and graph charts.

LTE/5G carriers values

LTE carrier values

RB/TP [kbit/s]
The RB/TP signal includes the following values:
● Resource Blocks (RB)
● Throughput (TP)
● Rank Indicator

MSC1/QCI1
Shows the first modulation value MCS1 and the first quality of channel value QCI1.

MSC2/QCI2
Shows the second modulation value MCS2 and the second quality of channel value
QCI2.
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5G carrier values

RB/TP [kbit/s]
The RB/TP signal includes the following values:
● Resource Blocks (RB)
● Throughput (TP)
● Rank Indicator

MSC1/QCI1
Shows the MSC modulation value MCS1 and QCI1.

MSC2/QCI2
Not displayed

4.4.21  UE CA uplink performance view

The descriptions and explanations given in the Chapter 4.4.20, "UE CA downlink per-
formance view", on page 1009 chapter apply for the "UE CA Uplink Performance
View".

Figure 4-644: UE CA Uplink Performance View

There is the configuration possibility to display or hide the RB/TP and MCS sections.
The "UE CA Uplink Performance View Properties" pane is used for the configuration.
Check or uncheck the "Show" property next to a corresponding section name.

4.4.21.1  Carrier values

The "RB/TP Mbit/s" section shows the following signals for LTE or 5G NR selected car-
rier if selected in properties pane.

● Resource Blocks ("RB")
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● Throughput ("TP") in MBit/s
● Rank Indicator

The "MSC" section shows the used UL modulation scheme values for LTE or 5G NR
selected carrier.

4.4.22  UE capabilities view

The "UE Capabilities View" visualizes an UE capability information included in the
Layer3 messages.

The view supports active and passive coupled focus.

The opening "Summary" page offers a summary of the most important capabilities of
the 5G NR, LTE, UMTS and GSM UEs. The summary consists of the accumulated
information retrieved by the corresponding Layer 3 messages.

The following figure shows the list of UE capabilities per technology. Shown is, for
example, the UE category, its capability to support 5G NR and EN-DC, LAA, carrier
aggregation in uplink and downlink, splitting DRB in UL and so on. LTE component car-
rier band combinations supported in downlink are marked green.

Figure 4-645: UE capabilities

It Is possible to highlight specific text by entering it into the "Summary" > "Highlight
Text" box.
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The all available band combinations for LTE and NR and the corresponding feature set
supported by an UE are visible if you click the "Feature sets per band" tab.

The opened page shows in tabular way what the UE is able to support. Which feature
set should be in use is decided by the network. The table shows also the max. availa-
ble throughput of each carrier.

Figure 4-646: Feature set per band view

The "Details" tab provides the UE capabilitiy details.

The details are shown in the lower part of the page if you click the message line of your
interest. The filter/search string is marked blue. The details of the UE capabilities can
be filtered by 5G NR, LTE, UMTS and GSM Layer 3 messages.
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Figure 4-647: Details of UE capabilities

The UE Capabilities View can be exported in CSV format.

Figure 4-648: Exporting data as CSV

To export the view in CSV format, right mouse-button double click any point in the
view's area to get the context menu. Select the "Export data as CSV" entry. The "Save
As" window lets you to save the export.
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4.4.22.1  5G NR UE capabilities

The following table lists the 5G NR UE capabilities and provides the additional explan-
ations.
Table 4-27: 5G NR UE capabilities

RAT type Parameters Comment

EUTRA EN-DC support Indicates if the eNB supports dual conectivity

EUTRA Bands Supported bands

EUTRA-NR MR-DC supported
band combinations

TS 38.331 6.3.3

The IE BandCombinationList contains a list of NR CA and/or MR-
DC band combinations (also including DL only or UL only band).

NR Release TS 38.331 6.3.3

The IE AccessStratumRelease indicates the release supported by
the UE

NR NR supported bands TS 38.306 4.2.7.11

Includes the supported NR bands as defined in TS 38.101-1 [2] and
TS 38.101-2 [3].

NR NR supported band
combinations

TS 38.306 4.2.7.11

Defines the supported CA and/or MR-DC band combinations by the
UE. For each band combination the UE identifies the associated fea-
ture set combination by featureSetCombinations index referring to
featureSetCombination. A fallback band combination resulting from
the reported CA and MR-DC band combination is not signalled but
the UE shall support it. For intra-band non-contiguous CA band com-
binations, the UE only includes one band combination, and exclude
the others for which the presence of uplink CA bandwidth class in the
band combination entry is different. One band combination entry can
also indicate support of any other possible permutations in the pres-
ence of uplink CA bandwidth class where a paired downlink CA band-
width class is the same or where the number of UL CCs is smaller
than the one of paired DL CCs expressed by the CA bandwidth class,
as specified in TS 36.306 [15]. For these band combinations not
included in the capability, the supported feature set is the same as the
ones for the band combination included in the UE capability.

NR Supported carrier
spacing DL

TS 38.306 4.2.7.6

Defines the supported sub-carrier spacing for DL by the UE indicating
the UE supports simultaneous reception with same or different
numerologies in CA. Note the UE shall support all mandated sub-car-
rier spacing for FR1/FR2. Same numerology for intra-band NR CA
including both continuous and non-continuous is mandatory with
capability in both FR1 and FR2. Two mixed numerologies between
FR1 band(s) and FR2 band(s) in DL are mandatory with capability if
UE supports inter-band NR CA including both FR1 band(s) and FR2
band(s). Optional for other cases.
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RAT type Parameters Comment

NR Supported band-
width DL FR 1

Supported band-
width DL FR 2

TS 38.306 4.2.7.6

Indicates maximum DL channel bandwidth supported for a given SCS
that UE supports within a single CC, which is defined in Table 5.3.5-1
in TS 38.101-1 [2] for FR1 and Table 5.3.5-1 in TS 38.101-2 [3] for
FR2. For FR1, all the bandwidths listed in TS38.101-1 v15.0.0 Table
5.3.5-1 for each band shall be mandatory with a single CC. For FR2,
the set of mandatory CBW is 50, 100, 200 MHz. When this field is
included in a band combination with a signle band entry and a single
CC entry (i.e. non-CA band combination), the UE shall indicate the
maximum channel bandwith for the band according to TS 38.101-1 [2]
and TS 38.101-2 [3].

NR Max number MIMO-
layers PDSCH

TS 38.306 4.2.7.6

Defines the maximum number of spatial multiplexing layer(s) suppor-
ted by the UE for DL reception. For single CC standalone NR, it is
mandatory with capability signaling to support at least 4 MIMO layers
in the bands where 4Rx is specified as mandatory for the given UE
and at least 2 MIMO layers in FR2.

NR Supported modula-
tion order DL

TS 38.306 4.2.7.6

Indicates the maximum supported modulation order to be applied for
downlink in the carrier in the max data rate calculation as defined in
4.1.2. The network may use a modulation order on this serving cell
which is higher than the value indicated in this field as long as UE
supports the modulation of higher value for downlink.

NR Supported carrier
spacing UL

TS 38.306 4.2.7.7

Defines the supported sub-carrier spacing for UL by the UE, indicat-
ing the UE supports simultaneous transmission with same or different
numerologies in CA, or indicating the UE supports different numerolo-
gies on NR UL and SUL within one cell. Note the UE shall support all
mandated sub-carrier spacing for FR1/FR2. Same numerology for
intra-band NR CA including both continuous and non-continuous is
mandatory with capability in both FR1 and FR2. Two mixed numerolo-
gies between FR1 band(s) and FR2 band(s) in UL are mandatory with
capability if UE supports inter-band NR CA including both FR1
band(s) and FR2 band(s). It is optional for other cases.

NR Supported Band-
width UL FR 1

Supported Band-
width UL FR 2

TS 38.306 4.2.7.7

Indicates maximum UL channel bandwidth supported for a given SCS
that UE supports within a single CC, which is defined in Table 5.3.5-1
in TS38.101-1 [2] for FR1 and Table 5.3.5-1 in TS 38.101-2 [3] for
FR2. For FR1, all the bandwidths listed in TS38.101-1 v15.0.0 Table
5.3.5-1 for each band shall be mandatory with a single CC. For FR2,
the set of mandatory CBW is 50, 100, 200 MHz. When this field is
included in a band combination with a single band entry and a single
CC entry (i.e. non-CA band combination), the UE shall indicate the
maximum channel bandwidth for the band according to TS 38.101-1
[2] and TS 38.101-2 [3].

NR Max Number MIMO-
layers CB PUSCH

TS 38.306 4.2.7.7

Defines supported maximum number of MIMO layers at the UE for
PUSCH transmission with codebook precoding. UE indicating support
of this feature shall also indicate support of PUSCH codebook coher-
ency subset. This feature is not supported for SUL.
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RAT type Parameters Comment

NR Max number MIMO-
layers NonCB
PUSCH

TS 38.306 4.2.7.7

Defines supported maximum number of MIMO layers at the UE for
PUSCH transmission using non-codebook precoding. This feature is
not supported for SUL.

NR Supported modula-
tion order UL

TS 38.306 4.2.7.7

Indicates the maximum supported modulation order to be applied for
uplink in the carrier in the max data rate calculation as defined in
4.1.2. The network may use a modulation order on this serving cell
which is higher than the value indicated in this field as long as UE
supports the modulation of higher value for uplink.

NR UL sharing EUTRA-
NR

TS 38.306 4.2.7.9

Indicates whether the UE supports EN-DC with EUTRA-NR coexis-
tence in UL sharing via TDM only, FDM only or both TDM and FDM
from UE perspective as specified in TS 38.101 3 [4].

4.4.23  UE carrier aggregation view

The "UE Carrier Aggregation View" makes possible the 5G NR and LTE carrier aggre-
gation measurement analysis from a single view. The view is derived from the former
"LTE Carrier Aggregation View".

Figure 4-649: Default UE Carrier Aggregation View
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The "Carrier" drop-down box lets you select between LTE and 5G NR CA view. If you
select "LTE", you can choose up to 9 carriers (PCell and SCell1 to SCell8) in the view's
"UE Carrier Aggregation View Properties" field. If you select "5G-NR" for carrier, the
properties field lets you select up to 12 5G NR carriers (PSCell and SCell1 to SCell11).

For selected carriers, in the Properties field, select the signals you want to be dis-
played in the associated charts of the view. The view contains five charts to display the
following signals for LTE and 5G NR: RSSI (LTE only), RSRP, RSRQ, SINR and the
DELTA (Maximum Carrier Value – Minimum Carrier Value). DELTA also contains leg-
end and properties components.

The X-axis is displayed at the bottom of the view.

The view's legend and properties are located on the right-hand side of the view by
default. In the "UE Carrier Aggregation View Properties" field you can select carriers
and signals out of supported ones for display. The chosen color for the selected carri-
ers is associated to the selected signals both in the bar and chart fields.

If you deselect, for example the RSRQ chart display, the RSRQ bar, line and legend in
DELTA chart become invisible.

If you resize the screen to reduce the width, at certain point, legend is hidden to give
more space to lines and bars.

Figure 4-650: Auto hidden chart legend

If you resize the view to even smaller width, the lines are hidden to show only bars.
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Figure 4-651: Auto hidden chart legend and line graph

If you increase the width of the view, the line and legend are restored if they are so
configured.

4.4.23.1  Charts and legend

Chart
The view contains four signal charts and a DELTA chart. A chart has bars and lines.

Figure 4-652: Single chart display

For each displayed chart, the view shows a bar graph in the left pane and line graph in
the right pane. The user can configure the size of the screen taken up by a graph on
the view. Click the size bar of a signal and drag the mouse to either increase or
decrease the size.
The width change is done for all bars or lines. The user cannot resize the width of an
individual bar or line.
A chart has a title displayed vertically on the left of the chart. If the chart does not have
enough space to show the entire title, ellipsis is displayed at the end.

Figure 4-653: Condensed chart title
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You can hide bars, lines or legend in configuration bar using the "Show Graph" prop-
erty.

Figure 4-654: Chart selection

Three values are available in the "Show Graph" drop-down box.
● "Both" - show both bars and lines (default)
● "Bar Graph" - show bars only
● "Line Graph" - show lines only

Signal Charts
The RSSI, RSRP, RSRQ, SINR are signal charts.
For chart RSSI and RSRP, the bar and line graphs show power levels in [dBm] for PCC
and SCC1 to SCC8 for LTE. For "5G- NR" carrier selection, RSRP power levels are
shown for PSCell component carrier and component carriers of up to 11 SCells.
For chart RSRQ and SINR, the bar and line graphs show power ratios in [dB] for PCC,
SCC1 to SCC8 for LTE. For "5G- NR" carrier selection, power ratios are shown for
PSCell component carrier and component carriers of up to 11 SCells.

DELTA Chart
"DELTA" chart shows the signal differences. In the chart, the bar and line graphs show
differences of the four values that are associated with charts RSSI (LTE only), RSRP,
RSRQ and SINR.
The value for a line or a bar in DELTA chart is the difference between the maximum
and minimum values of the corresponding signals.
For example, measured LTE SINR signal values in an instant of time are PCell = 33,
SCell1 = 22, SCell2 = 32, SCell3 to SCell 8 = no value. The max is 33 and min is 22.
So, the SINR value in "DELTA" chart at the given time is 11 (33 – 22 = 11).
The value in "DELTA" chart is valid if and only if at least two signal values of PCell/
PSCell and SCell1 to SCell8/SCell1 to SCell11(LTE /5G NR) are available and valid.
If the two valid values are not found at a given time, line and bar graph are empty in
"DELTA" chart at that time. The following figure shows an empty "DELTA" chart,
because only one signal, PCell, is available.
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Figure 4-655: Empty DELTA chart

Legend
Legend is by default shown on the right side of the view.
The following figure shows the legends for signal RSSI and Delta charts.

Figure 4-656: Legend for signal and DELTA charts

Other signal legends are similar. For signal charts, individual bar and line can be hid-
den by clearing the corresponding legend check boxes.
The DELTA legend does not have check boxes. The lines and bars for "DELTA" chart
are associated with signal charts, RSSI, RSRP, RSRQ and SINR. You are not sup-
posed to activate/deactivate those bar-/line-series using DELTA legend check boxes.

Figure 4-657: DELTA chart properties

For the same reason, DELTA properties bar does not have the "Show" properties for
each individual series to show or hide the DELTA series.
The legend can be entirely hidden to make more space for bars or lines by clearing the
"Show Legend" check box.
If the list of all properties in the legend cannot be displayed due to screen size con-
straints, you can use an up and down arrow to access the non-displayed items.
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Figure 4-658: Legends scroll arrows

Click the arrow to scroll the list up and down accordingly.

4.4.23.2  Replay and measurement display items

During replay and measurement the following items are available.

Moving the mouse over the line graph shows the power levels for each component car-
rier represented by the current mouse location.

Figure 4-659: Mouse over display data

The bar shows the values for the current time within the measurement or replay.

Figure 4-660: Bar chart values

Within the line graph, the current time stamp of the measurement is represented by a
solid vertical black line. The approach is the same as in the "UE CA Downlink Perfor-
mance View".

While a replay of a measurement is paused, double click at any point within the line
graph rewinds or advances the replay file to that point. All other synced views are also
advanced to that point.

If you scroll on any one X-axis of the line graphs, the X-axes of the other displayed line
graphs scroll the same amount.

If you attempt to scroll the X-axis to a point in the measurement where the current cur-
sor (solid black line) cannot be displayed during replay and measurement, the view
automatically scrolls the line graph back to a point where the current cursor can be dis-
played. This behavior can be changed in configuration, see the configuration section
for details.
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You can scroll the Y-axis (power levels) of the power and line graph by clicking the
scroll bar on the line graph. Move the mouse up and down. The Y-axis can be adjusted
for each signal independently.

The thickness of the cursor and other lines in the line graph can be changed by clicking
the "Show Thick Line" property in "UE Carrier Aggregation View Properties".

Figure 4-661: Line chart thickness property

Zoom to Fit
The "Zoom to Fit" feature sets the Y-axis minimum and maximum automatically, so that
all lines and bars are displayed properly using the available chart space.

Figure 4-662: Zoom to fit

The following buttons for the feature are available in configuration bar:
● "Reset Zoom"

Click  to reset the Y-axis min and max to the default values in configuration.
● "Zoom To Fit"

Click  to recalculate the Y-axis min and max to show the lines/bars with all availa-
ble chart spaces.

Hovering mouse over the icons displays the function of the associated icon.

Auto Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is checked, the Auto Zoom mode is active. This
zoom mode is useful during measurement or replay.
In Auto Zoom mode, when a new value that is outside of the current Y-axis scope
enters the display, the Y-axis range is reconfigured. The new value is shown in the
chart properly after reconfiguration.
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Note: The Y-axis is not reconfigured if the maximum or minimum value goes out of cur-
rent display.
If you change the Y-axis or zoom-in to a line using mouse wheel in Auto Zoom mode,
the mode turns off.
Click "Auto Zoom To Fit" icon to resume the Auto Zoom mode. The min and max value
settings of Y-axis in configuration bar are disabled.

Figure 4-663: Y-axis configuration disabled by Auto Zoom to Fit

Manual Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is cleared, the Auto Zoom mode is deactivated.
The default configured Y-axis min and max settings are used.
Click the "Zoom To Fit" icon to zoom to fit the charts.
In this mode, the min and max value settings of Y-axis in configuration bar is enabled.

4.4.23.3  UE carrier aggregation view configuration

Click the "UE Carrier Aggregation View Properties" tab, which is by default located in
the upper right portion of the view, to access the configuration.

If the tab is not visible, it can be recovered by right mouse-button click any point in the
"UE Carrier Aggregation View" and selecting "Properties" in the drop-down menu.

By clicking the tab, a configuration item can be changed. The tab automatically hides
itself if another item on the screen is clicked. The configuration properties can be pin-
ned to the screen. To do that, click the pin icon of the "UE Carrier Aggregation View
Properties" panel. The properties panel is displayed always when the view is active.
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Figure 4-664: UE Carrier Aggregation View properties bar

Once the properties panel is pinned, it can be undocked from the view and made float-
ing. To do undocking, double click the title bar of the properties panel or single click the
title bar and drag the panel out of the view.

Drag the panel to the left, right, top or bottom of the view to redock the properties
panel. Drag the panel to the display arrows to dock the panel to the desired location on
the view.

Figure 4-665: Redocking the properties panel

The properties configured are saved when the workspace or measurement file is
saved.

Three buttons are available within the properties panel.
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Figure 4-666: Available buttons in properties panel

Apart from the buttons "Reset Zoom" and "Zoom To Fit", there is the "Restore All Val-
ues" button. The associated icon is . Click the button to restore all properties to the
values existed when the view was first started. If a workspace/measurement file is loa-
ded, the setting reverts to the values from the file. Any individual setting can be rever-
ted by right mouse click the setting and choosing "Reset Value".

Properties available in the view - global

The following properties are available for selection in the view.

Update Rate in MS
The number of milliseconds between the bar and the line graph display updates during
a measurement or replay. This update is done to help with system performance. The
lower the number the more frequent the screen refresh during measurement or replay,
therefore slowing overall system performance. A value of zero refreshes the screen
every time a new data point is received.

Lock Axis
Unchecked, this configuration property allows scrolling the X-axis of each line graph
independently. X-axes of all line graphs are scrolled together if the property is checked.

Track Axis
Unchecked, this configuration allows scrolling the line graph outside of the current cur-
sor during replay. If checked, always returns to X-axis of the line graph back to the cur-
rent cursor.

Properties available in the view

X Axis Span is S
Time in second to display on the line graph X-axis.

Show Graph
The "Show Graph" drop box contains three possible values to choose.
● "Both" - show both bars and lines (default)
● "Bar Graph" - show bars only
● "Line Graph" - show lines only

Show Chart Legend
If unchecked, this configuration property hides the legend. It is checked by default to
show a chart legend.

Auto Zoom To Fit
Check "Auto Zoom To Fit" to activate the automatic zoom mode to fit Y axis when mea-
suring or replaying. Unchecked, the mode is deactivated.
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Properties available in the view - y axis

RSSI Minimum Value
Minimum power level value to display on the Y-axis of the RSSI chart.

RSSI Maximum Value
Maximum power level value to display on the Y-axis of the RSSI chart.

RSRP Minimum Value
Minimum power level value to display on the Y-axis of the RSRP chart.

RSRP Maximum Value
Maximum power level value to display on the Y-axis of the RSRP chart.

RSRQ Minimum Value
Minimum power level value to display on the Y-axis of the RSRQ chart.

RSRQ Maximum Value
Maximum power level value to display on the Y-axis of the RSRQ chart.

SINR Minimum Value
Minimum power level value to display on the Y-axis of the SINR chart.

SINR Maximum Value
Maximum power level value to display on the Y-axis of the SINR chart.

DELTA Minimum Value
Minimum power level value to display on the Y-axis of the DELTA chart.

DELTA Maximum Value
Maximum power level value to display on the Y-axis of the DELTA chart.

Zoom Option
The setting changes the way how the zoom control works for the line graph.
● "None"

No zoom control for the charts is enabled.
● "Mouse Wheel & Pan"

Zoom the chart by using the mouse wheel
● "Magnify"

Allow for zoom; the left mouse button click the line graph to zoom in, the right
mouse button to zoom out.

● "Selection"
Allow a specific location to be zoomed into by selecting an area with mouse.

Show Data Points
Allows changing the view so that when the mouse is moved over the line graph the
individual antenna power levels are not shown.
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Cursor Color
Allows changing the color of the cursor that indicates the current time in the measure-
ment or replay.

PSCell Color/SCCell1 Color to SCCell8 Color
Allows changing the color that represents this item in the bar and graph charts ("Car-
rier" LTE).

PSCell Color/SCell1 Color to SCell11Color
Allows changing the color that represents this item in the bar and graph charts ("Car-
rier" 5G-NR).

RSSI

Show
Show signal for this type.

PCell, SCell1 to SCell8
Show signal strength on antenna for this signal.

RSRP

Show
Show signal of this type.

PCell, SCell1 to SCell8
Show reference signal strength on antenna for this carrier (LTE).

PSCell, SCell1 to SCell11
Show reference signal strength on antenna for this carrier (5G-NR).

RSRQ

Show
Show signal of this type.

PCell, SCell1 to SCell8
Show reference signal quality for this carrier (LTE).

PSCell, SCell1 to SCell11
Show reference signal quality for this carrier (5G-NR).

SINR

Show
Show signal of this type.
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PCell, SCell1 to SCell8
Show reference signal quality for this carrier (LTE).

PSCell, SCell1 to SCell11
Show reference signal quality for this carrier (5G-NR).

DELTA

Show
Show signal of this type.

4.4.24  UE MIMO view

The "UE MIMO View" offers a quick overview of all LTE and 5G NR component carrier
cells. The provided information types are the same for both technologies.

Figure 4-667: UE MIMO view - MIMO Layer, RI, RSRP, RSRQ, SINR sections

The view fully supports LTE and 5G NR technologies. It lets you select for display one
out of 9 LTE carriers ("LTE PCC" or "LTE SCC1" to "LTE SCC8") and one out of 12 5G
NR carriers ("5G NR PCC" and "5G NR SCC1" to "5G NR SCC11"). To select carrier
for display, use the "Carrier" drop-down box.
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There are some preconditions that have to be noticed in 5G NR:
● Create the measurement file with the current version. Older measurement files do

not show the complete content.
● Exynos chipsets

The minimal required ICD version is 6.12.
● Qualcomm chipsets

– RSRQ per antenna is not supported.
– RSRP is supported for two antennas only.
– RSSI log is switched off by default as this log generates a high load on the UE.

It can be switched on in the UEs configuration page.

Figure 4-668: Extra settings for Qualcomm chipset based device

The MIMO Layer, RI, RSRP, RSRQ and SINR sections can be shown or hidden. The
configuration if to be shown or not is done in the "UE MIMO View Properties" window.
Check or uncheck the "Show" property next to a corresponding section name.
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Figure 4-669: UE MIMO view properties

4.4.24.1  Charts and legend

Chart
UE MIMO view contains six signal charts.
A chart has bars and lines.
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Figure 4-670: UE MIMO view - chart

For each displayed chart, the view displays a bar graph in the left pane and line graph
in the right pane. You can configure the size of the screen taken up by a graph on the
view. Click the size bar of a signal and drag the mouse to either increase or decrease
the size.
The width change is done for all bars or lines. The user cannot resize the width of an
individual bar or line.
A chart has a title displayed vertically on the left of the chart. If the chart does not have
enough space to show the entire title, ellipsis is displayed at the end.
User can hide bars, lines or legend in configuration bar using the "Show Graph" prop-
erty.

Figure 4-671: Show graph options

Three values are available in the "Show Graph" drop-down box.
● "Both" - show both bars and lines (default)
● "Bar Graph" - show bars only
● "Line Graph" - show lines only

Signal Charts
The MIMO Layer, RI, RSSI, RSRP, RSRQ, SINR are signal charts.
In the all charts, the bar and line graphs show values for:
● Primary and four secondary LTE cells
● Primary secondary 5G NR cell and four secondary 5G NR cells

Legend
Legend, by default, is shown on the right side of the view. The following figure shows
the signal legends for RSSI chart. Other signal legends are similar.

Figure 4-672: Chart legend for RSSI
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The individual bar and line can be hidden by clearing the corresponding legend check
boxes.
The legend can be entirely hidden to make more space for bars or lines by clearing the
"Show Legend" check box in "UE MIMO View Properties".

Figure 4-673: Show legend options

If the list of all options in the legend cannot be displayed due to screen size con-
straints, use one up and down arrow to access the non-displayed items.

Figure 4-674: Legends scroll arrows

Click the arrow to scroll the list up and down accordingly.

4.4.24.2  Replay and measurement display items

During the replay and measurement, the following items are available.

Moving the mouse over the line graph shows the power levels for each antenna repre-
sented by the current mouse location.

Figure 4-675: Box showing the power levels

The bars show the power levels for the current time within the measurement or replay.
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Figure 4-676: Bar showing the power levels

Within the line graph, a solid black line shows the current time stamp of the measure-
ment.

Figure 4-677: Vertical solid black line

While a replay of a measurement is paused, double clicking any point within the line
graph rewinds or advances the replay file to that point. All other synced views are also
advanced to that point.

If you scroll on any one X-axis of the line graphs, the X-axes of the other displayed line
graphs scroll the same amount.

If you attempt to scroll the X-axis to a point in the measurement where the current cur-
sor (solid black line) cannot be displayed during replay and measurement, the view
automatically scrolls the line graph back to a point where the current cursor can be dis-
played. This behavior can be changed in configuration, see the configuration section
for details.

You can also scroll the Y-axis (power levels) of the power and line graph by clicking the
scroll bar on the line graph and moving the mouse up and down. The Y-axis can be
adjusted for each signal independently.

The thickness of the cursor and other lines in the line graph can be changed by clicking
the "Show Thick Line" options in the UE MIMO properties view bar, see the following
figure.

Figure 4-678: Line thickness options
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Zoom to Fit
The "Zoom to Fit" feature sets the Y-axis minimum and maximum automatically, so that
all lines and bars are displayed properly using the available chart space.

Figure 4-679: Zoom to fit

The following buttons for the feature are available in configuration bar:
● "Reset Zoom"

Click  to reset the Y-axis min and max to the default values in configuration.
● "Zoom To Fit"

Click  to recalculate the Y-axis min and max to show the lines/bars with all availa-
ble chart spaces.
See Figure 4-685 for the configuration bar.

Hovering mouse over the icons displays the function of the associated icon.

Auto Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is checked, the Auto Zoom mode is active. This
zoom mode is useful during measurement or replay.
In Auto Zoom mode, when a new value that is outside of the current Y-axis scope
enters the display, the Y-axis range is reconfigured. The new value is shown in the
chart properly after the reconfiguration.
Note: The Y-axis is not reconfigured if the maximum or minimum value goes out of cur-
rent display.
If you change the Y-axis or zoom-in to a line using mouse wheel in Auto Zoom mode,
the mode turns off.
Click "Zoom To Fit" icon to resume the Auto Zoom mode. The min and max value set-
tings of Y-axis in configuration bar is disabled.
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Figure 4-680: Y-axis configuration disabled in Auto Zoom to Fit mode

Manual Zoom to Fit ← Zoom to Fit
If the "Auto Zoom To Fit" check box is cleared, the Auto Zoom mode is deactivated.
The default configured Y-axis min and max settings are used.
Click the "Zoom To Fit" icon to zoom to fit the charts.
In this mode, the min and max value settings of Y-axis in configuration bar is enabled.

Figure 4-681: Auto Zoom To Fit deactivated

4.4.24.3  UE MIMO view configuration

To access the configuration, click the "UE MIMO View Properties" tab located by
default in the upper right portion of the view.
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Figure 4-682: UE MIMO View Properties tab

If the tab is not visible, it can be recovered by right mouse-button click any point in the
"UE MIMO View" and selecting "Properties" in the drop-down menu.

By clicking the tab, a configuration item can be changed. The tab automatically hides
itself if another item on the screen is clicked. The configuration properties can be pin-
ned to the screen. To do that, click the pin icon in the "UE MIMO View Properties"
panel. The properties panel is displayed always when the view is active.

Once the options panel is pinned, it can be undocked from the view and made floating.
To do undocking, double click the title bar of the options panel or single click the title
bar and drag the panel off of the view.

Figure 4-683: Undocked options panel

The options panel can be redocked to the view. Drag the panel to the left, right, top or
bottom of the view. To dock the panel to the desired location on the view, drag the
panel to the display arrows.
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Figure 4-684: Redocking the options panel

The properties configured are saved when the workspace or measurement file is
saved.

Three buttons are available within the properties panel.

Figure 4-685: Available buttons in properties panel

Apart from the buttons "Reset Zoom" and "Zoom To Fit", there is the "Restore All Val-
ues" button. The associated icon is . Click the button to restore all properties to the
values existed when the view was first started. If a workspace/measurement file is loa-
ded, the setting reverts the values from the file. Any individual setting can be reverted
by right mouse click the setting and choosing "Reset Value".

Properties available in the view - global

The following properties are available for selection in the view.

Currently Selected Tab
This setting sets the default selected tab when R&S ROMES4 starts.

Update Rate in MS
The number of milliseconds between the bar and the line graph display updates during
a measurement or replay. This update is done to help with system performance. The
lower the number the more frequent the screen refresh during measurement or replay,
therefore slowing overall system performance. A value of zero refreshes the screen
every time a new data point is received.

Lock Axis
Unchecked, this configuration property allows scrolling the X-axis of each line graph
independently. X-axes of all line graphs are scrolled together if the property is checked.

Track Axis
Unchecked, this configuration allows scrolling the line graph outside of the current cur-
sor during replay. If checked, always returns to X-axis of the line graph back to the cur-
rent cursor.
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X Axis Span is S
Time in second to display on the line graph X-axis.

Show Graph
Indicate which graph to be shown. The "Show Graph" drop box contains three possible
values to choose.
● "Both" - show both bars and lines (default)
● "Bar Graph" - show bars only
● "Line Graph" - show lines only

Show Chart Legend
If unchecked, this configuration property hides the legend. It is checked by default to
show a chart legend.

Auto Zoom To Fit
Automatic zoom to fit Y Axis when measuring or replaying
Check "Auto Zoom To Fit" to activate the Auto Zoom mode.
Clear "Auto Zoom To Fit" to deactivate this mode.
Check "Auto Zoom To Fit" to activate the automatic zoom mode to fit Y axis when mea-
suring or replaying. Unchecked, the mode is deactivated.

Y Axis
 

RSSI Minimum Value ← Y Axis
Minimum power level value to display on the Y-axis of the RSSI chart.

RSSI Maximum Value ← Y Axis
Maximum power level value to display on the Y-axis of the RSSI chart.

RSRP Minimum Value ← Y Axis
Minimum power level value to display on the Y-axis of the RSRP chart.

RSRP Maximum Value ← Y Axis
Maximum power level value to display on the Y-axis of the RSRP chart.

RSRQ Minimum Value ← Y Axis
Minimum power level value to display on the Y-axis of the RSRQ chart.

RSRQ Maximum Value ← Y Axis
Maximum power level value to display on the Y-axis of the RSRQ chart.

SINR Minimum Value ← Y Axis
Minimum power level value to display on the Y-axis of the SINR chart.

SINR Maximum Value ← Y Axis
Maximum power level value to display on the Y-axis of the SINR chart.
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Zoom Property
The way how the zoom control works for the line graph.
● "None"

Zoom control for the charts is inactive.
● "Mouse Wheel & Pan"

Zoom the chart by using the mouse wheel.
● "Magnify"

Allow for zoom; the left mouse button click the line graph to zoom in, the right
mouse button to zoom out.

● "Selection"
Allow a specific location to be zoomed into by selecting an area with mouse.

Show Data Points
Allows changing the view so that when the mouse is moved over the line graph the
individual antenna power levels are not shown.

Cursor Color
Allows changing the color of the cursor that indicates the current time in the measure-
ment or replay.

Rx0 Color to Rx3 Color
Allows changing the color that represents this item in the bar and graph charts.

Properties available in the view - MIMO layer

Show signal of MIMO layer type.

ML1, ML2, ML3, ML4, AVG Shown
Show MIMO layers signal and its average.

Properties available in the view - RI

Show signal type Rank Indicator.

RI1, RI2, RI3, RI4 Shown
Show signals of this type.

Properties available in the view - RSSI

Show
Show signal for this type.

Rx0, Rx1, Rx2, Rx3 Shown
Show antenna for this signal.

Properties available in the view - RSRP

Show
Show signal value of this type.
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Rx0, Rx1, Rx2, Rx3 Show
Show for this antenna reference signal received power.

Properties available in the view - RSRQ

Show
Show signal value of this type.

Rx0, Rx1, Rx2, Rx3 Shown
Show for this antenna reference signal received quality.

Properties available in the view - SINR

Show
Show signal of this type.

Rx0, Rx1, Rx2, Rx3 Shown
Show for this antenna signal to noise and interference.

4.4.25  UE modulation view

The "UE Modulation View" makes possible the 5G NR and LTE measurement analysis
from a single view. The view is derived from the former "LTE Modulation View".

The view is launched from the R&S ROMES4 menu "View" > "Mobile Views" > "UE".
The view can also be launched from the context pop-up menu by right mouse button
clicking the empty view area.

The "UE Modulation View" tracks the uplink and downlink modulation values of all LTE
carriers and of all 5G NR carriers.
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Figure 4-686: Default UE Modulation View

The "Carrier" drop-down box lets you select for display these values of LTE primary cell
("LTE PCell") and up to 8 secondary cells ("LTE SCellx", where x = 1 to 8) or of 5G NR
primary secondary cell ("5G NR PSCell") and up to 11 %G NR secondary cells("5G NR
Scellx").

The view contains two sections:
● Downlink section shows modulation for downlink signal per selected carrier type.
● Uplink section shows modulation for uplink signals per selected carrier type.

Each section can be configured to be shown or not from the "UE Modulation View
Properties" panel. Check or uncheck the "Show" property next to corresponding sec-
tion name.

Properties are by default located on the right side of the "UE Modulation View".

In each section displayed is a current value column that shows the modulation signal
percentage (based on 100%) for a given time in the measurement file. An over time
graph chart that shows modulation percentages over the life of the measurement file is
displayed on the left-hand side of the chart.

You can configure the size of the view taken up by a section. Click the horizontal size
bar that divides "Downlink" and "Uplink" section and drag the mouse to either increase
or decrease the size.

Tracked signals

The view tracks the following signals.

● LTE PCell - Downlink
PDSCH – QSPK Rate/16QAM Rate/64QAM Rate/256QAM Rate
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● LTE PCell - Uplink
PUSCH – QSPK Rate/16QAM Rate/64QAM Rate

● LTE SCellx - Downlink, x = 1 to 8 secondary component carriers
PDSCH – QSPK Rate/16QAM Rate/64QAM Rate/256QAM Rate

● LTE SCellx - Uplink, x = 1 to 8 secondary component carriers
SCCn PUSCH – QSPK Rate/16QAM Rate/64QAM Rate

4.4.25.1  Replay and measurement display items

During replay and measurement, the following items are available.

Moving the mouse over the time graph shows the values that are present at that point
in time.

Figure 4-687: Mouse hovering over data

Tooltips are displayed in the upper left section of each chart. When the mouse is
moved over the chart the Tooltip information box in the upper left of the chart displays
the current value for all chart elements. If the mouse leaves the chart, the Tooltip box is
no longer displayed.

Figure 4-688: Tooltip for UE Modulation View

Within the time chart, a solid vertical black line represents the current time stamp of the
measurement.
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Figure 4-689: Black line showing current cursor

While a replay of a measurement is paused, double clicking any point within the line
graph rewinds or advances the replay file to that point. All other synced views are also
advanced to that point.

You can scroll along the time axis by clicking, holding and then moving the mouse on
the scroll bar on the bottom chart.

Also, you can scroll the time axis by clicking, holding and then moving the mouse on
any of the displayed charts. If you attempt to scroll the time axis to a point in the mea-
surement where the current cursor (solid black line) cannot be displayed during replay
and measurement, the view automatically scrolls the line graph back to a point where
the current cursor can be displayed. This behavior can be changed in configuration.

During the replay, you can also zoom in on the time-axis by using the mouse wheel or
by using touch pinch and zoom gestures.

4.4.25.2  UE modulation view configuration

The configuration for the view can be accessed by clicking the "UE Modulation View
Properties" bar. The tab is by default located in the upper right portion of the view.

Click the bar to open the properties panel and to change some configurations. The
panel automatically hides itself when another item on the screen is clicked.

The configuration properties can be pinned to the screen by clicking the pin icon the
properties panel. The properties panel is displayed as long as the view is active.
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Figure 4-690: UE Modulation View properties

If this pane is not visible, it can be recovered by right mouse-button click any point in
the "UE Modulation View" and selecting "Properties" in the drop-down menu.
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Figure 4-691: UE Modulation View docking options

Properties available in the view - global

The following properties are available for changing in the view.

Update Rate in MS
The number of milliseconds between the bar and the line graph display updates during
a measurement or replay. This update is done to help with system performance. The
lower the number the more frequent the screen refresh during measurement or replay,
therefore slowing overall system performance. A value of zero refreshes the screen
every time a new data point is received.

Lock Axis
Unchecked, this configuration property allows scrolling the X-axis of each line graph
independently. X-axes of all line graphs are scrolled together if the property is checked.

Track Axis
Unchecked, this configuration allows scrolling the line graph outside of the current cur-
sor during replay. If checked, always returns to X-axis of the line graph back to the cur-
rent cursor.

X Axis Span is S
Time in second to display on the line graph X-axis.

Show Graph
The "Show Graph" drop box contains three possible values to choose.
● "Both" - show both column and area graphs (default)
● "Column Graph" - show current value
● "Line Graph" - show values over time

Show Chart Legend
If unchecked, this configuration property hides the legend. It is checked by default to
show a chart legend.
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Zoom Option
The setting changes the way how the zoom control works for the line graph.
● "None"

No zoom control for the charts is enabled.
● "Mouse Wheel & Pan"

Zoom the chart by using the mouse wheel
● "Magnify"

Allow for zoom; the left mouse button click the line graph to zoom in, the right
mouse button to zoom out.

● "Selection"
Allow a specific location to be zoomed into by selecting an area with mouse.

Show Data Points
Allows changing the view so that when the mouse is moved over the line graph the
individual antenna power levels are not shown.

Cursor Color
Allows changing the color of the cursor that indicates the current time in the measure-
ment or replay.

Downlink Show
Show or hide the downlink section for the current carrier.

Uplink Show
Show or hide the uplink section for the current carrier.

4.5  CW views

The "CW Views" offers only the "Alphanumeric View for CW".

Figure 4-692: CW views

Click the entry to get the alphanumeric view for CW

Figure 4-693: Alphanumeric view for CW of the selected measurements
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Click any point in the "Alphanumeric View for CW" to get the view's configuration page.
In the drop-down menu select the "Configuration" entry. The displayed opening "Val-
ues" tab offers signals available for display in the view.

The following screenshot shows the CW view configuration page and the selection of
the signals. The "Settings" tab allows you to select coloring for the selected signals
when displayed in the view. Refer also to Chapter 4.2.3, "Alphanumeric view",
on page 466.

Figure 4-694: CW view configuration page

4.6  QoS views

The "QoS Views" display the test results obtained by the R&S data quality tester,
named R&S ROMES4DQA. The purpose of the DQA measurement is to evaluate the
Quality of Service (QoS) of any kind of data transfer connection.

DQA measurements are performed using the DQA tester (see chapter 6, Devices).
Loading the tester does not require any hardware or additional test devices. An exam-
ple procedure for setting up and testing a connection is described in chapter Chap-
ter 2.2.1, "Test mobiles", on page 72.

Many of the QoS results can also be displayed in other R&S ROMES4 views, for
example, in the "Alphanumeric View", "2D Chart View" and "ROMESMAP Route Track
View".

The QoS views can be selected from a submenu displayed on the right side of the
"View" menu when the mouse pauses over "QoS Views".
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Figure 4-695: QoS views

4.6.1  QoS SQA view

The QoS SQA view displays the results of the speech quality analysis (SQA).

The SQA -Voice Quality PESQ needs the R&S ROMES4 SQA option.

The view can be accessed from a submenu displayed on the right side of the "View"
menu when the mouse pauses over "SQA" entry.

Figure 4-696: QoS SQA view selection

4.6.1.1  SQA message view

The "SQA Message View" shows the progress of the test. It displays the state of the
measurement engine and also the values of the done measurements.

To obtain results for the "SQA Message View", the SQA must be enabled and config-
ured using the "Speech Quality" tab of the test mobile devices. For a detailed descrip-
tion of the device configuration, the SQA procedure and the test setup, see Chap-
ter 6.4.12.3, "Configuration – speech quality", on page 1689.

SQA is provided for different mobile types and the 3GPP specified technologies.
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If an audio file is recorded for a certain MOS value, the corresponding line is written in
blue. By using the context menu, the user is able to listen and/or export the degraded
audio file.

In addition to the results in the "SQA Message View", R&S ROMES4 generates a wide
range of SQA signals.
The signals are under the "SQA Tester" node of the signal tree (to get it, click "Tools" >
"Preferences" > "Available Signals").
You can analyze the signals in one of the basic views. For example, you can see the
PESQ score in a series of consecutive loops and calculate average, minimum and
maximum values in the "Statistic Histogram View".
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Figure 4-697: SQA Message View
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Example: 
The SQA message view of the speech quality measurement results made with smart-
phone

Figure 4-698: SQA message view measurement results with smartphone

The possible prefixes in the "SQA Message View" are explained in the following table.
Table 4-28: SQA message view prefixes

Prefix Description

[A] A-Party Mobile: The mobile which is configured for speech quality.

[B] B-Party Mobile: The mobile which is configured as a B-Party.

[L] Land Unit: After having merged the land unit files into the measurement file, these messages
appear in the same view as the [A] messages do.

For more information on Land Unit, see "Measurement setup with land unit as B-Party"
on page 1672.

SQA measurement explanation

An SQA measurement consists of a specified number of test loops. In each test loop,
R&S ROMES4 uploads or downloads voice data for a specified duration and calculates
the PESQ score according to ITU-T recommendation P.862. An offset time precedes
each data transfer. Moreover the individual loops are separated by a pause time. All
timing parameters can be set in the device configuration menu; for the configuration
see Chapter 6.4.12.2, "SQA settings", on page 1684.
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The interval between two consecutive PESQ evaluations is calculated as a sum of a
sample length, end pause and delay (EWMA), as shown in the following figure. The
delay is adjusted with each new PESQ calculation.

Figure 4-699: SQA timing intervals

In case shown in the Figure 4-699, initial pause is for downlink set to 11300 ms and the
sample duration is 8402 ms. The first PESQ evaluation is obtained after 11300 ms +
8402 ms + 0 ms = 19 702 ms. In the equation the value 0 ms is the configured offset,
i.e delay at the beginning of SQA measurement with reference file.

The second PESQ evaluation referring to the first one happens after 2500 ms + 8402
ms + 286 ms = 11188 ms. The third PESQ evaluation happens after 11188 ms + 2500
ms + 8402 ms +58 ms = 22148 ms, and so on. In the equation the value 2500 ms is
the configured downlink end pause between two consecutive PESQ evaluations.

For definition of the timing parameters, see "SQA settings dialog" on page 1686.
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The following figure shows a low confidence SQA message, due to not trusted reliabil-
ity check.

Figure 4-700: Low confidence SQA message

SQA messages

The "SQA Message View" contains a chronological record of the generated SQA mes-
sages. An SQA message either describes an event (i.e. the beginning of a particular
stage of the measurement), a measurement result, or an error. The messages depend
on the measurement mode (download, upload). The basic events and results are
repeated for each loop.

Degraded voice samples are stored in the *.rscmd measurement file if selected in the
SQA configuration. When the voice sample was stored in the *.rscmd file, the line
with the measurement value is marked blue.

Context menu of a selected voice sample

It is possible to select/de-select the view for hold, copy the current view to the clipboard
and create views, see Chapter 4.1.3, "Context menu", on page 429.
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To open the context sensitive menu of the SQA View, mark the line of the voice sample
and a right mouse click.

To replay the selected voice sample, click "Play degraded wav file".

To export the selected voice, click "Export degraded wav file".

To export all wave files of a device, click "Export all degraded wav files". If this option is
selected, R&S ROMES4 stores the files in the export folder named as the currently loa-
ded measurement file. The wave files' names include the device name and a counting
index. The following figure shows a result of an export.

Figure 4-701: Files export result

Export all degraded wave files

Create a logfile holding meta info to the all wave file export

A file is generated, holding some meta data for the all wave file export.

This file is generated automatically at .\My ROMES\ExportResult\<RSCMD_name>\

The name is ExportAllWav_<SQAname>_<mobileName>_.txt.

For example, ExportAllWav_SQA[1]_STP8000[1]_.txt

Example: 
Case: One data set
#Meta data for 
.\My ROMES\ExportResult\<Tetra Alternate 5\2017.05.22_335325ms_SQA[1]
_STP8000[1]__OK.wav
Timestamp: 2017.05.22;10:21:31.937
Coordinates: 48.15310000 11.64410000 6400m
Model: SQA[1]<STP8000[1]> 
Version: ROMES 4.50
Origin: D:\TetraAlternate5.rscmd

Naming of the export wave files

Exporting all WAV files ("SQA Messsage View" > Context menu > "Export all degraded
wav files") names the files as

<Date>_<Time>_<SQA[2]_STP9000[3]_OK.wav
For example,
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2017.05.22_155331ms_SQA[2]_STP9000[2]__OK.wav or

2017.05.22_14:15:16.789_SQA[2]_STP9000[2]__OK.wav, which gives more
information at a glance.

Events and results: downlink

● Entering loop <nr>
Start time of the loop, beginning of the transferred file. The actual data transfer
starts after the "Offset" defined in the configuration menu. The system waits until
enough data have been transferred to start the PESQ evaluation.

● Performing PESQ evaluation
Start time of the PESQ evaluation in the current loop.

● Resulting delays: ...
Time delay between reference file and acquired sample in ms. Different network
signaling for sending and receiving mobile and the speech codec can introduce
variable delays within the sample; therefore the PESQ result contains the mini-
mum, average, and maximum delay. If the average delay exceeds 30 ms, the sys-
tem corrects the timing and repeats the PESQ evaluation.

● PESQ Result
Offset between the start of the loop and the calculation of the result. The offset
includes the transmission time through the communication system; it is not identical
to the offset defined in the device configuration menu. The PESQ P862.1 result is
the calculated PESQ score which is converted to a scale between 1 and approx.
4.55; see Table 4-29 and the following background information.

● Searching for next valid sample data
The PESQ evaluation failed or crashed in a first attempt, however, the system tries
to repeat the evaluation in the current loop with a shifted evaluation interval.

● Repeating this sample using new delay information
The PESQ evaluation failed or crashed in a first attempt, the delay between the
acquired sample and the reference file was larger than 30 ms. The system tries to
repeat the evaluation in the current loop with a shifted evaluation interval.

● Using new delay information for next sample
The delay between the acquired sample and the reference file was larger than 30
ms. Therefore, the evaluation of the current sample cannot be repeated (e.g.
because the beginning of the sample was lost). The system tries to synchronize to
the next sample (next loop) using the delay information; the PESQ result in the cur-
rent loop is omitted.

● Waiting until data threshold is reached
Audio data is acquired (recorded) until the length of the recorded sample is identi-
cal to the length of the reference sample.

Events and results: uplink

● Playing initial silence
Initial pause before the start of the first loop (loop 0). The length of the initial pause
is defined in the device configuration menu.

● Playing sample
The loop was started; the sample file (play file) is being played.
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● Playing silence between samples
Pause time between two consecutive loops of the sample file (play file).

Errors: downlink

● PESQ evaluation failed
The system could not determine a PESQ result. The reason can be, for example,
because the delay between the acquired sample and the reference file was too
large, or because the two files were hardly correlated. The PESQ evaluation is
repeated with a shifted evaluation interval until the end of the loop is reached.

● PESQ evaluation crashed…
The system crashed during the PESQ evaluation (possible reason see above). The
PESQ evaluation is repeated with a shifted evaluation interval until the end of the
loop is reached.

● Abort requested
The measurement was aborted.

Errors: uplink

● Abort requested
The measurement was aborted.

Correction of low PESQ values

The SQA device introduced in R&S ROMES4 4.69 was performing SQA measure-
ments based on the PESQ algorithm synchronized to the incoming signal. The syn-
chronization however was performed in a per-call basis, which means that with each
new call all calculations were performed all over. Repeating the calculation leds to rela-
tively low PESQ values at the beginning of each call, since the PESQ algorithm inter-
preted the large delay as a perceptual quality loss.

The problem of relatively low PESQ values at the beginning of a call is solved by trans-
ferring the estimated delay information from call to call. In this way achieved is better
delay estimation overall. Also, some stability and safety issues are improved to avoid
problems while using the SQA tester.

In some rare occasions unexpected low PESQ values were observed at the end of the
call as well. Two causes were identified.

The first cause is due to an error when the SQA configuration calculates the number of
loops that could fit inside the call window.

The second cause of low PESQ values is when performing the SQA measurements
during TETRA group calls. It was observed, that group calls were held by the network
much longer after the call is released by the initiating party.

This problem is solved by adding the function "Loop as much as possible" to the SQA,
see "SQA settings dialog" on page 1686.

The following figure shows how the synchronization algorithm keeps PESQ values
constant from call to call.
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Figure 4-702: PESQ evaluation with old (upper) and improved algorithm

Mapping of PESC score and ITU P.800 values

According to ITU-T recommendation P.862, the PESC score expresses the speech
quality on a scale between -0.5 and +4.5, as shown in following figure.

An appropriate conversion formula has been standardized by the ITU in P.862.1 to
map the PESQ P 862.1 score values to ITU P800 scale values.

This scale ranges between approx. +1 and +4.55, as shown in the lower diagram of
Figure 4-702.

R&S ROMES4 displays the converted values as "PESQ P862.1" results, it means in a
scale between 0 and +4.5.
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Figure 4-703: Mapping of PESC score (P862) to ITU P.800 values according to ITU P862.1

The meaning of the PESQ P862.1 scaling is described in Table 4-29.
Table 4-29: PESQ p862.1

PESQ P862.1 Speech Quality Impairments

4 - 5 Excellent Imperceptible

3.2 - 4 Good Perceptible, but not annoying

2.3 - 3.2 Fair Slightly annoying

1.5 - 2.3 Bad Annoying

0 - 1.5 Poor Very annoying

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

QoS views



Display and evaluation of resultsDrive Test Software

1071Operating Manual 1171.6415.12 ─ 66

The degraded voice samples are stored in a *.rscmd measurement file if selected in
the SQA configuration.

It is possible to play or export the degraded *.wav file.

If the voice sample is stored in the *.rscmd file, the line with the measurement value
is marked blue.

To export the voice sample mark the line, open the context menu and select "Export
degraded wav file". This function is also available during a measurement with record-
ing.

The "SQA Message View" has no a configuration menu assigned.

4.6.2  QoS DQA views

The "QoS DQA Views" display the result of the Data Quality Analysis (DQA, with option
R&S ROMES4DQA, "Voice Quality PESQ").

The QoS DQA views can be selected from a submenu displayed on the right-hand side
of the "View" menu when the mouse pauses over "DQA".

Figure 4-704: QoS DQA views

4.6.2.1  Capacity test summary view

To see the different throughput values of the capacity test job, use the "Capacity Test
Summary View".
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Figure 4-705: Capacity test job summary view

The meaning of the view's entries/columns are described in the following table:
Table 4-30: Capacity Test Summary View entries

Column Description

"Job Index" DQA job index with its execution count or the subtest with its index

"Time" Time the test has been stopped

"Protocol" HTTP, FTP or UDP

"Direction" Link direction (Uplink or Downlink)

"IP TP" Throughput on the IP Layer

"IP Sust. TP" Sustainable throughput on the IP layer

"App. TP" Throughput on the application layer

"RTT" Round trip time

"Duration" Duration of the test

"Sust. Duration" Sustainable duration of the test

"Result" Result of the test

4.6.2.2  DQA message view

The "DQA Message View" monitors all actions of the currently running job. Each action
is described with a message and the associated time. The causes of possible errors
are reported with the messages.
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Figure 4-706: DQA Message View - FTP download / upload action

Disconnect from network

The "DQA Message View" displays the message Successfully Disconnected
before the Disconnect from Network job performs the idle time.

The length of the idle time command is also displayed in the "DQA Message View",
for example "Waiting 5000 ms…", shown in the following figure.
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Figure 4-707: DQA Message View - Disconnect from network

View contents

The messages depend on the job that is being executed but are all self-explanatory.
The previous Figure 4-706 shows the messages generated during the "Connect to Net-
work" job with the download / upload of a binary files 10M.bin.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "QoS DQA Message View" has no configuration menu assigned.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.
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4.6.2.3  DQA progress view

The QoS "DQA Progress View" monitors the progress and the status of the current job
measured on the Service Socket. The view contents depend on the job and the DQA
job setting mode that is being executed.

For more information, refer to the description in chapter Chapter 6.5.1, "Data quality
tester (DQA)", on page 1880.

Figure 4-708: DQA Progress View (FTP download)

View contents

The job name forms the heading of the upper panel, which also shows the most impor-
tant properties of the job and its current state.

A detailed list of the different actions involved in the job is given in the "Trigger Points"
table. The entries in the table are self-explanatory. In particular, the table contains the
duration of each action and the number of transmitted and received bytes.

The "DQA Progress View" shows all jobs which are started, pending or finished.

Figure 4-709: Progress view of multiple DQA services

A double click on a list item of the pending jobs shows the details of the selected item's
progress.
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Figure 4-710: Detailed DQA Progress View of the selected HTTP job

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The "DQA Progress View" has no configuration menu assigned.

The "Info" page for different views and technologies can be obtained in general via the
"Tools" > "Configuration Active View" command. Dependent on a selected view, the
opened page is the "Info" page only or the configuration page containing the "Info" tab
among others.

4.6.2.4  DQA throughput view

The QoS "DQA Throughput View" monitors the current, maximum and average data
rate in UL/upload and DL/download direction measured on a network adapter (Ether-
net/NDIS/modem).
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Figure 4-711: DQA Throughput View

The DL and UL data rate is shown in the two 2D charts. The scale and appearance of
the two charts (DL and UL throughput) can be configures and modified using the "DQA
Throughput View: <variable> Propeties" pane of the view.

For the view configuration, see Chapter 4.2.1, "2D chart view", on page 448.

The 2D chart provides the following:
● "Mean Netw. DL/UL" shows the average throughput since the beginning of the cur-

rent job, DQA session, or measurement session, depending on the DQA through-
put view configuration

● "Current Netw. DL/UL" shows the net throughput vs. time
● "Current Netw. DL/UL Avg" shows the average throughput since the beginning of

the current job
● "Current Netw. DL/UL Max" shows the maximum throughput since the beginning of

the current job
● "DQA Cur. DL/UL Data Rate" shows the current DL/UL data rate

The listed values are the same as the ones displayed in the "3GPP Overview
View". They are calculated by the DQA which measures the throughput of all
download and upload sockets (in the application layer).

The "DQA Throughput View" works also with network adapters.
If working with network adapters, it is important to activate the "Use Gateway for Rout-
ing" option to establish the correct network connections. The option is activated in
"DQA Settings" > "Connect to Network" > "Advanced Connection Settings".

Since version 4.66, the "DQA Throughput View" shows data for the connection initiated
outside of R&S ROMES4. In this way shown data works only if one Internet connection
is activated on a PC. It is necessary to specify the IP addresses for the server because
no DNS solution is performed via the DQA. Otherwise, a failure message turns up, for
example, "Could not create FTP Socket" for an FTP Download.
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To obtain valid results, the "Record the computer network throughput" option must be
enabled in the "Connection Statistics" tab of the DQA configuration menu. The data is
recorded and displayed by checking the "Global" > "Update Rate..." options in the
view's properties pane.

Context menu

The "DQA Throughput View" configuration is done in the "DQA Throughput View:
<variable> Properties" pane. Selecting the "Configure" command in the context sensi-
tive menu of the view opens only the "Info" page.

4.6.2.5  Interactivity test summary view

Interactivity test summary view

The "Interactivity Test Summary View" supports the Interactivity test job events. This
view is able to identify spots/timings with high latency variation and through sync to
other views to look for possible reasons of these variations.

The view complies with the recommendation ITU-T G.1051 (accepted in January 2023)
which assumes the following:
● Support of differentiation between QoS parameters without considering an applica-

tion and a respective packet delay budget and the input to the interactivity model.
R&S ROMES 4 outputs the raw RTT and PDV values without discarding packets.

● Adaption of the pattern 'Interactive remote meeting' to be asynchronous by apply-
ing one peak only in uplink and the other only in downlink.
The case that each side shares content at some point in the meeting is an realistic
case.

● The "Interactivity Score Model" adaption to take the standard deviation of the PDV
instead of the median as input.
The model constants for this term have been adapted.

The "Interactivity Test Summary View" is divided into the grid and graphic display of
data. The graphic display provides a better understanding of the grid display of data.
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Figure 4-712: Summary view of the interactivity test job

Selecting one row in the grid synchronizes all views to the selected time.

The "Properties" button on the right on the graphic display shows or hides the configu-
rable properties of the view.

The Interactivity Test job events can be configured in the view's context sensitive menu
and displayed in the graphic view.

The context sensitive menu opens if you click any point in the view.

Grid display

The following table lists the entries included in the grid's columns.
Table 4-31: Interactivity test summary view entries in the grid

Column Description

"Job Index" DQA job index with its execution count or the subtest with its index

"Time" Time the test has been stopped

"Pattern" Configured pattern used for the test

"# Sent Packets" Number of sent packets

"# Lost Packets" Number of lost packets

"Disc. Ratio [%]" Percentage of discarded packets

"PLR [%]" Packet lost ratio

"PLR UL [%]" Uplink packet lost ratio

"PLR DL [%]" Downlink packet lost ratio

"Channel QoS
[%]"

The channel QoS 3GPP is a single value. It expresses the quota of valid packets that
arrived in time compared to the maximum allowed packet error rate (PER) for a given
traffic pattern (application) [0,1] (display as %).
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Column Description

"RTT (median)
[ms]"

Median round-trip time of all individual packets returned within the given packet delay
budget

"RTT (P10th)
[ms]"

10th percentile of the round-trip times of all individual packets returned within the given
packet delay budget

"RTT (max) [ms]" Max RTT, what is the worst case

"RTT Details" The grid's "RTT Details" column is a button "Show Details". It opens a detailed list of
RTT data of the underlying job. The "Interactivity Statistic Details" dialog is displayed if
you click the button, see Figure 4-714.

"RTT QoS
(median)"

Median round-trip time in [ms] of all individual packets returned on QoS level, i.e. not
taking the packet delay budget given by the target application into account. The signal
value floats.

RTT QoS [10p]"" 10th percentile of the round-trip time in [ms] of all individual packets returned on QoS
level, i.e. not taking the packet delay budget given by the target application into
account. The signal value floats.

"Interactivity
Score"

QoE score as expert model that takes the technical results (RTT, PDV, PLR) as input
and delivers a single score value [0,100] (display as %)

"PDV (median)
[ms]"

Median of the packet delay variation distribution based on all packets returned within
the given packet delay budget

"PDV UL
(median) (ms)"

Median of the PDV at the point of the packets being received by the server regarding
the sending timestamps of the client

"PDV DL
(median) [ms]"

Median of the PDV at the point of the packets being received by the client regarding
the sending timestamps of the server

"PDV (P99.9th)
[ms]"

99.9th percentile of the packet delay variation within the given packet delay budget

"PDV UL (P99.9)" 99.9th percentile of the PDV at the point of the packets being received by the server
regarding the sending timestamps of the client.

"PDV DL (P99.9)" 99.9th percentile of the PDV at the point of the packets being received by the client
with reference of the sending timestamps of the server

"PDV DL
(stddev)"

Standard deviation of the packet delay variation distribution in [ms] of all individual
packets returned on QoE level, i.e. within the given packet delay budget. The signal
value floats.

"UL TP [Mbit/s]" Uplink throughput on UDP application layer

"DL TP [Mbit/s]" Downlink throughput on UDP application layer

"# Duplicate
UL"/"# Duplicate
DL"

Number of packets that were duplicated during uplink, respectively downlink transfer
and eventually were received at the a client. The range is from 0 to N.

"Time To leave
UL (average)"

Average number of hops left for the packets in uplink direction before they would have
been dropped. A measure for the path length between client and server. The signal
value floats.

"Time To leave
DL (average)"

Average number of hops left for the packets in uplink direction before they would have
been dropped. A measure for the path length between server and client. The signal
value floats.

"Score [%]" Result of a test
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Click the "RTT Details" button in the grid, to get the "Interactivity Statistics Details" dia-
log of the selected job index.

Figure 4-713: RTT details button

Figure 4-714: Details of an interactivity job

In the "Interactivity Statistic Details" dialog, the "Zoom" button lets you zoom the
graphic view to the time range of the measured data. The per-packet statistics related
to a sequence number at the server side and received timestamp of the server are
available in the details dialog. A paket status indicated in the diagram can be "OK",
"Lost","Discarded" or "Duplicated". The status is displayed with the same color as the
corresponding cross in the graph view.

The grid can be sorted per each column.

The "Export to CSV" button lets you export the complete list as it is sorted.
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You can sort the grid on time or on the round-trip time. These sorting options make it
easy to see how many measured RTTs are above a threshold.

Graph display

The graphic displays the following entries for the job selected in the grid:

● "Lost Packets"
● "Round-Trip Latency (median) in [ms]"
● "Round Trip Latency per packet in [ms]"
● "Throughput Upload in [kBit/s]"
● "Throughput Download in [kBit/s]"
● Packet status as previously mentioned: "Lost", "Discarded", "Duplicated" and "OK"

All-time ranges between jobs are grayed out.

Y-axis shows the throughput on the right-hand side and the round-trip latency or lost
packets on the left-hand side.

The time-axis floats with the zoomed time-axis of the TimeLine control. While in replay,
a time ruler is displayed. During measurement, up to the last 5 minutes are displayed.

The graph legend displays the colors of the entries in it and their meaning.

All axes in the graph can be scrolled (Shift+mousewheel) and zoomed (Ctrl+mouse-
wheel).

Properties

The "Properties" pane controls the displayed axes (range, auto-zoom). It can be col-
lapsed to a "Properties" button on the right to increase the size available for the graph.

Figure 4-715: Properties of the Interactivity Test Summery View

The following functions to control the view are included in the "Properties" pane:

QoS views



Display and evaluation of resultsDrive Test Software

1083Operating Manual 1171.6415.12 ─ 66

● "Show full time axis" - resets/fully zooms out the time-axis with one click.
● "Axes" > "Left Y Axis" - lets select display of left Y-axis between "Latency" and

"Lost Packets".
● "Axes" > "Show Events" - configured events can be shown using a Boolean flag.
● "Axes" - all axes ("Time axis", "Throughput", "Latency" and "Lost Packets") can be

changed. Setting the "Time Axis" to auto-zoom selects automatically the time range
of a single job during replay.

Context menu

The context menu offers to export the view's data in CSV format, also to show and hide
the "Properties" pane. The "Show RRT Details" entry of the menu opens a detailed list
of RTT data of the underlying job. The "Events Configuration" entry, when clicked,
opens the configuration dialog where can be selected events for display in the graphic
view.

Use "Properties" to show or hide event in the top line of the graphic display.

Figure 4-716: Available events of the Interactivity test job
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4.6.2.6  QoS report view

To get the start page of the view, click "QoS Views" > "DQA" > "QoS Report View".

If the view is started outside of replay mode or with no mobiles attached and config-
ured, the window is without data.

Figure 4-717: QoS Report View opening page

Once a replay is loaded or mobiles attached and configured for DQA test, the "QoS
Report View" creates a tab in the title bar of the view for each attached mobile.
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Figure 4-718: Opening page - replay mode

The "QoS Report View" contains the following panes:

● "Provider Information"
● "Job List"
● Details - grid and chart

Loading workspaces created with R&S ROMES4 19.3 or older versions does not load
the "QoS Report View" automatically. Add the view manually again.

Provider information

This pane shows the current providers' information for the associated mobile device.
Information displayed is provider's name and MCC/MNC.

Job list

The "Job List" > "Session" table displays the controls of each configured and connec-
ted job. The controls are the same for data and voice jobs. If configured, the data and
voice sessions have their own section.
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Figure 4-719: QoS Report View - job list

The following controls are displayed for each connected job.
● "Index" - index associated to a job in the "Job List"
● "Name" - name of the job
● "#" - the overall number of times the job has been run (top number)
● "Success Rate" - the number of times the job has run successfully (middle number)
● "State" - the current state of the job execution
● "Progress" - the progress percentage of the current job execution
● "Current" - the throughput rate of the current job execution.

Considered is upload or download jobs throughput (UL or DL labels). Dependent
on job type, can be the current RTT, example given Ping job, or MOS and CST for
voice call.

● "Average" - the average of the quantities named in the previous bullet
● "Last 5 Results" - the last 5 results of the job executions

Green dot indicates successful execution and red one an unsuccessful execution.

- "Call Session Start", "Call Session End" and "Disconnect" jobs contain the "Index"
and "Name" controls only in the "Job List".
- "Connect" job contains the "#" and "Success Rate" control in the "Job List".

Details - grid and chart

The lowest pane shows the statistics of monitored DQA jobs. Each executed job is
assigned own tab showing the monitored quantities in a grid and chart.

Session

The "Session" option/tab monitors the statistics of a connection that R&S ROMES4
sets up to a remote network. The connection can be a radio link towards a network
established by test mobiles or a connection via dial-up network.

The "Session" tab is available for each Connect to Network/Disconnect from Network
job.
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Figure 4-720: QoS Report View – session details in session tab

The left part of the "Session" pane displays the connect job's name as set in the DQA
configuration dialog, an overview of the attempted connections and the time statistics
of the connections.

The "Session" pie chart on the right displays the percentage of good, blocked, drop-
ped, incomplete session and no service/application error.

● Good
Every call successfully established and terminated by the system after exactly the
"Call duration" set in the "Autodialing" tab.

● Blocked
A call is qualified as blocked if one of the following applies:
– An idle message was detected during call setup but the call was not canceled.

The idle message detection happens in all cases where a call setup was per-
formed at least up to the Layer 3 message SERVICE REQUEST, but not up to
ALERTING / CONNECT, and where no DISCONNECT, RELEASE or CHAN-
NEL RELEASE was executed or

– The call was canceled, call setup was not performed up to ALERTING and/or
CONNECT or

– A dial command has been sent to the mobile at a moment with sufficient cover-
age, but because of temporarily insufficient coverage no call could be estab-
lished: The NQA state machine remains IDLE. On the next dialing, the system
recognizes that no call could be established and one blocked call is added.

● Dropped
A call is qualified as dropped if one of the following applies:
– An established call is canceled before the "Call duration" set in the Autodialing

tab has passed or
– An established call is terminated not to order. A NQA data package will be gen-

erated when an "Idle" or "Error (No Service)" state is detected after a call was
established and the "Call duration" has not passed yet.

● No service
A "No service" call is added every time the system wants to dial but the mobile is
out of service. If the mobile remains out of service the time interval between two
subsequent "No service" calls is equal to the "Call duration" plus the "Idle time",
both set in the "Autodialing" tab.
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● Call Canceled
A call is canceled if one of the following applies:
– Manual hang up by user
– Stop measurement during a call
– Called party did a hang up
– Call starts in a certain RAT, for example, in UMTS and during the call the RAT

changes, for example, to GSM and the "Hang up call, if a RAT handover occur-
red" is checked.

Figure 4-721: Voice call canceled

The tabs alongside the "Session" tab, show the results of other DQA executed jobs.

QoS report view grid

The third pane of the "QoS Report View" displays on the left side the QoS jobs repor-
ted values. In the figure Figure 4-718 opened is the report view of the interactivity job
as an example.

The following controls, dependent on the QoS job, are displayed first.
● "Total Count" - the total execution count of the job
● "Success" - the number of successful executions and the percentage of successful

executions
● "Minimum", "Maximum", "Avg" of the throughput across all execution of the job
● "DL/UL UR" - the URL used for the test

The grid at the bottom on th left side contains the following controls:
● "#" - the index of the job execution

The currently executing job is indicating with a right arrow icon.

Figure 4-722: Icon for currently executing job

● "Result" - shows the job execution result. Green dot stands for successful and red
dot for unsuccessful execution.

● The third column can host the following controls:
– "UL Throughput"/"DL Throughput" - upload/download throughput of the jobs

like FTP, HTTP upload/download in kbits/s
– "Interactivity Score" - 5G interactive jobs in percentage
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– "MOS" - voice call, mean observation score as an integer number
– "RTT" - ping job in ms

● "Duration"/"CST" - time it took the job to execute in seconds
● "RAT" - the technology that is used during the job execution
● "Call Status" - the status of voice call only

Figure 4-723: QoS Report View of a call session

● "MOC/MTC" - mobile originating call/mobile terminating call
● "RTT (median)" - RTT interactivity jobs only
● "PDV (median)"- PDV interactivity jobs only

Double click any entry in a job grid results in the replay moving to the beginning of
selected jobs execution if replay mode.

QoS report view distribution chart

The distribution chart, of in time selected job tab, is placed on the right-hand side of the
third "Qos Report View" pane.

The chart summarizes the distribution of the throughput/Interactivity score/RTT/MOS of
a DQA job execution.

Each successful execution of a job adds a data point on the chart. After three success-
ful executions of the job, a solid horizontal line is placed on the chart. The line indicates
the average value for a reported control which is specified by the color of the line.

Data points in the chart have different shape (diamond and circle shape) to differentiate
among the reported controls.

The color of the data point corresponds the technology that was active during the job
executions, see Figure 4-718.
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RAT is displayed with 100% bar length in the chart. The bar shows the percentage for
a given RAT usage over the entire measurement or replay.

The amount of time the RAT was active can be found by moving the mouse over the
RAT bar and examining the Tooltip that pops up.

Figure 4-724: RAT bar in the distribution chart

Elements of voice call

The "Call Stats", "MTC" and "MOC" columns in the "QoS Report View" grid are added
to aid analysis and determination of voice call quality.

For the CST, MOS A and MOS B shown are minimum, maximum and average values.

Figure 4-725: CST, MOS counted values

The voice call data considered in the call status are focused in the following figure.
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Figure 4-726: Additional columns in QoS Report View of voice call

If none of the call results of a MOC/MTC value are available, then only one group of
call statics is displayed and the MTC, MOC headers are removed.

Figure 4-727: Missing MTC/MOC header

The items contained in the call result grid are shown in the following figure.

Figure 4-728: Call result grid

Voice call data Description

MOS A/MOS B MOS value for side A and side B of the voice call. A “*” alongside of the value
indicates if the call is side A or side B.

Call status Possible results of a call: "Good", "Dropped", "Blocked" or "No Svc".

The distribution chart on the right-hand side of the view shows both CST and MOS val-
ues. The MOS values are allocated along the upper y-axis and the CST values along
the lower y-axis in the chart. In the figure Figure 4-723 the axes are colored green and
red, respectively.

Display of current job execution

The "DQA [1] <variable>" tab for the currently executing job is shown during replay or
measurement. This default option can be disabled by unselecting the "Auto Tab" entry
of the "QoS Report View Properties" pane.
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Figure 4-729: Auto Tab entry

Calculation of DQI/PQI

DQI: Data Quality Indicator

PQI: Performance Quality Indicator

The IREG specification declares the following constants:

Minimum Connection Setup Time:MIN_CON_SETUP = 3000ms

Maximum Connection Setup Time: MAX_CON_SETUP = 60000ms

DQI Time Constant: DQI_TIME_CONST = 3600000ms (1Hour)
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● Cut off Session Ratio: Ratio of the incomplete sessions and the sessions that were
started successfully

● Service Non Accessibility: Ratio of failed connections and tried connections
● Network Non Accessibility: Ratio of unavailable services and the connect attempts
● Service Success Rates:

– FTP DL: DQI average of all successful FTP DL services
– FTP UL: DQI average of all successful FTP UL services
– HTTP DL: DQI average of all successful HTTP DL services
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– HTTP UL: DQI average of all successful HTTP UL services

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

QoS report view configuration

The "QoS Report View" contains only the general "Info" tab.

Figure 4-730: QoS Report View configuration

4.6.3  QoS KPI export result view

The "QoS KPI Export View" shows the result of an exported *.csv file from the KPI
export definition. Every row of type header is a tree node for the rows of type
session, see the KPI Definition File.doc.
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The rows and columns depend on the KPI export definition. All devices of a measure-
ment which are recognized by the KPI Generator are displayed in separate table.

Figure 4-731: QoS KPI Export Result View

If you click the header of a column, the contents is sorted as alphanumeric.

Example: 
QoS KPI export result view of speech quality measurement made with smart-
phone
The "KPI Export Result View" displays the average of the MOS values per session and
per measurement, see the following figure.

Figure 4-732: Exported smartphone speech quality (MOS) measurement results

QoS views



Display and evaluation of resultsDrive Test Software

1095Operating Manual 1171.6415.12 ─ 66

4.6.3.1  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● Export CSV

It is possible to export the content of the table as a *.csv file.
● Clear all Filters

This command is used to clear all created filters.

4.6.4  QoS KPI generator view

The KPI generator displays in the "QoS KPI Generator View" the KPIs for which it has
found trigger points. Also the KPIs with trigger points outside the session are dis-
played. By defining a session (normally a connect – disconnect sequence), all the ses-
sion's KPIs are shown under it is tree node.

The QoS KPIs of measurement devices recognized by the KPI generator are displayed
in a separate table.
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Figure 4-733: QoS KPI generator view

R&S ROMES4 separates the measurement of trigger points and the postponed KPI
calculation based on them. This separation implies the following:
● Trigger points are stored in the measurement file only
● KPI generator calculates the KPIs and sends them to the "KPI Generator View"

The calculation method is adaptable and extensible for specific customer requests. It is
defined in a KPI definition file in XML format. A basic definition file is delivered for cal-
culating all common KPIs, which the R&S ROMES4 was calculating until now.

The calculated KPIs can be exported to a CSV file. Which KPIs to export can be
defined in XML format of a KPI export definition file, see Chapter 3.8.2.15, "TEC for
QoS tester", on page 367. The calculation of average, minimum or maximum value
over sessions, and the whole measurement is possible in the export. The export result
is visualized in the "KPI Export Result View".
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Average Export on Time Basis
To be able to calculate throughput correctly, rate has to be calculated on a time basis.
The rate depends on how long the last value was valid. Start and End Trigger points
are the same. For example, a trigger point at t1 = 100 is 2000 Bytes, a second one at
t2 = 200 is 3000 Bytes. The single KPI would be (3000-2000)/(200-100) = 1000 / 100 =
10 Bytes per second. If a third TP occurs at t3 = 500 with 9000 Bytes, the second KPI
would be (9000-3000)/(500-200) = 6000 / 300 = 20 Bytes per second. The average as
implemented now is (10 + 20) / 2 = 15, what is wrong. The rate on time basis is (10 *
100 + 20 * 300) / (100+300) = 17,5. So an attribute “method” for the key word AVG and
AVG_PER_SESSION for the XML file is available. The method can be “time” or “sam-
ple”. If the method is not specified, the “sample” is the default value.

4.6.4.1  View contents

The "QoS KPI Generator View" displays different values depend on a job that is being
executed.

Column description
● KPI

KPI name defined in the KPI definition.
● Service

Service whose trigger points were measured. If the service of start and stop trigger
point are not identical, the service of the KPI is taken from the stop trigger point.

● Value
The value of the KPI and the trigger points. The value types (units) of the KPI and
their trigger points can be different due to the reason illustrated with the following
example. KPI FTP Mean User Data Rate is calculated as the number of bytes
between start and stop trigger point divided by the time span between start and
stop trigger point. The result value of the KPI has the unit kbit/s. The values of the
trigger points have the unit bytes to calculate the number of bytes between start
and stop trigger point.

● Info
A trigger point can have meta data such like the URL, IP Address (see Trigger
Point Definitions.doc for available meta data keys). This meta data information is
displayed here. The KPI displays the meta data both of start and stop trigger point.

● Timestamp
The timestamps of the KPIs and its trigger points. It corresponds to the timestamp
of the start trigger point.

Short Keys
● <Ctrl+F>

Opens the "Find" dialog.
● <F3>

Continues a previous search, searching from top to bottom for a next occurrence of
the search string.

● <Shift+F3>
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Continues a previous search, searching from bottom to top for a next occurrence of
the search string.

4.6.4.2  SQA trigger points and KPI

The trigger points related to a speech quality analysis (SQA) are included in the R&S
ROMES4. The trigger points mark the beginning and the end of playback of the
selected speech sample, during an ongoing uplink SQA measurement.

These events are logged as the key performance indicators (KPIs) and can be viewed
inside the QoS KPI generator view, as shown in the following figure. For the KPIs and
the trigger points in general, refer to the Chapter 9.4, "R&S ROMES4 KPI Description",
on page 2312 and Chapter 9.3, "Trigger point definitions", on page 2243.

Figure 4-734: KPI records - the beginning and end of a speech sample during an uplink SQA mea-
surement

Like all other trigger points, the SQA trigger points are associated with timestamps,
which can be used precisely to determine the time at which these events occur.

Note that the precision of logged timestamps is affected by internal delays due to pro-
cessing and audio buffering, and can only be used as an approximate value.

The trigger points of some KPI are also available as signals in the "QoS Trigger Points
(Legacy)" signal tree branch, if selected in "Tools" > "Preferences" > "Available Sig-
nals".
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Figure 4-735: Selected signal as a KPI trigger point

The selected signal, for example "Playback of the speech sample...", can be used as
an event recorded during the measurement.

Figure 4-736: Selected event
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Example: 
QoS KPI generator view of speech quality measurement made with a smart-
phone
The following figure shows the "QoS KPI Generator View" of speech quality measure-
ment results made with a smartphone. The view displays KPIs based on Layer 3 mes-
sages and the KPIs for the DL MOS values.

Figure 4-737: Trigger points and KPI (MOS) of smartphone speech quality measurement

The marked KPIs in the figure are related to the introduced KPIs for CSFB and VoLTE
calls, "Telephony Setup Time (CSFB)" and "Telephony RAT Chance (CSFB)".

4.6.4.3  DQA jobs supported by the QoS KPI generator

The following table shows the availability of trigger points for the DQA jobs.
Table 4-32: Availability of trigger points for DQA jobs

DQA Job Service / Proto-
col

Application Trigger
Points

TCP/IP Trigger
Points

Remarks

Connect Service Independ-
ent

Yes No IP Tracer start is after suc-
cessful connection

Disconnect Service Independ-
ent

Yes No IP Tracer stop is before
disconnect request

FTP DL FTP Yes Yes  

FTP UL FTP Yes Yes  

FTP DL/UL FTP Yes No IP Tracer can only detect
TPs for one action per job
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DQA Job Service / Proto-
col

Application Trigger
Points

TCP/IP Trigger
Points

Remarks

FTP Multi FTP Yes No IP Tracer can only detect
TPs for one action per job

HTTP DL HTTP Yes Yes  

HTTP UL HTTP Yes Yes  

HTTP with IE HTTP Yes Yes  

WEB 2.0 HTTP Yes Yes  

Email DL POP3 Yes Yes  

Email DL IMAP Yes No TCP/IP not available

Email UL SMTP Yes Yes  

Ping ICMP Yes Yes  

Ping ICMPv6 Yes No TCP/IP not available

VLC VLC Yes No  

Run External
Process

- No - n.a.

Auto Dial - No - not available

SMS - No - not available

DQA Multi
Service
(Flow)

Several Services Yes No IP Tracer cannot detect
TPs for parallel running
jobs
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Example: 
The following figure shows the trigger points and associated KPI for the HTTP Upload
DQA job.

Figure 4-738: Trigger points and KPI for HTTP upload DQA job

The trigger points of this KPI are also available as the signals in "Available Signals" >
"QoS Tester" > "HTTP UL Progress", see Chapter 3.8.1.2, "Available signals configura-
tion", on page 228.

Figure 4-739: Selected signal used as KPI of HTTP upload job
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The current version only visualizes trigger points related to a DQA session. This visual-
ization leads to the limitations, that no KPIs for circuit switched services are displayed.
Currently Generic RAT trigger points based on Layer 3 messages are supported for
GSM and UMTS only.

4.6.4.4  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.7  WLAN views

The "WLAN Views" show the WLAN information obtained in the network scans per-
formed by a WLAN adapter in regular intervals. WLAN data can be acquired with all
common WLAN devices listed in the MS Windows "Connection Manager" > "Wireles
Network Connection".

The "WLAN Views" can be selected from a submenu displayed on the right side of the
"View" menu when the mouse pauses over "WLAN Views".
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Figure 4-740: WLAN views

The WLAN scan view and the WLAN overlapping networks view use a configurable
observation interval. The observation interval is necessary because the hardware can
only scan 32 available networks in one run. Available stations disappear from these
views when they are not scanned anymore in the configured observation time. The
approach leads to a more stable display of available stations, for more see "Observa-
tion" on page 1111.

WLAN signals

WLAN adapters constantly monitor and report many parameters describing the current
signal quality and data traffic. The parameters are used to generate the signals in the
WLAN section of the data tree. The signals complement the WLAN interface status
and statistics information, the WLAN network scan information, the WLAN connection
status and the information related to WLAN radio state.

For example, the WLAN set of signals and the signals can be viewed in the "Available
Signals" > "WLAN" list of the "Alphanumeric View" > "Configuration" window, see the
following figure.
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Figure 4-741: Some WLAN signals

The WLAN signal sets in the data tree are:
● Interface Status

The signals related to information on the current interface status.
● Network Scan

The signals related to all scanned networks. The maximum number of scanned
networks for one scanner is 32.

● Connection Status
The signals of this set are only available when the device is connected to network.

● Interface statistics
The signals related to statistics. The “Phy” signals in this set are only available
when the device is connected to network.

● Radio state
The signal is related to the current radio state.

● WLAN overlapping networks view.......................................................................1106
● WLAN scan view................................................................................................. 1108
● WLAN signal view................................................................................................1112
● WLAN survey view.............................................................................................. 1114
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4.7.1  WLAN overlapping networks view

The "WLAN Overlapping Networks View" displays information about the co-existing
channels and overlapping channels.

At the left side of the view, a table containing all access points with co-existing and
overlapping channels is displayed. At the right side, the details are displayed if an
access point has been selected in the table. During measurement and replay, the
details of the selected access point are updated until a new access point has been
selected in the table.

The table can be sorted by each column of the table.

Figure 4-742: WLAN Overlapping Network view -AP selected

The table contains the following parameters:
● "AP"

Access point number
● "SSID"

Service set identifier (network name)
● "MAC address"

MAC address of the access point or other client, depending on whether the test
device operates in infrastructure or ad hoc mode.
The MAC is a unique serial number assigned to a networking device by the manu-
facturer.

● "Chan."
Channel identifier of the radio channel that the test device uses for communication.
For 40 MHz channels, the secondary channels follow the "+" separator.

● "Ch. Width"
The channel width in MHz (20 or 40).

● "Co-Channel"
The number of detected co-existing channels for this AP.

● "Overl. Net"
The number of detected overlapping access points.

● "RSSI"
Signal strength for all received packets.

● "C/I"
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Carrier to interference in dB; only available if co-existing channels were detected
for the access point.

● "Age"
Time since the Probe/Beacon response is received in ms.

The "Access Point Details" window displays the table of the access points which are on
the same channel of the selected access point, the table of the access points which
overlap the selected access point and a graph which contains the RSSI value of the
overlapping access points along the channels.

The thick line in the figure Overlapping network view is the selected access point.

4.7.1.1  WLAN overlapping networks view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

WLAN overlapping networks view settings

The "Overlapping Networks View..." option lets you choose whether to filter the list of
signals by the co-existing channels and overlapping networks or not and specify the
contents of the view.

You can choose all the scanned networks to be displayed in the table. By default, the
list shows only networks with existing co-channels and overlapping networks.

Figure 4-743: WLAN Overlapping Networks View - settings
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The parameters you want to be displayed in the view have to be selected in the "Table
columns" panel.

WLAN overlapping networks view: colors

The "Colors" option lets you set the colors in the view.

Figure 4-744: WLAN Overlapping Networks View - colors configuration

You can select the colors for bars and lines here.

The color settings in the WLAN configuration menus apply to all WLAN views. The
color definitions overwrite each other.

Note the following features of the WLAN color settings:
● The color no. 0 is always used for the noise signal which is measured in a single,

fixed channel defined in the NDIS configuration menu.
● The colors no. 1 to 500 can be assigned to signals from access points or other cli-

ents (the maximum number of signals received simultaneously is 32). The assign-
ment is chronological. The first detected signal is displayed with color code no. 1,
the second with color code no. 2, etc.

4.7.2  WLAN scan view

The "WLAN Scan View" displays basic information acquired in a WLAN network scan
(WLAN BSSID list information).

Each access point generates a table row with a colored analog bar. The columns dis-
played and the maximum number of rows (access points) can be limited in the configu-
ration menu. The length of each bar is a measure for the received signal strength
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(RSSI) of the signal from the access point. The numeric RSSI value appears in the
RSSI (in dBm) row. The scale settings in the configuration menu define the length of
the bars.

Figure 4-745: WLAN Scan View

The table contains the following parameters:
● "Network"

Network name
● "MAC Address"

MAC address of the access point or other client, depending on whether the test
device operates in infrastructure or ad hoc mode.
The MAC is a unique serial number assigned to a networking device by the manu-
facturer.

● "Frequency"
Center frequency of the used channel in MHz. According to standard IEEE 802.1, it
is 2484 MHz. Depending on the regulatory domain, the channel range can be
restricted.

● "Channel"
Channel identifier of the radio channel that the test device uses for communication.

● "Auth. Algorithm"
Gives information about the required authentication and cipher algorithms.

● "Mode"
"Infrastructure" or "Ad hoc" mode. In "Infrastructure" mode the test device can com-
municate with access points and other network infrastructure devices; in "Ad hoc"
mode, it can also communicate with other client devices.

● "Type"
Spread-spectrum type used for the physical layer: Direct Sequence ("DS") or Fre-
quency Hopping (FS).

● "Supported Rates"
Data rate at which the test device transmit or receive data, unit MBit/s.
"1/2/5/11/18/24/36/54" means that a 5-GHz test device uses Auto Rate Selection.

● "Beacon"
Beacon period in the range between 20 Kµs and 976 Kµs, specifies the duration
between beacon packets. The beacon packets help clients to find each other in ad
hoc mode.
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(Kµs is a measurement unit in software terms, K = 1024, µ = 10–6, s = seconds,
therefore 1 Kµs = 0.001024 seconds = 1.024 ms)

● "RSSI"
Signal strength for all received packets in dBm.

The results provided by each test device are displayed in a separate table. Each tab
shows the WLAN parameters of the signals from the access points detected by the test
device in a network scan. The results are updated every time the test device termi-
nates a network scan.

4.7.2.1  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.7.2.2  WLAN scan view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration

The "Configuration" option lets you specify the scale and the contents of the view,
defines the color settings, and displays information about the view version.

The "Configuration" defines the scale for the bars in the "WLAN Scan View", the maxi-
mum number of bars and selects the parameters shown in the table.

WLAN views



Display and evaluation of resultsDrive Test Software

1111Operating Manual 1171.6415.12 ─ 66

Figure 4-746: WLAN Scan View Configuration

Graph
The three input fields in the Graph panel define the RSSI levels corresponding to bars
of zero length and full-length.
The actual length of the bars in the "WLAN Scan View" is equal to:
● L = RSSI [dBm] * <full length> / (Max. RSSI [dBm] – Min. RSSI [dBm])

– "Max. Count"
Maximum number of bars/access points displayed in the "WLAN Scan View".
The actual number can be smaller, if less than "Max. Count" access point sig-
nals are detected.

Show Columns
"Show Columns" lets you select previously described parameters for display in the
"WLAN Scan View" table.

Observation
The WLAN scan view and the WLAN overlapping networks view use a configurable
observation interval.
The observation time can be configured in the configuration dialog of the "WLAN Scan
View" and takes also effect to the WLAN overlapping networks view. The default value
is 5 seconds.

WLAN scan view: colors

The "Colors" lets you define the colors for bars and lines in the WLAN view.

The configuration page is the same as the "Colors" page of the "WLAN Overlapping
Networks View", see "WLAN overlapping networks view: colors" on page 1108.
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4.7.3  WLAN signal view

The "WLAN Signal View" displays the power of all received signals of the frequency
bands 2.4 GHz and 5 GHz in the stacked chart. Only the channels which show activity
are displayed.

Figure 4-747: WLAN Signal View

The view shows by default the charts of both bands. You can hide a chart of the band
you are not interested in if you uncheck the "Show 2,4GHz Band" or "Show 5GHz
Band" checkbox in the view.

Figure 4-748: Band 5 GHz is unchecked

The X-axis of the chart shows the channel numbers of the band. Below a channel num-
ber, the number of involved access points (AP) is displayed. Since the power of the
single values is added in this view, the power is displayed in [µW] on Y-axis.

Each received signal power generates a colored bar. The length of the bars is a mea-
sure of the received power.

The numeric RSSI value appears in the "RSSI" column of the Chapter 4.7.2, "WLAN
scan view", on page 1108.
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On a linear scale, the power values can be small, so that the calculated values are less
than one pixel. For this reason, it looks like the channels have less different values
than they have. For example, channel 64 of 5 GHz band in the previous screenshot
looks like 4 different values. However there are another 23 values which are too small
to display (4 different colors + 23 values below one pixel sums up to 27 access points
involved).

A test device operating in ad hoc mode can also communicate with other clients. The
"WLAN Signal View" does not the show access point signals in this case but all the sig-
nals used in communication.

4.7.3.1  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

4.7.3.2  WLAN signal view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration

The "Configuration" option lets you set the scale for the bars in the "WLAN Signal
View".
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Figure 4-749: WLAN Signal View configuration

WLAN signal view configuration: colors

The "Colors" lets you define the colors for bars and lines in the WLAN view.

The configuration page is the same as the "Colors" page of the "WLAN Overlapping
Networks View", see "WLAN overlapping networks view: colors" on page 1108.

4.7.4  WLAN survey view

The "WLAN Survey View" gives an overview of the measured WLAN parameters from
all access points including the distribution of the RSSI, C/I, and S/N values.

If a replayed measurement file was recorded in "Block Mode", the "WLAN Survey
View" generates block-specific statistical results. Blocks are defined in the "ROMES-
MAP Route Track".
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Figure 4-750: WLAN Survey View

The WLAN Survey View contains an access point table, a percentage table, and two
2D chart diagrams.

In the access point table, each access point generates a table row with a color code.
The columns displayed and the colors can be defined in the configuration menu.

The access point table contains the following parameters:
● Line

Number of the table row, assigned in the order the row is created. If n rows are dis-
played, the line numbers are 1 to n.

● MAC Address
MAC address of the access point.
The MAC is a unique serial number assigned to a networking device by the manu-
facturer.

● Channel
Channel number that the access point uses for communication.

● AP
Number of the access point, assigned in ascending order according to the detec-
tion time of the access point signal. New access points always receive a new
(higher) AP number, so the AP numbers and line numbers can be different when
signal is no longer detected.

● RSSI (10%)
RSSI that is reached or exceeded by 90% of the measured values (10% of the
measured RSSIs are below RSSI (10%)). RSSI denotes the received signal
strength of the signal from the access point in dBm

● RSSI (50%)
RSSI that is reached or exceeded by 50% of the measured values.
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● C/I (10%)
C/I that is reached or exceeded by 90% of the measured values (10% of the mea-
sured C/I are below C/I (10%)). C/I denotes the ratio of the RSSI of the strongest
(carrier) signal to the sum of the RSSIs of all other signals in the channel.

● C/I (50%)
C/I that is reached or exceeded by 50% of the measured values.

4.7.4.1  RSSI chart

Shows the integrated distribution of the measured RSSI values from all access points.
For a given RSSI, the curves show the percentage of measured RSSI values that fall
below this RSSI. The complement, i.e. 100% minus the "Probability [%]", corresponds
to the percentage of measured RSSIs above this RSSI. The colors of the curves corre-
spond to the color codes in the access point table.

For a Gaussian distribution of the measured RSSI values around the center value of
RSSI (50%), the integrated distribution corresponds to an error function:

The curve which rises at the highest RSSI values (i.e. in the right side of the diagram)
corresponds to the access point with the strongest signal.

4.7.4.2  C/I chart

Shows the integrated distribution of the measured C/I values from all access points.
The diagram is analogous to the RSSI chart.

4.7.4.3  Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

4.7.4.4  WLAN survey view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

WLAN survey view: access points

The "Access Points" option lets you select the contents of the access point table, that
is, the columns of the table is some of the parameters mentioned in Chapter 4.7.4,
"WLAN survey view", on page 1114.

Figure 4-751: Access Points - configuration

WLAN survey view: colors

The "Colors" lets you define the colors for bars and lines in the WLAN view.

The configuration page is the same as the "Colors" page of the "WLAN Overlapping
Networks View", see "WLAN overlapping networks view: colors" on page 1108.

4.8  Scanner views

From the "Views" > "Scanner Views" menu select the RAT and the scanner view you
want to be displayed.
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Figure 4-752: Scanner Views

Many views that display scanner data are implemented as tab views, showing a tab for
each configured scanner device.

● Scanner views commonalities............................................................................. 1118
● 5G NR scanner views..........................................................................................1126
● C-V2X scanner views..........................................................................................1151
● CDMA2000/1xEV-DO scanner views..................................................................1160
● GSM scanner views............................................................................................ 1179
● LTE scanner views..............................................................................................1204
● LTE-M scanner views..........................................................................................1273
● NB-IoT scanner views.........................................................................................1297
● RF power scanner views.....................................................................................1319
● TETRA scanner views.........................................................................................1339
● UMTS scanner views.......................................................................................... 1370
● WiMAX scanner views........................................................................................ 1412

4.8.1  Scanner views commonalities

4.8.1.1  Scanner BCH view

The scanner BCH views of the 3GPP specified RATs allow multiple views to open in a
such way, that each view displays the data of a single device. This means, the second
view displays the data of the second device, while the first view displays the data of the
first device.

To open a new instance of the scanner BCH View:

1. Select a device instance in the view.

2. Click any point in the view with the right mouse button.

The context menu appears.
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3. Select the "New View" menu entry.

The scanner view for that device instance appears.

To remove a view, do the same, but select the "Destroy View" entry instead. This entry
is only available in the context menu on the view also created with "New View". That
means, the view instance number must be bigger than one. The instance number is
visible in the title bar of the view. For example, for the second GSM scanner BCH view,
it is "GSM Scanner BCH View:2".

Once only one instance of the view is left, the data of all devices is displayed in this
single instance.

The functions and the user interface for exporting operation are present in each RAT
BCH scanner view.

The operation has two parts:
● Global export settings
● Filter and export options for the view

Figure 4-753: Scanner BCH View

Global export settings

Global export settings are done via the "Global export settings" entry of the context-
sensitive menu. To get the menu, right-mouse button click any point in the "Scann BCH
View" area, see the blue ellipse on the previous figure. The export settings page looks
like shown in the following figure.
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This dialog combines export and filter functionality in one.

Global export provides the following functions:
● "Target"

Defines export output format (Romes ATD, TXT or Google Earth KML format). If
you choose the "Google Earth" format, the "position is not available" and "position
is taken from Basestation Database" options are dimmed and the base stations
with these characteristics are not included into the final document.

● "Filter"
In this section of dialog user can define filter for export. Export filter combines the
text search options ("Search phrase", "Match case" and "Search in details"), base
station position filter and error ellipse filter (if appropriate checkbox was selected).
If search phrase is empty, it means "the text filter is not applied at all".

● "Additional options"
Export automatically after measurement. If this checkbox was selected, export
starts immediately after the end of measurement, if the user presses the "Stop
measurement" button).
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User has three possibilities to close this dialog:
● Press the "Save and close" button. In this case all settings will be stored in the reg-

istry immediately and would be applied only for automatic export after measure-
ment (if appropriate checkbox was selected).

● Press "Save and export" button. In this case all settings is stored in the registry
immediately and system starts the export follows filter settings.

● Press the "Cancel" button. Dialog closes, no filter changes are stored in the regis-
try.

Note: The settings of this dialog have no effect for the BCH views.

Filter & export options for view

Every "Scanner BCH View" dialog has in the left-bottom corner the "Text Filter" dialog.

Figure 4-754: Filter & Export Options

Unlike the "Global export settings" dialog, this dialog effects only for appropriate view
and does not impact another dialogs. This dialog has the following special features:

● "Set filter"
The  "Set filter" button applies filter to the dialog. If the filter was defined, but not
applied, this button is gray.

● "Clear filter"
The  "Clear filter" resets all filter settings and restores original (non–filtered) set-
tings of the view.

● "Show all messages of matching transmitters"
"Always show messages of transmitters" allows you to see info on base stations
even if the base station information does not match with the text filter settings, but
the parent node does.
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Figure 4-755: Show messages of matching transmitters

For example, if you type in the text search field “1800” and check this option, you
see all base stations of the node “GSM 1800”, because “GSM 1800” contains
search phrase and "Always show messages of transmitters" was selected as
shown in the figure above.

The "Text Filter" dialog has also the export functionality. The dialog provides four differ-
ent kinds of export:

● "Export ROMES Basestation List"
Exports actual view (What You See Is What You Get) to the file in the R&S ROMES
data format.

● "Export to Google Earth"
The same as previous, but to the Google Earth format, and selection of "Position
not available" and "Position is taken from database" check boxes are ignored for
this kind of export. In this case user gets the following notification.

● "Export Complete Tree to Text File"
This option exports whole tree of the view into the plain text file of the following for-
mat:
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Figure 4-756: Format of tree views export

● "Export Selected Branch to Text File"
This option exports information in the same format as a previous option, but only
for selected node. If selected, node has child nodes. You get the following ques-
tion:

Figure 4-757: Export child items

Depending on the answer, an export file contains export data only for selected
node or for the all child nodes. You are informed with the following message about
the export of tree.

Figure 4-758: Successful export
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The filter is automatically restored and applied to the view when launching the program
again next time. Each technology view saves and restores own filter settings sepa-
rately.

4.8.1.2  Scanner Top N view

GSM, UMTS, LTE, NB-IoT, LTE-M, 5G NR, WiMAX, TETRA and cdma200/1xEV-DO
technologies share the generic implementation of the Top N processing and the Top N
display functions. This generic implementation is achieved with a common Top N user
interface and more common Top N views for these technologies, among others in
respect of:

● Choice of a power value for the graph
There are two ways to visualize the power of the mentioned technologies. The
power values of supported technologies are shown in the "List" and "Chart" of the
Top N scanner views, for example, see Figure 4-1071.

● Hovering with mouse over the parameters of a scanner Top N view's "List" line the
Tooltips shows up. The ToopTip contains the definition of the parameter.

Figure 4-759: Description of SINR column

● BTS distance display in the Top N view
The optional parameter "Dist.(km") and the related column in the view are available
for display for each supported technology.

● "Auto Width" button in the "Top N" line for automatic adjustment of the widths of the
columns in the "Top N List". For details, see Chapter 4.8.11.7, "UMTS scanner Top
N view", on page 1404.

However, the Scanner Top N view and some other views suppose a device-specific
configuration, for example, displaying data for a specific UMTS scrambling code. In this
case it does not make a sense to apply the configuration to the complete list of loaded
scanner devices.

The "Device-specific configuration" feature allows a single scanner device to select for
display. Click "Device Selection" to configure scanner views for selected device on this
page. The selection can be done by the device instance or its name on this configura-
tion page, see Figure 4-1065.

The feature works with the second selection option only if the devices or *.rscmd files
are loaded.

The result of the device selection is shown in Figure 4-1066.
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Commonalities applicable to 3GPP technologies

For the Scanner Top N views of the 3GPP defined technologies, i.e, for GSM, UMTS,
LTE, LTE-M, NB-IoT and 5G NR scanner views, the following applies:

● Top N view is set to show all Top N pools
● Option to display the Top N pools as a grid with 2D bar charts instead of standard

3D bar chart.

The following figures of LTE Scanner Top N view illustrate the two mentioned options
of displaying Top N pools in the view's chart.

Figure 4-760: Standard 3D bar chart
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Figure 4-761: Grid with 2D charts

For more details, see "UMTS scanner Top N view for automatic pool configuration"
on page 1406.

4.8.2  5G NR scanner views

The 5G NR scanner views show the information obtained in the 5G network scans per-
formed by the R&S 5G NR radio network analyzer.

Currently supported views are shown in the following figure.

Figure 4-762: 5G NR scanner views

The 5G NR supports several broadcast beams named SSB blocks which contain four
signals, PBCH, DM-RS, SSS and PSS. Each block contains optionally two symbol
types: Full Symbol (Fs) and Not Full Symbol (NFs).

The signals showing the best beam indexes are based on SSB RSRP and SSB SINR
values.
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R&S ROMES4 supports also mixed SSB RSSI signals.

The mixed SSB RSSI is calculated as a function of SSB blocks and their associated Fs
and NFs symbols, using the following expression:

[Fs(PBCH + DMRS + SSS + PSS RSSI) + NFs(PBCH + DMRS + SSS + PSS RSSI)] /
(2*NumberOfValidPairs)

The 5G NR scanner views show the beam values in the following way:

● If a beam value is available, it is shown by "beamindex", for example "5"
● If a beam value is not available but beamindexMod8 is available, it is shown by

"**beamindexMod8", for example "**3"
● If none is available, it is shown as "-"

The values are included in the list of 5G NR scanner available signals within the "gNo-
deB Templates" branch.

The 5G NR scanner provides the information if a gNodeB operates in NSA or SA
mode. The information is available in the "Top N Templates" signal branch of the scan-
ner and as the optional column in the "5G NR Scanner Top N View".

5G NR RAT supports the RAN sharing like LTE does. The additional PLMNs, if config-
ured, are also shown as the "Top N Templates" signal branch of the scanner and in the
"5G NR Scanner Top N View". If selected auto Top N per provider, one Top N is cre-
ated for each provider.

The BCH view creates a provider branch for each PLMN.

To derive the 5G NR operation mode or the additional configured PLMNs for RAN
sharing, 5G Demodulator v47.97 or higher is required during recording.

The Alphanumeric, Top N and 2D Chart views show the signals.
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Figure 4-763: R&S ROMES4 basic and 5G NR scanner TopN views - SSB best index for RSRP

The SSB best index signals have associated events. The events are shown in the fol-
lowing figure.

Figure 4-764: Events associated to SSB best index signals
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The Top N pool members offer an Top N reference signal ("Top N UE Reference")
which reflects the usage of an gNode by the UEs of the current measurement. The sig-
nal provides information on UE's number and its carrier which uses this gNode of the
Top N pool member. The signal is available in the "5G NR Scanner TopN View" as
optional signal. The signal is available in the "SignalTree" > "5G NR Scan" > "Top N
Templates" and in the "Alphanumeric View".

Figure 4-765: Top N UE reference of Top N pool member

The screenshot shows that PCI 337 is currently used as Primary Component Carrier
by UE 4, 5 and 6.

For the detailed of the previously mentioned signals, see "Description of R&S
ROMES4 signals" document.

● 5G NR scanner signals templates.......................................................................1129
● 5G NR BCCH view..............................................................................................1136
● 5G NR scanner chart view.................................................................................. 1141
● 5G NR scanner SSS-PBCH CIR view.................................................................1143
● 5G NR scanner Top N view.................................................................................1145
● 5G NR SSB history view..................................................................................... 1149
● 5G NR SSB performance view............................................................................1150

4.8.2.1  5G NR scanner signals templates

The 5G NR scanner signals templates offer easy access to the measurement data of a
specific gNB. Specify he PCI and the SSB index of the wanted measurement item to
access the measurement data. Most notably in conjunction with the map view is that
you only carry about the SSB index with the best value.

The "Top N Templates" and the "gNodeB Templates" branch of the "Signal Tree" > "5G
NR Scanner" tree are a home of all created template signals.

Figure 4-766: 5G NR scanner signal templates

The best SSB beams for a specific PCI available in the branch improve the usability
and representation of 5G NR parameters in R&S ROMES4. With these signals, you
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can fix PCI and plot all the SSBs for the chosen PCI based on the best measured
beam, RSRP or SINR value.

5G NR scanner template signals can be filtered by Channel/NR-ARFCN, PCI and SSB
index.

To create a template signal, do the following:

1. Select from the "Top N Templates" or "gNodeB Template" branch a signal that you
want to see in a R&S ROMES4 basic view and in the "Signal Tree" as a template
signal for the specified filtering.

2. Drag the selection into the basic view dialog or double click the item in the view's
configuration page.

A dialog pops-up where you can define the filter for the signal.

3. The filter requires you to specify a combination of PCI and SSB index.
If you have selected several signals, tick the "Apply for all signal" box to apply the
same filter for all signals.

The filter for the signal is entered.

The signal now appears in a R&S ROMES4 basic (generic) view and in a template
of the "Signals Tree" > "5G NR Scan" tree.

The template signals can be used to filter the scanner data on the R&S ROMES4 map.
The SSB best index signals are shown as black and white.

Figure 4-767: Matched PCI/SSB combination

If the data matches with the configured PCI/SSB combination, the plot on the map
turns black. If there is no match, it remains white.

Configuration of 5G NR scanner Top N templates

There are no separate branches for each Top N pool and Top N member. Instead,
there is only a single Top N node under the "Top N Templates" node.

The Top N template signal can be configured on any generic view. If a signal is config-
ured on the generic view, a prompt for specific Top N pool and Top N member to be
configured is displayed.
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Figure 4-768: Template to filter Top N PCIs

Configuration of Template Top N Pool: Enter the desired Top N pool number. A
range of Top N pools can be entered by using a comma separator which separates
individual pools or a dash to define a range of pools. For example, entered 1, 2, 4 rep-
resent pools 1, 2 and 4 and 1 to 4 would represent an entry of pools 1 to 4.

If measurement is running or measurement replay is in progress, the valid Top N pools
are available for selection if you click the down arrow. Click one or more of the valid
pools.

Figure 4-769: Available Top N pools

Once all selections are made, click another field or "OK" to close the selection window.

Configuration of Template Top N Member: Enter the desired Top N member number.
A range of Top N members can be entered by using a comma separator which sepa-
rates individual pools or a dash to define a range of pools. For example, entered 1, 2, 4
represent members 1, 2 and 4 and 1 to 4 would represent an entry of members 1 to 4.

Selection of Field Color Code: Once a valid selection is made, the field gets a green
background color. If a selection is not valid, the background color is red.
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Figure 4-770: Colored fields for Top N PCI filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior User
Selections". (These selections are reset each time R&S ROMES4 is restarted). To
select one of the prior selections, check the box next to the desired option and press
"OK". The new selection items are hidden. They reappear if all prior selection boxes
have been deselected.

Figure 4-771: Prior selections

Configuration of gNodeB signals templates

The signals that are directly under the "gNodeB Templates" node prompt only for
Channel/NR-ARFCN.
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Figure 4-772: Channel / NR-ARFCN prompted signal

The signals that are in the nodes under the "gNodeB Templates" prompt only for
"Channel/NR-ARFCN/PCI/SSBx".

Figure 4-773: Prompted signals in subnode

To allow signal configuration with just PCI, uncheck the "SSB Idx" check box. R&S
ROMES4 uses then the best SSB value for that PCI to represent the signal.

Configuration of Channel / NR-ARFCN Value: A Channel Index or ARFCN value can
be entered. Multiple Channel Index/NR-ARFCN can be entered by separating the val-
ues with a “,”sign. For example, by entering 1, 2 selected are the channels 1 and 2.

If a measurement replay file is opened or a measurement is in progress, a list of cur-
rently valid NR-ARFCN values is displayed by clicking the down arrow. One or more of
the values can be selected if you check the box next to the desired choice.

Once all selections are made, click another field or "OK" to close the selection window.

Figure 4-774: Entered and selected NR-ARFCN
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Configuration of PCI: PCI Cell ID value can be entered. Multiple PCI values can be
chosen by separating the values with “,” sign. For example, entered values 393, 394
select PCI value 393 and 394.

Click the down arrow to see a list of valid PCI values of the selected NR-ARFCN in the
opened measurement replay file or in a maeasurement in progress. One or more of the
values can be selected if you check the box next to the desired choice.

Figure 4-775: Entered PCI values

Once all selections are made, click another field or "OK" to close the selection window.

Configuration of SSB Idx: Optionally, a SSB index can be supplied. If not supplied,
the best SSB index for the cell is used when displaying signal values. To select the
SSB index, check the box next to the "SSB Idx" row. A SSB index can be entered.

Multiple SSB indexes can be entered by separating the values with a “,” sign. Click the
drop-down arrow to see the valid SSB indexes of the selected Channel/PCI combina-
tion in opened measurement replay file or in a measurement in progress. One or more
of the values can be selected if you check the box next to the desired choice,

Figure 4-776: Selection of SSB Index

Once all selections are made, click another field or "OK" to close the selection window.

Selection of Field Color Code: Once a valid selection is made, the field gets green
background color. If a selection is not valid, the background color is red.
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Figure 4-777: Colored fields for gNodeB Name filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections" rows. (These selections are reset each time R&S ROMES4 restarts).

To select one of the prior selections, check the box next to the desired option and
press "OK". The new selection items are hidden. They reappear if all prior selection
boxes have been deselected.

Figure 4-778: Preselected template signals

Availability of 5G NR gNodeB info

The "Top N Templates" and "gNodeB Templates" branches contain the optional signals
that provide the 5G NR gNodeB info, that is, a gNodeB name and a distance of a
device to the base station.

The first mentioned branch supports the signal which shows the configured TDD full-
slot pattern apart from the TDD slot pattern signal. The "TDD Pattern(full)" signal pro-
vides the slot number added to the slot letter and the info on slot's symbols configura-
tion. A symbol is marked as "d" for DL, "u" for UL and "f" for flexible symbol. For the
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"Top N TDD Pattern" and the "Top N TDD Pattern(full)" signal, see the Tooltip in the
branch or refer to "Description of R&S ROMES4 signals" document. To see the signals
displaying the TDD configuration only, type filtering criterion "tdd" in "Signal Tree".

Activate the optional signals. They are then visible under the following conditions:

● GPS hardware is connected and properly initialized.
● 5G NR channel has a valid NR-ARFCN (Some low frequency channels can have

valid GSCNs, but not NR-ARFCN).
● 5G NR Cell Database is available and contains the entry for the NR_ARFCN.

4.8.2.2  5G NR BCCH view

The "5G NR BCH View" shows the 5G NR mode of operation, NSA or SA, the signals
derived from SIB1, the signals from other activated SIBs and the all detected beams of
a specific channel. The view shows the configured TDD Pattern(full).

If selected auto Top N per provider, one Top N is created for each provider. The "5G
NR BCH View" creates a provider branch for each PLMN in this case.
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Figure 4-779: 5G NR scanner BCH view

The "5G NR BCH View" can show all R&S ROMES4 supported SIBs if configured to be
demodulated. The following screenshot shows that demodulated are SIB 1, SIB 2 and
SIB 21 of the PCI 52 cell. The details of the SIB 21 are visible on the view's right-hand
side.
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Figure 4-780: Demodulated 5G NR SIB 21

You can obtain the 5G NR SIB demodulation information from the "Open" page when
you run a measurement file. The SIB information including PDU and internals is availa-
ble in "BCH Demod" line of the page.
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Figure 4-781: Open page shows demodulated 5G NR SIBs

For the supported SIBs, see Figure 6-237.

All beams of a provider whose MCC and MNC are not demodulated are listed below
the "Provider information not decoded yet" branch.

Cell identity display in 5G NR BCH view

According to 3GPP TS 38.331 specification, a 5G NR cell identity is 36 bits long string
composed of a gNB identity and local cell identity. A gNB is specified to be of variable
length 22 bits to 32 bits. However the specification does not strictly define how to split
these 36 bits between gNB and local cell ID.

Splitting the specified number of bits for cell identity between gNB identity and local cell
identity is a customer decision.

The R&S ROMES4"5G NR BCH View" shows 36 bits of a cell ID and applies as default
the gNB/local cell ID split 28/8. You can change this cell ID default display in gNB by
entering the wanted split into the registry. The figure shows where to set splitting and
default splitting.
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Figure 4-782: Default splitting of cell ID bits in registry

The following splits are supported by R&S ROMES4.

The sum of bits cannot exceed 36 bits - most right bits bigger than 36 are cut.

The cell ID is available in the "5G NR BCH View" only if SIB1 is present, otherwise the
view shows "n.a.", see Figure 4-779.

Figure 4-783: "NR5G_CI_Split"="28/8"

3GPP TS 38.413 defines a Global gNB ID where the gNB ID as a variable from 22 bits
to 32 bits corresponds to the leftmost bits of the NR cell Identity IE contained in the NR
CGI IE ("GCI" in the figure) of each cell served by the gNB.
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Figure 4-784: "NR5G_CI_Split"="30/6"

Figure 4-785: "NR5G_CI_Split"="36"

4.8.2.3  5G NR scanner chart view

The "5G NR Scanner Chart View" shows the n best beams over all. The view can be
filtered by PCI and frequency.

Scanner views



Display and evaluation of resultsDrive Test Software

1142Operating Manual 1171.6415.12 ─ 66

Figure 4-786: 5G NR Scanner Chart View

The view shows all beams sorted by the selected sorting algorithm. The view is inde-
pendent from any Top N pools and gets all data unsorted. The sorting is done in the
view itself. The view sorts the reported beams every time new measurement values
are reported by SS-SINR.

The background color of the columns corresponds to the PCI and the color of the col-
umn to the beam index.

The filter accepts string of the following format: [Beam@]PCI;[Beam@]PCI;…

The beam value of the filter works as follows:
1. If the beam index is available, the beam is accepted only if the beam index matched
the filter value.
2. If the beam index is not available
● a. If the beamindexMod 8 is available, the beam is accepted only if the beamindex-

Mod 8 matches the filter value.
● b. If the beamindexMod 8 is not available, the beam is not accepted.

Example: 
449  All beams of gNBs with PCI 449 are shown.
31@449  Only the beam 31 of PCI 449 is shown.
449;12@1005  All beams of gNB with PCI 449 and the beam 12 of PCI 1005 are
shown.
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Figure 4-787: An example of filtering

4.8.2.4  5G NR scanner SSS-PBCH CIR view

The "5G NR Scanner SSS_PBCH CIR View" shows the CIR of the different beams.

The CIR results are displayed as NR-ARFCN/PCI/Beam Index combinations.

Figure 4-788: 5G NR Scanner SSS CIR View

The "CIR List" pane provides an option for filtering results displayed in the pane.

The list can be filtered on any of the available columns. The filtering option offers the
following formats:

● XXX   - Exact match for the data
Example 1: Inserted value 13 in the filter  of the "PCI" column shows only CIR
values of the cells having PCI 13 in the "CIR Chart".

● >XXX - Greater than
Example 2: > -50 in "P total" column would show values greater than -50

● >=XXX - Greater than equal
● <XXX - Less than

Example 3: < -50 in "P total" column would show values less than -50
● <=XXX - Less than equal
● !XXX - Not data value

Example 4: The PCI filter !13, shows all items other than !13
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Multiple filters can be applied to each cell and with each filter separated by either
comma or semicolon mark. For example, if you want only PCI 13 and 15 to be shown,
then enter "13,15" in the PCI filter.

In the filter string, there is no difference between using comma or semicolon to spate
filters. For example, "13,15" in the PCI filter produces the same filter result as "13;15".
Only PCI 13 and 15 are displayed.

Update the chart by new input data once the list's filter has been changed.

For the 5G NR scanner CIR signals, see the "Description of R&S ROMES4 Signals"
document.

5G NR scanner SSS CIR view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "CIR View" lets you customize the diagram and the contents of the table in "5G
NR Scanner CIR View".

Figure 4-789: 5G NR Scanner SSS CIR View - configuration
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The configuration scales the y-axis of the "CIR View", selects the information to be dis-
played in the table and corrects the Doppler drift.

Dynamic Range
The two input fields in this panel define the maximal/minimal signal level to be dis-
played in the view. The signal levels out of the range defined with maximal and minimal
signal levels are not displayed.

CIR List Column
The CIR list selects which information to display in the left table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.

Peak List Column
The peak list selects which information to display in the right table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.

Doppler Frequency
The panel provides an input field for correcting the Doppler frequency displayed in the
"Peak List". The purpose of the correction in the measured frequency is to subtract fre-
quency offsets not originating from the speed of the test vehicle relative to the signal
source.
The frequency offset is calculated as follows:
Meas. Freq. [Hz] * Drift Correction [ns/s] * 10^-9.

Channel Timeout
If there is no data on a channel anymore, the "CIR List" entries for this channel are
removed after a timeout.

Show Cyclic Prefix in Graph
The display of the cyclic prefix in the CIR chart can be switched on or off via "Show
Cyclic Prefix in Graph". If the checkbox is ticked, the Cyclic Prefix is displayed as a dot-
ted vertical line of the cell ID color in "CIR Chart" for each "CIR List" element.

4.8.2.5  5G NR scanner Top N view

The columns in the "5G NR Scanner TopN View" are generated automatically from the
Top N signals.

To see all possible 5G NR scanner Top N signals, the default and the optional ones
which can be included in the "List" pane on Top N view, refer to Chapter 12.1, "5G NR
scanner Top N signals mapping", on page 2381.
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Figure 4-790: 5G NR Scanner Top N View

To fill the "Details" pane, set the "Value" to "Cell-xxx" value in "Top N Pool Settings".
The figure shows the possible setting as Cell-RSRP value.
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Figure 4-791: Needed setting to fill Details

Enlarge the page by clicking the "Auto Width" button to see the activated optional sig-
nals in the Top N "List".

Figure 4-792: Enlarged 5G NR Scanner Top N view

If an optional signal is not configured for display in the "Signal Tree", it is not displayed
in the Top N view.

The automatic pool configuration feature is supported with "5G NR Scanner Top N
View". Applied are the common functions and rules as for other 3GPP specified tech-
nologies, see "Scanner Top N view for automatic pool configuration" on page 1262.

For the "Chart" layout in case the feature is active, see Figure 4-761.

5G NR scanner TopN pools calculation

The beam-based 5G TopN pools calculation uses the high-speed data measurements
of a scanner.
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The 5G NR scanner delivers measurement data packets at a maximum of every
200ms. Such an packet can contain several high-speed data measured during the last
measurement period. The all single high-speed measurements are put into the TopN
algorithm. This approach can have an impact, especially if max. is used for TopN pool
ranking.

The TopN pool ranking is based on the observation interval. By default, it is set to 1
second. Therefore, measurement data, which has been reported within the last second
is accounted. It is possible to decrease the observation interval down to 100 ms.

If the "Dynamic: Adjustment to Max Scan Cycle Time Last Minute when above given
Interval" option in the "TEC for 5G NR Scanner" > "Top N Pool Settings" > "Properties"
dialog is active, the observation time is increased to the max. cycle time during the
measurement. If the option is inactive, it can happen that the TopN algorithm invalid-
ates the data due to missing measurement data in the observation interval. The lack of
measurement data can happen during measurement on more than one channel.

The TopN pools ranking is triggered by every scanner measurement packet but does
the calculation at a maximum rate of 1 per second. The example is given for the obser-
vation interval 100ms.

Figure 4-793: TopN ranking observation interval

5G NR scanner TopN view configuration

For the description of the tabs functions included in the configuration page, see "LTE
scanner Top N view configuration" on page 1272.

For the activated optional signals that are selected for visualization, you can choose
whether the SSB-RSSI or SSB-RSRP value to show as the first 2D and 3D chart value.

Figure 4-794: 5G NR Scanner Top N View - configuration
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4.8.2.6  5G NR SSB history view

The view is only available during measurement.

Figure 4-795: 5G NR SSB History View

The maximum number of TopN cells can be configured, the range is 1 to 6.

Figure 4-796: 5G NR SSB History View - set the number of Top N cells

The max number of beam indexes can be also configured, the range is 1 to 6.
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Figure 4-797: 5G NR SSB History View - set the number of beam indexes

To display data in the view, at least one TopN pool must be configured per cell. If cell-
based TopN pools are not configured, the "No Cell Based Top N Pools" error message
is displayed at the top left of the view.

4.8.2.7  5G NR SSB performance view

The view is only available during measurement.

You can select the Top N pool, which you want to be visualized by pressing the corre-
sponding blue button on the upper left corner. Only the Top N pools based on cell sig-
nals are applicable for this view.

The left part of the view shows the best n members of the pool. For each member, the
background column in the color of the corresponding PCI visualizes the average value.
In the front, m bars for the m best beams of the cell are drawn in the color of the beam
index. The values n and m are configurable.

On the right-hand chart, the values of the n best cells are drawn over time. The back-
ground color corresponds to the PCU of the best member (Top1).
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Figure 4-798: 5G NR SSB performance view

Figure 4-799: 5G NR SSB performance view - set details

To display data in the view, at least one TopN pool must be configured per cell. If cell-
based Top N pools are not configured, the "No Cell Based Top N Pools" error message
is displayed at the top left of the view.

4.8.3  C-V2X scanner views

The C-V2X scanner views show the information of cellular vehicle scans obtained with
the R&S TSME6 scanner.

Currently supported views are shown in the following figure.
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Equation 4-1: C-V2X scanner views

During a measurement or file replay, assuming that C-V2 eNodeB signal is configured
for use on a generic view, a list of all available MAC2SrcvIDs of the measurement/
replay is available. The list of all available MAC2SrcvIDs is shown in the L2 MAC
Source ID drop down box of the signal filter dialog.

Figure 4-800: L2 MAC Source IDs added to eNodeB signal

For the R&S ROMES4 supported C-V2X scanner signals, see the "Description of R&S
ROMES4 supported signals".

To get the C-V2X scanner views, check the C-V2X box in the "Romes Technology
Selector" page. The page pops-up during the R&S ROMES4 installation. The box is by
default unchecked.

4.8.3.1  C-V2X scanner message view

The "C-V2X Scanner Message View" shows the signals measured and decoded by the
R&S TSME. The following screenshot displays this view.
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Figure 4-801: C-V2X Scanner Message View - C-V2x and GPS device loaded

The measured signals are displayed in the columns of the "C-V2X Scanner Message
View" grid.

● "UTC Timestamp"- UTC time of this message
● "L2 Mac Source ID" - layer 2 source Id provided by the media access controller
● "RSSI (dBm)" - C-V2X PSCCH RSSI in dBm
● "PSCCH CINR (dB)" -C- V2X PSCCH CINR in dB
● "PSCCH RSRP(dBm)" - C-V2X PSCCH RSRP in dBm
● "PSSCH CINR (dB)" - C-V2X PSSCH CINR in dB
● "PSSCH RSRP (dBm)" - C-V2X PSSCH RSRP in dBm
● "PSSCH BER (%)" - PSSCH block error rate in percentage format
● "Latitude (°)" - C-V2X GPS latitude
● "Longitude (°)" - C-V2X GPS longitude
● "Altitude (m)" - C-V2X GPS altitude in meters
● "Delay (s)" - time delay between the creation of the ITS message in the OBU and

its reception in the R&S TSME scanner.
● "Distance (m)" - distance between the R&S TSME scanner and the C-V2X trans-

mitting OBU/RSU.
● "Altitude Difference (m)" - elevation difference between the R&S TSME scanner

and the C-V2X transmitting OBU/RSU. A positive value indicates that the C-V2X
source of the transmitter is higher.

The Latitude, Longitude and Altitude signals filling the associated columns in the view
are GPS position signals. They can come from two sources, the R&S ROMES4 GPS
device or C-V2X scanner, see the following section.
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The last three signals offer more data related to coverage and range of C-V2X signals.
These signals are based on decoded ITS information during replay. If the L2 MAC
Source ID is not decoded for the Delay, Distance and Altitude Difference signals, no
value is available in the associated columns. The hyphen “-“ is displayed instead.

If double-click any list-item during replay of a selected measurement file, the details
dialog pops up. The details are not supported during recording.

All unique L2 Mac Source IDs are listed on the right side of "C-V2X Scanner Message
View".

The "C-V2X Scanner Message View" supports Coupled Focus feature. Clicking one
view synchronizes its timestamp with other views.

GPS position display

The GPS position data for filling the GPS columns of the "C-V2X Scanner Message
View" can come from two sources: the R&S ROMES4 GPS device or the C-V2X scan-
ner.

1. If you load C-V2X scanner and R&S ROMES4 GPS device, the GPS position col-
umns of the view are filled by R&S ROMES4 GPS device as shown in the previous
screenshot.

2. If you load C-V2X scanner, without loading any R&S ROMES4 GPS device, GPS
data in C-V2X scanner are used. In this situation, the symbol “*” appears at the end of
the GPS position values.

Figure 4-802: C-V2X Scanner Message View - GPS position data w/o GPS device load

C-V2X measurement does not start if GPS is not available.

The "C-V2X Scanner Message View" supports warning message if GPS signal is not
available for longer time. The error message appears every other 20 seconds in that
case.
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Figure 4-803: Error message - no GNSS information

Decoding of ITS messages

To improve the performances, the full ITS Info in a measurement file is decoded in
batch mode.

The ITS messages are decoded in replay mode only and they are not available in mea-
surement mode. The initial ITS messages decoding starts automatically after a C-V2X
measurement file is loaded. A progress message is displayed.

Figure 4-804: Progress of ITS messages decoding

A measurement file contains multiple frames. Each frame contains multiple XML pack-
ets or ITS messages.

The XML packets are processed in batch mode, each batch contains 1000 packets by
default.

ITS messages decoding only occurs after measurement file is fully loaded. Decode ITS
messages using "Add ITS info to grid".

Figure 4-805: Enabled/disabled Add ITS info to grid

Decoding process can be stopped at any time using the "Cancel" button, for example,
if the decoding takes too long for large measurement files.

If the decoding is stopped before it is done, the ITS decoding is partially finished. The
three previously mentioned columns of the "C-V2X Scanner Message View" can be
partially filled.
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Figure 4-806: Delay, Distance and Altitude Difference columns display of partly decoded ITS mes-
sages

To resume the ITS messages decoding:

1. Right mouse click any point in the view's grid. The configuration menu pops-up.

2. Click "Add ITS info to the grid" from the menu.

The ITS decoding continues from where it was stopped.

If measurement file is configured to be loaded when R&S ROMES4 starts, the ITS
decoding is disabled.

Under the following situations, the "Add ITS info to the grid" is grayed out and decoding
is disabled:

1. The ITS messages are fully decoded.

2. The measurement file replay is in progress.

3. The measurement file is closed.

C-V2X scanner message details dialog

To see the details dialog of the C-V2X scanner messages, right mouse button double
click a list-item during replay of the measurement. A message detail dialog pops up.
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Figure 4-807: Details dialog of the C-V2X Scanner Message View

The top line of the dialog provides some functions for the dialog easier handling.

Figure 4-808: Functions of the details dialog

The functions are described in the following table.

Function Meaning

1 Edit box for searching ITS message tree

2 Search for the next message

3 Search for the previous message

4 Copy to clipboard

5 Print

6 Save to disk

7 Pin to screen
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The pinned box stays and shows the message details if the box is pinned. Double-click
again to get the updated detail box.

The top line is followed by the dissector result of the message.

Figure 4-809: Results of measured channels

ITS info is displayed on the ITS Info dissection in the middle of the detail dialog.

Figure 4-810: Signals in the ITS Info section

The auto-scroll-down feature shows the recorded messages in the list during the C-
V2X messages recording.

C-V2X scanner message data export

With the right mouse button double-click any point in the view, you get the pop-up
menu shown in the screenshot.

Figure 4-811: Options to export the measurement list

You can export the list content to a CSV file if you select "Export data as CSV" from the
menu. The default export file name is V2X_Message_CSV_Export.csv.

The exported file is here shown. The first line is the header of exported measurement
list.

Figure 4-812: Export file layout

If you select "Export C-V2X ITS Messages", the ITS messages associated with the list
can be exported. The default exported message name is
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ITS_Message_Export.its. The exported data is many lines of hexadecimal strings
of the ITS messages. The first line in this file is also the header.

4.8.3.2  C-V2X scanner Top N view

The "C-V2X Scanner Top N View" is displayed in the following screenshot.

Figure 4-813: C-V2X Scanner Top N View

The following signals are measured and displayed in the view.

● "#"- amount of measured SCH within Top N pool
● "TopX" - top x
● "Center Frequency" - center frequency of the C-V2X channel in Hz
● "EARFCN" - E-UTRA absolute radio frequency channel number. ":" separates the

channel frequencies in the list
● "TopX" - layer 2 source Id provided by the media access controller
● "RS-RSSI (dBm)" - reference signal RSSI in dBm
● "RSRP (dBm)" - RSRP in dBm
● "RS-CINR (dB)" - CINR of the physical sidelink control channel
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4.8.4  CDMA2000/1xEV-DO scanner views

The CDMA2000/1xEV-DO scanner views show the CDMA2000/1xEV-DO information
obtained in the CDMA2000/1xEV-DO network scans performed by an R&S radio net-
work analyzer. The R&S TSME scanner with its hardware R&S TSME-K22 option for
cdma2000 and the R&S TSME-24 option for 1xEVDO is required.

The CDMA2000/1xEV-DO network scan available option for R&S TSME is R&S
ROMES4T1E.

The CDMA2000/1xEV-DO network PNS configuration is described in Chapter 6.4.20,
"CDMA2000 1xEVDO pseudo noise scanner (PNS)", on page 1806.

The "cdma2000/1xEV-DO Scanner Views" can be selected from a submenu displayed
on the right side of the "View" menu when the mouse hovers over "cdma2000 1x EV-
DO Scanner Views".

Figure 4-814: cdma2000 1x EV-DO Scanner views

4.8.4.1  CDMA2000/1xEV-DO scanner F-PICH view

The "cdma2000/1xEV-DO Scanner F-PICH View" shows the average signal power of
the received Forward Pilot Channels (F-PICHs) and a comprehensive analysis of the
properties of all DL signals received in the CDMA2000 PN scan.

The F-PICH is an unmodulated, direct-sequence spread spectrum signal transmitted
continuously by each CDMA base station. The Pilot Channel allows a mobile station to
acquire the timing of the Forward CDMA channel. It also provides a phase reference
for coherent demodulation, and a means for signal strength comparisons between
base stations. The signal strength comparison is used to determine when to handoff
and for the forward link signal strength measurement.

Different base stations are identified by different pilot PN sequence time phases ("Off-
set" values). Signals with different timing but equal PN offset originate from the same
BTS but propagated along different paths. A comparison of those signals provides
important information on reflections and possible interferences.
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Figure 4-815: Scanner F-PICH View

Frequency

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "Scanner F-SYNC View".

Changing the frequency in one of these views automatically adapts the frequencies in
all other views. This capability provides that the views have the same current number
in their title bar (e.g. the 1 in the figure above). The feature generates different groups
of views by the same current number (opened by the context menu) and selects fre-
quencies for an entire group by a single mouse click.

View area

The entire view area is horizontally split to accommodate a chart and a table/list. The
"F-PICH CIR Chart" shows the average signal power of the F-PICHs of all received
signals over the time. The displayed powers and times correspond to the "Ec (F-PICH)
[dBm]" and "Delta T[µs]" values listed in the "Peak List" (right-hand part of the "F-PICH
List" ).

Click the "F-PICH CIR Chart" or "F-PICH Lists" title bar to compress or expand the 2D-
chart or table. A compressed chart leaves more space for the table and vice versa.
Moreover, the tables appear in several Scanner views so that compressing them can
help to avoid redundancies. A compressed sub diagram is characterized by the symbol
>>> (instead of <<<) in its title bar. On pausing on one of the title bars, the cursor dis-
plays a compress symbol.

Diagram scale

The diagram is opened with a default x-axis scale of little more than one F-SYNC
frame length (25.666 ms, the F-PICH frame is 20 ms long). If placed inside the diagram
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area, the cursor takes the shape of a zoom-in icon (a magnifying glass with a '+'
inside). A vertical line is displayed at the cursor position.

A left mouse click magnifies the diagram in x-direction around the cursor position, "Ctrl"
plus left mouse click causes the opposite. An area to become the new x-axis range
(e.g. the area around a peak) can be marked while the left mouse button is pressed.
"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

The scale of the y-axis (power in dBm) can be set in the configuration menu.

Table entries

Below the diagram, the "F-PICH List" gives an overview of the received signals
together with their scrambling codes, different power parameters, frequency and timing
information. On mouse rollover, each cell in the table header provides a short explana-
tion of the corresponding column.

The entire table is divided into the "F-PICH List" and the "Peak List". In the configura-
tion menu, it is possible to show or hide each individual table row in both lists.

F-PICH list

The "F-PICH List" (left-hand part of the "F-PICH Lists") provides a general description
of the received F-PICH signals from each BTS. Each signal is characterized by its PN
sequence offset, corresponding to the transmitting BTS, and includes all possible
peaks (reflections) indicated in the Peak List on the right-hand side.

The list can contain the following F-PICH-related values (see also standard
TIA-2000.2-D and related standards. All power results in the F-PICH List and Peak List
are obtained in an unbiased measurement: The contribution of the noise floor to the
powers is subtracted.
● Offset

Pilot PN sequence offset index; time offset of the Forward Pilot Channel from
CDMA system time, as transmitted by the base station. The offset is expressed in
units of 64 PN chips of the F-PICH. It ranges from 0 to 511.
Each offset is identified by a color, to be customized in the configuration menu. The
offset color codes are also shown in the "ROMESMAP Route Track View" menu.

Signal power

● "Ec/Io [dB]"
Ratio of the received energy per PN chip of the F-PICH to the total inband power
spectral density. The value equals to the sum of the "Ec/Io (F-PICH) [dB]" values of
all individual peaks of the same PN offset displayed in the "Peak List".

● "RSCP [dBm]"
F-PICH Received Signal Code Power; sum of the received powers of all peaks on
one code, measured within the correlation section of the F-PICH.

● "P total [dBm]"
Total average inband power measured within the correlation sections of the F-
PICH. The correlation section is the same for all signals, so "P total" is the same for
all BTSs. The "P total" is equal to Io within the F-PICH correlation section so that
the following relation holds:
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"P total + Ec/Io = RSCP"

Peak list

The rows of the "Peak List" (right-hand part of the "F-PICH Lists") describe the single
peaks (reflections) that contribute to the different BTS signals.

The list can contain the following values (see also standard TIA-2000.2-D and related
standards):
● "Offset"

Pilot PN sequence offset index

Signal power
● "Ec (F-PICH) [dBm]"

Average energy per transmitted PN (Pseudo Noise) chip for the F-PICH, divided by
the chip period and thus converted into an average received signal power

● "Ec/Io (<Ch>) [dB]"
Ratio of the received energy per PN chip for the F-PICH to the total transmit power
spectral density

Signal timing
● "Delta T [µs]"

Time delay of the signal slot timing relative to the CDMA system time or GPS time
(hardware-dependent). The reference time (left edge of the diagram) is of minor
importance. The importance is minor because the diagram extends over more than
one frame, which is enough to display and separate all received signals.

● "Distance [km]"
Distance to BTS

Special table entries

Depending on the conditions of the measurement, the tables show some particular
results:
● An invalid result "---" denotes that a peak or the entire BTS signal was too weak to

be accurately measured. Selecting "SR1 High Dynamic mode" in the measure-
ments tab of the scanner configuration menu generally reduces the number of
invalid results.

● A number (":1, :2" etc.) behind the offset denotes that signals with the same PN off-
set but with a significant difference in their time delays were received.
Two different scenarios can cause multiple PN offsets:
– If several of those signals occur at the same time, they are likely to belong to

different BTSs that accidentally use the same PN offset.
– Two signals, having different numbers behind their PN offsets received at differ-

ent times, can belong to the same BTS, but actually indicate a strong time drift.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu has the additional "Reset Zoom" command to reset the x-axis scale.
The reset range is 0 ms to approx. 26.5 ms.

CDMA2000/1xEV-DO scanner F-PICH view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: F-PICH view

The configuration menu of the "cdma2000/1xEV-DO Scanner F-PICH View" custom-
izes the diagram in the view and the contents of the table.

Via the "cdma2000/1xEV-DO Scanner F-PICH View" tab the user can set the y-axis
scale of the "cdma2000/1xEV-DO Scanner F-PICH View", select the information to be
displayed in the table and correct the Doppler frequency.

In addition, the data which is shown during replay in two lists of the view can be expor-
ted to *.xml files. Instead, export to CSV format is also possible.
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Figure 4-816: cdma2000/1xEV-DO Scanner F-PICH View

Dynamic Range
The two input fields in the "Dynamic Range" panel define the minimum "(Min [dBm])"
and the maximum "(Max [dBm])" level to be displayed in the "Scanner F-PICH" view
diagram.

F-PICH List/Peak List
The "F-PICH List" and "Peak List" panels select which information is displayed in the
tables below the "Scanner F-PICH" diagram, see Figure 4-816. Clearing a box hides
the corresponding column in the diagram.

Export During Replay
The export during replay is active if "Export during Replay" is checked. The content of
the corresponding tables is then exported into a text file of the R&S ROMES4 export
directory.
The file names are generated from the cmd file name, the view name, plus “CIR” or
“Peaks" and the scanner instance, for example:
C2K-EVDO-PE-Scan-Pantech_cdma2000_
1xEV_DO_Scanner_F_PICH_View_1_
CIR_0.xml
The xml content for CIR looks like:
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The xml content for Peaks looks like:
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Note: Position data for every <ListContent> entry is available in CIR and CIR peak
export files.

Configuration: color settings

The "Color Settings" option in the scanner views lets you define the color scale of dif-
ferent signals dependent on technology. The color codes are also shown in the
ROMESMAP Route Track menu.

The following settings are available:
● "Random"

No ordering; colors are assigned to a signal at random.
● "All Gray"

Color scale suppressed; all colors are gray. This option is suitable, for example to
distinguish a single scrambling code or preamble index (or a few scrambling codes
and a few preamble indexes, respectively).

● "Default"
Predefined color scale: colors change continuously as a signal changes

● "Load"/ "Save"
A color scale can be loaded from a color file (e.g SC color file *.scc) and user-
defined color scales can be stored to *.scc files to be reused in a later session.
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Figure 4-817: cdma2000/1xEV-DO Scanner F-PICH View color settings

4.8.4.2  CDMA2000/1xEV-DO scanner BCH view

The "cdma2000/1xEV-DO Scanner BCH View" shows a list of all CDMA/1xEV-DO Sys-
tem Information (SI) messages (the cdma2000 Layer 3 messages) and the ATIM PDU
decoded from the BCH demodulator. The messages are the Layer 3 messages from
the CDMA/1xEV-DO sync. channel and the CDMA/1xEV-DO paging channel.

The SI messages are available only if the PNS data is recorded. The data is recorded
if the "BCH Demodulation" is active. Decoding of each SI message type must be
enabled explicitly in the CDMA/1xEV-DO PNS scanner configuration menu, see Chap-
ter 6.4.20.2, "Configuration menus CDMA2000 1xEVDO PNS", on page 1807.

If the position information is available in a Layer 3 message, it is extracted and han-
dled, as if the position estimation information had been applied, see "BTS position esti-
mation" on page 1170. The contents appear in a tree view.
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Figure 4-818: cdma2000/1xEV-DO Scanner BCH View - selected BTS details

The view accumulates the acquired SI messages and displays them on the left side of
the view. The SI messages are grouped under the network providers who are identified
by their NID and SID.

Each second-level node of the data tree shown represents a CDMA/1xEV-DO BTS
sector identified by NID, SID and ID. If it can be found in the CDMA/1xEV-DO database
loaded, the corresponding name is shown, e.g. MXU811A. Otherwise, the name is
composed as follows:

BTS<Base_ID>_<NID>_<SID>, where

<Base_ID> is a decimal Base_ID value, 5 digits.

<NID> is a decimal NID value, 5 digits.

<SID> is a decimal SID value, 5 digits.

e.g.: BTS00509_00002_00030.

Some parameters (PN, ID, position) are appended to the BTS name. If the BTS has
been retrieved from the database, the position is displayed as Lon <value> Lat
<value>. If the BTS has been generated from Layer 3 measurement without a corre-
sponding database entry, the position is displayed as Lon *<value> Lat *<value>. The
formats of the position values depend on the corresponding global R&S ROMES4 set-
ting.

Referring to the R&S ROMES4 support of dynamic PDU handling described in "Imple-
mentation of the dynamic PDU handling" on page 284, the "cdma2000/1x EV-DO
Scanner BCH View" is enhanced to show the list of measured variants of PDUs over
time. The PDU variants are shown as leaves of the base station.

Select a signal on the left side of the "cdma2000/1x EV-DO Scanner BCH View" to get
the details of your selection in "Details" pane. The "PDU Variant List" is a list of time
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stamps if there were different variants found. The "TimeStamp" shows the most recent
measurement of the PDU variant.

BTS position estimation

If the position estimation is active, the estimated positions are added to the BTS
entries. Estimated positions are marked by an asterisk.

At the end of measurement, the view automatically generates a BTS list import file with
an entry for every estimated BTS position.

Files

Two files are generated for each *.rscmd measurement file.
● CDMA_BTS_LIST<measurement filename>.ATD

Contains the database definition.
● CDMA_BTS_LIST<measurement filename>.TXT

Contains the BTS data.

The CDMA list files are stored in the R&S ROMES4 measurement directory. When the
measurement file replay ends, the same BTS list can be created via the view’s context
menu "Generate CMDA List" option.

Example

● Measurement file:
zgb-muc.rscmd

● Generated files:
CDMA_BTS_LIST_ zgb-muc.ATD
CDMA_BTS_LIST_zgb-muc.txt

Content *.ATD and *.TXT files

For a detailed example, refer to "Example" on page 1185.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

Scanner views



Display and evaluation of resultsDrive Test Software

1171Operating Manual 1171.6415.12 ─ 66

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

CDMA2000/1xEVDO scanner BCH configuration

The "Configuration" option lets you set the color for the selected BTS symbols in the
"ROMESMAP Route Track View" and define the filter for generating a BTS list.

Open the configuration page by a right mouse click on a point inside the view or via the
"Tools" > "Configuration Active View" command.

It is possible to get the BTS position information from the BTS Position Estimator or to
use the information from the Layer 3 messages.

Figure 4-819: cdma2000/1xEVDO Scanner BCH View – configuration
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Note: Layer 3 messages do not always have the BTS position information. Also, the
data from Layer 3 messages can be imprecise, which depends on the provider.

4.8.4.3  CDMA2000/1xEV-DO scanner F-SYNC view

The "cdma2000/1xEV-DO Scanner F-SYNC View" shows the information that the net-
work analyzer, see Chapter 4.8.4, "CDMA2000/1xEV-DO scanner views",
on page 1160 decoded from the Forward Synchronization Channel (F-SYNC). The F-
SYNC corresponds to code channel 32 in the forward CDMA channel which transports
the synchronization message to the mobile station.

Figure 4-820: cdma2000/1xEV-DO Scanner F-SYNC View

Frequency

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "cdma2000/1xEV-DO Scanner F-PICH View".

Changing the frequency in one of these views automatically adapts the frequencies in
all other views, provided they have the same current number in their title bar (e.g. the 1
in the figure above). Using this feature, it is possible to generate different groups of
views with the same current number (opened with the context menu). You can select
frequencies for an entire group with a single mouse click.
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View area

The entire view area is vertically split in two parts:
● The left part displays all PN offset values decoded from the F-SYNC. The fre-

quency of F-SYNC demodulation can be set in the "CDMA measurements"
on page 1818 tab of the CDMA PNS scanner configuration menu. The setting is
done once for each frequency, once for each new pilot, or once for each new pilot
but not more than once per 30 s. The color code is set in the "cdma2000/1xEV-DO
Scanner F-SYNC View" configuration menu.

● The left part displays the name of the different information elements in the synchro-
nization message and the last decoded values.

Information elements

The contents of the synchronization message are described in standard TIA-2000.5-D.
● "PILOT_PN"

Pilot PN sequence offset index, see Chapter 4.8.4.1, "CDMA2000/1xEV-DO scan-
ner F-PICH view", on page 1160).

● "P_REV"
Protocol revision level

● "MIN_P_REV"
Minimum protocol revision level

● "SID"
System identification

● "NID"
Network identification

● "LC_STATE"
Long code state

● "SYS_TIME"
System time

● "LP_SEC"
Number of leap seconds that have occurred since the start of the system time

● "LTM_OFF"
Offset of local time from system time

● "DAYLT"
Daylight savings time indicator

● "PRAT"
Paging channel data rate

● "CDMA_FREQ"
Frequency assignment

● "EXT_CDMA_FREQ"
Extended frequency assignment

● "SR1_BCCH_NON_TD_INCL"
SR1 Non-TD BCCH support indicator

● "SR1_TD_INCL"
SR1 TD BCCH support indicator
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● "SR3_INCL"
SR3 support indicator

● "DS_INCL"
Direct spread (DS) system and information available

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

Scanner F-SYNC view configuration

For the "Scanner F-SYNC View" configuration, see "Configuration: color settings"
on page 1167.

4.8.4.4  CDMA2000/1xEV-DO scanner system time line estimation view

The "cdma2000/1xEV-DO Scanner System Time Line Estimation View" shows the esti-
mated time of the PN offset arrival time intervals.

Figure 4-821: cdma2000/1xEV-DO Scanner System Time Line Estimation View

View area

The PPS signal from GPS and its delay have to be assessed continuously even when
the GPS signal is not available.
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This view shows the parameters related to the CDMA time line measurement. The
"System Time Line Estimation View" has no configuration menu assigned.

Information elements

The contents of the System Time Line Estimation View are described in this section.
● "GPS/PPS Signal"

Shows if arrival time was measured via GPS.
● "Estimation Method"

The following combinations are possible:
– 1. No Demod. / no GPS PPS: Offset value is random, transmit time is estima-

ted by receive time.
– [2. No Demod. / GPS PPS: not used]
– 3. Demod. / no GPS PPS: Offset value is correct, transmit time was estimated

by received pilots.
– 4. Demod. / GPS PPS: Offset value is correct, transmit time has GPS PPS

accuracy.
● "Age of demodulation"

Age of the last GPS PPS demodulation
● "Age of PPS"

Age of the last PPS signal from GPS.
● "PPS Delay"

Measured GPS PPS time difference in [ns].
Range: -1 ms (-1000000) to 999 ms (999000000)
The PPS delay shows the GPS arrival time for the case that the measurement
results (delays) are correct. If a time delay for a BTS signal is known, the measure-
ment error of the PN Scanner result can be calculated. The same error applies to
this value.
Example: PN Offset 271 was measured. The frame of this signal is transmitted
271*64/1228800 sec = 14114.58 µs after a frame with offset 0.
Assumption: The distance to the BTS is 5 km. So a measurement result of
14114.58 µs + 16.67 µs = 14131.31 µs is the expected measurement value. If for
instance, a delay of 14141.31 µs is measured as a delay value for this BTS, the
measurement result has an error of +10 µs. Now both delay value and PPS delay
value can be reduced by 10 µs to obtain the correct results.

4.8.4.5  CDMA2000/1xEV-DO scanner Top N view

The "cdma2000/1xEV-DO Scanner Top N View" displays the properties of the signals
from the NodeBs that are elements of the "Top N Pools" defined in the scanner config-
uration menu. A Top N pool contains up to N NodeBs with specific characteristics pro-
viding the strongest P-CPICH level at a given position and time. For more information,
refer to the description of the scanner configuration menu in chapter 6.
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Figure 4-822: cdma2000 1xEVDO scanner Top N view

The "cdma2000 1xEVDO Scanner Top N View" screenshot shows the cdma detected
physical channel (frequency) of one received CIPCH.

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.

The splitter position between the upper and lower part of the scanner view area and
the open or closed state of the "Top N List" and "Top N Chart" are restored from the
workspaces.

Top N list

The cdma2000/1xEV-DO "Top N List" gives an overview of the received signals in the
current Top N pool including measured power parameters, frequency and timing infor-
mation. On mouse rollover, each cell in the table header provides a short explanation
of the corresponding column.
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The "Top N List" contains the following columns:
● "Color"

Sequence number and the configured PN color.
● "#"

Number of the measured BTS (Node B) within a Top N pool.
NodeBs are numbered in ascending order, according to the time when they enter
the Top N pool. The current numbers tend to increase as the measurement pro-
gresses.

● "Rank"
Current rank of a Node B within the Top N pool, according to its average or maxi-
mum Ec/Io (see scanner configuration menu)
The ranks are reassigned every time the pool is updated; they are in the range 1 ≤
Rank ≤ N.

● "Frequency"
Frequency of the received physical CPICH

● "Channel type"
Channel type 1xRTT (C2K) or 1xEV-DO (EVDO)

● "Offset"
Channel offset

● "MeasID"
Measurement ID for measurements of a specific BTS
Measurement results with equal channel and MeasID values are expected to be
from the same BTS. If the results are not certain but the measurement was at the
same channel as a previous measurement, the ID is incremented. In this case, still
the measurement results can be from the same BTS but not with certainty. The PN
Offset in the measurement results is not used to indicate that results belong to the
same BTS as the PN Offset is time-estimated, demodulated, or invalid until the
time line estimation was finished.

● "EcIo (dB)"
Average Ec/Io= Ec Chip energy of the F-CPICH (unbiased), Io=Total inband energy
during one chip

● "RSCP (dBm)"
Integrated received signal code power for all measured peaks (unbiased)

● "P Total (dBm)"
Total averaged inband power within the correlation section on P-CPICH

● "BTS Name"
Name of the closest BTS with matching channel/PN

● "Dist. (km)"
Distance to the potential interferer, calculated from the BTS database; 0 km means
that the interferer is a different sector of the same BTS

● "SID"
Sub-net identifier

● "NID"
Network identifier

● "Base ID"
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The identity value derived from demodulated CDMA2000/1xEV-DO system mes-
sage. It is not always available.

Figure 4-823: Base ID signal in CDMA PNS

Diagram

Below the "Top N List" there is the "Top N Chart" showing the RSCP for all NodeB sig-
nals in the current Top N measurement.

Signals from different NodeBs are distinguished by their "PN" offset and "ID" displayed
along the x-axis. The scales for the RSCP and Ec/Io (signal quality) are displayed on
the left and right edge of the diagram, respectively. The y-axis scales (RSCP in dBm
and Ec/Io in dB) can be set independently in the configuration page. The left y-axis is
displayed if the "Show signal quality" box is checked in the configuration menu.

The color of the bars reflects the color of the PN offset. This color you can remark on
the very left column of the "TopN List" pane.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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CDMA scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-824: cdma2000/1xEV-DO Scanner Top N View configuration

The "cdma2000/1xEVDO Top N View" option lets you configure the following:
● Signals to be displayed in the "Top N List" of the scanner's Top N view. The "Top N

list" on page 1176 provides the signals' definitions. A signal is activated if the asso-
ciated check box in the "List Column" is checked.

● Y-axis scale of the "Top N Chart". You can configure for display the minimum and
the maximum value of signal level RSCP[dBm] and signal quality Ec/Io [dB].

● You can select for display the signal quality if the "Show signal quality" box is
checked in the "Graph" pane. Switch on or off the second y-axis on the chart and
quality signal bars.
If this option is selected, consider that you get the result of the switching in the next
frame. The chart must redraw at least once for it.

4.8.5  GSM scanner views

The GSM scanner views show the GSM network scan data obtained by a R&S radio
network analyzer. For this purpose used is the R&S TSME sanner with its hardware
R&S TSME-K23 option.
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The GSM network scan available option for R&S TSME is R&S ROMES4T1E.

The GSM network scanner is described in the Chapter 6.4.18, "GSM network scan-
ner", on page 1775.

The GSM scanner views can be selected from a submenu displayed in the "View"
menu when the mouse hovers over "Scanner Views" > "GSM".

Figure 4-825: GSM scanner views

● GSM scanner signals templates..........................................................................1180
● GSM scanner BCH view......................................................................................1181
● GSM scanner Top N view....................................................................................1187
● GSM scanner transmitter view............................................................................ 1196

4.8.5.1  GSM scanner signals templates

R&S ROMES4 offers easy access to the measurement data of a specific scanned
channel using the "Scanned Channel<ARFCN\BSCI>Template" branch of the "Signal
Tree".

Figure 4-826: GSM scanner template signals

1. Select from the "Scanned Channel<ARFCN\BSCI>Template" branch a signal you
want to be shown in a R&S ROMES4 view and in the "Signal Tree" as a template
signal. Drag & drop the selection into the view or double click the item in the view's
configuration page.

2. A dialog pops-up asking you to define the filter for the signal. In the case of GSM
scanner, this filter asks for the ARFCN or the combination of ARFCN and BSIC.
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Figure 4-827: Enabling GSM scanner templates

If you have selected several signals, check the "Apply for all signal" check box.
This will apply the same filter for all signals.

Enters the filter for the signal.

The signal now appears in the R&S ROMES4 view and in the "Template Signals"
branch added to the "Signal Tree".

Figure 4-828: Alphanumeric view of the template signal PSCH

The template signals branch is a home of all created template signals.

The dialog remembers the last set values.

The template signals are a part of the workspace. This means that they will be stored
to the workspace and restore when loading a workspace. Creating a new workspace
will remove the template signals.

4.8.5.2  GSM scanner BCH view

The "GSM Scanner BCH View" shows a list of System Information (SI) types decoded
by the GSM BCH demodulator. The content of each SI appears in a tree view on the
right side of the view as soon as the block is selected. The SI types and their informa-
tion elements are described in standard 3GPP TS 44.018.
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Figure 4-829: GSM Scanner BCH View - selected SI Type 3

The "GSM Scanner BCH View" contains the tabs for multiple scanners if the option is
activated, see Figure 3-200.

Extraction of system information

The SI is available only if the scanner data is recorded with the "BCH Demodulation"
enabled. Decoding of each SI type must be enabled explicitly in the GSM NWS scan-
ner configuration menu, see Chapter 6.4.18.4, "BCH demodulation", on page 1782.

The view accumulates the SI types of a BTS (Base Transceiver Station sector)
acquired as a tree. The information is grouped under the BTS details, see Fig-
ure 4-829.

If a SI Type n is selected by clicking it, its decoded content is shown as a tree on the
left side of the view, in the "Details", see Figure 4-829. If a BTS node is selected, its
parameters are shown instead.

For example, the SI Type 3 contains the information on cell identity, PLMN, control
channel and so on. The SI Type 2 and SI Type 2bis contain the information on neigh-
bor cells which can be seen as "2G Neighbours".
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Figure 4-830: GSM Scanner BCH View – serving and 2G neighbours

The first level node of the data thee shows the network operator details, that means,
MCC and MNC. Each second node level of the data tree represents a BTS identified
by LAC, CI and ARFCN. If it can be found in the loaded GSM BTS database, the BTS
name is shown, e.g. MXB053A. Otherwise, the name is composed as “S” followed by
the hexadecimal values of the parameters: "S[MCC]_[MNC]_[LAC]_[CI]". For example,
S262_001_34567_30641.

Based on R&S ROMES4 support of dynamic PDU handling described in "Implementa-
tion of the dynamic PDU handling" on page 284, the "GSM Scanner BCH View" is
enhanced to show the list of variants of PDUs over time. This is shown for the SI Type
3 in Chapter 6.4.18.4, "BCH demodulation", on page 1782. The PDU variants are
shown as leaves of the base station.

If a SI type is selected on the left side of the "GSM Scanner BCH View", the list of PDU
variants and the list of associated time stamps are displayed on the view's right side.
The "PDU Variant List" in the upper right of the view shows one time stamp as there
was one variant found in the mentioned figure.

The "PDU Variant List" shows the most recently found measurement of the variants.

See also Chapter 4.8.11.2, "UMTS scanner BCH view", on page 1377.

Extraction of SI2ter and SI2quater

The R&S ROMES4 GSM network scanner automatically demodulates all indices of the
SI Type 2ter and SI Type 2quater messages and shows them in BCH view, if the
demodulation of Layer 3 messages is activated.
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The performances of ACD are increased in sense of faster and more sensitive channel
detection if ACD is configured to use the SI Type 2quater message.

To see the message contents, select a PDU in the "PDU Variant List".

Figure 4-831: Demodulated SI2quater message

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.
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● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

BTS position estimation

If BTS position estimation is active (see "Hardware" > "Available Devices" > "BTS Posi-
tion Estimatior"), the estimated positions are added to the BTS entries. The estimated
positions are marked by an asterisk.

During a measurement, the view automatically generates a BTS list import files with an
entry for every estimated BTS position.

Files

Two files are generated for each *.rscmd measurement file.

● GSM_BTS_LIST<measurement filename>.ATD
Contains the database definition.

● GSM_BTS_LIST<measurement filename>.TXT
Contains the BTS data.

Example

● Measurement file:
manert_bts-position-estimation__2008-01-11_20-32-07.rscmd

● Generated files:
– GSM_BTS_LIST_manert_bts-position-estimation__2008-01-11_20-55-47.ATD
– GSM_BTS_LIST_manert_bts-position-estimation__2008-01-11_20-55-47.TXT

Content ATD file

[Main]
Type=ATD
[Table1]
Name=
File=GSM_BTS_LIST_manert_bts-position-estimation__2008-01-11_20-55-47.TXT
Columns_Size=13
Columns0_Name=BTS_Name
Columns0_Type=utDynChar
Columns1_Name=Longitude
Columns1_Type=utDouble
Columns2_Name=Latitude
Columns2_Type=utDouble
Columns3_Name=BCC
Columns3_Type=utUTInt
Columns4_Name=C0
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Columns4_Type=utUSInt
Columns5_Name=CI
Columns5_Type=utUSInt
Columns6_Name=NCC
Columns6_Type=utUTInt
Columns7_Name=LAC
Columns7_Type=utUSInt
Columns8_Name=MNC
Columns8_Type=utUTInt
Columns9_Name=MCC
Columns9_Type=utUTInt
Columns10_Name=#PosErr1
Columns10_Type=utFloat
Columns11_Name=#PosErr2
Columns11_Type=utFloat
Columns12_Name=#Err1Axis
Columns12_Type=utFloat

Content TXT file

The BTS List files are stored in the R&S ROMES4 measurement directory.

This BTS list can also be generated after the complete file has been replayed and R&S
ROMES4 has been stopped via the view's context menu option “Generate BTS List”

GSM scanner BCH configuration

The "Configuration" option lets you set the color for the selected BTS symbols in the
"ROMESMAP Route Track View" and define the filter for generating a BTS list.

Open the configuration page by a right mouse click on a point inside the view or via the
"Tools" > "Configuration Active View" command.
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Figure 4-832: GSM Scanner BCH View - configuration

The BCH view configuration page is common for all RATs. For the cdma2000/1xEV-DO
technology only, the page lets you choose the source of BTS position information, see
"CDMA2000/1xEVDO scanner BCH configuration" on page 1171

4.8.5.3  GSM scanner Top N view

The "GSM Scanner Top N View" displays the properties of the signals received from
the base transceiver stations. These signals are the selected elements of the "List Col-
umn" in the scanner configuration menu, see Figure 4-837. A Top N pool contains up to
n BSICs with specific characteristics providing the strongest synchronization signal
P(SCH) level at a given position and time.

The view area is divided into a list and a chart panel. The following figure shows the list
area only for enabled multiple scanners option, see Figure 3-200.
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Figure 4-833: GSM Scanner Top N View - selection

The "ARFCN" column in the Top N the "List" pane may contain equal channel numbers
of both GSM 1800 and GSM1900 band. To differentiate between them, the band
shows “P” prefix to represent GSM 1900 channels. Therefore, the "ARFCN" column
has the GSM1900 channels clearly marked with “P” prefix.

A cell's center frequency is included in the "List" of the "GSM Scanner Top N View",
see the last column in the following figure.

Figure 4-834: GSM Scanner Top N View
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GSM scanner Top N view for automatic pool configuration

The scanner Top N view of the R&S ROMES 3GPP technologies displays the all “auto-
matically configured Top N pools" on the screen.

If you select "Top N Pools" > "Automatic Pool Configuration" for a corresponding tech-
nology, the Top N selector control gets the additional entry "Show all TopN Pools" in the
view.

By selecting this entry, you can see all Top N pools in the list. The number of displayed
members per pool depends on the size of the window. It is calculated automatically in
such a way that all Top N pools can be observed without scrolling the list (if even one
member does not fit, scrollbars are added).

The signals and their decision values which users can select for ranking of the Top N
pools are available in the "Available Signals" tree.

Figure 4-835: GSM scanner - all Top N pools and Top N chart

The Top N "Chart" pane displays the 2D and 3D values of the signal selected for rank-
ing, see Figure 4-837.

The "Chart" panel is shown in 3D in case the automatic Top N pool configuration
active. The values of the selected signal used for ranking and display are shown as 3D
bars.
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The Top N chart can be rotated moving the mouse while pressing the left button (x-
axis, y-axis and z-axis when pressing the CTRL key additionally). Press the R key to
reset the 3D chart to its default orientation.

The configuration of the Top N view allows to configure the colors for the 3D chart and
the minimum and maximum for the Top N values.

The color of each bar represents the state of the signal based on the signals color
scale defined in the "Available Signals" configuration page. Typically this is green for
high values and red for low values.

You have the option to display the Top N pools as the grid with 2D charts instead of the
standard 3D bar chart.

To enable the grid with 2D bar charts, click on the "Show Grid" slider at the right top if
the 3D "Chart".

You may return to the 3D chart at any time by clicking the "Show 3D" slider at the right
top if the 2D "Chart".

For the Scanner Top N view the grid arrangement is dynamic to allow the best use of
space to display as many pools as possible.

Note: The maximum size of the grid is to be 6 columns and 3 rows.

The following figure shows how many rows and columns to expect in the grid.

Figure 4-836: Allowed sizes of the grids in 2D chart

For the "Chart" layout in this case, see Figure 4-761.
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View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.

The splitter position between the upper and lower part of the scanner view area and
the open or closed state of the "Top N List" and "Top N Chart" are restored from the
workspaces.

Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

If you start R&S ROMES4 with an empty workspace, the initial widths of the columns in
"Top N View" are initialized and scaled properly based on the current screen DPI set-
ting.

Top N list

The "Top N List" gives an overview of the received signals in the current top N pool
together with their measured power parameters, frequency and timing information. On
mouse rollover, each cell in the table header provides a short explanation of the corre-
sponding column.

The "Top N List" contains the following columns:
● "Color"

Applied color scale settings for the members of a Top N pool.
● "#"

Numbering index of the measured signal in the list.
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The SCH burst power, C/I or Cue can be selected for measurement and are num-
bered in ascending order, according to the time when they enter the Top N pool.
This means that the current numbers tend to increase as the measurement pro-
gresses.

● "Rank"
Current rank of the measured signals. The ranks are reassigned every time the
pool is updated; they are in the range 1 (Rank N).

● "ARFCN"
GSM channel number of the measured SCH. The GSM1900 channels in CH col-
umn are clearly marked with "P" prefix. In that way is overcome the problem of pos-
sible existence of equal channel numbers for both GSM1800 and GSM1900 bands,
see Figure 3-200.

● "BSIC"
Base transceiver station (BTS) identity code. In this view, the BSIC is always octal
(so that BSIC = ab where a is the NCC and b is the BCC), irrespective of the for-
mat selected in the "Preferences > Available Signals" tab (octal/decimal/hex).

● "PSCH [dBm]"
Burst power of the measured SCH (synchronization channel).

● "Mode"
Valuation method: average/min./max./last

● "C/I [dB]"
Carrier-to-Interference-ratio

● "Ptotal [dBm]"
Total channel power

● "CI"
Cell Identity (16 bit)

● "LAC"
Location Area Code

● "MCC"
Mobile Country Code

● "MNC"
Mobile Network Code

● "BTS Name"
Name of the closest base transceiver station with matching MNC, MCC, LAC, and
CI. This parameter is displayed if a valid BTS list is available. Detailed information
can be obtained by double-clicking the BTS name.
Note: R&S ROMES4 uses the BCCH and the BSIC to identify the BTS name. If the
BTS assignment is ambiguous because several BTS with the same BCCH and
BSIC are encountered, then a plus “+” sign precedes the BTS name.

● "Dist. [km]"
Distance to the BTS; getting this information requires a valid BTS database and
availability of own geographic position by GPS.

● "DecisionValue"
Top N ranking decision value

● "RankTime"
Top N ranking timestamp
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● "C1"
Cell selection criterion emulated by the mobile device

● "C2"
Cell reselection criterion emulated by the mobile device.

● "NR"
Neighbor Relation to the other members of the Top N pool; it is a percentage of
members which are listed in the BA list. It is only available if at least SI2 was
demodulated.

● "Center Frequency"
GSM center frequency

The Top N pools configuration is done in the GSM NWS technology component. From
this follows, that the Top N pool configuration can be modified from the same measure-
ment file in order to get different results.

It is possible to show or hide each individual table column in the view.

Up to 3 different named pools can be configured in the default setup. Each pool has
several configurable parameters.

Diagram

Below the table, the "Top N Chart" shows the C/I value and the code power of the mea-
sured SCH (synchronization channel) for all ARFCN signals in the current Top N mea-
surement as a bar chart.

In the configuration menu, it is also possible to select the upper and lower P(SCH) lev-
els for the y-axis of the chart.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

GSM scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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The Scanner Top N View is the R&S ROMES4 common view for all supported 3GPP
and non-3GPP defined technologies, see "Generic implementation of the Top N pro-
cessing and display features" on page 281.

Configuration: Top N view

The "Top N View" lets you the following:
● Select the Top N list contents
● Select the power signal type to be displayed in the 3D Top N chart and used for

ranking the pools. For example, the total channel power or the synchronization
channel burst power can be selected as the first 2D and 3D chart value.

● Select a GSM specific graph y-axis titles and limits to be displayed in the chart.
That assumes setting the minimum and the maximum value to be displayed for the
selected power signal. For example, the "PSCH Min [dBm]" and the "PSCH Max
[dBm]" signal level to be displayed in the view can be selected.

● Select the colors and the number of color definitions in the 3D chart view
● Select the signal quality to be displayed as a 2D chart option

Figure 4-837: GSM Scanner Top N - configuration

Graph
● "Show Ptotal"

Shows the total channel power if selected.
● "Show PSCH"

Shows the synchronization burst power if selected.
● "Ptotal Min/Max [dBm]"

Sets the upper and lower Ptotal for the y-axis of the chart if Ptotal selected.
● "PSCH Min/Max [dBm]"

Sets the upper and lower PSCH levels for the y-axis of the chart if PSCH selected.
● "C/I Min/Max [dBm]"

Sets the upper and lower carrier to interference levels for the y-axis of the chart.

3D Chart Option
● "Use Open GL Rendering"

The option determines if the 3D chart is rendered open GL (hardware) rendering or
software rendering. Using open GL allows faster rendering of the 3D chart.
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Grid Chart Options
● "Displayed Top N Members"

The check box lets you select the number of Top N member that each chart in the
grid will display.

● "Max Displayed Cols"
The check box lets you select the maximum number of displayed columns in the
grid. Allowed values are from 1 to 6.

● "Max Displayed Rows"
The check box lets you select the maximum number of displayed rows in the grid.
Allowed values are from 1 to 3.

2D Chart Options
The signal quality is displayed in the scanner Top N view, if the "2D Chart Option>
Show signal quality" is selected. This is actually possibility to switch "on" or "off" the
second y-axis on the chart and quality signal bars.
For LTE scanner Top N view users can select the wideband values to be displayed in
the 2D chart instead.
If the option is selected, consider that you will see the result of the switching only on
the next frame, chart must redraw at least once for it.
See "Configuration: Device selection" on page 1402.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.

Figure 4-838: Device selection
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4.8.5.4  GSM scanner transmitter view

The "GSM Scanner Transmitter View" displays the demodulated data acquired by the
scanner during the GSM network scan. The data also contains information transmitted
on the "Synchronization Channel" (BSIC and TDMA frame number) and the "System
Information Type 3" of the BCCH. The measured and detected sectors in the air are
displayed, sorted and updated in different rows. The view can show measurements
from more than one GSM NWS.

Figure 4-839: Transmitter View - several BSIC measured

Each table row corresponds to a GSM downlink signal received from one BTS. It is
underlined with a gray or colored bar, where the color denotes the measured BCC (the
second digit of the octal BSIC) of the signal in this channel. If no color code could be
measured an empty bar is drawn. Gray bars and brackets in the table row characterize
how complete or how recent the displayed results are; refer to the description of chap-
ter "Info levels" on page 1199. The length of this bar corresponds to the received
PSCH, according to the dBm scale displayed across the bottom of the view.

The channel column (CH) of the “GSM Scanner Transmitter View” ” which may contain
equal channel numbers from both GSM 1800 and GSM1900 bands, will show a “P”
prefix for GSM 1900 channels. The column CH indicates clearly which channels are
from GSM 1900.

View contents

The columns contain the following information:
● "Name"

Name of a Base Station (if available from the data base)
● "C/I"

Carrier-to-Interference ratio; the C/I values are visualized as gray bars which origi-
nate from the middle to the left. The numeric values are shown in a column.

● "CH"
The number of the measured channel; if two or more consecutive lines are mea-
surements on the same channel, they are marked with a vertical bar.
The column"CH" has the GSM 1900 channels clearly indicated with "P" prefix. In
that way is overcome the problem of possible existence of equal channel numbers
for both GSM1800 and GSM 1900 bands.
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Figure 4-840: Marked channels

● "PSCH"
Synchronization channel power displayed in the second column, with a dynamic
range from -120 dBm to 0 dBm.

● "BSIC"
BSIC in octal representation; the first digit denotes the NCC, the second BCC.

● "CI"
Cell Identity

● "LAC"
Location Area Code (decimal)

● "MNC"
Mobile Network Code (decimal)

● "MCC"
Mobile Country Code (decimal)
The four preceding elements uniquely identify a BTS worldwide. So this set of
information is especially useful in border regions where two network operators may
share the same frequency range, to identify a BTS of a network when there is no
base station list available.

● "T(MEAS)"
Time (hh:mm:ss) indicates the last measurement update of the displayed line. The
time is counted from the start of the measurement. Although T(MEAS) is displayed
in seconds it is internally stored in ms. This is important when T(MEAS) is used for
sorting, see "Sort Sequence".

● "T(TDMA)"
Time offset of the correlated burst; this time is given by T(MEAS) modulo one
TDMA frame. The unit is the length of one time slot, so the range is 0 (T(TDMA) <
8).

● "FN"
TDMA frame number of the correlated burst in the range 0 to FN_MAX where
FN_MAX = (26 x 51 x 2048) -1 = 2715647 (one hyperframe length) as specified in
GSM 05.02. The FN is obtained from the measured Synchronization Channel
(SCH). The FN column shows the FN at T(TDMA) which is calculated from the FN
at the SCH time T(SCH) and the time offset between T(SCH) and T(TDMA); see
Figure 4-841.

● "T3"
Frame number FN modulo 51 (one multiframe length)
Notes:
In case those two sectors are synchronized, both values T3 and T(TDMA), are
identical up to a measurement error. Synchronization can be checked this way.
For the interference analysis identical values of T3 and T(TDMA) imply that the sig-
nals in the interference diagram are on identical positions and cannot be distin-
guished.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

● "Freeze Input"
Additional input from the measurement or replay is not displayed. Meanwhile, the
data is still stored during measurement. Sorting of the data and changes in the
parameter settings are possible during input freezing.

● "Enable Input"
Terminates the input freezing.

Frame timing

The values T(MEAS), T(TDMA), FN are visualized in the following figure:

Figure 4-841: Display of the GSM NWS Transmitter Scan View time measurements

The start of the measurement is shown as a vertical bar on the left side of the diagram.
At "T(MEAS)" a SCH is detected and demodulated, giving the information about the
BSIC and the TDMA frame number "FN(MEAS"). "T(MEAS)" is shifted back to the time
period of the first TDMA frame after the start of the measurement by subtracting the
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duration of "n" TDMA frames. This yields the value "T(TDMA"). In the same way, the
demodulated frame number is reduced by "n" (modulo 2715648). So, both values,
"T(TDMA)" and "FN" denote the measurement time and frame number of a BTS if it
would have been measured within the first TDMA frame period after the start of the
measurement assuming no drift of both the BTS and the test receiver and assuming no
timing advance due to different measurement locations.

The advantage of this definition of frame numbers and measurement times is that the
values for one BTS are approximately constant with only small changes produced by:
● Drift of the BTS
● Drift of the test receiver
● Time shift on different measurement locations due to the finite speed of light
● Different offset times when repeater signals are received
● Additional time delay produced by reflections

Info levels

The "GSM Scanner Transmitter" view distinguishes three different info levels, depend-
ing on the amount of information that could be extracted from the received signal. At
level 3 the most complete information is available.

● Info level 1
A C0 channel of a BTS could be identified by correlating the FCCH and the exten-
ded training sequence of a SCH burst. As a result, the C0 channel number, the
measured power of the BCCH signal and the frame synchronization time are
known.

● Info level 2
This info level is reached when the SCH could be reliably demodulated. The valid-
ity of the demodulated data is checked with the 10 parity bits available, so the
probability that an error is not detected is about 1/1000. However, as the values
have restricted ranges, this probability can be improved to an estimated 1/3000.
Because this probability is still too high, the data is only considered to be reliable if
there are at least two independent SCH demodulations of one BTS reducing the
error rate to a negligible value. The probability that an error is not detected is
reduced to less than the factor (1/3000)^2, because the comparison of the SCH
content of both signals provides an additional constraint.
The additional information obtained at this info level is the BCC, NCC and frame
number. As soon as this info level is reached, the bars showing the measured
power become colored.

● Info level 3
The info level 3 is reached when the system information type 3 on the BCCH chan-
nel could be demodulated. The additional information obtained is the Cell Identity
(CI), Location Area Code (LAC), Mobile Network Code (MNC) and Mobile Country
Code (MCC).

By default, every new measurement result is compared with those already shown in
the list. The values of a measurement in the list matching with the new one are upda-
ted. If the older measurement had a higher info level, the old values missing in the new
measurement are kept in the display, indicated by values in brackets. This behavior
can be changed in the configuration menu; see description of "Matching Entries:
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Action" on page 1202. The decision algorithm for two measurements belonging to the
same BTS is described in chapter "Configuration: Matching entries" on page 1202.

GSM scanner transmitter view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Transmitter view

The "Transmitter View" option lets you criteria for the transmitter scanand shows infor-
mation on the current view version.

Figure 4-842: GSM Scanner Transmitter View - configuration

This configuration dialog contains the following panels:

Limits
Limits the displayed data. The entries denote the following limitations:
● "All Entries": The maximum number of signals displayed.
● "Entries per Channel": The maximum number of signals displayed for each chan-

nel.
● "Entries per Channel" – ETS only: The maximum number of entries per channel

which only have reached info level 1 (ETS: Extended Training Sequence).
● "Entries per Channel – SCH only": The maximum number of entries per channel

which only have reached info level 2.
● "History Depth (Seconds)": Entries which have not been updated during the given

amount of time are discarded from the display.
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● "Refresh Time (Seconds)": The display is refreshed every time the Refresh Time
has passed. Using higher values avoids the flickering of the diagram.

When the number of measurement data exceeds the above limitations, the oldest
entries are discarded in the view.

Sort Sequence
Specifies the criteria how the lines in the display are sorted.
● "Available Attrib."

List of available criteria (attributes). Any attribute can be selected to be appended
to the end of Order by: list; see description of buttons below.

● "Order by"
Specifies how the lines are sorted.
In the example of Figure 4-842, the list is sorted according to channel numbers, all
lines with the same channel number are sorted according to their info level, and so
on. Sorting is always in ascending order.

The buttons between the two lists move a selected entry from one list to the other
●

Removes the elements from the Order by: list and loads the default values.
●

A selected element in the Available Attributes list is moved to the end of the Order
by: list. Alternatively, the element can be double clicked.

●
A selected element in the Order by: list is moved to the Available Attrib. list. Alter-
natively, the element can be double clicked.

●
Empties the Order by: list.

Note: The measurement time "T(MEAS)" is stored internally in microseconds, although
it is displayed in seconds. So it is recommended to use "T(MEAS)" only as a last sort-
ing criterion in the "Order by:" list.

States
The "States" panel can be used to restrict the measurement range. Note that these
restrictions can be changed even during a running measurement.
● "Focus on Channel Map (Display)"

Restricts the displayed channels to those on which the focus is set in "Channel
Map".

Channel Map
The "Channel Map" is used to select the channels on which a focus can be set in the
"States" panel, see the previous figure.
The map consists of the following lists:
● List with the available channels.
● List of channels, which specify the focus if a corresponding entry in "States" is

selected.
The buttons between the two lists move a selected entry from one list to the other; see
"Sort Sequence" on page 1201.
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Matching Entries: Action
The "Matching Entries: Action" panel determines how a new entry to the "GSM NWS
Transmitter Scan" view is displayed if it matches with one that was recorded before.
● "Upgrade new Entries with Previous Measurement Results"

If this box is checked the entries in the old measurement are updated even if the
new measurement has reached a lower info level. The missing entries in the new
measurement result are taken over from the old entry and displayed in brackets. If
the box is not checked, a new measurement with a lower info level is displayed in a
separate line.

● "Remove Previous Entries with less or equal Information"
A new measurement only updates the old one if this item is selected, otherwise it is
displayed in a separate line. Deselecting this item allows e.g. to investigate the drift
behavior of a BTS.

Configuration: Matching entries

The "Matching Entries" option lets you set the conditions to decide whether two mea-
surements belong to the same BTS.

For the decision whether two measurement results originate from the same BTS the
following criteria apply:
● The decoded information available in both signals (info level 2 or 3) must corre-

spond.
● The offset times of both bursts must match to some measurement error.

In the "Matching Entries: Range" pane set the criteria for the allowed measurement
error in order to decide whether criterion 2 is fulfilled. In case of doubt it is recommen-
ded to keep the default values.

Figure 4-843: GSM Scanner Transmitter View - Matching Entries
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The matching entries are illustrated in the following figure:

Figure 4-844: Matching Entries: Range - parameters explanation

The decision whether two detected signals originate from the same BTS is based on a
comparison of the measurement times T(Meas) for both signals and of their measured
time offsets T(TDMA). The figure above shows the matching entries in the T(Meas)-
T(TDMA)-plane: If the large dot at T(Meas)1 corresponds to the measurement result
for signal 1 and the result for signal 2 is within the shaded area, then the two signals
are considered to originate from the same BTS. If both signals contain at least info
level 2, then the TDMA frame number is compared in addition, which extremely enhan-
ces the accuracy.

Matching Area
The shaded matching area is bordered by the measurement time of the first signal
detected T(Meas)1, the measurement time T(Meas)1 plus the "Time Span", the straight
lines parametrized by the equations
Δt = ±(<Time Offset> + <Time Drift> x [T(Meas) – T(Meas)1]) . (Equation 1)

The "Time Offset", "Time Drift", "Time Span" can be entered in the input fields in the
"Matching Entries: Range" tab. They provide estimates for possible errors from differ-
ent sources that might cause the measured time offsets T(TDMA) for two signals from
the same BTS to be different.

Time Offset
Difference of the measured time offsets T(TDMA) for two signals due to measurement
inaccuracies, e.g. caused by reflections.

Time Drift
Drift of T(TDMA) in time, caused by the BTS, the receiver, or a time delay due to a
location update.
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Time Span for
Maximum difference of the measurement time beyond which two signals are generally
considered to be different. The "Time Span" can be set independently for the case that
at least one signal has only reached info level 1 ("Time Span for ETS)" and for the
case that both signals have reached at least info level 2 ("Time Span for SCH"). In the
latter case, higher values for the "Time Span" are reasonable, because the inclusion of
the TDMA frame number minimizes the accidental time offset coincidences considera-
bly.

Max. Time Error
Maximum time error allowed calculated according to the equation 1, where T(Meas) =
Time Span; used as an information only.

4.8.6  LTE scanner views

The LTE scanner views show the information obtained in the LTE network. The scans
are performed by the R&S scanners.

For this purpose, the R&S TSME scanner with its hardware option R&S TSME-K29 is
needed.

The LTE-MIMO scan measurements need the R&S TSME-K30. The eMBMS measure-
ments need the R&S TSME-K32 option.

The LTE network scan available option for R&S TSME is R&S ROMES4T1E.

How to install and configure the LTE network scanner is described in Chapter 6.4.15,
"LTE scanner", on page 1726.

The LTE scanner views can be selected from a submenu displayed on the right-hand
side of the "View" menu if the mouse hovers over "Scanner Views" > "LTE".
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Figure 4-845: LTE scanner views

All LTE scanner views accumulate the configured channels. In the frequency combo
boxes currently inactive frequencies are marked with an asterisk (*), see Figure 6-272.

The choice of channel type for scanning (selected or virtual) has no impact on scanner
BCH view. It is so because the choice of channel type accumulates and shows all
decoded eNodeBs, regardless on what channels they are measured on.

On the contrary, the scanner Top N algorithm is based on the currently measured
channels. It is a snapshot of the current measurement, so that its result depends on
the channel configuration done by the primary device.

The Top N pool members offer an Top N reference signal ("Top N UE Reference")
which reflects the usage of an eNode by the UEs of the current measurement. The sig-
nal provides information on UE's number and its carrier which uses this eNode of the
Top N pool member. The signal is available in the "LTE Scanner TopN View" as
optional signal. The signal is available in the "SignalTree" > "LTE Scan" > "Top N Tem-
plates" and in the "Alphanumeric View". For the signal description, see "Description of
R&S ROMES4 signals" document.
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Figure 4-846: Top N UE reference of Top N pool member

The screenshot shows that PCI 150 is used as Primary Component Carrier by UE 5, 6
and 8.
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4.8.6.1  LTE scanner signals templates

The configuration of all signals PCIs and specification of several EARFCNs leads to a
huge number of measured signals. R&S ROMES4 makes the combination of frequen-
cies and PCIs. The huge number of measured signals makes it difficult to find and
select the required measurement data.

The LTE scanner signals templates offer an easy access to the measurement data of a
specific eNodeB. The easy access is achieved by specifying the EARFCN and the PCI
whose measurement data that you want to display in the "Top N Templates" and the
"eNodeB<EARFCN/PCI> Template" branch of the "Signals Tree" > "LTE Scan" tree.

Figure 4-847: LTE scanner signals templates
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1. Select a signal for display in a R&S ROMES4 basic (generic) view. You can select
it from the "Top N Templates" or the "eNodeB<EARFCN/PCI> Template" branch
and in the "Signals Tree" as a template signal for a specific eNodeB. Drag & drop
the selection into the view. Instead, double click the item in the view's configuration
page.

2. A dialog pops-up asking you to define the filter for the signal. For LTE scanner, this
filter asks for the EARFCN or the combination of EARFCN and PCI.
If you have selected several signals, check the "Apply for all signal" check box. The
function applies the same filter for all signals.

The filter for the signal is entered.

The signal appears in the R&S ROMES4 basic views and in a template branch of
to the "Signals Tree" > "LTE Scan" tree.

Figure 4-848: Alphanumeric view of the template signal RSRP

The filtering dialogs remember the last set values. You can select a eNodeB in the
"LTE Scanner BCH View" to preset the filter values for the dialog.

The template branches are a home of all created template signals. You can select the
signal directly from these branches if needed.

The template signals are part of the workspace. They are stored to the workspace and
restore when loading it. Creating a workspace removes the template signals.

Configuration of LTE scanner Top N templates

There are no separate branches for each Top N pool and Top N member. Instead there
is only a single Top N node under the "Top N Templates" node.

The Top N template signal can be configured on any generic view. If a signal is config-
ured on the generic view, a prompt for specific Top N pool and Top N member to be
configured is displayed.
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Figure 4-849: Template to filter Top N PCIs

Configuration of Template Top N Pool: Enter the desired Top N pool number. A
range of Top N pools can be entered by using a comma separator which separates
individual pools or a dash to define a range of pools. For example, entered 1, 2, 4 rep-
resents the pools 1, 2 and 4 and 1 to 4 would represent an entry of pools 1 to 4.

If measurement or measurement replay is in progress, the valid Top N pools are availa-
ble for selection if you click the down arrow. Click one or more of the valid pools.

Once all selections are made, click another field or "OK" to close the selection window.

Figure 4-850: Available Top N pools

Configuration of Template Top N Member: Enter the desired Top N member number.
A range of Top N members can be entered by using a comma separator which sepa-
rates individual pools or a dash to define a range of pools. For example, entered 1, 2, 4
represents the members 1, 2 and 4 and "1-4" represents an entry of members 1 to 4.
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Selection of Field Color Code: Once a valid selection is made, the field gets a green
background color. If a selection is not valid, the background color is red.

Figure 4-851: Colored fields for Top N PCI filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections". (These selections are reset each time R&S ROMES4 is restarted). To
select one of the prior selections, check the box next to the desired option and press
"OK". The new selection items are hidden. They reappear when all prior selection
boxes have been deselected.

Figure 4-852: Prior selections

Configuration of LTE scanner eNodeB<EARFCN\PCI> templates

If an eNodeB signal is configured to be used on a generic view, a prompt to configure
the signal with desired filter values is displayed.

All the EARFCN signals for a given channel that are found under the "eNo-
deB<EARFCN\PCI>" signal filter dialog box are prompted as shown in the following fig-
ure.
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Figure 4-853: WB RSSI template signal filtering

The highlighted line indicates that the channel has the primary and the multifrequency
band EARFCNs, refer to Figure 4-907 and the explanation below the figure.

The signals that are found under the "eNodeB<EARFCN\PCI>" > "eNodeB" are promp-
ted as shown in the following figure.

Figure 4-854: RSRP template signal filtering

Configuration of EARFCN Value: An EARFCN value can be entered. Multiple
EARFCN can be entered by separating the values with a “,”. For example, by entering
1300, 1444 selected are channels with EARFCN 1300 and 1444.

If a measurement or measurement replay is in progress, a list of currently valid
EARFCN values is displayed by clicking the down arrow. One or more of the values
can be selected if you check the box next to the desired choice.

Once all selections are made, click another field or "OK" to close the selection window.
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Figure 4-855: Entered EARFCN values

Configuration of PCI: A PCI value can be entered. Multiple PCI values can be chosen
by operating the values with a “,”. For example, entered values 103 and 104 select PCI
value 103 and 104.

If a measurement or measurement replay is in progress, a list of valid PCI values for
the currently selected EARFCN is displayed by clicking the down arrow. One or more
of the values can be selected if you check the box next to the desired choice,

Once all selections are made, click another field or "OK" to close the selection window.

Figure 4-856: Entered PCI values

Selection of Field Color Code: Once a valid selection is made, the field gets green
background color. If a selection is not valid, the background color is red.
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Figure 4-857: Colored fields for RSRP filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections" rows. (These selections are reset each time R&S ROMES4 restarts).

To select one of the prior selections, check the box next to the desired option and
press "OK". The new selection items are hidden. They reappear when all prior selec-
tion boxes are deselected.

Figure 4-858: Prior selected template signals

4.8.6.2  LTE scanner BCH view

The "LTE Scanner BCH View" shows a list of detected BTSs with their details decoded
from MIB and SIBs, included in related blocks. The contents of each block appears in
the tree view, when the block is selected.
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MIB and SIB1 are displayed correctly. All other SIBs are shown under the BTS entry
without label, as a BCCH DL SCH message (which can contain several SIBs). The cell
information from SIB1 is used to derive the BTS identification.

If a SIB is selected on the left-hand side of the "LTE Scanner BCH View", the list of
PDU variants and the list of associated time stamps are displayed on the view's right-
hand side. This selection is shown in the following figure for PDUs carrying SIB 1.

For the list of supported LTE SIBs see, Figure 6-282.

The "LTE Scanner BCH View" is enhanced based on R&S ROMES4 support of
dynamic PDU handling described in "Implementation of the dynamic PDU handling"
on page 284. The enhancement is the list of PDU variants over time. The PDU variants
are shown as leaves of the base station branch.

Figure 4-859: LTE Scanner BCH View - eNodeB SIB1 details

The "PDU Variant List" in the upper right-hand part of the view shows a list of time
stamps if different variants were found. In the shown case of SIB 1, there was only one
variant found. "TimeStamp" shows the most recent measurement of the variant.

"LTE Scanner BCH View" > "Details" shows the details of the entry selected in the
pane on the left-hand side. If you select eNodeB, you get the basic data such as the
eNodeB identity, PCI, EARFCN, PLMN, antenna port number. Added is enhanced info
on DL bandwidth, support of Nb-IoT, LTE-M, eMBMS and 5G NR.
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Figure 4-860: LTE Scanner BCH View - details

The enhanced info assumes the following:
● "dl Bandwidth [MHz] (xx) xx" is the same information as the one displayed in the

MIB pane.
● "NB-IoT Same PCI (EARFCN:Xxxx)", where Xxxx is the EARFCN of NB-IoT sta-

tion, indicates that the NB-IoT has the same PCI as the eNodeB.
● "LTE:-M yes/no" is based on "schedulingInfoSIB1_BR_r13" field of the MIB mes-

sage. If the field exists and is greater than zero, shown is "LTE:-M yes". Otherwise,
shown is "LTE:-M no".

● "eMBMS: not supported/supported" is based on "mbsfn_SubframeConfigList" field
of SIB 2 message. The following cases are possible
– If SIB 2 is not present, shown is "eMBMS:-".
– If SIB 2 is present, but "mbsfn_SubframeConfigList" does not exist, shown is

"eMBMS: not supported".
– If SIB 2 is presents, and "mbsfn_SubframeConfigList" is found, shown is

"eMBMS:supported".
● 5G NR is supported or not by the LTE scanner.

If the eNodeB has been generated from SIB 3 measurement without a corresponding
database entry, the position is displayed as "Lon *<value>  Lat *<value>". The format
of the position values depends on the corresponding global R&S ROMES4 setting.

The "LTE Scanner BCH View" can show all R&S ROMES4 supported SIBs if config-
ured to be demodulated. The following screenshot shows that demodulated is SIB 22
of the PCI 210 cell. The details of the SIB 32 are visible on the view's right-hand side.
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Figure 4-861: Demodulated LTE SIB 32

You can obtain the SIB demodulation information from the "Open" page when you
open a LTE measurement file. The SIB information including PDU and internals is
available in "BCH Demod" line of the page.

Figure 4-862: Open page shows demodulated LTE SIBs
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The MIB and SIBs information is available only if the LTE scanner data is recorded with
the "BCH Demodulation" enabled.

RAN sharing in LTE scanner BCH view

The "LTE Scanner BCH View" displays eNodeBs of all PLMNs reported in the SIB1,
see Add. PLMNs.

For example, the base stations which serve the PLMN 123,1 and PLMN 123.2 are visi-
ble in the view in the branch for PLMN 123,1 and PLMN123, 2 respectively.

A base station listed below a PLMN which is not its primary PLMN is displayed with an
"‘" appended to its name.

The LTE scanner BCH view creates branches for all the PLMNs of a base station,
instead of base stations of the primary PLMN only.

In this case the number of shown base stations does not reflect the number of physi-
cally existing ones.

Text filter

The "Text Filter" function offers filtering and exporting a base station list based on dif-
ferent criteria. For details, see "BTS export settings" on page 1217.

Figure 4-863: Show/hide shared base stations option

It is possible to hide the base stations, which are displayed as non-primary PLMNs if
the "Text Filter" > "Show Shared Basestations" box is checked.

Base stations export can be done based on state of their position.

The base stations in the scanner BCH view have different position states. The follow-
ing colors indicate the state of a base station:
● grey: position is not available
● grey with database symbol: position is taken from database
● red: position is estimated by power only
● yellow: position estimation is in progress
● green: position estimation finished
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

BTS export settings

If the export had been started before measurement or replay has been stopped, the file
contains all the System Information starting from the selected node in the BCH tree.
The file includes all SIBs of the selected eNodeB or all SIBs belonging to all eNodeBs
of one provider (MCC, MNC).

If the export has been started after measurement or replay had been stopped, the file
contains all System Information belonging to all eNodeBs included in the "LTE Scanner
BCH View".

The System Information can be exported to an ASCII file in the EXPORT directory of
R&S ROMES4. The name of the export file is

LTE_SysInfo_<measurement filename>.txt
If the Position Estimation is active, the estimated positions are added to the eNodeB
entries. Estimated positions are marked by an asterisk.
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After stopping the measurement, the view automatically generates an eNodeB list of
import files with an entry for every estimated eNodeB position. The eNodeB list files
are stored in the R&S ROMES4 measurement directory.
Table 4-33: Files generated for a measurement RSCMD file

Measurement
file

*.rscmd

Generated files LTE_eNodeB_LIST<measurement filename>.atd Contains the database
definition

LTE_eNodeB_LIST<measurement filename>.txt Contains the eNodeB data

Note:

After stopping the replay of a measurement file, the same eNodeB list can be created via the view’s "Gen-
erate eNodeB List" entry.

Table 4-34: Example

Files Measurement file zgb-muc.rscmd

Generated files LTE_eNodeB_LIST_ zgb-muc.atd

LTE_eNodeB_LIST_zgb-muc.txt

Content For the content of an ATD or a TXT file, see Example

Basestation list export

Click the "Global Export Settings" command of the view context sensitive menu to get
the "Basestation List Export" page.
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Figure 4-864: Base station list export

The following BTS list export entries are available:
● "Export ROMES Basestation List"

The content of the BCH views can be exported to a ROMES base station list.
● "Export to Google Earth"

Estimated base stations can be exported also to a KML file, which can be loaded
into Google Earth. The KML file shows the base stations positions, the error ellipse
and the most important data of the station.

● "Filter"
– "Search phase"

The export dialog allows to select which base station states are to be exported.
If mandatory columns of the list are not available, dummy data are inserted,
e.g. 0.0, 0.0 for an unknown position. All lists can be loaded into R&S ROMES4
afterwards, but they are not useful for further measurement due to missing
data.

– "Search in details"
The current visible details setting can be exported to a text file.

– "position..."
It is possible to show and hide the stations according to their different position
states by using the position filtering.

– "Max. size of error ellipse"
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The export can be filtered by a maximum size of the error ellipse of an estima-
ted base station, which must not be exceeded.
The filtering is done by a threshold value for the error ellipse area of the esti-
mated position. If this value is zero, all BTS entries with estimated position are
exported. Otherwise, only entries whose error ellipse area is less than the
threshold value are exported via the BCH view’s "Global export settings" con-
text menu item.
The error ellipse area Aε can be calculated from the position error values:
Aε = PosErr1 * PosErr2 * π
Note: The specified error ellipse's area defines a confidential interval of 66%
confidence.

● "Export Complete Tree to Text File"/"Export Selected Branch to Text File"
The content of the complete or selected branch of the BCH view can be exported
to an ASCII file.

● "Additional options"
If "Export automatically after measurement" checked, the BCH views for all tech-
nologies can export the database file automatically after a measurement was fin-
ished.

● "Save and export"
The button saves the settings of the export dialog and creates the export database
file.

● "Save & Close"
To store the settings without creating an export, click the button.

● "Cancel"
Cancels the made settings.

Neighbors are exported for GSM, UMTS, LTE, LTE-M and TETRA technologies. The
standard columns for the R&S ROMES4 base station list cannot be used, as they
require the global cell identity, which is not available in the broadcast information.
Instead of using the standard column, the following columns are used for exporting the
decoded information.
● GSM

The "2GNC-ARFCN" column is exported that contains the ARFCNs of the 2G
neighbors.

● UMTS
– "2GNC-NCC,BCC,Band,ARFCN" column is exported that contains the NCC,

BCC, band and the ARFCN of the 2G neighbors.
– "Intra3GNC-SC" column is exported that contains the scrambling codes of the

intra-frequency neighbors.
– "Inter3GNC-DL_UARFCN,UL_UARFCN,SC" column is exported that contains

the DL/UL UARFCN and the scrambling code of the inter-frequency neighbors.
● TETRA

The "NeighbourCellParameters" column is exported that contains the MCC, MNC
(both only if available) and the LA and carrier of the neighbors.

The settings of the export dialog are stored in the registry and valid for all technologies.
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The "Output" view informs about the executed exports of the BCH views.

Figure 4-865: Finished BCH view export

LTE scanner BCH view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Y

Figure 4-866: LTE Scanner BCH View - configuration

The "Configuration" option lets you filter base stations by selecting different states of
their position in the "Text Filter" pane. Select a base station color that you want to be
used in the "ROMESMAP Route Track View" in the "Visualization" drop-down box.
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4.8.6.3  LTE scanner cell ID tracer view

The "LTE Scanner Cell ID Tracer View" displays the evolution in time of the time delay
and power of all received LTE peaks with a particular Cell ID or a particular rank in a
Top N pool.

Figure 4-867: LTE Scanner Cell ID Tracer

Any deviations of the regular 1ms TTI can be seen by a non-vertical line in the waterfall
diagram. Usually the reason is missing or wrong synchronization, typically caused by
problem in the transport network connection.

Frequency

The "Frequency" pull-down list, contains all measured frequencies of the channels
ticked in "Channels" of the LTE scanner configuration tab, see Figure 6-272.

Fix current cell ID

The pin icon to the right of the "Frequency" list forces the system to trace the current
"Cell ID", even if "Trace TopN Element" is selected in the configuration menu. In fixed
Phy. Cell ID mode, the icon is crossed out with red color and "Fixed Top N" is indicated
in the title of the "Cell ID Trace Chart".

Click the crossed-out icon again to release the fixed Cell ID. The system continues
tracing the selected Top N element.

If "Trace a fixed Phy. Cell ID" is selected in the configuration menu, the pin icon has no
effect.
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View area

The view area is horizontally split to accommodate two different charts.

Click "Cell ID Tracer Chart" or "CIR Chart" to compresses / expand the corresponding
chart. A compressed chart leaves more space for the other chart. A compressed chart
is characterized by the symbol >>> (instead of <<<) in its title bar. On pausing on one
of the title bars, the cursor displays a compress symbol.

Cell ID tracer chart

The colored rectangular diagram shows the evolution in time of the CIR [dB] and the
time delay "Delta T[μs]" using the color scheme defined in the configuration menu.

"Power [dBm]" and "Delta T[μs]" are listed in "CIR View" > "Peak List".

● X-axis (delta time)
● Y-axis (time)

Symmetric range centered on the first measured relative timing slot. The delay time
span is fixed and equals 100 μs.
Linear time scale of the measurement. The diagram consists of 100 to 800 lines,
arranged from top to bottom. The diagram is continuously updated during the mea-
surement or replay by adding new lines. It is scrolled and a scrollbar is added
along the right border when a line reaches the bottom of the diagram.

CIR chart

The "CIR Chart" shows the power of all received peaks over the time.

The displayed powers and times correspond to the "Power [dBm]" and "Delta T[µs]"
values listed in the "CIR View" >"Peak List".

A scrollbar is provided to move the magnified diagram to the right or left. The scale of
the y-axis (power in dBm) can be set in the configuration menu.

By default, the diagram shows current results corresponding to the last line in the "Cell
ID Tracer Chart". To select a previous result for viewing, use the display line in the "Cell
ID Tracer Chart".

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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LTE scanner cell ID tracer view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Subband target selection

The "Subband Target" option lets you set the signals to be displayed in the "LTE Scan-
ner Cell ID Tracer View".

Figure 4-868: LTE Scanner Cell ID Tracer View - subband target selection

Trace Target
The "Trace Target" option lets you select a signal for tracing with a defined Cell ID or a
particular Top N element.
● Trace a fixed Cell ID

Define a fixed Cell ID for a trace.
Note: If the selected Cell ID is not assigned to any measured signal, the view
remains empty.

● Trace TopN Element
List of all Top N pools configured in the scanner's menu. The current Top N pool
selection is marked in the list.

Current Selection
Shows the current Cell ID selection.
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Configuration: Cell ID tracer view

The "Cell ID Tracer View" option lets you scale the diagrams and set the colors in the
view.

Figure 4-869: LTE Scanner Cell ID Tracer View - configuration

Dynamic Range
The input fields in "Dynamic Range" define the minimum and the maximum signal level
displayed in the diagrams of the "Cell ID Tracer View". The signals exceeding the
dynamic range are not displayed.

Color Graph
The "Color Graph" panel defines the number of lines to be displayed in the view. A line
corresponds to a single frequency sweep. The corresponding frequency range and the
measurement rate are set in the "Measurements" tab of the scanner's configuration
menu.

Colors
The "Color" panel defines a color scale for the lines in the "LTE Scanner Cell ID Tracer
View" and for the background. The scale is derived from 2 to 16 "definition colors". The
definition colors are entered at equidistant positions on the color scale, the first and last
color defining the beginning and the end of the scale. Between the definition colors, the
hue changes continuously.
● "Count of Definition Colors"

Pull down list to select the number of definition colors in the range 2 to 16.
● "Change Color Scale"

Opens the colors dialog to select or define the definition colors.

Scanner views



Display and evaluation of resultsDrive Test Software

1226Operating Manual 1171.6415.12 ─ 66

Figure 4-870: ROMES color scale

The current definition colors are displayed in the custom colors section.
● "Change Background Color"

Opens the colors dialog to select or define a background color for the diagram, as
shown in the previous figure.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.
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Figure 4-871: LTE Scanner Cell ID Tracer View - device selection

4.8.6.4  LTE scanner CIR view

The "LTE Scanner CIR View" displays the channel impulse response of the LTE sig-
nals.

Figure 4-872: LTE Scanner CIR View
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The CIR results of the LTE scanner are displayed as EARFCN/PCI combinations.

The "LTE Scanner CIR View" allows filtering of the "CIR List" content. The list can be
filtered on any of the available columns.

The "CIR Chart" of the view shows in the figure the same PCI as the "CIR List" does.

Figure 4-873: Filtered LTE scanner CIR list

Updated the chart by new input data once the list's filter has been changed.

View area

The entire view area is horizontally split to accommodate a chart and a table/list. The
"CIR Chart" shows the channel impulse response of the different LTE signals which
have been scanned. The graph allows zooming into the chart. The small button on the
right of the scroll bar reset the zoom level.

Click "CIR Chart" or "CIR Lists" to compresses/expand the 2D-chart or table. A com-
pressed chart leaves more space for the table and vice versa.

Moreover, the tables appear in several views so that compressing them can help to
avoid redundancies. To compress/expand table, use the ">>>"/"<<<" symbols in its title
bar. On pausing on one of the title bars, the cursor displays a compress symbol.

Diagram scale

If placed inside the diagram area, the cursor takes the shape of a zoom-in icon (a mag-
nifying glass with a '+' inside). A vertical line is displayed at the cursor position.
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The cyclic prefix is shown in the "CIR Chart" for each "CIR List" element as a dotted
vertical line in the cell ID color.

Figure 4-874: Cyclic prefix as dotted vertical line

The display of the cyclic prefix in the CIR chart can be switched off in the "LTE Scanner
CIR View" configuration.

A left mouse click magnifies the diagram in x-direction around the cursor position.
CTRL + left mouse click causes the opposite. An area to become the new x-axis range
(e.g. the area around a peak) can be marked while the left mouse button is pressed.

"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

Left table

The table lists all the scanned LTE segments:
● "Color"

Sequence number and physical cell ID color. The color can be configured in the
views configuration page.

● "Physical Cell ID"
Physical Cell Identity, range 0 to 503

● "ECI"
E-UTRAN Cell Identifier (format ENB-ID 20 bits, CI 8 bits), unique for a cell even if
the physical cell IDs are identical.

● "MNC"
Mobile Network Code

● "MCC"
Mobile Country Code

● "Power [dBm]"
The received power on S-Sync signal

● "Noise [dBm]"
Noise floor based on S-Sync signal
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● "P total [dBm]"
Total in-band power based on S-Sync signal, including thermal noise and noise
generated in the receiver

● "Frequency [MHz]"
Center Frequency

● "EARFCN"
Evolved Absolute Radio Frequency Channel Number

● "ISI"
CIR outside of cyclic prefix

● "Exp. Drift [ns/s]"
Expected time drift against the receiver time

● "Sigma Drift [ns/s]"
Expected standard deviation of the expected time drift

● "Max.Delay [µs]"
Maximum delay of the relating peaks

● "Time Delta [µs]"
Time difference between the first and the last arrived peak

● "Unique ID"
Unique BTS ID generated by the scanner per on a channel identified BTS

● "Count of Peaks"

Right table

The right table shows the different path of the segments. The table lists all scanned
LTE segments.

The specific ones are listed here.
● "Delay [µs]"

Signal's delay time
The delay values are calculated with the offset to the first measured CIR value in
the current scan. The delay in the peak list correspondents to the delay seen in the
CIR chart.

● "Match.Guard Per."
Display the number of the matching guard periods for each peak

For other signals in this table, see "Left table" on page 1229.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional command.
● "Reset Zoom"

Resets the x-axis scale to 0 ms to approx. 26.5 ms.

LTE scanner CIR view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-875: LTE Scanner CIR View - configuration

Dynamic Range
The two input fields in this panel define the maximal/minimal signal level to be dis-
played in the "LTE Scanner CIR View". The signal levels out of the range defined with
maximal and minimal signal levels are not displayed.

CIR List Column
The CIR list selects which information to display in the left table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.
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Peak List Column
The peak list selects which information to display in the right table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.

Doppler Frequency
The panel provides an input field for correcting the Doppler frequency displayed in the
"Peak List". The purpose of the correction is to subtract frequency offsets in the mea-
sured frequency that cannot originate from the speed of the test vehicle relative to the
signal source.
The frequency offset is calculated as follows:
Meas. Freq. [Hz] * Drift Correction [ns/s] * 10^-9.

Example: 
Frequency: 2 GHz
Drift Correction: 100 ns/s
Frequency Offset: 200 Hz

Channel Timeout
If there is no data on a channel anymore, the "CIR List" entries for this channel are
removed after a timeout.

Show Cyclic Prefix in Graph
The display of the cyclic prefix in the CIR chart can be switched on or off via "Show
Cyclic Prefix in Graph". If the check box is ticked, the Cyclic Prefix is displayed as a
dotted vertical line of the cell ID color in "CIR Chart" for each "CIR List" element.

4.8.6.5  LTE scanner eMBMS view

The "LTE Scanner eMBMS View" displays the results of the eMBMS signals measure-
ment.

eMBMS signal measurements per area ID are displayed in a tabular form in the upper
part of the view. The middle part of the view displays in the same way the measure-
ments per eNodeB branch. The lower part of the view is a chart containing CIRs of the
involved eNodeBs for the selected area.

The following figure shows the "LTE Scanner eMBMS View".
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Figure 4-876: LTE scanner eMBMS view

It is possible to configure n MBMS Area IDs, by default 12. Each of them can be
assigned to the actual measured areas automatically or manually by definition of chan-
nel and area pairs.

Signals per area ID:
● "Area ID" (MBSFN Area ID)
● "eMBMS RSRP (NC)"

RSRP of eMBMS Reference Signals with noise clipping; the signal includes the RS
power only

● "eMBMS RSRP"
RSRP of eMBMS Reference Signals

● "eMBMS RSRQ (NC)"
RSRQ of eMBMS Reference Signals with noise clipping; the signal includes the RS
power only

● "eMBMS RSRQ"
RSRQ of eMBMS Reference Signals

● "eMBMS RS SINR"
SINR of eMBMS Reference Signals

● "eMBMS RS RSSI"
Carrier RSSI measured in eMBMS Reference Signals

● "eMBMS RSSI"
Carrier RSSI measured at the time as the eMBMS measurements

● "eMBMS ISI"
Inter-symbol Interference calculated from the synchronization signals

The middle field contains count of involved eNodeBs.

Signals per eNodeB branch (n active members of an area ID, default 5 per area):
● "PCI"
● "CellId"
● "Power"

S-SYNCH Power, the same definition as normal TopN pool.
● "SINR"
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S-SYNCH Power, the same definition as normal TopN pool.
● "WB RSRP"

The same definition as normal TopN pool.
● "WB RS SINR"

The same definition as normal TopN pool.

Two dashed vertical lines in the CIR's chart show the duration of extended cyclic prefix
of the area. The CIR values are colored in the PCI color. The current zoom is reset, if
you change the area selection.

During the eMBMS measurements, all narrowband measurements, like RSRP, RSRQ
and RS-SINR are disabled.

You can configure the max/min values of the eMBMS signals in the "Available Signals"
tree under the "LTE Scan" > "eMBMS Area [n]".

Figure 4-877: eMBMS available signals

An overview of the eMBMS signals is included in "Signal Tree" > "LTE Scan" >
"eMBMS Area [n]".

LTE scanner eMBMS view configuration

The "LTE Scanner eMBMS View" parameters are configurable in the "TEC for LTE
Scanner" configuration page, see Figure 3-225.

The number of area IDs, the number of eNodeBs per an area ID and a frequency/area
ID assignment are configurable.

4.8.6.6  LTE scanner MIMO view

The "LTE Scanner MIMO View" area is divided into two panels.
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● "Condition Number Waterfall Diagram"
The diagram shows as a color-coded the measured Condition Numbers (CN) of
transmitted Resource Blocks per cell. The cell can be specified either by a physical
cell ID (PCI) or a certain Top N member number. If hovering mouse over the panel,
the SINR and the Rank values, apart from CN, are shown for the mouse position.

● "H Matrix Chart"
The chart shows measurement values of the signals selected for display and listed
on the right-hand side of the chart. In addition to the H-matrix signals, you can
select for display the Rank signal (up to 4 RI values available for 4x4 MIMO).

Figure 4-878: LTE Scanner MIMO View

The view zooming works with the mouse wheel. For panning, press the left mouse but-
ton and move the mouse. All parameters in the chat provide Tooltips when you hover
with the mouse over them.

View area

Each line represents one measurement over all resource blocks in this view. Evaluat-
ing an IQ data block up to N measurements can be performed. The IQ data block is x
seconds long, dependent on what is configured as a measurement speed in the wide-
band configuration page of the scanner. N depends on the length of a measured signal
and the MIMO measurement resolution.

The default values are 50 ms for the length of signal and 10 ms for the resolution,
which result in 4 measurements per IQ block. The view can show the condition num-
bers for the 2x2, 4x2 and 4x4 MIMO configuration, dependent on the selection in
"Tx/Rx" of the view, see the following figure.

Figure 4-879: Selection of the Tx/Rx combination
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A cursor displays details of the pixels. The active and the passive coupled focus is sup-
ported.

The lower part is the H-matrix chart. You can select the H-matrix elements you want to
be shown in the chart in the "hXX Matrix" drop-down box, see the following figure.

Figure 4-880: Selection of the H-Matrix elements

Select or unselect the checkbox to show or hide a channel in the H-matrix chart.

The graph shows CN, the selected elements of H-matrix and the MIMO rank. During
the measurement and replay, the H-matrix of the last measurement is displayed. The
graph of the H-matrix is updated by using the cursor in the waterfall diagram.

The Rank Indicator values are displayed on y-axis located on the right-hand side of the
chart, besides the axis for the H-matrix elements.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

LTE scanner MIMO view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Configuration: Subband target

The "Subband Target Selection" option lets you select the targets you want to trace
and see in the "LTE Scanner MIMO View".

Figure 4-881: LTE Scanner MIMO View - subband target selection

Trace Target
Lets you select a target for tracing. Target can be traced with a fixed PCI or as a partic-
ular Top N element.
● "Trace a fixed Phy. Cell ID"

The Phy. Cell ID is defined in the format selected in "TEC for LTE Scanner", see
Chapter 3.8.2.12, "TEC for LTE scanner", on page 341.

● "Trace Top N Element"
List of all the Top N pools defined in the scanner configuration menu. The current
Top N pool selection is indicated in the list "Top N Pools", see Chapter 3.8.2.12,
"TEC for LTE scanner", on page 341.

Configuration: MIMO view

The "MIMO View" option lets you scale the diagrams and define the colors in the view.
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Figure 4-882: LTE Scanner MIMO View - MIMO view

Dynamic Range
The dynamic range includes the configuration of:
● History graph

Set the minimum and maximum size of the history graph, expressed in [dB].
● Chart

Set the minimum and maximum of the Condition Number and the signal level of a
matrix element, displayed in the "LTE Scanner MIMO View" in [dB] and [dBm],
respectively.

The signals exceeding the configured dynamic range are not displayed.

Color Graph
For details, see "Configuration: Cell ID tracer view" on page 1225.

Colors
For details, see "Configuration: Cell ID tracer view" on page 1225.

Configuration: Device selection

The "Device Selection" page is identical to that one described in "Configuration: Device
selection" on page 1226.

4.8.6.7  LTE scanner power view

"LTE Scanner Power View" displays measured values of SINR, SINR of P-Sync and
SINR of S-Sync. The measured values are shown in the chart for the selected Cell ID
or selected Top N pool member configured in the view configuration page, see Fig-
ure 4-884. The selected Cell ID can be the physical Cell ID or the measured internal
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Cell ID. The cell ID selection can be done in the view configuration or by changing the
combo box and the edit field.

To select the cell ID, use the view configuration page or the tab at the top-left corner of
the "LTE Scanner Power View".

Figure 4-883: LTE Scanner Power View

View area

The scale of the x-axis (history) and the visibility of the y-values can be set in the view
configuration. The y-axis can be tracked while pressing the left mouse button when the
hand cursor appears when moving the mouse over the y-axis.

The Top N pools configuration is done in the "TEC for LTE Scanner".

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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The context menu provides the following additional commands:
● "Reset Zoom"

Resets the x-axis scale to 0 ms to approx. 26.5 ms.

LTE scanner power view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The configuration pages let you customize the diagram in the view.

Configuration: Power view configuration

The "Power View Configuration" option lets you set the x-axis scale of the view. Also
the option is used to select the parameters for display in the view.

Figure 4-884: LTE Scanner Power View - configuration

X-Axis
Define the scale of the x-axis by time information. The time interval that is shown range
between 1 and 60 seconds.
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Visible Values
Checks the values to be visible in the view. To change the used color for the selected
value, click with the right-mouse button the value in the view.

Cell Selection
The "Cell Selection" option lets you select for tracing a signal with a definite Cell ID or
a particular Top N element.
● "Trace a fixed Cell ID"

Define a fixed Cell ID for trace. The selected Cell ID can be the physical Cell ID or
the measured internal Cell ID.
Note: If the selected Cell ID is not assigned to any measured signal, the "LTE
Scanner Power View" remains empty.

● "Trace Top N Element"
List of all Top N pools defined in the scanner configuration menu. The current Top
N pool selection is indicated below the list.

Current Selection
Shows the current Cell ID selection.

Configuration: Device selection

The "Device Selection" page is identical to that one described in "Configuration: Device
selection" on page 1226.

4.8.6.8  LTE scanner reference signal CIR view

The "LTE Scanner Reference Signal CIR View" displays the CIR and CIR peaks of the
reference signal measurements. The following figure shows the results of measure-
ments in the RS CIR chart and RS CIR lists of the view.

Figure 4-885: LTe Scanner Reference Signal CIR View

The LTE scanner export supports the CIRs and CIR peaks export based on reference
signal measurements, see Chapter 7.2.5.2, "Interactive export", on page 2134.

An example of the LTE CIR and LTE CIR peak export to XML format is shown in the
following example.
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Example: 

Figure 4-886: LTE CIR export file layout

NOTE: The <ListContent> entry contains not only the timestamp but also the position
data.

Example: 

Figure 4-887: LTE CIR Peak export file layout

Position data for every <ListContent> entry is available in CIR and CIR peak export
files.
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The export to CSV format is supported.

View area

The "LTE Scanner Reference Signal CIR View" view area is similar to the LTE scanner
CIR view based on S-Sync signal measurements.

For the explanation of the view area and meaning of configurable parameters, see
"View area" on page 1228, "Left table" on page 1229 and "Right table" on page 1230.

LTE scanner reference signal CIR view configuration

The LTE scanner RS CIR view configuration is similar to the LTE scanner CIR view
configuration.

The difference between them two is that the "RS CIR View" configuration page does
not include the following entries:
● "Noise" and "P total" in the "CIR List Columns"
● "Match. Guard Per." in the "Peaks List Columns"

4.8.6.9  LTE scanner RSSI spectrum view

The "LTE Scanner RSSI Spectrum View" displays the RSSI spectrum in two ways:
● In a waterfall diagram (so called history graph) for a time span (upper part)
● In a chart for a specific timestamp (lower part)

The view supports the coupled focus function and the "Jump to timestamp" function.

Figure 4-888: LTE Scanner RSSI Spectrum View
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The view zooming works with the mouse wheel. For panning, press the left mouse but-
ton and move the mouse.

LTE scanner RSSI spectrum view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The opened page contains the "RSSI Spectrum View" tab and the common "Device
Selection" tab.

Configuration: RSSI spectrum view

The "RSSI Spectrum View" option lets you set the parameters of the RSSI chart. The
page is analog to the "LTE Scanner Cell ID Tracer View" > "Call ID Tracer View" page.

Figure 4-889: LTE RSSI Spectrum View - configuration

Configuration: Device selection

The "Device Selection" page is identical to that one described in "Configuration: Device
selection" on page 1226.

4.8.6.10  LTE scanner subband view

This view works analog to Chapter 4.8.6.3, "LTE scanner cell ID tracer view",
on page 1222. The view shows the measured RS-SINR, RS-RSRP or RS.RSRQ sub-
band values of one cell in its waterfall diagram.
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The cell can be specified either by a physical cell identity (PCI) or a certain Top N
member. The header section allows you to choose the LTE channel, the zoom factor
and the combinations of Tx and Rx antennas for display. The "Value" combo-box in the
header section allows switching between RS-SINR, RS-RSRP and RS.RSRQ display.

The selected value of the measured block is displayed in colors. The selected antenna
combinations are displayed side by side. A Tooltip shows detailed information on the
point below the mouse cursor. The active and the passive coupled focus is supported.

Figure 4-890: LTE Scanner Subband View

If the R&S ROMES NB-IoT scanner is configured to measure on that particular PRB,
the "LTE Scanner Subband View" shows where NB-IoT PRBs are configured during
the measurement. To avoid the overlapping between the NB-IoT PRBs, the view has
added the NB-IoT indicators  and the legend.
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Figure 4-891: Indicators show configured NB-IoT PRBs

There is no change in the scanner subband view if NB-IoT is not present.

Suffix for WB subband RSRP and RSRQ signals

WB subband RSRP and RSRQ signals are marked with the NC suffix meaning noise
clipping in the "Available Signals" > "LTE Scan" tree and in the associated Tooltips.

The suffix is intended to avoid naming confusion in the following signals:

● Top N Pool WB Subband RSRP(NC) and WB Subband RSRQ(NC) signals

Figure 4-892: Top N pool WB subband signals

● Template WB Subband RSRP(NC) and WB Subband RSRQ(NC) signals
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Figure 4-893: eNodeB template WB subband signals

● WB Subband RSRP(NC) signal Tooltip description
● WB Subband RSRQ(NC) signal Tooltip description

Figure 4-894: Example for the introduced WB subband Tooltips

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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LTE scanner subband view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Subband target selection

The "Subband Target Selection" option lets you select whether to be traced a signal
with a definite Cell ID or a particular Top N element.

Configuration: Subband view

The "Subband View" option lets you set supported parameters for RS-SINR, RS-RSRP
or RS-RSRQ and scale diagrams and the colors in the view.

Figure 4-895: LTE Scanner Subband View - configuration

Configuration: Device selection

The "Device Selection" page is identical to that one described in "Configuration: Device
selection" on page 1226.

4.8.6.11  LTE scanner throughput estimation 3D chart view

The "LTE Scanner Throughput Estimation 3D Chart View" visualizes the current esti-
mated throughput and CQI of each subband of a selected Top N member or PCI in 3D
chart.

The cell can be specified either by PCI or certain Top N member.

Each LTE scanner throughput estimation view has a header for fast view configuration.

The header section of the "LTE Scanner Throughput Estimation 3D Chart View" lets
you visualize the following parameters:
● LTE channel in the "Frequency" combo box
● Transmission modes and spatial layers if an item is selected in the "Transmission

Mode / Layer" drop-down box
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● CQI or estimated throughput (Est. TP) for each subband in the "Value" combo box
The bars of the CQI values are colored by the color definition of the corresponding
Est. TP values. The bars of the Est. TP values are colored by the color definition of
the corresponding CQI values.

Figure 4-896: CQI 3D chart view
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Figure 4-897: Throughput estimation 3D chart view

Passive coupled focus is supported.

The definitions of the transmission modes and the value display are coupled. If the
transmission mode or value display of one of the throughput estimation views changes,
the other views of the same view instance are updated with these definitions.

LTE scanner throughput estimation 3D chart view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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Configuration: Subband target selection

The "Subband Target Selection" option lets you select to trace signals, which you want
to be displayed in the view, via fixed PCI or as the members of the selected Top N
pool.

Figure 4-898: Subband target selection - configuration

Trace Target
The option buttons lets users select either a signal with a definite Cell ID or a particular
Top N element to be traced.
● "Trace a fixed Cell ID"

Define a fixed Cell ID for trace.
● "Trace Top N Element"

List of all Top N pools defined in the scanner configuration menu. If the "Trace
TopN Element" is checked, a Top N member of a pool in the list can be selected for
trace.

● "Current Selection"
Shows the current selection.

Configuration: TP estimation 3D chart view

The "TP Estimation 3D Chart View" option lets you scale the diagrams and sets the
colors of the CQI or Est. TP history graphs in the throughput estimation 3D chart view.
The panels include combo boxes for defining the range and the color of CQI and Est.
TP.
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Figure 4-899: Throughput estimation 3D chart view - configuration

The input fields in the "Settings for..." panels define the minimum and the maximum
CQI and estimated throughput values to be displayed in the diagrams of the view.

Signals that exceed the configured dynamic range are not displayed.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.

4.8.6.12  LTE scanner throughput estimation chart view

The "Throughput Estimation Chart View" visualizes the current estimated throughput
and CQI for each subband of a selected Top N member or a selected PCI.

The cell can be specified either by a physical cell identity (PCI) or a certain Top N
member.
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Figure 4-900: CQI chart view

The view displays the CQI or Est. TP value for each subband of the measured block.
The selected transmission modes/spatial layers are displayed in different (automati-
cally assigned) colors. The mean wideband CQI or Est.TP (total measured WB CQI or
Est. TP divided by the count of subbands) is displayed in a dotted line for each trans-
mission mode. The spatial layer is displayed in the same color as the corresponding
subband value.

Figure 4-901: Throughput estimation chart view
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The header section of the "LTE Scanner Throughput Estimation Chart View" allows
users to visualize the following parameters using the available combo boxes.
● LTE channel in the "Frequency" combo box
● Transmission modes and spatial layers if an item is selected in the "Transmission

Mode / Layer" drop-down box
● CQI or estimated throughput (Est. TP) for each subband in the "Value" combo box

Passive coupled focus is supported.

LTE scanner throughput estimation chart view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Subband target selection

The "Subband Target Selection" page is the same as one of the "Throughput Estima-
tion 3D Chart View", see "LTE scanner throughput estimation 3D chart view configura-
tion" on page 1250.

Configuration: TP estimation chart view

The "TP Estimation Chart View" option lets you scale the diagrams of the CQI or Est.
TP history graphs in the throughput estimation chart view. The tab's panels include
combo boxes for defining the range of displayed CQI and estimated throughput in this
view.

Signals exceeding the dynamic range are not displayed.

Scanner views



Display and evaluation of resultsDrive Test Software

1255Operating Manual 1171.6415.12 ─ 66

Figure 4-902: Throughput estimation chart view - configuration

Configuration: Device selection

See "Configuration: Device selection" on page 1252.

4.8.6.13  LTE scanner throughput estimation subband view

The "Throughput Estimation Subband View" visualizes the current estimated through-
put and CQI for each subband of a selected Top N member or a selected PCI in a
waterfall diagram. The cell can be specified either by a PCI or a certain Top N member.
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Figure 4-903: CQI Subband View

The view displays the CQI or Est. TP value of the measured block in color. The
selected transmission modes/spatial layers are displayed side by side. A Tooltip shows
detailed information on the point below the mouse cursor.

Figure 4-904: Throughput Estimation Subband View

The header section of the "LTE Scanner Throughput Estimation Subband View" allows
users to visualize the following parameters:
● LTE channel in the "Frequency" combo box
● Zoom factor in the "Zoom" combo box
● Transmission modes and spatial layers if an item is selected in the "Transmission

Mode/Layer" drop-down box
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● CQI or estimated throughput (Est. TP) for each subband in the "Value" combo box

Active and passive coupled focus is supported.

LTE scanner throughput estimation subband view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Subband target selection

See "Configuration: Subband target selection" on page 1251.

Configuration: TP estimation subband view

The "TP Estimation Subband View" option lets you scale the diagrams and sets the
colors of the CQI or Est. TP history graphs in the throughput estimation subband view.
The panels include combo boxes for defining the range and the color of CQI and Est.
TP history graphs.

Figure 4-905: Throughput estimation subband view settings

Configuration: Device selection

See "Configuration: Device selection" on page 1252.
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LTE scanner throughput estimation signals

The following signals are available in the Top N tree and every defined PCI tree.
● Wideband CQI for each transmission mode and spatial layer
● Wideband Est. TP for each transmission mode and spatial layer
● Min. Subband CQI for each transmission mode and spatial layer
● Max. Subband CQI for each transmission mode and spatial layer
● Average Subband CQI for each transmission mode and spatial layer
● All Subband CQI as text for each transmission mode and spatial layer
● Min. Subband Est.TP for each transmission mode and spatial layer
● Max. Subband Est.TP for each transmission mode and spatial layer
● Average Subband Est.TP for each transmission mode and spatial layer
● All Subband Est.TP as text for each transmission mode and spatial layer

For the detailed signal description, see the "Description of R&S ROMES4 Signals"
document.

4.8.6.14  LTE scanner Top N view

The "LTE Scanner Top N View" shows the parameters of the signals received from the
eNodeBs. These signals are the selected elements of the "Top N Columns" > "List"
pane in the scanner configuration menu, see Figure 4-926.

A Top N pool includes cells which have the strongest power, SINR, Cue or RSRP at a
given position and time. The cells are presented with several of their parameters, for
example, PCI, RSRP and RSRQ.

The columns in "LTE Scanner Top N View" > "List" carry the full names of the parame-
ters.
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Figure 4-906: LTE Scanner Top N View - detailed

Scanner Top N view shows multiple EARFCN

The default EARFCN(MFBI) column shows the current frequency value of the cell as
received in SIB 1 “multiBandInfoList” or “multiBandInfoList_v9e0” field. The "EARFCN"
optional column shows the primary band EARFCN value of the given Top N pool if the
signal is selected for display in the "TEC for LTE Scanner" > "Top N Settings".

Select "Show All TopN Pools" in the "Top N" box for a pool name. All Top N pools are
shown. Those ones having both primary and multifrequency band EARFCN for the
given channel are recognized by showing two EARFCN values.

Figure 4-907: All Top N pools shown

The primary band EARFCN is shown first and the EARFCN(MFBI) follows separated
by a “:” in the pool name.

The EARFCN signals are visualized in the basic views, example given, in the "Alpha-
numeric View".
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Figure 4-908: Primary and multifrequency band EARFCNs in Alphanumeric View

Scanner Top N view shows LTE-M

The optional column "LTE-M" in the "List" of the view shows if LTE-M is available on
the selected eNodeB. To have the column displayed, go to the configuration screen
and check the "LTE-M" check box, see Figure 4-926.

Figure 4-909: LTE-M column in the LTE Scanner Top N view list

The following values of the LTE-M column can be shown during replay or measure-
ment:
● "yes": LTE-M present
● "no": LTE-M not present
● "-": MIB of the eNodeB not detected

Scanner Top N view shows eNodeB name

The list contains the column "eNodeB Name" among other ones. To see the eNodeB
name, the transmitter database has to contain the provider name and the channel
number.

At least are needed:
● EARFCN and PCI or
● EARFCN, TAC and Cell ID

Two types of search for eNodeB name are available:
● PCI partial search

PCI partial search is based on EARFCN and PCI. The result can contain more than
one record. The geographically closest station is displayed.

● PCI full search
Full search is based on EARFCN, TAC and CellID. The result is unique with both
name and ECIs.

If provider or channel information (EARFCN) is missing, the eNodeB name is not avail-
able.

eNodeB name and ECI are generated in steps during the decoding of information
blocks.

1. By detecting a cell, MIB is decoded first. At this moment, only EARFCN and PCI are
available. PCI search is performed and ECIs is not available.
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2. After receiving SIB1, the full search can be performed and both eNodeB name and
ECIs become available.

Scanner Top N view shows wideband measurements

WB RSSI Min (not shown by default), WB RSSI, WB RSRP, WB RSRQ and WB SINR
signals improve the display of the wideband measurement results in the basic views,
see Chapter 4.2, "Basic views", on page 445.

The wideband (default) columns show the maximum value of the measured corre-
sponding signal over all antennas or antenna combinations (Tx/Rx). Display of
antenna/antenna combination is given in parentheses. For example, a WB RSSI of
-95.8 (2) means that this RSSI value was measured on antenna 2, and that the RSSI
value measured on antenna 1 is less than or equal to -95.8 dBm.

For the frontend configuration in the previous figure, see Chapter 6.4.15, "LTE scan-
ner", on page 1726.

Figure 4-910: LTE Scanner Top N View for antenna ports 0 and 3

The Tooltips of WB RSRP and WB RSRQ column of this view show Noise Clipping.

Figure 4-911: Measured wideband signals Tooltips
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Scanner Top N view for automatic pool configuration

The scanner Top N view of the R&S ROMES 3GPP technologies displays the all “auto-
matically configured Top N pools" on the screen.

If you select "Top N Pools" > "Automatic Pool Configuration" for a corresponding tech-
nology, the Top N selector control gets the additional entry "Show all TopN Pools" in the
view.

By selecting this entry, you can see all Top N pools in the list. The number of displayed
members per pool depends on the size of the window. It is calculated automatically in
such a way that all Top N pools can be observed without scrolling the list (if even one
member does not fit, scrollbars are added).

The signals and their decision values which users can select for ranking of the Top N
pools are available in the "Available Signals" tree.

Figure 4-912: LTE scanner - all Top N pools and Top N chart

The "Chart" panel is shown in 3D in case the automatic Top N pool configuration
active. The values of the selected signal used for ranking and display are shown as 3D
bars.

The Top N chart can be rotated moving the mouse while pressing the left button (x-
axis, y-axis and z-axis when pressing the CTRL key additionally). Press the R key to
reset the 3D chart to its default orientation.

The configuration of the Top N view allows to configure the colors for the 3D chart and
the minimum and maximum for the Top N values.
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The color of each bar represents the state of the signal based on the signals color
scale defined in the "Available Signals" configuration page. Typically this is green for
high values and red for low values.

You have the option to display the Top N pools as the grid with 2D charts instead of the
standard 3D bar chart.

To enable the grid with 2D bar charts, click on the "Show Grid" slider at the right top if
the 3D "Chart".

You may return to the 3D chart at any time by clicking the "Show 3D" slider at the right
top if the 2D "Chart".

For the Scanner Top N view the grid arrangement is dynamic to allow the best use of
space to display as many pools as possible.

Note: The maximum size of the grid is to be 6 columns and 3 rows.

The following figure shows how many rows and columns to expect in the grid.

Figure 4-913: Allowed sizes of the grids in 2D chart

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.
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Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

Figure 4-914: ToopTip for adjustment

If you start R&S ROMES4 with an empty workspace, the initial widths of the columns in
"Top N View" are initialized and scaled properly based on the current screen DPI set-
ting.

Top N list

The "List" gives an overview of the received signals in the current Top N pool together
with their measured power parameters, frequency and timing information. On mouse
rollover, each cell in the table header provides a short explanation of the corresponding
column.

It is possible to show or hide each individual table column in the view configuration
menu. Up to three differently named pools can be configured in the default setup. Each
pool has several configurable parameters.

The list contains the following columns:
● "Color"

Applies the configured color scale for the pool members.
● "#"

Number of the measured cell and Cell ID within the Top N pool.
● "TopX"
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Current rank within the Top N Pool.
● "PCI"

Physical Cell Identity, unique physical-layer cell identifier.
● "Power [dBm]"

Received signal power based on S-Sync (average/maximum/minimum/last value
taken in observation period, depending on the Top N pool settings).

● "WB RSSI Min"
Wideband Receive Signal Strength Indicator Min
Minimum received signal power in dBm based on wideband measurement, see the
following figure. The Tx antenna where the minimum was measured is noted in
parentheses.
The column is not shown by default.

Figure 4-915: WB RSSI Min column in Top N list and chart

● "WB RSSI"
Wideband Receive Signal Strength Indicator
Maximum received signal power in dBm based on wideband measurement. The Tx
antenna where the maximum was measured is noted in parentheses.

● "WB RS RSSI"
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Maximum received signal power in dBm observed only in OFDM symbols contain-
ing reference symbols for antenna port 0 (OFDM RS symbols in slot 0 & 4) based
on wideband measurement. The Tx antenna where the maximum was measured is
noted in parentheses.

● "RSRP"
Reference Signal Received Power, unit [dBm]
It is the linear average over the power contributions (in [W]) of the resource ele-
ments that carry cell-specific reference signals within the 6 innermost resource
blocks.
If receiver diversity is in use by the UE, the reported value cannot be lower than the
corresponding RSRP of any of the individual diversity branches (3GPP TS 36.214).

● "WB RSRP"
Maximum wideband Reference Signal Received Power per antenna combination
(Tx/Rx). The reference signal is like a pilot signal. RSRP is a measure of signal
strength and indicates the average received power over the resource elements that
carry cell-specific reference signals within a certain frequency bandwidth.

● "RSRQ"
Reference Signal Received Quality, unit [dB]
The signal is the ratio N×RSRP/(E-UTRA carrier RSSI), where N is the number of
RBs of the E-UTRA carrier RSSI measurement bandwidth. The measurements in
the numerator and denominator are made over the same set of resource blocks. E-
UTRA Carrier Received Signal Strength Indicator (RSSI), comprises the linear
average of the total received power (in [W]) observed only in OFDM symbols con-
taining reference symbols for antenna port 0, in the measurement bandwidth, over
N number of resource blocks by the UE from all sources, including co-channel
serving and non-serving cells, adjacent channel interference, thermal noise etc.
(3GPP TS 36.214)

● "WB RSRQ"
Wideband maximum RSRQ per antenna combination (Tx/Rx). The reference signal
is like a pilot signal. RSRQ is a measure of quality (similar to C/I). It is defined as
(N*RSRP)/(E-UTRA Carrier RSSI). The carrier RSSI measures the average total
received power observed only in OFDM symbols containing reference symbols for
antenna port 0 (OFDM RS symbols in slot 0 & 4) in the measurement bandwidth
over N resource blocks. The total received power of the carrier RSSI includes the
power from co-channel serving & non-serving cells, adjacent channel interference,
thermal noise, etc.

● "RS SINR"
Signal-to-Interference-plus-Noise Ratio measured in the 6 innermost resource
blocks per antenna combination (Tx/Rx).

● "WB RS-SINR"
Maximum Signal-to-Interference-plus-Noise Ratio measured on RS in the config-
ured wideband bandwidth per antenna combination (Tx/Rx).

● "SINR"
Signal-to-Interference-plus-Noise Ratio averaged over SSYNC and PSYNC SINR
for strong cell in [dB]. The value is marked with "*", if only SSYNC was measured
what is the case when the weak cell is measured.

● "MIMO nxm"
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The characteristics of the eNodeB, that is, the average Rank Indicator (RI) and
Condition Number (CN) in dB, where n, m is 2 and/or 4. MIMO 2x2 is the default
setting in the "LTE Scanner Top N View" configuration dialog, as shown in the fol-
lowing figure.

Figure 4-916: Default MIMO configuration

If MIMO 4x2 and/or MIMO 4x4 are selected, the associated measured RI and CN
values are also shown in the Top N List.

Figure 4-917: Top N list - detail

● "WB Bandwidth"
Detected wideband bandwidth [MHz]

● "Center Frequency"
Center frequency of the used channel, unit [GHz]. According to standard IEEE
802.16.

● "eNodeB Name"
LTE base station's name

● "Dist.(km)"
Distance to the eNodeB.

● "CIR out of CP"
CIR values in percent that are outside of the Cyclic Prefix.

● "ECI(20/8), ECI(28)"
EUTRAN Cell Identifier columns, showing the 28 bits long string, are added to the
"Top N List". The information is the same as the one in the ECGI column, but the
formatting of these parameters in the list is different.

Figure 4-918: ECI in the Top N list

● "EARFCN"
Evolved Absolute Radio Frequency Channel Number, see the "Scanner Top N
View Shows Multiple EARFCN" section.

● "ECGI"
Evolved Cell Global Identity
Cell Identifier: CellID*256 (or << 16) + eNodeB ID

● "MCC"
Mobile Country Code

● "MNC"
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Mobile Network Code
● "TAC"

Tracking Area Code
● "Cyclic Prefix"

Cyclic Prefix type
● "Physical-Layer Cell Identity"

A part of PCI, identifies a cell in the group. Possible value 0, 1 or 2
● "HPP"

Hard Pilot Pollution of the eNode B signal
● "SPP"

Soft Pilot Pollution of the eNode B signal
● "Cue"

The Cue criterion is used for UE emulation-based Top N ranking. At the point in
time, the ranking has to be performed. If selected, this algorithm calculates the Cue
for the detected cells and is used for sorting.
To calculate the Cue, that it is necessary to decode the broadcast message which
delivers the PLMN and the Cell Identity (SIB1). Only cells for which this information
is available are fed into the ranking algorithm.

● "NR"
Neighbor relation is the percentage of cells in the current Top N pool, which are
members of the specific cells intra-frequency neighbor list. It is available only after
demodulation of SIB4.

● "4G Drift"
The time drift against the receiver time, expressed in ns

● "Frame Time of Arrival Offset to PPS"
LTE frame time of arrival offset to PPS given in ms

● "CIR Delay Spread"
Time between the first and the last peak in the CIR sync measurement

● "eNodeB Tx Ports"
Number of eNodeB Tx antenna ports decoded from MIB

● "Add. PLMNs"
Additional PLMNs shared with this eNodeB, see "Top N pool signal settings"
on page 342.
Note: The shown MCC and MNC signals of the eNodeB in the "List" are always
related to the primary PLMN. However, for Top N pools, filtering of eNodeB signals
accounts all PLMNs that are in the list. The mentioned signals are shown in the
"Add. PLMNs" column, see the following figure.

Figure 4-919: MCC and MNC of additional PLMNs

● "MIB DL Bandwidth"
LTE downlink bandwidth decoded from MIB, expressed in MHz.

● "SIB eMBMS / DSS"

Scanner views



Display and evaluation of resultsDrive Test Software

1269Operating Manual 1171.6415.12 ─ 66

SIB2 eMBMS subframe configuration. For details, see "Description of R&S
ROMES4 Signals".

● "LTE-M"
Shows if LTE-M is available on the selected eNodeB. To have the column dis-
played in the "Top N" table, check the associated check-box in the "Top N Col-
umns" list of the view's configuration page.

● "5G NR"
The right-most column in the "LTE Scanner Top N View" > "List" table is dedicated
to the LTE scanner support of 5G NR measurements.
To have the column displayed in the table, check the "5G NR" check-box in the
"Top N Columns" list. The possible displayed content is:
– "-:" or "---" if there is no data
– "no" if 5G NR is not supported
– "yes" if 5G NR is supported

● "Sch. SIBs"
Shows the SIBs scheduled in SIB1. The signal is available as a Top N template
and a cell signal.

Figure 4-920: Scheduled SIBs displayed in two views

If the number of Top N members to display is limited, see "Measurement" on page 253,
the red line at the bottom of the last displayed member appears. It is a hint that the Top
N pool has more members and that some are not displayed.

Figure 4-921: Limited display of Top N members - red line

Visualization of the Frame ToA Offset to PPS

The LTE frame time of arrival offset per PPS is calculated for all LTE cells. The result
can be optionally visualized as the equally named signal in the "Alphanumeric View"
and "2D Chart View". It is illustrated in the following figure.
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Figure 4-922: Frame time of arrival offset to PPS enabled

Visualization of the CIR delay spread signal

If activated in the "Top N Pool Signal Settings", the CIR Delay Spread signal values are
displayed in this view and in the "Basic Views", see "Top N settings" on page 342.

The following figure illustrates the signal visualization in "Scanner LTE Top N View"
(the last column in the figure) and "Alphanumeric View".

Figure 4-923: CIR Delay Spread visualization

Visualization of the eNodeB Tx antenna ports signal

If the function to create power signals for each PCI is activated, the LTE scanner's
demodulator detects the number of Tx antenna ports of the eNodeB from MIB, see
"LTE signals settings" on page 352). The signal is in that case included in the "Signal
Tree" > "LTE Scan" tree, in the "eNodeB<EARFCN\PCI>Template" > "eNodeB" branch
as "WB num. Tx Antennas (MIB]".
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Figure 4-924: Number of Tx antenna port signals

The signal is visualized in the "Scanner LTE Top N View".

Figure 4-925: eNodeB Tx antenna ports visualization

Top N chart

The "Chart" shows the power and SINR as a 3D bar chart for all cells in the current Top
N pool measurement.

The bars for available WB values are also shown in the chart. In this case, the Power/
RSSI and SINR/WB-SINR signals are displayed for each cell.

The bars of the WB values slightly differ in color from the default color of the cell. The
bars of narrow band values are displayed in the exact color of the cell.

Up to eight bars per cell can be shown in the chart.
● The left side bars show: RSSI Rx1, Narrow band power, RSSI Rx2
● The right side bars stand for the quality values: SINR Rx1:Tx1, SINR Rx1:Tx2, Nar-

row band SINR, SINR Rx2:Tx1, SINR Rx2:Tx2.

In the Figure 4-915 the leftmost bar of each cell display shows the measured "WB
RSSI Min" signal. The second bar is the "Power" and the third one is the "WB RSSI".

You can select the upper/lower power and SINR level for the y-axis of the chart in the
configuration menu, see Figure 4-926.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

LTE scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Top N view

The "Top N View" option lets you the following:
● Selection of the Top N list contents.
● Selection of the power signal type to be displayed in the 2D/3D chart and used for

ranking the pools. For example, the received signal power based on S-Sync signal
or RSRP measured on the 6 innermost resource blocks can be selected as the first
2D and 3D chart value.

● Display the LTE-specific graph y-axis titles and limits in the chart, that is, the mini-
mum and the maximum value to be displayed for the selected power signal in the
view.

● Selection of the colors and the number of color definitions in the 3D chart view.
● Selection of the signal quality and/or wideband values (power and quality) to be

displayed as a 2D chart option.

Figure 4-926: LTE Scanner Top N View - configuration
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Graph
● "Show Power"

Shows the received signal power based on S-Sync in the chart, if selected.
● "Show RSRP"

Shows the Reference Signal Received Power in the chart, if selected.
● "Power Min/Max [dBm]"

Set the upper and lower Power levels for the left y-axis of the chart.
● "SINR Min/Max [dBm]"

Set the upper and lower SINR level for the right y-axis of the chart.

3D Chart Option ← Graph
● "Use Open GL Rendering"

The option determines if the 3D chart uses the open GL (hardware) rendering or
software rendering. Using open GL rendering allows faster rendering of the 3D
chart.

Grid Chart Options ← Graph
● "Displayed Top N Members"

The check box lets you select the number of Top N members that each chart in the
grid displays.

● "Max Displayed Cols"
The check box lets you select the maximum number of displayed columns in the
grid. Allowed values are from 1 to 6.

● "Max Displayed Rows"
The check box lets you select the maximum number of displayed rows in the grid.
Allowed values are from 1 to 3.

2D Chart Option ← Graph
● "Show signal quality"

If the option is selected, it shows the signal quality in the Top N chart. The option
gives the possibility to switch "on" or "off" the second y-axis on the chart and qual-
ity signal bars.

● "Show wideband values in the chart"
The option makes the bars for wideband values visible in the chart. Deactivating it
makes the chart less crowd in case there are many members.

For both options, if selected, the result of the switching is visible in the next frame, as
the chart must redraw at least once for it.

Configuration: Device selection

See "Configuration: Device selection" on page 1252.

4.8.7  LTE-M scanner views

The LTE-M scanner views show the information obtained in the LTE-M network. The
scans are performed by the R&S TSME scanner with its hardware R&S TSME-K29
option. LTE-MIMO scan and the LTE-M measurements need the R&S TSME-K35
option.

The LTE network scanner available option for R&S TSME is R&S ROMES4T1E.

Scanner views



Display and evaluation of resultsDrive Test Software

1274Operating Manual 1171.6415.12 ─ 66

How to install and configure the LTE network scanner is described in Chapter 6.4.15,
"LTE scanner", on page 1726.

The LTE-M scanner views can be selected from a submenu displayed on the right-
hand side of the "View" menu if the mouse hovers over "Scanner Views" > "LTE-M".

Figure 4-927: LTE-M scanner views

4.8.7.1  LTE-M scanner signals templates

Creating signals for all PCIs and specifying a number of EARFCNs leads to a huge
amount of measured signals as R&S ROMES4 makes the combination of frequencies
and PCIs. The huge amount of measured signals makes it difficult to find and select
the required measurement data.

The LTE-M scanner signals templates offer an easy access to the measurement data
of a specific eNodeB. This is achieved by specifying the EARFCN and the PCI for
which you want measurement data to be shown in a basic (generic) view and "Top N
Templates" and the "eNodeB Templates" branch of the "Signals Tree" > "LTE-M Scan"
tree.

Figure 4-928: LTE-M scanner signals templates

1. Select from a template branch a signal you want to be shown in a R&S ROMES4
basic view and in the "Signals Tree" as a template signal. Drag & drop the selec-
tion into the view or double click the item in the view's configuration page.
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2. A dialog pops-up asking you to define the filter for the signal. In the case of LTE-M
scanner, this filter asks for the EARFCN or the combination of EARFCN and PCI.
If you have selected several signals, check the "Apply for all signal" box. The action
applies the same filter for all signals.

The filter for the signal is entered.

3. To select data for a specific narrowband, select narrowband signal. For that, select
the narrowband index ("NB Idx") of the narrowband you want to measure in addi-
tion to the EARFCN/PCI combination,.

The signal appears in the R&S ROMES4 basic view and in a template branch of
the "Signals Tree" > "LTE-Scan" tree.

The filtering dialogs remember the last set values. You can select a LTE-M eNodeB in
the "LTE-M Scanner BCH View" to preset the filter values for the dialog.

The "Top N Templates" and the "eNodeB Templates" branch are a home of all created
template signals. You can select a signal directly from this branch if needed.

The signals templates are the part of the workspace. They will be stored to the work-
space and restore when loading it. Creating a new workspace removes the templates.

Configuration of LTE-M scanner Top N branches

There are no separate branches for each Top N pool and Top N member. Instead,
there is a single Top N node under the "Top N Templates" branch.

The Top N template signal may be configured on any generic view. If a signal is config-
ured on the generic view, a prompt for specific Top N pool and Top N member to be
configured is displayed.

Figure 4-929: Template to filter Top N PCIs

Configuration of Template Top N Pool: Enter the desired Top N pool number. A
range of Top N pools may be entered by using a comma separator which separates
individual pools or a dash to define a range of pools. For example, entered 1, 2, 4 rep-
resents the pools 1, 2 and 4 and 1-4 would represent an entry of pools 1 to 4.
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If measurement or measurement replay is in progress, the valid Top N pools are availa-
ble for selection if you click the down arrow. Click one or more of the valid pools.

Once all selections are made, click an another field or "OK" to close the selection win-
dow.

Figure 4-930: Available Top N pools

Configuration of Template Top N Member: Enter the desired Top N member number.
A range of Top N members may be entered by using a comma separator which sepa-
rates individual pools or a dash to define a range of pools. For example, entered 1, 2, 4
represents the members 1, 2 and 4 and 1-4 would represent an entry of members 1 to
4.
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Figure 4-931: Available members of the Top N pool

Selection of Narrowband Index: Enter the desired narrowband index. A range of nar-
rowbands may be entered by using a comma separator to separate individual mem-
bers or a dash to define a range of members. For example, entered 1, 2, 4 represents
the member 1, 2 and 4 and 1-4 represent an entry of member 1–4.
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Figure 4-932: Available narrowband indexes

Selection of Field Color Code: Once a valid selection is made, the field gets a green
background color. If a selection is not valid, the background color is red.

Figure 4-933: Colored fields for Top N PCI filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections". (These selections are reset each time R&S ROMES4 is restarted). To
select one of the prior selections, check the box next to the desired option and press
"OK". The new selection items are hidden. They reappear if all prior selection boxes
have been deselected.
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Figure 4-934: Prior selections

Configuration of LTE-M scanner eNodeB signals templates

If an eNodeB signal is configured for use on a generic view, a prompt to configure the
signal with desired filter values is displayed.

Figure 4-935: RSSI template signal filtering

Configuration of EARFCN Value: An EARFCN value can be entered. Multiple
EARFCN may be entered by seperating the values with a “,”. For example, by entering
1300, 1444 selected are channels with EARFCN 1300 and 1444.

If a measurement or measurement replay is in progress, a list of currently valid
EARFCN values is displayed if you click the down arrow. One or more of the values
may be selected if you check the box next to the desired choice.

Once all selections are made, click an another field or "OK" to close the selection win-
dow.
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Figure 4-936: Entered EARFCN values (LTE-M)

Configuration of PCI: A PCI value may be entered. Multiple PCI values may be
chosen by sperating the values with a “,”. For example, entered values 3, 4 select PCI
value 3 and 4.

If a measurement or measurement replay is in progress, a list of valid PCI values for
the currently selected EARFCN is displayed by clicking the down arrow. One or more
of the values may be selected if you check the box next to the desired choice,

Once all selections are made, click an another field or "OK" to close the selection win-
dow.

Figure 4-937: Entered PCI values for RSSI

Selection of Field Color Code: Once a valid selection is made, the field gets green
background color. If a selection is not valid, the background color is red.
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Figure 4-938: Colored fields for RSSI filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections" rows. (This selections are reset each time R&S ROMES4 restarts).

To select one of the prior selections, check the box next to the desired option and
press "OK". The new selection items are hidden. They reappear when all prior selec-
tion boxes are deselected.

Figure 4-939: Prior selected RSSI template signals

4.8.7.2  LTE-M scanner BCH view

The "LTE-M Scanner BCH View" shows a list of detected BTSs with their details deco-
ded from MIB and SIBs, included in related blocks.

Currently R&S ROMES4 supports only MIB decoding.

The contents of each block appears in a tree view, as soon as the block is selected.
MIB and SIB1 are displayed correctly. All other SIBs are shown under the BTS entry
without label, as a BCCH DL SCH message (which can contain several SIBs).
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Figure 4-940: LTE-M scanner BCH view - MIB content

The cell information from SIB1 is used to derive the BTS identification.

If MIB or SIB is selected on the left-hand side of the "LTE-M Scanner BCH View", the
list of PDU variants and the list of associated time stamps are displayed on the view's
right hand side. This selection is shown in the previous figure for PDUs carrying MIB.
The "LTE-M Scanner BCH View" is enhanced based on R&S ROMES4 support of
dynamic PDU. The enhancement is the list of PDU variants over time. The PDU var-
iants are shown as leaves of the base station branch.

The "PDU Variant List" in the upper right-hand part of the view shows a list of time
stamps if different variants were found. In the shown case of MIB, there was only one
variant found. "TimeStamp" shows the most recent measurement of the variant.

"LTE-M Scanner BCH View" > "Details" shows the details of the entry selected in the
pane on the left-hand side. If you select eNodeB, you get the basic data such as the
eNodeB identity, PCI, EARFCN, PLMN, antenna port number. Added is enhanced
information on DL bandwidth, support of Nb-IoT, LTE-M and eMBMS.
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Figure 4-941: LTE-M scanner BCH view - cell details

The marked data in the previous figure stands for the following view enhancements:
● "dl Bandwidth [MHz] (xx) xx" is the same information as the one displayed in Fig-

ure 4-940, the "Details" pane.
● "NB-IoT Same PCI (EARFCN:Xxxx)", where Xxxx is the EARFCN of NB-IoT sta-

tion, indicates that the NB-IoT has the same PCI as the eNodeB.
● "LTE:-M yes/no" is based on "scheduling InfoSIB1_BR_r13" field of the MIB mes-

sage. If this field exists and is greater than zero, shown is "LTE:- M yes". Other-
wise, shown is "LTE:-M no".

● "eMBMS: not supported/supported" is based on "mbsfn_SubframeConfigList" field
of SIB 2 message. The following cases are possible
– If SIB 2 is not present, shown is "eMBMS:-".
– If SIB 2 is present, but "mbsfn_SubframeConfigList" does not exist, shown is

"eMBMS: not supported".
– If SIB 2 is presents, and "mbsfn_SubframeConfigList" is found, shown

is"eMBMS:supported".

If the eNodeB has been generated from SIB 3 measurement without a corresponding
database entry, the position is displayed as Lon *<value>  Lat *<value>. The format of
the position values depends on the corresponding global R&S ROMES4 setting.

The MIB and SIBs information is available only if the LTE scanner data is recorded with
the "BCH Demodulation" enabled.

The base stations in the scanner BCH views have different states. The following colors
indicate the state of a base station:

● grey: position is not available
● grey with database symbol: position is taken from database
● red: position is estimated by power only
● yellow: position estimation is in progress
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● green: position estimation finished

RAN sharing in LTE scanner BCH view

The "LTE-M Scanner BCH View" displays eNodeBs of all PLMNs reported in the SIB1,
see Add. PLMNs.

For example, the base stations which serve the PLMN 123,1 and PLMN 123,2 are visi-
ble in the view in the branch for PLMN 123,1 and PLMN123, 2 respectively.

A base station listed below a PLMN which is not its primary PLMN is displayed with an
"‘" appended to its name.

The LTE-M scanner BCH view creates branches for all PLMNs of a base station,
instead of base stations of the primary PLMN only.

In this case the amount of shown base stations does not reflect the amount of physi-
cally existing ones.

Text Filter

The "Text Filter" function offers filtering and exporting a base station list based on dif-
ferent criteria. For details, see "BTS export settings" on page 1217.

Figure 4-942: Show/hide shared base stations option

It is possible to hide the base stations, which are displayed as non-primary PLMNs if
the "Text Filter" > "Show Shared Basestations" box is checked.

Base stations export can be done based on state of their position.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

Basestation list export

Click the "Global Export Settings" command of the view context sensitive menu to get
the "Basestation List Export" page.
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Figure 4-943: Base station list export

The following BTS list export entries are available:
● "Export ROMES Basestation List"

The content of the BCH views can be exported to a ROMES base station list.
● "Export to Google Earth"

Estimated base stations can be exported also to a KML file, which can be loaded
into Google Earth. The KML file shows the base stations positions, the error ellipse
and the most important data of the station.

● "Filter"
– "Search phase"

The export dialog allows to select which base station states are to be exported.
If mandatory columns of the list are not available, dummy data are inserted,
e.g. 0.0, 0.0 for an unknown position. This means, all lists can be loaded into
R&S ROMES4 afterwards, but they are not useful for further measurement due
to missing data.

– "Search in details"
The current visible details setting can be exported to a text file.

– "position..."
It is possible to show and hide the stations according to their different position
states by using the position filtering.

– "Max. size of error ellipse"
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The export can be filtered by a maximum size of the error ellipse of an estima-
ted base station, which must not be exceeded.
The filtering is done by a threshold value for the error ellipse area of the esti-
mated position. If this value is zero, all BTS entries with estimated position are
exported. Otherwise, only entries whose error ellipse area is less than the
threshold value will be exported via the BCH view’s "Global export settings"
context menu item.
The error ellipse area Aε can be calculated from the position error values:
Aε = PosErr1 * PosErr2 * π
Note: The specified error ellipse's area defines a confidential interval of 66%
confidence.

● "Export Complete Tree to Text File"/"Export Selected Branch to Text File"
The content of the complete or selected branch of the BCH view can be exported
to an ASCII file.

● "Additional options"
If "Export automatically after measurement" checked, the BCH views for all tech-
nologies can export the database file automatically after a measurement was fin-
ished.

● "Save and export"
The button saves the settings of the export dialog and creates the export database
file.

● "Save & Close"
To store the settings without creating an export, click the button.

● "Cancel"
Cancels the made settings.

Neighbors are exported for GSM, UMTS, LTE, LTE-M and TETRA technologies. The
standard columns for the R&S ROMES4 base station list cannot be used, as they
require the global cell identity, which is not available in the broadcast information.
Instead of using the standard column, the following columns are used for exporting the
decoded information.
● GSM

The "2GNC-ARFCN" column is exported that contains the ARFCNs of the 2G
neighbors.

● UMTS
– "2GNC-NCC,BCC,Band,ARFCN" column is exported that contains the NCC,

BCC, band and the ARFCN of the 2G neighbors.
– "Intra3GNC-SC" column is exported that contains the scrambling codes of the

intra-frequency neighbors.
– "Inter3GNC-DL_UARFCN,UL_UARFCN,SC" column is exported that contains

the DL/UL UARFCN and the scrambling code of the inter-frequency neighbors.
● TETRA

The "NeighbourCellParameters" column is exported that contains the MCC, MNC
(both only if available) and the LA and carrier of the neighbors.
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LTE-M scanner BCH view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Figure 4-944: LTE-M scanner BCH view - configuration

The "Configuration" option lets you filter base stations by selecting different states of
their position in the "Text Filter" pane. Select a base station color you want to be used
in the "ROMESMAP Route Track View" in the "Visualization" drop-down box.

4.8.7.3  LTE-M scanner Top N view

The "LTE-M Scanner Top N View" shows the parameters of the signals received from
the eNodeBs.

These signals are the selected elements of the "List" pane. A Top N pool includes cells
which have the Avg SINR, Avg RSRP, Avg RSRQ at a given position and time.
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Figure 4-945: LTE-M scanner Top N view

The cells are presented with a number their parameters, for example, PCI, RSRP,
RSRQ and so on.

The columns in "LTE-M Scanner Top N View" > "List" carry the full names of the
parameters.

The details of each narrow band are listed in the "Details" pane for a selected (blue
highlight) eNodeB. If you don't select an eNodeB for display, the first available eNodeB
is automatically selected in this pane.

Figure 4-946: Default columns in the LTE-M scanner Top N view list
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Scanner Top N view shows multiple EARFCN

The "LTE-M Scanner Top N View" supports the visualization of two EARFCNs for the
given channel in a same way the "LTE Scanner Top N View" does.

If the "LTE-M" and "EARFCN" optional signals are selected in the "TEC for LTE Scan-
ner" > "Top N Settings", the "LTE-M Scanner View" is available and the optional
EARFCN(Primary Band) column is present apart from the default EARFCN(MFBI) col-
umn in the "LTE-M Scanner Top N View" > "List".

The default EARFCN(MFBI) column shows the current frequency value of a cell as
received in SIB 1 “multiBandInfoList” or “multiBandInfoList_v9e0” field. The "EARFCN"
optional column shows the primary band EARFCN value of the given Top N pool under
the previously mentioned conditions for setting.

Select "Show All TopN Pools" in the "Top N" box for a pool name. All Top N pools are
shown. Those ones having both primary and multifrequency band EARFCN for the
given channel are recognized by showing two EARFCN values, see Figure 4-907.

The primary band EARFCN is shown first and the EARFCN(MFBI) follows separated
by a “:” in the pool name.

The EARFCN signals are visualized in the R&S ROMES4 basic views, example given,
in the "Alphanumeric View".

Figure 4-947: Primary and multifrequency band EARFCNs in Alphanumeric View

Scanner Top N view for automatic pool configuration

The scanner Top N view of the R&S ROMES 3GPP technologies displays the all “auto-
matically configured Top N pools" on the screen.

If you select "Top N Pools" > "Automatic Pool Configuration" for a corresponding tech-
nology, the Top N selector control gets the additional entry "Show all TopN Pools" in the
view.

By selecting this entry, you can see all Top N pools in the list. The number of displayed
members per pool depends on the size of the window. It is calculated automatically in
such a way that all Top N pools can be observed without scrolling the list (if even one
member does not fit, scrollbars are added).

The signals and their decision values which users can select for ranking of the Top N
pools are available in the "Available Signals" tree.
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Figure 4-948: LTE-M scanner Top N view - 3D chart

The "Chart" panel is shown in 3D in case the automatic Top N pool configuration
active. The values of the selected signal used for ranking and display are shown as 3D
bars.

The Top N chart can be rotated moving the mouse while pressing the left button (x-
axis, y-axis and z-axis when pressing the CTRL key additionally). Press the R key to
reset the 3D chart to its default orientation.

The configuration of the Top N view allows to configure the colors for the 3D chart and
the minimum and maximum for the Top N values.

The color of each bar represents the state of the signal based on the signals color
scale defined in the "Available Signals" configuration page. Typically this is green for
high values and red for low values.

You have the option to display the Top N pools as the grid with 2D charts instead of the
standard 3D bar chart.

To enable the grid with 2D bar charts, click on the "Show Grid" slider at the right top if
the 3D "Chart".

You may return to the 3D chart at any time by clicking the "Show 3D" slider at the right
top if the 2D "Chart".

For the Scanner Top N view the grid arrangement is dynamic to allow the best use of
space to display as many pools as possible.
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Note: The maximum size of the grid is to be 6 columns and 3 rows.

The following figure shows how many rows and columns to expect in the grid.

Figure 4-949: Allowed sizes of the grids in 2D chart

For the "Chart" layout in this case, see Figure 4-761.

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.

Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
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● Double-click or CTRL double-click the column header only toggles the sort order,
does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

Figure 4-950: ToopTip for adjustment

If you start R&S ROMES4 with an empty workspace, the initial widths of the columns in
"Top N View" are initialized and scaled properly based on the current screen DPI set-
ting.

Top N list

The "List" table gives an overview of the received signals in the current Top N pool
together with their measured power parameters, frequency and timing information. On
mouse rollover, each cell in the table header provides a short explanation of the corre-
sponding column.

It is possible to show or hide each individual table column in the view configuration
menu. Up to three differently named pools can be configured in the default setup. Each
pool has several configurable parameters.

The "Top N List" contains the following columns:
● "Color"

Applies the configured color scale for the pool members.
● "#"

Number of the measured cell and Cell ID within the Top N pool.
● "TopX"

Current rank within the Top N Pool.
● "PCI"

Physical Cell Identity, unique physical-layer cell identifier.
● "RSSI"

Received signal strength indicator; the RSSI measurement provides the total aver-
age power of the received waveform within the signal bandwidth. It will contain sig-
nal power from the signal of interest, noise and interferers.

● "EARFCN"
Evolved Absolute Radio Frequency Channel Number.
The signal stands for the primary EARFCN value of the given Top N pool (Primary
Band). It has to be differentiated from the Top N EARFCN (MFBI) signal which is by
default visible in the "LTE Scanner Top N View" and "Signal Tree".
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Top N Signal EARFCN(MFBI) shows the frequency current value of the cell as
received in SIB 1 “multiBandInfoList” or “multiBandInfoList_v9e0” fields.

● "Center Frequency"
Center frequency of the used channel, according to standard IEEE 802.16.

● "Internal CellID"
Unique cell identity.

● "Total BR-RSSI"
Total BR-RSSI across all narrow bands.

● "Avg BR-RSRP"
Average BR-RSRP across all narrow bands.

● "Avg BR-SINR"
Average BR-SINR across all narrow bands.

● "Avg BR-RSRQ"
Average BR-RSRQ across all narrow bands.

● "NB Index"
List of the values of the Top N decision value for each narrow band of the eNodeB.

● "NB Count"
The number of narrow bands for a given cell.

Top N details

The "Details" table gives an overview of a specific narrow band for the currently
selected eNodeB.

Each cell in the table header provides a short explanation of the corresponding column
on mouse rollover. It is possible to show or hide each individual table column in the
view configuration menu.

The table contains the following columns:
● "PCI"

Physical Cell Identity, unique physical-layer cell identifier.
● "NB Index"

Index of the specified narrow band.
● "NB RB Offset"

Narrow band Resource Block Offset.
● "Internal CellID"

Unique cell identity
● "BR-RSSI"

Reference signal received signal strength indicator; the measurement provides the
total average power of OFDM symbols that carry cell specific reference signals.

● "BR-RSRP"
Reference signal received power; the measurement represents the linear average
over the power contributions [mW] of the resource elements that carry cell specific
LTE-M reference signals (CRS) within the measurement bandwidth. By default, the
CRS from eNodeB antenna port 0 is are used for this purpose, but CRS of other
ports may also be used for the measurement.

● "BR-SINR"
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Reference signal carrier to interference and noise ratio; the measurement is a ratio
of the power of the LTE-M signal from a particular cell and noise and interference
that are present. This measurement is performed at the resource elements occu-
pied by cell specific reference signals.

● "BR-RSRQ"
Reference signal received quality; the measurement is computed as the following
ratio. Remember that the RS-RSSI measurement extends over the full signal band-
width BR-RSRQ = (NRB · BR-RSRP) / BR-RSSI.

Top n chart

The "Chart" shows the Avg BR-RSRP and BR-SINR as a 2D bar chart for all cells in
the current Top N pool measurement. You can select the upper/lower Avg BR-RRP and
Avg BR-SINR level for the y-axis of the chart in the configuration menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

LTE-M scanner Top N pool configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Top N view

The "Top N View" option lets you the following:
● Selection of the Top N list contents.
● Selection of the Top N details contents.
● Selection of the power signal type to be displayed in the 2D/3D chart.
● Display the LTE-M -specific graph y-axis titles and limits in the chart, that is, the

minimum and the maximum value to be displayed for the selected power signal in
the view.
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Figure 4-951: LTE-M Scanner Top N View - configuration

Graph
● "Show Avg BR-RSRP"

Shows the Reference Signal Received Power in the chart, if selected.
● "Show Avg BR-RSRQ"

Shows the Reference Signal Received Quality in the chart, if selected.
● "Avg BR-RSRP Min/Max [dBm]"

Sets the upper and lower Avg BR-RSRP for the left y-axis of the chart.
● "Avg BR-SINR Min/Max [dBm]"

Sets the upper and lower SINR level for the right y-axis of the chart.
● "Displayed Top N Members"

In the drop-down box select the number of a Top N members .

3D Chart Option ← Graph
● "Use Open GL Rendering"

The option determine if the 3D Chart is rendered open GL (hardware) rendering or
software rendering. Using open GL will allow for faster rendering of the 3D chart.

Grid Chart Options ← Graph
● "Displayed Top N Members"

The check box lets you select the number of Top N member that each chart in the
grid will display.

● "Max Displayed Cols"
The check box lets you select the maximum number of displayed columns in the
grid. Allowed values are from 1 to 6.

● "Max Displayed Rows"
The check box lets you select the maximum number of displayed rows in the grid.
Allowed values are from 1 to 3.

2D Chart Option ← Graph
● "Show signal quality"

If the option is selected, shows the signal quality in the Top N chart. This is the pos-
sibility to switch "on" or "off" the second y-axis on the chart and quality signal bars.
The result of the switching is visible in the next frame, as the chart must redraw at
least once for it.
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4.8.8  NB-IoT scanner views

The NB-IoT scanner views show the information obtained in the scanners performed
by a R&S radio network analyzer.

The NB-IoT scanner views can be selected from a submenu displayed on the right side
of the "View" menu when the mouse hovers over "Scanner Views" > "NB-IoT".

Click one of the available view entries to see the layout of the selection.

Figure 4-952: NB-IoT Scanner view

The NB-IoT scanner views offer the extended center frequency output to four digits
after the decimal point.

The basic views show the measurement values of the available, configured and detec-
ted NB-IoT signals.

The Alphanumeric View also shows the center frequency with four digits after the deci-
mal point.

Figure 4-953: Center frequency shown in Alphanumeric View

4.8.8.1  NB-IoT scanner signals tempates

The NB-IoT scanner signals templates offer an easy access to the measurement data
of a specific eNodeB. This is achieved by specifying the EARFCN\NPCI whose mea-
surement data you want to be shown in a basic (generic) view and in the "Top N Tem-
plates" and the "eNodeB<EARFCN/NPCI> Template" branch of the "NB-IoT Scan"
tree.
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Figure 4-954: NB-IoT scanner signals templates

1. Select from the "Top N Templates" or the "eNodeB<EARFCN/NPCI> Template"
branche a signal you want to be shown in a R&S ROMES4 basic view as a tem-
plate signal. Drag & drop the selection into the view or double click the item in the
view's configuration page.

2. A dialog pops-up asking you to define the filter for the signal. In the case of NB-IoT
scanner, this filter asks for the EARFCN or the combination of EARFCN and NPCI.
If you have selected several signals, check the "Apply for all signal" box. The action
applies the same filter for all signals.

The filter for the signal is entered.

The signal of the specific eNodeB appears in the R&S ROMES4 basic (generic)
view and the "Top N Templates" or "eNodeB<EARFCN/NPCI> Template" branch of
the "NB-IoT Scan" tree.

The filtering dialogs remember the last set values. You can select a eNodeB in the
"NB-IoT Scanner BCH View" to preset the filter values for the dialog.

The template branches are a home of all created template signals. You can select the
signal directly from these branches if needed.

The template signals are part of the workspace. They will be stored to the workspace
and restore when loading it. Creating a new workspace removes the template signals.

Configuration of NB-IoT scanner Top N branches

There are no separate branches for each Top N pool and Top N member. Instead,
there is a single Top N node under the "Top N Templates" branch.

The Top N template signals may be configured on any generic view. If a signal is con-
figured on the generic view, a prompt for specific Top N pool and Top N member to be
configured is displayed.
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Figure 4-955: Template to filter Top N NPCIs

Configuration of Template Top N Pool: Enter the desired Top N pool number. A
range of Top N pools may be entered by using a comma separator which separates
individual pools or a dash to define a range of pools. For example, entered 1, 2, 4 rep-
resent pools 1, 2 and 4 and 1-4 would represent an entry of pools 1 to 4.

If measurement or measurement replay is in progres, the valid Top N pools are availa-
ble for selection by clicking the down arrow. Click one or more of the valid pools.

Once all selections are made, click an another field or "OK" to close the selection win-
dow.

Figure 4-956: Available Top N pools

Configuration of Template Top N Member: Enter the desired Top N member number.
A range of Top N members may be entered by using a comma separator which sepa-
rates individual pools or a dash to define a range of pools. For example, entered 1, 2, 4
represent members 1, 2 and 4 and 1-4 would represent an entry of members 1 to 4.

Selection of Field Color Code: Once a valid selection is made, the field gets a green
background color. If a selection is not valid, the background color is red.
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Figure 4-957: Colored fields for Top N NPCI filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections". (These selections are reset each time R&S ROMES4 is restarted). To
select one of the prior selections, check the box next to the desired option and press
"OK". The new selection items are hidden. They reappear if all prior selection boxes
have been deselected.

Figure 4-958: Prior selections

Configuration of NB-IoT scanner eNodeB<EARFCN\NPCI> Signals Tempates

If an eNodeB signal is configured to be used on a generic view, a prompt to configure
the signal with desired filter values is displayed.

The signals that are found under the "eNodeB<EARFCN\NPCI>" are prompted as
shown in the following figure.
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Figure 4-959: NPSS power template signal filtering

Configuration of EARFCN Value: An EARFCN value can be entered. Multiple
EARFCN may be entered by seperating the values with a “,”. For example, by entering
1300, 1444 selected are channels with EARFCN 1300 and 1444.

If a measurement or measurement replay is in progress, a list of currently valid
EARFCN values is displayed if you click the down arrow. One or more of the values
may be selected by checking the box next to the desired choice.

Once all selections are made, click an another field or "OK" to close the selection win-
dow.

Figure 4-960: Entered EARFCN values

Configuration of NPCI: A NPCI value may be entered. Multiple NPCI values may be
chosen by sperating the values with a “,”. For example, entered values 393, 394 select
NPCI value 393 and 394.

If a measurement or measurement replay is in progress, a list of valid NPCI values for
the currently selected EARFCN is displayed if you click the down arrow. One or more
of the values may be selected if you check the box next to the desired choice,

Once all selections are made, click an another field or "OK" to close the selection win-
dow.
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Figure 4-961: Entered NPCI values

Selection of Field Color Code: Once a valid selection is made, the field gets green
background color. If a selection is not valid, the background color is red.

Figure 4-962: Colored fields for NSSS power filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections" rows. (This selections are reset each time R&S ROMES4 restarts).

To select one of the prior selections, check the box next to the desired option and
press "OK". The new selection items are hidden. They reappear when all prior selec-
tion boxes are deselected.

Figure 4-963: Prior selected template signals
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4.8.8.2  NB-IoT scanner BCH view

The"NB-IoT Scanner BCH View" shows a list of detected BTSs and their MIB and SIBs
decoded from the NB-IoT BCH. The contents of each block appear in a tree view, as
soon as the block is selected.

MIB and SIB1 are displayed correctly. All other SIBs are shown as BCCH DL SCH
message (which can contain several SIBs) under the BTS entry without label. Addition-
ally, the cell information from SIB1 is used to derive the BTS identification.

If the eNodeB is generated from SIB3 measurement without corresponding database
entry, the position is displayed as Lon*<value>Lat*<value>. The format of the position
values depends on the corresponding global R&S ROMES4 setting.

The MIB and SIBs information is available only if the NB-IoT scanner data is recorded
with the activated "BCH Demodulation".

Referring to R&S ROMES4 support of dynamic PDU handling described in Chap-
ter 3.8.2.1, "Technologies", on page 280, the "NB-IoT Scanner BCH View" is
enhanced. The enhancement is the list of measured PDU variants over time. The PDU
variants are shown as leaves of the base station branch.

Further enhancement in the "Details" of the view is the info "operationMo-
deInfo_r13_inband SamePCI..." indicating the same PCI as the eNodeB has.

Figure 4-964: BCH eNodeB MIB may show following information

The "NB-IoT Scanner BCH View" displays eNodeBs of all PLMNs reported in the SIB1,
see "Add. PLMNs" in "Top N list" on page 1316.

If a SIB is selected on the left-hand side of the "NB-IoT Scanner BCH View", the list of
PDU variants and the list of associated time stamps are displayed on the view's right-
right hand side.

The "PDU Variant List" in the upper right-hand part of the view shows a list of time
stamps if there were different variants found. In the shown case of SIB 1, there was
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only one variant found. "TimeStamp" shows the most recent measurement of the var-
iant.

The "NB-IoT Scanner BCH View" > "Details" shows the previously mentioned support
of four digits after decimal point in the frequency output.

Figure 4-965: Center frequency shown in BCH View

The base stations in the scanner BCH view have different position states. The follow-
ing colors indicate the state of a base station:
● grey: position is not available
● grey with database symbol: position is taken from database
● red: position is estimated by power only
● yellow: position estimation is in progress
● green: position estimation finished

Figure 4-966: Show or hide shared base stations

A base station, which is listed below a PLMN that is not its primary PLMN is displayed
with an ' appended to its name.

The view creates branches for all PLMNs of the base stations, instead of base stations
only for the primary PLMN. It is possible to hide the base stations, which are displayed
as non-primary PLMNs if you check the "Text Filter" > "Show Shared Basestations"
check-box in the view.

BTS export parameters configuration

If the export has been started before measurement or replay has been stopped, the file
contains all the System Information starting from the selected node in the BCH tree,
that is, all SIBs of the selected eNodeB or all SIBs belonging to all eNodeBs of one
provider (MCC, MNC).

If the export has been started after measurement or replay has been stopped, the file
contains all System Information belonging to all eNodeBs included in the "NB-IoT
Scanner BCH View".
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The System Information can be exported to an ASCII file in the EXPORT directory of
R&S ROMES4. The name of the export file is

NB-IoT_<measurement filename>.txt
If the position estimation is active, the estimated positions are added to the eNodeB
entries. Estimated positions are marked by an asterisk.

After stopping the measurement, the view automatically generates an eNodeB list of
import files with an entry for every estimated eNodeB position. The eNodeB list files
are stored in the R&S ROMES4 measurement directory.

Context Menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

Nb-IoT scanner BCH view configuration

The NB-IoT Scanner BCH View configuration assumes base stations filtering based on
selection of their position.

Click with the right-mouse button any point within the view to open the configuration
page.
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The option allows you to filter base stations using their different state of position in the
"Text Filter" pane. The base station color to be used in the ROMESMAP Route Track
view you can select in the lower pane of the view.

Figure 4-967: NB-IoT Scanner BCH View - configuration

4.8.8.3  NB-IoT scanner reference signal CIR view

The "NB-IoT Scanner Reference Signal CIR View" displays the CIR and CIR peaks of
the reference signal measurements. The following figure shows the results of measure-
ments in the RS CIR chart and RS CIR lists of the view.

Figure 4-968: NB-IoT Scanner Reference Signal CIR View
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The NB-IoT scanner export supports the CIRs and CIR peaks export based on refer-
ence signal measurements. An example of the NB-IoT CIR and NB-IoT CIR peak
export to XML format is shown in the following example.

Example: 

Figure 4-969: NB-IoT CIR export file layout

NOTE: The <ListContent> entry contains not only the timestamp but also the position
data.

Example: 

Figure 4-970: NB-IoT CIR Peak export file layout

The export to CSV format is supported.
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View area

The entire view area is horizontally split to accommodate a chart and a table/list.

The "CIR Chart" shows the channel impulse response of the different NB-IoT signals
which have been scanned. The graph allows zooming into the chart. The small button
on the right of the scroll bar reset the zoom level.

Click "CIR Chart" or "CIR Lists" to compresses/expand the 2D chart or table. A com-
pressed chart leaves more space for the table and vice versa.

Moreover, the tables appear in several views so that compressing them can help to
avoid redundancies.

To compress/expand table use the ">>>"/"<<<" symbol in its title bar.

Diagram scale

If placed inside the diagram area, the cursor takes the shape of a zoom-in icon (a mag-
nifying glass with a '+' inside), and a vertical line is displayed at the cursor position.

The cyclic prefix is shown in the "CIR Chart" for each "CIR Lists" element as a dotted
vertical line in the cell ID color.

Figure 4-971: Diagram scale

The display of the cyclic prefix in the CIR chart can be switched off in the "NB-IoT
Scanner Reference Signal CIR View" configuration.

A left mouse button click magnifies the diagram in x-direction around the cursor posi-
tion. CTRL + left mouse click causes the opposite.

An area to become the new x-axis range (e.g. the area around a peak) can be marked
while the left mouse button is pressed

"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

Left table

The table lists all the scanned NBI-IoT segments:
● "Color"
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Sequence number and physical cell ID color. The color can be configured in the
views configuration page.

● "Physical Cell ID"
Physical Cell Identity, range 0 to 503

● "ECI"
E-UTRAN Cell Identifier (format ENB-ID 20 bits, CI 8 bits), unique for a cell even if
the physical cell IDs are identical.

● "MNC"
Mobile Network Code

● "MCC"
Mobile Country Code

● "Power [dBm]"
The received power on S-Sync signal

● "Noise [dBm]"
Noise floor based on S-Sync signal

● "P total [dBm]"
Total in-band power based on S-Sync signal, including thermal noise and noise
generated in the receiver

● "Frequency [MHz]"
Center Frequency

● "EARFCN"
Evolved Absolute Radio Frequency Channel Number

● "ISI"
CIR outside of cyclic prefix

● "Exp. Drift [ns/s]"
Expected time drift against the receiver time

● "Sigma Drift [ns/s]"
Expected standard deviation of the expected time drift

● "Max.Delay [µs]"
Maximum delay of the relating peaks

● "Time Delta [µs]"
Time difference between the first and the last arrived peak

● "Unique ID"
Unique BTS ID generated by the scanner per on a channel identified BTS

Right table

The right table shows the different path of the segments. The table lists all scanned
NB-IoT segments.

The specific ones are listed here:
● "Delay [μs]"

Shows signal's delay time. The delay values are calculated with an offset to the
first measured CIR value in the current scan.
The delay in the peak list correspondents to the delay seen in the CIR chart.

● "Match.Guard Per"
Display the number of the matching guard periods for each peak
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For other signals in this table, see previous table signals.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional command.
● "Reset Zoom"

Resets the x-axis scale to 0 ms to approx. 26.5 ms.

NB-IoT scanner CIR view configuration

Right mouse click any point inside the view pops-up the context sensitive menu. Select
the "Configuration" command to get the "CIR View" configuration page.

The "CIR View" option lets you customize the diagram and the contents of the table in
"NB-IoT Scanner Reference Signal CIR View".
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Figure 4-972: NB-IoT Scanner CIR View - configuration

Dynamic Range
The two input fields in this panel define the maximal/minimal signal level to be dis-
played in the "NB-IoT Scanner Reference Signal CIR View." The signal levels out of
the range defined with maximal and minimal signal levels are not displayed.

CIR List Column
The CIR list selects which information to display in the left table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.

Peak List Column
The peak list selects which information to display in the right table below "CIR Chart".
Clearing a box hides the corresponding row in the diagram.

Doppler Frequency
The panel provides an input field for correcting the Doppler frequency displayed in the
"Peak List". The purpose of the correction is to subtract frequency offsets in depend-
ency of the measured frequency that cannot originate from the speed of the test vehi-
cle relative to the signal source. The frequency offset is calculated as follows:
Meas. Freq. [Hz] * Drift Correction [ns/s] * 10^-9.
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Example: 
Frequency: 2 GHz
Drift Correction: 100 ns/s
Frequency Offset: 200 Hz

Channel Timeout
If there is no data on a channel anymore, the "CIR List" entries for this channel are
removed after a timeout.

Show Cyclic Prefix in Graph
The display of the cyclic prefix in the CIR chart can be switched on or off via "Show
Cyclic Prefix in Graph". If the checkbox is ticked, the Cyclic Prefix is displayed as a dot-
ted vertical line of the cell ID color in "CIR Chart" for each "CIR List" element.

4.8.8.4  NB-IoT scanner Top N view

The "NB-IoT Scanner Top N View" shows the properties of the NB-IoT scanner signals
received from the eNodeBs.

These signals are the selected elements of the "List" columns, see Figure 4-980.

Figure 4-973: NB-IoT Scanner Top N View
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The R&S TSME scanners support measurements of synchronization and reference
signals.

The Top N view includes the received power and CINR on narrowband reference sig-
nals (NRS), NPSS and NSSS and the received quality (NRSRQ) of NRSs for each
physical antenna port (Tx0, Tx1).

The eNodeB name is shown in the list if the transmitter database contains provider and
channel, or at least EARFCN and NPCI.

Figure 4-974: Default columns in the NB-IoT Scanner Top N View List

Figure 4-975: Four digits after pointer for center frequency

The previous figure shows a part the "List" with emphasis on the center frequency
which is shown with four digits after the pointer.

The following figures of the "Alphanumeric View" show signals related to NPSS Power,
CINR and Frame Time of Arrival measurements available in the "NB-IoT Scanner Top
N View". To be viewed, these signals have to be activated in the scanner configuration
page, see Chapter 4.8.8.4, "NB-IoT scanner Top N view", on page 1312. The signals
are available in the R&S ROMES4 "Available Signals" tree and shown by ToolTips if a
mouse hovers over a signal.

Figure 4-976: Alphanumeric view - NPSS power and CINR
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Figure 4-977: Alphanumeric view - frame ToA

The signals range and the signal events are configurable.

To configure the range of a signal:

1. Double click any point in the scanner view page.

2. In the dropped menu select the "Configure Signals"

The "Configure Signals" > "Available Signals" page opens.

3. Select one of the mentioned signals, configure the range and click "OK".

Figure 4-978: Signal range configuration

The range of signals is also configurable in "Preference" > "Available Signals".

To configure the signal event:

1. Double click any point in the scanner view page.

2. In the dropped menu select the "Configure Events"

The "Configure Events" > "Available Events" page opens.

Select one of the mentioned signals and configure event.
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Figure 4-979: Event configuration

The event is also configurable in "Preference" > "Available Events".

For description of signals, see "Description of R&S ROMES4 Signals" > "NB-IoT Scan-
ner".

The numbers in the brackets besides the measured signals stand for the configured
antenna ports, that is, Tx antenna port 0 and Tx antenna port 1.

If you start R&S ROMES4 with an empty workspace, the initial "Top N View" column
widths are initialized and scaled properly based on the current screen DPI setting.

Frame time of arrival (ToA)

Frame ToA is calculated using offset to PPS or internal block time and offset. The
frame type is FDD or TDD frame.

Therefore, there are two types of Frame Time of Arrival.

● GPS PPS ToA
If using GPS PPS, the value is a shift/drift pertaining to RF grid,. The value is
always less than the frame length

● Block Time ToA
If using Block Time and Offset, the values are generated by internal clock.

The formula to calculate ToA for FDD frame is: Frame Time = ((Internal TOA + 5 ms)
modulo 10 ms ) - 5 ms

The formula fto calculate ToA for TDD frame is: Frame Time = ((Internal TOA + 2.5 ms)
modulo 5 ms ) – 2.5 ms

In the formulas display unit is millisecond, modulo is the operation that takes the
remainder of a division of two double operands. 5 ms and 10 ms stand for frame
lengths of TDD and FDD frames, respectively.
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● R&S ROMES4 v18.2 or higher must be used to record and show ToA time. Replay-
ing early recorded measurement file shows empty or "--" space. The following is
valid:

● Signal is available in Top N Pool and template signal trees
● GPS PPS values require GPS antenna and module and the signal values take a

little bit time (probably a minute) to be available
● Frame ToA signals do not have events
● ToA signals by Block Time are always available if R&S ROMES4 v18.2 or higher is

used

The automatic pool configuration feature is also supported with NB-IoT Scanner Top N
View. Applied are the common functions and rules as for other 3GPP specified technol-
ogies, see "Scanner Top N view for automatic pool configuration" on page 1262.

Top N line

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

Top N list

The "Top N List" gives an overview of the all received signals in the current Top N pool
together with their measured power parameters, frequency and timing information. On
mouse rollover, each cell in the table header provides a short explanation of the corre-
sponding column.

The "Top N List" shows the following optional signals if configured.
● "TopX"

Rank of the current cell in the Top N pool.
● "NPCI"

Physical Layer Cell Id, range 0 to 503.
● "NSSS Power"
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NSSS power of the secondary sync signal, range -150.00 to 10.00 dBm.
● "NSSS CINR"

Carrier to Interference plus Noise Ratio of the secondary synchronisation signal,
range -20 to 40.00 dB.

● "NPSS Power"
NSSS power of the primary sync signal, range -150.00 to 10.00 dBm.

● "NPSS CINR"
Carrier to Interference plus Noise Ratio of the primary synchronisation signal,
range -20.00 to 40.00 dB.

● "Frame ToA (GPS PPs)"
Frame Time of Arrival related to radio frequency grid in millisecond calculated by
GPS Pulse Per Second (PPS) and offset to PPS, range -10.00 to 10.00 ms.

● "Frame ToA (Internal)"
Frame Time of Arrival related to radio frequency grid in millisecond calculated by
internal block time and offset to it, range -10.00 to 10.00 ms.

● "NRSSI"
Total power received by the scanner inside the 180 kHz bandwidth of a NB-IoT
channel. This power includes all possible NB-IoT signals transmitting in the chan-
nel as well as noise, range -150.00 to10.00 dBm.

● "Frame Struct. Type"
FDD or TDD frame structure; type 1 or type 2 respectively.

● "Cyclic Prefix"
Normal or extended length.

● "Central Frequency"
Center frequency of the NB-IoT signal, range 0.00 to 4294967294.00 Hz

● "NRSRP (Tx0/1)"
Average power of the power received from reference signals from Tx antenna port
x, range -150.00 to 10.00 dBm.

● "NRSRQ (Tx0/1)"
Reference Signal Received Quality (from Tx antenna port x) considering also
NRSSI and the number of used Resource Blocks(N) - NRSRQ = (N * NRSRP) /
NRSSI measured over the same bandwidth, range -20.00 to 0.00 dB.

● "NRS CINR (Tx0/1)"
Reference Signal Power from Tx antenna port x divided by the sum of the interfer-
ence power and the power of some background noise, range -20.00 to 50.00 dB.

● "NRS RSSI (Tx0/1)"
Total received power of reference signals from Tx antenna port x, range -150.00 to
10.00 dBm.

● "EARFCN"
Evolved Absolute Radio Channel Number

● "eNodeB Name"
LTE base station's name

● "Dist.(km)"
Distance to the eNodeB.

● "ECI(20/8), EC(28)"
EUTRAN Cell Identifier columns
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Cell Identifier: CellID*256 (or << 16) + eNodeB ID
● "MCC"

Mobile Country Code
● "MNC"

Mobile Network Code
● "TAC"

Tracking Area Code
● "Add. PLMNs"

Additional PLMNs shared with this eNodeB
● "Operation Mode"

The operation mode of a NB-IoT cell broadcasted in the cell's MIB is included in
the scanner's Top N view list and in the "Signal Tree".

For the NB-ioT scanner signals details, see "Description of R&S ROMES4 Signals"
manual.

You can add or remove the optional signals by right click any point of the "NB-IoT
Scanner Top N View" and choose the wanted configuration.

Select or unselected the desired rows in the "List" of the "Top N View" page, see Fig-
ure 4-980.

NB-IoT scanner Top N view configuration

The "Configuration" option lets you set the color for the selected BTS symbols in the
"ROMESMAP Route Track View" and define the filter for generating a BTS list.

Open the configuration page by a right mouse click on a point inside the view or via the
"Tools" > "Configuration Active View" command.

Configuration: Top N view

The "Top N View" configuration option is common for all technologies, see "LTE scan-
ner Top N view configuration" on page 1272.

Figure 4-980: NB-IoT scanner Top N view - configuration

Configuration: Device selection

This configuration is common for all technologies.
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Figure 4-981: Device selection for NB-IoT scanner Top N view

4.8.9  RF power scanner views

The "RF Power Scanner Views" show the RF power information obtained in the RF
power scan performed by an R&S radio network analyzer.

For the RF power scan, use the R&S TSME scanner with its hardware option R&S
TSME-K27.

The RF Power Scanner available option is R&S TSME4T1E.

See Chapter 6.4.21, "RF power scanner", on page 1823.

The RF power scanner views can be selected from a submenu displayed on the right-
hand side of the "View" menu if the mouse hovers over the "RF Power Scanner
Views".
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Figure 4-982: RF Power Scanner views

"RF Power Scanner View:<n>" shows the RF power information obtained in the RF
scans performed by an R&S TSME radio network analyzer.

The RF power Peak of Peaks (PoP) signal list is added to the "Sweep Templates" of
the RF Power Scan branch in the "Signal Tree".

An RF power scan sweep contains RF Power Scan frames. Each of the frames con-
tains a list of peak signals. A peak is a turning point where signal power changes from
going strong to going weak. Peak signals are ranked by their power values. When
selecting peak signals in signal filter, sweep and rank are needed.

For the signals in the PoP list and their description, see "Description of R&S ROMES4
Signals" document.

4.8.9.1  RF power scanner sweep template

Adding signals to a generic view is done by dragging a signal from the "Signal Tree" >
"RF Power Scan" branch to the view. A signal filter dialog is displayed for selecting
sweep or optionally mark or channel number. If hovering mouse over the name column
of the dialog, the Tooltip is displayed.

Value fields are displayed red if a valid value is entered or selected.

Check boxes in the first column are readable only if the field is required.

The "Apply for all signals" check box indicates whether to apply the same selection to
all signals.

Filtering dialog is without the "Device" group, for example, in "Alphanumeric View".

Sweep names are listed in the sweep grid data column (the first row and the third col-
umn normally).
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● If no measurement file is opened, the default sweep name is "Sweep x" where x is
the sweep index.

● If a measurement file is opened, the sweep names are retrieved from measure-
ment file.

● If multiple RF Power devices are available, "+" is suffixed to the end of the first
sweep name.

Filter dialog without device group

The screenshot shows the filter dialog without device group, for a generic view, for
example, the "Alphanumeric View".

Figure 4-983: Frequency signal template without device filtering

Filter dialog with device group

The screenshot shows the filter with device group, for a generic view, for example, the
"2D Chart View" or the "Grid View".

Figure 4-984: Frequency signal template with device filtering

Select sweep

The maximum number of sweeps is 40.
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Figure 4-985: Filtering per total rate for sweep 2

Select sweeps for multiple devices

If multiple devices are configured, a sweep name of the first device is listed and suf-
fixed with indicator "+".

If the name already ends with "+", the indicator is "(+)".

Figure 4-986: Filtering per frequency for multiple devices

Select marks for fixed mark signals

The maximum number of fixed markers is four.
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Figure 4-987: Filtering per fixed markers

Select channel number for channels

Channels can be configured when creating RF Power Scan measurement file.

Channels are associated with sweep. After a sweep is selected, the corresponding
configured channels are available in the drop-down check list.

1. If there is no opened measurement file, free channels can be entered.

Figure 4-988: Filtering per free entered channels

2. If measurement file is opened and contains configured channels, these channels are
displayed in "Channel" row for selection.
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Figure 4-989: Filtering per channels from opened file

If the measurement file does not contain the configured channels, the channel row is
empty, as shown in the previous figure.

Prior selected signals

Figure 4-990: Prior selected signals

Select filter for peak of peaks signals

The RF Power Scan Peak of Peaks (PoPs) is added to the sweep template. The filter-
ing can be done per Frequency (PoP), Channel Index (PoP) and Level (PoP). To select
a PoP signal, sweep and rank are needed. Rank can be entered, but if not entered
assumed is to be 0. To enter Rank, the "Rank" check-box must be checked.
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Figure 4-991: Filtering per frequency PoP

The dialogs for filtering per Channel index (PoP) and Level (PoP) are identical.

The following screenshot shows a Frequency (PoP) filter with three sweeps and two
ranks selected.

Figure 4-992: Filtering per frequency (PoP) - three sweeps and two ranks

4.8.9.2  RF power scanner signals in alphanumeric view

The sweep names in the "Alphanumeric View" are different dependent on context. The
context depends on whether the sweeps are entered (no opened file), taken from the
measurement file or from the configuration of multiple devices.

Sweep names without open measurement in the view

The default sweep name specified in the filter is used: sweep x, where x is the sweep
number in the sweep filtering selection.
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Figure 4-993: Alphanumeric view - not opened measurement file

Sweep names with open measurement in the view

The sweep names are changed accordingly to the sweep names defined in a measure-
ment file.

If a sweep name is blank, "Sweep x" is used as default name. Values from the multiple
devices are listed on different column, see the next section.
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Figure 4-994: Alphanumeric view - opened measurement file
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Figure 4-995: Channel signals in Alphanumeric view
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Sweep names with multiple devices in the view

Figure 4-996: Alphanumeric view of RF Power Scanner - multiple devices

4.8.9.3  RF power spectrum view

"TEC for RF Power Scanner TSME" lets you create signals for each selected sweep
and allows elementary spectrum measurement and analysis, see Chapter 3.8.2.16,
"TEC for RF power scanner TSME", on page 369.

The analysis results are displayed in the "RF Power Spectrum View". The power spec-
trum is displayed in four different ways.
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Figure 4-997: RF Power Spectrum View dialog

● "Power Spectrum Overview"
The top section of the view displays an overview of the sweeps which were config-
ured in the scanner.

● "Peak of Peaks"
The section contains the peak list of the selected sweeps.

● "Details of the selected sweeps"
This section of the view displays the spectrum of the selected sweep in detail.

● "Spectrum History of the selected sweep"
The bottom section displays the spectrum with a time dimension ("Spectrum His-
tory"). The power values are indicated through a color scale.

The sweeps displayed in the last two sections can be chosen from the list of channels
in the top section by clicking it.

Peak of peaks section

The combination of three columns in a grid, called Peak Bar, is used to describe a
peak. The peak is described with the rank number, frequency and power.
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Figure 4-998: Peak bar

A PoP grid row contains multiple peak bars. The screenshot shows a grid with three
peak bars in a row.

Figure 4-999: PoP grid row

Peak limit line in details chart

The peak limit line is included in the details chart. A limit line marker displays around
the limit line. Power and frequency are displayed inside the marker.

Figure 4-1000: Normal limit line in details view

If hovering mouse over the limit line, it changes to thicker line with a hand cursor and is
active for dragging.

When the limit line is active, dragging the line up and down changes the limit value.
The width, marker, location and orientation of the limit line can be configured. For
details, open the property bar section on the right side of the view's dialog.

Peak limit line setting and peak list grid

Signals are displayed in peak list if their powers are above limit line.

Peak limit line setting and chart fixed markers

Fixed markers in the "Details for the selected sweep" chart are hidden if the power of
the markers is below the limit line setting.
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If the fixed markers are invisible, the corresponding text label on the header is suffixed
with a star ‘*’. When the limit line setting is changed, the states of the fixed markers
change accordingly.

Integrated view update rate service

If "Use update rate" is selected (for either measurement or replay in "Measurement" or
"Replay") in "Tools" > "Preferences" > "Performance" page, GUI update rate is
reduced.

The RF Power Spectrum view has integrated this service to improve the performance.

Figure 4-1001: Performance setting for RF Power Scanner

Properties bar

The "RF Power Spectrum View:1 Properties" is added on the top right-hand side of the
view.
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Figure 4-1002: RF Power Scanner properties bar

Under the "Global" > "Peak List", there is the possibility to select the peak list size and
N Top N peaks. The "Chart Limit Line" entries let you configure the grid layout.

Figure 4-1003: RF Power Scanner - peak to peak (PoP) properties

You can close the property window and make the property bar invisible if clicking the
"X" button in the property window. To get the property window again, right mouse but-
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ton click anywhere on the "RF Power Spectrum View". The configuration menu pops-
up. Select the "Properties" entry in the menu.

Figure 4-1004: RF Power Scanner - (PoP) properties activation

Peak list group

The following entries are configurable in the "Global" > "Peak List" of the "RF Power
Spectrum View: Properties" window:

"Max Number of Peaks" - set the maximum number of peaks to be based. The value
determines the number of grid rows. The maximum number of peaks to be based
ranges from 4 as the minimum value up to maximum allowed value 12. The default
value is 12. The number of rows in a grid is calculated dynamically to use better hori-
zontal space.

Grid width determines the number of peak bars in a row. The wider the grid, the more
peak bars are present in the chart. The minimum number of peak bars in a row is
1.The following screenshots show cases with 2 and 6 peak bars in a row.
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Figure 4-1005: RF Power Scanner - 2 peak bars in a row
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Figure 4-1006: RF Power Scanner - 6 peak bars in a row

The number of rows is then calculated by the max number of peaks and the number of
peak bars in a row.

For example, max number of peaks is set to 10 and each row can hold 6 peak bars.
Therefore, 2 rows are needed for showing 10 peaks.

"Display Peaks Order" - sets the way that the peaks are displayed. The order can be
column first or row first. In the order column first, the first column of all rows in the grid
is filled first, then the next column of all rows and so on.

"Show Top N Peaks" - shows the Top N peaks.

If "Show Top N Peaks" is checked, N in "Top N Peaks" edit box is enabled. The peak
list contains only the Top N peaks if available. If Top N is different from max number of
peaks, the smaller one is used.

"Top N Peaks" > "N" configure the N in Top N setting.

Chart limit line group

The following entries are configurable in the "Global" > "Chart Limit Line" of the "RF
Power Spectrum View: Properties" window:

"Show Limit Line" - show limit line if checked, hide otherwise.

"Limit Line Width" - configure the limit line width. Either the value 1 or 2 can be
selected in drop-down list.
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"Max Limit Power in dBm" - configure the threshold of the limit line. Value change is
populated to position the limit line. Dragging the limit line also changes this value.
Power in dBm is shown on the top of limit marker.

"Peak Excursion in dBm" - power of the peak used for the Peak algorithm.

"Limit Marker X Pos" - configures where the limit line marker is displayed in X Axis:

1. Ctrl Mouse Down: setting the limit line marker X position by hovering mouse over
limit line and CTRL-clicking on the limit line.

2. Mouse Down: set the limit line marker X position by clicking the limit line.

3. Center: position the limit line marker at the center of the line.

"Limit Marker Orientation" - configures the orientation of the limit line marker. You can
choose among some available limit marker orientations. Select a limit marker orienta-
tion available in the drop-down list of the "Limit marker orientation" entry in the "Chart
Limit Line".

Figure 4-1007: Selection of limit marker orientation

The following figures display some possible orientations. The reference position is the
"Best" orientation.
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Figure 4-1008: Best orientation of limit line marker

Figure 4-1009: North orientation of limit line marker

Figure 4-1010: South-West orientation of limit line marker

Default color scale for the RF power scanner view

It is possible to specify a default color scale for the "RF Power Scanner View".

Use the"Save As Default" button to store the current color scale as default. From now
on, empty workspaces use this color scale.
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Figure 4-1011: Used default color scale for RFPS

4.8.10  TETRA scanner views

The TETRA scanner views show the information obtained in the TETRA network scan
performed by an R&S radio network analyzer.

For this purpose, the R&S TSME scanner with its hardware option R&S TSME-K26 is
needed.

The TETRA network scan available option for R&S TSME is R&S ROMES4T1E.

How to install and configure the TETRA network scanner, see Chapter 6.4.22, "TETRA
scanner", on page 1837.

Figure 4-1012: TETRA Scanner Views
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The TETRA scanner views can be selected from a submenu displayed on the right
side of the "View" menu if the mouse hovers over the "TETRA" > "TETRA Scanner"
entry. Different views can be chosen to visualize the results of the TETRA scanner. A
TETRA carrier is always associated with the same color in all views, including the
ROMESMAP Route Track (RTM) module.

Measurements from two TETRA scanners are correctly shown in the CIR, Carrier
Spectrum and Constellation Diagram views.

The default TETRA carrier type is the "Fixed Carrier" with associated fixed parameters
"Top N Pool" and "Top N Member". It can be used for all single scanner configurations
and display in the previously mentioned views. Instead, you can configure the "Top N
Member" and "Radio" type of a TETRA carrier.

The mentioned views can follow the current server of any attach TETRA radio. Select
in the configuration dialog "Radio" as a TETRA carrier type and specify the appropriate
connected TETRA radio. A view shows automatically the data which belongs to the
TETRA channel on which the TETRA radio currently camps.

Figure 4-1013: TETRA carriers type selected for some views

The "Target" page shows the list of TETRA carriers selected for display in a few
TETRA scanner views, for example, in the "TETRA Scanner CIR View" and "TETRA
Scanner Constalation Diagram View".

4.8.10.1  TETRA scanner BCH view

The TETRA scanner measures TETRA signals, demodulates and decodes the content
of broadcast channels of the received TETRA signal. This data is depicted as a sum-
mary of all found TETRA transmitters by the "TETRA Scanner BCH View".

Scanner views



Display and evaluation of resultsDrive Test Software

1341Operating Manual 1171.6415.12 ─ 66

Figure 4-1014: TETRA Scanner BCH View

The left part of the view shows the tree of all found TETRA transmitters. The names of
the transmitter sites are displayed if available in the current loaded database, it is
BDBOS in the figure. The first node reflects the network, which is specified by MCC
and MNC. The next hierarchy level lists TETRA transmitters identified by the carrier
and location area. Select a TETRA transmitter to see the transmitter's detailed informa-
tion. The information is displayed in the "Details" pane on the right part of the view. The
highlighted Main Carrier in the pane identifies the main carrier given to a TCH.

Below the transmitter level, all broadcast and decoded messages in BCH signal for the
corresponding transmitter are shown. This level contains, for example, decoded SYNC
PDU, D-MLE-SYNC PDU and SYSINFO PDU messages of the transmitter. Select a
message to get the detailed information in the right part of the view.

The MCCH stations are displayed in light green color in "TETRA Scanner BCH View".
A MCCH station corresponds to an MCCH channel in the view.

To highlight a BTS in the "TETRA BCH View", double-click a column in "TETRA Scan-
ner Top N View" or "TETRA Scanner Spectrum View". The tree of "TETRA BCH View"
collapses then and only the branches of the selected BTS are selected and expanded.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

TETRA scanner BCH view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "Configuration" option lets you filter base stations according to configured state of
their position and visualize them in a predefined color in "ROMESMAP Route Track
View".

4.8.10.2  TETRA scanner carrier spectrum view

The "TETRA Scanner Carrier Spectrum View" shows the spectrum of the TETRA
channel of a selected carrier or several selected carriers. The carrier can be fixed car-
rier or a Top N member. The graph color of a carrier corresponds to the color which is
defined for the TETRA carrier number.
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Figure 4-1015: TETRA Scanner Carrier Spectrum View

Using the context menu, the view can be switched to show the TETRA2 spectrum
view. There is no difference in the view layout and configuration between TETRA and
TETRA2.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu command "Show TETRA2 spectrum" switches the view to the
TETRA 2 spectrum view.

TETRA scanner carrier spectrum view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Target

The "Target" option lets you specify TETRA carriers for carrier spectrum view. The car-
rier list can be modified in sense that new carriers can be added, the existing deleted
or the values of the carriers in the list change.

A carrier for visualization can be a fixed carrier, a member of a certain Top N pool or a
channel the TETRA radio currently camps on.
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The page shows in the list all currently specified TETRA carriers. The "Type" column in
the list indicates the selected option.

Figure 4-1016: TETRA Scanner Carrier Spectrum View - target selection

The "Target" page applies also to the TETRA CIR scanner and TETRA scanner con-
stellation diagram views.

Add
Adds the user-defined fixed carriers, Top N pools or carriers a TETRA radio currently
camps on in the list of "Available Signals", see "Add" on page 377.

Figure 4-1017: TETRA Carrier settings for display
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● Type
The selection specifies which type of TETRA carriers to display in the view.

● Top N Pool
(Only for Type = "Top N Member").
Specify the corresponding Top N Pool. The default entry is Top N 1.

● Top N Member
(Only for Type = "Top N Member")
Specify the corresponding Top N Member. The default entry is 1. Member.

● Carrier
(Only for Type = "Fixed Carrier")
Specifies the carrier number (0 to 3999).

● Sweep
Number of sweeps for the spectrum analysis (1 to 16).

Remove
Deletes the selected carrier from the list.

Change
Allows the modification of the properties for the selected carrier. The "Change" dialog
contains the same panels as the "Add" dialog, all field descriptions are defined there.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.
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Figure 4-1018: TETRA Scanner Carrier Spectrum View - device selection

The "Device Selection" page and the previously mentioned applies also for all the
TETRA scanner views.

4.8.10.3  TETRA scanner CIR view

The "TETRA Scanner CIR View" displays a carrier impulse response of the TETRA
signals. Analog to the "TETRA Scanner Constellations Diagram View", the view shows
the channel impulse response of the selected carriers, which can be fixed carriers or
Top N members. The power first path of the carrier is always drawn at x=0, the follow-
ing paths correspond to their arrival times.

The tabs with less than 40-microseconds delay spread are not displayed In the
"TETRA CIR View" as the TETRA channel bandwidth is less than 25 kHz. To prove
multi-path propagation if the CIR view is empty, use the numerically calculated "TETRA
Delay Spread" parameter. The parameter is available as a signal in the "TETRA Scan-
ner Top N View" and "TETRA Scanner Spectrum View".
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Figure 4-1019: TETRA Scanner CIR View

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

TETRA scanner CIR view configuration

Refer to "TETRA scanner carrier spectrum view configuration" on page 1343.
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Figure 4-1020: TETRA Scanner CIR View - target selection

TETRA scanner CIR view conf.: Target

Refer to "TETRA scanner carrier spectrum view configuration" on page 1343.

4.8.10.4  TETRA scanner constellation diagram view

The "TETRA Constellation Diagram View" shows the current state of the constellation
diagram of either a fixed carrier or a specified member of a Top N Pool. To specify what
elements have to be shown, the open configuration page of the view or use the context
menu of one of the other TETRA Scanner views.

The constellation diagram shows the phase difference between two consecutive sym-
bols and not the absolute phase (which would result in eight spots). The Sync Burst is
always analyzed. R&S ROMES4 supports the Sync Burst which uses DQPSK modula-
tion.

If D8PSK modulation is used for the Sync Burst, R&S ROMES4 could recognize it, but
the generated results are set in relation to DQPSK modulation instead of the wanted
D8PSK relation. Thus, the constellation diagram does not show the preferred informa-
tion.

The calculated phase error is the mean square distance from the expected phases
(45°, 135°, 225° and 315°).
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Figure 4-1021: TETRA scanner constellation diagram view

If the transmission is TETRA2, the "TETRA Constellation Diagram View" shows the
TETRA2 QAM data.

R&S ROMES4 supports absolute TETRA scanner constellation diagram format in addi-
tion to the previously described one.
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Figure 4-1022: Absolute TETRA scanner constellation diagram view

If the TETRA scanner is configured to measure the constellation diagram, the previ-
ously mentioned TETRA constellation diagram format is by default selected. To get the
absolute constellation diagram format, select the "Show Absolute Constellation Dia-
gram" option in the view's configuration page, see Figure 4-1023.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

TETRA scanner const. diagram view configuration

Refer to "TETRA scanner carrier spectrum view configuration" on page 1343.

.
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Figure 4-1023: TETRA Scanner Constellation Diagram View - target selection

If activated, the "Show Absolute Constallation Diagram" option provides the TETRA
scanner absolute constellation diagram format in addition to the default one.

4.8.10.5  TETRA scanner report view

The "TETRA Scanner Report View" allows you to get reports out of the TETRA mea-
surements in an easy and fast way.

The view is filled automatically for the following type of measurements:

● Indoor Hotspot Measurements
– Section is a Hotspot Location

● Panorama Measurements
– Section is an Angle

The "TETRA Scanner Report View" shows a table of all TETRA transmitters which
have been measured at least once with a TETRA power above the given threshold of
the TETRA Report Views configuration.

The table reports the resulting set of transmitters, its TETRA power and EVM values.
Over the time of measuring a section, the incoming values are averaged. For TETRA
power, several values in Watt are averaged and logarithm to dBm.

For the Panorama Measurement, the first line of the table has a combo-box which
allows you to select a panorama measurement between the performed ones in the
measurement file.
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The data used for this report view, as a panorama measurement, an indoor measure-
ment and outdoor measurement showing Geo Binning (see following chapters) are not
based on any TopN pools. The evaluation is based on the raw measurements as deliv-
ered by the TETRA scanner.

The report format depends on the measurement type. The following screenshot shows
a panorama measurement. In this case the power values are not colored.

Figure 4-1024: TETRA scanner report view - power values and panorama chart

The data can be exported to CSV format (without the chart) or to XLSX format (Excel).
To do so, open the views context menu and select the corresponding menu item
("Export data as CSV".

The Excel export exports all available panorama measurements (one per sheet) while
the CSV export exports the currently selected measurement only.

The following screenshot shows the Omni measurement in a separated chart. The
chart shows all transmitters which have been measured during the Omni measure-
ment. The chart’s x-axis range is from lowest to the highest measured frequency. The
label above the transmitters shows the LA, MCCH and frequency of the transmitter.
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Figure 4-1025: TETRA scanner report view - omni chart

The report format depends on the measurement type. The Figure 4-1024 shows a pan-
orama measurement. In this case, the power values are not colored.

The following screenshot shows a report of an indoor measurement.

For Indoor Hotspot Measurements, the table shows the Top1 and Top2 transmitter, and
the complete set of received transmitters, ordered by LA. The power cells are colored
as specified by the TETRA Top N TETRA Power signal.

Figure 4-1026: TETRA scanner report view - indoor power values

TETRA scanner indoor measurements

If the TETRA scanner is used for Indoor Hotspot Measurements, the waypoints on the
Indoor Map give additional information, which is directly linked to the "TETRA Scanner
Report View". The color of each waypoint represents the TETRA power of the best
server of the waypoint.
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Figure 4-1027: TETRA scanner - indoor route track view and power values

Also, the waypoint gets a label, which informs about the LA of the best server and the
waypoint name. The label is the link to the "TETRA Scanner Report View".

Figure 4-1028: Hiding options

If an ES4 signal is selected in the map, its histogram can overlap with the waypoints.
The "Hide Signal Layer" option, on the right-hand side of the icon bar, helps in such a
case to show the waypoints only, without having to remove the signals from the maps
configuration.
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TETRA scanner outdoor measurements

The TETRA Scanner Evaluation algorithm provides binned data. The binning is based
on the received power of the TETRA transmitters.

Basically, it is the same approach as for the indoor hotspot measurement, but applied
to geographic bins. The bin can be visualized in the "ROMESMAR Route Track View"
and in the "TETRA Scanner Report View". The color of the bin reflects the color of the
TETRA Power Signal. The frame of the bin is the color of the best LA.

Figure 4-1029: TETRA scanner - outdoor route track view and power values

The bin size can be set manually to sizes between 5 m and 1000 m on the "Binning
View" tab. For details about binning, see Chapter 4.3.3.2, "View area", on page 566.

The currently selected bin size is reflected in the "TETRA Scanner Report View" auto-
matically.

The following screenshot shows a Tooltip of each bin. It displays the content of the
bins. To disable the Tooltip, deactivate the select mode by clicking the arrow icon.
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Figure 4-1030: Tooltip of bins

The previously mentioned is available during the R&S ROMES4 Replay mode only.

4.8.10.6  TETRA scanner spectrum view

To visualize the complete scan, use the "TETRA Scanner Spectrum View".

The entire area is horizontally split into "TETRA Spectrum Chart" and "TETRA Spec-
trum List" to accommodate a pull-down list with all defined carriers for scan.

Click the mentioned chart/list to compress or expand the chart/table, respectively. A
compressed chart leaves more space for the table and vice versa. A compressed pane
is characterized by the symbol >>> (instead of <<<) in its title bar. On pausing on one
of the title bars, the cursor displays a compress symbol.

Figure 4-1031: TETRA Scanner Spectrum View

The upper part of the view shows the complete set of TETRA scans, which is specified
in the scanner's settings. All carriers, on which a TETRA signal could be found accord-
ing to type are colored as shown in the following table. The previous screenshot shows
a case where MCCH and TCH carriers are scanned (green and black vertical bars).
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Table 4-35: TETRA spectrum view: coloring of carriers by type

Carrier type Not Demodula-
ted

MCCH TCH DMO TEDS

Color gray green black blue red

The red bar in the spectrum chart shows the TEDS carrier if the "TETRA2 active"
checkbox is checked in "TEC for TETRA Scanner" > "Scanner Top N Settings". The
blue bar shows DMO channels if "DMO Channel" is checked in the same menu.

The carriers could be fixed carriers or the Top N members. The colors in the lower
pane, "TETRA Spectrum List", correspond to the colors set in the "Color List for Car-
rier" of the "TETRA Spectrum View Configuration" window.

Some parameters remain empty if it is a TEDS carrier. Measured signals are: Carrier,
Inband Power, MCC, MNC, Color code, Code rate, Modulation type, Burst Mod ER,
Pilot Mod ER, Header Mod ER, Data MER, SICH Error rate, AACH Error rate, Data
Error rate. Signal frequency and frequency offset are calculated from carrier.

View area

Diagram

The spectrum chart offers some tools on the left-hand side of the chart. For the explan-
ation of these tools (icons), see Chapter 4.2.1, "2D chart view", on page 448.

Hover with the mouse over a bar, to get more information on the selected carrier.

The corresponding carrier at the "TETRA Spectrum List" is marked. To toggle the
marker view, click "Show/Hide Marker" ( ) in the tool bar.

The information field of the marker line is always on the left side of the chart and not
stuck to the vertical marker line.

Figure 4-1032: Marker double-click to get further carrier information

TETRA spectrum list

The second part of the view shows the list of the found TETRA carriers, which are
marked green in the upper chart. Double-click a carrier selects the carrier in the dia-
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gram above and opens a marker with further measured information to the selected car-
rier.

The carrier list can be sorted by clicking the header of the corresponding column.
● "Color"

Carrier index configured color
● "#"

Number of measured cells
● "Frequency [MHz]"

Frequency corresponding to the index of TETRA carrier
● "Carrier"

Index of TETRA carrier (0 to 3999)
● "Main Carrier"

Frequency of the MCCH extracted from the SYSINFO PDU.
As the TETRA network can change the MCCH dynamically, this signal is not used
as a TETRA BTS identifier in ROMESMAP Route Track View.

● "LA"
Location Area is a geographical area consisting of one or more cells. The recogni-
tion of a base station in ROMEMAP Route Track View is based on this signal
together with MCC.

● "Inband Power[dBm]"
Inband power of the TETRA channel

● "TETRA Power[dBm]"
Received Signal Strength Indicator

● "SNR[dB]"
Signal to Noise Ratio

● "Pre-Vit BER[%]"
Ratio of estimated number of channel errors in block 1 and block 2. It is the com-
parison of the received data and re-encoded data after error correction to the num-
ber of analyzed bits in block 1 and block 2 (Convolutional Code with Viterbi-Detec-
tor). For more, see "TETRA scanner Top N settings" on page 374.

● "AACH BER[%]"
Access Assign Channel Bit Error Rate - ratio of estimated number of channel errors
in the broadcast block. It is the comparison of received data and re-encoded data
after error correction to number of analyzed bits in the broadcast block (Reed-Mul-
ler-Code).

● "Freq. Err[Hz]"
Frequency error

● "Phase Error[°]"
RMS (Root-mean-square) phase error on the information symbols

● "Delay Spread[µs]"
Delay spread of arriving paths. Useful to prove multi-path propagation, especially if
no data is shown in the TETRA Scanner CIR View, where the minimum delay
spread for displaying results is 40 microseconds.
The delay spread can be characterized through different metrics, although the most
common one is the root mean square (RMS) delay spread: According to Gold-
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smith, let Ac(τ) be the power delay profile of a channel. Then, the mean delay of the
channel is

Thus, the RMS delay spread is

● "Timeslot"
Timeslot number extracted from SYNC PDU

● "FN"
Frame number extracted from SYNC PDU

● "MFN"
Multiframe number extracted from SYNC PDU

● "Interference Info"
Information about the interference situation on the TETRA measured channel

● "MCC"
Mobile Country Code extracted from the D-MLE-SYNC PDU. The recognition of a
base station in ROMEMAP Route Track View is based on this signal together with
LA.

● "MNC"
Mobile Network Code extracted from the D-MLE-SYNC PDU

● "Transmitter"
Name of the TETRA transmitter

● "Colour Code"
Color code extracted from Sync-PDU

● "MCCH BER Pre-Vit.[%]"
Bit Error Rate on the Main Control Chanel (MCCH)

● "MER[%]"
Number of blocks which could not be corrected by the Reed Muller Error Correction
divided by the total number of blocks on the Access Assignment Channel (AACH)

● "ModER[dB]"
Modulation error ratio

● "MCCH BER AACH [%]"
Bit Error Rate on the AACH

● "MCCH ER Payload CRC[%]"
Error Rate of the payload CRC

● "MCCH BLER AACH[%"]
Block Error Rate on the AACH

● "Modulation Type"
Used modulation in burst

● "Code Rate"
Burst code rate

● "Burst Mod ER[dB]"
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Modulation Error Ratio over all symbols in the burst
● "Pilot Mod ER[dB]"

Modulation Error Ratio over the pilot and sync symbols
● "Header Mod ER[dB]"

Modulation Error Ratio over the header symbols
● "Data MER[dB]"

Modulation Error Ratio over data symbols
MER = Modulation Error Ratio (Mod ER)

● "SICH Error Rate[%]"
Number of errors in the received SICH bits / total number of SICH bits

● "AACH Error Rate[%]"
Number of errors in the received AACH bits / total number of AACH bits

● "Data Error Rate[%]"
Number of errors in the received data bits / total number of data bits

● "Source Address (DMO)"
Direct mode of operation: address of the source terminal

● "Destination Address (DMO)"
Direct mode of operation: address of the destination terminal

● "DMO Channel"
DMO channel as received by the PDU in SCH/H

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu has the additional "Add Carrier to" entries.

If a line within the Top N list is selected and the other referenced view is also opened,
these entries get active. It is possible with them to add the selected member of Top N
pool to other view. By later closing that view, the menu entry remains loaded, active
and the view can still be configured.

TETRA scanner spectrum view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.
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The "View Configuration" option lets you adapt the visualized columns to the actual
needs.

Figure 4-1033: TETRA Scanner Spectrum View - configuration

The following entries are included in the "TETRA Spectrum List" panel:
● "List Column"

For a short description of the parameters, see "TETRA spectrum list"
on page 1357.

● "Use Colours of Network Provider Database"
Defines which color settings to use.

● "Show Traffic Channels"
Option to remove traffic channels from the list of decoded transmitters. The condi-
tion for a traffic channel is Main Carrier does not equal Carrier.

● Activate Coupled Marker for selected cells (table / graph)
The Coupled Marker function, which marks the same carriers in the chart and in
the list, can be switched "on" and "off". The function is activated in the "Configure"
button (right mouse button click the view) of "TETRA Scanner Spectrum View".
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Figure 4-1034: Configure...

The table and the graph for "Activate Coupled Marker for the selected cells" of the
"TETRA Scanner Spectrum View" are controlled separately.
If the option is "on", the "TETRA Scanner Spectrum View" looks like in the following
figure.
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Figure 4-1035: Activate Coupled Marker for selected cells "on"

4.8.10.7  TETRA scanner Top N view

The "TETRA Scanner Top N View" visualizes the current state of the Top N calculation.
Furthermore, it displays the properties of the signals from the base transceiver stations
that are elements of the Top N pools defined in the technology configuration.

The upper part of the view, "List", shows the list of all Top N members of currently
selected Top N pool, configured in the previously described combo box "TETRA Car-
rier".
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Figure 4-1036: R&S TETRA Scanner Top N View

The MCCH carriers are marked in a light green color in the "List", in a way they are
colored in the "TETRA Scanner BCH View" and "TETRA Scanner Spectrum View".

"List" shows presence of the TEDS carriers, in red color. The only measured power is
the inband power of the TEDS channel (Inband Power), see the "List" of the previous
figure. Therefore, if TEDS carrier is considered in the Top N calculation, set the obser-
vation parameter to Inband Power. It is performed in "Top N Settings" > "Top N Pool
Settings".

The lower part is a chart which shows the observed values of the selected signals. By
default is shown TETRA Power and BER Pre-Viterbi (on the right side of the scale)
value as a quality parameter of TETRA signals, see Figure 4-1036.

The user can configure Inband Power as observation value instead of TETRA Power,
see Figure 4-1037. This configuration is necessary if the TEDS carriers are considered
in "Top N Chart" and seen as the bars.

It is assumed that Pre-Vit. BER is the most appropriate parameter to valuate the quality
of TETRA signals.

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.
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Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.

The splitter position between the upper and lower part of the scanner view area and
the open or closed state of the "Top N List" and "Top N Chart" are restored from the
workspaces.

Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

Refer to "Tools > Overview of Settings", Chapter 3.8.2.18, "TEC for TETRA scanner",
on page 374.

Top N list

The table "Top N List" gives an overview of the received signals in the current top N
pool together with their measured power parameters, frequency and timing information.
On mouse rollover, each cell in the table header provides a short explanation of the
corresponding column.

In the view configuration menu, it is possible to show or hide each individual table col-
umn. Up to 3 different named pools can be configured in the default setup. Each pool
has several configurable parameters.

The "Top N List" contains the following columns:
● "Color"

Carrier index-related color
● "#"

Number of measured cells within the Top N pool
● "Rank"

Cell current rank within the Top N Pool
● "Frequency[MHz]"

Frequency of the TETRA carrier index
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● "Carrier"
TETRA carrier index (0 to 3999)

● "Main Carrier"
Frequency of the MCCH extracted from SYSINFO PDU

● "LA"
Location Area; a geographical area consists of one or more cells

● "Inband Power[dBm]"
Inband power of TETRA channel

● "TETRA Power[dBm]"
Code power of TETRA channel
The default Top N pool uses TETRA Power as the observation value, see Fig-
ure 3-247.

● "SNR[dB]"
Signal to Noise Ratio

● "C1"
Path loss parameter C1; the calculation is based on the values of the broadcast
channel and the configured maximum UE transmit power.

● "FRA"
State of the fast reselection; the calculation is based on the values of the broadcast
channel.

● "SRA"
State of the slow reselection; the calculation is based on the values of the broad-
cast channel.

● "BER Pre-Vit.[%]"
Ratio of estimated number of channel errors in block 1 and block 2 to the number
of analyzed bits in block 1 and block 2. It is the comparison of received data and
re-encoded data after error correction (Convolutional Code with Viterbi-Detector).
See also "TETRA scanner Top N settings" on page 374.

● "BER AACH.[%]"
Ratio of estimated number of channel errors in the broadcast block to the number
of analyzed bits in the broadcast block. It is the comparison of received data and
re-encoded data after error correction (Reed-Muller-Code).

● "MER.[%]"
Number of blocks not corrected by the Reed Muller Correction divided by the total
number of blocks on the AACH.

● "ModER[dB]"
MER = Modulation Error Ratio

● Freq. Err[Hz]
Frequency error

● "Phase Error[°]"
RMS (Root-mean-square) phase error on the information symbols

● "Delay Spread[µs]"
Delay spread of arriving paths. It is useful to prove multi-path propagation, espe-
cially if no data is shown in the TETRA Scanner CIR View, where the minimum
delay spread for displaying results is 40 microseconds.
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The delay spread can be characterized through different metrics, although the most
common one is the root mean square (RMS) delay spread: According to Gold-
smith, let Ac(τ) be the power delay profile of a channel. Then, the mean delay of the
channel is

Thus, the RMS delay spread is

● "Timeslot"
Timeslot number extracted from SYNC PDU

● "FN"
Frame number extracted from SYNC PDU

● "MFN"
Multiframe number extracted from SYNC PDU

● "MCC"
Mobile Country Code extracted from the D-MLE-SYNC PDU

● "MNC"
Mobile Network Code extracted from the D-MLE-SYNC PDU

● "Transmitter"
Name of the TETRA transmitter

● "Dist.(km)"
Distance to the TETRA transmitter

● "Colour Code"
Color code extracted from Sync-PDU

● "MCCH BER Pre-Vit.[%]"
Bit Error Rate on the Main Control Chanel

● "MCCH BER AACH [%]"
Bit Error Rate on the Access Assignment Channel

● "MCCH ER Payload CRC[%]"
Error Rate of the payload CRC

● "MCCH BLER AACH[%]"
Block Error Rate on the AACH

● "Modulation Type"
Used modulation in burst

● "Code Rate"
Burst code rate

● "Burst Mod ER[dB]"
Modulation Error Ratio over all symbols in a burst

● "Pilot Mod ER[dB]"
Modulation Error Ratio over the pilot and sync symbols

● "Header Mod ER[dB]"
Modulation Error Ratio over the header symbols
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● "Data MER[dB]"
Data Modulation Error Ratio

● "SICH Error Rate[%]"
Number of errors in the received SICH bits / total number of SICH bits

● "AACH Error Rate[%]"
Number of errors in the received AACH bits / total number of AACH bits

● "Data Error Rate[%]"
Number of errors in the received data bits / total number of data bits

● "Source Address (DMO)"
Direct mode of operation: address of the source terminal

● "Destination Address (DMO)"
Direct mode of operation: address of the destination terminal

● "LTPxx(TETRA Power) [dBm]/LTPyy(TETRA Power) [dBm]"
Probability of a certain TETRA power value over the LEE time. For more details,
refer to "Top N Pool Signal Settings" on page 375.
To display the LTPxx(TETRA Power)/ LTPyy(TETRA Power) signals in the "TETRA
Scanner Top N View", make them active by checking the corresponding check-
boxes in "Top N View". Drag & drop the lines to another order to resort the col-
umns. The signals are then included in the "Alphanumeric View".

● "DMO Channel"
DMO channel as received by the PDU in SCH/H

● "EVM (Peak)"/"EVM (RMS)"
Calculated Error Vector Magnitude value, peak/root-mean square, range 0.00 to
100.00.

The export of the signals to ASCII files is supported.

Diagram

The "Top N Chart" shows Inband Power (or TETRA Power, dependent on selection)
and the BER Pre-Viterbi values for all cells as bars in the current Top N measurement,
refer to "Configuration: Top N view" on page 1369. Their upper and lower limits for the
y-axis of the chart are configurable.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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The context menu provides the following additional commands:
● "Add a Member of the Top N Pool to the ....."

If a line within the Top N list is selected and also the referenced other view is
opened, this context menu entry gets active. Then it is possible to add the selected
member of the Top N Pool to another view. If the other view is later closed, the con-
text menu entry remains loaded, active and the view can still be configured.

TETRA scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Top N view

The "Top N View" tab customizes the contents of the table and the chart, offering the
following:
● Selection of the parameters to be included in Top N list contents
● Definition of the y-axis scale display. The definition assumes minimum/maximum

level of a signal displayed as a first 2D/3D and second 2D chart value in the Top N
chart

● Selection of the power type to be displayed in the Top N chart
● Selection of the 3D chart colors
● Displaying or not the signal quality in the 2D Top N chart

Figure 4-1037: TETRA Scanner Top N View - configuration

List Column
Lists the parameters that, if selected are included in the Top N list contents, see "Top N
list" on page 1365.

Graph
● "Show Inband Power"

If selected, shows total inband power of the TETRA channel in the "Top N Chart".
● "Show TETRA Power"
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If selected, shows TETRA Power of the TETRA channel in the "Top N Chart".
● "Inband Power Min/Max [dBm]" or "TETRA Power Min/Max [dBm]"

Sets the upper and lower Inband Power or TETRA Power levels for the left y-axis
of the chart.

● "BER Pre-Viterbi Min/Max [%] "
Sets the upper and lower BER Pre-Viterbi levels for the right y-axis of the second
2D chart.

2D Chart Option
"Show signal quality" lets you switch on or off the second y-axis on the chart and qual-
ity signal bars. Dependent on switching, the signal quality is displayed or not.
The result of the switching is visible only on the next frame as the chart must redraw at
least once for it.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.

4.8.11  UMTS scanner views

UMTS PNS measurements are performed using the UMTS PN scanner, see Chap-
ter 6.4.19, "UMTS PN scanner", on page 1788. R&S ROMES4 controls an R&S scan-
ner (radio network analyzer) to alternate between UMTS Pseudo Noise (PN) scans
and a spectrum analysis. Most of the results obtained with the different test instru-
ments are equivalent.

The scanner measures and identifies all UMTS downlink signals in the air with an
UMTS PN scan. The main purpose of this measurement is to test the receiving condi-
tions of a mobile in an UMTS network and to analyze possible interferences.

The spectrum analysis consists of a frequency sweep over a specified range to detect
arbitrary UMTS downlink and uplink signals. Results of the UMTS PN scans are dis-
played in all UMTS scanner views except in the "UMTS Scanner Spectrum View" and
the "UMTS Scanner Spectrum History View".

The R&S TSME performs the UMTS networks scans. The hardware option required for
the R&S TSME scanner is R&S TSME-K21.

The UMTS PN scanner available option for R&S TSME is R&S ROMES4T1E.

Many of the UMTS PN scanner results can also be displayed in other R&S ROMES4
views, for example, in the "Alphanumeric View" and "ROMESMAP Route Track View".

Some measurement examples using the UMTS PN scanner are outlined in Chap-
ter 2.2, "Measurement examples", on page 72.
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To get wanted UMTS scanner view hover mouse over the "Views" > "Scanner Views" >
"UMTS", as shown in the following figure.

Figure 4-1038: View – UMTS scanner menu

● UMTS scanner signals templates....................................................................... 1371
● UMTS scanner BCH view................................................................................... 1377
● UMTS scanner CPICH view................................................................................1383
● UMTS scanner P-SCH view................................................................................1391
● UMTS scanner pilot view.................................................................................... 1393
● UMTS scanner SC tracer view............................................................................1397
● UMTS scanner Top N view..................................................................................1404

4.8.11.1  UMTS scanner signals templates

The UMTS scanner signals templates offer a way to get easy access to the measure-
ment data of a specific NodeB. The access is achieved by specifying the UARFCN and
the SC whose measurement data that you want to get in a basic (generic) view. That
data is also displayed in the "Top N Templates" or the "CIR SC <UARFCN\SC> Tem-
plate" branch of the "Signal Tree" > "UMTS PNS" tree.

Scanner views



Display and evaluation of resultsDrive Test Software

1372Operating Manual 1171.6415.12 ─ 66

Figure 4-1039: UMTS scanner signals templates

1. Select from the "Top N Templates" or the "CIR SC <UARFCN\SC> Template"
branch a signal that you want to visualize in a R&S ROMES4 basic view and in the
"Signal Tree" as a template signal.

2. Drag & drop the selection into the view. Instead, double click the item in the view's
configuration page.

3. A dialog pops-up asking you to define the filter for the signal. For UMTS PNS, this
filter asks for a combination of a NodeB UARFCN and SC.
If you have selected several signals, check the "Apply for all signal" box. The action
applies the same filter for all signals.

The filter for the signal is entered.

The signal appears in the R&S ROMES4 basic view and in a template branch of
the "Signals Tree" > "UMTS Scan" tree.

Figure 4-1040: Alphanumeric view of the template signal SIR

The template branches are a home of all created template signals.

The filtering dialog remembers the last set values.

The template signals are part of the workspace. Being the part of the workspace, they
are stored to it and restored when loading a workspace. Creating a workspace
removes the template signals.
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Configuration of UMTS scanner Top N templates

The Top N signals can be configured on any generic views ("Basic Views"). If a signal
is configured on a generic view, a prompt for specific Top N pool and Top N member to
be configured is displayed.

Figure 4-1041: Template to filter Top N SC

Configuration of Template Top N Pool: Enter the desired Top N pool number. A
range of Top N pools can be entered by using a comma separator which separates
individual pools or a dash to define a range of pools. For example, entered 1, 2, 4 rep-
resents the pools 1, 2 and 4 and 1 to 4 would represent an entry of pools 1 to 4.

If measurement or measurement replay is in progress, the valid Top N pools are availa-
ble for selection if you click the down arrow. Click one or more of the valid pools.

Once all selections are made, click another field or "OK" to close the selection window.

Figure 4-1042: Available Top N pools

Configuration of Template Top N Member: Enter the desired Top N member number.
A range of Top N members can be entered by using a comma separator which sepa-
rates individual pools or a dash to define a range of pools. For example, entered 1, 2, 4
represents the members 1, 2 and 4 and 1 to 4 would represent an entry of members 1
to 4.
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Selection of Field Color Code: Once a valid selection is made, the field gets a green
background color. If a selection is not valid, the background color is red.

Figure 4-1043: Colored fields for Top N SC filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections". (These selections are reset each time R&S ROMES4 is restarted). To
select one of the prior selections, check the box next to the desired option and press
"OK". The new selection items are hidden. They reappear if all prior selection boxes
have been deselected.

Figure 4-1044: Prior selected template signals

Configuration of UMTS CIR SC<UARFCN/SC> signals templates

If a CIR SC signal is configured for use on a generic view, a prompt to configure the
signal with desired filter value is displayed.
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Figure 4-1045: Ec/Io template signal filtering

Configuration of UARFCN Value: An UARFCN value can be entered. Multiple
UARFCN can be entered by separating the values with a “,”. For example, by entering
1300, 1444 selected are channels with UARFCN 1300 and 1444.

If a second-level or measurement replay is in progress, a list of currently valid
UARFCN values is displayed if you click the down arrow. One or more of the values
can be selected if you check the box next to the desired choice.

Once all selections are made, click another field or "OK" to close the selection window.

Figure 4-1046: Selection of an UARFCN value

Configuration of SC: A scrambling code (SC) value can be entered. Multiple SC val-
ues can be chosen by separating the values with a “,”. For example, entered values 32,
131 selects the SC value 32 and 131.

If a measurement or measurement replay is in progress, a list of valid PCI values for
the currently selected UARFCN is displayed by clicking the down arrow. One or more
of the values can be selected if you check the box next to the desired choice,

Once all selections are made, click another field or "OK" to close the selection window.
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Figure 4-1047: Selecting SC values

Selection of Field Color Code: Once a valid selection is made, the field gets green
background color. If a selection is not valid, the background color is red.

Figure 4-1048: Colored fields for Ec/Io filtering

If the entry field has focus, it is displayed as a blue background regardless of selection
status.

Prior Selections Selection: The last five user selections appear under the "Prior
Selections" rows. (These selections are reset each time R&S ROMES4 restarts).

To select one of the prior selections, check the box next to the desired option and
press "OK". The new selection items are hidden. They reappear when all prior selec-
tion boxes are deselected.
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Figure 4-1049: Prior selected power template signals

4.8.11.2  UMTS scanner BCH view

The "UMTS Scanner BCH View" shows a list of all System Information Blocks (SIBs)
and Master Information Block (MIB) decoded from the UMTS BCH of a certain NodeB.
The contents of each block appear in a tree view of the "Details" pane when the block
is selected. The SIB types and their information elements are described in standard
3GPP TS 25.331.

The view accumulates the SIBs acquired and displays them in the left part of the view,
grouped by network provider, i.e. by MNC and MCC.

Each second level node of the data tree shown represents an UMTS NodeB sector
identified by MCC, MNC and CI. If it can be found in the UMTS NodeB database loa-
ded, the corresponding name is shown, e.g. MXU811A.

Otherwise, the name is composed as S<MNC>_<MCC>_<CI>; for example,
S262_001_09814 with:
● <MNC> → decimal MNC value, 3 digits
● <MCC> →decimal MCC value, 3 digits
● <CI> → decimal CI value, 5 digits

Some parameters (SC, CI, position) are appended to the NodeB name. In the "Details"
pane within the tree view the scrambling code is always displayed in the decimal for-
mat.

If the NodeB has been retrieved from the database, the position is displayed as Lon
<value> Lat <value>. If the NodeB has been generated from SI3 measurement without
a corresponding database entry, the position is displayed as Lon *<value> Lat
*<value>. The format of the position values depends on the corresponding global R&S
ROMES4 setting.

The SIB and MIB information is available only if the PN scanner data are recorded with
the "BCH Demodulation" enabled. Decoding of each SIB type must be enabled explic-
itly in the UMTS PNS scanner configuration menu, see "Receiver settings UMTS PNS"
on page 1790.
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Figure 4-1050: Selected NodeB details

The data shown in the "Details" panel depend on selected item in the right-hand panel
of the view.

For example, if SIB 11 and SIB 12 are selected, the contained neighbour cells informa-
tion is extracted and can be seen as the neighbors of a serving NodeB in "Details".

If SIB 1 is selected, LAC is extracted and can be seen as cn_Com-
monGSM_MAP_NAS_SysInfo[LAC] in the "Details" of SIB 1 and as LAC in the
"Details" of the NodeB.

PDU variant list

As R&S ROMES4 supports dynamic PDU handling described in "Implementation of the
dynamic PDU handling" on page 284, the scanner BCH view for UMTS and other tech-
nologies is enhanced. The BCH view shows the list of PDU variants over time. The
PDU variants are shown as leaves of the base station.

When a SIB is selected on the left side of the "UMTS Scanner BCH View", the list of
PDU variants and the list of associated time stamps are displayed on the view's right
side. The following screenshot displays PDUs carrying SIB1.
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Figure 4-1051: Right panel shows details of NodeB parameters in SIB 1

The "PDU Variant List" in the upper right of the view shows a list of time stamps if there
were different variants found. For SIB1 shown in the previous screenshot, only one
variant is found. The "TimeStamp" shows the most recent measurement of the variant.

The following screenshot shows a list of time stamp of a PDU with variants, as UMTS
SIB 7.

Figure 4-1052: PDU list of time stamps

The "PDU Variant List" is common for all the RATs that support dynamic PDU handling.
Therefore, the given explanations are valid for all them.

RAN sharing in BCH view

The "UMTS Scanner BCH View" displays NodeBs of all PLMNs reported in the MIB
(the standard MIB for the primary PLMN and the v690ext MIB for additional PLMNs,
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see Add. PLMNs). For example, the transmitters which serve the PLMN 123,1 and
PLMN 123,2 are visible in the UMTS Scanner BCH view in the branch for PLMN 123,1
and PLMN123, 2 respectively.

A transmitter, which is listed below a PLMN that is not its primary PLMN is displayed
with an "‘" appended to its name.

The view creates branches for all PLMNs of the measured transmitters (base stations),
instead of transmitters only the primary PLMN. It is possible to hide the transmitters,
which are displayed as non-primary PLMNs if you check the "Text Filter" > "Show
Shared Basestations" check-box in the view.

Figure 4-1053: Show or hide shared base station options

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
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Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

BTS export parameters configuration

If the export is started before measurement or replay stops, the file contains all System
Information starting from the selected node in the BCH tree. All SIBs of the selected
NodeB or all SIBs belonging to all NodeBs of one provider (MCC, MNC) are contained
in the file then.

If the export is started after measurement or replay is stopped, the file contains all SIBs
belonging to all NodeBs of the "UMTS Scanner BCH View".

The System Information can be exported to an ASCII file in the EXPORT directory of
R&S ROMES4. The export file is named:

UMTS_SysInfo_&lt;measurement filename&gt;.txt

Content export file

Provider MNC: 2  MCC: 262
NodeB MXUW70C - SC 432 - CI 32703 - Lon 11°26'18"E - Lat 48°8'20"N
Master Information Block
value MasterInformationBlock ::=
{
  mib-ValueTag 7,
  plmn-Type gsm-MAP :
  {
    plmn-Identity
    {
      mcc
      {
        2,
        6,
        2
      },
      mnc
      {
        0,
        2
      }
    }
  },
  sibSb-ReferenceList
  {
    {
      sibSb-Type sysInfoType1 : 229,
      scheduling
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      {
        scheduling
        {
          sib-Pos rep32 : 2
        }
      }
    },
    {
      sibSb-Type sysInfoType2 : 3,
      scheduling
      {
        scheduling
        {
          sib-Pos rep64 : 6
        }
      }
    },

Position estimation

If position estimation is active (see Position Estimation), the estimated positions are
added to the NodeB entries. The estimated positions are marked by an asterisk, see
Figure 4-1051.

After stopping the measurement, the view automatically generates the BTS list import
files with an entry for every estimated BTS position.

Files

Two files are generated for each *.rscmd measurement file.

GSM_BTS_LIST<measurement filename>.ATD Contains the database definition.

GSM_BTS_LIST<measurement filename>.TXT Contains the BTS data.

Note:
The NodeB list files are stored in the R&S ROMES4 measurement directory. After stopping replay of a
measurement file, you can create the same NodeB list via the view’s "Generate NodeB List" context menu
option.

Example: 

Measurement file: zgb-muc.rscmd

Generated files: UMTS_BTS_LIST_ zgb-muc.ATD

UMTS_BTS_LIST_zgb-muc.txt

Content *.ATD and *.TXT file

For a detailed example, refer to "BTS export parameters configuration" on page 1381.
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UMTS scanner BCH view configuration

The "Configuration" option lets you set the color for the selected BTS symbols in the
"ROMESMAP Route Track View" and define the filter for generating a BTS list.

Open the configuration page by a right mouse click on a point inside the view or via the
"Tools" > "Configuration Active View" command.

Figure 4-1054: UMTS Scanner BCH View - configuration

4.8.11.3  UMTS scanner CPICH view

The "UMTS Scanner CPICH View" shows the average signal power of the received P-
CPICHs and a comprehensive analysis of the properties of all DL signals received in
the UMTS PN scan.

Different signals are distinguished by their slot timing (the beginning of the slot detec-
ted by the receiver of the test instrument). Signals from different NodeBs are distin-
guished by their primary scrambling codes (SC), transmitted over the CPICH. Signals
with different slot timing, but equal SC, originate from the same NodeB but propagate
along different paths. A comparison of those signals provides important information on
reflections and possible interferences.

The analysis requires synchronization to each received signal, which is performed in
the 3-step process:

1. The test device searches for the Primary Synchronization Channel (P-SCH) to
obtain the slot timing. The start of the P-SCH marks the beginning of the slot.

2. The Secondary Synchronization Channel (S-SCH) analysis derives the scrambling
code group (CG) and the frame timing.
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3. The SC within the CG is determined by correlating with the pilot bits of the CPICH.

Steps 2 and 3 are modified if "High Speed" is selected in the "Measurements" tab
of the scanner configuration menu, see Chapter 6.4.19.2, "Configuration menus
UMTS PNS", on page 1790. This tab defines the "Synchronization Rate".

Figure 4-1055: UMTS Scanner CPICH View

Frequency

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "UMTS Scanner P-SCH View", "UMTS Scanner Pilot View" and "UMTS
Scanner SC Tracer View".

Changing the frequency in one of these views, automatically adapts the frequencies in
all other views. This change provides that the views have the same current number in
their title bar. For example, the view in the previous figure is the number 1. Using this
feature, it is possible to generate different groups of views with the same current num-
ber and select frequencies for an entire group with a single mouse click.

View area

The entire view area is horizontally split to accommodate a chart and a table/list. The
"CPICH CIR Chart" shows the average signal power of the P-CPICHs of all received
signals over the time. The displayed powers and times correspond to the "Ec (CPICH)
[dBm]" and "Delta T[µs]" values listed in the "Peak List" (right-hand part of the "CPICH
List").

A click on the "CPICH CIR Chart" or "CPICH Lists" title bars compresses and expands
the 2D-chart or table. A compressed chart leaves more space for the table and vice
versa. Moreover, the tables appear in several UMTS Scanner views so that compress-
ing them can help to avoid redundancies. A compressed sub diagram is characterized
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by the symbol >>> (instead of <<< ) in its title bar. On pausing on one of the title bars,
the cursor displays a compress symbol.

Diagram scale

The diagram is opened with a default x-axis scale of little more than one UMTS frame
(10 ms). If placed inside the diagram area, the cursor takes the shape of a zoom-in
icon (a magnifying glass with a '+' inside). A vertical line is displayed at the cursor posi-
tion.

A left mouse click magnifies the diagram in x-direction around the cursor position, "Ctrl"
plus left mouse click causes the opposite. An area to become the new x-axis range
(e.g. the area around a peak) can be marked while the left mouse button is pressed.
"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

The scale of the y-axis (power in dBm) can be set in the configuration menu.

Table entries

Below the diagram, the "CPICH Lists" give an overview of the received signals
together with their scrambling codes, different power parameters, frequency and timing
information. On mouse hover-over, each cell in the table header provides a short
explanation of the corresponding column.

The entire table is divided into the "CPICH List" and the "Peak List." In the configura-
tion menu, it is possible to show or hide each individual table row in both lists.

CPICH list

The "CPICH List" (left-hand part of the "CPICH Lists") provides a general description of
the received CPICH signals from each NodeB. Each signal is characterized by its SC,
corresponding to the transmitting NodeB, and includes all possible peaks (reflections)
indicated in the "Peak List" on the right-hand side. The list can contain the following
CPICH-related values (see also standard 3GPP TS 25.215 and related standards.

All power results in the CPICH List and Peak List are obtained in an unbiased mea-
surement: The contribution of the noise floor to the powers is subtracted.):
● "SC [Hex]"
● Primary scrambling code no. of the CPICH signal in the format selected in the

"TEC for UMTS PNS" tab of the "Configuration of Software Modules" menu; refer
to chapter Chapter 3.8.2.9, "TEC for UMTS scanner", on page 321. In decimal rep-
resentation, the primary scrambling code numbers are multiples of 16: SC[dec] =
16*i where i=0 to 511, so the least significant digit of the hex numbers is always 0,
see Chapter 4.8.11.6, "UMTS scanner SC tracer view", on page 1397. Sequence
numbers:"1, :2" behind a code distinguish multiple reflections.

● Each SC is identified by a color, to be customized in the configuration menu. The
SC color codes are also shown in the "ROMESMAP Route Track" menu.

CPICH signal power

● "Ec/Io [dB"]
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Ratio of the received energy per PN chip of the CPICH and of the entire NodeB
signal to the total transmit power spectral density. The value equals to the sum of
the "Ec/Io (CPICH) [dB]" values of all individual peaks of the same SC displayed in
the "Peak List", see CPICH peak list.

● "SIR [dB]"
Signal-to-Interference Ratio of the CPICH, RSCP/ISCP*256 where 256 is the
CPICH spreading factor.

● "RSCP [dBm]"
CPICH Received Signal Code Power; sum of the received powers of all peaks on
one code, measured on the pilot bits of the Primary CPICH.

● "ISCP [dBm]"
Interference Signal Code Power, the interference on the received signal measured
on the pilot bits. Both the orthogonal and the non-orthogonal parts of the interfer-
ence are included in the measurement.

● "P total [dBm]"
Total received wide-band power in the channel, measured within the correlation
sections of the P-CPICH. The observed signal section is the same for all signals,
so P total is the same for all NodeBs. "P total" is equal to Io during the CPICH
chips so that the following relation holds:
"P total + Ec/Io = RSCP"

CPICH signal timing

● "Drift [ns/s]"
Averaged change of the time delay of the CPICH peaks of a NodeB signal over the
time. A drift translates into a lateral deviation of the signal in the Chapter 4.8.11.6,
"UMTS scanner SC tracer view", on page 1397. It can be due to one or several of
the following effects:
– Doppler Effect due to a relative movement of the test vehicle and the NodeB.
– Drift of the system time compared to the nominal UMTS timing
– Drift of the NodeB timing compared to the nominal UMTS timing
Tip:
A measurement at fixed position eliminates the Doppler effect and thus isolate the
two other effects making the assessment possible. To disentangle system time and
NodeB drift, it is sufficient to compare signals from several NodeBs. If several sig-
nals are measured with the same drift, this common drift is likely to be due to the
system time. After subtraction of this common system time drift, one is left with the
drift of the individual NodeBs.

● "Dev. Drift [ns/s]"
90% confidence interval width of the average time drift. A small value indicates that
the drift measurement is estimated to be relatively accurate.
Note:
The accuracy of the drift measurement increases with the number of measured val-
ues. Consequently, the Dev. Drift values (and often also the Drift values) typically
decrease as the measurement progresses.

● "Del. Spread [Chip]"
● RMS delay spread in chip periods: Standard deviation of the time delay "Delta T

(ΔT)" at all CPICH measurement points weighted with the measured powers "Ec
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(CPICH)". A small delay spread indicates that the individual CPICH peaks of the
NodeB signal are relatively close or that the power of peaks with different time
delay is low.

The "CPICH List" is also displayed in the "UMTS Scanner Top N View".

CPICH peak list

The rows of the "Peak List" (right-hand part of the "CPICH Lists)" describe the single
peaks (reflections) that contribute to the different NodeB signals.

The list can contain the following values (see also standard 3GPP TS 25.215 and rela-
ted standards):
● "SC [Hex]"

Primary scrambling code no. of the CPICH is defined in the format selected in the
"TEC for UMTS PNS" tab of the "Configuration of Software Modules" menu, see
Chapter 3.8.2.9, "TEC for UMTS scanner", on page 321.

Signal power

● "Ec (<Ch>) [dBm]"
Average energy per transmitted PN (Pseudo Noise) chip for channel <Ch>, divided
by the chip period and thus converted into an average received signal power (in
dBm). Ec is displayed for the (Primary) CPICH, P-SCH and S-SCH.

● "Ec/Io (<Ch>) [dB]"
Ratio of the received energy per PN chip for channel (<Ch>) to the total transmit
power spectral density. Ec/Io is displayed for the (Primary) CPICH, P-SCH and S-
SCH.

● "P total (SCH)"
Total averaged received signal power for the duration of the SCH. "P total" contains
the contributions of all channels during the observation period and is therefore
always greater than "Ec (P-SCH)" or "Ec (S-SCH)". The following relations hold:
"P total + Ec/Io (P-SCH) = Ec (P-SCH)"
"P total + Ec/Io (S-SCH) = Ec (S-SCH)"

Signal timing

● "Delta T [µs]"
Time delay of the signal's slot timing relative to the system time or GPS time (hard-
ware-dependent). The reference time (left edge of the diagram) is of minor impor-
tance. The diagram extends over more than one frame, which is enough to display
and separate all received signals.

● "Doppler Freq."
Frequency offset of the measured P-CPICH carrier frequency compared to the
nominal UMTS channel frequency. In a coverage measurement on a moving test
vehicle, an important source of frequency offsets is the Doppler shift due to the
speed of the receiver relative to the transmitter. Constant frequency offsets do not
originate from the Doppler shift and can be corrected in the configuration menu.
The "Doppler Frequency" is available only if "High Dynamic" is selected in the
"Measurements" tab of the scanner configuration menu, see "Measurements
UMTS PNS" on page 1801.
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The "Peak List" is also displayed in the "UMTS Scanner P-SCH View".

Special table entries

Depending on the conditions of the measurement, the tables can show some particular
results:
● An invalid result "---" denotes that a peak or the entire NodeB signal was too weak

to be accurately measured. Selecting "High Dynamic" mode in the measurements
tab of the scanner configuration menu generally reduces the number of invalid
results.

● A number as ":1", ":2", etc., behind the scrambling code denotes reception of sig-
nals with the same scrambling code but with a significant difference in their time
delays. Two different scenarios can cause multiple scrambling codes:
– If several of those signals occur at the same time, they are likely to belong to

different NodeBs that accidentally use the same SC.
– Two signals with different numbers behind their scrambling codes that are

received at different times can belong to the same NodeB but actually indicate
a strong time drift.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● Reset Zoom

Resets the x-axis scale to 0 ms to approx. 10.5 ms.
● Destroy View

Deletes the active view with its contents.

UMTS scanner CPICH view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "UMTS Scanner CPICH View" configuration customizes the diagram in the view
and the contents of the table.
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The "CPICH View" option lets you set the y-axis scale of the "UMTS Scanner CPICH
View", select the information to be displayed in the table and correct the Doppler fre-
quency.

Figure 4-1056: UMTS Scanner CPICH - configuration

Dynamic Range
The two input fields in the "Dynamic Range" panel define the minimum "(Min [dBm])"
and the maximum "(Max [dBm])" level to be displayed in the "UMTS Scanner CPICH
View".

CPICH List/Peak List
The "CPICH List" and "Peak List" panels select, which information is displayed in the
tables below the "CPICH CIR chart". Clearing a box, hides the corresponding row in
the diagram.

Export During Replay
You can export the data shown during replay in two lists of the view to XML files.
Instead, export to CSV format is also possible. The export is basically like the CIR
export in LTE and WiMAX. To export the data in CSV, thick the "Export during Replay"
check box in the "CPICH View" configuration page.
The file names are generated from the cmd file name, the view name, the “CIR” or
“Peaks” and the scanner instance, for example:
2012-06-21_10-09-24_mh_galaxy_3UMTS_
UMTS_Scanner_CPICH_View_1_
CIR_0.xml
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The xml content for CIR looks like:

The xml content for CIR peaks looks like:

Note: Position data for every <ListContent> entry is available in CIR and CIR peak
export files.
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Doppler Frequency
The "Doppler Frequency" panel provides an input field to correct the "Doppler Fre-
quency" displayed in the "Peak List". The purpose of the correction is to subtract out
constant frequency offsets that cannot originate from the speed of the test vehicle rela-
tive to the signal source.
Possible sources of constant frequency offsets are de-tuned NodeB transmitters and
test device receivers.
Tip: A measurement at fixed position eliminates the Doppler effect and thus allows the
frequency offset of the test device receiver and the different NodeBs to assess. A de-
tuned receiver causes the same frequency offset on signals from different NodeBs.
Therefore, if several NodeB signals are measured with the same Doppler frequency in
a fixed-position measurement, the Doppler frequency measured is due to the receiver.
If this common frequency offset is entered as an "Offset Correction", the CPICH View
table indicates the frequency offset of the individual NodeBs.

4.8.11.4  UMTS scanner P-SCH view

The "UMTS Scanner P-SCH View" displays the signal power of the Primary Synchroni-
zation Channel of all recorded DL UMTS signals. Additional information is displayed in
a table below the diagram.

Figure 4-1057: UMTS Scanner P-SCH View

Frequency

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "UMTS Scanner CPICH View, UMTS Scanner Pilot View", "UMTS Scanner
SC Tracer View".

Changing the frequency in one of these views, automatically adapts the frequencies in
all other views. The change provides that all views have the same current number in
their title bar. Using this feature, it is possible to generate different groups of views with
the same current number and select frequencies for an entire group with a single
mouse click.
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View area

The entire view area is horizontally split to accommodate a chart and a table/list. The
"P-SCH CIR Chart" shows the power of the received P-SCs in all recorded DL UMTS
signals over the time. This power is measured when the system correlates to the P-
SCs (1st synchronization step; see "UMTS scanner CPICH view" and therefore always
available. The "P-SCH List" below shows only the signals to which the system could
synchronize to determine the SC. Typically the tallest peaks of the diagram correspond
to the values of "Ec (P-SCH)" displayed in the table.

A click on the "P-SCH CIR Chart" or "P-SCH Lists" title bars compresses and expands
the 2D-chart or table. A compressed chart leaves more space for the table and vice
versa. Moreover, the tables appear in several UMTS Scanner views so that compress-
ing them can help to avoid redundancies. A compressed sub diagram is characterized
by the symbol >>>(instead of <<<) in its title bar. On pausing on one of the title bars,
the cursor displays a compress symbol.

Diagram scale

The diagram is opened with a default x-axis scale of one UMTS slot (2/3 ms, i.e. 666
µs). If placed inside the diagram area, the cursor takes the shape of a zoom-in icon (a
magnifying glass with a '+' inside). A vertical line is displayed at the cursor position.

A left mouse click magnifies the diagram in x-direction around the cursor position, "Ctrl"
plus left mouse click causes the opposite. An area to become the new x-axis range
(e.g. the area around a peak) can be marked while the left mouse button is pressed.
"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

The scale of the y-axis (power in dBm) can be set in the configuration menu.

Table

Below the diagram, the "P-SCH List" gives an overview of the received signals
together with their scrambling codes, different power parameters, frequency and timing
information. On mouse hover-over, each cell in the table header provides a short
explanation of the corresponding column. The "P-SCH List" is identical with the "Peak
List" in the "UMTS Scanner CPICH View". For a detailed explanation of the parame-
ters, refer to Chapter 4.8.11.3, "UMTS scanner CPICH view", on page 1383.

In the configuration menu, it is possible to show or hide each individual table row.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.
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Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Reset Zoom"

Resets the x-axis scale to 0 ms to 2/3 ms.
● "Destroy View"

Deletes the active view with its contents.

UMTS scanner P-SCH view configuration

The tab sets the y-axis scale of the view and selects the information to be displayed in
the table.

This configuration tab is analogous to the menu of the "CPICH View" tab of the "PNS
CPICH" view.

Refer to PNS CPICH configuration menu. See chapter UMTS scanner CPICH view

The "UMTS Scanner P-SCH View" option lets you customize the diagram in the view
and the contents of the table.

Figure 4-1058: P-SCH View - configuration

4.8.11.5  UMTS scanner pilot view

The "UMTS Scanner Pilot View" displays the the current Received Signal Code Power
(RSCP) of the Common Pilot Channels (CPICHs) as a bar.
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Figure 4-1059: UMTS Scanner Pilot View

View area

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "UMTS Scanner P-SCH View", "UMTS Scanner CPICH View" and "UMTS
Scanner SC Tracer View".

Changing the frequency in one of these views automatically adapts the frequencies in
all other views. The change provides that all views have the same current number in
their title bar. Using this feature, it is possible to generate different groups of views with
the same current number and select frequencies for an entire group with a single
mouse click.

The chart shows the CPICH Received Signal Code Power. It is the received signal
power measured on the pilot bits of a Primary CPICH which is identified by its primary
scrambling code.

Each signal generates a vertical bar in the view's chart. The bar visualizes the current
RSCP value of the pilot. The bar color is the SC color and is also used in the "UMTS
Scanner Top N View". The chart has only one mode. Remaining values of RSCP
("Min", "Max", "Average" and "SC") are displayed in the table below the chart. All four
values are constantly updated while the measurement or replay is running.

The scale of the y-axis (RSCP in dBm) can be set in the configuration menu.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● Export

Opens a "Save As" dialog to export the current RSCP values to a text file. This
function is unavailable during measurement or a file replay. It can be activated after
"Stop", "Stop Recording" or "Pause Replay". The export function is not affected by
a change of the chart type.

Export file format

The export file is an ASCII table in CSV format that can be opened and processed by
Excel. The table headings form the first line of the file. Each of the following lines corre-
sponds to a single signal with definite SC. The values in the lines are separated by
semicolons.

The file contains current measurement values as indicated in the Min.-Max.-Average-
Current chart. The values form the following columns
● "SC"

Primary scrambling code of the signal in the format selected in the "TEC for UMTS
PNS" tab, see Chapter 3.8.2.9, "TEC for UMTS scanner", on page 321. Sequence
numbers ":1, :2" behind a code distinguish multiple reflections.

● "RSCP"
Minimum, maximum and average RSCP in dBm

The last four columns contain the time stamps describing the recording history of each
signal.
● "Tfirst"

Time when the signal is detected for the first time. This can coincide with the begin-
ning of the measurement.

● "Tlast"
Time when the signal is detected for the last time. The time can coincide with the
time when recording or replay is stopped.

● "Tmin/Tmax"
Recorded time when the minimum/maximum RSCP was measured
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To ensure that the export file contains all signals ever recorded in the measurement,
deactivate the "History" parameter in the configuration menu.

UMTS scanner pilot view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "Pilot View Configuration" option lets you define the y-axis scale. You can define
the minimum and the maximum level of the RSCP to be displayed in the view and
select the diagram type ("Graph").

Figure 4-1060: UMTS Scanner Pilot View - configuration

Dynamic Range
The two input fields in the "Dynamic Range" pane define the minimum ("Min [dBm]")
and the maximum ("Max [dBm]") level for display in the "UMTS Scanner Pilot View".

Graph
"Graph" is used to select the diagram type.
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● "History [s] "
If no further information from the frequency signal is received, the "History" value
defines how long the old available values are shown until the view is cleared.
Clearing this parameter corresponds to an infinite history time. This approach
ensures that all signals ever recorded in the current measurement are displayed in
the view and can be exported to an ASCII table.

● "Sort Columns"
Sorts the bars/columns according to their RSCP. The strongest signal is displayed
on the left side, the weakest on the right side. If the box is cleared, the signals and
SC numbers keep their position irrespective of the evolution of their signal power.

4.8.11.6  UMTS scanner SC tracer view

The "UMTS Scanner SC Tracer View" shows the evolution in time of the time delay
and CPICH signal power of all received UMTS peaks with a particular primary scram-
bling code (SC) or a particular rank in a top N pool.

Figure 4-1061: UMTS Scanner SC Tracer View

Frequency

Below the view title, the "Frequency" pull-down list contains all measured frequencies
selected in the "Receiver" tab of the scanner configuration menu. The list is also provi-
ded in the "UMTS Scanner P-SCH View", "UMTS Scanner Pilot View", "UMTS Scanner
CPICH View".
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Changing the frequency in one of these views automatically adapts the frequencies in
all other views. The change provides that all views have the same current number in
their title bar. Using this feature, it is possible to generate different groups of views with
the same current number and select frequencies for an entire group with a single
mouse click.

Fix current scrambling code

The pin icon to the right of the "Frequency" list forces the system to trace the current
scrambling code, even if "Trace Top N Element" is selected in the configuration menu.
In fixed SC mode the icon is crossed out with red color and "Fixed Top N" is indicated
in the title of the "SC Trace Chart".

Clicking the crossed-out icon again releases the fixed SC: The system continues trac-
ing the selected top N element. If "Trace a Fixed SC" is selected in the configuration
menu, the pin icon has no effect.

View area

The entire view area is horizontally split to accommodate two different charts.

A click on the "SC Tracer Chart" or "CIR Chart" title bars compresses and expands the
corresponding chart. A compressed chart leaves more space for the other chart. A
compressed chart is characterized by the symbol >>> (instead of <<<) in its title bar.
On pausing on one of the title bars, the cursor displays a compress symbol.

SC tracer chart

The colored rectangular diagram shows the evolution in time of the power "Ec (CPICH)
[dBm]" and the time delay "Delta T[µs]" using the color scheme defined in the configu-
ration menu. "Ec (CPICH) [dBm]" and "Delta T[µs]" are listed in the "Peak List" in the
Chapter 4.8.11.3, "UMTS scanner CPICH view", on page 1383. The rectangular dia-
gram area represents the time/delay time plane.

In this plane, the signals with the same SC form one or several traces that change their
slot timing (horizontal position) and strength (color). All signals can be assumed to orig-
inate from the same NodeB, see the explanation at the beginning of Chapter 4.8.11.3,
"UMTS scanner CPICH view", on page 1383. Multiple traces indicate multiple signals
with different timing but the same SC and thus reflections. The example of the Fig-
ure 4-1061 shows a single (direct) signal. The time delay of the signal decreases/
increases while the test vehicle approaches/goes away from the transmitting NodeB.
The signal strength can be expected to reach its maximum where the distance to the
NodeB is close to its minimum. The slope of the trace corresponds to the "Drift" which
is also displayed in the Chapter 4.8.11.3, "UMTS scanner CPICH view", on page 1383.

In this plane, the signals with the same SC form one or several traces that change their
slot timing (horizontal position) and strength (color). All signals can be assumed to orig-
inate from the same NodeB, see explanation at the beginning of Chapter 4.8.11.3,
"UMTS scanner CPICH view", on page 1383. Multiple traces indicate multiple signals
with different timing but the same SC and thus reflections.

● "X-axis (del. time)"
Symmetric range centered on the first relative slot timing measured. The delay time
span is fixed and equals to 90 µs (13.5% of a slot).
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● "Y-axis (time)"
Linear time scale of the measurement. The diagram consists of 100 to 800 lines,
arranged from top to bottom. Each line shows the result of a single scan or sweep
with a frequency range of 5 MHz. The diagram is continuously updated during the
measurement or replay by adding new lines. It is scrolled and a scrollbar is added
along the right border when a line reaches the bottom of the diagram.

● "Display line"
On moving across the "SC Tracer Chart" area, the cursor displays a black, horizon-
tal line. A left mouse click on the chart updates the "CIR Chart" which now displays
the peaks at the time corresponding to the position of the display line.

CIR chart

The "CIR Chart" shows the average signal power of the P-CPICHs of all received
peaks over the time. The displayed powers and times correspond to the "Ec (CPICH)
[dBm]" and "Delta T[µs]" values listed in the "Peak List" in the Chapter 4.8.11.3, "UMTS
scanner CPICH view", on page 1383.

The diagram opens with a default x-axis scale of 90 µs (13.5% of a slot). If placed
inside the diagram area, the cursor takes the shape of a zoom-in icon (a magnifying
glass with a '+' inside). A vertical line is displayed at the cursor position.

A left mouse click magnifies the diagram in x-direction around the cursor position, the
CTRL key plus left mouse click causes the opposite. An area to become the new x-axis
range (e.g. the area around a peak) can be marked while the left mouse button is
pressed. "Reset Zoom" in the context menu restores the default scale. A scrollbar is
provided to move the magnified diagram to the right or left.

The scale of the y-axis (power in dBm) can be set in the configuration menu.

By default the diagram shows current results, corresponding to the last line in the "SC
Tracer Chart." To select a previous result for viewing, the display line in the "SC Tracer
Chart" can be used.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Select SC"

Opens a dialog box to select the primary scrambling code associated with the sig-
nal to be viewed.
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The scrambling code is defined in the format selected in the "TEC for UMTS PNS"
page, refer to chapter Chapter 3.8.2.9, "TEC for UMTS scanner", on page 321.
The "Select SC" command is unavailable if a particular Top N element is traced.

● "Reset Zoom"
Resets the x-axis scale.

UMTS scanner SC tracer view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: SC tracer target selection

The "SC Tracer Target Selection" option lets you select the signal to be traced in
"UMTS Scanner SC Tracer View".

Figure 4-1062: UMTS Scanner SC Tracer View - configuration

Trace Target
The "Trace Target" option lets you select either a signal with a definite scrambling code
or a particular Top N element to be traced.
● "Trace a fixed SC"
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The scrambling code is defined in the format selected in the "TEC for UMTS PNS"
tab, see Chapter 3.8.2.9, "TEC for UMTS scanner", on page 321. In decimal repre-
sentation, the primary scrambling codes are multiples of 16: SC[dec] = 16*i where
i=0 to 511, so the least significant digit of the hex numbers must be 0, preceded by
a hex value between 0 and 1FF.
If a scrambling code that is not assigned to any measured signal is selected, the
"UMTS Scanner SC Tracer View" remains empty.

● "Trace TopN Element"
List of all Top N pools defined in the scanner configuration menu. The current Top
N pool selection is indicated in the list of Top N pools.

Configuration: SC tracer view

The "SC Tracer View" option lets you scale the diagrams and define the colors in the
view.

Figure 4-1063: UMTS Scanner SC Tracer View - view configuration

Dynamic Range of CIR Chart
The fields in the panel define the minimum ("Min [dBm]") and the maximum ("Max
[dBm]") signal level displayed in the diagrams of the "UMTS Scanner SC Tracer View".
The signals exceeding the dynamic range are not displayed.

Color Graph
The entry defines the number of lines to be displayed in the view. A line corresponds to
the single frequency sweep.

Colors
The panel defines a color scale of the lines in this view and of the background. The
scale is derived from 2 to 16 "definition colors". The definition colors are entered at
equidistant positions on the color scale, the first and last color defining the beginning
and the end of the scale. Between the definition colors, the hue changes continuously.
● "Count of Definition Colors"
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Pull down list to select the number of definition colors in the range 2 to 16.
● "Change Color Scale"

Opens the Colors dialog to select or define the definition colors.

Figure 4-1064: ROMES color scale

The current definition colors are displayed in the Custom Colors section. The [F1]
function key provides help about the remaining control elements in the dialog.

● "Change Background Color"
Opens the Colors dialog to select or define a background color for the diagram, as
shown in the previous figure.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.
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Figure 4-1065: UMTS Scanner SC Tracer View - device selection

The result of the device selection looks like shown in the following figure. "UMTS Scan-
ner SC Tracer View" shows only the tab of the 1st scanner. If you need more than one
device-specific view of a certain type, open and configure more instances of the view in
"Context menu" > "New View".
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Figure 4-1066: Results of the device selection

4.8.11.7  UMTS scanner Top N view

The "UMTS Scanner Top N View" displays the properties of the signals received from
the NodeBs. These signals are the selected elements of the "Top N Columts" list in the
scanner's configuration menu, see Figure 4-1071. A Top N pool contains up to N
NodeBs with specific characteristics providing the strongest P-CPICH level at a given
position and time.
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Figure 4-1067: UMTS Scanner Top N View

The Pilot Pollution markers are inserted on the top of the RSCP bars in the 2D top N
"Chart" in the previous figure. The HPP marker is shown in red and the SPP marker in
blue color.

If the Top N cell number is limited during measurement, the view's chart panel uses the
full width for the limited number of members.
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Figure 4-1068: Limited Top N list

UMTS scanner Top N view for automatic pool configuration

The scanner Top N view of the R&S ROMES 3GPP technologies displays the all “auto-
matically configured Top N pools" on the screen.

If you select "Top N Pools" > "Automatic Pool Configuration" for a corresponding tech-
nology, the Top N selector control gets the additional entry "Show all TopN Pools" in the
view.

By selecting this entry, you can see all Top N pools in the list. The number of displayed
members per pool depends on the size of the window. It is calculated automatically in
such a way that all Top N pools can be observed without scrolling the list (if even one
member does not fit, scrollbars are added).

The signals and their decision values which users can select for ranking of the Top N
pools are available in the "Available Signals" tree.

The "Chart" panel is shown in 3D in case the automatic Top N pool configuration
active. The values of the selected signal used for ranking and display are shown as 3D
bars.

The Top N chart can be rotated moving the mouse while pressing the left button (x-
axis, y-axis and z-axis when pressing the CTRL key additionally). Press the R key to
reset the 3D chart to its default orientation.

The configuration of the Top N view allows to configure the colors for the 3D chart and
the minimum and maximum for the Top N values.

The color of each bar represents the state of the signal based on the signals color
scale defined in the "Available Signals" configuration page. Typically this is green for
high values and red for low values.

You have the option to display the Top N pools as the grid with 2D charts instead of the
standard 3D bar chart.
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To enable the grid with 2D bar charts, click on the "Show Grid" slider at the right top if
the 3D "Chart".

You may return to the 3D chart at any time by clicking the "Show 3D" slider at the right
top if the 2D "Chart".

For the Scanner Top N view the grid arrangement is dynamic to allow the best use of
space to display as many pools as possible.

Note: The maximum size of the grid is to be 6 columns and 3 rows.

The following figure shows how many rows and columns to expect in the grid.

Figure 4-1069: Allowed sizes of the grids in 2D chart

For the "Chart" layout in this case, see Figure 4-761.

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.

The splitter position between the upper and lower part of the scanner view area and
the open or closed state of the "Top N List" and "Top N Chart" are restored from the
workspaces.

Most of the information in the table is displayed in the Chapter 4.8.11.3, "UMTS scan-
ner CPICH view", on page 1383, so that compressing it can help to avoid redundan-
cies.
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Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

If you start R&S ROMES4 with an empty workspace, the initial widths of the columns in
"Top N View" are initialized and scaled properly based on the current screen DPI set-
ting.

Top N list

The "List" gives an overview of the received signals in the current Top N pool together
with their scrambling codes, different power parameters, frequency and timing informa-
tion. On mouse rollover, each cell in the table header provides a short explanation of
the corresponding column. Most of the results in the list are also displayed in the "Peak
List" in the "UMTS Scanner CPICH View". For a detailed explanation of the parame-
ters, refer to Chapter 4.8.11.3, "UMTS scanner CPICH view", on page 1383.

The "List" contains the following additional columns:
● "#"

Current number of a NodeB within the measurement. NodeBs are numbered in
ascending order, according to the time when they enter the top N pool. The current
numbers tend to increase as the measurement progresses.

● "Rank"
Current rank of a NodeB within the pool, according to its average or maximum
Ec/Io (see scanner configuration menu). The ranks are reassigned every time the
pool is updated; they are in the range 1 ≤ Rank ≥N.

● "SC"
Scrambling code in hex format.

● "RNC"
Radio Network Controller identity
The signal is also included in the "Available Signals" tree of the UMTS PNS. The
data shown is taken from the highest 16 bit of the cell identity in the SIB 3.
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Figure 4-1070: UMTS scanner BCH view - cell identity

● "Ec/Io [dB]"
Ratio of the received energy per P-CPICH to the total inband energy during one
chip.

● "SIR [dB]"
Signal to interference ratio, calculated as RSCP/ISCP*SF, where SF=256 for P-
CPICH.

● "RSCP [dBm]"
Integral received signal code power for all measured peaks.

● "ISCP [dBm]"
Interference power orthogonal and non-orthogonal.

● "Ptotal [dBm]"
Total average inband power within correlation section.

● "Channel"
Physical channel and channel frequency of the received CPICH.

● "Drift [ns/s]"
Mean time drift of P-CPICH regarding the internal clock which can be synchronized
with the PPS of GPS.

● "Std.Dev.Drift [ns/s]"
90% confidence interval width of the mean time drift value. A small value indicates
that the drift measurement is estimated to be relatively accurate.

● "Delay Spread [Chip]"
RMS (Root Mean Square) delay spread in chip periods: standard deviation of the
time delay Delta T at all CPICH measurement points weighted with the measured
power Ec (CPICH).
A small delay spread indicates that the individual CPICH peaks of the NodeB sig-
nal are relatively close or that the power of peaks with different time delay is low.

● "HPP"
Hard pilot pollution of the NodeB signal as defined in "TEC for UMTS PNS" > "Pilot
Pollution", see the Figure 3-214.

● "SPP"
Soft pilot pollution of the NodeB signal as defined in "TEC for UMTS PNS" > "Pilot
Pollution", see Figure 3-214.

● "Cue"
C-criterion for cell selection/re-selection emulated by the UE, based on EcNo;
Srxlev (reported in parenthesis). The ranking is done by quality in this case.

● "NR"
Neighbor relation to the other members of the Top N pool. This number is percent-
age of members which are listed in the BA list. It is only available if at least SIB11
and SIB12 was demodulated.
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● "Add. PLMNs"
Additional PLMNs shared on this NodeB, see "Top N pool signal settings"
on page 324.
The shown MCC and MNC signals of the eNodeB in the TopN List view are always
related to the primary PLMN. However, for Top N pools, filtering of eNodeB signals
takes into account all PLMNs that are in the list and the mentioned signals are
shown in the "Add. PLMNs" column.

The following information is available only if the PN scanner data are recorded with
"BCH Demodulation" (minimum SIB3 decoding) enabled (see "BCH demodulation
UMTS PNS" on page 1804).
● "LAC"

Location Area Code
● "CI"

Cell Identity (16 bits)
● "MCC"

Mobile Country Code
● "MNC"

Mobile Network Code
● "Node B"

Name of the closest NodeB with the corresponding SC and UARFCN.
● "ULI [dBm]"

Interference measured in the channel uplink measured in SIB7.

In the view configuration menu, it is possible to show or hide each individual table row.

Diagram

Below the table, the "Chart" shows the Ec/Io ratio and the Received Signal Code
Power (RSCP) for all NodeB signals in the current top N measurement (see Chap-
ter 4.8.11.3, "UMTS scanner CPICH view", on page 1383).

Signals from different NodeBs are distinguished by their primary scrambling codes
(SC), displayed along the x-axis. The scales for the two parameters RSCP and Ec/Io
are displayed on the left and right edge of the diagram, respectively. Both y-axis scales
(RSCP in dBm and in dB) can be set independently in the configuration menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.
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UMTS scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

Configuration: Top N view

The "Top N View" option lets you set the following:
● Select the Top N column list
● Select a type of power signal for display as the 2D and 3D chart value used for

ranking the pools. For example, select for display the total average inband power
within correlation section of P-CPICH. Also, the integral received signal code
power for all measured peaks can be selected as the first 2D and 3D chart value.

● Specify the UMTS graph y-axis titles and limit displayed in the chart. Define the
minimum ("Min [dBm]") and the maximum ("Max [dBm]") value to be displayed for
the selected power signal in the view.

● Select if the 3D chart uses open GL (Hardware) rendering. Using open GL render-
ing fastens the 3D chart.

● Select signal quality for the 3D chart option display.

Figure 4-1071: UMTS Scanner Top N View - configuration

All RSCP settings are analogous to the settings in the "UMTS Scanner CPICH View"
configuration menu, see Chapter 4.8.11.3, "UMTS scanner CPICH view",
on page 1383.

The pilot pollution limits are identical with thresholds providing the criteria for HPP and
SPP (see "Pilot pollution" on page 334).

UL Interference signals and Top N values are reset, if not updated during a certain time
period. For each frequency, this period is calculated as five times the time interval for
UL Interference measurement, but at least 3 seconds.

Graph
"First 2D Chart Value and 3D Chart Value"
● "Show P total"
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Shows total received power in the 2D/3D chart, if selected.
● "Show RSCP"

Shows the Reference Signal Code Power in the 2D/3D chart, if selected.
– "RSCP Min/Max [dBm]"

Sets the upper and lower RSCP for the left y-axis of the chart.
● "Display Top N Members"

The check box lets you select the number of Top N member for display.
● "Select 2D Chart Value"

– "Ec/No Min/Max [dBm]"
Sets the upper and lower SINR level for the right y-axis of the chart.

3D Chart Option ← Graph
● "Use Open GL Rendering"

The options determine if the 3D chart is rendered open GL (hardware) rendering or
software rendering. Using open GL allows faster rendering of the 3D chart.

Grid Chart Options ← Graph
● "Displayed Top N Members"

The check box lets you select the number of Top N member that each chart in the
grid will display.

● "Max Displayed Cols"
The check box lets you select the maximum number of displayed columns in the
grid. Allowed values are from 1 to 6.

● "Max Displayed Rows"
The check box lets you select the maximum number of displayed rows in the grid.
Allowed values are from 1 to 3.

2D Chart Option ← Graph
● "Show signal quality"

If the option is selected, shows the signal quality in the Top N chart. This is the pos-
sibility to switch "on" or "off" the second y-axis on the chart and quality signal bars.

For both 2D/3D chart options, if selected, the result of the switching is visible in the
next frame, as the chart must redraw at least once for it.

Configuration: Device selection

The function offers the following options for a device selection mode:

● Select that all tabs of all devices are displayed.
● Select that a single tab used by predefined device is displayed only.

In both cases you can make the selection by device instance number or its name.

NOTE: The "Device Selection" tab is not available during measurements or replay. It is
available if nothing is measured or the replay is paused.

4.8.12  WiMAX scanner views

The WiMAX scanner views show the information obtained in the WiMAX network scan
performed by an R&S radio network analyzer.
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For this purpose, the R&S TSME scanner with its hardware R&S TSME-K28 option is
needed.

The WiMAX network scan available option for R&S TSME is R&S ROMES4T1E.

How to install and configure the WiMAX network scanner, see Chapter 6.4.25, "WiMAX
scanner", on page 1856.

The "WiMAX Views" can be selected from a submenu displayed on the right side of the
"View" menu when the mouse hovers over "WiMAX Views".

Figure 4-1072: WiMAX Scanner Views

4.8.12.1  WiMAX scanner BCH view

The WiMAX scanner measures WiMAX signals and in addition demodulates and
decodes the content of received channels of the WiMAX signal. This data is depicted
as a summary of all found WiMAX transmitters by the "WiMAX Scanner BCH View".

The contents of the messages appear in a tree view when a message is selected.

The information is available only if the WiMAX scanner data is recorded with "BCH
Demodulation" enabled, refer to Chapter 6.4.25.2, "WiMAX scanner configuration",
on page 1857.
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Figure 4-1073: PDU list of variants and time stamps

Referring to R&S ROMES4 support of dynamic PDU handling described in "Implemen-
tation of the dynamic PDU handling" on page 284, the "WiMAX Scanner BCH View" is
enhanced. The enhancement is the list of measured PDU variants over time. The PDU
variants are shown as leaves of the base station tree.

If a signal is selected on the left-hand side of the "WiMAX Scanner BCH View", the list
of PDU variants and the list of associated time stamps are shown on the view's right-
hand side. The "TimeStamp" shows the most recent measurement of the variants.

In the previous figure the "PDU Variant List" shows the several time stamps in the
upper right of the view as there were found different PDU variants.
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Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Expand/Collapse Branch"

Expands or collapse the branch in the left part of the window.
● "Expand/Collapse Tree"

Expands or collapse the additional information in the tree view.
● "Expand Default Branch only"

Expands only the default branch. All others are collapse.
● "Global Export Settings"

Opens the "Basestation List Export" dialog which offers to generate the base sta-
tion list, see "Basestation list export" on page 1218.

● "Mark Selected Transmitter on Map"
Base stations which are found in the data base can be marked in the ROMESMAP
view via the context menu.

● "Remove Marker of Selected Transmitter"
Base stations which are marked in the ROMESMAP view can be removed.

● "Remove All Markers"
All base stations which are marked in the ROMESMAP view can be removed.

WiMAX BCH view configuration

The "Configuration" page is common for the scanner BCH view of all RATs.

The "Configuration" option lets you set the color for the selected BTS symbols in the
"ROMESMAP Route Track View" and define the filter for generating a BTS list.

Open the configuration page by a right mouse click on a point inside the view or via the
"Tools" > "Configuration Active View" command.
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Figure 4-1074: WiMAX Scanner BCH View – configuration

4.8.12.2  WiMAX scanner CIR view

"WiMAX Scanner CIR View" displays the channel impulse response (CIR) of the
WiMAX signals.

Figure 4-1075: WiMAX Scanner CIR View
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View area

The entire view area is horizontally split to accommodate a chart and a table/list. The
"CIR Chart" shows the CIR of the different WiMAX signals which are scanned. The
graph allows zooming the chart. The small button on the right of the scroll bar reset the
zoom level.

Click the "CIR Chart" or "CIR Lists" title bars to compress or expand the 2D-chart or
table. A compressed chart leaves more space for the table and vice versa. Moreover,
the tables appear in several views so that compressing them can help to avoid redun-
dancies. A compressed sub diagram is characterized by the symbol >>> (instead of
<<<) in its title bar. On pausing on one of the title bars, the cursor displays a compress
symbol.

Diagram scale

If placed inside the diagram area, the cursor takes the shape of a zoom-in icon (a mag-
nifying glass with a '+' inside). A vertical line is displayed at the cursor position.

A left mouse click magnifies the diagram in x-direction around the cursor position,
CTRL+ left mouse click causes the opposite. An area to become the new x-axis range
(e.g. the area around a peak) can be marked while the left mouse button is pressed.
"Reset Zoom" in the context menu restores the default scale. A scrollbar is provided to
move the magnified diagram to the right or left.

The scale of the y-axis (power in dBm) can be set in the configuration menu.

Left table

The left table lists all scanned WiMAX segments.
● "Color"

The color configured to represent the preamble index of a segment. It is configured
in views configuration page.

● "Preamble Index"
Downlink preamble index.

● "ID Cell"
Cell identity, if applicable. If not, written is "---" in the corresponding column.

● "Segment"
A cell site can be divided up into three different segments. Thus, the segment is
identified with ID, which can be 0, 1, or 2.

● "CINR"
Signal to interference and noise ratio of the preamble of the WiMAX cell.

● "RSSI"
Power of the preamble of a certain WiMAX cell characterized by ID Cell and Seg-
ment ID. It excludes noise and interference.

● "Noise"
Noise floor [dBm].

● "Ptot"
Total power, including noise and interference, measured at the same time and fre-
quency as the preamble.

● "Frequency"
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Center frequency of the used channel [GHz], according to IEEE 802.16.

Right table

The right table shows the different path of the segments. For each path, the following
parameters are displayed:
● "Color"

The color configured to represent the preamble index of a segment. It is configured
in views configuration page.

● "Preamble Index"
Downlink preamble index.

● "ID Cell"
Cell identity, if applicable. If not, written is "---" in the corresponding column.

● "Segment"
A cell site can be divided up into three different segments. Thus, the segment is
identified with ID, which can be 0, 1, or 2.

● "CINR"
Signal to interference and noise ratio of the preamble of the WiMAX cell.

● "RSSI"
Power of the preamble of a certain WiMAX cell characterized by ID Cell and Seg-
ment ID. It excludes noise and interference.

● "Ptot"
Total power, including noise and interference, measured at the same time and fre-
quency as the preamble.

● "Delay"
Signal delay time [µs]. The delay in the list corresponds to the delay seen in the
CIR list (left list).

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

The context menu provides the following additional commands:
● "Reset Zoom"

Resets the x-axis scale to 0 ms to approx. 26.5 ms.
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WiMAX scanner CIR view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "CIR View" lets you customize the diagram and the contents of the table in the
"WiMAX Scanner CIR View".

Figure 4-1076: WiMAX Scanner CIR View - configuration

The CIR view configuration includes y-axis scaling, selecting the information for display
in the view and a Doppler shift correction.

Dynamic Range
The two input fields in "Dynamic Range" define the minimum ("Min [dBm]") and the
maximum ("Max [dBm]") level to be displayed in the "WiMAX Scanner CIR View".

CPICH List, Peak List
"CPICH List" and "Peak List" select which information is displayed in the tables below
"CIR Chart". Clearing a box hides the corresponding row in the diagram.

Doppler Frequency
The function is disabled, setting can be ignored.
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Channel Timeout
If there are no data on a channel anymore, the "CIR List" entries for this channel are
removed after a timeout.

4.8.12.3  WiMAX scanner Top N view

The "WIMAX Scanner Top N View" displays the properties of the signals from the BTSs
that are the elements of the "Top N Pools" defined in the technology configuration. A
Top N pool contains cells with specific characteristics providing the strongest RSSI or
CINR level at a given position and time.

Figure 4-1077: WiMAX Scanner Top N View

View area

The entire view area is horizontally split into three parts. On the top, the view accom-
modates a pull-down list with all defined "Top N" measurements of the technology. The
"Top N List" below shows in tabular way the values of the parameters configured for
the measurement. The lowest part is the bar chart.

Click the ">>>"/"<<<" button to hide/expand the tables or chart pane. The hidden chart
leaves more space for the table and vice versa.
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The splitter position between the upper and lower part of the scanner view area and
the open or closed state of the "Top N List" and "Top N Chart" are restored from the
workspaces.

Top N

Below the view title bar there is the "Top N" line with the pull-down box which contains
all the Top N pools defined in the "Top N Settings" configuration page of technology.
The results in the "List" and "Chart" refer to the Top N pool selected in the list.

The "Top N" line contains in addition the "Auto Width" button. If clicked, the button
automatically adjusts the widths of all columns. If clicked CTRL + "Auto Width", adjus-
ted are the column widths to fit both column contents and titles.

If mouse hovers over the "Auto Width"" button, the related message is shown as a
Tooltip.

● Double-click the column divider auto-adjusts the width of a single column on its left.
● CTRL double-click a column divider auto adjusts all column widths.
● Double-click or CTRL double-click the column header only toggles the sort order,

does not adjust a column width.

The column widths adjustment is based on the cell content, not on the column title
widths.

Saving the workspace with adjusted Top N view column widths saves also the changed
column widths. Loading the workspace next time, restores the changed column widths.

Refer to "Tools" > "Overview of Settings" > "TEC for WiMAX Scanner" in Chap-
ter 3.8.2.11, "TEC for WiMAX scanner", on page 337.

Top N list

The "Top N List" gives an overview of the received signals in the current Top N pool
together with their measured power parameters, frequency and timing information. On
mouse rollover, each cell in the table header provides a short explanation of the corre-
sponding column.

In the view configuration menu, it is possible to show or hide each individual table col-
umn. Up to three differently named pools can be configured in the default setup. Each
pool has several configurable parameters.

The "Top N List" contains the following columns:
● "Color"

Automatically selected color code of the preamble index.
● "#"

Number of a measured cell and its preamble index within the Top N pool.
● "Rank"

Current rank within the Top N pool.
● "PA Ix"

Downlink preamble Index.
● "Segment"

Scanner views
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A cell site can be divided up into three different segments. Thus, the segment is
identified with ID, which can be 0, 1, or 2.

● "ID Cell"
Cell identity, if applicable. If not, "---" written is in the corresponding column.

● "Mode"
Valuation method (Average/Max/Min).

● "RSSI"
Power of the preamble of a certain WiMAX cell characterized by ID Cell and Seg-
ment ID. It excludes noise and interference.

● "CINR"
Signal to interference and noise ratio of the preamble of the WiMAX cell.

● "Frequency[GHz]"
Center frequency of the used channel according to IEEE 802.16.

● "Bandwidth[kHz]"
For WiMAX, different bandwidths are possible according to IEEE 802.16.

● "FFT Size"
Fast Fourier Transformation size

● "CP Ratio"
Cyclic Prefix ratio.

● "Frame Rate"
Frame rate.

● "BTS Name"
Name of the WiMAX base station

● "Distance (to BTS)"
Distance to the BTS.

Diagram

Below the table, the "Top N Chart" shows the RSSI and CINR for all cells in the current
Top N measurement as a bar chart.

It is possible to select the upper and lower RSSI and CINR levels for the y-axis of the
chart in the configuration menu.

Context menu

A right mouse button click at any point in the view opens the context menu.

The menu contains the following commands:

- access the configuration page,

- put the view on hold,

- copy the current view to the clipboard,

- create or delete views,

- save the current configuration as default, or move to another view area.

Refer to Chapter 4.1.3, "Context menu", on page 429.

Scanner views
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WiMAX scanner Top N view configuration

To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

The "Top N View" option lets you define y-axis scaling, specify the thresholds (mini-
mum/maximum) for RSSI/CINR for display in the chart view and the contents of the
Top N list.

Figure 4-1078: WiMAX Scanner Top N View - configuration

Graph
● "RSSI Min/Max [dBm]"

Sets the upper and lower RSSI levels for the left y-axis of the chart.
● "CINR Min/Max [dBm]"

Sets the upper and lower CINR levels for the right y-axis of the chart.
● "Show signal quality"

Shows the signal quality in the "Scanner Top N View" when the option is activated.
The option is the possibility to switch on/off the second y-axis on the chart and
quality signal bars.
If the option is selected, you see the result of the switching in the next frame, as
the chart must redraw at least once for it.

Scanner views
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5  R&S ROMES4 tools
Together with the main application, R&S ROMES4 installs additional useful software
tools. The tools are accessible in the MS Windows "Start" pane. The QualiPoc Update
Tool is accessible also via the "Tools" menu of the R&S ROMES4.

Figure 5-1: R&S ROMES4 tools

● Device manager..................................................................................................1424
● Georeferencing tool.............................................................................................1426
● QualiPoc converter..............................................................................................1430
● QualiPoc update tool...........................................................................................1436
● R&S ROMES4 technology selector.....................................................................1440
● R&S TSME diagnosis and updates.....................................................................1443

5.1  Device manager

The Device Manager helps to remove redundant USB devices (mainly test mobile devi-
ces and GPS devices) that R&S ROMES4 used in previous measurement sessions. A
USB device has to be assigned to several virtual COM ports whenever it is connected.

The operating system does not delete unused virtual COM ports if USB devices are
connected and disconnected repeatedly. As a result, the virtual COM port numbers for
new devices ("Assign Serial Ports" dialog) tend to increase, which in the end can
cause connection problems.

If the assigned port numbers exceed values of 30, or the holes in the sequence of the
COM port numbers are noticed, delete the redundant USB ports using Device Man-
ager.

Device manager
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The Device Manager is the standard device manager from Microsoft with the environ-
ment variable SET DEVMGR_SHOW_NONPRESENT_DEVICES set to 1.

5.1.1  Installation

The special Device Manager is automatically installed together with the test system.
The executable file DeviceManager.bat is stored in the C:\Program Files
(x86)\Rohde-Schwarz\ROMES<version>\Tools\DeviceManager program directory.

5.1.2  Removing unused devices

To remove unused device:

1. Select the "Start" > "R&S ROMES" > "Device Manager<version>" entry in Windows
GUI.

The "Device Manager" page opens.

2. Select "View" > "Show hidden devices".

Figure 5-2: Device manager view

Device manager
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Note: The entry must be ticked after each program start.

3. Expand the "Modems" and "Wireless Communication Devices" nodes in the
"Device Manager" page.

4. Gray icons display unused devices and port assignments.

5. Delete redundant entries, for example, the "Qualcomm" entries, all Qualcomm
COM ports and “compound devices”, and all other devices that appear several
times and you no longer need them.

6. Close the "Device Manager" page.

The lower virtual COM port numbers are available once again. You can use them
for the connection of new USB devices.

5.2  Georeferencing tool

Start the Georeferencing map referencing tool from the Windows "Start" > "R&S
ROMES" > "Georeferencing Tool<version>" entry.

How to use the tool, see GeoRefWizard_Manual_en.pdf which is located in the
C:\Program Files (x86)\Rohde-Schwarz\ROMES20.1\GeoRefWizard directory.

Figure 5-3: Location of GeoRefWizard_Manual

Georeferencing tool
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5.2.1  Referencing and patching indoor measurements

You can start the GeoReferencing Wizard from R&S ROMES4 to reference not refer-
enced maps of an indoor measurement. When started, the GeoReferencing Wizard
also patches the geographical coordinates of the measurement with the result of the
referencing.

Perform the following:

1. Click the "File > Reference/Patch Indoor Measurement" entry in the R&S ROMES4
window.

Figure 5-4: Reference/Patch Indoor Measurement command

2. Select a measurement file containing an Indoor measurement.

Georeferencing tool
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Figure 5-5: Indoor measurement file selected

If selected, the function searches for an indoor measurement file that contains
maps and measured geographical coordinates.

3. At the end of the searching, the following dialog appears.

Georeferencing tool
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Figure 5-6: Indoor files found

The dialog displays contained maps and the number of coordinates to patch.

4. Press "Start" to start the GeoReferencing Wizard. The "GeoReferencing" page
shows the first image of the list and the image can be referenced (you need to
adjust the zoom level first).

Figure 5-7: Image shown in the GeoRefWizard

5. Select the desired map projection.

6. Put the coordinates in "Longitude" and"Latitude".

7. Press "Run" to reference image. When done, it appears as the next image of the
list. By referencing the last image in the list, the application closes and writes the
new coordinates to the measurement file. This new measurement file has the suffix
"_referenced" appended to the original file name.

Georeferencing tool
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8. At the successful completion of the procedure, the following dialog appears.

9. Click "Open File for Replay" to open the referenced measurement file in R&S
ROMES4 or "Exit" to proceed with any other action.
Note: It is only possible to display georeferenced images together with MapInfo
maps in the "ROMES Route Track View". Displaying the images together with other
formats like "OpenStreetMap" is not supported.

5.3  QualiPoc converter

The QualiPoc Converter is a separate tool included in R&S ROMES4 installation which
provides the conversion of measurements performed with the QualiPoc app on a
mobile.

5.3.1  Supported technologies

QualiPoc Converter supports the following technologies:
● GSM
● UMTS
● LTE
● NB-IoT
● 5G NR

5.3.2  Supported DQA jobs

QualiPoc Converter supports the following DQA jobs:
● QualiPoc Session Start/End
● HTTP Download/HTTP Browsing
● HTTP Upload
● FTP Download/Upload
● Ping
● Email Send/Receive

QualiPoc converter
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The conversion of Email jobs works only with the QualiPoc Version 14.0.0 or later.
● Capacity DL/UL
● Call2AnyNumber

Voice calls, no matter if the POLQA speech quality measurements or simple voice
calls measurements are done, fill the "ETSI QoS View".

● YouTube Streaming
● QP Ookla ® Test
● Facebook
● Dropbox
● QP WhatsApp
● SMS Send

DQA views show the results of the conversion in the same way the same DQA jobs
performed with the Android smartphones with SQ interface show.

QualiPoc text markers are converted and shown in the "QualiPoc Message View".

5.3.3  Prerequisites for QualiPoc converter

The following prerequisites apply for the QualiPoc Converter:
● Pcap recording is activated in the QualiPoc application.
● If you open a *.mf measurement file, the recorded PCAP files have to be in a sub

directory with the same name as the *.mf file.
● If you do not enable Pcap recording or the QualiPoc Converter cannot find the file,

the TCP/IP trigger points and the related KPIs are not available.
● If you open a *.sqz measurement file, the PCAP files are extracted automatically

to the correct directory.
● It is not allowed to rename a *.sqz measurement file, as the unzipping and han-

dling of the contained files can fail.
● It is not allowed to rename the created PCAP files because they are referenced in

the measurement.
● Activate the RSCMD logging in the QualiPoc application. For how to activate the

RSCMD logging, see QualiPoc OneTraceDecoder/Converter.

5.3.4  Missing files info provided by QualiPoc converter

The QualiPoc Converter has a column for information during the conversion progress.
In this column the user is informed about missing files, for example, PCAP files or TAB
files. The case of missing PCAP file is shown in the following figure.

QualiPoc converter
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Figure 5-8: QualiPoc Converter info column

5.3.5  QualiPoc converter execution from the command line

QualiPocConverter.exe command-line options:
● -h [ --help ] Produce help message
● -v [ --version ] Print version
● -i [ --input ] arg Input file (*.mf or *.sqz)
● -o [ --output ] arg Output file (*.rscmd) [Optional]
● -l [ --qclogs ] Produce QC Log Code Statistics

5.3.6  Converted measurement file

In R&S ROMES4 the DQA has a relation to mobile devices. The relation is fixed by the
modem port of the device and the modem port of the used modem in the Connect Job.
The QualiPoc measurement does not have a special Connect Job. To create the rela-
tionship between DQA and mobile device, the converter simulates a pseudo Connect
job for each QualiPoc session start and Disconnect job for each session end.

All from R&S ROMES4 provided trigger points for session start and session end are
described in the "Trigger Point Definitions" document.

"File Info", which is a part of the "Open" page when you select a measurement file,
shows always COM3 for the name of Data Port and for Modem Port in the "Connect
Job" section.

QualiPoc converter
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Figure 5-9: QualiPoc - File Info layout

The session report has invalid values for Connection Dialup Time, HTTP Time and
Setup Time, see the following figure.

QualiPoc converter
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Figure 5-10: DQA Session Report - via QualiPoc Converter

5.3.7  Support of SQC container files

The QualiPoc SQC container files are available for conversion. They can be converted
when opening the QualiPoc file from the R&S ROMES4 "File" menu.

QualiPoc converter
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Figure 5-11: SQC container content

It is not possible to convert these files with the QualiPoc Converter GUI executable.

5.3.8  Replay of measurement files created by the SwissQual collection
tools

R&S ROMES4 converts measurement files created by the SQ collection tools Quali-
Poc, STS, Freerider and Smart Benchmarker during the file open dialog.

- All QualiPoc created *.sqz measurement files can be converted to RSCMD-based
*.sqc files and replayed in R&S ROMES4 for detailed analysis. This conversion and
replay comprises measurements using the UE GPS position, indoor floorplans and the
combination of floorplan and GPS positions.

Speech quality measurements and all data jobs available in R&S ROMES4 are trans-
ferred too.

- Site Testing Solution (STS) created measurements use an indoor floorplan and can
be converted based on the scanner measurement files.

- Freerider created *.sqc measurement files usually contain multiple UEs. All UE
measurements are merged to one RSCMD-based measurement file. GPS, floorplans
or the combination of floorplan and GPS positions can be used. Speech quality and
data jobs are transferred.

- Smart Benchmarker created *.sqc measurement files usually contain a scanner
measurement file and one or multiple UEs measurements. The scanner measurement
file contains all scanner measurements (already in RSCMD format) and is used during
conversion as basis. (Only during the longer measurements a set of files is created
named 001, 002 ...). Scanner measurements can comprise the 5G NR, LTE, NB-IoT,
UMTS and GSM technologies (however, only one instance of GSM scanner is pres-
ent). The UE measurements are merged into the scanner RSCMD measurement file. If

QualiPoc converter



R&S ROMES4 toolsDrive Test Software

1436Operating Manual 1171.6415.12 ─ 66

there are RSCMD file sets (for example, generated due to long measurement dura-
tion), choose one scanner RSCMD measurement file as a basis. UE files can be
selected individually for the merge process. GPS, floorplans or the combination of
floorplan and GPS positions can be used. Speech quality and data jobs are transfer-
red.

Filenames (floorplan *.ibwc files and measurement files previously mentioned) can
contain country-specific characters, blanks, underscores and hyphens.

5.4  QualiPoc update tool

Update of the fully integrated devices, if needed, is not performed inside R&S
ROMES4. Instead, it informs you which devices need an update. You get a dialog like
one shown in the following screenshot.

Figure 5-12: Fully integrated devices to be updated

If you press the "Skip" button, the mobiles cannot be used for measurements. They are
shown as greyed out in the "Available Devices" list on the "Welcome" page.

If you press the "Run QualiPoc Update Tool" button, the QualiPoc (QP also in the text)
Tool starts and R&S ROMES4 is closed. It can take a while (up to 60 seconds) until
R&S ROMES4 is terminated. The QualiPoc Update Tool displays currently connected
fully integrated devices.

QualiPoc update tool
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Figure 5-13: QP update tool screenshot

Entries in the QP Update Tool page

The following entries are shown in the "QualiPoc Update Tool <version>" page:

● "Path to QualiPoc APK"
Folder where the QualiPoc APK file is located. The folder can be changed with
"Browse".

● "Available Version"
Newest QualiPoc version available in the display folder.

● "Connected Mobiles"
Table showing the details of the connected fully integrated devices.
– "Serial"

Serial number of the mobile
– "Model"

The model name including the QualiPoc unit name. The unit name is available
when its probe state is READY.

– "Manufacturer"
Manufacturer of the mobile device

– "Version"
Current version of QualiPoc

– "Probe State"
Current state of QualiPoc probe - it can change during the startup and update
process.

– "Action"
Necessary action to execute for a mobile device. Some examples are shown in
the next section.

– "Maintenance Period"
The tool checks a mobile device's release maintenance period. If the mainte-
nance period has been expired, the update of the current installed main release
is only available - for example, from 21.1.20 to 21.1.xx. The maintenance

QualiPoc update tool
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period is available in R&S ROMES4 versions 21.1 and higher when the UE has
become the probe state READY. Older versions display "n.a." in this column.

– "Info"
Reported info messages

● "Start Romes when closed"
If checked, R&S ROMES4 is started after the application has been closed.

R&S ROMES4 is only started again, when the mobiles are ready again after they have
been updated. If not started after 4 to 5 minutes, perform scanning or check the mobile
devices manually.

The following screenshot shows that two mobile devices are in the "RF Trace Missing"
probe state. These devices with external diagnostic trace are in this state because the
message only disappears when the mobile devices are loaded. For QualiPoc Update
Tool, it is correct when the devices with external diagnostic trace stay in this state.

Figure 5-14: Display of connected fully integrated devices

The devices with external diagnostic trace can stay in the "RF Trace Missing" probe
state.

Buttons in the QP Update Tool page

The buttons present in the "QualiPoc Update Tool <version>" page perform the follow-
ing functions:

● "Browse"
Selects directory where a QualiPoc *.apk file is located.

● "Run displayed Actions"
Executes displayed actions.

● "Uninstall All"
Uninstalls QualiPoc on the mobiles.

● "Scan"
Executes rescan of the mobiles. Rescan is necessary if other mobiles have been
connected after the start of application. The scan of mobile devices is automatically
done on start of the application but not when they are plugged in to USB after-
wards.

● "Quit"
Closes the application.

QualiPoc update tool
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QP Update Tool maintenance license concept

For the QualiPoc license concept, see Chapter 3.10.4.3, "QualiPoc licenses",
on page 423.

5.4.1  Actions with the QualiPoc update tool

The "Action" function includes the following possible necessary actions for the fully
integrated devices:

● "Update" if the device's version is lower than the available version.
● "Install" if QualiPoc is not installed on the device.
● "Uninstall" if the device's version is greater than the available version.
● "No Action" if the device's version equals the available version.
● If "Check for QP Maintenance Update" selected, update maintenance license is

allowed as previously mentioned.

Figure 5-15: Action entries

The action can be changed depending on the detected state. The modified selection of
the action is reset with a new scan.

Installing / updating

The following screenshot shows the probe states installing/updating of the fully integra-
ted devices and the corresponding update/install actions.

Figure 5-16: Install/update

Shutdown during update

The following screenshot shows for three devices the shutdown probe state during the
update process.

QualiPoc update tool
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Figure 5-17: Shutdown during update process

5.4.2  Starting the QualiPoc update tool

The QualiPoc Update Tool is started from the MS Windows "Start" > "R&S Romes"
menu, see Figure 5-1.

It can also be started from the "Tools" > "Run QualiPoc Update Tool" menu.

Figure 5-18: Option to run the update tool

5.5  R&S ROMES4 technology selector

There is a possibility to select RAN technologies out of the R&S ROMES4 supported
ones. Users have to have administrator rights to do such selection.

To select some technologies from the list of available ones:

1. Click "Start" > "R&S ROMES" > "ROMES Technology Selector<version>". Choose
the target version of R&S ROMES4 (if there is more than one version available).

R&S ROMES4 technology selector
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2. Expand the "Tools" subfolder.

3. Launch the application, as shown in the following figure.

Figure 5-19: ROMES Technology Selector

If the main application (R&S ROMES <version>) is active currently, you get the
message.

In this case, you have to close the R&S ROMES4 application and restart the tool.

4. The "ROMES Technology Selector<version>" page looks by default as shown in
the following figure.

R&S ROMES4 technology selector
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Figure 5-20: Technology selection dialog

You can select/deselect technologies which you want to be loaded/not loaded
when launching the R&S ROMES4 next time.

R&S ROMES4 technology selector



R&S ROMES4 toolsDrive Test Software

1443Operating Manual 1171.6415.12 ─ 66

If the "Set All Defaults (and hide...)" flag is checked and you close the dialog by press-
ing "OK", you skip all the initialization dialogs by default settings at the first R&S
ROMES4 start after its installation.
If there is no interaction from you within 1 minute, this flag is set and auto-close is star-
ted giving you another minute to interact.
If you do not react in this next minute, e.g. on an unattended system like TSMA6, the
dialog is closed, inputs are accepted and all subsequent initialization dialogs are skip-
ped. Default settings are used.

Figure 5-21: Settings all initialization dialogs as default

5.6  R&S TSME diagnosis and updates

The R&S TSME Device Manager allows you to do a complete diagnosis of the R&S
TSME device and to perform updates, if necessary.

The R&S TSME Device Manager is available for downloading from the R&S homepage
https://www.rohde-schwarz.com/en/software/tsme/.

After installation, you can run the R&S TSME Device Manager from the Windows
"Start" menu under "R&S TsmeTools".

All new devices are preconfigured and specified technology and band options are
already installed. Only if you obtain additional software options later you have to
enable the options with the corresponding software license keys.

R&S TSME diagnosis and updates
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The R&S TSME scanner option R&S ROMES4T1 supports the following R&S
ROMES4 scanners:
● Chapter 6.4.19, "UMTS PN scanner", on page 1788
● Chapter 6.4.18, "GSM network scanner", on page 1775
● Chapter 6.4.20, "CDMA2000 1xEVDO pseudo noise scanner (PNS)",

on page 1806
● Chapter 6.4.21, "RF power scanner", on page 1823
● Chapter 6.4.25, "WiMAX scanner", on page 1856
● Chapter 6.4.15, "LTE scanner", on page 1726
● Chapter 6.4.22, "TETRA scanner", on page 1837

Software license keys are installed using the R&S TSME Device Manager, in the
"Options" tab. Another tabs provide information on device, network and band configu-
ration and the possibility to update the basic FPGA or the correction data on your R&S
TSME.

Figure 5-22: R&S TSME Device Manager window

R&S TSME diagnosis and updates
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The lower part of the R&S TSME Device Manager window shows the current errors,
warnings and info.

Figure 5-23: Device analysis output

For the complete information on the tool, see the "R&S TSME User Manual".

5.6.1  Obtaining firmware and correction data updates

The R&S ROMES TSME Device Manager is always provided with the most recent
basic FPGA. If a newer one becomes available due to security or functional issues, a
message is indicated in the "Device Analysis Output" at the bottom of the R&S
ROMES TSME Device Manager window. In this case, and only in this case, it is recom-
mended that you install this update on your R&S ROMES TSME.

The correction data on your R&S TSME has always to be kept up to date. Available
updates are also indicated in the "Device Analysis Output" and it is recommended that
you install them.

Risk of inoperability of device due to FPGA update
Before performing an update, make sure you have a stable power supply and the LAN
connection is not interrupted. Both updates take a few minutes.
If the LAN connection is interrupted during an FPGA update, the device can become
inoperable. Thus, only install such an update if it is explicitly recommended by a mes-
sage in the "Device Analysis Output" of the R&S TSME Device Manager or by the
Rohde & Schwarz support center.

You can update the basic FPGA or the correction data on your R&S TSME directly
from the R&S TSME Device Manager, in the "Update" tab. The currently installed ver-
sions and the newest supported version (of the FPGA) or the minimum recommended
version (of the correction data) are indicated.

5.6.2  Automatic firmware updates

Each time R&S ROMES4 is started, the software automatically compares the firmware
version of the connected R&S TSME with the version currently available on the host
PC. If a newer version is available, it is copied to and installed on the R&S TSME. Up
to two previously installed firmware versions are stored as backups and maintained on

R&S TSME diagnosis and updates
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the R&S TSME. Thus, it is not necessary to perform firmware updates on the R&S
TSME manually.

For more details, see the "R&S TSME User Manual", chapter 4.

R&S TSME diagnosis and updates
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6  Hardware Components
This chapter is dedicated to hardware devices, how to connect them and configure to
perform network measurements and analyze provided measurement results.

For all USB devices (most test mobiles and GPS receiversa devices) an additional
Windows driver on host PC has to be installed first.

Device Status
The status of the hardware devices can be observed in the "Views" > "Basic Views" >
"General Status View". The list shows all hardware devices and the amount of currently
produced data. Each hardware device is expected to deliver a certain amount of data
as long as its device is in a good condition. If the currently delivered amount of data
drops below that amount, an error box pops-up, see Chapter 6.3, "Devices observa-
tion", on page 1510. A wave file is available to be played additionally.

● Devices............................................................................................................... 1447
● Automatic reload of mobile devices.................................................................... 1509
● Devices observation............................................................................................1510
● Test devices.........................................................................................................1511
● Quality of service.................................................................................................1880
● Navigation........................................................................................................... 2061

6.1  Devices

The chapter intends to explain how to load hardware devices, how to assign them to a
physical or virtual COM port (e.g. emulated port created by USB adapter). Also is inclu-
ded the possibility of a device removal.

These actions are common for all devices with the following exceptions:
● Loading the R&S indoor device and the QoS tester does not require any hardware

or port assignments.

Devices
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● A PCMCIA slot is used for WLAN cards or/and the UMTS data cards.

The R&S ROMES4 drivers can be loaded into a device which is used for measurement
and analysis in the following ways:
● Using R&S ROMES4 "Devices Manager"
● Using the "Hardware" > "Connect/Disconnect" menu
● Loading the desired configuration file

Loading devices is not necessary if the measurement data is replayed from a measure-
ment file.

Default device template

The Default Device Templateis feature is intended for R&S ROMES4 system adminis-
trators, not for daily users.

Loading a device starts by loading a default template.

The default template loading allows an administrator to populate default settings for the
R&S ROMES4 drivers. Locate the template in the device’s template folder (Current
Users and Application Folder is supported) and name it ~default.xtemplate.

R&S ROMES4 loads the default template if available automatically. Then it checks if
the settings can be used with the actual connected device.

The creator of the default template is responsible for the compatibility of the settings
with the actual used hardware.

This template is not visible in the template page of a device, but can be saved as a
normal template from this page.

6.1.1  Devices manager

R&S ROMES4 offers the "Devices" bar for managing test devices docked to the left
side of the R&S ROMES4 window.

Following test devices are supported:
● Virtual COM Port devices (USB), (most test mobiles and GPS receivers)
● Network scanner devices of TSMX family (R&S TSME/TSME6/TSME6B)

R&S ROMES4 automatically detects those test devices which are detected automati-
cally by the PC operating system. However, the R&S ROMES4 capability automatically
to detect test devices is not applicable to test devices connected via LAN interface.
The R&S TSME family is using LAN interface to connect to the PC.

When a test device is connected to the PC and R&S ROMES4 is running, the R&S
ROMES4 Device Manager automatically performs a rescan and detects the newly con-
nected device.

The R&S ROMES4 Device Manager list is updated automatically.
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To detect the R&S TSME scanners:

1. Connect an R&S scanner to the computer having installed R&S ROMES4 SW.

2. Start R&S ROMES4.

During startup, R&S ROMES4 scans for connected R&S TSMEs. The connected
R&S scanners are recognized and added to the Device Manager list.
Note: If R&S ROMES4 is already running, click the "Rescan..." button to detect the
connected R&S TSME manually.

To load and activate a detected test device:

1. Select the device in the "Type" combo box.

Figure 6-1: Loaded scanners

2. Click the "Connect" button.

The corresponding R&S ROMES4 driver is loaded into the connected device. Once
the test device is loaded in R&S ROMES4 it becomes active and can be configured
according to wanted measurements.

The activated test devices are shown in the upper part of the Device Manager window
and ready for further configurations.

It is also possible to activate test device by right mouse click the selected device. The
context menu opens offering some possibilities, like test device activation with a pre-
configured template, wizard, or a ready-to-use profile (i.e. FTP download).

R&S ROMES4 adapts to the number of devices automatically. The maximum number
of devices is 16, which is an internal limit.

6.1.2  Hardware dialog for loading devices

To load a device, select the "Hardware" > "Connect/Disconnect" menu entry, or simply
load the desired configuration file.
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Figure 6-2: Hardware menu - connect/disconnect devices

Available devices supported by R&S ROMES4 are displayed in the "Hardware Config-
uration" window.

Figure 6-3: Hardware configuration window

The devices are grouped according to their functions.

The order of the groups and devices in a group changes dynamically. The group with
the most accesses is listed on the top. The group of the devices with the most
accesses is visible on the first level in the "Available Devices" pane.

The following table shows devices groups and devices, available at the time of writing.
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Table 6-1: Available device groups and devices

Device group Device

Navigation

(GPS and indoor devices - only one can be loaded
at a time)

Indoor Input

MAVLink

NMEA GPS (most GPS devices)

HE 300 GPS Compass

Simulator GPS (formerly: Dummy device)

R&S TSME GPS

U-Blox (R&S TSMX-PPS) GPS

Mobile Devices

(chipset-based mobiles, WiMAX cards etc.)

Generic Mobile GSM / WCDMA

Samsung Chipset (Phone, 3GPP)

Qualcomm Chipset (3GPP/3GPP2)

Neul Chipset

Sepura Radio

TETRA Mobile via PEI

Quality of Service Data Quality Analyzer

Speech Quality Analyzer

Others BTS Position Estimator

System Information System Information

Network Scanner R&S TSME family R&S TSME 5G NR Scanner

R&S TSME6 LTE C-V2X

R&S TSME LTE

R&S TSME WiMAX

R&S TSME GSM

R&S TSME CW

R&S TSME cdma2000® 1xEVDO

R&S TSME NB-IoT

R&S TSME RF Power Scanner

R&S TSME TETRA

R&S TSME WCDMA

WLAN WinWLAN

The ">" button click or double-click the selected device in the "Available Devices" list
opens the "Assign Ports to <variable>." window. If the ports are assigned to device, it is
loaded and is shown in the "Loaded Devices" pane. The ⃞ checkbox in front of the loa-
ded device indicates that the loaded device is not active. Click the checkbox to activate
it.

The applications "Quality of Service", "System Information", "Others" and the "Naviga-
tion" > "Simulator GPS" available in the "Available Devices" branches are automatically
active when selected for loading.
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Figure 6-4: Loaded and active devices

Click the "Continue" button to let system accept and save the configuration of devices.
The command also closes the "Hardware Configuration" window.

The all loaded devices are then displayed in the "Hardware" menu, which indicates if a
device is in inactive state. Only the loaded and activated devices are displayed in the
"Devices" window which pops-up if you click the "Device" bar on the left-side of the
R&S ROMES4 main window.

Figure 6-5: Windows to see loaded devices
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Now we deactivate the loaded SQA device, for example.

Figure 6-6: SQA is not active

The state of a device is always stored within the workspace file. The following figure
displays the difference of the content of loaded devices in mentioned menu and win-
dow. Inactive drivers are marked in the "Hardware" menu.

Figure 6-7: Windows to see loaded devices and states

For understanding of how devices are connected and interdependent with other devi-
ces we mentiondata quality testers. They are displayed as children of their correspond-
ing mobile devices. If a mobile is removed, its dependent tester is removed as well.
Activating or deactivating a mobile or DQA automatically does the same to its child or
parent, respectively.
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The "<" button removes a selected loaded device from the "Loaded Devices" pane and
accordingly from the previously mentioned menu and window.

More
The loading options for the available devices/drivers are controlled with the functions
contained in lower, the "More" pane of the window.
● "Ask for Templates if available"

If the driver is loaded and this option is checked, R&S ROMES4 looks for related
device templates stored in the driver directory of R&S ROMES4 and displays a list
of the found ones. The device can be loaded with default settings or with the set-
tings stored in any of the templates found.

● "Generate View Areas Automatically"
If checked, R&S ROMES4 automatically generates a view area depending on the
loaded device. After loading one or more devices, R&S ROMES4 displays auto-
matically some view areas with the most important views concerning the loaded
device.

● "Use Device Place Holder for Configuration"
If checked, configures R&S ROMES4 measurement workspaces and mobile devi-
ces, scanners and GPS devices without actual devices attached to a PC on which
R&S ROMES4 is running. See for details Chapter 6.1.13, "Place holder",
on page 1503.

Continue
Confirms the port assignments, loads the device with the configuration settings suitable
for the connected device type and closes the "Hardware Configuration" window.

6.1.3  Connection via COM port

Click "Hardware" > "Connect/Disconnect" to open the "Hardware Configuration" win-
dow. It shows available and loaded drivers.

The left-hand field shows a list of all available devices drivers.

Click ">" button to get the "Assign Ports to <variable>" dialog for assigning a COM port
to the selected device driver, as shown in the following screenshot for generic mobile.

Figure 6-8: Assign ports to generic mobile driver

There is an automatic verification if the COM ports are available. Only free ports are
offered in the pull-down list.
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Assigning COM ports to several drivers can be done by repeating the process via the
"Assign Ports to <variable>" dialog.

The dialog provides the following entries.

Serial Port Assigns a port to the driver to be loaded. Select a port from the pull-down list if the current
assignment is to be changed.

OK Confirms the port assignment and closes the window. The driver previously selected in the
"Available Drivers" list is initialized (loaded) and finally entered in the "Loaded Drivers" list.
The progress of the procedure is monitored in a displayed window.

Cancel Discards the made changes and closes the window.

If the initialization of the mobile driver fails (e.g. because no mobile of appropriate type
is available at the serial port), R&S ROMES4 displays the following message.

Figure 6-9: Unsuccessful loading of the driver

In this case, check the connection and verify if the correct port has been selected.

It can be necessary to add one driver type several times, for example, if several
mobiles of the same type are used. A number in brackets displayed behind the device
type denotes the number of allowed drivers. Several different ports can be assigned to
a same mobile driver.

6.1.3.1  NMEA GPS

R&S ROMES4 drivers check the COM port name during the automatic driver detection.

The NMEA GPS device supports by default the most common GPS names. However,
some special system setups can result in different COM port names.

These port names can now be specified in an XML file which is read by R&S
ROMES4. The content of the file is then added to the internal list of COM port names.

Locate the XML file in the My Documents\My ROMES\Configuration
\NMEA_COM_Ports.xml folder.

The content is a list of port names,

<?xml version="1.0"?>
<COMPorts>
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   <COMPort Name="serial port emulator" />
   </COMPorts>

6.1.3.2  Splitter box (mobiles supporting GPRS)

The test mobile devices which support GPRS measurements must use a splitter box.
This additional device is connected to the mobile and to the power supply.

The splitter box separates the trace and data interface of a mobile. The trace interface
corresponds to the normal GSM test mobile mode except GPRS. The data interface
represents an extension that is used for GPRS data transfer. Three different modes
can be set at the mobile.
Table 6-2: Trace interface modes

Trace Route the trace interface to "SL1"

Data Route the data interface to "SL1"

Trace/Data Route the data interface to "SL1", the trace interface to "SL2"

The two outputs "SL 1" and "SL 2" of the splitter box can then be connected to two
separate COM ports. The COM ports can be assigned in the "Assign Ports to ..." after
the "Use Splitter box ..." option is checked.

GPRS test mobiles from Qualcomm can be connected via USB interface, see Chap-
ter 6.1.4, "Connection via USB interface", on page 1456.

These special COM ports are only available as long as the mobile is connected to the
PC and powered on.

6.1.4  Connection via USB interface

Most of the test mobile devices are connected to a host PC via USB port/cable using
an appropriate driver. Physical COM ports are not needed. The USB drivers are
already pre-installed on controllers from Rohde & Schwarz.

Support of Rich Communications Service (RCS)

To boot a test mobile device if connected to the USB port, the following setting has to
be configured on the device:
● adb shell
● su
● setprop persist.sq.autoboot 1

6.1.4.1  Installing the USB drivers

The USB drivers are mobile-specific and located in the subdirectory on the R&S Smar-
tONE installation data package.
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To install the driver for your test mobile device:

1. Go to the relevant subdirectory related to your test mobile type.

2. Follow the instructions in the Readme.txt files or in the Readme.pdf installation
instructions.

During the installation, MS Windows creates the necessary number of virtual COM
ports and attaches them to the test mobile devices.

Many mobile devices require more than one virtual COM port (Qualcomm chipset-
based test devices).
Do not run R&S ROMES4 while installing drivers for such devices. R&S ROMES4
automatically detects device after installing the first virtual COM port, but the device
cannot be used by R&S ROMES4 until all ports are available. To avoid the confusion,
the driver must be fully installed before starting R&S ROMES4.

6.1.4.2  Loading the USB drivers

Once the USB drivers are installed on the system, they can be loaded to mobile device
following the procedure outlined in Chapter 6.1.3, "Connection via COM port",
on page 1454.

One of the virtual COM ports created during the USB driver installation can be
assigned to the 1st port (data interface), the 2nd port (AT interface) and the "Modem
Port" (data interface). The three virtual COM port numbers must be different.

The second port is optional but is required for autodialing. Assign always all three
ports.

The operating system does not reliably delete unused virtual COM ports if USB devi-
ces are connected and disconnected repeatedly. Delete redundant USB ports using
the Device Manager if a large number (30 or more) of ports has been created. To
access the Device Manager, choose the Windows "Start" > "R&S ROMES" > "Device
Manager<version>" option.

6.1.4.3  NDIS interface

To use the NDIS interface, select the "NDIS Interface" option in the "Assign Ports to
<variable>" dialog. R&S ROMES4 searches for available NDIS interfaces on the host
PC. If at least one NDIS interface is found, the NDIS option gets active. You can select
the desired NDIS interface in the "NDIS" combo box.

If there is no NDIS interface available, the message that NDIS interface is unavailable
is displayed and the options for the NDIS interface is grayed out.
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Connect mobile from the device tree
A mobile is loaded without an available NDIS driver if the loading is made from the
device tree via "Connect" or "Connect with Wizard".

Option data cards

Qualcomm option data cards

The R&S ROMES4 driver for Qualcomm chipset-based devices supports the NDIS
interface called GTNDIS.

The DQA "Connect to Network" job offers this interface using the DQA Dialup option.
For the job, refer to Chapter 6.5.1.4, "Configuration menus for the DQA jobs",
on page 1891.

Figure 6-10: Assign ports to Qualcomm chipset-based device

Samsung option data cards

The R&S ROMES4 driver for Samsung chipset-based devices does not support NDIS
interface.
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Sierra Wireless AC875 PC card

The NDIS interface supports the Sierra Wireless AC875 Edge/UMTS PC card. Unlike
the Option Card, the Sierra Wireless NDIS interface does not support AT Commands.
For this card, specify a modem port to be able to communicate with the card, see the
previous figure.

Select "Sierra Wireless DM Port" and "Sierra Wireless AT Command Port" if using
NDIS. Ensure that the Watcher is not running during the R&S ROMES4 session.

Sierra Wireless NDIS update

The R&S ROMES4 supports Sierra Wireless devices drivers for the latest NDIS ver-
sion. It is highly recommended to update the drivers for the device at least to version
6.20.0.18. The version is displayed by the Sierra Wireless Watcher in the "Info" dialog.

6.1.5  Network cards with MS Windows

If a network data card is connected to a measurement device (laptop or PC) running on
MS Windows operating systems, the mobile drivers can recognize the network card as
device. After recognizing the device, the drivers provide this information to R&S
ROMES4.

The information is necessary for the use of Windows Mobile Broadband with DQA.

If connected, the network card is then displayed in the "Devices" window docked on
the left side of the R&S ROMES4 window. If the device appears, it can be loaded via
"Hardware" > "Connect/Disconnect" and is available in the DQA Connect job.

The major advantage is that R&S ROMES4 checks for NDIS support apart from detect-
ing modems. R&S ROMES4 shows the capabilities of all detected devices under the
"Settings" of the "DQA Connect" job. You do not need to click the NDIS radio button to
find out whether NDIS is supported by the card.

Device assignment
The assignment of devices such as modems, serial ports and network cards depends
on MS Windows Registry entries. The algorithm is complex and is based on undocu-
mented key properties. Possibly, it does not work with all devices which are currently
available. If the network card is not assigned correctly to the mobile device, contact the
Rohde & Schwarz customer support.
Successful tests were made with several devices from Huawei and Sierra Wireless.
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MS Windows can support multiple cards
Systems using MS Windows and R&S ROMES4 version 4.63 (or later), can use sev-
eral network cards.
Furthermore, the MS Windows Mobile Broadband function automatically checks for
NDIS functionality and offers it in the "Settings" dialog of the "DQA Connect Job".

6.1.6  Improvements of mobiles handling

6.1.6.1  Mobile device connection

The ADB ID and IMEI are stored to the workspace together with the used COM ports.
Their port numbers are only used to reconnect to the mobile device when the work-
space is loading.

While loading a mobile device, R&S ROMES4 checks first if the ADB ID is available,
then checks the IMEI availability. If the driver finds the ADB ID or IMEI in the set of
available devices, it takes the COM port numbers of those devices to connect.

Only if both are not found, the driver tries to connect to the COM port number of the
workspace.

6.1.6.2  Mobile device connection to DQA

If available, the ADB ID is used instead of IMEI to identify the connection between the
Qualcomm chipset-based devices and a Data Quality Analyzer (DQA). The same iden-
tification applies for the smartphones using Samsung chipset-based devices connec-
tion to DQA.

6.1.6.3  Using multiple mobiles

If the measurement setup requires more than four mobile devices, open the "Overview
Views" automatically. Check the "Generate View Area Automatically" and "Overview
Views only" checkboxes in the "Tools" > "Preferences" page.

6.1.6.4  Loading fully integrated devices

By launching the SmartONE, R&S ROMES4 connects the fully integrated mobile devi-
ces (UE in further text) without the necessity for external diagnostic ports. The
approach matches the one in Smart Benchmarker. It means that the trace information
from diagnostic ports is internally routed through the UE and transferred to R&S
ROMES4 via ADB Interface.

This approach has lots of benefits, such as:

- Only ADB (classic Qualcomm/Samsung) drivers are needed to connect the fully inte-
grated devices to R&S ROMES4.
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- Operation approach as in Smart Benchmarker.

- Faster and easier setup time for the SwissQual (SQ) fully integrated devices.

- More operation stability without need for the stable diagnostic ports (especially for 5G
UEs with two diagnostic ports).

- Devices with external diagnostic trace need open diagnostic ports.
- On PC testing (Classic mode) use mode is not available for SQ fully integrated devi-
ces.
- Fully integrated device + GPS use mode is only available if "Offer GPS for QualiPoc
Devices" is activated in "Performance" > "Advanced Settings".

R&S ROMES4 checks the installed QualiPoc (QP) version of a fully integrated device
like it is done for a device with external diagnostic trace. If R&S ROMES4 SW brings
the newer QualiPoc version compared to the one installed on the device, R&S
ROMES4 outputs the question if the device has to be updated.

After having loaded a mobile device as fully integrated device via the "Welcome" page,
the configuration page of the associated QoS tester opens automatically (default). All
the device's configuration tests are integrated in the QoS tester.

The SQA section added to a device's welcome page shows if the device makes MOC
or MTC and the current MOS value.

Figure 6-11: Layout of the SQA section added to QoS tester

An SQ fully integrated device can be loaded via the "Hardware" > "Connect/Discon-
nect" dialog if you for any reason do not want to load it from the "Welcome" page. Both
Qualcomm and Samsung Exynos chipset-based mobile devices support this possibility.

By default, the already detected devices are loading directly from the opening "Wel-
come" page.
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Figure 6-12: Connect device dialog for Qualcomm UE

Figure 6-13: Connect device dialog for Samsung UE

If the connection via COM port is required, choose the "COM Port Connection" port
assignment.

6.1.6.5  Identification of fully integrated devices

R&S ROMES4 displays the connected and loaded fully integrated mobile devices
(QualiPoc) with a dedicated symbol in the "Available Devices" part of the "Welcome"
page.
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The following screenshot displays the QualiPoc devices connected to R&S ROMES4 in
the list of available devices after their loading. The symbols associated with the availa-
ble devices indicate their maintenance status, see "Handling a maintenance period of
fully integrated mobile devices" on page 1464.

Figure 6-14: Available fully integrated mobile devices

The symbol of the QualiPoc devices changes when they become available in compari-
son to the symbol when they are connected but not yet loaded.

The configuration page of a fully integrated device contains the "QualiPoc Settings" tab
to identify it.

Click the tab to open the dialog. The device's name is displayed for one second in the
"Unit Name" box. The displayed names help handling more devices connected to R&S
ROMES4.
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Figure 6-15: Mobile identification

Handling a maintenance period of fully integrated mobile devices

R&S ROMES4 implements the strict enforcing which prevents the application to run on
fully integrated mobile devices (QualiPoc) when out of maintenance period. R&S
ROMES4 warns you on time about a maintenance period expiry.

R&S ROMES4 detects the maintenance period of a QualiPoc device and provides an
indication in the "Welcome" page using the device's symbol.

The symbol of the available QualiPoc fully integrated mobile device changes when its
license of maintenance period is going to expire or has already expired. These symbol
changes serve as warning and error messages, respectively. The warning symbol is
shown the first time 90 days before the expiration date. The three possible mainte-
nance states of the QualiPoc fully integrated mobile devices and the associated sym-
bols are displayed in the following figure.

Figure 6-16: Symbols displaying the status of the maintenance period

6.1.7  Qualcomm mobile wizard

If a device is connected via Qualcomm device driver, R&S ROMES4 requires some
basic information about it. R&S ROMES4 has a large database which holds this infor-

Devices



Hardware ComponentsDrive Test Software

1465Operating Manual 1171.6415.12 ─ 66

mation for many different mobile devices. However, new devices are introduced more
and more frequently.

It is possible to add new mobile devices to the R&S ROMES4 database with the Qual-
comm wizard.

A mobile device information can be added to an external database which is an XML
file. To enter the information, it is necessary to edit the XML file and add the data man-
ually. The information about new Qualcomm chipset-based devices is entered auto-
matically with the Qualcomm wizard.

Whenever you connect a Qualcomm chipset based mobile device which cannot be rec-
ognized by R&S ROMES4, the wizard pops up.

Follow these steps to integrate a new Qualcomm chipset based mobile device into
R&S ROMES4.

1. Ensure that all necessary COM ports (diagnostics and modem port) are available.
Usually, the ports are opened for data cards but some mobiles need a special code
for the cards.

2. Connect your device to the computer.

3. Start R&S ROMES4.

4. Open the "Load Hardware" dialog ("Hardware" > "Connect/Disconnect").

5. If R&S ROMES4 cannot find the COM ports associated with the device, check the
"Show all COM Ports" box.

6. Select the diagnostic and modem ports of the device.
For diagnostic port configuration, see "Device Configuration" on page 271. The
handling of the diagnostic port per IP connection is so that R&S ROMES4 recon-
nects to the device, if for any reason the IP connection is disconnected during the
measurement.

7. Click "OK".

8. If the connected device cannot be found in the database, as mentioned, the wizard
pops up.

9. The first appeared dialog provides some basic information which the device read.
Click "Next".

10. The next dialog requests information on technologies that the device supports.
Select the appropriate entries from the "3GPP" and "3GPP2" sections.

Note: R&S ROMES4 automatically reads out the HSDPA category from the RRC
connection setup message during a measurement. This information is used by
default. If RRC connection setup is not available, the HSPDA category specified
here is taken.
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11. The next dialog requests the information about the setup of the circuit switched
calls. If you do not intend to initiate the circuit switched calls with the device, select
"CS not supported".
The option "Keyboard Emulation" means that R&S ROMES4 sends commands for
pressing the keys on the keypad to the device. The devices which have real key-
pad usually do not support these commands. If you select this option, you see the
dialed number in the display of the mobile device.

Using this option you can specify two additional parameters:
● Increase the pause between by pressing the keys if the device does not dial

the given number correctly.
● Increase the Interface

Pause before answering if the device does not answer incoming calls correctly.
This case can happen in devices which have to change the user interface
before making possible to press the answer button.

The option "AT Commands" is suitable for data cards, which allows you to initiate
circuit-switched calls.
Click "Next" to continue.

12. Now R&S ROMES4 tries to detect automatically:

● NDIS interface, if available.
● Extended AT command set, if available. To force the device to a specific RAT,

you need the command set.
● Information how to handle the PIN.

After the auto-detection has finished, a dialog window appears. It shows the results
of this process.

13. In the dialog window, decide if to use the detected features. For example, if you do
not want to use the NDIS interface, select "none (use Dialup Network)".
Click "Next" to continue.

14. The next dialog displays the name that R&S ROMES4 assigned to that device. It is
still possible to adapt the proposed name.
The other two edit fields show the names of the diagnostic and modem ports. It is
still possible to change these names, but usually it is not necessary.
Click "Next" to continue.

15. A summary window opens and displays the configuration that is stored into the
external database. Click "Finish" to finalize the setup of the new device.

R&S ROMES4 tries to load the device using the information that was added to the
external database.

If the new device is configured well and the information is successfully added to the
external database, the added Qualcomm chipset-based device is loaded success-
fully in R&S ROMES4.

Devices



Hardware ComponentsDrive Test Software

1467Operating Manual 1171.6415.12 ─ 66

6.1.8  Qualcomm chipset based mobile devices

It is possible to install some updates which allow R&S ROMES4 to recognize Qual-
comm chipsets-based mobile devices.

If integration of a new device into R&S ROMES4 is required, the procedure is per-
formed in the following steps:

1. MS Windows drivers offering access to the Qualcomm diagnostic and modem ports
have to be available.

2. Send the device to Rohde & Schwarz.

3. The Rohde & Schwarz personal tests the device with the latest released R&S
ROMES4 version.

4. If no technical problems occur, an installation setup is created within a short time
frame. This setup is published to all customers.

5. In the rare case when the device reports new log versions, the R&S ROMES4 has
to be adapted and tested carefully. In this case the device is integrated with the
next R&S ROMES4 version.

6. All integrated devices are automatically the part of the next R&S ROMES4 version.

The list of the supported Qualcomm chipset based devices is created.

The list of supported devices based on Qualcomm chipsets is composed of three parts:
● Internal hard-coded list of the R&S ROMES4 Qualcomm driver
● Users list, created by the Qualcomm wizard, see Chapter 6.1.7, "Qualcomm mobile

wizard", on page 1464 for the wizard
● List of also installed UEs

To get the actual composed list of supported UE, click "Help" > "Loaded Modules" in
the R&S ROMES4 toolbar. The "Available Options" window displays all the loaded
modules and associated information as well as the found licenses and sales options.

Figure 6-17: Loaded modules

Select the "Qualcomm:QC" line and press the "Detailed Information" button. The pop-
up dialog displays the list of the supported Qualcomm chipset based devices.
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Figure 6-18: List of supported Qualcomm devices

The "Export list to CSV file" button lets you save the list of supported mobiles to a
*.csv file.

6.1.8.1  Connecting Qualcomm chipset based mobiles

The supported Qualcomm chipset-based devices are the composite mobile devices
which require two virtual COM ports.

Connect the test mobile device to the USB port of the PC to load it. Once the USB driv-
ers are installed on the system, they can be loaded to mobile device following the pro-
cedure outlined in Chapter 6.1.3, "Connection via COM port", on page 1454. If one of
the Qualcomm chip-set based device is loaded, R&S ROMES4 opens the page shown
in Figure 6-10.

During loading, the MS Windows enumerates the device which is necessary to add it to
the USB mobile device internal list.

Certain mobile device types cannot be numerated during loading. The previously refer-
red page contains the "Use Internal Mobile List" combo-box and the "Expot List" button
in the "Mobile Recognition" pane.

These two options in the pane are function as following:
● "Use Internal Mobile List"

If unchecked, the internal mobile list is ignored while assigning the COM ports to
Qualcomm chipset-based mobile devices.
The option is used to force opening of the mobile wizard to integrate a new mobile
type. This integration is necessary if the internal mobile recognizes a wrong type.
Once the wizard integrates the new mobile successfully, it is not necessary to
ignore the internal mobile list anymore. The list created by the wizard is always
checked before the internal list.
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● "Export List"
Press the button to export the list of supported mobiles to a *.csv file.
(*) Category 1 means that the mobile is permanently used for tests, Category 2
means that the mobile was tested successfully at least once.

Parallel loading of Qualcomm chip-set mobile devices

The Qualcomm chip-set mobile devices can be initialized and loaded in parallel if you
add the registry key HKEY_CURRENT_USER\Software\Rohde &
Schwarz\Romes<version>\General\AllowParallelQCInit and set its value
to 1. This setting decreases significantly the loading time of a workspace with many
Qualcomm chipset-based mobile devices,

Figure 6-19: Adding QC registry key

If you load a device from scratch, you still have to do it one by one.

The feature is intended for experienced users only.

6.1.8.2  MAC CE UL analysis support

R&S ROMES4 supports display of the evaluated MAC control elements (CEs) in uplink
direction of Qualcomm chipset based mobile devices. Displayed is the current uplink
buffer status per logical cell groups and the power headroom for LTE and 5G NR UEs.

The signals which visualize the MAC CE uplink data are included in the "Signal Tree"
>"LTE UE" > "MAC CE UL" branch for LTE UEs and in the "Signal Tree" > "5G NR UE"
> "BSR Buffer Status"/"Power Headroom" branches for 5G NR.
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For the signals description, see the "Description of R&S ROMES4 Supported Signals"
document.

6.1.8.3  Qualcomm MTP 5G NR mobile support

R&S ROMES4 supports the Qualcomm form-factor Mobile Test Platform (MTP) for 5G
NR.

The MTP allows the 5G test user insight to standards-compliant 5G NR testing before
the commercial devices are ready for testing. The R&S ROMES4 support lets you ach-
ieve test data from a 5G NR network.

Use the three installed widget templates as a starting point for setting up a 5G NR grid
view, see "Templates" on page 512.

Connecting the Qualcomm MTP 5G NR mobile

The Qualcomm chipset-based devices offer two diagnostic ports. The MSM port is the
port for LTE chip, the MDM port is the port for the 5G NR chip. As the R&S ROMES4
supports dual port recording, the SW logs in parallel the trace output of both chips.

Figure 6-20: Available COM &LPT connections

The MTP 5G NR mobile is recognized automatically by R&S ROMES4. It can be con-
nected to R&S ROMES4 either by a double-click the "Welcome" screen or using the
"Hardware" > "Connect/Disconnect" dialog.

If using the dialog, be sure to select the MSM port as the main diagnostic port, and the
MDM port as the secondary one. The secondary port supports 5G NR logs only.
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Figure 6-21: Selection of the ports for MTP

The MTP mobile devices can be used as fully integrated devices and On PC testing
(Classic mode) devices.

The diagnostic ports can get unstable. In this case, reboot the MTP.

6.1.8.4  PMI evaluation support

Qualcomm chipset-based UE reports PMI to BTS. With the PMI feedback, the UE can
report its preferred codebook configuration.

The PMI reports are used in 5G NR by gNB for beamforming and MIMO management
when larger antenna configuration, e.g. 64 transceiver active antenna, is used. The
gNB is, according to 3GPP specifications not obliged to apply the UE preferred precod-
ing to PDSCH. However, the PMI can be an important input to the beamforming algo-
rithms.

Dependent on the content of gNB RRC configuration message, the UE can include
PMI in the CSI reports sent on PUSCH/PUCCH. The PMI values represent a beam
and phase shift selection of a virtual antenna that has a layout described in the CSI
report configuration Layer 3 IE.

For the Qualcomm chipset-based mobile devices, R&S ROMES4 derives the reported
PMI values for Type I Single Panel codebook (i11, i12, i13 and i2) and implements
them. The values are visible in the "5G NR TTI View" and are available as R&S
ROMES4 signals. For details, see "Evaluated PMI displayed in the view" on page 872.
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The Type I Single Panel codebook is configured using the CodebookConfig within the
CSI-reportConfig. The "codebookType" must be set to ‘Type1’, while the subtype must
be set to ‘TypeI-SinglePanel’.

This R&S ROMES4 feature is rated as an expert feature. It requires some insights into
the 3GPP specifications. Refer to 3GPP 38.214 or https://www.sharetechnote.com/
html/5G/5G_CSI_RS_Codebook.html for more details and information about precod-
ing, codebooks and PMI reporting in 5G NR.

6.1.8.5  Mobile devices use mode

The following modes to use a mobile device with R&S ROMES4 are available:

● Fully integrated device / fully integrated device plus GPS use mode
Devices with SwissQual (SQ) Flash (QP mode), loaded as QualiPoc. Such device
is used in R&S ROMES4 DQA tests in QP mode.

● Device with external diagnostic trace
Fully integrated device with the external diagnostic trace, loaded as QualiPoc.
Such device is used in R&S ROMES4 DQA tests in QP mode.

● On PC testing use mode
– Classic mode

Device loaded without QualiPoc. Such device can execute R&S ROMES4 DQA
tests.

– Classic mode 2
Classic mobile / IoT device Qualcomm chipset-based and loaded without Quali-
Poc. Such device can be used for DQA tests only in Classic mode 2, meaning
that network adapter needed.

The "Select Mobile Use Mode" dialog lets you select among the supported use modes.

Figure 6-22: Mobile use modes
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The following screenshot displays the hardware configuration dialog of the Qualcomm
chipset-based mobile devices configured in fully integrated use mode.

Figure 6-23: HW settings of Qualcomm mobile

If Qualcomm chipset based mobile device is loaded in On PC testing (Classic mode)
use mode, the device configuration dialog contains the "IP logging" tab. This tab and
its configuration page are not available if a device is configured in fully integrated
device mode.

Fully integrated device use mode with or without GPS makes the MOS speech quality
measurements with POLQA and SQUAD possible. For the available DQA jobs in this
mode, see Chapter 6.5.2, "DQA jobs with Android OS-based smartphones",
on page 1961.

To use Samsung chipset based mobile devices in On PC testing (Classic mode) use
mode, you need a license per system and a device license per connection.

6.1.8.6  Mobile devices without QualiPoc

The Classic mode 2 is available for selection as the use mode of non-QualiPoc sup-
porting mobiles.

The Classic mode 2 is used to load the non-QualiPoc mobiles. This use mode offers a
special set of QualiPoc tests performed on computer.

If loading such a mobile, select the wanted use mode in the "Select Mobile Use Mode"
dialog.
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Figure 6-24: Dialog to select use mode of non-QualiPoc mobiles

The Classic mode 2 is supported only by devices with Qualcomm chipset.

For supported DQA jobs, see "DQA jobs in classic mode 2" on page 1969.

6.1.8.7  Data and speech quality test on fully integrated devices

To run data and speech quality tests needed is a fully integrated device.

If data or speech quality tests are defined, a QualiPoc measurement starts on the
device. The results of the tests are transferred at once to R&S ROMES4 and stored in
the measurement file.

Running data and speech quality test on a mentioned device type prevents configura-
tion of other DQA jobs. If configured, those jobs fail.

Prerequisites

● A smartphone must have installed Android version 7 or higher to work in fully inte-
grated device use mode (QualiPoc application installed). The smartphones with an
Android version 6 or lower can be used as On PC testing (Classic mode) devices
only.

● The version of QualiPoc application must be the same as the R&S ROMES4 ver-
sion with a valid license.

● Do not install mobile tools like Samsung Kies or HTC Sync Manage on PC. Other-
wise, the problems with the ADB connection occur.

● DV-SMP-RF and DV-SMP-QA are not supported anymore, corresponding DV-RF
or DV-QA are required.

OTA update of QualiPoc versions

A QualiPoc OTA update can be started by R&S ROMES4.
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The R&S ROMES4 software checks if a QualiPoc version on a loadable mobile is sup-
ported by R&S ROMES4. If the version is not supported, the icon of the mobile on the
Welcome page has a warning marker.

After loading such a mobile, an update dialog appears letting you select a version to be
installed.

Figure 6-25: QualiPoc OTA update dialog

To install the selected QualiPoc version:

► Double-click the selection or click the "Update" button.

The progress of the installation process is displayed in the status line of the dialog.

The "QualiPoc OTA Update" dialog disappears, meaning that the installation was
successful.
The connection to a mobile having QualiPoc app installed is lost now, because
QualiPoc is closed and the mobile is rebooting.

R&S ROMES4 closes and restarts.

It is possible to look for updates in the "QualiPoc Settings" > "Version Info" pane, see
Figure 6-29.
Click the "QualiPoc Settings" > "Update QualiPoc Version" button to get the updated
dialog for QualiPoc versions.

Test call to any number by fully integrated device

R&S ROMES4 supports the QualiPoc test call to any number.
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If a mobile device is loaded in fully integrated device use mode and "Action" > "Dialing"
in the "Auto Dialing" page is checked, the QualiPoc performs autodial function.

Figure 6-26: Dialing activated in simple mode

If the auto dialing function is set to "External", the "Constant call pattern" and "Endless
call" options are unavailable in the "Auto Dialing" page. The test call to any number has
always a constant call pattern.
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Figure 6-27: Dialing activated in extended mode

Network forcing in fully integrated device mode

The mobile devices in fully integrated device use mode support network forcing for
3GPP defined RATs. R&S ROMES4 takes care of forcing states. The settings in the
"Network Forcing" dialog are loaded to device when the dialog closes.

R&S ROMES4 supports advanced cell forcing for 4G and 5G mobile devices,

A cell EARFCN and PCI parameters for 4G mobiles advanced forcing is mandatory.

If the 5G forcing is selected, the following parameters for 5G mobiles advanced cell
forcing can be defined:

● "NARFCN" - 5G NR ARFCN
● "PCI" - Physical Cell ID
● "Band" - a list of 5G bands available for this device
● "SCS" - subcarrier spacing in kHz

The 5G NR network forcing on fully integrated devices with SwissQual flash is suppor-
ted by R&S ROMES4 if forcing is supported by a mobile itself.
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Figure 6-28: QualiPoc forcing dialog

The R&S ROMES4 5G network forcing function supports bands that are available in
"Band" drop-down box.

Common QualiPoc settings

A device in fully integrated device use mode is set in the "QualiPoc Settings" dialog.
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Figure 6-29: QualiPoc settings dialog

Unit Name
A name assigned to a device configured in fully integrated device use mode used for
its identification.

Power Settings
Power setting is read from a device. 

Min. Battery Level [%] ← Power Settings
The minimum battery level a QualiPoc campaign starts with.

Auto Power On ← Power Settings
If check, starts device automatically if connected to USB power.

Auto Power Off / Delay ← Power Settings
If checked, a device automatically shuts down within the "Delay" defined time if the
connection to USB power is lost.

Wait time after DQA Data Jobs [s]
The time to wait after a QualiPoc data test. A wait time after the test is necessary to
catch all IP data relating to this test.

Idle Time after a DQA Session [s]
The idle time the execution of a DQA job list.

Idle Time a Voice Call Session [s]
The idle time after the execution of a voice call session (speech quality measurement).
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Idle Time after Multi RAB Session [s]
The idle time after the execution of a Multi RAB session (combined speech quality and
data test).

WiFi Usage
Sets the WiFi usage at the start of measurement.

Time Synchronization
If the "ROMES" option is selected, a time synchronization is done between R&S
ROMES4 and a mobile device operating in fully integrated device use mode.
If NTP is selected, at least one NTP server must be specified. A data connection must
be activated at the mobile.

Figure 6-30: Time synchronization with NTP

By default, the time synchronization is disabled.

Accesspoint
As mobile devices in fully integrated device use mode do not allow the write access to
the access points, there is only the possibility to select an existing access point. The
selection is done in the "QualiPoc Settings" > "Accesspoint" pane.
Select an existing access point for your fully integrated device from the "Name" combo-
box out of all defined access points.
The access points must be created/modified in the device's Android settings.

Location Provider
There are two modes available to locate mobile device position:
● Internal GPS
● Fused Location Provider

If "Fused Location Provider" is selected, the Android interface provides the best
available location out of all available providers, that is, WiFi, GPS and mobile net-
works. Prerequisite is that the mobile device is loaded as fully integrated with
active GPS.

IP Tracing
The configuration for PCAP logging, which includes enabling and defining the snap
length, is available on a session level. The PCAP logging on the session level makes it
possible to distinguish between data tests. There are tests for which PCAP recording is
important (for example, browsing, single file DL/UL). However there are tests which are
irrelevant and produce too much data (for example, capacity test).
Check the "Enable PCAP Recording for all Sessions" box to activate IP tracing, see
Figure 6-29.
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If the "Enable PCAP Recording for all Sessions" is selected, PCAP files are created for
each session in the measurement.
● "Snap Length": Length of the packet snap-shot in Bytes.
● "Max File Size [MB]": The maximum files size of PCAP file. A file size is unlimited if

the value is set to 0.
The "Enable PCAP Recording" option is grayed out if a device with external diagnostic
trace is used as fully integrated device.

Copy QualiPoc Log Files
The button to copy QualiPoc log files. The files are copied to a subfolder of MyROMES
\Logfiles.
If the QualiPoc installation crashes, the coped log file can help to analyze the cause of
crashes. By finishing the copy operation, a message box appears providing information
on where the files are copied to.

Figure 6-31: Location of the copied QP log file

Cleanup QualiPoc Result Folder
If clicked, the "Cleanup QualiPoc Result Folder" tab deletes the files of the result folder
in a mobile phone. The action is recommended if there is not enough disk space on the
phone.

Update QualiPoc Version
Click the "Update QualiPoc Version" button to update the dialog of QualiPoc versions,
see Figure 6-29.

6.1.8.8  QualiPoc on devices with external diagnostic trace w/o SQ flash optimizer

Mobile devices with Android operating system (OS) can be loaded as fully integrated
devices even if they do not have the SQ Flash Optimizer. The supported operating sys-
tem has to be Android version 7 or higher.

If such a mobile device is loaded for the first time, you are asked if to install the Quali-
Poc application on it.

If you select the "Install QualiPoc" option, the QualiPoc application is installed on the
device, but the device's driver is not loaded, as the installation requires a reboot of the
device.
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The mobile device is operational as fully integrated device after next R&S ROMES4
restart.

Figure 6-32: Support of QP for devices with external diagnostic trace

The devices with external diagnostic trace support some basic QualiPoc jobs, for
example, FTP Up-/Download, HTTP Transfer, Ping and Capacity Test.

Performing MOS speech quality tests with POLQA or SQUAD requires license.

During the QualiPoc chipset-based mobile device loading with an external diagnostic
trace in R&S ROMES4, the SQUAD drivers and libraries are installed along the device
loading process. The driver installation together with the availability of the SQUAD
license is necessary to perform the speech quality tests with MOS based on SQUAD.

6.1.8.9  IP socket connection with Qualcomm chipset based mobile devices

The R&S ROMES4 supports IP sockets for connecting the Qualcomm chipset-based
devices (cards, mobile hotspots, for example the Netgear Aircard AC810) to it. The IP
address and the port number depend on the device type.

To connect such a device to R&S ROMES4 via IP socket, proceed as follows:

1. Click "Hardware" > "Connect/Disconnect".

The "Hardware Configuration" page pops-up.

2. Click the "Qualcomm Chipset" option in the "Available Devices" > "Mobile Devices".

The page to connect Qualcomm chipset-based devices pops-up.
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Figure 6-33: IP socket connection

3. Check the "Socket Connection" option.

4. Specify the IP address and port number of the device in the active "Socket Link"
pane of the page.

5. Click "OK" to complete the procedure

The device is connected to R&S ROMES4 via IP socket.

6.1.8.10  IP logging with Qualcomm chipset based mobiles

The R&S ROMES4 "Qualcomm Chipset" option supports direct IP data logging with a
device using On PC testing (Classic mode) operation mode.

The "IP Logging" tab of a device configuration page lets you switch on this function.
The configuration page is visible only if the mobile is connected in On PC testing (Clas-
sic mode) operation mode.

Figure 6-34: IP logging configuration
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The whole IP traffic of a phone is logged without need of some additional tool. Check
the "Max. Packet Length (SnapLen)" box if you want to limit the maximum size of the
IP traffic to be logged.

The IP traffic is logged as a *.pcap file into the same folder where the measurement
file is written. The file name has the following format
<measurementname>.rscmd<devicename>_Date.pcap.

The file can be opened by Wireshark already during the measurement.

Example: 
The VoLTE tracing is logged as Measurement.rscmd.SM-G900F[1]_VoLTE.pcap.
The eMBMS tracing is logged as
Measurement.rscmd.SM-G900F[1]_eMBMS.pcap.

The IP logging can influence significantly the maximum achievable data throughput.
Therefore, it is highly recommended to switch off the logging when KPI measurements
are running.

The IP logging is done at best effort. It can happen, that not all packets are logged.

6.1.9  Samsung Exynos 5G chipset-based mobile devices

Starting from the version R&S ROMES4 19.0 SP1, R&S ROMES4 supports the Sam-
sung Exynos 5G chipset-based mobiles devices.

Since EN-DC relies on both LTE and 5G operating in NSA mode, two diagnostic ports
are needed.

The Samsung Exynos 5G mobile devices have two diagnostic ports like the Qualcomm
based devices.
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Figure 6-35: Exynos chipset-based devices - assign ports dialog

It is possible to connect the Samsung Exynos chip-set based mobile devices per IP
socket.

1. Click the "Hardware" > "Connect/Disconnect" command in the R&S ROMES4
page.

2. Select the "Mobile Devices" > "Samsung Chip Set (Phone)" branch in the "Hard-
ware Configuration" dialog.

The "Assign Serial Port" dialog pops-up where you can select the diagnostic ports.

3. Select the "IP Connection" in the "Assign Serial Port".

4. Define the IP address and the port number in the "IP Connection" pane.

5. Click "OK" to complete the connection procedure

If you select "Com Port Connection" instead, check the "5G NR Port" box to activate
the second port.

The Samsung Exynos 5G chipset-based mobile devices provide statistics on:
● Serving cell
● PRACH/RACH
● PDSCH/PUSCH
● Layer3
● RLC/MAC layer information, for example, the throughput values

There is a difference between the 5G available signals provided by the Qualcomm and
the Samsung Exynos chipset-based mobile devices. For a detailed overview of the dif-
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ference between them related to supported signals, a comparison is provided and
documented on R&S Sales Web. Also, see the "Qualcomm v.s. Samsung chipset-
based terminals" document.

6.1.9.1  Exynos SIP analysis

The R&S ROMES4 "Samsung Chipset" driver allows you to force SIP tracing using the
R&S ROMES4 SIP Analyzer for devices with external diagnostic trace.

Any IP port can be used for the SIP analyses if the "Use all IP Ports for SIP Message
Tracing" option is checked. A port setup of VoLTE and VoNR becomes easier in this
way.

Figure 6-36: Activating SIP analysis

Do not use the R&S ROMES4 SIP analyzer in parallel with high-speed data measure-
ments.
The SIP analyzer can analyze not-ciphered streams only.

6.1.9.2  SMS test with Exynos chipset-based mobile devices

The Samsung Exynos chipset-based mobiles loaded as fully integrated devices sup-
port the SMS test.

6.1.10  Neul chipset based devices

R&S ROMES4 supports the Neul chipset-based devices for NB-IoT.

Devices



Hardware ComponentsDrive Test Software

1487Operating Manual 1171.6415.12 ─ 66

Load the Neul chipset-based devices by using common the "Hardware" > "Connect/
Disconnect" command. In the "Hardware Configuration" dialog, select the "Neul Chip-
set" option in the "Mobile Devices" branch.

Figure 6-37: Load Neul chipset-based device

The user has to specify the AT command port and the diagnostic port of the connected
Neul chipset-based device.

After having successfully loaded the module, it appears on the right side of the dialog
as loaded device.

The Neul chipset-based devices currently cannot be detected automatically.

R&S ROMES4 automatically tries to connect to module with exchanged ports, if the
given assignment does not work.

6.1.11  Test devices

When loading a test device (R&S TSME, R&S TSME6, R&S TSM6B, also called the
R&S TSMX family), R&S ROMES4 checks whether the driver configuration settings
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comply with the connected device. If they do not comply, "Receiver settings" of the test
device configuration menu opens to adjust the settings.

To be identified by the R&S ROMES4 drivers, a test device connected to the host PC
has to be switched on.

6.1.11.1  R&S TSME network scanner

R&S ROMES4 supports the R&S TSME/TSME6/TSM6B variants of the device. Sup-
ported is also the R&S TSMA6.

The devices can be used in parallel as a GSM network scanner, UMTS PN scanner,
CDMA2000 1x EV-DO PN scanner, RF Power Scanner, WiMAX scanner, LTE scanner,
TETRA scanner, CW scanner and a GPS receiver. The 5G NR scan needs the R&S
TSM6/TSM6B network scanners.

If the R&S ROMES4 TSME/TSME6/TSM6B/TSMA6 driver loader for mentioned tech-
nologies is available, the selected device is loaded.

The Device Manager shows all the R&S ROMES4 drivers available for loading in the
TSME/TSME6/TSM6B/TSMA6 scanners. For a certain device, available are those driv-
ers for which the device has the corresponding scanning option and supports at least
one of the needed RF bands.

The "Device Manager" page and the "Devices" bar display the connected devices'
name supporting certain R&S ROMES4 driver, as shown in the following figure.

Figure 6-38: Loaded devices

All devices are listed, but only the devices that have the necessary RF bands for the
specific scanners can be selected. The others are displayed in gray color.
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Click a connected device name in "Devices" to extend the view and get information on
its serial number, IP address and the currently available RF bands. This information for
loaded and connected devices is also shown in "R&S <scanner variable>: Select
Device", see Figure 6-41.

The R&S ROMES4T1E (R&S No. 1117.6885.82) option is required for this driver.

R&S TSME jumbo frames use - inform user

The R&S TSME driver connection to the R&S ROMES4 needs to enable the "jumbo
frames" on the network interface.

The R&S TSME device scanning process is automatically done during the R&S
ROMES4 startup. The process checks for the error code "MTU size mismatch".

In the case an error is detected, the following happens:
● The connection is not established
● Error message is issued in the dialog window

● Error message is added to the "Output" > "ROMES Messages" list.

Figure 6-39: Mismatch error message in the Output window

Install R&S TSME drivers

To load the R&S TSME driver, perform the following steps:

1. Click "Hardware" > "Connect/Disconnect".
The "Hardware Configuration" window opens.

All device loader, which can be used by the R&S TSME/TSME6/TSMA6 device are
shown in the "Network Scanner TSME" branch.
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Figure 6-40: R&S ROMES4 TSME drivers

2. Double-click the selected device or press ">".

The device loader starts and tries to reach the R&S TSME/TSME6/TSMA6 at the
default IP address.
The "R&S <scanner variable>: Select Device" page opens showing the R&S
TSMEs attached to R&S ROMES4.

Figure 6-41: Attached R&S TSME devices

Devices



Hardware ComponentsDrive Test Software

1491Operating Manual 1171.6415.12 ─ 66

The dialog shows the serial numbers, IP addresses and available RF bands of the
devices.

3. Select an attached R&S TSME.

4. Click "Connect" to activate it.

The R&S TSME is active now.

Switch on and physically connect the all R&S TSMEs to the system before you start
R&S ROMES4.

Configuration check

The configuration is checked concerning the specified frequencies.

This check is useful if the available RF bands of a device are covered by the technol-
ogy bands.

Figure 6-42: Available scanning bands

If you specify a not supported frequency or load a template/workspace which contains
not supported frequencies, you are warned about that. You are requested to adapt the
frequencies or remove the affected measurement channels.
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Using wizards

The wizards also check the specified configuration with the actual available RF bands.

License check

The R&S TSME license can be verified in "Help" > "Loaded Modules".

Handling the connection to the R&S TSME

The R&S TSME connection to R&S ROMES4 has three states.

Once the scanner has been loaded successfully, the R&S TSME is connected.

Figure 6-43: R&S TSME connected to R&S ROMES4

If the network cable is removed, the R&S TSME tries to reconnect for about 20 sec-
onds.

If the R&S TSME connection is reestablished successfully within this time frame, the
state changes to connected again.

Figure 6-44: R&S TSME reconnects to R&S ROMES4

If the reconnection time frame expires, the state changes to disconnected.
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Figure 6-45: R&S TSME lost connection to R&S ROMES4

Stop the currently running R&S ROMES4 measurements to reconnect the R&S TSME.

Figure 6-46: Warning message

Once the user stops the measurements and reestablishes the cable connection, R&S
ROMES4 is able to reconnect the R&S TSME. R&S ROMES4 starts the next measure-
ment.

Stop the currently running R&S ROMES4 measurements even if the R&S TSME is not
actively used during the reconnection.

R&S TSME GPS frontend selection

The option provides the R&S TSME6 automatic frontend selection for R&S TSME.

Figure 6-47: Automatic GPS frontend selection
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If several R&S TSME6s are connected to the system and the GPS tile on the welcome
screen is used to load the GPS device the following cases are possible:

● The frontend is used automatically if only one R&S TSME6 has a GPS antenna
connected.

● The user has to select the fronted if several R&S TSME6s have a GPS antenna
connected, or none of them.

R&S TSME synchronization source

The synchronization source is selected automatically for this scanner type.

If GPS is available, the scanner normally uses PPS.

If no PPS is available, it uses a mobile network, GSM, UMTS or some other for syn-
chronization.

For the interpretation of measurement results, it is helpful to know which synchroniza-
tion method the scanner has used.

You can load the driver "System information", see Chapter 6.1.12, "System information
and performance counters", on page 1498. For each scanner you have then the "PPS
Synchronization" signal, so that you can see if PPS was used for synchronization or
not.

R&S TSME device information

Detailed information on the R&S TSME device can be found in the "Scanner" page of
the device.

The pane "Scanner Properties" of the page shows the installed device hardware and
software details, the available options and all the installed RF band options.

For example, the pane contains the production index, the currently active R&S TSME
SW including the FPGA version and the FW version of the default SW, the R&S TSME
scanner calibration date and the self-alignment date.

Figure 6-48: Installed R&S TSME scanner properties

The previously mentioned details are also included in the measurement file opening
page, see Figure 3-15.
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The R&S TSME Device Manager tool lets users do a complete diagnosis and perform
updates if necessary, refer to Chapter 5.6, "R&S TSME diagnosis and updates",
on page 1443.

6.1.11.2  Channel scan rates configuration for R&S TSME

R&S ROMES4 supports the configuration of the channel scanning rate for the R&S
TSME network scanner in a single configuration page and in a unified manner.

This R&S ROMES4 function applies to all three 3GPP technologies when using the
R&S TSME scanner.

The use of the same R&S TSME scanner is based on usage of the same IP address.

To configure the Channel Scan Rate function, use the "Channel Scan Rate Configura-
tion" button.

The button is available in the UMTS and LTE scanner configuration page at the bottom
of the page, see the following figure.

Figure 6-49: Channel scan rate configuration button - UMTS and LTE

In GSM technology, the button is located in the "Setup GSM NWS" > "Scan Parame-
ters" pane.

Figure 6-50: Channel scan rate configuration button - GSM

Press the button to open the function's configuration page.
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Figure 6-51: Channel scan rate configuration

The function has four operational modes.
● "Off"

The scan rates are set on the scanner configuration pages (default).
● "Automatic"

The optimization target is the highest possible channel scan rate, which is nearly
equal for all involved technologies (GSM, UMTS and LTE). Typically, the highest
possible channel scan rate is determined by the technology with the most mea-
sured channels.
This mode has the parameter "% of max. calculated rate", which allows reducing
the rate to lower levels. Reducing the rate level is useful for less load or smaller
measurement files.
The calculated measurement rates are target rates. The effective rates can be
lower depending on other factors, like additional technologies assigned to the
same scanner or network, or the CPU load.

● "User Defined 1"
Channel scan rate is set to a given value for all involved technologies. This value
can be used to set a specific rate like 1 Hz or to set low rates like 0.01 Hz.
The given rate is a target rate. If the max. possible rate for the involved technolo-
gies is lower than the target rate, the scanners adapt them to use the max. possi-
ble rate. A ROMES message is issued in the "Output" window; see the following
figure.
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Figure 6-52: Channel scan rate-related message

The effective measurement rates can be lower depending on other factors like
additional technologies assigned to the same scanner or network, or the CPU load.

● "User Defined 2"
Channel scan rate is set to a given value for each involved technology. This value
can be used to set a specific rate for different technologies.
The given rate is a target rate for the technology. If the max. possible rate for the
involved technology is lower than the target rate, then the technology is configured
to use the max. possible rate and a ROMES message with details is issued in the
"Output" window.
The effective measurement rates can be lower depending on other factors like
additional technologies assigned to the same scanner or network, or the CPU load.

The channel scan rate setting is applied on any configuration change of the involved
scanners.

The results of the optimization are visible in the GSM, UMTS and LTE scanner configu-
ration dialogs.

By choosing any function mode other than "Off", the channel scan rate controls of the
scanner configuration dialog are read-only.

Example: Scan cycle times
The scan cycle times of all three technologies with similar values, shown in the follow-
ing figure are result of the optimization. The time is defined as the time in which every
configured channel has been measured at least once.

Figure 6-53: Average scan cycle times of all 3GPP technologies
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6.1.12  System information and performance counters

The System Information device is a hardware-independent function that stores the val-
ues of the Windows performance counters to the measurement file. Monitoring of this
information during the measurement can be helpful for assessing the validity of the
measurement results.

The device is automatically loaded which makes it easier to access a scanner state.

Example: 
Suppose that a DQA job involving an FTP download from a remote server fails. Moni-
toring the local processor time together with the measurement data helps to decide
whether the failure is due to local performance problems rather than to an unstable
data connection.

The System Information is loaded like any other device. The configuration menu is
accessible via the "Hardware" > "Connect/Disconnect" dialog.

1. Select "System Information" from the "Available Devices" list.

2. Use the ">" button to load the device.

The device is loaded and you can see it in the "Loaded Devices" list and in the
"Hardware" menu.

Figure 6-54: Loaded System Information
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Click "Continue". The  icon appears in the R&S ROMES4 icon bar. Click the icon to
get the system information "System Monitor" opening page.

Figure 6-55: System Information page

In "Performance Counter" you can select the performance counters you want to store
to the measurement file and the time interval between two consecutive loggings.

Click "Add" to open the browser to select computer counters. The selected local com-
puter counters are directly written into the "Performance Counter" pane.
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Figure 6-56: Dialog to select computer's counters

R&S ROMES4 generates a signal for each selected computer counter in the "Signal
Tree" > "System Info" > "Performance Counter" branch. For the selected scanners-
generated, the signals are stored in the "Scanner" branch.

The signals are configured for display in the "Tools" > "Preferences" > "Available Sig-
nals" page.
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Figure 6-57: System Info available signals

For the signals description, see the "Description of R&S ROMES4 Signals" document.

The signals can be viewed in correlation with other signals by using an appropriate
view, for example, the "2D Chart View" or the "Alphanumeric View".

An example of the supported views is given in the following figure.

Figure 6-58: Alphanumeric view of the System Information signals

6.1.12.1  System information support of scanner status signals

The System Information makes it possible to log and visualize the R&S scanners sta-
tus.

The R&S TSME supports the all signals shown in the Figure 6-57.

The following figure shows the System Information of the supported scanner signals for
which an enhanced visualization is available.
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Figure 6-59: System information scanner signals

The meaning of the colors in the table is as following.

Figure 6-60: Explanation of colors

6.1.12.2  System information support of events and alarms for scanner status

The System Info device stores a scanner status in the measurement file. The stored
status helps to evaluate the RF conditions of the scanner during the measurement but
also to identify the system errors, for example, loose cable connections.

The information about error is available as a signal and as an event on some signals.

Also, a system alarm is activated if one of the connected scanners’ overall state is
erroneous. A scanner’s state alarm is triggered by the condition listed in the following
figure.

Figure 6-61: Conditions to trigger an alarm

The alarms are logged in the general status view, in the "Basic Views".

The General Status View function allows you to specify an audio file, which replays at
an alarm activation. A file is configured in the "Tools" > "Preferences" > "Available
Events" page.
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Figure 6-62: System Information available events

To get the scanner event status information and the alarms, it is necessary to load the
System Information device manually.

Figure 6-63: Add System Information device manually

6.1.13  Place holder

R&S ROMES4 allows the configuration of measurement workspaces and mobile/scan-
ner/GPS devices without the actual devices attached to a PC R&S ROMES4 runs on.

The workspace can be saved with place holder devices and then R&S ROMES4
prompts to replace the place holder devices with actual attached hardware when the
workspace is reloaded.

The benefit of the feature is the possibility to configure measurement at the home
office. At measurements configured from the home office, you get the workspace that
contains the place holder device. You only need to open the workspace and point to
the actual hardware. Then start the measurement.
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The feature currently supports only the R&S TSME scanner out of the R&S ROMES4
supported R&S scanners.

Click the "Available Devices" > "Add Device Manually" to initiate place holder configu-
ration from the "Welcome" page.

Figure 6-64: Option to initiate place holder

Alternatively, check the "Use Device Place Holders for Configuration" check-box in the
"Hardware Configuration" > "More" pane, see Figure 6-3. The action modifies the
"Available Devices" filed to show only devices that support place holder configuration.
WinWLAN and Position Estimator are excluded from the list.

Figure 6-65: Devices supporting place holders
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6.1.13.1  Scanner place holder configuration

Select the desired scanner technology from the list of available devices. The selection
brings up the configuration screen to configure the R&S TSME place holder devices.

Figure 6-66: Selected R&S TSME6 device

Click the  icon to add additional device. Clicking  icon removes the selected device
from the list. The type of the R&S TSME can be configured by choosing either "TSME"
or "TSME6" from the "Dev Type" drop-down menu. By default, all "TSME" place hold-
ers are synced to one another. A "TSME" place holder device can be unsynced from
other "TSME" place holder devices by unchecking the check box in the "Sync" column.

Figure 6-67: Additional place holder devices added
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If the desired number of the "TSME" place holders is configured, click "Connect" to
attach the R&S TSME to wanted technology.

Figure 6-68: Attached scanner

If a second scanner is chosen, then the previously configured "TSME" place holder is
removed and displayed in the place holder device selection dialog.

If all desired devices are loaded, clicking "Continue" completes the loading process.
R&S ROMES4 configures as normal. You can now also save the workspace from the
"File" menu as normal.

Figure 6-69: Several devices attached

If a place holder device is used, then "Start Measurement" button in R&S ROMES4 is
grayed out and a measurement cannot be started.

6.1.13.2  Mobile device place holder configuration

The configuration of mobile device place holder is the same as the scanner place
holder configuration, with one exception. As there is one to one relationship between
mobile devices and R&S ROMES4, there is no need to define place holder devices.
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Figure 6-70: Attached Qualcomm mobile device

Limitation for mobiles: Forcing, QualiPoc and QoS testing is not supported.

6.1.13.3  Other actions with place holder

Reload workspace for additional configuration

To reload the saved workspace to allow additional place holder configuration, perform
the following:

1. Open the workspace in R&S ROMES4.

2. When it prompts to identify the actual hardware, select the place holder as device
option for reload.
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Figure 6-71: Place holder as device option to reload

Place holder is loaded as a device.

Place holder replacement

1. Reload the workspace again to replace the place holder devices with the actual
hardware.

2. Start the measurement.

3. Attach all needed hardware to R&S ROMES4 first.

4. Open the workspace in R&S ROMES4.

5. When it prompts, replace each place holder device with the actual hardware nee-
ded in the measurement.

Figure 6-72: Place holder device repaced with actual one

6. Click "Continue".

The R&S ROMES4 measurement can now be started.

7. To start the measurement, click the "Measurement" > "Start" command in the R&S
ROMES4.

The workspace is now opened with a modified file name.
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The original workspace with the place holder devices is not modified.

Example: 
Assume the workspace file that contains place holder devices, called
2_TSME_LTE_PH.rsxks, is opened. Assume further that place holder devices are
replaced with actual hardware. A new workspace called
2_TSME_LTE_PH_modified.rsxks is now created and loaded so that the original
workspace is not modified.

6.2  Automatic reload of mobile devices

R&S ROMES4 reconnects 3GPP test devices automatically to the correct COM ports.
Therefore, the mobile drivers check the IMEI and IMSI of the test mobile device during
R&S ROMES4 connect process.

Only the COM ports specified in the workspace are accounted for connection to a
mobile. If the mobile is connected to a different COM port, you have to reallocate it by
selecting "Assign New Link".

If the original IMEI or the IMSI is found, the test device is installed automatically.

If the IMEI of the currently connected mobile is not equal to the IMEI stored in the
workspace, R&S ROMES4 searches the workspaces for the appropriate setting for the
current IMEI. If such setting exists in the workspace file, it is loaded for the mobile. Oth-
erwise, a window appears indicating that the workspace setting does not match the
currently connected mobile.
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Figure 6-73: Automatic reload of devices

Depending on the mobile device, the "Select Mobile to load" window offers single or
multiple selection possibilities.

● Select another test device that has the required IMEI, but another IMSI.
● Select another test device that has the required IMSI, but another IMEI.
● Load the device manually

Cancel the reconnect process and select the device manually. The 3GPP Qual-
comm drivers support this functionality.

If the COM port has to be changed the DQA and the SQA reconfigure automatically.

6.3  Devices observation

6.3.1  Expected data rate

R&S ROMES4 observes the amount of produced data per time unit of each R&S
ROMES4 connected device. This value is taken as indicator for a proper function of the
device connected to the R&S ROMES4. By default it is expected, that a R&S ROMES4
connected device produces and sends 100 Bytes per second. This value can be adap-
ted if necessary. To do so, open the configuration dialog of the corresponding device
and navigate to the "Information" section. Click the "Info" tab. At the top of the opened
page, this value can be changed.
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Figure 6-74: Info tab - Module Properties

The Chapter 4.2.7, "General status view", on page 501 reports the current data rate for
each R&S ROMES4 connected device involved in the current measurement. The right
column indicates the set threshold for alarms. Reporting of the current values does not
start earlier than 10 seconds after the start of measurement. The refresh rate is about
five seconds. If the current rate of data is below the given threshold, the corresponding
cell in the list gets a red background. An alarm dialog is shown and plays a wave file
(optionally).

6.3.2  Raw data logging

Some test devices, for example Qualcomm chipset-based mobiles, offer raw data log-
ging. Raw data offers more information, which can be useful for the interpretation of
network problems discovered during drive testing. By default the function is not active.
To activate it, click "Info" and check the "Module Properties" > "Raw Data Logging"
checkbox.

The log files are saved to the LogFiles directory of My ROMES.

Figure 6-75: Raw data logging checkbox included

Enable raw data logging only when required for investigating a specific problem. Other-
wise, the measurement files are larger than normal and the hard drive of the measure-
ment PC is quickly filled.

6.4  Test devices

The drivers needed for the test devices and their configuration are described in the fol-
lowing sections.

The measurement system supports a wide range of devices that can be used to per-
form measurements and provide the desired results:
● Mobile phones of various types and for usage in various networks
● Test receivers and analyzers, named here scanners
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● NB-IoT UE

About mobile devices

R&S ROMES4 supports NB-IoT measurement data collected by Qualcomm or Neul
chipset-based test UE, see Chapter 6.1, "Devices", on page 1447. The UE can be loa-
ded as any other test devices.

ADB phones not authorized for the R&S ROMES4 PCs do not appear on the "Wel-
come" screen. If R&S ROMES4 detects such a mobile phone, an error message is
issued in the "Output View". You are asked to authorize the ADB access on the phone.
An unauthorized mobile phone is a mobile phone with Android operation system not
authorized for the used PC. Authorization can be done on the mobile.

About scanners

The ACD function acts in a way that all detected channels are automatically added to
the actual scanners. This automatic behavior of any scanner can be suppressed by
deactivating the "Auto Start of Scan" option in the "Automatic Channel Detection"
page.

Figure 6-76: ACD page - auto start of scan

The option is useful if not all channels are of interest and the important ones should be
scanned with a maximum rate. Enabling only specific channels helps to save resour-
ces and to focus on the actually required channel measurements, seeChapter 4.2.2,
"ACD status view", on page 461.

GSM does not support this feature, as it does not use the ACD algorithm. if you enable
GSM in the ACD wizard, GSM is scanned always.
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6.4.1  Support of SwissQual TCM

R&S ROMES supports the SwissQual device Test Containment Module (TCM).

Network optimization and troubleshooting suppose use of unmodified phones in a con-
trolled environment to achieve reliable results. The TCM ensures maximum data qual-
ity for large-scale benchmarking campaigns.

In particular, if MIMO is used with increased number of build-in antennas, the TCM
allows assessing the real RF performance of the device.

The temperature control of the test devices is improved with the TCM. Temperature
control of the device is important to avoid that measurement results are impacted by
reduced phone performance due to overheating. The module enables stable thermal
environments and uniform conditions for all test devices, making measurement results
comparable.

6.4.1.1  Prerequisites

After installing the R&S ROMES4 application, the following steps have to be performed
to obtain the TCM functionality.
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● TCM driver installation
● TCM firmware version check and update

TCM driver installation

Two device types can be connected to R&S ROMES4. One Remote Power Controller
(RPC) and up to 16 Test device Containment Modules (TCM) can be connected.

Connect the RPC board for temperature control to avoid overheating of its compo-
nents. Also, this connection is necessary to switch the 4 auxiliary ports of the RPC con-
troller on and off.

1. Plugin the RPC device.

2. Look for the device named USB API with an exclamation mark at its icon in "Other
device" or "Unknown devices" of the Device Manager. Ignore any devices there
with the name SwissQual ASC.

3. Right-click the USB API device.

4. Select "Update Driver Software" and then "Browse my computer for driver soft-
ware".

5. Browse to the folder containing the RPC driver.

6. Click "Next".

7. The "Windows Security" dialog pops-up. Choose "Install this driver software any-
way".

The installation finishes.

Now plug in a TCM device and install the driver in the same way that you installed the
RPC device.

TCM firmware check and update

The SwissQual TCM firmware version must be 2.35 or higher to work with R&S
ROMES4. If the firmware is older, an error is shown in the "Output" window and the
device is ignored.

Check the TCM firmware version using the SiLabsHWTest tool.

1. Stop R&S ROMES

2. Start the SiLabsHWTest.

3. Select "ccc" at the top.

4. Click the folder symbol to connect to this device.

5. Open the "General" tab.
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6. Select "FW Version".

The firmware version is shown.

If the shown version is not 2.35 or higher, you have to update the firmware.

To update the firmware version, perform the following steps:

1. Select "Bootload" and ccc as "Device Serial String". Click "Open".

2. In the "Select Hex File" section, click "Browse". Select the hex file (*.hex) to load.

3. Click "Download".
Reset device after previously performed steps. Click "Reset Device".

4. Press "Exit" and connect to the ccc device again (folder symbol).

5. Click "Read" in the "TCM Flash option" group.

The radio button group below the "Read" button shows now "Romes".

If it is not a case, change the TCM and click "Set". Disconnect from the device.

6.4.1.2  TCM and RPC-related controls in R&S ROMES4

R&S ROMES4 automatically detects the connected RPC and TCM devices, USB ports
and the phones and starts temperature checking of the devices.

Press the "Stop" button in the TCM dialog to disconnect the mobile phone in the TCM
from the USB port. The mobile phone is no longer seen by R&S ROMES, but as the
TCM remains connected, the temperature can be seen. The button changes its name
into "Start". Press the button to reconnect the phone.

To reboot a phone, select the "Reset" button. It takes some time (around 30 seconds)
until the device is detected again by R&S ROMES4.

Unplugging and plugging the TCM again can cause that a R&S ROMES4 scanner can-
not find the mobile device although you see the TCM and the mobile in the TCM tool-
bar. In this case, switch the mobile's USB power off using the "Stop" button on the
TCM toolbar and switch it on again. Now the R&S ROMES4 scanner starts and looks
for the mobile again.

Restarting a mobile device with the "Reset" button can cause that the device cannot be
found again. (See <ABSENT> in the "Device" column and <Timeout error> in the
"State" column of the TCM toolbar). If this case occurs, switch the mobile's USB power
off by clicking "Stop" and then switch it again on. Now the R&S ROMES scanner starts
and looks for the mobile again.

Messages related to RPC/TMC devices are shown in the "Output" window, as the
"TCM" entry.
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Figure 6-77: Output - TCM messages

The TCM specification includes a value of 25 °C for the ambient temperature that it
tries to keep.

In addition to the warnings shown in the "Output", you can see a temperature problem
in the TCM toolbar. Temperatures out of the given range are shown yellow.

Figure 6-78: TCM temperature out of range

R&S ROMES supports TCM temperature range setting. R&S ROMES4 uses the con-
figured temperature values to decide if warnings are issued in the "Output Bar" of the
TCM page when the TCM temperature is not in the given range.

To set the temperature values for issuing a warning message, see Chapter 3.8.1, "Sys-
tem configuration (preferences)", on page 223.

Allowed range for the lower temperature value is 23 °C to 25 °C and for the higher 25
°C to 27 °C.

6.4.1.3  Single driver mode

If R&S ROMES4 is running under a Remote Desktop, a dongle with the
CVD_EXPORT_OPTION is in use, an RPC device is plugged in and a measurement
starts. R&S ROMES4 switches to the Single Driver Mode, what means that many con-
trols are disabled to avoid accidents.

6.4.1.4  Overheat alerts

The SwissQual TCM and the RPC devices show alerts in the TCM toolbar if the tem-
perature goes ahead 80° C. In this case, it is highly recommended to switch off the
involved devices to avoid hardware damage.

Test devices



Hardware ComponentsDrive Test Software

1517Operating Manual 1171.6415.12 ─ 66

6.4.2  Downconverters supported by R&S ROMES4 scanners

R&S ROMES4 supports the R&S TSME44DC and R&S 30DC.

6.4.2.1  R&S 30DC downconverter

The following R&S ROMES4 scanners support the R&S 30DC downconverter.

● 5G NR Scanner
● RF Power Scanner
● CW Scanner

The listed scanners accept frequencies in any of the supported frequency ranges of
the downconverter. The supported ranges are:

● 350 MHz – 6000 GHz (only primary R&S TSME connected to RF1)
● 24 GHz – 27.5 GHz
● 27 GHz – 30 GHz

In the overlapping range 27 GHz to 27.5 GHz R&S ROMES4 uses the antenna port of
the range 24 GHz – 27.5 GHz.

The "Output" view shows messages about connecting a downconverter or related
warnings and/or errors.

Figure 6-79: R&S TSME connected to the RS& 30DC

The R&S ROMES4 "Available Devices" field of the "Welcome" page displays the con-
nected downconverters of the scanners and the available frequency ranges per scan-
ner. An asterisk at the end of the TSME6-DC30* name marks the primary R&S
TSME6.

The R&S TSME6 which is connected via the AUX cable to the downconverter and via
the RF cable to the input IF1 of the downconverter is called Primary.
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Figure 6-80: Connected devices - available devices view

It is mandatory to set up the primary R&S TSME6 with the R&S TSME Device Man-
ager version 1.6 or higher according to the hardware setup. R&S ROMES4 reads out
this information and handles the downconverter and scanners accordingly. Without the
box, an R&S TSME6-30DC set-up does not work. All the R&S TSME6s connected to
the downconverter require an all-band option.

Overlapping region of R&S TSME30DC

The R&S TSME30DC has an overlapping region from 27 GHz to 27.5 GHz. R&S
ROMES4 supports this region as it takes antenna region for each R&S TSME as speci-
fied in the TSMxTranducerTables.xml.

1. Add a section TSME30DC with the attribute "Overlapping" to the Frontend selec-
tion.

2. Specify "High", if you want to take the high range antenna (27 GHz to 30 GHz). By
default a legacy solution applies, which is the lower range antenna.

The ACD wizard now starts with the current configuration.

<Frontends>
<Frontend Identnumber="4900.0004K02" Serialnumber="101035" Active="true">
  <TSME30DC Overlapping="High"></TSME30DC>
  <Node GainInDB="20.0" FrequencyInHz="2700000000" Type="Low"/>
  <Node GainInDB="20.5" FrequencyInHz="2800000000" Type="Mid"/>
  <Node GainInDB="20.6" FrequencyInHz="3000000000" Type="High"/>
</Frontend>
</Frontends>

6.4.2.2  External downconverters

The previously listed R&S ROMES4 scanners support the usage of external (third
party) downconverters with R&S TSME/A6 in addition to R&S DC30 downconverter.
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The TSMxTransducerTables.xml file allows you to specify the properties of an
external downconverter.

R&S ROMES4 reads this information analogue to the R&S TSME6-DC30 information,
which is stored in the primary R&S TSME6.

The file R&S ROMES4 reads is located in the C:\ User\<username-variable>\MyDocu-
ments\MyROMES\Configuration folder.

Specify several transducer tables, downconverters and ranges for an R&S TSME/
TSMA6 device in the *.xml file and activate one of these tables.

Refer to the following sample in the file for details:
● Device Section

Includes the following frontend settings:
– Frontend Identnumber - has to be in the format aaaa.bbbbKcc
– Frontend Serialnumber - serial number of R&S TSME/TSME6
– Frontend status Active - can be true or false

● Downconverter (only TSME6)
Includes the following settings:
– Downconverter Type
– LO frequency in MHz
– Multiplier for LO frequency

● Range
Range is mandatory setting if downconverter is specified. Required is to specify the
minimal and maximal input frequency of downconverter or device in MHz.

R&S ROMES4 reads the downconverter setup of the XML file only once during the
startup, while the Transducer Table itself can be changed and reloaded during a R&S
ROMES4 session.

The XML file warnings and errors are reported in the R&S ROMES4 "Output" bar.

Perform the following steps to get an external downconverter into your R&S ROMES4
system:

1. Open the TSMxTransducerTables.xml.

2. Read the comments at the top of the file.

3. Add a new frontend section:
a. Set the correct Ident number of your device.
b. Set the correct Serial number of your device.
c. Set Active to true, if you want to use the section or set it to false otherwise.

4. Define the downconverter properties:
a. Add a section downconverter.
b. Set its attributes accordingly.
c. Add a section Range.
d. Set the minimal and maximal input frequency of the downconverter.
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5. Specify the transducer nodes if desired.

The following figures show the layout of the TSMxTransducerTables.xml.

The first one shows the upper, explanatory part of the file. The second one is the lower
part of the file, an example for the transducer configuration.

Figure 6-81: Explanatory part of the file
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Figure 6-82: Configuration example, the lower part of the file
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It is not allowed to use the third-party downconverter settings together with the R&S
DC30 downconverter in the system.

6.4.3  Generic mobile devices

The driver for generic mobile test devices is based on AT commands, so that most
common mobile phones can be used for testing with a reduced functionality. The
generic mobile is no longer a fully enabled test mobile. Instead, it is limited to return
data like the measurement report (RxLev, RxQual) or the phone mode. Nevertheless,
the generic mobile can be used for e.g. speech quality measurements, where the AT
commands and responses are shown in the "Layer 3 View" instead of the L3 mes-
sages.

The selection of generic mobile test devices is performed in the "Hardware" > "Con-
nect/Disconnect" > "Hardware Configuration" configuration window. Select the
"Generic Mobile GSM / WCDMA" entry and click the ">" button. After you define the
device's serial port, the driver is loaded and added to the "Loaded Driver" list.

The measurement system provides a generic mobile driver for the test mobiles not
covered by the GSM or UMTS drivers.

6.4.3.1  Configuration menu

The "Generic Mobile GSM / WCDMA" driver configuration menu contains various tabs
to perform different tasks.

● "GM Settings", "Communication Item List Editor", "Mobile Options" to select the
measurement and message types evaluated by the test system

● "Autodialing" to configure the autodialing and autoanswer call mode
● "SQA" to set up the speech quality
● "Serial Port Driver Info" to display information on the driver and the assigned serial

port

Click the "Hardware" > "<Driver>" command line which is available when a mobile
driver is loaded.

● Generic mobile (GM) settings............................................................................. 1523
● Communication item list editor............................................................................1523
● Autodialing generic mobile..................................................................................1524
● SQA settings generic mobile...............................................................................1525
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● NQA settings.......................................................................................................1525
● Templates generic mobile................................................................................... 1526
● Serial port driver info generic mobile...................................................................1527

Generic mobile (GM) settings

The "GM Settings" tab lets you handle the PIN number, if applicable.

PIN handling
If "Use PIN" is checked, the PIN number for identification after switching on the test
mobile can be entered in the "GM Settings" panel of the configuration dialog. If nothing
is entered, the SIM must be entered manually at the mobile each time it is started.

Communication item list editor

The "Communication Item List Editor" tab shows the message commands, requests,
and responses to be recorded to the measurement file.

Communication Item List Editor
● ID

Internal list number of the communication item.
● Use

Toggles the use of the selected list item.
● Item

Communication item descriptor (or AT command).
● Type

Qualifies the list item to be a command, request, or result.
● Text

Additional optional description of the list item.
● Check

Sets whether the communication item is supported by the mobile. Setting "Yes"
indicates that there is active feedback from the mobile.

● Get Par.
List item parameter is requested by the generic mobile.

● Set Par.
List item parameter is sent to the mobile (e.g. PIN).

● Term.
Termination of the mobile response, i.e. the item defines the end of the mobile
response.

● Delim.
Sets the delimiter for parts of multi-part responses from the mobile.

● Time [ms]
Defines the time to wait for the response from the mobile.

● Response
Represents the value of the response, for example, 0 means that "Response is a
valid value", 1 usually means "OK".

Load List
Calls the "Load List" dialog to select a previously saved list for loading.
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Save List
Calls the "Save" dialog to store the current list.

Initialize List
Loads the default list (unsaved manual changes are lost).

Autodialing generic mobile

The "Autodialing" tab configures the mode where a definite phone number is dialed
periodically, and a call is set up to the mobile phone.

This mode is relevant for the network quality analysis described in "NQA settings"
on page 1547.

The autodialing mechanism of the mobile drivers allows the IRAT handovers automati-
cally to test, see the following figure and "Preconditions" on page 1541.

All settings are analogous to the GSM driver settings described in "Autodialing"
on page 1536.

If a 2nd virtual COM port is needed to be operated in autodial mode, refer to Chap-
ter 6.1.4.2, "Loading the USB drivers", on page 1457.

Figure 6-83: Generic Mobile driver configuration – Autodialing tab
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Autodialing can be limited for the mobiles to initiate a call in "Only LTE", see Fig-
ure 6-97.

SQA settings generic mobile

The SQA tab enables and configures the speech quality (SQA) with the R&S
ROMES4SQA, "Voice Quality PESQ" option. The SQA results are displayed in chapter
Chapter 4.6.1, "QoS SQA view", on page 1060.

All settings are analogous to the GSM driver settings described in "GPS health moni-
toring" on page 2064.

NQA settings

The "NQA Settings" tab provides the parameters for network quality analysis. The NQA
settings are prerequisite for drawing up a call statistic, where the calls are classified
and the classes are visualized separately.

Figure 6-84: Generic Mobile driver configuration – NQA Settings

The parameters in the "GSM NQA Parameters" and "NQA Monitoring" sections are
identical to the NQA parameters for GSM, see "NQA settings" on page 1547.

Use NQA
If checked, activates the network quality analysis (default).
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UMTS NQA Parameters
The following numeric parameters configure the UMTS NQA by defining conditions and
limits for the different call classes (we quote the ranges for all parameters; default val-
ues are underscored).
● "Handover Maxcount"

Maximum number of handover procedures during a call in the range 1 to 100.
Default is 5. If the defined value is exceeded, the call is classified as EXCESSIVE
HO.

● "Blocked Call Delay"
Maximum delay (in seconds) between CM_SERV_REQ and ASSIGNMENT_COM-
MAND in the range 1 (s) to 63 (s). Default is 15 (s). If the defined delay is excee-
ded, the call is classified as DELAYED CALL.

● "Ec/Io Threshold"
Minimum Ec/Io value included in measurement.

● "Ec/Io Exceed Percentage"
Minimum ratio of reported RxLev values in percentage falling below the RxLev
threshold. Default is 50 %. If the actual ratio falls below the specified percentage,
the call is classified as NOISY.

● "BLER Threshold"
Maximum Block Error Rate in percentage. Default is 30 %. BLER values above this
threshold contribute to NOISY.

● "BLER Exceed Percentage"
Minimum ratio (in percent) of reported BLER values exceeding the BLER threshold
in the range. Default is 50 %. If the actual ratio exceeds the specified percentage,
the call is classified as NOISY.

GSM NQA Parameters
Configures the GSM NQA, see "NQA settings" on page 1547.

NQA Monitoring
Activates NQA monitoring and displays the number of Blocked Calls, Dropped Calls
and No Service Calls, see "NQA settings" on page 1547.

Templates generic mobile

The "Templates" tab stores the current driver configuration as a template, lists, loads or
deletes driver templates. All settings and buttons are analogous to the GSM driver set-
tings described in "Templates" on page 1558.
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Figure 6-85: Driver Configuration – Templates tab

Serial port driver info generic mobile

The "Serial Port Driver" tab displays the custom name of the device, information on the
file version of the technology driver, the serial port assigned to it and the transfer
parameters. The "Custom Name" is used to assign a name to a test device, e.g. to
make a quick association of a test device to its designated test network provider.

Also the expected amount of produced driver data per time unit can be set. See also
Chapter 6.3, "Devices observation", on page 1510.
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Figure 6-86: Driver Configuration – Serial Port Driver Info tab

Raw Data Logging is not available for Generic mobile driver.

6.4.3.2  Action menu generic mobile

The "Action" menu opens pop-up boxes used to set up a call or show the contents of
the mobile display. It is added to the menu bar when a mobile driver has been success-
fully installed (see "Devices" ). If several mobiles are connected, separate command
lines are displayed for each of them.
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Figure 6-87: Action menu for different driver types

Handset generic mobile

Activates the entry of a number to dial, set up and terminate a call.
● Handset

The "Handset" command opens a window (equal for all drivers) which have two
possible statuses:
– Not selected
– Selected, marked with "- *" and shown in the following figure as connected

mobile [2].

If there is only one "Handset" window, it always has selected status.
If there is more than one "Handset" window, the selected status can be set to any
"Handset" window in one of two listed ways:
1) Click to the window using a mouse.
2) Choose selected window using the "N" key. In this case selection changed like
this: Window[1] > press "N"> Window[2] > press "N"> ...Window[n] > press "N">
Window[1] (cycling choose like "Alt+Tab" between open windows in MS Windows).
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Only selected windows accepts hotkeys “D” ("Dial"), “A”("Answer"), “H”("Hangup").
Note: The previously mentioned keys have only effect, if the focus is not set to an
input control, example-given edit field or combo box.
Example: if you select the phone number by selecting the corresponding entry of
the combo box, the keys do not work afterwards. Set the focus to another window,
for example to the main R&S ROMES4 window.

● >>
The ">>" button enlarges the dialog box, giving access to the Key pad and the
"Autodialing" option.

Figure 6-88: Use Autodialing

Figure 6-89: No Autodialing

● Dialed number
The number to be dialed can be entered either via the keyboard and the input field
or by clicking the on-screen keypad.

● "Close window ⊠"
Closes the window without any further action.

● "Dial"
Starts dialing the number entered before.

● "Answer"
Instructs the phone to accept the call.

● "Hangup"
Drops the line.

● "Autodialing"
If the box is checked, the phone number entered below is called periodically, the
"Dial", "Answer", and "Hangup" buttons are disabled (grayed). The autodialing
mode can be set even during the measurement, but only in "Idle mode".

Test devices



Hardware ComponentsDrive Test Software

1531Operating Manual 1171.6415.12 ─ 66

This item starts "Autodialing" if the "Start with Measurement option" was not
checked in the driver configuration-autodialing tab panel.

6.4.4  GSM mobile devices

This section is related to R&S ROMES4 support of the GSM mobile devices.

The drivers and mobile devices are grouped into the R&S supported classes 1 and 2.
The introduction of the R&S supported classes is necessary due to the sheer number
of supported mobiles.

The drivers and mobile devices of the R&S supported class 1 are continuously tested
with new R&S ROMES4 release and service packs. They are permanently available to
our testing staff.

The drivers and mobile devices of R&S supported class 2 are not always available for
testing. They have been tested successfully at least once with the current R&S
ROMES4 software release.

The mobile devices with the R&S supported class 1 are listed with the normal title type-
face. Mobile devices with R&S supported class 2 are marked with italic title typeface.

The GSM test devices are either hand-portable or vehicle-mounted mobile phones or
modules for system integration.

To see test mobile devices that are supported by R&S ROMES refer to
Supported Test Mobiles ROMES.pdf file which is found in
the ..\Documents\ReleaseNotes\ of the delivered R&S ROMES DVD.

All GSM channels and frequencies are listed in appendix Chapter 12.8.1, "GSM chan-
nel bands and power classes", on page 2395.

6.4.4.1  GSM mobile signals - Android performance data

The GSM signal tree in "Available Signals" contains a set of signals for Android perfor-
mance data. For more, see "R&S ROMES4 Description of Signals".

6.4.4.2  Configuration menu GSM

The GSM test mobiles configuration page contains various tabs providing basic set-
tings in the "Configuration" page and some advanced settings, like secondary receiver
control, in the "Advanced" page. Depending on the mobile type, some special menus
can be included also.

Many mobile drivers support template files. These files store a complete driver configu-
ration, which can be reused independent of the workspace. See Chapter 6.5.1.5, "Tem-
plates DQA", on page 1959.
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To open a view configuration window, right mouse click any point inside the view. The
context-sensitive menu pops-up. Select the "Configure" command.

A view can be opened also via "Tools" > "Configuration Active View", see Chap-
ter 3.8.2, "Overview of settings (configuration of software modules)", on page 279.

● General settings..................................................................................................1532
● Layer 3 uplink frames..........................................................................................1535
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● GSM/GPRS forcing.............................................................................................1544
● NQA configuration...............................................................................................1547
● Handover analyzer..............................................................................................1551
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● Serial port driver info...........................................................................................1559

General settings

The "Basic" tab configures the measurement mode, channels to scan, a call broadcast
and RxLev correction.

The "Basic" configuration window offers the possibility to change audio auto-routing via
the "Hardware Settings" panel. Audio is routed either to speaker and microphone or
through a USB cable.
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Figure 6-90: GSM test device settings with audio routed digital

Measurement Mode
GSM drivers support three measurement modes.
● "Normal"
● "Camp on BCCH"
● "Scan"
Some test mobiles do not support all them.
● "Normal"

The measurements are performed in the selected network.
During the measurement and a call (dedicated mode), it is possible to switch over
to one out of configured neighbor cells by forcing handover. This switchover is pos-
sible if the conditions in the desired cell are appropriate. If several mobiles are
installed, switching can be performed separately for each one. See "Handover"
command in Chapter 6.4.4.3, "Action menu GSM", on page 1560).

● "Camp on BCCH"
In this mode, the access to all cells except the one with a particular BCCH is
denied for the mobile. Handover attempts are thus suppressed. Therefore the
"Camp on BCCH" mode is recommended for cell boarder determinations.
If the measurement is started, the mobile initiates a cell reselect process. It tries to
register to the BCCH and BSIC that are set in the entry field behind the "Camp on
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BCCH" radio button for the GSM driver. This action is successful only when the
BCCH number and BSIC are available.

● "Scan"
This mode allows the complete frequency band or a part of it to scan. In this mea-
surement mode the operator can get a quick overview on the current activities of
the channels within the used frequency band. By default, only the signal strength of
each channel in [dB] is measured.
For this mode, it is necessary to select the desired channel range in the "Channels
to Scan" panel. Typically, "Start Channel" and "Stop Channel" define the scan
range, which must be completely within the used frequency band.
The R&S ROMES4 supports also the railway GSM channels (EGSM-R). If the
"Scan" measurement mode is selected, you can set for the GSM-R start channel
value one out of the range 940 to 954, which is the EGSM-R range. The channels
are scanned, saved and displayed in the GSM scan view.

● "BCCH Scan"
In this mode the mobile also decodes the BSIC in a specified channel range
entered in "Channels to Scan".
If entering the channels in an ascending order, for example, enter the range 940 to
954 into the "Enter the channels in an ascending order" combo box, all EGSM-R
channels are scanned.
As long as BCCH scan is active, the mobile measures each channel until the BSIC
is successfully decoded. This measurement can cause a considerable extension of
the measurement time.

Note: Test transmitter measurements can be performed in regions with operational
GSM networks without influences on those networks - select an available channel. To
avoid any conflicts, the channels on the left and right of the used channel (adjacent
channels) must also be available. So first use the "Scan" mode to look for a gap you
can use.
If a test mobile is synchronized to the test transmitter signal, the program flow is similar
to the "Camp" mode, however, only the downlink is performed.

Channels to Scan
The channel numbers entered in the "Start BCCH" and "Stop BCCH" determine the
measurement range in the "Scan(ning)" mode. This range must be within the suppor-
ted channel range (e.g. 1 to 124 for GSM900).
The GSM drivers provide an overview of channel ranges that can be set depending on
the GSM band used. Moreover, they support the "BCCH Scan" with BSIC decoding
over an arbitrary combination of single BCCH channels and channel ranges.
The "Samples" parameter defines the number of measured values to be acquired in
each channel, see the section "General settings" on page 1532.

Barred Cells / Cell Barring / Cell Bar Flag
This function allows the GSM devices to ignore or even invert the cell bar flag.
● "Normal"

Only cells that are not barred are accessible for the mobile
● "Ignore"

Cell bar flag ignored – all cells are accessible
● "Invert"
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Cell bar flag inverted – only barred cells are accessible

Trace Messages
The function is available for GSM (GPRS/EDGE) devices. If the function "RLC/MAC
Headers" is active, the information contained in the RLC/MAC headers of the transmit-
ted radio blocks is included in the measurement data and can be displayed in the
"GSM RLC/MAC Header View".
The R&S ROMES4 RSCMD file size increases quickly if this parameter is on and
packet data transfer is performed.

Mobile Info
The function is available for all GSM test devices. It displays information on the current
test device in the hardware configuration dialog.

RxLev Calibration
The function is available for GSM test devices. The "RxLEV Calibration" button opens
a dialog to activate the calibration of the received signal level reported by the mobile.

Init Mobile
The "Init Mobile" button starts the initialization if a GSM mobile device (even of the
same type) is changed.

Identify mobile
The "Identify mobile" button opens a message box and displays the IMEI.

Layer 3 uplink frames

The layout of the "Layer 3" dialog depends on the mobile type, however, the functions
are equivalent. The dialog allows you to modify Layer 3 messages.

The following figure shows an example of possible modification of up to four Layer 3
messages that an MS sends to the network.
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Figure 6-91: GSM driver configuration – layer 3 uplink frames

The rows "Message x" in the "Layer 3" page contain the following parameters:
● "PD and MT"

Indicates the protocol discriminator (PD, first two characters) and the message type
(MT) of the GSM or GPRS layer 3 message that is modified. See Figure 6-109.

● "Mask [Hex]"
Mask to be applied on the GSM or GPRS Layer 3 messages for the modification.

● "Data [Hex]"
Data to be used for modification.

Autodialing

Autodialing function provides the mode where a mobile periodically attempts call to a
network by dialing a definite phone number. This mode is relevant for the network qual-
ity analysis described in "NQA settings" on page 1547.

The autodialing mechanism of the mobile drivers supports the IRAT handover test
automatically with the "Call will be initiated if the UE is registered with option", see
"Preconditions" on page 1541.

The "Autodialing" configuration dialog is shown in the following figure.
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Figure 6-92: Driver configuration – autodialing (single mode)

Actions
The check boxes in "Actions" activate automatically the following call options:
● "Dialing"

If the box is checked, the mobile sets up the periodic calls using the parameters in
the remaining panels of the "Autodialing" dialog. The autodial function is useful for
many applications, in particular for the Network Quality Analysis (NQA).
Sometimes, the NQA state machine has difficulties if a new call is started when the
previous one was not finished (DISCONNECT message was sent, but RELEASE
was not yet received). This case happens, for example, if one call lasts longer than
specified in "Call Window".
The mobile autodialer algorithm inserts a pause after a call has terminated to pre-
vent a new dial attempt during radio resource cleanup. The pause is to be set in
"Autodialing" on page 1536.
The autodialing mechanism works as follows:
The pause time is calculated from the settings made in the "Timing" pane of the
autodialer configuration page. Therefore, the sum of the maximum access time and
the call duration is subtracted from the overall call window duration.
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The mobile and the network are given a chance to clean up a call properly even in
case the call takes longer than the overall call window.

The minimum value for a pause time is 5 seconds. Even if a shorter pause is
defined in the configuration dialog, the autodialer will append such a delay to each
call after a hang up has been triggered.

● "Answering"
If the box is selected, the mobile automatically accepts all incoming calls after a
certain number of ring tones.

● "Autostart"
If the box is selected, autodialing starts automatically with the measurement.

Subscriber number
Selects the subscriber number. Usually the subscriber number is received automati-
cally by the driver.

Mode
Two option buttons switch between single call and multi call mode.
● A single call is set up according to the settings in the remaining panels of the

"Autodialing" tab, see Figure 6-92. The call is periodically repeated if "Use autodial"
is activated.

● A multi call is a sequence of calls with individual call settings, to be configured in
the multi call version of the "Autodialing" dialog, see the following figure.
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Figure 6-93: Driver configuration – autodialing (extended mode)

If "Use autodial" is activated, the call sequence periodically repeats.
Note: Autodialing can be limited for the mobiles to initiate a call in "Only LTE", see Fig-
ure 6-97.

Type of Call
Several drivers display the "Type of Call" panel.
● "Voice Call"

All GSM test mobiles support voice calls.
● "Data Call"

If the driver is loaded, the R&S ROMES4 automatically initializes the data call ser-
vice using an appropriate AT command.

● "Video Call"
Video calls are not possible with GSM mobiles.

Timing
Defines the periodicity of the autodial process.
● "Constant Call Pattern (ETSI Specification)"

If this option is checked, the calls are repeated in the fixed Call duration/Call Win-
dow pattern. It is irrelevant if a connection is released or lost before the end of the
call duration. This setting is in accordance with IREG specifications and ensures
that several connected test mobiles operate synchronously.
In the alternative setting, the call duration ends and the next Min. Pause Time start
at the moment when a call is lost. This setting ensures that a maximum number of
calls per unit of time can be set up at fixed call duration and idle time.
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● "Max. Access Time"
Maximum time allowed for cell access. If no call can be established within this time,
the call is classified as a blocked call.

● "Call Duration"
Time between start and release of a call in the range between 15 s and 86400 s.
For some mobiles, it can be necessary to set the call duration higher than 15 s,
e.g. to 25 s. Such setting provides a Good Call.

● "Min. Pause Time"
The minimum pause time is automatically calculated as
"Call Window – (Max. Access Time + Call Duration)"
An example:

Figure 6-94: Wrong setting in Timing

If the resulting pause time is less than 10 seconds, an error message is issued and
the Call Window is increased correspondingly:

Figure 6-95: Warning about the setting

Figure 6-96: Correct setting in Timing

● "Call Window"
Time between two subsequent call attempts, including the access time, the call
duration and a possible idle time until the next call is initiated. The Call Window is
available while "Constant Call Pattern" is enabled.

● "Offset"
Time offset for dialing. Different offset times for different test mobiles (for example,
0 s for the first, 20 s for the second mobile) ensure that the test mobiles do not dial
simultaneously. Possible problems in the connection setup are avoided.

● "Endless call"
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For an endless call (box checked), the call duration is set to infinity; the Call dura-
tion input field is disabled. "Endless call" is disabled while Constant Call Pattern
(ETSI Specification) is selected.

Data Call
If a data call is selected, then the input fields in the "Data Call" panel are enabled. They
provide a subset of the possible parameters for the +CBST call control command
described in standard 3GPP TS 07.07. The values depend on the test mobile type.
● "Speed"

Baud rate of the data connection. The test mobile provides automatic baud rate
selection according to the quality of the radio link.

● "Bearer Service"
The value "data circuit asynchronous (UDI or 3.1 kHz modem)" cannot be
changed.

● "CE"
Connection Element; the value "non-transparent" cannot be changed.

Subscriber Number
The Subscriber Number, which is mandatory for SQA, is entered or selected in this list
field.
The number must be entered using the international format, e.g. (089) 12345678 would
be entered as "+498912345678" without fillers (such as blanks or hyphens).

Phone Numbers
One or more phone numbers can be entered via the keyboard and the input field.

Calling Conversion
R&S ROMES4 requires phone numbers in international format, including the ‘+’. How-
ever, on some mobiles the ‘+’ cannot be emulated. Thus, replace it by the national
numbers to access the international network. Former this replacement was done with
‘00’. But several regions use other numbers. Now this number can be defined here.
The default value is ‘00’, which reflects the former behavior.

Preconditions
The "Preconditions" panel sets home network-related parameters:
● "Call will be initiated if UE is registered with:"

The initiation of a call can be set to depend on the activation of the technology.
Possible options are: "Any RAT", "Only UMTS", "Only GSM" or "Only LTE".
The option "Call will be initiated, if UE is registered with:" allows you to specify the
RAT in which the UE has to camp before a call is initiated. If the UE does not camp
on this RAT at the point in time when the call is initiated, the trigger for the call is
ignored. No NQA message is generated in this case.

Test devices



Hardware ComponentsDrive Test Software

1542Operating Manual 1171.6415.12 ─ 66

Figure 6-97: Calling convention and preconditions

NOTE: In older version, R&S ROMES4 generated a NO_SERVICE message in this
case.

● "Hangup call, if an IRAT handover occurred"
The "Hangup call, if a IRAT handover occurred." option lets users end a call when
the IRAT handover took place. A new NQA event Call Canceled will be reported
after the UE returned to the idle mode. If the option is not activated, the call pro-
ceeds in the new RAT until the point in time defined in the autodialer.
The setting is reported in the measurement file information.

Canceled Calls are reported in the following Views:
– "Layer 3 View"

Figure 6-98: NQA: Call Canceled

– "ETSI QoS View"
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Figure 6-99: Result: Call Canceled

● "Verify network before start"
If "Verify network before start" is checked, the mobile is out of service if a call is
attempted from a foreign network (e.g. during a measurement tour near the border
of a network where roaming is possible). This verification ensures that calls from
foreign networks will not impair the network quality analysis; see next section.
By default, the "verify before start of call" function is not active.

● "MCC/MNC"
Mobile country code (MCC) and mobile network code (MNC) together identifies the
home network.

●

Tap the button to open the home network selection dialog.

Figure 6-100: Selection of the PLMN
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The "Autodialing" configuration menu changes if the "Mode" > "Extended" is selected,
see Figure 6-92 and Figure 6-93.
A multi call is a sequence of single calls with independent call settings. The settings for
each call are identical to the single call settings described previously. The individual
calls are listed in the center of "Call Generator". If "Constant Call Pattern" is activated,
the timing settings in this panel are valid for all calls in the list.
The buttons to the right of the list add or remove calls from the list and edit or modify a
selected call, respectively. "Add Call" or "Edit Call" opens the following "Call Settings"
dialog.

Figure 6-101: Call Settings (multi call type)

If "Constant Call Pattern" is activated, the "Call Settings" > "Timing" setting is dimmed.

GSM/GPRS forcing

The "GSM/GPRS Forcing" dialog lets you select the GPRS/GSM related parameters of
the mobile phones supporting GPRS.
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Figure 6-102: Driver configuration – GSM/GPRS forcing

GPRS Forcing Options
The GPRS parameters to be forced at the mobile phone can be selected in the "GPRS
Forcing Options" panel from several pull-down lists. Each of the lists is activated by
checking the box associated to the parameter. Otherwise, the parameter is not
enforced and the mobile uses its default value.

Multislot Class ← GPRS Forcing Options
Select the GPRS multislot class according to GSM 05.02. The list indicates the MS
class no. (1, 2, 4) plus (in brackets) the maximum number of receive and transmit time-
slots that the MS can use per TDMA frame.

DL Coding Scheme ← GPRS Forcing Options
Select the coding scheme (CS1 to CS4) for downlink data transfer.
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GPRS Auto Attach ← GPRS Forcing Options
Select whether the mobile device is automatically attached to the GPRS network at
power-up ("On") or not ("Off"). If it is set to "Off", the MS only attaches upon PDP Con-
text Activation.

MS GPRS Class ← GPRS Forcing Options
Select the GPRS class of the MS ("Class B" or "Class C").

UL Coding Scheme ← GPRS Forcing Options
Select the coding scheme (CS1 to CS4) for uplink data transfer. Disabling this item
gives the MS/network the decision.

EGPRS UL MCS ← GPRS Forcing Options
If the checkbox is activated, the related list allows the selection of the EGPRS uplink
coding scheme (MCS1 to MCS9, MCS5–7, and MCS6–9). Disabling this item gives the
MS/network the decision.

GPRS only (disable EGPRS) ← GPRS Forcing Options
The activation of this checkbox forces the use of GPRS. Disabling this item gives the
MS/network the decision.

GSM Forcing Options
General GSM parameters can be set in the "GSM Forcing Options" panel.

Power Class ← GSM Forcing Options
Power class of the MS while in GSM900 or GSM1800 mode. The GSM standard
defines power classes 1 to 5.
Table 6-3: Power classes of GSM mobiles

Power
class

GSM900 GSM/GSM1800 GSM/GSM1900

1 - 1 W / 30 dBm 1 W / 30 dBm

2 8 W / 39 dBm 0.25 W / 24 dBm 0.25 W / 24 dBm

3 5 W / 37 dBm 4 W / 36 dBm 2 W / 33 dBm
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Power
class

GSM900 GSM/GSM1800 GSM/GSM1900

4 2 W / 33 dBm - -

5 0.8 W / 29 dBm - -

The power class can be decreased. However, it is not possible to go beyond the high-
est supported power class of the selected mobile type. See the overview of power
classes and power control levels in Table 12-16.

Use Full Rate ← GSM Forcing Options
If checked, the MS is forced to use either Full Rate or Half Rate but not Enhanced Full
Rate (EFR) data transfer mode. "Use Full Rate" becomes unavailable if an EFR codec
is selected explicitly.

AMR Disable ← GSM Forcing Options
If checked, prevents the test mobile from activating an Adaptive Multi Rate (AMR FR or
AMR HR) codec. The test mobile uses its Full Rate (FR), Half Rate (HR), or Enhanced
Full Rate (EFR) codec.
"AMR Disable" becomes unavailable if an AMR codec is selected explicitly.

Preferred Voice Codec ← GSM Forcing Options
Explicit selection of a voice codec for the test mobile to use. The explicit voice codec
selection can possibly overwrite the "AMR Disable" and "Use Full Rate" settings.

The voice codec selection ensures that a test mobile does not change its voice codec,
which can have an undesired impact on the measurement results.

NQA configuration

The Network Quality Analyzer (NQA) configuration dialog, "NQA Settings", lets your
set the parameters for a network quality analysis. NQA is a prerequisite for drawing up
a call statistic where the calls are classified and the classes are visualized separately.

NQA settings

The "NQA Settings" configuration dialog is identical for all GSM mobile drivers.
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Figure 6-103: GSM driver configuration – NQA settings (all drivers)

Use NQA
If checked, the network quality analysis is active (default).

NQA Parameters
The following numeric parameters configure the NQA by defining conditions and limits
for the different call classes (the ranges for all parameters are quoted; default values
are underscored):
● "Handover Maxcount"

Maximum number of handover procedures during a call in the range 1 to 100.
Default value is 5. If the defined value is exceeded, the call is classified as EXCES-
SIVE HO.

● "Blocked Call Delay"
Maximum delay (in seconds) between CM_SERV_REQ and ASSIGNMENT_COM-
MAND in the range 1 (s) to 63 (s). Default value is 15 (s). If the defined delay is
exceeded, the call is classified as DELAYED CALL.

● "RxLev Threshold"
Minimum received signal input level in the range 1 to 63. Default value is 20.
RxLev values which fall below this threshold contribute to NOISY.

● "RxLev Exceed Perc."
Minimum ratio (in percent) of reported RxLev values falling below the RxLev
Threshold in the range 1 (%) to 99 (%). Default value is 50 (%). If the actual ratio
falls below the specified percentage, the call is classified as NOISY.

● "RxQual Threshold"
Maximum value of RxQual (i.e. minimum received signal quality) in the range 1 to
7. Default value is 4. RxQual values above this threshold contribute to NOISY.
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● "RxQual Exceed Perc."
Minimum ratio (in percent) of reported RxQual values exceeding the RxQual
Threshold in the range 1 (%) to 99 (%). Default value is 50 (%). If the actual ratio
exceeds the specified percentage, the call is classified as NOISY.

RxLev/RxQual Source ← NQA Parameters
The buttons in the "RxLev/RxQual Source" pane determine the type of values used for
the NQA:
● "Use RxLev/RxQual Full"

Both parameters are assessed over the full range of TDMA frames within a
SACCH block

● "Use RxLev/RxQual Sub"
Both parameters are assessed over a subset of 12 TDMA frames

The full and sub-values are displayed separately in the Chapter 4.4.18, "Serving cell
view", on page 999.
Note: Important note on NQA in downlink DTX mode. If the BTS uses discontinuous
transmission (DTX), the BTS transmitter is switched off during time periods where no
information needs to be transferred. The BTS (downlink) signal shows strong variations
in time resulting in a large difference between the measured "RXLev/RXQual Full"and
"RXLev/RXQual Sub" values. The NQA must be performed with the "Use RxLev/
RxQual Sub" option, otherwise it generally underestimates the network quality.

NQA Monitoring
If checked, "NQA monitoring active" activates the network quality (NQA) monitoring. In
this mode, a message is displayed in the Chapter 4.2.7, "General status view",
on page 501 when the number of blocked calls, dropped calls, or no service calls rea-
ches the entered value in the related input field of the NQA monitoring panel.
An example for the "General Status View", the messages are shown in the following
figure.

Figure 6-104: NQA reports in General Status View

Display of results

The displayed statistic related to NQA monitoring, classifies voice calls as following:

● "Good"
Good is every call successfully established and terminated by the system within
the time set in "Autodialing" > "Call duration".
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● "Blocked"
A call is qualified as blocked if one of the following applies:
– An idle message was detected during call setup but the call was not canceled.

This happens in all cases where a call setup was performed at least up to the
SERVICE REQUEST Layer 3 message . The idle message does not appear up
to message ALERTING / CONNECT and where no DISCONNECT, RELEASE
or CHANNEL RELEASE was executed, or

– The call was canceled, call setup was not performed up to ALERTING and/or
CONNECT.

– A dial command has been sent to the mobile at a moment with sufficient cover-
age, but because of temporarily insufficient coverage no call could be estab-
lished. The NQA state machine remains IDLE. On the next dialing, the system
recognizes that no call could be established and one blocked call is added.

● "Dropped"
A call is qualified as dropped if one of the following applies:
– An established call is canceled before the "Call duration" set in the "Autodial-

ing" tab has passed, or
– An established call is terminated. An NQA data package is generated when an

"Idle" or "Error (No Service)" state is detected after a call was established and
the "Call duration" has not passed yet.

● "No Service"
A "No service" call is added every time the system wants to dial but the mobile is
out of service. If the mobile remains out of service the time interval between two
subsequent "No service" calls is equal to the "Call duration" plus the "Idle time",
both set in the "Autodialing" tab.

● "Call Cancelled"
A call is canceled if one of the following applies:
– Manual hang up by user
– Stop measurement during a call
– Called party did a hang up
– Call starts in a certain RAT, for example, in UMTS and during the call the RAT

changes, for example, to GSM and the "Hangup call, if a RAT handover occur-
red" is checked. See "Calling Convention / Preconditions" in the Figure 6-93
and refer to "Preconditions" on page 1541.

Figure 6-105: Voice call canceled
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A single call can fit into more than one class and can therefore contribute to several
bars. The percentages do not necessarily sum up to 100 %.

Handover analyzer

The "Handover" configuration dialog lets user enable or disable the GSM handover
analyzer (the R&S R&S ROMES4HOA option) and set the timeout for the HO analysis.

The HO analysis and the meaning of the timeout is described in Chapter 4.4.10,
"3GPP handover analyzer view", on page 898. The dialog is identical for all GSM
mobile drivers.

Figure 6-106: GSM driver configuration – Handover Analyzer

Receiver

The "Receiver" configuration dialog lets the user set the tracking mode where the
mobile phone controls a CW test receiver (the R&S TSME CW) and set its receive fre-
quency. In tracking mode, the measurement must be performed on a single frequency
channel although the test receiver is able to measure at several frequencies simultane-
ously.

The "Receiver" dialog is identical for all GSM and UMTS mobile drivers.

Remarks about the tracking mode

The selected tracking mode has an impact on layout of some device's configuration
menus and views.
● In the tree views for data selection, for example, in the "2D Chart View" > "Values"

configuration menu, the main channel instead of the measurement frequency is
displayed for the mobile phone which controls the test receiver.

● The settings of the test receiver channels controlled by previously mentioned
mobile phone cannot be changed in the "Measurement Settings" of the test
receiver driver configuration menus, see Figure 6-416.

● Each channel change and each used receiver generate an event in the measure-
ment data. These events can be viewed together with all other events in the "Event
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View", the "ROMESMAP Route Track View" and the "2D Chart View". Also, each
channel change is indicated in the "General Status View".

Connected Receivers
List of test available receivers. To connect an additional test receiver, click the "Con-
nect Receiver" button. To remove a test receiver from the list, select the receiver and
click the "Disconnect Receiver" button.

Available RF Rx Paths
List of receiver signal paths, receiver, and receiver jobs assigned to each path. To
select an additional job to be done, click the "Job Management" button.

Activate Rem. Rec. Jobs
If the box is checked, the jobs that are shown in the "Available RF Rx Paths" table will
be done after "OK" is clicked and the configuration menu is closed.

Connect Receiver
The "Connect Receiver" button opens a selection dialog showing all test receivers
available as secondary.
Test receivers are not shown in the pull-down list before the test receiver drivers are
loaded. Click the "Load Secondary" button to call up the "Load Secondary" window and
select a test receiver to be loaded and shown in the pull-down list.
Use the R&S TSME receiver drivers for tracking.
● "OK"

Connect the selected test receiver, add it to the list of "Connected Receivers" in the
"Remote Receiver" tab and close the "Load Secondary" window.

● "Cancel"
Close the "Load Secondary" window without connecting a test receiver.

Disconnect Receiver
The "Disconnect Receiver" button disconnects the receiver selected in the list of "Con-
nected Receivers".

Job Management
The "Job Management" button opens the "Assign Job to Remote Receiver" dialog to
create or select a job and assign it to a remote test receiver.
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Figure 6-107: Job assignment to remote receiver

The job to be assigned to the remote receiver can be selected from the "Available
Remote Receiver Jobs" list. A description of each job is displayed below the list when
the job is selected.
● Serving Cell Tracking

The frequency of the receiver channel follows the BCCH of the server report.
● Two Channel Serving Cell Tracking

Channel A follows the strongest NC, one channel B the SC. After the SC changed,
the channel A tracks the SC which was supposed to be the strongest NC, and
channel B now tracks the new NC.

● Adjacent Ch. plus Serving Cell Tracking
One frequency of the receiver follows the BCCH of the server report. Two other fre-
quencies follow both adjacent channels of the BCCH.

● Upper Adjacent Channel Tracking
The receiver channel follows the upper adjacent channel of the C0 carrier.

● Lower Adjacent Channel Tracking
The receiver channel follows the lower adjacent channel of the C0 carrier.

● Uplink Serving Cell Tracking
The frequency of the receiver channel follows the uplink channel of the SC.

● OK
Assign the selected job to the receiver selected in the "Remote Receiver > Con-
nected Receivers" list and close the current dialog.
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● Cancel
Discard the current selection and close the dialog.

● Create Job
Activate the selected job and add it to the "Active Remote Receiver Jobs" list.

● Remove Job
Remove the selected job from the "Active Remote Receiver Jobs" list. This soft key
is disabled if the list is empty or if no job is selected in the list.

● Configure
Open the "Select Channel" dialog to assign one or several receiver channels (RF
Rx Paths) to the job selected in the "Active Remote Receiver Jobs" list. The "Con-
figure" soft key is disabled if the list is empty or if no job is selected in the list.
Some jobs require several channels which can be provided by one or several test
receivers.
The "Select Channel" dialog displays all channels that are available but not yet
assigned ("Available RF Rx Paths") and the channels that are already assigned to
the current job ("Current Job Settings"). Double-click on a channel in one of the
tables to move it to the other table.

QoS tests

The "QoS Tests" configuration dialog lets the user periodically initiate the number of
procedures in the GPRS mobiles being in dedicated mode, for example:
● GPRS mobility management actions ("GPRS Attach/Detach")
● Routing Area Update
● GPRS packet routing actions ("Activate/Deactivate PDP Context")
● GSM layer 3 actions ("Location Area Update")
● Cyclic Handover

A statistical evaluation of the actions provides an overview of the Quality of Service
(QoS), e.g. the amount of network resources given to the mobile. It can be displayed in
the "GSM QoS View".

To be recorded and evaluated, the actions must be enabled in the "QoS Statistics" dia-
log of the driver configuration menu. See "QoS statistics" on page 1557.
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Figure 6-108: GSM driver configuration – QoS tests

The entries "Periodic GPRS Attach/Detach", "Periodic PDP Context Activate/Deacti-
vate" and "Periodic Location Update" are analogous.

● Enable/Disable
The three types of periodic actions mentioned in the previous sentence can be acti-
vated independently. They are compatible with each other.
GSM test devices can be used for various automatically controlled, periodic tests,
for example, Autodialing and DQA analysis. Some of the periodic tests cause con-
flicts when activated simultaneously. For example, the QoS test functions cannot
be performed after a call releasing with autodialing function.

● Pause after Location
Defines the periodicity of the following actions:
– The GPRS Attach/Detach cycle consists of an attach, followed by the pause

after attach, detach, and pause after detach.
– The PDP Context Activate/Deactivate cycle consists of a PDP context activate,

followed by the pause after activate, PDP context deactivate, pause after deac-
tivate.

– The Location Area Update cycle consists of the location update procedure fol-
lowed by the pause after Location Update.

● Init String
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PDP Context +CGDCONT command specifies PDP context parameter values for
a PDP context identified by the (local) context identification parameter (first
numeric parameter after “=”). The command is described in standard 3GPP TS
07.07 and is preset as shown in Figure 6-108.
PDP Context +CGDCONT command specifies PDP context parameter values for
a PDP context identified by the (local) context identification parameter (first
numeric parameter after “=”). The command is described in standard 3GPP TS
07.07.
In most networks, adjusting the third string parameter ("Access Point Name
(APN)", preset as "internet") is sufficient to activate a PDP context.

Cyclic handover

Configures the neighbor cell BCCH and timing parameters necessary for cyclic hand-
over that a GPRS mobile can initiate while it is in dedicated mode (during a call).

For cyclic handover, the mobile manipulates the received signal strengths in its
receiver reports. The manupulationis in such a way that the network periodically ini-
tiates a handover to a given neighbor cell. The cells are arranged in a BA list. The
mobile cycles through the list, lingering in each cell for a definite amount of time.

The process is stopped if one of the cells is no longer detected, so cyclic hand-over is
typically tested on a fixed location. Cyclic handover and manual handover exclude
each other. Perform cyclic handover tests in autodial mode and with endless call dura-
tion, see "Autodialing" on page 1536.

If the network fails to initiate a handover, the "General Status View" displays a timeout
warning. Other warnings and error messages (for example, "Autodial switched off",
"Telephone number is empty", "No endless call selected", "BA list empty") are also dis-
played in the "General Status View".

The "Cyclic Handover" button opens the following dialog.
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Cyclic handover must be enabled explicitly by checking the "Enable Cyclic Handover"
checkbox. The BA list contains the BCCH channel numbers of all cells to be allocated
during the cyclic handover process. The mobile dwells in each cell for a definite "Linger
time". The "Add", "Edit", and "Delete" buttons are used to modify the BA list and its
entries.

QoS statistics

Statistical evaluation of the actions initiated by the previously mentioned actions like
Attach Request or Handover Command provides an overview of the quality of ser-
vice, e.g. the amount of network resources given to the mobile. The "GSM QoS View"
shows the amount of resources given to the mobile.

Figure 6-109: GSM driver configuration – QoS statistics
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Message / GSM/GPRS
List of layer 3 and RLC/MAC control messages generated or received by the mobile.
The actions initiated by the checked messages are included in the measurement file.
The messages are related to either GSM or GPRS service.

Timeout
Maximum time that the selected actions can take until they are classified as "No
Response" actions. For mobile-initiated actions, the time is measured from the time the
mobile transmits the REQUEST message to the time it receives the response from the
network.

An individual timeout can be set for each selected action.

Templates

The "Templates" dialog lets the user store the current driver configuration as a tem-
plate, lists, load or delete the driver templates. It is identical for all GSM mobile drivers.

When a driver is loaded using the "Hardware > Connect/Disconnectd/Remove" com-
mand, see Chapter 6.1, "Devices", on page 1447, the R&S ROMES4 checks whether a
driver template is stored in the Driver Templates directory and its subdirectories. The
driver can be loaded with default settings or with the settings stored in any of the tem-
plates found.
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Figure 6-110: GSM driver configuration – templates

Load/Delete
The buttons load, delete respectively a driver template or delete a template displayed
in the "Available Templates" list. Template files are ASCII files with the extension
*.template. The template definition is independent from the workspace. A selection
of template files for different drivers is supplied with the R&S ROMES4 installation.

Save
Saves the current driver settings together with the "Description" to a selected template
file.

Serial port driver info

The "Serial Port Driver" tab displays the custom name of the device, information on the
file version of the technology driver, the serial port assigned to it and the transfer
parameters. The "Custom Name" is used to assign a name to a test device, e.g. to
make a quick association of a test device to its designated test network provider.

Also the expected amount of produced driver data per time unit can be set. See also
Chapter 6.3, "Devices observation", on page 1510.

The configuration dialog identical for all GSM mobile drivers.
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Figure 6-111: GSM driver configuration – serial port

Raw data logging is not available for GSM mobile driver.

Custom Name
Used to assign a name to a mobile, e.g. to make a quick association of a test mobile to
its designated test network provider.

OK
Confirms all settings made in the "Driver Configuration" menu and closes the menu.
If any of the settings made are wrong (i.e. not compatible with the connected device),
an error message box pops up.

Cancel
Discards all changes made and closes the "Driver Configuration" menu.

6.4.4.3  Action menu GSM

The "Action" menu opens commands used to perform various actions at the mobile
phone, for example, to set up a call, force a handover to a neighbor cell, perform a
location update. The menu is added to the menu bar when a mobile driver is success-
fully installed, see the chapter Chapter 6.1, "Devices", on page 1447. The "Action"
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menu and its functionality depend on the driver and mobile type. If several mobiles are
connected, separate command lines are displayed for each of them.

Figure 6-112: Action menu of a GSM mobile device

Handover

Switches over to one of the six neighbor cells if possible.

Handover is possible in dedicated mode (during a call) only. The "Handover" command
opens a dialog box (equal for all drivers). On the bottom of the dialog, the current forc-
ing state is displayed.

1

2
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3

4
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Figure 6-113: The four screenshots show the steps of a handover

● No Forcing
Cancel all forced handover procedures and return to normal measurement mode.

● Suppress
Suppress a handover. Only possible if the mobile supports this functionality.

● Force to BCCH
An editable drop-down list lets you enter any neighbor cell or to select one from a
list of all visible neighbor cells. In case the mobile station can measure more than
six, they are also in the list. Every time the dialog is opened the list is updated. Or
by clicking the refresh button.

●

Refresh button. Updates the list of the neighbor cells.
● Force

Initiates a forced handover to the selected neighbor cell. This forcing can be done
several times in succession. After a forced handover, the mobile is locked on the
former neighbor cell which is now the serving cell.

The current action is indicated in the two output fields below the buttons.

This function is only possible in NORMAL measurement mode.

Handset (GSM)

Activates the entry of a number to dial, set up and terminate a call.
● Handset

The "Handset" command opens a window (equal for all drivers) which have two
possible statuses:
– Not selected
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– Selected, marked with "- *" and shown in the following figure as connected
mobile [2].

If there is only one "Handset" window, it always has selected status.
If there is more than one "Handset" window, the selected status can be set to any
"Handset" window in one of two listed ways:
1) Click to the window using a mouse.
2) Choose selected window using the "N" key. In this case selection changed like
this: Window[1] > press "N"> Window[2] > press "N"> ...Window[n] > press "N">
Window[1] (cycling choose like "Alt+Tab" between open windows in MS Windows).
Only selected windows accepts hotkeys “D” ("Dial"), “A”("Answer"), “H”("Hangup").
Note: The previously mentioned keys have only effect, if the focus is not set to an
input control, example-given edit field or combo box.
Example: if you select the phone number by selecting the corresponding entry of
the combo box, the keys do not work afterwards. Set the focus to another window,
for example to the main R&S ROMES4 window.

● >>
The ">>" button enlarges the dialog box, giving access to the Key pad and the
"Autodialing" option.

Figure 6-114: Use Autodialing
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Figure 6-115: No Autodialing

● Dialed number
The number to be dialed can be entered either via the keyboard and the input field
or by clicking the on-screen keypad.

● "Close window ⊠"
Closes the window without any further action.

● "Dial"
Starts dialing the number entered before.

● "Answer"
Instructs the phone to accept the call.

● "Hangup"
Drops the line.

● "Autodialing"
If the box is checked, the phone number entered below is called periodically, the
"Dial", "Answer", and "Hangup" buttons are disabled (grayed). The autodialing
mode can be set even during the measurement, but only in "Idle mode".
This item starts "Autodialing" if the "Start with Measurement option" was not
checked in the driver configuration-autodialing tab panel.

AT Command
● Enter the command to send.
● Click "Send".
The command is directly sent to the test device. This functionality is provided by the
Qualcomm drivers.
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AT commands are logged into the RSCMD file and visualized in the "2G/3G Layer 3
View".

Do cyclic forced handover

Forces the mobile cyclically to attempt a handover procedure, see "Cyclic handover"
on page 1556. It is grayed unless the mobile is in dedicated mode (during a call).

Force GPRS attach

Forces the mobile phone to attempt a GPRS attach.

Force GPRS detach

Forces the mobile phone to attempt a GPRS detach.

RxLev calibration

The "RxLev Calibration" button opens a dialog to activate the calibration of the
received signal level reported by the mobile devices.

The RxLev calibration is based on a comparison between the RX level values reported
by the mobile and the actual RX levels applied to the mobile receiver. This comparison
can be drawn with a CMD Digital Radio Communication Tester and the R&S MobCal
software tool.

Presently, RxLev calibration is implemented only with GSM900 and GSM1800. The
calibration can be used for single-band and for GSM900/1800 dual-band mobiles. For
GSM-E or GSM-R calibration, the values of BCCH 1 are used.
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For dual-band mobiles, two separate correction table files have to be created for the
two GSM bands, and they must be stored in the \driver\ subdirectory of the R&S
ROMES4 program directory.

To be recognized as two files belonging to the same mobile, the two correction tables
must be named as follows:
● For GSM900: <IMEI 8 last significant digits> <exit> (e.g. 12345678.cm)
● For GSM1800: <IMEI 8 last significant digits>_D <exit> (e.g. 12345678_D.cm)

If the file name does not follow this convention, a file open dialog prompts for the wan-
ted *.<ext> file at start of measurement.

Table 6-4: The file extensions are used as follows:

<ext> is used for...

.CM Normal and Camp measurements

Important notes
● A correction table file (ASCII) contains a maximum of 50 different channels.
● Channels others than 1 to 124 in the first file and 512 to 855 in the second file are

not allowed and could lead to crashes
● Level lines are between -110 dB and -35 dB in 1 dB steps in a 3-dimensional

matrix.
● Between the channels, the calibration value is linearly interpolated. Outside, the

last valid value is extrapolated. Between two level lines, the calibration value is lin-
early interpolated.

Example: A simple .CM file
The following file is an example with 3 channels (Ch 1, 40, and 124) and 9 level lines.
The shown calibration values change linearly from 1.0dB to 1.2dB.

{[D]};15.09.104;12:05:55;11:16:52
{[T]}25;25;25
{[M]}GSM; 350639.07.031008.0; 206.10.2000005178;4
{[F]}CM;GMSK;0.00
{[O]}1;-110;10
{[O]}1;-101;10
{[O]}1;-77;10
{[O]}1;-57;10
{[O]}1;-53;10
{[O]}1;-51;10
{[O]}1;-50;10
{[O]}1;-49;10
{[O]}1;-48;10
{[ ]} 
{[O]}40;-110;11
{[O]}40;-101;11
{[O]}40;-77;11
{[O]}40;-57;11
{[O]}40;-53;11
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{[O]}40;-51;11
{[O]}40;-50;11
{[O]}40;-49;11
{[O]}40;-48;11
{[ ]} 
{[O]}124;-110;12
{[O]}124;-101;12
{[O]}124;-77;12
{[O]}124;-57;12
{[O]}124;-53;12
{[O]}124;-51;12
{[O]}124;-50;12
{[O]}124;-49;12
{[O]}124;-48;12
{[ ]}

Table 6-5: Explanation of the line identifiers

Identifier Meaning of succeeding parameters

{[D]} User*);Date*);Time*);Duration of creation*)

{[T]} Room temp*);Mobile temp. (start)*);Mobile temp. (end)*)

{[B]} CMD TxPower (start)*);TCH (start)*);Tslot (start)*);used Tslot(dBm)*);unused Tslot (offset
dB)*)

{[M]} Network type*);IMEI*);IMSI*);power class*)

{[F]} CM;GMSK;0.00 // Type of corr.file CM; GMSK|CW*); FreqOffset in KHZ*)

{[O]} Channel; Level line RxLev in dB; calibration offset in 1/10 dB

{[ ]} Separator

*) not used so far

6.4.5  UMTS mobile devices

The R&S ROMES4 measurement system provides UMTS mobile drivers for the UMTS
test mobile devices based on the Qualcomm chipsets 6200, 6250, 6275, 6280, 7200,
7201 and 8200.

A driver is installed as described in Chapter 6.1, "Devices", on page 1447.

How to configure the UMTS mobile devices is described in the following sections. The
maximum number of test mobiles to be used simultaneously is limited by the option
file, by the number of interfaces and the performance of the controller. The test mobiles
must be connected via USB interface, see Chapter 6.1.4, "Connection via USB inter-
face", on page 1456.
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USB interface for power supply of Samsung mobiles
The Samsung mobiles rely on the USB interface for their power supply. A supply cur-
rent of approx. 0.5 A is required.
Check the specification of your USB interface, especially when connecting several
Samsung mobiles or other power-consuming devices in parallel. If necessary, use a
self-powered USB hub.

All UMTS channels and frequencies are listed in Chapter 12.9, "UMTS channels",
on page 2405.

The Qualcomm chipset-based test mobiles can be used to acquire data for most of the
UMTS and UMTS/GSM views, see Chapter 4.4.3, "UMTS views", on page 742 and
Chapter 4.4.12, "3GPP overview view", on page 923. Limitations are listed in the fol-
lowing table.
Table 6-6: Supported Views of Qualcomm test mobiles (excerpt)

View Qualcomm MSM
6200-/6250-based

Qualcomm MSM
6275-/6280-/

7200-/7201-based

Qualcomm MSM
8200-based

UMTS Finger Data View Yes Yes Yes

UMTS Cell Set View Yes, active set

and neighbor set

Yes, active set

and neighbor set

Yes, active set

and neighbor set

UMTS NAS Status View Yes Yes Yes

UMTS TrCH View Yes Yes Yes

UMTS Physical Channel View Yes Yes Yes

UMTS SIB View Yes Yes Yes

UMTS RLC/MAC View Yes Yes Yes

UMTS Measurement Report View Yes Yes Yes

UMTS Reselection View Yes Yes Yes

UMTS Power Control View Yes Yes Yes

UMTS Layer 1 Graph View Yes Yes Yes

All UMTS HSDPA Views No Yes Yes

All UMTS HSUPA Views No Only 72xx Yes

UMTS HSPA L2 Statistic No No Yes

2G/3G Layer 3 View Yes Yes Yes

2G/3G ETSI QoS View Yes Yes Yes

UMTS/GSM Overview Yes Yes Yes
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Analogous to GSM, the UMTS test mobiles and drivers are grouped into the R&S sup-
port classes 1 and 2. The mobiles of R&S support class 1 are continuously tested with
new R&S ROMES4 versions and service packs. They are permanently available to our
testing staff. The mobiles of R&S support class 2 are not always available for testing,
but they have been tested successfully at least once with the current R&S ROMES4
software release. The introduction of the R&S support classes is necessary due to the
sheer number of supported mobiles. The mobile types with R&S support class 1 are
listed with normal title typeface in the table below. The mobiles with R&S support class
2 are marked with italic title typeface.

To see test mobile devices that are supported by R&S ROMES refer to
Supported Test Mobiles ROMES.pdf file which is found in
the ..\Documents\ReleaseNotes\ of the delivered R&S ROMES DVD.

UMTS services are available for PCMCIA slot-based data cards. The following cards
(based on the Qualcomm chipset) are supported.
Table 6-7: UMTS properties of UMTS test data cards

Manufacturer: Novatel Wireless Manufacturer: Option Manufacturer: Sierra Wireless

● Merlin U740
UMTS 2100 MHz + HSDPA
1.8 MBit
GSM850/900/1800/1900
+ GPRS + EDGE

● Merlin U870
UMTS 2100 MHz + HSDPA
7.2 MBit
GSM850/900/1800/1900
+ GPRS + EDGE

● Globetrotter GT 3G +
EMEA
UMTS 2100 MHz + HSDPA
1.8 MBit
GSM 900/1800 + GPRS

● A850/A875
UMTS 2100 MHz
GSM 900/1800 + GPRS

6.4.5.1  UMTS devices configuration menu

The "Qualcomm" based devices' configuration menu contains various tabs with the fol-
lowing functions:
● "Configuration" and "Expert Mode" to select the message types evaluated by the

test system
● "NQA" to configure the network quality analysis
● "Autodialing" for autodialing and autoanswer call mode
● "Serial Port Driver Info" to display information on the driver and the assigned serial

port

To open the configuration menu, click "Hardware" > "Driver" line of the menu which is
available when a mobile driver is loaded.

● UMTS devices configuration............................................................................... 1571
● Extra settings UMTS........................................................................................... 1573
● NQA settings.......................................................................................................1583
● Handover analyzer..............................................................................................1584
● Speech quality.....................................................................................................1585
● Autodialing.......................................................................................................... 1586
● Serial port info.....................................................................................................1589
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● Templates............................................................................................................1589
● Data tester...........................................................................................................1590
● Tracking of SMS..................................................................................................1591

UMTS devices configuration

The PIN number can be entered in "Device" in case a data card is used. For most test
mobiles, the card has to be entered directly into the mobile. The tab allows a rough
preselection of the evaluated message type.

The message type selection can be refined in the "Extra settings" tab, see "Extra set-
tings UMTS" on page 1573.

The UMTS test mobiles provide information that the test system is able to store and
evaluate. In many applications, only a subset of this information is needed. Restricting
the recorded data saves system resources and reduces the size of the measurement
files.

Figure 6-116: UMTS driver - device configuration

Click "Identify". The following message box appears.
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Figure 6-117: UMTS driver configuration – data card

General
The PIN number for identification after switching on the test mobile can be entered in
the "General" panel of the configuration dialog (not supported by most test mobiles). If
nothing is entered or the PIN is ignored, the SIM must be entered manually at the
mobile each time it is started.
Select an AMR codec in the "AMR Rate" list box.
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Note:
The option "Make Diagnostic Calls" is removed from the Qualcomm driver configura-
tion page, as the current mobiles with Qualcomm chipset do not support this specific
call type.

Measurements
The six UMTS/GSM-related check boxes in the "Measurements" group are used for a
rough preselection of the messages and information types to be recorded and written
to the measurement (*.rscmd) file. The selection can be refined in the "Expert Mode"
tab. For an overview of available messages, views and signals, see Table 6-8.

Mobile Info
In the "Mobile Info" field information about the mobile is displayed. The button "Config-
ure" is used to force a Qualcomm data card to GSM.

Mobile Display
"Show Mobile Display" opens a view of the test mobile so that it is possible to observe
the display, dial numbers and browse the menu from the controller while a measure-
ment is performed. This function is also provided in the "Action" menu; see Chap-
ter 6.4.5.2, "Action menu UMTS", on page 1593.

Extra settings UMTS

The "Extra settings" tab selects the message types to be recorded to the measurement
file. A Layer 1, Layer 2, Layer 3, or UMTS message type can be selected only if the
driver has been configured to do "Layer 1", "Layer 2", "Layer 3" or "UMTS" measure-
ment. See description of "Hardware".
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Figure 6-118: UMTS driver configuration - extra settings

The available message types are listed in the following table. The names of the corre-
sponding views and data structures/signals in the data tree are included in the table.
For an explanation of the recorded parameters, refer to the description of the UMTS
and UMTS/GSM views in Chapter 4.4.3, "UMTS views", on page 742 and Chap-
ter 4.4.12, "3GPP overview view", on page 923.
Table 6-8: UMTS message types, views and signals

Message type R&S ROMES4 view Data structure/signal

Layer 1 Messages

WCDMA AGC UMTS Layer 1 Layer 1

WCDMA RACH Parameters Only general-purpose views
(e.g. Alphanumeric View)

RACH Parameters

WCDMA DRX Mode Only general-purpose views
(e.g. Alphanumeric View)

DRX Mode

WCDMA TrCH Downlink UMTS TrCH  

WCDMA TrCH Uplink UMTS TrCH  

WCDMA Common Physical Channels Down-
link

UMTS Physical Channels  

WCDMA Dedicated Physical Channels Down-
link

UMTS Physical Channels  
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Message type R&S ROMES4 view Data structure/signal

WCDMA Physical Channels Uplink UMTS Physical Channels  

WCDMA PRACH UMTS Physical Channels  

WCDMA Active Set UMTS CellSet, UMTS Network
Analyzer

Active Set

WCDMA Neighbour Set   

WCDMA BLER   

WCDMA SIR Estimation  SIR

WCDMA Cell Reselection UMTS Reselection View  

WCDMA List Searcher   

WCDMA compressed mode interfrequency
Step 1 search

  

WCDMA compressed mode interfrequency
list search

  

Layer 2 Messages

WCDMA Radio Bearer States HSDPA Performance View  

WCDMA MAC UL Logical Channel Parame-
ters

HSDPA Performance View  

WCDMA MAC DL Logical Channel Parame-
ters

HSDPA Performance View  

WCDMA MAC UL Traffic Volume Measure-
ment Report

HSDPA Performance View  

WCDMA MAC Ciphering Configuration   

WCDMA RLC UL State HSDPA Performance View  

WCDMA RLC UL Ciphering HSDPA Performance View  

WCDMA RLC UL Ciphering V1 HSDPA Performance View  

WCDMA RLC DL Ciphering HSDPA Performance View  

WCDMA RLC DL Ciphering V1   

WCDMA RLC DL Cipher PDU Combination
V1

  

WCDMA RLC UL Cipher PDU Combination
V1

  

WCDMA RLC UL AM Configuration HSDPA Performance View  

WCDMA RLC UL AM User Plane PDU   

WCDMA RLC UL AM Signaling Plane PDU   

WCDMA RLC DL AM User Plane PDU   

WCDMA RLC DL AM Signaling Plane PDU   

WCDMA RLC UL TM HSDPA Performance View  
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Message type R&S ROMES4 view Data structure/signal

WCDMA RLC UL UM HSDPA Performance View  

WCDMA RLC UL AM HSDPA Performance View  

WCDMA RLC UL AM Statistics HSDPA Performance View  

WCDMA RLC UL AM PDU   

WCDMA RLC UL AM NAK PDU   

WCDMA RLC DL State HSDPA Performance View  

WCDMA RLC DL TM HSDPA Performance View  

WCDMA RLC DL UM HSDPA Performance View  

WCDMA RLC DL AM HSDPA Performance View  

WCDMA RLC DL AM V1 HSDPA Performance View RLC Throughput

WCDMA RLC DL AM Statistics

Note:
This message type uses numerous cpu time
and therefore could stress the whole mea-
surement system.

HSDPA Performance View RLC Throughput

WCDMA RLC DL AM PDU   

WCDMA RLC DL AM NAK PDU   

WCDMA RACH Control Parameters   

WCDMA Uplink TFC   

Layer 3 Messages

WCDMA RRC Signaling Messages UMTS SIB, UMTS Layer 3,
UMTS Measurement Report,
all

Layer 3, RRC Message

UMTS

UMTS NAS GMM State UMTS NAS Status NAS State

UMTS NAS MM State UMTS NAS Status NAS State

UMTS NAS REG State UMTS NAS Status NAS State

UMTS NAS CS Connection Management  CS Call Management

UMTS NAS MM Characteristics UMTS NAS Status MM Info

UMTS NAS OTA Messages  NAS Message

UMTS NAS QoS  NAS QoS

UMTS NAS Connection Bearer Capability  Connection Bearer
Capability

UMTS Vocoder UL   

UMTS Vocoder DL   
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Message type R&S ROMES4 view Data structure/signal

UMTS NAS AMR Uplink (only older firmware
versions)

 AMR Uplink

UMTS NAS AMR Downlink (only older firm-
ware versions)

 AMR Downlink

The Layer 3 Decoder now decodes the following UMTS PDUs according to 3GPP TS
36.331 V12.7.0: Any of these PDUs provided by the test Mobile is displayed in the
Layer 3 View.

The following UMTS PDUs provided by test mobiles are also decoded by the Layer 3
decoder.
Table 6-9: UMTS Layer 3 messages according to 3GPP TS 36.331 V12.7.0 Spec

Message type R&S ROMES4 view Data structure/
signal

SIB3 Layer 3 View Layer 3 message

SIB11ter Layer 3 View

*UMTS Scanner BCH View

Layer 3 message

SIB23 Layer 3 View /*UMTS Scanner
BCH View

Layer 3 message

SIB24 Layer 3 View / *UMTS Scanner
BCH View

Layer 3 message

Measurement Report Layer 3 View Layer 3 message

UE_Positioning_Measurement Layer 3 View Layer 3 message

UE_Positioning_Measurement_r4 Layer 3 View Layer 3 message

UE_Positioning_Measurement_r7 Layer 3 View Layer 3 message

UE_Positioning_Measurement_r8 Layer 3 View Layer 3 message

UE_Positioning_Measurement_r9 Layer 3 View Layer 3 message

UE_Positioning_Measure-
ment_r10

Layer 3 View Layer 3 message

* R&S ROMES4 UMTS scanner driver allows SIB11ter, SIB23 and SIB24 to select for
demodulation. If a PDU has been demodulated, it is shown in the UMTS BCH View.

Currently, the UMTS Demodulator does not support SB3 (UMTS Scheduling Block
Type 3) and SIB23 (UMTS System Information Block Type 23). They use a Secondary
Broadcast Channel, which is not demodulated. Based on MIB (Master Information
Block) enhancement, a Secondary Broadcast Channel can be indicated, if present.

The "NQA State Machine" signals require several layer 3 and Layer 1 messages. They
are available in the default configuration of the driver configuration menu and are listed
in the following table.
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Table 6-10: GSM/GPRS/UMTS/HSDPA/HSUPA/HSPA+ message types, views and signals

Message type R&S ROMES4 view Data structure/
signal

GSM Messages

GSM Burst Metrics   

GSM surround cell BA list MMR MMR, SVR

GSM serving cell info MMR MMR, SVR

GSM TxLev Timing Advance  SVR

GSM L3 RR state  SVR

GSM L3 RR protocol error   

GSM L3 RR signaling message GSM/UMTS Layer 3 Layer 3

GSM L3 RR cell selection and reselection
parameters

GSM Layer 1 Layer 1 ext.

GSM L3 RR RACH control parameters  SVR

GSM L3 RR control channel description
parameters

 MM Info

GSM L3 RR cell options  SVR

MMR GSM L3 RR cell information MMR MMR, SVR

GSM L3 RR channel configuration  SVR, MM Info

GSM L3 RR ciphering mode  MM Info

GSM L3 RR cell selection and reselection
measurements

MMR MMR, SVR

GSM L3 RR downlink signaling counter  SVR

GSM L3 RR radio link timeout counter  SVR

GSM L3 RR SACCH report MMR MMR, SVR

GSM L3 RR 3G rejected cells Rejected 3G Cells RR 3G Rejected Cells

Idle 3G Cell List GSM L3 idle WCDMA known
list

Idle 3G Cell List Idle Mode WCDMA Known
List

GSM L3 dedicated WCDMA cell list Dedicated 3G Cell List 3G Dedicated Measurements

GSM 3G dedicated measurements Dedicated 3G Cell List 3G Dedicated Measurements

GPRS Messages

GPRS indicators GSM Layer 1 Layer 1 ext.

GPRS general parameters RLC/MAC MAC Info

GPRS cell options RLC/MAC MAC Info

GPRS power control parameters RLC/MAC MAC Info

GPRS mobile allocation   

GPRS PBCCH description   
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Message type R&S ROMES4 view Data structure/
signal

GPRS GRR State   

GPRS RR cell reselection parameters GSM Layer 1 Layer 1 ext.

GPRS RR cell reselection measurements GSM Layer 1 Layer 1 ext.

GPRS RR packet system information 1 RLC/MAC GPRS RR Info

GPRS RR packet system information 2 RLC/MAC GPSR MM Info

GPRS RLC-UL statistics RLC/MAC QoS Info

GPRS RLC-DL statistics RLC/MAC QoS Info

GPRS RLC-UL Release Indicators   

GPRS RLC-DL Release Indicators   

GPRS LLC ME information RLC/MAC QoS Info

GPRS LLC PDU statistics RLC/MAC QoS Info

GPRS LLC XID Information   

GPRS SNDCP PDP context information  SNDCP Info

GPRS MAC signaling message GSM/UMTS Layer 3 GPRS RLC Msg.

GPRS MAC UL TBF establish RLC/MAC MAC Info, RLC Info

GPRS MAC UL TBF release RLC/MAC MAC Info, RLC Info

GPRS MAC DL TBF establish RLC/MAC MAC Info, RLC Info

GPRS MAC DL TBF release RLC/MAC MAC Info, RLC Info

GPRS SM/GMM OTA signaling message GSM/UMTS Layer 3 GPRS GMM Msg.

RLC/MAC GPRS air interface summary  RAT Info

GPRS timing advance  SVR

GPRS power control RLC/MAC RLC Info

GPRS transfer summary RLC/MAC MAC Info, RLC Info

GPRS Uplink TBF Data Block Count   

GPRS L1 Message Metrics A RLC/MAC MAC Info, RLC Info

GPRS L1 Message Metrics B RLC/MAC MAC Info, RLC Info

GPRS L1 Message Metrics C RLC/MAC MAC Info, RLC Info

GPRS L1 Message Metrics D RLC/MAC MAC Info, RLC Info

GPRS L1 Burst Metrics A   

GPRS L1 Burst Metrics B   

GPRS L1 Burst Metrics C   

GPRS L1 Burst Metrics D   

GPRS L1 Hopping ARFCN   
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Message type R&S ROMES4 view Data structure/
signal

GPRS RR 3G reselection measurements
parameter

RR 3G Reselection Mea-
surements Parameters

GRR 3G Reselection Mea-
surements Parameters

GPRS RR 3G reselection measurements RR 3G Reselection Mea-
surements

GRR 3G Reselection Mea-
surements

GPRS/EGPRS RLC Uplink Header GPRS/EGPRS EGPRS Info

GPRS/EGPRS RLC Downlink GPRS/EGPRS EGPRS Info

GPRS/EGPRS RLC Uplink GPRS/EGPRS EGPRS Info

HSDPA Messages (only 6275, 6280, and 7200 chipsets)

HSDPA Configuration UMTS HSDPA Configura-
tion

HSDPA DL Configuration

HSDPA DL Configuration Dis-
able

HSDPA UL Configuration

HSDPA UIL Configuration
Disable

HSDPA Finger Configuration

HSDPA UL Beta Gain Table   

HSDPA Demodulator Control Table   

HSDPA Modulator Control Table  HSDPA Modulator Control
Table

HSDPA Decode Status UMTS HSDPA Decode
Status

HSDPA Decode Summary

HSDPA HS-SCCH Statistics  HSDPA SCCH Statistics

HSDPA HS-DSCH HARQ Statistics UMTS HSDPA HARQ Sta-
tistic

HSDPA DSCH HARQ Statis-
tics

HSDPA DSCH HARQ

HSDPA UL HS DPCCH Information UMTS HSDPA UL HS
DPCCH

 

HSDPA MAC HS Configuration UMTS HSDPA MAC Con-
figuration

 

HSDPA MAC HS Headers UMTS HSDPA MAC
Header

 

HSDPA MAC HS Status UMTS HSDPA MAC Sta-
tus

 

HSUPA Messages (7200 chipset only)

HSUPA EUL DL Channel Configuration UMTS HSUPA DL Chan-
nel Configuration

HSUPA DL Channel Configu-
ration

HSUPA EUL UL Channel Configuration UMTS HSUPA UL Chan-
nel Configuration

HSUPA UL Channel Configu-
ration

HSUPA EUL UL E-DPCH UMTS HSUPA HARQ HSUPA E-DPCH Summary
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Message type R&S ROMES4 view Data structure/
signal

HSUPA EUL combined L1/MAC UMTS HSUPA ACK/
NACK U

MTS HSUPA Cell Status

HSUPA Statistics

HSUPA EUL L1/MAC statistics UMTS HSUPA L1/MAC
Statistic

HSUPA Statistics

HSUPA EUL MAC-e/es Configuration UMTS HSUPA DL Chan-
nel Configuration

HSUPA MAC-e Configuration

HSUPA EUL MAC-e/es Header UMTS HSUPA L1/MAC
Statistic

HSUPA MAC-e/es Summary

HSUPA EUL UL UM PDU   

HSUPA EUL DL UM PDU   

HSUPA EUL Ciphering   

HSPA+ Messages (8200 chipset only)

HSUP+ MAC-ehs reassembly HSDPA Performance View  

HSPA+ Flexible DL RLC AM PDU sizes HSPA L2 Statistic View  

Trace Finger Info (Recommended)
The WCDMA finger info is necessary for the "UMTS Layer 1 View", "UMTS Finger
View", and the "UMTS Network Analyzer View". It must be selected as well to obtain
the "Finger Info" signals.

Generate GSM Measurement Results Layer 3 Messages
The GSM L3 measurement report messages are not reported by a phone with Qual-
comm chipset, although that the message is defined in the Qualcomm message list
(see driver configuration). However, the phone sends the "GSM RR SACCH Report"
messages, which basically contain the same information.
If this option is activated, the Qualcomm reports the "GSM surround cell BA list" and
the "GSM L3 RR SACCH report" (see GSM message tree in "Measurements"). Acti-
vate both reports to create GSM Measurement Layer 3 Messages. These reports can
be analyzed in the "Layer 3 View".
If this option is deactivated, no GSM measurement Layer 3 messages are created.

Update Rate
The high amount of trace data for HSUPA needs to be stored into HSUPA Sample
Blocks. The size of these blocks can be defined. A block is sent if either the specified
time (default 2s) is reached, or the specified number of TTIs were logged (default 1s
(10ms*100 or 2ms*500)).
Max. Update Rate for Ec/Io Values
Sets the maximum update rate for Ec/Io values. A lower update rate decreases the
size of the measurement file.
HSUPA Sample Block
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Sets the Max. UpQualiPocdate Rate for Ec/Io Values for HSUPA samples. Additional
option fields are provided for the case when N samples are logged for a TTI of 10 ms
or 2 ms.
Note: The HSUPA views show always one block at one point in time. Thus the speci-
fied number of TTIs is responsible for the size of the HSUPA graphs.

System Information Blocks
Layer 3 Radio Resource Control (RRC) messages are broadcast in system information
blocks of various types (see standard 3GPP TS 25.331). If the box "Store Raw RRC
Messages…" is checked, the complete information transmitted in the layer 3 RRC sig-
naling messages is stored to the measurement file.
If only the system information blocks are needed, the default configuration (box
unchecked) is sufficient. This configuration reduces the size of the measurement file.

Video Call Menu Option
To perform a video call, it is necessary that on the test device a specific video call
menu option is invoked. R&S ROMES4 automatically sets the correct value. Only if a
test device is used that is not officially supported by R&S ROMES4, the field "Menu
Entry" is accessible. Then the user has to set the correct value so that the video call is
possible.
Example: For the field "Menu Entry", the number 2 is set and grayed out. That means
that the required menu entry is at second position in the test device menu. Furthermore
the R&S ROMES4 system knows the correct setting therefore it is not possible and
necessary to edit this entry by the user.

HSPA+ and HSPA
The section applies to the R&S ROMES4QP/R&S ROMES4QC/ROMES4SAM option
for the testing the DQA jobs performed in Fully integrated device operation mode/On
PC testing operation mode, respectively.
HSPA+ supports 64QAM and MIMO mode. The "HSDPA Performance View" shows
the percentage of TTIs, which used 64QAM.

Figure 6-119: HSPA+ driver - extra settings
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● HSPA+ MAC-ehs reassembly
Activate this function as it provides basic information about the HSPA+ feature in
the network.

● HSPA+ Flexible DL RLC AM PDU sizes
It is optional, and would provide information about the flexible PDU sizes on Layer
2. However, activate the log only if needed, as it stresses mobile and measurement
system. The results of this log are reported to the "UMTS HSPA L2 Statistic
Views".

NQA settings

The "NQA Settings" dialog is used to set the parameters for the UMTS and GSM net-
work quality analysis (NQA). The NQA is a prerequisite for drawing up a call statistic
where the calls are classified and the classes are visualized separately.

The driver settings for one Qualcomm chipset-based mobile are shown in the following
figure.

Figure 6-120: UMTS driver configuration - NQA

The parameters in the "GSM NQA Parameters" and "NQA Monitoring" sections are
identical to the NQA parameters for GSM. See "NQA configuration" on page 1547.

Use NQA
If checked, the box activates the network quality analysis (default).
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UMTS NQA Parameters
The following numeric parameters configure the UMTS NQA by defining conditions and
limits for the different call classes (we quote the ranges for all parameters; default val-
ues are underscored).
● "Handover Maxcount"

Maximum number of handover procedures during a call in the range 1 to 100
(default 5). If the defined value is exceeded, the call is classified as EXCESSIVE
HO.

● "Blocked Call Delay"
Maximum delay (in seconds) between CM_SERV_REQ and ASSIGNMENT_COM-
MAND in the range 1 (s) to 15 (s). If the defined delay is exceeded, the call is clas-
sified as DELAYED CALL.

● "Ec/Io Threshold"
Minimum signal to noise ratio in dB and in the range –20 (dB) to 0 (dB). Default is
-12 (dB). Ec/Io values which fall below this threshold contribute to NOISY.

● "Ec/Io Exceed Perc."
Minimum ratio (in percent) of reported RxLev values falling below the RxLev
Threshold in the range 0 (%) to 100 (%). Default is 50 (%). If the actual ratio falls
below the specified percentage, the call is classified as NOISY.

● "BLER Threshold"
Maximum Block Error Rate in percent in the range 0 (%) to 100 (%). Default is 30
(%). BLER values above this threshold contribute to NOISY.

● "BLER Exceed Perc."
Minimum ratio (in percent) of reported BLER values exceeding the BLER Thresh-
old in the range 0 (%) to 100 (%). Default is 50 (%). If the actual ratio exceeds the
specified percentage, the call is classified as NOISY.

GSM NQA Parameters
Configures the GSM NQA, see "NQA configuration" on page 1547.

NQA Monitoring
Activates NQA monitoring and displays the number of blocked, dropped and "no ser-
vice" calls, see "NQA configuration" on page 1547.

Handover analyzer

The "Handover" tab enables or disables the handover analyzer (option R&S
ROMES4HOA) and sets the timeout for the HO analysis. The HO analysis and the
meaning of the timeout is described in Chapter 4.4.10, "3GPP handover analyzer
view", on page 898.
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Figure 6-121: UMTS driver configuration - handover

Speech quality

The "SQA" tab enables and configures the Speech Quality Analysis (SQA, with option
R&S ROMES4SQA, "Voice Quality PESQ)", as described in Chapter 6.4.12.3, "Config-
uration – speech quality", on page 1689.

SQA results can be displayed in the "SQA Message" view (see chapter "Display and
Evaluation of Results"). All settings are analogous to the GSM driver settings described
in "GPS health monitoring" on page 2064.
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Figure 6-122: UMTS driver configuration – Qualcomm mobile SQA window

Autodialing

The "Autodialing (MOC)" provides two autodialing modes, simple and extended, where
a definite phone number is dialed periodically and a call is set up by the mobile phone.

If the extended mode is selected, the configuration page contains additional options,
like to choose a call type, single or multi call, calling conventions and preconditions.
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Figure 6-123: UMTS driver configuration - autodialing simple mode

The modes are relevant for the network quality analysis described in "NQA configura-
tion" on page 1547. All settings are analogous to the GSM driver settings described on
"Autodialing" on page 1536.
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Figure 6-124: UMTS driver configuration - autodialing extended mode

Autodialing an emergency call
There is the additional option "Emergency Call dialing configuration" in the "Autodial-
ing" page.
This setting is visible only under the following conditions:
● "Mode" panels are set to "Extended" and "Single Call"

Autodialing an emergency call leads to a short-time UNCONNECTED state to allow the
mobile to scan for the best serving cell independent from its home network. The scan-
ning drops the call immediately. This behavior is avoided by activating the "Emergency
Call dialing configuration" function.
An emergency call is only performed with certain phone numbers like 112 in Europe or
911 in USA.
It is not possible to test an emergency call using an UE as a smartphone. Configure
the smartphone as a modem in this case.
Samsung S3 is the only smartphone that supports emergency call, if configured as a
modem.
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Serial port info

The "Serial Port Driver" tab displays the custom name of the device, information on the
file version of the technology driver, the serial port assigned to it and the transfer
parameters. The "Custom Name" is used to assign a name to a test device, e.g. to
make a quick association of a test device to its designated test network provider.

Also the expected amount of produced driver data per time unit can be set. See also
Chapter 6.3, "Devices observation", on page 1510.

Figure 6-125: UMTS driver configuration – serial port driver Info

Templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.
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Figure 6-126: UMTS driver configuration – templates

Data tester

The R&S ROMES4 Data Tester function allows direct connection of a mobile driver to a
Data Quality Analyzer. The configuration page as shown in the following figure.
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Figure 6-127: Connect a DQA

Connecting the DQA jobs with a mobile device is possible by using the "Wizard" or
when loading a driver, see Chapter 3.4.2.2, "Capacity test wizard", on page 199.

The function applies to all mobile drivers.
If a DQA is connected to a specific device, the linked device cannot be changed any-
more.

Tracking of SMS

SMS can be sent using the corresponding DQA job for the test UE, see Chap-
ter 6.5.1.4, "Configuration menus for the DQA jobs", on page 1891.

In the "Alphanumeric View" > "Values" the user can select available signals for sent
and received SMS during the measurement to visualize the corresponding count. A
sent SMS is marked as failed if the corresponding AT command returns with an error.
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Figure 6-128: Select SMS signals for tracking

The "Service" tab opens the window for tracking of incoming SMSs. Tracking of incom-
ing SMSs work only if the assigned modem port is available. It is not recommended to
activate (check the "Tracking of Incoming SMSs" check box) this feature, if a DQA
driver uses the modem port for a data connection, see the following figure.

Figure 6-129: Activating the tracking of SMS function

All incoming SMSs from any sender are counted.
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If the incoming SMS has been sent by the DQA "Send SMS" job with the automatically
created text from the same computer, the transfer time is calculated.

Figure 6-130: Tracked signals of sent SMSs

In the "Event View" there is the possibility to get information on events like SMS send
event OK or failed and SMS received event if these events are activated in the "Availa-
ble Events" > "GSM Events" branch, see Figure 4-105.

This SMS Tester does not create any entry to the ETSI QoS View. Its result is available
through the R&S ROMES4 signals only, shown in Figure 6-128.

The UE has to support the following AT commands:
● AT+CPMS,
● AT+CMGL
● AT+CNMI
● AT+CMGD

6.4.5.2  Action menu UMTS

The "Action" menu opens popup boxes used to set up a call or show the contents of
the mobile display. It is added to the menu bar when a mobile driver has been success-
fully installed (see Chapter 6.1, "Devices", on page 1447). If several mobiles are con-
nected, separate command lines are displayed for each of them.
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Figure 6-131: Action menu commands

Handset UMTS

Activates the entry of a number to dial, set up and terminate a call.
● Handset

The "Handset" command opens a window (equal for all drivers) which have two
possible statuses:
– Not selected
– Selected, marked with "- *" and shown in the following figure as connected

mobile [2].
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If there is only one "Handset" window, it always has selected status.
If there is more than one "Handset" window, the selected status can be set to any
"Handset" window in one of two listed ways:
1) Click to the window using a mouse.
2) Choose selected window using the "N" key. In this case selection changed like
this: Window[1] > press "N"> Window[2] > press "N"> ...Window[n] > press "N">
Window[1] (cycling choose like "Alt+Tab" between open windows in MS Windows).
Only selected windows accepts hotkeys “D” ("Dial"), “A”("Answer"), “H”("Hangup").
Note: The previously mentioned keys have only effect, if the focus is not set to an
input control, example-given edit field or combo box.
Example: if you select the phone number by selecting the corresponding entry of
the combo box, the keys do not work afterwards. Set the focus to another window,
for example to the main R&S ROMES4 window.

● >>
The ">>" button enlarges the dialog box, giving access to the Key pad and the
"Autodialing" option.

Figure 6-132: Use Autodialing
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Figure 6-133: No Autodialing

● Dialed number
The number to be dialed can be entered either via the keyboard and the input field
or by clicking the on-screen keypad.

● "Close window ⊠"
Closes the window without any further action.

● "Dial"
Starts dialing the number entered before.

● "Answer"
Instructs the phone to accept the call.

● "Hangup"
Drops the line.

● "Autodialing"
If the box is checked, the phone number entered below is called periodically, the
"Dial", "Answer", and "Hangup" buttons are disabled (grayed). The autodialing
mode can be set even during the measurement, but only in "Idle mode".
This item starts "Autodialing" if the "Start with Measurement option" was not
checked in the driver configuration-autodialing tab panel.

Show/hide mobile display UMTS

Shows or hides a view of the test mobile.

With the view it is possible to observe the display, dial numbers and browse the menu
from the controller while a measurement is performed (for Qualcomm mobiles only).
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6.4.6  TETRA radios

6.4.6.1  Loading TETRA radios

R&S ROMES4 offers two different drivers for TETRA radios:

● PEI - based on AT commands, supports Sepura, Motorola and EADS Radio THR9
radios

● Sepura - digital interface, supports Sepura radios only

The Sepura radios allow the continuous radios usage with the existing workspaces.
So, you can continue to use the TETRA Mobile via PEI driver despite the supported
Sepura driver.
However, as the R&S ROMES4 supports the Sepura driver for the Sepura radios,
including the Layer 3 messages traces, recommended is to reconfigure existing work-
spaces and use the Sepura driver.

R&S ROMES4 fully supports the following Sepura radios and the associated firmware
versions.
● SC2020

<version name="176400108525,176400108522,,,440150806883,"/>
● STP8000

<version name="166702002931, 166702302937,,, 440117302249,
440117302250,"/>
<version name="166702002931, 166702302937,,, 440148903083,
440117302250,"/>

● STP3900
<version name="169700602931, 169701402937,,, 440149703083,
440149704553,"/>
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● SRG3900
<version name="166702003579, 166702303577, 000000000000,
450701204063, 440149603083, 440117302250,"/>

● STP9000
<version
name="169700602931,169701402937,,,440149703083,440149704553,
"/>

There are no restrictions if one of the listed Sepura radios uses listed firm-wares other
than ones associated to it.

All other Sepura radios can work as well but with the reduced functions (voice and
group calls only, SDS is not supported). However, only the listed radios and firmware
versions have been tested. In any other cases, problems can occur.

Sepura SC2020

Sepura SC2020 can be used for TETRA measurements of group and individual calls.
Sending SDS works but it is limited. If Sepura SC2020 radio is used, sending SDS is
controlled by macros and it is important to verify the firmware and the configuration of
the radio. Namely, the associated firmware versions are used to develop the macros
which control sending of SDS.

The SC2020 radio has different buttons in comparison to STP8000. The middle context
button does not work as wanted at the macros. That is, the actual macros concerning
SC2020 at tetra_sds.xml is not working when generating an SDS and deleting it.
Enter and store an SDS manually at the SC2020. Such the SDS is used for the test.

Sepura SC2020 has a different bottom connector in comparison to STP8000. Use a
different data cable or a different cradle (WeTech WTC1902USB).

Sepura SC2020 needs a specific USB driver.

Install the USB drivers on MS Windows 10 version, use the
SepuraTETRA_USB_Serial_Port_Driver_Win10.exe file.

Sepura SC202x

Sepura introduced a purchasable option for SC202x to send certain AT commands.
This option is called PEI option. Without the PEI option, R&S ROMES4 shows several
missing L1 values like MCC, MNC, LA and missing connection state.

After stimulating the mobile (e.g. push PTT button), some values appear.

PEI option is necessary for Sepura SC202x.
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Sepura radios use a private copy of users tetra_sds.xm

As the R&S ROMES4 installation can overwrite the user's personal data in
tetra_sds.xml file, it is convenient to make a copy of the file in a file named
tetra_sds_user.xml. This tetra_sds_user.xml file is preferably taken at a run
time and is not overwritten at installation.

Driver - TETRA mobiles via PEI

The "TETRA Mobile via PEI" driver can be used with the supported TETRA radios that
have the PEI interface. Such are Sepura, Motorola and EADS Radio THR9 radios.

A name of TETRA radios loaded via PEI driver has attached the appendix (PEI) to dis-
tinguish between the PEI and SAIL SW.

In addition, the Tooltip of the radios' tab shows the ITSI, GTSI and the current group.

Motorola TETRA radios
Motorola radios only work with the serial cable. The PEI interface is not supported via
the USB cable.
Motorola radios do not show TEI or GSSI.

Driver - Sepura radio

The "Sepura Radio" driver can be used with a Sepura mobile only.

Sepura radios do not show TEI.

A TETRA driver loading and configuring is described in the following sections.

6.4.6.2  Loading TETRA radios general

The prerequisite for the loading is that TETRA mobile device is connected to the host
PC which has installed R&S ROMES4. Perform the following steps to load a TETRA
mobile driver.
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Figure 6-134: Hardware Configuration window – load TETRA device

1. Click "Hardware" > "Connect/Disconnect" entry.
The "Hardware Configuration" window opens.

2. Double-click one of the available TETRA drivers in the "Available Drivers" >
"Mobile Devices" pane.

The "Assign Ports to TETRA Radio (1)" or "Assign Ports to Sepura Radio (1)" win-
dow shows the default COM port number assigned to the mobile driver.

Figure 6-135: Hardware Configuration dialog – COM port selection
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The same output is obtained if you select wanted TETRA driver and click ">".

3. If the device is not set to COM port 1, choose the relevant port from the pull-down
list.

4. Click "OK".

A progress bar shows the initialization of the mobile.

After initialization, the driver is loaded and shown in the "Hardware Configuration" >
"Loaded Devices" pane.

For more details about devices installation, see Chapter 6.1.3, "Connection via COM
port", on page 1454.

6.4.6.3  TETRA radios configuration menu

This section describes the configuration of TETRA radios - PEI and Sepura.

In most respects, the configuration of PEI and Sepura radios is identical. The only dif-
ference is the autodialing configuration.

● PEI radios can only perform voice call and group call (no data call).

Figure 6-136: TETRA PEI driver - configuration page

● Sepura radios perform voice call, group call and send SDS messages (Short Data
Service is similar to the SMS text service in GSM).
Sepura radios support DMO.
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Figure 6-137: TETRA Sepura driver - configuration page

It is highly recommended to use the Sepura driver instead of the PEI driver.
Reason: Sepura radios are used as a calling party in group calls. If the PEI driver is
used as a calling party in a group call, illegal additional messages are produced by the
mobile. It can lead to a multiple of good or dropped calls.

Autodialing TETRA

The "Autodialing" tab lets you configure the mode where a defined phone number is
dialed periodically and a call is set up to the MS.

This mode is relevant for the network quality analysis described in "NQA settings"
on page 1547.

All settings are analogous to the GSM driver settings, see "Autodialing" on page 1536.

Call to PSTN
To call a number in the PSTN, put "$" in front of the "To Call" number in the "Autodial-
ing" page.
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Autodialing PEI radios

Figure 6-138: TETRA PEI radio driver – Autodialing page

For PEI mobile devices, the KPIs cannot be calculated with the required accuracy.
Activating "Autoanswer" at the configuration omits all the L1 signals as long as the
TETRA mobile is in idle mode because of lack of timing accuracy.
However, a change to dedicate mode (by an incoming call) starts the periodic request
of the L1 parameters.

If the mobile is not configured to autoanswer, the L1 is requested in all modes (idle,
dedicated).
Table 6-11: TETRA radio (PEI) L1 signals

TETRA radio type L1 signals

Motorola MTP850 Vegetate, MCC, MNC, TETRA Power (old name RSSI), LA

Sepura (PEI) RegState, MCC, MNC,
TETRA Power (old name
RSSI), LA, Frequency, Car-
rier, C1

Best NC (Frequency,
Carrier, TETRA Power
(old name RSSI), LA,
C2)

NCx (Frequency, Carrier,
TETRA Power (old name
RSSI), LA, C2)
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Test setup for call testing

Prerequisite: At least two mobile devices have to be connected to R&S ROMES4. For
details, see Chapter 6.4.6.1, "Loading TETRA radios", on page 1597.

The following setup steps are recommended when testing a call:
● 1. Load the mobiles
● 2. Configure one mobile for autodialing
● 3. Configure one mobile for autoanswer (if PEI mobiles are used, keep their limita-

tions in mind)

The following setup steps are recommended when testing a group call:
● 1. Connect more mobiles to R&S ROMES4
● 2. Configure them for auto answering

Data calls are always deactivated
The call type "Data Call" is deactivated by TETRA PEI driver, as this driver has no SDS
functionality. The "Data Call" button and configuration fields are grayed out.

Autodialing Sepura radios

The "Autodialing" configuration of the Sepura radios is almost identical to that of the
PEI radios.

The only difference is that Sepura supports the SDS service - in all other cases the
configurations described for PEI radios is applicable, see the following figure.
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Figure 6-139: TETRA SEPURA radio driver – Autodialing page

Autodialing - SDS

If the Sepura radio is configured for autodialing and the SDS button is selected, R&S
ROMES4 generates a dummy text (50 characters) then. It sends the text via SDS to
the phone number configured by the user.

Figure 6-140: Call type selected - SDS

Generating the SDS takes longer, up to 10 seconds. Due to that fact, the SDS is gen-
erated only once – at the start of the first measurement. To ensure that a message is
available, a new SDS is added always to the messages. The first message is deleted
and rewritten with the test content. The first message is always used for sending. By
closing R&S ROMES4 the message, if generated, is deleted from the radio.
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It is not possible to do an individual call with one radio and a group call with a second
radio to a group which the first radio belongs to. This measurement setup results in a
wrong call statistic for the first radio.
Due to a bug in the SRG3900, the group call does not work as expected. The PPT but-
ton cannot be held by the software and results in a release of the call after some sec-
onds. The Sepura SAIL software shows the same effect.

Creating and sending the test SDS messages

Creating and sending the test SDS messages using TETRA devices is based on xml-
script. The script has name tetra_sds.xml and is stored in the R&S ROMES4 con-
figuration directory. All tags and names of attributes and attributes values are case-
sensitive.

In the following the minimal script structure is shown.
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Tags description

● <manufacturers>
Root tag of the file; contains all other tags. Only one tag of this type is allowed.
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● <family_collection name="…">
Describes device of concrete manufacturer. The attribute "name" is not mandatory,
it is used only for clear file structure. The file can contain more than one tag of this
type.
Example:
<family_collection name="SEPURA">
…
<family_collection name="SEPURA">

● <configurations>
Child tag of <family_collection> tag. The tag is mandatory and contains set of
device configurations.

● <configuration name="…"default="…">
At least one tag <configuration> must exist under the tag <configurations>. This
tag has the following attributes:
– "name" - Name of device which is described in the configuration. It is important

to write the device right name.
– "default" - Initially ROMES searches appropriate configuration of a device using

firmware ID string, see tag <firmware>. If ROMES cannot find configuration
with exactly matched firmware ID, it tries to use default configuration for the
device with the same name. Only one configuration per device, identified by
"name", can be defined as default="true". If more than one configuration of the
device is defined with attribute default="true" or there is no configuration
defined as default="true", ROMES generates an error message.

Number of tags <configuration> is not limited. If the same firmware description is
found in more than one configuration, R&S ROMES4 uses the first one found.
Example:
<configuration name="STP8000" default="true">
</configuration>
In this example STP8000 is the name of the SEPURA device.

● <firmware>
Mandatory tag; collects the list of the firmware that describes parent configuration.
The tag must contain at least one child tag <version>.
Example:
<version 
name="166702002931,66702302937,,,440148903083,440117302250"/>
<version 
name="166702002931,66702302937,,,440148903083,440117302251"/>
<version 
name="166702002931,66702302937,,,440148903083,440117302252"/>
</firmware>

● <version>
Every tag of this type contains the firmware ID in the attribute "name". The tag is
used by ROMES for initial search for appropriate configuration of any attached
TETRA device.

● <specific_control_key_definition>
Mandatory tag; contains codes of device keys, excluding the keys "0 - 9". Every
key is described in the nested tag <ckey>.

● <ckey>
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Describes the collection of device keys. Every tag has attributes "name" and
"value". The first attribute contains the name of a key, the second one contains the
code of the key.
Example:
<specific_control_key_definition>
  <ckey name="VK_PTT" value="222"/>
  <ckey name="VK_SEND" value="223"/>
  <ckey name="VK_HANGUP" value="224"/>
  <ckey name="VK_MENU_UP" value="225"/>
  <ckey name="VK_MENU_DOWN" value="226"/>
  <ckey name="VK_MENU_LEFT" value="227"/>
  <ckey name="VK_MENU_RIGHT" value="228"/>
  <ckey name="VK_STP8000_LEFT_KEY" value="229"/>
  <ckey name="VK_STP8000_RIGHT_KEY" value="230"/>
</specific_control_key_definition>
All keys which are used in the tag <execute> must be described in the tag <ckey>.
For keys "0 - 9", you can use tags "VK_0 - VK_9". This name is predefined in the
code of R&S ROMES4. Special key with the name "VK_NUMBER_TO_DIAL" is
also predefined and means "dial the phone number". The phone number for exe-
cuting this action is defined in the ROMES user interface.

● <scenarios>
The tag contains unlimited number of the <scenario> tag.

● <scenario name="...">
The tag contains nested tags, which describe sequence of pressed device's but-
tons same as executing scripts.
Example:
<scenario name="GenerateTestSDS">
  <execute scenario="ResetScreen"/>
    <execute action="KEY_PRESS_RELEASE" key="VK_MENU_DOWN"/>
    <execute action="KEY_PRESS_RELEASE" key="VK_5"/>
    <execute action="KEY_PRESS_RELEASE" key="VK_MENU_DOWN
pause="100"/>
    ...
</scenario>
The example shows the steps made in the scenario named "GenerateTestSDS".
The steps are:
– Execute scenario with the name "ResetScreen".
– The button "VK_MENU_DOWN" is pressed and released with the code 226

(see the tags <specific_control_key_definition> and <ckey>).
– The button "5" is pressed and released.
– The button "VK_MENU_DOWN" is pressed and released with the code 226.
– After the button "VK_MENU_DOWN" is released, there is a pause 100 ms.
– ... and so on.
Every tag <scenario> must have attribute "name". Scenarios with the following
names must exist in the configuration:
– "ResetScreen"
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– "Answer"
– "GenerateTestSDS"
– "SendSDS"
– "DeleteTestSDS"
Also user can define own scenarios. For example, for replacing in the scenarios
sequence:
<execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
<execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
<execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
<execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
<execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP"/>
The user can create own scenario:
<scenario name="MenuUpRepeater">
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP
pause="10"/>
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_UP"/>
</scenario>
Use the following command in the scripts:
<execute scenario="MenuUpRepeater"/>
Tags <scenario> have the following restrictions: tags <execute> and <loop> are
only allowed as a child tags, while recursive calls are not allowed.
Example:
The following construction is illegal.
<scenario name="Muster">
  ...
  <execute scenario="Muster"/>
  ...
</scenario>

● </execute>
The tag can contain following attributes:
– "scenario" - Name of executing scenario.

Example:
<execute scenario="ResetScreen">

– "action" - Name of pressing buttons. If attribute "action" exists, non-empty
attribute "key" also must exist.
Example:
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_DOWN"/>
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or
  <execute action="KEY_PRESS_RELEASE" key="VK_5"/>

– "pause" - Defines pause after releasing the key. This attribute is using only with
attribute "action".
Example:
  <execute action="KEY_PRESS_RELEASE" key="VK_MENU_RIGHT"
pause="1000"/>

– "pause_between_keypress" - Defines pauses between pressing the keys when
attribute "action" has value "VK_NUMBER_TO_DIAL".
Example:
  <execute action="KEY_PRESS_RELEASE"
key="VK_NUMBER_TO_DIAL" pause_between_keypress"10"
pause="100"/>
The meaning of this example is: "Dial the phone number entered in interface,
make pauses of 10 ms between releasing one and pushing the next button.
After the end of call dialing, make pause of 100 ms."
If the key name is not "VK_NUMBER_TO_DIAL", the attribute
"pause_between_keypress" is ignored.

● <loop>
The tag is used for loop execution of the nested tags. Attribute "steps" defines
number of repeatings. This tag can contain only nested tags <loop> and <exe-
cute>.
Example:
<loop steps="49">
  <execute action="KEY_PRESS_RELEASE" key="VK_1" pause="100"/>
  <execute action="KEY_PRESS_RELEASE"
key="VK_STP8000_LEFT_KEY" pause="200"/>
</loop>
The meaning of this example is: "Make 49 times the following commands: "press
1", make pause 100 ms after releasing the button, then push the button
"VK_STP8000_LEFT_KEY" and make pause 200 ms after releasing it."

Templates TETRA

The "Templates" configuration page is identical for both TETRA radios.

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.
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Figure 6-141: TETRA Sepura radio driver – Templates page

 

Serial port info TETRA

The "Serial Port" configuration page is identical for both TETRA radios.

The "Serial Port Driver" tab displays the custom name of the device, information on the
file version of the technology driver, the serial port assigned to it and the transfer
parameters. The "Custom Name" is used to assign a name to a test device, e.g. to
make a quick association of a test device to its designated test network provider.

Also the expected amount of produced driver data per time unit can be set. See also
Chapter 6.3, "Devices observation", on page 1510.
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Figure 6-142: TETRA Sepura radio driver – Serial Port page

Advanced TETRA

The "Advanced" tab opens the pages to configure the SQA measurements of TETRA
radios and the "SEPURA Radio" page.

Sepura radio

"Transformation SEPURA Channel to Frequency" offers to specify two inputs:
● "Frequency Base [MHz]"
● "Frequency Step [MHz]"

The inputs provide R&S ROMES4 information how to transform the channel number
from Sepura radios to a frequency plan.
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Figure 6-143: TETRA SEPURA Radio page

At the start of the measurement, R&S ROMES4 tries to make a test call to find out
whether the radio would call to the TETRA network or to the PSTN.

Activated "Suppress the Radio Call Mode Selector Dialog"" suppresses the appear-
ance of a dialog that asks user to decide which network one is calling if this initial call
fails to be established for any reason. If the dialog suppression is chosen, the user has
to ensure that the radio calls the desired network.

If the test call fails, R&S ROMES4 assumes that the correct mode is set to the radio.

Activated "Listening to Unsynchronized Group Call Generator" enables the radio to
synchronize to a Group Call Generator for speech quality measurements.

The option suppresses the start of the Speech Quality Analyzer until one RELEASE
message has been received. This suppression ensures that the radio synchronizes to
the Group Call Generator by detecting the end of a group call. From now on, the
Speech Quality Analyzer starts at the correct point in time.

R&S ROMES4 supports the Sepura TETRA radios DMO mode with the appropriate
R&S ROMES4TET option. To run the Sepura radios in DMO mode, check "Radio is in
DMO Mode".

The autodialer of the radio supports only group calls, once set to DMO mode. The
radio can either set up a group call or stay in idle mode. In idle mode, the radio accepts
incoming group calls and shows them in the ETSI QoS View.
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All parameters that are available from the radio are shown in "TETRA Graph View" and
"TETRA Overview View".

Figure 6-144: TETRA Graph View

The mobile radio's chipset is responsible for the unreliable TETRA Power signal mea-
surements during a call (down to -127 dBm).

Figure 6-145: TETRA Overview View with DMO active

The DMO messages are displayed in the "Layer 3 View".
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Figure 6-146: TETRA Layer 3 DMO messages

SQA TETRA

The "SQA" tab lets you configure and enable the Speech Quality Analysis. The R&S
ROMES4SQA option is needed ("Voice Quality PESQ)") as described in Chap-
ter 6.4.12.3, "Configuration – speech quality", on page 1689.

SQA results are shown in the "SQA Message View".

The configuration pages are identical for both TETRA radios.

SQA TETRA PEI radios

● For general introduction on SQA, refer to Chapter 6.4.12.1, "SQA – principle and
test setup", on page 1683

● For how to configure the SQA driver, refer to Chapter 6.4.12.3, "Configuration –
speech quality", on page 1689

The following figure shows the SQA configuration page for TETRA PEI radios.
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Figure 6-147: TETRA PEI radio driver – SQA page

SQA TETRA Sepura Radios

The following figure shows the SQA configuration page of TETRA Sepura radios.
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Figure 6-148: TETRA Sepura radio driver – SQA page

● For general introduction on SQA, refer to Chapter 6.4.12, "Speech quality analy-
sis", on page 1683.

● For how to configure the SQA driver, refer to Chapter 6.4.12, "Speech quality
analysis", on page 1683.

6.4.6.4  Alternating TETRA group calls

The feature activates measurements of alternating TETRA group calls.

The Sepura Sail drivers support the feature.

TETRA mobiles with PEI interface cannot be used, as the necessary configuration for
dialing and auto-answering results in malfunction. They also give reduced information,
for example, no L3 messages.

Having two TETRA mobiles which are in the same group, the mobile A calls the mobile
B and afterwards, the mobile B calls the mobile A.

First, the mobile A sets up a group call. The mobile B listens to.

After a while, the mobile B sets up a group call and mobile A listens to. To avoid con-
flicting calls, set both sides to the identical call timings but one side has to have a shift
of half duration.
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Testing mobile to mobile voice group call needs many configurations. These configura-
tions are described in the following chapters.

Alternating TETRA group call measurements show correct calls, timings and MOS in
ETSI view.

In addition, each group call is used to transfer speech samples by the SQA driver. The
opposite side does a PESQ calculation. As a group call is a simplex direction call, the
SQA has to consider which direction is suitable and which is not.

Sending a *.wav file and performing a PESQ calculation on SQA is omitted in the
wrong direction.

Alternating TETRA group calls on one PC

The assumption is that two TETRA mobiles are running on the same R&S ROMES4,
on one PC. If two PCs are used, there is no guarantee that the call timing does not
conflict.

Hardware configuration

Two TETRA Sepura mobiles run on the same R&S ROMES4, on one PC.

Each TETRA mobile is connected with antenna, power, audio cable and RS232 to the
PC.

An audio sound card is installed. For how to set up the audio chain, see "M-Audio
transit" on page 1626.

In this example TETRA Sepura Sail is used.

Using TETRA mobiles with PEI interface in this configuration does not work.

Software configuration

The following figures show how to configure mobile and SQA drivers in R&S ROMES4.

Figure 6-149: Configuration of TETRA drivers
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Figure 6-150: Autodialing configuration for A-Party

The call pattern of both TETRA mobiles is the same, except the shift of half of call win-
dow. Both are intended to dial and answer.

There is a call window of 120 s In this example, where a 30 s call is performed. A long
pause then ensures that the opposite mobile can do its call.

Figure 6-151: Autodialing configuration for B-Party

Notice that 2nd call setup has a delay of half of call window.

Figure 6-152: Transformation for Sepura Radio

Set both mobiles on Sepura Radio configurations as shown in the following figures.
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A-Party SQA[1] is linked to STP8000[1].

Figure 6-153: SQA page for A-Party

B-Party SQA[2] is linked to STP8000[2].

Figure 6-154: SQA page for B-Party
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SQA settings for both party are identical.

There is no need of tricky pause timings for playback file and reference file, as there is
no overlapping at the calls.

The only difficulty is to find out the correct in/out audio lines.
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Figure 6-155: SQA settings for A-Party
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Figure 6-156: SQA settings for B-Party

In this example there is a 30 s call.

With an initial pause set to 2000 ms, the set WAV file duration and the end pause set to
3000 ms, two loops are possible.

2000ms + (8403ms +3000ms) + (8403ms +3000ms) = ~24,8s

For each loop, a PESQ calculation is done.

Alternating TETRA group calls on two PCs

The further improvement is to support TETRA group call with two PCs, each with R&S
ROMES4 and one TETRA mobile.

There is a feature to align the start of a call to the clock.

Normally, calls are set up periodically according to the call window settings. With this
feature, the start of a call is postponed to the next full minute. The synchronization is
ensured by having both system times set correct.
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It is recommended to have a GPS for setting the system time.

Figure 6-157: Aligning the start of the call window

By activating the "Align call window", the start of a next call is postponed to the next full
minute.

This feature applies only to TETRA and is therefore only visible at configuration of
TETRA mobiles.

Figure 6-158: Call postpone message written in Output

The Measurement File Info reports "Call window is aligned to Clock (next full minute)" if
this feature is enabled.

Measurement

The following figure shows the measurement with Sepura SAIL.
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Figure 6-159: SQA Message view

According to the call timing, an alternating group call is set up.

M-Audio transit

The following figures show the actual settings of the M-Audio Transit.

Figure 6-160: M-Audio Transit bandwidth button
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Figure 6-161: M-Audio Transit level setting

Analog Output Volume is set to 0, Analog Input Gain is set to +18.

Figure 6-162: M-Audio Transit latency setting

Figure 6-163: M-Audio Transit product info

Voice level on both Sepura ~75%.

PESQ result attenuation has to be near by 0dB (+-10 dB).
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6.4.6.5  Action menu TETRA

The "Action" menu opens a popup box used to set up a call. It is added to the menu
bar when a mobile driver has been successfully installed, see Chapter 6.1, "Devices",
on page 1447.

If several mobiles are connected, separate command lines are displayed for each of
them.

Handset TETRA

Activates the entry of a number to dial, set up and terminate a call.
● Handset

The "Handset" command opens a window (equal for all drivers) which have two
possible statuses:
– Not selected
– Selected, marked with "- *" and shown in the following figure as connected

mobile [2].

If there is only one "Handset" window, it always has selected status.
If there is more than one "Handset" window, the selected status can be set to any
"Handset" window in one of two listed ways:
1) Click to the window using a mouse.
2) Choose selected window using the "N" key. In this case selection changed like
this: Window[1] > press "N"> Window[2] > press "N"> ...Window[n] > press "N">
Window[1] (cycling choose like "Alt+Tab" between open windows in MS Windows).
Only selected windows accepts hotkeys “D” ("Dial"), “A”("Answer"), “H”("Hangup").
Note: The previously mentioned keys have only effect, if the focus is not set to an
input control, example-given edit field or combo box.
Example: if you select the phone number by selecting the corresponding entry of
the combo box, the keys do not work afterwards. Set the focus to another window,
for example to the main R&S ROMES4 window.
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● >>
The ">>" button enlarges the dialog box, giving access to the Key pad and the
"Autodialing" option.

Figure 6-164: Use Autodialing

Figure 6-165: No Autodialing

● Dialed number
The number to be dialed can be entered either via the keyboard and the input field
or by clicking the on-screen keypad.

● "Close window ⊠"
Closes the window without any further action.

● "Dial"
Starts dialing the number entered before.

● "Answer"
Instructs the phone to accept the call.

● "Hangup"
Drops the line.

● "Autodialing"
If the box is checked, the phone number entered below is called periodically, the
"Dial", "Answer", and "Hangup" buttons are disabled (grayed). The autodialing
mode can be set even during the measurement, but only in "Idle mode".
This item starts "Autodialing" if the "Start with Measurement option" was not
checked in the driver configuration-autodialing tab panel.
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6.4.6.6  Signals

Not all TETRA mobiles provide the same information to R&S ROMES4.

The following table gives an overview of the signals provided by different TETRA
mobiles.

Signal Sepura Motorola EADS Radio THR9

Transmitter Yes No No

Reg.State Yes Yes No

MCC Yes No No

MNC Yes No No

TETRA Power Yes No Yes

BER No No No

LA Yes Yes Yes

Frequency Yes No Yes

C1 Yes No No

Best NC LA Yes No Yes

Best NC C2 Yes No No

NC x TETRA Power Yes No Yes

NC x Frequency Yes No Yes

NC x C2 Yes No No

KPI Values
Use SEPURA radios to obtain the most accurate KPI values.

Layer 3 messages
If the Sepura mobile is loaded using the Sepura driver (not the PEI driver), R&S
ROMES4 can also decode and provide L3 messages.

To generate events for most of the TETRA Layer 3 messages:

1. Open the preferences dialog.

2. -Select the "Available Events" section.

3. Double-click the events which you would like to have shown.

Handling handover time with Sepura mobiles

The SEPURA driver shipped with R&S ROMES4 version 4.71 supports the measure-
ment of handover time in TETRA networks, using Mobile Link Entity (MLE) indications.
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Support for the following indications is added to the SEPURA driver:
● MLE-OPEN-IND

The primitive used by the MLE to notify higher sublayers that they have access to
communication resources.

● MLE-CLOSE-IND
The primitive used by the MLE to notify higher sublayers that they no longer have
access to communication resources.

● MLE-BREAK-IND
The primitive used by the MLE to indicate to higher sublayers that communication
resources are temporarily unavailable.

● MLE-RESUME-IND
The primitive used by the MLE to indicate to higher sublayers that communication
resources are available again.

● MLE-RESTORE-REQ
The primitive used by higher CMCE sublayer to request the MLE to send a restore
request to the new serving switching and management infrastructure (SwMI) to
continue a previous call.

The TETRA MLE sublayer is responsible of providing communication resource ser-
vices to the upper Layer 3 sublayers. When lower Layer 2 services become available
to higher layers, the MLE sublayer issues an MLE-OPEN-IND indication to the upper
layers. It notifies them that communication services are now available for transmission.
Equivalently, the MLE-CLOSE-IND indication is sent when lower layer services can no
longer be used.

Handover signaling

During a handover, the radio terminal (RT) must switch between cells. All radio links
have to be transferred from one cell to the next one. The MAC layer of the RT must
switch to a new channel in the target location area (LA). All lower layer 2 services
become unavailable for layer 3 entities while a handover is in progress. To notify that
communication services are temporarily unavailable, the MLE sublayer sends an MLE-
BREAK-IND indication to higher layer 3 sublayers. These sublayers, in response, sus-
pend their activity and wait for services to become available again. Upon handover
completion, the MLE notifies the higher sublayers that the communication resources
are available once again by issuing an MLE-RESUME_IND indication.

In case a connection has to be restored (i.e. an ongoing call has to be continued), a
MLE-RESTORE_REQ request is sent from higher layers to the MLE. MLE then asks
the SwMI to restore the connection at the new LA. If the connection is lost and commu-
nication services can no longer be accessed, the MLE notifies higher sublayers by
issuing an MLE-CLOSE-IND indication. All higher-level services are halted until com-
munication is established again, which is notified by the MLE by sending an MLE-
OPEN-IND indication.

If the connection is lost and communication services can no longer be accessed, the
MLE notifies higher sublayers by issuing an MLE-CLOSE-IND indication. All higher-
level services are halted until communication is established again, which is notified by
the MLE by sending an MLE-OPEN-IND indication.
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Determining handover time

The handover time is defined as the time span, during which lower layer services can-
not be used by higher layer 3 entities. This time can thus be estimated, by calculating
the length of the interval between an MLE-BREAK-IND indication and the correspond-
ing MLE-RESUME-IND indication.

MLE signaling in the R&S ROMES4 layer 3 view

The introduced MLE indications can be found inside the "Layer 3 View" when measur-
ing with Sepura radios, as shown in the following figures.

Figure 6-166: MLE signaling during successful handover procedure

In addition, the MLE-BREAK-IND and MLE-RESUME-IND indications hold additional
useful information about the handover process, which can be accessed by double-
clicking the messages inside the Layer 3 View.

The MLE-BREAK-IND details show the current location area, the location area of the
target cell and the type of handover procedure that has been started by the device.
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After handover has been completed, the location area of the new serving cell can also
be inspected inside the MLE-RESUME indication details, as shown in the following fig-
ure.

6.4.7  LTE mobile devices

To see test mobile devices that are supported by R&S ROMES refer to
Supported Test Mobiles ROMES.pdf file which is found in
the ..\Documents\ReleaseNotes\ of the delivered R&S ROMES DVD.

● LTE Samsung chipset-based devices.................................................................1633
● LTE Qualcomm chipset-based devices...............................................................1636
● Support of Android debug interface.................................................................... 1648
● Action menu LTE.................................................................................................1650

6.4.7.1  LTE Samsung chipset-based devices

R&S ROMES4 fully supports the Samsung chipset based mobile devices.

The requested Samsung chipset version has to be at least ICD 4.80 and the R&S
driver option R&S ROMES4SAM.

To load the Samsung chipset-based mobile device, select the "Samsung Chipset
(Phone)" entry in the "Hardware" > "Connect/Disconnecte" > "Available Devices" pane.

The Samsung chipset-based mobile devices do not support all available R&S
ROMES4 signals and views. The following mobile views are supported:
● 3GPP

– "3GPP Overview View"
– "Layer 3 View"
– "3GPP Handover Analyzer View"
– "3GPP Neighbor Set View"
– "ETSI QoS View"
– "UE Capabilities View"

● LTE Views
– "Cell Set View"

● UMTS Views
– "Cell Set View"
– "UMTS Layer 1 Graph View"
– "UMTS Neighbourhood Analyser"
– "UMTS RLC/MAC View"

Test devices



Hardware ComponentsDrive Test Software

1634Operating Manual 1171.6415.12 ─ 66

– "UMTS SIB View"
● GSM Views

– "Cell Set View"
– "GSM Chart View (no FER)"
– "GSM Neighbourhood Analyser"
– "GSM System Information View"
– "GSM GPRS TS/CS View"
– "Partly GSM GPRS/EGPRS"
– "Partly GSM GPRS RLC/MAC View"

The Samsung chipset-based devices can operate in DQA fully integrated trace mode
and in On PC testing (Classic) mode.

Configuration menu LTE (Samsung)

The configuration page for Samsung chipset-based mobile devices has the following
tabs opening the associated configuration pages:

● "Autodialing"
● "VoLTE"
● "Advanced"

The following figures show the "Autodialing (MOC Analysis)" and "VoLTE" pages for
the SM-G925F phone.

The autodialing settings are the same as for all other test UEs.
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Figure 6-167: Simple mode autodialing with SM -G295F

VoLTE test needs the R&S ROMES4VO option and the activated VoLTE Tracing fea-
ture.

Deactivate the VoLTE tracing option if the higher data throughput is requested. The
tracing of VoLTE consumes much device's processing capability.

Figure 6-168: VoLTE tracing
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Support of emergency call test

Samsung chipset based mobile devices support the emergency call test if set in On PC
testing (Classic) mode.

Emergency numbers are registered on a certain SIM card field. Calling one of these
emergency numbers results in a special signaling (L3 EMERGENCY SETUP) in oppo-
site to call of normal phone numbers.

Disabled lock screen is the prerequisite for emergency call on smartphone.

For example, on Samsung Galaxy S6 perform the following:

"Settings" > "Lock screen and security", "Screen lock type" > "NONE"

Otherwise, the call does not start.

6.4.7.2  LTE Qualcomm chipset-based devices

The R&S ROMES4 Qualcomm driver offers a common user interface for the supported
devices.

Disable third-party connection programs
It is highly not recommended to use third-party tools for device configuration during the
time the device is connected to R&S ROMES4.
Disable the connection programs delivered with the test devices.

To use the LTE Qualcomm chipset-based mobile devices, the R&S ROMES4QP (LTE
extension) or R&S ROMES4QC/ROMES4SAM option is required, dependent on DQA
operation mode.

● For DQA measurements, most of test devices with Qualcomm chipset must be loa-
ded by using the NDIS Interface. For details, see Chapter 6.1.8.1, "Connecting
Qualcomm chipset based mobiles", on page 1468 and Chapter 6.1.4.3, "NDIS
interface", on page 1457.

● Use the R&S ROMES4 DQA Dialup method for DQA Connect job. Bind it to the
NDIS interface of the test device.

To measure the performance and behavior of specific bands and RATs of heterogene-
ous networks, it is required to force the UE to a specific band.

Some Qualcomm chipset-based test mobiles devices, for example, Huawei LTE USB
sticks and several Sierra LTE UEs, allow setting a specific combination of supported
bands for different RATs.

Configuration menu LTE (Qualcomm)

The configuration page of Qualcomm chipset-based mobile devices contains tabs hav-
ing different functions.
● "Configuration" > "Extra setting" evaluates the message types by the test system.
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● "NQA Settings" runs network quality analysis.
● "Autodialing" configures autodialing and auto-answer call mode
● "Serial Port Driver Info" displays information on the driver and assigned serial port

Click the "Hardware" >"Connect/Disconnect" command.

In the "Hardware Configuration" > "Available Devices" window, under the Mobile Devi-
ces, double-click the "Qualcomm Chipset" option. The connected Qualcomm chipset-
based device is loaded, activated and the device configuration page opens.

● Configuration LTE (Qualcomm)...........................................................................1637
● Extra settings LTE (Qualcomm).......................................................................... 1639
● Network forcing LTE (Qualcomm)....................................................................... 1640
● Qualcomm mobile wizard support of Android smartphones and VoLTE............. 1644
● Extended VoLTE support.................................................................................... 1644

Configuration LTE (Qualcomm)

The opening "Advanced" > "Device" page allows a rough preselection of the message
types to evaluate. Here the PIN number can be entered in case a data card. For most
test mobile devices, PIN has to be entered.

The LTE test devices provide much information that the test system is able to store and
evaluate. In many applications, only a subset of this information is needed. Restricting
the recorded data saves system resources and reduces the size of the measurement
files.
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Figure 6-169: LTE driver configuration – Device

General
Enter the PIN number for identification after switching on the test mobile in the "Gen-
eral" pane of the configuration opening page (not supported by most test mobiles). If
nothing is entered or the PIN is ignored, the SIM must be entered manually at the
mobile each time it is started.
Select an AMR codec in the "AMR Rate" drop-down box.
Note:
The option "Make Diagnostic Calls" is removed from the Qualcomm driver configura-
tion page, as the current mobiles with Qualcomm chipset do not support this specific
call type.

Measurements
The technology-related checkboxes in the "Measurements" pane are used for a rough
preselection of the messages and information types to be recorded and written to the
measurement file.
The selection can be refined in the "Extra settings" page. For an overview of available
messages, views and signals, see "Extra settings LTE (Qualcomm)" on page 1639.

Mobile Info
Gives the information about the test device.
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Mobile Display
"Show Mobile Display" is not provided.
To identify the IMEI of a test mobile device, click the "Identify" button. If the test device
has a display, the corresponding number appears on it.

Figure 6-170: Message window

Extra settings LTE (Qualcomm)

The "Extra settings" page allows selecting the message types for recording to the mea-
surement file.

Configure the LTE driver for making LTE measurements, see the previously mentioned
"Device" page, "Configuration LTE (Qualcomm)" on page 1637.

Figure 6-171: LTE driver configuration – Extra settings
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Select the LTE messages which you want to be included in measurement report and
evaluated from the list in the upper pane of the page. For an explanation of the recor-
ded parameters, see the description in the Chapter 4.4.6, "LTE views", on page 810.

Parameter description
For the meaning of the checkboxes in the page, see "Extra settings UMTS"
on page 1573.
For the parameters in the "NQA Settings", "Handover" and "SQA" pages, see "NQA
settings" on page 1583"Handover analyzer" on page 1584 and "Speech quality"
on page 1585, respectively.

Network forcing LTE (Qualcomm)

This option is stored in the registry and can be exported/imported via the system con-
figurations export of R&S ROMES4. The forcing settings are part of the workspace/
template settings. If a workspace is loaded with forcing settings which is not or only
partially supported by the currently connected device, a message pops-up. It informs
that the forcing settings are not applied at all (applying partially settings is not suppor-
ted).

The "Network Forcing" configuration page of the Qualcomm driver offers the actual
supported bands and its state of selection for currently connected device, see the fol-
lowing figure.

Figure 6-172: Network Forcing page
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Actually, the current state is read only once from the device. From that point in time,
the software traces all state changes, which are performed by R&S ROMES4. The
state is not displayed correctly, if it was changed by using another program during a
R&S ROMES4 session.

You can change the selected bands and after click the "Apply Network Forcing Now"
button the new configuration is written to the device.

If the "Enable Forcing" option is inactive, R&S ROMES4 does not write any settings
automatically to the device. Thus, activate the option to store the forcing settings to the
workspace, restore and write them to the device automatically.

"Bandforcing: Off" is the report for the combination of all supported bands.

Figure 6-173: Forcing settings - all bands enabled

Some devices cannot support the all possible band combinations. For example, some
Huawei sticks do not allow you to select only UMTS/GSM without LTE.

The Qualcomm chipset-based mobile device support to change the forcing during the
measurement by using the "Network Forcing" action menu.

Note that the access to certain interfaces of the device is required when changing the
forcing. If these interfaces are blocked by other tasks, for example by DQA or Auto-
dialer, the forcing command fails. The forcing settings which were applied during the
measurement do not change the workspace settings. Thus after a restart of the mea-
surement, the device will be set to the initial forcing settings which are part of the cur-
rent device configuration. If you change the forcing settings but deactivate the forcing
and do not apply these settings, a warning is issued when leaving the network forcing
page. The figure shows the warning.
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Figure 6-174: Options offered when changing forcing settings

Band forcing visualization

The forcing settings are written into the device at the start of measurement. A message
which notes the forced bands is written to the "General Status View".

A R&S ROMES4 signal also displays the current state of the device concerning forc-
ing.

Figure 6-175: Forced bands

An icon in the "3GPP Overview View" informs on forcing of the UE which was actively
set by R&S ROMES4. A Tooltip on the icon shows the actual forced bands.
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Figure 6-176: Current forcing indication in 3GPP Overview View

Applied forcing settings are stored in the "File Info" page, see the following figure.

Figure 6-177: Measurement file info
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Qualcomm mobile wizard support of Android smartphones and VoLTE

The Qualcomm Mobile Wizard has additional settings for supporting Android smart-
phones and VoLTE.

The Android debug interface is supported as dial method, see the following figure.

Figure 6-178: Dialing method for CS calls

To use this interface, a mobile phone has to have an Android operating system. Switch
on the USB debugging at that mobile device. The availability of the ADB interface for
the phone is checked when pressing the "Next" button. If the interface is not available,
another dialing method has to be selected.

The IMS stack to be installed on the phone is selected in the lower part of the Wizard
dialog. The dialog is active only if the phone supports LTE (RAT page).

The following stack options can be selected:
● VoLTE not supported
● Qualcomm IMS Stack
● Samsung IMS Stack
● Other IMS Stack

Extended VoLTE support

VoLTE is supported independently of the implemented IMS stack. During the integra-
tion of a phone with the Qualcomm Mobile Wizard, the phone has to be properly con-
figured to perform VoLTE measurements. The actual kind of IMS stack has to be acti-
vated.
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Figure 6-179: IMS stack activation

Selection of proper point of observation

The Qualcomm devices have two different points of observation concerning VoLTE.

Although most of the UEs use point 1 as a point of observation, some use point 2. If no
IMS messages are show in the Layer 3 View while setting up a VoLTE call, most prob-
ably the wrong point of observation is selected. In this case open the UEs "VoLTE"
configuration page and press the "Auto" button, see the previous figure.

The driver is now trying to detect the correct point of observation automatically.

While doing the autoconfiguration, the driver tries to register to the VoLTE network.
R&S ROMES4 notifies that registration try. This registration period takes up to 30 sec-
onds.

Figure 6-180: Driver tries register to VoLTE network

If a valid registration has been notified, the process stops, the correct point of observa-
tion is set and the controls are disabled.

Figure 6-181: UE ready for VoLTE measurements
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Creation of PCAP file

R&S ROMES4 allows PCAP file for VoLTE calls in parallel to write to the R&S
ROMES4 measurement file. The file name is
<ROMESMeasurementFileName>.rscmd<DeviceName>.pcap.

By default, writing a PCAP file is disabled. Writing is activated by selecting the "Create
PCAP File (File will be created...)" option, see Figure 6-179.

The timestamps of the *.pcap file are set intentionally to the R&S ROMES4 measure-
ment file's timestamp, not to the UTC time. This setting allows the timestamps of the
R&S ROMES4 display to match with the Wireshark timestamps.

By default Wireshark displays the relative timestamps in second column only. To make
times comparable, add new column "UTC Time" in Wireshark using the "Column Pref-
erences" option, as shown in the following figure.

Figure 6-182: Adjusting timestamp in Wireshark

The displayed timestamps in the new column correspond to the R&S ROMES4 time-
stamp in “Relative Timestamp” format (xxx ms).

Figure 6-183: ROMES timestamp formats

The following figure shows message views obtained by the R&S ROMES4 and Wire-
shark.
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Figure 6-184: Message views comparison

The PCAP file can be opened in Wireshark already during the running measurement.

RTP analyzer

The RTP analyzer calculates the RTP Packet Loss during the VoLTE call. The algo-
rithm uses a jitter buffer whose length you can configure between 1 to 20 packets.

Figure 6-185: Services - VoLTE dialog

A timeout value specifies when R&S ROMES4 resets the analyzer and its values. This
timeout is used also to cancel active calls. If the calls are set up by the R&S ROMES4
autodialer, the call is marked as BLOCKED/DROPPED CALL.
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The settings are stored in the measurement file and are part of the measurement file
info, see the following figure.

Figure 6-186: VoLTE settings shown in file info

VoLTE POLQA measurements

Using the SMP option with the SM-G900F, R&S ROMES4 is able to do the POLQA
measurement on VoLTE networks.

Possible problems check during VoLTE call

The Qualcomm driver checks the possible problems during a VoLTE call.

If the autodialer starts and the SIP Invite message is received although a dedicated
bearer is requested, the driver cancels the call without marking it as blocked. After can-
celing the call, the driver tries to re-register to the IMS server.

Figure 6-187: Call canceled due to detected problem

6.4.7.3  Support of Android debug interface

While using smartphones, it can happen that AT commands are not supported as
expected. R&S ROMES4 offers the possibility to use the adb commands instead of AT
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commands. The Adb commands are device-specific. Define them for each device sep-
arately.

Another advantage of using the adb commands is that the multi RAB session can be
initiated without the need of using tethering.

A device is defined by its VID and PID (vendor and product ID). While loading the
Qualcomm driver of the UE, R&S ROMES4 prints the "Output" window where it looks
for the device specific adb commands.

Figure 6-188: ROMES Output window

R&S ROMES4 scans for *.adb files for each supported command.

Whenever a command is executed the output view shows the exact command, which
was sent to the device.

A precondition for using the adb commands is that USB Debugging is switched on at
the UE. This switch can be found usually in the "Developer Options" > "Options" >
"Settings" application.

Supported commands

The supported adb commands are listed in the following sections.

The content of the files is used as an argument for the adb.exe.

Dial

The file name of the command is dial.adb.

Use the place holder %%TELNUMBER%% in the file. This place holder is replaced by
the actual phone number which is called.

Example: 
shell am start -a android.intent.action.CALL tel:%%TELNUMBER%%

Hangup

The file name of the command is hangup.adb.

Example: 
shell input keyevent 6

Answer

The file name of the command is answer.adb.

Test devices



Hardware ComponentsDrive Test Software

1650Operating Manual 1171.6415.12 ─ 66

Example: 
shell input keyevent 5

Switch to airplane mode

The file name of the command is AirplaneModeOn.adb.

Use the following place holders in the file:
● %%TELNUMBER%%
● %%SMSBODY%%

These place holders are replaced by the actual phone number and SMS Text.

Example: 
shell settings put global airplane_mode_on 1
shell am broadcast -a android.intent.action.AIRPLANE_MODE --ez state true

Switch off airplane mode

The file name of the command is AirplaneModeOff.adb.

Example: 
shell settings put global airplane_mode_on 0
shell am broadcast -a android.intent.action.AIRPLANE_MODE --ez state false

Send SMS

The file name of the command is "SendSMS.adb".

Example: 
shell am start -a android.intent.action.SENDTO -d sms:%%TELNUMBER%% --es
sms_body "%%SMSBODY%%" --ez exit_on_sent true
shell am broadcast -a android.intent.action.AIRPLANE_MODE --ez state false
shell input keyevent 22
shell input keyevent 26

6.4.7.4  Action menu LTE

Click the "Action" menu to get the box in the tool bar used to set up a call. The "Action"
is added to the menu bar when mobile device has been successfully installed (see
Chapter 6.1, "Devices", on page 1447).

Figure 6-189: Action menu for LTE driver
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If several mobiles are connected, separate command lines are displayed for each of
them.

Handset LTE

Activates the entry of a number to dial, set up and terminate a call.
● Handset

The "Handset" command opens a window (equal for all drivers) which have two
possible statuses:
– Not selected
– Selected, marked with "- *" and shown in the following figure as connected

mobile [2].

If there is only one "Handset" window, it always has selected status.
If there is more than one "Handset" window, the selected status can be set to any
"Handset" window in one of two listed ways:
1) Click to the window using a mouse.
2) Choose selected window using the "N" key. In this case selection changed like
this: Window[1] > press "N"> Window[2] > press "N"> ...Window[n] > press "N">
Window[1] (cycling choose like "Alt+Tab" between open windows in MS Windows).
Only selected windows accepts hotkeys “D” ("Dial"), “A”("Answer"), “H”("Hangup").
Note: The previously mentioned keys have only effect, if the focus is not set to an
input control, example-given edit field or combo box.
Example: if you select the phone number by selecting the corresponding entry of
the combo box, the keys do not work afterwards. Set the focus to another window,
for example to the main R&S ROMES4 window.

● >>
The ">>" button enlarges the dialog box, giving access to the Key pad and the
"Autodialing" option.
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Figure 6-190: Use Autodialing

Figure 6-191: No Autodialing

● Dialed number
The number to be dialed can be entered either via the keyboard and the input field
or by clicking the on-screen keypad.

● "Close window ⊠"
Closes the window without any further action.

● "Dial"
Starts dialing the number entered before.

● "Answer"
Instructs the phone to accept the call.

● "Hangup"
Drops the line.

● "Autodialing"
If the box is checked, the phone number entered below is called periodically, the
"Dial", "Answer", and "Hangup" buttons are disabled (grayed). The autodialing
mode can be set even during the measurement, but only in "Idle mode".
This item starts "Autodialing" if the "Start with Measurement option" was not
checked in the driver configuration-autodialing tab panel.

6.4.8  NB-IoT devices

R&S ROMES4 supports the Exelonix NB-IoT development/evaluation modules. Their
full integration in R&S ROMES4 makes required NT-IoT performance testing more
comfortable.
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Currently supported Exelonix NB-IoT modules use the following devices:

● SARA-R410M device (Qualcomm chipset based)
● SARA-N211 device (Neul chipset based)

6.4.8.1  Support of Exelonix NB-IoT modules

These modules offer band forcing in their "Network Forcing" configuration dialog.

R&S ROMES4 supports the Exelonix NB-IoT stick based on Quectel BG77. This mod-
ule supports the on-device tests Ping and FTP jobs.

Note: Band forcing requires a reboot of the module. It is recommended to force the
module before doing the measurement, and not as a part of the measurements config-
uration.

Note: If the Qualcomm R410M device is added to R&S ROMES4 by using the Qual-
comm Wizard, remove the corresponding entry from the file
My ROMES\Configuration\QualcommMobilesV462.xml. In that way, you get the
access to the new features.

Figure 6-192: Band forcing for NB-IoT
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These modules offer preconfigured DQA jobs, which allow to do the tests listed in the
following table.
Table 6-12: NB-IoT supported DQA jobs

DQA Job SARA-R410M SARA-N211

NB-IoT Attach available available

NB-IoT Detach available available

NB-IoT Send UDP available available

NB-IoT Ping not available available

NB-IoT FTP The job is supported if the Exelonix stick supports FTP

Figure 6-193: List of available NB-IoT DQA jobs

6.4.9  Support of smartphones

R&S ROMES4 supports variety of the Qualcomm Snapdragon and Samsung Exynos
chipset-based smartphones.

For the supported smartphones, see the Supported Devices2023-07-04.xlsx
file, which is a part of the customer documentation. The "x" symbol in the column Qual-
iPoc RF of the "Devices" tab indicates the QualiPoc devices w/o POLQA which R&S
ROMES4 supports. The next column, the QualiPoc QA with the same symbol indicates
devices with speech quality analysis capability which R&S ROMES4 supports.

Support of Qualcomm and Samsung chipset based smartphones is indicated in "Hard-
ware" > "Hardware Configuration" > "Mobile Devices". All services' test (for example,
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FTP or HTTP service) are executed on a device, not on the computer. Such an execu-
tion of a test allows the system to simulate the user behavior more accurately.

The R&S ROMES4 fully supports service test on listed smartphone models.

Figure 6-194: Supported smartphone

Prerequisite for Android based smartphones
To use an Android OS based mobile device as a "Smartphone" with the R&S
ROMES4, a special SW is installed on it. The Rohde & Schwarz is supposed to do the
installation. This installation requires the R&S ROMES4QP or the R&S ROMES4QC/
ROMES4SAM option dependent on the selected DQA operation mode.

Prerequisites for first usage a Samsung Galaxy S3 LTE GT-I9305 Smartphone
with R&S ROMES4
Before you use the Samsung Galaxy S3 LTE GT-I9305 for the first time as the "Smart-
phone" with R&S ROMES4, perform the following steps:
● Dial *#7284# on telephone keypad.
● Choose "DM + MODEM + ADB" in the "Qualcomm Settings" submenu and press

"OK".
● Leave the main menu without pressing "SAVE" and "RESET".

Reboot of a smartphone
The first time a smartphone is connected to R&S ROMES4, reboot of the phone after
the installation of the Android applications can be required. If loading the R&S
ROMES4 driver files fails with the message that a reboot is necessary, connect the
phone again after it is rebooted.

For the successful connection to the mobile network, the software requires the properly
configured default APN profile.

Dependent on mobile type, users can select predefined entries for APN type or enter
them as a text via keyboard.

To set the APN type, navigate to the APN menu within your phone settings menu (for
example, "Settings" > "Wireless & Networks" > "Mobile Networks" > "Access Point
Names").

1. ● Select the APN "Internet" if only the predefined settings are possible.
● Type default,supl when the APN type setting is editable (string value).
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2. Save the settings.

3. Exit the menu.

The default APN profile is now properly configured.

The Samsung chipset based mobile device can be loaded in two ways:
● From the "Devices" in the "Welcome" page, see Figure 3-3.
● From the "Hardware" > "Connect/Disconnect" > "Hardware Configuration" page.

If the device is loaded from the "Welcome" page, the same load options as for the
Qualcomm chipset-based devices are available, see Figure 6-22.

If the device is loaded from the "Hardware Configuration" page, the "Assign Serial
Ports" dialog opens, which allows to select diagnostic ports.

The Samsung Exynos chipset-based smartphones offer both a diagnostic port and IP
connection, see Chapter 6.1.9, "Samsung Exynos 5G chipset-based mobile devices",
on page 1484.

Selection of the "as QualiPoc" diagnostic port together with the "use GPS"option,
allows the internal mobile's GPS usage. The GPS driver performs the DQA jobs in QP
mode. In addition, if the WLAN option is available, possible is usage of internal WLAN
interface for WLAN scanning.

● Action menu........................................................................................................ 1656
● Smartphones configuration page........................................................................ 1656
● RAT forcing with smartphones............................................................................ 1657
● Advanced band forcing with smartphones.......................................................... 1657
● Supported GPS of smartphones......................................................................... 1659
● Smartphones support of WLAN scanning...........................................................1665

6.4.9.1  Action menu

For quick tests, use the "Action" > "<mobile name>(QP)" menu, which initiates data
tests and visualizes the basic log results.

This interface is designed for the expert user.
Ensure not to interfere running DQA measurement sessions.

The R&S ROMES4 does not support dis- and reconnect of a smartphone during a
measurement.

6.4.9.2  Smartphones configuration page

The figure shows the tabs available to set a Qualcomm chipset based mobile device
and the contents of the main "Device" page. The page gives basic information about
connected device.

Select measurement types/technologies to run on the device in the "Measurements"
pane.
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For the supported services, see Chapter 6.5.2, "DQA jobs with Android OS-based
smartphones", on page 1961.

Figure 6-195: Connected Samsung device

6.4.9.3  RAT forcing with smartphones

Smartphones support the RAT forcing. The forcing is the same as with other mobile
devices.

Smartphones do not support a query which allows getting the information about the
currently active forcing. Thus unless the R&S ROMES4 has control over the forcing
activity, the R&S ROMES4 cannot display the actual state of the forcing settings.

After sending a force command to a device for the first time, R&S ROMES4 tracks the
state of forcing. The state tracking checks if the forcing commands are sent by the
R&S ROMES4 and not by other products or changed manually.

RAT network forcing is not available for the Samsung Galaxy S6 smartphones.

6.4.9.4  Advanced band forcing with smartphones

Smartphones support the advanced band forcing. You can force them to a certain
channel and a certain cell of the channel.
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Figure 6-196: Network forcing setting

Select the band forcing type in the "Network Forcing" > "Mode" combo-box.
● Select the "Band Forcing" entry to force bands in the known way.
● Select the "Advanced Forcing" entry to configure channels and cells for band forc-

ing of the 3GPP specified RATs. The entry is unavailable if a mobile does not sup-
port advanced forcing.

After selection, click "OK" to execute the task. The forcing process takes up to 60 sec-
onds. After this time, the forcing stops.

Advanced forcing is an experimental feature and could harm the mobile phone.

To force UMTS or LTE only to a special UARFCN/EARFCN, the SC/PCI value in the
corresponding combo-box must be set to "–".

Sometimes forcing is not possible due to the current state of a mobile phone. If the
forcing fails, an error message is displayed. Often, the mobile phone must be rebooted
to activate band forcing and the trace port is lost then. Confirm the related R&S
ROMES4 message by pressing the "OK" button.

At a measurement start, the mobile phone is forced with the configuration of the cur-
rent workspace. The "General Status View" shows the current forcing state or, if availa-
ble, the reason of a forcing failure (for example, Android error, BCCH lock not available
for this device).
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Figure 6-197: Current forcing state of a mobile

During the advanced measurement, forcing is not possible.

6.4.9.5  Supported GPS of smartphones

QualiPoc plus GPS

If a smartphone has built-in GPS, i.e. uses the QualiPoc mode plus GPS, the usual
GPS configuration page is a part of the drivers' configuration dialog, see Figure 6-22.

The following figure shows the "GPS Health Monitoring" page for the Samsung Galaxy
S5.
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Figure 6-198: GPS configuration dialog

For the details about the functions in the "GPS Health Monitoring" and "Indoor Configu-
ration" pages, see Chapter 6.6.1, "GPS devices", on page 2061.

GPS of iPhones

The GPS of an iPhone can also be the GPS source of the R&S ROMES4 measure-
ment.

As most of the users use the scanner GPS or have a special GPS device, the option to
use the iPhone’s GPS is disabled by default.

To enable the GPS of the iPhone, select the option "Offer GPS for QualiPoc/Phone
Devices" in the "Preferences" > "Advanced Settings" page.

If the option is selected, the page pops-up asking you whether to use the GPS once
the iPhone is loaded into R&S ROMES4. Only one GPS is accepted in R&S ROMES4
application. If two or more iPhones are loaded into R&S ROMES4, only one of them
can be the GPS source.

Confirm on the iPhone that the R&S ROMES Probe iOS App is allowed to use GPS. If
it is denied, no GPS data can be forwarded to R&S ROMES4. If you decide later to
activate usage of the iPhone's GPS, it has to be done in the iPhone’s configuration, as
usual.

iPhone app

For the GPS support of the R&S ROMES Probe iOS App on iPhone, the application
asks for permission to use the phones location data. The first time the application is
started you are prompted to give the application permission to use location whenever
the app is in use.
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Figure 6-199: Allowing app to use device location

The following selections for the location usage are available:

- "Allow Once": The R&S ROMES Probe iOS App (further R&S ROMES Probe) pro-
vides GPS data to R&S ROMES4 only during a data test measurement. GPS during
voice call test is not done as the application is in the background. Despite "Allow Once"
selection, the location permission does not receive location updates while in the back-
ground. The next time the application is run, the prompt for location permission is done
again.

- "Allow While Using App": The R&S ROMES Probe prompts if it is allowed to receive
location updates while in the background.

- "Don’t Allow": The R&S ROMES Probe does not provide location data to R&S
ROMES4. It does not prompt you for location permission again. This choice can be
changed in the "Settings" > "Privacy" > "Location Services" by giving the "Always" per-
mission to the R&S ROMES Probe iOS App.
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Figure 6-200: Allowing app usage during voice call

- "Change to Always Allow": The R&S ROMES Probe provides GPS data to R&S
ROMES4 during data and voice test. The "Always" permission is need so that location
data can be provided on voice call test while the application is in the background. The
application is periodically reprompt for "Always" permission. The periodical reprompt
ensures you continuously to allow R&S ROMES Probe to receive location updates
while the application is in the background.

- "Keep Only While Using": The R&S ROMES Probe only provides GPS data to R&S
ROMES4 during a data test measurement. GPS during voice call test is not done as
the application is in the background. The location permission with "Allow While Using
App" selected does not receive location updates while in the background. The app
honors you selection and does not prompt for location permission again. This choice
can be changed by "Settings" > "Privacy" > "Location Services" by selecting "Always"
for the R&S ROMES Probe.
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Figure 6-201: "Always" set for R&S ROMES Probe

iPhone App Settings
R&S ROMES Probe has two settings to support GPS of iPhone.
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Figure 6-202: iPhone location settings

The settings are:
- "Send Location to ROMES": If activated and the application has given the location
services permission, the location updates are sent to R&S ROMES4 during measure-
ments. If not activated, the location updates are not sent to R&S ROMES4 regardless
of location services permission given.
- "Send to ROMES Interval" – The frequency location updates are sent to R&S
ROMES4 during measurements. The available periodicities for sending the updates
are available in the "Send All Updates".
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Figure 6-203: Send location update each 500 ms, default

6.4.9.6  Smartphones support of WLAN scanning

If the R&S ROMES4WF2 WLAN option is available, it is possible to scan WLAN net-
works with a smartphone.

The WLAN option must be activated on the smartphone to start the WLAN scanning
during measurement.

The WLAN data are displayed in the all available WLAN scan views.
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Figure 6-204: Supported WLAN scan views for Smartphone

If a smartphone is connected to WLAN, certain IP connections are offloaded to WLAN.

If the smartphone is connected to a WLAN network and a DQA job is linked to it, the
R&S ROMES4 Data Quality Analyzer is informed about this connection. The offloading
can run.

If the connection changes during a DOA job execution, the job is aborted, because the
current connection is dropped. In this case, the job automatically restarts WLAN with
the new current connection.

The current WLAN connection status can be observed within the "Signal Tree View" >
"WLAN", the "Connection Status" branch.

Support of WLAN offloading for smartphone

If the connection changes from LTE to WLAN during the execution of a DQA job (for
example, FTP Download), the current job is aborted. The job is aborted as the connec-
tion dropped. The job automatically restarts WLAN then.

The signals in "Interface Statistics" and "Radio State" brunch are not available. The
"Smartphone Event" signal indicates scanning and connection state changing, the info
is provided from smartphone.

6.4.10  Integration of Quectel RM5xxQ modules

As being integrated into R&S ROMES4, the usage of Quectel modules for measure-
ments is made easier.

6.4.10.1  Preparation of the device

It is R&S recommendation to use the Windows Mobile Broadband approach.
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To use that approach, install the Quectel’s MBIM drivers and ensure that the USBnet
configuration of the device is set to 2. The mentioned can be done directly via the AT
commands or using R&S ROMES4, once the MBIM driver is installed.

Ensure that only the MBIM driver is installed. Remove all other Quectel drivers, as they
can interfere with the MBIM driver.

R&S ROMES4 recognizes the module automatically. Nevertheless, ensure that R&S
ROMES4 can access the modem and the diagnostic port of the module, that is, close
any terminal program like PuTTY which opens the modem port.

Figure 6-205: Quectel device available

R&S ROMES4 allows you to change the USBnet and the APNs via the GUI.

Change the configuration of the driver and select the "Device Properties" page.

Figure 6-206: RM5xxQ-GL device properties
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The APN cannot change, depending on the SIM card inserted into the module.

If for any reason the device has not been detected automatically, try the "Add Device
Manually" option. Select the Qualcomm mobile driver and assign the COM ports of the
Quectel device accordingly.

The APN 1 connection to the data network is the one which is used. To change the
APN, enter its complete specification as required by the AT+CGDCONT command.
Changes are not written to the device automatically. To write the new settings to the
device, press the "Apply Changes" button.

To reset the device, what can be necessary for some changes, press "Reset Device"
button.

The network forcing option is implemented and accessible via the GUI. To force the
network, select the "Network Forcing" page.

Figure 6-207: RM5xxQ-GL network forcing

Check "Enable Forcing" and select the bands which are supported. The fewer bands
are selected, the faster the initial cell search finishes. If you enable only 5G bands, the
UE switches into the 5G NR Standalone mode.

You can apply the selected forcing directly from the dialog. Note that applying the forc-
ing needs a reboot of the device. If the "Enable Forcing" is checked, when pressing
"OK" R&S ROMES4 takes care that the selected forcing is applied before the start of
measurement.
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6.4.10.2  Configuration of data session

Ensure that you have not selected Windows option to connect device to a network
automatically.

Figure 6-208: Connect automatically deselected

If the MBIM driver is installed, a Mobile Broadband adapter has to be used. Quectel
USB modem does not work.

Figure 6-209: Configuring network connection

Figure 6-210: An example of the configured jobs with Quectel device

If the Windows Mobile Broadband setup is correct, the "DQA Message View" looks
similar to the following screenshot for the Connect job.
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Figure 6-211: DQA messages view for connect job

6.4.10.3  Trouble shooting

Table 6-13: Possible solutions for occurred problems

Problem Possible solutions

R&S ROMES4 does not recog-
nize the device automatically

Restart R&S ROMES4

Ensure that the diagnostic port and the modem port are accessible and
not blocked by other applications.

Test the modem port with the Windows Device Manager.

Windows Mobile Broadband
Connection does not work

Ensure that the MBIM driver is the only Quectel driver installed on your
machine.

Verify APN settings.

Verify the USBbnet property of the device, it has to be set to “2.”

R&S ROMES4 does not offer
the Mobile Broadband Adapter

Ensure that the MBIM driver is the only Quectel driver installed on your
machine.

Verify the USBnet property of the device, it has to be set to “2” .

Mobile Broadband Connection
connects automatically

Ensure that the Windows property "Windows shall handle this connection
automatically" is disabled.
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Problem Possible solutions

Device does not find the net-
work

Check the currently forced bands and adapt to required band.

Ensure that you have coverage.

Device does need long to find
the network

Force the device to the used band or more bands.

6.4.10.4  Alternative setup

The device can be also configured as an RNDIS device.

To configure it as an RNDIS device, set the USBnet property to “3” and install Quec-
tel’s Windows USB driver.

Ensure that all other Quectel drivers are uninstalled, as they can interfere.

The RNDIS setup is similar to a “normal” Ethernet connect. As soon, as the device is
attached, the connection is established.

Configure the R&S ROMES4 DQA Connect job using the Quectel Windows Network
Adapter.

Figure 6-212: Alternative for Quectel device setup

In this case, the Connect job does not really establish a connection, but is necessary to
get the link to the used network adapter. This link is necessary to calculate throughput.

This alternative setup is not recommended. Use the MBIM driver and Windows Mobile
Broadband connection approach.

6.4.11  Speech quality measurements with smartphones

R&S ROMES4 allows a speech quality measurement in an easy and convenient way if
smartphones are used. POLQA or SQUAD (the corresponding option is necessary) is
executed actually on the smartphone itself. The analysis execution on the smartphone
saves the CPU power on the PC side and even more important, makes any cabling for
speech needless.

R&S ROMES4 allows the user to measure the achieved speech quality between the
smartphone and a dedicated Land Unit (speech server) or between two mobile devi-
ces.

The Land Unit (LU) is a separate product with its own manual.
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For detailed description of speech quality measurement jobs and parameters, see
Chapter 12.11, "Smartphone SQ measurement job file", on page 2414

6.4.11.1  Measurement prerequisites

The following products/options are necessary to measure speech quality:
● R&S ROMES4 with smartphone option
● SQ smartphone with R&S ROMES4 and POLQA option
● SQ speech server

Do not load the SQA in parallel to the smartphone.

6.4.11.2  Measurement setup

The measurement sequence is defined in so called "job files". Each job file of the mea-
surement system has a corresponding file for the server. Import the server job files to
the server before using them. The server job files have the naming convention
job_nnn.ini, where nnn is a number between 0 and 999.

R&S ROMES4 allows setting the ExcludeCallSetupFromCallDuration parameter for
speech quality measurements in Fully integrated device operation mode.

The generation of the LU file allows you to set the test repetition value).

In Fully integrated device operation mode the LU.ini file contains the settings for the
*.wav file recording. The same settings as for the A-side are used.

Measurement setup with land unit as B-Party

For installation and maintenance, follow the corresponding manuals of the Land Unit.

The configuration of the device is stored in the measurement file and displayed in the
measurement file information.

Figure 6-213: Information on device configuration

To perform measure speech quality with a smartphone, the phone has to be loaded as
a smartphone (Qualcomm chipset-based device).

Import the correct job file in the "Voice Call Settings" > "Profile" combo-box used for
speech quality test with LU as a B-party.

If using a voice file profile with MTCs, ensure that a phone number of the measurement
systems’ smartphone is set correctly before importing the file. It is essential as the
imported file contains a phone number of the smartphone.
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The content of the voice file profile is displayed in the lower section of the "Voice Call
Setings" page.

Figure 6-214: Content of the selected profile - mobile to Land Unit

The LU job file is generated automatically in the smartphone's "Autodialing" page.

The complete setup of the measurement is done in the smartphone's "Autodialing"
page. If a smartphone is connected, the page offers the "Voice Call Settings" option.

1. Select the "Voice Call Settings" option.

2. Select one of the available smartphone job files in "Profile".

3. Enter the telephone number of the smartphone ("Own") and the Land Unit ("To
Call").

4. Press the "Land Unit" button to generate the corresponding job file for the Land
Unit.

5. Confirm the edited parameters of the Land Unit 's job_nnn.ini file in the opened
"Land Unit Configuration Parameters" dialog.
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Figure 6-215: Land Unit parameters

The job file is created in the Land Unit 's subdirectory.

The parameters shown in the dialog are:
● "A-Party Number"

Telephone number of the dialing party (the smartphone)
● "B-Party Number"

Telephone number the Land Unit listens to
● "B-Party Device ID"

Device ID configured in the file LU isdn conf.txt on the Land Unit
● "ISDN Adapter Number"

Configured ISDN adapter number

The job files have to be writeable, as they are adapted during the measurement.

The "Voice Call Settings" > "Audio File Handling" function offers three different options
for handling the recorded audio file.
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Table 6-14: Options for handling the recorded audio file

Option Description

"Don’t Store Audio" Audio files are never stored to the measurement file

"Store Audio" All audio files are stored to the measurement file

"Store Audio, if MOS is
worse than…"

Audio files are stored only, if the corresponding MOS value is worse than the
given value

Click the "Edit Profile" button to edit a voice file profile you selected in the "Profile"
combo box. The "Voice Call Profile <*.ini>" page is displayed.

Figure 6-216: Job profile configuration

Voice call profile

The file name of the selected voice file profile is shown in the "Voice Call Profile
<*.ini>" > "Description (will be shown...)" box. The additional description can be added.

Select the algorithm to be used for the voice file profile in "Algorithm".

You can change the reference sample file of a voice file profile in "Reference Sample
File". The "Reference Sample File" combo-box is filled with the *.wav files available
on the phone. After saving the reference sample file configuration of call values, R&S
ROMES4 checks if the selected reference file is also available on the B-side.

This file must be available on mobiles of the A-side and the B-side, i.e. on the Land
Unit used as a B-side. If not available, a warning message is displayed.
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Figure 6-217: Combo-box filled with files available on A-side

To edit the call values of a reference sample file, position the mouse cursor over the
desired slider and use the mouse wheel.

"Window Duration" defines the total time for the call.

The ranges of the other call values depend on the value adjusted in "Window Dura-
tion".

That is, the settings in the "First Call Setup Delay" + "Call Duration" + "Pause Duration"
must be lower or equal than this value.

The "Voice Call Profile" page lets set the MOC to MTC ratio. The job name must be
defined other than being in the range 001 to 010, as the jobs in mentioned range are
R&S ROMES4 system configurations (ROMES System INI Files).

If the selected file is a R&S ROMES4 predefined profile (for example, job_001.ini),
the "Save" button is disabled because such a profile cannot be changed. If the job's
name is greater that 010, the button is active and the modified settings can be saved.
The file name is automatically generated using the job name.

To create a user defined (modified) file from a predefined profile file, i.e. the source
file's name is in range 001 to 010, apply "Save as" and different file name.
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If the profile is configured to call the B-Party which is a Land Unit, the question whether
to create the LU job_xxx.ini file with these modified settings is displayed.

If you select "Yes", the "Land Unit Configuration Parameters" dialog is displayed, see
Figure 6-215, where additional settings can be done.

The storage directory for the new profile must be the same directory where the R&S
ROMES4 standard profiles are stored. One of the following storage locations is used:
C:\ProgramData\Rohde&Schwarz\My ROMES\Smartphone Voice Profiles\
UE-UE, if two mobiles are involved.
C:\ProgramData\Rohde&Schwarz\My ROMES\Smartphone Voice Profiles\
UE-LU, if a Landing Unit is used.

If the profile is saved, it is shown as the current one in the "Autodialing" configuration
page.

Measurement setup with smartphone as B-Party

If two smartphone mobiles are connected to R&S ROMES4, it is possible to test the
speech quality of a call from one mobile to the other one.

For the test, select a connected mobile within the "B-Party" combo box. If the phone
number of the B-Party is known, the number is displayed in the "To Call" box automati-
cally.
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Figure 6-218: Content of the selected profile - mobile to mobile

Use different profiles for tests mobile to mobile.
The content of the "Profiles" combo box is updated automatically when switching
between LU and mobile. The B-Party mobile is set to Speech Quality (B) mode auto-
matically.
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Figure 6-219: B-party mobile

Measurement results for both mobiles are merged. The A- and B-party mobiles report
their downlink speech quality results separately what can be interpreted as the uplink
result for the other one.

For the profiles editing, see "Voice call profile" on page 1675.

6.4.11.3  Measurement with smartphones

After having started the measurement, the smartphone tries to configure the Land Unit
via the configuration call (voice call). KPIs are not generated during the configuration
call.

If the configuration call is unsuccessful after five attempts, the measurement system
shows an alarm and stops the speech quality measurement.
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Figure 6-220: Configuration call failed five times

All other measurements continue.

If the configuration call was successful, the actual speech quality measurement starts.
The smartphone starts the call and measurements as specified in the job file. The pro-
gress of the test can be observed in the "SQA Message View".

If the UE does not support speech quality measurements, the measurement stops and
the user is informed, see the following figure.

Figure 6-221: Probable cause for the speech quality test failure
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6.4.11.4  Visualization of measurement results

The results of speech quality measurement made with smartphones are visualized in
several views.

The results of measurements with smartphones are show in the following views:
● Chapter 4.4.14, "ETSI QoS view", on page 949
● Chapter 4.6.1.1, "SQA message view", on page 1060
● Chapter 4.6.3, "QoS KPI export result view", on page 1093
● Chapter 4.6.4, "QoS KPI generator view", on page 1095

6.4.11.5  Side effects of SQ measurement

Miscellaneous

The smartphone test writes a log file for every measurement session into the log file
directory (which is located under MyROMES).

R&S ROMES4 cleans up this directory at each startup by default. It deletes all files
which are older than 14 days.

This value can be changed with the registry entry
Romes4.xx/General/MaxAgeOfLogFilesInDays.

The automatic cleaning of the log file directory can be switched off in "Preferences" >
"General", see Figure 3-111.

Test user equipment

The "Autodialing" page is redesigned for the smartphone speech quality measure-
ments. Also all other 3GPP, 3GPP2 and TETRA UEs benefit from this layout.

Figure 6-222: Redesigned Autodialing page
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6.4.11.6  R&S ROMES4 signals for speech quality measurement with smartphone

Several R&S ROMES4 signals are generated by the smartphone speech quality mea-
surement. The signals are located in the "Signal Tree" > "SQA Tester" branch.

"QP Speech Quality Results (DL/UL)" contains the most important signals for the
speech quality test, described in the following table.
Table 6-15: QP Speech Quality Results branch signals

Signal Description

MOS The mean opinion square as a result of the speech quality algorithm

Offset Start offset from the beginning of the file to first speech activity

Type Type of used algorithm: SQuad08, PESQ, POLQA, SQuad08 (wideband) or
POLQA (wideband)

Sequence Sequence number of the voice call

Test Test number of a speech sample within the sequence

The branch "QP Speech Quality Details" offers more detailed results of the test, which
can help to analyze the reasons of degraded speech samples.
Table 6-16: QP Speech Quality Details branch signals

Signal Description

Application The application used for the speech quality test

Quality Code The quality code explains the reason, why the recorded speech sample was
marked as degraded

MOS-LQO NB MOS-LQO value obtained by SQuad-LQ in narrowband (remains NIL in WB);
only valid for applications 0 and 100

MOS-LQO WB MOS-LQO value obtained by SQuad-LQ in wideband; only valid for application 2

MOS POLQA NB POLQA MOS NB P.863; only valid for application 10 and 110

MOS POLQA WB POLQA MOS NB P.863; only valid for application 12

Signal Length Length of speech in seconds

Bits/Sample Number of bits per sample

Sampling Frequency Sampling frequency of the speech files

Missed Voice Percentage of missed voice compared to reference signal

Gain Gain of the transmission channel (to be in the range of +6 dB to -12 dB)
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Signal Description

Active Speech Level Active speech level acc. to ITU-T P.56 in dB, considers only active speech parts
but no speech pauses

Speech Activity Speech activity acc. to ITU-T P.56 in percentage

Noise Level Noise level (r.m.s. of the noise floor) in dB

SNR Signal-to-Noise ratio between active speech level and noise level

Delay Delay between the reference speech signal and the signal evaluated in seconds

Delay Spread Maximal spread of observed delay jitter in milliseconds

Delay Deviation Delay deviation of observed delay jitter in milliseconds

Bandwidth Actual measured bandwidth

For details about ranges and units of the signals, refer to the "Description of R&S
ROMES4 Signals" document.

6.4.12  Speech quality analysis

The objective of the speech quality analysis (SQA) is to assess the subjective quality of
speech codecs operating in a real network. The SQA process is divided in two steps.
The first step is to make the measurements. The second step is to evaluate the collec-
ted measurements and calculate the KPIs from them.

The SQA is carried out as a cyclic end-to-end measurement in downlink and/or uplink
direction. The test mobile to test mobile Speech Quality measurements work without
configured call. A configured call has to be performed only for measurements test
mobile to Land Unit.

In outgoing wave mode, the remote test mobile plays sound files to a calling device.

In incoming wave mode the remote test mobile measures speech quality of sound
coming from a calling device.

6.4.12.1  SQA – principle and test setup

● Downlink
In downlink mode, a remote test mobile 2 plays a known *.wav file. The output of
the test mobile 1 speech decoder is digitalized using a sound card and the
acquired sample file is compared to a copy of the original played file (reference
file). R&S ROMES4 assesses the quality of the mobile’s speech decoder using the
PESQ algorithm.

● Uplink
In uplink mode, a file is played on a sound card. The analog output of the sound
card is fed to the test mobile 1 speech coder. The speech coder data is transferred
to a remote test mobile 2 where it can be compared to a copy of the original play
file.

● PESQ algorithm
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The PESQ (Perceptual Evaluation of Speech Quality) algorithm compares an origi-
nal *.wav file with a degraded *.wav’ file that is obtained by passing the original
file through a communication system. The result of the comparison is translated
into a PESQ score in the range between –0.5 and +4.5 (+1 to approx. +4.55 after
conversion), where low values indicate poor speech quality and high values indi-
cate good quality. See also the description of the "SQA Message View" in Chap-
ter 4.6.1.1, "SQA message view", on page 1060.
The PESQ model is built aiming to ensure that the objective PESQ score is closely
correlated to subjective scores of the speech quality acquired in listening tests with
real subjects. For a description of the PESQ method, its use and its limitations refer
to the ITU-T recommendation P.862.

● Preconditions
The SQA requires option R&S ROMES4SQA, "Voice Quality Test PESQ". A *.wav
test file must be stored both on the local PC (reference file, play file) and on the
remote device. The test mobile must be equipped with an appropriate connector so
that its audio circuit can be fed to the analog input/output of a sound card. The
basic test setup is shown below.

A sound card without specific requirements is necessary to perform SQA, otherwise a
failure message is created.

Figure 6-223: Basic SQA Test Setup

6.4.12.2  SQA settings

The "SQA" dialog lets you select the measurement mode ("Downlink" test, "Uplink" test
or combined, simultaneous "Up- and Downlink") and specify the global settings.

SQA results can be displayed in the "SQA Message View", refer to Chapter 4.6.1.1,
"SQA message view", on page 1060. The results can be obtained as described in the
section concerning a device configuration.
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Figure 6-224: SQA Settings

The "SQA Settings" tab contains the following panes:
● "Playback File"

Parameters in this panel are relevant for uplink signal direction. It is available after
selecting the corresponding measurement mode.

● "Reference File"
Parameters in this panel are relevant for downlink signal direction. It is available
after the corresponding measurement mode has been selected.

● "Measurement Mode"
Selects the signal direction and global test parameters.

● "Configuration B-Party"
Enables to configure the other, B-party SQA settings automatically from the config-
uration dialog of the current party.
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The functionality is useful when two or more Speech Quality Analyzers (SQA) are
configured and SQA measurement are performed in mobile to mobile mode on one
PC.

SQA settings dialog

Playback File
The "Playback File" pane lets you set the uplink SQA test. The parameters determine
how often and how long the sound card will play the test file.
The uplink test consists of a repeated conversion of a test file located on the local PC
to an analog speech signal and the transmission of this signal to a remote test mobile 2
using the test mobile speech coder, see chapter Chapter 6.4.12.3, "Configuration –
speech quality", on page 1689.
● "Soundcard"

Selection of a sound card used to play the local test file and convert it into an ana-
log signal.

Figure 6-225: Steinberg‘s ASIO trademark statement

● "Filename"
Name and location of a played test file.

● "Play complete file"
If checked, the complete file will be played.

● "Offset [ms]"
Delay from the beginning of the loop (beginning of the play file) until the sound card
starts playing the file. During the offset time, the sound card plays silence. In con-
trast to the "Initial Pause", offset is used once at the beginning of each loop.

● "Duration [ms]"
Duration of the played section of the file. If "Play all the file" is selected, "Duration"
is unavailable and shows the time needed to play the entire file.

● "Initial Pause [ms]"
Pause time before each test loop, i.e. before each single transmission of the test
file. During the pause the sound card plays silence.

● "End Pause [ms]"
Pause time after each test loop, i.e. after each single transmission of the test file.
During the pause the sound card plays silence.

● "Loop as much as possible"
It was observed, that group calls were held by the network much longer after the
call is released by the initiating party.
To avoid this problem the "Loop as much as possible" check box is used. You can
manually choose how many loops to expect at the receiving end. By setting this
value accordingly, the number of PESQ evaluations per call can be kept fixed, even
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if the call is released with large delay. It is recommended to use this setting when-
ever possible. To use the function, unselect the “"Loop as much as possible" check
box, see "Correction of low PESQ values" on page 1068.

● "Loops"
Number of test loops to be entered manually.
The configured measurement time must be smaller or equal than the "Call Dura-
tion" defined in the "Autodialing" tab of the device configuration menu.

● "WB AMR"
If checked also Wideband Adaptive Multi Rate (WB AMR) can be used.
Note: Use only voice samples with a sample rate of 16 kbit/s.
Limits: The mobile and network have to support WB AMR. For this reason up to
now only mobile-to-mobile tests are supported.

The entire call is periodically repeated if autodialing is enabled.

Reference File
Sets the "Downlink" SQA test. The downlink test consists of a repeated transmission of
a test file from a remote test device 2 to the local PC using the test mobile speech
decoder and a subsequent conversion of the analog speech signal to a digital sample
file.
The parameters are analogous to the uplink parameters in the "Playback File" section.
If parallel SQA tests are performed with different test mobiles, each test mobile must
be configured with its own copy of the reference file.

Measurement mode
Selects the measurement mode ("Downlink" test, "Uplink" test or combined, simultane-
ous "Both (Up- and Downlink)", see Chapter 6.4.12.1, "SQA – principle and test setup",
on page 1683) and specifies the following global settings:
● "Output Volume"

Volume at the analog output of the sound card (minimum value to maximum value).
The output volume is relevant for uplink tests where it controls the input level at the
mobile’s audio input.

● "Call Duration"
This is a call duration defined in the "Autodialing" tab of the mobile device's config-
uration menu.

● "Store audio with MOS value worse than"
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If selected, voice samples below the specified PESQ score are saved in the
*.rscmd measurement file. To save all voice samples enter the highest PESQ
value (5). Generally only *.wav files from downlink test could be stored in the
*.rscmd measurement file.
If a voice sample was stored in the "*.rscmd" file, the line with the measurement
value is marked blue in the chapter Chapter 4.6.1.1, "SQA message view",
on page 1060.

● "Mobile"
A test mobile type is displayed for information.

● "Temp. Output Dir."
Define a directory to store the *.wav files temporarily so that the files could be
stored in a *.rscmd measurement file later on.

To avoid miss-configurations and improve overall usability, the SQA function performs
a smart check of the parameters configuration in the "SQA" dialog while the user is
entering. The pauses, the duration, the loops and every other input is adapted auto-
matically in order to avoid configuiration that would lead to bad measurements.
"Mapping of PESC score and ITU P.800 values"
The PESC score according to ITU-T recommendation P.862 expresses the speech
quality on a scale between –0.5 and +4.5. The PESC score values can be mapped to
the ITU P800 scale of the table above; an appropriate conversion formula has been
standardized by the ITU in P.862.1. The conversion formula maps the PESQ score val-
ues to a range between approx. +1 and +4.55. R&S ROMES4 displays the converted
values as PESQ P862.1 results.

Figure 6-226: Mapping of PESC score (P862) and ITU P.800 values according to ITTU P862.1
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Figure 6-227: ITU P.800 PESQ scale

6.4.12.3  Configuration – speech quality

The "Speech Quality" tab enables and configures the speech quality analysis. You
need the R&S ROMES4SQA option ("Voice Quality PESQ"). The SQA results are dis-
played in the "SQA Message View", see Chapter 4.6.1.1, "SQA message view",
on page 1060.

The "Speech Quality" tab is provided for many mobile types and technologies (GSM,
GPRS, UMTS, cdmaOne/IS-95, CDMA2000, TETRA, LTE) and is identical for all of
them.

The purpose of the SQA is to test the quality of the speech codec while the mobile
operates in the network.

1. Establish the basic test setup according to Figure 6-223, ensuring that the test
mobiles and the local PC contain copies of the same *.wav file.

2. Load the appropriate mobile device , e.g. the GSM mobile device, as described in
Chapter 6.1, "Devices", on page 1447.

3. In the "Autodialing" tab of the mobile device's configuration menu, select "Use
Autodial" and set an appropriate "Call Duration".

4. Open the "Speech Quality" tab, click "Connect SQA,", load the SQA slave device.

5. Click "Configure SQA" and select the measurement mode and the appropriate con-
figuration settings.

6. Back in the "Speech Quality" tab, select "Enable Speech Quality" and click "OK".

7. Open the "SQA Message" view ("View" > "QoS Views" > "SQA Messages View")
and observe the displayed results.
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Figure 6-228: Device configuration – speech quality analysis

The SQA involves the following steps:
● "Enable Slave Driver"

Enables the SQA slave, causing R&S ROMES4 to initiate the data transfer and the
analysis as soon as the test mobile has set up a call. It is recommended to use the
autodial feature, see "Autodialing" on page 1536 in order to repeat a call of fixed
duration in periodic time intervals.

● "Connect SQA"
Loads the SQA tester. The device has to be selected in the dialog box shown in the
following figure.
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After loading the tester, R&S ROMES4 displays its name and parameters in the
settings table of the "Speech Quality" tab. The parameters can be changed using
the configuration menu. The "Disconnect SQA" and "Configure SQA" buttons are
available as soon as a device has been loaded. Only one SQA can be active at
one time.

● "Disconnect SQA"
Releases/disconnects the loaded SQA.

● "Configure SQA"
Opens the configuration menu for the loaded SQA. The SQA configuration menu
provides all settings for downlink or uplink SQA tests and displays information
about the mobile device version.
Tip:
The SQA configuration menu is also accessible over the "Hardware" menu of the
toolbar. If the SQA is loaded, it is appended as a slave tester to the "Hardware"
menu.

6.4.12.4  Templates SQA

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.
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Figure 6-229: SQA tester configuration - Templates

6.4.13  Support of voice over WiFi

R&S ROMES4 supports Voice calls over WiFi (VoWiFi). The prerequisite is configura-
tion in the Fully integrated device usage mode or a Qualcomm chipset based device
with the Qualcomm IMS stack configured as On PC testing (Classic mode) device.

The following licenses and preconditions are necessary.
Table 6-17: Licenses and preconditions needed to support VoWiFi

 Fully integrated device On PC testing (Classic
mode)/ADB

WLAN license Necessary Necessary (R&S ROMES4WF2)

SMP license Necessary -

VoWiFi license - Necessary (R&S ROMES4WF2)

If the license is not present, all
VoWiFi calls are blocked by active
R&S ROMES4.

VoWiFi license (IMS) Necessary Necessary (R&S ROMES4VO)

QC IMS stack Supported Supported

Other IMS stack Supported Not Supported

Qualcomm Chipset Supported Not Supported

Test devices



Hardware ComponentsDrive Test Software

1694Operating Manual 1171.6415.12 ─ 66

 Fully integrated device On PC testing (Classic
mode)/ADB

Exyinos Chipset Supported Not Supported

POLQA Measurements Supported Not Supported

SwissQual Flash Yes No

(Diag and ADB port have to be
available)

Tested with Samsung S6 Sony XZ

If the WLAN and VoWiFi licenses are available, a mobile device which supports ADB
also reports the WiFi scan and connection status.

A mobile phone, the SIM card and the network have to support a VoWiFi call.

6.4.13.1  VoWiFi views

The call mode is VoWiFi and can be found in the corresponding R&S ROMES4 Views.

Figure 6-230: ETSI QoS View of VoWiFi

The figure shows the state of the VoWiFi call of a mobile device configured in fully inte-
grated use mode.

6.4.13.2  ADB WLAN scan

If a Qualcomm chipset based mobile device is connected in On PC testing (Classic
mode) usage mode, R&S ROMES4 does the basic WLAN scan using ADB.

Take care to fulfill the following conditions:
● WLAN option available
● VoWiFi option available
● ADB interface available
● Mobile device operates in On PC testing (Classic mode)
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Figure 6-231: Device setting with ADB interface

6.4.14  5G NR scanner

R&S ROMES4 includes the driver to load a network scanner as 5G NR scanner.

The R&S ROMES4 5G NR scanner driver requires the R&S TSME6 or R&S TSME6B
network scanner. The 5G NR measurements can run on both network scanner types..
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Figure 6-232: Driver selection for 5G NR

The R&S TSME6/TSME6B devices can run as the 5G NR scanners if loaded with the
R&S ROMES4 5G NR scanner driver.

Click the "Hardware" > "Connect/Disconnect" menu entry. The "Hardware Configura-
tion" page pops-up.

To load R&S ROMES4 5G NR scanner driver into R&S TSME6 device, double_click
the "Network Scanner TSME" > "TSME 5G NR Scanner" branch in the "Hardware Con-
figuration" > "Available Devices" pane. Specify the serial number, IP address and the
bands for measurement for the loaded device in "R&S 5G NR Scanner(<variable>):
Select Device". Click the "Connect" button to confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The device is loaded and visible in the "Loaded Devices" pane of the page.

It is now added as the "R&S 5G NR Scanner [<variable>]" command line to the "Hard-
ware" menu.

Once loaded the driver, you can start a measurement, Click the "R&S 5G NR Scanner
[<variable>]" command line to open the 5G NR scanner main configuration page.

Installation of the driver is explained in Chapter 6.1, "Devices", on page 1447.

The 5G NR scanner device configuration is explained in the following.
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The outcome of the measurement is data for the configured channels. For the mea-
sured and evaluated data, see Chapter 4.8.2, "5G NR scanner views", on page 1126.

While measuring 5G NR with the R&S TSME6 scanner, other RAT measurements
must not run on it.

The 5G NR scanner driver supports multiple frontends of a synchronized TSME/A6
array. For the configuration of multiple frontends, see Chapter 6.4.2, "Downconverters
supported by R&S ROMES4 scanners", on page 1517.

Figure 6-233: Support of multiple frontends

6.4.14.1  5G NR scanner configuration

The "R&S 5G NR Scanner" configuration page is similar to the other scanners configu-
ration pages.

The configuration lets you select a specific frontend for a channel. All frontends which
are synchronized to the selected R&S TSME6 devices can be used.

By setting the frequency of a channel (SS-Ref), the appropriate frontend is selected
automatically. If more than one frontend is possible, the first usable frontend is used.

If the frequency is valid but SSB NR-ARFCN has non-standard SSB NR-ARFCN step,
the SSB NR-ARFCN column is displayed with ‘*’ instead of “---“ at the end in scanner
configuration dialog. The same symbol appears in the related helper dialog. The mes-
sage displayed in this case in Tooltip or top section of the helper dialogs is

“* at end of NR-ARFCN: the NR-ARFCN has non-standard step."

The case is displayed in the following figures within the frequency helper dialog and
Tooltip.
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Figure 6-234: SSB NR-ARFCN step is non-standard

Figure 6-235: Show "*" in the SSB NR-ARFCN column

If a frequency is invalid or unsupported by scanner, a “---” is displayed for SSB NR-
ARFCN. This display of the frequency could happen in export mode and if a frequency
is directly entered. The figure shows entered frequency 2112.053 [MHz] which is an
unsupported frequency.

Figure 6-236: Show “---" in the SSB NR-ARFCN column

It is not possible to remove or add virtual channels. It is also not possible to select the
frontend for a virtual channel. Virtual channels are configured regarding the ACD con-
figuration automatically. Depending on the ACD configuration, virtual channels are
added or removed.
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Figure 6-237: 5G NR scanner configuration page

The time domain transmission pattern of SSB blocks in 5G NR is indicated as a "case".
3GPP specifies the cases A, B, C, D and E, each one determined by the subcarrier
spacing (numerology) and frequency rasters FR1 and FR2.

The Tooltip in the Figure 6-234 shows the case A with selected frequency band n1
which belongs to sub-3 band.

In accordance with 3GPP Rel 16.50, R&S ROMES4 supports the following 5G NR
bands of FR1 and FR2.

● FR1
Bands n34, n38, n39, n40 and n50 and the cases A and C; LAA bands n46 and
n96 and the C case.

Figure 6-238: Supported Bands and cases

● FR2
mmW band n259 and the cases D and E.

The channels of the mentioned bands can be configured by defining frequency, NR-
ARFCN or GSCN in the corresponding helper dialogs. A helper dialog opens when
clicking the "SS-Ref [MHz]", "SSB NR-ARFCN" or "GSCN" grid field of the "5G NR
Scanner Configuration" > "Channel" pane.

The examples of channel configuration using all three types of helper dialog are shown
in the following for bands n46, n96 and n259 in details.

Name
The name given to a channel.
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SS-Ref[MHz]
Click "SS-Ref[MHz]" to access the helper dialog which allows you to enter the fre-
quency. While entering the digits of the frequency, the combo box shows all valid set-
tings which are close to the given frequency. Select one of the possible values.
You can configure only one 5G NR channel with a click in a field of channel line.

Figure 6-239: 5G frequency helper

Click "Apply" to apply these settings to the configured channels.
● If the entered frequency matches an SS-Ref, the matched item is selected and dis-

played.
● If the entered frequency does not match any SS-Ref in the list, the value just below

the entered frequency is selected and displayed.
● If the entered frequency is below all possible SS-Ref, the first available item is

selected and displayed.

Band n46 - Frequency Selection ← SS-Ref[MHz]
Click the "SS-Ref[MHz]" grid field and insert a frequency. Select one out of offered SS-
Ref frequencies of band n46 (frequency range: 5150MHz to 5925MHz).

Figure 6-240: Band n46 configuration using frequency

Band n96 - Frequency Selection ← SS-Ref[MHz]
Click the "SS-Ref[MHz]" grid field and insert a frequency. Select one out of offered SS-
Ref frequencies of band n96 (frequency range: 5925MHz to 7125MHz).
Scanner supporting 7125MHz is needed for frequencies above 6000MHz, otherwise,
the maximum configurable frequency is 6000MHz.
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Figure 6-241: Band n96 configuration using frequency

Band n259 - Frequency Selection ← SS-Ref[MHz]
Click the "SS-Ref[MHz]" grid field and insert a frequency. Select one out of offered SS-
Ref frequencies of band n259 (frequency range: 39500MHz to 43500MHz).
Downconverter is needed to verify this band.

Figure 6-242: Band n259 configuration using frequency

SSB NR-ARFCN
Click "SSB NR-ARFCN" to access the helper dialog which allows you to enter SSB
NR-ARFCN and select one NR-ARFCN. While entering the digits of the channel num-
ber, the combo box shows all valid settings which are close to the given channel num-
ber. Select one of the possible values.
You can configure only one 5G NR channel with a click in a field of channel line.

Figure 6-243: 5G SSB NR-ARFCN helper

Click "Apply" to apply these settings to the configured channels.
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● If the entered channel number matches an SSB NR-ARFCN, the matched item is
selected and displayed.

● If the entered channel number does not match any SSB NR-ARFCN in the list, the
value just below the entered channel number is selected and displayed.

● If the entered channel number is below all possible SSB NR-ARFCN, the first avail-
able item is selected and displayed.

Band n34 - SSB NR-ARFCN Selection ← SSB NR-ARFCN
The screenshot shows a channel configuration belonging to band n34 by using SSB
NR-ARFCN helper dialog. If the proper SSB NR-ARFCN is configured, the helper
shows all relevant information concerning the channel.

Figure 6-244: Configuration of channel in band n34

Band n46 - SSB NR-ARFCN Selection ← SSB NR-ARFCN
Click the "SSB NR-ARFCN" grid field and insert the NR-ARFCN. Select one out of
offered NR-ARFCN values of band n46 (range: 743333 to 795000).

Figure 6-245: Band n46 configuration using SSB NR-ARFCN

Band n50- SSB NR-ARFCN Selection ← SSB NR-ARFCN
Example of a channel configuration belonging to band n50 by using SSB NR-ARFCN
helper dialog.
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Figure 6-246: Configuration of channel in band n50

Band n96 - SSB NR-ARFCN Selection ← SSB NR-ARFCN
Click the "SSB NR-ARFCN" grid field and insert the NR-ARFCN. Select one out of
offered NR-ARFCN values of band n96 (range: 795000 to 875000).

Figure 6-247: Band n96 configuration using SSB NR-ARFCN

Band n259 - SSB NR-ARFCN Selection ← SSB NR-ARFCN
Click the "SSB NR-ARFCN" grid field and insert the NR-ARFCN. Select one out of
offered NR-ARFCN values of band n259 (range: 2270832 to 2337499).

Figure 6-248: Band n259 configuration using SSB NR-ARFCN
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GSCN/Band/SSB Pattern
Click one of these entry columns to pop up the GSCN helper dialog. You can configure
the GSCN, band and SSB pattern value in the helper dialog. While entering the value,
the combo-box shows all valid settings which are close to the given one. The associ-
ated helper dialog checks the validity of a given value and offers the values of other
entries. Select one of those possibilities.
● If the entered GSCN/Band/SSB Pattern value matches a GSCN/Band/SSB Pattern

value in the list, the matched item is selected and displayed.
● If the entered GSCN/Band/SSB Pattern value does not match any GSCN/

Band/SSB Pattern value in the list, the one just below the entered GSCN is
selected and displayed.

● If the entered GSCN/Band/SSB Pattern value is below the all possible GSCN/
Band/SSB Pattern values, the first available item is selected and displayed.

Figure 6-249: 5G GSCN helper

SSB Periodicity
Lets you select the periodicity of the SSB used by the scanner.

BCCH-Demodulation
Click this entry to open the drop-down list letting you select/deselect SIB signals for
editing by BCCH demodulation. MIB in the list is always selected and is not editable.
The following SIBS can be demodulated and shown in BCCH view. The BCH view
shows also the positioning SIB (posSIB).
● SIB 1 - Cell selection, cell access, cell baring information and information about

availability and scheduling of another SIBs
● SIB 2 - Cell reselection, serving cell frequency and intra-freq cell reselection infor-

mation
● SIB 3 - NR Intra-frequency neighbor cell list and reselection criteria
● SIB 4 - NR Inter-frequency neighbor cell list and reselection criteria
● SIB 5 - EUTRA neighbor cell list and reselection criteria
● SIB 6 - ETWS notification
● SIB 7 - ETWS secondary notification
● SIB 8 - CMAS notification
● SIB 9 - GPS time and UTC (Coordinated Universal Time)
● SIB 10 - Human readable network names of non-public networks
● SIB 11 - information related to idle/inactive measurements
● SIB 12 - NR sidelink configuration
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● SIB9 13, SIB 14 - V2X sidelink configuration
● posSIB - Positioning
The BCH view shows also the positioning SIB (posSIB). The 3GPP rel.16 introduces
the following SIB fields which are all posSIB elements.
● posSib1-1, posSib1-2, ..., posSib1-8 - GNSS common assistance data
● posSib2-1, posSib2-2, ..., posSib2-23 - GNSS generic assistance data
● posSib3-1 - Observed TimeDiffOfArrival assistance data
● posSib4-1 - Barometric assistance data
● posSib5-1 -TerrestrialBeaconSystem assistance data
● posSib6-1, posSib6-2, posSib6-3 - NR DL TDOA/DL-AngleofDeparture assistance

data
R&S ROMES4 supports further, 3GPP rel. 17 defined SIBs, SIB 15 to SIB 21.
● SIB 15 - Carries configurations of disaster roaming information.
● SIB16 - Carries configurations of slice-specific cell reselection information.
● SIB 17 - Carries configurations of TRS resources for idle/inactive UEs.
● SIB18 - Carries Group IDs for Network selection (GINs) to support access using

credentials from a Credentials Holder or to enable UE onboarding. SIB18 can only
be present if there is at least one SNPN that supports previously mentioned access
or onboarding UE.

● SIB 19 - Carries satellite assistance information.
● SIB 20 - Carries the information required to acquire the MCCH configuration for

MBS broadcast.
● SIB 21 - Carries the mapping between frequency and MBS services.

Synchronization Rate
The 5G NR scanner offers two independent measurement rates.

SynchRate[Hz] ← Synchronization Rate
In the "SynchRate[Hz]" entry configure the max. sync-measurement rate for this chan-
nel. The rate indicates how quick the new gNBs can be detected and synchronized.

HSRate[Hz] ← Synchronization Rate
The high-speed measurement rate configured in the "HSRate[Hz]" entry indicates how
quick the SSB measurements would be performed once the scanner is synchronized
on a gNB.
The high-speed measurement rate can be set up to 50 [Hz], what equals the maximum
number of SSBs in a 5G NR signal with a periodicity of 20 [ms]. For the measurement
based on high speed, refer to Chapter 6.4.14.5, "5G NR high-speed scanner",
on page 1714.

FE
Shows the appropriate frontend for the set channel frequency.

Advanced
Click the "Advanced" column to open the advanced settings dialog of the selected
channel.
The "Custom" (default) mode checks if the frequency is valid (TS38.101) and if the
selected case applies for the selected band.
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Select "Open" to get the "Advanced channel settings" dialog.
The dialog has two tabs:
● "Dynamic PDU Settings"
● "Advanced Options"

Dynamic PDU Settings ← Advanced
The dynamic PDU setting is available for supported SIBs, which are SIB1 to SIB 21
and posSIB. MIB is not editable.
Check the associated check box of a SIB that you want to monitor in the "Dynamic"
column of the "Dynamic PDU Settings" page. Enter an interval value or use the default
one. The selected SIB is shown in the "5G NR BCCH View".

Figure 6-250: Dynamic PDU settings dialog

At the lower part of the "Dynamic PDU Settings" dialog, there are the "Demodulation
Mode" and "Frontends" panes.
The "Demodulation Mode" lets you select demodulation mode out of two available.
● "Cell: Strongest beam in a cell"

Demodulation is done at cell level for the strongest beam in the cell. The mode is
the most efficient mode.

● "Beam: All beams"
Demodulation is done for all beams in the cell. The mode can be only activated in
special SIB configurations, where SIB messages per beam are different.

The mode change applies to MIB and SIB1. Demodulation modes can be specified for
MIB or SIB1 and then the same mode applies to both and the specified mode applies
only to a current channel. Different channels can have different modes.
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Other SIBs (OSI), that is SIB2 to SIB9, always use the cell mode. The beam mode
does not apply to them.
The demodulation mode can be changed by clicking the associated radio button. The
mode change does not affect other SIBs, as the cell mode only applies to them.
The R&S ROMES4 5G NR Scanner's demodulator supports multiple R&S TSMEs.
This kind of support increases the performance, especially for FR2 measurements. By
default, the demodulator takes all R&S TSMEs connected to the same downconverter
as the scanner’s TSME and supports the required frequency range. It is possible to
choose the R&S TSMEs, which have to be used for demodulation.
To select the used R&S TSMEs manually, check the "Frontends" box.

TDD pattern decoding ← Dynamic PDU Settings ← Advanced
The TDD pattern is broadcasted in SIB1 of gNodeBs. As the content of SIB1 is not
self-explaining, R&S ROMES4 brings it to a more human readable form.
R&S ROMES4 shows the pattern as a sequence of three different characters for a
duration of 20 ms. Each character represents a 5G TDD slot.
The 5G TDD slots within a frame are marked using the following letters:
- D: downlink slot
- U: uplink slot
- F: flexible slot (some symbols are used for downlink, some for uplink)
The representation considers the pattern1 and pattern 2. The resulting text is visual-
ized in the "5G BCH View" and as gNodeB and TopN template signals.

Example: 
Carrier bandwidth: 78.120 MHz
BWP bandwidth: 78.120 MHz
BWP center frequency: 3450.00 MHz
TDD configuration; DDDFUDDDFUDDDFUDDDFU
(N)SA support: SA Supported

System Information ← Dynamic PDU Settings ← Advanced
The demodulation mode is shown at the bottom part of the measurement's "Open" dia-
log.
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Figure 6-251: Open dialog shows data of demo channel

The information on demodulation mode is shown for a demodulation channel in this
dialog.
Channel Info:
5G Band Version:  TS 38.101.Ver16.5.0

Count of all measured channels: 1 

Selected channel starting with the following parameter
Channel Name:  5G NR Channel 1

contains a long list of reported parameter values.
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Advanced Options ← Advanced
"Advanced channel settings" > "Advanced Options" provides the possibility to switch to
an “expert input mode”. In this mode, you can select any frequency and a combination
of frequencies in bands below or above 3GHz (FR1). The channel validation is not
available in expert input mode. Band and GSCN do not apply in this mode.
To activate the mode, check the "Expert Input Mode" box. In expert mode you can set
the Lmax threshold, which indicates the maximum number of beams per PCI. The pos-
sible number of beams is 4 or 8 dependent on frequency bands. By default, the "Expert
Input Mode" is inactive and the default mode is "Auto", meaning that the selection of
Lmax value is disabled and the Lmax="Auto".
For optimized scanner measurement with signal generator, select the count of gener-
ate frames value in the "Generator Frame Count" drop box.

Figure 6-252: 5G NR scanner configuration - advanced options

The manual configuration of bands requires the SSB case A, B or C and active expert
mode. Select the requested SSB cases in the "R&S 5G NR Scanner" > "SSB Pattern"
column, see Figure 6-237.
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Figure 6-253: Expert input mode activated

The configured channel information is saved in a measurement file and displayed if
you click the file.

Time Gated Spectrum Measurement ← Advanced Options ← Advanced
R&S ROMES4 offers in the "Advanced Options" page the possibility to configure a time
gated spectrum measurement with the 5G NR scanner. The time gated spectrum mea-
surement provides the necessary timing information to the time gated spectrum scan-
ner.
Check the "Enable" check box in the "Time Gated Spectrum Measurement" pane to
enable the time gated spectrum measurement. Define the default timing values.
The pattern1 and 2 for 5G TDD configuration are supported. You can enter the two pat-
terns either manually or configure the software to use the SIB1’s content. The value in
the "Periodicity" grid is found in the SIB1 directly and makes the configuration simple.
To set up a measurement, specify only one 5G NR channel in the "Channel Configura-
tion" page. The time gated spectrum scanner does not start if you specify more than
one channel or a virtual channel.
If the "Overwrite by SIB1..." option is selected, the time gated spectrum scanner is
reconfigured by the 5G NR TDD configuration which is found in the SIB1 on the chan-
nel.
If no SIB1 is available, the time gated spectrum measurement needs to be configured
manually. The settings in the "Time Gated Spectrum Measurement" pane need to
reflect the settings of the used NR TDD signal:
● "Extended Cyclic Prefix"

Enable this option, if extended CP is used in the NR TDD signal scanning.
● "Selections" to scan

Select among "Uplink", "Downlink" and "Guard Period" for scanning.
● Settings provided by SIB1

– UL/DL TDD configuration
– "Timing Advance"
– "Gate Count"

Count of time gates.
When the 5G NR scanner detects a gNodeB, the time gated spectrum scanner starts.
The results can be observed in the "Basic Views" > "Time Gated Spectrum View".
Note: Create a workspace after configuring the "Time Gated Spectrum Measurement"
parameters.
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Note: The R&S Option TSMx-K51 is required on the scanner device.

Measurement Mode ← Advanced Options ← Advanced
The "Advanced Options" > "Measurement Mode" pane offers you to select the most
suitable option for the measurement dependent on use case.

Add
Opens the dialog which allows you to add a channel for scanning. Virtual channels
cannot be added.

Remove
Removes all highlighted channels from the "Channels" pane. Virtual channel cannot be
removed.

Clone
Makes a copy of all highlighted channels, automatically sets the “selected” status for it
and assigns name by adding the word “copy” to the original channel name.

6.4.14.2  5G NR automatic channel detection

5G NR Automatic Channel Detection function allows an easy setup of the 5G NR scan-
ner. It is not necessary to know the exact frequency on which the SSBs are broadcas-
ted. Instead of specifying the frequency, it is enough to specify a range or the 5G NR
band in which SSB is located.

The 5G scanner ACD allows for more than the standard cases to scan. To scan for
more, open the "Automatic Channel Detection" dialog in the 5G scanner configuration.
By default, the ACD only searches for the standard cases as defined in TS38.101.

If desired, the ACD can be configured to scan for all possible cases of the band’s fre-
quency range (FR1 or FR2). For all bands less than n256, the ACD searches for the
cases A, B, C and for all bands above, it searches for cases D and E.

Figure 6-254: 5G NR ACD (Auto start of scan case)

Test devices



Hardware ComponentsDrive Test Software

1712Operating Manual 1171.6415.12 ─ 66

For the selected band in the figure, the "scannACD Status View" shows "5G NR:
n1(case: A,B,C)" as the currently active case.

If necessary, scanning for all five cases is possible. Note that scanning for more cases
increases the required CPU processing time for the ACD.

The most comfortable way to set up the 5G NR ACD in R&S ROMES4 is to use the
ACD wizard.

1. Click "Hardware" > "Wizard" > "Automatic Channel Detection" in the R&S ROMES4
main page.

2. Select the "TEC for 5G NR Scanner" and press "Next".

Figure 6-255: ACD wizard

3. The wizard leads you through the next steps, where you have to specify the band
on which the algorithm looks for SSBs. It allows you all bands which are possible
on the selected synchronized R&S TSME6 array to select.

The band is associated with the frontends automatically. They can be adjusted in
the "5G NR Scanner" configuration page in a second step, if necessary.

The wizard assumes a periodicity of 20 ms for 5G NR scanner.

The ACD wizard supports the Band Slicing feature. How to configure band slicing with
ACD wizard, see Chapter 3.4.2.1, "Automatic channel detection wizard", on page 192.
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The configuration of the 5G NR consists basically of the periodicity and the bands. The
5G ACD finds only SSBs with the given periodicity on the given bands. Once the ACD
has found an SSB, a channel scan is set up automatically to follow the 5G NR carrier.

The ACD wizard sets-up the scanner configuration automatically. If necessary, setting
up the ACD wizard could be done manually.

The RF Power Scan is not required for the 5G NR ACD.
Position Estimation is not yet available for 5G NR.

6.4.14.3  5G NR MIB demodulation

The 5G NR scanner can demodulate the MIB of the 5G NR beam. The demodulated
values can be displayed as R&S ROMES4 signals.

Figure 6-256: Some 5G NR signals

The shown signals are optional ones. Enable these optional signals in the configuration
of the 5G NR technology module.

6.4.14.4  Advanced configuration - BCH demodulator

Click the "R&S 5G NR Scanner" > "Advanced" button at the right bottom of the scanner
configuration page to launch the "Advanced Configuration" page.

Specify the minimum SINR of the 5G NR signals that you want to debe modulated in
"Advanced Configuration" > "BCH Demodulator" > "Thresholds" pane.
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Figure 6-257: 5G NR scanner - BCH demodulator setting

The SINR threshold of 5G NR signals to be demodulated is configurable. The former
default value was -5 dB.

6.4.14.5  5G NR high-speed scanner

The 5G NR scanner is able to deliver up to 50 measurements per seconds (single
channel). It measures on single synchronization block, which means 50 measurements
per seconds at a synchronization block periodicity of 20 ms.

The 5G NR scanner offers two independent measurement rates. The sync-measure-
ment rate is a measure for discovering new cells and synchronizing on them. The high-
speed measurement rate, however, is a measure for the effective measurement rate
(independent measurement points, for example, on the map or in the 2D chart).

The high-speed measurement rate can be set up to 50 Hz in "HSRate[Hz]", what
equals the maximum number of SSBs in a 5G NR signal with a periodicity of 20ms.
The default setting is:

- Sync scanner rate: 1Hz

- High-speed scanner rate: 50 Hz

This setting is the best trade-off between discovering new cells on time and achieving
the highest update rate for the RF measurements.
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Figure 6-258: High-speed scanner setting

The scanner delivers measurement data up to every 200 [ms]. This data contains an
average and the high-speed data that this average is based on, if available.

The following R&S ROMES4 signals support high-speed data:

- TopN xx-RSRP

- TopN xx-RSRQ

- TopN xx-SINR

- TopN xx RePower

- gNode B Template xx-RSRP

- gNode B Template xx-RSRQ

- gNode B Template xx-SINR

- gNode B Template xx RePower

The following R&S ROMES4 modules can handle the high-speed data:

- 2D Chart View

- Map (allows high-speed data optionally to use). By default is active, but can be deac-
tivated for huge amount of data.

- ASCII Export

- Scanner Raw Export

- KML Export (in this case, consider the huge amount of data)
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Figure 6-259: HS data shown in 2D chart view

All other R&S ROMES4 modules show the average data.

6.4.14.6  Dynamic loading of 5G band tables by using XML files

The 5G band tables for 5G NR are dynamically loaded using XML files and can be cus-
tomized. The benefit is possibility to replace or extend the band tables.

There are two XML files for customizing 5G NR band tables:

● UserBands.Sample.xml - sample file that shows sample entries and how to cus-
tomize band table.

● UserBands.xml - R&S ROMES4 loads this file at runtime. Entries in this file are
used to add or update current LTE band tables. The actual band customizations
are done in this file.

The UserBands.Sample.xml file is installed during the R&S ROMES4 installation on
top of all user folders. The file is then copied to “My ROMES\Configuration” folder
when R&S ROMES4 fully starts for the first time. If the file exists already, it is not cop-
ied.

To customize a band table, copy or rename the UserBands.Sample.xml file to cre-
ate the UserBands.xml file.

Change the content of the UserBands.xml accordingly to customize bands. Updated
bands are loaded next time when R&S ROMES4 starts.

5G NR samples in UserBands.Sample.xml

Short descriptions for band table fields are provided in the UserBands.Sample.xml.

Using the sample entries in this file to customize the band table.

- If the defined bands already exist in band table, the defined bands overwrite existing
entries.

- If the defined bands do not exist in band table, new band entries are added.

- If the same band number is specified more than once, only the last one takes effect.

- Removing UserBands.xml restores the original bands.

The 5G NR user bands include the following samples whose values are decimal num-
ber strings:
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1. Subband: 0 for user bands

2. Band: band to be defined, not included in 3GPP band spec range

3. Duplex: duplex mode, 0=FDD, 1=TDD, 2-SDL, 3=SUL, 4=Not Used

4. FULLOW: frequency uplink low

5. FULHI: frequency up link high

6. FDLLOW: frequency down link low

7. FDLHI: frequency down link high

8. Raster: frequency raster in kHz

9. ULLARFCN: uplink low ARFCN

10. Step: uplink step

11. ULHARFCN: uplink high ARFCN

12. DLLARFCN: downlink low ARFCN

13. Step2: downlink step

14. DLHARFCN: downlink high ARFCN

15. SCS1/SCS2: subcarrier spacing 1/2

16. Case1/Case2: 8-case A, 16-caae B, 32-case C, 64-case D, 128-case E

17. GSCN1F/GSCN2F: GSCN 1/2 First

18. GSCN2L/GSCN2L: GSCN 1/2 Last

19. Step3/4: step for GSCN 1/2

20. GeoFlag: 4294967295 for all geo locations

21. DuplexSpacing: duplex spacing for FDD can be negative. 0 for others

Sample usage to redefine band

For example, use band 5 to redefine band 1.

The following lines stand for band 5.

<Index Subband="0"
      Band="5" Duplex="0" FULLOW="8240" FULHI="8490"
      FDLLOW="8690" FDLHI="8940" Raster="100"
      ULLARFCN="164800" STEP="20" ULHARFCN="169800"
      DLLARFCN="173800" STEP="20"DLHARFCN="178800"
      SCS1="15" Case1="8" GSCN1F="2177" STEP3="1" GSCN1L="2230"
      SCS2="30" Case2="16" GSCN2F="2183" STEP4="1" GSCN2L="2224"
      GeoFlag="4294967295" DuplexSpacing="450" />

Changing now band 5 to band 1, both bands are listed when entering frequency of
band 5, for example, 869.000 MHz. The two definitions are the same except the band
number.
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<Index Subband="0"
      Band="1" Duplex="0" FULLOW="8240" FULHI="8490"
      FDLLOW="8690" FDLHI="8940" Raster="100"
      ULLARFCN="164800" STEP="20" ULHARFCN="169800"
      DLLARFCN="173800" STEP="20"DLHARFCN="178800"
      SCS1="15" Case1="8" GSCN1F="2177" STEP3="1" GSCN1L="2230"
      SCS2="30" Case2="16" GSCN2F="2183" STEP4="1" GSCN2L="2224"
      GeoFlag="4294967295" DuplexSpacing="450" />

Click the column "SS-Ref(MHz") in the "R&S 5G NR Scanner (TSME)" dialog. The"5G
Frequency Helper" dialog displays.

Figure 6-260: Entering wanted frequency value

Enter frequency value 869.0, clicking the dropdown arrow. The following entries are
displayed along with others:

Both n1 and n5 are listed meaning that band 1 has been overwritten.

3GPP bands are overwritten most of time. You can customize the non-3GPP bands.

The "Use User Bands" entry at the bottom of the "R&S 5G NR Scanner (TSME)" >
"Open" measurement dialog indicates whether "UserBands.xml" is used at the time
when the measurement was created.

This entry is only available for 5G NR measurement files created with the latest R&S
ROMES4 version.
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Figure 6-261: Entries in the Open measurement dialog

As new bands can be added to the band table by 3GPP specification in the future, cus-
tomize bands carefully. Your customized band can conflict with 3GPP bands. In this
case, user bands are used.

Entries in scanner template use band index to reference bands. User bands cannot be
always available if the template was created by others and user bands were used.

6.4.14.7  Time of arrival measurement

The Time of Arrival (TOA) measurements are essential for measuring the time syn-
chronization between different gNBs to avoid an overlap between uplink and downlink
timeslots. They are a measure for the time offset between the ultra-precise PPS pulse
(from GPS) and the time of arrival of the SSB sequences. Different TOAs either show a
bad synchronization or a higher distance between receiver and gNB.

Two Time of Arrival signals and two columns in the "5G Scanner TopN View" are avail-
able and let you compare the time of arrival of the signals of a gNodeB. The ToA (PPS)
is based on the GPS PPS pulse and is the preferable signal for usage.

As a fallback the signal ToA (CIR) offers a time of arrival calculation based on the devi-
ce’s internal timer (if GPs is not available).

The displayed time is normalized to the 5G NR 10 [ms] frame.
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Example: 

Figure 6-262: Example for TOA

6.4.14.8  TAE measurements

The 5G scanner can measure the Time Alignment Error (TAE). TAE is measured by
calculating the time of transmission of a 5G NR frame with a specific System Frame
Number (SFN) in UTC time.

As the TAE measurement dialog contains many expert parameters, expert's knowledge
is needed for timing measurements. For the less skilled users, R&S adds an option
that hides 5G NR TAE measurement expert parameters and emphasizes the important
ones and their values. Here is the screenshot of the option, the minimized "TAE Mea-
surement" dialog.

Figure 6-263: TEA measurement minimized dialog

The minimized dialog shows green or red for the precondition state and the average
offset and average relative frequency error of all measurements. The expert values can
be accessed by opening the dialog with the ">>>" button, see Figure 6-265.

The TAE measurement requires the R&S TSME6 option K51.
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The TAE measurements configuration allows you to select the GPS source and GPS
altitude source. By default, the system tries to find the best source within the set of
connected R&S TSMEs. But if for any reason the GPS is taken from a specific device,
you can select that device.

Figure 6-264: GPS source for TAE measurement

The following GPS altitude modes are available:
● "Current"

The system uses the current GPS altitude.
● "Last In Motion"

The most recent altitude measured with a speed more than 20 km/h is used for the
uBlox devices used to produce PPS information. Each uBlox has its own altitude.
Altitudes measured during motion are normally better than measured altitudes in
stationary case. This option can be used when the TAE location can be arrived in a
flat road using a vehicle faster than 20 km/h.

● "User Altitude [m]"/"Accuracy [m]"
You can enter the exact altitude and its accuracy.

During replay, the used values are reported as information of the TAE start event.

Preconditions

To perform the TAE measurement, set up a normal 5G measurement with fixed chan-
nels or ACD. Once the scanner has detected the beams, double-click a beam in the
"TopN View" to open the TAE measurement dialog. The dialog can be also opened if
you select the "Action Menu" > "TAE Measurement".

The TAE measurement must be triggered by the user, contrary to all other scanner
measurements which are done automatically.

The scanner performs TAE measurements only if the all following preconditions are ful-
filled.

● PPS is available
● PPS has the necessary accuracy
● UTC time sync is available
● R&S TSME must not detect movement with one of its internal GNSS devices
● CINR of the selected beam for TAE measurements is good enough
● Weighted TAE-specific delay spread is small enough for TAE measurements

The TAE measurement shows the precondition flags for the currently selected beam.
Also, the transmitter under the test has to be in line of sight (LOS). The following table
shows the parameters which you have to add to the measurement.
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Parameter Remark

LOS [m] Exact distance from the receivers’ antenna to the transmit antenna. The RF prop-
agation is subtracted for the assumption of propagation in normal air with speed
of light a little slower than in vacuum. (299710 m/s)

GPS cable length [m] The length of the GPS antenna cable. The time required by the wave is calcula-
ted as follows: Cable Length [m] / (299710 m/s * VF(GPS))

RF cable length [m] The length of the RF antenna cable. The time required by the wave is calculated
as follows: Cable Length [m] / (299710 m/s * VF(RF))

Velocity factors The velocity factor (VF) is the relation between the speed of light in vacuum and
in the cable.

As the GPS cable length, RF cable length and the velocity factors are system parame-
ters. They can be preset in the transducer table file. If the values are found in the trans-
ducer table, the dialog does not allow them to change anymore.

Example: 
<Frontend Identnumber="4900.0004K02" Serialnumber="101034" Active="true">
<CableLengthsInMeter GPS="5" RF="1" VFRF="0.66" VFGPS="0.66"></CableLength-
sInMeter> </Frontend>

Measurement

Once all parameters are set, the measurement can be started for the selected beams.
The results of the measurements are displayed directly in the dialog.
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Figure 6-265: TAE measurement expert dialog

Once the required accuracy is reached, you can stop the measurement and continue
to the next beam.

If you choose the "any beam" option, the measurement performs TAE measurements
for all beams of the selected PCI, which do fulfill the preconditions. Select a beam
whose measurement results you want to be displayed on the "TAE Measurement" dia-
log.

It is possible to continue with the same measurement to the next transmitter and start a
new TAE measurement. All result of the TAE measurements is stored in the measure-
ment file and can be analyzed in the "Replay" mode or exported to a *.csv file using
the ASCII export. For export of the TAE measurement results, see the section "Export
of 5G NR Scanner TAE Measurements Data" in Chapter 7.2.5.2, "Interactive export",
on page 2134.

The "Signal Tree" offers all relevant signals of the TAE measurements. For the signals,
see the "Description of R&S Romes Signals".

All signals are template signals. Thus, you have to specify the filter during activation of
the signal.
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Figure 6-266: Activation of TAE signal templates

Set the following filters:

● NR-ARFCN of the transmitter under test
● PCI of the transmitter under test (0...1007)
● SSB Index of the beam under test (0...64)
● Statistic Type ("Most recent","Last minute", "All")

Specific signals are created for the applied filters.

The results of the TAE measurements can be displayed in the "Alphanumeric View".

Figure 6-267: Alphanumeric view of TAE measurements

The two R&S ROMES4 events show when the measurement has started and stopped.
The "Info" column contains the setting details of the TAE measurement.

Figure 6-268: TAE events
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6.4.14.9  Geometry factor calculation

R&S ROMES4 does the Geometry Factor (GF) calculation for the current 5G TopN
Set.

Depending on the TopN configuration, the factor calculation depends on the selection
of beams/SSB or cells. The values can be displayed as R&S ROMES4 signals, or as
an additional column in the "5G Scanner TopN View".

The Geometry Factor is defined as the difference between the best cell/beam path
gain and the sum of the path gains all other neighbor cells/beams in the network.

The motivation for GF calculation is getting the cell isolation or the inter-cell interfer-
ence value which is an important characteristic of radio networks. It is a measure for
the dominance of a certain beam/SSB or cell.

The cell isolation together with a link performance limits the achievable user throughput
and the capacity for a 1-reuse link adaptive packet access systems, such as 5G.

Cell isolation is measured as geometry factors. For 5G NR, the measurement is based
on Cell SS-RSRP.

The following figure highlights the GF signal, but also the Time of Arrival signals is visi-
ble.

Figure 6-269: 5G NR scanner signals
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The Intra-GF value is available for beam-based TopNs only.

6.4.15  LTE scanner

The R&S ROMES4 LTE scanner driver controls the R&S TSME scanner device while
performing LTE measurements.

The needed hardware option is R&S TSME-K29. The options R&S TSME-K30 and
R&S TSME-K32 are needed for MIMO and eMBMS measurements, respectively. The
driver is available with the R&S ROMES4T1E option.

Installation of the driver is explained in Chapter 6.1, "Devices", on page 1447.

The LTE scanner device configuration is explained in the following.

For the LTE scanner measured and evaluated data, see Chapter 3.3.17.4, "LTE scan-
ner views", on page 184.

6.4.15.1  Loading LTE scanner

The R&S TSME devices can run as the LTE scanner devices if loaded with the R&S
ROMES4 LTE scanner driver.

Click the "Hardware" > "Connect/Disconnect" menu entry. The "Hardware Configura-
tion" page pops-up.

To load R&S ROMES4 LTE scanner driver into R&S TSME, double_click the "Network
Scanner TSME" > "TSME LTE" branch in the "Hardware Configuration" > "Available
Devices" pane, see Figure 6-40.

The device is loaded and visible in the "Loaded Devices" pane of the page. Specify the
serial number, IP address and the bands for measurement for the loaded device in
"R&S LTE Scanner(<variable>): Select Device". Click the "Connect" button to confirm
the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The device is now added as the "RS LTE Scanner [<variable>]" command line to the
"Hardware" menu.

Figure 6-270: Loaded R&S TSME as LTE scanner

Click the "RS LTE Scanner [<variable>]" line to open the LTE scanner main configura-
tion page.
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The dialogs of a device chooser open when the R&S TSME driver is loaded. The
device chooser dialog is used to select the test device and define the essential connec-
tion parameters, if necessary.

For details about the loader's dialog, see Chapter 6.1.11.1, "R&S TSME network scan-
ner", on page 1488.

The "R&S <variable>: Select Device" dialog is used to share the test device resources
between all loaded R&S TSME hardware drivers. Furthermore, over the dialog the IP
address of a device can be selected, if necessary.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.

The scanner needs at least one frontend (Rx unit). If more than one LTE channel has
to be measured, it is recommended to use two Rx units.

Note: Only the synchronized R&S TSMEs can be used simultaneously as the LTE
scanners when loaded into one R&S ROMES4 LTE scanner driver. Thus, it is possible
to set up the R&S ROMES4 LTE scanner driver to use different set of R&S TSME devi-
ces. It allows, for example, two times MIMO 2x2 to measure by using four R&S
TSMEs.
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Figure 6-271: Configured frontends of four connected R&S TSMEs

The receive antenna reported by all measurements is the frontend number minus 1.
For example, if the frontends 1 and 4 are connected to an R&S ROMES4 LTE scanner
driver, obtained measurement data is for the receive antenna 0 and 3, see Fig-
ure 4-910.

6.4.15.2  Configuration LTE scanner

If you select the "Hardware" > "R&S LTE Scanner [<variable>]" command line, R&S
ROMES4 provides a configuration menu for the R&S ROMES4 LTE scanner. The
menu is available when the driver is loaded.

The "R&S LTE Scanner [<variable>]" > "Scanner Configuration" tab offers to select
channels for scanning. The "Scanner" tab let you set the scanner properties. The "Info"
and "Templates" tabs display information on the test receiver driver and store the set-
tings to a template, respectively.

In "Scanner Configuration" configure the measurement parameters for one or more
channels that you want to measure.

The co-existence of 5G NR and LTE in the same bandwidth requires the feature DSS.
The feature allows the specific resource elements of the LTE spectrum to reserve for
the 5G carrier. From the UE's perspective, this feature is identical to eMBMS. The LTE
scanner is redesigned in such a way that DSS and eMBMS can be configured. Both
eMBMS and DSS are signaled via SIB2.

There are signals associated to the carriers which are shared between 5G NR UEs
and LTE UEs in DSS procedure. To mark these signals, R&S ROMES4uses "-D"
appendix added in their names. For the conditions to mark them in that way, refer to
the text below the Figure 4-472.

The narrowband scanner does not make reference symbol measurements before SIB2
is demodulated while the wideband scanner measures reference symbol only on a limi-
ted set of them.

If the LTE carrier under test offers eMBMS or DSS, the LTE scanner has to know about
it to use the correct reference symbols and subframes. Enable the DSS option to make
the scanner sensitive to considering DSS-specific subframes and reference symbols.
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Channels pane

Configure the channels which you want to be scanned in the "Channels" pane. Activate
scanning of the configured specific channels.

Figure 6-272: Configuration page - virtual channel option not active

Instead, you can allow the scanner to follow another device by choosing the "Virtual"
option. Choosing this option, the primary R&S ROMES4 driver is selected which con-
figures scanning dynamically. Therefore, no need for defining a certain EARFCN.

This Virtual Channel feature allows the scanning without knowing a specific frequency
of the LTE network. It is useful while monitoring the UEs with configured one or more
SCCs in the LTE-A networks.

Figure 6-273: Configuration page - virtual channel option active

The following functions and their parameters are shown in the "Channel" pane.

Channel Enabled/Virtual
Enable or disable scanning of a selected channel or set the "Virtual" channel option.
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Figure 6-274: Status selection of the set channels

If "Virtual" is selected, the combo-boxes of the frequency, "EARFCN" and the "Band"
columns disappear in the pane. Instead a combo-box appears which allows to select
between a test device and the ACD.
If the ACD is selected, the combo-box under the "f[MHz]| EARFCN|Band" column
offers all the possible sources for the virtual channel. By default, the LTE bands 3, 7, 8
and 20 are searched, see Figure 6-273.
For the ACD configuration, see Chapter 3.8.2.1, "Technologies", on page 280 and
Chapter 6.4.15.2, "Configuration LTE scanner", on page 1728.
If the LTE channel is detected, the settings concerning the BCH measurements, mea-
surement rates and the advanced settings of the virtual channel is applied to the detec-
ted channel.
Note: The entry "Virtual" is only available with the ACD option or if at least one device
driver is loaded. The latest can be commanded by the scanner (currently only the
Qualcomm drivers support the feature).
The primary device can add and release physical channels during the measurement. It
can be useful to ignore the release command.
For example, if LTE device adds an SCC, the second channel is scanned automati-
cally. In a case the SCC is to be released, the UE releases this channel also in the LTE
scanner.
If the user wants to scan the SCC always, regardless of the UE usage of SCC, the
release commands can be ignored. In this case, the scanner scans the SCC from the
point in time when the UE adds the SCC the first time.

Name
Name of the channel, for example, a provider name.

f[MHz]
Carrier center frequency of the channel.

EARFCN
E-UTRA Absolute Radio Frequency Channel Number.
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Band
E-UTRA operating band.

BCH Demodulation
BCH demodulation allows selection of MIB and SIB types for demodulation.
The list of SIBs which can be configured for demodulation and display in R&S
ROMES4 is given in this column. To comply with 3GPP Rel 17, LTE SIBs from SIB26a
to SIB32 and posSIBS are added to the list.
SIB26a: contains NR bands list which can be used for EN-DC operation with the serv-
ing cell.
SIB27: contains information relevant only for inter-RAT cell selection i.e. assistance
information about NB-IoT frequencies for cell selection.
SIB28: contains NR sidelink communication configuration.
SIB29: contains common resource reservation, e.g. for coexistence with NR.
SIB30: contains configurations of disaster roaming information.
SIB31: contains satellite assistance information for the serving cell.
SIB32: contains satellite assistance information for prediction of discontinuous cover-
age.
posSIBs: contains positioning assistance data as defined in TS 36.355 [54].

Mode
The signal on the channel is an LTE FDD or TDD signal. FDD/TDD selection depends
on selected band.
If a standard band is selected, the mode changes automatically (automatic FDD/TDD
selection), depending on the band. The corresponding cell is read only.
If "No 3GPP band" is selected, the cell is accessible and the user can set the mode.

NB Rate [Hz]
Maximum narrowband measurement rate.

WB Rate [Hz]
Maximum wideband measurement rate, up to 50 Hz.

eMBMS
If selected, activates the eMBMS scanner and eMBMS measurements.

Figure 6-275: eMBMS and DSS options selection

- The narrowband scanner does not measure reference symbols until SIB2 has been
demodulated. In eMBMS or/and DSS, reference symbol measurement is not per-
formed.
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- The wideband scanner uses a limited set of reference symbol measurements until
SIB2 has been demodulated. After a successful demodulation of SIB2, the wideband
scanner demodulates all relevant reference symbols.
Note: The column "eMBMS" is only available if the scanner option is available.
eMBMS works in auto mode and therefore has no configuration page.

DSS
If DSS is selected, the following applies:
- The narrowband scanner does not measure reference symbols until SIB2 has been
demodulated. In eMBMS or/and DSS, reference symbol measurement is not per-
formed.
- The wideband scanner uses a limited set of reference symbol measurements until
SIB2 has been demodulated. After a successful demodulation of SIB2, the wideband
scanner demodulates all relevant reference symbols.

LTE-M
If checked, LTE-M scanner is active and measure LTE-M channel, see Chap-
ter 6.4.15.8, "LTE-M scanner configuration", on page 1751.
Note: The column "LTE-M" is only available, if the scanner option is available.

FE
It is possible to select a frontend for each LTE channel. The selected frontend is used
for the narrowband scanner and the demodulator (LTE and LTE-M).

Figure 6-276: Frontend selection

Frontends for MIMO and wideband scanner can be selected independently in the
advanced configuration.

Advanced
For most measurement applications, the default configuration values are the proper
ones. However, if you wish to adapt them, you can do that by opening the advanced
configuration pages.
The "Advanced" drop-down combo-box offers different settings for a selected channel.
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Figure 6-277: Advanced entries

All LTE views accumulate the configured channels. The currently inactive frequencies
are marked with an asterisk (*) in the frequency combo-boxes. The Top N algorithm is
based on the currently measured channels. It is a snapshot of the current measure-
ment. Thus, the measurement result depends on the channel configuration done by the
primary device. The BCH view accumulates all decoded eNodeBs, regardless of what
channels were measured.

Advanced Channel Settings
If you select "Advanced" > "Open", the "Advanced Channel Settings" dialog shows up.
The dialog offers a channel-specific setting.
If the "Virtual" option in the column "Channel" is selected, the "Virtual Channels" tab is
also included in this dialog.

WB/MIMO measurements

The "Advanced Channel Settings" > "WB/MIMO Measurements" dialog contains the
combined WB and MIMO measurement configuration parameters. The dialog is subdi-
vided into the "WB RS Measurements" and the "MIMO Measurements" pane.
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Figure 6-278: WB/MIMO Measurements

To get the dialog, you need the R&S TSME-K30 option with additional R&S TSMEs
and sync cables, see Chapter 6.4.27.1, "Multiple R&S TSMEs", on page 1869.
LTE WB measurements can run at maximum speed in parallel with LTE NB measure-
ments if using the R&S TSME ROMES4T1E. The maximum speed depends on band-
width.

WB RS measurements pane

You can configure the following parameters in this pane:
● Bandwidth of RS measurements in the "Bandwidth" list

Defines how the number of transmitted resource blocks (bandwidth) for each eNo-
deB on this channel is determined.
– If "Auto (once)" is selected, the bandwidth is taken from the first MIB on the

channel, thus the demodulation of MIB is mandatory. It is assumed that all eNo-
deBs on the same channel frequency use the same number of resource blocks.

– If "Auto (tracking)" is selected, the bandwidth is taken from each MIB on the
channel, thus the demodulation of MIB is mandatory. It is assumed that the
eNodeBs on the same channel frequency use different number of resource
blocks.
This mode uses more resources. Apply it only if the bandwidth really differs.

– Use the manually given bandwidth specified for LTE, that is, 1.4 MHz, 3 MHz,
to 20MHz.
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● Frontends and TX antenna ports for SINR, RSRP and RSRQ measurements in
"Frontends" and "Tx Antennas", respectively. Up to 16 antennas can be selected,
from "Tx Antenna Port 0" up to "Tx Antenna Port 15".
Four FEs are available for these measurements if four R&S TSMEs are connected.

● If checked, "Subband Measurements" controls activation/deactivation of the sub-
band measurements. A subband measurement with the finest granularity requires
the scanner to process a long RF signal. Therefore, the subband measurements
can only be provided at lower rates.
For high-speed measurement, reduce the granularity of the subband measure-
ments using "Min. Number of RBs" or even deactivate the subband measurements.
Increasing the minimum number of RBs used for subband measurement improves
the maximum accuracy. However, more computation time is required and measur-
ing high RS SINRs is more difficult.
To avoid the gap in the middle of the subbands, set "Force No Gap" to "Yes". The
gap remains and includes the DC carrier in case the number of RBs is not divider
of the total number of RBs.

● Check "High dynamic mode" to activate wideband (WB) RS measurement that
delivers one result (RSRP, RSRQ, RS SINR or RS RSSI) over complete band-
width. The measurement is provided down to -20 dB for RS SINR.
This WB RS measurement requires the scanner to process a limited amount of sig-
nal. Due to that approach, the measurement is provided at the high rate.
If the high dynamic mode measurements are not required, select the thresholds for
activation of WB RS measurements.
By deselecting "High dynamic mode" the following thresholds can be set:
– "Max eNodeBs" - maximum number of eNodeBs which use one frequency for

which the RS SINR measurement is set, default 50
– "Min RSRP" - minimum RSRP for which the RS SINR measurement is set,

default -160 dBm
– "Min NB RS SINR" - minimum narrowband RS SINR for which the RS SINR

measurement is set, default -20 dB
– "Max. Delta RSRP to Best Cell" - maximum delta between the NB RSRP of the

currently measured cell and the NB RSRP of the best received cell for which
the RS SINR measurement is set, default 20 dB

● "Settings for RSSI Measurements" lets configure the parameters for the WB RSSI
spectrum measurements.
The measured WB RSSI spectrum is shown in the "TopN List" of the "LTE Scanner
TopN View", see Figure 4-915.
If "Average (all FEs)" is set to "Yes" and more than one frontend is used, the RSSI
power and power spectrum of the frontends is averaged (in Watt, power combin-
ing). If not, a value for each frontend is measured separately. Select frontend/fron-
tends to be used for RSSI and spectrum measurements in "Frontends".
Associate a driver to both frontends to measure MIMO values. If four R&S TSMEs
are connected, there are four FEs on disposal for RSSI measurement as the R&S
TSME supports 4x4 MIMO.
The WB RSSI measurement time is set to some value (in ms) or to "Auto" in the
"Measurement time".
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The scanner reports the actual used measurement time as the "WB RSSI Meas.
Time" signal within the "Top N Templates" and "eNodeB <EARFCN\PCI> Template"
branches of "Signal Tree" > "LTE Scan".
The signal is visible in the "Alphanumeric View".

Figure 6-279: Alphanumeric view showing WB/MIMO measurements

The WB RSSI spectrum measurement is disabled by default as the measurement
results generate a huge amount of data which is rarely used. You can nevertheless
activate the measurements if you check the "RSSI Spectrum Measurement (increa-
ses file sizes)" checkbox. The "LTE Scanner WB RSSI Spectrum View" is the only
R&S ROMES4 view which allows to visualize this data.
If "TD LTE Timeslot RSSI Measurement" is selected, the RSSI of a TD timeslot is
measured in LTE TDD mode.
In that case the following RSSI TD TS-related signals are available in "Top N Tem-
plates" and "eNodeB <EARFCN\PCI> Template" branches of "Signal Tree" > "LTE
Scan".
– "RSSI TD TS Rx0/Rx1" showing the received signal power on a certain

receiver for each DL slot of an LTE radio frame
– "TDD RSSI Slot" showing a measured slot number (0-19) of the LTE radio

frame

If the "WB RS Measurement" is inactive, the "Subband Measurements" and the "High
dynamic mode" are also inactive. The related parameters cannot be set in that case.

MIMO measurements pane

MIMO Measurements
Here you can configure and activate MIMO measurements.
The following signals are configurable:
● MIMO mode in "Mode".

Measurement and processing of 2x2 MIMO, 4x2 MIMO and 4x4 MIMO signals are
supported. The signals are available in "Available Signals" > "Top N"/"Power Fre-
quency".
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Figure 6-280: Measurement of MIMO signals

Note: The MIMO 4x4 feature needs the R&S TSME setup. The setup must include
four R&S TSMEs interconnected with the four port sync cable. For the Gigabit
Ethernet connection, needed is a Gigabit Ethernet switch capable to forward 9k
Jumbo frames.

● MIMO channel matrix (H-Matrix), Condition Number (CN) and the theoretical Rank
Indicator in "2x2 Results","4x2 Results" and "4x4 Results".

● Time interval between MIMO measurements within the captured data in "Resolu-
tion".
The parameter can be set to some value (in ms) or as "Auto". The scanner reports
the used 2x2 MIMO, 4x2 MIMO or 4x4 MIMO resolution time. This value must be
less or equal the “measurement time” of the WB measurements. Value 0 is used to
calculate just one MIMO result per acquisition.
For example, if the resolution is set to 5 ms and the data capturing lasts 50 ms, the
MIMO results are calculated up to 10 times and returned.
For TDD, the resolution has to be a multiple of 10 ms (LTE frame duration).

● "Thresholds for activation of MIMO measurements" allows setting the threshold val-
ues of the parameters which are relevant for the MIMO measurement. For descrip-
tion, see the previously mentioned activation of high dynamic mode of WB RSSI
measurements.
Note: Default value for "Min SINR for Rank" is 0 dB.

Advanced option

Shows the narrowband measurements configuration details.

"Power of Sync-Channels" allows the ratio of the SSS power to PSS power to specify.
You can select one of the three offered options.

The number of symbols per RB, that is, 6 (Extended Cyclic Prefix) or 7 (Normal Cyclic
Prefix), is configured in the "Symbols" area.

The "RSRP / RSRQ Measurements" lets the LTE-TDD subframe 9 configuration, which
was released in 3GPP Rel. 11.
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Figure 6-281: Advanced options measurements

Dynamic PDU settings

For the general issues related to dynamic PDUs handling, see "Implementation of the
dynamic PDU handling" on page 284.

All the supported PDUs (MIB and SIBs) of a selected channel which can be configured
for measurement are shown in the "Dynamic PDU Settings" page. The page is inclu-
ded in the "Advanced channel settings" dialog that can be launched by clicking the
"Open" pop-up item in "Advanced" grid column.

R&S ROMES4 supports LTE 3GPP rel.17 defined SIBs, which are SIB 26a, SIB 32
and proSIB.
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Figure 6-282: LTE Scanner - dynamic PDU settings

Check the associated check box of a SIB that you want to monitor in the "Dynamic"
column of the "Dynamic PDU Settings" page. Enter a repetition interval value in "Inter-
val [s]" or use the default value which is 1[s]. The possible range depends on the scan-
ner driver for the technology, see Dynamic PDU Settings.

If the BCH demodulation list does not contain all the selected PDUs (MIB/SIBs), you
are asked to enable them via the dialog shown in the next figure.

Figure 6-283: Enable missing PDUs

Click "Yes" to enable these MIBs and/or SIBs in BCH demodulation list.

Then click "OK" to add the settings to the selected channel and return to the "LTE
Scanner Configuration" dialog.
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Click "Cancel" to discard the changes and return to the "LTE Scanner Configuration"
dialog.

Clicking "Previous" or "Next" leads you through the list.

Templates

The "Advanced" column holds combo-boxes which show the advanced settings of the
channel as the name of a template. The use of the templates simplifies the channel
configuration.

If the settings do not match an existing template, the "<custom>" is displayed.

All available and usable templates are shown in the combo-box and also in the
"<Open>" entry. If you select this entry, the configuration page of advanced features
shows up, see the following figure.

Figure 6-284: Templates page

This kind of template allows saving, loading or deleting the advanced settings of a
channel.

The templates hold the wideband and MIMO settings of a channel. They are stored in
the following directories:

- My ROMES\DriverTemplates\R&S LTE Scanner_TSME\Advanced (the user-
defined templates)

-
\ProgramData\Rohde&Schwarz\My ROMES\DriverTemplates\
R&S LTE Scanner_TSME\Advanced (the system defined templates, supplied with
the R&S ROMES4 installation or copied here by an administrator)

Templates with eMBMS detection are available automatically whereas they end with
eMBMS, as shown for FDD/TDD mode in the following figures.
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Figure 6-285: Template with FDD MIMO eMBMS detection

Figure 6-286: Template with TDD MIMO eMBMS detection

The following table describes the meaning of the default templates.

Figure 6-287: Table of default templates

The "usable templates" means that templates requesting MIMO measurements are not
shown if the TSME-K30 MIMO option is missing. The templates using two frontends
are not shown if only one frontend is available.
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If the settings of an existing template configuration are changed, then "<custom>" is
shown as the pseudo name, but you can store the settings as a new own template and
in this way the setting provides you defined individual name.

Virtual channels

If assumed that at least one device driver which can run an LTE scanner is loaded and
the option "Virtual" is selected, the "Virtual Channels" dialog gives the option to release
these channels. The "Ignore Release Command" checked is default setting.

LTE channel scan rate configuration

The Channel Scan Rate function for LTE is supported with the R&S TSME drivers.

For details, see Figure 6-49.

LTE automatic channel detection

To adapt the default ACD configuration, press the "Automatic Channel Detection
(ACD)" button in the "LTE Scanner Configuration" page, see Figure 6-272.

The ACD page opens.

Figure 6-288: LTE Scanner ACD configuration page

The "Automatic Channel Detection" pane of the page contains the parameters that
apply to all technologies. The "LTE Automatic Channel Detection" pane is the LTE spe-
cific.

Automatic Channel Detection Pane
The following parameters are configurable in the first mentioned pane:
● "Use Layer 3 Messages"

If selected, R&S ROMES4 reads out all neighbor lists of detected transmitters and
adds the detected neighbor cells' channels automatically to the system.

● "Create Template"
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The template can be used to set up a new measurement with the found channels
which is not requested for the monitoring use case.
If selected, R&S ROMES4 creates a template for the scanner, which includes all
detected channels at the end of the measurement. The name of the template is the
name of the measurement file.

Figure 6-289: Automatically created template

● "Auto Start of Scan"
This automatic approach has sense during a drive test. It is needed during a moni-
toring use case as the monitoring use case aims to measure only actual “on air”
transmitters.

● "Sensitivity (UMTS, LTE, NB-IoT, 5GNR)"
For the listed technologies, the sensitivity allows user to fine-tune the setup for the
long term monitoring use cases, for details see Chapter 3.8.2.1, "Technologies",
on page 280.
Three different levels of the ACD sensitivity are available for power and quality
measurements. Depending on the requirements of the monitoring use case, you
can select the sensitivity level for transmitters detection between low, medium and
high.

● "Advanced"
If pressed, the "ACD Measurement Rate" page shows up, where you can set the
ACD priorities for different RATs, see Figure 6-344.

The ACD feature tries to achieve the same measurement rates for all detected chan-
nels. However, R&S ROMES4 SW offers the user option to prioritize one RAT against
the other. This prioritization is achieved by adding to the technologies supporting ACD
(excluding TETRA) weighting factors. These factors then represent how higher mea-
surement rate for one technology has to be in comparison to the others.
For example, if LTE has to have the double measurement rate compared to other
RATs, set the LTE detected channels weight 2, and leave the weight 1 for the other
RATs' detected channels.
To set the weight, press the "Advanced" button in the ACD page. Set the prioritization
in the shown "ACD Measurement Rates" page.
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LTE Automatic Channel Detection Pane ← Automatic Channel Detection Pane
The following parameters are configurable in the "LTE Automatic Channel Detection"
pane.
● "LTE Bands to scan"

This parameter in the LTE-specific ACD panel allows the LTE bands for scanning
to select. The smart LTE ACD can detect also small bandwidths like 1.4 MHz or 3
MHz.
It is highly recommended to activate only those bands which are specified for LTE
in the corresponding geographic region.

● "Minimum LTE Bandwidth"
Defines the minimum LTE bandwidth for scanning. The smart LTE ACD starts
bandwidth searching from the bandwidth specified in this box.
By default the ACD searches for networks with a minimum bandwidth of 10MHz. To
improve the scan speed, set the minimum bandwidth correctly - if known, espe-
cially in bands which are used for several technologies (e.g. LTE and GSM).

The progress of the ACD can be observed in the "Output View".

Figure 6-290: ACD progress view

Use Cases of Automatic Channel Detection ← Automatic Channel Detection
Pane
The main use case of the LTE ACD is to let you start a measurement anywhere without
any knowledge of the used EARFCNs within the known LTE bands.
Typically, you have to initiate a measurement with the ACD and use the resulting tem-
plate for the best measurement rates as a starting point for the actual measurement.
If the detection of transmitters along a drive is the goal of the measurement, run the
ACD according to the procedure described in Chapter 3.8.2.1, "Technologies",
on page 280.
The primary goal of the measurement is the detection of cells usually. The speed of the
measurement on already detected cells is of secondary interest. If your goals are as
mentioned, you can increase the detection speed by reducing the measurement rate of
the virtual channel. For example, reduce the measurement rate to 10Hz for NB mea-
surements and to 1Hz for WB measurements. This reduction increases the speed
available for cell detection.

Measurement rate

The two input fields define how often the system synchronizes to the received LTE sig-
nals and updates the measurement file.
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● "Sync Rate [Hz]"
Defines the synchronization rate in Hz.

● "Measurement Rate [Hz]"
Defines the used measurement rate in Hz.

The measurement rate of the channel is the max. measurement rate. The actual ach-
ieved measurement rate depends on many factors, e.g. CPU speed, memory. The
actual achieved speed can be selected by the Measurement Rate signals.

The configured number is related to the number of measurements at one subframe.

Figure 6-291: Measurement rate of LTE scanner

LTE scanner buttons/check-boxes

In the following are listed the LTE scanner buttons and check boxes present in the
"Channel" pane.

Add
Opens the dialog which allows to add a channel for scanning. The basic channel con-
figuration is the center frequency and the bandwidth to be used.

Remove
Removes all highlighted channels from the table of channels.

Clone
Makes a copy of all highlighted channels, automatically sets the “selected” status for it
and assigns name by adding the word “copy” to the original channel name.
Note: The "Remove" and "Clone" buttons are available only if at least one channel in
the table is highlighted.

Enable Throughput Estimation
The function makes possible to estimate the throughput of all LTE channels. The
throughput estimation for the complete LTE scan can be switched on by checking or
unchecking the "Enable Throughput Estimation" checkbox.
The function is available with the R&S TSME. Select the MIMO measurement and pro-
vide the R&S TSME-K29 and R&S TSME-K30 option.
The following views show the CQI values and estimated throughput (Est. TP) in kbit/s.
● LTE Scanner Estimation Throughput 3D Chart View
● LTE Scanner Estimation Throughput Chart View
● LTE Scanner Estimation Throughput Subband View
For the details about throughput estimation possible views, refer to Chapter 4.8.6, "LTE
scanner views", on page 1204.
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Automatic Channel Detection
For the feature description, see previous Chapter 6.4.15.2, "Configuration LTE scan-
ner", on page 1728. The feature requires option R&S ROMES4ACD.

Advanced
If the "Advanced" button is selected, the advanced settings dialog is shown, see the
following chapter.

OK
Adds the new defined channel to the channel list and returns to the "LTE Scanner Con-
figuration" page.

Cancel
Discards the changes made and returns to the "LTE Scanner Configuration" page.

6.4.15.3  LTE scanner advanced configuration

The LTE scanner advanced configuration concerns the configuration of the scanner
parameters which are not a channel specific.

Advanced general parameters

The parameters, which are not channel specific are configured in the "Advanced Gen-
eral Parameters" page.

Figure 6-292: Advanced general parameters

The "Channel model for calculation of RS CINR" pane allows configuring:
● "max. Delay Spread" - time difference of a signal arrival via different paths
● "max. Spread" - maximum mobile speed that can be expected during the drive
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The larger these values, the longer the computation time for RS CINR. If the maximum
delay spread or the speed is bigger than set, the accuracy of measurement results is
degraded or the results even get wrong.

BCH demodulator configuration

The "BCH Demodulator" page lets you configure the minimum SINR signal level which
is required to demodulate BCH signal both for LTE and LTE-M (if LTE-M is activated).

Figure 6-293: BCH demodulation parameters

● "Min. SINR of LTE signal, which shall be demodulated [dB]"
Defines the minimum SINR that LTE BCH signal has to have to be demodulated,
range -15 dB to 50 dB.

● "Min. SINR of LTE-M signal, which shall be demodulated [dB]"
Defines the minimum SINR that LTE-M BCH signal has to have to be demodulated,
range -15 dB to 50 dB.

6.4.15.4  Scanner

The "Scanner" tab opens the page which displays the properties of the R&S TSME
device used as LTE scanner and the information on the file version of the R&S
ROMES4 LTE scanner driver.

Preselection option

The "Scanner" page of R&S TSME6/TSMA6 offers the preselection mode of operation
for these scanners.
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Figure 6-294: R&S TSME6 scanner page

The preselection mode is selected in the "Preselection" drop-down combo box.

The following preselection modes are available:
● "TSME(A)6 Preselection Auto" - use preselection based on R&S TSME6/TSMA6

internal spectrum measurements
● "TSME(A)6 Preselection on" - preselection on
● "TSME(A)6 Preselection off" - do not use preselection for better noise figure

6.4.15.5  Info

The "Info" page displays information on the file version of the R&S ROMES4 LTE scan-
ner driver.

Figure 6-295: LTE scanner info
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6.4.15.6  Templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.

6.4.15.7  Dynamic loading of LTE band table by using XML files

The LTE band table is dynamically loaded using XML files and can be customized. The
benefit is the possibility to replace or extend the band table.

There are two XML files for customizing LTE band table:

● UserBands.Sample.xml - sample file that shows sample entries and how to cus-
tomize band table.

● UserBands.xml - R&S ROMES4 loads this file at runtime. Entries in this file are
used to add or update current LTE band table. The actual band customizations are
done in this file.

The UserBands.Sample.xml file is installed during the R&S ROMES4 installation on
top of all user folders. The file is then copied to “My ROMES\Configuration” folder
when R&S ROMES4 fully starts for the first time. If the file exists already, it is not cop-
ied.

To customize a band table, copy or rename the UserBands.Sample.xml file to cre-
ate the UserBands.xml file.

Change the content of the UserBands.xml accordingly to customize bands. Updated
bands are loaded next time when R&S ROMES4 starts.

LTE samples in UserBands.Sample.xml

Short descriptions for band table fields are provided in the UserBands.Sample.xml.

Using the sample entries in this file to customize the band table.

- If the defined bands already exist in band table, the defined bands overwrite existing
entries.

- If the defined bands do not exist in band table, new band entries are added.

- If the same band number is specified more than once, only the last one takes effect.

- Removing UserBands.xml restores the original bands.

The LTE user bands include the following samples whose values are decimal number
strings:

1. Band: user base to be defined

2. Duplex: duplex mode, 0-FDD, 1-TDD, 2-Not Used

3. DLFLOW: downlink flow

4. DLNoff: downlink N offset

5. DLLOW: downlink low
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6. DLHI: downlink high

7. ULFLOW: downlink flow

8. ULNoff: uplink N offset

9. ULLOW: uplink low

10. ULHI: uplink low

11. GeoFlag: 1-Africa,2-Caribbean, 4-Central America,8-South America, 16-NorthA-
merica, 32-Asia, 64-Europe, 128-MiddleEast,

12. BWMIN100KHZ: Bandwidth Minimum in 100KHz

13. BWMAX100KHZ: Bandwidth maximum in 100KHz

14. IOTSupport: 0, reserved, don not use 15. UniqueFreq: 0, reserved, do not use.

Sample usage to define band

For example, band 64 is defined as shown.

<Index Band="64" Duplex="0"
      FDLOW="24000" DLNoff="100000" DLLOW="100000" DLHI="101000"
      ULFLOW="26000" ULNoff="102000" ULLOW="102000" ULHI="103000"
      GeoFlag="0" BWMIN100KHZ="14" BWMAX100KHZ="200"
      IOTSupport="false" UniqueFreq="false" />

Click the "Band" button in the "R&S LTE Scanner" configuration dialog to see the
defined band 64.

Figure 6-296: Added band 64

The details of the channel band can now be selected.
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Sample usage to add bands

For example, add the new bands 104 to 105.

<Index Band="104" Duplex="0"
      FDLOW="24457" DLNoff="60000" DLLOW="60000" DLHI="60050"
      ULFLOW="24078" ULNoff="61000" ULLOW="61000" ULHI="61050"
      GeoFlag="0" BWMIN100KHZ="14" BWMAX100KHZ="200"
      IOTSupport="false" UniqueFreq="false" />

<Index Band="105" Duplex="0"
      FDLOW="24557" DLNoff="60100" DLLOW="60100" DLHI="60150"
      ULFLOW="24178" ULNoff="61100" ULLOW="61100" ULHI="61150"
      GeoFlag="0" BWMIN100KHZ="14" BWMAX100KHZ="200"
      IOTSupport="false" UniqueFreq="false" />

6.4.15.8  LTE-M scanner configuration

Launch the LTE scanner configuration page as previously described by using, for
example, the R&S TSME scanner.

Figure 6-297: LTE scanner configuration page

There is the "LTE-M" column in the "Channel" pane and the  check box in the chan-
nel's grid row of LTE-M scanner. If the box is checked in one channel row, the LTE-M
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scanner is activated for that channel. Unchecked box indicates that the scanning is
deactivated for that channel.

LTE-M advanced global settings

Click the "R&S LTE Scanner" > "Advanced" button to launch the "Advanced Configura-
tion" page.

BCCH demodulator

Specify the minimum SINR of the LTE signals that you want to be demodulated in
"Advanced Configuration" > "BCCH Demodulator" > "Thresholds" pane.

In the "LTE_M Threshold" pane you can specify the minimum SINR of LTE-M signal
you want to be demodulated. This section is dimmed if the option keys are unavailable
or the "TEC for LTE-M Scanner" > "LTE-M Signals" check box is cleared. The valid
range for the threshold is -15.0 dB to 50.0 dB.

Figure 6-298: LTE-M scanner - BCCH demodulation page

The settings on this page are used for all channels.

LTE-M enabled channels configuration

If the LTE-M is activated, a new page "Advanced channel settings" is available.

Click "Open" button in the "Advanced" drop-down column.
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Figure 6-299: Advanced column - open command

The "Advanced channel settings" page opens.

Figure 6-300: Advanced channel settings - LTE-M settings page

This page is always available no matter if LTE-M check-box is checked in the channel
grid row.

Enable LTE-M measurement

Check the "Enable LTE-M Measurement" check box at the top of the "LTE-M Settings"
to activate the LTE-M measurements. Uncheck it to deactivate the measurement.

If checked, the page becomes editable. Otherwise the page is grayed out and nothing
can be changed. The "Enable LTE-M Measurement" check box has the same function
as the LTE-M check box in channel line.
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Figure 6-301: Enable LTE-M measurements

The "Bandwidth Control Recovery Mode" specifies how the bandwidth control is recov-
ered.

The possible options are:
● "Auto (once)"
● "Auto (tracking)"
● Use the manually given bandwidth specified for LTE, that is, 1.4 MHz, 3 MHz, ... up

to 20MHz.

The following buttons are contained in the previous figure:
● "All"

Activates all messages.
● "None"

Deactivates all messages.
● "OK"

Click the button to accept the changes.
● "Cancel"

Click the button to discard the changes.

LTE-M channel measurement configuration

The following settings are used to configure the LTE-M channel measurements.

Average Measurement Rate
Specify the measurement rate for the particular LTE-M channel. Valid value range is
0.0 Hz to 100.0 Hz. Default value is 25.0 Hz.
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MBMS Control Mode
The drop-down box lets you select the MBMS control mode between the following
options.
● "MBMS not present"

If selected, the manual configuration selection is inactive.
● "MBMS configuration is detected automatically"

If selected, the manual configuration selection is inactive. The MBMS settings are
determined automatically.

● "MBMS configuration manually"
If selected, the manual configuration selection is activated.

MBMS manual configuration

To configure MBMS manually, MBSFN area ID has to be selected first. The MBSFN
Area ID values range 0 to 254.

Select one from the "MBSFN Area ID" drop-down box.

After the MBSFN Area ID is selected, set the other parameters accordingly. Set the fol-
lowing parameters:

● "Num. PDCCH Symbols"
Select 1 or 2 symbols.

● "Notification Indicator"
Select indicator's value in the range 0 to 7.

● "MCCH Offset"
Select MCCH offset value in the range 0 to 10.

● "MCCH Repetition Period"
Select the MCCH repetition period value out of the offered number of radio frames,
which are 32, 64, 128, and 156.

● "MCCH Modification Period"
Select the MCCH modification period value out of the offered number of radio
frames, which are 512 and 1024.

● "Subframes which may carry MCCH"
The subframes that can carry MCCH are shown in the following figure. Check the
associated check boxes to include or exclude the subframes, respectively.

Figure 6-302: Subframes that can carry MCCH

Click "All" to include all or "None" to exclude all subframes.
Click "OK" or "Cancel" to accept the changes or to discard them, respectively.

● "Signalling MCS"
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The available signaling MCS is MCS2, MCS7, MCS13 and MCS19.
● "MBSFN Subframes for"

Select value 0 or 4.
● "MBSFN Subframes"

Select the subframes associated with the "MBSFN Subframes for" selection.

● "Radio Frame Allocation Period"
Select the frame allocation period from the range, 1, 2, 4, 8, 16 and 32 frames.

● "Radio Frame Allocation Offset"
Select the frame allocation period from the range, 1, 2, 4, 8, 16 and 32 frames.

After setting all values, click "OK" to accept the manual setting.

All parameters must be set to be accepted, otherwise the warning message asks for
entering the missing settings.

Figure 6-303: Warning messages

LTE-M PDU settings

"LTE-M PDU Settings" lets you specify the PDU for the particular LTE-M channel.

Click the "Advanced channel settings" > "LTE-M Settings" > "Repetition" tab to launch
the "LTE-M PDU Settings" page.
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Figure 6-304: LTE-M PDU demodulation setting

Check the check box in the "Enable" column. A value is auto populated to the "Interval"
column. Interval can be customized and the valid value range is 0.0 second to 65.5
seconds.

Figure 6-305: Checked PDU for repeated demodulation

If you activate the LTE-M PDU messages in this page but not in the BCH settings, the
opened dialog asks whether to populate the PDU changes back to BCH settings. See
also the Figure 6-301.
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Figure 6-306: Saving selected LTE-M PDUs

Click "Yes" to apply the change in the BCH setting, click "No" to avoid the change in
the BCH setting.

6.4.16  LTE-M scanner

R&S ROMES4 supports LTE-M technology as an option.

To run LTE-M scanning, you have to check in the "ROMES Technology Selector" dialog
if the LTE-M technology is activated. The dialog pops-up during the R&S ROMES4
installation, see Figure 5-20. By default the LTE-M technology is activated in the dialog.

Moreover, provide that the following conditions are fulfilled:
● LTE-M module installed,
● Option key R&S K29 and R&S K35 available,
● LTE-M signals activated to support the LTE-M scanning, see Figure 6-297.

If the conditions are fulfilled, the R&S TSME LTE scanner supports the LTE-M scan-
ning.

The LTE-M scan support is visible in the "Welcome" > "Available Devices" section and
in the "Hardware" menu.

Figure 6-307: LTE-M as loaded device

The LTE-M scanner configuration is a part of LTE scanner configuration.

6.4.16.1  LTE-M scanner configuration

Click the LTE-M command line in the "Hardware" menu to configure the RS LTE scan-
ner as the LTE-M scanner as well.

Or add the device via the "Welcome" page. In the "Available Devices" section click the
icon for the connected device.
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For the LTE-M scanner configuration, see Chapter 6.4.15.8, "LTE-M scanner configura-
tion", on page 1751.

6.4.17  NB-IoT scanner

The R&S NB-IoT scanner is used to scan NB-IoT signals and to analyze the measure-
ment data. R&S ROMES4 supports the ACD feature for NB-IoT if there is an active
LTE ACD on the same band.

The corresponding scanner option and R&S ROMES4 option are necessary to load the
R&S TSME as the NB-IoT scanner and visualize it in R&S ROMES4.

NB-IoT scanner configuration without using MDL

The MDL is one of the parameters for configuring NB-IoT scanner frequency. It is not
used in NB-IoT scanner configuration.

This document has in focus non-virtual channel configuration for the In-Band, Guard
Band and Stand Alone modes. All verifications are active if the "No 3GPP Band" mode
is unselected.

6.4.17.1  Loading NB-IoT scanner

To launch the NB-IoT scanner configuration dialog, double-click "TSME NB-IoT" of the
"Available Devices" field on the "Welcome" screen.
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Figure 6-308: List of available devices - NB-IoT scanner included

The action opens the dialog for initial setup of the selected device.

To load the R&S TSME network scanner with the R&S ROMES4 NB-IoT scanner
driver, click the "Hardware" > "Connect/Disconnect" menu command. Select the
"TSME NB-IoT" branch in the list of available devices in the "Available Devices" > "Net-
work Scanner TSME" pane, see Figure 6-40. Double-click the selected device.

The device is loaded and displayed in the "Loaded Devices" pane of the "Hardware
Configuration" window. Specify the serial number, IP address and the bands for mea-
surement for the loaded device in "R&S NB-IoT Scanner(<variable>): Select Device".
Click the "Connect" button to confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to complete the selection
and close the window.

The loaded NB-IoT scanner is now added as the "R&S NB-IoT Scanner [<variable>]"
command line to the "Hardware" menu.
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Click "R&S NB-IoT Scanner [<variable>]" to open the scanner main configuration dia-
log.

6.4.17.2  NB-IoT scanner configuration

Launching the NB-IoT scanner device opens the NB-IoT "R&S NB-IoT Scanner" con-
figuration dialog.

Figure 6-309: NB-IoT scanner configuration dialog

The previous figure shows the dialog at its first opening. A channel row shows the
default values of the channel parameters.

The "Scanner Configuration" > "Channels" right-hand pane shows a channel grid with
a few buttons at the bottom of the screen.

The first column of the "Channels" grid offers three choices for channel status:

● "Disabled"
● "Enabled"
● "Virtual"

The "Enabled" channels status is only considered in the following chapters.

Other columns related to the NB-IoT scanner parameters are:
● "Name"

User given name of the channel
● "f[MHz]"

Primary center frequency of the NB-IoT channel
● "f2[MHz]"

Secondary center frequency of the NB-IoT channel
● "NB EARFCN"

The four possible frequencies that are associated with a given channel number NB
EARFCN can be selected in drop-down combo box.

● "Band"
NB-IoT band contains all valid, NB-IoT supported bands.

● "BCH Demodulation"
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The drop-down combo box contains the System Information types available for
demodulation: MIB, SIB1, SIB2, SIB3, SIB4, SIB5, SIB14, SIB15, SIB16, SIB20
and SIB22. Demodulation of all SIBs is available if the "All SIBs" check box is
ticked.

Figure 6-310: Supported NB-IoT SIBs

● "Mode"
Calculation mode: "In Band", "NB Guard Band" and "Stand Alone" mode.
For In Band and NB Guard Band modes, available are three possible ways to enter
a frequency. Related note is displayed next to the "Clone" button.
Note: If changing mode to a different one, the channel record parameters are reini-
tialized. It can happen that the frequency in one mode is not valid in other mode.
Note: If band is not “No 3GPP Band”, the In Band and NB Guard Band require
configuration helper dialog for configuring the NB-IoT frequencies.

● "NB Rate [Hz]"
● "Advanced"

BCH demodulation by dynamic PDU changes

The buttons included in the pane are

● "Add"
Add a new channel populated with default parameters.

● "Remove"
Remove the highlighted channel.

● "Clone"
Clone the highlighted channel.

● "Automatic Channel Detection (ACD)"
Adapts the configured channel modes, refer to Chapter 6.4.17, "NB-IoT scanner",
on page 1759.

● "Advanced"
Perform the advanced configurations.

Preconfigured channels

If some channels have already been configured in the "NB-IoT Scanner" page, opening
the page shows all the preconfigured channels.
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Figure 6-311: Preconfigured channels

Inband mode

If the selected mode of operation is "In Band", the NB-IoT center frequencies are loca-
ted inside the LTE band and occupy predefined resource blocks.

Inband frequency calculation

The calculation of inband frequency is supported by the "Inband Frequency Calculator"
dialog.

1. Click "f[MHz]", "f2[MHz]", "NB EARFCN" or "Band" to launch the "Inband Fre-
quency Calculator" dialog.

2. Enter a valid LTE EARFCN.
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The corresponding "LTE Bandwidth" drop-down list is filled with all possible valid
bandwidths.
The NB-IoT frequency and NB-IoT EARFCN are calculated and displayed.

3. If the entered LTE EARFCN is invalid, the "LTE Bandwidth" and "Used PRB for NB-
IoT" boxes are cleared.

The "NB-IoT Frequency" and "NB-IoT EARFCN" show "---". The "Apply" button is
disabled.

4. After having entered a valid LTE EARFCN, select a bandwidth from the "LTE Band-
width" drop-down list.

The "Used PRB for NB-IoT" is filled with all possible valid Resource Blocks.

5. Select a PRB from "Used PRB for NB-IoT".

The NB-IoT frequency and NB EARFCN are calculated and displayed.

6. Click "Apply" to accept the frequency or "Cancel" to cancel the selection. In either
case, the dialog is dismissed.

If "Apply" was clicked, the calculated frequency and NB-IoT EARFCN would be
shown in "f[MHz]", "NB EARFCN" and "Band" columns of the channel. The f2[MHz]
is ".00".
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NB guard band mode

If the selected mode of operation is the "NB Guard Band", the NB-IoT center frequen-
cies are on the edges of the LTE band.

For a given NB EARFCN, there can be two valid NB-IoT frequencies, say, fa and fb.

Where: fb - fa = 15 kHz

The grid column "f2[MHz]" shows the second frequency if any.

NB guard band frequency calculation

A guard band frequency calculation is supported in the "NB Guard Frequency Calcula-
tor" dialog.

NB Guard Band mode:

1. Click "f[MHz]", "f2[MHz]", "NB EARFCN" or "Band" to launch the "NB Guard Fre-
quency Calculator" dialog.

The dialog opens.

2. There are two buttons in the "NB Guard Band Frequency Calculator" dialog:

● "Use LTE bandwidth" - LTE bandwidth to use for calculating NB frequency.
● "Use NB EARFCN" - NB EARFCN to use for calculating NB frequency.

Clicking a radio button switches the calculation mode.

Use LTE bandwidth

Click "Use LTE bandwidth" to switch the calculation to bandwidth mode.

1. Enter a valid LTE EARFCN.
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If the LTE EARFCN is valid, the all possible valid bandwidths fill the corresponding
"LTE Bandwidth" drop-down list.

2. Now you can select a bandwidth from the "LTE Bandwidth" drop-down list.

The "NB EARFCN, frequency 1, frequency 2" drop-down list is filled with all possi-
ble valid combinations of NB EARFCN, frequency 1, frequency 2.

3. An invalid LTE EARFCN entered, clears the "LTE Bandwidth" drop-down list.
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The "Apply" button is disabled. You can still click the "Cancel" button.

4. Click "Apply" to accept the frequencies or "Cancel" to cancel the selection.

In either case, the dialog is dismissed.

5. If clicked "Apply", the calculated frequencies, NB EARFCN and Band fill the
"f{MHz]", "f2[MHz]", "NB EARFCN" and "Band" columns of the channel accordingly.

The drop-down list is of the following format: "NB EARFCN, frequency 1, frequency 2",
where the meaning of the entries is:

● NB EARFCN - NB-IoT channel number
● Frequency 1 - Calculated primary frequency based on the LTE EARFCN
● Frequency 2 - Calculated secondary frequency based on the LTE EARFCN

The frequency 1 is placed to "f[MHz]" grid column and the frequency 2 is placed to
"f2[MHz]" grid column if it is available.

For example, in highlighted selection in the previous figure NB EARFCN = 521, Fre-
quency 1 = 2162.0925 MHz, Frequency 2 = 2162.1075 MHz means that the second
frequency is not available.

If two frequencies, for example, fa and fb are available and fb > fa, then they have to
satisfy the condition fb - fa = 15 kHz.

Both frequencies are sent to the scanner. The scanner detects and tries both and use
the correct one. The correct frequency is observed during measuring and replay in
BCH tree view and Top N pool center frequency signal and list.

Both frequencies are also reported in the measurement file system info box as shown
in the following list. You can highlight the measurement file to see the system informa-
tion. If secondary frequency is not configured, the Center Frequency2 is displayed.

Test devices



Hardware ComponentsDrive Test Software

1768Operating Manual 1171.6415.12 ─ 66

Count of all measured channels:    2
Selected Channels:
    Channel Name:        NB-IoT Channel 1
    LTE Band:            Band 1 (FDD)
    NB EARFCN:            53
    Center Frequency:        2115292.5 kHz
    M[DL]:                -1.0    (Informative only)
    Center Frequency2:    2115307.5 kHz
    M[DL] 2:                1.0    (Informative only)
    Mode:                 NB Guard Band
    max. Delay Speed:        4 µs
    max. Speed:            100 Km/h

    Rate per second:        10.0
    BCH Demod:        MIB(Rep: 1.000 s);SIB1(Rep: 1.000 s);SIB2(Rep: 1.000 s);
SIB3(Rep: 1.000 s);SIB4(Rep: 1.000 s);SIB5(Rep: 1.000 s);SIB14(Rep: 1.000 s);
SIB15(Rep: 1.000 s);SIB16(Rep: 1.000 s);SIB20(Rep: 1.000 s);SIB22(Rep: 1.000 s);

    Channel Name:        NB-IoT Channel 2
    LTE Band:            Band 1 (FDD)
    NB EARFCN:            167
    Center Frequency:        2126692.5 kHz
    M[DL]:                -1.0    (Informative only)
    Center Frequency2:    2126707.5 kHz
    M[DL] 2:                1.0    (Informative only)
    Mode:                 NB Guard Band
    max. Delay Speed:        4 µs
    max. Speed:            100 Km/h

    Rate per second:        10.0
    BCH Demod:            MIB;SIB1;SIB2;SIB4;SIB5;SIB14;SIB15;SIB16;SIB20;SIB22;

Use NB EARFCN

If "Use NB EARFCN" is clicked, the calculation switches to NB EARFCN mode.

1. Enter a valid LTE EARFCN.

The corresponding NB-IoT frequency 1 and NB-IoT frequency 2 are calculated and
displayed. Note that the NB-IoT frequency 2 may show "---".
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2. If the entered NB EARFCN is invalid, the"NB EARFCN, NB-IoT frequency 1, fre-
quency 2" box is cleared.

The "Apply" button is disabled. You can still click the "Cancel" button.

3. With a valid LTE EARFCN and NB EARFCN, one or two frequencies can be dis-
played.
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4. Click "Apply" to accept the frequencies or "Cancel" to cancel the selection. In either
case, the dialog is dismissed.

5. If clicked "Apply", the calculated frequencies, NB EARFCN and band fill the
"f{MHz]", "f2[MHz]", "NB EARFCN" and "Band" columns of the channel accordingly.

Screenshot in the previous figure shows two frequencies scenario:

NB-IoT Frequency 1 = 2134.2925 MHz

NB-IoT Frequency 2 = 234.3075 MHz --- means that the second frequency is not avail-
able with NB EARFCN = 244

If two frequencies, say fa and fb where fb > fa, are available, they must satisfy the con-
dition fb - fa = 15 kHz.

Both frequencies are sent to the scanner. The scanner detects and tries both and use
the correct one.

The correct frequency is observed during measuring and replay in BCH tree view and
Top N pool center frequency signal and list.

Both frequencies are also reported in the measurement file system info box as shown
in the following list. You can highlight the measurement file to see the system informa-
tion. If secondary frequency is not configured, the Center Frequency2 is displayed.

Count of all measured channels:    2
Selected Channels:
    Channel Name:        NB-IoT Channel 1
    LTE Band:            Band 1 (FDD)
    NB EARFCN:            53
    Center Frequency:        2115292.5 kHz
    M[DL]:                -1.0    (Informative only)
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    Center Frequency2:    2115307.5 kHz
    M[DL] 2:                1.0    (Informative only)
    Mode:                 NB Guard Band
    max. Delay Speed:        4 µs
    max. Speed:            100 Km/h

    Rate per second:        10.0
    BCH Demod:        MIB(Rep: 1.000 s);SIB1(Rep: 1.000 s);SIB2(Rep: 1.000 s);
SIB3(Rep: 1.000 s);SIB4(Rep: 1.000 s);SIB5(Rep: 1.000 s);SIB14(Rep: 1.000 s);
SIB15(Rep: 1.000 s);SIB16(Rep: 1.000 s);SIB20(Rep: 1.000 s);SIB22(Rep: 1.000 s);

    Channel Name:        NB-IoT Channel 2
    LTE Band:            Band 1 (FDD)
    NB EARFCN:            167
    Center Frequency:        2126692.5 kHz
    M[DL]:                -1.0    (Informative only)
    Center Frequency2:    2126707.5 kHz
    M[DL] 2:                1.0    (Informative only)
    Mode:                 NB Guard Band
    max. Delay Speed:        4 µs
    max. Speed:            100 Km/h

    Rate per second:        10.0
    BCH Demod:            MIB;SIB1;SIB2;SIB4;SIB5;SIB14;SIB15;SIB16;SIB20;SIB22;

Stand alone mode

If "Mode" is "Stand Alone" and "Band" is other than "No 3GPP Band", the "f[MHz]",
"EARFCN" and "Band" column are editable. The "f2[MHz]" column is still read only.

Figure 6-312: NB-IoT scanner configuration dialog for stand-alone mode

If any of the f[MHz], EARFCN or band value changes, the other two are recalculated
accordingly.

For example, if you change the frequency the EARFCN and band is recalculated.

Frequency associated with unique band

If the entered frequency is associated with a valid NB EARFCN, which is unique and
the NB-IoT supports it, the new frequency is accepted. The calculated NB EARFCN,
Band NB EARFCN and Band are applied.
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Frequency associated with multiple bands

If the entered frequency is valid and supports NB-IoT, but is associated with multiple
bands, then the bands helper dialog is displayed. For example, Band 1 and Band 4
share the starting frequency.

Select an entry from the list and click "Apply" to accept it. The selected Band and NB
EARFCN is inserted in the associated grid columns. If you click "Cancel", the first
choice of the list is applied.

Invalid frequency

If the new frequency does not support NB-IoT or is invalid, NB EARFCN column shows
"---", and band is set to "No 3GPP Band".

Figure 6-313: Invalid frequency case (3433 MHz)

No 3GPP band mode

The "Band" column has a special value "No 3GPP Band". If you select or set this
value, the columns "f[MHz]", "EARFCN" can be manually changed without validation or
recalculation.

Figure 6-314: No 3GPP band mode

Enabling dynamic PDU change

1. Click the "Advanced" column.

The drop-down box shows the "<Open>" entry.

2. Click "<Open>".

The "Advanced channel settings" dialog shows-up.

You can select dynamic PDUs by checking the associated check-boxes in the dia-
log.
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Figure 6-315: NB-IoT Scanner - dynamic PDU settings

If the BCH demodulation list does not contain all the selected PDUs (MIB/SIBs), you
will be asked to enable them via the dialog shown in the next figure.

Click "Yes" to enable the settings of SIBs/MIB in BCH demodulation list.

Automatic channel detection for NB-IoT

The active LTE ACD activates always automatically the all active NB-IoT ACD bands
for the ACD. Thus, for each band which is activated in the NB-IoT ACD, the LTE ACD
performs also an ACD search and reports the results, see Figure 4-38.

If misconfigured ACD, R&S ROMES4 does not start the measurements as it checks
the configuration at the start of it.

The NB-IoT ACD supports all three NB-IoT modes and searches for In-Band, NB
Guard band and Standalone channels.
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Figure 6-316: NB-IoT ACD configuration page

To set up an ACD measurement, it is recommended to use the ACD Wizard. Using the
Wizard ensures that the LTE ACD is configured accordingly. The LTE ACD searches
always for all three NB-IoT modes. If necessary, the modes can be adapted in the NB-
IoT scanner's "Automatic Channel Detection (ACD)" configuration dialog. The found
channel is visualized in the "ACD View" as an orange rectangle.

It is possible to distribute the NB-IoT channels to different frontends. The demodulator
uses the same frontend as the scanner.

Advanced configuration

The "Advanced" button is used to make advanced configuration. Click the button to
open the "Advanced Configuration" page.

The page contains the "Advanced General Parameters" and "BCH Demodulator" tabs.

The "Advanced General Parameters" tab lets you configure the following:

● "max. Delay Speed"
The time difference of a signal arrival via different paths.

● "max. Speed"
The maximum mobile speed that can be expected during the drive
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Figure 6-317: Advanced General Parameters page

Click the "BCH Demodulation" tab to open the page where you can configure the
requested minimum NB-IoT SINR signal for demodulation. The valid range is 15 [dB] to
50 [dB]. Set the requested value in "Min SINR of NB-IoT signal, which shall be
demodulated [dB]".

Figure 6-318: BCH Demodulation page

6.4.18  GSM network scanner

The R&S TSME and R&S TSME6 scanner device, controlled by the R&S ROMES4
GSM network scanner (NWS) driver, measure and identify all the GSM downlink radio
signals.
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For this purpose, the following hardware options can be used:
● R&S TSME with the R&S TSME-K23 option
● R&S TSME6 with the R&S TSME6-K23 option

The drivers are available with the option:
● R&S ROMES4T1E for the R&S TSME
● R&S ROMES4T1E6 for the R&S TSME6

However, the following descriptions of menu structure are identical for both drivers, if
not mentioned otherwise.

Installation of the driver is explained in Chapter 6.1, "Devices", on page 1447.

The devices configuration is explained in the following.

The GSM NWS data can be viewed in Chapter 4.8.5, "GSM scanner views",
on page 1179.

6.4.18.1  Resources configuration GSM NWS

Figure 6-319: Hardware Configuration window
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To load the GSM NWS-supporting device, select the "Network Scanner TSME" >
"TSME GSM" branch of the "Hardware Configuration" > "Available Devices" pane, see
Figure 6-40. Duble-click the selection.

The R&S TSME device is loaded with the R&S ROMES4 GSM NWS driver and dis-
played in the "Loaded Devices" pane. Specify the serial number, IP address and the
bands for measurement for the loaded device in "R&S GSM Scanner(<variable>):
Select Device". Click the "Connect" button to confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The loaded device is now added as the command line to the "Hardware" menu. Click
the command line to open the GSM NWS device configuration page.

Figure 6-320: Loaded GSM NWS device

The dialogs of a device chooser open when the R&S TSME driver is loaded. The
device chooser dialog is used to select the test device and define the essential connec-
tion parameters, if necessary.

For details about the loader's dialog, see Chapter 6.1.11.1, "R&S TSME network scan-
ner", on page 1488.

The "R&S <variable>: Select Device" dialog is used to share the test device resources
between all loaded R&S TSME hardware drivers. Furthermore, over the dialog the IP
address of a device can be selected, if necessary.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.
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Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.

6.4.18.2  Configuration menu GSM NWS

R&S ROMES4 provides a configuration page for the GSM NWS driver when you click
the "RS GSM NWS [<variable>]" command line in the "Hardware" menu. The com-
mand line is available when the driver is loaded.

The variable is an integer number indicating the number of connected devices.

The R&S ROMES4 GSM NWS opening configuration page contains several tabs hav-
ing different functions. The "Channels" opening page lets you select the channels for
measurement. The page contains tabs used to select the synchronization mode, con-
figure the time slot and channel power measurement. The tabs "Info" and "Templates"
are technology independent. They display information on the test receiver version and
store the settings to a template, respectively.

6.4.18.3  Setup GSM NWS

In the "R&S GSM NWS" > "Channels" page you can configure the following:

● Channels to be scanned
● Scanning rate
● Frontend for scanner and demodulator, if available.

The "R&S GSM NWS" > "Channel" page differs dependent on used scanner type as
shown in the following figures.
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Figure 6-321: R&S GSM NWS configuration – Setup GSM NWS (R&S TSME)
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Figure 6-322: R&S GSM NWS configuration – Setup GSM NWS (R&S TSME6)

Network
You can select the GSM band or a combination of bands for scanning in the "Network"
pane. The GSM channel numbers (ARFCNs) for the selected bands are displayed in
"Valid Channels".
For an overview of GSM bands, channels and frequencies refer to Chapter 12.8.1,
"GSM channel bands and power classes", on page 2395.
The GSM ER band is supported by R&S ROMES4 and included in the BTS database.
The band has been added to all GSM 900 band definitions and also is added as a
standalone. The band extension adds 15 channels (ARFCN 940…954) to the GSM R
band.

Figure 6-323: Selection of GSM band
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Transmitter Scan
● "Scanned Channels"

Allows selection of the scanned channels within the selected GSM bands. The
channels are scanned periodically with the measurement rate selected below. A
warning "The channel list is invalid" indicates that one or more channels do not
belong to any of the selected GSM bands.

● "Currently loaded GSM database"
Allows the used channels to extract from a database and transfer the list of chan-
nels to the "Scanned Channels" list. The file path of the current database is shown
and the two buttons are available:
– "Get channels from current database"

Copy the channels of the current database into the "Scanned Channels" list.
– "Load and get channels from other database"

Load another GSM transmitter database and copy the channels into the "Scan-
ned Channels" list. The benefit of the function is to optimize the scanning by
skipping the channels of the GSM bands which are not used by the provider.
The same function was already available in the GSM NWS wizard.

Scan Parameters
● "Average measurement rate…"

Number of GSM channels measured per second. The average measurement rate
of R&S TSME is up to 800 channels per second.
A lower measurement rate limits the size of the measurement file. If the system
performance is not sufficient, the R&S ROMES4 reduces the amount of evaluated
data by discarding part of the results acquired by the scanners.

● "C/I measurements ON for DL channels"
If checked, the C/I measurement is performed for all identified stations on the
downlink channels. Caused by measuring more information, the data volume and
the CPU load increase. The measurement is performed on the ETS part of the
SCH burst. The function is active by default.

● "Dummy Burst Filtering..."
This option activates a preprocessing step in the GSM NWS software which
detects the dummy bursts in a GSM signal. The option also subtracts the dummy
bursts from the signal before further processing. Handle with the care as this addi-
tional processing uses the CPU cycles.
The benefit of the dummy burst filtering is increased sensitivity for measuring trans-
mitters which work on the same channel (reused channel).
After filtering, the remaining signal shows more clearly the SCH bursts that can be
then demodulated and processed. Also the chance to demodulate successfully the
System Information types on the BCH increases.

Scanner/Demodulator
The options allow frontend selection for scanner and demodulator if available.
Only valid frequency ranges are listed in the "Channels" > "Scanner"/"Demodulator"
drop-down lists for the selected frontend. Click the drop-down box to get the list of
available frontends.
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Figure 6-324: List of available frontends

The "R&S GSM NWS" > "Channels" page has in the "Scanner"/"Demodulator" pane in
addition the "Preselection" option, see Figure 6-322.
The option offers three choices of frontend selection: "Auto", "On" and "Off".

6.4.18.4  BCH demodulation

The "BCH Demodulation" allows the settings for GSM BCH demodulation. The GSM
NWS driver can be configured to demodulate the GSM BCCH channels (normal and
extended) by specifying the System Information types to be decoded. The results of
this measurement can be displayed in the GSM NWS BCH View.

Figure 6-325: GSM NWS configuration – BCH demodulation

Select System Information
The "Select System Information types to be demodulated from the BCCH" panel offers
to check demodulation of specific SITs. System Information Type 3 is always demodu-
lated and is switched on by default.
● "Select all SI types"

Checks all System Information Types.
● "Select no SI types"

Removes all checks for the System Information Types.
● "Limit the demodulation to a specific network"

Demodulation of the checked SI types can be restricted by MCC and/or MNC.

Test devices



Hardware ComponentsDrive Test Software

1783Operating Manual 1171.6415.12 ─ 66

If the "Demodulation is limited to:" box is checked, the given MCC and MNC are
compared to the information in the SI type 3 and only if there is a match the
demodulation of the other SI types is done. If either MCC or MNC is left empty, it is
not included in the comparison. This approach can be used, for example, to select
only a specific country code.
The SI type 3 must be always demodulated to identify the GSM stations. Needed
demodulation is also indicated by the SI type 3 check box, which cannot be
unchecked.

Demodulation Timeout
After identification of a new station by demodulation of the SI type 3, all the other
checked SI types will be requested and demodulation will be performed with a timeout.
● "Demodulation Timeout"

Steps of 100ms, range 0 … 18000

BCH Demodulation settings
● "Max. Total Power offset for BCH Demodulation"

BTSs are monitored by SCH measurements. Each SCH measurement has a total
power offset from the CIR main power. If the power offset is high, the demodulation
probability drops. The limitation is given by the max. total power offset. BTS mea-
sured with a higher total power offset is not demodulated.
Range: 0 dB to 20 dB

6.4.18.5  Dynamic PDU settings

The "Dynamic PDU Settings" allows dynamic PDUs handling by selecting the SI types
for measurement with a repetition interval to record their changes over time, see
"Implementation of the dynamic PDU handling" on page 284.

Figure 6-326: GSM NWS configuration – PDU settings
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If the "Dynamic" check box is ticked, the checked PDUs in the list are measured with
the repetition interval specified in "Interval".

Click "OK" to add the settings to the selected channel and return to "GSM NWS Con-
figuration".

Click "Cancel" to discard made changes and return to "GSM NWS Configuration".

The default value for interval is 1 second. The possible range depends on the selected
GSM scanner driver and is checked, see "Advanced - Open" on page 1796.

6.4.18.6  Time slot and channel power measurement

The "Time Slot and Channel Power Measurement" tab allows a new time slot and
channel power of the GSM network to configure. The function is available with the R&S
ROMES4COI option.

The measurements can generate a high data volume. It depends on the count of chan-
nels which are configured for measurement and on the "Results per GSM slot" setting.
Set the parameters with care.

Figure 6-327: GSM NWS configuration – time slot and channel power measurement

Power Types to be Measured
Defines the measured power types.
● "TSC (Training Sequence Code) Power"

The power of GSM bursts which have a Training Sequence Code. The bursts on
the traffics channels and also the bursts on the broadcast channel which are used
for System Information broadcast.
The exact timing and the TSC (0...7) are measured in addition to the power. The
TSC of a BTS has the same code as the BTS's BCC and can be used to identify
the station which transmits the GSM bursts.
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(This function is only available for computers with processor with SSE2 unit, e.g.
Pentium 4.)

● "DB (Dummy Burst) Power"
The power of dummy bursts which can be measured on the broadcast channels of
stations.
Besides the power, the exact timing is measured. This measurement can be used
to identify the station which transmitted the dummy bursts.

● "Channel Power"
The inband power on the channel as sequence of power values with a fine resolu-
tion over time. Each sequence has duration of about 50 ms and covers at least 11
GSM frames. The resolution and the averaging of the values can be configured in
the lower section of the configuration page.

Channel Selection
The first part of "Channel selection" defines which channels are used for time slots or
channel power measurements.
● None
● "The same channels as Transmitter Scan", default
● "The same channels as Transmitter Scan plus additional channels"
● Only the channels from user-defined list
● "For each channel number measure"

Select from the above selected channels the desired types for the time slots or
channel power measurement.
Note:
Since no dummy bursts are expected on UL channels, no dummy bursts measure-
ment is done on UL channels.

● "DL Channel"
If activated, downlink channels are measured.

● "UL Channel"
If activated, uplink channels are measured.

● "Adjacent Channels"
The measurement of adjacent channels is by default off. If activated, adjacent
channels are measured.

Channel Power Measurement Details
● "Results per GSM Slot"

Range: 1 to 50. Default value is 16.
● "Averaging Interval"

Range: 6.4 us to 577.0 us. Default value is 32 us.

6.4.18.7  R&S TSME GSM NWS

The "Scanner" displays the properties of the R&S TSME device and information on the
file version of the GSM NWS driver.

The dialogs of a device chooser open when the R&S TSME driver is loaded. The
device chooser dialog is used to select the test device and define the essential connec-
tion parameters, if necessary.
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For details about the loader's dialog, see Chapter 6.1.11.1, "R&S TSME network scan-
ner", on page 1488.

The "R&S <variable>: Select Device" dialog is used to share the test device resources
between all loaded R&S TSME hardware drivers. Furthermore, over the dialog the IP
address of a device can be selected, if necessary.

6.4.18.8  Templates GSM NWS

The "Templates" page lets you store the current driver configuration as a template, to
edit, load or delete the driver templates.

Figure 6-328: R&S GSM NWS - Templates
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If a driver is loaded via "Hardware" > "Connect/Disconnect", R&S ROMES4 checks
whether the device template is stored in the Driver Template directory and its subdirec-
tories. The driver can be loaded with default settings or with the settings stored in any
of the found templates.

Figure 6-329: Selecting template

6.4.18.9  Information GSM NWS

The "Info" page displays some general information.

Figure 6-330: R&S GSM NWS - Info
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6.4.19  UMTS PN scanner

The R&S ROMES4 UMTS Pseudo Noise Scanner (PNS) drivers control the R&S
TSME or R&S TSME6 network scanner to alternate between UMTS PN scans and a
spectrum analysis.

Also multiple UMTS PNS scanners can be used for measurement if so configured in
"Hardware" > "Hardware Configuration".

For this purpose, the following hardware options can be used:
● R&S TSME with the R&S TSME-K21 option
● R&S TSME6 with the R&S TSME6-K21 option

The drivers are available with the option:
● R&S ROMES4T1E for R&S TSME
● R&S ROMES4T1E6 for R&S TSME6

Installation of the drivers is explained in chapter Chapter 6.1, "Devices", on page 1447.

Devices configuration is explained in the following text.

The UMTS PN data can be viewed in the "UMTS PNS Views", see Chapter 3.3.17.8,
"UMTS scanner views", on page 187).

Some measurement examples using the UMTS PN scanner are outlined in Chap-
ter 2.2, "Measurement examples", on page 72.

6.4.19.1  Resources configuration UMTS PNS

The R&S TSME devices can run as UMTS PNS devices if loaded with R&S ROMES4
UMTS scanner driver.

Click "Hardware" > "Connect/Disconnect" entry. The "Hardware Configuration" page
pops-up.

To load the R&S ROMES4 UMTS PNS driver, double-click the selected "Network
Scanner TSME" > "TSME WCDMA" entry in the "Available Devices" pane, see Fig-
ure 6-40.

The device is loaded and visible in the "Loaded Devices" pane of the page. Specify the
serial number, IP address and the bands for measurement for the loaded device in
"R&S UMTS PNS Scanner(<variable>): Select Device". Click the "Connect" button to
confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The device is now added as a command line to the "Hardware" menu.
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Figure 6-331: Accessing the UMTS PNS driver configurations

The dialogs of a device chooser open when the R&S TSME driver is loaded. The
device chooser dialog is used to select the test device and define the essential connec-
tion parameters, if necessary.

For details about the loader's dialog, see Chapter 6.1.11.1, "R&S TSME network scan-
ner", on page 1488.

The "R&S <variable>: Select Device" dialog is used to share the test device resources
between all loaded R&S TSME hardware drivers. Furthermore, over the dialog the IP
address of a device can be selected, if necessary.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.
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6.4.19.2  Configuration menus UMTS PNS

R&S ROMES4 provides a configuration menu for the UMTS PNS driver that pops-up if
you double-click the "R&S UMTS PNS[<variable>]" command line in the "Hardware"
menu.

The variable is an integer number indicating the number of connected devices.

The UMTS PNS driver's opening "Scanner Configuration" configuration page lets you
configure the scanner by defining the "Channels" parameters. The page shows addi-
tional tabs: "Scanner" used to identity the connected driver, "Info" and "Templates". The
last two tabs open the pages which show the information on the driver's file versions
and the load, respectively.

● Receiver settings UMTS PNS.............................................................................1790
● Measurements UMTS PNS.................................................................................1801
● BCH demodulation UMTS PNS.......................................................................... 1804
● UMTS scanner.................................................................................................... 1804
● Templates UMTS PNS........................................................................................ 1804
● Information UMTS PNS.......................................................................................1805

Receiver settings UMTS PNS

The "R&S UMTS PNS[<variable>]" page of the R&S TSME driver displays the chan-
nels which you want to scan.

Figure 6-332: UMTS scanner configuration

Channels scanning
The following configurations are possible in the displayed "Channels" pane of the "R&S
UMTS PNS" > "Scanner Configuration" page:
● Activate/Deactivate the scanning of a selected channel by checking the

"Enabled"/"Disabled" checkboxes.
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Figure 6-333: UMTS channel configuration options

● Set the virtual channel option by selecting "Virtual" instead.

Figure 6-334: Virtual channel option - test device selected

● Select of the frontend for a channel, in the "FE" drop-down entry which shows the
available frontends. Different channels can select different frontends.

Figure 6-335: Selection of a frontend

Instead of defining a certain UARFCN, the R&S ROMES4 driver can be selected with
the Virtual Channel feature, which dynamically configures the scanner. In dual network,
it is useful to follow the UE configured to use the second cell.
Automatic channel detection (ACD) is supported with the Virtual Channel feature. This
feature lets you use the scanner without knowing specific frequency of the UMTS net-
work. Only the UMTS bands on which the specified UARFCNs are supposed to be
located have to be entered. These bands are typically known from the spectrum alloca-
tion plan of the regulator. The UMTS scanner of the R&S TSME automatically detects
the channels in this case.
If you choose "Virtual", the "f[MHz]", "UARFCN" and "Band" columns in the table disap-
pear. Instead, a combo box appears which offers the all possible sources for the virtual
channel. You can select between a test device and the ACD, as shown in the following
figure.
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Figure 6-336: Virtual channel option - ACD selected

By default the ACD searches the UMTS band I. If a UMTS channel was detected, the
settings concerning the BCH-demodulation, measurement rates and advanced settings
of the virtual channel are applied to the detected channel.
For the ACD configuration, see "UMTS Automatic Channel Detection" on page 1798.
Note: The "Virtual" option is only available if at least one device driver which can com-
mand the scanner is loaded. For the UMTS scanner, currently only the Qualcomm
driver can do that.
The primary device can add and release physical channels during the measurement. It
can be useful to ignore the release command.
For example, if a UMTS device adds a second UARFCN, the second channel is scan-
ned automatically. In the case that UARFCN is to be released, the UE releases also
the channel in the UMTS scanner. If you want to scan the second UARFCN always,
regardless if the UE uses it or not, the release commands can be ignored, see
"Receiver settings UMTS PNS" on page 1790. In this case the scanner scans the sec-
ond UARFCN from the point in time when the UE adds this UARFCN for the first time.
For each enabled channel the following is configurable:
● "Name"

Name for the channel, for example, the provider's name.
● "f[MHz]"

Carrier center frequency of the channel.
● "UARFCN"

UTRA Absolute Radio Frequency Channel Number.
● "Band"

UTRA operating band.
● "BCH-Demodulation"

SIB type to be demodulated and decoded from the UMTS BCH.
● "Advanced"

Advanced, channel-specific settings.
The UMTS PNS driver depends on a selected type of test receiver (R&S TSME).
The test receiver is selected during a driver installation in "Hardware Configuration" >
"Available Devices", refer to Chapter 6.1.11.1, "R&S TSME network scanner",
on page 1488.
The "R&S UMTS PNS" dialog is used to configure settings for the UMTS PNS driver
and to display them. The modifications of the settings are done directly from the chan-
nel list of the dialog.
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Figure 6-337: Modify provider name

Figure 6-338: Modify frequency name

f [MHz]/UARFCN/Band
The "f", "UARFCN" and "Band" combo boxes display a selection of predefined chan-
nels to be measured. It is possible to select frequencies of the nominal UMTS downlink
band. However, all frequencies must be in multiples of 0.2 MHz, corresponding to
specified UARFCNs.
The WCDMA-related channel frequencies are in the nominal UMTS downlink band,
depending on the WCDMA band (3GPP TS 25 101 V12.2.0), see also Table 12-18 and
Table 12-19.
The channel frequency can be also defined freely from the range 80 MHz to 3000
MHz. The channel frequencies differ by the UMTS carrier spacing of 5 MHz.
The measured frequencies can be selected in the measurement range of the used test
device.
Table 6-18: All WCDMA Bands (I – XXVI) and free configurable measurements

WCDMA Band Uplink (MHz) (Spectrum) Downlink (MHz) (Spectrum)

I 1920 - 1980 2110 -2170

II 1850 -1910 1930 -1990

III 1710-1785 1805-1880

IV 1710-1755 2110-2155
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WCDMA Band Uplink (MHz) (Spectrum) Downlink (MHz) (Spectrum)

V 824 – 849 869-894

VI 830-840 875-885

VII 2500 - 2570 2620 - 2690

VIII 880 - 915 925 - 960

IX 1749.9 - 1784.9 1844.9 - 1879.9

X 1710-1770 2110-2170

XI 1427.9 - 1452.9 1475.9 - 1500.9

XII 698 - 716 728 - 746

XIII 777 - 787 746 - 756

XIV 788 - 798 758 - 768

XV Reserved Reserved

XVI Reserved Reserved

XVII Reserved Reserved

XVIII Reserved Reserved

XIX 830 – 845 875 -890

XX 832 – 862 791 – 821

XXI 1447,9 – 1462.9 1495,9 – 1510,9

XXII 3410 – 3490 3510 – 3590

XXV 1850 – 1915 1930 – 1995

XXVI 814 – 849 859 – 894

Band and frequency selection dialog ← f [MHz]/UARFCN/Band
If the user selects a new band which does not match the current frequency band and
the UARFCN, the "Specify RF Configuration" window pops-up forcing the selection of
the proper frequency or UARFCN for the selected band.
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Figure 6-339: Band and frequency selection

This dialog provides list of all existing combinations of the channel numbers and fre-
quencies for selected band. If you select one combination and click "OK", selected pair
of values is inserted to the appropriate cells of the main scanner interface window. If
you click "Cancel", the band value does not change.
Note: The number of channels which can be measured at the same time by the UMTS
PN Scanner is limited.
R&S TSME: max. 32 UARFCN

BCH-Demodulation
Shows the System Information Blocks (SIB) to be demodulated and decoded from the
UMTS Broadcast Channel (BCH). Modification of this type of measurement for a
selected channel is also made here. The complete range of available SIBs have been
added to the BCH-Demodulation combo box.
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Figure 6-340: BCH-Demodulation combo box - SIB type selection

BCH decoding is performance critical, therefore it is recommended to restrict the selec-
tion to the SIBs of interest.
SIB type 3 is enabled by default for a new channel.
If disabled, selecting any other SIB type automatically activates SIB 3 because it con-
tains MCC, MNC and CI which is fundamental for any deeper analysis of SIB content.
SIB 1 contains the LAC which is another important information.
SIB 11 contains the neighbor list.
SIB 1, SIB 3 and SIB 11 are necessary (and sufficient) for the UMTS neighborhood
analysis (the option R&S ROMES4HOA is needed).
Note: The SIB contents is displayed in the "UMTS Scanner BCH View", see Chap-
ter 4.8.11.2, "UMTS scanner BCH view", on page 1377.

Advanced - Open
Click "Advanced" >"Open". The "Advanced channel settings" window opens. Here you
can select measurement settings for each configured channel separately.
The possible advanced channel settings are:
● "UL Interference"

This option provides the measurement of uplink interference with configurable
sampling rate. The fastest possible rate is 1/100 ms.
UL interference measurement requires decoding of SIB type 7 which is enabled
automatically.
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Figure 6-341: UMTS Scanner - UL interference

The value can be observed in the "PNS TopN View" and in the views using the
general parameter tree like the "Alphanumeric view" or the "2D Chart View".

● "Dynamic PDU Settings"
This option provides settings for dynamic PDUs handling.
All the PDUs of the selected channels which can be requested for measurement
are shown in the list.

Figure 6-342: Dynamic PDU settings

In the configuration page you can select dynamic PDUs. For dynamic PDUs, refer
to "Implementation of the dynamic PDU handling" on page 284.
The page is obtained in the same way for all the R&S ROMES4 supported technol-
ogies, except for GSM, where it is directly accessible.
If the "Dynamic" check box is ticked, the PDU is requested for measurement with
the repetition interval specified in the "Interval" column.
To add the settings to the selected channel and return to the "R&S UMTS PNS"
dialog, click "OK".
To discard made changes and return to the "R&S UMTS PNS" dialog, click "Can-
cel".
To go through the list, click "Previous" or "Next".
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The default value for interval is 1 second. The possible range depends on the
scanner driver for the technology and is checked. The message in the following fig-
ure is the interval check message for UMTS.

UMTS PNS buttons
The main "R&S UMTS PNS" page contains the following buttons in the pane area.
● "Add"

Adds a new channel frequency to the table and configures the BCH-demodulation.
For BCH-demodulation, see "BCH demodulation UMTS PNS" on page 1804.

● "Remove"
Removes a selected entry from the list. The button is available only if at least one
channel in the table is highlighted.

● "Clone"
Makes a copy of all highlighted channels. Automatically sets the “checked” status
for the channels and assigns name by adding the word “copy” to the original chan-
nel names. The button is available only if at least one channel in the table is high-
lighted.

● "Channel Scan Rate Configuration"
Supports the configuration of the channel scan rate.

● "Automatic Channel Detection (ACD)"
Supports the adaptation of the default ADC configuration.

● "Advanced"
Supports common, frequency-independent settings of scanner. Click the button to
get the "Advanced settings" page which contains the "Measurements" and "BCH-
Demodulation" configuration tabs.

Channel Scan Rate Configuration
The Channel Scan Rate function for UMTS is supported with the R&S TSME driver.
For details, see Chapter 6.1.11, "Test devices", on page 1487.

UMTS Automatic Channel Detection
To activate the default ACD configuration for a certain UMTS band or adapt it, press
the "Automatic Channel Detection" button in the "UMTS Scanner Configuration" page,
see Figure 6-332.
In the "Automatic Channel Detection" page you can set the following ADC parameters:
● Parameters that apply to all technologies in the "Automatic Channel Detection"

pane.
● UMTS-specific parameters in the "UMTS Automatic Channel Detection" pane.
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Figure 6-343: UMTS ACD configuration page

Automatic channel detection pane ← UMTS Automatic Channel Detection
The following parameters are configurable in the first mentioned pane:
● "Use Layer 3 Messages"

If selected, R&S ROMES4 reads out all neighbor lists of detected transmitters and
adds the detected neighbor cells' channels automatically to the system.

● "Create Template"
The template can be used to set up a new measurement with the found channels
which is not requested for the monitoring use case.
If selected, R&S ROMES4 creates a template for the scanner, which includes all
detected channels at the end of the measurement. The name of the template is the
name of the measurement file.

● "Auto Start of Scan"
This automatic approach has the sense during a drive test. It is not needed during
a monitoring use case as the monitoring aims to measure only actual “on air” trans-
mitters.

● "Sensitivity (UMTS, LTE, NB-IoT, 5GNR)"
For the listed technologies, the sensitivity allows user to fine-tune the setup for the
long term monitoring use cases, for details see Chapter 3.8.2.1, "Technologies",
on page 280.
Three different levels of the ACD sensitivity are available for power and quality
measurements. Depending on the requirements of the monitoring use case, you
can select the sensitivity level for transmitters detection between low, medium and
high.

● "Advanced"
If pressed, the "ACD Measurement Rate" page opens, where the user can set the
ACD priorities for different RATs, see Figure 6-344.
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The ACD feature tries to achieve the same measurement rates for all detected chan-
nels. However, R&S ROMES4 SW offers the user option to prioritize one RAT against
the other. This prioritization is achieved by adding to the technologies supporting ACD
(excluding TETRA) weighting factors. These factors then represent how higher mea-
surement rate for one technology has to be in comparison to the others.
For example, if LTE has to have the double measurement rate compared to other
RATs, set the LTE detected channels weight 2, and leave the weight 1 for the other
RATs' detected channels.
To set the weight, press the "Advanced" button in the ACD page. Set the prioritization
in the shown "ACD Measurement Rates" page.

Figure 6-344: Set ACD weighting factor

UMTS Automatic Channel Detection Pane ← UMTS Automatic Channel Detection
The "UMTS Automatic Channel Detection" pane contains all UMTS bands letting you
select those ones that you want to scan by checking combo boxes in "UMTS Bands to
scan".
The progress of the ACD configuration can be observed in the "Output View".

Use cases of Automatic Channel Detection ← UMTS Automatic Channel Detec-
tion
The main use case of the ACD is the measurement anywhere without any knowledge
of the used UARFCNs within the known UMTS bands.
Typically, you initiate a measurement with the ACD and use the resulting template as
starting point for the best measurement rates concerning the actual measurements.
If the detection of transmitters along a drive is the goal of the measurement, running
the ACD in smart mode is the best solution.
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The primary goal of the measurement is detection of cells and the speed of the mea-
surement on already detected cells. The second goal of the measurement with the
ACD is to increase the detected speed by reducing the measurement rate of the virtual
channel.

Measurements UMTS PNS

The "Measurements" configuration page allows the general measurement parameters
setting for the UMTS scan.

Figure 6-345: UMTS PNS configuration – Measurements tab of R&S TSME, High Speed mode

The highest real measurement rates can be expected with:
● UMTS synchronization
● All demodulation requests off
● Measuring only one channel

The R&S TSME "Measurements" page of UMTS scanner configuration offers the fol-
lowing:

Measurement Mode
Measurement modes are supported both by R&S TSME scanner.
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The controls in the "Measurement Mode" pane define how R&S ROMES4 processes
the baseband (I/Q) data for an UMTS PN scanner. The measurement mode has an
impact on the measurement speed, the dynamic range, the synchronization procedure
and the measured quantities, see description of the "UMTS PNS CPICH View" Chap-
ter 4.8.11.3, "UMTS scanner CPICH view", on page 1383.
The drop-down box in this pane offers the following measurement modes:
● "High Speed"

The analysis is based on a limited amount of data and optimized for fast evalua-
tion.

● "High Dynamic"
It provides the refined analysis using a larger amount of data, slowing down the
measurement but increasing its dynamic range. The SC is determined by correla-
tion with the pilot bits of the CPICH. The Doppler offset value is available.

Advanced ← Measurement Mode
Click the "Measurement Mode" > "Advanced" button to open the dialog for advanced
settings.
The dialog provides the additional measurement setting "Performance", common for
the UMTS scanners.

Figure 6-346: R&S TSME Advanced Settings dialog

"Buffer Size" lets you define the time for which the raw measurement data is stored in
the R&S TSME if R&S ROMES4 is unable to process it immediately (for example, due
to temporary low performance of the controller). If the R&S ROMES4 buffer remains
blocked after the buffer size time expiry, the oldest data in the buffer is deleted and
overwritten by a new data.
Data transfer starts when R&S ROMES4 is again ready to receive and process data.
A large buffer size increases the probability that no measurement data is lost, even
though R&S ROMES4 can be blocked for an extended time. However, storage and
transfer of large amounts of buffer data increase the possible delay between data
recording and evaluation/display in the views.
The synchronization source is selected in this case automatically for the scanner types
R&S TSME.
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Measurement Rate ← Measurement Mode
Number of PN scans per second is shown in the following:

The actual measurement time is shorter than the maximum rate for all provided test
device settings so that even a large measurement rate never covers the spectrum
measurement completely.

Synchronization
The two input fields in the "Synchronization" pane define how often the system syn-
chronizes to the received UMTS PN signals and updates the measurement file:
● Sync. Rate

Number of synchronization processes per received channel and per second. A low
synchronization rate improves the system performance, especially if R&S ROMES4
receives many channels. The risk of the low synchronization rate is missing the
NodeB signals that are only received for a short time.

● P-SCH Display Rate
Rate by which the data for the "PNS P-SCH View" is stored to the measurement
file and the view itself is updated. The P-SCH data is always acquired during syn-
chronization so that the update rate must be smaller or equal to the "Synchroniza-
tion Rate". A smaller update rate has no impact on the measurement but can con-
siderably reduce the size of the measurement file.

NodeB hold time
The "NodeB hold time" > "Max.NodeB hold time" option is added to UMTS scanner
configuration and to the *.rscmd file info.

The option gives the scanner a limit for the time that it remembers an already mea-
sured NodeB (channel, SC, SCId). If a NodeB defined by channel, SC and SCId were
not received for the here specified time, these parameters are not used anymore. This
case causes a restart of the all demodulation requests for this NodeB.
Range: 15 s to 1 day (default 300s)
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BCH demodulation UMTS PNS

If selecting the "BCH-Demodulation" tab, the page opens where users can set the
Ec/Io threshold for frequency-independent BCH demodulation. The page is identical for
all R&S scanner types.

Figure 6-347: UMTS PNS configuration – BCH demodulation tab of R&S TSME

The system resources reserved for BCH demodulation are restricted by:
● Threshold

Defines a minimum signal strength Ec/Io for BCH demodulation. Only signals
above this threshold are decoded.

UMTS scanner

The "Scanner" tab opens the window which displays the properties of the R&S TSME
device and information on the file version of the R&S ROMES4 UMTS PNS driver.

This "Scanner" window is identical for all technologies.

Templates UMTS PNS

The "Templates" tab stores the current driver configuration as a template, lists, loads or
deletes driver templates.

Figure 6-348: UMTS PNS configuration – templates
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If a driver is loaded via the "Hardware" > "Connect/Disconnect" command, R&S
ROMES4 checks whether a driver template is stored in the Driver Templates directory
and its subdirectories. The driver can be loaded with default settings or with the set-
tings stored in any of the found templates.

Figure 6-349: Selecting template

Information UMTS PNS

The "Info" tab displays information on the file version of the R&S ROMES4 UMTS PNS
driver.

It is identical for all R&S ROMES4 UMTS PNS drivers.

Figure 6-350: UMTS PNS configuration – info
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6.4.20  CDMA2000 1xEVDO pseudo noise scanner (PNS)

The R&S TSME network scanner device controlled by the TSME cdma2000®1xEVDO
driver performs the CDMA2000 and 1xEVDO Pseudo Noise (PN) scan. In a
CDMA2000 and 1xEVDO PN scan, the test device measures and identifies all
CDMA2000®1xEVDO downlink (BTS) radio signals.

The hardware options supported are the R&S TSME-K22 for CDMA2000 and the R&S
TSME-K24 option for 1xEVDO. The drivers are available with the R&S ROMES4T1E.

For the device installation, see Chapter 6.1, "Devices", on page 1447.

The following section describes the CDMA2000® 1xEVDO PNS device configuration.

For the CDMA2000®1xEVDO PNS scanned and evaluated data, see Chap-
ter 3.3.17.2, "CDMA2000/1xEV-DO scanner views", on page 183.

6.4.20.1  Resources configuration CDMA2000 1xEVDO PNS

Double-click the selected "Available Devices" > "Network Scanner TSME" > "TSME
cdma2000(R) 1x EVDO PNS" branch in the "Hardware" > "Connect/Disconnect" >
"Hardware Configuration" window to load the R&S TSME CDMA2000 1xEV-DO PNS
device. See Figure 6-40.

The device is loaded and displayed in "Loaded Devices" pane of the window. Specify
the serial number, IP address and the bands for measurement for the loaded device in
"R&S CDMA2000 1xEV-DO PNS(<variable>): Select Device". Click the "Connect" but-
ton to confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

Figure 6-351: Accessing the CDMA PNS device configurations

The variable in the bracket is the name or number of connected devices.

The device is now added as the line command to the "Hardware" menu.

Click the command line to open the "R&S CDMA2000 1xEV-DO PNS[1]" configuration
page.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.
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● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.

6.4.20.2  Configuration menus CDMA2000 1xEVDO PNS

R&S ROMES4 provides the configuration page for the RS TSME CDMA2000 1x EV-
DO PNS installed and loaded device if selecting the "RS CDMA2000 1x EV-DO PNS
[<variable>]" command line in the "Hardware" menu. The command line is available
when the driver has been loaded.

The CDMA2000 1x EV-DO PNS driver opening configuration page contains several
tabs. The opening "Scanner Configuration" page is dedicated to define channels you
want to measure. In the "Scanner" page you can identify the connected scanner. The
"Info" and "Templates" are common to all radio technologies and display information on
the file versions of the driver and store the current setting as a template, respectively.

● CDMA2000 1x EV-DO PNS scanner configuration.............................................1807
● Automatic channel detection (ACD)....................................................................1814
● Advanced settings...............................................................................................1817
● CDMA2000 1xEVDO PNS scanner.................................................................... 1822
● CDMA2000 1xEVDO PNS templates..................................................................1822
● CDMA2000 1xEV-DO PNS information.............................................................. 1822

CDMA2000 1x EV-DO PNS scanner configuration

The "R&S CDMA2000 1x EV-DO PNS [<variable>]" main page lets you configure
parameters of the channel you want to be measured. The parameters are the channel
name, frequency, channel number and band, type of messages to be demodulated
from the Broadcast Channel (BCH). The usage of the channel (cdma2000 1x/EVDO or
cdma2000 and 1xEVDO channels, separately) is also configurable in this page.
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Figure 6-352: CDMA2000 1xEV-DO PNS configuration for R&S TSME

The page allows you to define the same frequency twice if the entries have the
"Usage" parameter different, as shown in the following figure.

Figure 6-353: Same channel for CDMA and EVDO

The CDMA2000 and 1xEVDO measurements are allowed on the same channel.

The warning message for duplicated frequencies is shown:

Because of ambiguity of channel number and frequency combinations, the "R&S
CDMA2000 1xEV-DO PNS [Device name]" > "Channel" table does not provide auto-
matically frequency change when user changes channel number.

R&S ROMES4 CDMA2000 scanner driver allows the ATIM demodulation. If this PDU
has been demodulated, it is shown in the "CDMA2000/1xEv-DO Scanner BCH View".
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Scanner Configuration - Channels pane
The "Channels" pane displays configured CDMA2000/EV-DO channels for PN scan-
ning.
All channels visible in the pane's table are measured. You can modify the channels'
configuration by clicking the selected channel line. Drivers support all Spreading Rate
1 (SR 1) band classes 0 to 21 specified in standard 3GPP2 C.S0002. It is possible to
select frequencies of the nominal CDMA downlink bands.

Figure 6-354: Virtual channel option - ACD selected

The CDMA2000 1xEV-DO PNS scanner of R&S TSME supports the ACD with virtual
channels. This feature allows the scanner without any knowledge about used channels
to use. Only the 3GPP2 bands on which channels are supposed to be located have to
be entered. This support is known from the spectrum allocation plan by the regulator.
The CDMA2000 1xEV-DO PNS scanner of the R&S TSME automatically detects chan-
nels in this case.
By default, the ACD searches the 3GPP2 Band 1. If a CDMA/EVDO channel was
detected, the settings concerning demodulation, measurement rates and advanced
settings of the virtual channel is applied to the detected channel.
For the ACD configuration, see "Automatic channel detection (ACD)" on page 1814.
The following columns and buttons are the entries of this pane.

Name ← Scanner Configuration - Channels pane
An arbitrary, optional identification string for the selected frequency.

Frequency ← Scanner Configuration - Channels pane
The frequency calculated according to the selected "Band" and "Channel" values. "Out
of Band!" indicates that the frequency entered is an off-band frequency.

Channel ← Scanner Configuration - Channels pane
A channel number within the selected band. If an undefined channel number is speci-
fied, the frequency becomes invalid.
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Band ← Scanner Configuration - Channels pane
Selection of the SR 1 band class (0 to 21) with selected band.
Note: BC 20 and 21 is only for satellite reception.
For an overview of all CDMA2000 band classes, refer to the appendix Chapter 12.10,
"CDMA2000 band classes", on page 2411.

BCH Demodulation ← Scanner Configuration - Channels pane
Shows the BCH messages available for demodulation from Broadcast Channel (BCH).
The selection or modification of already selected messages for demodulation is done in
"BCH-Demodul" column. Click the "BCH-Demodulation" combo-box to get the com-
plete range of available messages.
The content of the BCH-Demodulation messages column depends on the selected
value in the "Usage" column.
The "BCH Demodulation" > "Quick Config" option contains all messages for both
CDMA2000 and EVDO channels.

Figure 6-355: BCH-Demodulation combo box contents

The Quick Config message for EVDO is checked by default so that the detected EVDO
channels are displayed in the "BCH View" automatically.

Usage ← Scanner Configuration - Channels pane
Displays the type of activated channel.
The "EVDO" value in the column indicates activated EVDO channels. This activation
disables the "PN Offset Configuration" block in the "Advanced Channel Settings", as
not needed for EVDO, see Figure 6-356.
If the ACD option is activated, both CDMA2000 and EVDO channels are displayed.
Note: Activation of the "Usage EV-DO Channel" defines channels as EVDO channels.
The deactivated option disables the PN Offset Configuration block which is not needed
for EVDO in "Advanced Channel Settings", see Figure 6-356.
To configure a 1xEVDO channel, in the column "Usage" EVDO has to be selected.

Advanced ← Scanner Configuration - Channels pane
Click the "Open" combo-box in the "Advanced" column to open the "Advanced channel
settings" dialog.
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There are two different "Advanced channel settings" dialogs dependent on channel
usage.
● CDMA
● EVDO
If CDMA channel is used, the dialog offers the advanced channel settings and dynamic
PDU settings. To do these settings, the corresponding tabs are present in the dialog.
The advanced channel settings provide the PN Offset Mask, see "Advanced Channel
Settings" on page 1812.
The dynamic PDU settings provide dynamic handling of the PDUs, see "Dynamic PDU
Settings" on page 1813.

Figure 6-356: Advanced channel settings dialog - CDMA channel usage

As for EVDO channels, only the dynamic PDU settings are possible, that means, only
the "Dynamic PDU Settings" tab is present.

Figure 6-357: Advanced channel settings dialog - EVDO channel usage
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Buttons ← Scanner Configuration - Channels pane
● "Add"

Opens a dialog for adding a new channel to the table of channels.
● "Remove"

Removes a selected channel from the list.
● "Clone"

Makes a copy of all highlighted channels, automatically sets the “checked” status
for it and assigns name by adding the word “copy” to the original channel name.
Note: The "Remove" and "Clone" buttons are available only if at least one channel
in the table is highlighted.

● "Automatic Channel Detection (ACD)"
The button opens the page where you can set the parameters for ACD and select
the bands you want to be scanned, see "Automatic channel detection (ACD)"
on page 1814.

● "Advanced"
Click the "Advanced" button to open the "Advanced settings" dialog.
The dialog lets you further open the "CDMA Measurements", "EVDO Measure-
ments" and "BCH-Demodulator" pages by clicking the corresponding tab. These
pages are related to common, the scanner frequency-independent settings, see
"Advanced settings" on page 1817.

Figure 6-358: Advanced settings - Advanced button

Advanced Channel Settings
Click the "Advanced Channel Settings" tab to get the "PN Offset Configuration" pane.
Different CDMA cells and cell sectors use the same short code, but different code's
phases, which is how the mobile differentiates them from each other. The phase is
known as the PN Offset and defines the offset of the PN sequence. Changing the PN
offset changes the timing of the pilot channel, the timing and contents of the sync
channel message and the long code mask of the paging channel.
Each square represents one unit of 64 PN chips. The squares can be selected either
manually (clicking a square toggles its value) or defined by entering values into the
"Bias" and "Step" entry fields. They are activated with the "Set" button.
● "PN Offset Configuration" table
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Shows the selected value for the PN Offset as configured (range from 0 to +511).
● "Clear"

Clears all unit squares in the PN Offset Configuration table.
● "Set All"

Sets all unit squares in the "PN Offset Configuration" table.
● "Bias"

The bias value sets the number of cleared unit squares at the beginning of the "PN
Offset Configuration" table. The change becomes active after "Set" is clicked.

● "Step"
The step value defines the interval of the set unit squares as a sequence. The
change becomes active after "Set" is clicked.

● "Set"
Activates the defined settings for "Bias" and "Step".

Note: The Bias=0 / Step=4 settings are shown only if the "Set" button is pressed.

Example: 
An example for a setup with a Bias=0 and a Step=4, resulting in a "PN Offset 21", is
shown in the following figure.

Figure 6-359: PN Offset configuration - example

Dynamic PDU Settings
As the broadcast messages demodulated by the scanner vary over time, the demodu-
lation and visualization of them is made dynamical. PDUs, like system parameters, are
configured for measurement with a repetition interval to record their changes over time.
The "cdma2000 1x EV-DO Scanner BCH View" displays the sets of cdma2000/1x EV-
DO PDU variants, see Chapter 4.8.4.2, "CDMA2000/1xEV-DO scanner BCH view",
on page 1168.
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Figure 6-360: Dynamic PDU Settings dialog - CDMA channel

This window enables dynamic PDUs to configure, refer to "Implementation of the
dynamic PDU handling" on page 284.
All the PDUs of the selected channel which can be requested for measurement are
shown in a list, see figure Figure 6-360.
If the "Dynamic" check box is ticked, the PDU is measured with the repetition interval
specified in "Interval".
Click "OK" to add the settings to the selected channel and return to the "R&S
CDMA2000/1x EV-DO PNS" configuration dialog.
Click "Cancel" to discard made changes and return to the "cdma2000/1x EV-DO PNS
Configuration" dialog.
Click "Previous" or "Next" to go through the list.
The default value for interval is 1 second. The possible range depends on the scanner
driver for the technology and is checked, see Dynamic PDU Settings.

Virtual Channels
You can activate scanning of a specific channel, deactivate channel scanning or allow
the scanner to follow other device by choosing the "Virtual Channel" option. The option
dynamically configures the scanner instead of entering a certain channel value for
scanning if primary R&S ROMES4 driver is selected.
Specify a measurement device as a source of the channels to be scanned instead of
specifying a specific channel. The source can be a test device or the R&S ROMES4
ACD functionality. Using a test device as a source, allows the scanner to follow the
channels the test device is using.
Note: For each network mode (cdma2000/1xEVDO), a separate virtual channel is nec-
essary. If you want to scan CDMA2000 and 1xEVDO channels, two virtual channels
have to be added. Configure one as CDMA2000, the other one as 1xEVDO channel.

Automatic channel detection (ACD)

The R&S ROMES4 ACD function uses the C2K/EVDO channel finder, like for other
RATs. The finder is a component which scans and finds channels fast for ACD.
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To adapt the default ACD configuration press the "Automatic Channel Detection
(ACD)" button in the "CDMA2000 1xEV-DO PNS" configuration page, see Fig-
ure 6-352.

The opened page lets you set the ADC parameters.

Figure 6-361: CDMA 1xEV-DO - automatic channel detection page

The "Automatic Channel Detection" pane holds the parameters which apply to all RAT.
The CDMA2000 1xEV-DO specific parameters are located in the "3GPP2 Automatic
Channel Detection" pane.

Click the corresponding check-box in the "Automatic Channel Detection" pane to
enable or disable the following functions:

● "Use Layer 3 Messages"
If selected, R&S ROMES4 reads out all neighbor lists of detected transmitters and
adds the detected neighbor cells' channels automatically to the system.

● "Create Templates"
If selected, R&S ROMES4 creates a template for the CDMA2000 1xEV-DO PN
scanner which includes all detected channels at the end of the measurement. The
name of the template is the name of the measurement file.

● "Auto Start of Scan"
The automatic scan approach has sense during a drive test but is not what is nee-
ded during a monitoring use case. The monitoring use case aims to measure only
actual “on air” transmitters.

The above settings are stored in a service that serves all technologies.

2. Click the "Advanced" button to set the measurement rates in the displayed dialog
which is common for different technologies.
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Figure 6-362: Default settings of ACD measurement rates

3. Now choose the bands from "3GPP2 Automatic Channel Detection" > "CDMA
Band", by clicking the corresponding check-boxes.

Clear the check-box to deselect bands. If all check-boxes are cleared, the ACD chan-
nel is removed when changes are accepted.

4. Click "OK" to accept settings.

The screenshot Figure 6-354 shows an ACD configuration with four selected bands.

The selected bands are shown in the "Channels" > "Frequency" column. The "Usage"
column shows "cdma/EVDO" and the "Name" column indicates virtual channel 1.

The main use case of the ACD is to let users start measuring anywhere without any
knowledge of the used channels within the known 3GPP2 bands.

Typically, users initiate a measurement with the ACD and for the best measurement
rates use the resulting template as starting point for the actual measurements.
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Existing CDMA2000 1xEV-DO workspaces and templates
The CDMA2000 1xEV-DO PNS workspaces of former releases can exist with multiple
virtual channels. Those channels share the selected bands, but can have different
"Usage": CDMA2000 or 1x EVDO channel type.
The virtual channel is shown as "cdma/EVDO" in "Usage" column if you open an exist-
ing old workspace or template which has only one virtual channel.
If the existing old workspace or template has multiple virtual channels, a warning mes-
sage is displayed.

Figure 6-363: Warning message for existing multiple virtual channels

If you press the "Try to fix the problems automatically" button, the system fixes the
problem and you get the information about it.

The problem fixing is done in a way that two original channels are merged into one vir-
tual channel having the same selected band and are shown as cdma/EVDO in the
"Usage" column.

Advanced settings

The "Advances settings" page opens when you click the "Advanced" button. The page
lets you configure the CDMA2000 and 1xEVDO measurements as well as the BCH
demodulator and antenna parameters.
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CDMA measurements

"cdma Measurements" lets you define general measurement settings for the R&S
CDMA2000 1xEVDO PNS.

Figure 6-364: CDMA PNS configuration – measurements tab of R&S TSME drivers

Measurement Configuration
The settings in the "Measurement Configuration" pane define how R&S ROMES4 pro-
cesses the baseband (I/Q) data for a CDMA PN scan.

Meas. Frequency ← Measurement Configuration
Defines the CDMA measurement frequency in Hz. The maximum scan rate for
CDMA2000 is 80 Hz.
It is possible to set different measurement frequency for CDMA2000 1xRTT and
1xEVDO.
Tip: To see statistical information on the CDMA2000 1xRTT measurement frequency,
select the following signals from the signal tree in the "Value" configuration tab of a
view (e.g. "Statistic View").
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Figure 6-365: CDMA PNS signals

Buffer ← Measurement Configuration
Time for which the raw measurement data is stored in the R&S TSME as R&S
ROMES4 is unable to process it immediately. The reason can be, for example, tempo-
rary low performance of the controller. If the R&S ROMES4 buffer remains blocked
after the buffer size time, the oldest data in the buffer is deleted and overwritten by new
data. Data transfer starts when R&S ROMES4 is ready again to receive and process
data.
A large buffer size increases the probability that no measurement data is lost, even
though R&S ROMES4 can be blocked for an extended time. However, storage and
transfer of large amounts of buffer data increase the possible delay between data
recording and evaluation/display in the views.

Maximum Speed ← Measurement Configuration
The value for the maximum speed of the measurement vehicle is used for improved
evaluation of fading channel measurements. The range is between 0 km/h and 300
km/h, otherwise an error message is displayed.

EVDO measurements

The "EVDO Meas. Configuration" page defines the parameters about frequencies and
measurement in a CDMA PN scan. The configured options are also shown in the
enhanced measurement file header.
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Figure 6-366: CDMA PNS configuration – EVDO measurement configuration

EVDO meas. frequency

Defines the EVDO measurement frequency in Hz. The maximum scan rate for EVDO
is 30 Hz, while for CDMA the maximum is 80 Hz.

It is possible to set different measurement frequency for CDMA2000 1xRTT and
1xEVDO.

Tip:

To see statistical information for the 1xEVDO measurement frequency select the fol-
lowing signals from the signal tree in the "Value" configuration tab of a view (e.g. "Sta-
tistic View":

Figure 6-367: 1xEVDO PNS signals
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Parameters to optimize synchronization performance

The following parameters allow the synchronize process fine-tuning.

● "Full Sync Frequency"
Full synchronize frequency from 0.1 Hz to 1 Hz.

● "Short Sync Frequency"
Short synchronize frequency from 1.0 Hz to 10 Hz.

● "Short Sync Range"
Short synchronize range from 160 chips to 1024 chips.

BCH demodulator configuration

Click the "BCH Demodulator" tab of the "R&S CDMA2000 1xEV-DO PNS [Device
name" ] > "Advanced settings" page to set the frequency-independent Ec/Io threshold
parameter for the BCH demodulation.

Figure 6-368: CDMA2000 - BCH Demodulator configuration

The "BCH Demodulator" page offers to set the requested minimum BCH signal quality
for demodulation in the "Ec/Io threshold for BCH Demodulation" box.

Only scanner peaks with an Ec/Io of at least this threshold value starts BCH demodula-
tion and decoding.

The demodulation threshold is displayed in the available list of decoded messages, as
shown in the following figure.
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The Ec/Io threshold is not a hard limit. It uses a probability function to determine the
likelihood of a successful decode based on the received signal strength from the scan-
ner.

CDMA2000 1xEVDO PNS scanner

The "Scanner" tab opens the page which displays the properties of the R&S TSME
device and information on the file version of the R&S CDMA2000 1xEV_DO PNS
driver.

CDMA2000 1xEVDO PNS templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.

If a device is loaded via the "Hardware" > "Connect/Disconnect" command, R&S
ROMES4 checks whether a driver template is stored in the Driver Templates directory
and its subdirectories. The driver can be loaded with default settings or with the set-
tings stored in any of the templates found.

Figure 6-369: Selecting template

CDMA2000 1xEV-DO PNS information

The "Info" tab displays information on the file version of the R&S CDMA2000 1xEV-DO
driver. It is identical for both CDMA2000 1xEV-DO drivers.
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6.4.21  RF power scanner

The RF Power Scanner driver controls the R&S TSME scanner device. The hardware
option used with the device is the R&S TSME-K27 option. The driver is available with
the option R&S ROMES4T1E for R&S TSME.

The RF Power Scanner driver for R&S TSME can be used with multiple scanner devi-
ces. In this way, the RF Power Scanner driver measures and visualizes data from all
devices simultaneously.

The support of multiple scanner devices requires:
● N* option ID for the RF Power Scanner
● R&S TSME with the R&S K27/K127 option

RF Power Scanner with R&S TSME is not limited. Multiple R&S TSMEs with the R&S
K27/K127 option are combined to an array and loaded as one driver instance with N
frontends. AE array with N devices needs one option ID, not N option IDs.

The Measurement File Info names and shows the RF frontend used in a certain
sweep.

Figure 6-370: Frontend 0 used for sweep 1

The Chapter 6.1, "Devices", on page 1447 describes the drivers installation.

The following chapter describes the RF Power Scanner device configuration.

You can see the RF Power Scanner measurement data in the "RF Power Scanner
Views", see Chapter 4.8.9, "RF power scanner views", on page 1319.

6.4.21.1  R&S TSME RF power scanner performances

The performances of R&S TSME RF Power Scanner are listed in the following table.

R&S TSME performances

Supported Frontends 1

Count of Sweeps 1 – 20

Spectrum analyzer-type FFT

Frequency Range 350 MHz – 4.4 GHz

Adjustable Frequency Resolution yes

Adjustable via FFT and sample rate (bandwidth)

Adjustable Bandwidth 1 MHz – 20 MHz

Adjustable Sample Rate 1.15 times the bandwidth => 1.15 MHz – 23 MHz
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R&S TSME performances

FFT Size 16 / 32 / 64 / 128 / 256 / 512 / 1024 / 2048 / 4096 / 8192

Window Type Rectangle, Hann, Hamming, Blackman, Flat Top

Attenuation and Preamplifier Automatic mode only

Adjustable Frequency Detector Max, RMS, Auto

Adjustable Time Detector yes

Max, RMS, Auto, Min

Threshold yes

Channel Filter (GSM, UMTS, LTE 5 MHz,
LTE 10 MHz predefined)

yes

Configuration of own Channel Filters via
XML-file

yes

Adjustable Sweep Rate yes

Adjustable R&S ROMES4 Update Rate Update rate of the views and the signals

R&S ROMES4 Signals Marker (4x Fixed, Free, Current Peak), Sweep Rate, All
Channels

Envelope yes

Jump-To-Next-Measurement-Point The fixed marker jumps automatically to the measurement
value or channel center frequency next to the clicked fre-
quency value

Enhanced Graphical User Interface yes

6.4.21.2  Loading RF power scanner

The R&S TSME devices can run as the RF Power Scanner devices if loaded with the
R&S ROMES4 RF Power Scanner driver.

Click the "Hardware" > "Connect/Disconnect" menu entry. The "Hardware Configura-
tion" page pops-up.

To load the driver, double_click the "Network Scanner TSME" > "TSME RF Power
Scanner" branch in the "Hardware Configuration" > "Available Devices" pane, see Fig-
ure 6-40.

The device is loaded and visible in the "Loaded Devices" pane of the page. Specify the
serial number, IP address and the bands for measurement for the loaded device in
"R&S RF Power Scanner(<variable>): Select Device". Click the "Connect" button to
confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The device is now added as the "RS RF Power Scanner [<variable>]" command line to
the "Hardware" menu.
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Figure 6-371: Accessing the RF Power Scanner driver configurations

The variable in the bracket is the scanner's name or a number indicating the number of
connected devices.

Click the "RS RF Power Scanner [<variable >]" command line to open the "R&S RF
Power Scanner" configuration page.

The dialogs of a device chooser open when the R&S TSME driver is loaded. The
device chooser dialog is used to select the test device and define the essential connec-
tion parameters, if necessary.

For details about the loader's dialog, see Chapter 6.1.11.1, "R&S TSME network scan-
ner", on page 1488.

The "R&S <variable>: Select Device" dialog is used to share the test device resources
between all loaded R&S TSME hardware drivers. Furthermore, over the dialog the IP
address of a device can be selected, if necessary.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.
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6.4.21.3  Configuration menu RF power scanner

R&S ROMES4 provides a configuration page for the RF Power Scanner if selecting the
"Hardware" > "R&S RF Power Scanner [<variable>]" command line in the "Hardware"
menu. The command line is available after loading the driver.

The R&S ROMES4 "RF PowerScan" opening configuration page shows the existing
sweeps or lets you add some. Other available tabs let you define the scanner parame-
ters, get the information on the test receiver driver and create template of current set-
tings.

6.4.21.4  R&S TSME RF power scanner configuration

Click the "RF PowerScan" tab of the R&S TSME to get the page which shows the
existing sweeps for the R&S ROMES4 RF Power Scanner. The spectrum analysis set-
tings are made in this page.

The "Add"/"Edit" buttons open the "Basic" configuration dialog with five tabs where a
new sweep can be configured or the existing one edited.

The drivers support between 1 and 20 impartially definable sweeps.

Figure 6-372: R&S RF Power Scanner – measurements

Basic settings

In the "Basic" > "Basic Settings" tab select the sweep rate, range and minimum and
maximum power.

The sweep buffer defines the internal holdback time of the RF Power Scanner driver's
measurement buffer. The value is automatically set to the "Time Range" value of the
time detector, see "Detector settings" on page 1829. This value guarantees that the
sweep buffer is large enough.
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Figure 6-373: RF Power Scanner configuration – basic settings

Sweep Name
Enter an individual name as a kind of description.

Max. Sweep Rate (Visualization)
Maximum update rate of the R&S ROMES4 Views.

Sweep Range
The "Sweep range" can be adjusted alternatively by "Start"- and "Stop"-frequency or by
"Center"-frequency and "Span". The values are specified in MHz. If active "Channel Fil-
ter", the sweep range is automatically calculated.
The R&S TSME scanner supports the sweep range from 350 MHz to 4400 MHz.

Frontend
Selects the R&S TSME frontend for the sweep.

Measurement settings

The "Measurement Settings" tab selects the sweep rate, range and minimum and max-
imum power in case the R&S TSME is used as RF Power Scanner.

Here you set the scanned bandwidth, attenuation, FFT settings and measurement
time.
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Figure 6-374: RF Power Scanner configuration – measurement settings

Bandwidth
There are three possibilities to set the bandwidth:
● Activate Auto Bandwidth

If "Auto" is set, the bandwidth is 20 MHz. In this case, the center frequencies of the
requested measurement jobs are set by a static 20 MHz-grid [30 MHz, 50 MHz, 70
MHz, and so on]. The setting is independent from the frequency range.

● De-activate Auto Bandwidth
If "Auto Attenuation" is inactive, the bandwidth can be set manually in a range of 1
MHz ≤ BW ≤ 20 MHz. In this case, the measurement does not use a frequency-
grid.
Configure the sample rate. It is always 1.15-times the bandwidth.

● Clear Spectrum
This mode is designed especially for measurements on potential clear spectra. The
bandwidth is fixed to 2073 MHz (6.66 MHz). Two blocks are measured at once.
The center frequency part of the bandwidth is not used so that the spectrum is free
of DC-Gap/Carrier.

Attenuation
There are two possibilities to set the attenuation and pre-amplifier.
● Activate Auto-Attenuation

Set "Auto Attenuation" to active first. In this case, the R&S TSME controls the
attenuation and pre-amplifier itself.

● De-activate Auto-Attenuation
The other possibility is to set "Auto Attenuation" to inactive. In this case, you have
to set the attenuation and the pre-amplifier on your own.
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FFT Settings
By the Fast-Fourier-Transformation (FFT) size and the sample rate, it is possible to
adjust the frequency resolution of the spectrum.

Figure 6-375: FFT settings

A continuous signal is processed in blocks. Because the lengths of the blocks are finite
and the blocks usually are not a multiple of the signal period, a leakage effect is
obtained. By using an adequate window function, the effect can be reduced.

Measurement Time (Detector)
Measures time-dependent signals. If "Use Measurement Time" is activated, each inter-
nal measurement block (=bandwidth) is measured for the time duration. It is adjusted
with the "Measurement Time" parameter. The measurement time has a range between
the measurement time for the FFT (=FFTSize/SampleRate) and 100 ms.
To compress the accumulated measurement values from the different FFTs, a separa-
ted detector is used. It guarantees the adjusted frequency resolution and measurement
duration.
There are three possibilities to detect the frequencies:
● "Maximum Peak" - maximum value of all the dedicated samples.
● "Root-Mean-Square (RMS)" - effective value of all the dedicated samples.
● "Minimum Peak"- minimum value of all the dedicated samples.

Detector settings

The "Detector Settings" page lets you set the time and frequency detector properties of
the R&S TSME devices.

The frequency detector cannot be used in combination with an active channel filter.

If more results (count of lines) are requested, they are obtained from the FFT results,
independently of the detector type. The results are interpolated via Bresenham algo-
rithm.

The following detector settings are possible for the R&S TSME.
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Figure 6-376: RF Power Scanner configuration – detector settings

Frequency Detector
● "Count of Lines"

Specifies the resolution of the virtual window in the frequency domain. The maxi-
mum number of lines is defined by the scanners native resolution of 12.8 kHz.

● "Maximum Peak"
Maximum sample value out of all dedicated ones.

● "Root Mean Square (RMS)"
Effective value of all dedicated samples.

● "Auto Peak"
Minimum and maximum sample value out of all dedicated ones.

Time Detector
A time detector works in a similar way to the frequency detector. It processes samples
at the same frequency in a group of measurements within a time interval. The time
detector compresses the values obtained in time domain like the frequency detector in
frequency domain. The time detector can be used in combination with the frequency
detector and in combination with the channel filter.
● "Time range"

By default is computed from the "Max Sweep Rate (Visualization)" in the "Basic
Settings" of the driver. In the configuration shown in the previous figure the rate is
set to 5 Hz so that the time range is 1/5 Hz=200 ms.

● "Manual setting"
If checked, lets you edit the time range value manually. The current configuration is
stored in the Workspace if the user saves it.
All sweeps from the recent sweep, back to the sweeps with a smaller time distance
than a time range, are used.
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The sweep buffer size affects the time range. Therefore, the value is automatically
set to the "Time range" value. This value guarantees that the sweep buffer is large
enough.

● "Maximum Peak"
Maximum sample value out of all dedicated samples.

● "Root Mean Square (RMS)"
Effective value of all dedicated samples.

● "Auto Peak"
Minimum and maximum sample value out of all dedicated samples.

● "Minimum Peak"
Minimum sample value out of all dedicated samples.

Channel filter

The channel filter is used to assign the power inside a channel of a digital modulated
signal. It equates hereby the modulation filter of the respective system. The boundary
areas of the filter are apportioned by a less powerful weighting. The less powerful
weighting leads to a more realistic reflection of the channel. The idea is based on a fact
that the signals at the center of the flanking channel are more disturbed than the sig-
nals at the boundary. To prevent these disturbances, the matched filter condition is
used.

The main application of channel filters is in mobile radio communication technologies,
like TETRA and WCDMA, where the power of the main and flanking channels are
affected.

The "Channel Filter" tab lets you create, edit or remove channel filter.

Figure 6-377: RF Power Scanner configuration – channel filter

Add
Opens the "Channel Filter" dialog to generate a new filter.
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Figure 6-378: Channel filter

Figure 6-379: Channel Filter - select a filter

The following parameters are set in the "Channel Filter" panel:
● "Filter"
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Multiple channel filters for TETRA, WiMAX and LTE are available.
● "First Center Frequency"

Defines the first center frequency of the first channel in MHz.
● "Frequency Spacing"

Distance between the center frequencies of two channels specified in MHz.
● "Number of Objects"

Number of channels with the chosen filter type.
A tag in the ChannelFilterDefinitions.xml file describes the related channel fil-
ter.

Figure 6-380: ChannelFilterDefinitions.xml file

The description marked in previous figure is displayed in the "Channel Filter" dialog of
the RF Power Scanner driver.

XML-File
The channel filter definition describes the shape of the filter and is configured by an
XML file, with the following parameters:
● Name

Defines the name, which appears in the channel filter dialog of the driver.
● Indicator

User-defined unique number for identification.
● Freq-Spacing

Distance between filter values in Hz.
● Weight

– Value
Filter values vary in division of 0 and 1. It is assumed that filters are symmetri-
cal. Only the values of one side of filter are needed.

– Repeat
Specifies, how often this value is repeated.
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Figure 6-381: Example for the GSM Channel Filter Configuration with XML

Figure 6-382: Example for the UMTS Channel Filter Configuration with XML
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Threshold settings

If the threshold is active, only sweep results with power values greater than the adjus-
ted threshold are stored and displayed.

Figure 6-383: RF Power Scanner configuration – threshold settings

6.4.21.5  RF power scanner – scanner

The "Scanner" tab opens the window which displays the properties of the R&S TSME
device and the information on the file version of the R&S ROMES4 RF Power Scanner
driver.
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Figure 6-384: RF Power Scanner configuration

6.4.21.6  Info RF powers scanner

The "Info" page displays information on the file version of the RF Power Scanner
driver. It is identical for all RF Power Scanner drivers.

Figure 6-385: R&S RF Power Scanner – info
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6.4.21.7  Templates R&S RF power scanner

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.

Figure 6-386: R&S RF Power Scanner - templates

6.4.22  TETRA scanner

The R&S ROMES4 TETRA scanner driver controls the R&S TSME scanner device
when scanning a TETRA network. The hardware needed is the R&S TSME-K26 option
which includes DMO. The driver is available with the R&S ROMES4T1E option.

The TETRA scanner configuration is explained in the following chapters.

For data collected, measured and analyzed by the R&S TETRA scanner, see Chap-
ter 3.3.17.7, "TETRA scanner views", on page 186.

File scanning
The proper working of the coupled focus and calculation of the Top N pools, need to
scan the complete measurement file when you open it for replay. Thus, if a measure-
ment file contains TETRA scanner data, the TETRA scanner scans the file, regardless
of "File Scanning" activation.

6.4.22.1  Loading TETRA scanner

The R&S TSME devices can run as the TETRA scanner devices if loaded with the
R&S ROMES4 TETRA scanner driver.
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Click the "Hardware" > "Connect/Disconnect" menu entry. The "Hardware Configura-
tion" page pops-up.

To load R&S ROMES4 TETRA scanner driver into R&S TSME, double_click the "Net-
work Scanner TSME" > "TSME TETRA" branch in the "Hardware Configuration" >
"Available Devices" pane, see Figure 6-40.

The device is loaded and visible in the "Loaded Devices" pane of the page. Specify the
serial number, IP address and the bands for measurement for the loaded device in
"R&S TETRA Scanner(<variable>): Select Device". Click the "Connect" button to con-
firm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

The device is now added as the "RS TETRA Scanner [<variable>]" command line to
the "Hardware" menu as well.

Click the "RS TETRA Scanner [<variable>]" line to open the TETRA scanner main con-
figuration page.

By default, the scanner is configured for measuring a certain TETRA band, for exam-
ple, for German TETRA band.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.
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6.4.22.2  Measurement rate signals

The R&S ROMES4 TETRA scanner consists of two modules:
● Scanner Module which measures the level of signals in the analysis range.
● Analysis Module which measures the quality of the active TETRA frequencies.

Both modules use the same IQ-data from the R&S TSME. Due to the narrowband sys-
tem of TETRA, long sequences have to be acquired for the analysis. An acquisition
takes about 113 milliseconds. To get moreover high-speed level measurements, an
acquisition is segmented in the Scanner-Module and three results are calculated.
Therefore, the measurement rate of the R&S TSME is less than the scanning rate of
the system.

To get distance information, a GPS device (for example, the R&S TSME’s GPS device)
must be connected to one or more TETRA scanner devices and used for the measure-
ment.

6.4.22.3  Configuration TETRA scanner

The "Scanner Configuration" tab allows configuration of measurement parameters for
one or more channels that you want to measure.

The R&S ROMES4 Automatic Channel Detection (ACD) feature is supported for
TETRA scanners. You can select the mode of the TETRA channels detection by con-
figuring manual or automatic mode.

The layout of the "Scanner Configuration" page depends on selected mode.

Figure 6-387: TETRA scanner configuration - manual mode
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TETRA Channels
The TETRA channels detection mode is configured in "TETRA Channels". The page
also contains parameters for channels detection, if you select the manual mode.

Mode ← TETRA Channels
● "Manual"

The manual configuration of TETRA channels measurement is described in the fol-
lowing sections.

● "Automatic Channel Detection (ACD)"
For the ACD configuration mode, see TETRA Automatic Channel Detection.

Figure 6-388: TETRA scanner configuration - ACD mode

Base Frequency Index ← TETRA Channels
Specifies the number of the base frequency.

Frequency Offset ← TETRA Channels
Specifies the carrier frequency offset. The TETRA standard defines four values (-6.25
kHz, 0 kHz, +6.25 kHz and +12.5 kHz).

Autodetect TETRA Channels ← TETRA Channels
If "Autodetect TETRA Channels" is checked, the scanner detects TETRA channels
automatically. If unchecked, specify the TETRA channels for scanning within the bands
specification.
The maximum limit for forcing channels and excluded channels is 100.
Note: If more channels are specified, the warning message pops-up, asking you to
correct the string.
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Figure 6-389: Too many channels are configured

Many forced channels can reduce the analysis speed. Also, forced channel where no
signal is seen slows down analysis speed.

Sweep ← TETRA Channels
The R&S TETRA scanner supports multiple sweeps.
"Sweep" lets you select the sweep number. The checkbox on the left side of the com-
bobox indicates whether the sweep is a part of the actual measurement setup.
To get more than one sweep in the box, increase the number of sweeps, see "ROMES
signals" on page 382. The sweep number corresponds to the configured sweep num-
ber.
For example, if only sweep 2 and 4 is configured in the drivers configuration, the tabs
and signals show up with symbol #2 and #4, respectively.

Figure 6-390: Configured two sweeps for TETRA scanner
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A tab is provided for the results of each sweep in the "TETRA Scanner Spectrum
View".

Figure 6-391: TETRA scanner sweep

The scanner driver is able to scan up to 16 frequency blocks in parallel. The scan rate
per sweep decreases when adding more sweeps to the measurement configuration.

First Carrier Index ← TETRA Channels
Defines the first channel number to be scanned (0 to 3999)

Last Carrier Index ← TETRA Channels
Defines the last channel number to be scanned (0 to 3999).

The given channels are DMO channels ← TETRA Channels
The R&S ROMES4 TETRA Scanner supports also measurements on DMO TETRA
carriers. The DMO measurement is exclusive, that is, a R&S ROMES4 scanner driver
can scan DMO carriers or non-DMO carrier.
The R&S TSME-K26 option is required for DMO.

DMO Driver ← The given channels are DMO channels ← TETRA Channels
If the DMO measurements option is active, the scanner assumes that the given carri-
ers are TETRA DMO carriers.
The following additional features are not supported with DMO measurements:
● Channel Impulse Response measurement
● Interference Analysis
● QAM measurement
● Position estimator measurement
● More MCCH measurement
● Extended Sensitivity

DMO Signals and Events ← DMO Driver ← The given channels are DMO chan-
nels ← TETRA Channels
The following TETRA DMO signals are measured:
● Frequency
● Carrier
● Inband Power
● TETRA Power
● SNR
● ModER
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● MCC
● MNC
● BER Pre - Vit
● Freq. Err
● Phase Error
● Delay Spread
● Time Slot
● FN
Additional supported DMO signals and events are:
● Source Address
● Destination Address

DMO Views ← The given channels are DMO channels ← TETRA Channels
TETRA views show the available parameters of DMO carriers.
The "BCH View" shows the identified MS and the DMAC-SYNC PDU in SCH/S and
SCH/H.

Measurement Data
The "Measurement Data" section of the driver configuration lets you define data to be
measured during the channels scanning.
● "Maximum Scan Rate"

Defines the maximum measurement speed for the scanner.
● "Maximum Analysis Rate"

Defines the maximum speed of the analyzer.
● "Interference Analysis"

If checked, the scanner analyzes interference during the measurement and stores
the data.
The results are shown in "TETRA Scanner Spectrum View". The results are also
available in the "TETRA Scanner Top N View" and as the Top N Carrier signals.
Available results are:
– C/I
– MCC of interferer
– MNC of interferer
– LA of interferer

● "Channel Impulse Response"
If checked, the scanner measures and stores CIR data. The results are shown in
the "TETRA Scanner CIR View".

● "Constellation Diagram"
The scanner is able to measure the constellation diagram during its analysis. How-
ever, this data needs much storage space. Due to that reason, the measurement
and storage of the constellation diagram has to be activated.

● "Inband Spectrum"
If checked, the scanner measures and stores inband spectrum data. It is displayed
in the "TETRA Scanner Carrier Spectrum View".

● "TETRA 2 Measurements"
If checked, TETRA 2 measurements are switched on.
Note: TETRA channel has carrier bandwidth of 25 kHz. TETRA 2 channel numbers
entered in the channel list also refer to the standard TETRA 25 kHz channel raster,
although their real bandwidth can be different, for example, 150 kHz.
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● "Interference Analyzer Settings"
Opens a dialog to specify the conditions for interference analysis.

Figure 6-392: TETRA interference analysis parameters

An interference situation is given if the following conditions are fulfilled:
– Level is more than a [dBm]
– Phase error is worse than b [°]
– If SNR is less than c [dB], then an asynchronous interference is supposed to be

the problem.
The SNR values are considered to distinguish between a synchronous and an
asynchronous interference. If SNR is less than c [dB], then an asynchronous inter-
ference is supposed to be the problem.
A synchronous interference means that a signal and an interferer are in the same
synchronized network. Therefore, the sync bursts are transmitted at the same time.
As the SNR measurement is done on the frequency correction part of the sync
burst, R&S ROMES4 does not notice an interference in this part. The SNR is high,
because adding 2 sine-waves of the same frequency results in another sine-wave.
An asynchronous interference means that a signal and an interferer are asynchro-
nous because the network is running asynchronously or they belong to different
networks. The sync bursts are transmitted at different times and the interference is
resulting in a low (= bad) SNR. Distinguishing between synchronous and asynchro-
nous interference is important for determining the interferer.

● "More MCCH Measurements"
If checked, additional measurements on the 1st slot of the MCCH are performed.
Hovering over the "More MCCH Measurements" displays these measurements.

Figure 6-393: MCCH measurements

The measured signals are also described in Top N Pool Signal Settings.
● "Extended Sensitivity"

If checked, the sensitivity of the scanner increases.
● "Normal Burst Measurements"
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The quality measurements on the normal burst are by default activated, see Fig-
ure 6-387. This measurement approach increases the measurement speed for
quality parameters significantly, especially in high-loaded networks.

Advanced
"Advanced" allows you to define:
● Minimum number of successive TETRA detections to reach the candidate state.
● Minimum time the channel has to be above the minimum level to reach the candi-

date state.
● Minimum time the carrier is not analyzed as TETRA carrier after being declared as

non-TETRA carrier.
Configure the following parameters:
● "Threshold for Analysis [dBm]"

Specifies the minimum level for a channel to be analyzed as TETRA carrier.
● "Threshold for Analysis [ms]"

Specifies the minimum threshold for analysis in ms. That means, the value speci-
fies the minimum time the channel has to be above the minimum level to reach the
candidate state.

● "Threshold above noise [dB]"
Specifies the threshold that disables the analysis of signals which are close to the
noise floor.
The performance of the TETRA scanner can be improved by choosing the limited
signal levels for analysis. If the analysis of the signals is limited to those signals
which are at least a certain level stronger than the noise level the performances
are improved. This limit can be adjusted in range 0 dB to 99 dB.

● "Max. parallel Analysis"
To reduce the CPU load, the scanner can be forced to analyze only a certain num-
ber of signals in parallel.
Possibility to limit the maximal number of simultaneous calculations ranges from 1
to 64.

● "Threshold Repetitions"
Specifies the iteration of the threshold value for an analysis. That means, it speci-
fies the minimum number of successive TETRA detections to reach the candidate
state.

● "Threshold for Retesting [ms]"
Specifies the minimum threshold value in ms before a retest starts. The value
specifies the minimum time that the carrier is not analyzed as a TETRA carrier after
being declared as non-TETRA carrier.

● "Disable Equalizer/Disable Frequency Correction"
The parameter lets you disable the internal equalizer or the internal frequency cor-
rection. Usually, equalizer and frequency correction are on. However, if the mea-
surement results refer closer to TETRA mobiles which do not use these functions,
switch them off. Switching off equalizer and frequency correction for such mobiles
predicts their performances better in areas with strong reflections, especially if no
line of sight to the BTS antenna.

TETRA Automatic Channel Detection
If the selected TETRA channels measurement mode is "Automatic Channel Detection",
the shown page lets you specify the ACD measurement parameters.

Test devices



Hardware ComponentsDrive Test Software

1846Operating Manual 1171.6415.12 ─ 66

The page is divided into two parts. In the left part set the mode and the other ACD
parameters independently on technology. The right part of the page is TETRA-specific.
Note: Virtual TETRA channel is a 10 MHz block. Maximum 16 virtual TETRA channels
can be scanned in parallel.
In "Automatic Channel Detection" the following settings are available:
● "Mode"

– "Simple"

Figure 6-394: TETRA ACD - simple mode configuration

The mode tries every possible TETRA channel for a signal.
– "Smart"

The mode uses the RF power scanner to check for power in frequency blocks
before trying TETRA scan. The corresponding drivers for the R&S TSME and
the R&S ROMES4 have to be available.

Figure 6-395: TETRA ACD - smart mode configuration
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If RF Power Scanner is not loaded, you are asked to do that.

Figure 6-396: Load RF Power scanner request

● "Maximum Number of Attempts"
Number of times the TETRA scanner tries to find a TETRA cell on a certain chan-
nel. Increasing the number helps to find weaker cells and increase the detection
probability, but reduces the detection speed.

● "Sensitivity (Smart mode)"
Three different levels of the ACD sensitivity are available. Depending on the
requirements of the measurement, users can select a faster or more sensitive
ACD.

● "Create Template"
If selected, the R&S ROMES4 creates a template for the TETRA scanner which
includes all detected channels at the end of the measurement.

"TETRA Automatic Channel Detection" allows selection of the frequency bands to be
observed by the ACD function for TETRA channels.
For each detected virtual TETRA channel, a TETRA sweep is configured automatically.
If a template is created, it can be used to set a new measurement with dedicated chan-
nels up.
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Figure 6-397: TETRA template created by ACD

The current state of the smart ACD is visualized in the "ACD Status View".

Figure 6-398: TETRA ACD status view

6.4.22.4  Scanner TETRA

"Scanner" opens the window which displays the properties of the R&S TSME devices.
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Figure 6-399: R&S TETRA Scanner properties

6.4.22.5  Info

"Info" displays information on the file version of the R&S ROMES4 TETRA Scanner
driver.

6.4.22.6  Templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.

6.4.23  WLAN device

The R&S ROMES4 WLAN driver controls the data transfer from/to Wireless LAN client
adapters. It supports all common WLAN devices. Which WLAN devices are present is
visible in the MS Windows "Connection Manager" > "Wireless Network Connection"
section.

The WLAN driver has the subitem "WinWLAN" in the R&S ROMES4 hardware configu-
ration.

The WLAN device loading with the R&S ROMES4 WinWLAN driver and the device
configuration is covered in the following chapters. The measured WLAN data can be
viewed in the "WLAN Views", see Chapter 4.7, "WLAN views", on page 1103. The
measured WLAN data are also visible in many basic views.
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6.4.23.1  Loading WinWLAN devices

The R&S ROMES4 WLAN provides a configuration window for the WLAN devices
which are loaded. Install the WinWLAN driver previously.

To load WinWLAN driver into a WLAN device:

1. Click the "Hardware" > "Connect/Disconnect" command.

The "Hardware Configuration" window pops-up showing the "Available Devices"
list.

2. Select the "WLAN" > "WinWLAN" branch.

3. Click the ">" button.

The "Select WLAN Device" dialog pops-up asking you to select the WLAN device.

4. Click "OK".

The selected WLAN device is included in the "Loaded Devices" list.

5. Click "Continue" to confirm the selection.

The selection is stored and the window is closed.

The WinWLAN device is available now in the "Hardware" menu and in the "Wel-
come" > "Available Devices" section. You can open its configuration page if you
click, for example, the device's icon in the "Available Devices" list.

6.4.23.2  Configuration WLAN

The "WinWLAN[<variable>]" configuration window offers the tab for a WLAN device
setup for measurement. The other two tabs in the window carry information on device
capabilities and version.
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Figure 6-400: WinWLAN device setup

Device setup

The "Device Setup" dialog lets you select the measurement interval and a beacon/
probe response time.

The parameters are explained in the dialog itself.
● "Measurement interval [ms]"

The time in ms after which R&S ROMES4 records and evaluates a new set of mea-
surement data from the test device. A short measurement interval allows the quick
variations of the signal quality and the data traffic to analyze. However, the short
measurement interval causes large measurement files which require more R&S
ROMES4 system capacity.
The actual update interval of the data in the test device is shorter than the mea-
surement interval so that R&S ROMES4 skips part of the available information.
This update interval is not influenced by the driver settings.

● "Beacon or Probe Response Timeout [ms]"
The time in ms without having received a beacon or probe response from the net-
work. When this time is reached, the SSID is removed from the network list.

Device info

Click the "Device Info" tab to get the information on the test device capabilities.
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Figure 6-401: WLAN driver information

WLAN info

The opening page of the "Info" tab is identical to info tab of other technologies suppor-
ted by R&S ROMES4.

6.4.24  WLAN measurements with QualiPoc converter

The QualiPoc Converter supports WLAN measurements done with the converter ver-
sion 13.1.0.25 or higher.

The following data and associated parameters are available in the QualiPoc measure-
ment file:
● WiFi Scan Data

– SSID - Service Set Identifier
– BSSID - Basic Service Set Identifier (MAC address)
– Frequency - Frequency of the channel over which the client is communicating

with the access point
The channel number is calculated by the frequency according to IEE 802.11.

– Capability - Authentication, key management and encryption schemes suppor-
ted by the access point
The capability is displayed in the column "Auth. Algorithm" in the "WLAN Scan
View", refer to Chapter 4.7.2, "WLAN scan view", on page 1108.
The "Net x QP Capability" signal is created for this parameter, see in "View" >
"Signal Tree Bar" > "WLAN" > "Device x" > "Network Scan".
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Figure 6-402: Capability shown in the Auth. Algorithm column

In the "Alphanumeric View" the capabilities are displayed as well, see the fol-
lowing figure.

Figure 6-403: Net x QualiPoc capabilities

● WiFi Connection Data
– SSID - Service Set Identifier
– BSSID - Basic Service Set Identifier (MAC address)
– RSSI - Received Signal Strength Indication
– Frequency - As defined in Frequency
– Capability - As defined in Capacity
– Link Speed - Throughput expressed in kbps
– Status - Detailed state of the supplicant's negotiation with an access point

The "Connection QP Status" signal is created for this parameter in "View" >
"Signal Tree Bar" > "WLAN" > "Device x" > "Connection Status", see the follow-
ing figure.

Test devices



Hardware ComponentsDrive Test Software

1854Operating Manual 1171.6415.12 ─ 66

Figure 6-404: Connection QualiPoc status

The possible WLAN states of the supplicant's negotiation with an access point are
given in the following table.
Table 6-19: States of the supplicant's negotiation with an access point

WLAN state Description

AUTHENTICATING Network link established performing authentication

BLOCKED Access to this network is blocked

CONNECTED IP traffic is available

CONNECTING Currently setting up data connection

DISCONNECTED IP traffic not available

DISCONNECTING Currently tearing down data connection

FAILED Attempt to connect failed

IDLE Ready to start data connection setup

OBTAINING_IPADDR Awaiting response from DHCP server to assign IP address information

SCANNING Searching for an available access point
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WLAN state Description

SUSPENDED IP traffic is suspended

VERIFY-
ING_POOR_LINK

Link has poor connectivity

The QualiPoc measurement file info dialog shows just the adapter information for
WLAN, which is a mobile driver's name. Other WLAN information is not available.

Figure 6-405: Used WLAN adapter
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In the "WLAN Overlapping Networks View", the chart of the details section can stay
empty. The reason for the empty chart is missing channel bandwidth measurement
information of the QualiPoc.

Only the co-existing channels are displayed in the left part of the view.

Figure 6-406: QualiPoc measurements displayed in WLAN Overlapping Networks View

6.4.25  WiMAX scanner

The R&S ROMES4 WiMAX scanner driver controls an R&S TSME scanner device to
perform WiMAX measurements. You need for this control the R&S TSME hardware
option R&S TSME-K28. The driver is available with the R&S ROMES4T1E for R&S
TSME option.

The configuration of the R&S TSME network scanner as the WiMAX scanner is
explained in the following text.

The WiMAX data measured, collected and analyzed by the R&S WiMAX scanner can
be viewed in the Chapter 3.3.17.9, "WiMAX scanner views", on page 188.

6.4.25.1  Loading WiMAX scanner

The R&S TSME devices can run as the WiMAX scanner devices if loaded with the
R&S ROMES4 WiMAX scanner driver.

Click the "Hardware" > "Connect/Disconnect" menu entry. The "Hardware Configura-
tion" page pops-up.
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To load the WiMAX scanner driver into R&S TSME, double_click the "Network Scanner
TSME" > "TSME WiMAX" branch in the "Hardware Configuration" > "Available Devi-
ces" pane, see Figure 6-40.

The device is loaded and visible in the "Loaded Devices" pane of the page. Specify the
serial number, IP address and the bands for measurement for the loaded device in
"R&S WiMAX Scanner(<variable>): Select Device". Click the "Connect" button to con-
firm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

It is now added as the "RS WiMAX Scanner [<variable>]" command line to the "Hard-
ware" menu.

Click the "RS WiMAX Scanner [<variable>]" line in the "Hardware" menu to open the
WiMAX scanner main configuration page.

Some connectors on the rear panel of the R&S TSME device are here briefly descri-
bed.

● The R&S TSME device must be connected to the host PC via high-speed Gigabit
Ethernet interface with RJ 45 connector using IPv4.

● SMA female [RF IN] connector for antenna RF signal.
● SMA connector for the GPS antenna. The internal GPS receiver of the R&S TSME

provides a PPS signal to the scanner. The R&S TSME has no indication of the
GPS signal provision.

Tip:

The R&S TSME operating manual is provided on the R&S ROMES4 DVD-ROM. Refer
to the directory Firmware & Drivers\R&S RF Receivers. See also the para-
graph about the Chapter 6.1.11.1, "R&S TSME network scanner", on page 1488.

6.4.25.2  WiMAX scanner configuration

The "R&S WiMAX Scanner" configuration page allows configuring the measurement
parameters.

The "WiMAX Scanner Configuration" tab lets you select channels, frequency, band,
BCH-demodulation for scanning. The "Scanner" tab shows the properties of the con-
nected driver, the "Templates" tab displays the current driver installation and the "Infor-
mation" tab displays the information on the file versions of the driver.
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Figure 6-407: WiMAX Scanner

The "Scanner Configuration" page contains the "Channels" table and some buttons.

Channels
The "Channels" table displays a list of channels for scanning.
The user has the options to activate or deactivate scanning of a specific channel, or to
allow the scanner to follow another device by choosing the "Virtual Channel" option.
The user can in this table also set the frequency or modify the parameters of an
already configured channel. To modify the channel parameters, click the channel's line.
Instead of defining certain channels for scanning, the user can configure channels
scanning dynamically. With the Virtual Channel option a primary R&S ROMES4 driver
is selected, which dynamically configures the scanner.
This option allows the user to use the scanner without knowing specific frequency of
the WiMAX network.
The "Virtual Channel" feature makes possible automatic channel detection (ACD). The
automatic channel detection is configurable as a virtual channel. The WiMAX scanner
R&S TSME automatically detects channels just by specifying band on which the chan-
nels have to be located.
You can enable or disable the scanning of a selected channel or set the "Virtual" chan-
nel option via the no-name combo box on the left of the "Channel" pane.
If the "Virtual" is selected, the combo box under the "f[MHz]| BW [MHz]" column offers
all the configured sources for the virtual channel, see the following figure. By default
the 2.3GHz band is searched.
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Figure 6-408: Follow specified band for WiMAX ACD

For the ACD configuration, see "WiMAX Automatic Channel Detection" on page 1860.
If the WiMAX channel is detected, the settings concerning the BCH measurements,
measurement rates and the advanced settings of the virtual channel are applied to the
detected channel.
Note: The "Virtual" option is only available with the ACD option.
The primary device can add and release physical channels during the measurement. It
can be useful to ignore the release command.
The following channel parameters are specified:
● "Name"

Name of the channel, for example, the provider name.
● "f[MHz]" | "BW [MHz]"

The basic configuration of a channel is the Carrier Center Frequency (f) and the
used operating bandwidth (BW). The bandwidth must be selected from a drop-
down list. Values allowed in this column are: 3.5, 5, 7, 8.75 and 10. The selected
value is shown on top of the drop-down list.

● "BCH-Demodulation"
The option activates or deactivates during the scanning demodulation of the wan-
ted information. The column has default value "None".

● "Open"
If you select this entry of the "Advanced" column, the "Advanced channel settings"
page opens. The selected setting applies to a single configured channel.
The possible settings in this dialog are:
– "Advanced channel settings"

If you check the "FFT Size" and "Cyclic Prefix Ratio" combo boxes, the
selected FFT size and cyclic prefix are set according to defined values.
The frame rate can be predefined in the "Framerate Hz" text box.

Figure 6-409: WiMAX Scanner - advanced channel settings
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Select in the "Use for resynchronization" box the "Yes" option, if this channel
can be used for synchronization of the receiver.

– "Dynamic PDU Settings"
The page allows dynamic PDUs handling, refer to "Implementation of the
dynamic PDU handling" on page 284.
All the PDUs of the selected channel which can be requested for measurement
are shown in a list.

Figure 6-410: WiMAX Scanner - dynamic PDU settings

When a "Dynamic" check box is ticked, the PDU is requested for measurement
with the repetition interval specified in the "Interval" column.
Click the "OK" button to add the measurement settings to the selected channel
and return to the "WiMAX Scanner Configuration" dialog.
Click the "Cancel" button to discard made changes and return to the "WiMAX
Scanner Configuration" dialog.
Click the "Previous" or "Next" button to go through the list.
The default value for interval is 1 second. The possible range depends on the
scanner driver for the technology and is checked, see Dynamic PDU Settings.

Add
The button adds a new channel to the list of channels.

Remove
The button removes all highlighted channels from the table of channels.

Clone
The button makes a copy of all highlighted channels, automatically sets the “checked”
status for it and assigns name by adding the word “copy” to the original channel name.
Note: The "Remove" and "Clone" buttons are available only if at least one channel in
the table is highlighted.

WiMAX Automatic Channel Detection
The ACD configuration is the same as for other technologies. Select the WiMAX bands
to use for the ACD, as shown in the following figure.
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Figure 6-411: WiMAX Scanner ACD configuration page

For the parameters description, see "UMTS Automatic Channel Detection"
on page 1798.

Advanced
Click the "Advanced" button. The "Advanced Configuration" dialog opens where you
can find the tabs for measurement and BCH demodulation configuration. The button
opens common, scanner frequency-independent settings, for details see the following
sections.

Figure 6-412: Advanced configuration dialog - Advanced button
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6.4.25.3  Measurement page

The two input entries define how often the system synchronizes to the received
WiMAX signals and updates the measurement file.

● "Sync Rate [Hz]"
Defines the synchronization rate in Hz.

● "Measurement Rate [Hz]"
Defines the used measurement rate in Hz.

6.4.25.4  BCH demodulator WiMAX scanner

The "BCH Demodulator" page lets you set the "CINR Threshold [DB]" for BCH demod-
ulator.

Specify the requested minimum BCH signal quality for demodulation. Only scanner
peaks with a CINR of at least this threshold value starts BCH demodulation and decod-
ing.

Figure 6-413: R&S WiMAX Scanner - BCH demodulator page

6.4.25.5  WiMAX scanner

The "Scanner" tab displays the properties of the R&S TSME device and information on
the file version of the R&S WiMAX scanner driver.

6.4.25.6  Information

The "Info" tab displays information on the file version of the WiMAX driver.

6.4.25.7  Templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.
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6.4.26  CW scanner

6.4.26.1  R&S CW driver for R&S TSME devices

The R&S CW scanner driver controls and provides CW measurements for R&S TSME
test devices. The measurements are named R&S CW Scanner.

The R&S K25 option is necessary on the R&S TSME side.

The R&S CW driver for the R&S TSME requires:
● A high-speed Gigabit Ethernet
● The R&S TSME device must be connected to the host PC via high-speed Gigabit

Ethernet interface with RJ45 connector using IPv4

Loading devices

The R&S CW driver is loaded into the supported R&S TSME devices using the "Hard-
ware" > "Connect/Disconnect" command. Select the "Network Scanner TSME" >
"TSME CW" branch in the opened "Hardware Configuration" > "Available Devices"
pane, see Figure 6-40. Double-click the selection to load device.

The device is loaded and displayed in the "Loaded Devices" pane of the "Hardware
Configuration" window. Specify the serial number, IP address and the bands for mea-
surement for the loaded device in "R&S CW Scanner(<variable>) Select Device". Click
the "Connect" button to confirm the inserted data.

Then, click the "Hardware Configuration" > "Continue" button to store load and close
the window.

Loading the R&S TSME network scanner as CW receiver is shown in the following fig-
ure.

Test devices



Hardware ComponentsDrive Test Software

1864Operating Manual 1171.6415.12 ─ 66

Figure 6-414: R&S CW scanner - selected device R&S TSME

The loaded device is now added as the command line to the "Hardware" menu. Click
the command line to open the "CW Scanner(<variable>)" configuration page.

Predefined templates for R&S TSME CW

● Template LTE
Defines the LTE Band 3, 7, 20 and 28. As the CW receiver can handle up to 512
channels some bands, having more than 512 channels, are split into part 1 and
part 2.

● Template TETRA BOS
The Startfrequency 380.0125MHz, bandwidth 25kHz, 200 channels template is
created and added to the channel list.

It is possible to load a template within an empty configuration page.

6.4.26.2  Configuration menu CW scanner

The CW scanner configuration relays on a set of tabs. The "CW Scanner" > "Receiver
settings" opening page lets you configure the CW scanner for measurements. Here
you configure a frequency or band to be measured and the associated parameters.
The "Measurement Settings" tab lets you define how to measure the signal. The
"Channel Filter" tab lists all predefined channel filters.
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The "Scanner", "Info" and "Templates" tabs show the information identical to previously
mentioned test receivers and are common for all RATs.

Figure 6-415: CW Scanner page - receiver settings

CW scanner configuration

Receiver settings

Frequencies can be configured as a band definition, frequency list or a frequency. The
latest option allows an easy-to-use frequency input GUI.

The default "Frequencies" option applies to the R&S TSME/TSME6. It lets you enter
the frequency, its bandwidth and the used frontend.

The "Band definition" option allows measurement on several GSM bands and even
simultaneous measurement of several technologies. All the frequencies are listed with
their parameters.

A channel at its center frequency and the selected bandwidth is configured. Consider
that center frequency +- ½ bandwidth need not to exceed the receiver limits.

A bandwidth could be predefined either by a list of bandwidths or by a defined channel
filter.

The channel filters are named CFxxx, where xxx stands for the channel filter indicator
number. See "Channel filter" on page 1867 which shows all the predefined channel fil-
ters.

Frequencies must be unique, a warning prohibits double entries and also is issued at
leaving the configuration page if the maximum of 63 added channels is exceeded.

On a single R&S TSME, there is only one FE available.
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By default, "Auto Attenuation" is enabled. The receiver checks its RF paths and sets
the optimal amplifier and the attenuator.

For special purposes, the Auto Attenuation feature can be disabled. In that case, one
step, out of 3 possible attenuator steps, is fixed applied. This fixing can lead to over-
flowed data. The setting applies to the whole measurement on all frontends.
Table 6-20: Fixed attenuator's step

Manual Attenuation Steps R&S TSME

Step 0 All possible LNAs ON, RF Att 0dB, IF Att 5dB

Step 1 All but IF LNA2 ON, RF Att 4dB, IF Att 2dB

Step 2 All but IF LNA2 ON, RF Att 4dB, IF Att 2dB

The "Detector" selectable parameter applies to the whole measurement of all region.
The measurement can be Peak/RMS/Min Peak/Average.

The "Max. Measrate" parameter is the desired measurement rate per second, range
[1/s] to [1000/s].

"Max. Measrate" is not a guaranteed rate.
As the other measurement tasks can be run in parallel on this receiver and depending
on the configured frequencies, the receiver scheduler calculates the measurement
rate. This rate could also get larger and smaller, depending on the receivers actual
capacity.

The page contains the "Add", "Remove" and "Clone" buttons allowing you to add a new
channel for measurement, remove configured one or make a copy of it.

Measurement settings

If "Store raw data" is checked, the raw data (i.e., all the measurement data taken by
the test receiver) is saved in a measurement file. Otherwise, only the averaged data is
saved.

Measurement time is the time during which the test receiver acquires the measurement
data.

Average divider is a few raw data collected for an averaging value. The minimum value
is automatically set according to the measurement rate. A higher measurement rate
increases the minimum average divider.
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Figure 6-416: Measurement Settings page of the CW scanner

Channel filter

The "Channel Filter" page shows all the predefined channel filters. Each line describes
a filter which is stored in
the ...\Configuration\ChannelFilterDefinitions.xml file and is read in
into the driver at a start time.

An own filter can be designed by editing the ChannelFilterDefinitions.xml.
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Figure 6-417: Channel Filter page of the CW Scanner

Two channel filters, which also can be used for RF Power scan, are added to the chan-
nel filter list of the CW Scanner driver.
● Channel filter with 8 MHz bandwidth named DVB-T/T2 8 MHz Transm.

It is a rectangular filter with a bandwidth of 7.8 MHz.
● Channel filter with 180 kHz bandwidth, named NB-IoT LTE 12PRB

It is a rectangular filter with a bandwidth of 180 kHz. It is suitable for NB-IoT mea-
surements on an LTE in-band operation with 12 PRBs.

Support of antenna correction

The R&S TSME CW driver supports antenna correction. Based on this support, it is
possible to transduce measurement values to unit dBµV/m.

It is possible to enable and specify an antenna correction file on the configuration page
of antenna drivers. The file is a comma-separated file, that is, the antenna.csv file,
which holds frequencies and correction values. Between these frequencies, the correc-
tion values are interpolated.

At measurement time, this antenna correction file is considered.

To apply the antenna correction, change the unit for signal ESVx/EBx Average data to
dBµV/m.

Value [dBµV/m] = Value [dBm] +107dB + "interpolated correction value [dB]"

The antenna correction file is only applied if the selected unit is dBµV/m. The correc-
tion is not applied if the selected unit is dBm/dBµV.
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Views and exports

As the CW measurement data is similar to the former R&S receiver, there are no new
views and exports.

The "Alphanumeric View" and the "2D Chart View" are intended to visualize the CW
data.

ASCII export is suitable to export CW measurement data.

6.4.27  Support of multiple scanners

R&S ROMES4 supports multiple scanners for R&S TSME device.

It is possible to connect and use more than one scanner of each type.

6.4.27.1  Multiple R&S TSMEs

R&S ROMES4 handles multiple R&S TSMEs as one TSME scanner array. This han-
dling means that some R&S ROMES4 scanner drivers can be connected to multiple
R&S TSMEs. These R&S TSMEs are synchronized when connected with the proper
sync-cable (TSME-ZC2). Synchronized R&S TSMEs are displayed with the same color
in the ROMES Device Manager dialog.

Figure 6-418: Multiple R&S TSME

R&S ROMES4 LTE Scanner can be connected to one R&S TSME or to two synchron-
ized R&S TSMEs.

R&S RF Power Scanner connects automatically to all available R&S TSMEs.

All other scanners use one R&S TSME, as there is no benefit of using more devices.

LTE scanner connection to multiple R&S TSMEs

When loading the LTE scanner, select one frontend. If currently an additional synchron-
ized R&S TSME is available, it is connected to the LTE scanner as well. In this case,
select the R&S TSME which you want to use.
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If two synchronized R&S TSMEs are connected to the LTE scanner and are used, the
scanner can perform MIMO measurements. Select the R&S TSME which you want to
use as the narrow-band scanner and the R&S TSME which to use as the LTE demodu-
lator.

By default, the R&S TSME which is initially selected for loading the LTE scanner driver
is the selected device. This approach applies both when the device is used as the nar-
row-band scanner and the LTE demodulator.

Figure 6-419: LTE scanner properties

6.4.28  BTS position estimation

Estimation process

The R&S ROMES4 BTS Position Estimation function only estimates positions of trans-
mitters from which a new signal has been received since the last estimation. All other
transmitters are not estimated again, as no new data is available.

The data of the knowledge base, see "Position Estimation Knowledge Base File"
on page 1877, is used as initial state of the estimation result collector if using the
Knowledge Base function. To improve the estimation results, it is highly recommended
to use a knowledge base.

The R&S ROMES4 signals report the number of estimated transmitters for the number
of reported positions since the last estimation.

This number only reflects the number of estimated positions during the last estimation,
and not the number of all estimated positions during the complete measurement.

BTS position estimation prerequisites

To estimate a BTS position, the option R&S ROMES4LOC must be available. The BTS
Position Estimator calculates BTS locations from GSM, WCDMA, cdma2000, EV-DO,
LTE, NB-IoT, TETRA or WiMAX scanner measurements, GPS position measurements
and high accuracy PPS signals.
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Position estimation is only possible under the following preconditions:
● At least one scanner driver of the previously mentioned technologies must be loa-

ded.
● A GPS receiver supporting a PPS pulse. PPS routed to the corresponding R&S

TSME.
● The system must be moving to deliver results.

The scanner needs 100 PPS pulses to synchronize its internal time base correctly to
the GPS system. Therefore, a measurement delivers results not earlier than 2 minutes
after start of measurement.

BTS position estimation and automatic channel detection

Automatic Channel Detection can be used together with the BTS Position Estimator.

However, during the phase of adapting the timing between PSS, GPS and PC, the
ACD does not change the configuration of the scanner, even if a new channel was
detected. After the BTS Position Estimator has finished this process (which takes
about two minutes), the scanner will be reconfigured and scans the additional chan-
nels.

6.4.28.1  Load the BTS position estimation driver

The first step is to load the Position Estimator driver.

To load the driver, perform the following steps:

1. Click the "Hardware" menu.

The "Hardware Configuration" page pops-up.

2. Select the "Others" > "BTS Position Estimator" command line from the "Available
Devices" list.

3. Click the ">" button to place the driver in the "Loaded Devices" list.

4. Click "Continue".

The driver is loaded now. The loading is indicated with the added "BTS Positon
Estimator" command line in the "Hardware" menu.

Figure 6-420: Loaded BTS Position Estimator
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6.4.28.2  Scanner settings for the BTS position estimator

Click the "BTS Position Estimator" command line to get the configuration page.

By default, the "BTS Position Estimator [<variable>]" > "Scanners" page allows you
technologies and scanners to include/exclude for position estimation.

Figure 6-421: Case not all scanners are optimized

Figure 6-422: Case all scanners are optimized

The Position Estimation algorithm supports the 5G NR scanner data. Analog to the
other technologies, the scanner can be loaded and the position estimator can be con-
figured to estimate the positions and antenna directions of the detected cells.
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As a cell identity is often not available in 5G non-standalone networks, the identification
of the cell has to be done by frequency and PCI. Do the position estimation per cluster
to ensure that PCI is unique per cell on a certain frequency.

Figure 6-423: Position estimation enabling for 5G NR scanner

The position estimation is done per PCI. The estimated position is mapped to all
beams of the PCI in the "5G NR BCH View".

The following parameters in the "BTS Position Estimation" dialog can be set.

Included Technologies
Default technologies are automatically included. The check-boxes per technology let
you include or exclude certain technology.
The results are shown in the "<RAT> BCH View" and the "ROMESMAP Route Track
View".

Included Scanners
The available scanner drivers of the included technologies are shown in the "Included
Scanners" list.
All scanners are included per default in the position estimation process. The check
boxes per scanner let you include or exclude certain scanner in the list.
If you select a scanner in the list, its configuration details are shown in the "Details of
the highlighted Scanner" field.
TIP: For getting better results, it is recommended to set the average measurement rate
for the scanner as high as possible. The measurement rate for each scanner is config-
ured directly within the configuration menu of the scanner driver.
Note: The NB-IoT scanner requires a lot RF time of the scanner device. Thus, the
scanner measurement rates for other technologies can drop significantly. This drop can
lead to the worse position estimation results compared to those results you can get
without the NB-IoT scanner.
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Scanner Optimization
The BTS Position Estimator checks if the settings of the scanners are optimal for posi-
tion estimation. The scanner settings for the position estimation are signaled in the
"Scanner" page. Three states can be signalized by a red, yellow and green dot in the
upper right corner of the "Included Technologies" field.
In general, the scanners have to be configured to produce as many as possible result,
measured with the most sensible algorithm. Disable all measurements which are not
used for the position estimation process. Also, demodulate only the necessary broad-
cast messages.
● Green: All scanners are set up with the optimal configuration for position estima-

tion.
● Yellow: Some of the scanners are not configured optimal for position estimation.

The scanner delivers the necessary data and allows a measurement to start.
● Red: Mandatory settings for using the position estimators are wrong. Such a wrong

mandatory setting can be a synchronization method other than PPS or missing
GPS driver.

The BTS Position Estimator optimizes scanners settings automatically. There are two
optimization options.
● "Optimize all Scanners": All included scanners are optimized.
● "Optimize highlighted Scanners only": Only the highlighted scanners are optimized.
Note: If some essential settings of the scanner are currently not correct (for example,
missing specified frequency or channel), the optimization can fail.
The configuration page of the scanners can also be opened by a double-click the item
in the list.

6.4.28.3  Estimation settings for the BTS position estimator

The Position Estimator parameters are set in the "BTS Position Estimator" > "Estima-
tion settings" page.
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Figure 6-424: Estimation settings

The following parameters can be set.

Min. position error (estimation cutoff)
Defines a distance in meter which limits the position estimation to a reasonable accu-
racy for performance reasons. If the 66% probability of the estimated position falls
below this distance, the estimation process for this transmitter is finished.

Update rate of results
Defines the period in seconds between estimation orders for the position estimator.
After executing the estimation order, the new position estimation results will be reques-
ted from the position estimator and will be stored in the measurement file (*.rscmd).

The result frames are distributed to R&S ROMES4. They can be viewed in the scanner
BCH views of all RATs containing BCH that R&S ROMES4 demodulates.

Tower Merger Mode
By assuming that several transmitters are on the same tower (geographic position), the
estimation algorithm can improve the estimation accuracy significantly.
The following tower merging modes are supported:
● "Off"

Prevents merging the position of towers
● "Moderate"

Ensures that no signals are merged by mistake at the cost of less merged signals
● "Aggressive"

Improves the number of merged signals at the cost of a higher probability of wrong
assumptions

The moderate and aggressive merger modes are both based on counting the number
of "positive indications". The modes only differ in criteria for the positive indication and
the needed number of indications for merging.
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The positive indication means that the sectors are synchronized, i.e. the sectors were
measured within a start-stop cycle of a scanner and met the arrival time condition.
In moderate tower merger mode the estimator assumes that the sectors belong to the
same tower if at least 5 positive indications were found fulfilling the additional distance
requirement. The measurements must be collected at least 200 m away from a straight
line. This line represents a major axis of a least square fitted ellipsis created with all
candidate measurement locations. The positive indication is counted if the following is
fulfilled:
● Arrival time difference is less than 1 µs
● At least 5 such measurements at different locations were collected
● Both sectors are measured within 0.5 sec or, when the measurement distance is

less than 100 m, within 10 sec
In aggressive tower merger mode the estimator assumes that the sectors belong to the
same tower if at least 3 positive indications at different locations were found. The posi-
tive indication is counted if the following is fulfilled:
● Arrival time difference is less than 2 µs
● At least 5 such measurements at different locations were collected
● Both sectors are measured within 0.5 sec or, when the measurement distance is

less than 1000 m, within 20 sec
If the signal arrival time difference is bigger than 4 µs, different tower locations for sec-
tors are assumed both in moderate and aggressive tower merger modes.
The mode can be configured separately for each radio technology, as each technology
has additional preconditions for merging.
Table 6-21: Technology dependent merging precondition

Technology Remarks concerning tower merger

GSM The time offsets are measured between both hyperframes (51 * 26 * 2048 TDMA
Frames; about 3.48 hours frame duration). Both GSM signals must have equal
MCC/MNC but different frequencies.

UMTS The time offset is measured between the 10ms radio frame of a signal and a time
shifted 10ms radio frame of the other signal. The allowed time shift is +/- 256 chips or
+/- 512 chips. Both WCDMA signals must be transmitted at the same frequency and
equal MCC/MNC but the primary scrambling code must be different.

TETRA The time offsets are measured between timeslots (14.167 ms duration). For accurate
time of arrival estimation, only the slots containing sync bursts are used. For tower
merging, both signals must have the same MCC/MNC and LA but different carrier
numbers.

LTE The time offsets are measured between the 10 ms frames of both stations. The refer-
ence signals are used as markers. For tower merging both signals must have the
same carrier frequency, MCC/MNC but different physical cell IDs.

cdma2000 The time offsets are measured between PN code sequences (26.66 ms). Both
cdma2000 signals must have equal PN Offset, SID, NID, REG_ZONE and BASE_ID
but different frequencies.

Note: A cdma2000 network can be configured in a way that all these parameters are
equal at different channels.

EV-DO The time offsets are measured between PN code sequences (26.66 ms). Both EV-
DO signals must have equal PN Offset SECTOR_ID128 or SECTOR_ID24 but differ-
ent frequencies.

Note: An EV-DO network can be configured in a way that all these parameters are
equal at different channels.
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NB-IoT No NB-IoT specifics

5G NR No5G NR specifics

Position Estimation Knowledge Base File
● "Use selected Position Estimation Knowledge Base File"

Use or not a knowledge base file to enhance later measurements. If the flag is
checked, the currently selected knowledge base is sent to the position estimator at
the start of measurement. The knowledge is used in the estimation process if at
least one estimation was executed. The knowledge base of the estimator is written
to the current knowledge base file (overwriting the old contents).

● "Discard all measurements older than xxx hours when storing the KB"
For performance reasons and data volume limiting; The option to discard older
measurements (than <xxx> hours) from the knowledge base when storing the file.

 Button
The pathname of the current position estimation (PE) knowledge base file. By pressing
the "…" button, the file can be selected in an enhanced file chooser dialog, which
shows also a summary of the content of the selected knowledge base. Also a new
(empty) knowledge base can be created in the file dialog by typing a new file name and
pressing "OK". The extension .pekb is automatically added if not already specified.

Clear Knowledge
The content of the current knowledge base file can be reset to the initial empty content
by using this button.

Add Measurement File
This function allows you to add your measurement files to the Knowledge Base File.
To add the measurement files, load the Position Estimation driver into R&S ROMES4
and select the "Estimation settings" page.

Export
The driver allows you to export the content of the given knowledge base file. The con-
tent looks like here shown.
#,MinUtc,MaxUtc,Network,MaxPower[dBm],Frequency[kHz],TowerID,Longitude[°],Lati-
tude[°],l1[km],l2[km],phi[°],Estimation,Direction,ConfidenceInterval,MCC(GSM/UMTS/
TETRA/LTE/5G NR),MNC(GSM/UMTS/TETRA/LTE/5G NR),LAC(GSM/UMTS/LTE/
TETRA/5G NR),CellID(GSM/UMTS/LTE/5G NR),PCI(LTE/5G
NR),BSIC(GSM),SC(UMTS),NID(cdma2000),SID(cdma2000),BaseID(cdma2000,EVD
O),PN(cmda2000/EVDO),Country-
Code(EVDO),Sector24ID(EVDO),BtsID128Bit(EVDO),BaseStationID(WiMAX),Seg-
ment(WiMAX),Cell(WiMAX),Preamble(WiMAX)
The following table provides description of the file content.
Table 6-22: Exported data of the Position Estimation Knowledge Base file

Content RAT Description

UtcMin All The first time when this BTS was measured

UtcMax All The last time when this BTS was measured
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Content RAT Description

Network All GSM, UMTS, LTE, NB-IoT,...

MaxPower All Max. received power of the transmitter

Frequency All Frequency of transmitted signal

TowerID All ID of the tower. This ID is assigned by the tower merger
and is used only internally

Longitude All Estimated longitude

Latitude All Estimated latitude

l1. l2, phi All Error ellipse of estimated position

Estimation All Type oif estimation. Estimation is based on power or
time

MCC GSM, UMTS, TETRA,
LTE, NB-IoT

Mobile Country Code

MNC GSM, UMTS, TETRA,
LTE, NB-IoT

Mobile Network Code

LAC GSM, UMTS, LTE,
NB-IoT, TETRA,

Location Area Code, respectively Location Area for
TETRA

CellID GSM, UMTS, LTE,
NB-IoT

Layer 3 cell identity

BSIC GSM Base Station Identity Code

SC UMTS Scrambling Code of NodeB

PCI LTE, NB-IoT Physical Cell Identity for eNodeB

NID cdma2000 Network ID

SID cdma2000 System ID

BaseID cdma2000/EV-DO BaseID of the 3GPP2 transmitter

PN cdma2000/EV-DO PN-offset of the 3GPP2 transmitter

CountryCode EV-DO Country code of the EV-DO transmitter

Sector24ID EV-DO 24 bit sector ID of the EV-DO transmitter

BtsID128bit EV-DO 128-bit Layer 3 transmitter ID of the EV-DO transmitter

Segment WiMAX Segment of the WiMAX transmitter

Cell WiMAX Cell of the WiMAX transmitter

Preamble WiMAX Preamble of the WiMAX transmitter

Note: This file is for information only and cannot be imported as transmitter list into
R&S ROMES4 again.

Show File Info
The button displays a dialog which shows details of the content of the current knowl-
edge base file. The provided details are the same as the info shown in the file chooser
dialog.
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6.4.28.4  TecPE: signals of the BTS position estimator

Figure 6-425: Overview of the available signals for Position Estimator

The signals allow error conditions detection and monitoring the progress of the estima-
tion process.

The status of the position estimator is polled every 5 seconds during the first minute of
measurement and in this time the Estimation Status goes to OK.

If the Estimation Status OK is reached, the estimation cycle is started and estimation
results are reported periodically.

6.4.28.5  Measuring with the BTS position estimator

Preconditions
● This measurement mandates that the scanner is used with a PPS signal, so this

request must be provided by the hardware and software setup.
● With a scanner a GPS source and a PPS signal available, a measurement can be

configured.
● The estimation process needs from each transmitter a set of measurements which

are taken from different locations.
● The locations are distributed in a larger area and are not on a single straight line.

Useful patterns could be a round trip or two lines with a large crossing angle or par-
allel lines in a reasonable distance.

The current position estimation results can be viewed during a measurement in the
scanner BCH view of all RATs for which R&S ROMES4 demodulates BCH.

The Position Estimation algorithm also tries to estimate the direction of each sector/cell
(=azimuth), that is, makes the azimuth estimation. Apart from displaying the azimuth
values in the BCH views, the BTS symbols are displayed on the map accordingly. The
following figure of the "5G NR BCH View" shows the sector/cell direction.
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Figure 6-426: BCH View - position estimation details

6.5  Quality of service

This chapter is dedicated to data quality testers which test and analyze services inde-
pendent on devices on which the services run or technology. They can be loaded as
explained in Chapter 6.1, "Devices", on page 1447, however, the ports (if needed) are
assigned in the device configuration menus.

● Data quality tester (DQA)....................................................................................1880
● DQA jobs with Android OS-based smartphones.................................................1961
● DQA jobs with iOS-based smartphones..............................................................2049
● DQA KPIs aggregation in KPI generator.............................................................2060

6.5.1  Data quality tester (DQA)

The Data Quality Analyzer (DQA) controls the measured parameters and assesses the
Quality of Service (QoS) of any kind of data transfer connections using the R&S
ROMES4DQA option. In the further text the DQA is also named the data quality tester
(also the DQA tester).

For the installation of the tester, see Chapter 6.1.2, "Hardware dialog for loading devi-
ces", on page 1449.

The DQA obtained data can be viewed in the "View" > "QoS Views" > "DQA" pages,
see Chapter 3.3.15.1, "DQA", on page 180.

DQA sets the tester's state according to the test results to:
● OK if any job has a failure rate less than 20% of the last 5 executions.
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● WARNING if any job has a failure rate more than 20% of the last 5 executions.
● ERROR if any job has a failure rate more than 80% of the last 5 executions.

6.5.1.1  Resources configuration DQA

The DQA is loaded by selecting the "Quality of Service"> "Data Quality Analyzer"
branch in the "Available Devices" pane of the "Hardware Configuration" page. Click the
"Hardware" > "Connect/Disconnect" menu entry to get the page.

When the tester is installed, the entry "DQA[1]" is added to the "Hardware" menu. Click
"DQA[1]" to open the DQA configuration page letting you set up different types of con-
nections.

The DQA loading does not require any hardware or additional test devices. The data
quality tester can be used to test the QoS of any kind of physical connection between
the test system and a remote entity.

The connection can be a network connection established with test mobiles supporting
any mobile technology or a fixed connection to a remote server accessible from the
test system.

If test mobiles are used, the results of the DQA complement the information acquired
with the test mobile device.

6.5.1.2  DQA settings

To configure the QoS test that you are interested in, select and arrange jobs available
in the default opening page "DQA Settings" of the "DQA[1]" menu entry. The page is
fully editable with keyboard. The focus is visualized over all control buttons.

Speech quality and voice test are supported. Simple and extended voice call tests can
be set in the UE configuration. If a voice test is configured in the DQA job list, the UE
configuration is overwritten.

The available jobs are grouped by the job types in the "DQA Settings" > "Available
Jobs" list. The list has a tree structure. The branches of the tree and the jobs they
include depend on a mobile device type and its supporting operation "Mode".

The R&S ROMES4 DQA supports for the On PC testing (Classic mode) devices the
following jobs or groups of jobs:
● Connect to Network
● Call Session Start
● Disconnect to Network
● Call Session End
● HTTP
● FTP
● Performances
● Miscellaneous
● Mobile
● Batch
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The first four previously listed entries are DQA jobs, other are groups of jobs of the
similar type.

For the DQA jobs which support devices configured in fully integrated device use
mode, see Chapter 6.5.2.1, "DQA jobs with fully integrated devices", on page 1962.

Click a branch to expand the tree and see all the available jobs.

Figure 6-427: DQA configuration page

It is possible to mix available jobs. Select a job from the "Available Jobs" list and drag
and drop it into the "Job" pane.

For example insert them in the following order:

1. Data Session Start

2. FTP DL

3. Data Session End

4. Call Session Start

5. Call Any Number

6. Call Session End

A voice or speech quality test is performed in parallel with one or two data jobs. The
data jobs run sequentially.
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For the configuration of speech quality and voice tests, see the case of the devices
operating in fully integrated device use mode shown in Chapter 6.5.2.5, "Voice and
speech jobs", on page 1973.

Actions
The following functions are part of the "Actions" pane.

Linked Devices ← Actions
Loaded devices are listed in the drop-down box. Select a device from here for direct
DQA usage.
The DQA direct usage means that devices in this box are in use by data quality tests
and an analysis instance and cannot be used by other analysis instance.
A log file to run each test is created in the <My ROMES>/LogFiles directory.
How to include a device in the list, refer to Chapter 6.1.3, "Connection via COM port",
on page 1454.
The value "<None>" selected in "Linked Device" switches the DQA back to On PC test-
ing (Classic mode) use mode.
The app for the "Diversity Data" tests is installed and updated automatically when such
tests run. As for the mobile, change its settings by clicking "Settings" > "Developer
Options" > "USB-Debugging". No further mobile station manual preparations are nee-
ded.

Mode ← Actions
Possible modes of operation of the DQA available jobs. The selected mode depends
on a mode of operation a device can support.
You can select among the following modes:
● On PC testing (Classic mode) mode
● Classic mode 2
● Fully integrated device mode (QualiPoc)
● IPhone mode

Available Jobs ← Actions
A list of DQA jobs available for quality test and analysis.
Drag and drop or double mouse click the selected job to move it to the "Job" pane. The
job's configuration page opens where you can connect/select a test file of definite size
for transfer.

Job ← Actions
Once configured, the job is included in the "Job" pane.
The jobs in the "Job" pane are executed in the following order of appearance in the
pane.
1. A job sets up a call to a network provider.
2. Downloads a file from a service remote server.
3. Waits for a predefined time period.
4. Releases the call from the network provider.
The entire job list is executed repeatedly as long as the DQA measurement is running.
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It is possible to change the name of a job to a custom name directly from the list. Click
the name and change it.
Note: Name of jobs used in a multi RAB session cannot be changed.
Note: It is not possible to calculate ETSI trigger points if a job runs more than once in a
session loop.
In the "Count" row you can define how many times the selected DQA job has to be
executed in a session loop. The default value is 1.
Click the column and insert preferred value. The value in the "Count" row is displayed
only for the entries in the list that allow change.

Buttons ← Actions
● "Configure"

Opens the configuration page of a selected job. The job's configuration page can
be opened also when double-clicked the job.
The opened page provides address fields for the remote access and additional set-
tings, for example, timeouts. Each job has own configuration page. The button is
disabled if there are no jobs in the "Job" pane.

● "Remove"
Removes the job selected in the "Job" pane.

● "Copy Job"
Duplicates the job selected in the "Job" pane.

● "Rename (F2)"
Rename an action by pressing this button or use F2 function of your keyboard.

● "Move Up"/"Move Down"
The jobs in the list can be moved up and down using these buttons, respectively.

● "Create Batch"
Creates a batch job for reusing. Click the button to define a name of a new batch
job. For details, see Chapter 6.5.1.4, "Configuration menus for the DQA jobs",
on page 1891.
The feature is helpful for setting up AT command scripts for NB-IoT and for normal
tests.

● "Add to actions"
Adds available jobs.

● "Delete Batch"
Deletes the created batch job.

● "Save Batch"
Edits existing batches and saves them. For details, see Chapter 6.5.2.12, "Batch
for fully integrated devices", on page 2047.

Note
Shows a description of the job selected from the job list.

Session Watch Dog
A watch dog process monitors the activity of the network adapter of the used connec-
tion during a current DQA job session.
Check the associated combo.box to consider the session as dropped if the current job
seems to hang due to no response from the network for the specified time.
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Extended Features
The "Extended Features" pane supports IP tracing, timing / statistics of a DQA session
control, test files and job servers creation.
The IP Tracer is activated in the job configuration menu, as shown in Figure 6-435.
The following functions are part of the "Extended Functions" pane.

Use IP Address Family ← Extended Features
Lets you select the wanted IP address version. The views show IP of the accessed
server in the selected IP version's format.
Note: A job fails if IPv6 is selected and a job establishes a connection to a server
which only supports IPv4 and vice versa.

Write QualiPoc IP Trace into ROMES Measurement File ← Extended Features
This function is not applicable for the devices operating in Classic mode and the line is
dimmed.
. The function is only available in fully integrated device use mode (QualiPoc mode) of
smartphones with Android OS with SQ Android interface, see Chapter 6.5.2.1, "DQA
jobs with fully integrated devices", on page 1962.

Create a PCAP File with QualiPoc IP Traces ← Extended Features
This function is not applicable for the devices operating in Classic mode and the line is
dimmed.
The function is only available in fully integrated device use mode (QualiPoc mode) of
smartphones with Android OS with SQ Android interface, see Chapter 6.5.2.1, "DQA
jobs with fully integrated devices", on page 1962.

Synchronize QualiPoc Test Executions ← Extended Features
This function is not applicable for the devices operating in Classic mode.
The function supports synchronization of DQA job execution for QualiPoc tests of dif-
ferent UEs. To activate this function, "Synchronize QualiPoc Test Executions" has to be
enabled for each QoS (UE) whose job executions you want to synchronize.
For the supported cases of synchronization of DQA job execution for QualiPoc tests,
see Chapter 6.5.2.1, "DQA jobs with fully integrated devices", on page 1962.

More ← Extended Features
Opens the "More Extended Features" page.
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Figure 6-428: Selecting extended features

How to execute the job list and how often is configurable in the check boxes of the
"Measurement Session Control" pane.
The following options are configurable in the pane:
● "Start Job List at Start of Measurement"

If active, the entire "Job" list is automatically started when the QoS measurement is
initiated ("Measurement" > "Start Measurement"). Otherwise, it is paused and can
be initiated via "Action" > "DQA" > "Enable DQA".
If the job list has been changed at the start of a measurement, the function is
improved with the option to start jobs of all loaded QoS testers.
At pressing the "More Extended Features" > "OK" button, the message box pops-
up asking you if to start jobs for all loaded QoS testers.
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Figure 6-429: Activation of all measurement for jobs of all loaded DQAs

Press "OK" in this message box. The setting for "Start Job List at Start of Measure-
ment" is immediately set in all loaded QoS testers.
In the "Action" menu there are the menu entries to activate/deactivate all load QoS
testers at once.

Figure 6-430: Entries associated to the option

● "Max. number of DQA loops"
Limits the scope of the DQA measurement to a maximum number of job lists
(loops) to be executed. In addition, it is possible to specify whether all loops or just
the successful ones are counted.

● "Retry Connect Job when failed"
If selected, R&S ROMES4 tries to dial up to the network repeatedly in case the
previous connection failed.

"GPRS/UMTS Mobiles" controls a packet switched (PS) data connection through a
GPRS or UMTS mobile. The following parameters are configurable:
● "Detach Mobile..."

The option is enabled after an appropriate GSM or UMTS mobile device is loaded
and the virtual COM ports have been assigned, see Chapter 6.1.4, "Connection via
USB interface", on page 1456. It is possible to force the PS service to be detached
before start of the measurement and after each Disconnect job.

● "Check Service Availability Timeout"
Allows checking if the network supports the PS service. PS support is indicated
through Layer3 System Information messages or blocks. For GSM/GPRS net-
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works, it is possible to specify a timeout after which a network is considered as not
supporting the PS service.

"Timing" allows an additional idle time to set after:
● "GPRS unavailability was detected"
● "DialUp failed (blocked)"
● "Connection dropped"

Create Test Files ← Extended Features
Click the "Create Test Files" button to open the page where you can define the size
and the format ("Text File" or "Binary File") of a test file. The file can be stored to a local
directory and used for file transfer to a remote location. The contents of the file are ran-
dom.
A file of definite size is useful for many DQA applications.

Figure 6-431: Create test file

Job Servers ← Extended Features
The "Job Servers" button lets you preconfigure the FTP and HTTP job servers provid-
ing easier and faster job configurations later.
Click the button to open the "DQA Job Servers Configuration" page.
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Figure 6-432: DQA Job Servers configuration

DQA Job Servers Configuration ← Job Servers ← Extended Features
The "Servers" pane shows the list of pre-configured DQA job servers if available. The
"Properties" pane edits the properties of a job (service) supported by the server
selected in the list.
The QoS Job Servers configuration simplifies and improves a server configuration in
the following aspects:
● The "Add New", "Add Coppy" and "Remove" buttons are visually clear connected

to the list of configured servers.
● After a new server or a copy of the previously selected one is added, only the new

created server is selected.
● "Remove" supports multiple selections.
● The change of the selected server triggers "Apply Changes" automatically.
● If on the "Properties" pane something wrong is edited (for example, "60s" instead

of "60" in the "Max. Transfer Time") and you try to select another server, an error is
reported. The new selection is refused.

Properties ← DQA Job Servers Configuration ← Job Servers ← Extended Fea-
tures
Check the "Properties for QualiPoc Job" combo box if the DQA job is QualiPoc suppor-
ted.
To configure a DQA job server, the following properties have to be defined:
● "Name"

The name of a DQA job server
● "Service"

The services to be supported by the server:
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– FTP download and FTP upload
– HTTP download and HTTP upload

● "URL"
The target URL of the server.

● "User"
The user name to get access to the server.

● "Password"
The password for the user.

● "File"
– The FTP file to be downloaded from a server or uploaded to a server.
– HTTP n/a
Browse the file with "…".

● "Target Directory"
– Target directory where to store the downloaded FTP file.
– Target directory where from to upload the FTP file.
– HTTP n/a
Browse the directory with "…".

● "URL File Size"
● The size of a file to be downloaded or uploaded and the unit.
● "Full Transfer"/"Fixed Duration"

The options are mutually exclusive. If you select full transfer, the option to fix the
transfer duration is disabled and vice versa. For details, see the "HTTP download /
browsing" on page 1979 and "DQA FTP download" on page 1985.

● "Max. Transfer Time [s]"
Limits the transfer time of a job, the range is from 0 [s] to 36000 [s].

● "FTP Passive"
If checked, the FTP passive connection is activated.

● "FTP Get File Size"
If checked, the file size of the download file is retrieved.

● "Store Data File On Disk"
Stores data file on disk for FTP DL.

● "Delete Files after Download"
Deletes files after download for FTP DL.

The available buttons, apart from those buttons mentioned in the "Servers" pane are:
● "Apply Changes"

Writes the changes in the properties of the selected DQA job server.
● "Save"

Stores the configuration to
the ..MyRomes\Configuration\DQAJobServers.xml configuration file.

Stop a DQA Job ← Extended Features
It can happen that a DQA job stop takes longer than 30 seconds. Continue to wait
when time-out happens, as recommended in the notification that pops-up.
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Figure 6-433: Notification of stop DQA

If stop DQA is aborted, it is highly recommended to restart R&S ROMES4.

6.5.1.3  DQA RAT settings

Data packet sizes can be specified for different RATs in the "DQA RAT Settings" page.

The specified size defines the size of one service data packet to be sent at once on a
service data socket (FTP, HTTP, etc.).

The recommend values of the data packet sizes are given in the following figure.

Figure 6-434: Default packet size settings for different RATs

Different values for download and upload can be defined.

The RAT's "Unknown" value applies if the DQA is not in relation to a mobile device or
the device cannot detect the current RAT.

6.5.1.4  Configuration menus for the DQA jobs

The following chapters describe the configuration of the DQA jobs available for On PC
testing (Classic mode) devices.

The pages to configure a job open by selecting the job from the "DQA[1]" > "DQA Set-
tings" > "Available Jobs" list or by dragging the job to "Job" pane.
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The "Connect to Network" page opens also when reconfiguring a job present in the
"Job" list (the "Configure" button).

Connect to network

The "Connect to Network" configuration page lets you select a network link and refer-
ence server and define the idle time intervals for redialing.

To configure the job, simple move a part of the ROMES DQA Dialup configuration to
"Dialup" pane of the "Connect to Network" page.

To configure the job's parameters of a used reference server and timing, click
"Advanced". The "Advanced Connection Settings" page opens, see Figure 6-438.
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Figure 6-435: DQA Connect to Network page

The DQA "Connect to Network" entries are listed in the following sections.

Link
The "Link" pane contains the following parameters:
● "Type"

Three different link types are available:
– "Windows Dialup" requires a modem port of the device under test.
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– "Windows Network Adapter" allows choosing one of the existing network adap-
tors. The Connect to Network job does not connect or disconnect this connec-
tion without trigger. This link type is typically used for WLAN measurements.

– "ROMES DQA Dialup" is default type. Dialup wizard allows defining all neces-
sary access parameters. The ROMES DQA Dialup type is mandatory if the
NDIS interface of the test UE is used. In this case, the DQA requests connect-
ing to and disconnecting from the test UE device.

● "Device"
A list of available modems or network adapters.

Dialup
The "Dialup" pane lets you select an operator from the list of operators of a selected
country, choose the network type and execute the existing configuration changes or
testing using the available buttons.
Choose a country from the pull-down menu and select an operator from the given list.
The 3GPP or non-3GPP RAT networks are selected with the "Network" buttons.
To confirm selections, click "OK".

Configure/Add ← Dialup
The user can reconfigure parameters of a provider selected from the provider list
("Configure" tab) or add a new one ("Add" tab). If one of these tabs is clicked, the fol-
lowing dialog opens.

Figure 6-436: Provider configuration

Delete ← Dialup
Deletes selected provider from the provider list.

DQA Connection for Test
Opens a dialog where you can create a dial-up connection for testing.
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IP Tracing (no license)
The following parameters are used to configure IP tracing in the "IP Tracing" page:
● "Enable Tracing"

If the purchased option is activated, this flag enables the IP protocol sniffer for this
connection.

● "Update Rate"
The time span within which the results are written into a *.rscmd file.

● "Store IP Tracer Data to Measurement File"
The IP tracer data are written to measurement file only if this option is selected. By
default it is unselected.
When the IP trace data are not written to the measurement file, the data are not
visible in the Layer 3 view and the CAP/PCAP export is not possible. Then the data
is only used for KPI calculation.
The option is also available if a smartphone is selected for connection.
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Figure 6-437: IP tracer data store supported for smartphones

Note: IP tracer results are shown in the 2G/3G Layer 3 view, see Figure 4-567.

WiFi usage
See Chapter 6.5.1.4, "Configuration menus for the DQA jobs", on page 1891.

Advanced
Opens a page to define additional connection settings.
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Figure 6-438: Advanced settings in Connect to Network

Reference Server ← Advanced
The name of the reference server to ping. The name can be URL or the IP address.
The reference server is used to check whether a packet switched connection can be
established and to define a time limit for setting up the connection.
"Max. Number of Tries" defines the maximum number of pings sent to the reference
server before the system assumes that the dial-up has failed and aborts the job.

Timing ← Advanced
Defined are:
● "Idle Time before Dialing"

Idle time interval between the start of the job and dialing (the "QoS Message View"
displays the message "Waiting <n> milliseconds before dialing", see Figure 6-447).

● "Idle Time after successfully connected"
Idle time after successful connection.

● "Connection Timeout (ms)"
Time-out due to unsuccessful connection.
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TCP Settings ← Advanced
Opens a dialog to define additional connection settings.
● "TCP Window Size"

The flow of data is controlled by the TCP window size. It defines the maximum data
(in bytes) which can be received at once into the TCP buffer without losing any
TCP packet. The configured TCP window size guarantees how many data can be
received at once without problems and represents also an overload protection
mechanism.

● "TCP max. Number of outstanding ACKs"
Specifies the number of acknowledgments that are outstanding before the delayed
ACK timer is ignored. Microsoft does not recommend changing the default value 2
without careful study of the environment.

● "TCP ACK Interval Timeout"
Specifies the time interval that defines the end of a segment stream. If this interval
elapses between the receipts of TCP segments, TCP considers the segment
stream complete and sends an ACK message to acknowledge the segment. Other-
wise, TCP acknowledges every other segment only. The default value is 200 ms.
This default value effects only when the angle algorithm is enabled.

Routing ← Advanced
Check the "Use Gateway for Routing" check box if connecting with a network adapter,
but also dependent on LAN. If checked, the route to the destination server (e.g. an FTP
server) is created through the LAN’s default gateway.
Note: Standard gateway for routing must be enabled for any DQA job which uses
external windows programs, such as Internet Explorer. This option can be enabled in
the advanced settings of the "Connect to Network" dialog.

DQA connect job using tethering mobiles

Tethering allows sharing the Internet connection of a mobile phone with a PC. Smart-
phones based on Android OS, such as the Samsung Galaxy family, support tethering.

The DQA supports tethering mobiles. If tethering is activated on the mobile, the
mobile’s network adapter can be selected in the "Connect to Network" configuration
dialog by selecting the "Windows Network Adapter" option from the "Type" list.

Quality of service



Hardware ComponentsDrive Test Software

1899Operating Manual 1171.6415.12 ─ 66

Figure 6-439: Tethering activation for Samsung mobile

If the mobile device is loaded, the device's name is displayed and the DQA is linked
with the device.

It is possible to use other tethering mobiles in other DQA instances. However, in this
case, the servers in the DQA jobs (for example, FTP, HTTP) are assigned with their
native IP addresses. The reason is because all the tethering mobiles use the same
internal DNS server. The following figure illustrates the case.
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Figure 6-440: IP configuration for device 3 and 4

It is not possible to use the DQA HTTP jobs with Internet Explorer with more than one
DQA instance.

To avoid undesired traffic on the network adapters, close other Windows applications
that use Internet, as the default gateways of the tethering mobiles with their routes are
still available.
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DQA connect job using WiFi for data transfers

DQA Connect to Network job offers the option to select a mobile network type, which is
then used for data transfer with smartphones.

Figure 6-441: WiFi usage options

The user can select between the following network types:
● "Mobile Network only"

Only the mobile network is used for data transfers. The WiFi usage of the mobile is
switched off. Also the WiFi scanning of the mobile is disabled.
NOTE: When in this mode, do not switch on WLAN manually in the mobile during
the measurement.

● "Mobile Network / WiFi combined" (the current mode)
If the mobile is connected to a WiFi network, WiFi is used for data transfers. Other-
wise, the mobile network is used.
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Figure 6-442: DQA messages in mobile network / WiFi combined mode

● "WiFi only"
Only the WiFi network is used for data transfers. If the mobile is not connected to
WiFi network, the connect job fails.

Figure 6-443: DQA messages in WiFi only

NOTE: It is highly recommended for this mode not to switch off WLAN manually on
the mobile during the measurement.

Invalid connect to network job of a workspace

If a DQA session contains more than one connect job and these jobs are not valid any-
more, the "DQA Configuration Error" page reports a problem.

The instance of a DQA tester or its customized name, e.g. "HUAWEI mobile Connect -
3G Modem" in the figure, is displayed in the window caption of the dialog.
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Figure 6-444: DQA configuration error

The "Apply selection only for the current connect job" function lets you execute the
action for a single connected job. By default, the selection function applies to all con-
nected jobs.

Choose whether to ignore the problem, reconfigure or remove connected jobs by
choosing one of the following entries:
● "Reconfigure Job"
● "Remove Job"
● "Ignore"

DQA templates

The settings of the UE are written in one template file. The UE template files contain
the settings which are linked with the DQA settings and vice versa.

On loading a template file, R&S ROMES4 checks if the template contains settings of
other devices and applies the template to it if the device is applicable. On loading, not
only the settings of the UE but also the DQA settings are overwritten.

If saving a template which contains a Connect to Network job with "ROMES DQA
Dialup", the system asks whether to store the provider's settings of the job in the tem-
plate.

Quality of service



Hardware ComponentsDrive Test Software

1904Operating Manual 1171.6415.12 ─ 66

Figure 6-445: Store the settings

If you select "No", the system asks for the provider while loading this template next
time.

Disconnect from network

The "Disconnect from Network" dialog lets you define an idle time in seconds between
disconnection from the network and start of the next job defined in "Job" list. For more
details, see Chapter 4.6.2.2, "DQA message view", on page 1072.

Figure 6-446: Setting of Disconnect from Network

"DQA Message View" displays message Successfully Disconnected before the Discon-
nect from Network job performs the idle time. The length of the idle time is also dis-
played in the "DQA Message View", example given, "Waiting 5000 ms…".
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Figure 6-447: DQA Message View - Disconnect from Network

HTTP

HTTP download

The "HTTP Download" configuration dialog lets you download a file using TCP/IP on a
target web server. The downloaded file is displayed in a HTTP browser and printed
using "Action".
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Figure 6-448: HTTP Download job - configuration

The "Configured Servers" pane shows all the preconfigured servers for HTTP Down-
load job. Double-click an entry in the list to save the preconfigured server in the
"Server" pane of the "QoS Job Server Configuration" dialog.

File
The following properties of a preconfigured server are available:
● "URL"

Uniform Resource Locator encodes the link to the file to be downloaded, see
"Properties" on page 1889

● "Target"
The target directory, see "Properties" on page 1889

● "Time Based HTTP Download"
The HTTP download is time-based which means that the download is stopped suc-
cessfully after a defined time. The real transfer time can differ from the defined
time, dependent on the current data rate and the transfer packet size.
Example: Defined transfer time is 10000 ms and a data packet of 128 kb is
required on a data socket at 9500 ms. The transfer stops when the complete
packet is transferred at the data socket. The transfer can take a couple of seconds
if the current data rate is slow.

Browser simulation
Specifies the maximum number of simultaneous connections. It limits the number of
HTTP connections.

Options
● "Socket Connect Retries"

Number of retries if a socket connection fails.
● "Socket Timeout [ms]"
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Timestamp when the socket closes the connection without having received data.
The socket time-out function is used to limit the transfer time and thus the amount
of transferred information.

● "Packet Size [Bytes]"
The socket connection is started only if the route is created. If the route is not cre-
ated in the wait time, the job fails. Default is 5000 ms.

Note
Download of a single file with a size greater than 5 MB is not stored to a file in the tar-
get folder to avoid memory exhaustion. However, the calculation of the transfer data
rates continues.

Figure 6-449: DQA message about exceeded file size

During the measurement, a note that the file cannot be stored is shown in the "DQA
Message View".

Add To Servers
Select "Add To Servers" to add the current configuration with the available properties
listed previously to the "Configured Servers" pane. Before storing the configuration,
define the server name.

HTTP upload

The "HTTP Upload" configuration dialog lets you select a file for uploading by using
TCP/IP to a target web server.

To open the configuration dialog, double-click the "HTTP" > "HTTP Upload" in the
"Available Jobs" pane.
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Figure 6-450: HTTP Upload job - configuration

"Configured Servers" shows all the preconfigured servers for the HTTP Upload job.
Double-click an entry in the list to save the preconfigured server in the "Server" pane of
the "QoS Job Server Configuration" dialog.

The following properties of a preconfigured server are available:

"File" pane
● "URL"

Uniform Resource Locator encodes the link for uploading a file, see "Properties"
on page 1889.

● "File"
The file to be uploaded, see "Properties" on page 1889.

● "User"
The user name for the HTTP server if the server requires a login.

● "Time Based HTTP Upload"
Checks if the HTTP upload is time limited.

● "Max HTTP Transfer Time"
The max. HTTP transfer time in time-based HTTP upload.

● "Append File Index to Source File"
Check if a file index has to be appended to the source file on the server.

"Options" pane
● "Socket Connect Retries"

Number of socket connect retries to the HTTP server if the connection fails.
● "Socket Timeout"

Socket timeout in milliseconds
● "Max. Wait time for Route"

The max. wait time in milliseconds for establishing a route to the HTTP Server.
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● "Add to Servers"
Adds the current configuration to configured servers.

HTTP upload progress view

The "Progress View" shows the current state of the HTTP upload.

The following information is shown in "Progress View":
● Current Data Rate

The data rate in the last 1000ms
● Average Data Rate

The average data rate in the time span from start of upload until the current
elapsed time.

● Elapsed Time
The elapsed time since start of upload.

● Already Uploaded
The already uploaded bytes.

● Total Size
The total size of the uploaded file.

Figure 6-451: HTTP upload progress view

HTTP upload QoS report view

The "QoS Report View" shows the summary of all HTTP upload sessions.

Figure 6-452: HTTP upload report view
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The following information is shown in "QoS Report View":
● Upload Rate: Min., Max. and Average data rate
● Upload Time: Min., Max. and Average upload time

HTTP upload KPI generator view

The "KPI Generator View" shows the trigger points and KPIs of the HTTP Upload job,
see Chapter 4.6.4.3, "DQA jobs supported by the QoS KPI generator", on page 1100.

Parallel HTTP download and ping

The job makes possible to perform pings in parallel to the HTTP Download jobs. With
the HTTP Download job termination, terminates the ping job as well.

For details, see "Parallel FTP download and ping" on page 1928.

Parallel HTTP upload and ping

The job makes possible to perform pings in parallel to the HTTP Upload jobs. With the
HTTP upload job termination, terminates the ping job as well.

For details, see "Parallel FTP download and ping" on page 1928.

FTP

FTP download

The "FTP Download" configuration dialog lets you download a file using the FTP server
configured in "Servers" pane.
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Figure 6-453: FTP Download job - configuration

"FTP Download" > "Configured Servers" shows all preconfigured servers for FTP
Download job. Double-click an entry in the list to save the preconfigured server in the
"Server" pane of the "QoS Job Server Configuration" dialog, see Chapter 6.5.1.2,
"DQA settings", on page 1881.

The following properties of a preconfigured server are available.

Server
● "URL"

Uniform Resource Locator (host name) or IP address identifying the remote server,
see "Properties" on page 1889.

● "User name"
See "Properties" on page 1889.

● "Password"
See "Properties" on page 1889.

● "FTP Mode"
– "Passive"

See "Properties" on page 1889.
– "Active"

If checked, the FTP active connection is activated.
– "Anonymous"

Inserts the user name "anonymous" and an arbitrary password. The password
can be overwritten, if necessary.

File
● "Download File"
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File to be downloaded including the directory path, see "Properties" on page 1889.
The "..." button provides a tree view of all available directories on the FTP server.

● "Target Directory"
Directory accessible from the test system (for example, hard disk of the PC) where
the downloaded file is stored, see "Properties" on page 1889. The "..." button pro-
vides a tree view of all available directories.

● "Store Data in File on Disk"
Select this function to store the downloaded data in a file that is copied to the local
hard disk. If it is cleared, the data can be kept in memory (see "Delete Files" below)
but are not processed, which generally improves the system performance.

● "Delete Files..."
Select this function to omit copying the downloaded file after finishing the job. Oth-
erwise, R&S ROMES4 creates multiple copies of the downloaded file when the
"FTP Download" job is performed repeatedly. For a downloaded file
<file_name>.<extension>, the copies are named
<file_name>_0.<extension>, <file_name>_1.<extension> etc.

● "Get File Size before Download"
If the option "Get File Size before Download" is selected, the size of the transferred
file is indicated in the "QoS Progress View" together with downloaded number of
bytes "Properties" on page 1889.

● "Time Based FTP Download"
The"FTP Download" job can be time-based which means that the download is
stopped successfully after a defined time. The real transfer time can differ from the
defined time, dependent on the current data rate and the transfer packet size.
Example: Defined transfer time is 10000ms and a data packet of 128 kb is required
on a data socket at 9500 ms. The transfer stops when the complete packet is
transferred at the data socket. The transfer can take a couple of seconds when the
current data rate is slow.

Options
● "Socket Timeout [ms]"

The time when the socket closes the connection without having received data. The
function can be used to limit the transfer time and thus the amount of information
transferred.

● "Socket Connect retries"
Number of retries, if socket connection fails.

● "Routing Timeout [ms]"
The socket connection starts only when the route is created. If the route is not cre-
ated in the wait time, the job fails. Default is 5000 ms.

Add to Servers
Select "Add To Servers" to store the current configuration with the available properties
listed previously to the "Configured Servers". Before storing the configuration, define
the server name.
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FTP upload

The "FTP Upload" configuration dialog lets you upload a file using FTP to a predefined
target server.

Figure 6-454: FTP Upload job - configuration

In the "Configured Servers" pane all preconfigured servers for FTP Upload job are lis-
ted. Double-click an entry in the list to save the preconfigured server in the "Server"
pane of the "QoS Job Server Configuration" dialog.

Server
The following properties of a preconfigured server are available:
● "URL"

Uniform Resource Locator (host name) or IP address identifying the remote server.
● "User Name"

See "Properties" on page 1889.
● "Password"

See "Properties" on page 1889.
● "FTP Mode"

– "Passive"
See "Properties" on page 1889.

– "Active"
When checked, the FTP active connection is activated.

● "Anonymous"
Inserts the user name "anonymous" and an arbitrary password. The password can
be overwritten, if necessary.

File
● "Source File"
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File to be uploaded including the directory path. The "..." button provides a tree
view of all available directories on the preconfigured servers for FTP upload.

● "Target Directory"
Directory name and path on the target server, see "Properties" on page 1889. The
"..." button provides a tree view of all available directories.

● "Append File Index to Source File"
If this option is selected, the source file name is extended by an index before the
file transferring. The index is incremented before each FTP upload. In that way the
target server receives multiple copies of the same file with different file names.

● "Time Based FTP Upload"
The FTP Upload job can be time-based which means that the upload is stopped
successfully after a defined time. The real transfer time can differ from the defined
time, dependent on the current data rate and the transfer packet size.
Example: Defined transfer time is 10000ms and a data packet of 128 kb is sent on
the data socket at 9500 ms. The transfer stops when the complete packet is trans-
ferred. The transfer can take a couple of seconds when the current data rate is
slow.

Options
See "Options" on page 1912.

Add to Servers
Select "Add To Servers" to store the current configuration with the available properties
listed previously to the "Configured Servers". Before storing the configuration, define
the server name.

FTP download / upload

The "FTP Download /Upload" configuration dialog lets you define a remote server and
two files - one file on the remote server and one on the local file system to be uploa-
ded/downloaded using FTP. The configuration menu combines the "FTP Upload" and
"FTP Download" configuration dialogs, see "FTP upload" on page 1913 and "FTP
download" on page 1910.

In the provided KPI definition file, the session time is calculated for download and
upload separately.
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Figure 6-455: FTP Download / Upload job - configuration

The all preconfigured servers for FTP download are listed in the "Configured Servers
for Download" list. Double-click an entry in the list to save the preconfigured server in
the "Server" pane of the "QoS Job Server Configuration" dialog.

The following properties of a preconfigured server are available for FTP download:

● "URL"
● "User Name"
● "Password"
● "FTP Mode"
● "Download File"
● "Target Directory"
● "Get File Size Before Download"

For the properties definition, see "Properties" on page 1889.

Click "Download File" > "Add To Servers" to store the current download configuration
with the available properties listed previously to "Configured Servers for Download". A
server configuration name must be defined before storing the configuration.
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In the "Configured Servers for Upload" list box all preconfigured servers for FTP upload
are listed. Double-click an entry in the list to save the preconfigured server in the
"Server" pane of the "QoS Job Server Configuration" dialog.

The following properties of a preconfigured server are available for FTP upload:

● "URL"
● "User Name"
● "Password"
● "FTP Mode"
● "Upload File"
● "Target Directory"
● "Source Directory"

For the properties definition, see "Properties" on page 1889.

It is not possible to select upload properties from a server which URL is different to the
URL of this configuration. In this case the following message appears:

Click "Upload File" > "Add To Servers" to store the current upload configuration with
the available properties listed previously to "Configured Servers for Upload". A server
configuration name must be defined before storing the configuration.

FTP download / upload views

R&S ROMES4 supports for FTP Download / Upload jobs several views. The "Progress
View" and "Report View" are shown in the following figures.
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Figure 6-456: Progress view of FTP Download / Upload job

Figure 6-457: QoS report view of FTP Download / Upload job

Multi FTP

The "Multi FTP" configuration dialog lets you define a remote server and several files
on the remote server. The definition also includes the local file system to be uploaded
and downloaded using FTP between an FTP login and an FTP logout. The dialog is
the combination of "FTP Upload" and "FTP Download" dialogs. Between the transfers,
optional pauses can be defined.

The KPIs Session Time, Transfer Time and Mean Data Rate cannot be calculated by
the ETSI methods. Therefore, this job is not ETSI conformed. All other ETSI KPIs are
calculated, if possible.
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In the provided KPI definition file, the session time is calculated for every action sepa-
rately.

Example 1

1. FTP login

2. Download 300k file once.

3. Download 1Mb file 10 times.

4. FTP logout

Example 2

1. FTP login

2. 10s pause

3. Download 1Mb file once.

4. 10s pause

5. Download 1Mb file once.

6. FTP logout

Figure 6-458: Multi FTP job - configuration

FTP Server
● "URL"

Uniform Resource Locator (host name) or IP address identifying the remote server.
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● "User Name", "Password"
Account data: Optional input fields for authentication at the remote server.

● "Anonymous"
Inserts the user name anonymous and an arbitrary password. The password can
be overwritten, if necessary.

Options: Lets define additional file transfer parameters.
● "Socket Timeout [ms]"

The time when the socket closes the connection without having received data. This
time is used to limit the transfer time and thus the amount of information transfer-
red.

● "Socket Connect Retries"
Number of retries, if socket connection fails.

● "Max.Wait Time for Route [ms]"
The socket connection starts only if the route is created. If the route is not created
in the wait time, the job fails. Default is 5000 ms.

Actions
● "Add"

Adds a new action to the action list. The action configuration dialog opens.

Figure 6-459: FTP Action - configuration

– "Action Type"
Possible actions type: FTP Download, FTP Upload, FTP Pause

Depending on the selected action types, the following parameters are available:
– "File"

The file to be transferred. Press "..." to explore the file.
– "Target Directory"
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Directory accessible from the test system (e.g. the hard disk of the PC) where
the downloaded file is stored. The "..." button provides a tree view of all availa-
ble directories.

– "Run Count"
The number of times to repeat this action.

– "Get File Size Before Download"
If selected, the size of the transferred file is indicated in the "QoS Progress
View" together with downloaded number of bytes.

– "Store Data in File on Disk"
If selected, the downloaded data is stored in a file that is copied to the local
hard disk. If it is cleared, the data can be kept in memory (see the "Delete Files
after download") but are not processed, which generally improves the system
performance.

– "Delete Files after download"
If selected, no copy of the downloaded file is kept after the job is finished. Oth-
erwise, R&S ROMES4 creates multiple copies of the downloaded file during job
operation. For a downloaded file <file_name>.<extension>, the copies
are named <file_name>_0.<extension>,
<file_name>_1.<extension> etc.

– "Append File Index to Source File" (FTP Upload only)
If selected, the source file name is extended by an index before the file is trans-
ferred. The index is incremented before each FTP upload so the target server
receives multiple copies of the same file with different file names.

– "Generate Trigger Points"
If unchecked, the trigger points of this action (FTP DL/ FTP UL) are not availa-
ble for the KPI Generator.
However, the trigger points are written into the measurement file with a different
service flag (0x05 for FTP DL, 0x06 for FTP UL) for internal use. Therefore
these trigger points are not documented in the document
Trigger Point Definitions.doc.

● "Configure"
The action configuration dialog opens for the selected action. Also a double-click
the selected action opens the configuration dialog. For details refer to "Add" in
"Multi FTP" on page 1917.

● "Copy"
Creates a copy of the selected action.

● "Remove"
Removes the selected action from the action list.

● "Move Up"
Moves up the selected action in the action list.

● "Move Down"
Moves down the selected action in the action list.

The progress information values and the job result values are available in the signal
tree under the "QoS Tester" tree object.
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Figure 6-460: Configured Multi FTP signals

The "DQA Progress View" shows the states of the current action. Terminated actions
are displayed in the "FTP Action" list.

Figure 6-461: DQA Progress View of Multi FTP job

The "QoS Report View" shows the statistics of all actions. The accumulated data rates
of all actions are split into download and upload.

FTP parallel download

The high traffic on the network needs to be produced for LTE test cases. A test can be
done with DQA FTP Parallel Download job. The job uses different servers and/or differ-
ent files, but not necessarily.

TCP/IP trigger points are not available for FTP Parallel Download job.

Double-click "FTP" > "FTP Parallel Download" in the "Available Jobs" list to open the
job's configuration dialog.
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Figure 6-462: FTP Parallel Download job - configuration

The minimum number of parallel FTP downloads is 2. These 2 jobs are shown by
default in the "Jobs" pane and must be configured. The maximum number of parallel
FTP downloads is 10.

To add and configure further FTP Parallel Download jobs, click the "Add FTP DL" but-
ton. The configuration can be taken from the preconfigured servers included in the
"Configured Servers" pane. The configured parameters of a job are shown in the "FTP
Download Configuration" pane, if you select the job in the "Jobs" pane.

To remove a job selected in the "Jobs" pane from it, click the "Remove FTP DL" button.

Select "Add To Servers" to store the current configuration with the available properties
listed previously to the "Configured Servers". Before storing the configuration, define
the server name.

There is the option to stop the FTP Parallel Download job when one of the parallel FTP
downloads is finished. To activate this option, check "Stop when first DL has finished"
in the configuration dialog.

By activating this option, all other FTP download jobs are canceled when one of the
jobs is finished. As a consequence, only the result of the job which finished at first can
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be shown in the "QoS Report View". However, the calculation of the Total Download
Rate considers the amount of data and the time window of all FTP download jobs, see
Figure 6-464.

FTP parallel download progress view

The parameters are the same as in the "Progress View" of a single FTP download.
However, the Current Data Rate cannot be calculated because the notifications of the
parallel running FTP download jobs are not synchronous.

The Average Data Rate is calculated as follows:

][
8]/[

msTimeElapsed
BytesdTransferreAlreadyskbitRateDataAverage 



Already Transferred Bytes: the number of transmitted bytes of all jobs.

Elapsed Time [ms]: (Current Time) – (Start Transfer Time of the job which started
transfer at first)

The parameters of each parallel running FTP download are shown in the list.

Figure 6-463: FTP Parallel Download - progress view

The sum of the Average Data Rate of all parallel jobs is not equal to the calculated
Average Data Rate shown in the top-left corner, because the jobs are not running syn-
chronous.
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FTP parallel download QoS report view

Figure 6-464: FTP Parallel Report - stop transfer when first DL finished not checked

Figure 6-465: FTP Parallel Report - stop transfer when first DL finished checked

This report is similar to a "FTP Multi Job Report".

At first, the results of each parallel running job are shown in the "QoS Report View" list.

Quality of service



Hardware ComponentsDrive Test Software

1925Operating Manual 1171.6415.12 ─ 66

][
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msTimeTransferTotal
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Total Transfer Time: the time span from Start Transfer of the job which started transfer
at first and Stop Transfer of the job which finished at last.

FTP parallel download signals

The FTP Parallel Download job uses the signals of the single FTP Download job. The
signals are under the "QoS Tester" > "QoS [variable]" tree branch.

Figure 6-466: FTP DL Result signals

FTP parallel upload

The high traffic on the network needs to be produced for LTE test cases. A test can be
done with the DQA FTP Parallel Upload job and Chapter 6.5.1.4, "Configuration menus
for the DQA jobs", on page 1891. The job uses different servers and/or different files,
but not necessarily.

The TCP/IP trigger points are not available for this job.

Double-click "FTP" > "FTP Parallel Upload" in the "Available Jobs" list to open the job's
configuration dialog.
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Figure 6-467: FTP Parallel Upload job - configuration

The minimum number of parallel FTP uploads is two. These two jobs are listed by
default in the "Jobs" pane and must be configured. The maximum number of parallel
FTP uploads is 10.

To add and configure the further FTP Parallel Upload jobs, click the "Add FTP UL" but-
ton. The configuration can be taken from the preconfigured servers included in the
"Configured Servers" pane. The configured parameters of a job are shown in the "FTP
Upload Configuration" pane, if you select the job in the "Jobs" pane.

To remove a job selected in the "Jobs" pane from it, click the "Remove FTP UL" button.

Select "Add To Servers" to store the current configuration with the available properties
listed previously to the "Configured Servers". Before storing the configuration, define
the server name.

Figure 6-468: Server name

A file suffix is always added to the uploaded file to avoid accessing conflicts on the
server.
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FTP parallel upload progress view

The parameters are the same as in the "Progress View" of a single FTP upload. How-
ever, the Current Data Rate cannot be calculated because the notifications of the par-
allel running FTP upload jobs are not synchronous.

The Average Data Rate is calculated as follows:

][
8]/[

msTimeElapsed
BytesdTransferreAlreadyskbitRateDataAverage 



Already Transferred Bytes: the number of transmitted bytes of all jobs.

Elapsed Time [ms]: (Current Time) – (Start Transfer Time of the job which started
transfer at first)

The parameters of each running FTP Parallel Upload job are shown in the list.

Figure 6-469: Progress view of FTP parallel upload job

The sum of the Average Data Rates of all parallel jobs is not equal to the calculated
Average Data Rate shown in the top-left corner because the jobs are not running syn-
chronous.

FTP parallel upload report view

This report is similar to a"FTP Multi Job Report".

The results of each in parallel running job are shown in the "FTP Parallel UL Report" of
the "QoS Report View".

Quality of service



Hardware ComponentsDrive Test Software

1928Operating Manual 1171.6415.12 ─ 66

Figure 6-470: QoS report view of FTP parallel upload job

Total Transfer Time: the time span from FTP Multi Job Report of the job which started
transfer at first and Stop Transfer of the job which finished at least.

FTP parallel upload signals

The FTP Parallel Upload job uses the signals of the single FTP Upload job, see the
following figure. The signals are under the "QoS Tester" > "QoS [variable]" tree branch.

Figure 6-471: FTP UL Result signals

Parallel FTP download and ping

The job makes possible to perform pings in parallel to the FTP DL jobs. With the FTP
DL job termination, terminates the ping job as well.
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Double-click "FTP" > "Parallel FTP Download and Ping" in the "Available Jobs" list to
open the job's configuration dialog.

Figure 6-472: FTP DL and Ping job - configuration

Parallel FTP download and ping progress view

The "DQA Progress View" shows only the progress of the main job, which is the FTP
Download job.

Figure 6-473: DQA jobs progress view

The Ping jobs are only shown in the "DQA Message View" and "Current State" sec-
tions of the "Progress View", see the previous figure.
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Figure 6-474: DQA jobs message view

Parallel FTP download and ping report view

The reports of both jobs are available in the "QoS Report View".
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Figure 6-475: QOS report view of FTP download job
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Figure 6-476: Ping job report

Parallel FTP upload and ping

The job makes possible to perform pings in parallel to the FTP UL jobs. With the FTP
UL job termination, terminates the ping job as well.

See the previous chapter.

Performance

Ping

To open the Ping job configuration dialog, double-click the "Performance" > "Ping"
entry in the "Available Jobs" pane.

The configuration dialog lets you define a target server for Ping job (using ICMP proto-
col), the timing and the number of pings to be sent.
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Figure 6-477: Ping job - configuration

● "Server"
Name of the target server to ping; IP address like in the example above or host
name.

● "Idle Time between pings"
Time elapsed between reception of a response from the target server and start of
the next ping. The idle time between two pings is in the range 0 ms to 100000 ms.

● "Ping Timeout"
Maximum time between the start of a ping and reception of a response from the
target server. If the configured "Ping Timeout" expires, the ping is classified as
unsuccessful.

● "Mode"
Defines the scope of the ping job: Either a time limit in seconds or a maximum
number of pings can be set.

● "Time to Live"
Time_of_life parameter allocated to the transmitted data packets. Packets are dis-
carded if their time to live has expired.

● "Packet Size"
Packet size in the range between 32 bytes and 1024 bytes.

Miscellaneous

Wait

The DQA Wait job provides a configurable wait time between executions of two jobs.
The job includes the feature which allows the user to wait for one or more ROMES
events and to wait for signal expressions to become true.

Quality of service



Hardware ComponentsDrive Test Software

1934Operating Manual 1171.6415.12 ─ 66

To open the Wait job configuration dialog, double-click the "Miscellaneous" > "Wait"
entry in the "Available Jobs" pane.

Three wait modes of the job are supported:
● "Wait a specified Time"
● "Wait for an Event"
● "Wait for Signals"

Wait a specified Time
If adding the Wait job to the DQA Job list, the job appears with this mode as default.

Figure 6-478: Wait a specified time

This mode is used to provide the necessary time for the system reconfigurations before
the next job is started.

Wait for an Event
If selected in the "Wait Mode" combo box, the job suspends the execution of the DQA
job list until the one of the specified events occurs.
The configuration dialog opens to set the mode's parameters.
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Figure 6-479: Wait for an event dialog

Wait for an Event ← Wait for an Event
The "Wait for an Event" mode of Wait job allows you to set the following parameters in
the "Settings", "Selected Events" and "Available Events" panes.
Settings
● "Timeout"

Defines a timeout to terminate the job when no specified event occurred during the
specified time.

● "Target Job in Case of Timeout"
Defines a target job when time out. By default, the next job in the list executes
then.

● "Cancel Current Job"
If selected, the job is executed in parallel to the previous job. The previous job is
canceled if one of the selected events occurs. If the previous job terminates nor-
mally, this job has no influence.
The setting is not available during initial job creation. It is selectable while configur-
ing the job after creating the job.

Selected Events
● "Event"

The R&S ROMES4 events enabled in the event page, see Chapter 3.8.1.3, "Avail-
able events configuration", on page 238. Several R&S ROMES4 events can be
selected. The waiting/cancel condition is fulfilled whenever one of the events
occurs (OR).

● "Target"
Each selected event can define a jump to a specific job (target). By default, the
next job in the list is executed.
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Available Events
● "Show only Events of Device"

The "Available Events" list shows by default only R&S ROMES4 events of the cur-
rently used UE.

● "Show all Events"
If this option is active, however, any event can be selected.

● "Configure Events"
The R&S ROMES4 event configuration page is available if this button is clicked.

Buttons
● "Add Selected"

Selected an event from a list of currently available event lists using this button or
drag and drop the event to the "Selected Events" > "Event" pane.

● "Remove Event"
Removes a marked event from "Selected Events".

● "Remove All Events"
Removes all events from "Selected Events".

Wait for Signals
If this mode is selected in the "Wait Mode" combo box, the job waits until at least one
of the defined signal expressions is true. The signal expressions are evaluated in the
same order as defined. If more than one expression is true, the first one in the list is
the one which is responsible for the job’s behavior.
A R&S ROMES4 signal expression is a tree of expressions of R&S ROMES4 signals
and values, which can be combined by Boolean expressions.
The user can define several R&S ROMES4 signal expressions. If the expression
becomes true, the wait job stops. For each expression, a specific successor job can be
specified. By default, the next jump in the list is the successor.
The expression tree can be created in the following steps:
1.  Select a R&S ROMES4 signal. By default only signals of the current device are
offered by the "Signal Tree" dialog. You can select the option to see all signals.
2.  If the signal has alias, the available operators are "Equal" and "Out Of".
● "Equal": Selects the desired value with the combo box
● "Out Of": Selects all desired values with the checked combo box
3.   If the signal is numeric, the following operators are available for selection:
● "Equal"
● "Less Than"
● "Less or Equal Than"
● "Greater Than"
● "Greater or Equal Than"
Define a signal value to be compared. The currently selected unit for the signal is
assigned to the value. The dialog displays this unit and checks if the given value is in
the valid range.
Two signal expressions can be combined to Boolean expressions by using one of Boo-
lean operators AND, OR and XOR. Two Boolean expressions can be combined to new
Boolean expression.
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Example: Expressions
RSSI > -90 dBm

AND
IRAT Mode == UMTS
OR
RxLev > -80 dBm
AND
IRAT Mode == GSM

Configuration of Wait for Signals ← Wait for Signals
The "Wait for Signals" mode of the Wait job allows you to set the following parameters
in "Settings" and "Selected Signal Conditions" panes.
Settings
● "Timeout"

Defines a timeout to terminate the job when no specified signal expression
becomes true during the specified time.

● "Cancel Current Job"
If selected, the job is executed in parallel to the previous job. The previous job is
canceled if one of the selected signal expressions becomes true. If the previous job
terminates normally, this job has no influence.

Figure 6-480: Wait for signals dialog
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The setting is not available during the initial job creation. It is selectable while con-
figuring the job after creating the job.

● "Target Job in Case of Timeout"
Defines a target job at timeout. By default the next job in the list is executed then.

● "Add New Expression Tree"
The button allows defining a new signal expression. Click the button to open the
"Create Signal Expression" dialog.
– "Available Signals"

The list of available signals is shown on the left side of the dialog. The "Availa-
ble Signals" pane in the following figure shows only the R&S ROMES4 signals
of the currently used UE, as "Show only Signals of Device" entry is active,
which is default.

Figure 6-481: Defining new signal expressions

However, there is the possibility to select signals of other devices, if "Show all
Signals" is clicked instead.

– "Signal Expression"
If one or more signals are selected in "Available Signals", the signals expres-
sion is shown in this pane.
Double-click with the right mouse button a signal in the available signals list to
select it. In the "Signal Expression" pane the signal is shown with its current
configured unit.

The expression operator for the signal expression can be selected out of the following
ones in the "Signal Expression" combo box.
● "Equal"
● "Greater Than"
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● "Greater or Equal Than"
● "Less Than"
● "Less or Equal Than"
The value of current signal can be defined in the box below the "Signal Expression"
combo box.
If the signal has alias, the available operators are Equal and One of.
● "Equal": Selects the alias with the combo box

Figure 6-482: Expression operator - equal

● "Out Of": Selects several aliases with the checked combo box
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Figure 6-483: Expression operator - One of

Note: UMTS scrambling codes must be defined in 16-step mode (0 to 8192, the real
SC multiplied by 16).

Configuration of Signal Expression Tree ← Wait for Signals
Right mouse-button click a signal expression of an expression tree, see the Fig-
ure 6-480. The opened context menu lets you add Boolean conditions, configure or
remove signal expressions, add a new expression tree or remove the currently
selected one. The context menu is shown in the following figure.
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Figure 6-484: Wait for signals context menu

In the context menu the following commands are available:
● "Add Boolean Condition AND"

The expression becomes true, if both parts of the expressions become true.
● "Add Boolean Condition OR"

The expression becomes true, if one or both parts of the expressions become true.
● "Add Boolean Condition XOR"

The expression becomes true, if only one part of the expressions becomes true.
● "Configure Signal Expression"

Opens the "Create Signal Expression" dialog where the selected signal expression
can be modified.
The option is also available by double-click with the left mouse button.

● "Remove Signal Expression"
Removes the current selected signal expression.

● "Add Expression Tree"
Opens the "Create Signal Expression" dialog where the new signal expression can
be created.

● "Remove Expression Tree"
Removes the current selected expression tree.

Right-click the root element of an expression tree or a Boolean operator of a Boolean
expression to make only the "Add Expression Tree" and "Remove Expression Tree"
commands in the context menu available.
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In the "Target Job" column of the tree a target job to jump to can be defined if the sig-
nal expression becomes true.

Wait job progress view
A progress view is available to see the current elapsed time of the Wait job, see the
following figure.

Figure 6-485: Progress view of Wait job

Go to job

The only action of the "Go to Job" job is to jump to a specific job in the "Job" list.

To open the configuration dialog, double-click the "Miscellaneous" > "Go to Job" entry
in the "Available Jobs" pane. The combo box offers a list of jobs to jump to.

Figure 6-486: Go to selected job - configuration

The Wait job conditional testing can be programmed in combination with the "Go to
Job" option.

Run external process

It is possible to execute an external process. If the external process is a console appli-
cation, the console output is redirected to the DQA Message View.

To open the configuration dialog, double-click the "Miscellaneous" > "Run External
Process" entry in the "Available Jobs" pane.
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Figure 6-487: Run external process job - configuration

The following properties can be configured in the "Run External Process" configuration
dialog.

● "Application"
The application to be executed

● "Parameters"
A list of parameters for the executable.
The following place holders are available:
– %IP%: The IP address of the connected network adapter or modem.
– %DNS%: The DNS server address of the connected network adapter or

modem.
● "Max.Run Time [ms]"

The maximum run time of the application in milliseconds. If this time expires during
the application execution, the process is terminated.

● "Is Console Application"
Must be checked if the application is a console application. If checked, the console
output is redirected to the "DQA Message View".

If the "Is Console Application" box is checked, the console output and the execution
state of the application is shown in the "DQA Message View".
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Figure 6-488: DQA message view

Semaphore

The Semaphore job allows you synchronizing several DQA testers.

To open the Semaphore job configuration dialog, double-click the "Miscellaneous" >
"Semaphore" entry in the "Available Jobs" pane.

Figure 6-489: Semaphore job - configuration

The page consists of the text box to name the job and an optional timeout value.

The name of the Semaphore job is used to distinguish several Semaphores.

The timeout value can be used to limit the wait time for the Semaphore. If the Sema-
phore job is not signaled by all DQA testers within the given timeout, the DQA cancels
the job and continues with the next job in the list. The configuration dialog offers all cur-
rently existing Semaphore names. A new name can be entered directly into the text
box.

Using timeout values is not recommended, because it can lead to instability of the
measurement process.
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If entering the Semaphore job, the job waits until all DQA testers which have at least
one Semaphore job with an identical name have entered one of those Semaphore
jobs. Semaphore jobs of other DQA testers with different names are ignored for this
Semaphore.

A DQA tester can have more than one Semaphore job with the same name. The DQA
tester signals the Semaphore, whenever one of those jobs is executed.

Figure 6-490: Semaphore job messages

Mobile

AT command

The AT Command job lets you send the AT commands to the test UE. The job is only
available if a test UE is loaded. In that case, the AT Command job for all installed test
UE can be found in the "Available Jobs" > "Mobile" branch.

To open the configuration dialog, double-click the "Mobile" > "AT Command" entry in
the "Available Jobs" pane.

Specify the desired AT command, the expected response and a timeout value in the
configuration dialog.
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Figure 6-491: AT Command job - configuration

The "DQA Message View" shows the command and the received response.

Figure 6-492: DQA message view of the AT Command job

AT command ping

R&S ROMES4 supports the specific AT Ping commands of Quectel and U-Blox, i.e.
AT+QPING and AT+NPING.

If these AT commands are sent to the UE via the DQA job, R&S ROMES4 tries to eval-
uate the results of the pings and generate the values for corresponding R&S ROMES4
signals in "GSM" > "AT Ping Response".

AT commands are the basic communication method of 3GPP modules, starting from
GSM technology.

SMS send

The "SMS Send" job lets you test sending an SMS from a test UE to other one.

The job is only available if the test UE is loaded. The job is then visible in the "Available
Jobs" > "Mobile" branch. The result of the job is to test if the SMS could be sent to the
SMS service provider.
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Double-click the "Mobile" > "SMS Send" entry in the "Available Jobs" pane to get the
"SMS Tester" configuration dialog.

A text of the message can be produced automatically or a custom text can be entered.
Configure the following short message properties:

● "SMS Text"
In the mobile display, the following text appears: "0,1203590186, This is a test
ROMES SMS". In the next SMS the number before comma is increased by 1. After
the comma, the UTC time is given in seconds after 1st January 1970.

● "Subscriber Number"
Phone number of the originating subscriber

● "Addressee Number"
Phone number of the destination subscriber

● "Service Center"
Number of the service center

● "Domain"
Circuit or Packet Switched

● Idle Time [s]
Waiting time after sending the SMS before starting the next "SMS Send" job.

Figure 6-493: SMS Send job - configuration

"SMS Send" job can only be created outside of the Connect – Disconnect – cycle.
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In the "DQA Message View" all relevant steps of sending the message are listed. ETSI
specified KPIs can be evaluated by using the QoS KPI View.

MOC analyzer

The MOC Analyzer job lets you enable or disable the MOC analyzer (Outgoing Call
Analyzer).

The job is available in the "Available Jobs" > "Mobile" branch if the test UE which sup-
ports this feature, for example, the Qualcomm chipset-based mobile device, is loaded.

Double-click the "Mobile" > "Audo Dialing" entry to get the configuration dialog. The
analysis can be enabled or disabled for the mobile in the "Action" text box.

The job tests if the SMS can be sent to the SMS service provider.

The auto-dial menu of the associated mobile device is used for DQA MOC analysis.

The "Dialing" check box of the "Autodialing" > "Action" pane is disabled as long as the
DQA job has control over the autodialer. How to configure the autodialer, see "Autodial-
ing" on page 1536.

The DQA Message View shows the command and the received response.

The results of the voice calls are displayed in "NQA Chart View", "ETSI QoS View" and
"QoSKPI View".

Figure 6-494: Voice call KPI view

The mobile can be connected to a speech quality analyzer (SQA). In this case, the
SQA reports the KPIs concerning the voice calls. If not, the DQA does the reports.

MTC analyzer

The MTC Analyzer job lets you enable and disable the MTC analyzer (Incoming Call
Analyzer).

The job is only available if the test UE which supports this feature, for example, the
Qualcomm chipset-based UE, is loaded.

The job is then visible in the "Available Jobs" > "Mobile" branch. The result of the job is
to test if SMS sent from the service provider can be received by UE.
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Double-click the "Mobile" > "MTC Analyzer" entry in the "Available Jobs" pane to get
the configuration dialog. The analysis can be enabled or disabled for the UE in the
"Action" text box.

The job’s only function is to activate/deactivate the MTC analyzer of the UE (check/
uncheck the "Answering" checkbox in the "Autodialing" > "Action" pane). The job ends
immediately after having changed this setting.

Use the MTC Analyzer job together with the MOC Analyzer job and Semaphore job.

Figure 6-495: MTC analyses enabled for Z500 mobile

MOC / MTC analyzer use case: Ping-pong calls

The MOC/MTC Analyzer jobs allow setting-up ping-pong voice calls between two loa-
ded UEs.

Two DQA testers are added to the configuration and they manage the UE's measure-
ment jobs.

The DQA testers are running independently. The MTC Analyzer job has no information
about the expected incoming call. Thus, it is not applicable to use timeouts or other
indications about the state of the incoming call. A better solution is to synchronize DQA
testers.

While the MOC Analyzer job (Autodialing) is active during the complete duration of the
outgoing call, the MTC job finishes immediately after having enabled/disabled the MTC
Analyzer.

Example: 
Two cases are considered in this example:
● Case 1: DQA1 and DQA 2 settings when the UE1 initiates an originating call

addressing the UE2, while the UE2 waits for the incoming call (initiated by UE1)
● Case 2: DQA1 and DQA 2 settings when the UE 2 initiates an originating call

addressing the UE1, while the UE1 waits for the incoming call (initiated by UE2)

Case 1 - DQA 1

1. Start with the DQA 1 of UE1 by enabling the MOC Analyzer and Semaphore 1
jobs.

2. On the UE2 side, enable the MTC Analyzer job.

3. Wait until the UE1 finishes the MOC Analyzer job.

4. Then disable the MTC Analyzer job.
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Figure 6-496: Enabled jobs for UE1

Case 1 - DQA 2

1. Start with the DQA 2 of UE2 by enabling the MTC Analyzer and Semaphore job
with the same name "Semaphore 1".

2. On the UE2 side, disable the MTC Analyzer job.

3. Add Wait job to give the UE some time to the recent call properly.

Figure 6-497: Enabled jobs for UE2

The Case 2 for the call from UE 2 to UE 1 does the same but vice versa. The result job
lists look similar to the ones for the Case 1, which are shown in the previous two fig-
ures.

The result of such a ping-pong call is visualized in the "ETSI QoS View", see the fol-
lowing figure.
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Figure 6-498: ETSI QoS View for ping-pong calls

Airplane mode

The DQA Airplane Mode job is intended to test the UE which supports switch-on and -
off the airplane mode remotely. The job lets you include this action in the DQA job list,
for example, to force the UE to register to the network.

DQA jobs for NB-IoT

If one of the NB-IoT modules mentioned in the Chapter 6.4.8, "NB-IoT devices",
on page 1652 is loaded, the DQA configuration page shows the jobs available for NB-
IoT modules in the "Available Jobs" > "Mobile" branch.

For the supported jobs, see Table 6-12.

All NB-IoT jobs running on the modules are commanded by AT commands. No Win-
dows IP stack, modem or network connection is involved in these job tests.

The results of the job tests can be found in the associated branches of the "GSM" sig-
nals.

Figure 6-499: Branches for AT command results

The test results are available in the Alphanumeric view.
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Figure 6-500: Alphanumeric view of NB-IoT jobs test

The details of the current tests are shown in the DQA Message View.

Figure 6-501: Alphanumeric view of NB-IoT jobs test

NB-IoT attach

The NB-IoT Attach job switches-on the modules and commands of the mobile to attach
it to a specific network, defined by MCC and MNC.
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Figure 6-502: NB-IoT Attach job - configuration

The job can wait until AT+CGATT returns 1 or continue immediately after having sent
out the commands.

NB-IoT detach

The NB-IoT Detach job switches off the module.

Figure 6-503: NB-IoT Detach job - configuration

NB-IoT ping

The NB-IoT Ping job uses proprietary AT commands to send pings from the module to
the specified IP address. You can specify a maximum amount of pings or the test dura-
tion.

Figure 6-504: NB-IoT Ping job - configuration
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The test is validated as OK if more than 50% of the pings are successful.

NB-IoT send UDP

The Send UDP job sends the packet with the content inserted in "Message" to a speci-
fied IP address and port. The format to specify them is <IP address>:<port>.

If the server is supposed to send-back some byte, the job can wait for this response.

Figure 6-505: NB-IoT Send UDP job - configuration

NB-IoT FTP

If the NB-IoT FTP job is selected, the configuration page shows up.

Figure 6-506: NB-IoT FTP job - configuration

● "FTP Server IP Address": The IP address of FTP server
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● "User": User name
● "Password": User's password
● "FTP Mode": Passive/Active
● "Direction": Download or Upload
● "FTP Folder": In upload, it is the FTP destination folder. In download, it is the folder

of the download file.
● "Upload File": A file which exists on the stick. The available files are listed in the

combo-box.
● "Download File": A file which exists on the FTP server in the selected folder
● "Get Direct": If checked, shows a progress during download.
● "Number of Transfers": Number of transfers configured for this job.
● "Inactivity Timeout": The job is canceled with result "timeout" after expiry of this

time.
● "Transfer Timeout": The time during data transfer without received data.
● "Create Local File": If pressed, a file with the defined size and name is created on

the stick.

Report view of NB-IoT FTP job

The "QoS Report View" of NB-IoT FTP job shows both the job's progress and the
results. There is no dedicated progress view for this job.
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Figure 6-507: QoS Report View for NB-IoT FTP job

KPIs and KPI generator view for NB-IOT FTP job

KPIs of the NB-IoT FTP job are not supported. Therefore, the "KPI Generator View"
does not show them.

Signals of the NB-IoT FTP job

The signals generated by this job are shown in the "Available Signals" > "NB-IoT" in
the "NB-IoT Progress" and "NB-IoT Result" branches. For the signals and their descrip-
tion, see "Description of R&S ROMES4 Signals" document.

Batch

The Batch job is used for reusing.

1. Click the "DQA Settings" > "Available Jobs" > "Batch" to include it in the "Job" list.
At least two jobs have to be already present in the "Job" list.

2. Select the jobs to be batched. Select the successive jobs 1...n in the "Actions" >
"Job" list.
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Figure 6-508: Two jobs selected

3. Click the "Create Batch" button to name the Batch job. This Batch job's name
includes the names of selected jobs with its current configuration.

Figure 6-509: Batch job name

The "Job" list now rearranges in such a way, that the name of the Batch job repla-
ces the selected jobs (FTP and HTTP in the previous figure). Under the job, a tree
"Branch" with the jobs of the batch are displayed.

Figure 6-510: Batch creation

The job as a batch tree branch is added to the "Batch" branch of the "Available
Jobs" pane.

Quality of service



Hardware ComponentsDrive Test Software

1958Operating Manual 1171.6415.12 ─ 66

Figure 6-511: Change in the available signals pane

The "QoS Settings" page let you edit existing batches and save them. While saving the
batch, you are asked to enter a new name or keep the name and overwrite the existing
batch.

If you try to leave the page with an unsaved modified batch in the configuration, you
are prompted to auto save the batch with a new name. Otherwise, you stay on the
page.

A Batch job can be configured in any hierarchy of the job tree. The job can contain
other Batch jobs in the "Job" list. However, it is not allowed to create Batch jobs from
other ones. A Batch available job can be added to the "Batch" tree of the "Job" list by
dragging it from the "Available Job" list to the position of the Batch in the "Job" list.

Figure 6-512: Batch ping and FTP UL under the batch FTP and HTTP

A Batch job can be executed n times (the "Counter" column), similar to other jobs.
Double-click the "Counter" column to change the number of executions.

A job in the "Job" list can be added to a Batch job by using drag and drop. Click the
"Remove" button if you want to remove it from the list.

To delete the Batch jobs from the "Available Jobs" list, click the "Delete Batch" button.

A Batch job is supported in the fully integrated device use mode in the same way. For a
few limitations in that mode, see Chapter 6.5.2, "DQA jobs with Android OS-based
smartphones", on page 1961.
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6.5.1.5  Templates DQA

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.

Figure 6-513: DQA configuration - Templates

By creating the DQA job list with a template, the jobs which are using devices open a
device selection dialog if more than one device is available for the job. The following
jobs support this feature:

● "Connect to Network"
● "Auto Dial"
● "Send AT Command"
● "Send SMS"

Example: Loading a template with the "Auto Dial", "Send AT Command" and "Send
SMS" jobs when two mobiles are connected to the PC.
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Figure 6-514: Loading mobile devies template

The following dialog appears:

Figure 6-515: Device selection for configured job

The "DQA Jobs" list shows the configured jobs of the template. For every DQA job in
the left list, an available device can be selected.

If confirmed with "OK", each job uses its selected device. If clicked "Cancel", each job
uses the initial selected device.

Example 2: Loading a template with the "Connect to Network", "FTP" and "Disconnect
from Network" jobs when two mobiles are connected to the PC.
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The following dialog appears.

For the Connect to Network job, 2 modems are available. An entry in "Available Devi-
ces" can be selected.

If confirmed with "OK", the selected device is used for the connect job. If clicked "Can-
cel", the initial selected device is used.

The "Available Devices" list shows only available devices, which are not used by other
instances of the DQA.

6.5.2  DQA jobs with Android OS-based smartphones

The "DQA" page of jobs made with the Android OS-based smartphones contains the
same controls as the "DQA" page of the On PC testing (Classic mode) jobs. The page
is fully editable with keyboard and the focus is visualized over the control buttons.

For the description of the panes and control buttons of the page, see Chapter 6.5.1.2,
"DQA settings", on page 1881. For the Classic mode 2 mobiles, see "DQA jobs in clas-
sic mode 2" on page 1969.
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The following is applicable for the DQA jobs with the Android-based smartphones:
● DQA job from the list can be connected only to one smartphone.
● Watchdog is always disabled for smartphone sessions.
● Application socket trigger points and the relating KPIs are not available for smart-

phone jobs. Therefore, the selection of ETSI calculation is disabled.
● Currently smartphones support IPv4 only.
● For all smartphone jobs, the IP tracing is always available. The KPI generator can

calculate the relating TCP/IP KPIs of the TCP/IP trigger points.
● Export of the IP tracer data must be done with the PCAP export; the Netmon

export fails.
● QualiPoc mobiles and the R&S ROMES4 DQA measurements support DQA

throughput measurement during a smartphone session.
● Recording of PCAP files must be enabled in the QualiPoc measurements.
● "Device" column shows IMEI of a smartphone.
● Speech quality and voice tests are supported. If a voice test is configured in the

DQA job list, the configuration made in UE is overwritten.
● Data test configurations in R&S ROMES4, QualiPoc and SmartBenchmarker are

harmonized and look similar.

The "QoS KPI Export Result View" shows nothing useful due to limitation of the under-
lying Android package.

6.5.2.1  DQA jobs with fully integrated devices

If an Android OS-based smartphone with the SQ Android interface is loaded, the R&S
ROMES4 DQA jobs available for the smartphone are the same as the jobs for a fully
integrated device. The available jobs are grouped by a job type in the "Available Jobs"
list.

The following jobs or groups of jobs are available in fully integrated device's use mode:
● Data Session Start
● Call Session Start
● Data Session End
● Call Session End
● Multi RAB Session
● HTTP
● FTP
● Performance
● Miscellaneous
● App Test
● Mobile
● Batch

The Network Forcing function supports the call sessions.
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Figure 6-516: Android based fully integrated device - available jobs

It is possible to mix data and voice session in the "Job" list.
● Data Session Start
● FTP DL
● Data Session End
● Network Forcing for Call Sessions
● Call Session Start
● Call Any Number
● Call Session End

A voice or speech quality test can be performed in parallel with one or two data jobs.
The data jobs run sequentially.

R&S ROMES4 supports Video MOS (VMOS) analysis of the fully integrated devices.
The analysis is based on ITU J343.1 standard for Perceptual Video Quality measure-
ment algorithm.
Perceptual Evaluation of Video Quality (PEVQ) measurement algorithm is not suppor-
ted.

A smartphone with SuissQual Android interface does not support other DQA connect
job configurations like dialup, IP tracing and advanced settings. FTP download and
FTP upload jobs are by default available as being the time-based jobs.
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DQA jobs in fully integrated device use mode

If the R&S ROMES4 DQA function is linked with a fully integrated device, the "Quali-
Poc" mode is available. The QualiPoc supported measurements can be configured.

If the fully integrated device use mode (QualiPoc) is selected, the list of available jobs
is the same as that one for smartphones with SQ Android interface.

Extended features with Android OS-based smartphones

The "QoS" > "Extended Features" pane offers the support of IP tracing, timing/statistics
of a DQA session control, test files and job servers creation.

Extended Features
The "QualPoc" mode selection offers in the "Extended Features" pane the functions
that are mentioned in the chapter dedicated to the DQA jobs of the On PC testing
(Classic mode) devices.

Use IP Address Family ← Extended Features
Lets you select the wanted IP address version. The views then show IP address of the
accessed server in the format of selected IP version.

Write QualiPoc IP Trace into ROMES Measurement File ← Extended Features
If selected, writes the QualiPoc IP traces into the R&S ROMES4 measurement file.
The traces are logged in the same way as they are shown on the phone's monitor.
Note: R&S ROMES4 logs the same IP trace as QualiPoc does. If no details are log-
ged, no details are available in R&S ROMES4 as well.
The IP logging can increase the measurement file size significantly. It can influence the
achievable throughput and lead to lost trace packets on high throughput scenarios.

Create a PCAP File with QualiPoc IP Traces ← Extended Features
If selected, QualiPoc IP tracing results are recorded in PCAP format file. The traces
are logged in the same way as a PCAP file is logged.
It is also possible to create a *.pcap file using TCPdump directly of the Android OS-
based smartphones. This setting is found on the mobile’s QualiPoc configuration page.
There are some differences between both approaches. The following table shows the
differences.

Differences QualiPoc IP trace TPCdump

What is logged Not all raw messages are logged.
QualiPoc applies a time filter and
does not log details by default

Everything is logged as tcpdump
logs and written directly to the SD
card of the UE

VoLTE RTP is logged RTP is not logged

Performance Influence Medium to high Medium

Configuration What is logged, configure man-
ually in QualiPoc

Nothing to configure
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Synchronize QualiPoc Test Executions ← Extended Features
The function supports synchronization of DQA job execution for QualiPoc tests of dif-
ferent UEs. To run this function, "Synchronize QualiPoc Test Executions" has to be
enabled for each QoS device (UE) whose job executions you want to synchronize.

Synchronize QualiPoc Test Execution - Example 1 ← Synchronize QualiPoc Test
Executions ← Extended Features
In the example 1, the first data session of both UEs starts at the same time. The sec-
ond data session of both UEs starts when the jobs of the first data session of both UEs
are finished.

Figure 6-517: Configured job sessions of UE1 - example 1
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Figure 6-518: Configured job sessions of UE2 - example 1

The first data session of both UEs starts again when the jobs of the second data ses-
sion of both UEs are finished. All jobs have the same execution count at the end of the
measurement. The exception from this rule is the aborted jobs at the time of measure-
ment stop.

Synchronize QualiPoc Test Execution - Example 2 ← Synchronize QualiPoc Test
Executions ← Extended Features
In the example 2, the first data session of UE1 and the single data session of UE2 start
at the same time. The second data session of UE1 and the single data session of UE2
start again when the jobs of the first data session of UE1 and the jobs of the single
data session of UE2 are finished.
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Figure 6-519: Configured job sessions of UE1 - example 2

Figure 6-520: Configured job sessions of UE2 - example 2
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The first data session of UE1 starts again and the single data session of UE2 starts
again, when the jobs of the second data session of UE1 and the jobs of the single data
session of UE2 are finished. The sum of the execution count of all jobs of UE1 is equal
to the sum of the execution count of all jobs of UE2 at the end of the measurement.
The exception from this rule is the aborted jobs at the time of measurement stop.

Buttons of Extended Features ← Extended Features
The pane contains the following buttons.

More ← Buttons of Extended Features ← Extended Features
Opens the "More Extended Features" page, see "Extended Features" on page 1885.

Create Test Files ← Buttons of Extended Features ← Extended Features
Opens the page where you can define the size and the format of a test file. The file can
be stored to a local directory and used for file transfer to a remote location. The con-
tents of the file are random.

Job Servers ← Buttons of Extended Features ← Extended Features
The "Job Servers" button lets you preconfigure the FTP and HTTP job servers provid-
ing easier and faster job configurations later, see "Job Servers" on page 1888.

6.5.2.2  DQA jobs with devices without QualiPoc

DQA jobs in classic mode

The following jobs or groups of jobs are available for devices operating as On PC test-
ing (Classic mode).

● Connect to Network
● Call Session Start
● Disconnect to Network
● Call Session End
● HTTP
● FTP
● Performances
● Miscellaneous
● Mobile
● Batch

The first four previously listed entries are DQA jobs, other are groups of jobs of the
similar type.
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The Performance group supports the capacity test for HTTP job, but not the tests for
FTP and UDP jobs which are supported for the fully integrated mobile device mode.

Figure 6-521: Capacity test page of unrooted devices

The configuration of classic mode devices is covered in the Chapter 6.5.1, "Data qual-
ity tester (DQA)", on page 1880.

DQA jobs in classic mode 2

The DQA page of the jobs with non-QualiPoc mobiles used in Classic mode 2 contains
the same controls as the DQA page of the On PC testing (Classic mode) jobs.
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Figure 6-522: Supported jobs in Classic mode 2 use mode

For the non-QualiPoc mobiles in Classic mode 2 use mode, supported are the follow-
ing DQA jobs:
● Ping
● Interactivity
● Iperf3
● Wait

The Classic mode 2 uses the Windows network adapter selected in the "Select Net-
work Adapter" combo-box. Only IP addresses are allowed to configure the hosts.

Figure 6-523: Network adapter selection for Classic mode 2

If you select the "Default Gateway" as the adapter, make sure that no other applica-
tions (e.g. e-mail, browser, update services), which can influence the test results, are
active during the data tests.
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If you select a Windows Mobile Broadband adapter, the APN can be set as in the Clas-
sic mode, that is, using the "Connect to Network" dialog with the "…" button placed on
the right side of the "Select Network Adapter" combo-box.

Figure 6-524: An option to set the APN

The Classic mode 2 is only offered, if the mobile is loaded from the "Welcome" page or
using a QoS job wizard. It is not available in the "Hardware" > "Connect/Disconnect"
dialog.

Only one Classic mode 2 is possible in a workspace.

There are some preconditions that have to be fulfilled.

- Java 11 must be installed on the computer. The Java setup is a part of the R&S
Romes4 installation kit.

- Ping and Interactivity tests are only supported if at least the Windows Subsystem for
Linux WSL 1 with Linux distribution Debian is installed on the computer.

How to install WSL, refer to the application note "Performing Data Tests with 5G Mod-
ules" which is available in the
Documentation\Application Notes\
Application Note – Performing Data Tests with 5G Modules.pdf.

The measurement files can be analyzed in NQDI and SmartAnalytics, if "Write SQZ
Files for Mobiles and QoS in Classic Mode" is checked in the "Preferences" > "File
Handling" page.

6.5.2.3  Data session start

"Data Session Start" triggers the start of a data session. The session number is incre-
mented and the Session Start Trigger Points are written.

1. Select the smartphone that you want to connect.

2. Double-click the "QualiPoc Session Start" in the "Available Job" list.

The "Data Session Start" page opens.
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Figure 6-525: Selection of connection type

3. Select the type of the connection. Default is "Mobile Network only".

The job is included in the "Job" list.

By selecting the job, from this point in time, the DQA job list offers only the jobs which
can be executed by a smartphone.

The following functions are included at data session start:
● "WiFi Usage" - the WiFi usage in the QualiPoc "Data Session Start" job.

The usage is defined by selecting one of the following options:
– "Mobile Network only" - WiFi not to be used.
– "Mobile Network / WiFi combined" - QualiPoc decides which network to use.
– "WiFi only" - Use WiFi network only.

● "Enable/Disable Flight Mode" - if checked, offers the Flight Mode to switch on/off
every cycle or once per measurement.

● "Flight Mode Wait Duration [s]" - if "Enable / Disable Flight Mode" is checked in
"Data Session Start", a wait duration between enable and disable can be defined.
The wait time is expressed in seconds.

● "Enable PCAP Recording" - if checked, PCAP recording is activated on the session
level with defined snap length and maximum file size.

● "Dynamic Snap Length" - if checked, QualiPoc stores only needed information to
keep the amount of data manageable. The "Snap Lenght [Bytes]" value is then
configurable.

If "PCAP Recording for all Sessions" is checked in the QualiPoc settings page, see
Figure 6-29, the PCAP controls are disabled in this dialog.

6.5.2.4  Data session end

"Data Session End" triggers end of the data session. The Session End Trigger Points
is written.
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There is no configuration menu for this job.

6.5.2.5  Voice and speech jobs

Voice test and Speech Quality jobs can be configured by selecting "Mobile" > "Auto
Dialing" job in the "Available Jobs" list.

For "Auto Dialing", see "Auto dialing" on page 2045.

R&S ROMES4 allows setting the parameter ExcludeCallSetupFromCallDuration for
speech quality measurements in fully integrated device use mode.

The generation of the land unit file allows you to set the test repetition value.

Voice test w/o speech quality

A MOC voice test must be surrounded by the "Call Session Start" and "Call Session
End" jobs.

Figure 6-526: Voice MOC configuration

Voice test with speech quality

A speech quality test must be surrounded by the "Call Session Start" and "Call Session
End" jobs, see Figure 6-516. The job configuration is unchanged, as shown in the fol-
lowing figure.
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Figure 6-527: Speech quality configuration

If the B-Party is an UE, a speech quality B-side job is automatically created in the job
list of the B-side UE.

An existing B-side job list is overwritten because double ended speech quality tests
can only run exclusively on a fully integrated device.
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Figure 6-528: Speech quality configuration - B-side

The "Available Jobs" buttons are deactivated (dimmed) in the "Speech Quality / B-
Side" configuration page.

Multi RAB session

Multi RAB session is combined speech quality and data quality test.
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Figure 6-529: Multi RAB session active - other jobs unavailable

If a double ended call test is defined in the voice test within a such session, the B-side
also has the multi RAB session with the voice test on its side and the same data test
as the A-side has. The data test on the B-side can be modified.

If the settings of the A-side have been changed, you are supposed to overwrite the
data jobs on the B-side.

Figure 6-530: Request to overwrite data jobs on B-side

For the use case which requires this action, see the Example 4 in the "Job list exam-
ples" on page 1978.

Configuration of multi RAB session

To configure a multiple RAB session job, select "Available Jobs" > "Multi RAB Ses-
sion". The configuration page opens.
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Figure 6-531: Configuration page of multi RAB session job

● "WiFi Usage"
WiFi usage definition, equal to the WiFi usage of the Data Session Start job.

● "Jobs"
The first job in the list is always a voice call. A speech quality test or a voice call
can be defined. If the A-side speech quality test is configured, the B-side job list is
configured automatically.

● "Add Data Job"
The button to define two other data jobs from the offered list of jobs.

Figure 6-532: Possible jobs to be added

No other jobs can be added to the Multi RAB Session job.

If the Multi RAB Session job is configured, the "Available Jobs" list is empty.

For the previously mentioned case of double ended call test of voice test and data test,
the following configurations are requested:

1. Call duration 60 [s] for double ended call of voice test,
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2. Wait job duration 65 [s],

3. Ping job duration 30 [s],

4. Wait job duration 20 [s].

Limitations

The following limitations apply:
● Only one Multi RAB Session can be in a job list.
● If a Multi RAB Session is in a job list, no other jobs can be in the job list.
● Multi RAB Session Report is unavailable.
● If a Speech Quality job is in the job list, no other jobs can be in the job list.
● If an Auto Answering job is in the job list, no other jobs can be in the job list.

Job list examples

Example 1: Two call sessions to different destinations

Figure 6-533: Call sessions to different destinations
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Example 2: Maximum of two call sessions and two data sessions

Figure 6-534: Two data and two call sessions

Example 4: Voice test with double ended call test and data test

Figure 6-535: Double ended call test in voice call test

6.5.2.6  HTTP

For the HTTP transfer test in fully integrated device use mode, it is possible to set a
maximum transfer time even if the transfer is not a time-based one. If a transfer has
not been finished in the defined maximum transfer time, the result is calculated as
failed. The minimum value for the maximum transfer time is 5000ms.

HTTP download / browsing

The "HTTP Download" page supports a file download or browsing job for smartphones
in fully integrated device use mode.
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● If "File Transfer" is checked, the QualiPoc HTTP Download test is executed.

Figure 6-536: HTTP download complete file

Figure 6-537: HTTP download file time-based transfer

● If "Browsing" is checked, the QualiPoc job HTTP Browsing is executed. The socket
and PC connection-related configuration parameters are not available in that case.
Specify a *.htm or *.html file for browsing.

● "URL" - the URL for encoding the link for a file download or select an entry in "Con-
figured Servers".

● "User" - the user's name
● "Password" - the user's password

Support of username and password as an input for this QP job makes an UE
access to a protected server possible.

● "Max. Setup Time [s]" - max setup time for the HTTP Download test job
● "Force DNS Lookup" - If checked, activates the function to clean the DNS cache

before the HTTP Download/Browsing job test starts. The function checks the status
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of DNS records or troubleshoot issues with accessing a service, which provides the
reliable DNS cache control.

● "Transfer Types" - allows selection between the HTTP Download test for complete
file transfer or for fixed duration of file transfer.
– "Full Transfer" - if checked, the duration of HTTP Download file transfer corre-

sponds to complete file transfer. This transfer type is non-time-based transfer
and is the default setting. The transfer duration is limited with the value speci-
fied in "Max. Transfer Time".
The test fails if the download is not finished within the "Max. Transfer Time".
Default is 60 [s].

– "Fixed Duration" - if checked, the HTTP download file transfer lasts as config-
ured in the "Fixed Transfer Time [s]". This transfer type is time-based transfer.
At a time-based transfer, the test finishes after the fixed time with success.
Default time is 60 [s].

● "Configured Servers" - shows all the preconfigured servers for HTTP download.

Views and signals

The views and signals are the same as for the HTTP download in On PC testing (Clas-
sic mode) usage if the HTTP browsing job is selected.

In the "Progress View", there is only one entry for the main object on the page.

HTTP upload

The "HTTP Upload" in the list of available jobs lets you select a file for uploading test
by using TCP/IP to a target web server.

Double-click the line to open the configuration dialog for this job.

"File"
● "URL" - the host name or IP address identifying the remote server
● "Upload File Size" - size of a file you want to upload expressed in kB, MB or GB.

HTTP supposes the file size to be expressed in MB which is also default unit.
● "UL File Name" (fully integrated device use mode only) - created a file name on the

HTTP server
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Figure 6-538: HTTP upload complete file

Figure 6-539: HTTP upload time-based transfer

● "User"- the user's name
● "Password" - the user's password
● "Max. Setup Time [s]" - maximum allowed setup time for this job in [s]
● "Force DNS Lookup" - If checked, activates the function to clean the DNS cache

before the HTTP Upload job test starts. The function checks the status of DNS
records or troubleshoot issues with accessing a service providing the reliable DNS
cache control.
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"Transfer Types" - allows selection between the HTTP Upload test for complete file
transfer or for fixed duration of file transfer.
● "Full Transfer" - if checked, the duration of HTTP upload transfer corresponds to

complete file transfer. This transfer type is non-time-based transfer and is default
setting. The transfer duration is limited with the value specified in "Max. Transfer
Time".
The test fails if the upload is not finished within the "Max. Transfer Time", default is
60 [s].

● "Fixed Duration" - if checked, the HTTP Upload file transfer lasts as configured in
the "Fixed Transfer Time [s]". This transfer type is time-based transfer.
At a time-based transfer, the test finishes after the fixed time with success. Default
time is 60 [s].

"Configured Servers" - shows a list of all the preconfigured servers for HTTP upload.
Double-click a list entry to store the available properties of the preconfigured server for
HTTP upload.

NB-IoT HTTP download with Quectel BG77 device

R&S ROMES4 supports the HTTP download of a file analog to the NB-IoT FTP with
the Qualcomm Quectel based devices - tested with BG77 device. The device has to
support the corresponding AT command set.

The configuration of the job asks for the complete path of the file to download and
some additional timeout settings.

Figure 6-540: Configuration page of NB-IoT HTTP download
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The normal mode uses an AT command, which writes the complete file onto the
device. It returns GET after the complete file has been downloaded and written to the
device.

Download small files only to get frequent feedback.

The direct mode does not store the file to device. The used AT command allows R&S
ROMES4 to read the content of the file itself. This mode offers progress signals during
the download.

The BG77 device does the HTTP download in two steps. The first "Get" step reads the
header and some bytes of the file to download. A second step reads the rest of the file.
For short files, the first step can occupy most of the transfer time.

The HTTP upload can be done only file based. Use a small file and more transfers to
get more results.
The content of the file is sent to the server, but the DQA does not verify what the server
does with this data. If there is no specific script running on the server, the data is most
probably just deleted. However, the data is transferred to the server and thus the avail-
able throughput can be calculated.

The following screenshot shows the NB-IoT HTTP download job available signals.

Figure 6-541: Supported signals of the NB-IoT HTTP download job

For the signals description, see "Description of the R&S ROMES signals" document.
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6.5.2.7  FTP

DQA FTP download

The FTP Download job allows downloading a file from the selected server.

The FTP download supports the SFTP protocol. The sftp:// instead of ftp://
must be used for transfer with SFTP servers.

Figure 6-542: FTP Download complete file transfer

The page contains the following parameters:

"Server"
● "URL" - the host name or IP address identifying the remote server
● "User name" - the user's name
● "Password" - the user's password
● "FTP Mode" - selection of active or passive FTP connection
● "Anonymous" - if clicked, creates the user name and password automatically

"Settings"
● "Download File" - allows browsing for the file
● "Max. Setup Time [s]" - max setup time for the FTP Download test job
● "Force DNS Lookup" - If checked, activates the function to clean the DNS cache

before the FTP Download job test starts. The function checks the status of DNS
records or troubleshoot issues with accessing a service, which provides the reliable
DNS cache control.

"Transfer Types" - allows selection between the FTP Download job test for full file
transfer or for fixed duration of file transfer.
● "Full Transfer" - if checked, the duration of FTP Download transfer corresponds to

complete file transfer. This transfer type is non-time-based transfer and is default
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setting. The transfer duration is limited with the value specified in "Max. Transfer
Time".
The test fails if the download is not finished within the "Max. Transfer Time", default
is 60 [s].

● "Fixed Duration" - if checked, the FTP Download file transfer lasts as configured in
the "Fixed Transfer Time [s]". This transfer type is time-based transfer.

Figure 6-543: FTP Download time-based transfer

At a time-based transfer, the test finishes after the fixed time expiry with success.
Default time is 60 [s].

● "Configured Servers" - shows the list of all the preconfigured servers for FTP down-
load.
Double-click a list entry to store the available properties of the preconfigured
server.

The socket and PC connection-related configuration parameters are not available.

It is not possible to get a file size before downloading the file.

The configuration page of this job is common for both operating modes (the Classic
and QualiPoc modes).
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Figure 6-544: QP FTP download QoS report view

DQA FTP upload

The FTP Upload job allows uploading a file to the selected server.

The DQA FTP Upload job supports the SFTP protocol. The sftp:// instead of
ftp:// has to be used for transfer to SFTP servers.
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Figure 6-545: FTP Upload - complete file transfer

The "FTP Upload" configuration dialog of fully integrated device mode includes the fol-
lowing entries.

"Server"
● "URL" - host name or IP address identifying the remote server.
● "User Name" -predefined user's name
● "Password" - user's password

"Settings"
● "Upload File Size" - size of a FTP file you want to upload expressed in kB, MB or

GB. MB is the default unit.
● "UL File Name" - name of a file you want to upload (only fully integrated device use

mode)
● "Target Directory" - name of the target FTP server
● "Time Based FTP Upload" - FTP upload time-based job is configured by checking

the box
● "Max. FTP Transfer Time" - the max. transfer time of the activated time-based FTP

upload
● "Force DNS Lookup" - If checked, activates the function to clean the DNS cache

before the FTP Upload job test starts. The function checks the status of DNS
records or troubleshoot issues with accessing a service, which provides the reliable
DNS cache control.

"Transfer Types" - allows selection between the FTP Upload test for full file transfer or
for fixed duration of file transfer.
● "Full Transfer" - if checked, the duration of FTP upload transfer corresponds to

complete file transfer. This transfer type is non-time-based transfer and is default
setting. The transfer duration is limited with the value specified in "Max. Transfer
Time".
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The test fails if the upload is not finished within the "Max. Transfer Time", default is
60 [s].

● "Fixed Duration" - if checked, the FTP Upload file transfer lasts as configured in the
"Fixed Transfer Time [s]". This transfer type is time-based transfer.

Figure 6-546: FTP Upload time-based transfer

At a time-based transfer, the test finishes after the fixed time with success. Default
time is 60 [s].

"Configured Servers" - shows a list of all the preconfigured servers for FTP upload.
Double-click a list entry to store the available properties of the preconfigured server for
FTP upload.

The socket and PC connection-related configuration parameters are not available.

Specify the server address "URL" to encode the link for uploading a file and the size of
file you want to upload, apart from other requested entries (user name, password).
After selection, the dialog with all available files pops-up on the smartphone.

Figure 6-547: Selection of reference file
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Double-click a selected file and click "Close" after the selection. The selected file is
written into the "...\My Romes\DQAFiles\Upload" directory of a PC. After the file has
been successfully transferred, you can see it there.

Figure 6-548: Location of the uploaded file

Click "Add Files" to transfer a file from PC to a smartphone.

6.5.2.8  Performance

The jobs available in the "Performance" group are shown in the following figure.

Figure 6-549: QP jobs in Performance group

Ping

The following figure shows the configuration page of the QP Ping job.
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Figure 6-550: Ping job configuration page

The time based and the endless ping modes are not supported. These TTL parameters
are not configurable and shown dimmed in the page.

RTT values are calculated with a higher accuracy in QualiPoc and Classic Mode 2
measurements. For example, RTT = 22.2 ms instead of 22.0 ms

Ping test views

The following views are available for the Ping test:

● "Alphanumeric View"
● "DQA Message View"
● "DQA Progress View"
● "QoS Report View"

In the presented screenshots, one can remark mentioned RTT high resolution.

Figure 6-551: Ping test results in Alphanumeric view
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Figure 6-552: List of messages related to Ping test

Figure 6-553: Ping test statistic in DQA progress view

Capacity DL/UL test

The "Capacity DL/UL" job allows the capacity test of FTP/HTTP/UDP DL/UL jobs to
perform.

The following is valid:
● It is not possible to combine services in capacity tests (e.g. all FTP or all HTTP)
● There is no additional license for FTP/HTTP/UDP capacity test (the capacity test

license)
● FTPS/FTPES is not supported in capacity test
● Not all KPIs are available for HTTP

Capacity DL/UL test configuration

The Capacity Test job supports FTP, HTTP and UDP services.

The screenshots show the HTTP and FTP DL capacity tests configuration pages for
Android OS-based smartphones with SQ Android interface, the fully integrated devices
use mode.
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The Capacity DL/UL tests apply the adaptive bandwidth algorithm.

The advantage of using an adaptive bandwidth algorithm over the fixed one is less
waisted data. Also, the input about maximum expected bandwidth from the user is not
required.

Figure 6-554: Capacity HTTP DL test in fully integrated device mode

Figure 6-555: Capacity FTP DL test in fully integrated device mode
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The following settings are included in the "Capacity Test Settings" pane:
● "Service"

Select the service type for the test out of three offered in the combo-box according
to your need.

Figure 6-556: Service selection

● "Link Direction"
Select the operation mode of the selected service out of offered "Downlink" or
"Uplink"

● "Fixed Transfer Time"
Set the duration of a test that you want to perform, default 60 [s]. The entry is man-
datory for all services. If one of the file transfers ends before the fixed duration is
reached, the job fails.

If the UDP capacity test is selected, the "Capacity Test Settings" pane holds in addition
the "Host" and "Port" combo boxes to specify a host name or IP address and its port
number.

Figure 6-557: Capacity UDP DL test in fully integrated device mode
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The "File Transfer" pane shows the list of files available for capacity test and the set of
buttons to add an URL, configure it, copy a selected one or remove it from the URL list.
The pane of UDP service selection is disabled as this capacity test does not request to
specify the full URL.

If you click the "Add" button for HTTP or FTP as selected service, the following dialogs
are displayed.

Figure 6-558: HTTP capacity test - upload direction

Figure 6-559: HTTP capacity test - download direction

● "URL"
URL to transfer a file from/to must be defined.

● "Direction"
Download or upload. A file to be downloaded must be included in the URL’s entry,
as shown in the previous screenshot.
It is possible to define an HTTP transfer directory in upload direction. A file suffix
(the zero-based list-box index) is appended to the transferred file to avoid access
violations on the HTTP server.

Click "OK" to add the configured job to the DQA job list and leave the "Capacity Test"
dialog.

DQA capacity DL/UL test views

The following DQA views are available for the Capacity DL/UL job with HTTP as
selected service on smartphones supporting SQ Android (i.e. fully integrated device
mode).
● "DQA Message View" shows the actions of the currently running job.
● "DQA Progress View" shows the current results of the job.
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● "QoS Report View" shows a summary of the all sessions of the measurement.
● "Capacity Test Summary View" shows throughput values of capacity test job.
● "QoS KPI Generator View" display for a job defined KPIs.

DQA message view

The "DQA Message View" of capacity test shows the test outcome and the values of
the monitored signals. The following figure shows the HTTP capacity test signals and
results.

Figure 6-560: Messages exchanging during the capacity test

DQA progress view

The "DQA Progress View" shows the measured values during the job execution of the
following signals in the upper part.
Table 6-23: Capacity test progress view entries

Signal Description

Average Data Rate DL Current throughput of the download; only available in operation mode Down-
load/Download and Upload

Already Transferred DL Already downloaded bytes; only available in operation mode Download/Down-
load and Upload

Average Data Rate UL Current throughput of the upload; only available in operation mode Upload/
Download and Upload

Already Transferred UL Current throughput of the upload; only available in operation mode Upload/
Download and Upload

Elapsed Time Current elapsed time of the test
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Signal Description

Round Trip Time Round trip time of the first packet.

Max. Transfer Time Maximum transfer time of the test

The Elapsed Time and Max. Transfer Time values are used to calculate the position of
the progress bar, as Elapsed Time divided by Max. Transfer Time, unit [%].

Figure 6-561: DQA progress view of HTTP capacity tests

The lower part of the view, named "HTTP Capacity Tests", is a list displaying the cur-
rent values of each defined HTTP transfer. The current IP throughput is a part of the
list values.

The data to be transferred is buffered between the TCP and application layers.
The buffering can lead to differences in the amount of received and sent data for the
same point in time on the two layers. The differences are in the measured throughput,
so that the first result can show too high number of transferred bytes and data rate of
an HTTP upload.
The buffering of data is the reason why the first result of the transferred bytes and data
rate of an HTTP upload seems to be too high.
For details, refer to SQ document
Application Note - Fixed Duration Tests.pdf.

QoS report view

The "QoS Report View" is a summary of all sessions.

The "QoS Report View" of the HTTP capacity test shows minimum, maximum and
average values of Transfer Time and Data Rate. The view shows these values for each
defined HTTP transfer and for the total result of all defined HTTP transfers.
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Figure 6-562: QoS report view of HTTP capacity test

Histograms for download and upload data rates are available.

KPI generator view

For the DQA HTTP Capacity Test job, the following KPIs are defined.

● HTTP Capacity Test (DL) start
● HTTP Capacity Test (UL) start
● HTTP Capacity Test (DL/UL) start
● HTTP Capacity Test (DL) completed
● HTTP Capacity Test (UL) completed
● HTTP Capacity Test (DL/UL) completed
● HTTP Capacity Test (DL) Time

To derive listed KPIs, the following two trigger points are defined:
● HTTP Capacity Test Start
● HTTP Capacity Test Stop

The mentioned tests are shown in the "QoS KPI Generator View".

Other KPIs are not available because there are no trigger points delivered by the
Android interface.
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Figure 6-563: QoS KPI generator view of HTTP capacity test

For details of the job's trigger points and the KPIs, refer to Chapter 9, "R&S ROMES4
KPI generator", on page 2229.

Available signals for capacity test DL/UL

The following figure shows the signals available for this job.

Figure 6-564: Capacity test signals

There are two sets of signals for this job.
● Capacity Test Progress
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For the description and ranges of signals in this group, refer to "Description of R&S
ROMES4 Signals" > "QoS Tester" > "Capacity Test Progress".

● Capacity Test Result
For the description and ranges of signals in this group, refer to "Description of R&S
ROMES4 Signals" > "QoS Tester" > "Capacity Test Result".

A signal description appears as well in a Tooltip when hovering with mouse over the
signal in R&S ROMES4 GUI, in "Signal Tree" >"QoS Tester".

The Round trip time signal is displayed in the Message View and DQA Progress View.
The signals related to sustainable throughputs are displayed in "Message View".

Sustainable throughput calculation

In the Network Performance Test each capacity measurement can be short compared
to the test interval, typically around 6 to 10 seconds. Therefore, the ramp-up of the
throughput cannot be neglected when calculating the average achievable capacity.
Instead of discarding fix number of data samples from the calculation, the test utilizes
an algorithm to detect the end of the throughput ramp-up. In this way the test does not
lose information about later drops in the capacity that can occur.

The example results of the ramp-up detection algorithm are presented in the following
figure. The blue bars are showing the measured throughput in a capacity test. The red
line is marking the end of the ramp-up and thus the first data sample that is taken for
calculating the average sustainable capacity.

Figure 6-565: Ramp-up detection algorithm example

The algorithm in the example works as following:

- The moving average length "n" is defined to be 3.

- Every time a new 1 [s] interval throughput value t0 is reported, compare the value t -n
with the average of the following n newer ones.

- If t -n > c * average(t0 - t -n-1), where c is a constant threshold (currently 0.95), then
the end of the ramp-up is reached at t -n.
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- If the condition cannot be met for the whole capacity peak, the ramp-up detection
fails. Consequently, the throughput ramp-up is not finished during the capacity peak
duration.

QP Ookla ®

The QualiPoc supports the Ookla ® test as a DQA job.

Upon the start, the App for Ookla ® job first looks for the best server. Then the job per-
forms subtests in the following order:

1. Ping

2. Download

3. Upload

For more details and preconditions e.g. installing the App, see the "QualiPoc" manual.

QP Ookla ® job configuration

Select the job from the list of available QP jobs.

Figure 6-566: QP Ookla ® job selection

If this job is selected, the following configuration dialog appears.
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Figure 6-567: QP Ookla ® job configuration

The maximum transfer time (test duration) is configurable.

Click "Use special Speed Test Server" to use the speed test server with the defined
server ID. Otherwise, Ookla ® searches for the best server.

A list of valid server IDs can be found at https://www.speedtestserver.com/.

The special Speedtest ® server is not available with QualiPoc 17.2.0.14 and the earlier
versions. The defined server ID is ignored.

DQA QP Ookla ® job views

The following views are available for the R&S ROMES4 test:

● "Alphanumeric View"
● "DQA Message View"
● "DQA Progress View"
● "QoS Report View"

Alphanumeric view

The R&S ROMES4 "Alphanumeric View" supports configuration and display of the
Ookla ® signals. The screenshot shows some Ookla ® speed test signals configured
for display.
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Figure 6-568: Selected Ookla ® signals in Alphanumeric view

DQA message view

The "DQA Message View" monitors all actions of the currently running job. The suppor-
ted Ookla ® signals are shown in this view. In the following figure highlighted is the
supported jitter signal.

Figure 6-569: Ookla ® job DQA message view

DQA progress view

The "DQA Progress View" displays the current action id and the action name of the
test. QP Ookla ® test has only one action, "Execute Test". No further information is
available during the progress.

QoS report view

The "QoS Report View" displays the overall result of the QP Ookla ® test.
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Figure 6-570: QP Ookla ® test QoS report view

KPI generator view

No KPIs are available for this test.

QP Ookla ® test signals

The signals are not named as Ookla ® because of other QualiPoc tests, like Facebook,
which use these records and parameters as well. In the "Available Signals" or "Signal
Tree" page, the Ookla ® signals are shown under the "QP App Test Result" and "QP
App Action Pref. Result" branches. In the parameter "App Test Job", the job name
Ookla ® is displayed.
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Figure 6-571: QP Ookla ® signals

For more details, see Tooltips in the "Signal Tree" or signals description in the
"Description of R&S ROMES4 Signals" document.

QualiPoc Iperf3

A QualiPoc mobile must have the Iperf3 license to perform the QualiPoc (QP in further
text) Iperf3 test job.

QP Iperf3 configuration

If the QP Iperf3 job has been selected, the configuration page is displayed.
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Figure 6-572: QP Iperf3 - configuration page

The meaning of the QualiPoc Iperf3 configurable parameters is given in the "QualiPoc
Iperf3" > "Settings" pane. Configure the "Port" value according to a port the Iperf3
server is listened to. Download or Upload can be selected in "Direction". The protocols
supported are UDP and TCP. The UDP buffer size is set to 1400 Bytes by default. This
setting is preferred to avoid the packet fragmentation and provide the safety-margin, as
the MTU size is 1500 Bytes in most IP networks.

QP Iperf3 test views

The following views are available for the QP Iperf3 test:

● "DQA Progress View"
● "QoS Report View"
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DQA progress view

Figure 6-573: QP Iperf test progress view

The "Progress View" is not filled during a measurement because the data from Quali-
Poc come delayed after the test.

QoS report view

The "QoS Report View" shows the overall result.
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Figure 6-574: QoS report view of QP Iperf3 test

QP Iperf3 signals

The following figure shows the QP Iperf3 signals available for display in the "Basic
Views".
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Figure 6-575: QP Iperf available signals

For the signal description, see "Description of R&S ROMES4 Signals" document.

QP interactivity test

This test is the QualiPoc UDP performance test based on technical measures that is
5G ready, targeting uRLLC scenarios. It is a single-sided QoS test between one UE
and a server instance.

QP interactivity test configuration

The QualiPoc Interactivity job requires the QualiPoc license for the configuration.
Select the "QP Interactivity" in the "Available Jobs" > "Performance" group.

Figure 6-576: QP Interactivity - configuration page

In the "Settings" pane you can configure the following parameters of the QP Interactiv-
ity test job:
● "Server Address" - destination address of the TWAMP server the application con-

nects to.
● "Port"- destination port for TWAMP control connection.
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● "Pattern" - predefined configuration set for the test.
Table 6-24: Parameters of the traffic patterns of predefined configuration set

Pattern
Con-
stant
low

Con-
stant
mediu
m

Con-
stant
high

Con-
stant
long

eGaming
real time

Online
meeting
(<23.0)

Online
meeting
(>=23.0)

Video
chat HD

Parame-
ters Parameter values of the patterns   

Packet per
second

125 200 1300 150 125/375/125
0

62/250 62/248 62/125

Traffic
shape

Con-
stant
low rate

Con-
stant
medium
rate

Con-
stant
high
rate

Con-
stant
low rate
over
longer
time

Bursty Bursty Bursty Changing

Packet
size
UL[Bytes]

100 650 1450 250 100 1000 1008/252 1000

Packet
size
DL[Bytes]

100 650 1450 250 100 1000 1008/252 1000

Resulting
target
bandwidth
UL[Mbit/s]

0.1 1 15 0.3 0.1/0.3/1 0.5/2 0.5/2 0.5/1

Resulting
target
bandwidth
DL[Mbit/s]

0.1 1 15 0.3 0.1/0.3/1 0.5/2 0.5/2 0.5/1

Packet
delay
budget
[ms]

<
R23.0:
500

>=
R23.0:
2000

<
R23.0:
500

>=
R23.0:
2000

<
R23.0:
500

>=
R23.0:
2000

2000 100 300 300 300

Test dura-
tion [s]

2 2 2 30 10 10 10 10

Max.
packet
error rate
[%]

2 2 2 2 0.2 0.2 0.2 0.2

Traffic
shape (1 s
step, l-low,
m-
medium,
h-high, u-
ultrahigh)

    l m h
mmmm lll

ll h llll h ll DL: II IIIII
H II

UL: II h IIII
I II

ll
hhhhhhhh
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Pattern
Con-
stant
low

Con-
stant
mediu
m

Con-
stant
high

Con-
stant
long

eGaming
real time

Online
meeting
(<23.0)

Online
meeting
(>=23.0)

Video
chat HD

Interactiv-
ity score
(3GPP 5QI
value)

no no no no Real-time
Gaming
(5QI = 3)

Conver-
sational
video
(5QI = 2)

Conversa-
tional
video (5QI
= 2)

Conversa-
tional
video (5QI
= 2)

Comment      Symmet-
rical

Symmetri-
cal

 

Support of asymmetric traffic patterns

Some interactivity applications show different data flows in up- and down-link. In gen-
eral, there is much less data transported in uplink than in downlink. R&S ROMES4
offers more realistic applications' target patterns in the interactivity test. These target
patterns are even available for the applications based on highly asymmetric traffic, for
example, cloud-gaming.

The following table shows the configuration parameters available for the asymmetric
traffic patterns.
Table 6-25: Parameters of the asymmetric traffic patterns

Pattern Constant DL
dominant

Stepwise DL
dominant

Constant UL
dominant

VR/Cloud- gaming
HD

I4.0 Process
automotion

Parameters Parameter values of the upper patterns

Traffic shape Constant high
DL, low UL

High DL, low
UL changing
stepwise with
constant rela-
tion

Constant high
UL, low DL

Changing DL domi-
nant

Constant low
rate

Packets per
second

1400 l:134/
m:672/:2688

1040 60 625

Packet size
UL[Bytes]

120 93 1200 520 100

Packet size
DL[Bytes]

1200 1400 120 l:5460/h:10920 100

Resulting target
bandwidth UL
[Mbit/s]

1 l:0.1/m:0.5/h:2 10 0.25 0.5

Resulting target
bandwidth DL
[Mbit/s]

10 l:1.5/m:7.5/h:30 1 l:2.5/h:5 0.5

Packed delay
budget [ms]

2000 2000 2000 100 20

Test duration
[s]

10 10 10 10 30

Max packet
error rate [%]

2 2 2 0.2 0.02

Quality of service



Hardware ComponentsDrive Test Software

2012Operating Manual 1171.6415.12 ─ 66

Pattern Constant DL
dominant

Stepwise DL
dominant

Constant UL
dominant

VR/Cloud- gaming
HD

I4.0 Process
automotion

Traffic shape (1
s step, l-low, m-
medium, h-
high, u-ultra-
high)

 ll mm hh mm ll  DL: ll hhhhhh ll

UL: iiiiiiiiiiii

 

Interactivity
score (3GPP
5QI value)

no no no Real-time gaming
(5QI = 3)

Discrete
automotion
(5QI = 82)

Comment 1:10 1:15 10:1 - Based on real traf-
fic captures of Goo-
gle stadia

- Emulates a FullHD
@60fps video
streaming

- One TWAMP DL
packet has size of 3
to 8 MTUs

Input of real
traffic cap-
tures pending

In Classic mode 2 patterns listed in both tables are available.

The asymmetric traffic patterns are only available in the QualiPoc mode with the Quali-
Poc option Interactivity- PatternPackage_1 or in the Classic mode 2.

The parameters introduced with the R&S ROMES4 support of asymmetric traffic pat-
terns during the interactivity tests are included as signals in the "Signal Tree" > "QoS
Tester" branch.

For the signals description, see the "Description of the R&S ROMES4 signals" docu-
ment, or hover with mouse over a signal in "QoS Tester" > "QP Interactivity Pro-
gress"/"QP Interactivity Result".
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Figure 6-577: Available signals of QP interactivity test

The Pattern parameters are shown in the "DQA Message View" at the start of the test.
The "Number of Packets" value in the view is calculated as packets/s x test duration.

Figure 6-578: QP Interactivity test - message view
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QP interactivity views

The following views are available for the QP Interactivity test:

● "DQA Progress View"
● "QoS Report View"
● "Interactivity Test Summary View"

The "DQA Progress View" and "Interactivity Test Summary View" are available for
interactivity tests of supported asymmetric traffic applications.

KPIs are not supported for the test.

DQA progress view

The "Progress View" shows the current result of the test. The signals for the parame-
ters of the current progress shown in this view are available in the "Signal Tree" >
"DQA Tester", under the "DQA Interactivity Progress" branch. For the signals descrip-
tion, see "Description of the R&S ROMES4 Signals" document.

Figure 6-579: DQA progress view of a QP interactivity test

The view is only available during replay because all intermediate results are delivered
at the end of the test.

QoS report view

The "QoS Report View" displays the Interactivity score.

When displaying the results of the Interactivity Test job, the view has two additional col-
umns in the "Result" table, containing measured results of the latency and packet
delay that is:

● RTT (median): Round-Trip Latency (median)
● PDV (median): Packet Delay Variation (median)
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Figure 6-580: QoS report view of interactivity test

The signals for the parameters of the interactivity score shown in this view are availa-
ble in the "Signal Tree" > "DQA Tester", under the "DQA Interactivity Progress" and
"DQA Interactivity Result" branches.

For the signals description, see "Description of the R&S ROMES4 Signals" document.

QP traceroute

The QualiPoc Traceroute job is only available for SQ fully integrated devices.

The Traceroute is also known as a Windows or Linux test tool. It tests the route from
the network device to the destination. On its way, the route hops over several router
and switches. The time to leave (TTL) counter of the data packet (probe) is decremen-
ted on every node. Each targeting node can send back this data. The traceroute meas-
ures also the sending and receiving time (round-trip time, RTT). The more nodes or
slow networks and slow hardware extent the RTT. As a result, the route is detected,
how many hops are needed and its RTT is measured.

The QP Traceroute test performs one time the measurement, which is, detecting the
route and the round-trip time from the QualiPoc mobile device to each network node.

QP traceroute configuration

The following screenshot shows the QP Traceroute configuration page.
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Figure 6-581: QP Traceroute - configuration page

Configure the following parameter:

● "Destination" - destination or IP address has to be here defined
● "Max. Hops" - specifying the maximal number of hops helps to limit the searching

range. If the destination is valid and reachable, the search ends when the destina-
tion is reached. If the destination is temporally not available, the test stops search-
ing after reaching the "Max. Hops" value.

● "Protocol" - several protocols are selectable, TCP, UDP and ICMP.
● "Packet Size" - the packet size to be set. For TCP, the size is fixed to 60 [bytes].
● "Probe Timeout" - the parameter specifies how long the measurement waits until it

assumes no responding and proceeds testing the next network node. The function
is needed as there are some network nodes configured not to answer to probe
packets.

● "Port" - the network port which is used to send out the probe. Some ports are pre-
defined and used for certain network services and protocols, for example, port 80,
port 8080.

The previous screenshot shows the Traceroute test for the route www.heise.de config-
ured with max. 30 hops. The TPC protocol on port 80 is used. Whenever the network
node does not respond, the test proceeds to next node after 1 s.

QP traceroute supported views

Supported are the following views for QP Traceroute test:

● "DQA Message View"
● "DQA Progress View"
● "QOS Report View"

Quality of service



Hardware ComponentsDrive Test Software

2017Operating Manual 1171.6415.12 ─ 66

DQA message view

The information, warnings and errors are shown in this view.

Figure 6-582: QP Traceroute test result

During a QP Traceroute measurement, the "Progress View" shows in the upper part
the configured parameters.

The lower part informs you about the route to the destination. If a node does not
answer within the probe timeout, no address is reported and the RTT shows an aster-
isk. To each node are sent 10 probes. A Min./Max./Average RTT is shown for 10 or
less responses.

The following screenshot shows the Traceroute test of the www.heise.de route reached
in 11 hops. The node on first hop did not answer in configured time.

Figure 6-583: Progress view of www.heise.de route test

In the following example (port 8080) there are 14 hops on the route to www.heise.de
but the last server did not answer. The nodes on first hop and on hops 10,11,12,13 did
not answer in time.

Quality of service
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Figure 6-584: Progress view of www.heise.de route test - other route

QoS report view

In the "Report View" the average round-trip time and the duration results are shown.

Quality of service
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Figure 6-585: QOS Report View of QP Traceroute test

QP traceroute signals

The available QP Traceroute test signals are introduced under the "QoS Tester" branch
of the "Signal Tree". For each actual hop, signals are shown. For the signals descrip-
tion, see the "Description of R&S ROMES4 Signals" document.
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Figure 6-586: QP Traceroute signals

The signals can be shown in the "Basic Views", for example in the "Alphanumeric
View," as shown in the following screenshot and can be used for export.

Figure 6-587: Alphanumeric view of the QP Traceroute signals

6.5.2.9  Miscellaneous

Wait

The Wait job of a fully integrated device lets you configure pauses between execution
of other QP jobs.
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Figure 6-588: Wait job of fully integrated device - configuration

Wait job configuration

To open the configuration page, press "Configure" after selecting the Wait job in the
"Action" > "Job" list.

The configuration page lets you configure the following parameters.

● "Wait Mode"
Three wait modes are available:
– "Wait a specified Time"
– "Wait for an Event"
– "Wait for Signals"

● "Wait time"
Time QualiPoc waits until the next job in the lists is executed if the first mentioned
wait mode is selected.

● "Send AT Command"/"Execute adb Command"
The R&S ROMES4 implementation allows you to configure AT or ADB commands
which can be executed while QualiPoc is waiting. If one of these options is activa-
ted, important is that the configured wait time is longer than the expected maximal
duration of the AT or ADB command.

The ADB command can be used, for example, to run some Iperf3 tests. R&S ROMES4
offers to install Iperf3 on the UE and prepare the wait job accordingly.

Exchange the iperf server to your needs.

YouTube streaming

If a device is used as fully integrated, the DQA job "Youtube Streaming" is available in
the DQA job list.
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Install the YouTube version 11.27.53.130 on the smartphone. Install the version man-
ually.

A note is displayed on the DQA YouTube job configuration pane indicating the version
request and manual installation on the phone.

YouTube streaming job configuration

To open the configuration page, press "Configure" after selecting the "Youtube Stream-
ing" job in the "Action" > "Job" list. The screenshot displays the configuration page.

If the QualiPoc option YouTube 4K is available on the fully integrated device, it is possi-
ble to make test with YouTube UHD (4k) videos.

Figure 6-589: YouTube Streaming page

Select the "Video Id" in the "Video Source" pane.

The following parameters can be configured in the "Options" pane, although they are
adapted to the QualiPoc rules by default:

● "Display Duration" - duration of the video display, by default [40 s]
● "Connection Timeout" - time after which the job fails because not yet connected, by

default [30 s]
● "Stream Lost Timeout" - time for the job to fail, after the last stream input, by

default [20 s]
● "Max. Test Duration" - max. time for the job execution, by default [90 s]
● "Viewing Resolution" - dependent on license availability, select full HD or UHD (4k)

resolution
● "Force DNS Lookup" - If checked, activates the function to clean the DNS cache

before the YouTube job test starts. It is active by default. The function checks the
status of DNS records or troubleshoot issues with accessing a service, providing
the reliable DNS cache control.

The YouTube job tests always calculate the MOS values.
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The YouTube *.apk files and the related Playservice *.apk files are located in the
ROMES application folder, see the following figure.

Figure 6-590: Location of the YouTube files

The required YouTube *.apk and all Playservices *.apk files must be copied to the
device storage of the smartphone. For the transfer of files to the smartphone, the
phone must be in MTP mode.
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Figure 6-591: Youtube files copied in smartphone

To install the YouTube version 11.27.53.130:

1. Copy the YouTube *.apk and all Playservices *.apk files to the device storage of
the smartphone

2. Select the Youtube-11.27.53.130.apk.

3. Run the file.

The version is installed.

If the installation fails, install YouTube-10.34.57.0.apk first and then
Youtube-11.27.53.130.apk.

YouTube streaming test views

The following views are available for the YouTube Streaming test:

● "DQA Message View"
● "DQA Progress View"
● "QoS Report View"
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DQA progress view

Figure 6-592: Youtube Streaming DQA progress view

The "DQA Progress View" of a YouTube Streaming job displays:
● "Current MOS"

The current MOS value of the streamed video
● "Current State"

The current progress of the streamed video in relation to the whole movie duration
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QoS report view

Figure 6-593: Youtube Streaming QoS report view

The "QoS Report View" displays:
● "Min./Max./Avg MOS"

Minimum / maximum and average MOS over all jobs

YouTube streaming job KPIs

There are no trigger points and KPIs available.

YouTube streaming job available signals

The YouTube Streaming job test provides values of the signals in the "Youtube Pro-
gress Info" and "Youtube Result" group of signals.

The available signals for the YouTube test job are shown in the following screenshot.
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Figure 6-594: Youtube Progress/Results Info signals

For detailed description of the signals in these two groups, refer to "Description of R&S
ROMES4 Signals" document, the "QoS Tester" chapter.

6.5.2.10  App test

QP Facebook

Smartphones with SQ interface and fully integrated devices support DQA Facebook
job.

Prerequisite

A Facebook test requires an App ID and the access token, which you can obtain when
you create a Facebook App.

Therefore, before you can create and run a SwissQual Facebook test, create a Face-
book App. Consider the note about the App ID and the access token for the app.

This process involves the following steps:

1. Create a regular Facebook account.

2. Create a Facebook developer's account.

Creation of Facebook app and account

To create Facebook:

Open a browser, go to https://www.facebook.com and then click "App Console".
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To create account:

1. Enter the account information in the sign-up form.

Figure 6-595: Facebook sign up page

2. Click "Sign Up".
If you do not see the form, click the "Sign Up" button at the bottom of the page.

3. On the "Find your friends" page, click "Next".

4. Log in to the e-mail account that you provided on the sign-up form.

5. Open the confirmation message from Facebook.

6. Click the link.

The account is created.

Registration as a Facebook developer

1. Go to https://developers.facebook.com in your browser.

2. Click "Register" at the top right of the page.

3. Click "Yes" in the dialog box to accept the registration terms.

4. Click "Next".

5. Enter your phone number in the "Register as a Facebook Developer" dialog.

6. Click "Send as Text".

7. Type the confirmation code that you received on your phone.
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Figure 6-596: Registration as a developer

8. Click "Register" to end the procedure.

You are registered as a Facebook developer.

Creation of an app for Facebook test

1. Click "My Apps".

2. Click "Add a New App".

The "Add a New App" page pops-up.

3. On the "Add a New App" page, click "Basic setup".

Figure 6-597: Adding new App

4. Enter a name for the App in "Display Name", for example, SQ.
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Figure 6-598: Creation of App ID

5. Select the App category in "Category".

6. Click "Create App ID"

7. Perform the "Security Check".

8. Click "Submit" to complete the App ID creation.

9. Copy your App ID from the "Dashboard" to a text file for your records. You need
this ID when you configure a Facebook test.

Figure 6-599: Created App ID on dashboard

Obtaining Facebook access token

To get the Face access token:

1. At the top of the page, click "Tools & Support".

2. Click "Access Token Tool".

3. Locate your App.

4. Copy the "App Token" to a text file for your record.

5. Click "Submit"

You need this token when you configure a Facebook test.
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App ID and Facebook access settings in QualiPoc settings

1. Open QualiPoc in "Handheld Mode".

2. Open "Settings".

3. Open "Apps".

4. Change the entries for Facebook access token and the App ID.

QP Facebook job configuration

1. Select the QP Facebook job from the "Available Jobs" list, see Figure 6-516.

2. Double-click the selection.

The "QualiPoc Facebook" page opens.

Figure 6-600: QualiPoc Facebook configuration page

3. Define the maximum test duration, default is 30000 ms.

4. Select an action from the "Facebook Actions" drop-down box.

The selected Facebook test job is placed in the "Actions"> "Job" list of the "QoS
Settings" configuration page.

It is not possible to create multiple Facebook actions in one test. Create the actions
separately in a session.

Figure 6-601: Separate QualiPoc Facebook actions

Pause about 5 minutes before performing the Facebook test to avoid wrong recogni-
tion of R&S ROMES4/QualiPoc by the Facebook server.
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To configure the pause, define the wait time in the QualiPoc "Settings" > "Wait Time
after DQA Data Job".

The wrong recognition can be avoided also if you define other tests after the Facebook
test which runs a couple of minutes.

DQA QP Facebook test views

The following views are available for the QP Facebook test:

● "DQA Progress View"
● "QoS Report View"
● "Alphanumeric View"

DQA progress view

The "DQA Progress View" is the same as for the Ookla ® test.

The "Current Throughput" and "Already Transferred" values are always reported as 0
values from the QualiPoc application.

Figure 6-602: QP Facebook job DQA progress view

QoS report view

The view reports the "Min" /"Max" /"Avg" values of the Facebook test duration.

Figure 6-603: QP Facebook test QoS report view
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Alphanumeric view of QP Facebook job

The "Alphanumeric View" displays the QP Facebook job signals. The App test signals
are used. For the signals and their description, see "Description of R&S ROMES4 Sig-
nals" document.

Figure 6-604: QP Facebook test alphanumeric view

KPI generator view of QP Facebook job

No KPIs are available for this job, therefore the view does available.

QP dropbox

QualiPoc Dropbox is supported by the DQA.

Prerequisites

Before you can create and run a QualiPoc Dropbox test, you need to create a Dropbox
App and take a note of the access token for the App. This process involves the crea-
tion and configuration of a Dropbox account.

Creation and configuration of a Dropbox account

The Dropbox test requires a Dropbox developer account and an access token.

To create an access token for your Dropbox account:

1. Select the https://www.dropbox.com/developers/ link in opened browser.

The "Build your app on the Dropbox platform" access pane pops-up.
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Figure 6-605: Dropbox platform

2. Click "Create your app"

3. Create a Dropbox account in a following way:

● a) Click "Create an account".
● b) Enter the account information.

Figure 6-606: Dropbox account creation

● c) Select "I agree to Dropbox terms".
● d) Click "Create an account".
● e) Use the browser's "Back" button to cancel the Dropbox app download and to

return to the previous page.
● f) Optionally, if you do not receive any verification message, click "Send email

for verification".
● g) Login to your email account.
● h) Open the verification message from Dropbox.
● Click "Verify your email".

Note: You do not need to download the Dropbox App.

4. Create an app for the Dropbox test in a following way:

● a) On the "Create a new app on the Dropbox Platform" page, click "Dropbox
API" on "1. Choose an API" area.
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● b) Click "App folder – Access to a single folder created specifically for your
app." on "2. Choose the type of access you need".

● c) Enter a name for your app in "3. Name your app".
● d) Check "I agree to Dropbox API Terms and Conditions".
● e) Click "Create app".

Figure 6-607: Dropbox app creation

● f) Click "Enable additional users" in the "Development users" area.
● g) Confirm the selection with "Limit raised to 500 users" > "Okay".
● h) Click "Generate" in the "OAuth 2" area.
● i) Copy the access token to a text file and save the file.

Figure 6-608: Coping the generated file

● k) Sign out.
Note: You need the access token to configure the Dropbox test.

5. Open QualiPoc in Handheld Modes:

● a) Touch Settings
● b) Touch Apps

Quality of service



Hardware ComponentsDrive Test Software

2036Operating Manual 1171.6415.12 ─ 66

● c) Type the access token in the related field and the Dropbox settings.

Dropbox job configuration

1. Select the QP Dropbox job from the "Available Jobs" list. Double mouse click the
selection to open the configuration page.

2. Click "Add Action" in the opened page to get the "Dropbox Action" page.

Figure 6-609: DQA Dropbox job configuration page

3. In the opened page define the job direction. Download or upload directions are
available.

Figure 6-610: Dropbox job direction

If you select download, define an action name (example given, Download 10MB)
and the remote path of the file's location in the Dropbox server.
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Figure 6-611: Dropbox job download

4. If you select upload, define in addition the maximal size of the file for uploading.

Figure 6-612: Dropbox job upload

DQA QP dropbox job views

The following views are available for the QP Dropbox test:

● "DQA Progress View"
● "QoS Report View"
● "Alphanumeric View"

DQA progress view

The "DQA Progress View" for this job is the same as for QP Ookla ® and QP Face-
book jobs.

QoS report view

The "Min" /"Max" /"Avg" values of the Throughput and Transfer Time of the test are
reported.
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Figure 6-613: QP Dropbox test QoS report view

Alphanumeric View

The "Alphanumeric View"displays the QP Dropbox job signals. The App test signals
are used. For the signals and their description, see "Description of R&S ROMES4 Sig-
nals" document.

Figure 6-614: QP Dropbox test alphanumeric view

KPI generator view

No KPIs are available for this test.

QP WhatsApp

QP WhatsApp Send and Receive jobs are supported by the DQA.
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Prerequisites

Before you can create and run a QualiPoc WhatsApp test, you need to install the appli-
cation on your phone and to create a WhatsApp account for the used SIM.

Install WhatsApp

The application must be downloaded from "QualiPoc" > "Settings" > "Apps" (currently
only version 2.17.395 is supported). If different version is already available in the
device, WhatsApp tests are not supported in QualiPoc.

Figure 6-615: Available applications

Touch "WhatsApp Version" and confirm the suggested version.

The WhatsApp application is downloaded and installed.

Create WhatsApp account

Initial WhatsApp configuration requires to start the WhatsApp application manually and
follow the verification steps.

Adding only one friend in the WhatsApp "Contacts" list must be done manually (use the
same name as the WhatsApp name set on the other device). Pay attention where you
save the contact accordingly to your needs (on the device or on the SIM).

If you change SIM, WhatsApp asks to repeat the verification steps.
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Figure 6-616: Verifying own phone number

Figure 6-617: Creating own name

Touch "WhatsApp" > "Settings" > "Data usage" > "Media auto-download" to disable all
the auto-download options (set "No media" for all the options).

Figure 6-618: Disabling options

WhatsApp messages tests

The sending side sends first an initialization message containing test identifier and the
number of messages. In the case shown in the following figure, two messages are
sent, the text messages (‘1’) and a photo (‘3’). Sending messages is indicated by the
last part of the initialization message (1,3,1).
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Figure 6-619: Message flow

The receiving side sends the finalization message "*SQTest # Done" after receiving all
messages as an indication that all them have been successfully received.

QP WhatsApp job configuration

Configuration of sending party

1. Load a mobile as fully integrated device.

2. Configure a related DQA.

3. DQA page opens.

4. Select the "QP WhatsApp" job with double-click from the "Available Jobs" list.
The "QualiPoc WhatsApp Send Message" page pops-up.

Figure 6-620: WhatsApp configuration page - send text

5. Select the wanted WhatsApp service's type test in "Action" out of offered
options"Send Text" and "Send Photo".
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6. Type the contact of the receiving party in "WhatsApp Contact".

7. Specify the test duration in "Max. Test Duration".

8. Check the "Detected Delivery Notification" combo-box.
When checked, the function calculates duration of delivery. If the feature is active,
a message can be delivered to an inactive B-party without QualiPoc, but with
WhatsApp on.
Set the UE's operating system to English language to make possible calculation of
the delivery duration.

QP WhatsApp views

The following views are available for the QP WhatsApp test:

● "DQA Progress View"
● "QoS Report View"
● "Alphanumeric View"
● "Message View"

DQA progress view

The "DQA Progress View" of WhatsApp is the same as the views of QP Ookla ®, QP
Facebook and QP Dropbox.

Figure 6-621: WhatsApp sending/receiving party DQA progress view

The Current Throughput and Already Transferred Bytes values of the WhatsApp send-
ing and receiving party are not available in the "Progress View".

In addition, the Elapsed Time value of WhatsApp receiving party is not available in this
view.
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QoS report view

The Min /Max /Avg values of the Throughput and Transfer Time of the test are reported
in the Report View of WhatsApp sending party.

Only the counters for OK and failed tests are reported in the "QoS Report View" of
WhatsApp receiving party.

Figure 6-622: WhatsApp sending/receiving party QoS report view

Alphanumeric view

The view displays the QP App test signals. For signals, see "Description of R&S
ROMES4 Signals".

Figure 6-623: App test signals in alphanumeric view
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DQA message view

The QP WhatsApp job signals are shown in the DQA Message View. The following fig-
ure shows the sequence of QP WhatsApp messages related to results of testing the
send messagings.

Figure 6-624: Messages related to results of QP WhatsApp messaging send test

For the signals, refer to the "Description of R&S ROMES4 signals" document.

Figure 6-625: Configurations of signals for QP WhatsApp messaging send test

6.5.2.11  Mobile

DQA SMS send

SMS Send job is supported by the DQA.
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Figure 6-626: SMS job for smartphones tester

"Service Center" and "Domain" are dimmed. These entries are not available, as the
QualiPoc handles the job, that is, these parameters are taken from internal smartphone
settings and therefore do not need configuration.

SMS receive

Other smartphone with SQ interface (that is, with QualiPoc) can receive SMS sent by
the mobile involved in SMS Send job.

"Tracking of Incoming SMSs" must be checked in the SMS page of the mobile device.
In this case, no other smartphone jobs are configured for the mobile, because they
would fail.

Auto dialing

The configuration of an auto dialing job with QualiPoc is unchanged. The configura-
tions for the Voice Call MOC and MTC are shown in the following figures.
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Figure 6-627: Auto dialing activated - voice call MOC

Figure 6-628: Auto answering activated - voice call MTC

If auto answering is selected, no other jobs are possible in the job list. The "Available
Jobs" list is empty in this case.
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QP network forcing

The Network Forcing job is available as a DQA job if the mobile is loaded as fully inte-
grated device. The forcing job must be placed before the QP Session Start job.

QP network forcing job configuration

Technology and band forcing are available.

Figure 6-629: Technologies and bands for NTW forcing test

After the forcing, the QualiPoc rests in idle mode for a defined time.

6.5.2.12  Batch for fully integrated devices

The description of the Batch job in Chapter 6.5.1.4, "Configuration menus for the DQA
jobs", on page 1891 applies for the fully integrated devices having the following limita-
tions.

● Value in the "Count" column can only be changed for a defined Batch job.
● Batch cannot contain other Batch jobs.
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Figure 6-630: Batch job on fully integrated device

The "QoS Settings" page allows existing batches to edit and to save them.

While saving the batch, you are asked to enter a new name or keep the name and
overwrite the existing batch.

If you want to leave the page while there is an unsaved modified batch in the configu-
ration, you are prompted to auto-save the batch with a new name. Instead, you can
choose to stay on the page.

Figure 6-631: Dialog to save unsaved batch

Auto-save checks the name of the original batch. If the batch has a number in its
name, this number is increased until it is unique. In the previous screenshot, the “Batch
Job 1” is saved to “Batch Job 2”. If a batch with this name already exists, it is stored as
“Batch Job 3”.

6.5.2.13  QualiPoc status events and signals

There are events and signals aiming to follow the state of the fully integrated devices.

The corresponding event helps you get alarms whenever the connection to a device is
lost or a QualiPoc job fails.
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The status events and signals can be found in the "GSM Event" and the "GSM" availa-
ble signals branch, respectively.

Figure 6-632: QP status events and signals

For the QualiPoc status signals, see the "Description of R&S ROMES4 Signals" docu-
ment.

6.5.3  DQA jobs with iOS-based smartphones

R&S ROMES4 supports DQA jobs with smartphones using iOS operating system -
iPhones 13/14 are supported. Data and voice test configuration can be done in R&S
ROMES4, which controls iPhone, pushes jobs and run tests on iPhone.

To support mentioned functions, the necessary option for iPhone has to available on
the R&S ROMES4 side.

On the iPhone side, do the following actions:

- Prepare iPhone with a special build, which provides access to the modem and Qual-
comm diagnostic port on the Windows PC.

- Pair iPhone via Bluetooth with your Windows PC.

- Install the iPhone App called R&S ROMES Probe iOS App in the iPhone, see Chap-
ter 6.5.3.3, "R&S ROMES probe iOS app", on page 2054. The application is free of
charge available in the AppStore.

- Start manually the R&S ROMES Probe iOS App on the iPhone.

- Supported iPhone 13 and 14 with iOS 16.

- The Windows PC clock and iPhone clock have to be in sync. The maximum allowed
offset is 60 seconds.

Connect iPhone via cable to the PC where R&S ROMES4 is running (the same
approach as for QualiPoc Probes). The service/tool called iPhoneConnector App han-
dles connection to the iPhone over Bluetooth.
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Figure 6-633: iPhone Collector page

If the necessary option is available, the iPhoneConnector App starts during the R&S
ROMES4 start-up. The iPhone App connects through Bluetooth to the iPhoneConnec-
tor App, which is connected to the R&S ROMES4 application. If the last 6 digits of the
IMEI match, R&S ROMES4 shows the phone as iPhone.

Figure 6-634: Recognized iPhone in Available Devices pane

Figure 6-635: iPhone symbol
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If R&S ROMES4 does not detect the phone as the iPhone, check if the last six digits of
the IMEI are correct. The R&S ROMES4 GUI shows them on the Welcome sheet. Also
ensure the R&S ROMES Probe app is running foreground and that the Bluetooth con-
nection is established.

Figure 6-636: Not recognized device

The iPhoneConnector App is put into the Windows Tray by default.

6.5.3.1  DQA jobs with iPhone

The following DQA jobs are supported by the iPhone, i.e. by the R&S ROMES Probe
iOS App installed in the iPhone.

● AT Command
The Airplane Mode On and Off jobs correspond to AT Command jobs.

● Voice Call outgoing (MOC)
● HTTP Download
● HTTP Upload
● Ping
● Iperf3
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Figure 6-637: iPhone mode selection in QoS setting

The listed jobs can be combined in any order. The Session Start/Stop jobs are not
necessary for an iPhone.
After loading iPhone into R&S ROMES4, the iPhone mode is visible offering all
available jobs. A job configuration and execution is analog to the QualiPoc UE jobs
configuration.
The settings for Iperf3 job for QualiPoc and iPhone operation mode reflect the dif-
ferent options of the Iperf3 binary.
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Figure 6-638: Settings of Iperf3 job of iPhone

For Auto Answering, the iOS Auto Answer feature can be used.

6.5.3.2  IMS support

There is a limited IMS message support by the iPhone by default.

Although the call life cycle can be followed, not all messages are available. If the net-
work does not use IPSec, R&S ROMES4 can be used to get all IMS messages. Active
the "VoLTE" > "Use ROMES IMS Stack Tracing based in IP Tracing" option in the
Qualcomm devices configuration page to obtain all IMS messages.
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Figure 6-639: iPhone VOI configuration page of Qualcomm devices

6.5.3.3  R&S ROMES probe iOS app

The R&S ROMES probe iOS app can be downloaded from the iOS app store. After
downloading the app and before the app is used with R&S ROMES4, the ROMES ID
has to be configured in the app. This ID is the last 6 digits of the IMEI of the phone.

To get the app configuration screen where you can enter the ROMES ID, click the
“gear” icon on the iPhone's screen.
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Figure 6-640: iPhone screen showing the installed app
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Figure 6-641: Setting screen of an iPhone

Until the ROMES ID is filled in, R&S ROMES4 does not show the iPhone app as con-
nected.

The R&S ROMES Probe app currently supports the following test:

● Ping
● HTTP Download
● HTTP Upload
● Voice

Test results

Clicking the "HOME" button at the bottom of the application screen shows the current
test results screen.

The application screen shows the following entries:

- "Status": the current connection status and application status

- "Current Test": The name of the currently active test

- "Test Progress": The progress of the current test from 0% to 100%

- "Test Results": The colored graphic (box) in the middle of the screen shows the
results of the current throughput test.
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Figure 6-642: Tess progress

The successful test result "OK" is displayed in a green results box. The unsuccessful
results are displayed in the red box containing also the reason for the failure of the test.

Click the "Stop" button to stop the currently running test. This action stops the cam-
paign on the phone only, not on R&S ROMES4.

Log screen

Click the "Log" button at the bottom of the application (highlighted in the previous fig-
ure) to bring up the active log.
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Figure 6-643: Ping test results

The log file drops-down at the top of the screen of an iPhone. By default, the active log
file is shown. The contents of the drop-down is all log files currently stored by the appli-
cation. This action is only available when a campaign is not in progress.

Click the “trash can icon” to delete currently displayed log. If the "Active" log file is dis-
played, this deletion action clears the active log file. If a prior log file is chosen, then
that log file is deleted from the disk.
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Figure 6-644: Selected Active log of ROMES Probe

Click the “file folder” icon to save the active log file to disk.

The “file folder” icon is only displayed on the screen when the active log file is dis-
played.

Click the “lap top" icon to send the currently displayed log file to R&S ROMES4. The
file is stored in the ROMES log file directory.

The “lap top" icon is displayed on the screen when a log file stored on disk is dis-
played.

Configuration settings

The figure Figure 6-641 shows the entries in "Settings" that have to be set.

As mentioned, the "ROMES ID" is 6 characters of the phones IEMI. Enter this ID
before the app is connected to R&S ROMES4.

The "Log Settings" entry includes the following settings:

- "Send to ROMES after campaign": If turned on, the current application is sent to R&S
ROMES4 after the measurement campaign to include it into the SQC file.

- "Log Files to Keep": At the conclusion of each campaign, the contents of the current
log is saved to disk. This setting stands for the number of log files that the application
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has to keep. When the number of log files reaches this number, the oldest log is
deleted.

The "Manage Log Files" entry displays the following when clicked.

- "Log Files": Shows the list of log files saved to disk. Clicking the “trash can” icon dele-
tes the selected log file, see the previous figure.

Figure 6-645: Managed log files screen

- "Flush Old Logs": Deletes all log files saved to disk.

- "Clear Current Log": Clears the contents of the active log.

The "ABOUT" entry shows the version of the application in the "Version" line and
where to find the open-source acknowledgment for the file in the "Open Source
Acknowledgement".

The "Reset All Settings" resets all settings in the application to the default values.

6.5.4  DQA KPIs aggregation in KPI generator

The implementation phase of KPI generator includes the aggregation of the following
KPIs on ETSI_B basis:
● Dial Up Time (Data Call Access Time)
● PDP Context Activation Time
● DNS Resolution Time
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● Setup Time (Service Setup Time)
● Mean Data Rate (FTP, HTTP, UDP, EMAIL)
● PING RTT
● FTP / HTTP / UDP / EMAIL IP Setup Time
● FTP / HTTP / UDP / EMAIL IP Access Failure Ratio
● FTP / HTTP / UDP / EMAIL IP Session Failure Ratio

Usage of the original KPI definition file kpi.xml (as delivered by Rohde&Schwarz) is
necessary due to KPI definition ID numbers.

Minimum R&S ROMES4 4.70 version should be used for measuring. All measurement
files before R&S ROMES4 4.70 version are evaluated in classical mode of operation
from the DQA frames (KPI generator not used). This is reported as ‘Info’ within the
"Analysis Messages".

6.6  Navigation

R&S ROMES4 uses two different methods to determine the geographic coordinates of
a measurement position:

● For ordinary outdoor applications, a GPS receiver is used to detect the satellite sig-
nals of the Global Positioning System (GPS).

● In areas where no GPS signals can be detected, e.g. inside closed buildings, the
position is defined by means of a user-defined map.

The navigation drivers U-Blox and the R&S TSME GPS which run the U-Blox devices
for navigation, support U-Blox chip NEO-M9V. The U-Blox chip NEO-M9V supports up
to 4 GNSS in parallel. The supported GNS are GPS, Galileo, GLONASS and Beidou. If
the NEO-M9V chip is detected, the configuration switches to this 4 GNSS setting.

Navigation and indoor drivers and their configurations are described in the following
sections.

6.6.1  GPS devices

The R&S ROMES4 measurement system supports different GPS devices to be used
as the GPS receivers.

A GPS device is loaded by selecting one GPS device out of offered devices in the
"Navigation" branch of the "Hardware" > "Hardware Configuration" > "Available Devi-
ces" pane. The configuration menus of the loaded GPS devices are explained in the
next chapters.

Navigation devices (ublox and TSME GPS) support also Blox chip NEO-M9V. This
uBlox chip NEO-M9V supports up to 4 global navigation satellite systems (GNSS) in
parallel. These systems are GPS, Galileo, GLONASS and Beidou. If this chip NEO-
M9V is detected, the configuration switches to the 4 GNSS setting.
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6.6.1.1  Supported GPS device types

Table 6-26: GPS supported devices

GPS devices Description of supported devices

NMEA GPS All GPS receivers supporting the NMEA ("National Marine Electronics
Association") protocol.

U-Blox GPS U-Blox driver enables the U-Blox protocol with enhanced setting possibil-
ities supported by the GPS receivers R&S TSMX-PPS GPS MODULE.

R&S TSME GPS Internal GPS receiver of the R&S TSME

R&S HE300 GPS R&S HE300 active directional antenna w/wo integrated GPS receiver,
see Chapter 6.6.1.6, "R&S HE300 GPS compass", on page 2080

MAVLink Drons, see Chapter 6.6.1.7, "MAVLink", on page 2081

Each R&S ROMES4 configuration provides also the GPS simulator. The "Simulator
GPS" option assigns fictitious geographic information to a set of measurement data so
that they can be displayed in the "ROMESMAP Route Track View". A GPS receiver is
not required.

6.6.1.2  GPS configuration menus

The GPS device configuration menus offer device-specific settings. Click the devices
command line of the "Hardware" menu which is available when a device used as GPS
receiver is loaded.

6.6.1.3  NMEA GPS

The R&S ROMES4 NMEA device version supports the following NMEA protocol ver-
sions: GSA, GGA, RMC, ZDA. Protocol versions not listed here are ignored. The for-
mat of the NMEA data depends on the protocol version.
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Figure 6-646: NMEA configuration: GPS Health Monitoring

The following example shows a comparison of the RMC, GGA and VTG (not suppor-
ted) protocols:

$GPRMC,144732,A,4807.530037,N,01136.650214,E,0,144,070800,001.0,E*76

$GPGGA,144732,4807.530037,N,01136.650214,E,1,09,1.1,546.6,M,46.8,M,,*4F

$GPVTG,144,T,069.3,M,0,N,0,K*5D

$GPRMC,144733,A,4807.530037,N,01136.650214,E,0,144,070800,001.0,E*77

$GPGGA,144733,4807.530037,N,01136.650214,E,1,09,1.1,546.6,M,46.8,M,,*4E

$GPVTG,144,T,080.7,M,0,N,0,K*5E

$GPRMC,144734,A,4807.530037,N,01136.650214,E,0,144,070800,001.0,E*70

$GPGGA,144734,4807.530037,N,01136.650214,E,1,09,1.1,546.7,M,46.8,M,,*48

$GPVTG,144,T,074.7,M,0,N,0,K*55

...
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GPS health monitoring

The "GPS Health Monitoring" tab switches health monitoring in the "General Status
View" on or off. Also, the tab offers the possibility to adjust the synchronization
between PC and GPS time, see "NMEA device information" on page 2066. Transmis-
sion time causes delays in milliseconds. If the delay is known, higher accuracy can be
reached by setting the "Constant Offset". Such accuracy is only important for Video
Quality Analysis.

Figure 6-647: NMEA configuration input

Bad GPS health means that the GPS signal received is low. Bad health situations can
frequently occur during an ordinary test trip, e.g. if the vehicle crosses an underpass or
a tunnel. If "Use GPS Health Monitoring" is active, the bad health situations cause a
warning message. The message is displayed in the "General Status View", providing
that they last longer compared to the time selected in the "Duration of bad GPS Health"
field.

Furthermore, GPS and Indoor can work together in combined mode. Therefore, define
it within the "Input Mode" area. If configured, Indoor becomes active when the GPS
signal gets lost. For this mode, the indoor input works only in measurement mode
"Continuous Measurement" and navigation mode "Stream Input".

Mode "GPS / Indoor combined"
This mode is only available when a georeferenced map is loaded.

Indoor configuration

The "Indoor Input" tab is used to select the measurement and navigation mode and
allows waypoints to configure. It is only active if the "GPS / Indoor combined" input
mode is selected in the "GPS Health Monitoring".

For the explanation of the settings refer to Chapter 6.6.2.2, "Indoor input configuration
– setup", on page 2083.

Navigation



Hardware ComponentsDrive Test Software

2065Operating Manual 1171.6415.12 ─ 66

Figure 6-648: Indoor Configuration tab, input mode „GPS only“ and input mode "GPS / Indoor com-
bined"

Templates

The "Templates" tab let you store the current device configuration as a template, list,
load or delete the device templates. It is provided for many test devices and is identical
for all them.

Figure 6-649: NMEA Configuration - Templates
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NMEA device information

The NMEA "Navigation Driver" page displays information on the current device ver-
sion.

If the "GPS Time and Initial Position" box is checked, the system time is synchronized
with the GPS time so that the PC clock can be set to the accurate GPS clock. The val-
idity of the received time is checked before the system time is set.

NMEA devices take the time from the RMC sentence. Set the data valid flag to ‘A’
before the system time is updated. This setting implies that the measurement can be
started only after a string containing the time information has been received. This time
delay can be avoided by switching off the correction and starting the measurement
immediately. No other configuration settings are required.

Figure 6-650: NMEA Configuration - Navigation Driver

R&S ROMES4 detects any NMEA device at the selected COM port. If not, check the
COM port and the device power supply.

6.6.1.4  UBLOX GPS

The U-Blox device supports the GPS receiver R&S TSMX-PPS and R&S TSMX-PPS2.
Also other devices based on U-Blox chipsets which have virtual serial port can be sup-
ported.
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Disconnecting and connecting the USB cable is detected by R&S ROMES4, the U-Blox
device is configured automatically. If a measurement is running, the recording of GPS
data continues.

Figure 6-651: UBLOX Device - Configuration

The R&S ROMES4 U-Blox device disables the output of the NMEA messages on the
device. To use the device again with NMEA protocol, it must be re-enabled with the u-
center software from U-Blox (www.ublox.com). This software can be found on the R&S
ROMES4 DVD in
\Firmware & Drivers\GPS Receiver\ublox TSMX-PPX\u-center\.

U-Blox configuration

The "UBLOX Device" configuration menu configures the loaded U-Blox device. With
this protocol, it is possible to set the navigation output filters.

The "Configuration" tab enables the following to configure:

Antenna

When the GPS antenna is not correctly connected, you are warned about if this option
is enabled in the device configuration. Following fault reports can be enabled:
● Control signal
● Short circuit detection
● Short circuit power down logic
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● Open circuit detection

Figure 6-652: Example of a R&S ROMES4 Alert popup message

GPS mode

Eight different modes for the GPS are available:
● Portable

Applications with low acceleration, for example, portable devices; suitable for most
situations.
– Max Altitude [m]: 12000
– Max Velocity [m/s]: 310
– Max Vertical Velocity [m/s]: 50
– Sanity check type: Altitude and Velocity
– Max Position Deviation: Medium

● Stationary
Used in timing applications (antenna must be stationary) or other stationary appli-
cations.
– Velocity restricted to 0 m/s
– Zero dynamics assumed
– Max Altitude [m]: 9000
– Max Velocity [m/s]: 20
– Sanity check type: Altitude and Velocity
– Max Position Deviation: Small

● Pedestrian
Applications with low acceleration, for example, how a pedestrian would move; low
acceleration is assumed.
– Max Altitude [m]: 9000
– Max Velocity [m/s]: 30
– Max Vertical Velocity [m/s]: 20
– Sanity check type: Altitude and Velocity
– Max Position Deviation: Small

● Automotive (recommended for drive tests)
Default setting for ADR (Automotive Dead Reckoning). Used for applications with
equivalent dynamics to those ones of a passenger car; low vertical acceleration is
assumed.
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– Max Altitude [m]: 6000 (5000 for firmware versions 6.00 and below)
– Max Velocity [m/s]: 84 (62 for firmware versions 4.00 to 5.00)
– Max Vertical Velocity [m/s]: 15
– Sanity check type: Altitude and Velocity
– Max Position Deviation: Medium

● Sea
Recommended for applications at sea, with zero vertical velocity; zero vertical
velocity is assumed.
– Max Altitude [m]: 500
– Max Velocity [m/s]: 25
– Max Vertical Velocity [m/s]: 5
– Sanity check type: Altitude and Velocity
– Max Position Deviation: Medium

● Airborne 1 G
Used for applications with a higher dynamic range and vertical acceleration than a
passenger car.
– Max Altitude [m]: 50000
– Max Velocity [m/s]: 100
– Max Vertical Velocity [m/s]: 100
– Sanity check type: Altitude
– Max Position Deviation: Large

● Airborne 2 G
Recommended for typical airborne environment. No 2D position fixes supported.
– Max Altitude [m]: 50000
– Max Velocity [m/s]: 250
– Max Vertical Velocity [m/s]: 100
– Sanity check type: Altitude
– Max Position Deviation: Large

● Airborne 4 G
Only recommended for extremely dynamic environment. No 2D position fixes sup-
ported.
– Max Altitude [m]: 50000
– Max Velocity [m/s]: 500
– Max Vertical Velocity [m/s]: 100
– Sanity check type: Altitude
– Max Position Deviation: Large

Navigation output filters

● Position Dilution of precision (DOP) mask
● Time DOP mask
● Position accuracy mask [m]
● Time accuracy mask [m]
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● Frequency accuracy mask [m/s]

Reset Button

● Reset (Coldstart) device
Click the button "Reset (Coldstart) device" shuts down and resets the device.
Resetting the device commands a total erasing of all stored data. This reset is
called the cold start. Achieving all the needed info needs several seconds and is
normally not necessary.

Write Default Settings Button

● Write Default settings
Writing default settings take a valid U-Blox default configuration on the U-Blox chip
and write over the actual configuration. Writing default settings helps easy return to
a valid and working configuration.

Update Rate

● Update Rate
The "Update Rate" slider is limited by the maximum update rate that the U-Blox
chip can deliver. This update rate can be from 1Hz up to 20 Hz. The U-Blox chips
with the enabled ADR functionality have maximum rate of 1 Hz only.

ADR configuration (R&S TSMX-PPS2 only)

The R&S TSMX-PPS2 has a built-in Automotive Dead Reckoning (ADR) feature. Even
in tunnels or building canyons with bad or missing GPS coverage, the last valid posi-
tion is extrapolated using distance and angle information from a gyroscope and a
speed/direction pulse input from the vehicle.

The gyroscope for heading information is already embedded in the R&S TSMX-PPS2.
Fed the vehicle tachometer pulses and the direction indication via the accessory sen-
sor cable into the SENSOR IN port.

For using an R&S TSMX-PPS2 together with car sensors, we recommend a UBLOX
flash version 7.03 or higher. Contact Rohde & Schwarz for a firmware update.
Attention: ADR positioning does not work or is incorrect if the polarity setting is errone-
ous.
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Figure 6-653: UBLOX Device - DR configuration

ADR Car Sensors Connected

Checking the "ADR Car sensors connected" enables the ADR functionality on the chip
(only available with R&S TSMX-PPS2).

Direction Pin Polarity

The polarity depends on the reverse gear light signal and can be a high-level signal
forward direction or backward direction. A correct setting can be seen at GPS Info view
during a measurement.

PPS2 Mounting Orientation

As the gyroscope is placed on the UBLOX chip, it is necessary to know which mount-
ing position the R&S TSMX-PPS2 has. Referring to the R&S TSMX-PPS2 operating
manual, the PPS2 normal (strict horizontal) and upside down mounting position is pos-
sible.

● Set to "normal" if the R&S TSMX-PPS2 lettering can be seen from the top.
● Set to "upside down" if the R&S TSMX-PPS2 lettering is on the bottom side.

For optimum ADR performance, the system needs to learn from the internal sensors
(gyro) and from the provided vehicle signals (speed & direction). Sometimes, for exam-
ple when changing the vehicle or the sensors or when the GPS shows bad positioning
data, it can be helpful to reset this calibration data by using the "Clear DR Calibration/
Temp Data" button.

As a result a new calibration is done.
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In case the UBLOX chip has no ADR capability (e.g. R&S TSMX-PPS) all the ADR set-
tings are disabled.

TSMX-PPS2 and UBLOX device navigation

As the TSMX-PPS2 device needs a correct information how the box is mounted in the
vehicle and what the polarity of the backlight signal is, these must be set through the
driver configuration. A wrong configuration prohibits a proper dead reckoning calibra-
tion.

Usually the TSMX-PPS2 is mounted in a car. If a R&S ROMES4 measurement is star-
ted with the uBlox device and a TSMX-PPS2, the device tries to improve its calibration
status during movement. Whenever the calibration status for the tacho pulses and for
the gyro is both coarse calibration or fine calibration, the configuration is written into
the registry.

A wrong initial setting of direction pin polarity and PPS2 mounting orientation never
reach a sufficient calibration state. Later at each load of the uBlox device, the registry
searches for this configuration and uses it as a default. Of course, an existing work-
space can overwrite this configuration.

This feature applies only for R&S TSMX-PPS2 device and if the "ADR Car sensors
connected" functionality is enabled and the backlight signal is wired.

GPS health monitoring

The "GPS Health Monitoring" tab lets switch health monitoring in the "General Status
View" on or off. Also, the tab offers the possibility to adjust the synchronization
between PC and GPS time, see "Navigation driver information" on page 2074. Trans-
mission time causes delays in milliseconds. If the delay is known, a higher accuracy
can be reached by setting the "Constant Offset". This is only important for Video Qual-
ity Analysis.
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Figure 6-654: UBlox configuration - GPS Health Monitoring

Bad GPS health means that the GPS signal received is low. Bad health situations can
frequently occur during an ordinary test trip, for example, if the vehicle crosses an
underpass or a tunnel. If "Use GPS Health Monitoring..." is checked, bad health situa-
tions cause a warning message to be displayed in the "General Status View", provided
that they last longer than the time selected in the "Duration of bad GPS Health..." entry
field.

Furthermore GPS and Indoor can work together in combined mode.

The possible input modes are:
● GPS only
● GPS / Indoor

Therefore, define it within the "Input Mode" area. If configured as GPS / Indoor, indoor
becomes active when the GPS signal is lost. For this mode, the indoor input works only
in the measurement mode "Continuous Measurement" and the navigation mode
"Stream Input".

Indoor configuration

The "Indoor Input" configuration menu lets select the measurement and the navigation
mode and allows waypoints to configure. It is only active if the "GPS / Indoor com-
bined" input mode is selected in the "GPS Health Monitoring".

For the explanation of the settings refer to Chapter 6.6.2, "Indoor input device -
INDOOR", on page 2083.
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Figure 6-655: Indoor configuration tab, Input Mode „GPS only“ and Input Mode "GPS / Indoor"

Templates

The "Templates" tab let you store the current device configuration as a template, list,
load or delete device templates. It is provided for many test devices and is identical for
all them.

Figure 6-656: UBlox Configuration - Templates

Navigation driver information

The U-Blox "Navigation Driver" page displays information on the current driver version.
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If the "GPS Time and Initial Position" box is checked, the system time is synchronized
with the GPS time so that the PC clock can be set to the accurate GPS clock. The val-
idity of the received time is checked before the system time is set.

U-Blox devices take the time form the sentence TIMEUTC. The accuracy has to be at
least 0.1 seconds before the system time is updated. This accuracy implies that the
measurement can be started only after a string containing the time information has
been received. This time delay can be avoided, however, by switching off the correc-
tion and starting the measurement immediately. No other configuration settings are
required.

The "Navigation Driver" tab displays information on the current device version. Mes-
sages such as "GPS bad health condition" or "Antenna open circuit" are displayed in
the "General Status View".

The system detects any U-Blox device at the selected COM port. If not, check the
COM port and the device power supply.

Figure 6-657: UBLOX Configuration - Navigation Driver

Configuration settings and information regarding the used hardware are displayed in
the Measurement File Info.
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Example: Measurement file Info layout
===================================================
[GPS, Ver. 4.76]
Type:          UBLOX Device
Ellipsoid:           WGS84
Hardware Version:                    u-blox 6
Chip Version:                           LEA-6R
Protocol Version:                    7.03
ROM Version/Flash Version:        6.02 / 7.03
Features:                               GPS; DR; 

Position DOP mask:                   25.0
Time DOP mask:                       25.0
Position accuracy mask:           100.0 m
Time accuracy mask:                  300.0 m
Frequency accuracy mask:          1.5 m/s
DGPS timetag rounding disabled.
GPS mode:                               Automotive
Antenna control signal enabled.
Antenna short circuit detection enabled.
Antenna short circuit power down logic enabled.
Antenna open circuit detection enabled.
Car sensors are not connected.

Driven Area:    48°8'34"N (Lat. up left)
                11°36'31"E (Long. up left)
                48°6'11"N (Lat. bottom right)
                11°45'32"E (Long. bottom right)
===================================================

6.6.1.5  R&S TSME GPS

Installation of the R&S TSME GPS device is explained in Chapter 6.6.1, "GPS devi-
ces", on page 2061.

The following figure shows the R&S TSME GPS device configuration.
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Figure 6-658: R&S TSME GPS Device - Configuration

It is possible to set the navigation output filters.

The update rate with the R&S TSME GPS device is one per second.

The following figure shows the R&S TSME6 scanner configuration page which allows
to configure the GNSS mode. Tick the "Untethered Dead Reckoning enabled" check-
box to configure the GNSS mode.
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Figure 6-659: R&S TSME6 GPS Device - Configuration

Click the "Untethered Dead Reckoning enabled" checkbox to get more precise GPS
positions. For details, refer to https://www.u-blox.com/en/dead-reckoning.

Configuration

The "Configuration" tab lets you configure the following:

Antenna

Incorrect connected GPS antenna is reported to you if the option to report the case is
enabled in the device configuration page. Following fault reports can be enabled:
● Control signal
● Short circuit detection
● Short circuit power down logic
● Open circuit detection

Navigation
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Figure 6-660: Example of a R&S ROMES4 Alert popup message

GNSS Mode

GNSS mode is active for R&S TSME GPS if the "Untethered Dead Reckoning
enabled" checkbox is ticked in the R&S TSME6 mode.

GNSS selection

The drop-down "GNSS Selection" box offers the selection of a satellite positioning sys-
tem.

Navigation output filters

● Position Dilution of precision (DOP) mask
● Time DOP mask
● Position accuracy mask [m]
● Time accuracy mask [m]
● Frequency accuracy mask [m/s]

DGPS

● DGPS time tag rounding enabled
● Timeout for differential correction data [s]
● Timeout for pseudo range correction (PRC) data [s]
● Timeout for carrier phase correction data (CPD) [s]

Reset Button

● "Reset (Coldstart) device"
Click the "Reset (Coldstart) device" button to shut down and reset the device.

Update Rate

Enter the update rate of the GPS device. It can be set between 1 and 5 position
updates per second.

Input Mode

It is available for all drivers. For the R&S TSME the user can select between:
● "GNSS only"
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● "GNSS/Indoor"

Indoor configuration

If the "Indoor Configuration" tab is clicked, the same window opens as that one shown
in Chapter 6.6.1.3, "NMEA GPS", on page 2062.

Scanner tab

Click the "Scanner" tab to get the information on configured device and the running
software version.

6.6.1.6  R&S HE300 GPS compass

The R&S HE300 GPS compass is an active directional antenna.

Two variants of the R&S HE 300 antenna are available.
● R&S HE300 Var03 with built-in compass and GPS
● R&S HE300 Var02 with no electronic compass and no GPS, but with magnetic

compass

Figure 6-661: Some available navigation devices

If the R&S HE300 Var03 is used, the antenna cable feeds a scanner or receiver. The
USB adapter transfers GPS position and compasses heading data from the antenna to
the connected PC. There are no drivers for antennas in R&S ROMES4. The R&S
HE300 device covers the part of a compass and GPS.

The R&S ROMES4PAN option is necessary to use the R&S HE300 Var03.

If the R&S HE300 Var02 (without electronic compass/GPS) is used, the HE300 device
is not required and cannot be loaded.

Driver and option ID are not necessary to use the R&S HE300 Var02.

The "Direction" signal shows the compass value. GPS data, if available, are signaled
as longitude and latitude.
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Figure 6-662: Compass info for GPS

The electronic compass also detects the roll and pitch values. Validity of direction only
applies for roll and pitch values between -59° and 59°.

How to use the antenna: refer to "R&S HE300 Manual"

Configuration of R&S HE300 GPS compass

If the GPS is in a bad receiving condition, deactivate "Use GPS Health Monitoring in
General Status View" in the "GPS Health Monitoring" page. This prevents from nag-
ging about health alert.

If floor plans are used, select the GPS / Indoor combined option in the "Input Mode"
field.

6.6.1.7  MAVLink

The drones are used more and more for QualiPoc and scanner measurements to get
the reliable altitude information. The reliable altitude information is a key for identifica-
tion of coverage holes or interference. To send messages between ground stations and
drone, MAVLink is commonly used protocol. It is an open-source protocol.

R&S ROMES4 supports MAVLink data from a serial port. The R&S ROMES4 MAVLink
GPS device reads MAVLink data packets from any COM port.

Configure a drone that sends out the required MAVLink messages. For GPS data,
MAVLink message #33 is used.

6.6.1.8  GPS simulator

The "Simulator GPS" menu configures the GPS simulator and shows the current file
version.

Position

The "Position" tab lets you select the geographical start position, the speed and direc-
tion of the measurement curve on the map. Some attributes can be assigned to the
measurement data via this menu also.
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Figure 6-663: GPS Simulator configuration

● "Position"
The panel defines the position of the measurement data on the map:
– "Start"

The first measurement point is assigned the three geographic coordinates in
the "Start" column. If the data is displayed in the "Route Track View", then the
"Altitude" coordinate does not contribute to the representation but is shown in
the "GPS Info" view.

– "Step/s"
The three coordinates in the "Step/s" column define the geographical distance
of a data point from another that was recorded 1 s earlier. The "Altitude" coordi-
nate is not considered. The ratio between "Longitude" and "Latitude" deter-
mines the angle of the measurement curve on the map; the sum of the squares
of both values is proportional to the square of the speed of the measurement
curve on the map.

● "Attributes"

The panel assigns a (fictitious) "Validity" and "Health" value to the measurement. Both
values are shown in the "GPS Info" view.

GPS health monitoring

For the "GPS Health Monitoring" tab, see "GPS health monitoring" on page 2064.

Navigation driver

The "Navigation Driver" tab displays information on the current GPS simulator version,
see "NMEA device information" on page 2066.
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6.6.2  Indoor input device - INDOOR

The option R&S ROMES4IND and the "ROMESMAP Route Track View" are necessary
to use the "Indoor Input" device.

The Indoor Input device is used for measurements in areas where no GPS navigation
signal is available, that is, inside buildings.

The "ROMESMAP Route Track View" is used to visualize the measurement route, see
ROMESMAP route track view.

One or more user-defined maps, for example, floorplans are used. Furthermore, it is
possible to use GPS and Indoor measurement in Combined mode. That means, when
the GPS signal is lost the navigation device switches to Indoor Input mode, where the
waypoints are set on a map to be treated as GPS signals.

How to configure the Combined mode, see Chapter 6.6.1.3, "NMEA GPS",
on page 2062.

The Indoor Input device itself does not need additional hardware.

Support of indoor navigation device
Old workspaces, created with the Indoor Navigation device, cannot be read anymore.
To display the old measurement files, use the still existing earlier version of "Indoor
View".
The "Indoor Navigation Control" does not exist anymore. The indoor navigation is inte-
grated in the "ROMESMAP Route Track View".

Qualipoc/SmartBenchmarker indoor measurements
The Indoor measurements conducted directly with QualiPoc/SmartBenchmarker
(*.sqc/*.sqz files) are fully supported for an import and replay in R&S ROMES4.

6.6.2.1  Device configuration menu INDOOR

"ROMESMAP Route Track View" is used for displaying signals of indoor measure-
ments.

Therefore, the wanted background bitmap is loaded over the "ROMESMAP Route
Track View".

Open the Indoor Input device configuration menu for all other configuration settings
related to indoor measurements. To do that, select the "Indoor Input" command line in
the "Hardware" menu which is available after loading the device.

6.6.2.2  Indoor input configuration – setup

The "Indoor Input" dialog is used to select the measurement and navigation mode and
to configure waypoints.
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Figure 6-664: Indoor input device configuration menu

Measurement Mode
Two modes are available for indoor measurement:
● Measurement in a fixed time interval; select the "Hot Spot" option button
● Measurement that lasts for an undetermined time unless restarted explicitly; select

the "Continuous Measurement" option button
Both measurement modes can be combined individually with the "Waypoints".
A waypoint defines a position of a measurement location, and is reported to the mea-
surement system.
R&S ROMES4 offers to predefine waypoints before the measurement starts. To prede-
fine waypoints, click the "Preconfigure Waypoints" button. Otherwise, the waypoints
are set during the measurement. See also Indoor measurements in different navigation
and measurement modes.
If "Generate GPS signals each ... ms" is checked, the position interpolation is running
during the measurement. This interpolation is available only in the Continuous mea-
surement mode. The frequency and the number of GPS signals define the interpolation
granularity.
Click the "Preconfigure Waypoints" button to define waypoints on the current loaded
indoor view of the measurement route. For details how to add, edit and remove way-
points, see Chapter 6.6.2.3, "Preconfigure waypoints", on page 2085.
Note: The "Preconfigure Waypoints" button is only active, if already an image map is
loaded in the "ROMESMAP Route Track View".
How to load an image map, see Chapter 4.3.3.6, "Maps menu", on page 606.

Maps
Only available for MapInfo maps.
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If "Store Maps in Measurement File" is active, all the map files of the Map Set are
stored in the measurement file. Stored maps are extracted before replay is performed.
In "Output" the extracted files are shown below the green colored entries, see the fol-
lowing figure.

Note: The mentioned setting has no impact if indoor mode is used together with GPS
mode, described in NMEA GPS as combined mode (GPS/Indoor combined). The maps
are not saved in the measurement file regardless of the checking the check box.
If "Change Map when last Waypoint was measured" is active, the next, not yet mea-
sured map, is activated after the last waypoint being measured. This feature is only
available in the "Navigation Mode Waypoints".

OK
Applies the current configuration (if it is valid) and closes the "Indoor Input" menu.

Cancel
Discards the configurations made and closes the "Indoor Input" menu.

6.6.2.3  Preconfigure waypoints

Click the "Measurement Mode" > "Preconfigure Waypoints" button to prepare way-
points for a current loaded indoor view in advance.

Figure 6-665: Indoor Input – Preconfigure Waypoints button
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Always load the map first
Always add or remove the maps before configuring waypoint or measurement tasks!
If the map of a measured waypoint is not loaded in the "ROMESMAP Route Track
View", a message box informs the user that the waypoint cannot be displayed. This
message appears once for each map on which waypoints are created during a mea-
surement.

► Click the button "Preconfigure Waypoints" to switch to the waypoint configuration
mode.

For this purpose, the "ROMESMAP Route Track View" opens in a waypoint config-
uration mode and a "Waypoint Configuration" dialog appears on the right hand-side
of the view.
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Figure 6-666: Route Track View in waypoint configuration mode

Waypoint configuration

The "Waypoint Configuration" dialog contains the following functions.

Maps
All maps of the "Map Set" are displayed in the list box. If a map is selected from the
list, it is displayed in the "ROMESMAP Route Track View" and waypoints can be
defined for this map. The last selected map is placed on top in the list.
The "Floorplan Changed" event makes it possible to visualize floorplan changes in the
basic views.
If activated, the "Floorplan Changed" event makes floorplan changes visible in this and
another R&S ROMES4 basic views. The event is activated in the "Performance" >
"Available Events" > "GPS Events" >"Indoor".

Edit Mode
Defines the "clicking" mode on the map.
● Add

If active, a new waypoint is created by clicking a wanted position on the map. The
waypoint has the name "Waypoint" plus a continuous number. The created way-
points are shown in the list box.

● Edit/Remove
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If active, waypoints can be moved by dragging it to another position. Furthermore,
from a selected waypoint the coordinates (lon. and lat.) can be changed or a way-
point deleted by clicking the "Delete Waypoint" button.

Move Up
Moves up the selected waypoint one position.

Move Down
Moves the selected waypoint one position down.

Delete Waypoint
Removes the selected waypoint

Update Names
Updates the waypoint names using the current order. The update can be necessary
after deleting a waypoint or changing their order.
How to rename a waypoint, see step-by-step explanation in section "Rename a way-
point" on page 2093.

Pos X/Pos Y
Defines the X- and Y-screen coordinates in pixel of the selected waypoint.

Lon/Lat
Specifies the longitude and the latitude of the selected waypoint. If the "Edit Mode" is
set to "Edit/Remove", the coordinates are editable.

OK
The waypoint configuration mode closes and the configuration is saved in the current
workspace.

Cancel
The waypoint configuration mode closes without saving the changes.

6.6.2.4  Indoor navigation - templates

The "Templates" tab stores the current device configuration as a template, lists, loads
or deletes device's templates. All settings are analogous to the GSM device settings,
refer to Chapter 6.4.18.8, "Templates GSM NWS", on page 1786.
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Figure 6-667: Indoor Navigation – Templates

6.6.2.5  Load maps

For loading maps, see Chapter 4.3.3.6, "Maps menu", on page 606.

Special characters are not allowed within the map name.
For example, German characters ö,ü and ä have to be transferred to oe, ue and ae;
instead of Übersicht.jpg write Uebersicht.jpg.

6.6.2.6  Measurement mode INDOOR

The "Measurement Mode" panel of the Indoor Input device offers two different mea-
surement modes, the "Hot Spot" and the "Continuous Measurement".

Figure 6-668: Indoor Input – Measurement Mode pane
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Table 6-27: Indoor measurements in different navigation and measurement modes

Navigation Mode Measurement Mode

Hot Spot
(measurement with time limit)

Continuous
(measurement without time limit)

Preconfigured
Waypoints

(predefined measure-
ment points)

● Go to next waypoint
● Click the waypoint button in the

control menu to initiate new mea-
surement after preset second
count.

The result is shown at the waypoints
(discrete values)

● Go to next waypoint
● Click waypoint button in the control

menu to initiate new measurement

The result is shown between the way-
points (color scale)

Stream Input
(measurement points

defined ad hoc)

● Go to next measurement point
● Use mouse to mark the measure-

ment point (current position) on the
Indoor view

● Click position to initiate new mea-
surement after preset second count

The result is shown at the measurement
points (discrete values)

● Go to next measurement point
● Use mouse to mark the measure-

ment point on the Indoor view
● Click map location to initiate new

measurement.

The result is shown between the mea-
surement points (color scale)

Configure signals and test devices in advance
To see the signals and devices in "ROMESMAP Route Track View", configure them via
"ROMESMAP Route Track View" > "Configuration" first, see chapter ROMESMAP
route track view.

Starting an indoor measurement switches the "ROMESMAP Route Track View" to
Indoor Measurement mode. The "Indoor Measurement" dialog appears at the right-
hand side of the view.

The measurement dialog of the Indoor Navigation module is made more usable on
touch screens by adding the “Auto Heading” feature. If this one is active, the map is
rotated in a such way, that the last segment of the route is made vertical. The following
figure shows the segment for the waypoint 7.
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Figure 6-669: Indoor Continuous Measurement mode

The previous figure shows the possibility to jump to points between waypoints of the
Indoor measurement in continuous mode. Note the marked points with the hand sym-
bol between two waypoints in the figure. It is possible to click anywhere on the route
track.

Limitation of this new function is: additional to way points, for all route via points there
are timestamp values available.

If clicked between two via points, corresponding timestamp is calculated by assuming
a constant speed. Therefore, the cursor marker cannot be exactly set to clicked route
point.

Auto Heading enables automatically the rotating mode of the ROMESMAP Route
Track View, see Rotate map on / off.

Indoor measurement control

Force Indoor
If active, forces the Indoor input in a GPS/Indoor combined measurement. This feature
can avoid frequent switching Indoor on and off when there is a poor GPS quality.
Switching off the Force Indoor option has only the effect when there is a good GPS.
If the GPS device runs in GPS/Indoor combined mode, the Indoor Measurement Con-
trol is always displayed.
If GPS is active and the "Force" checkbox is ticked, the position data and the GPS
state are displayed in the upper right-hand part of the window.

Navigation



Hardware ComponentsDrive Test Software

2092Operating Manual 1171.6415.12 ─ 66

Figure 6-670: Displayed position data and GPS state

Force Indoor can be also configured in the "Action" menu during the measurement.

Action Buttons
The actions which these buttons enable depend on the measurement mode. An infor-
mation field under the action buttons informs about the next action.

Mode
The "Mode" combo-box lets you select the action after adding a new waypoint. The
available actions depend on the measurement mode ("Hot Spot" or "Continuous Mea-
surement"). The action is performed only if all other waypoints were measured before
adding a new waypoint.
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The possible modes are:
● No Action

No action is performed after adding a new waypoint.
● Check Waypoint (only Hot Spot mode)

Performs the Check Waypoint action after adding a new waypoint.
● Waypoint Arrival (only Continuous Measurement mode)

Performs the Waypoint Arrival action is performed after adding a new waypoint.
● Waypoint Passing (only Continuous Measurement mode)

Performs the Waypoint Passing action is performed after adding a new waypoint.

Maps
All maps of the Map Set are displayed in the list box. Selecting a map displays the map
on the "ROMESMAP Route Track View" and all the waypoints defined on this map.
The last selected map stays on top of the list.

Edit Mode
Defines the clicking mode on the map.
● Add

If "Add" is activated, a new waypoint is created by clicking a wanted position on the
map. The waypoint gets the name "Waypoint" plus a continuous number. The cre-
ated waypoints are shown in the list box.

● Edit/Remove
The selected waypoint can be moved by dragging it to another position. The
selected waypoint can be deleted using the "Delete Waypoint" button. Furthermore,
via right mouse click "Show Maps Menu" the context menu for the selected way-
point is available.
"Edit/Remove" provides the possibility to add, move or remove waypoints also in
Navigation Mode Waypoints.

Delete Waypoint
Removes the selected waypoint. If the "Edit Mode" is set to "Edit/Remove", the name is
editable.

Rename a waypoint

Select a waypoint in the list box and press the left mouse button more than one second
on the selected item or double-click the selected item. The list box item goes into edit
mode.

Rename a waypoint

1. Set "Edit Mode" to "Edit/Remove".

2. Select a waypoint in the list box.
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Figure 6-671: Selected waypoint is editable

3. Double-click the selected item.

The name of the waypoint is editable now.

Rename multiple waypoints

Procedure

1. Set "Edit Mode" to "Edit/Remove".

2. Select the waypoint with the prefix that is used for all other waypoints.

Figure 6-672: Selected waypoint is editable

After a double-click or a single slow click, the name of the selected waypoint is
editable.

3. Click "Update Names".

All the waypoint names have the same prefix as the selected on.
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Hot spot

The measurement in the "Hot Spot" mode terminates after a fixed time, but can be
restarted at each measurement position (hot spot). The fixed measurement time is set
in the input field of the "Hot Spot" radio button.

When the measurement is started, the "ROMESMAP Route Track View" switches to
"Measurement" mode. The "Indoor Measurement" control dialog appears at the right
side of the view.

As soon the action mode "Check Waypoint" is selected, the "Hot Spot Measurement"
starts at once after a new waypoint was added. A histogram is shown for the selected
signal at the measured waypoint.

Hot Spot histogram
If an already measured waypoint is moved or removed, the signal route and the posi-
tion of the Hot Spot histogram is not updated at measurement time. The replay shows
the correct routes and positions.

Depending on the "Navigation Mode" (the "Preconfigured waypoints" or "Stream input")
the hot spots are either the waypoints defined before the actual measurement and
stored in the waypoints configuration file ("Waypoints") or arbitrary points on the map
defined during the measurement via the mouse or trackball ("Stream input").

Each measurement is initiated via the "Waypoint" button of the Indoor control view.

Figure 6-673: Indoor Hot Spot Measurement mode
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Select next hot spot
A measurement can be started and the next hot spot can be defined only after the end
of the previous measurement, i.e. after the measurement time has elapsed.

Continuous measurement

The measurement in the "Continuous Measurement" mode uses the previously defined
waypoints without time limit. If the "Generate GPS signals each ... ms" checkbox is
checked, the position interpolation is activated during the measurement.

Figure 6-674: Example - Indoor Continuous Measurement mode

This interpolation is available only in "Continuous Measurement" mode. The frequency
and the number of GPS signals define the interpolation granularity.

The following actions are available:
● Waypoint Arrival

Arrive a waypoint and rest there.
● Waypoint Departure

Left a waypoint.
● Waypoint Passing

Pass a waypoint. This action is equal to the "Check Point" action of the former
Indoor Navigation.

If the navigation "Mode" is set to "No Action", then the "Waypoint Passing" button has
to be clicked every time the operator reaches a waypoint. If the action mode "Waypoint
Arrival" or "Waypoint Passing" is selected, the selected action will be performed at
once after a new waypoint was added.
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Stop measurement after last Waypoint
The measurement is not stopped automatically when reaching the last waypoint. To
terminate it, click the "Stop Measurement" button or the corresponding command line
in the "Measurement" menu.

The interpolated positions and measurement results are not visible in the "ROMES-
MAP Route Track View". They can be exported though to an ASCII file or evaluated
and viewed by an appropriate *.rscmd evaluation and post-processing software.
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7  Data processing
The chapter describes the various options for saving and exporting measurement data.

The steps taken for the data acquisition and the data analysis are independent. R&S
ROMES4 uses its own standard formats (RSCMD or CMD) for measurement files but
offers various options for printing results or interchanging the data with other applica-
tions:
● The *.rscmd or *.cmd files can be directly used by an appropriate measurement

file evaluation and post-processing software.
● The contents of a view can be printed to a file or hard copy using the "File" > "Print"

option, Chapter 3.2.15, "Print", on page 131.
● The *.rscmd or *.cmd files can be converted into other file formats and exported.
● A screenshot of the whole screen or a part of it (active window) can be generated.

● Saving data with R&S ROMES4......................................................................... 2098
● Exporting data.....................................................................................................2099
● BTS list formats...................................................................................................2163
● Obtaining screenshots........................................................................................ 2188
● Basic report.........................................................................................................2188
● Evaluation of KML/KMZ data with Google Earth.................................................2191

7.1  Saving data with R&S ROMES4

Data Recording
If a measurement starts via "Start recording" (see Chapter 3.6.2, "Start recording",
on page 214), the recorded data is automatically saved under the selected file name
with the extension *.rscmd. This format and the older format CMD provide the Replay
feature. The RSCMD and the CMD format are supported by several software tools.
Take care when starting a measurement via "Start measurement" without recording,
see Chapter 3.6.1, "Start", on page 213. In this case, the system asks you to enter a
measurement file name. This name applies at the moment that you start recording. If
there is no data to record, the file is not stored as an empty file but is deleted after the
measurement is terminated.
Note: If you select an existing measurement file, it is deleted if no data is recorded,
and overwritten if data is recorded.
In general, if the start measurement precedes the start recording action, the recording
time starts with start the recording action. The data measured before is lost. However,
whether the data is lost depends on the used device. If using the GSM Network Scan-
ner, the data measured before start recording are written to the file.

Export
The "Export" function generates required data formats of a measurement file for the
further evaluation with the applications which cannot read the original R&S ROMES4
RSCMD format.

Saving data with R&S ROMES4
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Save Workspace
"Save Workspace" and "Save Workspace as" in the "File" menu and the corresponding
floppy disk icon in the tool bar are only used for saving the workspace files (*.rsxks).

7.2  Exporting data

To export a measurement file, perform the following steps:

1. Select the target file format and directory

2. Select the measurement file

3. Export configuration (selection of signal parameters, export options)

4. Generate the export file

The export process is described in the following section. The configuration menus
depend on the selected export file format. They are described in Chapter 7.2.4, "Export
configuration menus", on page 2105.

7.2.1  Exporting data out of views in *.csv format

R&S ROMES4 supports the export of the table contents of the following views as CSV
data:
● Alphanumeric View
● DQA Message View
● All Top N Views

To export a view's table content in CSV format, select "Export data as CSV" in the con-
text menu of the view.

Figure 7-1: View selection for CSV export

If the table is empty or the view does not support exporting as CSV data, the entry is
dimmed.

Only the columns you selected in the configuration is exported. In the first line of the
generated file, the column names are listed, all following lines contain the data.

Exporting data
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7.2.2  Export procedure

Measurement data files can be exported via "File" > "Export Measurement File(s)".

Figure 7-2: Export measurement file

The "Export Measurement File(s)" command opens the "Export measurement data"
page. The page converts an arbitrary measurement file into a file of selected export
format out of offered ones and stores it in a selected target directory.

Export Format
The "Export Format" pull-down list offers the file formats of the target files. Which for-
mats are available depends on your system options. Some of the most used export file
formats are here listed.
● ASCII (*.asc)

ASCII tables, for example, for import into an MS Excel chart, see Chapter 7.2.4.1,
"User-defined ASCII format (*.asc)", on page 2105.
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Figure 7-3: Export ASCII measurement file

● KML/KMZ Export (*.kml, *.kmz)
Export measured signal data to Google Earth's Keyhole Markup Language format,
either as compressed (*.kmz) or normal, uncompressed files (*.kml). The expor-
ted data can then be easily visualized and analyzed according to the position it was
measured at, using the Google Earth software package, see Chapter 7.2.4.2,
"Google Earth Keyhole Markup language (*.kml/ *.kmz)", on page 2120.

● Map Info (*.mif)
MapInfo Interchange format for evaluation in MapInfo, see Chapter 7.2.4.3,
"Mapinfo interchange format (*.mif)", on page 2126.

● NetMon (*.cap)
Interchange format for evaluation of IP tracing with the Microsoft Network Monitor.
The IP Tracer results can be exported to a Netmon CAP file, see Chapter 7.2.4.5,
"Netmon format (*.cap)", on page 2130.

● WinPcap (*.pcap)
A PCAP file can be loaded in a libcap based program of your choice and pro-
cessed further. For more details, see Chapter 7.2.4.4, "PCap format (*.pcap)",
on page 2130.
Note: WinPCap Export is used only for exporting the measurement files generated
by the versions R&S ROMES 4.63 and previous. It does not work with measure-
ment files done with R&S ROMES 4.64 and later. For these releases, Netmon
export must be used.

● Scanner Data Transmitter (Transmitter Lists, CIR) (*.atd, *.xml, *.txt)
Used for batch export of transmitter data and CIR data. Export of the raw data of
the GSM, UMTS and LTE scanner is supported, see Chapter 7.2.5, "Export scan-
ner data", on page 2132.

Target Folder
"Target Folder" shows the current target directory for the export file. Select wanted
folder via the "..." browse button.
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"Browse for Folder" is composed of:
● Directory tree

Overview of all available directories. A selected directory is highlighted.
● "OK"

Closes the "Change directory" dialog by using the selected directory as the export
target directory.

● "Cancel"
Closes the "Change directory" dialog by discarding any changes.

Configuration
The "Configuration" field lets you select between the following export scenarios.
● Silent export
● Interactive export
The interactive export runs when the "Silent Mode" is inactive. For more details, see
Chapter 7.2.5.2, "Interactive export", on page 2134 and Chapter 7.2.5.1, "Silent
export", on page 2133.

Silent Mode ← Configuration
The export silent mode prevents displaying the messages and the configuration ques-
tions during the export. If enabled, specify a configuration file to assure a proper export
configuration.
Some modules do not require special configuration (for example, PCAP export). It is
not necessary to specify a configuration file in such case.
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Configuration File ← Configuration
If the specified configuration file is not compatible with the selected export type, a small
white cross on red sub font is displayed.

Figure 7-4: Error message: Specified configuration file is not compatible

Use configuration for all files ← Configuration
If activated, the configuration dialog is only shown for the first file to be exported and
the configuration is then reused for the subsequent files export. If silent mode is
selected, this approach is implicitly set.

OK
Exports a measurement file with the selected format and target directory.
"OK" opens the standard "Open" file dialog (see chapter Chapter 3.2.2, "Open work-
space", on page 105 ) where the measurement file for exporting can be selected, fol-
lowed by the "Export Configuration" menu for the file format selection.
The configuration menus depend on the export format. They are described in the fol-
lowing sections Chapter 7.2.4, "Export configuration menus", on page 2105.
Several measurement files can be selected simultaneously (use the SHIFT or the
CTRL key) and exported to several target files. If a measurement file is already opened
(for example, because an "Open Measurement File" command was executed before
starting the file export), the opened file is selected by default. Otherwise, an arbitrary
measurement file can be selected in "File" > "Open".
Names of the export files are assigned automatically. The extension of an exported
*.rscmd file is replaced by the selected export format. It is possible to modify the
default export file name using a "File Pre/Suffix". The "Export Info" window logs the file
creation process.
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Figure 7-5: Export Info

Cancel
Cancels the file export and closes all corresponding dialogs.

7.2.3  Export info

After successful termination of the file export, or after its interruption, click "Cancel" to
select one of the actions in "Export finish".

Figure 7-6: Available actions after export finish

Close
Terminates the file export without saving the logging information to a file or opening the
result.

Save Log File
Saves the logging information shown in the "Export Info" window as a *.txt file and
terminates the file export. The file name is given in the "File" dialog.
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Open Export Result
Opens the generated export file using the standard application for the export file type.
If no standard application is defined for the export file type, uses MS Windows Explorer
to assign an appropriate application (for example, Notepad or MS Excel).
To assign an application, open the context menu for the file and select "Properties" >
"General" > "Opens with" > "Change". Select the wanted application and click "OK".

7.2.4  Export configuration menus

Every export format is assigned its own "Export Configuration" menu which opens
automatically during the file export.

The "Export Configuration" menus for ASCII, MIF and KML/KMZ file formats are made
similar. Export of a file in some of these formats can be done in two ways. Different
tabs of the "Export Configuration" menu are provided to support different export
approaches.

In contrast to other configuration menus (for example, to views), the "Export Configura-
tion" menus cannot be accessed unless a file is being exported. Switchover between
the menus for different export formats is not possible. However, all selections and set-
tings made in a particular "Export Configuration" menu are saved and can be re-used.

● User-defined ASCII format (*.asc).......................................................................2105
● Google Earth Keyhole Markup language (*.kml/ *.kmz)......................................2120
● Mapinfo interchange format (*.mif)......................................................................2126
● PCap format (*.pcap).......................................................................................... 2130
● Netmon format (*.cap).........................................................................................2130

7.2.4.1  User-defined ASCII format (*.asc)

With the ASC format, a user-defined ASCII measurement data table can be created. It
is useful, for example, to import the data into an MS Excel chart. The file starts with a
header, containing all useful information about the tour, see the example file at the end
of this section.

The "ASCII Export" configuration dialog contains the following tabs:
● "Values"
● "Settings"
● "Export Configuration Management"
● "Advanced"

Values tab

The "Values" page shows a list of all available signals that can be displayed, if
selected, in the exported measurement file (*.rscmd or *.cmd).
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Figure 7-7: ASCII Export Configuration - Values tab

Available signals
The "Available Signals" pane displays the list of all signals of a generic (basic) view
available to be selected for display in the view. A signal you select is then displayed in
the "Selected Signals [Maximum Allowed <variable>]" pane.
● To select a signal for display in a view, left-mouse button click the signal (which

becomes highlighted) and click ">". Alternatively, double-click the signal.
The selected signal is then displayed in the "Selected Signals [Maximum Allowed
110]" pane. Some views, for example the "2D Chart View" or some mobile views,
pop up the "Please Specify the Filter for the Signal" window request you to select
filtering criteria.

● To remove a single signal from the "Selected Signals [Maximum Allowed <vari-
able>]" pane, click "<".

● To remove all signals at once, click "<<".

Selected Signals
The list of all the signals selected for display.
The order of the signals can be changed using the "Up" and "Down" buttons. Each
selected signal forms a column in the ASCII file. The order of columns is equal to the
order of signals in the "Selected Signals" list.
● "Up"

Interchange the position of the selected signal with the signal located directly
above. The first signal in the list cannot be moved upwards.

● "Down"
Interchange the position of the selected signal with the signal located directly
below. The last signal in the list cannot be moved downwards.

● "Tree Filter", see Chapter 4.2, "Basic views", on page 445.
The other possibility to select multiple signals for ASCII export is via the filter dialog
box, see for example "5G NR scanner Top N settings" on page 291.
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Figure 7-8: ASCII Export of multiple Top N signals

The case in the figure shows that 32 members of the three Top N pools are selected
for export.
Note: LTE scanner module can export the scanner's raw data.
The "ASCII Export" supports the following LTE scanner raw data export:
● Power Raw
● SINR Raw
● SINR PSS Raw
● SINR SSS Raw

Settings tab

In the "Settings" page data selection can be refined by imposing additional selection
criteria to the exported signal values. Imposing the additional selection criteria is suita-
ble (or even inevitable) to handle large amount of data.

Figure 7-9: ASCII Export Configuration - Settings tab
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Trigger conditions
The "Trigger conditions" pane defines a parameter interval in which exactly one value
per output signal is written to the target export file.
● "Export All Data"

No reduction of the original data - the unchanged values are exported.
● "Time triggered"

A time interval between 0.001 s and 60 s is specified.
● "Square triggered"

A square surface with a side length between 1 m and 10000 m is specified.
The square triggered period is not distance-related but depends on the actual posi-
tion in a field of squares. A value is generated whenever a square is left. As a con-
sequence, the last square does not contribute to the export file.
The amount of data collected for export value generation and the time between two
trigger events can differ extremely from one square to another. In the B square of
the figure below, much time is spent and many data can be collected. In C, D and
E the spent time and the amount of collected data is different. The number of data
points measured in a square does not have any influence on the length of the
export file.

Figure 7-10: Square Trigger condition

If large squares are defined, do not use the time stamp in combination with the
average GPS position to determine the vehicle speed. Otherwise, a high error rate
is generated.

● Point to point""
A driven distance between 10 m and 1000 m is specified.

Value generation
The "Value generation" pane defines how the value exported in a trigger period is cal-
culated. The value generation works both for "triggered" and "all data" exports.
● "Reset after trigger / Signal Received"
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If checked, the buffer is cleared after each trigger period or all data export, depend-
ent on settings in "Trigger conditions".
If unchecked, the export values (the last value, minimum, maximum, or average,
whichever is selected) in each trigger period are stored in the buffer. If only invalid
values are detected in one trigger period, the buffer value (the value of the previous
trigger period) is exported. See the example at the end of this section.

● "Last value"
If only invalid values are detected in one trigger period, the last valid value is
exported.

● "Min hold"
The minimum value within one trigger period is exported.

● "Max hold"
The maximum value within one trigger period is exported.

● "Average"
The average value within one trigger period is exported.

● "Median"
The median value within one trigger period is exported. If the count of numbers is
even (e.g. 10, 2, 5, 13), the two middle numbers (here, 5 and 10) are taken after
sorting. The arithmetic average value is used (here, 7.5).

● "Merge data with same timestamp"
This option of the ASCII Export allows the user to define handling of data with the
same timestamp. The data is merged to one line or put in separate lines and prin-
ted.
If you choose to merge data, the last entry is taken if the different values of the
same timestamp for the same R&S ROMES4 signal are available.

Example: Exporting with and without reset after trigger
The export example consists of the following:
● Export of a measurement including UMTS PN and LTE scanning
● Export all data
● Interpolate GPS positions

The Rank Indicators and RSCP / RSRP of the three first ranks of each pool are
selected.
[DESCRIPTION]
Timestamp [hh:mm:ss]
GPS\Position\Longitude [°] : [1]
GPS\Position\Latitude [°] : [1]
UMTS PNS\TOP N Pool 5\1. TOP N Pool 5 Rank[5] : [1]
UMTS PNS\TOP N Pool 5\1. TOP N Pool 5 RSCP[5] [dBm] : [1]
UMTS PNS\TOP N Pool 5\2. TOP N Pool 5 Rank[5] : [1]
UMTS PNS\TOP N Pool 5\2. TOP N Pool 5 RSCP[5] [dBm] : [1]
UMTS PNS\TOP N Pool 5\3. TOP N Pool 5 Rank[5] : [1]
UMTS PNS\TOP N Pool 5\3. TOP N Pool 5 RSCP[5] [dBm] : [1]
LTE Scan\TOP N Pool 1\1. TOP N Pool 1 TopX[1] : [1]
LTE Scan\TOP N Pool 1\1. TOP N Pool 1 RSRP[1] [dBm] : [1]
LTE Scan\TOP N Pool 1\2. TOP N Pool 1 TopX[1] : [1]
LTE Scan\TOP N Pool 1\2. TOP N Pool 1 RSRP[1] [dBm] : [1]
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LTE Scan\TOP N Pool 1\3. TOP N Pool 1 TopX[1] : [1]
LTE Scan\TOP N Pool 1\3. TOP N Pool 1 RSRP[1] [dBm] : [1]

Note: LTE and UMTS data come asynchronously as they use different device. There-
fore, when a UMTS data set is written into the export, no LTE data is present and vice
versa. This asynchronous data arrival explains the question marks which represent the
'invalid' sign.
Export with "Reset after trigger"
[DATA]
10:50:14;7.815306;49.863769;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?    LTE data only
10:50:14;7.815306;49.863770;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?  UMTS data only
10:50:14;7.815308;49.863774;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815309;49.863780;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815311;49.863786;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:14;7.815311;49.863786;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:14;7.815311;49.863786;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815312;49.863792;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815314;49.863797;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815314;49.863799;?;?;?;?;?;?;?;?;?;?;?;?
10:50:14;7.815315;49.863802;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815316;49.863807;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815318;49.863813;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:14;7.815318;49.863813;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:14;7.815318;49.863813;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:14;7.815320;49.863819;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:15;7.815321;49.863824;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:15;7.815321;49.863824;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:15;7.815322;49.863829;?;?;?;?;?;?;1;-85.06;2;-86.02;?;?
10:50:15;7.815324;49.863834;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815325;49.863840;1;-69.3;2;-77.6;3;-79.0;?;?;?;?;?;?
10:50:15;7.815325;49.863840;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:15;7.815325;49.863840;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815327;49.863845;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815328;49.863850;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815329;49.863852;?;?;?;?;?;?;?;?;?;?;?;?
10:50:15;7.815330;49.863858;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815331;49.863863;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:15;7.815332;49.863868;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:15;7.815332;49.863868;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:15;7.815332;49.863868;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:16;7.815333;49.863873;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:16;7.815334;49.863876;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:16;7.815334;49.863878;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:16;7.815335;49.863883;?;?;?;?;?;?;1;-90.94;2;-88.92;?;?
10:50:16;7.815336;49.863888;?;?;?;?;?;?;1;-88.92;2;-90.94;?;?
10:50:16;7.815337;49.863893;?;?;?;?;?;?;1;-88.92;2;-90.94;?;?
10:50:16;7.815339;49.863898;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:16;7.815339;49.863898;1;-69.3;2;-89.5;3;-81.4;?;?;?;?;?;?
10:50:16;7.815339;49.863901;?;?;?;?;?;?;1;-88.92;2;-90.94;?;?
10:50:16;7.815340;49.863906;?;?;?;?;?;?;1;-88.94;2;-88.10;?;?
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10:50:16;7.815341;49.863911;?;?;?;?;?;?;1;-88.94;2;-88.10;?;?
10:50:16;7.815341;49.863912;?;?;?;?;?;?;?;?;?;?;?;?
10:50:16;7.815342;49.863916;?;?;?;?;?;?;1;-88.94;2;-88.10;?;?
10:50:16;7.815342;49.863921;?;?;?;?;?;?;1;-88.94;2;-88.10;?;?

Export without "Reset after trigger"
[DATA]
10:50:14;7.815306;49.863769;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815306;49.863770;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815308;49.863774;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815309;49.863780;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815311;49.863786;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815311;49.863786;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815311;49.863786;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815312;49.863792;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815314;49.863797;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815314;49.863799;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815315;49.863802;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815316;49.863807;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815318;49.863813;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815318;49.863813;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815318;49.863813;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:14;7.815320;49.863819;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:15;7.815321;49.863824;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:15;7.815321;49.863824;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:15;7.815322;49.863829;1;-69.3;2;-77.6;3;-79.0;1;-85.06;2;-86.02;3;-115.16
10:50:15;7.815324;49.863834;1;-69.3;2;-77.6;3;-79.0;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815325;49.863840;1;-69.3;2;-77.6;3;-79.0;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815325;49.863840;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815325;49.863840;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815327;49.863845;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815328;49.863850;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815329;49.863852;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815330;49.863858;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815331;49.863863;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815332;49.863868;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815332;49.863868;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:15;7.815332;49.863868;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:16;7.815333;49.863873;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:16;7.815334;49.863876;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:16;7.815334;49.863878;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:16;7.815335;49.863883;1;-69.3;2;-89.5;3;-81.4;1;-90.94;2;-88.92;3;-115.16
10:50:16;7.815336;49.863888;1;-69.3;2;-89.5;3;-81.4;1;-88.92;2;-90.94;3;-115.16
10:50:16;7.815337;49.863893;1;-69.3;2;-89.5;3;-81.4;1;-88.92;2;-90.94;3;-115.16
10:50:16;7.815339;49.863898;1;-69.3;2;-89.5;3;-81.4;1;-88.92;2;-90.94;3;-115.16
10:50:16;7.815339;49.863898;1;-69.3;2;-89.5;3;-81.4;1;-88.92;2;-90.94;3;-115.16
10:50:16;7.815339;49.863901;1;-69.3;2;-89.5;3;-81.4;1;-88.92;2;-90.94;3;-115.16
10:50:16;7.815340;49.863906;1;-69.3;2;-89.5;3;-81.4;1;-88.94;2;-88.10;3;-115.16
10:50:16;7.815341;49.863911;1;-69.3;2;-89.5;3;-81.4;1;-88.94;2;-88.10;3;-115.16
10:50:16;7.815341;49.863912;1;-69.3;2;-89.5;3;-81.4;1;-88.94;2;-88.10;3;-115.16
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10:50:16;7.815342;49.863916;1;-69.3;2;-89.5;3;-81.4;1;-88.94;2;-88.10;3;-115.16
10:50:16;7.815342;49.863921;1;-69.3;2;-89.5;3;-81.4;1;-88.94;2;-88.10;3;-115.16

Use of "Reset after trigger" is recommended. Otherwise, the values are continuously
reported although you already left the covered area.

Line output format ← Value generation
Export the data with the absolute time and date or with the relative timestamp using
"ASCII Export" > "Settings". In the last case, the timestamp is the relative time since
the start of measurement.
The "Line output format" pane defines the format of an ASCII table line.
● "Print File Header"

If checked, the file header information is included in the target file. The file header
comprises the information retrieved with the command, see Chapter 3.2.10, "Mea-
surement file info", on page 115.

● "Single Line Description"
If checked, the description of all parameters is written into a single line. The entries
are separated by the "Delimiter" that is used for the data. This option is suitable for
an import of the target file into MS Excel where each parameter description forms a
table heading.
If unchecked, each parameter description is written into a separate line.

● "Print date"
If checked, the date is added to the beginning of every data line.

● "Print 1/1000s"
The 1/1000 s data is added to every data line start.

● "Use Real World Time"
Deactivating this check box switches to the relative timestamp output. As a conse-
quence, the "Print date" check box is unselected and grey, the "Print 1/1000s"
checkbox is selected and grey. The exported file shows the time according to the
settings. The unit of the relative timestamp is in ms, see the following figure.

Figure 7-11: Relative timestamp

● "Export Events"
Events included in the measurement file is included in the export file.

● "Use tabs as delimiter"
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Two signals in the export file are separated by tabs. The "Delimiter" field is dis-
abled.

● "Delimiter"
This character separates the values of two signals in the export file. The "Delimiter"
field is disabled if the "Use tabs as delimiter" option is active.

● "Invalid sign"
The invalid sign shows that no valid value was detected.

● "Quote Char."
The default character “ is placed at the beginning and end of the field that contains
CR/LF characters (for example, L3 messages) for any ASCII export while exporting
the file. This character makes it easier to parse the ASCII export files.
Emptying the "Quote Char." field prevents ASCII export from placing a quote char-
acter in a field that contains the CR/LF characters. In an instance where the quote
chart is changed to ‘ and the field otherwise contains ‘ character, those instances
are changed to “.

● "Decimal Separator"
This character has to be different from the "Delimiter" to avoid conflicts when post-
processing the exported data.

● "Configure Events"
Opens the "Preferences" >"Available Events" page, see Chapter 3.8.1.3, "Available
events configuration", on page 238.

File Pre/Suffix/Extension
Defines two text strings which can be used to modify the file names and distinguish
several exported files.
The prefix is inserted at the beginning of the file name, the suffix at the end:
<file name>.asc ⇨ <prefix><file name><suffix>.asc
The third option is to configure an extension for the result file of the ASCII export.
This option allows the user to choose the extension which is the most convenient for
the user’s tool chain.
For example, if the next step is an analysis in Excel, choose csv as the extension.
Excel opens the CSV file automatically by double clicking.

Positioning
● "Interpolate GPS Position"

If checked, R&S ROMES4 calculates the position of each measurement record by
linear interpolation of the closest position data provided by the GPS receiver. Oth-
erwise, a position remains valid until a new GPS result is available.
GPS position data is updated about once per second. Interpolating the positions is
suitable if the measurement rate of other test devices is much larger than 1/s (for
example, the CW receivers), or at high speed of a test vehicle.
The interpolation is done with all the GPS-related parameters: latitude, longitude,
altitude, distance, speed and heading.

● "Separate Indoor Measurements per Floor"
If checked, indoor measurements are exported (ASCII Export only) by floors. That
means, the feature separates the measurement data according to the floor maps,
and therefore generates several export files.
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Note: As floors are identified by different floor maps, it is necessary to configure these
floor maps and set waypoints at measurement time to signal the floor change. If no
floor maps are configured, all waypoints are on the basic map and result therefore in a
single export file.
Export of several indoor floor files is the same as ordinary export, only the files' name
changes into <filename>.<floorname>.asc. In addition, the file header shows the
floor name.

Figure 7-12: Exported indoor floor file

Measurements that hold no indoor measurement are treated as before, one export file
is generated.
Switching from floor A to floor B and back to floor A results in 2 files, one for floor A
and floor B.
Data older than the first floor name is dedicated to the first floor. Data which is between
two floors is dedicated to the previous floor until the new waypoint on the next floor
map is set.
The original export file is deleted if it concerns indoor measurements and the export
files per floor have been generated.

Export configuration tab

Once the configuration dialog is shown for an export, it is possible to load and save the
current configuration to or from a file. Export modules supporting that feature have this
"Export Configuration" tab in their configuration setup dialog.

The dialog contains a list of files found in the default directory for export configuration
(i.e. the workspace directory). Selecting an entry in the list defines the default value for
the "Load" and "Save" dialogs shown when pressing the related buttons.
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Figure 7-13: ASCII Export Configuration - Export Configuration tab

Blocks tab

The "Blocks" page shows the list of all blocks and bookmarks within a measurement
file. Select block for export from the list. Measurement files recorded with R&S
ROMES4 V3.22 and higher can be divided into several blocks, see Chapter 3.7.9,
"Replay jump to block", on page 222. The "Blocks" page is analogue for all export for-
mats.

Figure 7-14: ASCII Export Configuration - Blocks tab

Info tab

The "Info" page shows information on the current ASCII export software module. The
"Info" page is analogue for all export formats and is omitted in the following.
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Figure 7-15: ASCII Export Configuration - Info tab

Add Top N pool settings to ASCII export header

The ASCII export header shows the Top N configurations for each R&S ROMES4 sup-
ported scanner technology, which has that type of configuration.

In the following figure this header information is highlighted.
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Figure 7-16: Example of a GSM NWS with R&S TSME and its Top N configuration

ASCII export file examples

(OT290, 1 GSM/GPRS Mobile)

Exporting data



Data processingDrive Test Software

2118Operating Manual 1171.6415.12 ─ 66

[Measurement Info, Ver. 4.00 Rev. 1 SP 4]
Time Zone:        Westeuropäische Normalzeit
Start Of Measurement:    Monday, 11.02.2008, 20:14:36.99

Comment:        Test with AMR

Username:    John Doe
Vehicle Name:    Test Car
Vehicle ID:    M-RS 123
Num of Blocks:    1
Duration:    00:02:52 (HH:MM:SS)

================================================================

Drivers:
- Test Tool OT290[1]
- NMEA Device[1]

================================================================

[Test Tool OT290 [1], Ver 4.00]
Type:                Sagem GPRS (Firmware JY3,Bj 315)
ROMES Locking Info:
GSM Band Lock:        Off
GSM Channel Lock:        No
GSM Net:            GSM900/DCS1800
Meas. Mode:            Normal
IMEI:                08202501
Subscriber Number:
Auto Dial Timing:
 Supported RAT:        Any RAT
 Call Window:        60 sec
 Call Duration:        30 sec
 Max. Access Time:    15 sec
Call Window Offset:    0 sec
Type of Call:        Voice Call
NQA Rx Source:        Full
Number:            2000
RxLev Calibration:    No
Antenna name:         Default_Antenna
Cable loss [dB]:      0.00
Antenna gain [dBi]:     0.00
Cellbar Flag:         Normal
CBCH:             not decoded
GPRS Mobile:        Yes
Forcing Settings:
 Multi Slot Class:    No Forcing
 Coding Scheme:        No Forcing
 GPRS Auto Attach:    No Forcing
 MS Class:            No Forcing
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 GSM Power Class:        No Forcing
 DCS Power Class:        No Forcing
 EFR:                Off
GSM/GPRS QoS Actions Evaluation
 1. GSM Handover:
  Timeout: 10000 ms
 2. Location Area Update:
  Timeout: 10000 ms
 3. GPRS Attach:
  Timeout: 10000 ms
 4. GPRS Detach:
  Timeout: 10000 ms
 5. Activate PDP Context:
  Timeout: 10000 ms
 6. Deactivate PDP Context :
  Timeout: 10000 ms
 7. Routing Area Update:
  Timeout: 10000 ms

Handover Analyzer
 Enabled:            No

Port Settings
1. Port:
    Type: Trace
    Name: COM1

================================================================

[GPS Ver 4.00]

Type:        NMEA Device
Ellipsoid:        WGS84
Nav.Proc.Version:    not available
Sig.Proc.Version:    not available
Driven area:    48.128276 (Lat. up left)
        11.613015 (Long. up left)
        48.126521 (Lat. bottom right)
        11.614277 (Long. bottom right)

================================================================

[EXPORT OPTIONS]
Exported by version:    4,0,5,163
Trigger type:        All Data is Exported
Delimiter:            ;
Invalid Sign:        ?
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Created during multiple file export:    no
Parameter selection:    individual

[DESCRIPTION]
Timestamp [hh:mm:ss]
GPS\Position\Longitude [°] : [1]
GPS\Position\Latitude [°] : [1]
GSM\Server Report\MCC : [1]
GSM\Server Report\MNC : [1]
GSM\Server Report\LAC : [1]
GSM\Measurement Report\BCCH [ChanNr] : [1]
GSM\Server Report\CI : [1]
GSM\Measurement Report\BSIC : [1]
GSM\Measurement Report\RxLev Full [dBm] : [1]
GSM\Measurement Report\RxQual Full : [1]

[DATA]
20:16:01;11.613307;48.126941;262;1;34567;23;5717;32;-79;0
20:16:02;11.613119;48.126671;262;1;34567;23;5717;32;-79;0
20:16:03;11.613077;48.126606;262;1;34567;23;5717;32;-82;0
20:16:03;11.613058;48.126580;262;1;34567;23;5717;32;-82;0

7.2.4.2  Google Earth Keyhole Markup language (*.kml/ *.kmz)

The main use of these exported data is to display the measured signal levels on a geo-
graphical map. The KML and KMZ file format is a particular Google Earth XML file for-
mat that stores geographic annotation and visualization on existing compatible two-
dimensional maps and three-dimensional Earth browsers. The file format specifies a
set of features for display in Google Earth, Maps and Mobile, or any other 3D Earth
browser (geo-browser) implementing the Keyhole Markup Language (KML) encoding.

Force the export of all GPS data
To force the export of the GPS data, export from the "KML Export > Available Signals"
a signal associated with the R&S GPS device, such as longitude, latitude, altitude,
speed, or heading, in addition to all other signals you wish to export.

The R&S ROMES4 "KML Export" automatically filters unwanted data:
● All signal data that is not positioned between two GPS measurements is deleted,

since its position cannot be interpolated.
● GPS positions that are found to be unlikely are automatically deleted during export.

Deleted are:
– GPS data which usually occurs during calibration right after turning the GPS

device on
– GPS data not assigned to measured signals and irrelevant; that is, all the GPS

positions measured before the first or after the last signal measurement to be
exported are deleted
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KML export of the ACD-based UMTS/LTE Top N pools

The KML export supports the ACD feature. The export function sorts out different
UMTS and LTE Top N pools created by the "Automatic pool configuration per channel
selection" feature into different sections in the KML file format. After opening the mea-
surement file, users have to select the measurement data they want to be exported, for
example, the RSRP values of the LTE Top N pool.

The file can contain the UMTS/LTE transmitter list which was created by the Position
Estimator during the measurement, see Figure 7-18.

Figure 7-17: KML Export page

Press the CTRL key + the ">" button to select a Top N pool parameter. The parameter
is added to all available Top N pools automatically.

KML export files configuration

The R&S ROMES4 "KML Export" configuration page contains the following tabs.
● "Values"
● "Settings"
● "Export Configuration Management"
● "Advanced"

This tab lets users open additional configuration pages:
– "Blocks"
– "Information"

● "Info"

The listed tabs, excluding the "Settings" tab, open the configuration pages analogue to
these tabs described in "ASCII Export", see Chapter 7.2.4.1, "User-defined ASCII for-
mat (*.asc)", on page 2105.

Values tab

Click the tab to open the page showing a list of all signals contained in the selected
measurement file (*.rscmd or *.cmd).
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Available signals
The "Available Signals" pane displays the list of all signals of a generic (basic) view
available to be selected for display in the view. A signal you select is then displayed in
the "Selected Signals [Maximum Allowed <variable>]" pane.
● To select a signal for display in a view, left-mouse button click the signal (which

becomes highlighted) and click ">". Alternatively, double-click the signal.
The selected signal is then displayed in the "Selected Signals [Maximum Allowed
110]" pane. Some views, for example the "2D Chart View" or some mobile views,
pop up the "Please Specify the Filter for the Signal" window request you to select
filtering criteria.

● To remove a single signal from the "Selected Signals [Maximum Allowed <vari-
able>]" pane, click "<".

● To remove all signals at once, click "<<".

Selected Signals
List of all signals selected for display.
Note: At least one GPS device must be selected from the "Navigation Devices" to
make KML export possible.
Note: Only signals with numerical values can be exported. Non-numerical signals
appear as empty folders in Google Earth.
The order in the list can be changed using the two buttons placed at the bottom of this
pane.

Settings tab

In "Settings" you can select the way height is displayed, the data export mode and
which type of measured data are exported to the *.kml or *.kmz file.

Figure 7-18: KML/KMZ Export - Settings page

Tip: Export large files in KMZ file format.
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*.kml files can be large if many data has to be exported. Export measurement data in
KMZ format in that case. The *.kml file can still be accessed and edited by decom-
pressing the *.kmz file using a ZIP file manager.

KML Settings
● "Use GPS Altitude"

KML export allows the GPS altitude to use as a height. The option can be used for
3D measurements, for example, with drones. Instead of using the value of the sig-
nal, the GPS altitude is used for the z-coordinate. The signal value is reflected by
the color of the measurement bubble.

● "Maximum placemark height (m)"
The maximum height that a placemark can have in Google Earth. Exported signals
are extruded according to their values in the range from zero this maximum height
to make the exported signals easily visible.

Export Mode
Note: For high data rates (about 20 samples/second and more), it is recommended to
select GPS-based export.
The ways of exporting the captured information are:
● "Data based Export"

Creates a placemark for each available signal measurement and interpolates its
GPS position using the GPS data.

Figure 7-19: Placemark for every measured single signal

● "GPS based Export"
Creates a placemark for every GPS measurement available and chooses its value
depending on the option selected in "Data Selection", see the following section.

Data Selection
Defines how to calculate a signal value, so that the value is associated an exact GPS
position. The panel is active only if the "GPS based Export" condition is selected.
● "Closest Value"

Selects the valid measured value that lies closest to the measured GPS data,
according to its timestamp.
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Figure 7-20: Closest Value

● "Interval Minimum"
Shows the minimum signal value between a GPS measurement and the next one.

Figure 7-21: Interval Minimum

● "Interval Maximum"
Shows the maximum signal value between a GPS measurement and the next one.

Figure 7-22: Interval Maximum

● "Interval Average"
Shows the average of all valid signal measurements between a GPS measurement
and the next one.
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Figure 7-23: Interval Average

Include Transmitters
Select the "Include Transmitters, estimated by the Position Estimator" option if you
wish to add the transmitters' positions.
Note: No transmitters from transmitter databases are exported.
Select GPS-based export to reduce the measurement data to one value per available
GPS datum.
The exported KML has one folder per Top N. This export makes it easy to switch
between the different Top N pools (respectively channels).

Figure 7-24: Export tree
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Importing *.kml/*.kmz files to Google Earth

After finishing the export, you can view the newly created *.kmz / *.kml file using the
Google Earth application, which you can download for free. Visualization of a *.kmz is
shown in the following figure.

Figure 7-25: BTS error ellipses

1. Go to the export directory (mostly My Documents\My ROMES\ExportResult)

2. Double click the directory.

3. Open the file from Google Earth or a file manager.

For more information, refer to Chapter 7.6, "Evaluation of KML/KMZ data with Google
Earth", on page 2191.

7.2.4.3  Mapinfo interchange format (*.mif)

MIF format is a particular ASCII file format that stores graphical information to be dis-
played in a MapInfo table.

The R&S ROMES4 "MIF Export" configuration dialog contains five tabs. The configura-
tion dialogs of the "Values" and "Settings" tabs are described in the following sections.

The "Export Configuration Management", "Advanced" and "Info" tabs are analogous to
tabs of the "ASCII Export" dialog, see Chapter 7.2.4.1, "User-defined ASCII format
(*.asc)", on page 2105.

The export of measurement file to MapInfo MIF/MID format respects the "Preferences"
> "Formats" > "Timestamp Format" settings. Timestamp is saved accordingly.
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Values tab

The "Values" tab offers a list of all parameters in the selected measurement file
(*.rscmd or *.cmd).

NOTE: The same list of parameters in the selected measurement file opens when
choosing the tab "Advanced" instead.

Figure 7-26: MIF Export Configuration - Values tab

Available signals
The "Available Signals" pane displays the list of all signals of a generic (basic) view
available to be selected for display in the view. A signal you select is then displayed in
the "Selected Signals [Maximum Allowed <variable>]" pane.
● To select a signal for display in a view, left-mouse button click the signal (which

becomes highlighted) and click ">". Alternatively, double-click the signal.
The selected signal is then displayed in the "Selected Signals [Maximum Allowed
110]" pane. Some views, for example the "2D Chart View" or some mobile views,
pop up the "Please Specify the Filter for the Signal" window request you to select
filtering criteria.

● To remove a single signal from the "Selected Signals [Maximum Allowed <vari-
able>]" pane, click "<".

● To remove all signals at once, click "<<".

Selected signals
List of all signals selected for display.
The order of the list can be changed using the two buttons below.
For each selected signal, a separate *.mif plus a *.mid file is generated.
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The *.mif file contains the file header followed by the geographic coordinates of each
exported data point and the code for the symbols to be used for display in MapInfo;
see description of "Settings" tab below. This file can be imported into MapInfo as
described in "Importing *.mif files to mapinfo" on page 2130.
The *.mid file contains two columns for the exported signal values and a general sig-
nal, e.g. the time stamp associated to each signal value.

Settings tab

The "Settings" tab selects the symbols to display the data in MapInfo and the data to
be exported to the *.mif file.

Figure 7-27: MIF Export Configuration - Settings tab

Map Info Symbol
Selects the symbol to display the data in a MapInfo view and the symbol size. The
symbols can be defined with their code number ("Symbol") and "Size" or selected from
a list that is opened on clicking the "Show Map Info Symbols..." buttons.
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Trigger
Defines which values in the selected signals are exported and how the geographical
coordinates assigned to the exported values are calculated. The following alternative
options are provided:
● "Export All Data"

Export all values of the selected signals to the *.mif file. Use an appropriate inter-
polation method to determine the position of each value from the GPS data availa-
ble in the measurement file.

● "GPS"
Export one signal value for each GPS position stored in the measurement file using
the "Value generation" settings.

Value Generation
Defines how the signal value assigned to a definite GPS position is calculated. The
panel is active only if the "GPS" trigger condition is set. One trigger period corresponds
to the time between two consecutive GPS positions.
● "Reset after trigger"

If the box is checked, the buffer is cleared after each trigger period. If not, the
export values (for example, the last value, minimum, maximum, or average, which-
ever is selected) in each trigger period is stored in the buffer. If only invalid values
are detected in one trigger period, the buffer value (for example, the value of the
previous trigger period) is exported.

● "Last value"
If only invalid values are detected in one trigger period, the last valid value is
exported

● "Min hold"
The minimum value within one trigger period is exported

● "Max hold"
The maximum value within one trigger period is exported

● "Average"
The average value within one trigger period is exported
This option is not applied to parameters where averaging does not make a sense,
for example, channel numbers or station codes.
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Importing *.mif files to mapinfo

The *.mif file can be imported to MapInfo and converted to a MapInfo table file
(*.tab) to be viewed in a MapInfo table. This import involves several steps:

1. Open "MapInfo" and select the "Import" command in the "Table" menu.

2. In the "Import File" dialog select the file format MIF, the *.mif file you want to
import.

3. Press "Open" to start the file import.

4. In the "Import into Table" dialog, select a name and directory for the TAB file you
want to create.

5. Press "Save."

By default, the TAB file is stored in the same directory and uses the same file name as
the MIF file.

1. In the "File" menu, select "Open Table" to display an "Open Table" dialog.

2. Select the created TAB file.

3. To display all data points stored in the *.mif file, use the "View Entire Layer" com-
mand in the "Map" menu.

For more information, refer to the MapInfo help.

7.2.4.4  PCap format (*.pcap)

Raw packet data recorded via IPTracer module and stored in a measurement
(*.rscmd) can be exported into the PCap file format. This file format is used by any
libpcap based program, e.g. Wireshark (Ethereal) or tcpdump.

The "PCap Export" configuration dialog contains two tabs:
● "Blocks"
● "Information"

These tabs are analogous to the ASCII Export tabs, see Chapter 7.2.4.1, "User-defined
ASCII format (*.asc)", on page 2105.

7.2.4.5  Netmon format (*.cap)

The NetMon (*.cap) is a successor of the WinPcap (*.pcap) since R&S ROMES4 4.64.
Exporting the measurement files recorded with R&S ROMES4 4.64 and later releases
is done only with NetMon (*.cap).

The raw packet data recorded via IP Tracer module and stored in a measurement
(*.rscmd) file is exported into the CAP file format.
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Figure 7-28: Export Netmon CAP measurement file

The "Netmon Export" configuration dialog contains two tabs:
● "Blocks"
● "Information"

Figure 7-29: Netmon Export configuration dialog

These tabs are analogue to the ASCII Export tabs, see Chapter 7.2.4.1, "User-defined
ASCII format (*.asc)", on page 2105.
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7.2.5  Export scanner data

To export scanner data, click "File" > "Export Measurement File(s)" and select the
export scenario for scanner data in the "Export measurement data" > "General" >
"Export Format".

Figure 7-30: Export scanner measurement data

The scanner data export function makes batch export of the following data:
● Transmitter tree of BCH views
● Transmitter list of BCH views
● CIR export
● Scanner raw export
● Time gated measurement data

You can choose the silent or interactive export in the "Export measurement data" >
"Configuration" pane. For silent export, check the "Silent Mode" check-box.

Click "OK" to confirm the selection.

The scanner export scenarios are configurable in the "ScannerData Export <version>"
> "Data Selection" page, which opens upon this confirmation of the interactive export
mode.

Exporting data



Data processingDrive Test Software

2133Operating Manual 1171.6415.12 ─ 66

Figure 7-31: Export scanner data configuration

7.2.5.1  Silent export

For silent export, check the "Silent Mode" box and choose the previously saved export
configuration file.

If a file is not defined, the last used export configuration or default export parameters
are used.

Figure 7-32: Silent export mode
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7.2.5.2  Interactive export

The interactive export scenario is executed if the "Silent Mode" box is unchecked
(default). In this case, the "Open" page offers to select one or more (not recommen-
ded) files for export.

Figure 7-33: Selection of files for export

Select one (or more) files and click "Open". The "ScannerData Export <version>" con-
figuration page displays, see Figure 7-31. You can define export parameters for all
kinds of export in this page.

● "Transmitter Time of BCH Views"
If the selected data export scenario is this one, specify RAT or select all available in
the list box "cdma,GSM,LTE,TETRA,UMTS,WiMAX,NB-IoT". Further, specify the
quality of position filter and the error size in the pane.

● "Transmitter Llsts of BCH Views"
If the selected data export scenario is this one, specify RAT or select all available in
the list box "cdma,GSM,LTE,TETRA,UMTS,WiMAX,NB-IoT". Further, select the
format of export, the quality of position filter and the error size in the pane.

● "CIR Exports"
The option lets you select RAT or all in the list box "LTE,UMTS,WiMAX" and the
format of a CIR export file. The format can be CSV or XML. If you need the LTE
CIR raw data to export, check the "Enable LTE CIR Raw Export (XML)" box. For
LTE CIR raw data, see Chapter 7.2.5.7, "LTE scanner CIR raw data export",
on page 2143.
The LTE CIR and CIR peak raw data exports are based on the reference signal
measurements, see Chapter 4.8.6.8, "LTE scanner reference signal CIR view",
on page 1241. These data exports are only available to XML format.
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The CIR and CIR peaks export files have added position data for every <ListCon-
tent> entry, see examples in the Example.

● "Scanner Raw Export"
The option lets you select the raw data export of LTE, UMTS, GSM or NB-IoT or of
all these RATs scanners.
The Top N sorting is not applied to the exported data. Top N is exported as scan-
ners measured the data. The output format is fixed and cannot be modified. It con-
tains time-stamp, geographic information and the scanner data. One file is gener-
ated per RAT.

● "Time Gated Spectrum Export"
The option lets you export scanner data of Time Gated measurements. The
option's configuration allows you to disable this export or to enable it by selecting a
threshold for the data. The output file has CSV format with the following columns:
Date; Time; UTC; Latitude; Longitude; Altitude; Speed; Heading; #Satellites; Fre-
quency[Hz]; Power[dBm].
Note: The power column can contain a valid power value in dBm, a ‘-‘ for not mea-
sured, an ‘u’ for underflow or an ‘o’ for overflow.

While running the export, the CSV files are created.

At the standard export folder, a folder for each measurement file is created containing
*.csv files per selected RATs. A file's name is created as:
<MeasurementFileName>_<RAT>_TecRaw_
<Time and Date of Export>.csv. The file can be opened with MS Excel directly.

Figure 7-34: Exporting LTE CIR and peak

Consider that some export parameters are not compatible. Incompatible parameters
cannot be selected.
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Example: 
For the KML export format of different RATs available in "Transmitter List of BCH
views", the "Position Quality Filter" > "No Position"/"Position from Database" option is
incompatible. Therefore, with "No Position" selected, it is not possible to select the
KML format and vice versa.

Figure 7-35: Incompatible parameters

Export of NB-IoT scanner data

NB-IoT technology is a part of the R&S ROMES4 scanner data export.

NB-IoT measurements can be chosen from the following sections of the export config-
uration page:

● "Transmitter Tree of BCH views"
● "Transmitter List of BCH views"
● "Scanner Raw Export"

NB-IoT is selected by default for the mentioned referenced sections.

The raw scanner data is exported in CSV format. By default, the export file
{NameOfMesurementFile}_NB-IoT_TecRaw_{DateTimeOfExport}.csv is
located at the User\Documents\My Romes\ExportResult\{NameOfMeasurmentFile}\
directory.

The exported data is given in the following order:

Date;Time;UTC;Latitude;Longitude;Altitude;Speed;Heading;#Sat;EARFCN;Fre-
quency;NPCI;MCC;MNC;TAC;CI;eNodeB-ID;cellID;RSSI-Tx0;RSSI-Tx1;NSINR-
Tx0;NSINR-Tx1;NRSRP-Tx0;NRSRP-Tx1;NRSRQ-Tx0;NRSRQ-Tx1;NSSS-
Power;NSSS-RSSI;NSSS-CINR;

Export of C-V2X scanner data

C-V2X technology is a part of the R&S ROMES4 scanner data export.

The scanner measurement data is exported as a CSV file. The default export file name
is V2X_Message_CSV_Export.csv.
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Figure 7-36: C-V2X scanner measurement export

Export of 5G NR scanner data

"ScannerData Export <version>" supports both the CIR exports and raw data export for
5G NR scanner.

The 5G NR raw scanner data is exported in CSV format and the exported data are
shown in the 5G NR column of the Table 7-1.

The 5G NR Scanner CIR exports are shown in the following figures.

Figure 7-37: 5G NR scanner CIR raw data

The exported CIR raw data in the previous figure is given in the following order:

Date;Time;UTC;Latitude;Longitude;Altitude;Speed;Head-
ing;#Sat;GSCN;SSRef;Band;PCI;Beam;BeamMod8;RSSI;SS-SINR;SS-RSRP;SS-
RSRQ;

Figure 7-38: 5G NR scanner CIR export data

The CIR export data in the previous figure is given in the following order:

Timestamp;Longitude;Latitude;Color;PCI;Beam;Power [dBm];P total
[dBm];SSRef[MHz];Max. Delay [µs];Time Delta [µs];BTS ID;

Figure 7-39: 5G NR scanner CIR peak export data

The CIR peak export data in the previous figure is given in the following order:

Timestamp;Longitude;Latitude;Color;PCI;Beam;SS-Ref [MHz];Power [dBm];P total
[dBm];Delay [µs];Match.Guard.Per.;BTS ID;
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Export of 5G NR scanner TAE measurements data

The ASCII export signal filter dialog offers the additional option "ANY" for NR-ARFCN,
PCI and Beam. To identify the transmitter, it is recommended to select the signals "TAE
NR-ARFCN", "TAE PCI" and "TAE Beam" together with the TAE result signals. The
"ANY" option allows you to get a line for every TAE measurement of the file, independ-
ent of the transmitter.

Example Result:

08:31:27;The PC clock was used to read the UTC for a received
PPS;630000;393;5;0;310;06:31:26.900;8;23;8164;1595572286900008164;433;7;0;0

08:31:27;The PC clock was used to read the UTC for a received
PPS;630000;393;6;0;334;06:31:27.140;7;13;8124;1595572287140008124;512;7;0;0

08:31:27;The PC clock was used to read the UTC for a received
PPS;630000;393;6;0;348;06:31:27.280;10;19;8557;1595572287280008557;436;7;0;0

08:31:27;The PC clock was used to read the UTC for a received
PPS;630000;393;5;0;368;06:31:27.480;8;19;8147;1595572287480008147;425;7;0;0

Export of raw scanner data

The raw scanner data exported for the RAT selected in the "Export of the Raw Data for
the following RATs" is given in the following table. The first column contains data com-
mon for supported RATs.

Table 7-1: Exported raw scanner data in CSV format

All RATs
exported data

GSM exported
data

UMTS exported
data

LTE exported data NB-IoT export data 5G NR exported data

Measurement
File Info

ARFCN UARFCN EARFCN EARFCN GSCN

Date, Time Frequency Frequency Frequency Frequency Band

UTC LAC LAC TAC TAC Beam

Latitude CI CI CI CI Beammod8

Longitude BSIC SC PCI NPCI PCI

Altitude Total Power RSSI eNodeB-ID eNodeB-ID SSRef.

Speed SCHPower Ec/No (PSCH) cellID cellID RSSI

Heading C2 Ec/No (SSCH) BWE RSSI-Tx0;RSSI-Tx1 SS-SINR

#Sat  Ec/No SymPerSlot NSSS-RSSI SS-RSRP

MCC  SIR Power NSSS-Power SS-RSRQ

MNC  RSCP SINR NSINR-Tx0; NSINR-
Tx1

SSS-RePower
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All RATs
exported data

GSM exported
data

UMTS exported
data

LTE exported data NB-IoT export data 5G NR exported data

  ISCP RSRP NRSRP-Tx0

NRSRP-Tx1

SIB1 Signals: (in addi-
tion to MCC and MNC)

LAC

RNC-Cell ID* (Hexa-
decimal) R

NC-Cell ID* (Decimal)

RNC-Cell ID* is expor-
ted twice with indica-
ted formats.

  Drift DevDrift RSRQ NRSRQ-Tx0;
NRSRQ-Tx1

MIB Signals:

MIB_Sfn

MIB_ScsCom-
mon30or120kHz

MIB_SsbSubcarrier-
Offset

MIB_DmrsTypeAPosi-
tionPos3

MIB_PdcchConfigSib1

MIB_CellNotBarred

MIB_IntraFreqRese-
lectionNotAllowed

  Delay Spread 4G-Drift NSSS-CINR DM_RS Signals:

DM_RS-SINR

DM_RS-RSRP

DM_RS-RSRQ

DM_RS-RePower

  ULI Sigma-4G-Drift  PBCH Signals:

PBCH_RS-SINR

PBCH_RS-RSRP

PBCH_RS-RSRQ

PBCH_RS-RePower

  TimeOfArrival

The R&S option
Position Estimator
has to be available
during the measure-
ment.

The signal is ana-
logue to the one for
LTE - means the
time of arrival of the
UMTS signal relative
to the PPs pulse.
Although being
optional, activate it
in the "TEC for
UMTS Scanner".

TimeOfArrival  PSS Signals:

PSS_RS-SINR

PSS_RS-RSRP

PSS_RS-RSRQ

PSS_RS-RePower

SSS_PBCH Signals:

SSS_PBCH-SINR

SSS_PBCH-RSRP

SSS_PBCH-RSRQ

SSS_PBCH-RePower
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All RATs
exported data

GSM exported
data

UMTS exported
data

LTE exported data NB-IoT export data 5G NR exported data

  TimeOfArrival Virtual Frame Number

For UMTS and LTE, the internal virtual
frame number (VFN) is available as the
R&S ROMES4 signal. This value is the 10
ms frame number, which belongs to the
current Time Of Arrival (ToA) value. This
value allows the user to bring together the
Time Of Arrival values on an absolute time
(Abs. Time) scale.

The absolute time value can be calculated
as follows: T = ToA + VFN * 10ms , see the
following example.

 SS_PBCH Signals:

SS_PBCH-SINR

SS_PBCH-RSRP

SS_PBCH-RSRQ

SS_PBCH-RePower

Time of Arrival (ToA)
Signals

ToA (PPS)

ToA (CIR)

Note: To be exported, some raw data require a software and/or hardware option. If the corresponding options are not available, the
column in the file is left blank.

Example: Abs. time calculation

Time of Arrival Virtual Frame Number Abs. Time

0.00345 1000 10.00345

0.00346 1001 10.01346

Scanner export configuration

It is possible to save the configuration or load the previously saved configuration in the
"Export Configuration Management" window, see Chapter 7.2.4.1, "User-defined ASCII
format (*.asc)", on page 2105.

Figure 7-40: Export Configuration window

The "Load" function tests configuration and returns warning, if combination of parame-
ters is not effective. For example, it acts when user has not defined any position filter
for export, but defined RATs list, or vice versa. Click the button before you start export.
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If the user loads the configuration, even clicking the "Cancel" button does not reset the
export settings.

Multiple files export is not recommended in the interactive mode because user gets the
export parameters dialog before export of every file. If user needs to export many files,
and export parameters were saved in this dialog, it would be more effective to use
silent export.

7.2.5.3  Batch export

The user also can make scanner export in the batch mode. For this mode, you need to
use command string like this:

Romes.exe –e sca –f SourceFile.rscmd –c PreSavedConfigFile.rma,
where

● SourceFile.rscmd is the source file with measurement data
● PreSavedConfigFile.rma is the existing export configuration data file.

Exporting scanner measurement data in batch mode
Do not forget to use ❝❞, if file names or paths contain the spaces.

7.2.5.4  Export log

During a file export, independently on used export mode, R&S ROMES4 generates a
log and shows it in the "Export Info" window.

Figure 7-41: Export info
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You can see the export status. The progress bar gives the information on the actual
progress of the export.

To terminate export, click "Cancel".

7.2.5.5  View export results

After finishing the export process, the "Export Info" > "Export finish" dialog appears.

The possible actions are:
● Doing nothing (click "Close")
● Saving a log file for export (click "Save Log File")
● Opening all created export files (click "Open Export Result")

Export files can have a huge size and opening a file can take much time.
To open all XML files simultaneously, change the settings of those MS Windows ver-
sions which have Internet Explorer as the default viewer for XML files. Without the set-
tings change you get only the first file opened.
Use the "Control Panel" > "Folder Options" > "Open each folder in its own window"
option, see Chapter 7.2.3, "Export info", on page 2104.

7.2.5.6  Names of exported files

For every source file, R&S ROMES4 creates subdirectory with the same name into the
export directory name.

Exporting data



Data processingDrive Test Software

2143Operating Manual 1171.6415.12 ─ 66

Example: 
Default export directory name is C:\Export.
Measurement file name is 2012-08-03_09-52-51_DV_DRT8b_4.69B15.rscmd.
Directory C:\Export\2012-08-03_09-52-51_DV_DRT8b_4.69B15 is created, and the all
export files are stored.

Names of exported files are generating using the following templates:
● Transmitter tree export file

“Technology name” + “Scanner instance number” + “_trans_tree_” +
+ “[“ +timestamp + “]”.txt

● Transmitter list export file
"Technology name” + “Scanner instance number” + “_trans_list_” +
+ “[“ + timestamp + “]”.extension
Extension is:
– kml for KML format

– txt for R&S ROMES4 Basestation List format
● CIR export file

– "Technology name” +”[” + “Scanner instance number” +”]” +
+ "_cir_[" + timestamp + "].xml

– “Technology name” +”[” + “Scanner instance number” +”]” +
+ "_peaks_[" + timestamp + "].xml

● LTE CIR raw data export_file
“LTE_[“ + “unique ID” + “]_CIR_Raw_[" +” + timestamp + "].xml

Timestamp format is: hour_min_sec_day_month_year

All files generated by one export operation have the same timestamp as the timestamp
is calculated once at the beginning of every export. A single timestamp makes sort and
analysis of files easier.

7.2.5.7  LTE scanner CIR raw data export

To get the LTE scanner CIR information, which is the raw channel impulse responses,
use the "File" > "Export Measurement File(s)" menu. The raw channel impulse
response means one CIR per up to every 5ms.

This export does not depend on the update rate of the lists. All data is exported.

The reconstruction of the spectral channel impulse response is done as follows.

The fading channel is measured as few single paths. Each path has an amplitude
a(i)=sqrt(p(i)), phase phi(i), Doppler frequency fd(i) and a delay tau(i). The CIR is mea-
sured on a bandwidth of 1.08 MHz and a 9 5ms long IQ data block, which starts at Tcir.
In this block the LTE frame start at the time tau_min (minimum of the delays of all
peaks). The temporal relation of the position of the reference symbols is given implic-
itly. The reconstruction is done for each transmit antenna (Port 0,.., Port 3) separately,
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because the transmit channels are different. The reconstruction of the 12*6=72
resource elements r(t, k*15kHz) {k=-36...-1,1,...,36} is the impulse response in spectral
range at time t for the bandwidth of 1.08 MHz, which is given as a TransferFunction. An
IQ Block normally has a length of 100 ms, which result in (100ms / 5ms) - 1 = 19
TransferFunctions.

The phases of the exported results are only in relation to each other within one expor-
ted IQ block, called Single Measurement.

The CIRs are exported in to an XML file with the name
RSCMD-filename_LTE_CIR_Raw.xml which is created in the ExportResult directory.
The XML file is written whenever the replay was stopped. Tags and attributes of the
XML file are given in the following table.
Table 7-2: Tags and attributes of the XML file

ScannerResult Tag Bunch of measurement results
reported by the scanner

 Measurement_Time_s: Start time of the measurement in
seconds from start of the mea-
surement (PC time)

 Receiver_Time_s: Receiver internal start time of the
measurement in seconds

 Device: Id of the receiver device

SpectralCIR  Spectral Channel Impulse
Response

Port  Antenna Port

 Port Number Number of the port 0..3

 CountOfTransferFuntions Number of transfer functions for
this single measurement on this
port 0..19

 Device: Id of the receiver device

Transfer Function  Transfer function as explained
above

 TransferFunctionNumber Number of the transfer function
0..19

 Receiver_Time_s Receiver internal time for the
transfer function in seconds

Point  Point of the transfer function

 Power_dBm Power in dBm

 Arg_Radiant Phase in radiant

Server Tag LTE eNodeB

 PCI Physical Cell Identity

 NumberOfSymbolsPerSlot 7 for normal CP, 6 for extended
CP
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 SSSToPSSRatioInDB Measured power ratio
power(SSS)/power(PSS) in dB
LTE Scanner Signals

 ExpectedTimeDriftInNsPerSec Due to observation of the arrival
time of the strongest BS signal,
we can calculate an expected time
drift against the receiver time

 SigmaTimeDriftInNsPerSec Expected standard deviation of
the value above

 CenterRSRPinDBm Gives the RSRP value based on
the reference signal power mea-
surement of the 6 innermost
resource blocks. (1MHz BW
around center frequency at sym-
bols used for the PBCH). It is a
combination of noise clipping and
non-noise clipping results. (See
the explanation for the Ofdm-
Based and the CirBased values)

 PBCHbasedRSRQinDB RSRQ value based on Center-
RSRPinDBm and the total inband
power in resource blocks used to
transmit the PBCH within the 100
ms IQ data block analyzed with
the scanner

 CntResourceElementsForRSRP Number of resource elements
used for RSRP measurement

 OfdmBasedCenterRSRPinDBm100 RSRP value based on the refer-
ence signal power measurement
of the 6 innermost resource
blocks. (1 MHz BW around center
frequency at symbols used for the
PBCH). The power measurement
is done from the OFDM symbol
without clipping of noise.

 CirBasedCenterRSRPinDBm100 RSRP value based on the refer-
ence signal power measurement
based on CIR measurement and
noise clipping of the 6 innermost
resource blocks. (1 MHz BW
around center frequency) at sym-
bols used for the PBCH.

Power Values  Measured power of signal

PowerValue  One power value

 TimeFromStartOfBlockInNs Time in ns of the first IQ value for
the SSS power measurement from
the IQ block start. This value is
normally within the CP of the
OFDM symbol containing the
SSS. In the case that not a single
symbol has been used the value is
reported.

Exporting data



Data processingDrive Test Software

2146Operating Manual 1171.6415.12 ─ 66

 PowerInDBm Power of SSS signal in dBm. The
PSS power can be retrieved indi-
rect using the measured SSS /
PSS power ratio. If TimeFromStar-
tOfBlockInNs is not reported, then
the power is measured for 19..20
SSS OFDM Symbols (calculated
from the CIR). If we have a valid
time value, the power is measured
for one SSS symbol only.

 CinrDB: CINR value in dB for the sync sig-
nals. If TimeFromStartOfBlock-
InNs is not reported then the CINR
is measured for 19..20 S-Sync
OFDM Symbols (calculated from
the CIR). If we have valid values
in CinrDetails for S-Sync and P-
Sync, then CINR value is the aver-
age of P-SYNC and S-SYNC. If in
CinrDetail only S-Sync CINR is
valid, then this value is the S-Sync
CINR. For details, see CinrDe-
tailTable which is parallel to this
record.

 CinrPSyncInDB: CINR of the PSS in dB

 CinrSSyncInDB: CINR of the SSS in dB

 AmpBasedCinrPSyncInDB CINR of the PSS in dB based on
amplitude noise. The measure-
ment performed for this result
value reduces the noise contribu-
tion that is produced by the phase
noise of transmitter or receiver. If
receiver or transmitter phase
noise contributions cannot be
neglected, the amplitude-based
CINR is higher than the CINR
based on the regular CINR mea-
surement.

 AmpBasedCinrSSyncInDB CINR of the SSS in dB based on
amplitude noise.

CIR_PowerDelay  Channel Impulse Response and
Power Delay

PowerDelayProfile  Power Delay Profile

 SamplingTimeInSec Sampling time or time distance
between CIR samples.
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 InbandPowerInDBm Inband power during the CIR mea-
surement in dBm. The inband
power is measured within the
same band or frequency range.
One or more time intervals are
occupied by a special transmitted
signal sequence which is used to
calculate the CIR. For example, in
LTE up to 20 SSS signals are
used to calculate the CIR and the
power delay profile. Each SSS is
defined by 62 subcarriers which
define the band or frequency
range for the inband power mea-
surement. The symbol time-slots
of the 20 SSS define the used
time intervals. So, the minimum
value of the inband power mea-
surement is the aggregate power
of all components in the power
delay profile. If no interference sig-
nal is present, both aggregate
power and inband power are
equal and the measurement errors
neglected.

 AggregatePowerInDBm Received power from all paths in
dBm. Note that this power is not
necessary the peak power or the
sum of the power values in the
power delay profile. Due to higher
resolution in time delays and Dop-
pler frequency, concerning the
measured bandwidth and length of
the analyzed signal, the value is
different. The aggregate power is
defined as the RMS power of
some signals (e.g. SSS or refer-
ence signal for LTE) out of the all
signals used to calculate the CIR.
It corresponds to the same section
as the inband power. Sometimes
the aggregate power can be
higher than the inband power. This
case happens when a noise con-
tribution disturbs the algorithm is a
way, that the reconstructed signals
have a higher power than the
received signals.

 NoiseFloorInDBm This parameter is an estimated
noise floor for the CIR. Reported
values below or next to the noise
floor are caused or significantly
influenced by noise.

Point  Point of the Power Delay Profile
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 PowerInDBm Here the time discrete power val-
ues (power samples) of the power
delay profile in dBm are reported.
Some power values cannot have a
valid value. At the corresponding
delays, the power measurement
was not done or not successful.
I.e. we have not been able to
measure a delayed power with the
methods for CIR measurement.

ComplexCIR  Complex Channel Impulse
Response

 PowerOf1InDBm For complex values, we need
some scaling for the delayed
power in dBm which is 10 *
log10(re^2 + im^2) + Pow-
erOf1InDBm.

Point  Point of the complex CIR

 re Real part

 Im Imaginary part

Peaks  List of peaks of the CIR

 NumberOfPeaks Number of peaks in the list

Peak  Peak of the CIR

 InbandPowerInDBm Inband power for this peak in dBm

 PeakPowerInDBm Power of the peak in dBm

 MainDopplerInHz A main input component for a
Doppler frequency in Hz.

 CountOfGuardPeriods CountOfGuardPeriods are various
guard periods checked for the CIR
peak.

 CountOfMatchingGuardPeriods CountOfMatchingGuardPeriods =
0..CountOfGuardPeriods are vari-
ous guard periods checked for the
CIR peak and the signal of the
peak is within the guard period.

  If 0 < CountOfMatchingGuardPer-
iods < CountOfGuardPeriods then
there are some guard periods
where the peak is in and others
where the peak is outside. This
case happens when the guard
period position is shifted between
the measured OFDM symbols.

 DopplerPhaseIn2P16 Main Doppler phase in 2^-16
(2^16 = 360ø) at the first sample
or 0.
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 MainDopplerFractionIn2Pm16Hz To get a better resolution of a
Doppler frequency, we can store
the sub Hz part in this variable.
The Doppler frequency is then
MainDopplerInHz + 2^-16 * Main-
DopplerFractionIn2Pm16Hz.

 DelayInSec Delay in seconds from the first
sample. This delay can be in a
better resolution than the sampling
time from the power delay profile.

7.2.5.8  RF power scanner data export

In "ASCII Export <version>" > "Values" page select the RF Power Scan signals for
export.

Apart from the current peak marker and the free marker signals, you can activate the
additional four fixed marker signals for export. Exporting the signals from the "Fixed
Marker" branch needs to define the fixed marker frequencies in "TEC for RF Power
Scanner TSME".

For description of the fixed marker frequency signals, see "Signal settings"
on page 370 and Figure 3-244.

A RF power scanner measurement can have some sweeps, for example, one for
GSM900, one for GSM1800 and a scan of the UMTS band, see Figure 3-243).

If a frequency falls into the start/stop frequency of a sweep, the sweep's fixed marker is
applied. Therefore, it is possible that none, one or many fixed marker frequencies are
applied for a certain sweep. It is also possible that one fixed marker frequency falls into
several sweeps (e.g. GSM-R and GSM900).

If no fixed marker is applied, the exported signals are signed invalid with "?".

Some signals depend on the measurement settings and cannot be valid. For example,
no usage of AUTO detector results in an invalid min level, auto attenuation selection
results in an invalid attenuation and preamplifier signal.

The "Output" window shows how the markers are applied on the sweeps.

Figure 7-42: Output messages for Fixed Marker configuration
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Figure 7-43: Example of an ASCII exported file

7.2.6  Exporting RF power scanner data from multiple scanners

If the RF Power Scanner is used with multiple scanners (refer to Multiple R&S TSME
with RF power scanner), the "Available Signals" > "RF Power Scan" branch allows
exporting the signals of all configured scanners.

Exporting the signals from the "Fixed Marker" branch needs to define the fixed marker
frequencies.

Figure 7-44: Selected multiple RF power scan signals for export

The result is an export result file. A list of the selected and exported signals is con-
tained in the "[DESCRIPTION]" part of the result file. Here [1] and [2] denotes the
device instance.
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Figure 7-45: Result file of the multiple RF Power Scan signals export

7.2.7  Export via MS Windows command line

Use the command-line to export measurement files if you do not want also to run some
replay or measurements on your system.

The user-defined ASCII format ASC does not support this export approach.

General command-line export syntax:

[C:\RuS\ROMES4.xx\]romes.exe –e <export module> -f <measurement
file(s)> [-s] [-c <export config file>] [-w <workspace file>]
[-y] [-r <report file>] [-d <destination dir>]

Use quotation marks (" ") if blanks are in path or files names
In case blanks are in paths and/or file names, it is mandatory to use quotation marks.
In example: "C:\User\My ROMES\MeasData\Measurement File.rscmd"

To export the data, one out of the formats MIF, ASC or CSV must be selected. Multiple
selections are allowed.

If an input file name has no related output file name after the /o switch, the input file
name will be used for the output file.

If more output file names than input files are specified, the spare output files are
ignored. If fewer output files than input files are specified, the n given output file names
are used for the first n input files. The names of remaining files are unchanged, only
the default extension is used.

If the /r option is used, all text output (e.g. error messages) produced during export is
diverted into a report file. If no report file name is specified, the default name
error.txt or export.txt is used.
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Enter the MS Windows command line into the input field of the "Run" dialog box which
is accessible from "Start".

You can also start from the DOS box. Here you can also use a batch file, if desired. If
you do so, start every new line with the CALL command, otherwise only the first line of
the batch file is executed.

7.2.7.1  Possible R&S ROMES4 return codes for command-line export

The possible return codes, issued when R&S ROMES4 is started with command-line
export parameters, are shown in the following table.
Table 7-3: R&S ROMES4 return codes

Return code Explanation

0 Export was successful

2 File not found

5 Access denied (for example, when tried to start a second ROMES instance)

13 Invalid data (for example, the measurement file header data is invalid)

30 Read error (the properties of a measurement are not readable)

110 A specified file could not be opened (used for source and target file)

All the other MS Windows application return codes are documented in

http://msdn.microsoft.com/en-us/library/windows/desktop/ms681381(v=vs.85).aspx

7.2.7.2  Additional features for command-line export

The command-line export functionality supports the following:
● Recursive directory scan for measurement files
● Export configuration files can be specified
● Silent mode to support batch export

The valid syntax is shown below:
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romes.exe –e <export module> -f <measurement file> [-s] [-c
<export config file>] [-w <workspace file>] [-y] [-r <report
file>] [-d <destination dir>]
For multiple measurements file export, the following syntax for -f option applies.

romes.exe –e <export module> -f <"measurement1" "measurement2"
"..."> [-s] [-c <export config file>] [-w <workspace file>] [-y]
[-r <report file>] [-d <destination dir>]
The given example shows the syntax for exporting two files.

romes.exe -e sca -f "C:\data\2021-12-25_14-12-14_test1.sqc" "C:\data\2021-12-25_
14-12-14_test2.rscmd" -c "C:\data\LTE_5G_NB-iot_PE_BTSlist.rma"

The command options have the meanings described in the following table.
Table 7-4: Command-line options

Option Count Argument Description

-e 1 Name of an
export module

Specifies which kind of export to be performed. Possible values are
“asc”, “csv”, “mif”, "geo", "sca".

-f 1+ Names of the
files to be expor-

ted

Specifies which files to be exported. The names are interpreted as
wildcards and are used to scan recursively directories. For exam-
ple, if a name “C:\Rus\ROMES4.xx\MeasData\*.rscmd” is specified,
all files with the suffix rscmd in the R&S ROMES4 measurement
data directory and all subdirectories are exported.

-s 0/1  If this option is used, then all kinds of feedback or graphical outputs
like dialog and messages boxes are suppressed. It is useful to con-
sult the Export.txt file after the export has finished. Neverthe-
less, some windows are displayed during export, but they close
automatically.

-c 0/1 Configuration File
(*.rma)

Specifies which configuration file to be used to initialize the export
module. The ASCII export, for example, can store the list of export
parameters in that file.

-w 0/1 Workspace File Exported configurations can be saved in a workspace as well. If a
configuration file is not available, a workspace can also provide
configuration. If –c is specified, this workspace function is ignored.

-y 0/1  Specifies if the default settings for the export stored in the registry
to use. It is only considered if –c and –w are not set.

-r 0/1 Result Log File The messages from the export are written in the result log file. Per
default, this file is stored at .\My ROMES\LogFiles\ as
Export.txt, for exam-
ple .\My ROMES\LogFiles\2022-01-19\12-45-11\
Export.txt.

It is possible to specify another file name using this option.

-d 0/1 Output Directory Controls where to write the export result data to. If omitted, the
results are written to the same directory as the input file.
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If a configuration is not specified (-c, -w or –y) and silent mode is enabled, the export
fails sometimes (ASCII export), since the list of output parameters is missing. If –s is
omitted, the standard export configuration dialog for the specific export module is dis-
played.

7.2.8  R&S ROMES4 IBWC exporter

7.2.8.1  General

The main use of the R&S ROMES4 IBWC exporter is to display the measured signals
in iBwave Design.

The IBWC file format is a ZIP folder containing XML files, which stores geographic
annotation and visualization. The format was created to exchange data between the
iBwave platform and third-party tools.

To use this export, a layout plan has to be created in iBwave Design first (*.ibw) and
exported as iBwave Collection Data (*.ibwc), see Chapter 7.2.8.2, "Create floorplan in
iBwave design", on page 2158.

Figure 7-46: Principle of IBWC exporter

After that, it is possible to import this file as an Indoor Floorplan in R&S ROMES4, see
Chapter 7.2.8.3, "Import *.ibwc file to R&S ROMES4", on page 2158, start a measure-
ment and export the measurement back to IBWC format, see Chapter 7.2.8.4, "Export
measurement files to *.ibwc file", on page 2159.

The R&S ROMES4 IBWC exporter automatically filters unwanted data.

Deleted is the following data:
● All signal data that are not positioned between two GPS measurements, since their

position cannot be interpolated.
● GPS positions that are not located on a floorplan - automatically deleted during

export.

The IBWC exporter exports 5G data recorded both by a mobile phone and scanner. If
the 3GGP/non-3GPP specified RATs, LTE, UMTS, HSPA, GSM/CDMA2000Data, WiFi,
the exporter only exports data which is recorded by a mobile phone.
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The following tables list the data of different RATs that can be exported.
Table 7-5: 5G exportable data

IBWC key Meaning Mobile Scanner

Time  x x

RasterX  x x

RasterY  x x

PathID    

BeamID Beam identifier x x

PSS_RSSI Primary Sync Signal_Received signal strength
indication [dBm]

 x

PSS_RSRP Primary Sync Signal_Received signal strength
[dBm]

 x

PSS_RSRQ Primary Sync Signal_Received signal quality [dB]  x

PSS_SINR Primary Sync Signal_Signal to Noise Ratio [dB]  x

SSS_RSSI Secondary Sync Signal Signal strength [dBm]  x

SSS-RSRP Secondary Sync Signal Resource Signal strength
[dBm]

 x

SSS_RSRQ Secondary Sync Signal Resource Signal quality
[dB]

 x

SSS-SINR Secondary Sync Signal Signal Noise Ratio [dB]  x

SSB_RSSI Sync Signal Block Signal strength [dBm]  x

SSB_RSRP Sync Signal Block Resource Signal strength
[dBm]

 x

SSB_RSRQ Sync Signal Block Resource Signal quality [dB]  x

SSB_SINR Sync Signal Block Signal vxy<x21Noise Ratio
[dB]

 x

CSI_RSSI Channel State Information Signal strength [dBm]   

CSI_RSRP Channel State Information Resource signal
strength [dBm]

  

CSI_RSRQ Channel State Information Signal quality [dB]   

CSI_SINR Channel State Information Signal Noise Ratio [dB]   

    

PBCH_RSSI PBCH Signal strength [dBm]  x

PBCH_RSRP PBCH Resource Signal strength [dBm] x x

PBCH_RSRQ PBCH Signal quality [dB] x x

PBCH_SINR PBCH Signal Noise Ratio [dB] x x

TimeOffset Time offset of the TX-Transmit antenna [ms] x  
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IBWC key Meaning Mobile Scanner

ss_DelaySpread The delay spread width – the time difference
between the arrival of the first SSS component to
the arrival of the last multi-path component [ns]

 x

PCI Physical Cell ID x x

CellID Cell identifier x x

MobileTxPower UE transmit power [dBm] x  

OperatorName Name of the operator x x

OperatorMCC Home MCC x x

OperatorMNC Home MNC x x

TrackingAreaCode Tracking Area Code x x

ChannelBW Channel Bandwidth [MHz]  x

_5GMode 1=TDD, 2 = FDD x x

Modulation 1 BPSK 2, QPSK 3, 16QAM 4, 32QAM 5, 64QAM
6, 128QAM 7, 256QAM 8, 512QAM 9, 1024QAM
10, Other

x  

RankIndicator Number (1 or more) of useful transmission layers
as specified by 3GPP. A number indicates the
number of MIMO streams available at this loca-
tion

x  

Band Band number of survey S x x

DL_ARFCN Downlink channel number x x

UL_ARFCN Uplink channel number x x

DL_Throughput Downlink throughput [kbps] x  

UL_Throughput Uplink throughput [kbps] x  

ChannelQualityIndica-
tor

Channel Quality Indicator x  

ConditionNumber Condition Number [dB]   

OverlapServers Number of servers in this area   

x - indicates that the IBWC exporter exports data recorded by 5G mobile phone and/or
scanner.
Table 7-6: Other 3GPP RATs exportable data

Technology Signal Meaning

LTE

RSSI Signal strength

RSRP Reference signal strength

RSRQ Reference signal quality

SINR Signal to noise and interference ratio

MobileTxPower UE transmit power
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Technology Signal Meaning

Band Band number of survey

DL_EARFCN Downlink channel number

UL_EARFCN Uplink channel number

PCI Physical cell ID

CellID Cell identity

DL_Throughput Downlink throughput (kbps)

UL_Throughput Uplink throughput (kbps)

UMTS and HSPA

RSSI Signal strength

RSCP Received signal code power

EcNo Signal noise ratio or Ec/Io

MobileTxPower UE transmit power

Band Band number of survey

DL_UARFCN Downlink channel number

UL_UARFCN Uplink channel number

PSC Primary scrambling code

CellID Cell identity

DL_Throughput Downlink throughput (kbps)

UL_Throughput Uplink throughput (kbps)

GSM

RSSI Signal strength

CtoI Carrier to interferer ratio

MobileTxPower MS transmit power

Band Band number of survey

ARFCN Absolute radio frequency channel number

CellID Cell identity

Table 7-7: More RATs exportable data

Technology Signal Meaning

CDMA2000Data

RSSI Signal strength

Pilot Pilot power or Ec

EcNo Signal noise ratio or Ec/Io

MobileTxPower MS transmit power

Band Band number of survey

Channel Channel number

PN Pseudo noise code
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Technology Signal Meaning

CellID Cell identity

WiFi

RSSI Signal strength

SSID Service set identifier

Channel Channel number

MAC MAC address

DL_Throughput Downlink throughput (kbps)

UL_Throughput Uplink throughput (kbps)

7.2.8.2  Create floorplan in iBwave design

Create and save a floorplan in iBwave Design.

For information on creating the floorplan in iBwave Design, refer to iBwave Design doc-
umentation.

Figure 7-47: iBwave Design page "Export to"

Export the floorplan to the *.ibwc file format via "File" > "Export" > "iBwave Collec-
tion Data".

7.2.8.3  Import *.ibwc file to R&S ROMES4

1. Start R&S ROMES4.

2. Select "Indoor Navigation".
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3. Import the *.ibwc file.

Figure 7-48: *.ibwc file selection

After importing the file, start the measurement.

7.2.8.4  Export measurement files to *.ibwc file

To export a measurement file to IBWC file format, perform the following steps.

1. Select "File" > "Export Measurement File(s)".

The "Export measurement data" page pops-up.

2. Select the iBwave file format (*.ibwc) as export format.

3. Open the measurement file in which you have imported the iBwave file earlier.

4. Select in "Configuration" the imported *.ibwc file.

5. Select the export mode.

6. Click "OK" to start the export.
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Figure 7-49: Exporting *.ibwc file

You can choose between the following modes in the "Export Mode" pane:
● Data-based export

Creates a place mark for each single signal measurement available and interpo-
lates its GPS position using the GPS data.

Figure 7-50: Data-based export mode

● GPS-based export
Creates a place mark for every GPS measurement available and chooses its value
depending on the option selected in "Data Selection".

The place mark value options applicable for the GPS-based export are:
● Current value

Selects the valid measured value that lies closest to the measured GPS data,
according to its timestamp.
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Figure 7-51: Current value of place mark

● Interval minimum
Selects the minimum signal value between a GPS measurement and the next one.

Figure 7-52: Minimum value of place mark

● Interval maximum
Selects the maximum signal value between a GPS measurement and the next one.
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Figure 7-53: Minimum value of place mark

● Interval average
Selects the average of all valid signal measurements between a GPS measure-
ment and the next one.

Figure 7-54: Average value of place mark

7.2.8.5  Import *.ibwc in iBwave design

Open the iBwave project file (.ibw) and import the *.ibwc file via "File" > "Import" >
"iBwave Collection Data".
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Figure 7-55: iBwaveDesign page "Import from"

7.3  BTS list formats

A BTS database is imported from a BTS list file using the "Tools" > "Transmitter Data-
base" > "Import" page.

The BTS list files are ASCII files characterized by one of the extensions *.atd, *buf,
*.csv,*.cdc/CDN or *.vig.

The examples for the BTS list files you can find in the C:\Users\<name>\Documents
\My ROMES\BaseStationLists\samples directory.

Figure 7-56: TETRA BTS file list

Some views, for example, the alphanumeric view and the ROMESMAP Route Track
view and the measurement reports contain information on base stations.

File formats

The ATD BTS list file format is used and is supported with the all R&S ROMES4 soft-
ware versions.
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This file format can be used for GSM, WiMAX, CDMA, TETRA, UMTS, LTE and 5G NR
BTS list files. The information in all BTS list files is arranged in a table. Each column of
the table corresponds to a BTS parameter, each line to a particular BTS sector. The
names of the BTS parameters in the file are fixed.

The BUF and VIG formats are customized. Fixed formats and not intended for general
use.

As the GSM neighbor station list provides 3G and 4G neighbors for GSM transmitters,
the user has to modify list of importing transmitters (TXT file) and import descriptor
(ATD file). For needed modifications, see Chapter 7.3.1.8, "ATD file modification",
on page 2174.

The ATD format must be used for GSM BTS, WiMAX BTS, CDMA BTS, TETRA BTS,
UMTS NodeB and LTE eNodeB network data bases.

Alternatively, it is possible to write a DLL file defining a new, user-defined BTS list for-
mat, see Chapter 7.3.4, "User-defined BTS list format", on page 2185.

Identification of base stations

The assignment of different sectors to a particular BTS is based on the measured geo-
graphical position of each sector: Up to three sectors with a distance of less than 5
meters are considered to belong to the same base station. It is assumed that the 51
multiframes (T51 frames) of all sectors of the BTS are time-synchronized, i.e. that the
starting time of their M51 multiframe is the same. Individual clock codes are used if
asynchronous sectors or few sectors larger than three.

Update of the BTS database

The BTS list database can be updated by adding a new BTS list file. In the update
process base stations that are already included in the database are replaced, and new
base stations are added to the data base. Two BTSs are considered to be identical if
both their geographical position and the clock codes of their sectors match.

Clock codes

Up to three sectors with a distance of less than 5 meters are considered to be time-
synchronized if their clock codes are equal. A maximum of three sectors with the same
position and the same clock codes are allowed.

If the BTS list database and the added BTS list file contain the same BTS with different
clock codes, the system erroneously assumes that the BTS in the list file is new and
adds it to the database for a second time. To avoid such a situation, an automatically
generated clock code is never used. To indicate cearly whether two base stations are
identical or not, their sectors are time-synchronized. There are the following choices:

● If the sectors are not synchronized, use the Cell Identity (CI) of the individual sec-
tors as clock codes.

● If the sectors are synchronized, use the smallest of the CIs of all sectors as a com-
mon clock code.
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This problem is reduced when the GSM Network Scanner decodes the Cell Identity
(CI) and the complete Location Area Information (LAI). Then the comparison is taken
using these values.

7.3.1  ASCII table description (*.atd) format

ATD files control the import of ASCII tables, in particular BTS/NodeB/eNodeB lists, into
the R&S ROMES4.

Since the R&S ROMES4 allows flexible import of different ASCII table formats, a
description format is required to explain the table attributes.

An ATD format file (*.atd) is a plain text file. The file can be edited with any text editor
(e.g. Notepad) that does not insert format commands into the text (like MS Word does
into the *.doc format files). The table attributes can be defined at will. However, the
R&S ROMES4 uses fixed names to identify the parameters in the individual columns,
see Chapter 7.3.1.6, "Column names", on page 2171.

Txt-based import of transmitters list into database
The ATD files contain (optional) description of the field “OnAir” (case sensitive) of type
“utUSInt”.
The ATD file for UMTS transmitter database export with this field is shown.

As the field is optional, add it as the last column in the ATD file and the appropriate
value to the end of every row of TXT file. The value in this field defines if the string in
the TXT file is the subject of import or not. All strings are imported in the system if the
TXT file does not contain this field.
For the field values, see Table 7-11.

Example *.atd files are provided in the BTSLists subdirectories of the R&S
ROMES4 program directory.
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7.3.1.1  Exporting NB-IoT base station list

When exporting the NB-IoT base station list, the SYS_TYPE column is included.

The exported *.atd and *.txt files contain SYS_TYPE definition and NB-IoT value,
respectively.

The exported *.atd contains SYS_TYPE definition.

...

Columns17_Name=SYS_TYPE

Columns17_Type=utDynChar

The exported *.txt file contains NB-IoT and NPCI instead of PCI in each line.

;exported by ROMES NB_IoT BCCH View

;The name is either the name of the station found in the database
 or in case no station is found in the database eNodeB<eNodeBID/CellID><PhyCellID>

;Position of 0.0/0.0 mmeans unknown

;

;Name;Longitude;Latitude;PosErrorDirection;PosErrorLambda1;PosErrorLambda2;
IsDirected;Direction;Power;MaxPowerUsedForTowerEstimationbyPE;TowerID;MCC;MNC;
TAC;CellIdentity;EARFCN;PhyCellID;SYS_TYPE

eNodeB - ID:0/1 NPCI:0 (0/0);0;0;0;0;0;0;0;30;-999.0;;1;1;1;1;0;0;NB-IoT

7.3.1.2  Keywords for *.ndb export

The following keywords / descriptors are generated when data in a network database
(*.ndb) file is exported to a *.atd BTS List file.

Table 7-8: Keywords for *.ndb export

Keyword Description Remarks

MainErrDir Main direction of position uncertainty in °, 0..360,
North = 0°, East=90°

For each, estimate that an error ellipse
is given. This ellipse describes a two-
dimensional area with 66% confi-
dence.

PosErr1 Position uncertainty in main direction in meters. For each, estimate that an error ellipse
is given. This ellipse describes a two-
dimensional area with 66% confi-
dence.

PosErr2 Position uncertainty orthogonal to the main direc-
tion in meters.

For each, estimate an error ellipse is
given. This ellipse describes a two-
dimensional area with 66% confi-
dence.

SourceST1 Source for BTS data from "System Information
Type 1"

Values: INVALID, BTS_LIST,
USER_EDIT, MEASURED

SourceST3 Source for BTS data from "System Information
Type 3"

Values: INVALID, BTS_LIST,
USER_EDIT, MEASURED
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Keyword Description Remarks

ValidityST1

ValST1

Validity for BTS data from "System Information
Type 1"

Values: IIS_VALID, TO_BE_VERIFIED

ValidityST3

ValST3

Validity for BTS data from "System Information
Type 3"

Values: IIS_VALID, TO_BE_VERIFIED

TimeSector Time for the last check of entered values for a
sector in seconds since 1970

For example, time of the measurement
or time of last change of BTS list files.

TimeST1 Time for the last check of "System Information
Type 1" values for a sector in seconds since 1970

 

TimeST3 Time for the last check of "System Information
Type 3" values for a sector in seconds since 1970

 

7.3.1.3  ASCII file BTS table format

The following entries are included in the BTS table format of the ASCII file.
Table 7-9: ASCII file BTS table format

Entry Required/
Optional

Remarks

[Main] req.  

Type=ATD req.  

[Table{TableIndex}]

TableIndex: index of table (> 0)

req. More than one table can be imported using one
ATD file. Table index is one-based, thus the first
table entry is [Table1]. TableIndex numbers have
to be in consecutive order. The tables after a gap
are not used.

Name={TableName}

TableName: name of the table, as it has
to be imported and appears inside R&S
ROMES4. Use only letter characters,
numbers and ‚_‘ to form a valid table
name

req. Attention!
SQL keywords used as ASCII table or column
names cause an error when the ASCII file is loa-
ded.

File={FilePath}

FilePath: relative or absolute file path of
the ASCII table file. Relative path root is
the location of the ATD file, meaning a
mere file name without directory has to be
located in the same directory as the ATD
file.

req. Examples:
File=c:\data\cells.txt
File=..\cell.asc

Columns_Size={NumOfColumns}

NumOfColumns: Number of columns of
this table (>0)

req. The table must contain at least NumOfColumns
column entries; if more column entries exist, only
the first NumOfColumns is used.

BTS list formats



Data processingDrive Test Software

2168Operating Manual 1171.6415.12 ─ 66

Entry Required/
Optional

Remarks

Columns{ColumnIndex}_{Attrib}

column attribute entry;

ColumnIndex: index of column (zero
based) the attribute belongs to;

Attrib: attribute of column as specified
below;

- Multiple of these attribute entries belong to one
column with the same index.

Columns{ColumnIndex}_Name

={ColumnName}

ColumnName: name of column, as it have
to be imported and appear in the data
tree; use only letter characters, numbers
and ‚_‘ to form a valid column name;

req. Attention!
SQL keywords used as ASCII table or column
names cause an error when the ASCII file is
loaded.
The column names must be unique to be iden-
tified by the measurement system; see Chap-
ter 7.3.1.6, "Column names", on page 2171.

Columns{ColumnIndex}_Type

={ColumnType}

ColumnType: data type of the column
(refer to reference table below)

req.  

Columns{ColumnIndex}_Size

={TypeSize}

TypeSize: size of fixed size data

req. for
fixed size
data;

Specify it only for types „utFixedChar“ and „utFix-
edArray“;

the maximum size is 4000 Bytes.

Columns{ColumnIndex}_ boIndexed

={IndexedFlag}

IndexedFlag: 0 or 1; indicating if column
has an index (1) or not (0)

opt.;
default 0

Selections are much faster if columns used as
search criteria are indexed; thus index columns
which are often used as selection or join criterion!
Indexed columns need slightly more disk space.

Columns{ColumnIndex}_boPrimaryKey

={PrimaryKeyFlag}

PrimaryKeyFlag: 0 or 1; indicating if col-
umn is used as primary key (1) or not (0)

opt.;
default 0

All columns with primary key flag set form the pri-
mary key. Only one record with the same primary
key can exist inside the database, otherwise an
exception is thrown during import. (This can be
used to ensure consistent data even when
appending data to an already existing table.) Pri-
mary keys can also have an advantageous influ-
ence on selection performance.

The records are separated by [<NewLine>], the columns by [<TAB>].

Terminate the last line also with <NewLine>, otherwise it is ignored!

If an attempt is made to import an ASCII table which does not match the ATD descrip-
tion file, an error message describing the kind and position of the erroneous statement
is produced. The error messages are self-explanatory.

7.3.1.4  Examples

Examples of the ATD files and the corresponding ASCII files.
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Example 1 (General)

*.atd file

[Main]
Type=ATD
[Table1]
Name=CellData
File=celldata.txt
Columns_Size=5
Columns0_Name=BTS_Name
Columns0_Type=utFixedChar
Columns0_Size=25
Columns0_boIndexed=1
Columns0_boPrimaryKey=1
Columns1_Name=Longitude
Columns1_Type=utDouble
Columns1_boIndexed=1
Columns2_Name=Latitude
Columns2_Type=utDouble
Columns2_boIndexed=1
Columns3_Name=BCC
Columns3_Type=utTInt
Columns3_boIndexed=1
Columns4_Name=C0
Columns4_Type=utSInt

Compatible ASCII table

The following ASCII table is compatible with the example 1 *.atd file:

Cell1:1       12.774       50.038       2       814
Cell2:1       12.397       49.991       1       ?
Cell2:2       12.397       49.991       2       807

Example 2 (TETRA-specific ATD file)

*.atd file

[Main]
Type=ATD
[Table1]
; Mandatory
Columns0_Name=UniqueId
Columns0_Type=utULInt
; Mandatory
Columns1_Name=Name
Columns1_Type=utDynChar
Columns2_Name=Power
Columns2_Type=utDouble
Columns3_Name=PosLongitude
Columns3_Type=utDouble
Columns4_Name=PosLatitude
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Columns4_Type=utDouble
Columns5_Name=PosErrorDirection
Columns5_Type=utDouble
Columns6_Name=PosErrorLambda1
Columns6_Type=utDouble
Columns7_Name=PosErrorLambda2
Columns7_Type=utDouble
Columns8_Name=IsDirected
Columns8_Type=utUTInt
Columns9_Name=Direction
Columns9_Type=utUSInt
Columns10_Name=BaseIndex
Columns10_Type=utUSInt
Columns11_Name=Channel
Columns11_Type=utULInt
Columns12_Name=FreqOff
Columns12_Type=utUSInt
Columns13_Name=MNC
Columns13_Type=utUSInt
Columns14_Name=MCC
Columns14_Type=utUSInt
Columns15_Name=LAC
Columns15_Type=utUSInt
Columns16_Name=RxLevelAccessMin
Columns16_Type=utUSInt
Columns17_Name=FastReselThreshold
Columns17_Type=utUSInt
Columns18_Name=FastReselHysteresis
Columns18_Type=utUSInt
Columns19_Name=SlowReselThreshold
Columns19_Type=utUSInt
Columns20_Name=SlowReselHysteresis
Columns20_Type=utUSInt
Columns21_Name=Neighbours
Columns21_Type=utDynChar
Columns_Size=22
File=Tetra.txt
Name=TETRATable

Compatible ASCII table

The following ASCII table is compatible with the example 2 *.atd file:

1;TETRA 1;30.0;11.6;48.11;0.0;0.0;0.0;0;0;3;3615;0;262;1000;6661;1;2;3;4;5;#1
2;TETRA 2;40.0;11.61;48.10;0.0;0.0;0.0;0;120;3;3634;0;262;1000;6658;11;12;13;14;15;#2
3;TETRA 3;20.0;11.7;48.12;0.0;0.0;0.0;0;240;3;3638;0;262;1000;6659;21;22;23;24;25;#3
3;TETRA 4;20.0;11.71;48.105;0.0;0.0;0.0;0;240;3;3750;0;262;1000;6657;21;22;23;24;25;#3
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7.3.1.5  Attributes

The attributes must correspond to the type specified in the table description according
to the following type reference:
Table 7-10: Attributes in an *.atd file

Type Identi-
fier

Description Range / Representation in ASCII table file

utInt 1 byte integer –128 ... 127

utSInt 2 bytes integer –32768 ... 32767

utLInt 4 bytes integer –2147483648 ... 2147483647

utFloat 4 bytes floating point 3.4E-38 ... 3.4E+38 (7 digits)

(decimal or scientific notation)

utUInt 1 byte unsigned integer 0 ... 255

utUSInt 2 bytes unsigned integer 0 ... 65535

utULInt 4 bytes unsigned integer 0 ... 4294967295

UtDouble 8 bytes floating point 1.7E-308 ... 1.7E+308 (15 digits)

(decimal or scientific notation)

utFixedChar Character string of fixed size as
specified by ‚size‘ attribute.

In single quotes or without:

['string'] or [string] (first way is more secure); an
empty string has always to be represented by ''. The
string can be shorter than the given size, but must
not exceed it.

utDynChar Character string of variable size
(variant by record).

Refer to utFixedChar, except that there is no size
limitation other than the 4000 Bytes maximum.

utFixedArray Array of fixed size as specified by
‚size‘ attribute.

Hexadecimal literal, e.g. 0x341a5bc2 for a 4 Bytes
vector; all ‚size‘ bytes have to be specified.

utDynArray Array of variable size (variant by
record);

Hexadecimal literal, e.g. 0x341a5bc2 for a 4 Bytes
vector.

utBlob Large array of variable size (variant
by record); can be bigger than
4000 Bytes.

Not supported in version 3.0.

7.3.1.6  Column names

The column names in an ATD file must be unambiguous to be clearly identified by the
test system. The following names can be used for GSM BTS databases.
Table 7-11: Column names in an *.atd file for GSM BTS

Column Name Type Range Description

UniqueId utULInt 0 to
4294967295

Unique Identifier of the BTS sector for the database
(The easiest way of providing a UniqueId is to use
the line (record) number)

Longitude utDouble –180 to 180 Longitude of the position of the BTS
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Column Name Type Range Description

Latitude utDouble –90 to 90 Latitude of the position of the BTS

BTS_Name utFixedChar – Name of BTS sector

BCC utTInt 0 to 7 decimal BTS Color Code

C0 utSInt See chapter 8 C0 carrier channel number

C1 to C15 utSInt See chapter 8 Cn carrier channel number

CI utLInt 1 to 65535 dec-
imal

Cell Identity

NCC utTInt 0 to 7 decimal Network Color Code

CC utLInt 1 to 65535 dec-
imal

Clock Code

Ant utLInt – Antenna type

Power utFloat See chapter 8 EIRP power

    

MNC utUSInt 0 to 999 Mobile Network Code

MCC utUSInt 0 to 999 Mobile Country Code

LAC utUSInt 1 to 65533

and 65535

Location Area Code

2GNC utDynChar – GSM neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). CI, LAC(MCC, MNC)
for each neighbor cell, a # character separates two
cells, e.g.
1234,5678,262,1#1238,5678,262,1#1240,5678,262,
1

3GNC utDynChar – UMTS neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). MCC, MNC, LAC, CI
for each neighbor cell, a # character separates two
cells, e.g. 262,1,1234,
5678#262,1,1234,5679#262,1,1234,5680

4GNC utDynChar – LTE neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). MCC, MNC, TAC, ECI
for each neighbor cell, e.g. 262,1,1234,
5678#262,1,1234,5679#262,1,1234,5680

Transmitter list OnAir 0

1

-

R&S ROMES4 does not import this string

R&S ROMES4 imports this string

R&S ROMES4 imports this string

The MNC columns through 3GNC are required for the UMTS neighborhood analysis.
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Column Name Type Range Description

UniqueId utULInt 0 to
4294967295

Unique Identifier of the BTS sector for the database
(The easiest way of providing a UniqueId is to use
the line (record) number)

Longitude utDouble –180 to 180 Longitude of the position of the BTS

Latitude utDouble –90 to 90 Latitude of the position of the BTS

BTS_Name utFixedChar – Name of BTS sector

Base_ID utSInt 16-bit number Base station identification

PN utSInt 11-bit number Pilot code channel number

Channel utSInt 11-bit number CDMA channel number

SID utLInt 15-bit number System Identification, a number uniquely identifying
a cellular or PCS system

NID utLInt 16-bit number Network identification, subidentifier of a system

LOCAID utLInt 12-bit number Received location area identity

Power utDouble – Pilot channel power in dBm

Antenna utTInt – Antenna type

Direction utUSInt 0 to 360 Direction of the directed antenna in degrees

The following names can be used for UMTS Node B databases.
Table 7-12: Column names in an *.atd file for UMTS BTS

Column Name Data Type Range Description

UniqueId utULInt 0 to
4294967295

Unique Identifier of the Node B sector for the data-
base (The easiest way of providing a UniqueID is to
use the line (record) number)

PosLongitude utDouble –180 to 180 Longitude of the position of the Node B in degrees

PosLatitude utDouble –90 to 90 Latitude of the position of the Node B in degrees

NodeB_Name utDynChar – Name of Node B sector

CellID utULInt – Cell Identity

SC utUSInt 0 to 8176 Scrambling Code. It must be in the range of 0…
8176, and SC modulo 16 has to be equal to 0

ARFCN utUSInt 8000 to 12000 Channel Number

IsDirected utUTInt 0 to 1 1: Antenna is directed

0: Antenna is omnidirectional

Direction utUSInt 0 to 360 Direction of the directed antenna in degrees

Power utDouble –10 to 100 Power of CPICH in dBm

    

CellIDNeigh-
borsList

utDynChar – Information about the cell identities of the neighbor
cells; list of numbers separated by # characters, e.g.
67#861#14558.
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Column Name Data Type Range Description

    

MNC utUSInt 0 to 999 Mobile Network Code

MCC utUSInt 0 to 999 Mobile Country Code

LAC utUSInt 1 to 65533

and 65535

Location Area Code

2GNC utDynChar – GSM neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). MCC, MNC, LAC, CI
for each neighbor cell, a # character separates two
cells, e.g. 262,1,1234,
5678#262,1,1234,5679#262,1,1234,5680

3GNC utDynChar – UMTS neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). MCC, MNC, LAC, CI
for each neighbor cell, a # character separates two
cells, e.g. 262,1,1234,
5678#262,1,1234,5679#262,1,1234,5680

4GNC utDynChar – LTE neighbor cell list for neighborhood analysis
(option R&S ROMES4HOA). MCC, MNC, TAC, ECI
for each neighbor cell, e.g. 262,1,1234,
5678#262,1,1234,5679#262,1,1234,5680

In UMTS NodeB databases, the columns "UniqueID" to "Power" are mandatory. The
"CellIDNeighborsList" column is optional but is also recognized by the measurement
system. If it is provided, the R&S ROMES4 checks for differences between the entries
and the real network. Each time the UMTS test mobile fails to detect the signal from
one of the neighbor cells in the list, a "Neighbor List Alarm" is generated. The alarms
can be displayed, e.g. in the "UMTS Network Analyzer View".

For the UMTS neighborhood analysis, the rows from MNC to 4GNC are required.

In general, R&S ROMES4 is not able to process data in columns with user-defined
names other than the ones listed above. The UniqueID parameter is explained in
Chapter 7.3.1.9, "Speeding up the import file", on page 2175 below.

7.3.1.7  Missing entries

If a value to be entered in the ASCII table file is not available, a question mark (?) can
be used instead. R&S ROMES4 interprets question marks as missing entries, the cor-
responding table cells in the views and dialogs of the application are left empty.

7.3.1.8  ATD file modification

ATD file describes structure of importing TXT file. The changes which must be imple-
mented are shown in the following table.
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Table 7-13: Columns - fields and values

Field and Value What does it mean

Columns_Size=35 Number of columns in the text file (“;” uses as sepa-
rator of fields.

Columns33_Name=3GNC

Columns33_Type=utDynChar

Column N 33 (3G neighbor) and type of this column

Columns34_Name=4GNC

Columns34_Type=utDynChar

Column N 34 (4G neighbor) and type of this column

7.3.1.9  Speeding up the import file

The R&S ROMES4 has to assign numbers to all lines of the BTS lists every time the
list is opened. This time-consuming line numbering can be bypassed by adding the
"UniqueID" column to the BTS list. The "UniqueID" entries (e.g. 1, 2, 3, ... ) can be
added with a tool like MS Excel.

Example: Modification of the ATD file
Columns12_Name=UniqueID
Columns12_Type=utLInt
Columns12_Size=4
Columns12_boIndexed=1
Columns12_boPrimaryKey=0

All numbers in the UniqueID column must be unique. Any number that is used more
than once causes problems. Use a unique scheme like the line numbers from MS
Excel to fill the UniqueID column.

7.3.1.10  TETRA-specific *.atd requirements

All columns not specified in the following table are added to the database for informa-
tion only.
Table 7-14: Mandatory columns for all cells

Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

Name utDynChar Yes Yes Name of Cell

Longitude utDouble No Yes Geo. Position Lon-
gitude

Latitude utDouble No Yes Geo. Position Lati-
tude

The columns in the following table describe the cell in more detail. If the importer does
not use the default values, they have to be available.
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Table 7-15: Cell details

Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

Power utDouble No No Max Tx. Power of
Cell – Default: 30
dBm

IsDirected utUTInt No No Type of Antenna, 1:
directed, 0: omni –
default: omni

Direction utUSInt No No Direction of
Antenna, manda-
tory for Antenna ==
1

The following tables show the TETRA transmitter-specific columns and parameters.

The first table shows the mandatory columns and parameters for a TETRA transmitter
as they identify the cell.
Table 7-16: Mandatory columns in TETRA transmitter database

Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

BaseIndex1) utUSInt No No Frequency Base
Index (1..9)

Channel utULInt Yes Yes TETRA Channel
Number (0…3999)

FreqOff1) utUSInt No No Frequency Offset

0: 0 KHz: all texts
in R&S ROMES4
show the value 0
KHz

1: 6.25 KHz: all
texts in R&S
ROMES4 show the
value 6.25 KHz

2: -6.25 KHz: all
texts in R&S
ROMES4 show the
value -6.25 KHz

3: 12.5 KHz: all
texts in R&S
ROMES4 shows
the value 12.5 KHz

MNC1) utUSInt No Yes Mobile Network
Code

MCC1) utUSInt No Yes Mobile Country
Code
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Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

LAC utUSInt Yes Yes Location Area
Code

1) Also these values are required. As they are usually the identical for all cells in the list, they are not put
into the list. The import dialog allows the user put in these values directly into the GUI. If nothing is put in,
the columns are mandatory in the list.

The following table shows the columns and parameters which are optional for a
TETRA transmitter.
Table 7-17: Optional columns in TETRA transmitter database

Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

RxLevelAccessMin utUSInt No No RxLevelAccessMin
(0..31)

FastReselThres-
hold

utUSInt No Yes FastReselThres-
hold(0..31)

FastReselHystere-
sis

utUSInt No Yes FastReselHystere-
sis(0..31)

SlowReselThres-
hold

utUSInt No Yes SlowReselThres-
hold(0..31)

SlowReselHystere-
sis

utUSInt No Yes SlowReselHystere-
sis(0..31)

Neighbours utDynChar No No Neighbors,

specified by the
MCC,MNC,LAC
and the Channel-
Number

MCC and MNC are
optional

The values are
separated by, and
the transmitters by
a #

e.g.
262,112,1234,1002
#262,112,1254,100
5#

e.g. ,,1234,1002#,,
1245,1008#

The description of the identifier "Neighbours" is not evaluated at the moment. Anyway,
it is recommended to use this format at later implementation.

7.3.1.11  LTE-specific *.atd requirements

The following table shows the mandatory columns and parameters for a LTE transmit-
ter as they identify the cell.
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Table 7-18: Mandatory columns for LTE transmitter database

Identifier Data Type Default Short Info
Text

Default Long Info
Text

Description

UniqueId utUSInt No No Unique Identifier

eNodeB_Name uTDynChar Yes Yes eNodeB Name

PosLongitude utDouble No No Longitude

PosLatitude utDouble No No Latitude

PhyCellID utUSInt No No Physical Cell Iden-
tity

CellID utULInt Yes Yes Downlink Cell Iden-
tity

EARFCN utULInt No No Evolved Absolute
Radio Frequency
Channel Number

IsDirected utUTInt No No Type of Antenna

1: Antenna is direc-
ted

0: Antenna is omni-
directional (=
default)

Direction utUSInt No No Direction of
Antenna, manda-
tory for Antenna ==
1

Power utDouble Yes Yes Power in dBm

7.3.1.12  5G NR specific *.atd requirements

The following table shows the mandatory columns and parameters for a 5G NR trans-
mitter as they identify the cell.
Table 7-19: Mandatory columns for 5G NR transmitter database

Column No. Identifier Data Type Description

2 PosLongitude utDouble Geo Position Longitude

3 PosLatitude utDouble Geo Position Latitude

5 MCC utUSInt Mobile Country Code

6 MNC utUSInt Mobile Network Code

9 NRARFCN utULInt Evolved Absolute Radio Fre-
quency Channel Number

10 NCI utULInt Cell Identity
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Table 7-20: Optional columns for 5G NR transmitter database

Column No. Identifier Data Type Description

11 IsDirected utUTInt Type of Antenna

1: Antenna is directed

0: Antenna is omnidirectional (=
default)

12 Direction utUSInt Direction of Antenna, mandatory
for Antenna == 1

13 PhyCellID utUSInt Physical Cell Identity

8 CellID utULInt Downlink Cell Identity

0 Technology utUSInt RAT this cell belongs to

1 Name utDynChar Name of Cell

4 PosAltitude utDouble Geo Position Altitude

7 TAC uiULInt Tracking Area Code

14 Power utDouble Power in dBm

For 5G NR, the CellID is calculated from the last 8 bits of NCI.

Figure 7-57: 5G NR CellId standard definition

7.3.2  Technology dependencies

GSM
The following columns identify a GSM cell. Those columns are mandatory for a GSM
cell.
Table 7-21: Mandatory columns for all GSM cells

Identifier Required/
Optional

Description Remarks

BCC req. Base Station Color Code 0 to 7 decimal

NCC req. Network Color Code 0 to 7 decimal

CI req. Cell ID 1 to 65535 decimal

C0 req. Channel 0 (BCCH) -

MNC1) req. Mobile Network Code 0 to 999
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Identifier Required/
Optional

Description Remarks

MCC1) req. Mobile Country Code 0 to 999

1) Also these values are required. As they are usually the identical for all cells in the list, they are not put
into the list. The import dialog allows the user put in these values directly into the GUI. If nothing is put in,
the columns are mandatory in the list.

The following columns are not mandatory, but is used if available:
Table 7-22: Optional columns for GSM cells

Identifier Required/
Optional

Description Remarks

C <n> opt. Traffic Channels 1...n -

CC opt. Clock Code -

SyncCode opt. Synchronization Code -

UMTS
The following columns identify a UMTS cell.
Table 7-23: Mandatory columns for all UMTS cells

Identifier Required/
Optional

Description Remarks

SC req. Scrambling Code 0 to 8176

Must be in the range of 0…8176, and
SC modulo 16 has to be equal to 0

UARFCN req. UTRA Absolute Radio Fre-
quency Channel Number

-

CI req. Cell Identity -

MNC1) req. Mobile Network Code 0 to 999

MCC1) req. Mobile Country Code 0 to 999

1) Also these values are required. As they are usually the identical for all cells in the list, they are not put
into the list. The import dialog allows the user put in these values directly into the GUI. If nothing is put in,
the columns are mandatory in the list.

CDMA
The following columns identify a CDMA cell.
Table 7-24: Mandatory columns for all CDMA cells

Identifier Required/
Optional

Description Remarks

PN req. PN Offset -

Channel req. Channel Number -

Bandclass req. Band Class -

SID1) req. System ID -
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Identifier Required/
Optional

Description Remarks

NID1) req. Network ID -

LOCAID req. Location Area ID -

1) Also these values are required. As they are usually the identical for all cells in the list, they are not put
into the list. The import dialog allows the user to put in these values directly into the GUI. If nothing is put
in, the columns are mandatory in the list.

The following column is not mandatory, but is used if available.
Table 7-25: Optional columns for CDMA cells

Identifier Required/
Optional

Description Remarks

EVDO opt. 0: no 1xEV-DO cell

1: 1xEV-DO cell

-

WiMAX
The following columns identify a WiMAX cell.
Table 7-26: Mandatory columns for all WiMAX cells

Identifier Required/
Optional

Description Remarks

CentreFre-
quency

req. Centre Frequency -

Bandwidth req. Bandwidth -

PreambleIn-
dex

req. Preamble ID -

BaseID req. Base Station ID (6 Bytes) -

Segment req Segment Number -

IDCell req ID Cell -

LTE
The following columns identify a LTE cell.
Table 7-27: Mandatory columns for all LTE cells

Identifier Required/
Optional

Description Remarks

CellID req. Downlink Cell Identity -

EARFCN req. Evolved Absolute Radio Fre-
quency Channel Number

-

PhyCellID req. Physical Cell Identity -

UniqueId req. Unique Identifier Unique Identifier of the BTS sector
for the database (The easiest way
of providing a UniqueID is to use
the line (record) number)
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TETRA
The following columns identify a TETRA cell.
Table 7-28: Mandatory columns for all TETRA cells

Identifier Required/
Optional

Description Remarks

BaseIndex req. Frequency Base Index 1..9

Channel req. TETRA Channel Number 0…3999

FastResel-
Threshold

req. Fast Reselection Threshold 0..31

FreqOff req. Frequency Offset 0: 0 KHz: all texts in R&S ROMES4
show the value 0 KHz

1: 6.25 KHz: all texts in R&S
ROMES4 show the value 6.25 KHz

2: -6.25 KHz: all texts in R&S
ROMES4 show the value -6.25
KHz

3: 12.5 KHz: all texts in R&S
ROMES4 show the value 12.5 KHz

LAC req Location Area Code 1 to 65533 and 65535

MCC1) req. Mobile Country Code 0 to 999

MNC1) req. Mobile Network Code 0 to 999

RxLevelAc-
cessMin

req. RX Level Access Minimum 0..31

UniqueId req. Unique Identifier Unique Identifier of the BTS sector
for the database (The easiest way
of providing a UniqueID is to use
the line (record) number)

1) Also these values are required. As they are usually identical for all cells in the list, they are not put into
the list. The import dialog allows the user to put in these values directly into the GUI. If nothing is put in, the
columns are mandatory in the list.

The following column are not mandatory, but will be used if available.
Table 7-29: Optional columns for TETRA cells

Identifier Required/
Optional

Description Remarks

Neighbour-
CellParame-
ters

opt. Neighbours, specified by the
MCC, MNC, LAC and the Chan-
nelNumber.

-

7.3.3  CSV format definition for BTS list

The CSV export accepts the formats for BTS lists given in the following table. The
meaning of the m/o abbreviation is mandatory and optional, respectively.
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Table 7-30: GSM, UMTS, LTE and 5G CSV format definition table

Column Name (Identifier) m/o Description Accepted Format

CellType m Specifies the type of the cell OperatorDefined: The cell
has been imported from an oper-
ator's cell data base file.

UserDefined: The cell has
been entered manually .

Estimated: The cell has been
estimated.

NCI m 5G only: Cell Identity integer number

Technology m RAT this cell belongs to GSM, gsm, Gsm (case insensi-
tive)

UMTS, umts, Umts (case
insensitive)
5GNR, NR, 5G

TxName o Name of the cell Text

ValidStart m Point in time from when this cell
is considered valid

yyyy-MM-ddThh:mm:ss
(e.g. 2015-08-05T08:00:00, see
ISO8601)

ValidEnd o Point in time until this cell is
considered valid

yyyy-MM-ddThh:mm:ss
(e.g. 2016-08-05T07:59:59, see
ISO8601)

MCC m Mobile Country Code Integer number

MNC m Mobile Network Code Integer number

LAC m GSM / UMTS only: Location
Area Code

Integer number

TAC m/o LTE / 5G: Tracking Area Code Integer number

ENodeBID m LTE only: LTE eNB ID Integer number

CellID m GSM/UMTS: CID

LTE: LTE Cell ID

5G: CID

Integer number

Downlink Channel Number m GSM: BCCH

UMTS: UARFCN

LTE: EARFCN

5G: NRARFCN

Integer number

Physical Cell Identifier m GSM:
● BCC
● NCC

UMTS: SC

LTE / 5G: PCI

Integer number

Bandwidth o Bandwidth of a cell, usually only
relevant for LTE cells.

Floating point number [MHz]
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Column Name (Identifier) m/o Description Accepted Format

TechExtension o Technology extension Common: unknown, none

GSM only: GPRS, EGPRS

UMTS only: HSDPA, HSUPA,
HSPA, HSPA+

LTE only: LTEAdvanced

TrafficChannels o GSM only: ARFCNs of traffic
channels, separated by #

Integer numbers, separated by #

BSC o GSM only: base station control-
ler this cell belongs to

Text

RAC o GSM / UMTS only: Routing
Area Code

Integer number

MSN o Mobile Subscriber Number Text

RNC o UMTS only: Radio Network
Controller

NOTE:
The name of the RNC, given by
operators, available only if an
operator's cell database is
imported

Text

RNC_ID o UMTS only: Radio Network
Controller Identifier

Integer number

RepeaterID o Repeater ID Integer number

GeoLong m Longitude of the cell's geo loca-
tion in WGS 84

Integer number [m]

GeoLat m Latitude of the cell's geo loca-
tion in WGS 84

Integer number [m]

GeoAlt m Altitude of the cell's geo location
in WGS 84

Integer number [m]

AntennaDir o Antenna direction / azimuth

Today the reference plane for
an azimuth is typically true
north, measured as a 0° azi-
muth.

Moving clockwise on a 360° cir-
cle, east has azimuth 90°, south
180°, and west 270°.

Floating point number [°]

AntennaPower o Power of the antenna Text

AntennaType o Type of antenna Text

Manufacturer o Antenna / or base station manu-
facturer

Text

ElectricalTilt o Electrical tilt of the antenna Floating point number [°]

MechanicalTilt o Mechanical tilt of the antenna Floating point number [°]

HeightAboveGround o Height of antenna above
ground

Floating point number [m]
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Column Name (Identifier) m/o Description Accepted Format

GSMNeighbours o GCIs of GSM neighbors, sepa-
rated by #

MCC MNC LAC CI#...

MNC LAC CI#...(MCC taken
from the column Mcc)

LAC CI#...(MCC and MNC is
taken from column Mcc and
Mnc)

UMTSNeighbours o GCIs of UMTS neighbors, sepa-
rated by #

MCC MNC LAC CI#...

MNC LAC CI#... (MCC taken
from column Mcc

LAC CI#...(MCC and MNC taken
from column Mcc and Mnc)

LTENeighbours o GCIs of LTE neighbors, separa-
ted by #

MCC MNC ENodeBId CellSu-
bId#...

MNC ENodeBId CellSubId#...
(MCC taken from column Mcc)

ENodeBId CellSubId#...(MCC
and MNC take from columns
Mcc and Mnc)

ErrorEllipseAzimuthOfLarge-
HalfAxis

o Estimated cells only: the azi-
muth of the large half axis of the
error ellipse

Floating point number [°]

ErrorEllipseLargeHalfAxis o Estimated cells only: the length
of the large half axis of the error
ellipse

Floating point number [m]

ErrorEllipseSmallHalfAxis o Estimated cells only: the length
of the small half axis of the error
ellipse

Floating point number [m]

Classification o Classification of the cell NotClassified: The cell has
not been classified.

Good: The cell has been classi-
fied as good.

Bad: The cell has been classified
as bad.

Metric o Metric that is related to the clas-
sification

Floating point number with preci-
sion of 0.01.

7.3.4  User-defined BTS list format

Instead of using the TXT and ATD formats described in the previous sections, define
your file formats for the BTS list. To distinguish from the standard BTS list formats, the
user-defined BTS list formats must have file extensions different from *.txt or
*.atd. Also, a dynamic link library (DLL) with the name GSS_K6_Import_xxx.dll
must be written, where xxx is the extension of the files' format.

The DLL must contain a class (e.g. Import), derived from the following abstract class
AsciiImport:
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class AsciiImport
{ public:
  enum NEXT_LINE_STATUS {SECTOR_VALID, SECTOR_INVALID, END_OF_FILE, SKIP_SECTOR};
      AsciiImport(){};
      virtual ~AsciiImport(){};
      // Open the file "pFilename":
      virtual bool Start(char* pFilename) = 0;
      // load next sector:
      virtual NEXT_LINE_STATUS NextSector(char** ppErrorString) = 0;
      // number of the sector in the Ascii file
      virtual unsigned int* GetSectorNr() = 0;
      virtual char *GetSectorName() = 0;           // Name
      virtual double* GetLongitude() = 0;          // Longitude
      virtual double* GetLatitude() = 0;           // Latitude
      virtual unsigned short* GetBCC() = 0;        // Base station color code
      virtual unsigned short* GetChannelArray(int index) = 0;
   // index = 0 points to the C0 carrier
            // index points to TCH index
      virtual unsigned int* GetCI() = 0;           // Cell Identity
      virtual unsigned int* GetNcc() = 0;          // National color code
      virtual unsigned int* GetClockCode() = 0;    // ClockCode
      virtual double* GetPower() = 0;              // EIRP
      virtual unsigned int* GetAntennaType() = 0;  // Antenna type
      virtual double* GetDirection() = 0;          // Direction of the antenna
      virtual unsigned int* GetSyncCode() = 0; // Synchronisation Identification
      virtual unsigned short* GetLAC() = 0;             // Location area code
      virtual unsigned short* GetMNC() = 0;             // Mobile network code
      virtual unsigned short* GetMCC() = 0;             // Mobile country code };

The file is installed in the Installation subdirectory of the main directory.

The file line status is explained in the following.
● The function bool Start(char* pFilename) opens the ASCII file. The return

value is "true“, if the file could be successfully open. If the return value is "false" the
program returns to the calling menu.

● NEXT_LINE_STATUS
Each call of the function NEXT_LINE_STATUS NextSector(char**
ppErrorString) loads the next sector, or the first one if it is called after
Start(char* pFilename) has been called.

● END_OF_FILE
When the return value is END_OF_FILE, the DLL is deallocated and the loading of
the operator information is considered to be finished.

● SECTOR_VALID
The return value SECTOR_VALID implies that the sector has been loaded success-
fully. In this case there must be access to its data via the remaining functions point-
ing to them. The name of the sector, its geographical position, BCC and C0 carrier
(obtained by the value of GetChannelArray(0)) and the sector number are
mandatory. The sector number is necessary to monitor possible inconsistencies in
the data. The remaining values are for additional information. If some of the latters
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are not included in the sector information, the corresponding access functions must
return the NULL pointer.

● SECTOR_INVALID
The return value SECTOR_INVALID is used to indicate an error in loading the sec-
tor. An error message is displayed including a message in a character string, to
which ppErrorString points. The memory of this character string must be
defined and allocated in the DLL and the content of this string can be specified
arbitrarily. After that error message, the loading of the operator information is stop-
ped and the sectors already loaded are canceled.

● SKIP_SECTOR
The return value SKIP_SECTOR can be used to skip a sector if, e.g., the sector
contains some invalid data and is not loaded. However, the program does not stop
loading the base station list but reads the next sector instead. A message is written
into the file CtoI_Reports.txt stored in the "TestFiles" subdirectory.

The declaration of exported DLL functions is realized via the file Import_xxx.def,
where xxx has to be replaced by the file following extension.

LIBRARY IMPORT_xxx.DLL
DESCRIPTION "Reading the operator info of the BTS stations"
EXPORTS
ImportConstruction    @1
ImportDestruction    @2

● ImportConstruction
ImportConstruction is a function which takes no arguments. It allocates mem-
ory for the class "Import" and returns a pointer to this memory.

● ImportDestruction
ImportDestruction is a function taking a reference to a pointer to "Import" as
an argument and deleting the allocated memory. The return value of this function is
of type void.

Example: 
The following example of the corresponding DLLStart.cpp is a possible realization
of the *.txt format file.

# include "ImportTxt.h"
ImportTxt* ImportConstruction()
{    return (new ImportTxt()); }
void ImportDestruction(ImportTxt* & Import)
{     if(Import != NULL)
          delete Import; }

The ImportTxt.h is the header file declaring the class.
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7.4  Obtaining screenshots

R&S ROMES4 fully supports the "Print Screen" functionality familiar from many other
MS Windows applications. The contents of all views can be printed to a file or sent to a
printer; an extended selection of print options is available. In addition, all pages can be
previewed before they are sent to the printer.

If you still wish to obtain an accurate copy of your application screen, there are differ-
ent ways to obtain screenshots:
● To copy a view to the clipboard, available is for all views the "Copy to Clipboard"

function via the "Configuration Menu" (right mouse click).
● Via "File Print/Print Preview" it is possible to print everything what is visible in the

"View Area". The function adds date and name of the measurement file.
● Copy the whole screen to the clipboard (<PrtSc>) or
● Copy the active window to the clipboard (<Alt> + <PrtSc>)

In R&S ROMES4, the active window is always the frame application, not the individual
views which are so-called child windows. Use the "Copy to Clipboard" Function for a
specific view.

Now you can switch to another MS Windows application (<Alt> + <TAB>), like MS
Word or MS PowerPoint, and insert the screenshot via <Shift> + <Insert>. From
this application, you can also obtain hardcopies. All the screenshots in this documenta-
tion are created this way.

7.5  Basic report

R&S ROMES4 fully supports generating the basic reports for views. A basic report can
be generated from the available views.

R&S RF power scan view
For technical reasons, the Spectrum History of the selected sweep is empty in the gen-
erated report.

1. Select the "Report" menu entry in the "Tools" menu.
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Figure 7-58: Select Tools - Report

2. The "HTML Report" dialog opens where you can specify the target directory and
the name of the report.

Figure 7-59: Report dialog window
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A specified directory stores the measurement report. The folder name is the combi-
nation of target directory and name of the report. The dialog offers all active views
by default. Disable the views which are not part of the report.

"Name" Enter a name for a new folder where to save the report file.

"Target Directory" Enter or select via "..." the output directory of the report. The system
always creates also a new directory in the entered directory.

The name of the additional directory is the target directory. The name
of the report file is the combination of the name of the target directory
and the name of the report.

"Available Views" All active views are shown and by default selected. Deselect the views
that have not to be part of the report.

"Open Report in Browser" To show the generated report in the browser, check the box.

3. After entering and selecting the desired options in the "View" dialog, click "OK".

The report is generated.

If "Open Report in Browser" was selected, the current default browser opens automati-
cally and shows the generated report.

Figure 7-60: Generated reports are shown within default browser

The HTML report normally resizes the views to make the screenshot for the HTML
report. For several reasons this resizing method does not work for the "Route Track
View". The HTML report is adapted, so that the screenshot is taken from the "ROMES-
MAP Route Track View" as it is at the point in time, when the report is generated.

Basic report
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7.6  Evaluation of KML/KMZ data with Google Earth

After finishing the export, you can view the newly created kmz/kml file using the Goo-
gle Earth application, which you can download for free.

7.6.1  Load exported files in Google Earth

Prerequisite:

Google Earth is installed on the local PC.

Procedure:

1. Double click on the *.kml/kmz file to open and view it in Google Earth.

2. Opening a file creates a directory under the Places window with the same name as
the file. This folder contains two subfolders, namely one for the GPS data and one
for the exported signals.

Figure 7-61: Activate Places

7.6.2  Visualize data

Display GPS Data at Google Earth

1. Activate the GPS Data to visualize it on the map.

Evaluation of KML/KMZ data with Google Earth
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Figure 7-62: Activate GPS Data

Figure 7-63: Display GPS Data

2. The viewer automatically displays and centers all the available GPS data. Each
GPS measurement is shown as a blue diamond and if you zoom in, you can follow
the path traveled, which is connected by white lines.

Evaluation of KML/KMZ data with Google Earth
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Figure 7-64: Click on a GPS entry to view more information.

Explore GPS position information

► Click on an individual GPS placemark to explore its position information and the
time at which the measurement was taken (relative to the R&S ROMES4 timer).

Figure 7-65: Click on a GPS entry to view more information

Visualize measured signal with placemarker

► To display a signal, simply click one from the Signals subfolder.

Figure 7-66: Activate Signal

Evaluation of KML/KMZ data with Google Earth
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Tip: View multiple signals at once
Only one signal can be viewed at a time for visibility reasons; to display multiple
signals at the same time, export them to different files and open them in Google
Earth simultaneously.

After clicking on a signal, its placemats are shown.

Figure 7-67: Display signal with placemarker

The height of the placemark represents the level of the signal measured at that
given point. All signals are mapped linearly to the same interval from ground level
to the maximum height as chosen before during R&S ROMES4 export.

Figure 7-68: Display signal with placemarker, detailed

Color setting of a signal
The maximum, minimum and color of the signal are acquired from the R&S ROMES4
settings.

Evaluation of KML/KMZ data with Google Earth
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Disable the terrain level
The height of the placemarks is relative to ground level, it is thus recommended to dis-
able the terrain level in Google Earth to make the visualization more accurate.

Inspect specific signal values

► Click a signal placemark to inspect the actual signal value measured at that GPS
position. Notice that information about all signals is always available, even if only
one signal is displayed.
To go to a specific placemark or to activate or deactivate single ones, it is also pos-
sible to access them by expanding the signal subfolder.

Figure 7-69: Placemark for every measured single signal

Evaluation of KML/KMZ data with Google Earth
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8  Installation instructions R&S ROMES4
This chapter explains how to install and uninstall R&S ROMES4 and third-party utilities
that might be useful or necessary for the operation of some R&S ROMES4 compo-
nents.

● Installation R&S ROMES4.................................................................................. 2196
● Uninstall R&S ROMES4......................................................................................2216
● Directory structure R&S ROMES4...................................................................... 2223
● Operating R&S ROMES4 without local administration rights..............................2224

8.1  Installation R&S ROMES4

R&S ROMES4 is software running on a controller with MS Windows operating system.

R&S ROMES4 offers the installation process execution on command line in a silent
mode. For more details, see Chapter 8.1.8, "Unattended install process",
on page 2213.

The distributed R&S ROMES4 software is organized in several directories:
● "AddOns" provides various applications and utilities for R&S ROMES4, for exam-

ple, QualiPoc Converter and LicenseServerGui.
● "Documents" provides the current version of the R&S ROMES4 help manual in

CHM format and the "ONF Overview" document of the R&S ROMES4 version-rela-
ted features within the service pack.

● "Firmware & Drivers" provides the WiBu software for manual installation (only rele-
vant if the automatic installation fails).

● "ROMES" contains the ROMES dependencies installer and the ROMES installer as
a service pack.
Note that the service packs have to be installed manually during Initial Setup. The
service pack can be installed from any location on the target computer, because
the required R&S ROMES4 installation directory is obtained from the MS Windows
registry.

● "runtime" contains installation versions of the third-party utilities.
Table 8-1: Available devices

Devices for ... Purpose Installation file Reference

Edgeport USB to
8Serial Converter

Edgeport/8 301-1002-08 USB
to 8xserial Converter

Edgeport USB to 8Serial
Converter\ip4n5340.exe

Edgeport USB to 8Serial
Converter\Readme.txt

GPS Receiver Various GPS receivers with
USB interface

GPS Receiver\...\...\
*.exe

GPS Receiver\...\*.pdf

Qualcomm Chipset USB devices Qualcomm chip-
set-based mobiles (Qual-
comm, Samsung,…)

\Test Mobiles\*.exe \Test Mobiles\...
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Devices for ... Purpose Installation file Reference

Sound Cards Sound Cards used for Speech
Quality measurements (SQA)

\Sound Cards\...\
*.exe (or *.zip)

\Sound Cards\...

WiBu CodeMeter Device for hardlock \Firmware & Drivers\
WiBu\
CodeMeterRuntime64.64.exe

-

R&S ROMES4 supports WIBU licensing concept, enabling software licensing. WIBU
licensing is needed also for SmartONE cross-licensing.

The license information and optional reconfiguration are available in the "License Info"
dialog.

R&S ROMES4 and SmartBenchmarker can be integrated.

R&S ROMES4 supports multiple WiBu firm-codes for both R&S ROMES4 and Smart-
Benchmarker. This support simplifies and optionally automates installation,

For multiple WiBu firm code support, see Chapter 8.1.5, "Multiple WiBu firm-codes
support", on page 2208.

8.1.1  ROMES installer

R&S ROMES4 is installed with the SmartONE installer. The SmartONE installer uses
the ROMES installer and the ROMES dependencies installer.

The ROMES Dependencies Installer installs Microsoft redistribution kits, Mapdata and
SafeNet hardlock device. The Microsoft redistribution kits 2017 and the Codemeter are
installed by the SmartONE installer and no more installed by the ROMES installer
because both R&S ROMES4 and SmartBenchmarker use this software.

The standalone usage of the ROMES installer is not possible. The DVD surface is not
available.

Use the Windows Explorer to navigate through the content of the delivered package.

8.1.1.1  Tech selector

The SmartONE installer is not used to choose technologies to be displayed in the R&S
ROMES4 tool.

Technologies to be displayed are selected after the first start of R&S ROMES4.

After Initial Setup, if registry entry General\FRESH_INSTALLATION exists and the
value is 1, the Tec Selector is launched and you can choose technology modules to be
loaded.

Installation R&S ROMES4
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Figure 8-1: Technologies to select after Tec Selector launching

For the function of the "Set All Defaults (and hide a subsequent initialization dialogs)"
flag, see Note.

If "OK" is selected, the following message is shown.

Figure 8-2: Message dialog for installation change

After running the Tech Selector, the registry entry General\FRESH_INSTALLATION is
set to 0. The Tec Selector runs as needed.

If R&S ROMES4 is running in a remote controlled mode, the Tec Selector does not run.
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8.1.1.2  License configuration

The existance of the WiBu license is detected during the R&S ROMES4 setup. If the
license is detected, the system uses it and there is nothing to configure.

If the license is not detected, the following message pops-up.

Figure 8-3: Warning message offering Read Only mode

If you click "Yes", R&S ROMES4 continues in "Read only" mode.

WiBu license can be available in two manners, installed on the PC as a soft-license or
stored on a WiBu license dongle.

If a WiBu soft-license is in use, the following actions break/corrupt the WiBu license
container, making the measurement software unusable:

1. R&S TSMA6/TSMA6B - Reset to factory default, restore of a user backup or image
installation.

2. PC - Backup&Restore

Refer to the "R&S ROMES4_WIBU_LicenseManagement manual - 6. Troubleshooting"
in case any kind of restore or image installation is necessary or the license container is
already broken.

The "License Overwiew" > "Found Sales Options" shows the installed licenses. The
PESQ license is the only license that can be modified, see Chapter 3.10.4, "Licenses",
on page 419.

Replay

R&S ROMES4 continues with the Replay mode when you run R&S ROMES4 if WiBu
license is not available and you select the "Yes" option shown in the previous screen-
shot.

8.1.2  Installing R&S ROMES4 basic software

A setup program controls the software installation. All necessary settings are config-
ured automatically during the installation process. The assumption is that you already
have stored the R&S ROMES4 package on your machine.

Installation R&S ROMES4
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Perform the following steps:

1. Turn on your machine and start your MS Windows operating system.

2. If the program Hardcopy is running on your machine, stop the program.

3. Start the Romes_setup-<version>.exe program in the subdirectory "ROMES".
The R&S ROMES4 service pack installation wizard opens with a startup screen.

Figure 8-4: R&S ROMES4 installation - start

4. Click "Next" to start the installation. The "License Agreement" window opens.

Figure 8-5: R&S ROMES4 installation - accept agreement

5. Before proceeding to the next step, read the user license agreement carefully.
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6. Click "I Agree" to accept the user license agreement and to continue the installa-
tion.

7. Check the desired components for installation. It is safe to accept the default selec-
tion, shown in the following figure.

Figure 8-6: Selection of R&S ROMES4 components - default

Click "Next" to confirm your selection.

8. The "Choose Install Location" window opens.

Figure 8-7: Selection of R&S ROMES4 install location - default

9. Select the desired destination folder for R&S ROMES4 installation. The installer
checks for previous R&S ROMES4 installations. If one is found, the installer copies
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the path to the installation directory and offers this path as the installation location.
Otherwise, the default C:\Program Files\Rohde-Schwarz\ROMES<release> direc-
tory is offered. Click "Next".

10. After installing the components, the R&S ROMES4 installation continues.

Figure 8-8: R&S ROMES4 is installing

11. The window opens showing that the installation was successful.
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Figure 8-9: R&S ROMES4 installation - completed

The installation completion is reported.

12. Click "Next" to finish the installation.

The R&S ROMES4 SW is installed on your computer and the set up is completed.
Click "Finish" to verify the installation and close the wizard.

If you abort any of the subinstallers, the R&S ROMES4 installation also terminates.

The system reboot is mandatory after installation.

8.1.2.1  Installing components

It is safe to accept the default entries shown in the "Choose Components" window dur-
ing the basic R&S ROMES4 installation.

The default installation options in the "ROMES" branch are:

● ROMES - the basic R&S ROMES4 installation
● ROMESMapServer
● CellDataBaseServer
● QualiPoc Installation
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The "Auxilary Files" branch contains the Firewall installation option by default. The
installation runs silently. No user interface is shown.

During the startup of the installer, R&S ROMES4 checks whether the components are
already installed or need to be installed. The "Choose Component" window shows this
information. If a component in the branch is not installed, the check box of the branch
is checked and grayed.

If you abort any of the subinstallers, R&S ROMES4 installation also terminates.

Installing registry

This component is enabled for R&S ROMES4 installation and cannot be disabled by
the user. During the registry installation, R&S ROMES4 is registered at Windows and
the registry settings needed by R&S ROMES4 are installed.

The component is mandatory for any new installation or update.

Installing IEC API

This API is installed silently. No user interface is shown.

8.1.3  Installing ROMES dependencies

To install some of the R&S ROMES4 supported dependent components, proceed as
following:

1. Click the RomesDependencies_setup-<version>.exe.

The opening "ROMES Dependencies <version> Setup" page is shown followed by
the agreement page.

2. Click "I Agree" to proceed.

The "Choose Component" page opens letting you select the components you want
to be installed.
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Figure 8-10: ROMES Dependencies - selecting components

3. Select the wanted components.

4. Click "Next".

The installation process starts, showing the progress. At the 100% progress, the
page about successful installation is shown.

5. Click "Next", to get the final page, click "Finish" to verify the installation.

8.1.3.1  Installing 3rd party

Libraries and utility programs such as the MFCxxx libs from Microsoft belong to this
group.

Visual Studio runtime

Microsoft Visual Studio <version> C++ Runtime Library is installed silent. No user inter-
face is shown.

1. During installation, a license agreement window appears.
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Figure 8-11: VC2005 agreement

2. Click "Yes" to continue.

The library is installed. The ROMESDependencies installation continues to install
the next component which is selected in the "Choose Component" window.

8.1.3.2  Auxiliary files

Check the "AtlControls" entry in this group. 

This controller is installed silently. No user interface is shown.

8.1.4  R&S ROMES4 initial setup and configuration

The Initial Setup is used to simplify the installation and potentially automate the instal-
lation. It runs in silent mode, no message or progress information is displayed. If error
occurs, the error is written in romes.log file.

8.1.4.1  Initial setup

If the folder C:\Users\UserName\Documents\My ROMES\InitialSetup exists, files in this
folder are copied or imported when R&S ROMES4 starts. The UserName in the folder
path is the user login name.

The following is valid:
● Home Directory is the folder where the R&S ROMES4 executable is located.
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● My ROMES\InitialSetup refers to C:\Users\UserName\Documents\My ROMES\Ini-
tialSetup.

● File names are case insensitive.

RomesTecSelector.ini

The Tec Selector uses the RomesTecSelector.ini file to change the technology
modules to be loaded.

If the RomesTecSelector.ini file is detected,

1. The file is copied to Home Directory while the existing one in Home Directory is
overwritten.

2. If the entry exists, the registry entry General\FRESH_INSTALLATION is cleared,
therefore the Tec Selector does not run.

PESQ file

PESQ file is a license file and is copied accordingly in the My ROMES\InitialSetup
folder if detected.

The file can be browsed and changed using the "License Info" dialog, see Chap-
ter 3.10.4, "Licenses", on page 419.

Figure 8-12: Change PESQ file

The "OK" button becomes active by selection of a PESQ file.

Press the button. The warning dialog to restart R&S ROMES4 pops-up.

Figure 8-13: Warning dialog
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SystemConfig.zip

If My ROMES\InitialSetup\SystemConfig.zip is detected, it is imported silently.
No message or progress information is displayed for automated installation.

Rename initial setup folder

After Initial Setup is successfully done, the InitialSetup folder name is changed to Ini-
tialSetupDone.

If this folder exists, InitialSetupDoneX is tried, where X is a number from 0 to 9.

If all folder names exist, the one with earliest timestamp is overwritten. Initial Setup
runs once as needed.

Error log

The Initial Setup is for automated installation and runs in silent mode. Errors if occur,
are written to RMSDBG.txt in Home Directory.

8.1.5  Multiple WiBu firm-codes support

WiBu firm-codes both for R&S ROMES4 and SmartBanchmarker are supported.

If no firm code is detected, WiBu license is not used.

If any or both firm codes are detected, WiBu license is used.

If both firm codes are detected, the actual WiBu license coverage is the superset of
both. To get the WiBu maintenance license details, see Chapter 3.10.4, "Licenses",
on page 419.

8.1.6  Installing R&S ROMES4 Network Problem Analyzer

Before starting the installation, ensure that previously installed R&S ROMES4 was run-
ning so that the needed R&S ROMES4 NPA license is available.

The R&S ROMES4 NPA is installed separately by running the
npa_setup-<version>.exe file which is a part of delivered software.

The installation is running via the installation wizard.

1. Double-click the npa_setup-<version>.exe file available in the ...\ROMES
<version>\AddOns\NetworkProblemAnalyzer directory.
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Figure 8-14: R&S ROMES4 NPA installation - start

Click "Next" to continue the installation.

The installer checks for previous R&S ROMES4 NPA <version> installations. If one
is found, the installer copies the path to the installation directory and offers this
location as the install location. Otherwise, the default directory
C:\Program Files\Rohde-Schwarz\ROMES<version>\
NetworkProblemAnalyzer is offered.

2. The "Choose Install Location" window opens.
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Figure 8-15: R&S ROMES4 NPA installation - choose location

3. Enter the desired destination folder for the R&S ROMES4 NPA.
Click "Install" to start the installation.

The installation runs and shows the installation progress.

4. The end of the R&S ROMES4 NPA installation is indicated in the "Installation Com-
plete" window.
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Figure 8-16: R&S ROMES4 NPA installation - successfully completed

Click "Next" to continue.

The R&S ROMES4 NPA completing installation window opens.

5. Click "Finish" to verify the installation.
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Figure 8-17: R&S ROMES4 NPA installation - finished

To use R&S ROMES4 NPA, you need the NPA license.

8.1.7  User-defined script

At the end of the R&S ROMES4 installation, a batch job UserProg.cmd is performed
in the R&S ROMES4 section of the installer, if it exists in the same directory as the
installer. The job is called with 5 parameters:
Table 8-2: UserProg.cmd job parameters

No. Example Description

0 UserProg.cmd Name of the batch job; standard parameter of
batch jobs in MS Windows.

1 C:\Program Files\Rohde-Schwarz\
ROMES<version>

Target directory of R&S ROMES4 installation.

2 C:\MyDocuments\My ROMES Target directory of stored R&S ROMES4 data

(for future use).

3 <version> Version of R&S ROMES4.

4 d:\ Path of batch.
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It can be used to install files to the R&S ROMES4 directory, which are added by the IT
team of the user's company.

Error handling
The return code of the batch is not checked by the installer. Therefore, error handling
must be performed by the user job itself.

An example SampleUserProg.cmd can be found on DVD.

8.1.8  Unattended install process

It is possible to install R&S ROMES4 via a preconfigured command file. The installa-
tion process is performed silently.

An example is delivered in the R&S ROMES4 SW, as the UnattendedInstall.cmd
file.

Example for user-defined procedure, "after" installation of R&S ROMES4
SampleUserProg.cmd is an example for user-defined procedure called "after instal-
lation of R&S ROMES4". The file is also a content of delivered DVD.

All system logging messages are written to a log file or returned on the command-line
window.
● R&S ROMES4 installation generally checks, whether sub parts need to be instal-

led. Parts which are already installed in the correct version, are not installed again.
● Using the command-line parameters in unattended operation, parts of installation

can only be excluded from installation process.
● It is not possible, to force installation of certain components in unattended mode.

To force reinstallation of some components, you need to start the installation in
interactive mode.

No automatically reboot after finished installation.

8.1.8.1  Syntax

setup [/S] 
      [/TSMx=0|1] [/Dongle=0|1] [/NETMON=0|1]  
      [/QPC=0|1] [/NPA=0|1] /D=<path>

Parameters case-sensitive
Parameters are case-sensitive; no space allowed between the option, also before and
after the sign "=" .
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Return Code
The installer does not check the return code of the batch. Therefore, error handling
must be performed by the user job itself.

8.1.8.2  Parameters

Table 8-3: Installation parameters

Parameter Description

/S Silent operation.

The installer runs without any user interaction. Optional parameter.

Note:

- Error messages are still presented to the user.

- Some subinstallers such as WinPcap and VLC player installer still
require user interaction.

/D=<path> Target directory for the installation. If not present, the default directory is
used. The default directory is the programs section of the operating sys-
tem.

The parameter has to be the last parameter on the command line.

If the path name contains blanks, no " are required.

/NETMON=<0|1> Specifies whether to install MS Netmonitor. The /NETMON=<1> means
install, <0>means do not install. If <1>, a link to page on web server of
Microsoft is established for downloading.

/QPC=<0|1> Specifies whether to install the QualiPoc Converter.

/VLC=<0|1> Specifies whether to install the VLC player.

Note:

The installer of the VLC player requires user interaction, even if the
user supplied the /S parameter.

0: No installation of the VLC player.

1: Installation of the VLC player. Only if it has not already been instal-
led, or no previous version is installed.

The parameter is optional. If the parameter is not available, the installer
tries to install the VLC player.

/ServicePacks=<0|1> Specifies whether the installer searches for R&S ROMES4 service
packs automatically or not.

0: Installer does not search.

1: Installer searches automatically during installation setup for service
packs.

The parameter is optional. If not available, the installer searches auto-
matically for R&S ROMES4 service packs.
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Parameter Description

/LicenseFiles=<0|1> Specifies whether to install the license files.

Note:

It is recommended to use the option "0" and copy the license file (i.e.
PesQPesqLicenseFile.txt) by using other programs.

0: No installation.

1: Installation of license files.

The parameter is optional. If not available, the installer tries to install the
license file.

/NPA=<0|1> Specifies whether to install the Network Problem Analyzer (NPA).

0: No installation.

1: If not yet installed, the installer tries to install the NPA.

The parameter is optional. If not available, the installer tries to install the
NPA.

Note:

The NPA needs an own license key (option_xxx.npa). In silent
installation (parameter /S), the user is not prompted for the location of
the license file. Hence, the file has to be copied to the correct location
by the user afterwards.

/_3GPP=<0|1> Specifies whether to install the 3GPP packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/QOS=<0|1> Specifies whether to install the QoS packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/CW=<0|1> Specifies whether to install the CW packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/TETRA=<0|1> Specifies whether to install the TETRA packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/_3GPP2=<0|1> Specifies whether to install the 3GPP2 packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/RFPS=<0|1> Specifies whether to install the RFPS packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

NBIOT=<0|1> Specifies whether to install the NB-IoT packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.
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Parameter Description

/WIMAX=<0|1> Specifies whether to install the WiMax packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

/WLAN=<0|1> Specifies whether to install the WLAN packet.

0: No installation.

1: If not yet installed, the installer tries to install the packet.

Example: 
setup [/S] [other options=0] /D=<path>
It can be used, to install files to the R&S ROMES4 directory, which are added by the IT
team of the company.

8.2  Uninstall R&S ROMES4

In addition to the uninstall wizard, R&S ROMES4 offers an unattended uninstallation
process. For more details, see Chapter 8.2.6, "Unattended uninstall process",
on page 2221.

8.2.1  Uninstall wizard

To uninstall the R&S ROMES4 SW:

1. Click "Start" >"Settings" > "Apps & features" to open the list of installed software.
Select "ROMES<version>" you want to uninstall.

2. The uninstallation dialog opens.
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Figure 8-18: Start of uninstallation process

Click "Next" to continue.

3. A window opens showing the uninstallation path.
Click "Next" to continue.

4. The "Choose Components" window opens.
Check the components that you want to uninstall.
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Figure 8-19: Uninstall the selected components

Click "Uninstall" to continue.

The checked components are uninstalled.

5. During the uninstallation, you can choose if you want to remove all the MapX com-
ponents. Click "Yes".

The "Remove Shared Files" window opens.

6. Select files that you want to remove. Click "Yes to All".

The "Remove Programs from your Computer" window opens informing you that
Uninstall Shield removed MapX.
Note: The steps 5. and 6. are performed only if the program MapX exists in a com-
puter as being installed in some previous version of R&S ROMES4.

7. During the uninstallation, the system asks if to remove all user data files and all
user private data files installed during the R&S ROMES4 installation. The corre-
sponding dialogs pop-up if the related combo-boxes are checked in "Choose Com-
ponents" > "ROMES".

Uninstall R&S ROMES4
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Note: User data files that are in the R&S ROMES4 directory are uninstalled on
request only.

8. A window appears showing that the R&S ROMES4 <version> uninstallation is
completed successfully.

Figure 8-20: Uninstallation completed

A window appears to close the uninstallation process.

Uninstall R&S ROMES4
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9. Click "Finish".

Figure 8-21: Closing the uninstallation process

The R&S ROMES4 is uninstalled and the shortcut desktop icons to start the pro-
gram are removed.

Licenses are uninstalled only when user data and settings are uninstalled.

R&S ROMES4 and R&S ROMES4 NPA Uninstallation
The links to uninstaller of the R&S ROMES4 and the R&S ROMES4 NPA are removed
from desktop and start menu, following the Microsoft’s guide lines. As a result,R&S
ROMES4 can only be uninstalled using Control Panel.

8.2.2  System files

The component "SystemFiles" defines the files which are registered and copied to the
directory of Windows system.

8.2.3  Devices

Some of the hardware devices can be uninstalled in this group of registered files and
copied to the directory of Windows system.

Only devices which can automatically uninstall themselves are uninstalled by the R&S
ROMES4 uninstaller.

Uninstall R&S ROMES4
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8.2.3.1  IEC API

This APT is uninstalled silently without any user interface.

8.2.4  3rd party

All 3rd party products, which can be uninstalled automatically, are available in this
group.

The libraries from Microsoft are not uninstalled since many other programs rely on the
presence of these libraries.

8.2.5  Registry

Registry settings are uninstalled silently without any user interface.

8.2.6  Unattended uninstall process

It is possible to uninstall R&S ROMES4 via a pre-configured command file. The unin-
stall process is performed silently. An example is delivered on the R&S ROMES4 DVD
- UnattendeddeInstall.cmd.

All system logging messages are written to a log file or returned on the command-line
window.
● R&S ROMES4 uninstallation generally checks, whether sub parts need to be unin-

stalled. The parts which were not installed before, are not uninstalled.
● Using the command-line parameters in unattended operation, some parts of instal-

lation can be excluded from uninstallation process.

8.2.6.1  Syntax

ROMESUnInstall [/S] 
      [/TSMx=0|1] [/NPA=0|1]  
      

All options are case insensitive. Space between the option and the equal sign is not
allowed. Spaces are allowed (but not recommended) after the equal sign.

Uninstall R&S ROMES4



Installation instructions R&S ROMES4Drive Test Software

2222Operating Manual 1171.6415.12 ─ 66

8.2.6.2  Parameters

Parameter Description

/S Silent operation.

The uninstaller runs without any user interaction. It is optional parameter.

Note:
- Error messages are still presented to the user.

- Some subinstallers such as WinPcap and VLC player installer still require user
interaction.

/QPC=<0|1> Specifies whether to uninstall the QualiPoc Converter.QPC= <1> means unin-
stall, QPC=<0> do not uninstall.

The parameter is optional. If the parameter is not available, the uninstaller tries to
uninstall the QualiPoc Converter.

/VLC=<0|1> Specifies whether to uninstall the VLC player.

Note:
The uninstaller of the VLC player requires user interaction, even if the /S parame-
ter has been supplied by the user.

0: VLC player is not uninstalled.

1: uninstall the VLC player.

The parameter is optional. If the parameter is not available, the uninstaller tries to
uninstall the VLC player.

/NPA=<0|1> Specifies whether to uninstall the Network Problem Analyzer (NPA).

0: Do not uninstall NPA.

1: Uninstall the NPA.

The parameter is optional. If not available, the uninstaller tries to uninstall the
NPA.

Note:
The NPA needs an own license key (option_xxx.npa). In silent installation
(parameter /S), the user is not prompted for the location of the license file.
Hence, the file has to be copied to the correct location by the user afterwards.
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Parameter Description

UserPrivateFiles/
=<0|1>

Specifies whether to uninstall the user files of the current user.

Note:
- The user has to accept this operation, even if the user supplied the /S parame-
ter.

- The parameter has to be “1” for this option, as user private files are kept by
default.

0: Do not uninstall user files of the current user.

1: Uninstall user files of the current user.

The parameter is optional. If not available, the uninstaller does not uninstall user
files of the current user.

/AllUsers
=<0|1>

Specifies whether to uninstall the user files of all users.

Note:
The user has to accept this operation, even if the user supplied the /S parameter.

- The parameter has to be “1” for this option, as user private files are kept by
default.

0: Do not uninstall user files of all users.

1: Uninstall user files of all users.

The parameter is optional. If not available the uninstaller does not uninstall any
user file.

8.3  Directory structure R&S ROMES4

The directory structure of is compliant with the standard MS Windows structure. All
user data is stored in the personal user account folder or in the Application folder. For
details see the following overview table:

program Standard folder for programs. "c:\Program Files\Rohde-Schwarz\ROMES<version
no.>"

user data tem-
plates

Standard folder for all users'
application documents.

"c:\Documents and Settings\All Users\

Application Data\Rohde&Schwarz\My ROMES"

current user data Standard folder for current
user documents.

"c:\Documents and Settings\<me>\My Documents\

My Romes"

During startup R&S ROMES4 checks, whether the templates in the Application folder
are newer than the data currently used. If the templates in the Application folders are
newer R&S ROMES4 updates the data in the current user's documents folder automat-
ically.

Directory structure R&S ROMES4
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8.4  Operating R&S ROMES4 without local administration
rights

Users without local administration rights may only use R&S ROMES4 in replay mode,
unless the User Account Control (UAC) is set to "Never notify".

8.4.1  File sharing settings

The limited account user without local administration rights needs full file control for the
following directories:
● R&S ROMES4 directory ( e.g.

C:\Program Files\Rohde-Schwarz\ROMES<version no.>)
● MapInfo directory ( e.g. C:\Program Files\MapX)

Note: Applies only if the program exists in a computer as being installed in some
previous version of R&S ROMES.

● R&S ROMES4 temporary directory for route track modules ( C:\TEMP)

This involves the following steps:

1. Open the Windows Explorer and select the menu item "Tools" ⇨ "Folder
Options...". Select the tab "View" and scroll down until the "Use simple file sharing"
list item is visible as shown below:

Operating R&S ROMES4 without local administration rights
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2. Deselect the "Use simple file sharing" checkbox and "Apply" the change.

3. Back in the Windows Explorer, select the default R&S ROMES4 directory (e.g.
C:\RuS) and click right mouse button. In the resulting context menu, select the
"Properties" entry, which leads to a dialog for the selected directory. Click the
"Security" tab to obtain a dialog similar to the one shown in the following figure.
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4. Select the user with limited account privileges (RS_USER in this example) in the
upper list. Then select "Allow" in the "Full control" entry of the lower list. Apply the
change and repeat this step for all directories listed at the beginning of this section.

5. When Step 4. is completed, modify the registry as described in the following chap-
ter.

8.4.2  Registry modifications

To operate R&S ROMES4 with a limited user account, the following registry keys need
to be updated:
● ROMES Registry Key

HKEY_LOCAL_MACHINE\SOFTWARE\Rohde & Schwarz
● MapInfo Registry Key

HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo
Note: Valid only if the program MapX exists in a computer as being installed in
some previous version of R&S ROMES.

Operating R&S ROMES4 without local administration rights



Installation instructions R&S ROMES4Drive Test Software

2227Operating Manual 1171.6415.12 ─ 66

This involves the following steps:

1. Open the "Start" menu and select "Run" to obtain the following dialog.

2. Type "regedit32" and click "OK" to start the MS Windows Registry editor.
Tip: regedit32
Do not use "regedit" as this tool does not support security settings for registry
entries. Alternatively, call C:\WINNT\SYSTEM32\regedit32.exe from the com-
mand prompt.

The Registry Editor starts with a window similar to the following:

3. Click HKEY_LOCAL_MACHINE, then SOFTWARE.

4. In the SOFTWARE list, locate the Rohde & Schwarz and MapInfo items (valid
only if the program MapX exists in a computer as being installed in some previous
version of R&S ROMES).
. Right-click an item to obtain a context menu like the following.
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5. Select "Permissions" to open the following dialog:

6. In the upper list, select the user with limited account privileges (RS_USER in this
example). Then select "Allow" in the "Full control" list item of the lower list. Apply
the change and repeat this step for all Software items listed at the beginning of this
section.
These changes allow the full functionality of the R&S ROMES4 software in the con-
text of a limited user account.

Operating R&S ROMES4 without local administration rights
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9  R&S ROMES4 KPI generator
The measurement procedure and the KPI calculation in R&S ROMES4 is separated. At
the measurement time only trigger points (TPs) – and no KPIs - are stored in a
*.rscmd file.

KPIs calculation is based on these trigger points and is separated and postponed. Dur-
ing the measurement or at replay the KPIs are formed according to the calculation
method which is defined in a KPI definition file.

This has a big advantage as the calculation method is changeable, adaptable and
extensible for specific customer requests. Therefore no new measurement is neces-
sary if any new KPI calculation is needed.

● KPI definition file and KPI export definition file................................................... 2229
● KPI definition - how to define a KPI.....................................................................2239
● Trigger point definitions.......................................................................................2243
● R&S ROMES4 KPI Description...........................................................................2312

9.1  KPI definition file and KPI export definition file

This document defines the format of the XML file, which is responsible for the genera-
tion of the KPIs in the KPI Generator. It defines also the format of the XML file, which is
responsible for the layout of the KPI export tables.

● Introduction......................................................................................................... 2229
● KPI definition file................................................................................................. 2230
● KPI export definition file...................................................................................... 2235

9.1.1  Introduction

The calculation method is defined in a KPI definition file in XML format. A basic defini-
tion file is delivered with the R&S ROMES4 installation for calculating all common
KPIs, which R&S ROMES4 has calculated in previous versions.

This basic definition file can be found usually at
[RomesApplicationData]\configuration\KPI.xml

This documentation will describe all the parameter used by a KPI definition. For an
example how to define own KPIs see [4].

The result of a KPIs calculation is shown in the KPI Generator View.

These calculated KPIs can be exported to a CSV file and are shown in the KPI Export
Result View.

What KPI data should be exported and how the data should be formatted is described
in another XML file usually named KPIExport.xml. For example Calculation of aver-

KPI definition file and KPI export definition file



R&S ROMES4 KPI generatorDrive Test Software

2230Operating Manual 1171.6415.12 ─ 66

ages, minimum, maximum over sessions and the whole measurement are possible in
the export.

A basic definition file is delivered with the R&S ROMES4 installation for exporting com-
mon KPIs.

However, applying an own modified KPI definition file is only possible if the option
ROMES4KPI has been ordered.

This basic export definition file can be found usually at
[RomesAppliciationData]\configuration\ KPIExport.xml

This documentation will describe all the parameter used by a KPI export definition and
may help to configure the export to the user’s needs.

9.1.1.1  References

[1] Chapter 9.3, "Trigger point definitions", on page 2243

[2] KPIExport.xml
[3] KPI.xml
[4] Chapter 9.2, "KPI definition - how to define a KPI", on page 2239

9.1.2  KPI definition file

This document defines the format of the XML file, which is responsible for the genera-
tion of the KPIs in the KPI Generator.

Trigger points generated by the R&S ROMES4 software are used to calculate KPIs.

Whenever a trigger point appears, the KPI generator checks in the definition if this trig-
ger point is part of any defined KPI. If so, either a KPI will be initiated (started) or a KPI
will be finished (stop TP or error TP).

As the definition of the KPI is written in the KPI.xml file, the user has the possibility to
change either the start and stop trigger points for a wanted KPI or he may invent or
strip off the KPI list to his needs. However, applying an own modified KPI definition file
is only possible if the KPI Generator option ID is available.

All tags, attributes and values are case sensitive! Wrong or not specified tags and
attributes may lead to an error message. As a result of an error the KPI generator func-
tionality may be declined.

KPI definition file and KPI export definition file
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9.1.2.1  File specification

Main tag

The complete XML file has to be enclosed into the tag <kpi_generator>.

Example:

<kpi_generator>
.....
</kpi_generator>

Triggerpoint definition

The tag <triggerpoint> allows the user to specify all the trigger points which may
be used for generating KPIs. Trigger points are generated by several modules in the
R&S ROMES4 software, for example, from DQA, SQA and the L3 messages from
GSM, UMTS, and another RATs. Each trigger point has an unique ID, all IDs are
defined at [1]. These 64 bit trigger point IDs are used as follows:

Attribute Allowed Values Description

name String, default “” Name of the triggerpoint [1]

id Integer, default -1 ID of triggerpoint, a 64bit ID [1]

Both attributes are not mandatory, but it makes no sense to define a trigger point with-
out an unique ID and a characteristic name.

Example:

<triggerpoint name="GMM ATTACH REQUEST" id="0x000008010018044C"></triggerpoint>
<triggerpoint name="FTP login request" id="0x00002107050408A6"></triggerpoint>

Having many trigger points defined but using only few of them for KPI calculation does
not matter. Also order of trigger points and KPIs is not important.

KPI

The tag <kpi> specifies a KPI definition.

It describes the type of KPI and its behaviour in a certain situation. Important info is
what trigger point in which role leads to initiate a KPI (role="start") or finishes a KPI
(role="stop" or role="error").

A special KPI which updates periodically its value can be achieved via the type=”SPE-
CIAL” in combination with trigger point role=”periodic”. Whenever this periodic trigger
point appears, the KPI is finished.

Some pre conditions and post actions give more power and flexibility to the system.

Example:

<kpi name="Attach Setup Time" id="0201" type="DURATION" unit="ms" 
timeout="15000" session="true" reinitiate="false">
    <triggerpoint role="start" id="0x000008010018044C"></triggerpoint>
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    <triggerpoint role="stop" id="0x010008020018044C"></triggerpoint>
    <triggerpoint role="error" id="0x010008040018044C"></triggerpoint>
</kpi>

Attribute Allowed Values Description

name String

default ""

Name of the KPI, editable, is used
later to display this text

id Integer

default -1

ID of KPI, a unique number, edita-
ble, is used to identify the KPI.
Should be a unique number over
all KPI ids.

type RATE The result of the KPI is the ratio of
(v2-v1)/(t2-t1), where v is value, t
is timestamp given with the TP
start and TP stop.

 DURATION

default

Duration in ms between occur-
rence of TP

start until TP stop

 BOOLEAN The occurrence of the TP stop
leads to a success (true) result,
while a TP error or a timeout
leads to a failed (false) result.

 NEG_BOOLEAN Inverse to BOOLEAN

 SPECIAL The result is the value of the
given trigger point. Needs a TP in
role= “periodic”

 SINGLE A single trigger point generates a
KPI.

timeout Integer

default -1

Timeout in ms. If a KPI was star-
ted and the time has elapsed
without any occurrence of a TP in
the role stop or error, the KPI is
finished by timeout. -1 if no time-
out applied

session bool

default false

A KPI can depend on a session or
not. If a KPI depends on a ses-
sion, it will be calculated only, if a
session is open. During a session
only generic TP or TPs belonging
to the session will be accepted.

A session can be opened by ini-
tiating a CS call or by DQA con-
nect.

unit String

default ""

Unit of the KPI result

if type=”BOOLEAN” or
“NEG_BOOLEAN”

a unit=”%” results in 0..100%,

a unit=”” results in Failed/Ok
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Attribute Allowed Values Description

reinitiate bool

default false

Allows reinitiating a KPI or not If it
is not allowed, a 2nd start TP for
this pending KPI is ignored or
leads to a KPI finished by timeout.
If it is allowed, a 2nd start TP for
this pending KPI finishes this KPI
by an error TP and initiates a new
KPI.

action none

default

Action is only possible if
type=”BOOLEAN” or “NEG_BOO-
LEAN” perform no action

 closeSession close Session if KPI is finished

 closeSessionOnFailure close session if KPI is finished by
error TP

 closeSessionOnSuccess close session if KPI is finished by
stop TP

alias Text,

Default empty

Alias text for the KPI values, only
valid with type SPECIAL, The for-
mat is as follows:

(value,Text) (value,Text)
(value,Text)

e.g.

alias="(0|Good)(1|Blocked)(2|
Dropped)(3|No Service)"

Both attributes name and id are not mandatory, but it makes no sense to define a KPI
without a unique ID and a characteristic name.

Triggerpoint role

Important and mandatory are the trigger points which initiate and finish a KPI. For that
the trigger points must be named and must have a certain role.

A trigger point in the role start initiates a KPI.

A trigger point in the role stop finishes a KPI.

A trigger point in the role error finishes a KPI in a negative way.

A trigger point in the role=”periodic” in combination with type=”SPECIAL” gives the
possibility to update the value of a certain KPI periodically.

Attribute Allowed Values Description

role start TP which initiates a KPI

 stop TP which initiates a KPI

 error TP which finishes a KPI in a neg-
ative way
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Attribute Allowed Values Description

role periodic If type=”SPECIAL” TP leads
immediately to a KPI

id integer ID of triggerpoint, a 64bit ID[1]

Rules:

Only one triggerpoint role=”start” is allowed, many (at least one) role=”stop” may be
used, triggerpoint role=”error” is optional, many roles=”error” may happen.

The first stop trigger point or error trigger point which occurs finishes the KPI.

Alternatively one triggerpoint role=”periodic” may happen.

Preconditions

If the calculation of a KPI depends on former KPIs, the tag <preconditions> can be
used. It holds 0..N <precondition>.

Example:

<preconditions>
    <precondition id="0200" result="false" optional="true"></precondition>
    <precondition id="0202" result="false"></precondition>
</preconditions>

A KPI is only calculated if the KPI’s result (identified by precondition id) of all precondi-
tions is fulfilled.

Precondition

All preconditions must be fulfilled to calculate the KPI.

A precondition is fulfilled if a KPI with this id has the wanted result.

A precondition must be fulfilled if optional=”false” or optional=”” attribute is not present.

If a precondition is optional=”true”, its existence is not mandatory, that means if the KPI
is not existent, the precondition is fulfilled. But if the KPI is existent, the precondition
result will be taken into account.

Attribute Allowed Values Description

id Integer

default -1

ID of KPI, an unique number

result bool

default true

expected result to fulfill precondi-
tion

optional bool

default false

Denotes if this precondition is
optional or mandatory

Take care that the ID of KPI used for precondition is existent. Otherwise an error mes-
sage comes up.
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A precondition makes only sense if the KPI used for precondition is type=”BOOLEAN”
or “NEG_BOOLEAN”. Otherwise an error message comes up.

9.1.3  KPI export definition file

This document defines the format of the XML file, which is responsible for the layout of
the KPI export tables.

All tags, attributes and values are case sensitive! Wrong or not specified tags and
attributes may lead to an error message. As a result of an error the KPI export func-
tionality may be declined.

9.1.3.1  File specification

Main tag

The complete XML file has to be enclosed into the tag <kpi_export>.

Example:

<kpi_export>
.....
</kpi_export>

Export configuration

The tag <configuration>allows the user to specify some general settings.

Attribute Allowed Values Description

cell_delimeter Any character The character which separates
the cells

decimal_delimeter , or . The delimeter of decimal numbers

Example:

<configuration cell_delimiter=";" decimal_delimiter=","></configuration>

Table

The tag <table>specifies a table object.

Example:

<table>
...
</table>
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Row

The tag <row>specifies a row object within a table object.

It is mandatory to have both row types "header" and "sessions" in a table.

A header must consist of a

<row type="header">
        <cell type="TEXT" value="My Header"></cell>
</row>

with one column which denotes the main headline.

And it must consist of a

<row type="header">
    <cell type="TEXT" value="Session"></cell>
    <cell type="TEXT" value="Timestamp"></cell>
    <cell type="KPINAME" value="0300" subtype="AVG"></cell>
    ...
</row>

with multiple columns which denotes the headlines for each column.

Optional empty lines may be inserted and will be seen only if exported to a file.

<row type="header"></row>        <!-- an empty line for export to a file -->

Attribute Allowed Values Description

type header This will be printed once and is
used for headlines or comments.
Only cells of the types TEXT, KPI-
NAME are allowed.

 session This row will be printed N times
for each session. N is the number
of sessions [3]. Only cells of the
types SESSION, KPI are allowed.

Example using <row type="header">:

<table>
    <row type="header">
        <cell type="TEXT" value="MyHeader"/>
    </row>
    <row type="header"/> <!-- an empty line for export to a file -->
    <row tpye="header">
        <cell type="TEXT" value="Session"/>
        <cell type="TEXT" value="TimeStamp"/>
        <cell type="KPINAME" value="0300" subtype="AVG"/>
        <!-- print name of KPI ID 300 and append text "AVG" -->
        ...
    </row>

    <row type="sessions">

KPI definition file and KPI export definition file



R&S ROMES4 KPI generatorDrive Test Software

2237Operating Manual 1171.6415.12 ─ 66

    ...
    </row>
</table>

Cell

The cell tag <cell>and its object define the content of the table.

Attribute Allowed Values Description

type TEXT Fixed text.

 KPINAME Name of a KPI [3], value define
the ID of the KPI

 KPI The result of the KPI.

 SESSION Properties of the session will be
printed, see subtype

value Depends on type  

type="KPINAME"

type="KPI"

type="META"

Integer IDof KPI [3]

type="TEXT" String String which has to be printed

type="SESSION" String ID of session

subtype Depends on type  

type="SESSION" ID ID of session

type="KPINAME" AVG (AVG) will be appended to the
KPIs name.

 MIN (MIN) will be appended to the
KPIs name.

 MAX (MAX) will be appended to the
KPIs name.

 SUM (SUM) will be appended to the
KPIs name.

 COUNT (COUNT) will be appended to the
KPIs name.

 AVG_PER_SESSION (AVG-S) will be appended to the
KPIs name.

 MIN_PER_SESSION (MIN-S) will be appended to the
KPIs name.

 MAX_PER_SESSION (MAX-S) will be appended to the
KPIs name.

 SUM_PER_SESSION (SUM-S) will be appended to the
KPIs name.

 COUNT_PER_SESSION (COUNT-S) will be appended to
the KPIs name.
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Attribute Allowed Values Description

type="KPI" META META data [1] will be displayed

 AVG The cell will be filled with the
cumulative average of the KPI
value over all sessions. Only
allowed in rows with type=”ses-
sion”

 MIN The cell will be filled with the
cumulative minimum of the KPI
value over all sessions. Only
allowed in rows with type=”ses-
sion”

 MAX The cell will be filled with the
cumulative maximum of the KPI
value over all sessions. Only
allowed in rows with type=”ses-
sion”

 SUM The cell will be filled with the sum
of the KPI values over all ses-
sions. Only allowed in rows with
type=”session”

 COUNT The cell will be filled with the num-
ber of KPI values over all ses-
sions. Only allowed in rows with
type=”session”

 AVG_PER_SESSION The cell will be filled with the
cumulative average of the KPI
values over one session. Only
allowed in rows with type=”ses-
sion”

 MIN_PER_SESSION The cell will be filled with the
cumulative minimum of the KPI
values over one session. Only
allowed in rows with type=”ses-
sion”

 MAX_PER_SESSION The cell will be filled with the
cumulative maximum of the KPI
values over one session. Only
allowed in rows with type=”ses-
sion”

 SUM_PER_SESSION The cell will be filled with the sum
of the KPI values over one ses-
sion. Only allowed in rows with
type=”session”

 COUNT_PER_SESSION The cell will be filled with the num-
ber of KPI values over one ses-
sion. Only allowed in rows with
type=”session”

 TIMESTAMP_START The timestamp of the start trigger
point will be printed. The time-
stamp is given in milliseconds
from the start of the measure-
ment.

KPI definition file and KPI export definition file
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Attribute Allowed Values Description

 SESSION_ID Associated Session ID of the KPI,
if applicable

key String META data key e.g. URL, File-
Name, … see [1].

precision Integer Precision of the calculated value

average_mode String Average mode for subtype AVG
and AVG_PER_SESSION Values:
● sample_based (default):

average will be calculated by
the sum of the sample value
divided by the number of
samples

● time_based: average will be
calculated be the sum of the
product of DeltaValue*Delta-
Time, between two trigger
points divided by DeltaTime
between the last and the first
trigger point.

Example using <row type="sessions">:

<table>
    ...
    <row type="sessions">
        <cell type="SESSION" subtype="ID"/>
        <cell type="KPI" subtype="TIMESTAMP_START" value="200"/>
        <cell type="KPI" value="200"/>
        <cell type="KPI" value="201"/>
        <cell type="KPI" value="202"/>
        <cell type="KPI" value="203"/>
        <cell type="KPI" value="204"/>
        <cell type="KPI" subtype="AVG" value="0201" precision="1"/>
        <cell type="KPI" subtype="AVG" value="0203" precision="1"/>
    </row>
</table>

9.2  KPI definition - how to define a KPI

A KPI (key performance indicator) is a kind of performance measurement. Usually a
start trigger point initializes a KPI while a stop trigger point finishes that KPI.

To define a proper KPI, it must be clear what trigger points meet the requirements.
Each trigger point has at least a timestamp and a kind of value which depends on the
kind of trigger point.

Easily durations can be calculated by timestamp[stop] - timestamp[start]. Or rates
which are calculated by value[stop] - value[start] / duration. Also if the pure appearance
of a trigger point signals success or error it can be used to signal a boolean result (true
or false).

KPI definition - how to define a KPI
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Next consideration is what kind of result the KPI should have. Some pre conditions and
post actions give more power and flexibility to the system.

● References..........................................................................................................2240
● Example: defining trigger points..........................................................................2240
● Example: defining a KPI definition...................................................................... 2241

9.2.1  References

[1] Chapter 9.3, "Trigger point definitions", on page 2243

[2] Chapter 9.1, "KPI definition file and KPI export definition file", on page 2229

[3] KPI.xml

9.2.2  Example: defining trigger points

For example, we want to define a KPI which signals the success of a GSM HAND-
OVER.

The initiation of a GSM handover is signaled by the L3 command RR HANDOVER
COMMAND.

It is sent by the network to the mobile and will be answered from the mobile by either
RR HANDOVER COMPLETE or if failed with RR HANDOVER FAILED.

As all L3 and RRC messages lead to a trigger point we can use this for KPI calculation.

First we must define a trigger point in KPI.xml. According to [2] the syntax is

<triggerpoint name="String of TP" id="ID of trigger point"/>

Parameter Description

String of TP An editable name which is used later to display this
text.

ID of trigger point A characteristic number which is unique in the whole
system. It is a 64bit ID, see [1] for how to build that
ID.

For a GSM Trigger point we need to have a look into the 3GPP specification TS 4.018
ch. 9.1 and ch. 10.4. It shows that the protocol discriminator of RR Radio Resource is
0x06 and the message type of HANDOVER COMMAND is 0x2B.

Further we know that HANDOVER COMMAND is a GSM L3 message (0x03) and
comes in downlink.

As described in [1], the 64bit ID is build of:

Bytes 1 – 2 (the least significant byte ) has always the value
0x044C, built by the frame number.

Byte 3 built by the frame record number, in this case 0x03
for GSM L3 message.

KPI definition - how to define a KPI
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Byte 4: CS data call, 0x10

Bytes 5 – 6: Message ID built from Transaction identifier, proto-
col discriminator and message type - in our case
0x062B

Byte 7: not used, always 0x00

Byte 8: The lowest bit is set for data downlink or uplink
direction. In our case set to 0x01 for downlink direc-
tion

This results in the 64bit trigger point ID 0x01 00 062B 00 03 044C which is unique for
GSM HANDOVER COMMAND

Put that info into the xml format:

<triggerpoint name="GSM HANDOVER COMMAND" 
id="0x0100062B0003044C" />

All tags, attributes and values are cas sensitive! Wrong or not specified tags and attrib-
utes may lead to an error message.

Similar to GSM HANDOVER COMMAND the 64bit IDs for the stop trigger points are:

<triggerpoint name="GSM HANDOVER COMPLETE"
id="0x0000062C0003044C" />
<triggerpoint name="GSM HANDOVER FAILED" 
id="0x000006280003044C" />
Please note that both come in uplink direction (0x00) and the message IDs thus are
different.

Write these xml tags into the file KPI.xml.

9.2.3  Example: defining a KPI definition

Next step in our example is defining a KPI which signals the success of a GSM HAND-
OVER.

A typical KPI definition is:

<kpi name=" String of KPI " id=" ID of KPI " timeout="5000" type="BOOLEAN">
    <triggerpoint role="start" id=" ID of trigger point "></triggerpoint>
    <triggerpoint role="stop" id=" ID of trigger point "></triggerpoint>
    <triggerpoint role="error" id=" ID of trigger point "></triggerpoint>
</kpi>

A KPI definition is enclosed by the tag <kpi>.

KPI definition - how to define a KPI
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Parameter Description

String of KPI An editable name which is used later to display this
text.

ID of KPI An editable number which is used to identify the
KPI. It should be a unique number over all KPI IDs.

timeout="5000" Specifies the time in ms when a KPI is assumed to
be timed out. If a KPI was started and the time has
elapsed without any occurrence of a trigger point in
the role stop or error, the KPI is finished by timeout.
If the duration between start and stop can not be
estimated and therefore no timeout makes sense,
either timeout="-1" or no timeout="" statement
(default -1) suppress the time out check.

notimeout="" The statement (default -1) suppress the time out
check.

type="" Specifies how and what KPI result should be calcu-
lated. Some key words are possible, see [2].

type="BOOLEAN" Specifies that the occurrence of the trigger point in
the role stop leads to a success result, while a trig-
ger point in the role error or a timeout leads to a
failed result.

Some more attributes not named here specify some pre conditions and post actions
and give more power and flexibility to the system.

Important and mandatory are the trigger points which initiate and finish a KPI. For that
the trigger points must be named and have a certain role.

A trigger point in the role start initiates a KPI.

A trigger point in the role stop finishes a KPI.

A trigger point in the role error finishes a KPI in a negative way.

A KPI definition needs exactly one start trigger point but may have several stop trigger
points or error trigger points. The first stop trigger point or error trigger point which
occurs finishes the KPI.

Back to the example:

1. Enter the wanted name and set the ID.

2. Set timeout and type.

3. Enter the 64bit trigger point ID of trigger point GSM HANDOVER COMMAND for
the start condition.

4. Enter the 64bit trigger point ID of GSM HANDOVER COMPLETE for the stop con-
dition and the 64bit trigger point ID of GSM HANDOVER FAILED for the error con-
dition

This info results in the following xml format:

KPI definition - how to define a KPI
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<kpi name="GSM Handover Success" id="0001" timeout="5000" type="BOOLEAN">
    <triggerpoint role="start" id="0x0100062B0003044C"></triggerpoint>
    <triggerpoint role="stop" id="0x0000062C0003044C"></triggerpoint>
    <triggerpoint role="error" id="0x000006280003044C"></triggerpoint>
</kpi>

Write these xml tags into the file KPI.xml

9.2.3.1  Functionality

Whenever a trigger point with the id 0x0100062B0003044C (which signals GSM
HANDOVER COMMAND) occurs, a KPI will be initiated.
● If within 5000ms a trigger point with the id 0x0000062C0003044C occurs, the KPI

will be finished with result success (true).
● If within 5000ms a trigger point with the id 0x000006280003044C occurs, the KPI

will be finished with result failed (false).
● If no stop or error trigger point occurs within 5000ms, the KPI will be finished with

result timeout.

9.3  Trigger point definitions

● 64Bit trigger point IDs..........................................................................................2243
● Trigger point meta data keys...............................................................................2268
● Value types..........................................................................................................2268
● Trigger point description......................................................................................2269

9.3.1  64Bit trigger point IDs

The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: The phylis frame number

Byte 3: The record number of the frame

Byte 4 - 8: Technology specific

9.3.1.1  DQA trigger points

Byte 1 – 3 have always the value 0x0408a6, built by the phylis frame number 2214 and
the record number 4 of the frame 2214.

Trigger point definitions
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Byte 4: The Service ID

0x00 Not used

0x01 Not used

0x02 Not used

0x03 Not used

0x04 HTTP

0x05 FTP

0x06 ICMP

0x07 POP3

0x08 SMTP

0x09 Video Streaming

0x0A Service Independent

0x0B IMAP

0x0C not used

0x0D SMS

0x0E not used

0x0F UDP

Byte 5 - 6: Trigger point identifier

Byte 7: Service Flags

0x00 Service Link Direction unspecified

0x01 Service Link Direction down

0x02 Service Link Direction up

0x03 Service Link Direction bidirectional (e.g. FTP
DL/UL)

0x04 Trigger Point excluded from KPI Calculation,
when Service Link Direction unspecified. (FTP Multi
Job only)

0x05 Trigger Point excluded from KPI Calculation,
when Service Link Direction down. (FTP Multi Job
only)

Example: 0x01052004050408A6 (TP ID 2004) is not
used for KPI Calculation

0x06 Trigger Point excluded from KPI Calculation,
when Service Link Direction up. (FTP Multi Job only)

Example: 0x00062006050408A6 (TP ID 2006) is not
used for KPI Calculation

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Example: Device sends ATD Command for Connection Request:

0x 00 00 1001 0A04 08a6
  8  7  6 5  4 3  2 1 - Byte

Trigger point definitions
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Device trigger points

Trigger Point Identifier Description

0x1001 Device sends ATD Command for Connection
Request.

64bit ID: 0x 00 00 1001 0A04 08a6

0x1002 Connection completed

64bit ID: 0x 01 00 1002 0A04 08a6

0x1003 Connection failed

64bit ID: 0x 01 00 1003 0A04 08a6

0x1004 Connection HTTP Check Start

64bit ID: 0x 00 00 1004 0A04 08a6

0x1005 Connection HTTP Check Completed

64bit ID: 0x 01 00 1005 0A04 08a6

0x1006 Connection HTTP Check failed

64bit ID: 0x 01 00 1006 0A04 08a6

0x1007 Connection Dialup Completed

64bit ID: 0x 01 00 1007 0A04 08a6

0x1008 Connection Dialup Failed

64bit ID: 0x 01 00 1008 0A04 08a6

0x1009 Connection Dialup was canceled by user

64bit ID: 0x 01 00 1009 0A04 08a6

0x1010 QualiPoc / SQ Andoid Session Started

64bit ID: 0x 01 00 1010 0A04 08a6

0x1011 QualiPoc / SQ Andoid Session Finished

64bit ID: 0x 01 00 1011 0A04 08a6

0x1012 Modem COM port opened

64bit ID: 0x 00 00 1012 0A04 08a6

0x1013 CS Connection Request

64bit ID: 0x 00 00 1013 0A04 08a6

0x1014 CS Connection Completed

64bit ID: 0x 00 00 1014 0A04 08a6

0x1015 CS Connection Failed

64bit ID: 0x 00 00 1015 0A04 08a6

0x1016 Circuit 109 ON

64bit ID: 0x 00 00 1016 0A04 08a6

0x1017 Circuit 109 OFF

64bit ID: 0x 00 00 1017 0A04 08a6

0x1101 Disconnect Start

64bit ID: 0x 00 00 1101 0A04 08a6

Trigger point definitions
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Trigger Point Identifier Description

0x1102 Disconnect Completed

64bit ID: 0x 01 00 1102 0A04 08a6

0x1103 Disconnect Failed

64bit ID: 0x 01 00 1103 0A04 08a6

0x1201 CS Call Connection Loss

64bit ID: 0x 00 00 1201 0A04 08a6

Service application trigger points

Trigger Point Identifier Description

0x2001 Service Socket Connect Request

64bit ID for HTTP: 0x 00 01 2001 0404 08a6

64bit ID for FTP DL: 0x 00 01 2001 0504 08a6

64bit ID for POP3: 0x 00 01 2001 0704 08a6

64bit ID for IMAP: 0x 00 01 2001 0B04 08a6

64bit ID for UDP DL: 0x 00 01 2001 0F04 08a6

64bit ID for HTTP: 0x 00 02 2001 0404 08a6

64bit ID for FTP UL: 0x 00 02 2001 0504 08a6

64bit ID for SMTP: 0x 00 02 2001 0804 08a6

64bit ID for UDP UL: 0x 00 02 2001 0F04 08a6

0x2002 Service Socket Connect Completed

64bit ID for HTTP: 0x 01 01 2002 0404 08a6

64bit ID for FTP DL: 0x 01 01 2002 0504 08a6

64bit ID for POP3: 0x 01 01 2002 0704 08a6

64bit ID for IMAP: 0x 01 01 2002 0B04 08a6

64bit ID for FTP DL: 0x 01 01 2002 0F04 08a6

64bit ID for HTTP UL: 0x 01 02 2002 0404 08a6

64bit ID for FTP UL: 0x 01 02 2002 0504 08a6

64bit ID for SMTP: 0x 01 02 2002 0804 08a6

64bit ID for UDP UL: 0x 01 02 2002 0F04 08a6

0x2003 Service Socket Connect Failed

64bit ID for HTTP: 0x 01 01 2003 0404 08a6

64bit ID for FTP DL 0x 01 01 2003 0504 08a6

64bit ID for POP3: 0x 01 01 2003 0704 08a6

64bit ID for IMAP: 0x 01 01 2003 0B04 08a6

64bit ID for UDP DL: 0x 01 01 2003 0F04 08a6

64bit ID for HTTP UL: 0x 01 02 2003 0404 08a6

64bit ID for FTP UL: 0x 01 02 2003 0504 08a6

64bit ID for SMTP: 0x 01 02 2003 0804 08a6

64bit ID for UDP UL: 0x 01 02 2003 0F04 08a6
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Trigger Point Identifier Description

0x2004 Service receives the first data packet containing
content on the data socket.

64bit ID for HTTP: 0x 01 01 2004 0404 08a6

64bit ID for FTP DL 0x 01 01 2004 0504 08a6

64bit ID for POP3: 0x 01 01 2004 0704 08a6

64bit ID for IMAP: 0x 01 01 2004 0B04 08a6

64bit ID for UDP DL: 0x 01 01 2004 0F04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL: n.a.

0x2005 Service Timeout while receiving the data packet
containing content on the data socket

64bit ID for HTTP: 0x 01 01 2005 0404 08a6

64bit ID for FTP DL 0x 01 01 2005 0504 08a6

64bit ID for POP3: 0x 01 01 2005 0704 08a6

64bit ID for IMAP: 0x 01 01 2005 0B04 08a6

64bit ID for UDP DL: 0x 01 01 2005 0F04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL: n.a.

0x2006 Service sends the first data packet containing con-
tent on the data socket

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL:
n.a.

64bit ID for HTTP UL: 0x 01 02 2006 0404 08a6

64bit ID for FTP UL: 0x 01 02 2006 0504 08a6

64bit ID for SMTP: 0x 01 02 2006 0804 08a6

64bit ID for UDP UL: 0x 01 02 2006 0F04 08a6

0x2007 Service failure while sending the first data packet
containing content on the data socket

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL:
n.a.

64bit ID for HTTP UL: 0x 01 02 2007 0404 08a6

64bit ID for FTP UL: 0x 01 02 2007 0504 08a6

64bit ID for SMTP: 0x 01 02 2007 0804 08a6

64bit ID for UDP UL: 0x 01 02 2007 0F04 08a6

0x2008 Service receives the last data packet containing
content on the data socket

64bit ID for HTTP: 0x 01 01 2008 0404 08a6

64bit ID for FTP DL: 0x 01 01 2008 0504 08a6

64bit ID for POP3: 0x 01 01 2008 0704 08a6

64bit ID for IMAP: 0x 01 01 2008 0B04 08a6

64bit ID for UDP DL: 0x 01 01 2008 0F04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL: n.a.
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Trigger Point Identifier Description

0x2009 Service didn’t receive the last data packet contain-
ing content on the data socket

64bit ID for HTTP: 0x 01 01 2009 0404 08a6

64bit ID for FTP DL 0x 01 01 2009 0504 08a6

64bit ID for POP3: 0x 01 01 2009 0704 08a6

64bit ID for IMAP: 0x 01 01 2009 0B04 08a6

64bit ID for UDP DL: 0x 01 01 2009 0F04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL: n.a.

0x2010 Service did send the last data packet containing
content on the data socket

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL:
n.a.

64bit ID for HTTP UL: 0x 01 02 2010 0404 08a6

64bit ID for FTP UL: 0x 01 02 2010 0504 08a6

64bit ID for SMTP: 0x 01 02 2010 0804 08a6

64bit ID for UDP UL: 0x 01 02 2010 0F04 08a6

0x2011 Service didn’t send the last data packet containing
content on the data socket

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL:
n.a.

64bit ID for HTTP UL: 0x 01 02 2011 0404 08a6

64bit ID for FTP UL: 0x 01 02 2011 0504 08a6

64bit ID for SMTP: 0x 01 02 2011 0804 08a6

64bit ID for UDP UL: 0x 01 02 2011 0F04 08a6

0x2012 Service sends DNS Request

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL,
Ping:

0x 00 01 2012 0A04 08a6

64bit ID for FTP UL, SMTP, UDP UL:

0x 00 02 2012 0A04 08a6

0x2013 Service receives a Host Address from a DNS
Request

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL,
Ping:

0x 01 01 2013 0A04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL:

0x 01 02 2013 0A04 08a6

0x2014 Service didn’t receive a Host Address from a DNS
Request

64bit ID for FTP DL, POP3, IMAP, HTTP, UDP DL,
Ping:

0x 01 01 2014 0A04 08a6

64bit ID for HTTP UL, FTP UL, SMTP, UDP UL:

0x 01 02 2014 0A04 08a6
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Trigger Point Identifier Description

0x2101 FTP Service started

64bit ID for FTP DL: 0x 00 01 2101 0504 08a6

64bit ID for FTP UL: 0x 00 02 2101 0504 08a6

0x2102 FTP Service stopped successfully

64bit ID for FTP DL: 0x 01 01 2102 0504 08a6

64bit ID for FTP UL: 0x 01 02 2102 0504 08a6

0x2103 FTP Service failed

64bit ID for FTP DL: 0x 01 01 2103 0504 08a6

64bit ID for FTP UL: 0x 01 02 2103 0504 08a6

0x2104 FTP Control Socket Connect Request

64bit ID for FTP DL: 0x 00 01 2104 0504 08a6

64bit ID for FTP UL: 0x 00 02 2104 0504 08a6

0x2105 FTP Control Socket Connect Completed

64bit ID for FTP DL: 0x 01 01 2105 0504 08a6

64bit ID for FTP UL: 0x 01 02 2105 0504 08a6

0x2106 FTP Control Socket Connect Failed

64bit ID for FTP DL: 0x 01 01 2106 0504 08a6

64bit ID for FTP UL: 0x 01 02 2106 0504 08a6

0x2107 FTP Login Request

64bit ID: 0x 00 00 2107 0504 08a6

0x2108 FTP Login Success

64bit ID: 0x 01 00 2108 0504 08a6

0x2109 FTP Login Failure

64bit ID: 0x 01 00 2109 0504 08a6

0x2110 FTP Send List Command

64bit ID for FTP DL: 0x 00 01 2110 0504 08a6

64bit ID for FTP UL: n.a.

0x2111 FTP Reception of Directory List succeeded

64bit ID for FTP DL: 0x 01 01 2111 0504 08a6

64bit ID for FTP UL: n.a.

0x2112 FTP Reception Directory List failed

64bit ID for FTP DL: 0x 01 01 2112 0504 08a6

64bit ID for FTP UL: n.a.

0x2113 FTP Logout Request

64bit ID: 0x 00 00 2113 0504 08a6

0x2114 FTP Logout Completed

64bit ID: 0x 01 00 2114 0504 08a6

0x2115 FTP Parallel Download Transfer started

64bit ID: 0x 01 01 2115 0504 08a6
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Trigger Point Identifier Description

0x2116 FTP Parallel Download Transfer succeeded

64bit ID: 0x 01 01 2116 0504 08a6

0x2117 FTP Parallel Download Transfer failed

64bit ID: 0x 01 01 2117 0504 08a6

0x2118 FTP Parallel Upload Transfer started

64bit ID: 0x 00 02 2118 0504 08a6

0x2119 FTP Parallel Upload Transfer succeeded

64bit ID: 0x 01 02 2119 0504 08a6

0x2120 FTP Parallel Upload Transfer failed

64bit ID: 0x 01 02 2120 0504 08a6

0x2201 Ping Sequence Start

64bit ID: 0x 00 01 2201 0604 08a6

0x2202 Ping Sequence Stop

64bit ID: 0x 01 01 2202 0604 08a6

0x2203 ICMP Echo Request.

64bit ID: 0x 00 01 2203 0604 08a6

0x2204 ICMP Echo Reply

64bit ID: 0x 01 01 2204 0604 08a6

0x2205 ICMP Echo Reply Failure

64bit ID: 0x 01 01 2205 0604 08a6

0x2301 HTTP Service Start

64bit ID: 0x 00 01 2301 0404 08a6

0x2302 HTTP Service Stop

64bit ID: 0x 01 01 2302 0404 08a6

0x2303 HTTP sends the first GET command

64bit ID: 0x 00 01 2303 0404 08a6

0x2304 HTTP Object Request

64bit ID: 0x 00 01 2304 0404 08a6

0x2305 HTTP Object Received

64bit ID: 0x 01 01 2305 0404 08a6

0x2306 HTTP Object Error

64bit ID: 0x 01 01 2306 0404 08a6

0x2307 HTTP Send PUT / POST command

64bit ID: 0x 00 02 2307 0404 08a6

0x2308 HTTP Send PUT / POST command failed

64bit ID: 0x 01 02 2308 0404 08a6

0x2309 HTTP Send PUT / POST command succeeded

64bit ID: 0x 01 02 2309 0404 08a6
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Trigger Point Identifier Description

0x2311 WEB 2.0 Action Start

64bit ID: 0x 00 01 2311 0404 08a6

0x2312 WEB 2.0 Action Completed

64bit ID: 0x 01 01 2312 0404 08a6

0x2313 WEB 2.0 Action Failed

64bit ID: 0x 01 01 2313 0404 08a6

0x2321 HTTP Capacity Test start

64bit ID for DL: 0x 00 01 2321 0404 08a6

64bit ID for UL: 0x 00 02 2321 0404 08a6

64bit ID for DL/UL: 0x 00 03 2321 0404 08a6

0x2322 HTTP Capacity Test (DL, UL, DL/UL) complete

64bit ID for DL: 0x 01 01 2322 0404 08a6

64bit ID for UL: 0x 01 02 2322 0404 08a6

64bit ID for DL/UL: 0x 01 03 2322 0404 08a6

0x2401 SMTP Service Start

64bit ID: 0x 00 02 2401 0804 08a6

0x2402 SMTP Service succeeded

64bit ID: 0x 01 02 2402 0804 08a6

0x2403 SMTP Service failed

64bit ID: 0x 01 02 2403 0804 08a6

0x2404 SMTP Authentication Request

64bit ID: 0x 00 02 2404 0804 08a6

0x2405 SMTP Authentication Success

64bit ID: 0x 01 02 2405 0804 08a6

0x2406 SMTP Authentication Failure

64bit ID: 0x 01 02 2406 0804 08a6

0x2407 Reception of the SMTP Reply Code 250 for the
HELO command

64bit ID: 0x 01 02 2407 0804 08a6

0x2408 Reception of the SMTP Reply Code 250 for the
HELO command failed

64bit ID: 0x 01 02 2408 0804 08a6

0x2409 Sending the SMTP MAIL FROM command

64bit ID: 0x 00 02 2409 0004 08a6

0x2410 Reception of the SMTP Reply Code 250 for the
EOM command

64bit ID: 0x 01 02 2410 0804 08a6

0x2411 Reception of the SMTP Reply Code 250 for the
EOM command failed

64bit ID: 0x 01 02 2411 0804 08a6
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Trigger Point Identifier Description

0x2501 POP3 Service Start

64bit ID: 0x 00 01 2501 0704 08a6

0x2502 POP3 Service succeeded

64bit ID: 0x 01 01 2502 0704 08a6

0x2503 POP3 Service failed

64bit ID: 0x 01 01 2503 0704 08a6

0x2504 POP3 Authentication Request

64bit ID: 0x 00 01 2504 0704 08a6

0x2505 POP3 Authentication Success

64bit ID: 0x 01 01 2505 0704 08a6

0x2506 POP3 Authentication Failure

64bit ID: 0x 01 01 2506 0704 08a6

0x2507 Sending the POP3 RETR command

64bit ID: 0x 00 01 2507 0704 08a6

0x2601 IMAP Service Start

64bit ID: 0x 00 01 2601 0B04 08a6

0x2602 IMAP Service succeeded

64bit ID: 0x 01 01 2602 0B04 08a6

0x2603 IMAP Service failed

64bit ID: 0x 01 01 2603 0B04 08a6

0x2604 IMAP Authentication Request

64bit ID: 0x 00 01 2604 0B04 08a6

0x2605 IMAP Authentication Success

64bit ID: 0x 01 01 2605 0B04 08a6

0x2606 IMAP Authentication Failure

64bit ID: 0x 01 01 2606 0B04 08a6

0x2607 Sending the IMAP FETCH command

64bit ID: 0x 00 01 2607 0B04 08a6

0x2608 Reception of the IMAP FETCH OK response

64bit ID: 0x 01 01 2608 0B04 08a6

0x2609 Reception of the IMAP FETCH OK response failed

64bit ID: 0x 01 01 2609 0B04 08a6

0x2801 VLC Streaming Start

64bit ID: 0x 00 01 2801 0904 08a6

0x2802 VLC Streaming succeeded

64bit ID: 0x 01 01 2801 0904 08a6

0x2803 VLC Streaming failed

64bit ID: 0x 01 01 2803 0904 08a6
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Trigger Point Identifier Description

0x2804 VLC Stream Open Start

64bit ID: 0x 00 01 2804 0904 08a6

0x2805 VLC Stream Open succeeded

64bit ID: 0x 01 01 2805 0904 08a6

0x2806 VLC Stream Open failed

64bit ID: 0x 01 01 2806 0904 08a6

0x2807 VLC Stream Playing Start

64bit ID: 0x 00 01 2807 0904 08a6

0x2808 VLC Stream Playing succeeded

64bit ID: 0x 01 01 2808 0904 08a6

0x2809 VLC Stream Playing failed

64bit ID: 0x 01 01 2809 0904 08a6

0x2810 VLC Stream Reproduction Cut Off Ratio

64bit ID: 0x 01 01 2810 0904 08a6

0x5101 Point of time the customer sends his SMS to the
SMS Centre

64bit ID: 0x 00 02 5101 0D04 08a6

0x5102 Point of time the mobile equipment receives the
confirmation from the SMS Centre

64bit ID: 0x 01 02 5102 0D04 08a6

0x5103 The mobile equipment did not receive the confirma-
tion from the SMS Centre

64bit ID: 0x 01 02 5103 0D04 08a6

  

TCP/IP trigger points

The TCP/IP trigger points are only available when the IP Tracer was started.
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Trigger Point Identifier Description

0x3001 Sending the first SYN on data socket

64bit ID for HTTP: 0x 00 01 3001 0404 08a6

64bit ID for FTP DL: 0x 00 01 3001 0504 08a6

64bit ID for POP3: 0x 00 01 3001 0704 08a6

64bit ID for IMAP: 0x 00 01 3001 0B04 08a6

64bit ID for FTP UL: 0x 00 02 3001 0504 08a6

64bit ID for SMTP: 0x 00 02 3001 0804 08a6

0x3002 Reception of the ACK from the SYN/ACK of a Ser-
vice Data Socket

64bit ID for HTTP: 0x 00 01 3002 0404 08a6

64bit ID for FTP DL: 0x 00 01 3002 0504 08a6

64bit ID for POP3: 0x 00 01 3002 0704 08a6

64bit ID for IMAP: 0x 00 01 3002 0B04 08a6

64bit ID for FTP UL: 0x 00 02 3002 0504 08a6

64bit ID for SMTP: 0x 00 02 3002 0804 08a6

0x3003 Reception of the first Data packet containing content

64bit ID for HTTP: 0x 00 01 3003 0404 08a6

64bit ID for FTP DL: 0x 00 01 3003 0504 08a6

64bit ID for POP3: 0x 00 01 3003 0704 08a6

64bit ID for IMAP: 0x 00 01 3003 0B04 08a6

64bit ID for FTP UL, SMTP: n.a.

0x3004 Sending first Data packet containing content

64bit ID for FTP DL, POP3, IMAP, HTTP: n.a.

64bit ID for FTP UL: 0x 00 02 3004 0504 08a6

64bit ID for SMTP: 0x 00 02 3004 0804 08a6

0x3005 Reception of the last Data packet containing con-
tent.

64bit ID for HTTP: 0x 00 01 3005 0404 08a6

64bit ID for FTP DL: 0x 00 01 3005 0504 08a6

64bit ID for POP3: 0x 00 01 3005 0704 08a6

64bit ID for IMAP: 0x 00 01 3005 0B04 08a6

64bit ID for FTP UL, SMTP: n.a.

0x3006 Sent the last Data packet containing content

64bit ID for FTP DL, POP3, IMAP, HTTP: n.a.

64bit ID for FTP UL: 0x 00 02 3006 0504 08a6

64bit ID for SMTP: 0x 00 02 3006 0804 08a6

0x3007 Sending DNS Request

64bit ID for FTP DL, POP3, IMAP, HTTP, Ping:

0x 00 01 3007 0A04 08a6

64bit ID for FTP UL, SMTP:

0x 00 02 3007 0A04 08a6
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Trigger Point Identifier Description

0x3008 Reception of a Host Address from a DNS Request

64bit ID for FTP DL, POP3, IMAP, HTTP, Ping:

0x 01 01 3008 0A04 08a6

64bit ID for FTP UL, SMTP:

0x 01 02 3008 0A04 08a6

0x3009 Reception of a Host Address from a DNS Request
failed

64bit ID for FTP DL, POP3, IMAP, HTTP, Ping:

0x 01 01 3009 0A04 08a6

64bit ID for FTP UL, SMTP:

0x 01 02 3009 0A04 08a6

0x3101 Sending the first SYN on FTP control socket

64bit ID for FTP DL: 0x 00 01 3101 0504 08a6

64bit ID for FTP UL: 0x 00 02 3101 0504 08a6

0x3102 Reception of the ACK from the SYN/ACK of a FTP
control socket

64bit ID for FTP DL: 0x 01 01 3102 0504 08a6

64bit ID for FTP UL: 0x 01 02 3102 0504 08a6

0x3103 Sending the FTP RETR command

64bit ID for FTP DL: 0x 00 01 3103 0504 08a6

64bit ID for FTP UL: n.a.

0x3104 Sending the FTP STOR command

64bit ID for FTP DL: n.a.

64bit ID for FTP UL: 0x 00 02 3104 0504 08a6

0x3201 Sending an ICMP request

64bit ID: 0x 00 01 3201 0604 08a6

0x3202 Reception of an ICMP Reply

64bit ID: 0x 01 01 3202 0604 08a6

0x3203 Reception of an ICMP reply failed

64bit ID: 0x 01 01 3203 0604 08a6

0x3301 Sending the first HTTP GET command

64bit ID: 0x 00 01 3301 0404 08a6

0x3302 Sending the first HTTP PUT / POST command

64bit ID: 0x 00 02 3302 0404 08a6

0x3401 Sending the SMTP HELO command

64bit ID: 0x 00 02 3401 0804 08a6

0x3402 Reception of the SMTP Reply Code 250 for the
HELO command

64bit ID: 0x 01 02 3402 0804 08a6

Trigger point definitions



R&S ROMES4 KPI generatorDrive Test Software

2256Operating Manual 1171.6415.12 ─ 66

Trigger Point Identifier Description

0x3403 Sending the SMTP MAIL FROM command

64bit ID: 0x 00 02 3403 0804 08a6

0x3404 Reception of the SMTP Reply Code 250 for the
EOM command

64bit ID: 0x 01 02 3404 0804 08a6

0x3405 Sending the SMTP QUIT command

64bit ID: 0x 00 02 3405 0804 08a6

0x3501 Sending the POP3 RETR command

64bit ID: 0x 00 01 3501 0704 08a6

0x3502 Sending the POP3 QUIT command

64bit ID: 0x 00 01 3502 0704 08a6

0x3601 Sending the IMAP FETCH command

64bit ID: 0x 00 01 3601 0B04 08a6

0x3603 Reception of the IMAP FETCH OK response

64bit ID: 0x 01 01 3603 0B04 08a6

9.3.1.2  SQA trigger points

Byte 1 - 3: Have always the value 0x0004 08a6, built by the
phylis frame number 2214 and the frame record 4.

Byte 4: Service ID

0x00 Voice Telephony

Byte 5 - 6: Trigger point identifier.

Byte 7: Service Flags

0x01 Downlink, values calculated by Local Client

0x02 Uplink, values calculated by Remote Client

Byte 8: not used. Always 0x00 for uplink, 0x01 for downlink

Example: MOS value calculated by a SQA local client

0x 00 01 4001 0004 08a6
    8  7  6 5  4 3  2 1 - Byte
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Trigger Point Identifier Description

0x4001 Reception of a MOS Value from the SQA measure-
ment engine

64bit ID for SQA Downlink: 0x 01 01 4001 0004
08a6

64bit ID for SQA Uplink: 0x 01 02 4001 0004 08a6

0x4010 Playback of the set speech sample started at the
SQA measurement engine

64bit ID for the SQA Uplink: 0x 01 02 4010 0004
08a6

0x4011 Pause after the speech sample started at the SQA
measurement engine

64bit ID for the SQA Uplink: 0x 01 02 4011 0004
08a6

9.3.1.3  GSM/GPRS trigger points

Trigger points from mobile L3 messages are generically built from the L3 message ID.
For that the 3GPP mobile radio interface layer 3 specification is needed. See 3GPP TS
24.008 and 3GPP TS 4.018.
Table 9-1: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x044C, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, for example:

0x03 for GSM L3 message

0x18 for GPRS GMM message

Byte 4: 0x10, CS Data Call

Byte 5 - 6: Message ID build from Transaction identifier, proto-
col discriminator and message type. See 3GPP TS
24.008 Kap. 10 and 3GPP TS 4.018 Kap. 9.1

Byte 7: Not used, always 0x00

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Example: CM service request

This message is sent by the mobile station to the network to request a service for the
connection management sublayer entities, e.g. circuit switched connection establish-
ment, supplementary services activation, short message transfer, location services.
See 9.2.9/3GPP TS 24.008.

Message type: CM SERVICE REQUEST

Significance: dual

Direction: mobile station to network
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0x 00 00 0524 0003 044C
    8  7  6 5  4 3  2 1 - Byte

More Example:

GSM HANDOVER COMMAND 0x0100062B0003044C

CC ALERTING 0x010003010003044C

GMM ATTACH REQUEST 0x000008010018044C

GMM ATTACH ACCEPTED 0x010008020018044C

SM PDP CONTEXT ACTIVATION REQUEST 0x00000A010018044C

9.3.1.4  Other GSM trigger points

RLC throughput

RLC downlink

Trigger Point ID: 0x010000000016044C

Value: Kbit/s

Description: Point in time; when the GSM device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

RLC uplink

Trigger Point ID: 0x000000000016044C

Value: Kbit/s

Description: Point in time, when the GSM device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

9.3.1.5  UMTS layer 3 trigger points

Trigger points from UMTS mobile RRC messages are generic built from the RRC mes-
sage ID.
Table 9-2: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x2134, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x19 for RRC message

Byte 4: Not used, always 0x00

Byte 5: Message type/choice. See 3GPP TS 25.331
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Byte 6: Channel type UMTS PDU ID See table below

Byte 7: Once more the channel type UMTS PDU ID, see the
following table.

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Example: ACTIVE SET UPDATE

This message is used by UTRAN to add, replace or delete radio links in the active set
of the UE.

RLC-SAP: AM or UM

Logical channel: DCCH

Direction: UTRAN to UE

From 3GPP TS 25.331

DL-DCCH-MessageType::=CHOICE {

activeSetUpdate ActiveSetUpdate, // 1

assistanceDataDelivery AssistanceDataDelivery, //2

...

0x 00 01 0101 0019 2134
  8  7  6 5  4 3  2 1 - Byte

More Example:

UL_DCCH activeSetUpdateComplete: 0x0102020100192134

UL_DCCH activeSetUpdateFailure: 0x0102020200192134

UMTS PDU ID UMTS channel type UMTS PDU ID UMTS channel type

0x01 DL DCCH Message
PDU

0x20 SysInfoType14 PDU

0x02 UL DCCH Message
PDU

0x21 SysInfoType15 PDU

0x03 DL CCCH Message
PDU

0x22 SysInfoType15 1 PDU

0x04 UL CCCH Message
PDU

0x23 SysInfoType15 2 PDU

0x05 PCCH Message PDU 0x24 SysInfoType15 3 PDU

0x06 DL SHCCH Message
PDU

0x25 SysInfoType15 4 PDU

0x07 UL SHCCH Message
PDU

0x26 SysInfoType15 5 PDU
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UMTS PDU ID UMTS channel type UMTS PDU ID UMTS channel type

0x08 BCCH FACH Message
PDU

0x27 SysInfoType16 PDU

0x09 BCCH BCH Message
PDU

0x28 SysInfoType17 PDU

0x0A HandoverToUTRAN-
Command PDU

0x29 SysInfoType18 PDU

0x0B InterRATHandoverInfo
PDU

0x2A SysInfoTypeSB1 PDU

0x0C RRC FailureInfo PDU 0x2B SysInfoTypeSB2 PDU

0x0D UE RadioAccessCapabi-
lityInfo PDU

0x2C TFC Subset ID With3b
PDU

0x0E MasterInformationBlock
PDU

0x2D TFC Subset ID With5b
PDU

0x0F SysInfoType1 PDU 0x2E TFC Subset ID With10b
PDU

0x10 SysInfoType2 PDU 0x2F ToTargetRNC Container
PDU

0x11 SysInfoType3 PDU 0x30 TargetRNC ToSour-
ceRNC Container PDU

0x12 SysInfoType4 PDU 0x31 SRNC RelocationInfo
v3h0ext IEs PDU

0x13 SysInfoType5 PDU 0x32 DL CCTrChTPCList PDU

0x14 SysInfoType6 PDU 0x33 MCCH Message PDU

0x15 SysInfoType7 PDU 0x34 MSCH Message PDU

0x16 SysInfoType8 PDU 0x35 SysInfoType5bis PDU

0x17 SysInfoType9 PDU 0x36 InterRATHandoverInfo r3
add ext IEs PDU

0x18 SysInfoType10 PDU 0x37 RRCConnectionSetup-
Complete r3 add ext IEs
PDU

0x19 SysInfoType11 PDU 0x38 UECapabilityInformation
r3 add ext IEs PDU

0x1A SysInfoType12 PDU 0x39 UE CapabilityContainer
IEs PDU

0x1B SysInfoType13 PDU 0x3A UL PhysChCapabili-
tyFDD r6 PDU

0x1C SysInfoType13 1 PDU 0x3B Event1b r6 PDU

0x1D SysInfoType13 2 PDU 0x3C MBMS PreferredFreqRe-
quest r6 PDU

0x1E SysInfoType13 3 PDU 0x3D SysInfoType11bis PDU

0x1F SysInfoType13 4 PDU 0x3E C RNTI PDU
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UMTS PDU ID UMTS channel type UMTS PDU ID UMTS channel type

  0x3F U RNTI PDU

  0x40 InitialUE Identity PDU

  0x41 V INITIAL UE IDENTITY
PDU

  0x42 RB WithPDCP InfoList
PDU

9.3.1.6  Other UMTS trigger points

RLC throughput

RLC downlink

Trigger Point ID: 0x01000000005D2134

Value: Kbit/s

Description: Point in time; when the UMTS device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

RLC uplink

Trigger Point ID: 0x00000000005E2134

Value: Kbit/s

Description: Point in time; when the UMTS device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

9.3.1.7  LTE RRC trigger points

Trigger points from mobile LTE RRC messages are generic built from the RRC mes-
sage ID.
Table 9-3: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x2149, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x08 for RRC message

Byte 4: Not used, always 0x00

Byte 5: Choice, see 3GPP TS36.331 chapter 6.2.1

Byte 6: Channel PDU (e.g. UL-DCCH Message,…), see
table below
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Byte 7: 0x00 for RRC

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Table 9-4: RRC PDU IDs

PDU ID PDU

0x01 BCCH BCH

0x02 BCCH DL SCH

0x03 PCCH

0x04 DL CCCH

0x05 DL DCCH

0x06 UL CCCH

0x07 UL DCCH

0x0A MIB

0x0B SIB1

0x0C SIB2

0x0D SIB3

0x0E SIB4

0x0F SIB5

0x10 SIB6

0x11 SIB7

0x12 SIB8

0x13 SIB9

0x14 SIB10

0x15 SIB11

0x1E PHICH Configuration

0x1F RACH ConfigCommon

0x23 PUCCH ConfigCommon

0x24 PhysicalCellIdentity

0x25 TDD_Configuration

0x26 RRC_TransactionIdentifier

0x27 UL_AM_RLC

0x28 DL_AM_RLC

0x29 UL_UM_RLC

0x2A DL_UM_RLC
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PDU ID PDU

0x2B PDCP_Configuration

0x2C C_RNTI

0x2D PUCCH_ConfigDedicated

0x2E AntennaInformationDedicated

0x2F MeasGapConfig

0x30 PRACH_Configuration

0x31 AntennaInformationCommon

0x32 RACH_ConfigDedicated

0x33 IntegrityProtAlgorithm

0x34 CipheringAlgorithm

0x35 RRCConnectionInfo_rs

0x36 UE_EUTRA_Capability

0x37 MMEC

0x38 PUSCH_ConfigCommon

0x39 PUSCH_ConfigDedicated

0x40 SoundingRS_UL_ConfigCommon

0x41 DRX_Config

0x42 CQI_ReportConfig

0x43 SoundingRS_UL_ConfigDedicated

0x44 SchedulingRequestConfig

0x45 VarMeasConfig

0x46 UplinkPowerControlCommon

0x47 UplinkPowerControlDedicated

0x48 ARFCN_ValueEUTRA

0x49 PLMN_Identity

0x4A CellIdentity

0x4B DRB_Identity

0x4C CellsTriggeredList

0x4D VarMeasReportList

0x4E VarShortMAC_Input

Example:rrcConnectionRequest
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Table 9-5: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: 0x2149

Byte 3: 0x08 for RRC message

Byte 4: Not used, always 0x00

Byte 5: 0x02, see 3GPP TS36.331 chapter 6.2.1

Byte 6: 0x06, UL-CCCH

Byte 7: 0x00, RRC

Byte 8: 0x00 for uplink

→0x0000060200082149

9.3.1.8  LTE EPS-NAS trigger points

Trigger points from mobile LTE EPS-NAS messages are generic built from the mes-
sage ID.
Table 9-6: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x2149, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x08 for EPS-NAS message

Byte 4: Not used, always 0x00

Byte 5: Message Type, see 3GPP TS24.301 chapter 9.8

Byte 6: 0x02 for EMM, 0x01 for SM

Byte 7: Not used, always 0x00

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Example:TrackingAreaUpdateRequest
Table 9-7: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: 0x2149

Byte 3: 0x08 for RRC message

Byte 4: Not used, always 0x00

Byte 5: 0x48, see 3GPP TS24.301 chapter 9.8

Byte 6: 0x02, EMM

Byte 7: 0x00

Byte 8: 0x00 for uplink
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→0x0000024800082149

9.3.1.9  Other LTE trigger points

RLC throughput

RLC downlink

Trigger Point ID: 0x01000000001D2149

Value: Kbit/s

Description: Point in time; when the LTE device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

RLC uplink

Trigger Point ID: 0x00000000001E2149

Value: Kbit/s

Description: Point in time; when the LTE device sends a new
RLC throughput calculation, the given value was
calculated between the trigger point and this.

RACH messages

RACH trigger

Trigger Point ID: 0x0x0000000000182149

Description: Point in time, when the RACH procedure was trig-
gered.

RACH message 1

Trigger Point ID: 0x0x0000000000232149

Description: Point in time, when the RACH Message 1 was
received.

RACH message 2

Trigger Point ID: 0x0x0000000000242149

Description: Point in time, when the RACH Message 2 was
received.
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RACH message 3

Trigger Point ID: 0x0x0000000000252149

Description: Point in time, when the RACH Message 3 was
received.

9.3.1.10  TETRA layer 3 triggerpoints

Trigger points from mobile TETRA Layer 3 messages are generic built from the mes-
sage ID.
Table 9-8: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x0C1C, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x07 for layer 3 message

Byte 4: Not used, always 0x00

Byte 5: PDU Type, see ETSI TS 100 392-2

Byte 6: Protocol Discriminator, see ETSI TS 100 392-2,
chapter 18.5.21

Byte 7: Not used, always 0x00

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

Example:D-SETUP
Table 9-9: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: 0x0C1C

Byte 3: 0x07 for layer 3 message

Byte 4: not used, always 0x00

Byte 5: 0x07, PDU Type, see ETSI TS 100 392-2, chapter
14.8.28

Byte 6: Protocol Discriminator, see ETSI TS 100 392-2,
chapter 18.5.21

Byte 7: 0x00

Byte 8: 0x01 for downlink

→0x100020700070C1C
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9.3.1.11  Cdma2000 layer 3 triggerpoints

Trigger points from mobile cdma2000 Layer 3 messages are generic built from the
message ID.
Table 9-10: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x0708, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x09 for cdma layer 3 message

Byte 4: Not used, always 0x00

Byte 5 - 6: Message ID

Byte 7: ChannelID, see table below

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

cdma2000 Channel Channel ID

Sync Channel 1

Access Channel 2

Paging Channel 3

Forward Traffic Channel 4

Reverse Traffic Channel 5

Forward CSCH 6

Reverse CSCH 7

Forward DSCH 8

Reverse DSCH 9

9.3.1.12  EVDO layer 3 triggerpoints

Trigger points from mobile EVDO Layer 3 messages are generic built from the mes-
sage ID.
Table 9-11: The 64bit (8Byte) ID has the following byte structure in right to left order:

Byte 1 - 2: Have always the value 0x0708, built by the phylis
frame number.

Byte 3: Has always the value, built by the frame record
number, e.g

0x2F for EVDO layer 3 message

Byte 4: Not used, always 0x00

Byte 5 - 6: Message ID
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Byte 7: ChannelID, see table below

Byte 8: The lowest bit is set for data down link direction.

Currently possible values: 0x00 for uplink, 0x01 for
downlink

EVDO Channel Channel ID

Access Channel 0

Reverse Traffic Channel 1

Control Channel 2

Forward Traffic Channel 3

Control Broadcast Channel 4

9.3.2  Trigger point meta data keys

URL HTTP URL, FTP URL e.g.

http://cms.rohde-schwarz.com

ftp://cms.rohde-schwarz.com

IP_Address An IP Address in IPv4 or IPv6 Format

UserName The Username for authentication to a service

FileName File name (e.g. the FTP server file to download

ErrorText An error text of a failure trigger point

HTTPHeaderText The HTTP header Text of a received HTTP Object

EMailAddress Email Address

GeneralInfo A general information to a trigger point

9.3.3  Value types

9.3.3.1  Boolean

Success state of the reached trigger point; 1 means trigger point reached successfully.

9.3.3.2  Duration

Current elapsed time of service in ms.
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9.3.3.3  Rate

Date rate in bytes per second of a DQA job.

9.3.3.4  MOS

SQM MOS value

9.3.3.5  Bytes

The amount of transferred bytes at the reached trigger point.

9.3.3.6  Special

-

9.3.3.7  Percentage

A ratio calculated by a R&S ROMES4, for example, cut-off ratio.

9.3.4  Trigger point description

Used symbol "-" in the following tables means:
● n/a (not applied) in "Used by ETSI"
● no meta data is generated in "Used Meta Data"

9.3.4.1  DQA

Service independent connection trigger points

Device sends ATD command for connection request

Trigger Point ID: 0x1001

Used by ETSI: A,B

Value Type: Boolean

Used Meta Data: -

Description: Mobile sends the ATD Command for the connction
request.
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Connection completed

Trigger Point ID: 0x1002

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Connection Completed before possibly HTTP Check

Connection failed

Trigger Point ID: 0x1003

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Connection failed

Connection HTTP check start

Trigger Point ID: 0x1004

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Connection HTTP Check Start

Connection HTTP check completed

Trigger Point ID: 0x1005

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Connection HTTP Check completed. Optional, only
available if activated in the Connect Job

Connection HTTP check failed

Trigger Point ID: 0x1006

Used by ETSI: -

Value Type: Boolean
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Used Meta Data: ErrorText

Description: Connection HTTP Check failed. Optional, only avail-
able if activated in the Connect Job

Connection dialup completed

Trigger Point ID: 0x1007

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Connection Dialup completed. The dialup is comple-
ted after the HTTP Check. If no HTTP Check was
defined, it is the same as 0x1002.

Connection dialup failed

Trigger Point ID: 0x1008

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Connection Dialup failed. The dialup is failed after
the HTTP Check. If no HTTP Check was defined, it
is the same as 0x1003.

Connection dialup canceled

Trigger Point ID: 0x1009

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Connection Dialup was canceled by user.

QualiPoc / SQ android session started

Trigger Point ID: 0x1010

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: A QualiPoc or SQ Android session has started
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QualiPoc / SQ android session finished

Trigger Point ID: 0x1011

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: A QualiPoc or SQ Android session has finished.

Modem COM port opened

Trigger Point ID: 0x1012

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Open Modem COM port successfully completed.

CS connection request

Trigger Point ID: 0x1013

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Device sends ATD Command for Circuit Switched
Connection Request.

CS connection completed

Trigger Point ID: 0x1014

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Response from ATD Command for Circuit Switched
call is successful (CONNECT).

CS connection failed

Trigger Point ID: 0x1015

Used by ETSI: -

Value Type: Boolean
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Used Meta Data: Error Text

Description: Response from ATD Command for CS call has
failed.

Circuit 109 ON

Trigger Point ID: 0x1016

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Modem signals transition of circuit 109 (DCD,
RLSD) to ON.

Circuit 109 OFF

Trigger Point ID: 0x1017

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Modem signals transition of circuit 109 (DCD,
RLSD) to OFF.

Disconnect start

Trigger Point ID: 0x1101

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Disconnect stated.

Disconnect completed

Trigger Point ID: 0x1102

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Disconnection completed successfully
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Disconnect failed

Trigger Point ID: 0x1103

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Diconnect failed.

CS call connection loss

Trigger Point ID: 0x1201

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Connection is lost.

General service trigger points

The following trigger points are used by different services.

Socket connect request

Trigger Point ID: 0x2001

Used by ETSI: A, B

Value Type: Chapter 9.3.3.5, "Bytes", on page 2269

Used Meta Data: URL

Description: The data socket tries to establish a connection to a
Host.

Socket connect completed

Trigger Point ID: 0x2002

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: The data socket connection has been established
successfully.

Socket connect failed

Trigger Point ID: 0x2003

Used by ETSI: A, B
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Value Type: Bytes

Used Meta Data: ErrorText

Description: The data socket connection has failed.

Service receives the first data packet containing content on the data socket

Trigger Point ID: 0x2004, 0x3003

Used by ETSI: A

Value Type: Bytes

Used Meta Data:  

Description: The first data packet arrives from the service server
on the data socket.

Service timeout while receiving the first data packet containing content on the
data socket

Trigger Point ID: 0x2005

Used by ETSI: A

Value Type: Bytes

Used Meta Data: ErrorText

Description: Waiting for the first data packet from the service
server timed out.

Service sends the first data packet containing content on the data socket

Trigger Point ID: 0x2006, 0x3004

Used by ETSI: A

Value Type: Bytes

Used Meta Data:  

Description: Sending the first data packet to the service server
on the data socket.

Service failure while sending the first data packet containing content on the data
socket

Trigger Point ID: 0x2007

Used by ETSI: A

Value Type: Bytes
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Used Meta Data: ErrorText

Description: Sending the first data packet to the service server
on the data socket failed.

Service receives the last data packet containing content on the data socket

Trigger Point ID: 0x2008, 0x3005

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: The last data packet arrives from the service server
on the data socket.

Service didn’t receive the last data packet containing content on the data socket

Trigger Point ID: 0x2009

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data: ErrorText

Description: Service didn’t receive the last data packet contain-
ing content on the data socket.

Service did send the last data packet containing content on the data socket

Trigger Point ID: 0x2010, 0x3006

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: The last data packet was sent to the service server
on the data socket.

Service didn’t send the last data packet containing content on the data socket

Trigger Point ID: 0x2011

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data: ErrorText

Description: Service didn’t send the last data packet containing
content on the data socket.
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HTTP capacity test (DL) start

Trigger Point ID: 0x2010, 0x3006

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: The last data packet was sent to the service server
on the data socket.

Sending the first SYN on a data socket

Trigger Point ID: 0x3001

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: Sending the first SYN on data socket.

Reception of the ACK from the SYN/ACK of a service data socket

Trigger Point ID: 0x3002

Used by ETSI: A, B

Value Type: Bytes

Used Meta Data:  

Description: Reception of the ACK from the SYN/ACK of a Ser-
vice data socket.

Service sends DNS request

Trigger Point ID: 0x2012, 0x3007

Used by ETSI: Yes

Value Type: Boolean

Used Meta Data: URL (only available for 0x2012)

Description: Service sends DNS Request.

Service receives a host address from a DNS request

Trigger Point ID: 0x2013, 0x3008

Used by ETSI: Yes

Value Type: Boolean
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Used Meta Data: IP_ADDRESS

Description: Service receives a Host Address from a DNS
Request.

Service didn’t receive a host address from a DNS

Trigger Point ID: 0x2014, 0x3009

Used by ETSI: Yes

Value Type: Boolean

Used Meta Data: ErrorText

Description: Service didn’t receive a Host Address from a DNS
Request.

Service dependent trigger points

Flow FTP download

Figure 9-1: Flow DQA FTP Download ETSI Method A
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Figure 9-2: Flow DQA FTP Download ETSI Method B
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Flow FTP upload

Figure 9-3: Flow DQA FTP Upload ETSI Method A
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Figure 9-4: Flow DQA FTP Upload ETSI Method B

FTP used service independent / general service trigger points

FTP DL TP 1, FTP DL TP 1:

0x1001 : Device sends ATD Command for Connection Request.

FTP DL TP 17, FTP UL TP 17:

0x2001 : Socket Connect Request

0x3001 : Sending the first SYN on data socket

FTP DL TP 20, FTP UL TP 20:

0x2002 : Socket Connect Completed

0x3002 : Reception of the ACK from the SYN/ACK of a Service Data Socket

0x2003 : Socket Connect Failed

FTP UL TP 21;

0x2006 : Service did send the first data packet containing content on the data socket

0x3004 : Sending first Data packet containing content (TCP/IP)

0x2007 : Service didn’t send the first data packet containing content on the data socket

FTP DL TP 22

0x2004 : Service receives the first data packet containing content
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0x2005 : Service Timeout while receiving the data packet containing content on the
data socket

0x3003 : Reception of the first Data packet containing content (TCP/IP)

FTP UL TP 25

0x2010 : Service did send the last data packet containing content on the data socket

0x3006 : Sending last Data packet containing content (TCP/IP)

0x2011 : Service didn’t send the last data packet containing content on the data socket

FTP DL TP 26

0x2008 : Service receives the last data packet containing content

0x3005 : Reception of the last Data packet containing content (TCP/IP)

0x2009 : Service didn’t receive the last data packet containing content

TPs not in Flow:

0x2012 : Service sends DNS Request

0x3007 : Sending DNS Request (TCP/IP)

0x2013 : Service receives a Host Address from a DNS Request

0x3008 : Reception of a Host Address from a DNS Request (TCP/IP)

0x2014 : Service didn’t receive a Host Address from a DNS Request

FTP service start

Trigger Point ID: 0x2101

Used by ETSI: -

Value Type Boolean

Used MetaData: URL, FileName

Description: The FTP Service started

FTP service stopped successfully

Trigger Point ID: 0x2102

Used by ETSI: -

Value Type Boolean

Used MetaData: 0x2102

Description: The FTP Service stopped successfully

FTP service stopped with failure

Trigger Point ID: 0x2103

Used by ETSI: -
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Value Type Boolean

Used MetaData: ErrorText

Description: The FTP Service stopped with Failure

FTP control socket connect request

Trigger Point ID: 0x2104

Used by ETSI: A, B

Value Type Boolean

Used MetaData: IP_ADDRESS

Description: The FTP Control socket tries to establish a connec-
tion to a Host.

TP No in FTP DL: 5

TP No in FTP UL: 5

FTP control socket connect completed

Trigger Point ID: 0x2105

Used by ETSI: -

Value Type Boolean

Used MetaData:  

Description: The FTP Control socket connection has been estab-
lished successfully.

TP No in FTP DL: 8

TP No in FTP UL: 8

FTP control socket connect failed

Trigger Point ID: 0x2106

Used by ETSI: -

Value Type Boolean

Used MetaData: ErrorText

Description: The FTP Control socket connection has failed.

TP No in FTP DL: 8

TP No in FTP UL: 8

FTP login request

Trigger Point ID: 0x2107

Used by ETSI: -
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Value Type Boolean

Used MetaData: URL, UserName

Description: The FTP login request

FTP login success

Trigger Point ID: 0x2108

Used by ETSI: -

Value Type Boolean

Used MetaData:  

Description: The FTP login completed successfully.

FTP login failure

Trigger Point ID: 0x2109

Used by ETSI: -

Value Type Boolean

Used MetaData: ErrorText

Description: The FTP login failed

FTP send list command

Trigger Point ID: 0x2110

Used by ETSI: -

Value Type Boolean

Used MetaData: FileName

Description: Send the FTP LIST command to retrieve the file size
of the requested file. Only available for the first run
of a FTP download job in the job list of a DQA ses-
sion.

FTP receive directory list succeeded

Trigger Point ID: 0x2111

Used by ETSI: -

Value Type Boolean

Used MetaData: -

Description: Received the directory entry from the FTP Send List
Command to retrieve the file size.
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FTP receive directory list failed

Trigger Point ID: 0x2112

Used by ETSI: -

Value Type Boolean

Used MetaData: ErrorText

Description: Didn’t receive the directory entry from the FTP Send
List Command to retrieve the file size.

FTP logout request

Trigger Point ID: 0x2113

Used by ETSI: -

Value Type Boolean

Used MetaData: URL

Description: The FTP logout request

FTP logout completed

Trigger Point ID: 0x2114

Used by ETSI: -

Value Type Boolean

Used MetaData: -

Description: The FTP logout completed

FTP parallel download transfer start

Trigger Point ID: 0x2115

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: The timestamp when the first FTP job in the job list
starts the data transfer.

FTP parallel download transfer succeeded

Trigger Point ID: 0x2116

Used by ETSI: -

Value Type Bytes
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Used MetaData: -

Description: All FTP jobs in the job list have completed the trans-
fer successfully. The timestamp is taken from the job
which completed the data transfer at least.

FTP parallel download transfer failed

Trigger Point ID: 0x2117

Used by ETSI: -

Value Type Bytes

Used MetaData: ErrorText

Description: At least one FTP job in the job list has not comple-
ted the transfer successfully.

FTP parallel upload transfer start

Trigger Point ID: 0x2118

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: The timestamp when the first FTP job in the job list
starts the data transfer.

FTP parallel upload transfer succeeded

Trigger Point ID: 0x2119

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: All FTP jobs in the job list have completed the trans-
fer successfully. The timestamp is taken from the job
which completed the data transfer at least.

FTP parallel upload transfer failed

Trigger Point ID: 0x2120

Used by ETSI: -

Value Type Bytes

Used MetaData: ErrorText

Description: At least one FTP job in the job list has not comple-
ted the transfer successfully.
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Sending the first SYN on FTP control socket

Trigger Point ID: 0x3101

Used by ETSI: A, B

Value Type Bytes

Used MetaData: -

Description: Sending the first SYN on FTP control socket

TP No in FTP DL: 5

TP No in FTP UL: 5

Reception of the ACK from the SYN/ACK of a FTP control socket

Trigger Point ID: 0x3102

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: Reception of the ACK from the SYN/ACK of a FTP
control socket

TP No in FTP DL: 8

TP No in FTP UL: 8

Sending the FTP RETR command

Trigger Point ID: 0x3103

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: reception of Sending the FTP RETR command

TP No in FTP DL: 13

Sending the FTP STOR command

Trigger Point ID: 0x3104

Used by ETSI: -

Value Type Bytes

Used MetaData: -

Description: reception of Sending the FTP STOR command

TP No in FTP UL: 13
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Used ping service independent / general service trigger points

None

Ping sequence start

Trigger Point ID: 0x2201

Used by ETSI: -

Value Type Boolean

Used MetaData: URL

Description: Start of Ping sequence

Ping sequence stop

Trigger Point ID: 0x2202

Used by ETSI: -

Value Type Boolean

Used MetaData:  

Description: Stop of Ping sequence

ICMP echo request

Trigger Point ID: 0x2203, 0x3201

Used by ETSI: -

Value Type Boolean

Used MetaData: IP_ADDRESS

Description: Ping sends an ICMP echo request

ICMP echo reply

Trigger Point ID: 0x2204, 0x3202

Used by ETSI: -

Value Type Boolean

Used MetaData:  

Description: Ping receives an ICMP echo reply

ICMP echo reply failure

Trigger Point ID: 0x2205, 0x3203

Used by ETSI: -

Value Type Boolean
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Used MetaData:  

Description: Error while receiving an ICMP echo reply

Flow HTTP download

Figure 9-5: Flow DQA HTTP Download ETSI Method A
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Figure 9-6: Flow DQA HTTP Download ETSI Method B

HTTP download used service independent / general service trigger points

TP 1 :

0x1001: Device sends ATD Command for Connection Request.

TP 5:

0x2001: Socket Connect Request

0x3001: Sending the first SYN on data socket

TP 8:

0x2002: Socket Connect Completed

0x3002: Reception of the ACK from the SYN/ACK of a Service Data Socket

0x2003: Socket Connect Failed

TP 16

0x2004: Service receives the first data packet containing content

0x2005: Service Timeout while receiving the data packet containing content on the
data socket

0x3003: Reception of the first Data packet containing content (TCP/IP)

TP 26

0x2008: Service receives the last data packet containing content
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0x3005: Reception of the last data packet containing content (TCP/IP)

0x2009: Service didn’t receive the last data packet containing content

TPs not in Flow:

0x2012: Service sends DNS Request

0x3007: Sending DNS Request (TCP/IP)

0x2013: Service receives a Host Address from a DNS Request

0x3008: Reception of a Host Address from a DNS Request (TCP/IP)

0x2014: Service didn’t receive a Host Address from a DNS Request

HTTP service start

Trigger Point ID: 0x2301

Used by ETSI: -

Value Type: Bytes

Used Meta Data: URL, see Chapter 9.3.2, "Trigger point meta data
keys", on page 2268

Description: Start of an HTTP download

HTTP service stop

Trigger Point ID: 0x2302

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: End of the Start of an HTTP download

HTTP sends first GET command

Trigger Point ID: 0x2303, 0x3301

Used by ETSI: B

Value Type: Bytes

Used Meta Data: -

Description: HTTP sends the first GET command.

TP in Flow: 11

HTTP object request

Trigger Point ID: 0x2304

Used by ETSI: -
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Value Type: Bytes

Used Meta Data: URL

Description: Request HTTP object download of an HTML page

TP in Flow: Between 10 and 11

HTTP object received

Trigger Point ID: 0x2305

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: HTTP object of an HTML page received success-
fully

TP in Flow: 18,22 ...

HTTP object error

Trigger Point ID: 0x2306

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: Error while receiving an HTTP object of an HTML
page.

TP in Flow: 18,22 ...

HTTP sending PUT / POST command

Trigger Point ID: 0x2307, 0x3302

Used by ETSI: B

Value Type: Bytes

Used Meta Data: -

Description: Sending the PUT or POST command

TP in Flow: 11

HTTP sending PUT / POST command failed

Trigger Point ID: 0x2308

Used by ETSI: B

Value Type: Bytes

Used Meta Data: -
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Description: Sending the PUT or POST command failed.

TP in Flow: 11

HTTP sending PUT / POST command succeeded

Trigger Point ID: 0x2309

Used by ETSI: B

Value Type: Bytes

Used Meta Data: -

Description: Sending the PUT or POST command succeeded.

TP in Flow: 11

HTTP capacity (DL) test time

Trigger Point ID: 0x2321

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Sending the PUT or POST command succeeded.

TP in Flow: 11

WEB 2.0 action start

Trigger Point ID: 0x2311

Used by ETSI: -

Value Type: Bytes

Used Meta Data: GeneralInfo

Description: Start of a WEB 2.0 Action

TP in Flow:  

WEB 2.0 action completed

Trigger Point ID: 0x2312

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: A WEB 2.0 Action completed successfully.

TP in Flow:  
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WEB 2.0 action failed

Trigger Point ID: 0x2313

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: A WEB 2.0 Action failed.

TP in Flow:  

HTTP capacity test start

Trigger Point ID: 0x2321

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Start HTTP capacity test in DL, UL directions and
bidirectional

HTTP capacity test stop

Trigger Point ID: 0x2322

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Stop HTTP capacity test in DL, UL directions and
bidirectional
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Flow SMTP

Figure 9-7: Flow DQA Email Upload (SMTP) ETSI Method A
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Figure 9-8: Flow DQA Email Upload (SMTP) ETSI Method B

STMP used service independent / general service trigger points

TP 1 :

0x1001 : Device sends ATD Command for Connection Request.

TP 5:

0x2001 : Socket Connect Request

0x3001 : Sending the first SYN on data socket

TP 8:

0x2002 : Socket Connect Completed

0x3002 : Reception of the ACK from the SYN/ACK of a Service Data Socket

0x2003 : Socket Connect Failed

TP 13:

0x2006 : Service did send the first data packet containing content on the data socket

0x3004 : Sending first Data packet containing content (TCP/IP)

0x2007 : Service didn’t send the first data packet containing content on the data socket

TP 21:

0x2010 : Service did send the last data packet containing content on the data socket
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0x3006 : Sending last Data packet containing content (TCP/IP)

0x2011 : Service didn’t send the last data packet containing content on the data socket

TPs not in Flow:

0x2012 : Service sends DNS Request

0x3007 : Sending DNS Request (TCP/IP)

0x2013 : Service receives a Host Address from a DNS Request

0x3008 : Reception of a Host Address from a DNS Request (TCP/IP)

0x2014 : Service didn’t receive a Host Address from a DNS Request

SMTP trigger points

SMTP Service Start

Trigger Point ID: 0x2401

Used by ETSI: -

Value Type: Bytes

Used Meta Data: EmailAddress

Description: Start of a SMTP service

SMTP Service Stopped Successfully

Trigger Point ID: 0x2402

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: SMTP service stopped successfully.

SMTP Service Stopped with Failure

Trigger Point ID: 0x2403

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: SMTP Service stopped with failure.

SMTP Authentication Request

Trigger Point ID: 0x2404

Used by ETSI: -
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Value Type: Bytes

Used Meta Data: UserName

Description: SMTP authentication request

SMTP Authentication Success

Trigger Point ID: 0x2405

Used by ETSI: -

Value Type: Bytes

Used Meta Data:  

Description: SMTP authentication succeeded.

SMTP Authentication Failure

Trigger Point ID: 0x2406

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: SMTP authentication failed.

Sending the SMTP HELO Command

Trigger Point ID: 0x3401

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Sending the SMTP HELO command

TP in Flow: 9

Reception of the SMTP Reply Code 250 for the HELO Command

Trigger Point ID: 0x2407, 0x3402

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Reception of the SMTP reply code 250 for the
HELO command

TP in Flow: 12

Trigger point definitions
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Reception of the SMTP Reply Code 250 for the HELO Command Failed

Trigger Point ID: 0x2408

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: Reception of the SMTP reply code 250 for the
HELO command failed.

TP in Flow: 12

Sending the SMTP MAIL FROM Command

Trigger Point ID: 0x2409, 0x3403

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Sending the SMTP MAIL FROM command

TP in Flow: 13

Reception of the SMTP Reply Code 250 for the EOM Command

Trigger Point ID: 0x2410, 0x3404

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Reception of the SMTP reply code 250 for the EOM
command

TP in Flow: 28

Reception of the SMTP Reply Code 250 for the EOM Command Failed

Trigger Point ID: 0x2411

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: Reception of the SMTP reply code 250 for the EOM
command failed.

TP in Flow: 28

Trigger point definitions
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Sending the SMTP QUIT Command

Trigger Point ID: 0x3405

Used by ETSI: -

Value Type: Bytes

Used Meta Data:  

Description: Sending the SMTP QUIT command.

Flow POP3

Figure 9-9: Flow DQA Email Download POP3 ETSI Method A
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Figure 9-10: Flow DQA Email Download POP3 ETSI Method B

Used POP3 service independent / general service trigger points

TP 1 :

0x1001 : Device sends ATD Command for Connection Request.

TP 5:

0x2001 : Socket Connect Request

0x3001 : Sending the first SYN on data socket

TP 8:

0x2002 : Socket Connect Completed

0x3002 : Reception of the ACK from the SYN/ACK of a Service Data Socket

0x2003 : Socket Connect Failed

TP 20

0x2004 : Reception of the first data packet containing content

0x2005 : Service Timeout while receiving the data packet containing content on the
data socket

0x3003 : Reception of the first Data packet containing content (TCP/IP)

TP 28

0x2008 : Service receives the last data packet containing content

Trigger point definitions
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0x3005 : Reception of the last Data packet containing content (TCP/IP)

0x2009 : Service didn’t receive the last data packet containing content

TPs not in Flow:

0x2012 : Service sends DNS Request

0x3007 : Sending DNS Request (TCP/IP)

0x2013 : Service receives a Host Address from a DNS Request

0x3008 : Reception of a Host Address from a DNS Request (TCP/IP)

0x2014 : Service didn’t receive a Host Address from a DNS Request

POP3 trigger points

POP3 Service Start

Trigger Point ID: 0x2501

Used by ETSI: -

Value Type: Bytes

Used Meta Data: EMailAddress

Description: Start of a POP3 service

POP3 Service Stopped Successfully

Trigger Point ID: 0x2502

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: POP3 service stopped successfully.

POP3 Service Stopped with Failure

Trigger Point ID: 0x2503

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: POP3 service stoppped with failure.

POP3 Authentication Request

Trigger Point ID: 0x2504

Used by ETSI: -

Trigger point definitions
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Value Type: Bytes

Used Meta Data: UserName

Description: POP3 authentication request

POP3 Authentication Success

Trigger Point ID: 0x2505

Used by ETSI: -

Value Type: Bytes

Used Meta Data:  

Description: POP3 authentication succeeded.

POP3 Authentication Failure

Trigger Point ID: 0x2506

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: POP3 authentication failed

Sending the POP3 RETR Command

Trigger Point ID: 0x2507, 0x3501

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Sending the POP3 RETR command

TP in Flow: 17

Sending the POP3 QUIT Command

Trigger Point ID: 0x3502

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: Sending the POP3 QUIT command

TP in Flow: 29

Trigger point definitions
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Flow IMAP

Figure 9-11: Flow DQA Email Download IMAP ETSI Method A
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Figure 9-12: Flow DQA Email Download IMAP ETSI Method B

IMAP Used Service Independent / General Service Trigger Points

IMAP used service independent / general service trigger points

TP 1 :

0x1001 : Device sends ATD Command for Connection Request.

TP 5:

0x2001 : Socket Connect Request

0x3001 : Sending the first SYN on data socket

TP 8:

0x2002 : Socket Connect Completed

0x3002 : Reception of the ACK from the SYN/ACK of a Service Data Socket

0x2003 : Socket Connect Failed

TP 16

0x2004 : Reception of the first data packet containing content

0x2005 : Service Timeout while receiving the data packet containing content on the
data socket

0x3003 : Reception of the first Data packet containing content (TCP/IP)

Trigger point definitions



R&S ROMES4 KPI generatorDrive Test Software

2306Operating Manual 1171.6415.12 ─ 66

TP 24

0x2008 : Service receives the last data packet containing content

0x3005 : Reception of the last Data packet containing content (TCP/IP)

0x2009 : Service didn’t receive the last data packet containing content

TPs not in Flow:

0x2012 : Service sends DNS Request

0x3007 : Sending DNS Request (TCP/IP)

0x2013 : Service receives a Host Address from a DNS Request

0x3008 : Reception of a Host Address from a DNS Request (TCP/IP)

0x2014 : Service didn’t receive a Host Address from a DNS Request

IMAP trigger points

IMAP Service Start

Trigger Point ID: 0x2601

Used by ETSI: -

Value Type: Bytes

Used Meta Data: EMailAddress

Description: Start of a IMAP service

IMAP Service Stopped Successfully

Trigger Point ID: 0x2602

Used by ETSI: -

Value Type: Bytes

Used Meta Data: -

Description: IMAP service stopped successfully.

IMAP Service Stopped with Failure

Trigger Point ID: 0x2603

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: IMAP service stopped with failure.

Trigger point definitions
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IMAP Authentication Request

Trigger Point ID: 0x2604

Used by ETSI: -

Value Type: Bytes

Used Meta Data: UserName

Description: IMAP authentication request

IMAP Authentication Success

Trigger Point ID: 0x2605

Used by ETSI: -

Value Type: Bytes

Used Meta Data:  

Description: IMAP authentication succeeded.

IMAP Authentication Failure

Trigger Point ID: 0x2606

Used by ETSI: -

Value Type: Bytes

Used Meta Data: ErrorText

Description: IMAP authentication failed.

Sending the IMAP FETCH Command

Trigger Point ID: 0x2607, 0x3601

Used by ETSI: B

Value Type: Bytes

Used Meta Data: -

Description: Sending the IMAP FETCH command

TP in Flow: 13

Reception of the IMAP FETCH OK Response

Trigger Point ID: 0x2608, 0x3602

Used by ETSI: A

Value Type: Bytes

Used Meta Data: -

Trigger point definitions
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Description: Reception of the IMAP FETCH OK response

TP in Flow: 16

Reception of the IMAP FETCH OK Response Failed

Trigger Point ID: 0x2609

Used by ETSI: A

Value Type: Bytes

Used Meta Data: -

Description: Reception of the IMAP FETCH OK reponse failed.

TP in Flow: 16

Video streaming with VLC

Used Service Independent and General Service Trigger Points

0x1001 : Device sends ATD Command for Connection Request

VLC Streaming Start

Trigger Point ID: 0x2801

Used by ETSI: -

Value Type: Boolean

Used Meta Data: URL

Description: Start of a VLC streaming job

VLC Streaming Succeeded

Trigger Point ID: 0x2802

Used by ETSI: -

Value Type: Boolean

Used Meta Data:  

Description: VLC streaming job stopped successfully.

VLC Streaming Failed

Trigger Point ID: 0x2803

Used by ETSI: -

Value Type: Boolean

Trigger point definitions
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Used Meta Data: ErrorText

Description: VLC streaming job stopped with failure.

VLC Stream Open Start

Trigger Point ID: 0x2804

Used by ETSI: -

Value Type: Boolean

Used Meta Data:  

Description: VLC start of opening a stream

VLC Stream Open Succeeded

Trigger Point ID: 0x2805

Used by ETSI: -

Value Type: Boolean

Used Meta Data:  

Description: Opening of a stream succeeded.

VLC Stream Open Failed

Trigger Point ID: 0x2806

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Opening of a stream failed.

VLC Stream Playing Start

Trigger Point ID: 0x2807

Used by ETSI: -

Value Type: Boolean

Used Meta Data:  

Description: Start of playing a stream

VLC Stream Playing Succeeded

Trigger Point ID: 0x2808

Used by ETSI: -

Trigger point definitions
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Value Type: Boolean

Used Meta Data:  

Description: Playing a stream succeeded.

VLC Stream Playing Failed

Trigger Point ID: 0x2809

Used by ETSI: -

Value Type: Boolean

Used Meta Data: ErrorText

Description: Playing a stream failed.

VLC Stream Reproduction Cut Off Ratio

Trigger Point ID: 0x2810

Used by ETSI: -

Value Type: Percentage

Used Meta Data: ErrorText

Description: The stream reproduction cut off ratio calculated by
the VLC

9.3.4.2  Voice calls and SQA

Reception of a MOS value

Trigger Point ID: 0x4001

Used by ETSI: -

Value Type: MOS

Used Meta Data:  

Description: Reception of a MOS value calculated by a SQA
local client or remote client.

Start dialing

Trigger Point ID: 0x4002

Used by ETSI: -

Value Type: -

Trigger point definitions
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Used Meta Data: NUMBER

Description: Point in time, when the NQA State Machine within
ROMES starts the dial process.

Voice call connected

Trigger Point ID: 0x4003

Used by ETSI: -

Value Type: -

Used Meta Data: -

Description: Point in time, when the NQA State Machine detects,
that the Voice Call was connected.

Voice call NQA result

Trigger Point ID: 0x4004

Used by ETSI: -

Value Type: Result (0|Good), (1|Blocked), (2|Dropped), (3|No
Service)

Used Meta Data: -

Description: Point in time, when the NQA State Machine gener-
ates the result for the voice call test case.

Playback of speech sample started

Trigger Point ID: 0x4010

Used by ETSI: -

Value Type: -

Used Meta Data: -

Description: Point in time, when the SQA measurement engine
sends the set speech sample to the audio output
device to start playback.

Pause after speech sample started

Trigger Point ID: 0x4011

Used by ETSI: -

Value Type: -

Used Meta Data: -

Description: Point in time, when the SQA measurement engine
pauses, after the speech sample has completed
playback.

Trigger point definitions
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9.3.4.3  SMS

 

Initiate sending a SMS

Trigger Point ID: 0x5101

Used by ETSI: -

Value Type: Boolean

Used Meta Data: NUMBER

Description: Point of time the customer sends his SMS to the
SMS center.

Receiving acknowledgement of the SMSC

Trigger Point ID: 0x5102

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: Point of time the mobile equipment receives the
confirmation from the SMS center.

Receiving acknowledgement of the SMSC failure

Trigger Point ID: 0x5103

Used by ETSI: -

Value Type: Boolean

Used Meta Data: -

Description: The mobile equipment did not receive the confirma-
tion from the SMS center.

9.4  R&S ROMES4 KPI Description

This chapter describes how the KPIs shown in the R&S ROMES KPI View are calcula-
ted. The differentiation is made for the most of the listed group of KPIs between those
derived in accordance to ETSI or R&S ROMES.

The chapter is divided in the following parts depending on what the performance the
KPIs are related to.
● Service Independent KPIs
● FTP Download KPIs
● FTP Upload KPIs

R&S ROMES4 KPI Description
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● HTTP Download KPIs
● E-Mail Download POP3 KPIs
● E-Mail Download IMAP KPIs

9.4.1  Service Independent KPIs

9.4.1.1  ETSI Connect to Network KPIs

Network Unavailability [%]

Before a connect job can start, the network availability is checked. This parameter is
the proportion of unsuccessful network availability checks and the total number of net-
work availability checks.

Attach Failure Ratio [%]

The attach failure ratio describes the probability that a subscriber cannot attach to the
PS network.

Trigger Points

Start: [TP 1]

Mobile sends the attach request message.

Stop: [TP 4]

Mobile receives the attach accept message.

R&S ROMES4 KPI Description
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Attach Setup Time [ms]

This attach setup time describes the time period needed to attach to the PS network.

Setup Time [ms] = t attach complete [ms] – t attach request [ms]

Trigger Points

Start: [TP 1]

Mobile sends the attach request message.

Stop: [TP 4]

Mobile receives the attach accept message.

PDP Context Activation Failure Ratio [%]

The PDP context activation failure ratio denotes the probability that the PDP context
cannot be activated. It is the proportion of unsuccessful PDP context activation
attempts and the total number of PDP context activation attempts.

Trigger Points

Start: [TP 5]

Mobile sends the PDP context activation request message.

Stop: [TP 8]

Mobile receives the PDP context activation accept message.

PDP Context Activation Time [ms]

This parameter describes the time period needed for activating the PDP context.

PDP Context Activation Time [ms] = t pdp context activation accept [ms] – t pdp con-
text activation request [ms]

9.4.1.2  R&S ROMES4 PDP Context Activation Ratio KPI

The PDP context activation ratio denotes the probability that the PDP context can be
activated. It is the proportion of successful PDP context activation attempts and the
total number of PDP context activation attempts.

Trigger Points

Start: [TP 5]

Mobile sends the PDP context activation request message.

R&S ROMES4 KPI Description
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Stop: [TP 8]

Mobile receives the PDP context activation accept message.

9.4.2  FTP Download KPIs

9.4.2.1  ETSI FTP Download KPIs

R&S ROMES4 KPI Description
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Service Accessibility Ratio [%]

The service accessibility ratio denotes the probability that a subscriber can establish a
PDP context and access the service successfully.

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 22]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

R&S ROMES4 KPI Description
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Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Setup Time [ms]

The setup time describes the time period needed to access the service successfully,
from starting the dial-up connection to the point of time when the content is sent or
received.

Setup Time [ms] = first data packet received [ms] – dialup connection initiated [ms]

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 22]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

IP – Service Access Ratio [%]

The IP-service access ratio denotes the probability that a subscriber can establish an
IP connection to the server of a service successfully.

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 22]

Reception of the first data packet containing content.

ETSI Method B:

R&S ROMES4 KPI Description
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Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

IP – Service Setup Time [ms]

The IP-service setup time is the time period needed to establish an IP connection to
the server of a service, from sending the initial query to a server to the point of time
when the content is sent or received.

IP Service Setup Time [ms] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 22]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Completed Session Ratio [%]

The completed session ratio is the proportion of completed sessions and sessions that
were started successfully.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

R&S ROMES4 KPI Description
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- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.

Session Time [ms]

The session time is the time period needed to successfully complete a data session.

Session Time [ms] = session end [ms] – session start [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.

Mean Data Rate [kBit/s]

After a data connection has been successfully established, this parameter describes
the average data transfer rate measured throughout the entire connect time to the ser-
vice. The data transfer shall be successfully terminated. The prerequisite for this
parameter is network and service access.

Trigger Points

ETSI Method A:

Start: [TP 22]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK] (Data
Socket).

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 26]

R&S ROMES4 KPI Description
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Reception of the last data packet containing content.

Data Transfer Cut-off Ratio [%]

The data transfer cut-off ratio is the proportion of incomplete data transfers and data
transfers that were started successfully.

Trigger Points

ETSI Method A:

Start: [TP 22]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK] (data
socket).

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 26]

Reception of the last data packet containing content.

Round Trip Time [ms]

The round trip time is the time required for a packet to travel from a source to a desti-
nation and back. It is used to measure the delay on a network at a given time. For this
measurement the service must already be established.

IP Service Setup Time [s] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 7]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP control socket connection.

R&S ROMES4 KPI Description
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9.4.2.2  R&S ROMES FTP Download KPIs

Transfer Time [ms]

The transfer time is the time span between start and end of the data transfer. Although
this is not an ETSI KPI, the time calculation depends on the selected ETSI method,
because this transfer time is used to calculate the Mean Data Rate KPI.

Transfer Time [ms] = transfer end [ms] – transfer start [ms]

Trigger Points

ETSI Method A:

Start: [TP 22]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK] (Data
Socket).

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 26]

Reception of the last data packet containing content.

Session Failure Ratio [%]

The session failure ratio is the proportion of not sessions with failure and all success-
fully started sessions.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.

R&S ROMES4 KPI Description
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9.4.3  FTP Upload KPIs

9.4.3.1  ETSI FTP Upload KPIs

R&S ROMES4 KPI Description
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Service Accessibility Ratio [%]

The service accessibility ratio denotes the probability that a subscriber can establish a
PDP context and access the service successfully.

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 21]

Sending of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

R&S ROMES4 KPI Description
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ATD command from the mobile to the network.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Setup Time [ms]

The setup time describes the time period needed to access the service successfully,
from starting the dial-up connection to the point of time when the content is sent or
received.

Setup Time [ms] = first data packet sent [ms] – dialup connection initiated [ms]

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 21]

Sending of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

IP – Service Access Ratio [%]

The IP-service access ratio denotes the probability that a subscriber can establish an
IP connection to the server of a service successfully.

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 21]

Sending of the first data packet containing content.

R&S ROMES4 KPI Description
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ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

IP – Service Setup Time [ms]

The IP-service setup time is the time period needed to establish an IP connection to
the server of a service, from sending the initial query to a server to the point of time
when the content is sent or received.

IP Service Setup Time [ms] = sending of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 21]

Sending of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK]

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Completed Session Ratio [%]

The completed session ratio is the proportion of completed sessions and sessions that
were started successfully.

Trigger Points

ETSI Method A / ETSI Method B:
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Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP data socket closed.

Session Time [ms]

The session time is the time period needed to successfully complete a data session.

Session Time [ms] = session end [ms] – session start [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP data socket closed.

Mean Data Rate [kBit/s]

After a data connection has been successfully established, this parameter describes
the average data transfer rate measured throughout the entire connect time to the ser-
vice. The data transfer shall be successfully terminated. The prerequisite for this
parameter is network and service access.

Trigger Points

ETSI Method A:

Start: [TP 21]

Sending of the first data packet containing content.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP data socket closed
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ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK] (Data
Socket).

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP data socket closed.

Data Transfer Cut-off Ratio [%]

The data transfer cut-off ratio is the proportion of incomplete data transfers and data
transfers that were started successfully.

Trigger Points

ETSI Method A:

Start: [TP 21]

Sending of the first data packet containing content.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP Data Socket closed

ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK] (data
socket).

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 30]

KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet con-
taining content.

KPI calculation without IP Tracer: FTP Data Socket closed.

Round Trip Time [ms]

The round trip time is the time required for a packet to travel from a source to a desti-
nation and back. It is used to measure the delay on a network at a given time. For this
measurement the service must already be established.
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IP Service Setup Time [s] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 7]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK].

- KPI calculation without IP Tracer: Successful FTP control socket connection.

9.4.3.2  R&S ROMES FTP Upload KPIs

Transfer Time [ms]

The transfer time is the time span between start and end of the data transfer. Although
this is not an ETSI KPI, the time calculation depends on the selected ETSI method,
because this transfer time is used to calculate the Mean Data Rate KPI.

Transfer Time [ms] = transfer end [ms] – transfer start [ms]

Trigger Points

ETSI Method A:

Start: [TP 21]

Sending of the first data packet containing content.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP Data Socket closed

ETSI Method B:

Start: [TP 20]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: Successful FTP data socket connection.

Stop: [TP 26]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

- KPI calculation without IP Tracer: FTP data socket closed.
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Session Failure Ratio [%]

The session failure ratio is the proportion of not sessions with failure and all success-
fully started sessions.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 30]

- KPI calculation with IP Tracer: Reception of the [FIN, ACK] for the last data packet
containing content.

KPI calculation without IP Tracer: FTP data socket closed.
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9.4.4  HTTP Download KPIs

9.4.4.1  ETSI HTTP Download, WEB 2.0 KPIs
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Service Accessibility Ratio [%]

The service accessibility ratio denotes the probability that a subscriber can establish a
PDP context and access the service successfully.

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 11]

Sending of the first GET command.
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Setup Time [ms]

The setup time describes the time period needed to access the service successfully,
from starting the dial-up connection to the point of time when the content is sent or
received.

Setup Time [ms] = first data packet received [ms] – dialup connection initiated [ms]

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 11]

Sending of the first GET command.

IP – Service Access Ratio [%]

The IP-service access ratio denotes the probability that a subscriber can establish an
IP connection to the server of a service successfully.

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP socket connect request.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP socket connect request.

Stop: [TP 11]
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Sending of the first GET command.

IP – Service Setup Time [ms]

The IP-service setup time is the time period needed to establish an IP connection to
the server of a service, from sending the initial query to a server to the point of time
when the content is sent or received.

IP Service Setup Time [ms] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP socket connect request.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP socket connect request.

Stop: [TP 11]

Sending of the first GET command.

Completed Session Ratio [%]

The completed session ratio is the proportion of completed sessions and sessions that
were started successfully.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP control socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.
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Session Time [ms]

The session time is the time period needed to successfully complete a data session.

Session Time [ms] = session end [ms] – session start [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.

Mean Data Rate [kBit/s]

After a data connection has been successfully established, this parameter describes
the average data transfer rate measured throughout the entire connect time to the ser-
vice. The data transfer shall be successfully terminated. The prerequisite for this
parameter is network and service access.

Trigger Points

ETSI Method A:

Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 11]

Sending of the first GET command.

Stop: [TP 26]

Reception of the last data packet containing content.

Data Transfer Cut-off Ratio [%]

The data transfer cut-off ratio is the proportion of incomplete data transfers and data
transfers that were started successfully.
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Trigger Points

ETSI Method A:

Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 11]

Sending of the first GET command.

Stop: [TP 26]

Reception of the last data packet containing content.

Round Trip Time [ms]

The round trip time is the time required for a packet to travel from a source to a desti-
nation and back. It is used to measure the delay on a network at a given time. For this
measurement the service must already be established.

IP Service Setup Time [s] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: FTP control socket connect request.

Stop: [TP 7]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK].

- KPI calculation without IP Tracer: Successful HTTP socket connection.

9.4.4.2  R&S ROMES HTTP Download, WEB 2.0 KPIs

Transfer Time [ms]

The transfer time is the time span between start and end of the data transfer. Although
this is not an ETSI KPI, the time calculation depends on the selected ETSI method,
because this transfer time is used to calculate the Mean Data Rate KPI.

Transfer Time [ms] = transfer end [ms] – transfer start [ms]

Trigger Points

ETSI Method A:
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Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 26]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 11]

Sending of the first GET command.

Stop: [TP 26]

Reception of the last data packet containing content.

Session Failure Ratio [%]

The session failure ratio is the proportion of not sessions with failure and all success-
fully started sessions.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: HTTP control socket connect request.

Stop: [TP 26]

Reception of the last data packet containing content.

9.4.4.3  HTTP Capacity Test KPIs

The HTTP Capacity Test KPIs are releated to the Downlink, Uplink and Downlink and
Uplink transfer time. The transfer time is a time elapsed between the transfer starts
and transfer ends in miliseconds.

Capacity (DL) Test Time

<kpi/>

<kpi name="HTTP Capacity Test (DL) Time" id="3201" timeout="-1" type="DURATION"
 session="true" reinitiate="false" unit="ms" >

<triggerpoint role="start" id="0x00012321040408A6"></triggerpoint>

    <triggerpoint role="stop" id="0x01012322040408A6"></triggerpoint>

<kpi/>
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Capacity (UL) Test Time

<kpi/>

<kpi name="HTTP Capacity Test (UL) Time" id="3202" timeout="-1" type="DURATION"
 session="true" reinitiate="false" unit="ms" >

<triggerpoint role="start" id="0x00022321040408A6"></triggerpoint>

    <triggerpoint role="stop" id="0x01022322040408A6"></triggerpoint>

<kpi/>

Capacity (DL/UL) Test Time

<kpi/>

<kpi name="HTTP Capacity Test (DL/UL) Time" id="3203" timeout="-1" type="DURATION"
 session="true" reinitiate="false" unit="ms" >

<triggerpoint role="start" id="0x00032321040408A6"></triggerpoint>

    <triggerpoint role="stop" id="0x01032322040408A6"></triggerpoint>

<kpi/>
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9.4.5  E-Mail KPIs

9.4.5.1  ETSI E-Mail Download POP3 KPIs
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Service Accessibility Ratio [%]

The service accessibility ratio denotes the probability that a subscriber can establish a
PDP context and access the service successfully.

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 20]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.
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Stop: [TP 17]

Send RETR command.

Setup Time [ms]

The setup time describes the time period needed to access the service successfully,
from starting the dial-up connection to the point of time when the content is sent or
received.

Setup Time [ms] = first data packet received [ms]– dialup conncetion initiated [ms]

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 20]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 17]

Send RETR command.

IP – Service Access Ratio [%]

The IP-service access ratio denotes the probability that a subscriber can establish an
IP connection to the server of a service successfully.

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 20]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.
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- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 17]

Send RETR command.

IP – Service Setup Time [ms]

The IP-service setup time is the time period needed to establish an IP connection to
the server of a service, from sending the initial query to a server to the point of time
when the content is sent or received.

IP Service Setup Time [ms] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 20]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 control socket connect request.

Stop: [TP 17]

Send RETR command.

Completed Session Ratio [%]

The completed session ratio is the proportion of completed sessions and sessions that
were started successfully.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 27]
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Reception of the last data packet containing content.

Session Time [ms]

The session time is the time period needed to successfully complete a data session.

Session Time [ms] = session end [ms] – session start [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 27]

Reception of the last data packet containing content.

Mean Data Rate [kBit/s]

After a data connection has been successfully established, this parameter describes
the average data transfer rate measured throughout the entire connect time to the ser-
vice. The data transfer shall be successfully terminated. The prerequisite for this
parameter is network and service access.

Trigger Points

ETSI Method A:

Start: [TP 20]

Reception of the first data packet containing content.

Stop: [TP 27]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 17]

Send RETR command.

Stop: [TP 27]

Reception of the last data packet containing content.

Data Transfer Cut-off Ratio [%]

The data transfer cut-off ratio is the proportion of incomplete data transfers and data
transfers that were started successfully.
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Trigger Points

ETSI Method A:

Start: [TP 20]

Reception of the first data packet containing content.

Stop: [TP 27]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 17]

Sending of the RETR command.

Stop: [TP 27]

Reception of the last data packet containing content.

Round Trip Time [ms]

The round trip time is the time required for a packet to travel from a source to a desti-
nation and back. It is used to measure the delay on a network at a given time. For this
measurement the service must already be established.

IP Service Setup Time [s] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 7]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK].

- KPI calculation without IP Tracer: Successful POP3 socket connection.

9.4.5.2  R&S ROMES E-Mail Download POP3 KPIs

Transfer Time [ms]

The transfer time is the time span between start and end of the data transfer. Although
this is not an ETSI KPI, the time calculation depends on the selected ETSI method,
because this transfer time is used to calculate the Mean Data Rate KPI.

Transfer Time [ms] = transfer end [ms] – transfer start [ms]
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Trigger Points

ETSI Method A:

Start: [TP 20]

Reception of the first data packet containing content.

Stop: [TP 27]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 17]

Sending of the RETR command.

Stop: [TP 27]

Reception of the last data packet containing content.

Session Failure Ratio [%]

The session failure ratio is the proportion of not sessions with failure and all success-
fully started sessions.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: POP3 socket connect request.

Stop: [TP 27]

Reception of the last data packet containing content.

9.4.6  E-Mail KPIs

9.4.6.1  ETSI E-Mail Download IMAP KPIs

ETSI does not define calculations for IMAP. Due to that, the trigger points for IMAP are
calculated with the ETSI methods A/B equivalent to the POP3 protocol.
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Service Accessibility Ratio [%]

The service accessibility ratio denotes the probability that a subscriber can establish a
PDP context and access the service successfully.

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 13]
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Send FETCH command.

Setup Time [ms]

The setup time describes the time period needed to access the service successfully,
from starting the dial-up connection to the point of time when the content is sent or
received.

Setup Time [ms] = first data packet received [ms]– dialup conncetion initiated [ms]

Trigger Points

ETSI Method A:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 1]

ATD command from the mobile to the network.

Stop: [TP 13]

Send FETCH command.

IP – Service Access Ratio [%]

The IP-service access ratio denotes the probability that a subscriber can establish an
IP connection to the server of a service successfully.

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

R&S ROMES4 KPI Description



R&S ROMES4 KPI generatorDrive Test Software

2348Operating Manual 1171.6415.12 ─ 66

Stop: [TP 13]

Send FETCH command.

IP – Service Setup Time [ms]

The IP-service setup time is the time period needed to establish an IP connection to
the server of a service, from sending the initial query to a server to the point of time
when the content is sent or received.

IP Service Setup Time [ms] = reception of first data packet [ms] – first [SYN] sent [ms]

Trigger Points

ETSI Method A:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 16]

Reception of the first data packet containing content.

ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP control socket connect request.

Stop: [TP 13]

Send FETCH command.

Completed Session Ratio [%]

The completed session ratio is the proportion of completed sessions and sessions that
were started successfully.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 24]

Reception of the last data packet containing content.
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Session Time [ms]

The session time is the time period needed to successfully complete a data session.

Session Time [ms] = session end [ms]– session start [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 24]

Reception of the last data packet containing content.

Mean Data Rate [kBit/s]

After a data connection has been successfully established, this parameter describes
the average data transfer rate measured throughout the entire connect time to the ser-
vice. The data transfer shall be successfully terminated. The prerequisite for this
parameter is network and service access.

Trigger Points

ETSI Method A:

Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 24]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 13]

Send FETCH command.

Stop: [TP 24]

Reception of the last data packet containing content.

Data Transfer Cut-off Ratio [%]

The data transfer cut-off ratio is the proportion of incomplete data transfers and data
transfers that were started successfully.
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Trigger Points

ETSI Method A:

Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 24]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 13]

Send FETCH command.

Stop: [TP 24]

Reception of the last data packet containing content.

Round Trip Time [ms]

The round trip time is the time required for a packet to travel from a source to a desti-
nation and back. It is used to measure the delay on a network at a given time. For this
measurement the service must already be established.

IP Service Setup Time [s] = reception of first data packet [ms]– first [SYN] sent [ms]

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 7]

- KPI calculation with IP Tracer: Reception of the [ACK] from the [SYN, ACK].

- KPI calculation without IP Tracer: Successful IMAP socket connection.

9.4.6.2  R&S ROMES E-Mail Download IMAP KPIs

Transfer Time [ms]

The transfer time is the time span between start and end of the data transfer. Although
this is not an ETSI KPI, the time calculation depends on the selected ETSI method,
because this transfer time is used to calculate the Mean Data Rate KPI.

Transfer Time [ms] = transfer end [ms] – transfer start [ms]

Trigger Points

ETSI Method A:

R&S ROMES4 KPI Description
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Start: [TP 16]

Reception of the first data packet containing content.

Stop: [TP 24]

Reception of the last data packet containing content.

ETSI Method B:

Start: [TP 13]

Send FETCH command.

Stop: [TP 24]

Reception of the last data packet containing content.

Session Failure Ratio [%]

The session failure ratio is the proportion of not sessions with failure and all success-
fully started sessions.

Trigger Points

ETSI Method A / ETSI Method B:

Start: [TP 5]

- KPI calculation with IP Tracer: First [SYN] sent.

- KPI calculation without IP Tracer: IMAP socket connect request.

Stop: [TP 24]

Reception of the last data packet containing content.

R&S ROMES4 KPI Description
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10  Messages
This chapter describes the messages shown during database maintenance proce-
dures. Some of the choice list dialogs do not appear during measurement, they are
only shown during manual database manipulations. Those messages are written to the
file CtoI_Reports.txt in the TestFiles subdirectory of the R&S ROMES4 main
directory.

● Message dialogs................................................................................................. 2352
● Choice list dialogs............................................................................................... 2352

10.1  Message dialogs

● "DB Init: Database Init OK": A database has been successfully loaded.
● "DB Init: Init Failed": The database could not be loaded. See the accompanying

choice list dialog for details.
● "DB Init: Transmitter Scan is nonlinear": There are several Transmitter Scan values

out of the allowed deviation. See the accompanying choice list dialog for details.

The other message dialogs are self explanatory.

10.2  Choice list dialogs

10.2.1  Message #1: Info – Unexpected network type

Message #1      Info
                Unexpected network type
                Database: DCS1800
                BTS_INFO frame: GSM
                Abort

Reason

A database was loaded which contains a network type different from the one chosen in
the "network" field in the "DB Settings/Query" dialog.

Effect

The new database was not loaded.

Choice list dialogs
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10.2.2  Message #2: Info – Missing DLL

Message #2      Info
                Missing DLL
                No DLL GSS_K6_Import_... is available in the path
                Abort

Reason

If the user takes the opportunity to write a dynamical linked library (DLL) to define the
load-ing of a network operator file of its own format this DLL must be in the main direc-
tory or in a directory being in the path so that automatic loading is possible.

Effect

The database is not created or updated.

10.2.3  Message #3: Info - Skip sector...

Message #3      Info
                Skip sector <nr> (name)
                Abort
                Suppress  this message for the next sectors
                OK

Reason

If the user takes the opportunity to write a dynamical linked library (DLL) to define the
loading of a network operator file of its own format (see chapter 5) and has defined a
situation where loading yields the return value SKIP_SECTOR this message appears,
showing the sector number <nr> and, if defined, the sector name.

Effect

Abort selected: The database remains unchanged.

Suppress this message for the next sectors: During loading of the ASCII file, this mes-
sage is not shown anymore on screen. Instead, all subsequent messages are written
into the file Dummy.chl in the subdirectory TestFiles.

OK selected: This sector is not loaded, but the program continues loading the next sec-
tor.

10.2.4  Message #4: Format error wrong BCC

Message #4      Format error
                Wrong BCC
                At value: 8
                In line 33

Choice list dialogs
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                BTS1 | 22.33454 | 44.5666 | 8 | 120 | 34 | 77
                Abort

Reason

Format error was found in ASCII text.

Effect

The database remains unchanged.

Remarks

The error is specified in more detail by the name (here BCC), the value (here 8), the
line number in the text file (here 33, where caption line is line number 0) and the con-
tents of the complete line.

10.2.5  Message #5: Info - Line buffer ...

Message #5      Info
                Line buffer too small while reading antenna type list
                Abort

Reason

The length of one line in the antenna type list text file exceeds 256 bytes.

Effect

The database remains unchanged.

Remarks

The end-of-line character is Line Feed (= 0x0A)

10.2.6  Message #6: Info - More than 3 ...

Message #6      Info
                More than 3 sectors at one position with the same clock code.
                Ok

Reason

The database can handle up to 3 synchronized sectors at one position. If more than 3
sec-tors at one position share the same clock code, the PCSD will try to separate the
sectors by their name. If that is not possible a message occurs.

Effect

The database remains unchanged.

Choice list dialogs
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10.2.7  Message #7: Info - Skip invalid position...

Message #7      Info
                Skip invalid position value:
                34.5566 -> 34.5578
                11.2345 -> 11.4345
                22.2 km (distance) > 0.6 km (max. range)
                Ok
                All

Reason

Before processing any Transmitter Scan data the system checks whether a valid posi-
tion value was obtained during the last 3 evaluated seconds. A position value is valid if
it lies inside a circle of radius r = 100 m + 120 km/h * (t - t1) around the position mea-
sured at time t1. Message no. 10 indicates that an invalid position value was detected.

Effect

OK selected:

The indicated position value will be skipped.

All selected:

The indicated position value and all subsequent invalid position values will be skipped.

Remarks

Parameters displayed:

position measured at time t1 (here: 34.5566, 11.2345)

invalid position at time t (here: 34.5578, 11.4345)

distance between the position values (here: 22.2 km)

allowed distance (here: 0.6 km)

10.2.8  Message #8: Info - Measurement not related...

Message #8      Info
                Measurement not related to database.
                Ok

Reason

No Transmitter Scan was assigned to a BTS in the database.

Effect

The database remains unchanged.

Choice list dialogs
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Remarks

Possible reasons
● The GPS was not working properly during the Transmitter Scan. In this case no

position data for the Transmitter Scan are found and an assignment to a BTS is not
possible.

● The Transmitter Scan was performed in an area for which no BTSs are available in
the database

● The network has been provided with a new channel configuration, but the database
has not been updated with this new configuration.

● If there is a finite reset probability per month for a BTS, the total reset probability
might be above a threshold where an assignment is still reasonable. In this case, a
new database should be created.

10.2.9  Message #9: Info - Start time...

Message #11     Info
                Start time evaluation failed.
                Ok

Reason

Synchronization between previous Transmitter Scans and the new one failed.

Effect

The database remains unchanged.

Remarks

No common BTSs were found or the reset probability for the BTSs found was too high.

10.2.10  Message #10: Different timing...

Example 1

Message #12     Different timing for one base station:
                BTS_A1 [25: 7 ]
                [ C0:BCC]    Probability  T51(TS)/us  Distance/km  Power/dBm
                [ 25: 7 ]    99.7%        011234      3.5          -77
                [ 25: 7 ]    98.4%        123567      4.7          -88
                Do not use 1st measurement.
                Do not use 2nd measurement.
                Do not use either measurement.

BTS_A1 [25: 7 ] BTS name [C0: BCC]

[ C0:BCC] Channel and BCC of measurement value

Probability Probability that the measurement belongs to the given BTS

Choice list dialogs
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T51(TS)/us Synchronization time of the T51 frame within the Transmitter Scan.

Note: This time (TS) is not the time in the database because the start time of the
Transmitter Scan file was not evaluated while this message was produced.

Distance/km Distance of measurement to the BTS

Power/dBm Received power in Transmitter Scan

Example 2

Message #12     Different timing for one base station:
                BTS_B1 [27: 7 ]
                BTS_B2 [33: 7 ]
                BTS_B3 [49: 3 ]
                [ C0:BCC]    Probability  T51(dB)/us  Distance/km  Power/dBm
                [ 33: 7 ]    99.3%        055534      3.5          -61
                [ 49: 3 ]    97.4%        177777      4.7          -85
                Do not use 1st measurement.
                Do not use 2nd measurement.
                Do not use either measurement.

BTS_B1 [27: 7 ]

BTS_B2 [33: 7 ]

BTS_B3 [49: 3 ]

Names of synchronized sectors and [C0: BCC] information.

[ C0:BCC] Channel and BCC of measurement value

Probability Probability that the measurement belongs to the given BTS (one of the sectors)

T51(dB)/us Synchronization time of the T51 frame within the Transmitter Scan.

Note: This time (dB) is the time in the database because the start time of the Trans-
mitter Scan file was evaluated before this message was produced.

Distance/km Distance of measurement to the BTS

Power/dBm Received power in Transmitter Scan

Reason

● The BTS list is not complete or the C0 channel number or BCC value has been
changed.

● During the Transmitter Scan a signal from BTS A [C0, BCC] was received next to
BTS B. The power of the signal was high with respect to the distance to BTS A and
C0, BCC is reused for BTS B. In this case the evaluated probability value that the
received signal belongs to BTS B was higher than 95%. At another location next to
BTS B the signal of BTS B was received. So there are two measurements for BTS
B.

● If 2 or 3 sectors are given and the measurements have been performed on different
channels (as in example 2) the clock code setting for this BTS may be wrong. In
this case the given sectors have the same clock code and the PCSD is forced to
assign the same synchronization time to each sector. If the sectors are not
synchronized, then this message is displayed.

Choice list dialogs
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Effect

Either the first, the second or both measurements can be discarded.

Remarks

To assign a Transmitter Scan value to a BTS the probability that the measurement
belongs to the BTS is calculated and assessed. The assignment is made if this proba-
bility exceeds 95%. In the case that two measurements with different synchronization
times for the T51 frames belong to the same BTS with a probability greater than 95%,
message no. 13 will appear.

10.2.11  Message #11: Difficult assignment

Example 1

Message #13     Difficult assignment:
                TS from: 06.22.97 15.30.07  P =-88 dBm T51 = 098840 
                Sector name   p(P)    p(P, T51)   d/km   T51/us
                BTS_A1       98.0%    1.5%        3.7    123456
                BTS_B2       2.0%     98.5%       17.8   098883
                Use first assignment
                Do not use first assignment

Example 2

Message #13     Difficult assignment:
                TS from: 06.22.97 15.30.07  P =-69 dBm T51 = 05789 
                Sector name   p(P)   p(P, T51)   d/km   T51/us
                BTS_A1       98.0%   3.5%        3.7    123456
                TS_B2        2.0%    96.5%       19.5   ---
                Use first assignment
                Do not use first assignment

TS from: 06.22.97 15.30.07 Date and time of the measurement

P = -88 dBm Measured power

T51 = 098840 Measured synchronization time for T51 frame

Sector name Name of the sector of both BTSs the measurement may belong to

p(P) Probability of received power

p(P, T51) Probability of received power and T51 synchronization time

d/km Distance from the measurement position to the location of BTS

T51/us Last synchronization time value assigned to the BTS

Reason

In both examples, the first given BTS has the higher power probability, whereas the
second has the higher probability with respect to power and time.

Choice list dialogs
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In example 1 it is highly probable that the measurement belongs to the BTS_B2 due to
the matching of the old and new measured T51 time.

In example 2 the new measured T51 value does not match the value in the database
for BTS_A1. For the BTS_B2 no previous synchronization time measurement exists.
This is why the probability p(P, T51) for BTS_B2 is higher than for BTS_A1.

Effect

Example 1:

<Do not use first assignment> may be a good choice.

Example 2:

If it is positively known that BTS_A1 was hit by a reset between the last and the new
Transmitter Scan, or if it is not probable that the signal from BTS_B2 was received with
a power of –67 dBm at a distance of 19.5 km, then it may be the right choice to assign
the measurement value to BTS_A1 by selecting <Use first assignment>.

Remarks

To assign a Transmitter Scan to a BTS, two probabilities p(P) and p(P, T51) will be
evaluated if some BTSs already have synchronization time values obtained from other
measurements in the same Transmitter Scan file or other measurements in the data-
base.

The probability p(P) takes into account the received power and position of the mea-
surement and location, transmitted power, antenna type and direction for all the BTSs
listed in the database which match the C0 and BCC of the Transmitter Scan.

For the probability p(P, T51) will be used in addition to the measured synchronization
time of the T51 frame and the probability function for this synchronization time for each
BTS which depend on the existence of a previous T51 measurement, the age of this
measurement, the drift of the BTS and the reset probability. In case that p(P) and p(P,
T51) contradict each other, message no. 13 will be produced.

10.2.12  Message #12: Info - ... sectors were...

Message #14     Info
                ... sectors were discarded in the validation of its values
                Ok

Reason

After reading a base station list, the program checks, whether the entries are consis-
tent (e.g. channel 150 does not denote a valid channel). If the data are not consistent,
a message appears in the K6 Message View window for each sector containing such
inconsistent data.

Effect

These sectors are not included in the database.

Choice list dialogs
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11  R&S ROMES4 remote control
R&S ROMES4 Remote Control function requires the R&S ROMES4RCO option.

The chapter describes commands and messages supported by the R&S ROMES4
Remote Control IP Socket application.

● R&S ROMES4 IP remote control - getting started.............................................. 2360
● Remote control commands................................................................................. 2365
● Available devices and measurement engines.....................................................2374
● Measurement engines.........................................................................................2377
● Remote control messages.................................................................................. 2379

11.1  R&S ROMES4 IP remote control - getting started

The chapter describes the following tasks:
● Setting up a remote connection to R&S ROMES4 using the PuTTY tool. Use http://

www.putty.org/ to download the tool.
● Performing an ACD task
● Retrieving the Top N lists for GSM, UMTS and LTE.

11.1.1  Setting up R&S ROMES4 remote connection

1. Install R&S ROMES4 software.
Ensure that the necessary options for doing the aforementioned tasks are availa-
ble.

2. If IP socket is used, set the DWORD (32-bit) registry key RemoteSocket to 1 in
HKEY_CURRENT_USER\Software\Rohde & Schwarz\ROMES4<version>\
General\RemoteSocket.

Figure 11-1: RemoteSocket key setting

Note: If the registry key "RemoteSocket" is set, all startup dialogs of the R&S
ROMES4 user interface (UI) are disabled. To have all UI dialogs enabled again

R&S ROMES4 IP remote control - getting started
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after using R&S ROMES4 as remote controlled, delete the RemoteSocket key from
the registry again.
By default, R&S ROMES4 listens on port 8084. To change the port number, create
the WORD (32-bit) registry key RemoteSocketPort and modify the key's value with
wanted port number in
HKEY_CURRENT_USER\Software\Rohde & Schwarz\ROMES4<version>\
General\RemoteSocketPort.

Figure 11-2: RemoteSocketPort creation and modifying the port value

3. Setup first the Top N pool for GMS, UMTS and LTE, respectively in "TEC for...".
Check if the pools for the mentioned technologies are set to manual pool configura-
tion. The manual pool configuration handles all detected cells without filtering.

Figure 11-3: Selection of manual Top N pool configuration

4. In order to get the information about the best server for different technologies, use
signal sets (Top N pool signals for GSM, UMTS and LTE). These signal sets give
the value for the first Top N pool for each technology. On how to create these signal
sets, refer to Chapter 11.2.1.3, "Measurement data command", on page 2370.

5. Start PuTTY; select the values for the "Connection type", "Host Name (or IP
address)" and "Port" parameters as shown in the figure Figure 11-4.

R&S ROMES4 IP remote control - getting started
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Figure 11-4: PuTTY configuration

6. Press the "Open" button.

The remote connection to R&S ROMES4 by using PuTTY application is estab-
lished now. The PuTTY window becomes black and the R&S ROMES4 window
shows the red "Remote" pane in the status bar as the indication of the established
remote connection.

11.1.2  Doing mesurement tasks

11.1.2.1  ACD and top n measurement for LTE, UMTS and GSM on selected bands with
best server information

Example: 
Perform the ACD measurement for LTE on bands 3, 7 and 20, for GSM on bands 900
and 1800 and for UMTS on band 1. The corresponding command is
Wizard ACD smart LTE@3,7,20 GSM@900,1800 UMTS@1.

R&S ROMES4 IP remote control - getting started
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Once the command is entered and the "Return" button is pressed, R&S ROMES4
starts configuring the measurement task automatically and responds with "OK".

1. To register the client for getting ACD measurement data, execute the command
Register Data ACD.

2. To get additionally the Top N data for each technology, load the corresponding sig-
nal sets you have created under the step 4. of the procedure explained in the
Chapter 11.1, "R&S ROMES4 IP remote control - getting started", on page 2360.
Choose 1 second for the update rate.
Load GSM as set 0, UMTS as set 1 and LTE as set 2. The commands are
SignalSet Load GSM_TopN.xml 0 2, SignalSet Load UMTS_TopN.xml
1 2 and SignalSet Load LTE_TopN.xml 2 2, respectively.

3. To register now the client for receiving the measured values of all signal sets, exe-
cute the command Register Data SIGNALSET.

4. After getting the "OK" response, start the measurement with the meas command

PuTTY receives the incoming measurement data as defined by the ACD report and
the signal sets:
Data SIGNALSET2
458;1;262;21009;-80.10;10.92;-100.26;-11.17;1815.00;1300;103602/0;456;-;-;-;-87.
39;5.59;-107.58;-18.49;1815.00;1300;-;457;-;-;-;-101.87;-20.09;-117.28;-28.19;181
5.00;1300;-;155;-;-;-;-99.96;-11.39;-114.95;-20.00;1815.00;1300;
Data SIGNALSET0
12;2;262;890;26012;76;-39.04;30;1;262;17249;5717;6;-39.84;101;1;262;17249;571
8;15;-48.96;11;2;262;890;24023;72;-50.80;14;1;262;17249;51172;37;-56.80;93;1;2
62;17249;5716;36;-58.40;49;1;262;17249;30640;37;-61.44;36;1;262;17249;29232;
20;-61.92;23;1;262;17249;51170;13;-62.08;41;1;262;17249;51244;24;-64.72;22;1;2
62;17249;26953;7;-66.08;85;1;262;17249;27671;1;-69.92;21;1;262;17216;53081;5;
-70.64;27;1;262;17216;64680;35;-70.72;98;1;262;17249;58191;7;-71.28;15;-;-;-;-;1
2;-72.24;25;-;-;-;-;35;-72.56;21;-;-;-;-;34;-72.88;39;-;-;-;-;35;-73.36;40;1;262;17249;1
5098;11;-74.00;99;1;262;17249;32995;4;-74.80;82;1;262;17249;62961;3;-75.60;32;
-;-;-;-;12;-75.84;22;-;-;-;-;22;-76.08;33;-;-;-;-;15;-76.24;124;1;262;17249;62965;34;-7
7.04;95;1;262;17249;15177;31;-77.44;94;1;262;17216;26963;20;-79.20;39;-;-;-;-;2;-
79.36;19;-;-;-;-;7;-79.60;87;1;262;17249;30641;10;-80.24;33;-;-;-;-;17;-80.56;124;-;-
;-;-;36;-81.20;97;-;-;-;-;34;-83.12;83;-;-;-;-;23;-85.28;716;7;262;51044;30069;77;-85.
28;97;-;-;-;-;76;-86.56;686;7;262;51044;10067;77;-87.44;638;7;262;51047;50041;7
5;-88.56;77;2;262;890;26013;45;-90.80;79;-;-;-;-;32;-92.88;616;3;262;32619;62539;
36;-92.96;986;3;262;32129;35980;37;-93.68;52;-;-;-;-;57;-93.76;74;2;262;890;2346
1;33;-94.48;63;2;262;890;22482;60;-94.88;993;3;262;32129;35960;37;-95.52;9;2;2
62;821;31592;57;-97.36;62;2;262;890;19612;41;-97.68;981;3;262;32619;54659;32;
-97.84;731;2;262;890;26016;46;-100.96;811;3;262;32619;849;35;-101.68;620;3;26
2;32129;27290;31;-103.76;695;-;-;-;-;75;-103.92;770;-;-;-;-;33;-106.32;746;-;-;-;-;53;
-106.40;-;-;-;-;-;-;-106.32;-;-;-;-;-;-;-106.40;
Data SIGNALSET1

R&S ROMES4 IP remote control - getting started
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130;0;1;262;17352;21011;-41.5;10836;-3.1;-44.6;-44.4;130;0;1;262;17352;21012;-
41.4;10812;-2.9;-44.4;-44.5;475;0;2;262;952;26016;-92.6;10588;-6.7;-99.3;-93.7;47
5;0;2;262;952;26012;-91.1;10564;-11.7;-102.8;-91.4;475;0;2;262;952;26019;-87.7;
10612;-11.4;-99.1;-88.0;422;0;-;-;-;-;-91.9;10639;-15.5;-107.5;-92.0;483;0;-;-;-;-;-91.
3;10564;-20.4;-111.7;-91.4;483;0;-;-;-;-;-87.5;10612;-23.1;-110.6;-87.5;418;0;-;-;-;-;-
91.8;10639;-22.0;-113.8;-91.8;85;0;-;-;-;-;-91.1;10564;-21.6;-112.8;-91.2;483;0;-;-;-;-
;-92.5;10588;-22.1;-114.7;-92.5;228;0;-;-;-;-;-87.3;10612;-27.1;-114.4;-87.3;
Data SIGNALSET0
30;2;262;890;26012;76;-38.56;30;1;262;17249;5717;6;-37.04;101;1;262;17249;571
8;15;-47.12;11;2;262;890;24023;72;-50.56;14;1;262;17249;51172;37;-56.32;93;1;2
62;17249;5716;36;-56.24;49;1;262;17249;30640;37;-62.08;36;1;262;17249;29232;
20;-60.64;23;1;262;17249;51170;13;-61.76;41;1;262;17249;51244;24;-63.60;22;1;2
62;17249;26953;7;-65.84;85;1;262;17249;27671;1;-67.12;21;1;262;17216;53081;5;
-70.48;27;1;262;17216;64680;35;-70.72;98;1;262;17249;58191;7;-70.00;15;-;-;-;-;1
2;-80.72;25;-;-;-;-;35;-72.56;21;-;-;-;-;34;-71.84;39;-;-;-;-;35;-74.96;40;1;262;17249;1
5098;11;-74.00;99;1;262;17249;32995;4;-70.08;82;1;262;17249;62961;3;-73.76;32;
-;-;-;-;12;-72.64;22;-;-;-;-;22;-76.08;33;-;-;-;-;15;-76.88;124;1;262;17249;62965;34;-7
7.04;95;1;262;17249;15177;31;-76.96;94;1;262;17216;26963;20;-76.80;39;-;-;-;-;2;-
71.44;19;-;-;-;-;7;-80.80;87;1;262;17249;30641;10;-78.48;33;-;-;-;-;17;-80.56;124;-;-
;-;-;36;-79.68;97;-;-;-;-;34;-82.08;83;-;-;-;-;23;-85.28;716;7;262;51044;30069;77;-84.
56;97;-;-;-;-;76;-84.32;686;7;262;51044;10067;77;-86.56;638;7;262;51047;50041;7
5;-88.56;77;2;262;890;26013;45;-90.08;79;-;-;-;-;32;-91.36;616;3;262;32619;62539;
36;-92.32;986;3;262;32129;35980;37;-92.00;52;-;-;-;-;57;-92.64;74;2;262;890;2346
1;33;-93.20;63;2;262;890;22482;60;-94.88;993;3;262;32129;35960;37;-95.20;9;2;2
62;821;31592;57;-98.16;62;2;262;890;19612;41;-97.12;981;3;262;32619;54659;32;
-94.72;731;2;262;890;26016;46;-102.24;811;3;262;32619;849;35;-101.68;620;3;26
2;32129;27290;31;-103.04;695;-;-;-;-;75;-104.72;770;-;-;-;-;33;-106.32;746;-;-;-;-;53;
-106.40;-;-;-;-;-;-;-106.32;-;-;-;-;-;-;-106.40;
Data SIGNALSET2
458;1;262;21009;-79.86;11.53;-100.02;-11.22;1815.00;1300;103602/0;456;-;-;-;-88.
19;4.64;-108.18;-19.38;1815.00;1300;-;457;-;-;-;-101.60;-19.90;-117.34;-28.54;181
5.00;1300;-;155;-;-;-;-100.23;-11.17;-115.39;-20.84;1815.00;1300;
Data ACD "LTE,Band 3 (FDD),20000000,true,1815000000,-" "UMTS,Band I
(DL),4200000,true,2112800000,-" "UMTS,Band I (DL),4200000,true,2117600000,-"
"UMTS,Band I (DL),4200000,true,2122400000,-" "UMTS,Band I
(DL),4200000,true,2127800000,-" "UMTS,Band I (DL),4200000,true,2147600000,-"
"UMTS,Band I (DL),4200000,true,2162400000,-" "UMTS,Band I
(DL),4200000,true,2167200000,-"

The values in the SIGNALSET are the same as those obtained for them by the Alpha-
numeric view. The units for the signals depend on settings.

To stop the measurement, execute the stp command.
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11.2  Remote control commands

This chapter describes the supported commands of the application. The commands
have a long and a short form.

The following applies for the remote control commands:
● The client application is responsible to call the only commands, which are allowed

at a certain R&S ROMES4 mode
● The command text has to be transferred as an ANSI text, using the provided data

structure
● The commands via socket have to be sent with a CR LF at the end. CR LF will trig-

ger the command execution at the R&S ROMES4 side
● All strings which contain spaces have to be put into “ ”, for example, “C:

\Users\someone\Documents\My ROMES\MeasData”
● Commands are case sensitive
● The "SendMessage" function of the client software will return a message after R&S

ROMES4 has completed the required action. It will return TRUE, if the command
has been recognized (NOT necessarily executed successfully) and FALSE, if not
recognized

11.2.1  Supported commands

The following commands are supported:
● General commands
● Wizard commands
● Measurement Data commands
● Autostart commands

11.2.1.1  General commands

New workspace

NewWorkspace
NewW 

Creates a new workspace.

Load measurement file path

LoadMeasurementFile path [true\false] 
LdM path [true\false]

Loads the measurement file from the given path and scans the file or not. If no second
parameter is given, the file is scanned by default.
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Scan time interval

ScanTimeInterval StartTime EndTime
cT StartTime EndTime

Scans an open measurement file partially from the start to the end time.

Spool to timestamp command

SpoolToTimestampCommand TargetTime 

Spools an open measurement file to the target timestamp (coupled focus).

Load workspace path

LoadWorkspace path
LdW path

Loads the workspace from the given path.

Save workspace path

SaveWorkspace path
SvW path

Saves the workspace to the given path or overwrites current one, if no path is given.

Start recording

StartRecording <path> [auto]
rec <path> [auto]

Starts the measurement and recording with the given measurement file name or gener-
ates a filename automatically if none is given.

If auto is set and the given file name already exists, than SME will add a suffix n
(<path>_nnn.rscmd>) to the filename.

Start measuring

StartMeasuring <path>
meas <path>

Starts the measurement without recording with the given measurement file name or
generates a filename automatically if none is given.

Start recording ex

StartRecordingEx <path> 
recEx <path>

Starts the measurement and recording with the given mandatory measurement file-
name.

If the given filename already exists, than the SME will add a suffix n
(<path>_nnn.rscmd>) to the filename.
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Reaching a file split limit (either duration or file size) a split is done and a new file
<path>.nnn.mmm.rscmd is started.

Changing from measurement (mesEx) to recEx <path> a split is done and a new file
<path>.nnn.mmm.rscmd is started using the new <path>. As each new *.rscmd
inherits the header info and the mandatory history, the newly started *.rscmd has a
certain start size which is about >=300KB.

Start measuring ex

StartMeasuringEx 
measEx

Starts the measurement without recording, generates a filename automatically.

For example, started R&S ROMES4 in SME mode generates a file
named ...\\2018-08-14_13-49-08_SME.rscmd
Reaching a file split limit (either duration or file size) a split is done and a new file
<path.nnn.mmm.rscmd is started.

Changing from recording (recEx <path>) to measEx the recorded *.rscmd file is
closed and a split is done. A new file <path>.nnn.mmm.rscmd is started using the
auto generated filename for measuring. As each new *.rscmd inherits the header info
and the mandatory history, the newly started *.rscmd has a certain start size which is
about >=300KB. The *.rscmd is not growing while state is measuring.

Stop

Stop
stp

Stops the measurement.

Register

Register <ModeChange> <OutputView>

reg <ModeChange> <OutputView>

Registers the caller to get messages for R&S ROMES4 Mode Changes and/or updates
the R&S ROMES4 Output View.

During the registration the current mode will be reported.

Register ModeChange
ModeChange Idle Idle
OK

Deregister

Deregister <ModeChange> <OutputView>

dereg <ModeChange> <OutputView>

Deregisters the caller to get messages for R&S ROMES4 Mode Changes and/or
updates the R&S ROMES4 getOutput View.
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Get system info

Get SystemInfo

The command allows the user to retrieve information about the system. This informa-
tion includes:

● Version of measurement server
● State of the system
● State of the systems device scanner
● accEngineState: accumulate state of engines. This is the result of the "or" of all

engine states.

Get SystemInfo
SystemInfo 131 BINARY
<SystemInfo>
<Version>4.89.0.2930</Version>
<SystemState>Idle</SystemState>
<HardwareScan>Finished</HardwareScan>
<accEngineState>00</accEngineState>
</SystemInfo>OK

Prepare shutdown

PrepareShutdown

Call this function before you stop the R&S ROMES4 process.

Set comment

Set Comment <any Text>

It is possible to set comments remotely (the same as done with CTRL+F12 from the
GUI) during recording measurement data. If the SME is not recording the command, it
will return an error.

Set logging

Set Logging [On/Off] <Path>

This command allows the host process to enable a log file. "On" enables the logger,
"Off" disables the logger. For "On" it is possible to specify the logfile with path. If no
path is specified, the default SME logging path is used.

For example

Set Logging On
Set Logging On C:\mylogfilefolder\smelog.txt
Set Logging Off
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11.2.1.2  Wizard commands

Wizard type

Wizard <Type> <Type specific Argumentlist>
wiz <Type> <Type specific Argumentlis>

Executes the wizard with the given argument list.

Type Comment

ACD Automatic Channel Detection Wizard

Argument list is:

[smartlsimple] [lowlmediumlhigh] [gpslpe] [IP@a.b.c.d][L3]<Tec1@Bands1>
<Tec2@Bands2>...

smartlsimple: smart: Use RF Power scanner, simple: ACD without assistance of RF Power
scanner, has to test every channel lowlmediumlhigh: ACD sensitivity; more fast or more
sensitive measurement

gpslpe: gps: use GPS pe: use position estimator and use GPS

IP@a.b.c.d: try tool load device with IP address a.b.c.d

L3: if the L3 command is added, the Layer 3 Message feature will be activated

Tec: LTE, NBIOT, UMTS, GSM, 3GPP2, 5G_NR

Bands: 1,2,3,4 (see Configure Command)

Bands GSM: 450,480,850,900,1800,1900

For example

Wizard ACD smart pe LTE@3,7,20 GSM@900,1800 UMTS@1

Configure ACD

Configure ACD <Tec> <Bands>
Cfg ACD <Tec> <Bands>

Configures the ACD of a certain technology with the given bands. The caller has to
ensure that the drivers are loaded correctly. No list of <Tec> <Bands> is allowed. Use
separate commands instead.
Table 11-1: Supported technologies

Tec Remark

LTE LTE ACD

Bands are the LTE Bands N, for example, to enable Bands 2,4,6 use the Config ACD
LTE 2,4,6 command

NBIOT NB-IoT ACD

Bands are the LTE Bands N, for example, to enable Bands 2,4,6 use the Configure ACD
NBIOT 2,4,6 command

Be aware that scanning NB-IoT a LTE scanning is also necessary and bands of LTE must
be similar with bands of NB-IoT

UMTS UMTS ACD

Bands are the UMTS Bands N, for example, to enable Bands I,II,VI use the Config ACD
UMTS 1,2,6 command
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Tec Remark

3GPP2 cmda/EVDO ACD

Bands are the 3GPP2 Band Class N, for example, to enable Band Classes 0,1,10 use the
Config ACD 3GPP2 0,1,10 command

TETRA TETRA ACD

Bands are the N-the TETRA Block. Each block has 50MHz. Block 0 is 300 MHz to
350MHz, Block 1 is 350MHz to 400MHz, and so on. For example, to scan the frequencies
from 350MHz to 450MHz use the Config ACD TETRA 5,6 command

WiMAX WiMAX ACD

Bands are specified by the start frequency. The following bands are currently supported:

23: 2.3 GHz - 2.4 GHz

25: 2.5 GHz - 2.6 GHz

3.3: 3.3 GHz - 3.4 GHz

34: 3.4 GHz - 3.5 GHz

35: 3.5 GHz - 3.6 GHz

57: 5.725 GHz - 5.85 GHz

5G_NR 5G NR ACD

Bands are specified in TS38101-1/-2. Currently only bands are allowed which are below
6GHz, bands from FR2 are not supported. Following bands are currently supported: n1..
n79 but there are many not defined! For example use the Configure ACD 5G_NR 3,5
command

Special ACD configuration commands

● Configure ACD TrackingRatePerChannel <Rate>
Sets the target scan rate per channel of the tracking scanners to the given rate in
Hertz.
For example
Configure ACD TrackingRatePerChannel 0.1

● Configure ACD SaveTemplates <true|false>
Enables or disables saving templates.

11.2.1.3  Measurement data command

Register data

Register Data <Type> <Subtype>

An application can register to receive measurement data. Currently supported mea-
surements are listed in the following table.
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Table 11-2: Supported measurement types

Type Source Report Format

ACD ACD Measurement

Identified Spectra of the Blind-
ScanFrame will be reported

Subtype not used

Data ACD

<"Tec,Band,Bandwidth,BWTrue,Frequency,Flags">,...

For example, "LTE,3,10000000,true,1815000000,-"

SIGNALSET R&S Signals and Events

If subtypes is given, only the
corresponding signalset is reg-
istered

● Signals
The report format depends on the specified signal-
set. The number of the reported set is appended to
the SIGNALSET keyword.
Data SIGNALSET0 a;b;c;d;

● Events
All events will be forwarded to the client in the fol-
lowing format:
Data EVENT timestamp;Source;Name;Info

Deregister data

Deregister Data <Type> <Subtype>

Deregisters the corresponding data handler; stands for the same measurement data
previously mentioned.

Signal set load

SignalSetLoad <File.xml> <Number> <UpdateRate>

Loads the signal set from *.xml files.

The file has to be located in the CurrentUser\My Documents\MyRomes\RemoteSignal-
Sets folder.

The given number is assigned to the signal set. If a signal set with this number has
been loaded earlier, it will be replaced. The update rate specifies how often the data is
reported. The given number will be multiplied by 500 ms.

For example, SignalSet Load “MyFile.xml” 0 2 means signals in the
MyFile.xml file will be stored in the signal set 0 and their values will be reported
once a second.

Signal set reset

SignalSet Reset

Unloads all signal sets.

Loading a workspaces resets the complete signal set configuration. All required sets
have to be configured again.

Signal set file format and creation

The signal set file is a xml file with the following format:

<?xml version="1.0" encoding="iso-8895-1"?>
<romes>
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       <section name="CRomesSignalRemoteReport_0">
               <value name="Count">2</value>
               <value name="Device0">0</value>
               <value name="Device1">0</value>
               
               <value name="Object0">LTE_SCAN-TOP_N_0-TOP_N_CELL_ID_0</value>
               <value name="Object1">LTE_SCAN-TOP_N_0-TOP_N_MNC_0</value>
       </section>
</romes>

The section name is fixed to CRomesSignalRemoteReport_0.

The value of the item Count is the number of containing signals. For each signal
Device<n> and Object<n> items are expected to be present in the file.

The Device<n> defines the driver from which the signal is taken. The Device0 means
that the signal is produced from the first instance (driver). The Device1 means the sig-
nal is produced from the second driver.

The Object<n> defines the ROMES Signal ID. The ID of a signal can be obtained from
the ToolTip for a certain signal in the "ROMES Signal Tree" or by the exported
"Descriprion of R&S ROMES4 Signals" document (Help Menu), which contains all R&S
ROMES4 signals.

The file has to be located in the <Current User>\Document\My ROMES\RemoteSignal-
Sets folder.

R&S ROMES4 offers an easy way to create such file. It is described in the following
procedure.

1. Drag and drop all required signals from the "Signal Tree" to the "Alphanumeric
View".

2. Click the "Export Remote Control Signal Set" command to export the file.
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Figure 11-5: Exporting signal set for remote control

3. Enter a name, which can be used as the filename and click "Create".

Figure 11-6: Naming the xml file

The file is exported and stored in the aforementioned folder under the given name.

Register binary

Register Binary <Type>

An application can register to receive binary phylis frames of certain types.

The registration means deletion of the frame IDs in the current list and filling it with the
IDs of this command.
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Type Source Report Format

Binary R&S ROMES4 Measurement Example: Register Binary 8000 8100

the command forwards all produced frames with ID 8000
and 8100 to a client.

Binary Length S<binary data>E

Deregister binary

Deregister Binary

Removes all subscribed data ID from the list.

Request

Get <Type> <SubType> <Mode> <Instance>

The client can pool the information types listed in the table.
Table 11-3: Types of information

Type SubType Mode Instance Report Format

BCH GSM, UMTS,
LTE, 3GPP2,
TETRA, WiMAX

0 (default): no
reporting of BCH
messages

1: BCH mes-
sages included

Instance of scan-
ner device

0 (default)

Example: Request BCH GSM 0
The reported result in XML format has
the following tags:
● Provider
● Channel
● Transmitter
● Message

Requested BCH GSM instance XML
Content

ACD    Example: Request ACD

The result, which represents the con-
tent of the identified spectra blocks in
the R&S ROMES. ACD Status View is
reported in XML format.

11.2.1.4  Autostart commands

It is possible to define Remote Control commands which are executed each time R&S
ROMES4 starts up and after a workspace is loaded. Just put the commands into the
RemoteIPAutostart.txt file which has to be placed in the <My Documents>\My
ROMES\configuration folder.

11.3  Available devices and measurement engines

11.3.1  Get devices

Get DEVICES
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This command requests the list of currently connected devices. The list contains all
devices and their capabilities. It is the responsibility of the host application to check the
available options of the devices before loading and/or configuring the measurement
engines.

For example

Get DEVICES
<ScannerType="TSME (FrontEnd:1)" ID="192.168.0.2@MU724954" Serial="100582">
<Connection>192.168.0.2@MU724954</Connection>
<TSMEInfo>
<FrontEnd>0</Frontend>
<TimeBase>0</TimeBase>
<SyncMask>0</SyncMask>
</TSMEInfo>

 

<NrOfRx>1</NrOfRx>
<Options>
<Bands>
<Band Min="375" Max="435>TETRA</Band>
<Band Min="445" Max="475>TETRA</Band>
<Band Min="865" Max="881>TETRA</Band>
<Band Min="910" Max="926>TETRA</Band>
</Bands>
<Applications>
<Option id="0">Demo 18 months (0)</Option>
</Applications>

 

</Options>
</Scanner>
OK

11.3.2  Get engines

Get ENGINES

The engines are the actual use cases which can be performed using one of the con-
nected devices. The list of the engines contains the name of the engine, its ID and a
list of devices which can be used with the measurement engine.

- ID: Unique ID of the engine; other commands refer to this ID

- Name: User-friendly name of the engine

- Type: Type of engine
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Table 11-4: Type of engine

Type Technology

1000 GPS

8001 UMTS Scanner

8003 cdma/EVDO Scanner

8005 GSM Scanner

8011 WiMAX Scanner

8013 LTE Scanner

8015 RF Power Scanner

8017 TETRA Scanner

8023 CW Receiver

8025 5G NR Scanner

8027 NB-IoT Scanner

For example

Get ENGINES
Engines List 1088 BINARY
<Engines>
<Engine ID="5_R&amp;S_LTE_Scanner_0" Name="TSME LTE" Type="8013">
<Device ID="1" Address="192.168.0.2@MU724954">
<MIMO>False</MIMO>
<eMBMS>True</eMBMS>
<ACD>True</ACD>
</Device>
<Device ID="2" Address="192.168.0.3@MU724954">
<MIMO>False</MIMO>
<eMBMS>True</eMBMS>
<ACD>True</ACD>
</Device>
</Engine>
<Engine ID="5_DrvGsmMws_1" Name="TSME GSM" Type="8005">
<Device ID="1" Address="192.168.0.2@MU724954">
<ACD>True</ACD>
</Device>
<Device ID="2" Address="192.168.0.3@MU724954">
<ACD>True</ACD>
</Device>
</Engine>
<Engine ID="5_R&amp;S_RF_Power_Scanner_TSME_0" Name="TSME RF Power Scanner" 
Type="8015">
<Device ID="1" Address="192.168.0.3@MU724954">
<ACD>True</ACD>
</Device>
<Device ID="2" Address="192.168.0.3@MU724954">
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<ACD>True</ACD>
</Device>
</Engine>
<Engine ID="5_DrvUMTS_PNS_1" Name="TSME WCDMA" Type="8001">
<Device ID="1" Address="192.168.0.3@MU724954">
<ACD>True</ACD>
</Device>
<Device ID="2" Address="192.168.0.3@MU724954">
<ACD>True</ACD>
</Device>
</Engine>
</Engines>

11.4  Measurement engines

11.4.1  Engine load

Engine LOAD <Device ID>

This command loads a measurement engine into R&S ROMES4. If it succeeds, R&S
ROMES4 returns the instance ID of the loaded engine. The <Device ID> is optional if
only one device is available for the measurement engine.

The return string is Engine LOADED <Engine ID> <Instance ID>.

For example

Engine LOAD 5_DrvGsmNws_1
Engine LOADED 5_DrvGsmNws_1 1009200560

11.4.2  Engine unload

Engine LOAD <Instance ID>

Unloads an engine.

For example

Engine UNLOAD 1009200560
Engine unloaded

11.4.3  Get loaded engines

Get LOADEDENGINES

The command reports a list of the currently loaded measurement engines.

For example
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Get LOADEDENGINES
LoadedEngines List 165 BINARY
<LoadedEngines>
<LoadedEngine ID="9585294002" Type="8013">
<Device ID="1"/>
<State Level="0" Info="Device reconnected">OK</State></LoadedEngine>
</LoadedEngines>
OK

The information about the states can be as listed in the table.
Table 11-5: Device states

Element Value Remark

Level 0

1

2

OK

Warning

Error

Info Text Information about the last action on the device

Value Timout

Bad condi-
tion

Connection
lost

Low data
rate

Error

Measurement engine run into a timeout

Bad receiving condition of device (GPS)

Used device lost its connection to the computer

Measurement engine delivers less data than expected

Measurement engine reported an error

11.4.4  Engine CFG set

EngineCFG Set <ID>

The message is sent whenever the engine with the corresponding ID has been recon-
figured.

11.4.5  Engine state changed

Engine <ID>STATECHANGED <OldState> <NewState>

The message is sent whenever the state of the engine has changed. The <states> are
given as hexadecimal numbers. The meaning of the bits is listed in the table.

Bit Meaning

0 Timeout

1 Bad condition of GPS signal

2 Connection to hardware lost

3 Device delivers less data as expected
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Bit Meaning

4 Other error

5 R&S TSME is currently in reconnection state

11.5  Remote control messages

This chapter concerns the R&S ROMES4 Remote Control messages.

11.5.1  Supported messages

Supported messages are sent by R&S ROMES4.

11.5.1.1  Mode change

ModeChange <OldMode> NewMode>

The following table shows the available modes.

Mode Remark

NotInitialized R&S ROMES4 is starting

Idle No driver, no measurement file loaded

FileOpening A measurement file is about to be opened

FileOpen Measurement file open

ReadyForMeasurement At least one driver is loaded, no measurement file open

Replay Replay is active

ReplayPause Replay is in Pause state

Measurement Measurement without recording is active

Reporting Recording is active

Exporting Exporting is active

11.5.1.2  Output view

Output view <Text>

11.5.1.3  System health

SystemHealth <Text> <State>

This message has not to be requested.
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The systems health is checked once a minute. The message is sent whenever one of
the following system checks fails.

Type State Remark

Memory Warning System is running out of memory, but can continue to work

Alarm System memory is critically low. Most probably, the system will
fail in the next minutes

DiskSpace Low System is running out of disk space

Critical System's disk space is too low, the measurement will be stopped

Measurement Bitmaps as HexNum-
ber, for example, 1F
The meaning of bits is:
● Bit 0: Timeout
● Bit 1: Bad Condi-

tion
● Bit 2: Connection

Lost Bit
● 3: Low Data Rate

Bit
● 4: Any other error

For example, 0C means that at least one of the drivers lost its
connection to the device and at least one driver does not deliver
the expected amount of data
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12.1  5G NR scanner Top N signals mapping

The columns in the "5G NR Scanner Top N View" > "List" are created automatically
from Top N signals.

The following tables list the columns of the signals in the "5G NR Scanner TopN View".

5G NR scanner Top N signals mapping
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Table 12-1: Columns of the default Top N signals in the List pane

Top N signal column name Column visible by default Prior Top N signal column
name

Color yes Color

# yes #

Top X yes Top X

PCI yes PCI

SSB Idx yes SSB Idx

Internal ID no Internal ID

SSB Idx ModB no Not in prior view

SSB Count no Not in prior view

RSSI yes RSSI

Dec. SS-RSRP no Not in prior view

Dec.SS-SINR no Not in prior view

Dec. SS-RSRQ no Not in prior view

SS-RSRP yes SS-RSRP

SS-SINR yes SS-SINR

SS-RSRQ yes SS-RSRQ

SS-SPL no Not in prior view

SS-RePower yes SS-RePower

NR-ARFCN yes NR-ARFCN

Band no Not in prior view

SS-Ref yes SS-Ref

ToA(PSS) no Not in prior view

ToA(CIR) no Not in prior view

GF-Inter yes Not in prior view

GF-Intra yes Not in prior view

Adjusted ToA(PSS) no Not in prior view

To visualize a column of an optional Top N signal in the "List", select the signal first in
the "TEC for 5G NR Scanner" settings. The column is then available in the "List".

The default status of these signals branches in the "Signal Tree" is:

ON - present in the "Signal Tree"

OFF - not present in the "Signal Tree"

5G NR scanner Top N signals mapping
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Table 12-2: Columns of the optional Top N signals in the List pane

Optional Top N signal
column name

"Signal Tree" default
status

Column visible by
default

Prior optional Top N
signal column name

DM-RSRP OFF no DM-RSRP

DM-SINR OFF no DM-SINR

DM-RSRQ OFF no DM-RSRQ

DM-RSLP OFF no Not on prior view

DM-RePower OFF no DM-RePower

PBCH-RSRP OFF no PBCH-RSRP

PBCH-SINR OFF no PBCH-SINR

PBCH-RSRQ OFF no PBCH-RSRQ

PBCH-SPL OFF no Not on prior view

PBCH_RePower OFF no PBCH_RePower

PS-RSRP OFF no PS-RSRP

PS-SNR OFF no PS-SINR

PS-RSRQ OFF no PS-RSRQ

PS-SPL OFF no Not on prior view

PS-RePower OFF no PS-RePower

SS-PBCH-RSRP OFF no SS-PBCH-RSRP

SS-PBCH-SINR OFF no SS-PBCH-SINR

SS-PBCH-RSRQ OFF no SS-PBCH-RSRQ

SS-PBCH-SPL OFF no Not on prior view

SS-PBCH-RePower OFF no SS-PBCH-RePower

SSB-RSRP OFF no SSB-RSRP

SSB-SINR OFF no SSB-SINR

SSB-RSRQ OFF no SSB-RSRQ

SSB-SPL OFF no Not on prior view

SSB-RePower OFF no SSB-RePower

MIB-system FrameNum-
ber

OFF no MIB-system FrameNum-
ber

MIB-subCarrierSpacinf-
Common

OFF no MIB-subCarrierSpacinf-
Common

MIB-ssb-SubCarrierOff-
set

OFF no MIB-ssb-SubCarrierOff-
set

MIB-dmrs-TypeA-Posi-
tion

OFF no MIB-dmrs-TypeA-Posi-
tion

MIB-pdcch-ConfigSIB1 OFF no MIB-pdcch-ConfigSIB1

5G NR scanner Top N signals mapping
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Optional Top N signal
column name

"Signal Tree" default
status

Column visible by
default

Prior optional Top N
signal column name

MIB-cellBarred OFF no MIB-cellBarred

MIB-intraFreqReselec-
tion

OFF no MIB-intraFreqReselec-
tion

k-SSB OFF no k-SSB

gNodeB Name ON no gNodeB Name

gNodeB Distance ON no gNodeB Distance

If an optional signal is not configured for display in the "Signal Tree" >" 5G NR Scan", it
is not displayed in "5G NR Scanner Top N View" > "List".

Table 12-3: Columns of the default Top N signals in the Details pane

Top N signal column name Column visible by default Prior optional Top N signal col-
umn name

PCI yes PCI

SSB IDx yes SSB IDx

Internal ID no Internal ID

RSSI yes RSSI

SS-RSRP yes SS-RSRP

SS-SINR yes SS-SINR

SS-RSRQ yes SS-RSRQ

SS-RePower yes SS-RePower

Table 12-4: Columns of the optional Top N signals in the Details pane

Optional Top N signal column
name

Column visible by default Prior optional Top N signal col-
umn name

DM-RSRP no DM-RSRP

DM-RSINR no DM-RSINR

DM-RSRQ no DM-RSRQ

DM-RePower no DM-RePower

PBCH-RSRP no PBCH-RSRP

PBCH-SINR no PBCH-SINR

PBCH-RSRQ no PBCH-RSRQ

PBCH-RePower no PBCH-RePower

PS-RSRP no PS-RSRP

PS-SINR no PS-SINR

PS-RSRQ no PS-RSRQ

5G NR scanner Top N signals mapping
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Optional Top N signal column
name

Column visible by default Prior optional Top N signal col-
umn name

PS-RePower no PS-RePower

SS-PBCH-RSRP no SS-PBCH-RSRP

SS-PBCH-SINR no SS-PBCH-SINR

SS-PBCH-RSRQ no SS-PBCH-RSRQ

SS-PBCH-RePower no SS-PBCH-RePower

SSB-RSRP no SSB-RSRP

SSB-SINR no SSB-SINR

SSB-RSRQ no SSB-RSRQ

SSB-RePower no SSB-RePower

MIB-systemFrameName no MIB-systemFrameName

MIB-subCarrierSpacingCommon
No MIB-subCarrierSpacingCom-
mon

no MIB-subCarrierSpacingCommon
No MIB-subCarrierSpacingCom-
mon

MIB-ssb-SubCarrierOffset no MIB-ssb-SubCarrierOffset

MIB-dmrs-TypeA-Position no MIB-dmrs-TypeA-Position

MIB-pdcch-ConfigSIB1 no MIB-pdcch-ConfigSIB1

MIB-cellBarred no MIB-cellBarred

MIB-intraFreqReselection no MIB-intraFreqReselection

12.2  LTE scanner Top N signals mapping

The "LTE Scanner Top N View" columns are associated with signals. The signal names
usually match the signal names in signal tree, but some of the names do not match.

The following table shows mapping of the TopN View signal names to the signal names
in the signal tree. This mapping lists only the mismatched names.
Table 12-5: Top N signals names mapped to signal tree signal names

Top N signal name Signal tree - signal names have prefix "Top N"

WB RSSI Min WB RSSI (min)

WB RSSI WB RSSI (max)

WB RSRP WB RSRP (NC) (max)

WB RSRQ WB RSRQ (NC) (max)

WB RS SINR WB SINR (max)

Dist. (km) eNodeB Dist.

Mode Frame Struc. Type

LTE scanner Top N signals mapping
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Top N signal name Signal tree - signal names have prefix "Top N"

Amp.SINR P-Sync SINR PSS based on Amp Noise

Amp.SINR P-Sync SINR SSS based on Amp Noise

Cue Cue-Lev

12.3  NB-IoT scanner Top N signals mapping

The columns in the "NB-IoT Scanner Top N View" > "List" are created automatically
from Top N signals.

If an optional signal is not configured for display in the "Signal Tree", it will not be dis-
played in "NB-IoT Scanner Top N View" > "List".

The following tables list the columns of the signals in the "NB-IoT Scanner Top N
View".
Table 12-6: Columns of default Top N signals in the List pane

Top N signal column name Column visible by default Prior Top N signal column
name

Color yes Color

# yes #

Top X yes Top X

Decision NSSS Power no Not in prior view

Decision NSSS CIR no Not in prior view

Decision NRSSI no Not in prior view

NPCI yes NPCI

NRSSI yes NRSSI

NSS CINR yes NSSS CINR

NSSS Power yes NSSS Power

NPSS Power no NPSS Power

NPSS CINR no NPSS SINR

Frame ToA (GPS PSS) no Frame ToA (GPS PSS)

Frame ToA (internal) no Frame ToA (internal)

Center Frequency yes Center Frequency

NRSRP (Tx0) yes NRSRP (Tx0)

NRSRQ (Tx0) yes NRSRQ (Tx0)

NRS CINR (Tx0) yes NRS CINR (Tx0)

NB-IoT scanner Top N signals mapping
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Top N signal column name Column visible by default Prior Top N signal column
name

NRS RSSI (Tx0) yes NRS RSSI (Tx0)

NRSRP (Tx1) yes NRSRP (Tx1)

NRSRQ (Tx1) yes NRSRQ (Tx1)

NRS CINR (Tx1) yes NRS CINR (Tx1)

NRS RSSI (Tx1) yes NRS RSSI (Tx1)

Frame Struct. Type yes Not in prior view

Cyclic Prefix yes Not in prior view

To visualize a column of an optional Top N signal in the "List", select the signal in the
"TEC for NB-IoT Scanner" settings first. The column is then available in the "List".

The default status of these signals branches in the "Signal Tree" is:

ON - present in the "Signal Tree"

OFF - not present in the "Signal Tree"
Table 12-7: Columns of the optional Top N signals in the List pane

Optional Top N signal
column name

"Signal Tree" default
status

Column visible by
default

Prior optional Top N
signal column name

eNodeB Name ON no eNodeB Name

eNodeB Dist. ON no Dist.(km)

EARFCN OFF yes EARFCN

EC(28) OFF yes EC(28)

EC(20/8)   EC(20/8)

MCC OFF yes MCC

MNC OFF yes MNC

TAC OFF yes TAC

Provider OFF yes Provider

Add. PLMNs OFF yes Add. PLMNs

12.4  LTE-M scanner Top N signals mapping

The columns in the "LTE-M Scanner Top N View" > "List" are created automatically
from Top N signals.

If an signal is not configured for display in the "Signal Tree" > "LTE-M Scan", it is not
displayed in "LTE-M Scanner Top N View" > "List".

LTE-M scanner Top N signals mapping
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The following tables list the columns of the signals in the "LTE-M Scanner Top N View".
Table 12-8: Columns of the Top N signals in the List pane

Top N signal column name Column visible by default Prior Top N signal column
name

Color yes Color

# yes #

Top X yes Top X

Decision Avg. BR-SINR no Not in prior view

Decision Avg. BR-RSRP no Not in prior view

Decision Avg. BR-RSRQ no Not in prior view

PCI yes PCI

RSSI yes RSSI

Center Frequency yes Center Frequency

EARFCN yes EARFCN

Internal CellID no Internal CellID

Total BR-RSSI yes Total BR-RSSI

Avg. BR-RSRP yes Avg. BR-RSRP

Avg. BR-RSRQ yes Avg. BR-RSRQ

Avg. BR-SINR yes Avg. BR-SINR

NB Index no NB Index

NB Count no NB Count

Table 12-9: Columns of the Top N signals in the Details pane

Top N signal column name Column visible by default Prior optional Top N signal col-
umn name

PCI yes PCI

NB Index yes NB Index

Internal CellID no Internal CellID

NB RB Offset no NB RB Offset

BR-RSSI yes BR-RSSI

BR-RSRQ yes BR-RSRQ

BR-SINR yes BR-SINR

BR-RSRP yes BR-RSRP

LTE-M scanner Top N signals mapping
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12.5  UMTS scanner Top N signals mapping

The columns in the "UMTS Scanner Top N View" > "List" are created automatically
from the Top N signals.

The following tables list the columns of the signals in the "UMTS Scanner Top N View".
Table 12-10: Columns of the Top N signals in the List pane

Top N signal column name Column visible by default Prior Top N signal column
name

Color yes Color

# yes #

Rank yes Rank

Decision Ec/Io no Not in prior view

Decision RSCP no Not in prior view

SC yes SC

RNCID yes RNCID

SC-ID no Not in prior view

Channel yes Channel

UARFCN no Not in prior view

Ec/Io [dB] yes Ec/Io [dB]

SIR [dB] yes SIR [dB]

RSCP [dBm] yes RSCP [dBm]

ISCP [dBm] yes ISCP [dBm]

P total [dBm] yes P total [dBm]

HPP yes HPP

SPP yes SPP

CI yes CI

LAC yes LAC

MCC yes MCC

MNC yes MNC

Provider yes Not in prior view

Node B Name yes Node B

Node B Dist (km) yes Dist (km)

ULI [dBm] yes ULI [dBm]

Delay Spread [Chip] yes Not in prior view

Drift [ns] yes Drift [ns]

Std.Dev.Drift yes Not in prior view

UMTS scanner Top N signals mapping
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Table 12-11: Columns of the optional Top N signals in the List pane

Optional Top N signal column
name

Column visible by default Prior Top N signal column
name

P(PSCH) yes Not in prior view

P(SSCH) yes Not in prior view

Ec/Io(PSCH) yes Not in prior view

Ec/Io(SSCH) yes Not in prior view

Doppler yes Not in prior view

Code Group yes Not in prior view

Cue-Qual yes Not in prior view

Cue-Lev yes Not in prior view

NR yes NR

Add. PLMNs yes Add. PLMNs

Frame Time of Arrival Offset to
PPS

yes Not in prior view

Frame Number of Arrival Offset to
PPS

yes Not in prior view

If an optional signal is not configured for display in the "Signal Tree" > "UMTS Scan", it
is not displayed in "UMTS Scanner Top N View" > "List".

12.6  4G/5G RRC events

The following table gives the complete list of the currently supported 4G/5G RRC
events.
Table 12-12: 4G/5G RRC events

Event RAT Description

RRC Setup Attempt LTE/LTE CA LTE RRC connection establishment attempt

RRC FullConfig LTE/LTE CA LTE RRC Connection reconfiguration with
full configuration option

RRC Reconfiguration Complete LTE/LTE CA LTE RRC connection reconfiguration com-
plete

RRC Reestablishment Attempt LTE/LTE CA LTE RRC connection reestablishment
attempt

RRC Release LTE/LTE CA LTE RRC connection release

   

Handover Attempt LTE PCell LTE LTE PCell intra-frequency handover attempt,
single carrier configuration

4G/5G RRC events
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Event RAT Description

IF Handover Attempt LTE PCell LTE LTE PCell inter-frequency handover attempt,
single carrier configuration

   

MCG Handover Attempt LTE PCell LTE CA LTE PCell intra-frequency handover attempt
with SCell configuration (CA)

MCG IF Handover Attempt LTE
PCell

LTE CA LTE PCell inter-frequency handover attempt
with SCell configuration (CA)

MCG Release LTE SCell LTE CA LTE MCG release of SCell

MCG Add LTE SCell LTE CA LTE MCG addition of SCell

   

eNB to MeNB Handover Attempt
LTE PCell

LTE/LTE CA LTE PCell reconfiguration with handover to
5G ENDC

MeNB to eNB Handover Attempt
LTE PCell

LTE-5G ENDC MN LTE PCell reconfiguration with handover
from 5G ENDC to LTE

eNB to MeNB Change LTE PCell LTE/LTE CA LTE PCell reconfiguration from LTE to 5G
ENDC

MeNB to eNB Change LTE PCell LTE-5G ENDC MN LTE PCell reconfiguration from 5G
ENDC to LTE

MN Handover Attempt w. SN
change

LTE-5G ENDC MN LTE PCell handover with SN 5G NR
PSCell change

MN Handover Attempt wo. SN
change

LTE-5G ENDC MN LTE PCell handover without SN 5G NR
PSCell change

MN Release w. SN Release LTE-5G ENDC MN LTE PCell release from 5G ENDC con-
figuration

   

SN Release NR PSCell LTE-5G ENDC SN 5G NR PSCell release from MN LTE
PCell

SN Addition NR PSCell LTE/LTE CA SN 5G NR PSCell addition related with LTE
PCell reconfiguration from LTE to 5G EN-DC
MN

SN Re-Addition NR PSCell LTE-5G ENDC SN 5G NR PSCell re-addition to 5G ENDC
MN

SN Change NR PSCell Inter-gNB LTE-5G ENDC SN 5G NR PSCell change inter-gNB with
sync and security key change

SN Change NR PSCell Intra-gNB LTE-5G ENDC SN 5G NR PSCell change intra-gNB without
sync and security key change

   

DSS Setup NR PSCell LTE-5G ENDC SN 5G NR PSCell configuration with LTE
DSS carrier

DSS Release NR PSCell LTE-5G ENDC SN 5G NR PSCell release from LTE DSS
carrier

SN Release NR SCell LTE-5G ENDC SCell release from SN 5G NR PSCell

4G/5G RRC events
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Event RAT Description

SN Addition NR SCell LTE-5G ENDC SCell addition to SN 5G NR PSCell

SN Modification NR MeasConfig LTE-5G ENDC SN 5G NR measurement configuration modi-
fication

SN Modification NR RB LTE-5G ENDC SN 5G NR Radio Bearer modification

SCG Failure NR SCG LTE-5G ENDC NR SCG failure reported by UE

Fake SCG Failure NR SCG LTE-5G ENDC NR SCG failure faked by UE to trigger RAN
to release 5G NR

   

IRAT LTE-NR Redirection Attempt LTE->5G NR IRAT LTE RRC release with redirection to 5G NR
carrier

IRAT Handover Type 5GC-to-EPC-
R15

5G NR -> LTE IRAT UE CN change from 5GC to EPC related
with 5G NR to LTE inter-system handover

   

RB AddMod LTE MCG RLC LTE Data Radio Bearer addition or reconfigura-
tion of RLC entity in LTE MCG

RB AddMod LTE MCG PDCP LTE Data Radio Bearer addition or reconfigura-
tion of E-UTRA PDCP entity in LTE MCG

RB AddMod LTE MCG NR-PDCP LTE Data Radio Bearer addition or reconfigura-
tion of NR PDCP entity in LTE MCG

RB AddMod LTE MCG Split PDCP LTE Split Data Radio Bearer addition or reconfi-
guration of NR PDCP entity in LTE MCG

RB Release LTE MCG RLC LTE Data Radio Bearer release of RLC entity in
LTE MCG

RB Release LTE MCG PDCP LTE Data Radio Bearer release of PDCP entity in
LTE MCG

   

RB AddMod NR SCG RLC LTE-5G ENDC Data Radio Bearer addition or reconfigura-
tion of RLC entity in 5G NR SCG

RB AddMod NR SCG PDCP LTE-5G ENDC Data Radio Bearer addition or reconfigura-
tion of PDCP entity in 5G NR SCG

RB AddMod NR SCG Split PDCP LTE-5G ENDC Split Data Radio Bearer addition or reconfi-
guration of NR PDCP entity in 5G NR SCG

RB AddMod NR SCG Split PDCP
UL

LTE-5G ENDC Uplink Split Data Radio Bearer configuration
of NR PDCP entity in 5G NR SCG

12.7  5G RRC events

The following table gives the complete list of the currently supported 5G RRC events.

5G RRC events



AppendixDrive Test Software

2393Operating Manual 1171.6415.12 ─ 66

Table 12-13: 5G RRC events

Event RAT Description

RRC Setup Attempt 5G NR 5G NR RRC connection establishment
attempt

RRC FullConfig 5G NR 5G NR RRC connection reconfiguration with
full configuration option

RRC Reconfiguration Complete 5G NR 5G NR RRC connection reconfiguration
complete

RRC Reestablishment Attempt 5G NR 5G NR RRC connection reestablishment
attempt

RRC Release 5G NR 5G NR RRC connection release

RRC Reject 5G NR 5G NR RRC connection reject

   

Handover Attempt 5G NR 5G NR PCell intra-frequency handover
attempt

IF Handover Attempt 5G NR 5G NR PCell inter-frequency handover
attempt

   

MCG Release NR SCell 5G NR CA 5G NR MCG release of SCell

MCG Addition NR SCell 5G NR CA 5G NR MCG addition of SCell

   

DSS Setup NR SCell 5G NR CA 5G NR MCG SCell configuration with LTE
DSS carrier

DSS Release NR SCell 5G NR CA 5G NR MCG SCell release from LTE DSS
carrier

   

SN Addition NR PSCell 5G NR-NR DC SN 5G NR PSCell addition to 5G NR MN

SN Release NR SCell 5G NR-NR DC SCell release from SN 5G NR PSCell

SN Addition NR SCell 5G NR-NR DC SCell addition to SN 5G NR PSCell

   

IRAT NR-LTE Handover Attempt 5G NR->LTE IRAT 5G NR to LTE inter-system handover
attempt

IRAT NR-LTE Redirection Attempt 5G NR->LTE IRAT 5G NR RRC release with redirection to LTE
carrier

   

RB AddMod NR MCG PDCP 5G NR Data Radio Bearer addition or reconfigura-
tion of NR PDCP entity in 5G NR MCG

5G RRC events
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12.8  GSM channels and power classes

There are various types of channels.

The traffic channel (TCH) serves to carry data, the control channel (CCH) to carry sig-
naling and synchronization data.

There are three types of control channel: broadcast channels are used to carry mobile
station frequency corrections (FCCH = frequency correction channel), for frame syn-
chronization (SCH = synchronization channel) and to carry information about the mode
in operation at the base station (BCCH = broadcast control channel). General control
channels (CCCH = common control channel) carry information about the communica-
tion network set-up. Purpose-related control channels (DCCH = dedicated control
channels) encode the exchanges between the base station (BS) and the mobile station
(MS).

Channel coding with error recognition and correction causes redundancies in the utiliz-
able data. Channel coding may raise the bandwidth requirements, but it also raises the
signal interference resistance and therefore lowers the power requirement.

The language coder on the TCH delivers 260 bit per 20 ms (13 kbit/s) to channel cod-
ing. The first 182 bits (class 1 bits) are far more important than the rest of the data (78
bit, class 2 bits) as far as their content is concerned. The first 50 bits in class 1 are fur-
ther protected with 3 parity bits (class 1a bits). The remaining bits in class 1 are called
class 1b bits. Three sensibility classes stem from this.

Figure 12-1: GSM coded channel

All class 1 bits are coded with a Convolutional code (Viterbi-Code, R = 1/2, v = 4). 4
additional bits are allocated to each bit in class 1 whereby the additional bits form the
memory of the Viterbi coder. So, a coded bit sequence of bit length 378 results from
the 189 bits of class1. The bit sequence together with the 78 non-coded, class 2 bits
form a block of 456 bits which are transmitted in 20 ms (22.8 kBit/s).

On the SCH (Synchronization Channel) 25-bit blocks are sequentially coded to a block
length of 78 bits with a BCH code shortened to 35 bits and then analogue to the TCH.

To save the signaling data, 184 bit frames are sequentially coded to a block length of
456 bits with the fire code on a 224 bit frame length and then analogue to the TCH.

The data are then interleaved and encoded.

GSM channels and power classes
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12.8.1  GSM channel bands and power classes

Table 12-14: Frequency ranges

Band Subband Uplink [MHz] Downlink [MHz]

GSM400 GSM450 450.4 to 457.4 460.4 to 467.4

GSM480 478.8 to 486.0 488.8 to 496.0

GSM700 GSM 750 747 to 762 777 to 792

GSM900 P-GSM900 (primary GSM) 890 to 915 935 to 960

E-GSM (extended GSM) 880 to 890 925 to 935

R-GSM (Railways GSM) 876 to 880 921 to 925

ER-GSM (extended Railways GSM) 873.2 to 876 918.2 to 921

GSM1800 GSM1800 1710 to 1785 1805 to 1880

GSM850 GSM850 824 to 849 869 to 894

GSM1900 GSM1900 1850 to 1910 1930 to 1990

Table 12-15: Channel numbers (ARFCN)

(Sub)band Uplink [MHz] Downlink [MHz] n Range

GSM450 450.6 + 0.2 * (n – 259) 460.6 + 0.2 * (n – 259) 259 ( n ( 293

GSM480 479.0 + 0.2 * (n – 306) 489.0 + 0.2 * (n – 306) 306 ( n ( 340

GSM 750 747.2 + 0.2 * (n – 438) 777.2 + 0.2 * (n – 438) 438 ( n ( 511

P-GSM900 890 + 0.2 * n 935 + 0.2 * n 1 ( n ( 124

E-GSM900 880.2 + 0.2 * (n – 975) 925.2 + 0.2 * (n – 975) 975 ( n ( 1023

R-GSM900 876.2 + 0.2 * (n – 955) 921.2 + 0.2 * (n – 955) 955 ( n ( 974

ER-GSM900 873.2 + 0.2 * (n – 940) 918.2 + 0.2 * (n – 940) 940 ( n ( 954

GSM1800 1710.2 + 0.2 * (n – 512) 1805.2 + 0.2 * (n – 512) 512 ( n ( 885

GSM850 824.2 + 0.2 * (n – 128) 869.2 + 0.2 * (n – 128) 128 ( n ( 251

GSM1900 1850.2 + 0.2 * (n - 512) 1930.2 + 0.2 * (n - 512) 512 ( n ( 810

GSM channels and power classes
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Figure 12-2: Downlink channels in P-GSM900 (primary GSM)
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Figure 12-3: Downlink channels in Railways GSM900: ER-GSM and R-GSM

GSM channels and power classes
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Figure 12-4: Downlink channels in extended GSM900: E-GSM
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Figure 12-5: Downlink channels in GSM1800 / part 1
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Figure 12-6: Downlink channels in GSM1800 / part 2
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Figure 12-7: Downlink channels in GSM850
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Figure 12-8: Downlink channels in GSM1900 / part 1

GSM channels and power classes
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Figure 12-9: Downlink channels in GSM1900 / part 2

Table 12-16: GSM power classes and output powers

 GSM900  1800/1900  

TxPower Level
(PCL)

Nominal output
power / dBm

Power Class/
Max. output
power

Nominal output
power / dBm

Power Class/
Max. output
power

0 43 1 / 20 W 30 1 / 1 W

1 41  28  

GSM channels and power classes



AppendixDrive Test Software

2404Operating Manual 1171.6415.12 ─ 66

 GSM900  1800/1900  

TxPower Level
(PCL)

Nominal output
power / dBm

Power Class/
Max. output
power

Nominal output
power / dBm

Power Class/
Max. output
power

2 39 2 / 8 W 26  

3 37 3 / 5 W 24 2 / 0.25 W

4 35  22  

5 33 4 / 2 W 20  

6 31  18  

7 29 5 / 0.8 W 16  

8 27  14  

9 25  12  

10 23  10  

11 21  8  

12 19  6  

13 17  4  

14 15  -  

15 13  -  

16 11  -  

17 9  -  

18 7  -  

19 5  -  

GSM Phase 1: 0≤TxPower ≤15

GSM Phase 2 (since 1996): 0≤TxPower≤19

Table 12-17: Definition of RX Level and RX Quality

Value of
RX Level

Corresponding
signal strength

 Value of
RX Qual-
ity

Corresponding
bit error rate

63 > –48 dBm  0 0% to 0.2%

62 –49 dBm to –48 dBm  1 0.2% to 0.4%

62 –50 dBm to –49 dBm  2 0.4% to 0.8%

... ...  3 0.8% to 1.6%

... ...  4 1.6% to 3.2%

2 –109 dBm to –108 dBm  5 3.2% to 6.4%

GSM channels and power classes
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Value of
RX Level

Corresponding
signal strength

 Value of
RX Qual-
ity

Corresponding
bit error rate

1 –110 dBm to –109 dBm  6 6.4% to 12.8%

0 < –110 dBm  7 12.8% to 100%

12.9  UMTS channels

The assignment between UMTS UARFCNs (UTRA Absolute Radio Frequency Chan-
nel Numbers) N, carrier frequency F, and frequency offset Foffset is defined in the 3GPP
specification (TS 25.101). The following relation holds for both directions of transmis-
sion (uplink and downlink) and all operating bands:

The downlink and uplink channels assigned in the operating bands I to IX are listed in
the tables below. Note that in operating bands II, IV and VI additional center frequen-
cies are specified. These additional channels are outside of the normal 200 kHz raster
and are calculated with different offsets according to the formula above, they must be
specified with their channel frequency. Refer to 3GPP TS 25.101 V12.2.0
Table 12-18: UTRA operating bands and channel numbers: Downlink

Operating
Band

DL Fre-
quency
Band (MHz)

DL Fre-
quency Off-
set (MHz)

Assigned Channels
(UARFCNs)

Assigned Center Frequen-
cies
(MHz)

I 2110 to 2170 0.0 10562 to 10838 2112.4 to 2167.6

II 1930 to 1990 0.0

1850.1

9662 to 9938,

Additional channels:

412, 437, 462, 487, 512, 537,

562, 587, 612, 637, 662, 687

1932.4 to 1987.6,

1932.5, 1937.5, 1942.5,
1947.5, 1952.5, 1957.5,
1962.5, 1967.5, 1972.5,
1977.5, 1982.5, 1987.5

III 1805 to 1880 1575.0 1162 to 1513 1807.4 to 1877.6

IV 2110 to 2155 1805.0

1735.1

1537 to 1738,

Additional channels:

1887, 1912, 1937, 1962,

1987, 2012, 2037, 2062,
2087

2112.4 to 2152.6,

2112.5, 2117.5, 2122.5,
2127.5,

2132.5, 2137.5, 2142.5,
2147.5, 2152.5

V 869 to 894 0.0

670.1

4357 to 4458,

Additional channels:

1007, 1012, 1032, 1037,

1062, 1087

871.4 to 891.6,

871.5, 872.5, 876.5, 877.5,

882.5, 887.5

VI 875 to 885 0.0

670.1

4387 to 4413,

Additional channels:

1037, 1062

877.4 to 882.6,

877.5, 882.5

UMTS channels
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Operating
Band

DL Fre-
quency
Band (MHz)

DL Fre-
quency Off-
set (MHz)

Assigned Channels
(UARFCNs)

Assigned Center Frequen-
cies
(MHz)

VII 2620 to 2690 2175

2105.1

2237 to 2563

Additional channels:

2587, 2612, 2637, 2662,
2687, 2712, 2737, 2762,
2787, 2812, 2837, 2862,
2887, 2912

2622.4 to 2687.6,

2622.5, 2627.5, 2632.5,
2637.5, 2642.5,

2647.5, 2652.5, 2657.5,
2662.5, 2667.5,

2672.5, 2677.5, 2682.5,
2687.5

VIII 925 to 960 340 2937 to 3088 927.4 to 957.6

IX 1844.9 to
1879.9

0.0 9237 to 9387 1847.4 to 1877.4

X 2110 to 2170 1490

1430.1

3112 to 3388

Additional channels:

3412 to 3687 (step 25)

2112.4 to 2167.6,

2112.5 to 2167.5

XI 1475.9 to
1500.9

736 3712 to 3812 1478.4 to 1498.4

XII 728 to 746 -37

-54.9

3837 to 3903

Additional channels:

3927, 3932, 3957, 3962,
3987, 3992

730.4 to 743.6,

730.5 to 743.5

XIII 746 to 756 -55

-64.9

4017 to 4047

Additional channels:

4067, 4092

748,4 to 753.6,

748.5 to 753.5

XIV 758 to 768 -63

-72.9

4117 to 4143

Additional channels:

4167, 4192

760.4 to 765.6,

760.5, 765.5

XIX 875 to 890 735

720.1

712 to 763

Additional channels:

787, 812, 837

877,4 to 887,6

877,5 to 887,5

XX 791 to 821 -109 4512 to 4638 793,4 to 818,6

XXI 1495,9 to
1510,9

1326 862 to 912 1498,4 to 1508,4

XXII 3510 to 3590 2580 4662 to 5038 3512,4 to 3587,6

XXV 1930 to 1995 910

674,1

5112 to 5413

Additional channels:

6292, 6317, 6342, 6367,
6392, 6417, 6442, 6467,
6492, 6517, 6542, 6567,
6592

1932,4 to 1992,6

1932,5; 1937,5; 1942,5;
1947,5; 1952,5, 1957,5;
1962,7; 1967,5; 1972,5;
1977,5; 1982,5; 1987,5;
1992,5

XXVI 859 to 894 -291 4598 to 4749 861,4 to

891,6

UMTS channels
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Operating
Band

DL Fre-
quency
Band (MHz)

DL Fre-
quency Off-
set (MHz)

Assigned Channels
(UARFCNs)

Assigned Center Frequen-
cies
(MHz)

Free
(10 kHz
resolution)
⇩

80 to 3000 – – –

⇧ = freely configurable measurement with TSMQ / TSMU / TSML-W

Table 12-19: UTRA operating bands and channel numbers: Uplink

Operating
Band

UL Fre-
quency
Band (MHz)

UL Fre-
quency Off-
set (MHz)

Assigned Channels
(UARFCNs)

Assigned Center Frequen-
cies
(MHz)

I 1920 to 1980 0.0 9612 to 9888 1922.4 to 1977.6

II 1850 to 1910 0.0

1850.1

9262 to 9538,

Additional channels:

12, 37, 62, 87, 112, 137,

162, 187, 212, 237, 262, 287

1852.4 to 1907.6 ,

1852.5, 1857.5, 1862.5,
1867.5, 1872.5, 1877.5,
1882.5, 1887.5, 1892.5,
1897.5, 1902.5, 1907.5

III 1710 to 1785 1525.0 937 to 1287 1712.4 to 1782.6

IV 1710 to 1755 1450.0

1380.1

1312 to 1513,

Additional channels:

1662, 11687, 1712, 1737,

1762, 1787, 1812, 1837, 1862

1712.4 to 1752.6,

1712.5, 1717.5, 1722.5,
1727.5,

1732.5, 1737.5, 1742.5,
1747.5, 1752.5

V 824 to 849 0.0

670.1

4132 to 4233,

Additional channels:

782, 787, 807, 812,

837, 862

826.4 to 846.6,

826.5, 827.5, 831.5, 832.5, 1

827.5, 842.5

VI 830 to 840 0.0

670.1

4162 to 4188,

Additional channels:

812, 837

832.4 to 837.6,

832.5, 837.5

VII 2500 to 2570 2100.0

2030.1

2012 to 2338

Additional channels:

2362, 2387, 2412, 2437,
2462, 2487, 2512, 2537,
2562, 2587, 2612, 2637,
2662, 2687

2502.4 to 2567.6,

2502.5, 2507.5, 2512.5,
2517.5, 2522.5,

2527.5, 2532.5, 2537.5,
2542.5, 2547.5,

2552.5, 2557.5, 2562.5,
2567.5

VIII 880 to 915 340 4412 to 4563 882.4 to 912.6

IX 1749.9 to
1784.9

0.0 8762 to 8912 1752.4 to 1782.4

X 1710 to 1770 1135

1075.1

2887 to 3163

Additional channels:

3187 to 3462 (step 25)

1712.4 to 1767.6,

1712.5 to 1767.5

UMTS channels
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Operating
Band

UL Fre-
quency
Band (MHz)

UL Fre-
quency Off-
set (MHz)

Assigned Channels
(UARFCNs)

Assigned Center Frequen-
cies
(MHz)

XI 1427.9 to
1452.9

733 3487 to 3587 1430.4 to 1450.4

XII 698 to 716 -22

-39.9

3612 to 3678

Additional channels:

3702, 3707, 3732, 3737,
3762, 3767

700.4 to 713.6,

700.5 to 713.5

XIII 777 to 787 21

11.1

3792 to 3818

Additional channels:

3842, 3867

779.4 to 784.6,

779.5, 784.5

XIV 788 to 798 12

2.1

3892 to 3918

Additional channels:

3942, 3967

790.4 to 795.6,

790.5, 795.5

XIX 830 to 845 770

755,1

312 to 363

Additional channels:

387, 412, 437

832,4 to 842,6

832,5; 837,5; 842,5

XX 832 to 862 -23 4287 to 4413 834,4 to 859,6

XXI 1447,9 to
1462,9

1358 462 to 512 1450,4 to 1460,4

XXII 3410 to 3490 2525 4437 to 4813 3412,4 to 3487,6

XXV 1850 to 1915 875

639,1

4887 to 5188

Additional channels:

6067, 6092, 6117, 6142, 6167,
6192, 6217, 6242, 6267,
6292, 6317, 6342, 6367

1852,4 to 1912,6

1852,5; 1857,5; 1862,5;
1867,5; 1872,5; 1877,5;
1882,5; 1887,5; 1892,5;
1897,5; 1902,5, 1907,5;
1912,5

Free
(10 kHz
resolution)
⇩

80 to 3000 – – –

⇧ = freely configurable measurement with TSMQ / TSMU / TSML-W

UMTS channels
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Figure 12-10: Downlink channels in UMTS operating band I

UMTS channels
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Figure 12-11: Downlink channels in UMTS operating band II

The 12 additional downlink channels of the 200 MHz raster are listed in Table 12-18

UMTS channels
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Figure 12-12: Downlink channels in UMTS operating band III

12.10  CDMA2000 band classes

The band classes for CDMA2000 forward and reverse signals are defined in 3GPP2
C.S0057. Each band class contains a number of carrier frequencies and corresponding
channel numbers.

The tables below list the supported band classes with the corresponding channel num-
bers and the formulas for calculation of center frequencies from channel numbers.

CDMA2000 band classes
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Table 12-20: Band classes for forward signals

Band Class
Number

Band Class Name Channel
Number N

Center
Frequency [MHz]

0 US-Cellular, Korean Cellular 1 ≤ N ≤ 799

991 ≤ N ≤ 1023

1024 ≤ N ≤ 1323

870 + 0.03 N

870 + 0.03 (N – 1023)

860.03 + 0.03 (N – 1024)

1 North American PCS 0 ≤ N ≤ 1199 1930 + 0.05 N

2 TACS Band 0 ≤ N ≤ 1000

1329 ≤ N ≤ 2047

2048 ≤ N ≤ 2108

934.9875 + 0.025 N

916.9875 + 0.025 (N – 1328)

849 + 0.025 (N – 2048)

3 JTACS Band 1 ≤ N ≤ 799

801 ≤ N ≤ 1039

1041 ≤ N ≤ 1199

1201 ≤ N ≤ 1600

860 + 0.0125 N

843 + 0.0125 (N – 800)

832 + 0.0125 (N – 1040)

838 + 0.0125 (N – 1200)

4 Korean PCS 0 ≤ N ≤ 599 1840 + 0.05 N

5 NMT-450 1 ≤ N ≤ 400

472 ≤ N ≤ 871

1039 ≤ N ≤ 1473

1536 ≤ N ≤ 1715

1792 ≤ N ≤ 2016

460 + 0.025 (N – 1)

420 + 0.025 (N – 472)

461.01 + 0.025 (N – 1024)

489 + 0.025 (N – 1536)

489 + 0.020 (N – 1792)

6 IMT-2000 0 ≤ N ≤ 1199 2110 + 0.05 N

7 Upper 700 MHz 0 ≤ N ≤ 240 746 + 0.05 N

8 1800 MHz Band 0 ≤ N ≤ 1499 1805 + 0.05 N

9 North American 900 MHz 0 ≤ N ≤ 699 925 + 0.05 N

10 Secondary 800 MHz 0 ≤ N ≤ 719

720 ≤ N ≤ 919

851 + 0.025 N

935 + 0.025 (N – 720)

11 European 400 MHz PAMR 1 ≤ N ≤ 400

472 ≤ N ≤ 871

1039 ≤ N ≤ 1473

1536 ≤ N ≤ 1715

1792 ≤ N ≤ 2016

460 + 0.025 (N – 1)

420 + 0.025 (N – 472)

Reserved

489 + 0.025 (N – 136)

Reserved

12 800 MHz PAMR 0 ≤ N ≤ 239 915.0125 + 0.025 N

13 IMT-2000 2.5 GHz Exten-
sion

0 ≤ N ≤ 1399 2620 + 0.05 N

14 US PCS 1900 MHz 0 ≤ N ≤ 1299 1930 + 0.05 N

15 AWS Band 0 ≤ N ≤ 899 2110 + 0.05 N

16 US 2.5 GHz Band 140 ≤ N ≤ 1459 2617 + 0.05 N

17 US 2.5 GHz Forward 140 ≤ N ≤ 1459 2617 + 0.05 N

CDMA2000 band classes
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Band Class
Number

Band Class Name Channel
Number N

Center
Frequency [MHz]

18 Public Safety Bands 700
MHz

0 ≤ N ≤ 240 757 + 0.05 N

19 Lower 700 MHz 0 ≤ N ≤ 360 728 + 0.05 N

20 L-Band 0 ≤ N ≤ 680 1525 + 0.05 N

21 S-Band 0 ≤ N ≤ 200

201 ≤ N ≤ 399

2190 + 0.05 N

2180 + 0.05 (N – 200)

Table 12-21: Band classes for reverse signals

Band Class
Number

Band Class Name Channel Number N Center Frequency [MHz]

0 US-Cellular, Korean Cellular 1 ≤ N ≤ 799

991 ≤ N ≤ 1023

1024 ≤ N ≤ 1323

825 + 0.03 N

825 + 0.03 (N - 1023)

815.04 + 0.03 (N - 1024)

1 North American PCS 0 t≤ N ≤ o 1199 1850 + 0.05 * N

2 TACS Band 0 ≤ N ≤ 1000

1329 ≤ N ≤ 2047

2048 ≤ N ≤ 2108

889.9875 + 0.025 N

871.9875 + 0.025 (N - 1328)

894 + 0.025 (N - 2048)

3 JTACS Band 1 ≤ N ≤ 799

801 ≤ N ≤ 1039

1041 ≤ N ≤ 1199

1201 ≤ N ≤ 1600

915 + 0.0125 N

898 + 0.0125 (N - 800)

887 + 0.0125 (N - 1040

893 + 0.0125 (N - 1200)

4 Korean PCS 0 ≤ N ≤ 599 1750 + 0.05 N

5 NMT-450 1 ≤ N ≤ 400

472 ≤ N ≤ 871

1039 ≤ N ≤ 1473

1536 ≤ N ≤ 1715

1792 ≤ N ≤ 2016

450 + 0.025 (N - 1)

410 + 0.025 (N - 472)

451.01+ 0.02 (N - 1024)

479+ 0.025 (N - 1536)

479+ 0.025 (N - 1792)

6 IMT-2000 0 ≤ N ≤ 1199 1920 + 0.05 N

7 Upper 700 MHz 0 ≤ N ≤ 240 776 + 0.05 N

8 1800 MHz Band 0 ≤ N ≤ 1499 1710 + 0.05 N

9 North American 900 MHz 0 ≤ N ≤ 699 880 + 0.05 N

10 Secondary 800 MHz 0 ≤ N ≤ 719

720 ≤ N ≤ 919

806 + 0.025 N

896 + 0.025 (N - 720)

11 European 400 MHz PAMR 1 ≤ N ≤ 400

472 ≤ N ≤ 871

1536 ≤ N ≤ 1715

450 + 0.025 (N - 1)

410 + 0.025 (N - 472)

479 + 0.025 (N - 1536)

12 800 MHz PAMR 0 ≤ N ≤ 239 870.0125 + 0.025 N

CDMA2000 band classes
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Band Class
Number

Band Class Name Channel Number N Center Frequency [MHz]

13 IMT-2000 2.5 GHz Exten-
sion

0 ≤ N ≤ 1399 2500 + 0.05 N

14 US PCS 1900 MHz 0 ≤ N ≤ 1299 1850 + 0.05 N

15 AWS Band 0 ≤ N ≤ 899 1710 + 0.05 N

16 US 2.5 GHz Band 140 ≤ N ≤ 1459 2495 + 0.05 N

18 Public Safety Band 700
MHz

0 ≤ N ≤ 240 787 + 0.05 N

19 Lower 700 MHz 0 ≤ N ≤ 360 698 + 0.05 N

20 L-Band 0 ≤ N ≤ 680 1626.5 + 0.05 N

21 S-Band 0 ≤ N ≤ s200

201≤N≤399

2000 + 0.05 N

2010 + 0.05 (N – 200)

12.11  Smartphone SQ measurement job file

12.11.1  Global job / call timing related parameters

The call timing and the global job parameters are given in the following tables.
Table 12-22: Call timing parameters

Parameter Name in Ini Explanation Value

Task Duration TaskDuration Duration of task 0: Unlimited

Task Cycles TaskCycles Number of task cycles 0: Unlimited

Window duration CallWndSize Time for a Mobile Originated Calls (MOC) or
Mobile Terminated Calls (MTC) window. For
NetQual, MOC means A to B and MTC means
B to A. Within a window, the system performs 0
or more tests calls. Such calls can either be
started and terminated by the mobile unit. This
parameter is extremely important and is always
respected during the test session to keep the A-
side and the B-side synchronized.

Integer (sec.)

First call setup delay CSDelay Time between the start of a new window and
the first call setup.

Integer (sec.)

Call duration CallDuration Time between the dial command and discon-
nect.

Integer (sec.)

Pause duration PauseDuration Time in seconds between the last call termina-
tion and the next dial command.

Integer (sec.)

Smartphone SQ measurement job file
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Parameter Name in Ini Explanation Value

Guard time GuardTime Time in seconds before the end of the window
where all ongoing calls are disconnected by the
system to ensure that the next measurement
window can start immediately.

Integer (sec.)

No call setup time NoCSTime Time before the end of the window where no
new calls are started.

Integer (sec.)

Pause after failed call PauseAfter-
Failed

Time that the system uses to pause after a
failed call setup. This can be different from the
normal pause time between calls.

Integer (sec.)

Pause after max
failed calls

PauseAfterMax-
Failed

Time that the system uses to pause after a
failed call setup. This can be different from the
normal pause time between calls.

Integer (sec.)

Average call setup
time

AverageCSTime Time which is used to calculate the remaining
time for the tests within a call. This value
directly affects the total duration.

Integer (sec.)

Max call setup time MaxCSTime Maximum time for call setup. Integer (sec.)

No connection time-
out

NoConnec-
tionTmo

If MOC or MTC calls occur within this time, the
system stops.

Integer (sec.)

Alerting timeout AlertingTimeout Time in seconds between Channel Request and
Alerting. If this value is > 0, then the call termi-
nates if the alerting signal is not received within
the specified time after a channel request. This
parameter is only applicable for mobile devices.

Integer (sec.)

Use call duration to
abort call

UseCallDuration Terminates the call when the pre-configured call
duration expires and makes the Dedicated
Mode part of a test fixed. If you want the call to
terminate after the tests are completed, clear
the check mark from this box. If you uncheck
the option, the duration of a test depends on the
Call Setup Time and on the Calculation Time of
the algorithm, both of which are not fixed. As a
result, the ratio between Dedicated Mode and
Idle Mode of a test is not fixed.

Integer

Table 12-23: Global job parameters

Parameter Name in Ini Explanation Value

Side Side Defines the side for which this job file is A; B

Use DTMF Job
Transfer

UseDTMF Defines whether DTMF Job Transfer mode is
used

0: off; 1: on

Record hang-over RecordHO The default value is 2000 ms, however, 1000
ms is usually sufficient for mobile to land unit
(M2L) calls. The record hang-over covers the
signal delay on the channel. To prevent clipping
at the end of the audio recordings, do not enter
a value that is close to 0 ms.

Integer (ms)

MOC:MTC ratio WndRatio Specify the ratio of MOC windows to MTC win-
dows. For QualiPoc speech tests, you must set
this parameter to 1:0.

<Inte-
ger>:<Inte-
ger>

Smartphone SQ measurement job file
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Parameter Name in Ini Explanation Value

Max failed calls MaxFailedCalls Maximum number of consecutive failed calls. In
the case of a failed call, the Window duration
always applies. The A-side and the B-side must
remain synchronized during the whole test,
even if a failed call occurs. By definition, a failed
call cannot be acknowledged by the B-side.

Integer

Job Name JobName Job file name String

Test sequence repeti-
tion

TestSeqRepeti-
tion

Specifies how often to repeat the sequence of
defined test

Integer

Allow call reestab-
lishment

AllowCallRees-
tablishment

Keeps the Diversity VoiceEngine open if a con-
nection drops and waits for the mobile phone to
reestablish the call, so that the measurements
can continue. At the end of the call duration that
you specify on the "Timing" tab, the phone
drops the call. Only some network operators
allow mobile phones to reestablish a dropped
call In both cases, the call status changes to
dropped.

Integer

12.11.2  Unit related parameters

The parameters for A and B side units are given in the following tables.
Table 12-24: A-side releated unit parameters

Parameter Name in Ini Explanation Value

Unit Type Unit_Name Unit type ID Integer

Unit Name Unit_Name Unit name String

Computer Name Com-
puter_Name

Computer name. String

Table 12-25: B-side releated unit parameters

Parameter Name in Ini Explanation Value

Unit Type Unit_Type Unit type ID Integer

Unit Name Unit_Name Unit name String

Computer Name Com-
puter_Name

Computer name. String

12.11.3  Tests related parameters

These parameters define all tests (0..n) within the job. Each parameter name is post
fixed by _n whereas n is 0...<test count>.

Smartphone SQ measurement job file
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Table 12-26: Test releated parameters

Parameter Name in Ini Explanation Value

Test Name TestName User specified test name String

Test Type TypeOfTest Type of test String

Direction Direction Audio direction 0: Uplink (A-
>B)

1: Downlink
(B->A)

Audio Reference ReferenceSam-
ple

Reference sample used 0: Yes

1: No

2: Based on
MOS

Save video files WaveFileOption Specifies the settings for saving video record-
ings as AVI files. Be aware that these files can
be quite large.

0: Yes

1: No

Save video files -
MOS threshold

WaveFileFilter If MOS is selected, then this threshold applies. Float

12.12  Configuration of a streaming server using VLC

R&S ROMES4 supports measurements of a MP4 video stream as it is available, for
example, in www.youtube.com.

There are several reasons not to use video streams from freely available addresses,
for example:
● Availability of the site is not guaranteed
● Streaming data rate depends on the availability of the server, not (only) on the net-

work

R&S ROMES4 users may wish to maintain a video streaming server on their own
server. In the following is described how to set up a server for this purpose. The server
may run on a Linux system, such as Red-Hat, CentOS or Ubuntu. This document
assumes an Ubuntu 64 bit system, version 14.04 (LTS). The server may also run on a
Windows system, such as MS Windows 7, Windows 8, Windows Server 2008 etc.

This document assumes the MS Windows10, 64 bits system.

12.12.1  Pre-requisites

Dependent on operating system, the following has to installed
● Linux

– Ubuntu 14.04 LTS
– VLC (out of the box)

● Windows

Configuration of a streaming server using VLC
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– Windows 10, 64 bits system
– VLC (source: http://www.videolan.org)

● Both systems
A mpeg-4 video to stream. A sample is provided on the R&S ROMES DVD
(RS_test_and_measurement.mp4).

12.12.2  Installation of VLC

● Linux
Run as root apt-get install vlc

● Windows
1. Download the installer for http://www.videolan.org, currently
vlc-2.1.5-win32.exe
2. Start the program and accept all defaults

12.12.3  Configure the stream

12.12.3.1  Linux

1. Copy the video to a directory, for example, the ~/RS_stream

2. Create a file named stream.vlm with the following contents:
● # VLC media player VLM command batch
● # http://www.videolan.org/vlc/
● # start vlc as root wit
● # vlc-wrapper --ttl 12 -vvv --color -I telnet

--telnet-password v --rtsp-host 0.0.0.0 --rtsp-port 5554 
--vlm stream.vlm

New rs_test vod enabled
Setup rs_test input RS_test_and_measurement.mp4
Start the server as a root with (one line)
vlc-wrapper --ttl 12 -vvv --color -I telnet --telnet-password
<your-password> --rtsp-host 0.0.0.0 --rtsp.port 5554 --vlm
stream.vlm

You should change the RTSP port and the telnet password according to your needs. A
sample bash script can be found on DVD in directory vlc\linux\ as
start_vlc_server.

The script must be located in the same directory as the MP4 file.

Configuration of a streaming server using VLC
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12.12.3.2  Windows

1. Copy the video to a directory, for example, the ~/RS_stream

2. Create a file named stream.vlm with the following contents:
● # VLC media player VLM command batch
● # http://www.videolan.org/vlc/
New rs_test vod enabled
Setup rs_test input RS_test_and_measurement.mp4
Start the server as a root with (one line)
vlc --ttl 12 -vvv --color -I HTTP --http-password
<your-password> --http-port 8080 --rtsp-host 0.0.0.0
--rtsp-port 5554 --vlm stream.vlm

You should change the RTSP port, HTTP port and the http password according to your
needs. A sample DOS script can be found on DVD in directory vlc\windows\ as
start_vlc_server.cmd as well as a sample configuration file stream.vlm.

The script must be located in the same directory as the MP4 file.

The server can only be stopped by killing it via the task explorer.

12.12.3.3  Remark

The http port and password are not really needed as the HTTP interface is not used in
our example.

If the rtsp-host is set to 0.0.0.0, all network card with all addresses are used. To restrict
the server to on LAN card only, enter the card’s address.

12.12.4  Test the stream

On both systems, the stream can be tested via the command line, by entering

vlc rtsp://127.0.0.1:5554/rs_test
On Windows you may need to enter the vlc name fully qualified, for example

"%ProgramFiles(x86)%\VideoLAN\VLC\vlc.exe"

Alternatively, start vlc interactively

1. Select "Media > Open Network Stream" (CTLR-N)

2. Enter "“rtsp://127.0.0.1:5554/rs_test"

Configuration of a streaming server using VLC
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if you start vlc on a remote PC, you need to enter the correct IP-address for the server
PC.

Figure 12-13: Server PC IP address

12.12.5  Firewall settings

You need to open the firewall for udp-port 5554 to enable remote access to the server.

12.13  Coordinate systems

The measured field strength values can be displayed in a variety of coordinate sys-
tems, depending on the needs of the user. Digitized data on the location coordinates
can be obtained with a GPS system or with a digitizer, which is moved over an appro-
priate land map.

Coordinate systems
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12.13.1  Gauß coordinate systems

The mathematical principles for this type of coordinate system were developed by
Gauß, and its adaptation for practical application was completed by Krüger. This pro-
jection can be seen more or less as a cylindrical projection on a quadrature axis, where
a cylinder is rotated over the earth ellipsoid at right angles to the rotational axis of the
ellipsoid. The surface of the earth is then translated through a central projection to the
inside of the cylinder. The position of the cylinder is chosen in such a manner that a
tangential meridian forms a distortion-free straight line. The equator, perpendicular to
the meridian, also forms a straight line. As distance from the tangential meridian
increases, there is some distortion. This is also noticeable in the representation of the
earth's surface to the east and to the west of the tangential meridian.

To keep the distortion as low as possible, the projection is limited to a strip 1.5° to the
side of the tangential meridian (for this reason also referred to as the mean or main
meridian). An ellipse is thus created on the surface of the cylinder, the extremities of
which are the poles. The entire surface of the earth is divided into 60 meridian strips,
which, by "opening up" the cylinder, can be represented as follows:

12.13.1.1  The gauß-krüger system

With the Gauß quadrature axis projection the surface of the earth can be represented
on one level in meridian strips. The mean meridian is represented by the y-axis
(abscissa) and the equator by the x-axis (ordinate). Both axes are perpendicular to
each other. The result is a rectangular coordinate system in each meridian strip (cf.
diagram above). The abscissa to the north of the equator are vertical values, the ordi-
nates to the east of the mean meridian are horizontal values.

To avoid negative values for the ordinates, every main meridian is given the value of
500000 meters. As a means of identification, this is prefaced by its degree of longitude
divided by three.

To reduce to acceptable values the distortions occurring as distance from the tangen-
tial meridian increases, strip systems were introduced in Germany which assume the

Coordinate systems
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degrees of longitude (meridians) at 6°, 9°, 12°, etc. to be main meridians true to longi-
tude and represent them as abscissa axes. Every partial system has an extension of
1.5 degrees of longitude in both directions (approx. 100 km).

A point which is 30500 m to the west of the mean meridian at 6° is assigned the hori-
zontal value

500000 m - 30500 m = 469500 m.

12.13.1.2  UTM system

The Universal Transversal Mercator projection (UTM) is a transversal cylindrical pro-
jection used mainly for NATO and USA military maps. The UTM system covers the
earth between 80° north and south with 60 meridian systems (zones). The main meridi-
ans of each zone lying at 3°, 9°, 15°, etc. are numbered from west to east, beginning
with the mean meridian at 177° west. In each zone intervals of approx. 8° are selected
and marked with capital letters, beginning at 80° south. All of the fields produced in this
way are then divided by grids with round 100 km values in the x and y directions from
the mean meridian to form squares with a width of 100 km. These squares are marked
with two letters according to their row and column position. Coordinates are then used
to determine an exact position within one of the squares. The coordinates are marked
E (east, corresponding to y or the horizontal value) and N (north, corresponding to x or
the vertical value). The resulting structure is a universal grid.

12.13.2  Coordinate system of the east european states

For average-scale maps the East European states use Gauß-Krüger meridian systems
with a longitudinal extension of 6° and a mean meridian true to longitude on the basis
of Krassovskij earth ellipsoid. For maps with scales of 1:5000 and more, strips of 3° are
used.

12.13.3  Geographical grid

In the geographical grid positional information is given by measuring the degrees of
longitude and latitude in degrees, minutes and seconds.

12.13.4  Decimal grid

In the decimal grid positional information is given by measuring the degrees of longi-
tude and latitude in decimal figures.

Coordinate systems
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Glossary: Abbreviations and terms
A

A3: Authentication Algorithm A3

A5/1: Encryption Algorithm A5

A5/2: Encryption Algorithm A5

A8: Algorithm A8

AACH: Access Assignment Channel, TETRA

AB: Access Burst

AC: Access Class (C0 to C15) or
Application Context

ACC: Automatic Congestion Control

ACCH: Associated Control Channel

ACD: Automatic Channel Detection

ACK: Acknowledgement

ACM: Address Complete Message

ACU: Antenna Combining Unit

ADB: Android Debugging Bridge

ADC: Administration Centre or
Analogue to Digital Converter

ADN: Abbreviated Dialling Number

ADPCM: Adaptive Differential Pulse Code Modulation

AE: Application Entity

AEC: Acoustic Echo Control

AEF: Additional Elementary Functions
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AGCH: Access Grant Channel

Ai: Action indicator

AMR: Adaptive Multi Rate (speech coding)

ANR: Automated Neighbor Relation

AoCC: Advice of Charge (Charging), supplementary service

AoCI: Advice of Charge Information, supplementary service

API: Application Programming Interface

APK file: Android Package file format

ARFCN: Absolute Radio Frequency Channel Number

ARQ: Automatic Request for Retransmission

ASCI: Advanced Speech Call Items

ASE: Application Service Element

ASN.1: Abstract Syntax Notation One

AT: Acceptance Test or Access Terminal (WiMAX) or ATtention (the prefix that informs
modem about start of a command line)

ATD: Command which establishes a data connection or voice connection to a remote
modem

ATIM: Alternative Technologies Information Message, specified by 3GPP2 C.S0005-F
v2.0 Spec, chapter 3.7.2.3.2.45

ATT (flag): Attach

AU: Access Unit

AuC: Authentication Centre

AUT(H): Authentication

B
BA: BCCH Allocation
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BAIC: Barring of All Incoming Calls, supplementary service

BAOC: Barring of All Outgoing Calls, supplementary service

BCC: Base Transceiver Station (BTS) Colour Code

BCCH: Broadcast Control Channel

BCCH_FREQ_NCELL: Frequency of the RF carrier on which the BCCH of a neigh-
bouring cell is transmitted

BCD: Binary Coded Decimal

BCF: Base Station Control Function

BCH: Broadcast Channel

BCIE: Bearer Capability Information Element

BCU: (See GSM 08.56 (ETS 300 595))

BER: Bit Error Ratio

BFI: Bad Frame Indication

BI: Barring of all Incoming call services

BIC-Roam: Barring of Incoming Calls when Roaming outside the HOME PLMN coun-
try, supplementary service

Bm: Full-rate traffic channel

BN: Bit Number

BO: Barring of all Outgoing Calls, supplementary service

BOIC: Barring of Outgoing International Calls supplementary service

BOIC-exHC: Barring of Outgoing international Calls except those directed to the Home
PLMN Country, supplementary service

BRI: Basic Rate Interface; an ISDN interface configuration

BS: Basic Service (group) or
Bearer Service
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BS_AG_BLKS_RES: Number of blocks on each common control channel reserved for
access grant messages

BS_BCCH_SDCCH_C0MB: Logical variable that indicates the combination of dedica-
ted and associated control channels on the same physical channel

BS_CC_CHANS: Number of basic physical channels supporting common control
channels

BS_G_BLKS_RES: Number of blocks on each common control channel reserved for
access grant messages

BS_PA_MFRMS: Number of multiframes between two transmissions of the same pag-
ing message to MSs of the same paging group

BSC: Base Station Controller

BSG: Basic Service Group

BSIC: Base Transceiver Station Identity Code

BSIC-NCELL: BSIC of a neighbour cell

BSS: Base Station Sub-system

BSSAP: Base Station System Application Part

BSSMAP: Base Station System Management Application Part

BSSOMAP: Base Station Operation and Maintenance Application Part

BTS: Base Transceiver Station

BWP: Bandwidth Part (for 5G NR)

C
C: Conditional

C-V2X: Cellular, aslo called LTE vehicle to everything

C/R: Command/Response field bit

CA: Carrier Aggregationn

CA_BAND_NUMB: Number of the frequency band that contains the cell allocation
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CAI: Charge Advice Information

CBC: Cell Broadcast Centre

CBCH: Cell Broadcast Channel

CC: Country Code or
Call Control or
Component Carrier

CCBS: Completion of Calls to Busy Subscribers supplementary service

CCCH: Common Control Channel

CCCH_GROUP: Group of MSs in idle mode

CCF: Conditional Call Forwarding

CCH: Channel

CCHl: Control Channel

CCITT: Comité Consultatif International Télégraphique et Téléphonique

CCPE: Control Channel Protocol Entity

Cct: Circuit

CDF: Cumulative Distribution Function

CED: Called station identifier

CELL_RESELECT_HYSTERESIS: RXLEV Hysteresis required for cell reselection

CELL-BAR-ACCESS: Cell Access Barred

CEPT: Conférence des administrations Européennes des Postes et Telecommunica-
tions

CER: Channel Energy Response

CF: Conversion Facility or
Call Forwarding services

CFB: Call Forwarding on MS Busy supplementary service
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CFC: Conditional Call Forwarding

CFNRc: Call Forwarding on MS Not Reachable supplementary service

CFNRy: Call Forwarding on MS No Reply supplementary service

CFU: Call Forwarding Unconditional supplementary service

CGI: Cell Global Identity

CHV: Card Holder Verification

CI: Cell Identity or
CUG Index

CIR: Channel Impulse Response

CKSN: Ciphering Key Sequence Number

CLI: Calling Line Identity

CLIP: Calling Line Identification Presentation, supplementary service

CLIR: Calling Line Identification Restriction, supplementary service

CM: Connection Management

CMD: Command

CMM: Channel Mode Modify

CNG: Calling tone

COI: Co-channel Interferer

COLI: Connect Line Identity

CoLP: Connected Line Identification Presentation supplementary service

CoLR: Connected Line identification Restriction supplementary service

COM: Complete

CONNACK: Connect Acknowledgement



Glossary: Abbreviations and termsDrive Test Software

2429Operating Manual 1171.6415.12 ─ 66

CQI: Channel Quality Information

CRC: Cyclic Redundancy Check (3 bit)

CRE: Call Re-establishment procedure

CS: Coding Scheme or Circuit Switched

CSFB: Circuit Switched Fallback

CSPDN: Circuit Switched Public Data Network

CST: Call Setup Time

CT: Channel Tester

CUG: Closed User Group, supplementary service

CW: Continuous Waveform or
Call Waiting, supplementary service

D
DAC: Digital to Analogue Converter

DB: Dummy Burst

DBWP: Downlink Bandwidth Part (for 5G NR)

DCCH: Dedicated Control Channel

DCE: Data Circuit terminating Equipment

DCF: Data Communication Function

DCN: Data Communication Network

DET: Detach

DISC: Disconnect

DL: Data Link (layer) or
Downlink (base station to mobile)

DLCI: Data Link Connection Identifier
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DLD: Data Link Discriminator

DLL: Dynamic Link Library

Dm: Control Channel (ISDN terminology applied to mobile service)

DMO: Direct Mode Operation; this is TETRA mobile radio communication between
mobile radios without existing network infrastructure.

DMR: Digital Mobile Radio

DNIC: Data Network Identification Code

DNS: Domain Name System

DP: Dial/Dialled Pulse

DPI: Dots per inch

DQA: Data Quality Analysis

DSE: Data Switching Exchange

DSI: Digital Speech Interpolation

DSS: Dynamic Spectrum Sharing

DSS1: Digital Subscriber Signalling No1

DTAP: Direct Transfer Application Part

DTE: Data Terminal Equipment

DTMF: Dual Tone Multi Frequency (signalling)

DTX: Discontinuous Transmission

E
EA: External Alarms

EBSG: Elementary Basic Service Group

Ec/No: Ratio of energy per modulating bit to the noise spectral density
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ECM: Error Correction Mode (facsimile)

ECT: Explicit Call Transfer, supplementary service

EEL: Electric Echo Loss

EIR: Equipment Identity Register

EIRENE: European Integrated Railway Radio Enhanced Network - System Require-
ments Specification made by GSM-R operators group

EL: Echo Loss

eMBMS: Evolved MBMS; LTE version of MBMS

EMM: Evolved Mobility Management

EMMI: Electrical Man Machine Interface

EN-DC: eNB-gNB Dual Connectivity

ERP: Ear Reference Point

ERR: Error

ERTMS: European Rail Traffic Management System

ESRI: Environmental Systems Research Institute

ETR: ETSI Technical Report

ETS: European Telecommunication Standard or
Extended Training Sequence

ETSI: European Telecommunications Standards Institute

EVM: Error Vector Magnitude, a measure of how accurately a radio is transmitting
symbols within its constellation

F
FA: Full Allocation or
Fax Adapter

FAC: Final Assembly Code
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FACCH: Fast ACCH

FACCH/F: Full rate Fast Associated Control Channel

FACCH/H: Half rate Fast Associated Control Channel

FB: Frequency correction Burst

FCCH: Frequency Correction Channel

FCS: Frame Check Sequence

FDM: Frequency Division Multiplexing

FEC: Forward Error Correction

FER: Frame Erasure Ratio

FFT: Fast Fourier Transform

FH: Frequency Hopping

FN: Frame Number

FPGA: Field Programmable Gate Array

FR: Full Rate

ftn: Forwarded-to number

G
GCC: Group Call Control

GID: Group Identifier - identification of user group

GMSC: Gateway Mobile (services) Switching Centre

GMSK: Gaussian Minimum Shift Keying (modulation)

GPA: GSM PLMN Area

GPRS: General Packet Radio Service

GSA: GSM System Area
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GSCN: Carrier number in 5G NR

GSM: Global System for Mobile Communication

GSM MS: GSM Mobile Station

GSM PLMN: GSM Public Land Mobile Network

GSM-R: GSM-Railway

GT: Global Title

GTSI: Group TETRA Subscriber Identity

H
HANDO: Handover

HDLC: High Level Data Link Control

HLC: High Layer Compatibility

HLR: Home Location Register

HO_MARGIN: SDL Message name for Handover Margin

HOLD: Call Hold, supplementary service

HPLMN: Home PLMN

HPU: Hand Portable Unit

HR: Half Rate

HSN: Hopping Sequence Number

I
I: Information (frames)

IA: Incoming Access (related to closed user group, SS)

IAM: Initial Address Message

iBWP: Initial Bandwidth Part (for 5G NR)
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IC: Interlock Code (CUG SS)

IC(pref): Interlock Code of the preferential CUG

ICB: Incoming Calls Barred

ICM: In-Call Modification

ID: Identification/Identity

IDN: Integrated Digital Network

IE: Information Element

IEC: International Electrotechnical Commission

IEI: Information Element Identifier

IF: Intermediate Frequency

IMEI: International Mobile (station) Equipment Identity

IMS: IP Multimedia Subsystem

IMSI: International Mobile Subscriber Identity

IN: Interrogating Node

IoT: Internet of Things

IP: Internet Protocol

IPv4: Internet Protocol version 4

ISC: International Switching Center

ISDN: Integrated Services Digital Network

ISUP: ISDN User Part (of the signalling system No.7)

ITC: Information Transfer Capability

ITS: Intelligent Transport System
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ITSI: Individual TETRA Subscriber Identity

IWF: InterWorking Function

IWMSC: InterWorking MSC

IWU: InterWorking Unit

K
K: Constraint Length of the Convolutional Code

Kc: Ciphering Key

Ki: Individual subscriber authentication key (Key Identity)

KPI: Key Performance Indicator

L
L1: Layer 1

L2ML: Layer 2 Management Link

L2R: Layer 2 Relay

L2R BOP: L2R Bit Orientated Protocol

L2R COP: L2R Character Orientated Protocol

L3: Layer 3

LA: Location Area

LAA: Licensed Assisted Access

LAC: Location Area Code

LAI: Location Area Identity

LAN: Local Area Network

LAPB: Link Access Protocol Balanced

LAPDm: Link Access Protocol on the Dm channel
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LCC: LAA component carrier

LCN: Local Communication Network

LE: Local Exchange

LEE: Low Estimation Error

LI: Length Indicator or
Line Identity

LLc: Low Layer compatibility

Lm: Traffic channel with capacity lower than Bm

LMSI: Local Mobile Station Identity

LPLMN: Local PLMN

LR: Location Register

LSTR: Listener Sidetone Rating

LTE: Long Term Evolution

LTP: Location Time Probability

LV: Length and Value

M
MA: Mobile Allocation

MAC: Medium Access Control

MACN: Mobile Allocation Channel Number

MAF: Mobile Additional Function

MAH: Mobile Access Hunting, supplementary service

MAI: Mobile Allocation Index

MAIO: Mobile Allocation Index Offset
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MAP: Mobile Application Part

MAVLink: Micro Air Vehicle Link

MBMS: Multimedia Broadcast Multicast Service, see 3GPP TS36.300 and TS36.311

MBS: Multimedia Broadcast Multicast Service, see 3GPP TS38.300 and TS38.311

MBSFN: Multicast-broadcast single-frequency network

MCC: Mobile Country Code

MCCH: Main Control Channel for TETRA

MCI: Malicious Call Identification, supplementary service

MCS: Modulation and Coding Scheme

MD: Mediation Device

MDL: Offset of NB-IoT downlink channel number to downlink EARFCN, defined in
3GPP TS36.104 as FDL = FDL_low + 0.1(NDL – NOffs-DL) + 0.0025*(2MDL+1) or
(mobile) Management (entity) Data Link (layer)

ME: Maintenance Entity or
Mobile Equipment

MEF: Maintenance Entity Function

MF: Multi-Frame

MFBI: Multifrequency Band Indication

MHS: Message Handling System

MIB: Master Information Block

MIC: Mobile Interface Controller

MIMO: Multiple-Input, Multiple-Output stands for the use of multiple antennas

MM: Man Machine or
Mobility Management

MME: Mobile Management Entity
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MMI: Man Machine Interface

MNC: Mobile Network Code

MO: Mobile Originated

MOC: Mobile Originated Call

MOS: Mean Opinion Score is a test providing a numerical indication of the perceived
quality from the users' perspective of received media after compression and/or trans-
mission. The MOS is expressed as a single number in the range 1 to 5, where 1 is low-
est perceived audio quality and 5 is the highest perceived audio quality measurement.
MOS tests for voice are specified by ITU-T recommendation P.800.

MoU: Memorandum of Understanding

MPEG: Moving Picture Experts Group - working group formed by ISO to set standards
for audio and video coding and compression, refer to DVB

MPH: (mobile) Management (entity) PHysical (layer) [primitive]

MPTY: Multi-Party, supplementary service

MR: Measurement report

MR-DC: Multi RAT-Dual Connectivity

MRP: Mouth Reference Point

MS: Mobile Station

MS_PWR_CLASS: MS Power Class; defines the power class of an MS expressed in
the same way as the R parameter

MS_RANGE_MAX: Mobile Station Range Maximum; handover criterion to determine
serving cell

MS_RXLEV_L: Lower Receive Level; threshold of RXLEV received from the serving
BS below which either power control or handover must take place to improve the cell
quality

MS_TXPWR_CONF MS: Transmitted RF Power Confirmation; parameter sent by the
MS to indicate its current transmitted RF power level

MS_TXPWR_MAX_CCH: Maximum Allowed Transmitted RF Power for MSs to access
the system until commanded otherwise
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MS_TXPWR_REQUEST: MS Transmitted RF Power Request; parameter sent by the
BSS that commands the required MS RF Power Level

MSC: Mobile Switching Centre

MSCM: Mobile Station Class Mark

MSCU: Mobile Station Control Unit

MSISDN: Mobile Station ISDN Number

MSRN: Mobile Station Roaming Number

MT: Mobile Terminated

MT (0,1,2): Mobile Termination

MTC: Mobile Terminated Call

MTM: Mobile-To-Mobile (call)

MTP: Media Transfer Protocol

MUL: Offset of NB-IoT uplink channel number to uplink EARFCN

MUMS: Multi User Mobile Station

N
N/W: Network

NB: Normal Burst or
Narrowband

NBIN: A parameter in the hopping sequence

NC0, NC1, NC2: NETWORK_CONTROL_ORDER options defining the measurement
reports provided by the mobile and its cell re-selection

NCC: Network (PLMN) Colour Code

NCELL: Neighbouring Cell

NCM: Network Configuration Manager of the QualiPoc; it provides the Bluetooth con-
nection to the R&S TSMA scanner.
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NDC: National Destination Code

NDIS: Network Driver Interface Specification; an application programming interface
(API) for network interface cards (NICs).

NDUB: Network Determined User Busy

NE: Network Element

NEF: Network Element Function

NET: Norme Européenne des Télécommunications

NF: Network Function

NIC: Network Independent Clocking

NID: Network ID (CDMA2000/EVDO)

NM: Network Management

NMC: Network Management Center

NMSI: National Mobile Station Identification number

NPI: Number Plan Identifier

NQA: Network Quality Analysis

NQDI: Network Quality Data Investigator

NR: New Radio, the 3GPP defined name for 5G RAN

NSA: Non-standalone, mode of operation of 5G NR

NSAP: Network Service Access Point

NSAPI: Network layer Service Access Point Identifier

NT: Network Termination or
Non Transparent

NUA: Network User Access

NUI: Network User Identification
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NUP: National User Part (of signaling system No7)

NWS: Network Scanner

O
O: Optional

O&M: Operations and Maintenance

OA: Outgoing Access (CUG SS)

OACSU: Off-Air-Call-Set-Up

OBU: On Board Unit

OCB: Outgoing Calls Barred within the CUG

OD: Optional for operators to implement for their aim

OLR: Overall Loudness Rating

OMC: Operations & Maintenance Center

OML: Operations and Maintenance Link

OS: Operating System

OSI: Open System Interconnection

OSI RM: OSI Reference Model

OTA: Over The Air, protocol

P
PABX: Private Automatic Branch eXchange

PAD: Packet Assembly/Disassembly facility

PAGING_GROUP: The set of MSs monitoring a particular paging block

PCC: Primary Component Carrier

PCH: Paging Channel
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PCI: Physical Cell Identity

PCM: Pulse Code Modulation

PD: Protocol Discriminator or
Public Data

PDN: Public Data Networks

PDU: Packet Data Unit

PDV: Packet Delay Variation

PEI: Peripheral Equipment Interface

PER: Packet Error Rate

PESC: Perceptual Evaluation of Speech Calls

PESQ: Perceptual Evaluation of Speech Quality

PH: Packet Handler or
PHysical (layer)

PHI: Packet Handler Interface

PI: Presentation Indicator

PIN: Personal Identification Number

PLMN: Public Land Mobile Network

PLMN_PERMITTED: PLMN permitted for handover purposes

PMI: Precoding Matrix Indicator

PNE: Présentation des Normes Européennes

PNS: Pseudo Noise Scanner

POI: Point Of Interconnection (with PSTN)

POLQA: Perceptual Objective Listening Quality Assessment;
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The standard that covers models to predict speech quality by means of digital speech
signal analyzis specified by ITU-T Rec. P.863. It is a successor of PESQ (ITU-T Rec.
p.632).

PP: Point-to-Point

PPE: Primative Procedure Entity

PPS: Pulse per Second

PRB: Physical Resource Block

Pref CUG: Preferential CUG

PRI: Primary Rate interface; telecommunications interface standard used on an ISDN

PS: Packet Switched

PSCCH: Physical Sidelink Control Channel

PSPDN: Packet Switched Public Data Network

PSS: Primary Synchronization Signal

PSSCH: Physical Sidelink Shared Channel

PSTN: Public Switched Telephone Network

PW: Password

Q
QA: Q (Interface) Adapter

QAF: Q Adapter Function

QoS: Quality of Service

Qualcomm MTP: Qualcomm Mobile Test Platform

R
R: Value of reduction of the MS transmitted RF power relative to the maximum allowed
output power of the highest power class of MS (A)

RA: Random mode request information field



Glossary: Abbreviations and termsDrive Test Software

2444Operating Manual 1171.6415.12 ─ 66

RAB: Random Access Burst

RACH: Random Access Channel

RADIO_LINK_TIMEOUT: The timeout period for radio link failure; the maximum value
of the radio link timer

RADIO_LINK_TIMER: Parameter which is incremented or decremented according to
the success with which SACCH messages are decoded

RAND: Random Number (used for authentication)

RB: Resource Block

RBER: Residual Bit Error Ratio

RCS: Revision Control System
or
Rich Commumnications Service

REC: Railway Emergency Call
or
An error-free series of frames longer then or equal to 5 frames

Rec.: Recommendation

REJ: Reject(ion)

REL: Release

REQ: Request

RESELECT_INTERVAL_MIN: Minimum time between cell reselections

RFC: Radio Frequency Channel

RFCH: Radio Frequency CHannel

RFN: Reduced TDMA Frame Number

RI: Rank Index

RLC: Radio Link Control (GPRS)

RLP: Radio Link Protocol
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RLR: Receiver Loudness Rating

RMS: Root Mean Square (value)

RNTABLE: Table of 128 integers in the hopping sequence

RPC: Remote Power Control

RPOA: Recognized Private Operating Agency

RR: Radio Resource

RRC: Radio Resource Control

RS: Reference Signal

RSCP: Receive Signal Coded Power

RSE: Radio System Entity

RSL: Radio Signalling Link

RSRP: Reference Signal Received Power (LTE)

RSS: ROMES Signal Set

RTE: Remote Terminal Emulator

RTP: Real Time Protocol

RTT: Round Trip Time

RTU: Remote Terminal Unit

RXLEV: Received Signal Level

RXLEV_ACCESS_MIN: The minimum received signal level at a MS for access to a
cell

RXLEV_MIN: The minimum received signal level at a MS from a neighbouring cell for
handover to be permitted

RXLEV_NCELL: Received signal level of neighbouring or current serving cell mea-
sured on the BCCH carrier
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RXLEV_SERVING_CELL: Received signal level in the serving cell measured on the
BCCH carrier

RXQUAL: Received Signal Quality

RXQUAL_FULL: Received signal quality assessed over the full set of TDMA frames
within a SACCH block

RXQUAL_SERVING_CELL: Received signal quality of serving cell

RXQUAL_SUB: Received signal quality assessed over a subset of 12 TDMA frames

S
S/W: Software

SABM: Set Asynchronous Balanced Mode

SACCH: Slow Associated Control Channel

SACCH/C4: Slow, SDCCH/4 Associated, Control Channel

SACCH/C8: Slow, SDCCH/8 Associated, Control Channel

SACCH/T: Slow, TCH Associated, Control Channel

SACCH/TF: Slow, TCH/F Associated, Control Channel

SACCH/TH: Slow, TCH/H associated, Control Channel

SAP: Service Access Point

SAPI: Service Access Point Indicator/Identifier

SB: Synchronization Burst

SC: Service Centre (used for SMS)
or
Service Code

SCC: Secondary Component Carrier
Service Code

SCCP: Signalling Connection Control Part

SCH: Synchronization CHannel
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SCN: Sub-Channel Number

SCS: Sub Carrier Spacing (5G NR)

SCS-SC: SCS Special Carrier

SDCCH: Stand-alone Dedicated Control CHannel

SDCCH/4: Stand alone Dedicated Control CHannel/4

SDCCH/8: Stand alone Dedicated Control CHannel/8

SDL: Specification Description Language

SDS: Short Data Service is TETRA data service simlar to SMS in GSM

SDU: Service Data Unit

SE: Support Entity

SEF: Support Entity Function

SFH: Slow Frequency Hopping

SI: Screening Indicator
or
Service Interworking
or
Supplementary Information (SIA Supplementary Information A)

SIB: System Information Block

SID: Silence Descriptor
or
Sector ID (CDMA2000/EVDO)

SIM: Subscriber Identity Module

SIT: System Info Type

SLR: Send Loudness Rating

SLTM: Signalling Link Test Message

SME: Short Message Entity
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SMP: Smartphone Mode

SMS: Short Message Service

SMS-SC: Short Message Service - Service Centre

SMS/PP: Short Message Service/Point-to-Point

SMSCB: Short Message Service Cell Broadcast

Smt: Short message terminal

SN: Subscriber Number

SNDCP: Subnetwork Dependent Convergence Protocol

SNPN: 5G Standalone Non-Public Network

SNR: Serial Number

SOA: Suppress Outgoing Access

SP: Service Provider
or
Signalling Point
or
Spare

SPC: Signalling Point Code
or
Suppress Preferential (CUG)

SQ: SwissQual

SQA: Speech Quality Analyzer

SQC: Structured Query Language Common Code

SRES: Signed Response (authentication)

SRTM: Shuttle Radar Topography Mission

SRVCC: Single Radio Voice Call Continuity (LTE)

SS: Supplementary Service
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or
System Simulator

SS7/SS#7: Signalling System No 7

SSB: Synchronisation Signal Block, related to combination of synchronization and
PBSCH signals in 5G NR

SSC: Supplementary Service Control string

SSL: Secure Socket Layer

SSN: Sub-System Number

SSS: Secondary Synchronization Signal

STMR: Sidetone Masking Rating

STP: Signalling Transfer Point

SUL: Supplemental Uplink

T
T: Timer
or
Transparent
or
Type

TA: Terminal Adapter

TAC: Type Approval Code

TAF: Terminal Adaptation Function

TBF: Temporary Block Flow

TBS: Temporary Block Size

TC: Transaction Capabilities

TCH: Traffic Channel

TCH/F: A Full-rate TCH
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TCH/F2.4: A Full-rate data TCH ( <2.4kbit/s)

TCH/F4.8: A Full-rate date TCH (4.8kbit/s)

TCH/F9.6: A Full-rate data TCH (9.6kbit/s)

TCH/FS: A Full-rate Speech TCH

TCH/H: A Half-rate TCH

TCH/H2.4: A Half-rate data TCH (2.4kbit/s)

TCH/H4.8: A Half-rate data TCH (4.8kbit/s)

TCH/HS: A Half-rate Speech TCH

TCI: Transceiver Control Interface

TCM: Test device Containment Module

TDMA: Time Division Multiple Access

TE: Terminal Equipment

TEDS: TETRA Enhanced Data Services - the high speed data part of the ETSI TETRA
Release 2 standard.

Tei: Terminal endpoint identifier

TETRA: Terrestrial Trunked Radio

TFA: Transfer Allowed

TFI: Temporary Flow Identity

TFP: Transfer Prohibited

TI: Transaction Identifier

TLV: Type, Length and Value

TMN: Telecommunications Management Network

TMSI: Temporary Mobile Subscriber Identity



Glossary: Abbreviations and termsDrive Test Software

2451Operating Manual 1171.6415.12 ─ 66

TN: Timeslot Number

TON: Type Of Number

TP: Throughput

TRX: Transceiver

TS: Time Slot or
Technical Specification (see ETS) or
Teleservice

TSC: Training Sequence Code

TSDI: Transceiver Speech & Data Interface

TSM: TruckSim(ulator) Map

TTI: Transmit Time Interval

TUP: Telephone User Part (of signalling system No7)

TV: Type and Value

TXPWR: Transmit power; Tx power level in the MS_TXPWR_REQUEST and
MS_TXPWR_CONF parameters

U
UAC: User access Control

UARFCN: UTRA Apsolute Radio Frequency Channel Number

UDI: Unrestricted Digital Information

UDP: User Datagram Protocol

UDUB: User Determined User Busy

UE: User Equipment, stands also as the term for test mobile

UEE: User Equipment Estimation

UI: Unnumbered Information (Frame)

UL: Uplink (mobile to base station)
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UMTS: Universal Mobile Telecommunications System

UPCMI: Uniform PCM Interface (13-bit)

UPD: Up to Date

URL: Uniform Resource Locator

USB: Universal Serial Bus

USSD: Unstructured SS Data

UTM: Universal Transverse Mercator coordinate system; uses 2-dimensional Cartesian
coordinate system to give the location on the surface of the Earth.

UTRA: UMTS Terrestrial Radio Access

UUS: User-to-User Signalling, supplementary service

V
V: Value

V(SD): Variable Send_State

V2X: Vehicle to everything

VAD: Voice Activity Detection

VAP: Videotex Access Point

VBCS: Voice Broadcast Service

VBS: Voice Broadcast Service, the same as previous

VC runtime: Microsoft Visual Studio (VC) C++ runtime library; 3rd party software.

VCO: Voltage Controlled Oscillator

VGCS: Voice Group Call Service

VGS: Voice Group Service

VLR: Visitor Location Register
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VMSC: Visited MSC

VoNR: Voice over New Radio

VPLMN: Visited PLMN

VSC: Videotex Service Centre

VTX host: The components dedicated to Videotex service

W
WB: Wideband

WinPcap: WinPcap is an API for capturing network traffic needed by the tracing tools.

WPA: Wrong Password Attempts (counter)

WS: Work Station

X
XID: eXchange IDentifier
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Glossary: GPS receiver
Symbols

2-D, 3-D: Refers to two-dimensional and three-dimensional positions. A 2-D position fix
provides latitude and longitude. Altitude is assumed to be fixed. Only three satellites
are required to provide a 2-D position with a user-supplied altitude. A 3-D position pro-
vides the altitude in addition to LAT/LON and requires four satellites.

A
Almanac: Data transmitted by a GPS satellite which includes orbit information on all
the satellites, clock correction, and atmospheric delay parameters. This data is used to
facilitate rapid SV acquisition. The orbit information is a subset of the ephemeris data
with reduced accuracy.

Ambiguity: The unknown integer number of cycles of the reconstructed carrier phase
contained in an unbroken set of measurements from a single satellite pass at a single
receiver.

Argument of latitude: The sum of the true anomaly and the argument of perigee.

Argument of perigee: The angle or arc from the ascending node to the closest
approach of the orbiting body to the focus or perigee point, as measured at the focus of
an elliptical orbit, in the orbital plane in the direction of motion of the orbiting body.

Ascending node: The point at which an object's orbit crosses the reference plane
(e.g. equatorial plane) from south to north.

Azimuth: A horizontal direction expressed as the angular distance between a fixed
direction, say North, and the direction of the object.

B
Bandwidth: A measure of the information-carrying capacity of a signal, expressed as
the width of the spectrum of that signal (frequency domain representation) in Hertz.

Baseline: The three-dimensional vector distance between a pair of stations for which
simultaneous GPS data has been collected and processed with differential techniques.
The most accurate GPS result.

Beat frequency: Either of the two additional frequencies obtained when signals of two
frequencies are mixed. The beat frequencies are equal to the sum or difference of the
original frequencies.

Bias: See Integer Bias Terms.
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Binary biphase modulation: Phase changes of either 0 or 180 degrees on a constant
frequency carrier (representing a binary 0 or 1 respectively). GPS signals are bi-phase
modulated.

Binary pulse code modulation: Pulse modulation using a string of binary numbers
(codes). This coding is usually represented by ones and zeros with definite meanings
assigned to them, such as changes in phase or direction of a wave.

C
C/A code: The Coarse/Acquisition (or Clear/Acquisition) code modulated onto the
GPS L1 signal. This code is a sequence of 1023 pseudo random binary bi-phase mod-
ulations on the GPS carrier at a chipping rate of 1.023 MHz, thus having a code repeti-
tion period of one millisecond. This code was selected to provide good acquisition
properties.

Carrier: A radio wave having at least one characteristic (such as frequency, amplitude,
phase) which may be varied from a known reference value by modulation.

Carrier beat: The phase of the signal which remains when the incoming Doppler-shif-
ted satellite carrier signal is beat (the difference frequency signal is generated) with the
nominally constant reference frequency generated in the receiver.

Carrier frequency: The frequency of the unmodulated fundamental output of a radio
transmitter. The GPSL1 carrier frequency is 1575.42 MHz.

Celestial equator: The great circle that is the projection of the Earth's geographical
equator of rotation onto the celestial sphere. Its poles are the North and South Celes-
tial Poles.

Celestial meridian: That vertical circle through the elevated celestial pole. It also
passes through the other celestial pole, the astronomical zenith, and the nadir.

Channel: The receiver hardware that is required to lock to a satellite, make the range
measurements and collect data from the satellite.

Chip: The length of time to transmit either a zero or a one in a binary pulse code.

Chip rate: Number of chips per second (e.g., C/A code = 1.023 MHz).

Clock offset: Constant difference in the time reading between two clocks.

Code division multiple access (CDMA): A method of frequency reuse whereby many
radios use the same frequency but with each one having a separate and unique code.
GPS uses CDMA techniques with Gold's codes for their unique cross-correlation prop-
erties.
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Conventional international origin (CIO): Average position of Earth's rotation axis
during the years 1900- 1905.

Correlation-type channel: A GPS receiver channel which uses a delay lock loop to
maintain an alignment (correlation peak) between the replicas of the GPS code gener-
ated in the receiver and the received code.

D
Datum: A mathematical model of the earth. Many local data model the earth for a
small region: e.g., Tokyo datum, OSGB-36 (Ordnance Survey of Great Britain 1936),
NAD-27(North American). Others, WGS-84, for example, model the whole earth. See
also Geodetic Datum

Deflection of the vertical: The angle between the normal to the ellipsoid and the verti-
cal (true plumb line). Since this angle has both a magnitude and a direction, it is usu-
ally resolved into two components: one in the meridian and the other perpendicular to it
in the prime vertical.

Delay lock: The technique whereby the received code (generated by the satellite
clock) is compared with the internal code (generated by the receiver clock) and the lat-
ter is shifted in time until the two codes match. Delay lock loops can be implemented in
several ways; tau dither and early-minus-late gating.

Delta pseudo-range: See reconstructed carrier phase.

DGPS: Differential GPS operation. The use of a reference station to provide correc-
tions using the RTCM SC-104 protocol for one or more mobile receivers. This may be
carried out in real time over a telemetry link or by storing the data and post processing
(see below).The accuracy of position measurement may be improved from 100 meters
2dRMSunder Selective Availability conditions to 1 - 15 meters depending on the choice
of sensors and telemetry.

Differential (relative) positioning: Determination of relative coordinates of two or
more receivers which are simultaneously tracking the same satellites. Static differential
GPS involves determining baseline vectors between pairs of receivers. See also
DGPS.

Differential processing: GPS measurements can be differenced between receivers,
satellites, and epochs. Although many combinations are possible, the present conven-
tion for differential processing of GPS phase measurements is to take differences
between receivers (single difference), then between satellites (double difference), then
between measurement epochs (triple difference).
A single-difference measurement between receivers is the instantaneous difference in-
phase of the signal from the same satellite, measured by two receivers simultaneously.
A double-difference measurement is obtained by differencing the single difference for
one satellite with respect to the corresponding single difference for a chosen reference
satellite.
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A single-difference measurement is the difference between a double difference at one
epoch of time and the same double difference at the previous epoch of time.

Dilution of precision (DOP): A description of the purely geometrical contribution to
the uncertainty in a position fix, given by the expression DOP = SQRT TRACE (A A)
where A A is the design matrix for the instantaneous position solution (dependent on
satellite-receiver geometry). The DOP factor depends on the parameters of the posi-
tion-fix solution. Standard terms for the GPS application are:
GDOP:
Geometric (three position coordinates plus clock offset in the solution)
PDOP:
Position (three coordinates)
HDOP:
Horizontal (two horizontal coordinates)
TDOP:
Time (clock offset only)
VDOP:
Vertical (height only)
RDOP:
Relative (normalized to 60 seconds)

Doppler aiding: The use of Doppler carrier-phase measurements to smooth code-
phase position measurements.

Doppler shift: The apparent change in frequency of a received signal due to the rate
of change of the range between the transmitter and receiver. See reconstructed carrier
phase.

Double-difference method: A method to determine that set of ambiguity values which
minimizes the variance of the solution for a receiver pair baseline vector.

Dynamic positioning: Determination of a timed series of sets of coordinates for a
moving receiver, each set of coordinates being determined from a single data sample,
and usually computed in real time.

E
Earth-centered earth-fixed (ECEF): Cartesian coordinate system where the X direc-
tion is the intersection of the prime meridian (Greenwich) with the equator. The vectors
rotate with the earth. Z is the direction of the spin axis.

Eccentric anomaly E: The regularizing variable in the two-body problem. E is related
to the mean anomaly M by Kepler's equation: M = E - e.sinE (e stands for eccentricity).

Eccentricity: The ratio of the distance from the center of an ellipse to its focus to the
semimajor axis. e = (I - b2/a2)-0.5 where a and b are the semimajor and semiminor axes
of the ellipse.
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Ecliptic: The earth-sun orbital plane. North is the direction of the system angular
momentum. Also called the ecliptic pole.

Elevation: Height above mean sea level. Vertical distance above the geoid.

Elevation Mask Angle: That angle below which satellites should not be tracked. This
varies according to the task and location, e.g. for land surveying it is normally set to 15
degrees to avoid interference problems caused by buildings, trees and multipath
errors. For marine navigation on the other hand, the angle can be lowered to 5
degrees. Please note that, because of the greater thickness of the ionosphere and tro-
posphere traversed by the signal at low angles together with the increased distance of
the satellite, the signal is weaker.

Ellipsoid: In geodesy, unless otherwise specified, a mathematical figure formed by
revolving an ellipse about its minor axis. lt is often used interchangeably with spheroid.
Two quantities define an ellipsoid; these are usually given as the length of the semima-
jor axis, a, and the flattening, f = (a - b)/a, where b is the length of the semiminor axis.
Prolate and triaxial ellipsoids are invariably described as such.

Ellipsoid height: The measure of vertical distance above the ellipsoid. Not the same
as elevation above sea level. GPS receivers output position-fix height in the WGS-84
datum.

Ephemeris: A list of (accurate) positions or locations of a celestial object as a function
of time. Available as "broadcast ephemeris" or as post processed "precise ephemeris."
For GPS navigation purposes the broadcast ephemeris is always used and is updated
every hour. It is sent as a set of 8 elements of the Keplerian orbital equation (qv) and
used by the receiver to compute the instantaneous position of that satellite.

Epoch: Measurement interval or data frequency, as in making observations every 15
seconds. Loading data using 30-second epochs means loading every other measure-
ment.

ESRI: Environmental Systems Research Institute

F
Fast switching channel: A switching channel with a sequence time short enough to
recover (through software prediction) the integer part of the carrier beat phase.

Flattening: f = (a - b)/a = I -(I - e2)1/2 where: a = Semimajor axis b - Semiminor axis e =
Eccentricity

Frequency band: A range of frequencies in a particular region of the electromagnetic
spectrum.

Frequency spectrum: The distribution of amplitudes as a function of frequency of the
constituent waves in a signal.
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Fullwave: Term used to differentiate between measurements made with signal-
squared (codeless)and code-tracking receivers. Specifically, a receiver tracking L2 P-
code can make measurement using the whole L2 wavelength (23 cm): the full wave.

Fundamental frequency: The fundamental frequency used in GPS is 10.23 MHz. The
carrier frequencies L1 and L2 are integer multiples of this fundamental frequency. L1 =
154F = 1575.42 MHz L2 =120F = 1227.60 MHz

G
GDOP: Geometric Dilution of Precision. The relationship between errors in user posi-
tion and time and in satellite range. GDOP2= PDOP2 + TDOP2

Geocenter: The center of the earth.

Geodetic datum: A mathematical model designed to best fit part or all of the geoid. It
is defined by an ellipsoid and the relationship between the ellipsoid and a point on the
topographic surface established as the origin of datum. This relationship can be
defined by six quantities, generally (but not necessarily) the geodetic latitude, longi-
tude, and the height of the origin, the two components of the deflection of the vertical at
the origin, and the geodetic azimuth of a line from the origin to some other point. The
GPS uses WGS-84.

Geoid: The actual physical shape of the earth which is hard to describe mathemati-
cally because of the local surface irregularities and sea-land variations. In geodetic
terms it is the particular equipotential surface which coincides with mean sea level, and
which maybe imagined to extend through the continents. This surface is everywhere
perpendicular to the force of gravity.

Geoid height: The height above the geoid is often called elevation above mean sea
level.

GIS: Geographic Information System

GNSS: Global Navigation Satellite System

GPS: Global Positioning System, consisting of:
1) A Space Segment (up to 24 NAVSTAR satellites in 6 different orbits)
2) The Control Segment (5 monitor stations, 1 primary control station and 3 upload
stations)
3) The User Segment (GPS receivers) NAVSTAR satellites carry extremely accurate
atomic clocks and broadcast coherent simultaneous signals.

GPS ICD-200: The GPS Interface Control Document is a government document that
contains the full technical description of the interface between the satellites and the
user. GPS receivers must comply with this specification if they are to receive and proc-
ess GPS signals properly.
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GPS Time: The length of the second is fixed and is determined by primary atomic fre-
quency standards. Leap-seconds are not used, as they are in UTC. Therefore, GPS
time and UTC differ by a variable whole number of seconds. See also Universal Time.

Gravitational constant: The proportionality constant in Newton's Law of Gravitation:
G=6.672 x 111 Nm2/K92.

Greenwich mean time (GMT): See Universal Time. They are often used interchange-
ably, although Universal Time is now defined as the accepted standard. Halfwave -
Measurements made using L2-squared measurements. The squaring process results
in only half of the original L2 wavelength being available.

H
HDOP: Horizontal Dilution of Precision. See DOP and PDOP.

HOW: Handover word; the word in the GPS message that contains time synchroniza-
tion information for the transfer from the C/A code to the P-code.

I
Inclination: The angle between the orbital plane of a body and some reference plane
(e.g., equatorial plane).

INS: Inertial Navigation System, which contains an inertial measurement unit (IMU).

Integer Bias Terms: The receiver counts the radio waves from the satellite, as they
pass the antenna, to a high degree of accuracy. However, it has no information on the
number of waves to the satellite at the time it started counting. This unknown number
of wavelengths between the satellite and the antenna is the integer bias term.

Integrated Doppler: A measurement of Doppler shift frequency or phase over time.

IODE: Issue Of Data, Ephemeris. Part of the navigation data. It is the issue number of
the ephemeris information. A new ephemeris is available usually on the hour. Espe-
cially important for Differential GPS operation that the IODE change is tracked at both
the reference station and mobile stations.

Ionospheric delay: A wave propagating through the ionosphere [which is a non homo-
geneous (in space and time) and dispersive medium] experiences delay. Phase delay
depends on electron content and affects carrier signals. Group delay depends on dis-
persion in the ionosphere as well, and affects signal modulation (codes). The phase
and group delay are of the same magnitude but opposite sign.

ipar soln: Values giving the difference in each of delta X, delta Y, delta Z vector com-
ponents.
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J
JPO: Joint Program Office for GPS located at the USAF Space Division at El Segundo,
California. The JPO consists of the USAF Program Manager and Deputy Program
Managers representing the Army, Navy, Marine Corps, Coast Guard, Defense Mapping
Agency and NATO.

K
Kalman Filter: A numerical method used to track a time-varying signal in the presence
of noise. If the signal can be characterized by some number of parameters that vary
slowly with time, then Kalman filtering can be used to tell how incoming raw measure-
ments should be processed to best estimate those parameters as a function of time.

Keplerian orbital elements: Allow description of any astronomical orbit:
a: semimajor axis
l: right ascension of ascending node
e: eccentricity
i: inclination
o: argument of perigee
t: true anomaly

Kinematic surveying: A form of continuous differential carrier-phase surveying requir-
ing only short periods of data observations. Operational constraints include starting
from or determining a known baseline, and tracking a minimum of four satellites. One
receiver is statically located at a control point, while others are moved between points
to be measured.

L
L band: The radio-frequency band extending from 390 MHz to (nominally) 1550 MHz.

L1: The primary L-band signal radiated by each NAVSTAR satellite at 1575.42 MHz.
The L1 beacon is modulated with the C/A and P-codes, and with the NAV message. L2
is centered at 1227.60 MHz and is modulated with the P-code and the NAV message.

Lane: The area (or volume) enclosed by adjacent lines (or surfaces) of zero phase of
either the carrier beat phase signal, or of the difference between two carrier beat phase
signals. On the earth's surface a line of zero phase is the locus of all points for which
the observed value would be an exact integer for the complete instantaneous phase
measurement. In three dimensions, this locus becomes a surface. Lane counts are
used extensively also in terrestrial radio navigation systems such as Loran or Decca to
define position.

LLA: A topocentric spherical coordinate system, whose coordinates are Latitude, Lon-
gitude, and Altitude. Note that altitude can be expressed with respect to any particular
ellipsoid or geoid model and generally depends on the model.
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M
MCX: A small RF coaxial cable antenna connector system produced by several com-
panies, e.g. Huber & Suhner.

Mean Anomaly: M = n (t - T) where: n is the mean motion, t is the time and T is the
instant of perigee passage.

Mean motion: n = 2 /P where P is the period of revolution.

Microstrip: Antenna. A two-dimensional, flat, precisely cut piece of metal foil glued to
a substrate.

Monitor station: Worldwide group of stations used in the GPS control segment to
monitor satellite clock and orbital parameters. Data collected here is linked to a primary
station where corrections are calculated and controlled. This data is uploaded to each
satellite at least once per day from an Upload Station.

Multichannel receiver: A receiver containing many independent channels. Such a
receiver offers highest SNR because each channel tracks one satellite continuously.

Multipath: Interference similar to "ghosts" on a television screen which occurs when
GPS signals arrive at an antenna having traversed different paths. The signal travers-
ing the longer path will yield a larger pseudo range estimate and increase the error.
Multiple paths may arise from reflections from structures near the antenna.

Multipath error: A positioning error resulting from interference between radio waves
which have traveled between the transmitter and the receiver by two paths of different
electrical lengths.

Multiplexing channel: A receiver channel which is sequenced through several satel-
lite signals (each from a specific satellite and at a specific frequency) at a rate which is
synchronous with the satellite message bit-rate (50 bits per second, or 20 milliseconds
per bit). Thus, one complete sequence is completed in a multiple of 20 milliseconds.

N
N-type: A large diameter screwed coaxial antenna connector, normally used with RF
cables such as RG213 or RG58 where the mechanical strain relief is taken through the
connector.

NAD-83: North American Datum, 1983.

NAVDATA: The 1500 bit Navigation Message broadcast by each satellite at 50 bps on
both L1 or L2 beacons. This message contains system time, clock correction parame-
ters, ionospheric delay model parameters, and the vehicle'ephemeris and health. This
information is used to process GPS signals to obtain user position and velocity.
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NAVSTAR: The name given to GPS satellites, built by Rockwell International (Block I)
or GE (Block II), which is an acronym formed from NAVigation System with Time And
Ranging.

O
Observing session: The period of time over which GPS data is collected simultane-
ously by two or more receivers.

OGC: Open Geospatial Consortium, a standards organization for geospatial informa-
tion systems

Outage: The occurrence in time and space of a GPS dilution of precision value
exceeding a specified maximum.

P
P-code: The protected or precise code used on both L1 and L2 GPS beacons. This
code will be made available by the DOD only to authorized users. The P-code is a very
long (about 1014 bits) sequence of pseudo random binary biphase modulations on the
GPS carrier at a chipping rate of 10.23 MHz which does not repeat itself for about 38
weeks. Each satellite uses a one-week segment of this code which is unique to each
GPS satellite, and is reset each week.

Parity error: A digital message is composed of 1s and 0s. Parity can be defined as the
sum of these bits within a word unit. A parity error results when one of the bits is
changed so that the parity calculated at reception is not the same as it was at transmis-
sion of the message.

PCB: Printed Circuit Board. Reference is also made to flexible PCBs, a method of pro-
viding flexible connector ribbons to normal PCBs.

PDOP: Position Dilution of Precision, a unitless figure of merit expressing the relation-
ship between the error in user position and the error in satellite position. Geometrically,
PDOP is proportional to 1 divided by the volume of the pyramid formed by lines run-
ning from the receiver to four satellites observed. Values considered "good" for posi-
tioning are small, say 3. Values greater than 7 are considered poor. Thus, small PDOP
is associated with widely separated satellites. Small PDOP is important in navigation
and positioning, but much less so in surveying. PDOP is related to horizontal and verti-
cal DOP by PDOP2 = HDOP2 + VDOP2.

Pengee: That point in a geocentric orbit when the geometric distance is a minimum.
The closest approach of a body.

Phase lock: The technique whereby the phase of an oscillator signal is made to follow
exactly the phase of a reference signal by first comparing the phases of the two sig-
nals, and then using the resulting phase difference signal to adjust the reference oscil-
lator frequency to eliminate phase difference when the two signals are next compared.
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Phase observable: See reconstructed carrier phase.

Point positioning: A geographic position produced from one receiver in a stand-alone
mode. At best, position accuracy obtained from a stand-alone receiver is 15-25 meters,
depending on the geometry of the satellites. With Selective Availability in operation the
best that can be expected is 100 meters 2dRMS.

Polar motion: Motion of the instantaneous axis of the rotation of the Earth with respect
to the solid body of the Earth. Irregular but more or less circular motion with an ampli-
tude of about 15m and a main period of about 430 days (called Chandler Wobble).

Precise positioning service (PPS): The highest level of military dynamic positioning
accuracy that will be provided by GPS, based on the dual-frequency P-code and hav-
ing high anti-jam and anti-spoof qualities.

Prime vertical: The vertical circle perpendicular to the celestial meridian.

PRN: Pseudorandom noise, a sequence of digital Is and 0s which appears to be ran-
domly distributed like noise, but which can be exactly reproduced. The important prop-
erty of PRN codes is that they have a low autocorrelation value for all delays or lags
except when they are exactly coincident. Each NAVSTAR satellite has its own unique
C/A and P pseudorandom-noise codes.

Pseudolite: A ground-based GPS transmitter station which broadcasts a signal with a
structure similar to that of an actual GPS satellite.

Pseudorange: A measure of the apparent propagation time from the satellite to the
receiver antenna, expressed as a distance. Pseudorange is obtained by multiplying the
apparent signal-propagation time by the speed of light. Pseudorange differs from the
actual range by the amount that the satellite and user clocks are offset, by propagation
delays, and other errors.
The apparent propagation time is determined from the time shift required to align (cor-
relate) a replica of the GPS code generated in the receiver with the received GPS
code. The time shift is the difference between the time of signal reception (measured in
the receiver time frame) and the time of emission (measured in the satellite time
frame).

Pseudorange difference: See reconstructed carrier phase.

R
Range rate: The rate of change of range between the satellite and receiver. The range
to a satellite changes due to satellite and observer motions. Range rate is determined
by measuring the Doppler shift of the satellite beacon carrier.

RDOP: Relative Dilution Of Precision, defined as:
(_DX2 + _DY2 + DZ2)1/2 / _DD
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usually in units of m/cycle. Multiplying RDOP by the uncertainty of a double-difference
measurement yields the spherical relative-position error.

Reconstructed carrier phase: The difference between the phase of the incoming
Doppler-shifted GPS carrier and the phase of a nominally constant reference fre-
quency generated in the receiver. For static positioning, the reconstructed carrier
phase is sampled at epochs determined by a clock in the receiver.
The reconstructed carrier phase changes according to the continuously integrated
Doppler shift of the incoming signal, biased by the integral of the frequency offset
between the satellite and receiver reference oscillators.
The reconstructed carrier phase can be related to the satellite-to-receiver range, once
the initial range (or phase ambiguity) has been determined. A change in the satellite-to-
receiver range of one wavelength of the GPS carrier (19 cm for L1 ) will result in a one-
cycle change in the phase of the reconstructed carrier.

Relative navigation: A technique similar to relative positioning except that one or
both, of the points may be moving. The pilot of a ship or aircraft may need to know his
position relative to a harbor or runway. A data link is used to relay the error terms to the
moving vessel to allow real-time navigation.

Relative positioning: The process of determining the relative difference in position
between two marks with greater precision than that to which the position of a single
point can be determined. Here, a receiver (antenna) is placed over each spot and mea-
surements are made by observing the same satellite at the same time. This technique
allows cancellation (during computations) of all errors which are common to both
observers, such as satellite clock errors, propagation delays, etc. See also Transloca-
tion and Differential Navigation.

Right ascension of ascending node: The angular distance measured from the vernal
equinox, positive to the east, along the celestial equator to the ascending node. Typi-
cally denoted by a capital omega (Ω). Used to discriminate between orbital planes.

RTCM: Radio Technical Commission for Maritime Services. Commission set up to
define a differential data link to relay GPS correction messages from a monitor station
to a field user. RTCM SC-104 recommendations define the correction message format
and 16 different correction message types.

S
SA: See Selective Availability SATNAV - A local term referring to use of the older
TRANSIT system for satellite navigation. One major difference between TRANSIT and
GPS is that the TRANSIT satellites are in low-altitude polar orbits with a 90-minute
period.

Selective Availability(SA): A DoD program to control the accuracy of pseudorange
measurements, whereby the user receives a false pseudorange which is in error by a
controlled amount. Differential GPS techniques can reduce these effects for local appli-
cations.
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Semimajor axis: One half of the major axis of an ellipse.

SEP: Spherical Error Probable, a statistical measure of precision defined as the 50th
percentile value of the three-dimensional position error statistics. Thus, half of the
results are within a 3-D SEP value.

Sidereal day: Time between two successive upper transits of the vernal equinox.

Simultaneous measurements: Measurements referenced to time-frame epochs
which are either exactly equal, or else so closely spaced in time that the time misalign-
ment can be accommodated by correction terms in the observation equation, rather
than by parameter estimation.

Slope distance: The three-dimensional vector distance from station one to station two.
The shortest distance (a chord) between two points.

Slow switching channel: A switching channel with a sequencing period which is too
long to allow recovery of the integer part of the carrier beat phase.

SMA, SMB, SMC: Small diameter RF coaxial cable connectors with various fastening
mechanisms. See manufacturers' catalogues for details.

Solar day: Time between two successive upper transits of the sun.

Spheroid: See ellipsoid.

Spread spectrum: The received GPS signal is a wide bandwidth, low-power signal (-1
60dBW). This property results from modulating the L-band signal with a PRN code in
order to spread the signal energy over a bandwidth which is much greater than the sig-
nal information bandwidth. This is done to provide the ability to receive all satellites
unambiguously and to provide some resistance to noise and multipath.

Spread spectrum systems: A system in which the transmitted signal is spread over a
frequency band much wider than the minimum bandwidth needed to transmit the infor-
mation being sent.

Squaring-type channel: A GPS receiver channel which multiplies the received signal
by itself to obtain a second harmonic of the carrier which does not contain the code
modulation. Used in so-called codeless receiver channels.

Standard positioning service (SPS): The level of dynamic- or static-positioning capa-
bility that will be provided by GPS, based on the single-frequency C/A-code. The accu-
racy of this service will be set at a level consistent with national security.

Static positioning: Positioning applications in which the positions of static or near
static points are determined.
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SV: Satellite Vehicle or Space Vehicle.

Switching channel: A receiver channel which is sequenced through a number of sat-
ellite signals (each from a specific satellite and at a specific frequency) at a rate which
is slower than, and asynchronous with, the message data rate.

T
TAIP: Trimble ASCII Interface Protocol. A protocol used to interface with Trimble vehi-
cle navigation sensors such as the Starfinder and SVeeSix. It is designed for bi-direc-
tional use with communication modems and radio data telemetry systems which have
problems with binary or hexadecimal data packets. Each packet is preceded by two let-
ters, followed by a sequence of alphanumeric information. A full specification of the
protocol is contained Appended.

TANS: Trimble Advanced Navigation Sensor. A family of rugged 6 channel GPS sen-
sors. Used also to refer to the protocol, also known as TSIP, Trimble Standard Inter-
face Protocol (q.v.).

TDOP: Time Dilution of Precision. See DOP.

TOW: Time of week, in seconds, from midnight Sunday UTC.

Translocation: A version of relative positioning which makes use of a known position,
such as a national survey authority mark, to aid in the accurate positioning of a desired
point. Here, the position of the mark, determined using GPS, is compared with the
accepted value. The three-dimensional differences are then used in the calculations for
the second point.

Trop: Tropospheric correction. The correction applied to the measurement to account
for tropospheric delay. This value is obtained from the modified Hopfield model.

True anomaly: The angular distance, measured in the orbital plane from the earth's
center (occupied focus) from the perigee to the current location of the satellite (orbital
body).

TSIP: Trimble Standard Interface Protocol. A binary/hex packet bi-directional protocol,
also known as the TANS protocol. Used by a large number of Trimble sensors. TSIP is
the subset of TANS which is recognized by all sensors except those of the 4000 series.
The protocol is defined in full in the TSIP Appendix.

U
Universal time: Trimble Standard Interface Protocol. A binary/hex packet bi-directional
protocol, also known as the TANS protocol. Used by a large number of Trimble sen-
sors. TSIP is the subset of TANS which is recognized by all sensors except those of
the 4000 series. The protocol is defined in full in the TSIP Appendix.
UTO:
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Universal Time as deduced directly from observations of stars and the fixed numerical
relationship between Universal and Sidereal Time; 3 minutes 56.555 seconds.
UTI:
UTO corrected for polar motion.
UT2:
UTI corrected for seasonal variations in the earth's rotation rate.
UTC:
Universal Time Coordinated; uniform atomic time system kept very close to UT2 by off-
sets. Maintained by the US. Naval Observatory. GPS time can be directly related to
UTC.
UTC:
GPS = seconds. (changing constant = 7 seconds in 1991).

User range accuracy (URA): The contribution to the range-measurement error from
an individual error source (apparent clock and ephemeris prediction accuracy's), con-
verted into range units, assuming that the error source is uncorrelated with all other
error sources. Values less than 10 are preferred. Block II satellites operating under
Selective Availability are usually set to 32.

UTM: Universal Transverse Mercator Map Projection. A special case of the Transverse
Mercator projection. Abbreviated as the UTM Grid, it consists of 60 north-south zones,
each 6 degrees wide in longitude.

V
VDOP: Vertical Dilution of Precision. See DOP and PDOP.

Vernal equinox: The intersection of the celestial equator with the ecliptic, with the pos-
itive sense being from the earth to the sun, as the sun crosses the equator from south
to north.

Vertical: The line perpendicular to the geoid at any point. The direction of the force of
gravity at that point. Plumb line.

W
Waypoint: A reference point in physical space used for purposes of navigation, also
named a landmark.

WGS-72: World Geodetic System (1972); the mathematical reference ellipsoid previ-
ously used by GPS, having a semimajor axis of 6378.135 km and a flattening of
1/298.26.

WGS-84: World Geodetic System (1984); the mathematical ellipsoid used by GPS
since January 1987. The shift from WGS-72 to WGS-84 in Sunnyvale CA (370 N, 1220
W) is about 13.6 meters east, 45 meters north and 2.7 meters up.
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Widelane: A linear combination of L1 and L2 observations (L1-L2) used to partially
remove ionospheric errors. This combination yields a solution in about one-third the
time of a complete ionosphere-free solution.

Z
Z-count: The GPS satellite clock time at the leading edge of the next data subframe of
the transmitted GPS message (usually expressed as an integer number of 6 seconds).
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